FeatureCAM

Copyright © 1995-2015 Delcam Ltd. All rights reserved.

Delcam Ltd has no control over the use made of the software described in this manual and cannot accept responsibility for any loss or damage howsoever caused as a result of using the software. Users are advised that all the results from the software should be checked by a competent person, in accordance with good quality control procedures.

The functionality and user interface in this manual is subject to change without notice in future revisions of the software.

The software described in this manual is furnished under licence agreement and may be used or copied solely in accordance with the terms of such licence.

Delcam Ltd grants permission for licensed users to print copies of this manual or portions of this manual for personal use only. Schools, colleges and universities that are licensed to use the software may make copies of this manual or portions of this manual for students currently registered for classes where the software is used.

Acknowledgements

This documentation references a number of registered trademarks and these are the property of their respective owners. For example, Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States.
Contents

Introduction 1

Using the Help window ....................................................................................... 1
Reference help PDF .............................................................................................. 3
Technical support ................................................................................................. 4
  Installing your PAF license ............................................................................... 4
  Silent install ....................................................................................................... 9
FeatureCAM product family .................................................................................. 10
  3D product differences ..................................................................................... 11
  Evaluating other FeatureCAM components .................................................... 11

Getting Started in FeatureCAM 1

Getting started in FeatureCAM ............................................................................ 1
  Starting FeatureCAM for the first time ............................................................ 2
  Creating a new file ............................................................................................ 4
  Screen layout .................................................................................................... 5
  Getting help ...................................................................................................... 6
Introduction to 2.5D milling .................................................................................... 9
  Defining the Stock ............................................................................................. 9
  Creating the features ........................................................................................ 10
  Viewing the part ................................................................................................ 13
  Simulating the toolpaths .................................................................................. 14
  Order of manufacturing operations .................................................................. 15
  Part documentation .......................................................................................... 19
  Controlling the strategies .................................................................................. 20
  Generating NC code .......................................................................................... 21
  Tool mapping .................................................................................................... 22
  Changing the post processor .............................................................................. 22
  Saving the NC code ........................................................................................... 23
Introduction to turning .......................................................................................... 24
  Defining the stock ............................................................................................. 24
  Preparatory steps ............................................................................................... 26
  Defining the geometry ....................................................................................... 27
  Creating the features ........................................................................................ 30
  Viewing the part ................................................................................................ 35
  Simulating the toolpaths .................................................................................. 37
  Order of manufacturing operations .................................................................. 38
  Part documentation (Turning) .......................................................................... 40
  Generating NC code (Turning) ......................................................................... 41
  Changing the post processor .............................................................................. 41
  Saving the NC code ........................................................................................... 42
Introduction to turn/mill ................................................................. 43
Preparatory steps ........................................................................... 44
Defining the geometry .................................................................. 44
Creating the features .................................................................... 47
Viewing the part ............................................................................ 48
Creating three radial holes on the face ......................................... 49
Engraving the face ......................................................................... 50
Creating three slots ....................................................................... 53
Simulating the toolpaths ............................................................... 54
Introduction to 3D milling .............................................................. 55
Defining the Stock ......................................................................... 56
Defining the geometry .................................................................... 56
Creating the bottle surface ............................................................ 60
Viewing the part ............................................................................ 61
Creating a surface milling feature ................................................ 63
Simulating the toolpaths ............................................................... 66
Introduction to wire EDM ............................................................... 67
Defining the stock ......................................................................... 67
Creating the profile ....................................................................... 68
Creating a wire EDM feature ........................................................ 69
Simulating the wire EDM toolpath ................................................. 71
Generating NC code ....................................................................... 73
Adding a taper angle ...................................................................... 74
Introduction to Feature Recognition .............................................. 77
Automatic Feature Recognition example ...................................... 78
Interactive Feature Recognition example ..................................... 84

What's New in FeatureCAM

What's new in FeatureCAM 2016 R2 .............................................. 2
User interface ................................................................................ 5
Importing ....................................................................................... 9
Milling ......................................................................................... 12
Turning ......................................................................................... 18
Machine Simulation ....................................................................... 21
Tombstone machining .................................................................... 25
Add-ins and extensions .................................................................. 28
XBUILD ....................................................................................... 38
Machine Design .......................................................................... 47

What's new in FeatureCAM 2016 R1 .............................................. 50
User Interface and work-flow ....................................................... 53
Importing ....................................................................................... 60
Milling ......................................................................................... 63
Turning ......................................................................................... 73
Add-ins and extensions .................................................................. 78
XBUILD ....................................................................................... 86

What's new in FeatureCAM 2015 R3 .............................................. 94
User Interface ............................................................................... 96
Importing ..................................................................................... 104
Milling ....................................................................................... 107
Contents

Customize Manufacturing

NC Code

Toolpaths

Features

Feature Recognition (REC/3D MX)

Solids (SOLID)

Surfaces

Curves

Getting the file to the machine

Tool Mapping

Results window

Simulating toolpaths

Creating NC code

Feed Optimization

Curves to geometry

Invalid solids

Transforming a solid

Verifying that a solid is valid

Fixing bad surface faces

Selecting and deleting solids

Unattached design features

Part View for solids

Surface wizard

Surface design tips

Surface editing tips

From curves

Primitive surface

From one surface

From multiple surfaces

Comparison of surface and solid modeling

Generating a solid

Features that can be recognized

Rerecognition wizard

Features

New Feature wizard

Specific features

Groups and Patterns

Editing features

Feeds and speeds

Toolpaths

Simulating toolpaths

Results window

Creating NC code

Feed Optimization

Tool Mapping

Getting the file to the machine

Customize Manufacturing
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machining attributes</td>
<td>1591</td>
</tr>
<tr>
<td>Tooling</td>
<td>1744</td>
</tr>
<tr>
<td>Feeds/Speeds and Cutting Data Tables</td>
<td>1847</td>
</tr>
<tr>
<td>Post Options</td>
<td>1857</td>
</tr>
<tr>
<td>Multiple fixture documents (2.5D &amp; 3D)</td>
<td>1872</td>
</tr>
<tr>
<td>Creating a multiple fixture part</td>
<td>1872</td>
</tr>
<tr>
<td>Multiple Fixtures dialog</td>
<td>1873</td>
</tr>
<tr>
<td>Configuration</td>
<td>1878</td>
</tr>
<tr>
<td>Layout</td>
<td>1879</td>
</tr>
<tr>
<td>Individual blocks</td>
<td>1880</td>
</tr>
<tr>
<td>Single block</td>
<td>1880</td>
</tr>
<tr>
<td>Nested</td>
<td>1881</td>
</tr>
<tr>
<td>Stock</td>
<td>1882</td>
</tr>
<tr>
<td>Completing the multiple fixture part</td>
<td>1883</td>
</tr>
<tr>
<td>Editing a multiple fixture document</td>
<td>1883</td>
</tr>
<tr>
<td>Saving and opening multiple fixture parts</td>
<td>1884</td>
</tr>
<tr>
<td>Tombstone machining (TOMB)</td>
<td>1885</td>
</tr>
<tr>
<td>Overview of tombstone machining</td>
<td>1885</td>
</tr>
<tr>
<td>Creating a tombstone machined part</td>
<td>1886</td>
</tr>
<tr>
<td>Specifying tombstone dimensions</td>
<td>1887</td>
</tr>
<tr>
<td>Tombstone global fixtures</td>
<td>1889</td>
</tr>
<tr>
<td>Tombstone Process Plan dialog</td>
<td>1891</td>
</tr>
<tr>
<td>Adding a part to the tombstone</td>
<td>1893</td>
</tr>
<tr>
<td>Machine Simulation</td>
<td>1895</td>
</tr>
<tr>
<td>Using Machine Simulation</td>
<td>1895</td>
</tr>
<tr>
<td>Creating a Machine Design document</td>
<td>1899</td>
</tr>
<tr>
<td>Machine Design tutorial: Simple 3-axis mill</td>
<td>1938</td>
</tr>
<tr>
<td>Machine Design handbook</td>
<td>1945</td>
</tr>
</tbody>
</table>

**Index**

1965
Welcome to the FeatureCAM help. Use the following sections to learn how to use FeatureCAM:

- **Introduction** — learn how to use the help window (see page 1), get technical support (see page 4), and see the FeatureCAM product line (see page 10).
- **Getting Started in FeatureCAM** (see page 1) — helps you learn how to use FeatureCAM.
- **What's New in FeatureCAM** (see page 1) — shows details of the latest features.
- **Reference Help** (see page 245) — a comprehensive user guide for FeatureCAM.
- **XBUILD** — shows you how to use XBUILD (C:\Program Files\Delcam\FeatureCAM\Program\Help\xbuild.chm).

The documentation for XBUILD, FeatureCAM's post processor, is available by selecting **Help > Contents** from the menu in XBUILD.

---

**Using the Help window**

The **Help** window contains information about FeatureCAM and how to use it:

- The left panel lists the topics available in the help. It contains three tabs, which enable you to search for information using a variety of methods.
- The right panel displays the information in the topic you select.

You can display the window using the **Help** menu or by pressing the **F1** key.
Contents tab
The Contents tab lists the help topics arranged by subject. Use it when you want to understand the structure of the application, or when you want to read around a topic and look for related information:

- To display the information for a topic, click its entry in the tree. The Book 📚 icon indicates the topic contains subsections; the Page 📝 icon indicates the topic has no subsections.
- To list the sections within a book topic, click the icon or its title.

Index tab
The Index tab lists names and subjects in alphabetical order. Use it when you want to look for information, but are not sure of its name or its location in the help:

- To find an index entry, type a subject in the box at the top of the index, or use the scrollbar to navigate up and down the list.
- To display the topics associated with an entry, double-click its entry in the list.
- To locate the selected topic in the Contents tab, click Display.

Search tab
The Search tab enables you to look for words or phrases contained in the help topics:

- To search for a word, type it in the search box, and click List Topics.

  By default, the search looks for common suffixes as well as the word itself. To search for the exact word only, deselect the Match similar words check box.

- To search for a phrase, type the text, enclosed in double quotation marks, in the search box, and then click List Topics.

  If you do not enclose the text in quotation marks, the search lists every occurrence of each word.

- To search for words or phrases using logical operators, enter the text in the search field; click ✤; select the operator you want to use; and then click List Topics.

- To restrict the search to the currently listed topics, select the Search previous results check box.

- To restrict the search to the titles of the help topics, select the Search titles only check box.

- To locate the selected topic in the Contents tab, click Display.
Reference help PDF

The FeatureCAM Reference help is available as a PDF file which enables you to print it to use away from your computer.

Select Help > Reference (PDF) to display the Reference help PDF.

This is available only in English.
Technical support

Technical support is available through:

- Your FeatureCAM reseller
- The FeatureCAM website (http://www.delcam.com/software/featurecam/#)

Installing your PAF license

To install your PAF license:

1. Install FeatureCAM and any Solid Plugins you are using.
2. Ensure your dongle is plugged into one of the PC's USB ports.
3. If the PC that you have installed FeatureCAM on has internet access, see Installing your PAF license with internet access (see page 4).
   If the PC that you have installed FeatureCAM on does not have internet access, see Installing your PAF license without internet access (see page 6).

   For any problems, see PAF Troubleshooting (see page 7).

Installing your PAF license with internet access

1. Open FeatureCAM.
2. If the New Part Document Wizard is displayed, click Cancel to close it.
3. Select the Help > Download License (PAF file) Updates menu option.
   The PAF file is downloaded. This process usually takes 10-20 seconds using a high-speed connection.
   When finished downloading, a message is displayed telling you the updated PAF file has been successfully updated.

   If FeatureCAM is still in Evaluation Mode, see PAF Troubleshooting (see page 7).

Installing your PAF license using the PAFWizard

1. Open FeatureCAM.
2 If the **New Part Document Wizard** is displayed, click **Cancel** to close it.

3 Select the **File > Evaluation Options** menu option. The **Evaluation Options** dialog is displayed.

4 In the **Evaluation Options** dialog, click **Diagnostics**. The **Dongle Diagnostics** dialog is displayed:

5 In the **Dongle Diagnostics** dialog, click **Run PAFWizard**. The **PAFWizard** is displayed.

6 In the **PAFWizard**, select the **Tools > Check for PAF updates** menu option. The PAF file is downloaded. This process usually takes 10-20 seconds using a high-speed connection.

   When finished downloading, a message is displayed telling you the updated PAF file has been successfully installed.

7 Close the PAFWizard and restart FeatureCAM. You can now use FeatureCAM in full access mode.

   *If FeatureCAM is still in Evaluation Mode, see PAF Troubleshooting (see page 7).*
Installing your PAF license without internet access

Your company should have received an email from Delcam containing your Product Authorization File (PAF).

We ship the software before sending the PAF file to you. It is very possible that you will receive the upgrade package before you receive the email containing the PAF file.

If you do not have that email, please wait 72 hours before installing the software or contacting support.

The email containing the PAF file could be sent to your supervisor, IT department, or purchasing department depending on the email address we have on file for your company.

If you need us to resend the PAF, or if you need us to send it to a different email address, please contact your support representative with your name, email address, company name, and the dongle number that you need the PAF for.

1. Save the PAF file included in your email to the desktop on your PC.
2. Open FeatureCAM.
3. If the New Part Document Wizard is displayed, click Cancel to close it.
4. Select the File > Evaluation Options menu option. The Evaluation Options dialog is displayed.
5. In the Evaluation Options dialog, click Diagnostics. The Dongle Diagnostics dialog is displayed:

6. In the Dongle Diagnostics dialog, click Open PAF Directory.
7. If you have any existing *.paf, *.flx, or *.lic files in this directory, please delete them or rename them to dcam.old.
8. Drag the PAF file from the desktop into this directory.
9. Restart FeatureCAM.
If FeatureCAM is still in Evaluation Mode, see PAF Troubleshooting (see page 7).

**PAF Troubleshooting**

- Are you evaluating items that you do not have a license for?
  
  a. Inside FeatureCAM, select File > Evaluation Options from the menu.
  
  You must close all files and windows in FeatureCAM before you can access Evaluation Options.
  
  b. Deselect any items that you don't have a license for and click Apply.

- Did you edit the PAF file in any way?
  
  If you open the PAF file in any program other than Notepad or WordPad, the file can become corrupt. If this happens, delete the file and re-save the original file that you received by email.

- Is the PAF file being recognized?
  
  The file extension must be *.paf, although the name of the file may be different. It is possible that an email program or something else has created or hidden an extension of *.txt. You can check this by looking at the Type of file. To do this, right-click on the PAF file and select Properties. The file Properties dialog displays. The Type of file should be Delcam PAF licence file or PAF file.

- Is the dongle attached to the computer?
  
  In order for FeatureCAM to function, the dongle must be attached to the computer.

- Do you have the latest Sentinel drivers installed?
  
  a. In FeatureCAM, select File > Evaluation Options from the menu.
  
  The Evaluation Options dialog is displayed.
  
  b. Click Diagnostics.
  
  The Dongle Diagnostics dialog is displayed.
  
  c. Check the value for Dongle. If it reads None, you must update the Sentinel drivers.
Click **Open Sentinel Driver** directory.

The directory opens and contains the program file **Sentinel Protection Installer 7.4.0.exe**.

Run this program.

Restart your computer.

- Do you have more than one PAF file on your computer?
  
  Most Delcam software reads any file with a *.paf extension, so if you want to keep an old *.paf file, rename the extension to something other than *.paf (such as dcam.old).

If you have followed the above instructions, and you still receive an error stating "FeatureCAM: ", make a note of the error along with the message and contact your FeatureCAM support representative.
**Silent install**

You can perform a silent install of FeatureCAM using the command prompt.

To perform a silent install, enter this in the command prompt:

```
"FeatureCAM.exe" /S /USERSHORTCUT=$shortcut_name /D=$install_location /LANGUAGE=$language
```

- **FeatureCAM.exe** — The name of the installer. If you are installing from the DVD the installer is called setup.exe.
- /S — This specifies the install is a silent install.
- **$shortcut_name** — The name of the FeatureCAM shortcut that is created on the Desktop. For example "FeatureCAM V22".
- **$install_location** — The complete path where FeatureCAM should be installed. For example C:\Program Files\Delcam\FeatureCAM\V22.

If no install location is specified, it is installed in the default location, C:\Program Files\Delcam\FeatureCAM.

Do not use quotes in the pathname.

- **$language** — The three letter acronym to specify the install language of FeatureCAM. For example, for a Spanish install enter esp. If no language is specified, or an incorrect acronym is used, FeatureCAM is installed in English.

**Catia add-in silent install**

To perform a silent install of the Catia add-in, enter this in the command prompt:

```
"FeatureCAMCatiaV5.exe" /S /D=$install_location
```

- **FeatureCAMCatiaV5.exe** — This is the name of the Catia plugin installer. If you are installing from the DVD the installer is called setup.exe.
- /S — This specifies the install is a silent install.
- **$install_location** — This is the complete path where FeatureCAM is installed.
FeatureCAM product family

FeatureCAM comprises several modules, which enable you to perform different functions. This help file documents the entire product family, so, to differentiate between the features specific to individual products, the titles of help topic titles are followed by product codes in parentheses. The codes are:

(25D) — requires a minimum of the 2.5D Milling product.
(3D LITE) — Requires a minimum of the 3D Lite product. The functionality is also available in the 3D MX and 3D HSM products. 3D Lite is an entry-level 3D product, which enables you to mill only one surface per feature, but you can create multiple features. The strategies available in 3D Lite are Z-level rough, Parallel rough, Parallel finish, Isoline, and 2D spiral.
(3D MX) — Requires a minimum of the 3D MX product. The functionality is also available in the 3D HSM product. 3D MX is a mid-level 3D product that enables you mill multiple surfaces. It has the same strategies as 3D Lite, plus Z-level finish, Radial finish, Flowline finish, Four-axis finish, Horizontal + vertical, Between curves, and Swarf milling.
(3D HSM) — Requires a minimum of the 3D HSM product. 3D HSM is a high speed machining product with the same strategies as 3D MX, plus Pencil, Plunge roughing, Remachine, Steep and Shallow, and Spiral 3D.
(REC) — Requires the FeatureRECOGNITION product.
(MSIM) — Requires the Machine Simulation product.
(5AP) — Requires the 5-axis Positioning product.
(5AS) — Requires the 5-axis Simultaneous product.
(TURN) — Requires the Turning product.
(TURNMILL) — Requires the Turn/Mill product.
(WIRE) — Requires the Wire EDM product.
(TOMB) — Requires the Tombstone product.
(SOLID) — Requires the Solid Modeling product.
(MTT) — Requires the Advanced Turn/Mill (MTT) (Multi-turret turning) product.
(SND) — Requires the shared Network Database product.

If no code follows the topic title, the functionality is available in all FeatureCAM modules. However, because the help contains many cross-topic links, you may cross module boundaries while navigating though it.
To see which products are included in your current license, select the Help > About FeatureCAM menu option. To evaluate products you have not purchased, see Evaluation Options (see page 11).

### 3D product differences

The main differences between the three 3D products are:

<table>
<thead>
<tr>
<th>3D Lite</th>
<th>3D MX</th>
<th>3D HSM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single surface</td>
<td>Everything in 3D Lite, plus:</td>
<td>Everything in 3D MX, plus:</td>
</tr>
<tr>
<td>Z-level rough</td>
<td>- Multiple surfaces</td>
<td>- Plunge roughing</td>
</tr>
<tr>
<td>Parallel rough</td>
<td>- Feature Recognition</td>
<td>- Pencil</td>
</tr>
<tr>
<td>Parallel finish</td>
<td>- Z-level finish</td>
<td>- Remachine</td>
</tr>
<tr>
<td>Isoline</td>
<td>- Radial</td>
<td>- Steep and shallow</td>
</tr>
<tr>
<td>2D spiral</td>
<td>- Flowline</td>
<td>- 3D spiral</td>
</tr>
</tbody>
</table>

You need **3D MX** or **3D HSM** to use 5-axis **Simultaneous**.

### Evaluating other FeatureCAM components

FeatureCAM contains a variety of modules. You can evaluate the modules you have not purchased. To evaluate other modules:

1. Close all FeatureCAM documents.
2 Click **File > Evaluation Options** from the menu. The **Evaluation Options** dialog is displayed.

![Evaluation Options dialog](image)

3 Select the **Manually select product components** option.

4 Select the boxes next to the product components you want to try.

5 Click **OK**.

You can now access the new modules, but you cannot post code or save a file. Your copy of FeatureCAM stays in evaluation mode until you deselect the product components you have not licensed.

![Tip icon](image) **Select Activate all available product components to automatically select the components you have licensed.**
Getting Started in FeatureCAM

Learn how to use FeatureCAM in the topics that follow.
Getting started in FeatureCAM

FeatureCAM is a CAD/CAM software suite that automates machining and minimizes programming times for parts on mills, lathes, and wire EDM.

The functionality available to you depends on which components you have licensed.

FeatureCAM generates toolpaths based on the features of the part, and automatically selects appropriate tools, determines roughing and finishing passes, and calculates feeds and speeds.

This Getting Started guide provides step-by-step instructions that highlight some of the features of this versatile software. FeatureCAM is very easy to use, and does not require any specialist computing knowledge.
Starting FeatureCAM for the first time

1. From the **Start** menu, select **All Programs > FeatureCAM > FeatureCAM**.
   
   ![You can also start the program by double-clicking the FeatureCAM icon on your desktop.](image)

   The first time you start FeatureCAM, it runs a program to create the tools and materials database.

2. Click **OK** to begin the configuration. This displays the **Tool and Material Setup** dialog.

   ![Tool and Material Setup dialog](image)

3. To create a local database, select **On my local computer**.
   
   If you want multiple computers to share the same tool and material information:
   
   a. Select **On another computer that I will access over a network**.
   
   b. Click the **Browse** button, and use the **Database Location** dialog to select the folder where the database is located.

   ![You need to create a database folder on your network first, and then copy an empty MDB database from the FeatureCAM CD-ROM to this location. The default database is created by MS Access, and should be accessed using the MS Jet database driver. You may use a different database type, such as MS SQL Server. For more information, refer to the online help.](image)

   ![You need to have the **Shared Network Database** module to use this option.](image)

4. Click **Next**.
5 Choose the tools to load:

- **Inch** - loads only the inch tools.
- **Metric** - loads only the metric tools.
- **Both** - loads both inch and metric tools.

6 Click **Next**.

7 If you chose to load both tool types, you are asked which tool type you use more often. Select **Inch** or **Metric**, and click **Next**.

8 Click **Finish** to initialize the database.

*The tools database specifies the set of tools used by FeatureCAM to perform manufacturing operations. For best results, use the Tool Manager (available from the Manufacturing menu) to customize the database to reflect the tools in your shop.*
Creating a new file

Starting FeatureCAM displays the New Part Document wizard.

1. If the New Part Document wizard is not displayed, select the File > New menu option.
3. Select a Milling Setup.
4. Select the Unit of Measure (Inch or Millimeter).

   You can change the default dimension units later, by selecting Options > File Options from the menu.
5. Click Finish.
Screen layout

The FeatureCAM interface contains a number of standard Windows elements, such as toolbars, dialogs, context menus, and wizards.

1. **Title** bar displays the type of part setup in round brackets, in this case (Milling), and the name of your part file in square brackets, in this case [FM1]. When you have any unsaved changes in your part file, an asterisk (*) is displayed next to its name.

2. **Menu** bar provides access to a number of menus. Selecting a menu, such as View, opens a list of associated commands and sub-menus. Sub-menus are indicated by a small arrow to the right of the text. For example, selecting View > Principal Views displays a list of commonly used views.

3. **Toolbars** provide quick access to the most commonly used commands in FeatureCAM.

4. The graphics window is the main working area.

5. **Toolbox** window with the Steps panel, Part View panel, and Browser.
The **Steps** panel contains an ordered list of steps for creating part programs. Each step is a wizard that presents a series of dialogs for each process. They are listed in the order in which you should use them during the process of creating a part program.

The **Part View** panel provides a hierarchical view of the part.

The **Browser** contains information on the latest features available in FeatureCAM, including example files that you can load straight into FeatureCAM.

- **Results** window contains the automatically generated documentation including tooling lists, setup sheets, and the NC part programs. Selecting one of the tabs at the bottom of the window changes the content of this window.

- **Assistance** bar displays help for the current command.

- **Feature/Geometry Edit** bar lets you select and edit a feature, or enter the point locations and parameters for geometry creation.

- **Status** bar shows your current drawing units, tool crib, and post processor settings, as well as your keyboard status and information about the simulation when you run one.

---

### Getting help

FeatureCAM provides a variety of ways for you to get help. Context-sensitive help displays help for the current task. You can also refer to the numerous examples in the **Examples** folder, located in the FeatureCAM root directory. Finally, if you cannot find an answer to your question, you can visit our website or contact our technical support.

#### Online help

The online help documentation is your primary source for in-depth technical information about FeatureCAM. It covers all FeatureCAM modules, and is accessed from the **Help** menu, or by clicking 💻 on the toolbar.

#### Reference help PDF

The help file is available as a PDF. This is the same as the online help, but it enables you to print it and use it away from your computer.

Select **Help > Reference (PDF)** to display the Reference help PDF.

#### Context-sensitive help

You can use one of the following methods to get help relevant to the current task:
Some commands automatically display the help in the Assistance bar.

Hovering the mouse over a toolbar icon displays a brief description.

Pressing F1 displays the relevant help page.

Most FeatureCAM dialogs have the Help button. Clicking it displays the relevant help page.

Click the Context Help button on the toolbar. When the cursor has changed to a question mark (??), click a menu item, button or dialog for more information.

Links
You can find FeatureCAM information from the Help menu:

- Help > FeatureCAM on the Web for product news, online support, training information, discussion forum, and mailing list.
- Help > Check for a FeatureCAM Patch for product updates.

This displays the Delcam Customer Download Center in your internet browser and checks for an update patch for FeatureCAM.

You can only use a patch to update within a major version of FeatureCAM. For example, you cannot upgrade from version 19 to version 20, but you can upgrade from version 20 to a later version of 20.

You can only use a patch to update official releases, not experimental versions, service packs or enhancement releases. To update any of these, you need to download the full release from updates.delcam.com, which you can access by selecting the Help > Visit the Delcam Customer Download Center menu option.

- Help > FeatureCAM API Help for documentation on the FeatureCAM API (Application Programming Interface).

Technical Support
If you have any questions related to FeatureCAM, which you cannot find an answer to in the documentation, you can contact the Delcam technical support service. Email support@featurecam.com, describing your problem as precisely as possible. This support is free for the first 60 days after your initial purchase and 30 days after the purchase of an upgrade.
Introduction to 2.5D milling

This example shows you how to create some simple 2.5D features, generate toolpaths and output the toolpaths used to machine the part.

To use the 2.5D milling example, start FeatureCAM (see page 2), create a new file (see page 4), then follow these steps:

1. Create the stock (see page 9).
2. Create the features (see page 10).
3. View the part (see page 13).
4. Simulate the toolpaths (see page 14).
5. Create the part documentation (see page 19).
6. Control the automation (see page 20).
7. Change the post processor (see page 22).
8. Generate NC code (see page 21).
9. Tool mapping (see page 22).
10. Save the NC code (see page 23).

Defining the Stock

The stock is the initial material from which you cut your part. When you create a new part, the Dimensions page of the Stock wizard is displayed. It enables you to determine the shape and dimensions for the stock, the stock material, part program zero, and the coordinate system for modeling.

1. On the Dimensions page of the Stock wizard:

   a. Enter a Thickness of 1 (25 mm).
b  Enter a Width of 4 (100 mm).
c  Enter a Length of 5 (120 mm).
d  Click Finish.

2  Click OK to accept the default values of the Stock wizard.

Creating the features

This step shows how to create Hole and Rectangular Pocket features.

1  Create a Hole feature.

a  Click the Features step in the Steps panel.
b  In the New Feature wizard, select Hole in the From Dimensions section, and click Next.
c  Enter a Diameter of 0.5 (12 mm), and click Next.
d  Enter a hole center location of X 1.0 (25 mm) and Y 1.0 (25 mm), and click Next.

This displays the Strategies page. This page controls the types of operations used to cut the feature. The default operations for a Hole feature are to spot drill and then drill the hole. If the Hole has a chamfer, the default is to cut the chamfer with the spot drill operation.

e  Accept the default strategy settings by clicking Next.
The Operations page shows a summary of the operations to cut the feature, the automatically selected tools, and the feeds and speeds.

The following operations will be created to machine this Hole feature:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Tool</th>
<th>Feed</th>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>hole</td>
<td>spot drill</td>
<td>0.0075</td>
<td>1582</td>
</tr>
<tr>
<td></td>
<td>drill</td>
<td>0.0075</td>
<td>1589</td>
</tr>
</tbody>
</table>

Click 'Finish' to create the feature. Click 'Next' to change tools and/or feeds and speeds for each operation.

f From the Finish menu button select the Finish option.

2 Create a Rectangular Pocket feature.

a Click the Features step in the Steps panel.

b In the New Feature wizard, in the From Dimensions section, select Rectangular Pocket, and click Next.

c Accept the default dimensions by clicking Next.

d Enter a pocket location of X 0.75 (15 mm), and Y 2.5 (60 mm), and Z 0 (0 mm), and click Next.
The **Strategies** page shows that roughing and finishing operations are created.

![Strategies page](image)

1. Click the **Finish** button.

2. Use the **Features** step to create a second Hole with a diameter of **0.5 (12 mm)**, located at **X=4 (95 mm)** and **Y=3 (75 mm)**.

3. Use the **Features** step to create another **Rectangular Pocket** the same dimensions as the first, but positioned at **X=2.5 (55 mm)**, **Y=0.5 (15 mm)**.

4. Select **File > Save**, and save the part as **milling.fm**.
Viewing the part

To look at the part in a different orientation you can select one of the standard predefined views. These options are available from the Standard toolbar:

1. To change the view to an isometric view, click the **Isometric** button on the **Standard** toolbar.

2. To change the view to a front view, from the Principle View menu button, click the **Front** button.

3. Click the **Isometric** button to return to the isometric view.
Simulating the toolpaths

Now you have created the features, FeatureCAM automatically:

- Selects the most appropriate tools and operations;
- Recommends machining strategies;
- Calculates speeds and feeds;
- Generates toolpaths and creates the NC code.

To view the simulated toolpath:

1. Click the Toolpaths step in the Steps panel to display the Simulation toolbar.

2. On the Simulation toolbar, select the 3D Simulation option, and then click Play to start the simulation.

If the Automatic Ordering Options dialog displays, click OK to close it. This accepts the default ordering options.

This displays a solid 3D rendering of the cutting process.

*If all tools are displayed in gray in the simulation, select Options > Simulation > General from the menu, and select the Tool Colors option, then click OK to close the dialog. This displays tools in different colors so you can see which features are machined by each tool.*
Click the Play button on the Simulation toolbar to see the changes.

3. Click the Play to Next Operation button. This displays the spot drill operation.

4. Repeat step 3 to view each subsequent operation until you complete the simulation.

5. Click Eject. This removes the Simulation toolbar.

Order of manufacturing operations

The Op List tab in the Results window shows all of the operations needed to machine the features. A yellow warning sign next to an operation indicates a potential problem with that operation. In this case, if you see any warnings ignore them.
This section looks at:

- The automatic ordering options. (see page 16)
- The manual ordering options. (see page 18)

**Automatic ordering operations**

You can control the automatic ordering of operations by using either rules or operation templates. The turning tutorial looks at operation templates (see page 38).

1. Select the **Automatic Ordering** option on the **Op List** tab. This ensures the automatic ordering rules are applied to the operations.

2. Change the automatic ordering to group together the operations which use the same tool.

   a. Click the **Ordering Options** button.
   b. In the **Automatic Ordering Options** dialog, select **Minimize tool changes**, deselect everything else, and click **OK**.

3. Simulate the part.

   a. Select the **Toolpaths** step from the **Steps** panel. This displays the **Simulation** toolbar.
   b. Click the **3D Simulation** button.
   c. Click the **Play** button.

      If the **Automatic Ordering Options** dialog displays, click **OK** to close it. Notice that the simulation first performs all the spot-drills, then the drills, and then the rough and finish milling for the pockets.
   d. Click the **Stop** button when simulation is complete to exit the simulation mode.

4. Change the automatic ordering to move the finish operations to the end of the list.
a Click the **Ordering Options** button.

b In the **Automatic Ordering Options** dialog, select **Do finish cuts last**, deselect everything else, and click **OK**.

This changes the order of operations in the **Operation List**.

5 Simulate the part.

a In the **Simulation** toolbar, click **Play**.

The finish cuts for the two pockets are now cut last.

b Click **Stop** when simulation is complete.

6 Change the automatic ordering to match the order of the features in the **Part View** panel.

a Click the **Ordering Options** button.

b Deselect everything, and click **OK**.

c Open the **Part View** panel by clicking on .

The tree view contains all the setups and features you have created.

d Click the **rect_pock2** item in the **Setup1** node, and drag it up above **hole2**.

7 Simulate the part.

a In the **Simulation** toolbar, click **Play**.

The second pocket is cut as the second feature.

b Click **Stop**.
Manual ordering options

The automatic ordering of operations determined the order by a set of rules. You can also specify an exact ordering of operations manually.

1. Select the **Manual Ordering** option on the **Op List** tab.

2. In the **Fixed Operation Ordering** dialog, select **Do Not Show This Warning Again**, and click **OK**.

3. Select the **spotdrill** operation for **hole2** from the list, and drag it up ahead of the **drill** operation for **hole1**.

4. Simulate the part.
   
   a. In the **Simulation** toolbar, click **Play**. The simulation performs the operations in the new order.
   
   b. Click **Stop** when simulation is complete.

5. Selecting **Automatic Ordering** to return to automatic ordering.

6. Click **OK** to close the **Automatic Operation Ordering** dialog.

   *If you want to erase the simulation and remove the **Simulation** toolbar, click **Eject**.*
Part documentation

As well as simulating the part manufacture, the simulation generates tool and operation lists. The tools selected are based on your tool database. You can print this information to use as an operator's checklist, using the File > Print menu option.

1 Click the Details tab in the Results window to display the Manufacturing Operations sheet.

2 Select the Tool List option at the top of the Details tab to show the Manufacturing Tool Detail sheet. It contains all of the tools used to create the part based on the tool crib you selected.
Controlling the strategies

You can control the strategies used to manufacture the part from the properties dialog.

1. Open the Part View panel.
2. Right-click on hole1 under the Setup1 node, and select the Properties option.

3. In the Properties dialog:
   a. Select the Strategy tab
   b. Deselect the Spot Drill option
   c. Click OK.

4. Select the Toolpaths step from the Steps panel.

5. In the Simulation toolbar, click the 3D Simulation button, and then click Play to start the simulation.
There is no spot drilling for the first hole. If you look through the operations list, there is only one spotdrill operation listed. FeatureCAM optimizes the part manufacturing process, but you control the level of automatic optimization.

6 Click Eject  . This removes the Simulation toolbar.

Generating NC code

FeatureCAM generates the NC code to manufacture parts on a CNC machine. You can generate NC code after you have simulated the part, and therefore calculated the toolpaths.

1 Select the NC Code step from the Steps panel. This displays the NC Code dialog.

2 Click the NC Program button to generate the code.

```
G0G70G94G75G80
'HOLE1' TOOL NUMBER 1
'SPINDLE RPM 2182'
N35G00X Y0 T1M6
N40S5182
N45X0 Y0
N50Z21.1M8
N55G60120.504F14.3
N60X0
N65G60
N70Z1.0
'HOLE1'
TOOL NUMBER 2
'SPINDLE RPM 1909'
N90G00X Y0 T2M6
N95G94F14.505S1909
N100X0 Y0
N105Z20.1
N110G03Z21.250220.62025F14.3
N115X0
N120G80
N125Z1.0
N130X40Y30Z20.1
N135G63Z21.250220.62025F14.3
N140X4.0
N145G80
N150Z2.0
'RECT_FACE2'
TOOL NUMBER 3
```
**Tool mapping**

To change the location of the tools in the tool changer:

1. Select the NC Code step from the Steps panel. This displays the NC Code dialog.

2. Click the Tool Mapping button. This displays the Tool Mapping showing the current tool order.

3. To move the center drill to the 5th position in the tool changer:
   a. Select Center_5 in the table.
   b. Enter a Tool Number of 5 in the Slots frame.
   c. Click Set.

   *You cannot change the number in the table.*

4. Click OK to save the changes, and close the Tool Mapping dialog.

**Changing the post processor**

To change the post processor:

1. Select Manufacturing > Post Process from the menu. This displays the Post Options dialog.

2. Click Browse to view available post processors.

   The default folder for posts is `C:\Program Files\Delcam\Examples\Posts`.

3. Select your post processor and click Open.
The new post processor is displayed in the **CNC File** field.

4. Click **OK** to exit the **Post Options** dialog and use the new post processor; click **Cancel** to exit the dialog and keep the original post processor.

5. Select the **Toolpaths** step from the **Steps** panel.

6. Run a simulation of the part to regenerate the NC code.

**Saving the NC code**

To save an NC program:

1. Select the **NC Code** step from the **Steps** panel. This displays the **NC Code** dialog.

2. Click the **Save NC** button in the **NC Code** dialog.

3. In the **Save NC** dialog, accept the default filename and folder, and click **OK**.
Introduction to turning

This tutorial shows you how to create a simple turning part, generate toolpaths and output the toolpaths used to machine the part.

To use the turn/mill example, start FeatureCAM (see page 2), create a new file (see page 4) with a Type of Turn/Mill Setup or Turning Setup, then follow these steps:

1  Create the stock (see page 24).
2  Preparatory steps (see page 26).
3  Define the geometry (see page 27).
4  Create the features (see page 30).
5  View the part (see page 35).
6  Simulate the toolpaths (see page 37).
7  Order the manufacturing operations (see page 38).
8  Create part documentation (see page 40).
9  Change the post processor (see page 22).
10 Generate NC code (see page 41).
11 Save the NC code (see page 23).

Defining the stock

The stock is the initial material from which you cut your part. By default, the Stock wizard (Dimensions page) opens on the screen as soon as you create a new part. It enables you to set the shape and dimensions for the stock, the stock material, part program zero, and the coordinate system for modeling.
1 On the **Dimensions** page of the **Stock** wizard:

![Dimensions page](image)

- Enter an **OD** (outside diameter) of **4** (100 mm).
- Enter a **Length** of **5** (125 mm).
- Enter an **ID** (inside diameter) of **0** (0 mm).
- From the **Finish** menu button select the **Finish and Edit Properties** option.

This displays the **Stock Properties** dialog.

2 In the **Stock Properties** dialog enter a **Z** of **0.0625** (1.5 mm), and click **OK**.

![Stock Properties dialog](image)
Preparatory steps

The preparatory steps determine the coordinate system and tool crib.

1. Select Options > Turning Input Modes > 3D (XYZ) from the menu to enable you to enter coordinates as X, Y, and Z values.

2. Select Manufacturing > Set Tool Crib from the menu to display the Select Active Tool Crib dialog.

3. Select the tools option from the Crib List, and click OK.

4. To display the complete part:
   a. Click the Rotate View menu button to display the View menu:
   b. Click Center All.

![Display View Menu](image1)

![Center All](image2)
Defining the geometry

This shows you how to design your part.

1 Draw two lines:

a Click the Geometry step in the Steps panel. This displays the Geometry Constructors dialog.

b Select the Create more than 1 option, and click the Line from two points button. This displays the Feature/Geometry Edit bar.

c Create two lines that define the outer profile, in the Feature/Geometry Edit bar:

For point 1, enter an XYZ 1 of X 2 (50 mm), Y 0, Z -3.5 (-88 mm).

For point 2, enter an XYZ 2 of X 1 (25 mm), Y 0, Z -3.5 (-88 mm).
Press **Enter**. This draws a line in the graphics window.

![Diagram of a line drawn in a graphics window]

**d** Create a second line:
For point 1 enter an **XYZ** of **X** 1 (25 mm), **Y** 0, **Z** -3.5 (-88 mm).
For point 2 enter an **XYZ** of **X** 1 (25 mm), **Y** 0, **Z** 0.
Press **Enter** to create a second line.

![Diagram of a second line drawn in a graphics window]

2 **Create a chamfer to trim your lines.**

**a** Click the **Geometry** step in the **Steps** panel.

**b** In the **Geometry Constructors** dialog, in the list of **Fillet** options click the **Chamfer** button.

**c** In the **Feature/Geometry Edit** bar, enter:
A **width** of **0.25** (6 mm).
A **height** of **0.25** (6 mm).

**d** Position your mouse pointer close to the chamfer location. The chamfer snaps into place.
e Click to place the chamfer on your drawing. The chamfer automatically trims your lines.

3 To turn the part you need to convert these three individual lines into a single curve (chain the curve).

a Select the **Curves** step from the **Steps** panel.

b In the **Curves Creation** dialog, select the **Pick Curve Pieces** button.

c In the graphics window, click locations 1, 2, and 3. Each line segment changes color when selected.

d In the **Feature/Geometry Edit** bar, name the curve *turn*, and press **Enter**.

4 Create third line which you will use to create a Bore feature.

a Click the **Geometry** step in the **Steps** panel.

b In the **Geometry Constructors** dialog, click the **Line from two points** button.

c In the **Feature/Geometry Edit** bar:
   For point 1 enter an **XYZ 1** of X 0.625 (16 mm), Y 0, Z 0.
   For point 2 enter an **XYZ 2** of X 0.625 (16 mm), Y 0, Z [-3.75] (-94 mm).

d Press **Enter**.

5 To chain the bore curve:

a Select the **Curves** step from the **Steps** panel.

b In the **Curves Creation** dialog, select the **Pick Curve Pieces** button.
c In the graphics window, click locations 4 and 5 (you select the same line twice).

![Diagram](image)

d In the Feature/Geometry Edit bar, name the curve *bore*, and press Enter.

**Creating the features**

This shows you how to create the turning features.

![Diagram](image)

1 Select the 2D Turned Profiles button, on the Display Mode toolbar, to switch to a simplified 2D representation of the part.

![Display Mode toolbar](image)

   To open the Display Mode toolbar, select the View > Toolbars menu option, select the Display Mode option, then click OK.

2 Create a Turn feature.

   a Click the Features step in the Steps panel.
b If you have the Turn/Mill module, the New Feature wizard asks you which type of feature you want to create. Select the Turning option, and click Next.

![New Feature - Type dialog](image)

c Select Turn in the From Curve section, and click Next.

d In the Curve field select turn from the list.

Click the Pick Curve button to select the curve graphically. The dialog minimizes to reveal the graphics window beneath.

Click the curve you named turn earlier.

In this particular case, two objects are available for selection: a line and a curve. Whenever your selection needs to be clarified, FeatureCAM opens the Select dialog.

In the Select dialog, select turn, and click OK.
e From the Finish menu button, select the Finish and Create More option to continue creating features.

3 Create a Face feature.
   a In the New Feature wizard, select the Turning option, and click Next.
   b In the From Dimensions frame, select Face, and click Next.
   c On the Dimensions page:
      Enter a Thickness of 0.0625 (1.5 mm).
      Enter an Outer Diameter of 4 (100 mm).
      Enter an Inner Diameter of 0.
      Click Next.
   d Click Finish and Create More.

4 Create a Hole feature.
a In the **New Feature** wizard, select the **Turning** option, and click **Next**.
b In the **From Dimensions** frame, select **Hole**, and click **Next**.
c On the **Dimensions** page:
   Enter a **Depth** of **3.75** (**94 mm**).
   Enter a **Diameter** of **1.0** (**24 mm**).
   Click **Next**.
d On the **Location** page enter a **Z** of **0**.
e Click **Finish and Create More**.

5 Create a Bore feature by using the same process you used to create the Turn feature. Use the curve named **Bore**.

6 Create a Groove feature.
   a In the **New Feature** wizard, select the **Turning** option, and click **Next**.
   b In the **From Dimensions** frame select **Groove**, and click **Next**.
   c On the **Dimensions** page:
      Select a **Location** of **ID**.
      Select an **Orientation** of **X axis**.
      Enter a **Diameter** of **1.25** (**31 mm**).
Enter a **Depth** of **0.125** (3 mm).
Enter a **Width** of **0.25** (6 mm).
Leave the other settings at **0**.
Click **Next**.

d On the **Location** page enter a **Z** of **-3** (-75 mm).
e Click **Finish and Create More**.

7 Create a Thread feature.

a In the **New Feature** wizard, select the **Turning** option, and click **Next**.
b In the **From Dimensions** frame, select **Thread**, and click **Next**.
c On the **Dimension** page:
   Select **Get the thread dimensions from a standard thread**.
   Select **OD**.
   In the **Designation** field select the **2.0000-4.5 UNC** (**M50-15** for metric).
   Click **Next**.
d On the **Dimensions** page:
   Select a **Thread of Right hand**.
   Enter a **Thread Length** of **1.0** (24 mm).
   Click **Next**.
8 Create a Cutoff feature.
   a In the New Feature wizard, select the Turning option, and click Next.
   b In the From Dimensions frame select Cutoff, and click Next.
   c On the Dimensions page:
      Enter a Diameter of 4 (100 mm).
      Enter an Inner Diameter of 0.
      Enter a Width of 0.122 (3 mm).
      Click Next.
   d On the Location page enter a Z of –4.5 (–112 mm).
   e Click Finish.

Viewing the part

You have been working in a 2D view.
To look at the part in a different orientation you can select one of the standard predefined views. These options are available from the Standard toolbar:
1 To return to a 3D view of the model, click the **2D Turned Profiles** button, on the **Display Mode** toolbar.

2 Click the **Isometric View** button on the **Standard** toolbar.

3 Shade the part.
   a Open the **Part View** panel, and select **bore1** under the **Setup1** node.
   b Click the **Shade Selected** button on the **Display Mode** toolbar.
   c Select **thread1** in the **Part View** panel.
   d Click the **Shade Selected** button again.

4 Click the **Unshade All** button on the **Display Mode** toolbar to return to the wireframe view.
Simulating the toolpaths

Now you have created the features, FeatureCAM automatically:

- Selects the most appropriate tools and operations;
- Recommends machining strategies;
- Calculates speeds and feeds;
- Generates toolpaths and creates the NC code.

To view the simulated toolpath:

1. Click the **Toolpaths** step in the **Steps** panel to display the **Simulation** toolbar.

2. On the **Simulation** toolbar, select the **3D Simulation** option, and then click **Play** to start the simulation.

3. If the **Automatic Ordering Options** dialog displays, click **OK** to close it. This accepts the default ordering options.

   This displays a solid 3D rendering of the cutting process. By default, the 3/4 view is shown when cutting or drilling the ID of the part.

4. Click the **Play to Next Operation** button. This displays the face operation.
5  Repeat step 3 to view each operation until the whole part is cut.

6  Click Eject. This removes the simulation.

**Order of manufacturing operations**

The Op List tab in the Results window shows all of the operations needed to machine the features. A yellow warning sign next to an operation indicates a potential problem with that operation. In this case, if you see any warnings ignore them.

![Operation List](image)

You can control the automatic ordering of operations by using either rules or operation templates. The 2.5D Milling tutorial looks at using rules (see page 16).

This section changes the automatic ordering by modifying the Turn Operation template.

**To modify the template**

1  Select the Automatic Ordering option on the Op List tab. This ensures the automatic ordering rules are applied to the operations.

2  Change the automatic ordering to group together the operations which use the same tool.

   a  Click the Ordering Options button.
b In the **Automatic Ordering Options** dialog, select **Use template**.

![Automatic Ordering Options dialog]

**Automatic Ordering Options**

- **Use rules**:
  - Minimize tool changes
  - Do finish cuts last
  - Cut higher operations first (milling only)
  - Minimize rapid distance (milling only)

- **Use template**

  ![Edit template button]

**c** Click **Edit template**.

**3 In the Feature Order dialog:**

- **a** Select **Rough OD Turn**.
- **b** Click ‣ until **Rough OD Turn** is below **Finish ID Turn**.
- **c** Click **OK** to close the **Feature Order** dialog.

**4** Click **OK** to close the **Automatic Ordering Options** dialog.

**5** Simulate the part.

- **a** Select the **Toolpaths** step from the **Steps** panel. This displays the **Simulation** toolbar.
- **b** Click the **3D Simulation** button, and then click the **Play** button to start the simulation.
  
  Notice that the OD roughing and finishing now happen after the hole is drilled.

- **c** Click the **Stop** button when simulation is complete to exit simulation mode.
Part documentation (Turning)

As well as simulating the manufacturing of the part, the simulation also generates complete tool and operations lists. The tools selected are based on your tool database. You can print all of this information for use as an operator's checklist.

1 Click the Details tab in the Results window to display the Manufacturing Operations sheet.

<table>
<thead>
<tr>
<th>Manufacturing Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation List</td>
</tr>
<tr>
<td>Tool List</td>
</tr>
</tbody>
</table>

MANUFACTURING OPERATION SHEET

Part: FM1
Setup: Setup1 (1 of 1)
Date: Tuesday, July 26, 2011 16:16:07
Time: 4:39.6
Stock: Z (0.0000 in., -5.0000 in.) x OD 4.0000 in.
Mat: ALUMINUM 11110 Brinell 0.30 HP min

Op: 1 face1 [finish]
F/S: 1500 SFM CW, 0.0060 IPR
Tool: #1 (SW_Turn_00_RP)
Time: 0.16 s

Op: 2 hole1 [drill]
F/S: 954 RPM CW, 0.0150 IPR

You can review this sheet using the scroll bars.

2 Select the Tool List option at the top of the Details tab to show the Manufacturing Tool Detail sheet. It contains all of the tools used to create the part based on the tool crib you selected.

You can print this documentation from the File > Print menu option.
Generating NC code (Turning)

FeatureCAM generates the NC code to manufacture parts on a CNC machine. You can generate NC code after you have simulated the part, and therefore calculated the toolpaths.

1. Select the NC Code step from the Steps panel. This displays the NC Code dialog.

2. Click the Display the NC Code button to generate the NC code.

```plaintext
N10 T1001 M6 'CHANGE TO TOOL #1
N15 G1 X0 Y0 M4 'SET RPM TO 1000
N20 G0 X4.2 Z0
N25 M8
N30 G1 X-0.0625 Z0 F0.006
N35 G1 X0.1251 Z0.0029 F0.006
N40 G0 X-0.025 Z0.0029 'CHANGE TO TOOL #2
N45 G954 M4 'SET RPM TO 954
N50 G0 X0 Z0.1625
N55 G0 X0 Z0.1
N60 G1 X0 Z-1.0 F0.015
N65 G0 X0 Z-1.0
N70 G0 X0 Z-0.25
```

Changing the post processor

To change the post processor:

1. Select Manufacturing > Post Process from the menu. This displays the Post Options dialog.

2. Click Browse to view available post processors.

   The default folder for posts is C:\Program Files\Delcam\Examples\Posts.

3. Select your post processor and click Open.

   The new post processor is displayed in the CNC File field.

4. Click OK to exit the Post Options dialog and use the new post processor; click Cancel to exit the dialog and keep the original post processor.

5. Select the Toolpaths step from the Steps panel.

6. Run a simulation of the part to regenerate the NC code.
Saving the NC code

To save an NC program:

1. Select the NC Code step from the Steps panel. This displays the NC Code dialog.

2. Click the Save NC button in the NC Code dialog.

3. In the Save NC dialog, accept the default filename and folder, and click OK.
Introduction to turn/mill

This tutorial introduces you to:

- Creating parts for lathes with milling capabilities.
- Mixing turning and milling features.
- Creating milling features on the outside diameter and face of the part.
- Simulating a turn/mill part.

You must have licensed the Turn/Mill option to run this tutorial.

To use the turn/mill example, start FeatureCAM (see page 2), create a new file (see page 4) with a Type of Turn/Mill Setup, then follow these steps:

1. Preparatory steps (see page 44).
2. Define the geometry (see page 44).
3. Create the features (see page 47).
4. View the part (see page 48).
5. Create three radial holes on the face (see page 49).
6. Engrave the face (see page 50).
7. Create three slots (see page 53).
8. Simulate the toolpaths (see page 54).
Preparatory steps

The preparatory steps define the stock and determine the coordinate system and view.

1. On the **Dimensions** page of the **Stock** wizard:

   a. Select a shape of **Round**.
   b. Enter an **OD** (outside diameter) of 3.
   c. Enter a **Length** of 2.
   d. Enter an **ID** (inside diameter) of 0.

2. Click **Next** until you reach the **Part Program Zero** page.
3. Select **Align to stock face**.
4. Click **Next**.
5. Click to position the datum of the part.
6. From the **Finish** menu, select the **Finish** button.
7. From the **View** menu select **Center All**.
8. Select **Options > Turning Input Modes > Diameter (DZ)** from the menu to enter coordinates as **Diameter** and **Z** values.

Defining the geometry

This shows you how to design your part.

1. Draw three lines:
a Select the **Geometry** step from the **Steps** panel. This displays the **Geometry Constructors** dialog.

![Geometry Constructors dialog](image)

b Select the **Create more than 1** option, and click the **Connected Lines** button. This displays the **Feature/Geometry Edit** bar.

c To create two lines that define the outer profile, in the **Feature/Geometry Edit** bar:

- For point 1 enter a **D/Z 1** of **D 2.5, Z 0**.
- For point 2 enter a **D/Z 2** of **D 2.5, Z -1.5**.
- Press Enter to create a line.

d Create a second line with the values:

- For point 2 enter a **D/Z 2** of **D 2.75, Z -1.5**.
- Press Enter to create a second line.

e Create a third line with the values:

- For point 2 enter a **D/Z 2** of **D 2.75, Z -2**.
- Press Enter to create a third line.
2 Create a Fillet to trim your lines.

   a Select the Geometry step from the Steps panel.
   b In the Geometry Constructors dialog, in the list of Fillet options click the Corner Fillet button.
   c In the Feature/Geometry Edit bar, enter a radius (R) of 0.125.
   d Position your mouse pointer in the corner between the first and second lines, and click to create the fillet. The fillet automatically trims your lines.

3 To turn the part you need to chain the curves.

   a Select the Curves step from the Steps panel.
   b In the Curves Creation dialog, select the Pick Curve Pieces button.
   c In the graphics window, click the first line and then the third line.
   d In the Feature/Geometry Edit bar, name the curve Turn, and press Enter.
Creating the features

This example shows you how to create the turning features.

1. Click the 2D Turned Profiles button, on the Display Mode toolbar, to switch to a 3D representation of the part.

2. Create a Turn feature.
   a. Click the Features step in the Steps panel.
   b. In the New Feature wizard, select the Turning option, and click Next.
   c. Select Turn in the From Curve section, and click Next.
   d. In the Curve field select turn from the list.

   Click the Pick Curve button to select the curve graphically. The dialog minimizes to reveal the graphics window beneath.
Click the curve you named **Turn** earlier.

In the **Select** dialog, select **turn**, and click **OK**.

e  Click **Finish**.

**Viewing the part**

1  On the **Standard** toolbar select the **Isometric View** button.

![Diagram](image)

*If this displays a 2D representation of the part, click the **2D Turned Profiles** button, on the **Display Mode** toolbar.*

2  Shade the part:

   a  Open the **Part View** panel, and select **turn1** under the **Setup1** node.

   b  Click the **Shade Selected** button on the **Display Mode** toolbar.

   ![Diagram](image)

   c  Click the **Unshade All** button on the **Display Mode** toolbar to return to the wireframe view.

3  To change the view to a top view; from the **Principal View** menu button, click the **Top** button.
Creating three radial holes on the face

This shows you how to add three Holes to the part.

1 To return to a 2D view of the model, click the 2D Turned Profiles button, on the Display Mode toolbar.

2 Create a Hole.
   a Click the Features step in the Steps panel.
   b In the New Feature wizard, select the Turn/Mill option, and click Next.
   c In the From Dimensions field, select Hole and click Next.
   d In the Dimensions dialog:
      Enter a Chamfer of 0.0.
      Enter a Depth of 1.0.
      Enter a Diameter of 0.25.
   e Click Finish and Create More.

3 Create a Pattern from feature:
a In the **New Feature** wizard, select the **Turn/Mill** option, and click **Next**.
b In the **From Feature** field, select **Pattern**, and click **Next**.
c Select the hole you just created and click **Next**.
d Select **Radial in the setup XY plane**, and click **Next**.
e On the **Pattern - Dimensions** page:
   Enter a **Number** of **3.0**.
   Enter a **Diameter** of **2.0**.
   Enter a **Spacing Angle** of **120**.
   Enter an **Angle** of **60**.
f Click **Finish**.
g Click **Cancel**.

4 View the 3D wireframe representation of the part:

a Click the **2D Turned Profiles** button, on the **Display Mode** toolbar, to switch to a 3D representation of the part.
b Click the **Isometric View** button on the **Standard** toolbar.

**Engraving the face**

This shows you how to engrave the part by:

- Creating the engraving text.
- Creating a Groove feature.

1 Create a curve.

a Select the **Curves** step from the **Steps** panel.
b In the **Curves Creation** dialog, select the **Curve Wizard** button.

c In the **Curve** wizard:

![Curve Wizard dialog](image)

Select **Other methods** as the construction method.
Select **Text** as the constructor.
Click **Next**.

d On the **Engraving Text** page, configure the text properties.

![Engraving Text dialog](image)

Enter a **Text** of **TURNMILL**.
Select a **Path type** of **Linear**.
Enter a location of **X 0.0, Y -0.045, Z 0.0**.
Enter an **Angle** of **-90**.
From the **Justification** list, select **Center**.
Enter a **Scaling** of **X 0.4, Y 0.4**.
Click the Font button to display the Font dialog.
From the Font list, select Machine Tool Gothic.
Enter a Size of 72.
Click OK to close the dialog.

Click Finish to close the wizard.

2 Create a Groove feature.
   a Select the TURNMILL text (curve1) in the graphics window.
   b Click the Features step in the Steps panel.
   c In the New Feature wizard, select the Turn/Mill option, and click Next.
   d In the From Curve field, select Groove, and click Next.
   e On the Curve page, click Next (as you have selected the text in step 2a).
   f On the Location page, click Next.
   g On the Dimensions page:
      Enter a Width of 0.0625.
      Enter a Depth of 0.02.
      Select Face.
      Select Simple (Engrave).
   h Click Finish.
Creating three slots

This shows you how to add three milled slots to the part.

1. Create a Slot feature:
   a. Click the Features step in the Steps panel.
   b. In the New Feature wizard, select the Turn/Mill option, and click Next.
   c. In the From Dimensions section, select Slot. Select Make a pattern from this feature, and click Next.
   d. On the Dimensions page:
      - Enter a Length of 1.0.
      - Enter a Width of 0.5.
      - Enter a Depth of 0.25.
      - Click Next.
   e. On the Patterns page select Radial around index axis, and click Next.
   f. On the Location page:
      - Enter a B Angle of 90.
      - Enter a Radius of 1.25.
      - Enter a Z to 0.25.
      - Click Next.
   g. On the Dimension page:
      - Enter a Number of 3.
      - Enter a Spacing Angle of 120.
   h. Click Finish.
Simulating the toolpaths

To view the simulated toolpath:

1. Click the **Toolpaths** step in the **Steps** panel to display the **Simulation** toolbar.
2. Select a CNC file (see page 1864) for a machine that supports live tooling. For example:
   
   `..\Examples\Posts\TurnMill\Skeleton\skeleton-1-turret.cnc`

3. Click the **3D Simulation** button, and then click the **Play** button to start the simulation. If the **Automatic Ordering Options** dialog displays, click **OK** to close it. This accepts the default ordering options.

   ![3D Simulation Example](image)

   The toolpaths are accurately simulated including the part rotations.

4. Click **Eject**. This removes the **Simulation** toolbar.
Introduction to 3D milling

This tutorial introduces you to:

- Modeling 3D surfaces.
- Manufacturing surfaces using surface milling features.
- Manufacturing operations.
- Tool selection.
- 3D manufacturing attributes.

You must have 3D milling to perform the examples in this chapter. These examples are only specified in inch units. You must have the basic tool crib installed.

This tutorial shows you how to create a simple part, generate toolpaths and output the toolpaths used to machine the part.

To use the 3D milling example, start FeatureCAM (see page 2), create a new file (see page 4), then follow these steps:

1. Define the Stock (see page 56).
2. Define the geometry (see page 56).
3. Create the bottle surface (see page 60).
4. View the part (see page 61).
5. Create a surface milling feature (see page 63).
6. Simulate the toolpaths (see page 66).
Defining the Stock

The stock is the initial material from which you cut your part.

1. On the Dimensions page of the Stock wizard:

   a. Enter a Thickness of 2.
   b. Enter a Width of 3.
   c. Enter a Length of 6.25.
   d. Click Finish.

2. Click OK to accept the default values of the Stock Properties dialog.

Defining the geometry

This shows you how to design your part.

1. Select View > Toolbars from the menu, in the Toolbars frame:
   a. Select Advanced.
   b. Select Geometry.
   c. Click OK.
2 Create three vertical lines:
   a On the Geometry toolbar, select Vertical \( \equiv \) from the Line menu.
   b In the Feature/Geometry Edit bar, enter an XYZ of X 1, Z 0, and press Enter.
   c Create a second line by entering an XYZ of X 5.25, Z 0, and press Enter.
   d Create a third line by entering an XYZ of X 6, Z 0, and press Enter.

3 Create three horizontal lines:
   a On the Geometry toolbar, select Horizontal \( \equiv \) from the Line menu.
   b Enter an XYZ of Y 0.5, Z 0, and press Enter.
   c Create a second line by entering an XYZ of Y 1.125, Z 0, and press Enter.
   d Create a third line by entering an XYZ of Y 1.5, Z 0, and press Enter.

4 Create a through line:
   a On the Geometry toolbar, select Point, Angle \( \equiv \) from the Line menu.
   b In the Feature/Geometry Edit bar, enter an angle A of 30.
c In the graphics window, click at the intersection between the second horizontal and second vertical lines, at point 1, to create a through line.

5 Create arcs.

a On the Geometry toolbar, select 2 Pts, Radius from the Arc menu.

b In the Feature/Geometry Edit bar, enter a radius R of 0.5, and click the vertical line around point 2 and the horizontal line around point 3.

c Create the second arc:

In the Feature/Geometry Edit bar, enter a radius R of 1.0, and click the horizontal line around point 4 and the through line around point 5.
d Create the third arc by clicking the through line around point 6 and the horizontal line around point 7.

6 To mill the part you need to chain the curves.

a Select the Curves step from the Steps panel.

b In the Curves Creation dialog, select the Pick Curve Pieces button.

c Click at the intersection of the vertical and horizontal line at point 8 and at the intersection of the vertical and horizontal line at point 9.
Creating the bottle surface

1. Select the Surfaces step from the Steps panel.
2. In the Surface wizard, select Surface of Revolution, and click Next.

3. On the Surface of Revolution page:
   a. Enter a Start Angle of 0.
   b. Enter an End Angle of 180.
   c. FeatureCAM automatically selects your chained curve in the Curve field.
d In the Axis field, click the Pick line button, and select the horizontal line around point 1.

Click Finish.

Viewing the part

1 To change the view to an isometric view, click the Isometric button on the Standard toolbar.

2 Control how the part is displayed using the Viewing Options.
   a Select Options > Viewing from the menu. This displays the Viewing Options dialog.
   b Select the Show surface boundaries only option, and click Apply.

   This displays the surfaces as only their outer boundaries and trimmed loops. No additional lines are drawn in the interior of the surface. This makes the display of larger models much faster.
c Deselect the **Show surface boundaries only** option, and click **Apply**.
This displays the surfaces with lines in the interior of the surface. This aids visualization, but for large models, it makes the display of the part slower.

d Enter a **Surface fineness Wireframe** of 20, and click **Apply**.
This displays the surfaces with more lines. Decreasing the value of **Surface Fineness** improves the display quality but slows down the graphics.

e Click **OK** to close the dialog.

3 From the **Hide** menu on the **Advanced** toolbar, click the **Hide All Geometry** button.

4 From the **Show** menu on the **Advanced** toolbar, click the **Show all surfaces** button.

5 Click the **Shade** button, on the **Standard** toolbar, to shade the part.
Creating a surface milling feature

This shows you how to create the surface features and select the toolpath strategies.

1. On the Standard toolbar, click the Select button, and select the surface (srf1). On selection it turns red.

2. Select the Features step from the Steps panel.

3. In the New Feature wizard, in the From Surface frame, select the Surface Milling option, and click next.

4. On the Part Surface page click Next.
5 On the New Strategy page, select the Choose Rough, Semi Finish, and Finish... option, and click Next.

6 On the Rough page:

a Select the Z Level Rough option.

b Select Classify slices as 3D Pocket.

c Click Next.
7 On the **Semi-Finish** page, select **None**, and click **Next**.

8 On the **Finish** page, select **Isoline**.

9 Click the **Finish** button.
Simulating the toolpaths

To view the simulated toolpath:

1. Click the Toolpaths step in the Steps panel to display the Simulation toolbar.

2. Click the 3D Simulation button, and then click the Play button to start the simulation. If the Automatic Ordering Options dialog displays, click OK to close it. This accepts the default ordering options.

![3D Simulation](image)

*Note how the toolpaths are accurately simulated including the part rotations.*

3. Click Eject. This removes the Simulation toolbar.
Introduction to wire EDM

This tutorial introduces you to the basics of creating wire EDM toolpaths. It looks at:

- Setting up your material and wire thickness.
- Creating wire EDM features.
- Specifying a wire EDM cutting strategy.
- Simulating wire EDM toolpaths.

You must have licensed the Wire EDM option to run this tutorial.

To use the wire EDM example, start FeatureCAM (see page 2), create a new file (see page 4) with a Type of Wire EDM Setup, then follow these steps:

1. Define the stock (see page 67).
2. Create the profile (see page 68).
3. Create a wire EDM feature (see page 69).
4. Simulate the wire EDM toolpath (see page 71).
5. Generate NC code (Wire EDM) (see page 73).
6. Add a taper angle (see page 74).

Defining the stock

The preparatory steps define the stock and determine the coordinate system and view.

1. On the Dimensions page of the Stock wizard:
a Enter a **Thickness** of 0.5.
b Enter a **Width** of 4.
c Enter a **Length** of 4.
d From the **Finish** menu button select the **Finish** button.

**Creating the profile**

This step defines the profile.

1 Select the **Curves** step from the **Steps** panel.

2 In the **Curves Creation** dialog, select the **Curve Wizard** button.

3 In the **Curve Wizard**:
   a Select a construction method of **Other methods**.
b Select a constructor of **Rectangle**.

4 Click **Next**.

5 On the **Rectangle** page:

```plaintext
- Select **Use corner, width, and height**.
- Enter corner point of **1, 1, 0**.
- Enter a corner radius of **0.5**.
- Enter a **Width** of **2.0**.
- Enter a **Height** of **2.0**.
- Click **Finish**.
```

**Creating a wire EDM feature**

This shows you how to create a wire EDM feature.

1 Click the **Features** step in the **Steps** panel.
2. In the **New Feature** wizard, select the **Die** option in the **2 Axis** frame, and click **Next**.

![New Feature wizard](image)

3. On the **Curves** page, click the **Pick curve or geometry** button, select the curve you created, and click **Next**.

![Curves page](image)

4. On the **Location** page, click **Next**.

5. On the **Dimensions** page, enter a **Thickness** of **0.5** and click **Next**.

6. On the **Start** page, click **Next**.
7 On the Strategies page:

![Strategies Page](image)

- In the Operations field select Retract.
- Select the Cutoff option.
- Select the Contour option.
- Click Finish.

Simulating the wire EDM toolpath

Now you have created the features, FeatureCAM automatically:

- Selects the most appropriate tools and operations;
- Recommends machining strategies;
- Calculates speeds and feeds;
- Generates toolpaths and creates the NC code.

To view the simulated toolpath:

1. Click the Toolpaths button in the Steps panel to display the Simulation toolbar.
2. Click the 2D Simulation button on the Simulation toolbar.
3. Center the Simulation Speed slider to specify the simulation rate.
4. From the Simulation Next menu button, select the Play to Next Operation button to see the retract operation. If the Automatic Ordering Options dialog displays, click OK to close it.
To slow down the simulation, drag the Simulation Speed slider to the left.

5 Click the Play to Next Operation button again to see the cutoff operation.
6 Click the **Play to Next Operation** button again to see the final contour operation.

7 Click **Eject**.

**Generating NC code**

FeatureCAM generates the NC code to manufacture parts on a CNC machine. You can generate NC code after you have simulated the part, and therefore calculated the toolpaths.

1 Select the **NC Code** step from the **Steps** panel. This displays the **NC Code** dialog.

2 Click the **Display the NC Code** button to generate the NC code.
Adding a taper angle

This example shows you how to add a draft angle to a wire EDM part.

1. Open the Part View panel, select the die1 feature from the Setup1 node, and click the Properties button on the Feature/Geometry Edit toolbar.

2. In the Properties dialog for die1:
   
   a. Select Constant.
   
   b. Select a taper type of Left.
c Enter a deg. of 10 as the taper angle.
d Click Apply.

3 Click the Hide Stock button from the Hide menu on the Advanced toolbar.

4 Click the Isometric View button on the Standard toolbar.

5 Return back to the Properties dialog, set the taper type to Right, and click Apply.

6 Change the taper type back to Left, and click OK to close the Properties dialog.

7 Select the Toolpaths step from the Steps panel.

8 Click the 3D Simulation button, and then click the Play button.
9 Click the Select button on the Standard toolbar.

10 Click inside the curve. FeatureCAM deletes that part of the stock.

11 Click Eject.

12 From the Show menu on the Advanced toolbar, click the Show Stock button.
Introduction to Feature Recognition

There are two types of Feature Recognition in FeatureCAM, which you can learn about in the following examples:

- Automatic Feature Recognition (see page 78) — Automatically recognize all features in a solid model.
- Interactive Feature Recognition (see page 84) — Recognize individual features from a solid model.
Automatic Feature Recognition example

This example shows you how to use Automatic Feature Recognition to recognize features in a solid model.

To use the Automatic Feature Recognition example, start FeatureCAM (see page 2), create a new file (see page 4), then follow these steps:

1. Import the ug_plate.x_t solid model (see page 79).
2. Use Automatic Feature Recognition to create the features (see page 81).
3. Simulate the toolpaths (see page 83).
Importing the solid model

This step shows you how to import a solid model into FeatureCAM.

To import the solid model:

1. If the Dimensions dialog is displayed, click Cancel to close it.
2. Select the File > Import menu option to display the Import dialog.
3. Navigate to the FeatureCAM\Examples\FeatureRECOGNITION folder.
   By default this folder is in the Program files\Delcam folder.
4. Select the ug_plate.x_t file and click Open.
   The Import Results dialog is displayed.
5. Select Use the wizard to establish the initial setup location and stock size and click Next.
   The Pick Initial Setup Z Direction page is displayed.
6. Click Next.
   The Pick Initial Setup X Orientation page is displayed.
7. Click Next.
   The Stock Type page is displayed.
8. Select Block and click Next.
   The Stock Dimensions page is displayed.
9. Select Compute stock size from the size of the part and click Next.
   The Pick Initial Setup XYZ Location page is displayed.
10. Click LL.
    This locates the Setup (the part’s coordinate system origin on the machine) in the lower-left corner of the stock.
11. Click Finish to close the Import wizard.
   The part is imported into the document.
12 Press the Ctrl+1 keys to select an isometric view.

You can learn more about the options available in the Import wizard by clicking the Help button on each page.
Using Automatic Feature Recognition

This step shows you how to use Automatic Feature Recognition to create features.

To use Automatic Feature Recognition:

1. Select the **Construct > Automatic Feature Recognition** menu option.
   
   The **Automatic Feature Recognition** dialog is displayed.

2. Select your imported solid in the list.

3. Click **Options**.
   
   The **AFR Options** dialog is displayed.

4. In the **AFR Options** dialog:
   a. Select **Create face feature**
   b. Select **Create hole pattern**
   c. Deselect **Create 3D feature**

5. Click **OK** to close the **AFR Options** dialog.

6. Click **Next**.
   
   The Setups page is displayed. You can use this page to select on which Setups the recognized features are created. In this example there is only one Setup.

7. Click **Next**.
   
   The features page is displayed. A list is displayed of all the recognized features, and a wireframe preview is displayed in the graphics window.

   ![Image of recognized features](image)

   You can deselect features in the list that you do not want to create. In this tutorial, you do not need to create a Face feature.

8. Deselect **face 01** in the list.

9. Click **Finish** to create the selected features.
The created features are displayed in the Part View.

You can move the cursor over an item's name in the Part View to highlight it in the graphics window.
Simulating the toolpaths (AFR)

You can now simulate the toolpaths to see the result of the feature recognition.

To simulate the toolpaths:

1. Click the Toolpaths step in the Steps panel to display the Simulation toolbar.

2. On the Simulation toolbar, select the 3D Simulation option, and then click Play to start the simulation.

   If the Automatic Ordering Options dialog displays, click OK to close it. This accepts the default ordering options.

   The 3D cutting simulation is displayed in the graphics window.

   If there are any gouges, the simulation is paused and a warning is displayed.

3. When the simulation is complete, check the part to ensure there are no gouges and all the features have been machined correctly.

4. In the Simulation toolbar, click Stop to clear the simulation.
Interactive Feature Recognition example

This example shows you how to use Interactive Feature Recognition to recognize features in a solid model.

To use the Interactive Feature Recognition example, start FeatureCAM (see page 2), create a new file (see page 4), then follow these steps:

1. Import the `Integrex.sat` solid model (see page 85).
2. Use Interactive Feature Recognition to create the features (see page 87).
3. Change the tool selection (see page 90).
4. Simulate the toolpaths (see page 92).
Importing the solid model

This step shows you how to import a solid model into FeatureCAM.

To import the solid model:

1. If the Dimensions dialog is displayed, click Cancel to close it.
2. Select the File > Import menu option to display the Import dialog.
3. Navigate to the \FeatureCAM\Examples\FeatureRECOGNITION folder.
   By default this folder is in the Program files\Delcam folder.
4. Select the Integrex.sat file and click Open.
   The Import Results dialog is displayed.
5. Select Use the wizard to establish the initial setup location and click Next.
   The Pick Initial Setup Z Direction page is displayed.
6. Click Next.
   The Pick Initial Setup X Orientation page is displayed.
7. Click Next.
   The Stock Type page is displayed.
8. Select Block and click Next.
   The Stock Dimensions page is displayed.
9. Select Compute stock size from the size of the part and click Next.
   The Pick Initial Setup XYZ Location page is displayed.
10. Click LL.
    This locates the Setup (the part’s coordinate system origin on the machine) in the lower-left corner of the stock.
11. Click Finish to close the Import wizard.
    The part is imported into the document.
12 Press the Ctrl+3 keys to select an isometric view.

You can learn more about the options available in the Import wizard by clicking the Help button on each page.
Using Interactive Feature Recognition

This step shows you how to use Interactive Feature Recognition to create features. In this example you will create Side features and then Hole features.

Creating the Side features

To create the Side features:

1. Click the **Features** step in the **Steps** panel. The **New Feature** dialog is displayed.
2. Under **From Curve**, select **Side**.
3. Select **Extract with FeatureRECOGNITION**.
4. Click **Next**. The **Feature Extraction** page is displayed.
5. Select **Select side surfaces** and click **Next**. The **Surface** page is displayed.
6. In the graphics window, select the surface on which to create the flat Side feature.
7. On the **Surfaces** page, click **Add from selected items** to add the surface to the list.
8. Click the arrow on the **Finish** button, and then click **Finish and Create More**.

The feature is created and the **New Feature** dialog is displayed.
9 Ensure **Side** and **Extract with FeatureRECOGNITION** are selected, and click **Next**.

The **Feature Extraction** page is displayed.

10 Select **Select side surfaces** and click **Next**.

The **Surface** page is displayed.

11 In the graphics window, select the surfaces on which to create the curved Side features, on both the front and back of the part.

Front:

Back:

- **Hold the Shift key and click to select multiple surfaces.**
- **Press the Ctrl+3 or Ctrl+7 to select the back and front isometric views.**

12 On the **Surfaces** page, click **Add from selected items** to add the surfaces to the list.

13 Click the arrow on the **Finish** button, and then click **Finish** to create the features and close the dialog.
Creating the Hole features
To create the Hole features:

1. Click the **Features** step in the **Steps** panel. 
   The **New Feature** dialog is displayed.
2. Under **From Dimensions**, select Hole.
3. Ensure **Extract with FeatureRECOGNITION** is selected.
4. Click **Next**.
   The **Hole Recognition Method** page is displayed.
5. Select **Recognize and construct multiple holes** and click **Next**.
   A preview of the recognized Holes is displayed in the graphics window.

![Hole Recognition Preview](image.png)

You can now select the Holes you want to create. Selected Holes are displayed in red.

6. Click **Select All** to select all the recognized Holes.
7. Click **Finish** to create the Hole features and close the dialog.
Tool selection (IFR)

When using Feature Recognition, it is possible to create features that you do not have the tools to machine.

In this example, there is no tool that meets the requirements for drilling the large Holes. If you try to run a simulation, the **Code Generation Failed** message is displayed.

When this happens, you can:

- add a new tool to your tool library that is the correct size to machine the feature; or
- machine the feature with an existing tool.

In this example, you will use an existing tool.

To select a tool to machine the feature:

1. In the **Results** window, select the **Op List** tab.

   The **Operation List** is displayed. The operations with no tool selected have a red exclamation mark, and no tool name.

2. Double-click an operation with no tool to display the Feature Properties dialog.

3. Select the **Tools** tab.

   A list of available tools is displayed.
4 Select the check mark to the left of **TD_03970_X:J** to use this tool.

5 Click **OK** to accept your changes and close the dialog.

Because similar Hole features are created as patterns instead of individual features, you only need to edit one feature and your changes are applied to all the features in the pattern.

```
The tool selection tolerance is determined by the Tool diameter tolerance option on the Tool Selection tab of the Machining Attributes dialog. You can increase this value to enable a wider range of tools to be selected to machine a feature.
```
Simulating the toolpaths (IFR)

You can run a 3D simulation to check if the features have been created correctly and to check for gouges.

1. Click the Toolpaths step in the Steps panel. This displays the Simulation toolbar.

2. On the Simulation toolbar, select the 3D Simulation option, and then click Play to start the simulation.

   If the Automatic Ordering Options dialog appears, click OK to close it. This accepts the default ordering options.

   The 3D cutting simulation is displayed in the graphics window.

3. Click Stop to clear the simulation results.
What's New in FeatureCAM

FeatureCAM issues a major enhancement release every September, January, and May. For details of our developments in the last year, see:

What's New in FeatureCAM 2016 R2 (see page 2)
What's New in FeatureCAM 2016 R1 (see page 50)
What's New in FeatureCAM 2015 R3 (see page 94)
What's New in FeatureCAM 2015 R2 (see page 133)
What's New in FeatureCAM 2015 R1 (see page 176)

Visit our website at http://www.delcam.tv/lz/ for up-to-the-minute news and videos; and visit http://updates.delcam.com to download our latest service packs and enhancements.
What's new in FeatureCAM 2016 R2

FeatureCAM 2016 R2 contains the following new features and enhancements:

User interface

FeatureCAM 2016 R2 contains the following changes and improvements to the user interface:

- **Sorting feature curves** (see page 6) — You can now sort feature profile curves based on selected criteria to improve the machining times.
- **Pocket curves manual ordering** (see page 8) — You can now manually specify the machining order of profile curves in Pocket features.

Importing

FeatureCAM 2016 R2 contains the following changes and improvements to importing:

- **Importing SolidWorks 2016 files** (see page 10) — You can now import SolidWorks 2016 files into FeatureCAM.
- **Parasolid v28.0 support** (see page 11) — FeatureCAM now supports Parasolid v28.0.

Milling

FeatureCAM 2016 R2 contains the following changes and improvements to milling:

- **5 axis Z-indexing** (see page 13) — You can now use Z indexing in 5-axis simultaneous parts.
- **Relative plunge** (see page 15) — You now have more control of when to use rapid moves during plunging in 2.5D features.
- **Automatic tool selection** (see page 16) — The automatic tool selection has been improved for tools with a large shank to prevent gouges.
- **Toolpath features** (see page 17) — You can now import toolpath points from an operation in between existing points of a Toolpath feature.

Turning

FeatureCAM 2016 R2 contains this improvement to turning:
- **TNR undercut checking** (see page 19) — You can now use undercut checking and auto-round when using tool nose radius compensation.

**Machine Simulation**

FeatureCAM 2016 R2 contains the following changes and improvements to machine simulation:

- **Selecting a Machine Design file** (see page 22) — It is now easier and quicker to change the machine design file used for machine simulations.

- **Simulating tool post movements during part handling** (see page 23) — The machine simulation now displays tool post movements during part handling.

**Tombstone machining**

FeatureCAM 2016 R2 contains this improvement to tombstone machining:

- **Adding Tombstone parts** (see page 26) — You can now specify the location of the part relative to the fixture location.

**Add-ins and extensions**

FeatureCAM 2016 R2 contains the following changes and improvements to add-ins and extensions:

- **Turning heads with multiple tools** (see page 29) — You can now simulate multiple tools on a turning head to give you more complete simulation and gouge checking.

- **Mill-curve tolerance add-in** (see page 31) — There is a new add-in that enables you resize milling features quickly to bring them into tolerance without redrawing the feature curve.

- **Setup Sheet improvements** (see page 34) — There are new tags in the Setup Sheet add-in.

- **Custom parallels for vises** (see page 35) — You can now use custom parallel sizes in the Import Vise add-in to ensure the part and vise are simulated in the correct position.

- **Setup Activate add-in** (see page 36) — The Setup Activate add-in has been improved.

- **Silent install language** (see page 37) — You can now specify the install language when performing a silent install of FeatureCAM using the command prompt.

**XBUILD**

FeatureCAM 2016 R2 contains the following changes and improvements to XBUILD:
**Segment End Format** (see page 39) — There is now a Segment End Format in XBUILD that gives you more flexibility when creating posts.

**Array operators** (see page 40) — The method for managing data stored in arrays has been improved.

**HTML documentation** (see page 42) — You can now use a template to improve the HTML documentation, and you can create HTML documentation from the command prompt.

**Machine design**

FeatureCAM 2016 R2 contains this improvement to machine design:

**Adding tool locations to tool blocks** (see page 48) — You can now specify whether to locate the tool tip or the back of the tool holder.
User interface

FeatureCAM 2016 R2 contains the following changes and improvements to the user interface:

- **Sorting feature curves** (see page 6) — You can now sort feature profile curves based on different criteria to improve the machining times.

- **Manually ordering Pocket curves** (see page 8) — You can now manually specify the machining order of profile curves in Pocket features.
Sorting feature curves

You can now sort feature profile curves based on selected criteria to improve the machining times. Previously you could only sort feature curves manually or automatically.

To sort feature curves:

1. In the **Feature Properties** dialog, on the **Dimensions** tab, click **Curves** or **Boundaries** (depending on the feature type).
2. The **Ordering** or **Select Boundary Curves** dialog is displayed.
3. Select the check-box next to the curves you want to use to define the feature boundaries.
4. Under **Ordering**, select **Manual ordering**.
5. Click the new **Sorting** button.

![Sorting feature curves dialog](image)
6 The new **Curve Sorting Options** dialog is displayed.

![Curve Sorting Options dialog]

7 Select how to sort the selected features:

- **Shortest path** — Sort the features to reduce the movement between features.
- **X/Y/Z ascending/descending** — Sort the features by position.

8 For rows or columns of features, select how to transition between rows or columns:

- **Unidirectional** — Cut all rows of features in the same direction, with a rapid move to the start of the next row.
- **Bidirectional** — Cut rows of features in alternating directions to reduce the rapid movement distance.
- **Location comparison tolerance** — Specify the tolerance within which a range of positions is considered a row or column.

9 Click **OK** to close the dialog and sort the features.
**Manually ordering Pocket curves**

You can now manually specify the machining order of profile curves in Pocket features. Previously, this was calculated automatically in some situations.

To manually order boundary curves for a Pocket feature:

1. On the **Dimensions** tab of the **Feature Properties** dialog, click **Boundaries** to display the **Select Boundary Curves** dialog.
2. Under **Ordering**, select **Manual ordering**.
3. Use the **Move item up** and **Move item down** buttons to order the curves.
   
   Alternatively, drag curves in the list to reposition them.
4. Click **OK** to close the dialog.
Importing

FeatureCAM 2016 R2 contains the following changes and improvements to importing:

- **Importing SolidWorks 2016 files** (see page 10) — You can now import SolidWorks 2016 files into FeatureCAM.

- **Parasolid v28.0 support** (see page 11) — FeatureCAM now supports Parasolid v28.0.
Importing SolidWorks 2016 files

You can now import SolidWorks 2016 files into FeatureCAM.

To import a SolidWorks file into FeatureCAM:

1. Select the File > Import menu option.
   The Import dialog is displayed.

2. In the Files of type list, select SolidWorks (*.sldprt;*.sldasm).
   Only SolidWorks documents are displayed in the Import dialog.

3. Select a file to display a preview image on the right of the dialog.

4. Click Open to import the file and close the dialog.
   The Import Results wizard is displayed, which you can use to specify the setup location and stock size, and to recognize features.
Parasolid v28.0 support

FeatureCAM now supports Parasolid v28.0.
Milling

FeatureCAM 2016 R2 contains the following changes and improvements to milling:

- **5 axis Z-indexing** (see page 13) — You can now use Z indexing in 5-axis simultaneous parts.
- **Relative plunge** (see page 15) — You now have more control of when to use rapid moves during plunging in 2.5D features.
- **Automatic tool selection** (see page 16) — The automatic tool selection has been improved for tools with a large shank to prevent gouges.
- **Toolpath features** (see page 17) — You can now import toolpath points from an operation in between existing points of a Toolpath feature.
FC 5-axis Z indexing

You can now use Z-indexing in 5-axis simultaneous parts. This gives you more control over the toolpaths to reduce machining times and prevent collisions. Z axis indexing was previously available only for 4-axis parts.

Enable the Cut feature using Y Axis coordinates option and enter a C Angle to use a fixed Z axis angle and move the tool in X and Y to machine the feature. Deselect this option to enable the part to rotate around the Z axis to machine the feature, keeping the tool oriented towards the center of the C axis from the positive X axis.

To enable Z indexing:

1. Ensure you are using a CNC file that supports 5-axis positioning, 5-axis simultaneous and Z-indexing.
2 In the **Stock Properties** dialog, on the **Indexing** tab, select the new **Use Z-indexing** option to enable Z-indexing for the document.

![Stock Properties dialog](image1.png)

3 For each feature, deselect **Cut feature using Y Axis coordinates** on the **Dimensions** tab of the **Feature Properties** dialog to enable the part to rotate about the Z axis during cutting.

![Feature Properties dialog](image2.png)
Relative plunge

You now have more control of when to use rapid moves during plunging in 2.5D features, which enables you to improve machining times by reducing unnecessary feed moves when it is safe to rapid.

For example, you can use this to plunge at the feed rate for features starting inside the stock, and plunge at the rapid rate for features starting outside the stock boundary.

There is a new Relative plunge option on the Plunge tab of the Feature Properties dialog.

Select this option to measure the Plunge clearance from the bottom of the feature instead of from the top.

Previously, you could only do this by using a negative Plunge clearance which is equal to the depth of cut minus the desired plunge height above the bottom of the cut.

This is available for Pocket, Boss and Side features when using OT toolpaths.
Automatic tool selection

The automatic tool selection has been improved for tools with a large shank to prevent gouges. When the shank diameter is greater than the cutter diameter, the tool selection now considers the cutter length attribute instead of the exposed length to prevent collisions between the shank and the stock.

For example, previously this tool could have been selected because the exposed length is large enough to prevent the tool holder from gouging the stock. Now a longer tool will be selected to prevent the shank colliding with the stock.

1 — Cutter length
2 — Exposed length
Toolpath features

You can now import toolpath points from an operation in between existing points of a Toolpath feature. Previously, imported points would replace existing points.

For example, you can use a curve to specify the start and end points of a toolpath, and then insert the toolpath points from an operation between the start and end points.

To import toolpath points from an operation into a toolpath feature:

1. In the Part View, double-click the toolpath feature to display the Toolpath Properties dialog.

2. On the Toolpaths tab, select a toolpath point. You can import the toolpath points above or below the selected point.

3. Click Add operation .

   The Add Operation to Toolpath dialog is displayed.

4. In the Operation list, select the operation from which you want to import the toolpath points.

5. Select where you want to locate the imported toolpath points:
   - **Replace all toolpath points** — Delete all existing toolpath points and import the toolpath points from the operation.
   - **Add operation points before selected toolpath point** — Import the toolpath points from the operation and insert them before the toolpath point selected in the Toolpath Properties dialog.
   - **Add operation points after selected toolpath point** — Import the toolpath points from the operation and insert them after the toolpath point selected in the Toolpath Properties dialog.

6. Click OK to close the dialog and import the toolpath points.
Turning

FeatureCAM 2016 R2 contains this improvement to turning:

- **TNR undercut checking** (see page 19) — You can now use undercut checking and auto-round when using tool nose radius compensation.
TNR undercut checking

You can now use undercut checking and auto-round when using tool nose radius compensation. Previously, these were only available when TNR comp was disabled.

For example, in this part the undercut has been removed to prevent the tool from gouging the part, and auto-round is used to insert an arc move in the corner of the toolpath without changing the shape of the machined part.

To enable tool nose radius compensation, select **TNR Comp** for each operation on the **Strategy** tab of the Feature Properties dialog.
To enable auto-round and undercut checking, use the options on the **Turning** tab of the Feature Properties dialog.
Machine Simulation

FeatureCAM 2016 R2 contains the following changes and improvements to machine simulation:

- **Selecting a Machine Design file** (see page 22) — It is now easier and quicker to change the machine design file used for machine simulations.

- **Simulating part handling tool post controls** (see page 23) — The machine simulation now displays tool post movements during part handling.
Selecting a Machine Design file

There is a new status bar item that enables you to change the MD file quickly without using the Setup wizard.

Click the name of the machine design file to display the **Setup - Simulation information** dialog, which you can use to change the machine design file associated with the active setup.

**Smart MD choice**

When you select an MD file that does not exist, or when the CNC file refers to an MD file that does not exist, FeatureCAM now selects an appropriate MD file from the **Examples\Machine Design** folder.

If a smart MD choice is made, a message dialog is displayed when you close the dialog and when you run a simulation. You can disable these messages by deselecting **Notify me when a smart choice is made**.

---

*If the Generate single program (see page 230) option is enabled in the Stock Properties dialog, this sets the MD file for the first setup, instead of the active setup. For Vertical Turnmilling documents, this sets the MD for the first turning setup.*
Simulating tool post movements during part handling

The machine simulation now displays tool post movements during part handling, enabling you to check the movements for collisions. In the following example the upper tool post is moved away, and the lower tool post is indexed to a safe position to prevent collisions during the transfer.

To control the tool posts during part handling:

1. Create a Part Handling feature.
2. In the Feature Properties dialog, in the Strategy tab, click Tool post control.

   The Transfer Tool Post Control dialog is displayed.

3. Select a Location for each tool post to specify whether to move it to the home position, a safe position away from the part, or keep it where it is.
4. Enter an Index number to specify to which tool location the tool post should index.

   Use this to ensure tools do not cause collisions, or improve machining times by indexing to the next tool in advance.
5 Click **OK** to close the dialog.
6 Run a machine simulation.
   The tool post movements are displayed in the simulation.
Tombstone machining

FeatureCAM 2016 R2 contains this improvement to tombstone machining:

- **Adding Tombstone parts** (see page 26) — You can now specify the location of the part relative to the fixture location.
Adding Tombstone parts

When adding parts to a tombstone, you can now specify the location of the part relative to the fixture location. Previously, you could only add parts relative to the faces of the tombstone.

For Heidenhain posts, this enables you to use a datum shift from the fixture location to the setup, instead of from the tombstone origin to the setup.

To add a part to a tombstone relative to a fixture location:

1. Use the **Fixture Offset Locations** dialog to create a fixture location. You will locate your part relative to this location.
2. Use the **Add Part** wizard to add a part and select the primary setup.
3. On the **Select Fixture** page, select **Create a new fixture zero at the setup origin**, and click **Next**.

   ![Select Fixture dialog]

   The new fixture location page is displayed.

4. Select **Relative to a global fixture location** to use the new method to add the part relative to an existing fixture location on the tombstone.
5. Select a fixture location in the list, and click **Next**.
The new **Part Location** page is displayed.

![Part Location Window](image)

6 Enter the **X**, **Y**, and **Z Offset** values to offset the part's primary setup location from the fixture location.

7 Click **Preview** to display a wireframe preview of the part in the graphics window.

8 Click **Next** to display the **Preview** page.

9 Click **Finish** to add the part to the tombstone.

For Heidenhain posts, the NC code now includes a datum shift from the fixture location to the setup location.

When using the existing method, the datum shift is from the tombstone location to the setup.
Add-ins and extensions

FeatureCAM 2016 R2 contains the following changes and improvements to add-ins and extensions:

- **Turning heads with multiple tools** (see page 29) — You can now simulate multiple tools on a turning head to give you more complete simulation and gouge checking.

- **Mill-curve tolerance add-in** (see page 31) — There is a new add-in that enables you to resize milling features quickly to bring them into tolerance without redrawing the feature curve.

- **Setup Sheet improvements** (see page 34) — There are new tags in the Setup Sheet add-in.

- **Custom parallels for vises** (see page 35) — You can now use custom parallel sizes in the Import Vise add-in to ensure the part and vise are simulated in the correct position.

- **Setup Activate add-in** (see page 36) — The Setup Activate add-in has been improved.

- **Silent install language** (see page 37) — You can now specify the install language when performing a silent install of FeatureCAM using the command prompt.
Turning heads with multiple tools

In FeatureCAM 2015 R3, support was introduced for turning head tool holders (see page 119).

You can now simulate turning heads with multiple tools. This enables you to create accurate simulations and check for gouges when using multiple tools. Using multiple tools in the same turning head enables you to reduce the machining time by reducing the time it takes to change to the next tool.

This requires the **Advanced Turn/Mill (MTT)** module, and it requires a modified CNC file and modified MD file (see page 1936) to facilitate the U axis movement.

To use a turning head tool holder with multiple tools:

1. Create a turning head feature (see page 186) for each tool on the tool holder. For example, create a rough and finish pass as separate features.
2 For each feature, set the **U Axis Sign** attribute in the **Dimensions** tab of the **Feature Properties** dialog to specify which direction along the U axis the tool is cutting.

3 Use the **Tool Block Selection** dialog (see page 1579) to select the **Tool block** as the turning head and select which sub slot holds each tool.

**Machine Design**

To modify the Machine Design file to simulate a turning head with multiple tools:

1 Create a UCS for each tool location on the sliding u-plate, facing in opposite directions. This enables the tools to cut the part from both sides.

2 Select **Machine Design > Tool Block for Tool Post** and use the **Tool Block** dialog to create a tool location at each UCS.
Mill-curve tolerance add-in

There is a new Mill-curve tolerance add-in that enables you automatically resize milling features quickly to bring them into tolerance without redrawing the feature curve.

Previously, this was available only for turning features using the Turn-curve tolerance add-in.

To use the Mill-curve tolerance add-in:

1. Install the MillCurveTolerance.bas add-in.
2. Select a milling feature created from a curve in the XY plane.
3. In the Utilities toolbar, click the Tolerances button.

The Tolerance of Line Segments dialog is displayed, and the vertical and horizontal segments of the curve are labeled in the graphics window.

4. Adjust the labels:
   - To change the label size, enter a new value in the Segment Text Size box, and click Set.
   - To label only the currently selected segment, deselect the Segment Labels On check box.
5 In the **Segments** list, select the segment you want to adjust. The segment and its label are displayed in red in the graphics window.

6 Specify the adjustment for the segment:
   - To calculate the adjustment from specified tolerances, select the **Upper tolerance - Lower tolerance** option and enter the tolerance values.
   - To calculate the adjustment from standard tolerances, select the **Upper tolerance - Lower tolerance** option, and select the tolerances in the ISO 286-2 list.
   - To specify the adjustment, select **Net tolerance**, and enter the distance by which you want to move the segment.

7 Click **Apply Tolerance**. The adjustment for the segment is displayed below the button.

8 Click **OK** to apply your changes and close the dialog.

FeatureCAM creates a new curve and feature, and displays the results in the graphics window, for example:
Notes

- You can use this only for features created from curves; Bosses, Chamfers, Grooves, Pockets, Rounds, and Sides.
- If a feature is created from multiple curves, only the first curve is adjusted.
- Open and closed curves work the same.
- If you enter a tolerance that would break the feature, a message is displayed explaining the maximum tolerance you can enter for a segment.
- Non-vertical and non-horizontal lines and curves are translated to accommodate the tolerance but not altered.
Setup Sheet improvements

There are new tags in the SetupSheet.dll add-in:

- NC code file name — `fm.cnc_file_name`
- Actual depth of cut — `operation.actual_depth`
  
  This is the setup or feature depth minus the allowances and offsets. This is applicable to all feature and operation types.
- Z end of operation — `operation.z_start`
- Z start of operation — `operation.z_end`
Custom parallels for vises

You can now use custom parallel sizes in the Import Vise add-in (see page 191) to ensure the part is simulated in the correct position in the vise.

There are new options in the **Import Vise** dialog.

To create a custom parallel size:

1. Select **Add parallels**.
2. In the **Parallels dimensions** list, select **Custom**.
3. Select **Metric** to enter the dimensions in cm, or deselect it to enter the dimensions in inches.
4. Enter the width (**W**), length (**L**), and thickness (**T**) dimensions.
5. Select **Save to library** to add your custom parallel to the **Parallel dimensions** list.
**Setup Activate add-in**

The SetupActivate.bas add-in has been improved. You can use the this add-in to assign solids to setups, and only display solids assigned to the active setup.

Previously, solids without the prefix *part* would be hidden, now solids with no prefix are not hidden, so you can use this add-in without having to rename your part solids.

This is useful when using the Import vise add-in (see page 191), as part solids are no longer hidden when you import vises into a document.
Silent install language

You can now specify the install language when performing a silent install of FeatureCAM using the command prompt.

To perform a silent install, enter this in the command prompt:

"FeatureCAM.exe" /S /USERSHORTCUT=$shortcut_name /D=$install_location /LANGUAGE=$language

- **FeatureCAM.exe** — The name of the installer. If you are installing from the DVD the installer is called setup.exe.
- /S — This specifies the install is a silent install.
- $shortcut_name — The name of the FeatureCAM shortcut that is created on the Desktop.
- $install_location — The complete path where FeatureCAM is installed.

If no install location is specified it is installed in the default location, C:\Program Files\Delcam\FeatureCAM.

Do not use quotes in the pathname.

- $language — The three letter acronym to specify the install language of FeatureCAM. For example, for a Spanish install enter esp. If no language is specified or an incorrect acronym is used, FeatureCAM is installed in English.
FeatureCAM 2016 R2 contains the following changes and improvements to XBUILD:

- **Segment End Format** (see page 39) — There is now a Segment End Format in XBUILD that gives you more flexibility when creating posts.

- **Array operators** (see page 40) — The method for managing data stored in arrays has been improved.

- **HTML documentation** (see page 42) — You can now use a template to improve the HTML documentation, and you can create HTML documentation from the command prompt.
**Segment End Format**

There is now a Segment End Format in XBUILD that gives you more flexibility when creating posts.

You can use the Segment End Format to include cancel codes without having to wait until the next Tool Change or Segment Start Format is called.

In XBUILD, select the **Formats > Program > Segment End** to open it in the Format editor.

The Segment End Format is output after each segment.

For example, when using a UDF feature to insert code between operations, you can use the Segment End format to ensure that the UDF code is output before the cancelation codes for the previous operation.

<table>
<thead>
<tr>
<th>Without Segment End</th>
<th>With Segment End</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Initialize 1st operation (Segment Start Format)</td>
<td>1 Initialize 1st operation (Segment Start Format)</td>
</tr>
<tr>
<td>2 Cut 1st operation (Move Formats)</td>
<td>2 Cut 1st operation (Move Formats)</td>
</tr>
<tr>
<td>3 <strong>Inserted code (UDF Text Format)</strong></td>
<td>3 1st operation cancel codes (Segment End Format)</td>
</tr>
<tr>
<td>4 1st operation cancel codes (Segment Start Format) Initialize 2nd operation (Segment Start Format)</td>
<td>4 <strong>Inserted code (UDF Text Format)</strong></td>
</tr>
<tr>
<td>5 Cut 2nd operation (Move Formats)</td>
<td>5 Initialize 2nd operation (Segment Start Format)</td>
</tr>
<tr>
<td>6 2nd operation cancel codes (Segment Start Format)</td>
<td>6 Cut 2nd operation (Move Formats)</td>
</tr>
<tr>
<td></td>
<td>7 2nd operation cancel codes (Segment Start Format)</td>
</tr>
</tbody>
</table>
Array operators

The method for managing data stored in arrays has been improved.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>ar_new(...)</td>
<td>Initializes a new array from a list of elements.</td>
<td>[arr = ar_new(1, 2, 3, 4)]</td>
<td>arr is the array {1, 2, 3, 4}</td>
</tr>
<tr>
<td>ar_by_len(length, value)</td>
<td>Initializes a new array of size length, with all elements initialized to value.</td>
<td>[arr = ar_by_len(3, &quot;abc&quot;)])</td>
<td>arr is the array {&quot;abc&quot;, &quot;abc&quot;, &quot;abc&quot;}</td>
</tr>
<tr>
<td>ar_get(array, index)</td>
<td>Retrieves the element at position index in array. Array indexes are 0-based.</td>
<td>[arr = ar_new(&quot;a&quot;, &quot;b&quot;, &quot;c&quot;)]; [ar_get(arr, 2)]</td>
<td>Returns &quot;c&quot;</td>
</tr>
<tr>
<td>ar_set(array, index, value)</td>
<td>Sets the element at position index in array equal to value. Array indexes are 0-based.</td>
<td>[arr = ar_new(1, 2, 3)]; [ar_set(arr, 1, 4)]</td>
<td>arr is the array {1, 4, 3}</td>
</tr>
<tr>
<td>ar_incr(array, index, delta)</td>
<td>Adds delta to the element at position index in array. Array indexes are 0-based.</td>
<td>[arr = ar_new(1, 2, 3)]; [ar_incr(arr, 0, -3)]</td>
<td>arr is the array {-2, 2, 3}</td>
</tr>
<tr>
<td>ar_append(array, ...)</td>
<td>Appends a list of elements to the end of array.</td>
<td>[arr = ar_new(1, 2, 3)]; [ar_append(arr, 4, 5)]</td>
<td>arr is the array {1, 2, 3, 4, 5}</td>
</tr>
<tr>
<td>ar_concat(array1, array2)</td>
<td>Creates a new array containing all of the elements of array1 followed by all the elements of array2.</td>
<td>[arr1 = ar_new(&quot;a&quot;, &quot;b&quot;, &quot;c&quot;)]; [arr2 = ar_new(&quot;d&quot;, &quot;e&quot;, &quot;f&quot;)]; [arr3 = ar_concat(arr1, arr2)]</td>
<td>arr3 is the array{&quot;a&quot;, &quot;b&quot;, &quot;c&quot;, &quot;d&quot;, &quot;e&quot;, &quot;f&quot;}. arr1 and arr2 are unchanged.</td>
</tr>
<tr>
<td>ar_copy(array)</td>
<td>Creates a new array containing all</td>
<td>[arr1 = ar_new(1, 2, 3)]</td>
<td>arr2 is the array {1, 2, 3}</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example Code</td>
<td>Output</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>--------------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| `ar_len(array)` | Returns the number of elements in array. | `[arr = ar_new("a", "b", "c", "d")]
[ar_len(arr)]` | Returns 4 |
| `arr2 = ar_copy(arr1)` | 2, 3] array {1, 2, 3}. arr1 is unchanged |
**HTML documentation**

You can create HTML documentation from CNC files to keep records and compare them easily.

Several improvements have been made to the HTML documentation:

- You can now use a template to improve the HTML documentation output (see page 43).
- You can now include images and comments in the documentation (see page 45).
- You can create HTML documentation from the command prompt (see page 46).
**HTML documentation: Using a template**

You can now use a template when creating HTML documentation from a CNC file to improve the output.

### HTML documentation without template:

### HTML documentation with template:

---

**Creating HTML documentation**

To create HTML documentation for a CNC file:

1. In XBUILD, select one of the **File > Document CNC > HTML** menu options.

To create documentation without a template, select **HTML Standard**.

To create documentation using a template, select **HTML With Template**.

The **Save As** dialog is displayed.

2. Browse to the location in which you want to save the HTML file.

3. Click **Save**.

   If you are using a template, the **Open** dialog is displayed.

4. Select the html template file you want to use to create the documentation.
The default template location is Program Files > Delcam > FeatureCAM > Posts > HTMLDocTemplate.html.

5 Click Open.

Editing the template

You can edit the template to customize the style and content of the HTML documentation.

The default template location is in the FeatureCAM > Posts folder. To customize the template, replace it with a file with the same name or customize the template file directly (remember to save a backup).

The template is responsible for providing most of the HTML. For example, it must include the `<html></html>`, `<head></head>`, `<title></title>`, and `<body></body>` tags. You can also include the `<style></style>` tags to write your own custom CSS. Consider the template a standalone HTML file, it must be able to display correctly in a browser.

When you output the documentation, the tags in the template are replaced with corresponding information from the post. For example, if the `{general info}` tag is included in the template, the html output includes the post's general information.

If the `{machine image}` tag is included in the template, any image in the same directory as the post is included in the HTML documentation.

You can include plain text in the template which is displayed in the HTML documentation, such as introductions and additional information.
**HTML documentation: Inserting images and comments**

You can now add images to HTML documentation when using a template, and you can add comments to post variables to document their usage.

To add an image to the HTML documentation, include it in the same directory as the CNC file.

To add a comment about a post variable, select a variable in the **Post Variable Names** dialog and enter a **User-visible Name** and a **Comment**.

![Post Variable Names dialog](image)

The name and comment are displayed in the HTML documentation:

<table>
<thead>
<tr>
<th>Designated Post Variable Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
</tr>
</tbody>
</table>

These comments are not displayed in FeatureCAM or in the other documentation formats.
**HTML documentation: Using the Command prompt**

You can now use the command prompt to create HTML documentation for a CNC file without using XBUILD, which enables you to use scripts more easily.

To create the HTML documentation without a template, enter this into the command prompt:

"Path & filename of XBUILD" /html "Path & filename of CNC" "Path & filename of html file"

To create the HTML documentation using a template, enter this into the command prompt:

Machine Design

FeatureCAM 2016 R2 contains this improvement to machine design:

- **Adding tool locations to tool blocks** (see page 48) — You can now specify whether to locate the tool tip or the back of the tool holder.
Adding tool locations to tool blocks

When adding tool locations to tool blocks, you can now specify the tool tip location instead of the back of the tool holder.

This enables you to program complex machines more easily, as the geometry of many gang tool posts is such that it is better to specify the location of the tool tip instead of the back of the tool holder.

Select the new option in the Tool Information dialog when adding a tool location in a turning machine.

This affects the tool location wire frame preview and machine simulation.

Tool location at back of tool holder:

Tool location at tool tip:
What's new in FeatureCAM 2016 R1

FeatureCAM 2016 R1 contains the following new features and enhancements:

User interface
- **Reference help PDF** (see page 54) — The FeatureCAM Reference help is now available as a PDF file.
- **Highlighting objects from the Part View** (see page 55) — You can now highlight objects in the graphics window by moving the cursor over the object's name in the Part View.
- **Creating Setups during IFR** (see page 56) — You can now create Setups from within the New Feature wizard when using Interactive Feature Recognition.
- **Changing the simulation tool color** (see page 57) — You can now manually change the tool color at any time in a simulation.
- **Displaying NC Code** (see page 58) — NC code is now displayed using fixed width text, where all the characters line up vertically, to make it easier to read.
- **Creating curves** (see page 59) — The images in the curve creation dialogs have been improved to make them easier to understand.

Importing
- **Imported solid names** (see page 61) — When you import a solid into FeatureCAM the solid name is now retained from the original program.
- **Importing AutoCAD files** (see page 61) — You can now import ACIS solids from DWG files.
- **Spatial R25 SP2 Interop integrated** (see page 62) — Spatial R25 SP2 Interop is now integrated.
- **Parasolid v27.1** (see page 62) — FeatureCAM now supports parasolid v27.1.

Milling
- **Vortex non-cutting moves** (see page 64) — You now have more control over the non-cutting moves in vortex toolpaths.
- **Collision avoidance** (see page 65) — Toolpaths are now collision-checked between unmachined stock and the shank and holder.
- **Swarf machining Z limits** (see page 66) — You can now limit Swarf operations to within a specified Z range on the surface.

- **5-Axis 2D spiral toolpaths** (see page 68) — You can now specify axis smoothing options for 2D spiral toolpaths.

- **Side grooves** (see page 69) — The toolpath calculation for ID and OD Grooves has been improved with several new options and supported functions.

- **Multiple coolant types** (see page 71) — You can now use multiple coolant types for a single operation.

- **User Defined Stock for NT toolpaths** (see page 72) — When using a stock solid and you create a 2D NT toolpath, FeatureCAM now calculates the toolpaths using the stock solid boundary to prevent air-cutting.

**Turning**

- **Turning tool orientation** (see page 74) — You can now use a turning tool in multiple orientations without having to create a different tool in the database for each orientation.

- **Roughing engage angle** (see page 76) — You can now specify the engage angle, lead in angle, and lead out angle for Turning roughing operations.

- **Negative leave allowance for grooves** (see page 77) — You can now use a negative leave allowance for groove features created from curves.

**Add-ins and extensions**

- **Setup Sheet add-in** (see page 79) — There are new tags which you can use to create more useful setup sheets.

- **FeatureCAM to CAMplete** (see page 80) — In the FeatureCAM to CAMplete dialog (see page 166), there is a new button that enables you to mark solids that are selected in the part as clamps.

- **API improvements** (see page 80) — The API has been improved to support full machine architecture.

- **Nesting add-in** (see page 81) — You can now use PowerSHAPE's nesting tool to nest parts in FeatureCAM.

- **Import Vise add-in** (see page 83) — You can now import vises into FeatureCAM for 3D simulation and gouge checking.

- **Bar-fed mills support** (see page 85) — Bar-fed mills are now supported, such as the Willemian-Macodel 408MT and Mazak integrex i-150.
**XBUILD**

- **Intermediate CNC files** (see page 87) — You can now split the nc file into multiple intermediate files, and then combine these intermediate files in different ways to create multiple output files.

- **Multi-code coolant** (see page 89) — You can now use different on and off codes for a single coolant type, depending on which turret and tool is being used.

- **5-axis untransformed coordinates** (see page 91) — There are new milling reserved words that contain the untransformed X, Y, and Z coordinates in a 5-axis part.

- **Formatting reserved words** (see page 92) — When formatting numeric reserved words in XBUILD, you can now remove trailing zeros from integer values without removing the decimal point.

- **CNC documentation** (see page 93) — The HTML documentation has been improved to make the output more readable.
User Interface and work-flow

FeatureCAM 2016 R1 contains the following changes and improvements to the user interface and work-flow:

- **Reference help PDF** (see page 54) — The FeatureCAM Reference help is now available as a PDF file.

- **Highlighting objects from the Part View** (see page 55) — You can now highlight objects in the graphics window by moving the cursor over the object's name in the Part View.

- **Creating Setups during IFR** (see page 56) — You can now create Setups from within the New Feature wizard when using Interactive Feature Recognition.

- **Changing the simulation tool color** (see page 57) — You can now manually change the tool color at any time in a simulation.

- **Displaying NC Code** (see page 58) — NC code is now displayed using fixed width text, where all the characters line up vertically, to make it easier to read.

- **Creating curves** (see page 59) — The images in the curve creation dialogs have been improved to make them easier to understand.
Reference help PDF

The FeatureCAM Reference help is now available as a PDF file, which enables you to print it to use away from your computer.

Select the new Help > Reference (PDF) to display the Reference help PDF.
Highlighting objects from the Part View

You can now highlight objects in the graphics window by moving the cursor over the object's name in the Part View. This enables you to find features quickly and improves the work-flow in complex documents.

For example, move the cursor over an object in the Part View:

The object is highlighted in green in the graphics window:

To turn off this option, deselect Show feature dynamic highlight on the General tab of the Viewing Options dialog.
Creating Setups during IFR

When creating Milling and Wire EDM features using Interactive Feature Recognition, you can now create Setups from within the New Feature wizard. This enables you to program parts with multiple setups more quickly.

To create a Setup using the New Feature wizard:

1. In the New Feature wizard, select the feature type you want to recognize.
2. Select Extract with FeatureRECOGNITION.
3. Click the new Create new setup button.

The Setup wizard is displayed.

4. Use the Setup wizard to create a new setup, then click Finish.

The New Feature wizard is displayed.

You can use the Create new setup button to create more setups, or click Next and use the New Feature wizard to create features.
Incrementing tool color in simulation

You can now manually change the tool color at any time in a simulation to make it easier to understand the toolpaths and see the tool simulation. For example you can use this to display different passes of an operation in different colors to check for air cutting.

This is only available for 3D, 3D rapid cut and machine simulations.

To change the tool color during a simulation:

1. In the Simulation Options dialog, on the General tab, ensure Tool Colors is selected.
2. Run a simulation.
   The tool color is displayed during the simulation.
3. Click the new Change the Simulation Tool Color button.
4. Continue the 3D simulation.
   The tool color is changed in the simulation.
Displaying NC Code

NC code is now displayed using fixed width text, where all the characters line up vertically, to make it easier to read.

You can display the NC Code in a variable-width font by right-clicking in the **NC Code** window and deselecting **Fixed Width Font**. Variable-width text requires less horizontal space.

Variable width

Fixed width
Creating curves

The images in the curve creation dialogs have been improved to make them easier to understand.

Letters are now used to show dimensions instead of arrows.

![Curve creation dialog](image)
Importing

FeatureCAM 2016 R1 contains the following changes and improvements to importing:

- **Imported solid names** (see page 61) — When you import a solid into FeatureCAM the solid name is now retained from the original program.

- **Importing AutoCAD files** (see page 61) — You can now import ACIS solids from DWG files.

- **Spatial R25 SP2 Interop integrated** (see page 62) — Spatial R25 SP2 Interop is now integrated.

- **Parasolid v27.1** (see page 62) — FeatureCAM now supports parasolid v27.1.
Solid names

When you import a solid into FeatureCAM the solid name is now retained from the original program. Previously, imported solids were named `ps_solid` and numbered sequentially.

This applies when importing X_T, SolidWorks, SolidEdge files, when pasting from PowerSHAPE, and for any solids imported using Exchange.

You can turn this off with the `importUseParasolidName` variable in the INI file.

Importing AutoCAD files

You can now import AutoCAD files using the FeatureCAM native import. Previously you could only import using Exchange. The FeatureCAM native import is quicker, and enables you to import 3DSOLID, REGION, and BODY entities as solids, instead of as a collection of surfaces.

When you import an AutoCAD file that contains solids, the AutoCAD Import Method dialog is displayed.

Select Natively within FeatureCAM... and click OK to use FeatureCAM’s native import.

For some files this may behave differently to the old method of importing using Exchange. To use the old method of importing, select the File > Import Using Exchange menu option.
Spatial R25 SP2 Interop integrated
Spatial R25 SP2 Interop is now integrated.
3D InterOp-enabled applications now support CATIA V5-6 R2015 and NX 10.

Parasolid v27.1
FeatureCAM now supports parasolid v27.1.
Milling

FeatureCAM 2016 R1 contains the following changes and improvements to milling:

- **Vortex non-cutting moves** (see page 64) — You now have more control over the non-cutting moves in vortex toolpaths.
- **Collision avoidance** (see page 65) — Toolpaths are now collision-checked between unmachined stock and the shank and holder.
- **Swarf machining Z limits** (see page 66) — You can now limit Swarf operations to within a specified Z range on the surface.
- **5-Axis 2D spiral toolpaths** (see page 68) — You can now specify axis smoothing options for 2D spiral toolpaths.
- **Side grooves** (see page 69) — The toolpath calculation for ID and OD Grooves has been improved with several new options and supported functions.
- **Multiple coolant types** (see page 71) — You can now use multiple coolant types for a single operation.
- **User Defined Stock for NT toolpaths** (see page 72) — When using a stock solid and you create a 2D NT toolpath, FeatureCAM now calculates the toolpaths using the stock solid boundary to prevent air-cutting.
Vortex non-cutting moves

You now have more control over the non-cutting moves in vortex toolpaths, which enables you to reduce machining times. Use the new **Vortex Non-Cutting Moves** dialog to specify whether to retract and increase the feed rate on non-cutting moves.

To display the **Vortex Non-Cutting Moves** dialog:

- for 2D toolpaths, click **Non-Cutting Moves** in the **Stepovers** tab of the **Feature Properties** dialog.
- for 3D toolpaths, click **Non-Cutting Moves** in the **Strategy** tab of the **Feature Properties** dialog.
- to change the default options, click **Non-Cutting Moves** in the **Milling** tab of the **Machining Attributes** dialog.

Under **Retract on non-cutting moves**, select whether you want the tool to retract on non-cutting moves:

- **Never** — the tool does not retract on non-cutting moves.
- **Automatic** — FeatureCAM will decide when the tool should retract on non-cutting moves.
- **Longer than** — the tool retracts instead of making non-cutting moves larger than the value you enter. For example, the left image is a standard vortex toolpath and in the right image the non-cutting moves are replaced with retracts.
Select **Increase feed rate for non-cutting moves** to override the feed rate for non-cutting moves with the specified **Non-cutting feed rate**. If the **Non-cutting feed rate** is lower than the Feed rate specified on the F/S tab, the **Non-cutting feed rate** is ignored.

**Collision avoidance**

Toolpaths are now collision-checked between unmachined stock and the shank and holder. Previously, you could only collision-check the shank and holder against the model, not the stock.

2016 R1  
2015 R3

To enable collision-checking against the shank and holder, select **Holder collision clipping** on the **Strategy** tab of the **Feature Properties** dialog.
**Swarf machining Z limits**

You can now limit Swarf operations to within a specified Z range on the surface. This enables you to limit air cutting, such as by limiting the toolpath where part of a surface has already been machined, and gives you more control when using swarf machining with other operations.

This was previously available for most 3D finish operations except swarf.
To specify the Z limits, use the new **Z start** and **Z end** attributes in the **Milling** tab of the **Feature Properties** dialog.

Select **Z start** or **Z end** to display the location of the Z limits in the graphics window.

The toolpath follows the isolines of the surface, but the toolpath is clipped above and below the specified Z level.

**5 Axis simultaneous**

For 5 axis simultaneous machining, you may not be able to enter values accurately for **Z start** and **Z end** depending on the rotation of the view and the axes, but you can use the **Pick Z location** button to pick the location in the graphics window and FeatureCAM will calculate the required value.
5-axis 2D spiral toolpaths

In FeatureCAM 2015 R3, the 5-Axis tab was made available for 2D spiral toolpaths, which enables you to perform 5-axis engraving (see page 753).

You can now specify axis smoothing options using the Axis Smoothing tab, which enables you to create smoother toolpaths which give a better surface finish and reduce tool wear.

To display the Axis Smoothing tab, ensure Tool axis smoothing is selected on the 5-Axis tab, then click Apply.
Side grooves

The toolpath calculation for ID and OD Grooves has been improved with several new options and supported functions. This gives you more control when creating side groove features, so you can create better and smoother toolpaths with better gouge checking.

To enable the new toolpath calculation, select **Use New ID/OD Groove** on the **Milling** tab of the **Machining Attributes** dialog.

When this option is selected, these changes are made to side groove toolpaths:

- The plunge and retract moves are checked for gouges.
  
  You can disable the gouge checking on plunge and retract moves by deselecting the **Plunge gouge check** option on the **Strategy** tab of the **Feature Properties** dialog.

- You can use wind fan finishing for the finish operation.
  
  To specify the wind fan settings, click **Wind Fan** on the **Strategy** tab of the **Feature Properties** dialog, and use the **Wind Fan Finish Options** dialog (see page 1643).
- You can use arc lead-in moves for the finish operations. Previously you could only use a linear lead-in move.
  To use an arc lead-in move, select Arc Lead on the Stepovers tab of the Feature Properties dialog.

- You can set a start point for the finish pass.
  To set a start point, use the Start point attribute on the Plunge tab of the Feature Properties dialog.

To create a side groove feature, create a Groove feature and select the Inside/Outside option on the Dimensions tab of the Feature Properties dialog.
Multiple coolant types

You can now use multiple coolants for a single operation. Previously you could only use one type of coolant for an operation.

There is a new Coolant tab where you can specify the types of coolant for an operation. Previously, you selected the coolant type from a list on different tabs depending on the operation type.

The new Coolant tab is available in these places:

- Set the coolant for an operation in the Feature Properties dialog.
- Set the default coolant for a tool in the Tool Properties dialog.
- Set the default coolant for the document in the **Machining Attributes** dialog, for both Mill and Turn.

![Machining Attributes dialog](image)

**User Defined Stock for NT toolpaths**

When using a stock solid and you create a 2D NT toolpath, FeatureCAM now calculates the toolpaths using the stock solid boundary to prevent air-cutting. Previously this was only available for OT toolpaths.

In this example, a Boss feature is cut using a stock solid.

2015 R3: ![Diagram](image) 2016 R1
Turning

FeatureCAM 2016 R1 contains the following changes and improvements to turning:

- **Turning tool orientation** (see page 74) — You can now use a turning tool in multiple orientations without having to create a different tool in the database for each orientation.

- **Roughing engage angle** (see page 76) — You can now specify the engage angle, lead in angle, and lead out angle for Turning roughing operations.

- **Negative leave allowance for grooves** (see page 77) — You can now use a negative leave allowance for groove features created from curves.
Turning tool orientation

You can now use a turning tool in multiple orientations without having to create a different tool in the database for each orientation.

For example, this tool is used in two orientations, but only one tool is required in the tool database.

Previously, to use a tool in multiple orientations you had to create duplicates of the tool, and select the tool orientation on the Orientation tab of the Tool Properties dialog.
Select the new **Automatic tool orientation** option in the **Misc** tab of the **Machining Attributes** dialog.

When **Automatic tool orientation** is selected, only tools in the default orientation are available, but the specified tool orientation is ignored and a tool can be used in any orientation.

For example, for OD turning operations, only tools with a SW orientation are available:
If you have any tools in the non-default orientation, specify the orientation as default and you can use it in any orientation, otherwise the tool will not be available.

Roughing engage angle

You can now specify the engage angle, lead in angle, and lead out angle for Turning roughing operations. Previously you could specify these options only for the finish pass.

This enables you to prevent the tool from plunging directly into the stock, reducing the load on the tool.

Engage angle

To specify the engage angle for a roughing operation, set the new Engage angle option on the Turning, Facing, or Boring tab of the Feature Properties dialog.

You can enter an Engage angle between 0 and 90. The tool engages the part at the specified angle for boundary moves, but a lower value may be used if the value you enter would be above the rapid level.

Lead in and lead out angle

To specify the lead in and lead out angles for a roughing operation, ensure the TNR comp option is selected on the Strategy tab of the Feature Properties dialog, and set a Lead in angle and Lead out angle on the Turning, Boring, or Facing tab.

The tool engages the part at the lead in angle for boundary moves and disengages the part at the lead out angle.
Default values

You can set the default values for these angles on the Turn/Bore tab of the Machining Attributes dialog.

Previously you could set the default Engage angle, Lead in angle, and Lead out angle. You can now set these options separately for rough and finish operations.

Negative leave allowance for grooves

In FeatureCAM you can set a leave allowance to leave unmachined material after a finish pass, and you can set a negative leave allowance to machine past the feature boundary, such as to allow for shrinkage.

You can now use a negative leave allowance for Groove features created from curves. Previously, this was only available for Grooves created from dimensions.

You can edit the Leave allowance attribute for an operation on the Turning tab of the Feature Properties dialog.
Add-ins and extensions

FeatureCAM 2016 R1 contains the following changes and improvements to add-ins and extensions:

- **Setup Sheet add-in** (see page 79) — There are new tags which you can use to create more useful setup sheets.

- **FeatureCAM to CAMplete** (see page 80) — In the *FeatureCAM to CAMplete* dialog (see page 166), there is a new button that enables you to mark solids that are selected in the part as clamps.

- **API improvements** (see page 80) — The API has been improved to support full machine architecture.

- **Nesting add-in** (see page 81) — You can now use PowerSHAPE's nesting tool to nest parts in FeatureCAM.

- **Import Vise add-in** (see page 83) — You can now import vises into FeatureCAM for 3D simulation and gouge checking.

- **Bar-fed mills support** (see page 85) — Bar-fed mills are now supported, such as the Willem-Macodel 408MT and Mazak integrex i-150.
Setup Sheet add-in

You can use the SetupSheet.dll (see page 177) add-in to generate html setup sheets from your document to give information to the machine operator about the manufacturing, tooling, and toolpaths of a part.

There are new tags which you can use to create more useful setup sheets:

- **Turn tool orientation**
  - `operation.tool_holder_orientation` — tool holder orientation (for lathe and thread tools)
    
    You can use this with or without the new Automatic tool orientation option (see page 74).

- **Spot drill body diameter**
  - `use_order_tool.body_diameter` — tool body diameter (User Order Tool Loop)
  - `operation.tool_body_diameter` — tool body diameter (Setup Loop)
  - `tool.body_diameter` — tool body diameter (Tool Loop)

- **Drill cycle and first peck**
  - `operation.drill_cycle_type` — drill cycle type of the operation
  - `operation.drill_peck_depth` — peck depth of a drill operation
  - `operation.drill_peck_depth2` — peck depth 2 of a drill operation
  - `operation.drill_min_peck` — min peck of a drill operation

- **Operation number**
  - `operation.number` — the operation number displayed in the Details tab of the Results window in FeatureCAM

- **The CNC post processor file name**
  - `fm.cnc_file_name` — The name of the cnc file used to generate the nc code.

- **Tool list. See the Setup Sheet help for how to use these options.**
  - **Show a tool only once in the operation list, even when it is used in multiple operations.**
• List only the tools you have marked. You can mark tools by adding \_SHOWTOOL to the Comments field in the Tool Properties dialog.

To see the Setup Sheet help, click the Help button in the Setup Sheet Options dialog.

FeatureCAM to CAMplete

CAMplete TruePath is an application that you can use to analyze, modify, optimize, simulate and post 5-Axis toolpaths. You can use the FeatureCAM to CAMplete add-in to export a document to use with CAMplete TruePath.

In the FeatureCAM to CAMplete dialog (see page 166), there is a new button that enables you to mark solids that are selected in the part as clamps.

To mark selected solids as clamp solids, click Select solids selected in the part.

The solids are selected in the Select solids to be exported as clamps list.

FeatureCAM API improvements

The API has been improved to support full machine architecture:

• pallet changes are now supported.
• you can temporarily disable gouge checking between solids.
• you can temporarily remove a solid from the machine heirarchy.
• you can move the tool change location.
• you can query the current operation, feature, tool and setup.

See the FeatureCAM API help for more information. Select the Help > FeatureCAM API help menu option to display the FeatureCAM API help.
Nesting add-in

There is a new Nesting add-in that you can use to nest multiple parts and machine them from a single stock using PowerSHAPE's nesting tool.

You must have PowerSHAPE open to use the add-in, and you can only nest parts which have a solid model.

To use the Nesting add-in:

1. Load the **Nesting.bas** add-in.
2. On the **Utilities** toolbar, click **Nesting**.
   
   The **Nesting To FeatureCAM** dialog is displayed.

3. In the **Stock** list, select the block in which you want to nest the parts.
   
   Select an existing block to nest additional parts in a block you created previously, or select **New Block** to start a new block.

4. In the fields around the stock diagram, enter the dimensions of the block in which you want to nest the parts.

5. Enter the **Distance between parts** to specify the minimum distance you want to leave between the nested parts on the block.
6 Enter a **Text height** to specify the height of the label on each part.

7 Click **Add** and use the **Open** dialog to select the parts you want to nest.

8 Enter the **Quantity** to specify how many duplicates of each part you want to nest in the block.

9 Enter the **Priority** to determine which parts to nest first. The parts with lowest **Priority** values are nested first. For parts with the same **Priority** value, the largest parts are nested first.

10 Enter the **Rotation increment** to specify the smallest increment by which the part can be rotated when nesting. You may be able to fit more parts in a block by reducing the **Rotation increment**.

11 To remove a part from the dialog, select the row and click **Delete**.

12 Click **OK** to nest the parts.

   FeatureCAM opens each file and puts all the features into a group, then adds the features to a new FM file. The solids are sent to PowerSHAPE and nested using PowerSHAPE's nesting tool.

   When the nesting is completed in PowerSHAPE, a message dialog is displayed telling you to modify the positions of the parts in PowerSHAPE if necessary.

13 Modify the position of the parts in PowerSHAPE, then click **OK** to close the message dialog.

   The positions of the parts are updated in FeatureCAM.

   A message dialog is displayed asking if you want to save the stock.

14 Click **Yes** to run a 3D simulation and save the stock. This enables you to nest additional parts in this block later.

   You can select saved stocks in the **Stock** list in the **Nesting To FeatureCAM** dialog to nest additional parts in a saved stock.

   A message dialog is displayed saying the nesting is completed.

15 Click **OK** to close the dialog.
Import Vise add-in

There is a new Import Vise add-in that you can use to import vises into FeatureCAM for 3D simulation and gouge checking.

1. Load the `Import_Vise.bas` add-in.
2. On the Utilities toolbar, click `Import_Vise`.
   The Import Vise dialog is displayed.

3. In the Vise list, select the vise you want to import.
   A preview of the vise is displayed in the dialog.

Vises

1. Select an option in the Part position in vise list to specify how to align the part in the vise.
2. Under Part along, select the axis that you want to be perpendicular to the jaws to specify the orientation of the part in the vise.
3. Under X offset from position, enter the offset of the part along the axis parallel to the jaws. You can enter a negative value.
   For example, select a Part position in vise of Left and enter a X offset from position of -1 to extend the part by 1 inch past the left edge of the jaws.
4. Under Amount of part held, enter the height at which to hold the part in the vise. If this value is set to 0 it is ignored and the part is held at the bottom of the vise.
   This option is unavailable when using parallels.
5. Under Jaws position, select how you want to position the jaws to hold the part.
For **Selected Solid Faces, Selected Surfaces, and Selected geometry**, select items in the graphics window.

6 For vises with multiple holding positions, select **Alternative holding** to use the alternative holding position.

7 To add parallels to raise the part in the vise, select **Add parallels** and select the **Parallels dimensions** from the list.

8 Click **Import** to import the vise.

**Turning chucks**

1 Under **Part along**, select the axis about which the chuck rotates to specify the orientation of the part in the vise.

2 Under **Z offset from position**, enter an offset to raise or lower the part in the jaws.

3 Under **Part length from Jaws Faces**, enter the length of part you want to extend past the top of the jaws.

4 Under **Jaws position**, select how you want the jaws to hold the part.
   
   For **Selected Solid Faces**, select solid faces in the graphics window.

5 Select the **Jaws types** you want to use.

6 Click **Import** to import the vise.
Bar-fed mills support

Bar-fed mills are now supported, such as the Willemin-Macodel 408MT and Mazak integrex i-150. Bar-fed mills enable you to machine multiple parts from bar stock, and to automatically transfer the machined slugs to the sub-spindle to machine the cut-off face. This eliminates the need for manually positioning the part, which can be a source of inaccuracy.

This requires a UDF add-in, and a customized MD file and post.
XBUILD

FeatureCAM 2016 R1 contains the following changes and improvements to XBUILD:

- **Intermediate CNC files** (see page 87) — You can now split the nc file into multiple intermediate files, and then combine these intermediate files in different ways to create multiple output files.

- **Multi-code coolant** (see page 89) — You can now use different on and off codes for a single coolant type, depending on which turret and tool is being used.

- **5-axis untransformed coordinates** (see page 91) — There are new milling reserved words that contain the untransformed X, Y, and Z coordinates in a 5-axis part.

- **Formatting reserved words** (see page 92) — When formatting numeric reserved words in XBUILD, you can now remove trailing zeros from integer values without removing the decimal point.

- **CNC documentation** (see page 93) — The HTML documentation has been improved to make the output more readable.
Intermediate CNC files

You can now split the nc file into multiple intermediate files, and then combine these intermediate files in different ways to create multiple output files. This gives you more control over the nc code files you create.

For example, you can use this to create a tool list at the start of the output file easily without needing to use a macro, by separating each line of tool information into an intermediate file, and placing it at the beginning of the output file.

You can also use this to group Wait codes together and output them at a single point in the post, and avoid mismatched wait codes when outputting to multiple channels.

To use multiple output streams for the nc code:

1. In XBUILD, select the **CNC-Info > Manage Files** menu option to display the new **Files** dialog.

2. Select **Use Output Streams**.

3. Under **Intermediate Files**, select the intermediate nc files you want to create and enter a **Name**.

   Each intermediate file has a number, which you can use to send individual lines of the nc code into different intermediate files.
4 Under **Output Files**, specify the final nc files you want to create and output from FeatureCAM.
   a Enter the **File Suffix** and **Ext** to specify the suffix and extension that will be applied to the file you output.
   b Under **Source List**, enter the intermediate files you want to combine to create the output file.
      
      In the example above, the **NC Code** output file includes all the intermediate streams, and the **ToolList** output file includes only the tool list intermediate file.
   c Enter the **Display Name**. This is the name of the nc file when displayed in the **NC Code** tab of the **Results** window in FeatureCAM.

5 Add the new reserved words to a format to separate the lines of nc code into the intermediate files.
   - `<F1>` to `<F20>` — Use this word at the start of a line to send the line to an intermediate file.
   - `<SET-F1>` to `<SET-F20>` — Use this word at the start of a line to send all proceeding information to an intermediate file, including in other formats.

   *Alternatively you can use the intermediate file name, such as `<F:start>` and `<Set-F:start>).*

   For example, use `<F10>` before the tool name in the Tool Change format to send the tool name to the tenth intermediate file. Use `<SET-F1>` at the beginning of the Program Start format to send all nc code except the tool names to the first intermediate file.

6 Simulate the toolpaths in FeatureCAM.

7 In the **NC Code** tab of the **Results** window, select an output file in the list to display it.

8 Use the **Save NC** dialog to save the nc code output files.
Multi-code coolant

You can now use different on and off codes for a single coolant type, depending on which turret and tool is being used.

To use multi-code coolant:

1. In XBUILD, in the Coolant dialog, select the new Multi-code option to enable multi-code coolant for a coolant type.

2. Click Configure to display the Coolant Configuration dialog.

3. For each row, select the Tool Posts for which you want to specify the On and Off Codes.

4. Enter the Tool Range, the range of tool numbers for which you want to specify the On and Off Codes.

5. Enter the On and Off Codes.

6. If needed, click Add Row to add more rows.

7. Click OK to close the dialog.
8 In the Coolant dialog, under Separate codes with, select an option to determine how to separate multiple codes when they are used together in the NC code.

**Newline** — Select this option to use a line break between coolant codes in the NC code.

**Space** — Select this option to use a space between coolant codes in the NC code.

**Nothing** — Select this option to not separate coolant codes in the NC code.

**Other** — Select this option and enter a string to use between coolant codes in the NC code.

9 Click OK to close the dialog.
5-axis untransformed coordinates

There are new milling reserved words that contain the untransformed X, Y, and Z coordinates in a 5-axis part. For example, you can use these in a post for positioning before turning on the RTCP transformation.

The new reserved words are:

- `<UNXFORM-X-COORD>`
- `<UNXFORM-Y-COORD>`
- `<UNXFORM-Z-COORD>`

These are only valid in the Program Start, Segment Start and Tool Change formats.
**Formatting reserved words**

When formatting numeric reserved words in XBUILD, you can now remove trailing zeros from integer values without removing the decimal point. Use this option to ensure numeric reserved words are interpreted correctly by your machine tool controller.

In the **Word Formatting** dialog, select **Minimize width** to remove the trailing zeros and select the new **Keep Decimal Points** option to keep the decimal point.

For example, when **Keep Decimal Points** is deselected, a value of 5 is output as 5, when **Keep Decimal Points** is selected, it is output as 5.0.

**Keep Decimal Points**
- Deselected:
  - Value 5 is output as 5
- Selected:
  - Value 5 is output as 5.0
CNC documentation

In XBUILD, you can select the File > Document CNC > HTML menu option to create HTML documentation about the CNC file.

The HTML documentation has been improved to make the output more readable:

- The CSS and HTML style has been modified to better present the output.
- Sections of the documentation with no content are not displayed in the output.
- Unnamed post variables are not displayed in the output.
- Some sections of the documentation have been removed, such as Motion Commands, Spindle, Synchronize Spindles, Compensation Commands, Stop Commands, Airblast, and Circular Planes.
- Unnecessary data has been removed from the General Info, Machine Info, Turret Info, Feeds and Speeds Info, Milling Cycle, and Turning Cycle sections.
- Several section headers have been renamed, and table elements have been reworded to be more clear.
What's new in FeatureCAM 2015 R3

FeatureCAM 2015 R3 contains the following new features and enhancements:

**User interface**

- **Improved icons** (see page 97) — Several icon graphics across FeatureCAM have been updated.
- **Selecting objects** (see page 98) — There is a new **Select Partial** mode.
- **Inserting Part Library features** (see page 99) — You can now use the **New Feature** wizard to insert Part Library features into a document.
- **Pasting features using polar coordinates** (see page 101) — You can now use polar coordinates to locate features in the **Paste Special** wizard.
- **Deleting unused curves** (see page 103) — There is a new add-in that you can use to identify all unused curves in a model and delete them.

**Importing**

- **Importing SolidWorks 2015 files** (see page 105) — You can now import SolidWorks 2015 files into FeatureCAM.
- **Importing SolidEdge ST7 files** (see page 106) — You can now import SolidEdge ST7 files.
- **Spatial R25 SP1 Interop integrated** (see page 106) — Spatial R25 SP1 Interop is now integrated.

**Milling**

- **Creating Faces features using IFR** (see page 108) — You can now automatically round the corners of Face features that are created using Interactive Feature Recognition.
- **Automatic tool selection** (see page 110) — You can now specify an additional clearance on the automatic tool selection to ensure the tool holder does not collide with the stock.
- **Simulating tool holders** (see page 112) — You can now simulate complicated tool holders more accurately.
- **Machine movement limits** (see page 113) — You can now display a warning message when the machine exceeds its limits of movement during machine simulation.
Turning and Turn/Mill

- **Indexing using a stock solid** (see page 116) — You can now calculate the index height directly from the stock solid, instead of calculating it above a square bounding box.
- **Setting the program point for turnmilling tools** (see page 118) — You can now specify the program point for turnmilling tools.
- **Turning head tool holders** (see page 119) — Turning head tool holders are now supported.

5-axis machining

- **C-axis indexing** (see page 124) — You can now specify the C-axis position of the part in the machine at the start of an operation.
- **5-axis engraving** (see page 126) — You can now create 5-axis engraving features with the tool axis normal to the surface.

Machine Design

- **Specifying machine movement limits** (see page 129) — You can now set the limits of movement for solids in a Machine Design file.
- **Testing machine movements** (see page 130) — You can now use machine jogging to simulate the movement of solids in a Machine Design document without having to use an FM file.
- **Simulating mini-turrets** (see page 132) — You can now simulate mini-turrets, which are tools with multiple inserts where the tool rotates around the b-axis to access each tool.
User Interface

FeatureCAM 2015 R3 contains the following changes and improvements to the user interface:

- **Improved icons** (see page 97) — Several icon graphics across FeatureCAM have been updated.
- **Selecting objects** (see page 98) — There is a new Select Partial mode.
- **Inserting Part Library features** (see page 99) — You can now use the New Feature wizard to insert Part Library features into a document.
- **Pasting features using polar coordinates** (see page 101) — You can now use polar coordinates to locate features in the Paste Special wizard.
- **Deleting unused curves** (see page 103) — There is a new add-in that you can use to identify all unused curves in a model and delete them.
Improved icons

Several icon graphics across FeatureCAM have been updated to improve the user interface, including:

- Feature Properties dialog
- Part View
- Part Library
- Tombstone Process Plan dialog
Selecting objects

There is a new **Select Partial** mode, which enables you to box-select items by partially selecting them. This improves work-flow when selecting multiple items, and enables you to select items more easily in complicated documents.

To enable the new **Select Partial** mode:

- In the **Standard** toolbar, in the **Select Menu**, select **Select Partial**.

- Select the **Edit > Select > Box Select Partial** menu option.

Click and drag to select objects. You do not need to enclose an object to select it. In the example below, all three features are selected:
Inserting Part Library features

You can now use the **New Feature** wizard to insert Part Library features into a document.

Adding features to the Part Library

To add a feature to the Part Library:

1. Select the **Construct > Part Library** menu option.
   
The Part Library dialog is displayed.
2. Select a feature in the **Tree View** or graphics window.
3. In the Part Library dialog, click **Add Selected**.
   
The selected feature is added to the list in the Part Library dialog.
4. Click **OK** to close the dialog.

Inserting features from the Part Library into the document

To use the Part Library in the **New Feature** wizard:

1. Click the **Features** step in the **Steps** panel to display the **New Feature** wizard.
2. In the **New Feature** wizard, under **From Feature**, select **User** and click **Next**.
   
The User defined feature page is displayed.
   
The Part Library features are displayed in the **Registered features** list.
3. Select a feature in the list and click **Next**.
   
The Paste Special dialog is displayed.
4. Use the **Paste Special** dialog (see page 1497) to insert the selected feature into the document, then click **Finish** to close the dialog.
5 The **User defined feature** page of the **New Feature** wizard is displayed.

6 Use the wizard to insert more features from the Part Library, or click **Cancel** to close the wizard.
Pasting features using polar coordinates

You can now use polar coordinates to locate features in the Paste Special wizard. This gives you more control when duplicating features and when using the Part Library (see page 1501).

You can only use polar coordinates to locate individual features.

To duplicate a feature into a new location using polar coordinates:
1. Right-click a feature in the Part Tree, and select Copy.
2. Select the Edit > Paste Special menu option.
   The Paste Special wizard is displayed.
3. Select Paste the clipboard contents. Select a new location and click Next.
   The Reference page of the Paste Special wizard is displayed.
4. Click Next. You do not need to specify a reference location.
   The Location page of the Paste Special wizard is displayed.
5. Select the new Polar option.

6. Enter the Radius and Angle to offset the new feature from the setup location.
7. Enter the Z value to specify the Z height of the feature above the setup.
8. Click Preview to display a preview of the new feature in the graphics window.
9 Click **Finish** to create the new feature and close the wizard.
Deleting unused curves

There is a new `delete_curves.bas` add-in that you can use to identify all unused curves in a model and delete them.

To delete all unused curves in a document:

1. Load the `delete_curves.bas` add-in using the Macro Add-ins dialog.
2. In the Utilities toolbar, click `deletecurves`.
3. The Curve Information dialog is displayed, which contains a list of unused curves in the document.
4. Click OK to delete all unused curves and close the dialog.
Importing

FeatureCAM 2015 R3 contains these changes and improvements to importing files from external applications:

- **Importing SolidWorks 2015 files** (see page 105) — You can now import SolidWorks 2015 files into FeatureCAM.
- **Importing SolidEdge ST7 files** (see page 106) — You can now import SolidEdge ST7 files.
- **Spatial R25 SP1 Interop integrated** (see page 106) — Spatial R25 SP1 Interop is now integrated.
Importing SolidWorks 2015 files

You can now import SolidWorks 2015 files into FeatureCAM.
To import a SolidWorks file into FeatureCAM:

1. Select the **File > Import** menu option.
   The **Import** dialog is displayed.

2. Browse to the folder containing the file you want to open.

3. In the **Files of type** list, select **SolidWorks (*.sldprt;*.sldasm)**.
   Only SolidWorks documents are displayed in the **Import** dialog.

4. Select a file to display a preview image on the right of the dialog.

5. Click **Open** to import the file and close the dialog.
   The **Import Results** wizard is displayed, which you can use to specify the setup location and stock size, and to recognize features.
Importing SolidEdge ST7 files

You can now import SolidEdge ST7 files.

To import a SolidEdge file:

1. Select the File > Import menu option.
   The Import dialog is displayed.

2. Browse to the folder containing the file you want to open.

3. In the Files of type list, select SolidEdge (*.par;*.psm;*.asm).
   Only SolidEdge files are displayed in the Import dialog.

4. Select a file to display a preview image on the right of the dialog.
   Click Open to import the selected file and close the dialog.
   The Import Results wizard is displayed, which you can use to specify the setup location and stock size, and to recognize features.

Spatial R25 SP1 Interop integrated

Spatial R25 SP1 Interop is now integrated.

InterOp now supports Creo 3.0 BREP, Assembly, PMI, and Graphical translation.
Milling

FeatureCAM 2015 R3 contains these changes and improvements to Milling:

- **Creating Face features using IFR** (see page 108) — You can now automatically round the corners of Face features that are created using Interactive Feature Recognition.

- **Automatic tool selection** (see page 110) — You can now specify an additional clearance on the automatic tool selection to ensure the tool holder does not collide with the stock.

- **Simulating tool holders** (see page 112) — You can now simulate complicated tool holders more accurately.

- **Machine movement limits** (see page 113) — You can now display a warning message when the machine exceeds its limits of movement during machine simulation.
Creating Face features using IFR

You can now automatically round the corners of Face features that are created using Interactive Feature Recognition.

This enables you to use a Face feature instead of a Side feature in some situations, which can reduce the machining time by reducing air cutting. This is especially useful when using cutter compensation and partline programming.

In the example below, a Face feature is created on the orange surface, and a deburr radius is applied to round the outside corners of the feature during machining:

To specify a corner radius for a Face feature:

1. Create a Face feature using Interactive Feature Recognition (see page 499).
2. In the Face Properties dialog, in the Misc tab, select one of the new options.
   - Use the Deburr radius option to round the outside corners of the feature.
   - Use the Min corner radius option to round the inside corners of the feature.
3. In the New Value field, enter a new value and click Set to override the selected option.
4 Click **OK** to accept your changes to the feature and close the dialog.

For Face features with multiple operations, you can set the **Min. corner radius** option separately for the rough operation and for each finish pass.
Automatic tool selection

In FeatureCAM 2015 R2, the Tool Holder Clearance dialog (see page 146) was added, which enables you to specify an additional clearance on the automatic tool selection to prevent tool holder gouges.

There is a new Stock option in the Clearance Requirement list. Select this option to ensure the tool is long enough for the tool holder to clear the total depth into the stock.

To specify a tool holder clearance above the stock for automatic tool selection:

1. Select the Manufacturing > Machining Attributes menu option to display the Machining Attributes dialog.
2. On the Tool Selection tab of the Machining Attributes dialog, click Tool Holder Clearance.
   The new Tool Holder Clearance dialog is displayed.
3. In the Clearance Requirement list, select Stock.
Click **OK** to close the dialog.
Simulating tool holders

You can now simulate complicated tool holders more accurately. This enables you to create better toolpaths that can access more material and check for gouges more accurately when using automatic tool holder clearance (see page 1680).

Previously, the shape of the tool holder was approximated using either a cylinder or a cone.

The tool holder shape does not take into account undercuts, for example:

If the tool holder has this curve:

![Tool holder curve diagram]

The toolpaths are calculated with this tool holder shape:

![Toolpath diagram]
Machine movement limits

You can now display a warning message when the machine exceeds its limits of movement during machine simulation.

There is a new **Pause on limits** option in the **2D/3D Shaded** tab of the **Simulation Options** dialog. Select this option to pause the machine simulation if the machine moves outside the limits specified in the MD file.

![Simulation Options](image)

A new message dialog is displayed when the machine moves outside the specified limits.

![Outside of Limits](image)

The **Outside of Limits** message dialog displays:

- The solid name that has exceeded its limits.
- The axis of movement.
- The specified limit.
- The solid's current position.

You can select these options in the **Outside of Limits** message dialog:

- **Don't pause for this solid again** — Select this option to continue the machine simulation without pausing when this solid exceeds its limits.
- **Don't pause on limits again** — Select this option to run machine simulations without pausing when any solids exceed their limits. This is the same as deselection **Pause on limits** in the **Simulation Options** dialog.
To specify a machine's limits of movement (see page 129), you need to edit the Machine Design file.
Turning and Turn/Mill

FeatureCAM 2015 R3 contains these changes and improvements to Turning and Turn/Mill:

- **Indexing using a stock solid** (see page 116) — You can now calculate the index height directly from the stock solid, instead of calculating it above a square bounding box.

- **Setting the program point for turnmilling tools** (see page 118) — You can now specify the program point for turnmilling tools.

- **Turning head tool holders** (see page 119) — Turning head tool holders are now supported.
Indexing using a stock solid

You can improve machining times for turn/mill parts with stock solids by reducing the distance above the part at which the tool indexes. There is a new Calculate index radius from solid stock outline option that enables you to calculate the index height directly from the stock solid, instead of calculating it above a square bounding box:

Calculate index radius from solid stock outline off:

Calculate index radius from solid stock outline on:

1 — Distance to bounding box
2 — Z rapid level attribute value

1 — Distance to stock boundary
2 — Z rapid level attribute value
The new option is displayed on the Misc tab of the Machining Attributes dialog.
Turnmilling program point

You can now specify the program point for turnmilling tools. This enables you to touch-off the tool at the edge, and specify the insert radius compensation at the machine instead of in FeatureCAM. Previously, this option was available for turning tools only.

In the Machining Attributes dialog, on the Misc tab, select an option under Turnmilling program point:

- **Tool edge** — Select this option to adjust the tool program point by the tool radius in the NC code.
- **Tool center** — Select this option to adjust the tool program point by the tool radius at the machine.

This option does not affect turnmilling tools that are used for milling.

To use a turnmilling tool, select the Turnmilling option in the Strategy tab of the Feature Properties dialog for a Turn feature.
Turning head tool holder support

Turning-head tool holders are supported in FeatureCAM, which enable you to perform turning and boring operations on a milling machine.

For more up to date help, see the reference help (see page 186).

For example, in the image below the piece is machined by rotating the tool around the stock.

This requires the Advanced Turn/Mill (MTT) module, and it requires a modified Machine Design file (see page 1936) and CNC file that provide the U coordinate.

4-Axis indexing is supported, but 5-Axis positioning is not.

To create a turning head feature:

1. Create a Setup over the center of rotation of the turning head, so that the tool will rotate about the Setup Z axis.

2. Create a curve in the XZ plane that defines the profile of the turned shape.

3. Load the TurningHeadCS.dll add-in using the Macro Add-ins dialog.

4. In the New Feature wizard, under From Feature, select User and click Next.
   The User defined feature page is displayed.
5 In the **Registered features** list, under **Macro Add-ins**, select **Turn Head**, and click **Next**.

The **Curves** page is displayed.

6 Select the curve in the graphics window and click **Add from selected items** +.

7 Click **Next** to display the **Location** page.

8 Click **Next** to display the **User defined feature** page.

9 Specify the parameters to define the feature. To change a parameter, select the parameter name, select an option in the **New Value** list, then click **Set**.

**Profile** — Select a curve to define the turning feature profile.

**Toolpath Type** — Select whether you want to create an **Inside Diameter** or **Outside Diameter** feature.

**Rough Stock Curve** — Select the curve that defines the toolpath boundary for the feature. Leave this unset to machine to the stock boundary.
**Rough Pass** — Select **True** to include a rough operation.

**Finish Pass** — Select **True** to include a finish operation.

**Cycle Type** — Select the cycle type.

In a **Turn** cycle, the roughing tool feeds along the Z axis while stepping down the X axis.

In a **Face** cycle, the roughing tool feeds from the outside of the part to the center while stepping down in the negative Z direction.

**Cut Direction** — Select the direction along the Z axis you want to cut the feature.

10 Click **Finish** to create the Turn Head feature and close the dialog.

11 Use the **Tool Block Selection** dialog (see page 1579) to select the tool block solid as a tool block for the turning tools.

12 You may need to adjust the **Start point** and **End point** on the **Turning** tab of the **Turn Head Properties** dialog for each operation to ensure the tool does not collide with the part at the start and end of the toolpath.

13 Run a simulation to check for collisions.

The rotation of the tool is not displayed in the simulation, but the tool is checked for collisions and gouges. For example, in this image the tool has gouged with the clamp at ![1](image1), and another gouge is displayed at ![2](image2).

### Machine Design

To modify a Machine Design file to support turning head tool holders:

1 In the Machine Design document, ensure the **Machine Design > Enable Turn/Mill UI** is selected.

2 Select the **Machine Design > Supports Specialized Turning Heads** menu option.
3 Create or import solids to represent the turning head tool holder and the plate that moves in the U axis that holds the turning tool.

4 Use the **Parent/Child Relationships** dialog (see page 1910) to make the U plate solid a child of the turning head tool holder solid.

5 Use the **Specify Movement** dialog (see page 1904) to enable the U plate solid to move in +delta X.

6 Create a UCS on the U plate solid to locate the tool.

7 Using the **Tool Block** dialog (see page 1923), make the turning head tool holder solid a tool block, and create a tool location on the tool block using the UCS you created on the U plate solid.
**5-axis machining**

FeatureCAM 2015 R3 contains these changes and improvements to 5-axis machining:

- **C-axis indexing** (see page 124) — You can now specify the C-axis position of the part in the machine at the start of an operation.
- **5-axis engraving** (see page 126) — You can now create 5-axis engraving features with the tool axis normal to the surface.
**C-axis indexing**

You can now specify the C-axis position of the part at the start of an operation. This is useful for large parts where the machine has limited travel, or to prevent machine collisions.

There is a new **Orientation angle** option in the **Milling or Drilling** tab of the **Feature Properties** dialog.

Use this option to specify the rotation of the X and Y axes about the Z-axis. This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis).

If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.

- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

For example:

With an orientation angle of 0, the groove is cut in the machine's Y direction.  
With an orientation angle of 90, the groove is cut in the machine's X direction.
5-axis engraving

The 5-Axis tab of the Feature Properties dialog is now available for 2d spiral operations, which you can use to create 5-axis engraving features. This enables you to use a tool axis angle normal to the surface to ensure the engraving has a uniform cross-section and depth of cut.

To create a 5-axis surface engraving feature:

1. Create a surface below the stock boundary to determine the depth of the engraving, for example:
2 Create the curve to define the shape of the engraving feature, for example:

You can use the Construct > Curve > From Surface > Project onto Surface menu option to project a curve onto a surface.

3 Create a surface milling feature with a 2D spiral operation.

4 Double-click the feature in the Part View to display the Feature Properties dialog, and select spiral2d in the Tree View.

5 On the Stock tab, under Choose the drive curve, select Select curves for boundaries and click Curve Options.

The Boundary Curve dialog is displayed.

6 Under Boundary curve type, select Wall only.

This creates a toolpath along the curve.

7 Under Boundary curves, click Boundaries.

The Select Boundary Curves dialog is displayed.

8 Select the curve that defines the shape of engraving, and click OK to close the Select Boundary Curves dialog.

9 Click OK to close the Boundary curves dialog.

10 On the 5-Axis tab, select Use Lead and Lean, and in the from list, select Contact normal.

This keeps the tool axis normal to the surface.

11 Click OK to close the Feature Properties dialog.
Machine Design

FeatureCAM 2015 R3 contains these changes and improvements to Machine Design:

- **Specifying machine movement limits** (see page 129) — You can now set the limits of movement for solids in a Machine Design file.

- **Testing machine movements** (see page 130) — You can now use machine jogging to simulate the movement of solids in a Machine Design document without having to use an FM file.

- **Simulating mini-turrets** (see page 132) — You can now simulate mini-turrets, which are tools with multiple inserts where the tool rotates around the b-axis to access each tool.
Specifying machine movement limits

You can now set the limits of movement for solids in a Machine Design file. This gives you more control of machine simulations, and enables you to ensure the machine does not move beyond its limits during a simulation.

To specify the limits of movement for a solid:

1. In a Machine Design document, select the Machine Design > Specify Movement menu option.
   
   The Specify Movement dialog is displayed.

2. Use the Specify Movement tab to select a solid and specify how it can move.

3. Use the new Specify Limits tab to specify the Home Position and the linear and rotational limits of movement for the selected solid.

4. Click OK to close the dialog.

FeatureCAM can display a warning if a solid exceeds these limits during machine simulation (see page 113).

*There are several new example MD files that have limits of movement set. These are located in \FeatureCAM\Examples\Machine Design\Axis Limits.*
Testing machine movements

You can now use machine jogging to simulate the movement of solids in a Machine Design document without having to use an FM file. This enables you to test the movement and ensure the limits (see page 1906) are set correctly.

To use machine jogging to test machine movements:

1. Save any changes to your MD document.
   Any unsaved changes to the document are not displayed in the jogging simulation.

   The new Jog Machine dialog is displayed.

   ![Jog Machine dialog]

   Each row displays an axis in which solids in the document can move.

3. Select a solid in the list next to an axis name.
   The list is unavailable if there is only one solid that can move in that axis.

4. For the selected solid, move the slider between the minimum limit and the maximum limit.
   The solid's current position is shown in the middle field, and the solid's movement is simulated in the graphics window.
You can set the limits and home positions of the solids using the **Specify Movement** dialog (see page 129).

5. To hide solids in the jogging simulation, click **Select** in the **Standard** toolbar, then click solids in the graphics window.

6. To return all solids to their default positions, click **Reset All**.

7. When finished, close the dialog. The jogging simulation is cleared, and all solids are returned to their default positions.
Simulating mini-turrets

You can now simulate mini-turrets, which are tools with multiple inserts where the tool rotates around the b-axis to access each insert. This enables you to create a more flexible tooling setup and perform faster tool changes. The tools are simulated simultaneously, which enables you to check for gouges with the tools that are not currently in use.

To simulate a mini-turret:

1. In the Machine Design file, create a solid and UCS to represent the mini-turret. The X-axis of the UCS must point towards the main spindle.
2. Create a UCS for each tool location. The difference between the X-axis of the tool location and the turret UCS determines the angle that the mini-turret is rotated to use the tool.
3. In the Tool Block dialog:
   a. Select the turret solid under This solid is a tool block for solids.
   b. Select the turret UCS under This UCS will match up with the tool location on the turret.
   c. Use the Tool Locations tab to add each tool location UCS as a separate sub slot in the tool block.
   d. Click OK to close the dialog.
5. In the FM document, use the Tool Mapping dialog to specify which tool block to use for each feature.
What's new in FeatureCAM 2015 R2

FeatureCAM 2015 R2 contains the following new features and enhancements:

User interface

- **Changing the point size** (see page 137) — You can now change the size of geometry point objects to make them easier to see.
- **Customizing the snapping cursor** (see page 138) — You can now change the size and color of the snapping cursor.
- **Measuring curve length** (see page 139) — You can now find the length of curves and geometry segments.
- **Creating internal gears** (see page 140) — You can now perform analysis on internal gears curves.
- **Combining solids** (see page 141) — You can now combine multiple solids.
- **Hiding rapid moves in centerline simulations** (see page 142) — You can now hide rapid moves in centerline simulations.
- **Chip recognition size** (see page 143) — You can now specify the size at which detached pieces of stock are considered to be chips and hidden from simulation.
- **Recognizing features on large parts** (see page 144) — IFR now works more quickly for large parts.

Milling

- **Automatic tool selection** (see page 146) — You can now specify an additional clearance on the automatic tool selection to prevent tool holder gouges.
- **Vortex approaches flats from outside stock** (see page 148) — Vortex toolpaths can approach flat areas from outside of stock instead of always ramping into it.
- **Output options for 2D NT toolpaths** (see page 150) — The Output Options dialog is now available for 2D toolpaths that use NT or Vortex stepover types.
- **Previewing the toolpath point distribution** (see page 152) — You can now preview the points of a surface milling toolpath to help with editing the point distribution.
- **Tool pecking depths** (see page 153) — You can now specify the pecking depths for individual tools.
- **Changing the posting tolerance** (see page 154) — You can now create more precise toolpaths, which is useful for machining small parts.

- **Helical side finish** (see page 155) — Helical side finish operations are now machine at the feed rate, instead of the plunge feed rate.

**Turning**
- **Removing undercuts in no-drag turning features** (see page 157) — You can now remove undercuts in no-drag turning features to prevent gouges and simplify toolpaths.

- **Controlling steady rests** (see page 158) — You can now open and close the jaws of a steady rest without moving it to the home position.

- **Simulating bar stock** (see page 160) — You can now simulate bar stock in FeatureCAM by specifying the length of the stock displayed in simulation.

- **Custom turret names (MTT)** (see page 161) — You can now use customized turret names to make FeatureCAM more consistent with your machine.

**XBUILD**
- **Generating Post documentation** (see page 162) — You can now output your CNC data file as HTML or XML to make it understandable.

- **Using macros in the post processor** (see page 163) — The **Disable Macros** option in the **Post Options** dialog is now selected by default.

**Add-ins and extensions**
- **Using Setup Sheets** (see page 165) — There are new tags which you can use to create more detailed setup sheets.

- **FeatureCAM to CAMplete TruePath add-in** (see page 166) — You can export documents to CAMplete TruePath, which you can use to analyze, modify, optimize, simulate and post 5-Axis toolpaths.

- **Probing update options** (see page 168) — When creating probing features, you can now select multiple update options, which enables you to perform multiple actions from a single probing cycle.

- **Support for Microsoft SQL 2014** (see page 168) — FeatureCAM now supports Microsoft SQL server 2014.
Machine Simulation Design

- **Multi-tool blocks** (see page 170) — You can now create multi-tool blocks and double-sided tool blocks in Machine Design files and use them in machine simulations.

- **Selecting the tool block** (see page 173) — You can now select which tool block holds each tool within an FM file, which enables you to create accurate machining simulations more easily.

- **Protecting Machine Design documents** (see page 175) — You can protect your Machine Design files from the extraction of solids, so that you can share them for simulation without anyone being able to extract the solids.
User Interface

FeatureCAM 2015 R2 contains the following changes and improvements to the user interface:

- **Changing the point size** (see page 137) — You can now change the size of geometry point objects to make them easier to see.
- **Customizing the snapping cursor** (see page 138) — You can now change the size and color of the snapping cursor.
- **Measuring curve length** (see page 139) — You can now find the length of curves and geometry segments.
- **Creating internal gears** (see page 140) — You can now perform analysis on internal gears curves.
- **Combining solids** (see page 141) — You can now combine multiple solids.
- **Hiding rapid moves in centerline simulations** (see page 142) — You can now hide rapid moves in centerline simulations.
- **Chip recognition size** (see page 143) — You can now specify the size at which detached pieces of stock are considered to be chips and hidden from simulation.
- **Recognizing features on large parts** (see page 144) — IFR now works more quickly for large parts.
Changing the point size

You can now change the size of geometry point objects to make them easier to see.

To change the point size:

1. Select the **Options > Viewing** menu option.
   The new **Point size** option is displayed in the **Viewing Options** dialog.

2. Enter a **Point size** to specify the size of geometry point objects in the graphics window.

3. Click **OK** to close the dialog.
Customizing the snapping cursor

The snapping cursor shows you which object you are snapping to. You can now change the size and color of the snapping cursor to improve work flow when working with large, small or complex parts.

To change the size of the snapping cursor:

1. Select the **Options > Viewing** menu option.
   
   The new **Snapping Point Size** option is displayed in the **Viewing Options** dialog.

2. Enter a **Snapping Point Size** to specify the size of the snapping cursor in the graphics window.

3. Click **OK** to close the dialog.

To change the color of the snapping cursor:

1. Select the **Options > Coloring > Default Colors** menu option.
   
   The **Default Colors** dialog is displayed.

2. Select **Highlight** in the list.

3. Click **More Colors** to display the **Color** dialog.

4. Select a color and click **OK** to close the dialog.
   
   The selected color is displayed in the **Default Colors** dialog.

5. Click **Apply** to apply the color to the selected item.

6. Click **Done** to close the dialog.
Measuring curve length

You can now find the length of curves and geometry segments, which enables you to find important dimensions of complicated shapes easily.

To find the length of a curve:

1. Select the Construct > Dimension > Interrogation menu option. The Pick Dimension dialog (see page 293) is displayed.
2. Under Pick type, select the new Length option.
3. Click Pick Location \( \text{\includegraphics[width=1cm]{pick_location.png}} \) and select the curve you want to measure in the graphics window.
   
   The length of the selected curve is displayed in the Pick value field.
4. To measure another curve, repeat the previous step.
5. When you have finished, click OK to close the dialog.
Creating internal gears

In FeatureCAM 2015 R1, the Analysis tab was added to the Gears dialog (see page 192), which enables you to view the calculated dimensions of the gear, the calculated pin gauge diameter and the outside measurement over pins diameter. In FeatureCAM 2015 R2, the Analysis tab has been extended to enable you to find the measurement over pins value of an internal gear.

To create and analyze an internal gear curve:

1. Select the Construct > Curve > Other Methods > Gears menu option.
   The Gears dialog (see page 378) is displayed.

2. In the Curve tab, specify the properties of the gear.

3. Select the Analysis tab.
   The calculated dimensions of the gear are displayed under General calculations.

4. Under Measurement over pins (MOP), select Internal Gear.
   The Ideal pin diameter and MOP ideal values are displayed.

5. Enter the Actual pin diameter and click Recompute.
   The calculated measurement over pins value is displayed in the MOP actual field.

6. Click OK to close the dialog.
Combining solids (SOLID)

You can now combine multiple solids in different ways to create complicated shapes more easily. Previously, you could combine only two solids at once.

To combine solids:

1. Select the **Construct > Solid > Modifiers > Combine solids** menu option.

   The **Combine Solids** dialog is displayed.

   *This dialog was previously called the **Boolean dialog**.*

2. Enter a **New solid name**.

3. Select an **Operation**:
   - **Difference** — Subtract a solid from another solid. You can combine only two solids with this operation.
   - **Union** — Merge multiple solids together.
   - **Intersection** — Create a solid at the intersection of multiple solids.

4. Add the solids you want to combine:
   - To add a solid by name, select it in the **Solid list** and click **Add item from list**.
   - To add solids graphically, click **Pick solid** and select them in the graphics window.

5. Click **OK** to close the dialog.
Hiding rapid moves in centerline simulations

You can now hide rapid moves in centerline simulations. This enables you to see the cutting moves more clearly in complicated toolpath simulations.

Rapid moves shown:  

Rapid moves hidden:  

To hide rapid moves in centerline simulations, deselect the View > Simulation > Show Centerline Rapids menu option. The next time you run a centerline simulation, rapid moves are not displayed.
**Chip recognition size**

You can now specify the size at which detached pieces of stock are considered chips and hidden from simulation.

There is a new **Chip recognition size** option on the **Round Stock** tab of the **Simulation Options** dialog.

![Simulation Options dialog](image)

For parts with large stock, you may want to reduce this value to ensure cutoffs are not hidden.
Recognizing features on large parts

Interactive Feature Recognition (IFR) now works more quickly on large parts.

Previously, IFR would validate the solid when recognizing features, which could take a long time for large parts.

To verify that a solid is valid (see page 449), select the solid in the **Automatic Feature Recognition** dialog and click **Verify**.
Milling

FeatureCAM 2015 R2 contains the following changes and improvements to Milling:

- **Automatic tool selection** (see page 146) — You can now specify an additional clearance on the automatic tool selection to prevent tool holder gouges.

- **Vortex approaches flats from outside stock** (see page 148) — Vortex toolpaths can approach flat areas from outside of stock instead of always ramping into it.

- **Output options for 2D NT toolpaths** (see page 150) — The Output Options dialog is now available for 2D toolpaths that use NT or Vortex stepover types.

- **Previewing the toolpath point distribution** (see page 152) — You can now preview the points of a surface milling toolpath to help with editing the point distribution.

- **Tool pecking depths** (see page 153) — You can now specify the pecking depths for individual tools.

- **Changing the posting tolerance** (see page 154) — You can now create more precise toolpaths, which is useful for machining small parts.

- **Helical side finish** (see page 155) — Helical side finish operations are now machine at the feed rate, instead of the plunge feed rate.
**Automatic tool selection**

You can now specify an additional clearance on the automatic tool selection to prevent tool holder gouges.

No additional clearance: ![No additional clearance diagram]

Clearance above the Setup: ![Clearance above the Setup diagram]

To specify a tool holder clearance for automatic tool selection:

1. Select the **Manufacturing > Machining Attributes** menu option to display the **Machining Attributes** dialog.
2. On the **Tool Selection** tab of the **Machining Attributes** dialog, click **Tool Holder Clearance**.

The new **Tool Holder Clearance** dialog is displayed.

3. In the **Clearance Requirement** list, select the clearance you want between the tool holder and the part. Select from:
   - **None** — Select this option to leave no additional clearance. Old part files still select the same tools as before.
   - **Feature** — Select this option to ensure the tool is long enough for the tool holder to clear the feature.
- **Setup** — Select this option to ensure the tool is long enough for the tool holder to clear the total depth into the setup.

4. Enter an **Extra allowance as a % of feature or setup depth** to leave extra clearance of the tool holder above the feature or Setup.

5. Select how tool selection is affected if no matching tool is found:
   - **Give an error if no tool meets requirements** — FeatureCAM does not select a tool for the operation, so an error is shown during NC code generation. In the **Operation List**, a red exclamation point ! is displayed beside operations with no tool selected.
   - **Select tool closest to requirements if none match** — this enables you to generate NC code, but it may result in tool holder gouges because a smaller tool may be used.

6. Click **OK** to close the dialog.
Vortex approaches flats from outside stock

Vortex toolpaths can approach flat areas from outside of stock instead of always ramping into it. This enables you to create Vortex toolpaths that are faster to machine and are compatible with a wider selection of tools.

**FeatureCAM 2016 R1**
The tool ramps into the part

**FeatureCAM 2016 R2**
The tool approaches from the outside

To approach from outside the stock, FeatureCAM:

- extends a section of the flat area beyond the stock and into an area already machined; and;
- fills the extended section with cutting moves.

*By extending the section to an area already machined, the machine tool can approach the flat area in open space.*

1. Edge of flat area
2. Stock
3. Extended section of flat area filled with cutting moves
4. Outside edge of extended section
5. Area already machined
Criteria for toolpath to approach from outside stock

FeatureCAM only extends a section of the flat area if the extended section:

- has an outside edge that the machine tool can approach.
- does not gouge the model.
- is wide enough to be profile smoothed successfully.
- can reach an area already machined within the distance of one tool diameter.

If the extended section fails to meet the criteria, FeatureCAM does not extend the flat area and instead uses a ramp move to approach the toolpath.
Output options for 2D NT toolpaths

The **Output Options** dialog is now available for 2D toolpaths that use NT or Vortex stepover types. This enables you to control how the points of 2D vortex and New Technology toolpaths are processed in the NC program. Previously, this was only available for 3D toolpaths.

To display the **Output Options** dialog, click **Output Options** on the **Milling** tab of the **Feature Properties** dialog.

The dialog contains these output options:

- **Filter linear moves** — This automatically removes unnecessary points in the toolpath while maintaining tolerance. The points are not equispaced because unnecessary points are deleted.

- **Filter linear moves and convert arcs to linear** — This is similar to the first option except that all arcs are replaced by straight line segments. This option is suitable for machine tools which do not handle arcs well.

- **Redistribute points after filtering linear moves. Convert arcs to linear** — This option allows the insertion of new points. This ensures a constant distance between points, only inserting extra points if they are necessary to keep tolerance. This option may increase toolpath creation time, but reduce time on the machine tool. This option is suitable for machine tools that can handle large numbers of equispaced points.
- **Approximate linear moves with arcs and lines** — Select this option to create an arc line approximation for toolpaths that are contained in the XY, YZ, and XZ plane. This allows 3D programs to be smaller and to result in smoother surface finishes for certain types of parts.

- **Limit linear moves** — Select this option to limit the distance between linear move points to the **Maximum length** value.
Previewing the toolpath point distribution

You can now preview the points of a surface milling toolpath to help with editing the point distribution.

To redistribute toolpath points:

1. In the Surface Milling Properties dialog, on the Milling tab, click Output Options.
   
The Output Options dialog is displayed.

2. Under Output Filtering, specify the options for filtering linear moves in the toolpath.

3. Click the new Preview button. The points of the toolpath are shown in blue in the graphics window.

4. Modify the view in the graphics window to see the toolpath preview.

5. When you have finished, click OK to close the dialog.
Tool pecking depths

Pecking is used when drilling deep holes, where the tool retracts multiple times while drilling to clear debris from the hole.

You can now specify the pecking depths for individual tools. Previously, you had to change the pecking depths for individual operations to override the global settings.

To specify the pecking depths at which the drill retracts:

- You can change the global pecking depths on the Pecking tab of the Machining Attributes dialog.
- You can change the pecking depths for each tool on the new Pecking tab of the Tool Properties dialog:

  Leave the values at 0% to use the global values in the Machining Attributes dialog.

- You can see and edit each operation's absolute pecking depths on the Cycle tab of the Hole Feature Properties dialog.

The peck style (see page 1605) is specified in the .cnc file. This determines which of the tool's pecking values are used to calculate the absolute pecking depths for the operation.
Changing the Posting tolerance

You can now control the tolerance with which toolpaths are created. This enables you to create more precise toolpaths, which is useful for machining small parts.

There is a new **Posting tolerance** option in the **Misc** tab of the **Machining Attributes** dialog.

Reduce the **Posting tolerance** for small parts to create more precise toolpaths. You must also adjust your post processor to output more digits. For example, if you adjust the posting tolerance from 0.001 to 0.0001, then you must adjust the digit format in the post processor so that the extra decimal place is used in the NC code.

Reducing the posting tolerance creates additional lines of NC code, so you should only do this for high-precision NC machines that can use the high-precision coordinates, when required for an application.
**Helical side finish**

You can use the **Helical side finish** option to create a continuous spiral finishing toolpath for a 2.5D milling feature, which prevents tool marks on the surface.

Helical side finish operations are now machined at the feed rate specified on the F/S tab of the **Feature Properties** dialog, previously they were machined using the plunge feed rate, specified by the **Plunge feed override** on the **Plunge** tab.

To enable this option, select **Helical side finish** on the **Strategy** tab of the **Feature Properties** dialog, and enter a **Pitch** for the spiral.
Turning

FeatureCAM 2015 R2 contains the following changes and improvements to Turning:

- **Removing undercuts in no-drag turning features** (see page 157) — You can now remove undercuts in no-drag turning features to prevent gouges and simplify toolpaths.

- **Controlling steady rests** (see page 158) — You can now open and close the jaws of a steady rest without moving it to the home position.

- **Simulating bar stock** (see page 160) — You can now simulate bar stock in FeatureCAM by specifying the length of the stock displayed in simulation.

- **Custom turret names (MTT)** (see page 161) — You can now use customized turret names to make FeatureCAM more consistent with your machine.
Removing undercuts in no-drag turning features

You can create turning features with a no-drag finishing strategy, where the tool does not cut the feature in a single movement, which reduces tool wear and prevents chips being dragged along the surface.

You can now remove undercuts in no-drag turning features to prevent gouges and simplify toolpaths, which improves machining time and prevents unnecessary tool wear. Previously, this option was available only for features which use a conventional finishing strategy.

To create a no-drag turning feature and remove undercuts:
1. Create a Turn feature.
2. In the Turn Properties dialog, on the Strategy tab, select No-Drag.
3. Select an operation in the Tree View.
4. On the Turning tab, select an option in the Undercuts list:
   - **No checking** — Select this option to not check the feature for undercuts.
   - **Adjust to tool geometry** — Select this option to clip undercuts that cause the tool to gouge the part.
   - **Remove all undercuts** — Select this option to remove all undercuts.
Controlling steady rests

You can now open and close the jaws of a steady rest without moving it to the home position.

This is useful for turning operations on long parts. For example, you can machine up to the steady rest, open the steady rest and machine past it, then close the steady rest and machine to the end of the part.

Steady rest open:       Steady rest closed:

To control the jaws of a steady rest without moving it:

1. Click the Features step in the Steps panel to display the New Feature wizard.
2. Select Part Handling and click Next. The Dimensions page is displayed.
3. To close a steady rest, select Part Support On.
   To open a steady rest, select Part Support Off.
4. Click Next. The Strategies page is displayed.
5. In the Support type list, select Steadyrest.
6. Select the new Jaws only option.
7. Click Finish to close the wizard.
8. To specify when the Part Handling feature is performed, click and drag the feature in Part View, or change the Base Priority attribute on the Misc tab of the Part Handling Properties dialog.
The **Jaws only** option is also displayed on the **Strategy** tab of the **Part Handling Properties** dialog.

![Part Handling Properties dialog](image)

There is a new `<AWS-ONLY>` reserved word in XBUILD. You must update your post Formats to use the reserved word to obtain the correct NC code that matches the new simulation.
Simulating bar stock

You can now simulate bar stock in FeatureCAM by specifying the length of the stock displayed in simulation without changing the stock dimensions.

Select the **Options > Simulation** menu option, and use the new **Display Specific Stock Length** option on the **Round Stock** tab of the **Simulation Options** dialog.
Custom turret names (MTT)

You can now use customized turret names to make FeatureCAM more consistent with your machine. Previously, all turrets were called upper and lower turrets.

The turret names are taken from the names of the turret or gang solids in the Machine Design file, and are used throughout FeatureCAM:

- In the Part View panel.
- In the Tool Posts tab of the Results panel.
- In the Details tab of the Results panel.
- In the NC program.
XBUILD

FeatureCAM 2015 R2 contains the following XBUILD improvements:

- **Generating Post documentation** (see page 162) — You can now output your CNC data file as HTML or XML to make it understandable.
- **Using macros in the post processor** (see page 163) — The Disable Macros option in the Post Options dialog is now selected by default.

**Generating Post documentation**

In XBUILD, you can output your CNC data file as a text file. This file has a .cnx extension, and you can edit and print it with any text editor.

You can now output your CNC data file as HTML or XML to make it more understandable.

Select one of these File > Document CNC menu options:

- **CNX (Text)** — Creates a .cnx file which can be read by any text editor.
- **HTML** — Creates a .html file. This is the most readable document.
- **XML** — Creates an .xml file.
Using macros in the post processor

The Disable Macros option in the Post Options dialog is now selected by default. You must deselect this option to enable macro generation for the NC code.
Add-ins and extensions

FeatureCAM 2015 R2 contains the following changes to add-ins and extensions:

- **Using Setup Sheets** (see page 165) — There are new tags which you can use to create more detailed setup sheets.

- **FeatureCAM to CAMplete TruePath add-in** (see page 166) — You can export documents to CAMplete TruePath, which you can use to analyze, modify, optimize, simulate and post 5-Axis toolpaths.

- **Probing update options** (see page 168) — When creating probing features, you can now select multiple update options, which enables you to perform multiple actions from a single probing cycle.

- **Support for Microsoft SQL 2014** (see page 168) — FeatureCAM now supports Microsoft SQL server 2014.
Using Setup Sheets

You can use the **SetupSheet.dll** (see page 177) add-in to generate html setup sheets from your document to give information to the machine operator about the manufacturing, tooling, and toolpaths of a part.

There are new tags which you can use to create more useful setup sheets:

- **Machining allowances:**
  - `{operation.finish_allowance}` — Finish Allowance.
  - `{operation.bottom_finish_allowance}` — Bottom Finish Allowance.
  - `{operation.surface_finish_leave_allowance}` — Finish Leave Allowance.

- **Stepover:**
  - `{operation.stepover}` — 3D milling stepover.

- **Z increment:**
  - `{operation.finish_z_increment}` — Finish Z Increment
  - `{operation.surface_finish_z_increment}` — Surface Finish Z Increment.
  - `{operation.surface_rough_z_increment}` — Surface Rough Z Increment.

- **Coolant:**
  - `{tool.coolant_override}` — The tool's coolant override.

- **Depth of cut:**
  - `{operation.turn_depth_of_cut}` — Rough Depth of Cut for turning operations.
FeatureCAM to CAMplete TruePath add-in

CAMplete TruePath is an application that you can use to analyze, modify, optimize, simulate and post 5-Axis toolpaths.

To export a document to use with CAMplete TruePath:

1. License the CAMplete verification product component, and ensure it is selected in the Evaluation Options dialog.

2. In the Post Options dialog, select the CAMplete_TruePath.cnc post in the /Posts/Mill/5-Axis folder.

3. Load the FeatureCAMToCAMplete.dll add-in (see page 145).

4. In the Utilities toolbar, click FeatureCAMToCAMplete. The FeatureCAM to CAMplete dialog is displayed.

5. Click Browse and select where you want to save the exported files.

6. In the Select solids to be exported as clamps list, select solids you want to export as clamps and fixtures.

You can export multiple clamp and fixture solids.
To mark multiple solids as clamps, select them in the graphics window and click **Select solids selected in the part**.

7 Click **Export Part solid** to export a solid to use as the part in CAMplete. You can export only one part solid.

- To export a solid in the document as an .stl file, select **Select solid to export as part**, and select a solid from the list.
- To use an .stl file, select **Select existing .stl file** and click **Browse** and select it in the **Select part .stl file** document.

If want to machine a part made of multiple solids, you can use FeatureCAM’s solid modelling to combine (see page 475) them.

8 Select whether you want the post to use the **Tool number** or **Tool ID** to identify tools.

9 Under **Offset from the setup UCS to pallet**, enter the offset distances in the X, Y and Z directions.

10 Click **Preview** to display a point in the graphics window which shows the offset from the setup UCS.

11 Click **Export** to export the document and close the dialog. The files are created in the selected output directory.
**Probing update options**

When creating probing features, you can now select multiple update options. This enables you to perform multiple actions from a single probing cycle.

To create a probing feature with multiple update options:

1. Select the **Options > Add-Ins** menu option and use the **Macro Add-ins** dialog (see page 145) to load the `StandardProbing2.dll` add-in.
   
   *This replaces the `StandardProbing.dll` add-in, but it is still available to enable backwards compatibility.*

2. Create a User Defined Feature, and select the feature type you want to measure, then click **Next**.

3. Select an item in the **Dimension** list, enter a **New Value**, and click **Set**.

   You can enter the following values:
   
   - **MCS** — Enter the Machine Coordinate System you want to update.
   - **Tool** — Enter the tool number for the tool you want to update.
   - **Store** — Specify whether to store the results.
   - **Print** — Specify whether to print the results.

4. Complete the wizard and click **Finish** to create the probing feature.

**Support for Microsoft SQL server 2014**

FeatureCAM now supports Microsoft SQL server 2014.

You can use SQL server (see page 1839) to improve the performance and reliability of your network database in FeatureCAM.
Machine Simulation Design

FeatureCAM 2015 R2 contains the following changes and improvements to Machine Simulation design:

- **Multi-tool blocks** (see page 170) — You can now create multi-tool blocks and double-sided tool blocks in Machine Design files and use them in machine simulations.

- **Selecting the tool block** (see page 173) — You can now select which tool block holds each tool within an FM file, which enables you to create accurate machining simulations more easily.

- **Protecting Machine Design documents** (see page 175) — You can protect your Machine Design files from the extraction of solids, so that you can share them for simulation without anyone being able to extract the solids.
Multi-tool blocks

You can now create multi-tool blocks and double-sided tool blocks in Machine Design files and use them in machine simulation. Previously, each tool block could hold only one tool.

To create a multi-tool block:

1. Ensure that the Machine Design > Enable Millturn UI menu option is selected to access the lathe design options.
2. Select the Machine Design > Tool Block for Turret menu option. The Tool Block tab of the Tool Block dialog is displayed. This tab has been updated.

3. Select a solid to use as the tool block.
4. Select a UCS for the tool location on the turret, or click New UCS Wizard and create one.
5. Select which turrets the tool block can address.
6. Select which tool locations on the turret the tool block can attach to.
7 Select the new Tool Locations tab.

8 Click Add to add a new tool location. The new Tool Information dialog is displayed.

9 Select a UCS to define the tool location (see page 1930), or click New UCS Wizard and create one.

10 Select which of the spindles the tool addresses.

11 Under Holds which tool type, select the tool types that can be used at this tool location. For OD Lathe tools, select the Handedness of the tool.

12 Click OK to add the tool location and close the Tool Information dialog.

13 To remove a tool location, select it and click Remove.

14 To edit a tool location, select it and click Edit, or double-click it.

15 Use the Move Up and Move Down buttons to change the order of the tool locations in the dialog.
Click OK to close the Tool Block dialog.
Selecting the tool block

You can now select which tool block holds each tool within an FM file, which enables you to create accurate machining simulations more easily.

To select the tool block for a tool:

1. Open a Turning or Turn/Mill document that contains toolpaths.
2. Select the Manufacturing > Tool Mapping menu option. The Tool Mapping dialog is displayed.
3. Select a tool in the list, and click the new Select Block button.

The new Select Block dialog is displayed.

4. In the Tool block list, select the tool block solid from the Machine Design file that you want to hold the selected tool.
5 Select the sub slot in the list that you want to hold the tool.
6 Click **OK** to close the **Tool Block Selection** dialog.
The tool block you selected is displayed in the tool mapping tree.

7 Click **OK** to close the **Tool Mapping** dialog and save your changes.
Protecting solids in Machine Design documents

You can protect your Machine Design files from the extraction of solids, so that you can share them for simulation without anyone being able to extract the solids.

FeatureCAM comes with some locked Machine Design files. You can use these for simulation, but you cannot extract solids from them. When you open a locked file, a dialog is displayed explaining the restriction.

You can lock your files, but you cannot unlock them. You should not lock an original file, instead create a copy of it and lock the copy.

To lock a file:

1. Use the **File > Save As** menu option to save a copy of your file.
2. Select the **File > Lock/Unlock** menu option.
   The **Lock or Unlock File** dialog is displayed.
3. Select **Lock**.
   *If you lock a file, you cannot unlock it.*
4. Click **OK** to close the dialog and save your changes.
What's new in FeatureCAM 2015 R1

FeatureCAM 2015 R1 contains the following new features and enhancements:

User interface

- **Installing FeatureCAM** (see page 180) — During installation, a dialog reminds you to prepare to update to Windows 8.
- **SQL server authentication** (see page 181) — FeatureCAM can now record the credentials for accessing the tools databases held in SQL Server.
- **Accessing machining attributes** (see page 182) — The Machining Attributes dialog can be opened directly from the Part View panel.
- **Customizing the Toolbox** (see page 182) — The width each view in the Toolbox can be customized separately.
- **Adding new stock materials** (see page 184) — The New Stock Material dialog prevents the creation of invalid stock names.
- **Improved feature recognition** (see page 185) — Feature recognition automatically excludes clamps from solids.
- **Recognizing Face features** (see page 186) — You can now recognize multiple Face features simultaneously.
- **Snapping modes** (see page 187) — The Snap Mode toolbar includes a new option that allows the use of the centre points of cylinders and cones.
- **Creating solids** (see page 188) — The Finish button of the Solid Wizard is configurable in the same way as the Features Wizard.
- **Polygonal curves** (see page 190) — A new option is available for creating polygonal curves.
- **Creating gears** (see page 192) — The Gears dialog now includes alternative methods of specifying curve information. A separate tab reports the properties of the calculated gear.
- **Command line options** (see page 194) — FeatureCAM’s command line interface has been extended.
- **Selecting surfaces** (see page 195) — Selecting the surfaces of long narrow models has been improved.

Milling

- **Tool Holder collision avoidance** (see page 197) — You can now automatically clip toolpaths which would cause a tool holder collision or a gouge.
- **Machine maximum stock** (see page 199) — A new machine maximum stock setting enables you to machine as much stock as possible without retracting the tool.

- **Isoline and Flowline features** (see page 200) — A new sequence option for isoline and flowline milling gives greater control over the creation of toolpaths.

- **Configuring counterbore operations** (see page 202) — A new Touch off at the shoulder option enables you to choose the z-zero position for a counterbore operation.

- **Default auto-chamfer tool** (see page 204) — The Machining Attributes dialog includes the ability to set a default tool for chamfer operations.

- **Setting toolpath boundaries** (see page 205) — You can use a clipping curve to restrict z-level roughing to a specific area of a part.

- **Creating 5-axis patterns** (see page 207) — 5-axis milling patterns can be specified for any axis.

**Turning**

- **Improved machining time for dips** (see page 210) — FeatureCAM uses a rapid move to machine dips smaller than the depth of cut.

- **Synchronizing operations** (see page 211) — Improved synchronization points for multi-turret machines make it easier to manage and update synchronization groups.

- **Turning curves** (see page 213) — Follow and pinch turning are now available for the face and back-face cycles of curves.

- **Tool properties for multi-turret machining** (see page 215) — You can assign operations to specific turrets in the Tool Properties dialog.

- **Multiple part catchers** (see page 216) — Multiple part catcher support is supported through the Cutoff Properties dialog and the FeatureCAM API.

**Wire EDM**

- **Improved reliability for no-core machining** (see page 218) — FeatureCAM can create no core toolpaths that ensure no material remains after machining.

- **Selecting cutting data** (see page 219) — Two new conditions are available for selecting data.

**Importing**

- **Using Inventor 2015** (see page 222) — FeatureCAM has been certified for use with Autodesk Inventor 2015.
• **Importing Pro/E files** (see page 223) — The feature tree of imported Pro/E files can be displayed.

• **Importing JT files** (see page 223) — You can load solids from JT files in addition to surfaces.

• **Importing PDF files** (see page 224) — You can import curves from Acrobat files using Delcam Exchange.

**Add-ins and extensions**

• **Using add-ins** (see page 226) — The **Macro Add-ins** dialog has been updated to improve the management of add-ins and macros.

• **The Add-in Library** (see page 228) — FeatureCAM now includes a catalog of add-ins that were previously only available on the website. The **Add-in Library** is a new feature that enables you to quickly view and select add-ins from the catalog.

• **Turn-curve tolerance** (see page 230) — A new TurnCurveTolerance.bas add-in enables you to tolerance multiple segments in turned or internal bore features.

• **Exporting NC programs to NCSIMUL** (see page 233) — The FeatureCAMToNCSIMUL.dll add-in can now export turn/mill programs as well as milling programs.

• **Extended machine support** (see page 234) — Add-in support for traveling steady rests, bar fed mills, and the Mori Seiki NTX1000 is available for FeatureCAM.

**XBUILD**

• **Custom formats** (see page 236) — The **Custom Format Name** dialog has an enhanced user interface to support the creation of naturalistic process names.

• **Customizing cutting data from Wire EDM** (see page 237) — You can now configure the headings of the cutting data table for use with Wire EDM.

• **Saving CNC files** (see page 240) — Post numbers can be used to identify individual output files for Fanuc-style multi-turret lathes.

• **Configuring reserved words** (see page 242) — The **Word Info** dialog includes a new option that enables you remove all non-significant zeros from numeric outputs.

• **Using the Reserved Words dialog** (see page 243) — The **Reserved Words** dialog is easier and quicker to use.
User interface improvements

FeatureCAM 2015 R1 contains the following changes and improvements to the user interface:

- **Installing FeatureCAM** (see page 180) — During installation, a dialog reminds you to prepare to update to Windows 8.
- **SQL server authentication** (see page 181) — FeatureCAM can now record the credentials for accessing the tools databases held in SQL Server.
- **Accessing machining attributes** (see page 182) — The Machining Attributes dialog can be opened directly from the Part View panel.
- **Customizing the Toolbox** (see page 182) — The width each view in the Toolbox can be customized separately.
- **Adding new stock materials** (see page 184) — The New Stock Material dialog prevents the creation of invalid stock names.
- **Improved feature recognition** (see page 185) — Feature recognition automatically excludes clamps from solids.
- **Recognizing Face features** (see page 186) — You can now recognize multiple Face features simultaneously.
- **Snapping modes** (see page 187) — The Snap Mode toolbar includes a new option that allows the use of the centre points of cylinders and cones.
- **Creating solids** (see page 188) — The Finish button of the Solid Wizard is configurable in the same way as the Features Wizard.
- **Polygonal curves** (see page 190) — A new option is available for creating polygonal curves.
- **Creating gears** (see page 192) — The Gears dialog now includes alternative methods of specifying curve information. A separate tab reports the properties of the calculated gear.
- **Command line options** (see page 194) — FeatureCAM's command line interface has been extended.
- **Selecting surfaces** (see page 195) — Selecting the surfaces of long narrow models has been improved.
Installing FeatureCAM

Following Microsoft’s decision to withdraw support for Windows 7 in 2015, Delcam will also be withdrawing support for this operating system. To enable you to prepare for this change, FeatureCAM 2015 R1 displays the following reminder when it detects you are installing it on a computer running Windows 7. or a 32-bit version of Windows 8:

If you want to continue using FeatureCAM updates after June 2015, you must update your computer to a 64-bit version of Windows 8.
SQL server authentication

You can now specify a username and password for SQL (see page 142) authentication. When you use SQL authentication, the Database Name list only displays databases to which you have access.

There are new options in these places:

- The Database tab of the File Options dialog:

- In the INITDB window:

To use SQL authentication:
1. Display the **Database** tab of the **File Options** dialog or the INITDB window.

2. Select **On a SQL server**.

3. Enter a **Server Name**.

4. In the **Authentication Mode** list, select **SQL Server**.

5. Enter a **SQL Username** and a **SQL Password**.

6. In the **Database Name** list, select a database. The list displays only the databases for which you have access rights.

### Accessing machining attributes

The **Machining Attributes** dialog can now be opened from the **Parts View** panel as well as from the **Manufacturing > Machining Attributes** menu option. This streamlines the document creation process by enabling you to quickly view and change the attributes of the part you are working with.

To open the **Machining Attributes** dialog from the **Part View**:

1. Double-click the **Machining Attributes** option below the document name. For example:

![Part View panel]

2. Update the machining attributes, and then click **OK** to save your changes and close the dialog.

### Customizing the Toolbox

FeatureCAM now remembers the last width change for each view in the **Toolbox** panel. This enables you to customize the display of the **Steps**, **Part View**, and **Browser** panels individually, and then have FeatureCAM automatically change the **Toolbox** width each time you switch between them. The separate widths are saved when you close the program, which means that your changes are remembered between sessions and can be shared across installations using the `ezfm_ui.ini` file.
To resize the Toolbox views:

1. Select Part View.

2. Position the cursor over the Toolbox border. When the cursor changes to ✂️, left-click and drag the border to its new position. For example:

   ![Toolbox View](image)

3. Repeat steps 1 and 2 for the Steps view and the Browser view.
Adding new stock materials

To avoid creating names that cause errors, the names of new materials are now restricted to capital letters (A-Z), numbers (0-9), underscores (_), and dashes (-). To enable you to type normally, lower-case letters are automatically converted to upper-case, and spaces are automatically converted to underscores.

To create a new stock material:

1. Select the **Manufacturing > Feeds/Speeds and Cutting Data Tables** menu option. The **Feeds/Speeds and Cutting Data Tables** dialog is displayed.

2. Click the **New Stock Material** button. The **New Stock Material** dialog is displayed.

3. Enter a name for the material and click **OK** to save your changes and close the dialog. The name is displayed in the **Material** list.

4. Complete the details of the material in the **Feeds/Speeds and Cutting Data Tables** dialog.

5. Click **OK** to save your changes and close the dialog.
**Improved feature recognition**

Previously, feature recognition identified and selected clamps as well as features on the part itself. This meant that when using feature recognition on a model that included clamps, you would often need to deselect clamp features.

In FeatureCAM 2015 R1, the feature recognition algorithm has been refined to automatically exclude the features of clamps from the recognition process, so cutting out unnecessary work and enabling you to create documents more quickly.

For example, to identify sides using feature recognition:

1. Open the solid.
2. Right-click the clamps and select **Use Solids as Clamp** from the context menu.
3. Open the **New Feature Wizard**.
4. Under **From Curve**, select the **Side** option.
5. Select the **Extract with FeatureRECOGNITION** check box, and click **Next**.
6. In the **Feature Extraction** dialog, select **Automatic recognition** and click **Next**. The **Feature Recognition Options** dialog is displayed, and only the side features on the part are selected.
7. Complete the wizard and click **Finish**.
Recognizing Face features

You can now use FeatureRECOGNITION to recognize multiple Face features simultaneously. This makes it easier to program complex parts, because you no longer need to create Face features individually.

To recognize Face features from surfaces:

1. Open a part that contains multiple flat surfaces.
2. In the Steps panel, click the Features step. The New Feature wizard is displayed.
3. In the From Dimensions section, select Face.
4. Select the Extract with FeatureRECOGNITION check box, then click Next. The Surfaces page is displayed.
5. Select all flat surfaces you want to recognize in the graphics window, and click to add the selected surfaces.
6. Click Next.
   A message asks if you want to create multiple features.
7. Click Yes to create the features and close the wizard.
Snapping modes

A new Snap to cylinder end points option has been added to the Snap Mode toolbar and the Snap Modes dialog. Use it to select and work with the center end points of cylinder and cone axes.

To select the cylinder end points:

1. Use one of these methods to select Snap to cylinder end points mode:
   - In the Snap Modes dialog, select 
   - In the Snap Mode toolbar, click the Snap to cylinder button.

   In the Graphics view, selection points are displayed at the center end points on the axis of each cylinder and cone.

2. Click the selection points to construct geometry or to display the distance between points. For example:

   ![Diagram](image)

   *If the Snap to cylinder button is not shown in the Snap Mode toolbar, select the toolbar in the Toolbars tab of the Customize Toolbars dialog (see page 23), and click Reset Selected.*
Creating solids

To improve usability, a new Finish button has been added to the Solid Wizard. It works in the same way as the Finish button in the Features Wizard, and enables you to speed up the creation of multiple solids. For example:

To create solids using the Solid Wizard:

1. Open the Solid Wizard.
2. Select a method of solid construction.
3. Select a constructor.
4. When you have completed your setting changes, click the down arrow on the Finish button and choose an option. Select:
   - Finish to create the solid and close the wizard.
   - Finish and Edit Properties to close the wizard and open the properties dialog for the solid you created. You can then view and edit the settings.
   - Finish and Create More to create the solid and return to the start of the wizard. You can then create a new solid.

FeatureCAM remembers your selection and, when you next use the wizard, the icon displayed on the button indicates its current state. For example: indicates the button is currently in Finish and Edit Properties mode.
Similarly, you can create multiple items when using the **Solids** toolbar to create items. For example:

To create solids from the properties dialogs:

1. Select an option in the **Solid** toolbar. The properties dialog for the solid is displayed.
2. Edit the settings.
3. Click the down arrow on the **Apply** button and choose an option. Select:
   - **Apply and Edit Properties** to save your changes and continue editing the current solid.
   - **Apply and Create More** to save your changes. Each time you click **Apply**, FeatureCAM creates a new solid.

As with the Solid Wizard, FeatureCAM remembers your selection, and an icon indicates the button's current state.
Polygonal curves

FeatureCAM 2015 R1 contains a new Polygon tool. Use it to create a curve in the shape of a regular polygon.

To create a polygonal curve:

1. Open the **Polygon** dialog in one of these ways:
   - In the **Curve Wizard** (see page 325), select **Other methods**, select **Polygon**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Polygon** button in the **Curve** menu.
   - Select **Construct > Curve > Other Methods > Polygon**.

     The **Polygon** dialog is displayed.

2. Enter a **Curve name**.

3. Enter the **Number of sides** in the polygon. For example, to create a regular hexagon, type **6**.

4. Enter the x and y coordinates of the **Center point**, or click and select the location in the graphics window.

5. To fillet the corners, enter a **Corner Radius**.

6. To rotate the rectangle counter-clockwise from the X axis, enter an **Angle** in degrees.

7. By default the curve is created on the UCS plane. If you want to position the curve on a parallel plane, enter an **Elevation**.

8. Size the polygon using one of these methods:
- In the **Side length** box, enter the length of the sides.
- In the **Center to side** box, enter the perpendicular distance between the curve center and the sides.
- In the **Center to corner** box, enter the distance between the curve center and the corners.

9. To convert the curve into arcs and lines, select the **Create as curves and lines** check box.

10. Click **Preview** to display the polygon in the graphics window.

11. Click **OK** or **Finish** to close the dialog.
Creating gears

The Gears dialog has been extended to allow the use of alternative parameters to specify gear curves. You can now specify Outer diameter, Root diameter, and Diametric pitch or Module measurements, making it easier for you to create curves directly from the specification. In addition, a new Analysis tab enables you to view the properties of the calculated gear and the measurement over pins values.

To create a gear curve:

1. Open the Gears dialog in one of these ways:
   - In the Curve Wizard (see page 325), select Other methods, then Gears, and click Next.
   - On the Curves and Surfaces (see page 13) toolbar, click the Gears button in the Curve menu.
   - Select the Construct > Curve > Other Methods > Gears menu option.
   The Gears dialog displays the Curve tab.

2. Enter a Name for the curve.

3. Enter a Firmness value to determine the number of control points in the tooth profile. The smaller the value; the greater the number of control points used to sample the curve.

4. Complete the gear specification:
   - Number of teeth — Enter the number of teeth on the gear.
   - Pressure angle — Enter the acute angle, in degrees, between the tangent to the two base circles and a normal to the line connecting the gear centers.
- **Tip radius** — Enter the radius of the tooth corner.
- **Addendum** — Enter the radial distance from the pitch circle to the outermost point of the tooth. Alternatively, select **Outer diameter** and enter the outside diameter of the gear.
- **Dedendum** — Enter the radial distance from the depth of the tooth trough to the pitch circle. Alternatively, select **Root diameter** and enter the root diameter of the gear.
- **Pitch diameter** — Enter the diameter of the pitch circle. Alternatively, select **Module** and enter the pitch diameter divided by the number of teeth, or select **Diametric pitch** and enter the number of teeth divided by the pitch diameter.
- **Root fillet radius** — Enter the radius of the fillet at the bottom of each tooth.
- **Center point** — Enter the coordinates for the centre of the gear curve, or click [ ] and pick the curve in the Graphics window.

5. Select the **Analysis** tab to view the calculated dimensions of the gear, the calculated pin gauge diameter and the outside measurement over pins diameter.

6. If you want to change the calculated diameter of the pin gauge, enter a new value in the **Actual pin diameter** box, and click **Recompute**.

7. Click **OK** (or **Finish** if you are using the wizard).
The command line interface for ezfm.exe, the FeatureCAM executable, has been extended. You can use it to control administrative functions, as well as to load customized user-interface and manufacturing setups. The following commands are available:

- **-b** Load the specified VB add-in from the specified path.
- **-c** Run the script at the specified path.
- **-debug** Send the debug output to the console.
- **-debugtofile** Send the debug output to file ezfm_debug.txt
- **-help or -?** List the command line options available for FeatureCAM.
- **-i** Load the settings from the specified FeatureCAM .ini file.
- **-l** Specify the network license for FeatureCAM.
- **-m** Load the manufacturing settings from the specified ezfm_mfg.ini file. For example:
  ezfm -uc:\ProgramData\FeatureCAM\ezfm_mfg.ini
- **-noflex or -norms** Skip the license checks.
- **-regserver** Register the FeatureCAM library
- **-u** Load the user-interface settings from the specified ezfm_ui.ini file. For example:
  ezfm
  -uc:\ProgramData\FeatureCAM\ezfm_custom_ui.ini
- **-viewal** Send debug graphics to this ezfm instance

To open FeatureCAM using a command line option:

1. Open a **Command Line** window.
2 Type `ezfm.exe`, followed by the parameter. For example:

![Command Prompt](image)

*You must enter the full path of the executable and any specified files when they are not located in the currently selected directory.*

3 Press the **Enter** key to execute the command.

*Commands are not case-sensitive.*

**Selecting surfaces**

Previously, it could be difficult to select surfaces at each end of a long narrow model. This was because rotating the part would place the view point inside the model causing the outer surfaces to disappear. The problem has been fixed in FeatureCAM 2015 R1.
Milling Improvements

FeatureCAM 2015 R1 contains the following changes and improvements to the Milling module:

- **Tool Holder collision avoidance** (see page 197) — You can now automatically clip toolpaths which would cause a tool holder collision or a gouge.

- **Machine maximum stock** (see page 199) — A new machine maximum stock setting enables you to machine as much stock as possible without retracting the tool.

- **Isoline and Flowline features** (see page 200) — A new sequence option for isoline and flowline milling gives greater control over the creation of toolpaths.

- **Configuring counterbore operations** (see page 202) — A new **Touch off at the shoulder** option enables you to choose the z-zero position for a counterbore operation.

- **Default auto-chamfer tool** (see page 204) — The **Machining Attributes** dialog includes the ability to set a default tool for chamfer operations.

- **Setting toolpath boundaries** (see page 205) — You can use a clipping curve to restrict z-level roughing to a specific area of a part.

- **Creating 5-axis patterns** (see page 207) — 5-axis milling patterns can be specified for any axis.
Tool holder collision avoidance

You can now automatically clip toolpaths which would cause a tool holder collision or a gouge. This makes it easier to program complex parts safely, and you can fix problems without having to simulate the toolpaths repeatedly to find the cause of collisions.

Holder collision clipping only checks for collisions between the tool holder and part surfaces or check surfaces, not remaining stock.

To use tool holder collision and gouge avoidance:

1. Create or open a part containing a Surface Milling feature.
2. Double-click the feature in the Part View to display the Surface Milling Properties dialog.
3. Select an operation in the Tree View.
4. In the Strategy tab, select Holder collision clipping.
5. Select a pass of the operation in the Tree View.
6. In the Milling tab, enter a Holder clearance and Shank clearance. The toolpath is clipped when the holder or shank move within these distances of a surface.
7. Click OK to accept.
8 Simulate the toolpath to show which areas have not been machined:
Machine maximum stock

There is a new **Machine maximum stock** setting, which you can use with **Holder collision clipping** (see page 197) to machine as much stock as possible without the tool retracting. This creates smoother toolpaths with fewer retracts, which can improve the surface finish and reduce the machining time.

- **Machine maximum stock** deselected:

- **Machine maximum stock** selected:

On some parts, this may increase air cutting, which could increase the machining time.

On the **Strategy** tab of the **Surface Milling Properties** dialog, select **Holder collision clipping** and **Machine maximum stock**:
Isoline and flowline features

There is a new sequence option for Isoline and Flowline surface milling features, which gives you more control over the toolpaths. You can now create toolpaths which start at the center of the surface and cut outwards, such as for machining towards and up the walls of cavities.

To create an Isoline or Flowline surface milling feature:

1. Import or open a model with surfaces you want to machine.
2. Click **New Feature** on the **Advanced** toolbar. The **New Feature** dialog is displayed.
3. In the **From Surface** area, select **Surface Milling** and click **Next**.
4. In the Graphics window, select the surfaces you want to machine and click **Next**.
5. Select **Choose a single operation** and click **Next**.
6. In the **Finishing Strategies** section, select **Isoline** or **Flowline** and click **Finish**.

To change the **Sequence** for an Isoline or Flowline Surface Milling feature:

1. In the **Part View**, double-click the feature to display the **Surface Milling Properties** dialog.
2. Select the Isoline or Flowline operation in the Tree View.
The Sequence is displayed on the Surface control tab:

3 Click **Sequence** to cycle through the toolpath sequence options for the selected surfaces. Select:
   - **None** to create a toolpath that cuts across the surface in the same way as in FeatureCAM 2014 R3. This is selected by default.
   - **In to out** to create a toolpath that starts at the center of the surface and cuts outwards.
   - **Out to in** to create a toolpath that starts at the outside of the surface and cuts inwards.

   *The Continuous Spiral option on the Strategy tab overrides this setting.*

4 Click **OK** to save your changes.
Configuring counterbore operations

By default, FeatureCAM calculates the z depth of an operation as the sum of the hole's **Bore depth** and the tool's **Pilot length**. In FeatureCAM 2015 R1, the **Counterbore** tab of the **Counterbore Tool Properties** dialog (see page 1757) contains a new **Touch off at the shoulder** option, which enables you to locate the tool's z-zero position at the end of the tool flutes (the tool shoulder) instead of at the end of the pilot (the tool tip). This improves the accuracy of the toolpath in 2-axis drilling because it minimizes the effect of the pilot length, which is susceptible to greater variation in tolerance.

To choose the z-zero position for a counterbore operation:

1. Double-click the hole feature in the **Part View**. The **Hole Feature Properties** dialog is displayed.
2. Select the **Counterbore** operation in the Tree view.
3. On the **Tools** tab, double-click the counterbore tool you want to configure. The **Counterbore Tool Properties** dialog is displayed.
4. On the **Counterbore** tab, select the **Touch off at the shoulder** check box to position the tool z-zero at the end of the flutes; deselect the check box to position the tool z-zero at the end of the pilot.
5. Complete any other changes in the dialog.
6. Click **OK** to save your changes and close the **Counterbore Tool Properties** dialog.
7 Click **OK** to save your changes to the **Hole Feature Properties** dialog.

*Selecting the **Touch off at the shoulder** check box has no effect on the simulation of the toolpath.*
Default auto-chamfer tool

You can now set a default tool for chamfer operations. This enables you to create multiple features without having to modify them individually to change the tool.

To set a default chamfer tool:

1. Select **Manufacturing > Machining Attributes** from the menu. The **Machining Attributes** dialog is displayed.

2. In the **Tool Selection** tab, select a **Default auto-chamfer tool** from the list:

3. Click **OK** to close the dialog.

The selected tool is used for any new chamfer operations you create; any existing chamfer operations that use the default tool are updated.
Setting toolpath boundaries

Previously, in 3D milling, the Stock Model option was a clipping-curve alternative in the Stock tab of the Surface Milling Properties dialog. This meant that when you chose to use a stock model to determine the toolpath boundaries, the machining operation had to be applied to the whole part. In FeatureCAM 2015 R1, the Stock Model setting is selectable separately to the clipping curve, enabling you to limit operations to a specific area of a part for z-level rough, parallel rough, and 3-axis finishing strategies.

To specify the boundaries of the toolpath:

1. Double-click the feature in the Part View, or right-click the surface and select Properties. The Surface Milling Properties dialog is displayed.
2. Select the strategy in the tree view. The strategy tabs are displayed.
3. Select the Stock tab.
4. Choose a clipping curve. Select:
   - Use part surface dimensions to create toolpaths on the surfaces regardless of the location of the stock.
   - Use stock dimensions to restrict the toolpaths to the portions of the surface feature that are within the stock.
- **Use solid model** to restrict toolpaths to be within the solid model or STL model that you choose.
- **Select curves for boundaries** to use curves to restrict the toolpath boundaries, or to affect the shape of a spiral toolpath.

5. To use the curve in combination with a stock model:
   a. Select the **Stock model** check box.
   b. Select the model from the list.
   c. Select an entry in the **Operations** list.

6. If you want to save the boundary for future use, click **Save Combined Boundary**.

7. Click **OK** to save your changes and close the dialog.
Creating 5-axis patterns

The New Feature Wizard now contains an additional option for creating 5-axis milling patterns. With the new Radial arbitrary index axis option on the Patterns page you can make a hole pattern around any axis, enabling you to program patterns in 5-axis parts quickly and easily. For example:

To create a 5-axis pattern from a new hole:

1. Create a stock using 5th axis positioning in the Stock Wizard, or select 5th axis positioning in the Indexing tab of the Stock Properties dialog.

2. In the New Feature Wizard, select the Hole option, select the Make a pattern from this feature check box. Click Next.

3. In the Dimensions page, enter the details of the hole you want to create. Click Next.
4 In the **Patterns** page, select the **Radial arbitrary index axis** option. Click **Next**.

![Patterns page](image)

5 In the **Location** page, enter the vector of the central axis and the position of the hole. Click **Next**.

6 In the **Dimensions** page, enter the **Number** of holes in the pattern and the **Spacing angle** between each hole. Click **Next**.

7 In the **Location** page, enter the vector of the indexing axis and the position of its origin. Click **Finish**.

To create a 5-axis pattern from an existing hole:

1 Select **5th axis positioning** in the **Indexing** tab of the **Stock Properties** dialog.

2 In the **New Feature Wizard**, select the **Pattern** option. Click **Next**.

3 In the **Pattern Base** page, select the hole from which you want to create the pattern. Click **Next**.

4 In the **Patterns** page, select the **Radial arbitrary index axis** option. Click **Next**.

5 In the **Dimensions** page, enter the **Number** of holes in the pattern and the **Spacing angle** between each hole. Click **Next**.

6 In the **Location** page, enter the vector of the central axis and the position of the hole. Click **Finish**.
Turning improvements

FeatureCAM 2015 R1 contains the following changes and improvements to the Turning module:

- **Improved machining time for undercuts** (see page 210) — FeatureCAM uses a rapid move to machine undercuts smaller than the depth of cut.

- **Synchronizing operations** (see page 211) — Improved synchronization points for multi-turret machines make it easier to manage and update synchronization groups.

- **Turning curves** (see page 213) — Follow and pinch turning are now available for the face and back-face cycles of curves.

- **Tool properties for multi-turret machining** (see page 215) — You can assign operations to specific turrets in the Tool Properties dialog.

- **Multiple part catchers** (see page 216) — Multiple part catcher support is supported through the Cutoff Properties dialog and the FeatureCAM API.
**Improved machining times for undercuts**

FeatureCAM now creates more efficient toolpaths for features that contain undercuts smaller than the depth of cut. Instead of feeding along a previous cut to machine the undercut, FeatureCAM now uses a rapid move. This prevents the tool from cutting the surface twice, and so reduces machining time, increases tool-life, and prevents problems such as work-hardening on the part.

To machine a turning feature that includes a small undercut in FeatureCAM 2015 R1, the tool:

1. Cuts the part to the correct diameters.

2. Retracts and makes a rapid move to the undercut location.

3. Cuts the undercut.
Synchronizing operations

Synchronization points in the Turrets tab (see page 1557) enable you to specify the order in which operations are performed on multi-turret machines. In FeatureCAM 2015 R1, synchronization points have been redesigned to be independent of operations in the tab, making it easier to change and update synchronization groups, and providing a simplified, more intuitive user interface.

Adding operations to the sequences

When you insert a feature into the Part View and Automatic Ordering is selected in the Ops List tab, FeatureCAM adds the feature's operation to the appropriate synchronization group. For example, a copy of the hole6 feature is automatically assigned to the same synchronization group and turret as the original hole.
Moving operations within the sequence

When you drag operations within the Turrets tab, the cursor changes to ; when you drop the operations, they are added immediately after it. If the insertion point is at the boundary of two synchronization groups, the position of the mouse cursor above or below the boundary marker determines which group the operations are added to.

In addition, when you drag one operation of an operation pair, both operations are moved together.

Operation pairs are created by FeatureCAM when a feature generates two linked operations. For example, linked operations are created by FeatureCAM's pinch turning feature.

Removing operations from the sequence

When you delete a feature, or exclude it by deselecting its check box in the Part View, FeatureCAM adjusts the remaining operations in the synchronization group. When you reselect a previously excluded feature, it is reinstated at its original position in the synchronization group.
Turning curves

Follow and pinch turning are now available for the face and back-face cycles of curves. This enables you reduce machining time and take full advantage of multi-turret lathes.

To select the cutting method for a curve:

1 Double-click the Turn feature in the Part View panel. The Turn Properties dialog is displayed.
2 Select the Strategy tab.
3 Select the Turning option.
4 Under Operations, choose a cutting method for each pass you have enabled. Select:
   - Single turret to cut the feature using one turret.
   - Pinch turning to cut the feature using turrets positioned above and below the axis of rotation. The tools cut simultaneously: the first tool leaves a spiral of material and the second tool cuts the spiral of material left by the first tool. For example:

   ![Pinch Turning Example]

   - Follow turning to cut the feature using turrets positioned above and below the axis of rotation. Each turret uses a standard depth of cut, and the top tool leads the bottom tool. For example:

   ![Follow Turning Example]
5 Click **Apply**. The details of the turrets are displayed in the tree view. For example:

6 Click **OK** to save your changes and close the dialog.
Tool properties for multi-turret machining

The **Override** tab of the **Tool Properties** dialog includes new turret options that enable you to set the tool registers for multiple turrets. Use them to quickly view and edit the overrides of tools that are assigned to different slot numbers on different turrets without using the **Tool Mapping** dialog (see page 1575).

To specify the register settings of turrets in the **Tool Properties** dialog:

1. Open the **Tool Properties** dialog for the tool.
2. Select the **Overrides** tab.
3. Select the **Set all turrets** option.
4. In the **Turret and spindle** list, select the turret you want to work with. For example:

5. Edit the **Default tool registers** settings for the turret.
6. Repeat steps 4 through 5 for each turret on the machine.
7. Click **OK** to save your changes and close the dialog.
8. If you are asked whether to set the edited tool as override, click **Yes** to use the new tool for the operation; click **No** to continue using the original tool.
Multiple part catchers

FeatureCAM now supports multiple part catchers on Turnmill machines, such as the Nakamura WT-150. Cutoff catchers are supported by selecting the **Part catcher** check box in the **Strategy** tab of the **Cutoff Properties** dialog (see page 1389); other catchers can be implemented by creating user-defined features with FeatureCAM's application programming interface (API).

For more information on implementing multiple part catchers, contact your sales representative.
Wire EDM improvements

FeatureCAM 2015 R1 contains the following changes and improvements to the Wire EDM module:

- **Improved reliability for no-core machining** (see page 218) — FeatureCAM can create no core toolpaths that ensure no material remains after machining.
- **Selecting cutting data** (see page 219) — Two new conditions are available for selecting data.
Improved reliability for no-core machining

You can create a no-core toolpath that machines an area without creating a slug.

In FeatureCAM 2015 R1, no-core toolpaths are more reliable, and no material remains after machining. This eliminates the risk of loose pieces being left during cutting, which can cause the machine to stop and can damage the nozzle.

To create a no-core toolpath:

1. Create a 2-Axis Die feature.
2. Display the Properties dialog for the Die feature.
3. In the Strategy tab, select Pocketing or Zigzag in the Operations list.
4. To add an unmachined area, click Islands and select a curve using the Select Islands dialog.
5. Click OK to close the dialog.
Selecting cutting data

The Condition dialog contains two new parameters: Nozzle Position and Fluid. If your machine supports different nozzle positions or different types of dielectric fluid, you can use these parameters to select machine register settings from the cut-data database.

![Condition dialog](image)

To select a machine condition for an existing document:

1. Create a Wire EDM document, and open the Stock Properties dialog.
2. On the Dimensions tab, click the Condition button. The new Nozzle Position and Fluid lists are shown at the bottom of the Condition dialog.
3. In each list, select an option to identify the combination of conditions you want to use. If you want to create a new option for a list, click the adjacent button and enter its name. For example, to specify a new Nozzle Position option:
   a. Click ![New](image). The New Nozzle Position Type dialog is displayed.
   b. Enter a name for the new position.
   c. Click OK to save your change and close the dialog.
4. The option is displayed in the Nozzle Position list.
5. To check or specify the machine settings for the condition, click the Cutting Data button. The Feeds/Speeds and Cutting Data Tables dialog is displayed showing the condition you selected:
   - If you have selected a previously defined condition, the machine settings for each pass are displayed in the Wire EDM tab. To change a setting, double-click its cell in the table and overtype the value.
   - If you have selected an undefined condition, a message is displayed in the Wire EDM tab. Click New, select the number of passes required for this condition, and enter the setting values for the condition.
You can customize the **Wire EDM table using the Cutting Condition Names dialog** (see page 237) in XBUILD.

5 When you have finished, click **OK** to save your changes and close the dialog.

6 In the **Condition** dialog, click **OK**.

You can also specify the condition in the **Stock** wizard.
Importing

FeatureCAM 2015 R1 contains the following changes and improvements to importing files from external applications:

- **Using Inventor 2015** (see page 222) — FeatureCAM has been certified for use with Autodesk Inventor 2015.
- **Importing Pro/E files** (see page 223) — The feature tree of imported Pro/E files can be displayed.
- **Importing JT files** (see page 223) — You can load solids from JT files in addition to surfaces.
- **Importing PDF files** (see page 224) — You can import curves from Acrobat files using Delcam Exchange.
Using FeatureCAM with Inventor 2015

FeatureCAM has been certified for use with Autodesk Inventor 2015, an easy-to-use application for the design and documentation of 3D mechanical parts and assemblies. This enables you to use Inventor’s latest design tools to create models, and then to quickly import them into FeatureCAM to create features that are ready for machining.

To use Inventor designs in FeatureCAM:

1. Open the New Part Document wizard.
2. Select Open an existing file and click Next. The Open dialog is displayed.
3. In the Files of type list, select Inventor (*.ipt, *.iam).
4. Select the file you want to work with and click Open.
5. In the New Part Document wizard, select the type of document you want to create, select the Wizard option, and click OK. The file is loaded and the Import Results dialog is displayed.
6. Select Use the wizard to establish the initial setup location, stock size, and import features from Inventor.

   *When FeatureCAM is installed on the same computer as Inventor, it accesses the Inventor data and creates hole features as originally designed.*

7. Complete the wizard to create the part.
Importing ProE files

FeatureCAM can now display the feature tree of imported Pro/E files. Only solid models are imported from Pro/E; the solid models are imported as surfaces or solids depending on the options you set in the Import/Export Options (see page 77) dialog. Only solids are read from a Pro/E file. Any curves or surfaces read must be part of a solid.

You must have the FeatureCAM ProE Import module to import Pro/E files.

To import CAD files:

1. Open a new or existing part file. You must have a part open to import geometry.
2. Select the File > Import menu option. The Import dialog is displayed.
3. Select the file you want to import and click Open. The Import Results dialog is displayed.

Files must have an extension of *.prt, *.prt.%number% (for example foo.prt.8), *.asm, or *.asm.%number% (for example bar.asm.23).

Importing JT files

Previously, FeatureCAM was only able to import surfaces from JT files even though the format supports other information, such as boundary representation surfaces (NURBS), Product and Manufacturing Information (PMI), and metadata. In FeatureCAM 2015 R1, the interoperability of the import process has been extended and you can now also load solids from JT files.

To import a JT file:

1. Open a new or existing part file. You must have a part open to import geometry.
2. Select the File > Import Using Exchange menu option. The Import dialog is displayed.
3. Select the JT file you want to use, then click Open to import the data.

You must install Delcam Exchange to use this feature. Contact your sales representative for more information.
Importing PDF files

The FeatureCAM license now includes the ability to import curves from Adobe Acrobat files using Delcam Exchange.

For example, to import curves from an acrobat file:

1. Open a document.
2. Select the File > Import using exchange menu option. The Import dialog is displayed.
3. In the Files of type list, select PDF Files (*.pdf).
4. Locate and select the acrobat file containing the curves you want to import, then click Open.
5. A message asks if you want to review the import log. Click Yes to view the log, or click No to continue.
6. If the Import Units dialog is displayed to inform you the file was defined using different measurement units to those used in your document, select an option then click OK to continue. The Import Results dialog is displayed.
7. Select Use the wizard to establish the initial setup location and stock size and click Next to create a part using the Import Wizard, or click Accept the imported data 'as is' and exit the wizard and click Finish to complete the import process.

The curves are displayed in the graphics view and listed in the Part View.
Add-ins and extensions

FeatureCAM 2015 R1 contains the following changes and improvements to its add-ins and extensions:

- **Using add-ins** (see page 226) — The *Macro Add-ins* dialog has been updated to improve the management of add-ins and macros.

- **The Add-in Library** (see page 228) — FeatureCAM now includes a catalog of add-ins that were previously only available on the website. The *Add-in Library* is a new feature that enables you to quickly view and select add-ins from the catalog.

- **Turn-curve tolerance** (see page 230) — A new TurnCurveTolerance.bas add-in enables you to tolerance multiple segments in turned or internal bore features.

- **Exporting NC programs to NCSIMUL** (see page 233) — The FeatureCAMToNCSIMUL.dll add-in can now export turn/mill programs as well as milling programs.

- **Extended machine support** (see page 234) — Add-in support for traveling steady rests, bar fed mills, and the Mori Seiki NTX1000 is available for FeatureCAM.
Using add-ins

FeatureCAM 2015 R1 now ships with most of the catalog of add-ins available for customizing and extending its abilities. This enables you to quickly view and select all the applications that have been developed for general and specific purposes without the need to locate and download them from the Internet. To accommodate this expansion, the Macro Add-ins dialog has been updated to make it easier to control and select the add-ins you want to use.

To choose the add-ins you want to use in FeatureCAM:

1. Select the Options > Add-Ins menu option. The Macro Add-ins dialog is displayed.

2. Select the check boxes of the add-ins you want to use. One or more buttons is added to the Macro toolbar for each add-in you can control manually.

Alternatively, if the add-ins are not listed in the dialog, click Library (see page 228) to load them from the FeatureCAM library, or click to load them from file.

Use the Customize Toolbars dialog (see page 28) to create or change the toolbar buttons of add-ins.
3  Deselect the check boxes of the add-ins you do not want to use.

   To remove the selected add-in from the list, click X.

4  If you want to view or edit an add-in, click . The IDE Editor (see page 147) is displayed.

5  Click OK to save your changes and close the dialog.

To run an add-in, click its button on the Macro toolbar. Alternatively, select the View > Run Basic Macro menu option, select the macro in the Run Macro dialog, and click Run.
The Add-in Library

The Add-in Library is a new feature for FeatureCAM 2015 R1. It contains most of the add-ins currently available for FeatureCAM together with descriptions of what they do and how they work. Use it to find out more about add-ins and to choose those you want to make available in the Macro Add-ins (see page 226) dialog.

To use the Add-in Library:

1. In the Macro Add-ins dialog, click the Library button. The Add-In Library dialog is displayed.

The left column lists the available add-ins and macros, categorized by type; add-ins already available in the Macro Add-ins dialog are marked by a check ✓ icon.

2. Choose one or more actions:
   - To show programming examples in the list, select the Include programming examples check box.
   - To search the list, type a string in the Search box. For example, to restrict the list to only those add-ins that include NCCode in their name, type NCCode.
   - To display the Description of an add-in, select its entry in the list.
To add an add-in to the **Macro Add-ins** dialog, select its entry in the list and click **Load**. The entry is marked by a plus **+** icon.

To remove an add-in from the **Macro Add-ins** dialog, select its entry in the list and click **Unload**. The entry is marked by a cross **×** icon.

3 Click **OK** to save your changes and close the dialog. Loaded add-ins are listed in the **Macro Add-ins** dialog; unloaded add-ins are removed from it.
Turn-curve tolerance

TurnCurveTolerance.bas is a new add-in which enables you to tolerance turned or internal bore features according to ISO 282-2 standards or custom tolerances specified in design documents. Use it to quickly resize features without redrawing the curve.

To adjust a curve:

1. Install the TurnCurveTolerance.bas add-in. (see page 145)
2. Select the turning or internal bore feature in the Part View.
3. In the Macros toolbar, click the add-in's button. The Fillet and Chamfer Limit dialog is displayed.

4. Enter the size of the largest fillet or chamfer of the feature:
   - Diagonals and arcs shorter than or equal to this value are treated as chamfers and fillets. When neighboring segments are adjusted, the add-in translates them without changing their size or orientation.
   - Diagonals and arcs longer than this value are treated as stationary parts of the curve. They affect the tolerance limits of adjacent segments and are not translated.
5  Click OK. The Tolerance of Turned Segments dialog is displayed, and the vertical and horizontal segments are labeled in the graphics window.

![Tolerance of Turned Segments dialog](image)

6  Adjust the labels:

   - To change the label size, enter a new value in the Set text size box, and click Set.
   - To label only the currently selected segment, deselect the Segment labels on check box.

7  In the Segments list, select the segment you want to adjust. The segment and its label are displayed in red.

![Segments list](image)

8  Specify the adjustment for the segment:

   - To calculate the adjustment from specified tolerances, select the Upper tolerance - Lower tolerance option and enter the tolerance values.
   - To calculate the adjustment from standard tolerances, select the Upper tolerance - Lower tolerance option, and select the tolerances in the ISO 286-2 list.
To specify the adjustment, select **Net tolerance**, and enter the distance by which you want to move the segment.

9 Click **Apply Tolerance**. The adjustment for the segment is displayed below the button.

10 Repeat steps 7 through 9 for each segment you want to adjust.

11 Click **OK** to apply your changes and close the dialog.

FeatureCAM creates a new curve and feature, and displays the results in the Graphic window. For example:
Exporting NC programs to NCSIMUL

FeatureCAMToNCSIMUL.dll is an add-in, which provides the ability to export NC code for simulation and optimization in NCSIMUL. In FeatureCAM 2015 R1, the add-in has been extended to enable the export of turn/mill programs as well as the original milling programs.

To export a program to an NCSIMUL project:

1. Install NCSIMUL on your computer and the NCSIMUL tool for reading FeatureCAM files.
2. In FeatureCAM, open the milling or turn/mill document you want to export.
3. Run a simulation and generate the NC code, Ensure the code has no errors.
4. Select the Options > Add-Ins menu option. The Macro Add-ins dialog is displayed.
5. Select the FeatureCAMToNCSIMUL.dll check box. 

   *If the add-in is not listed in the dialog, you can load it from the Add-ins Library dialog.*

6. Click OK. The FeatureCAM to NCSIMUL add-in button is displayed in the Macros toolbar.
7. Click the FeatureCAM to NCSIMUL button on the Macros toolbar. The FeatureCAM to NCSIMUL dialog is displayed.
8. In the FeatureCAM to NCSIMUL dialog, select the export options for the document.
9. Click Export to save the NC code to file. FeatureCAM simulates the part and exports the program files. When the export is finished, a message lists the files and their locations.
Extended machine support

FeatureCAM now includes add-in support for the following machines and features:

Mori Seiki NTX1000

The Mori Seiki NTX1000 is an integrated mill turn center designed for machining small, precision parts. A new machine design (.md) file and post are available for programming the machine together with a user defined feature for controlling the actions of the workpiece discharge unit.

Traveling steady rests

A new TravelingSteadyRest. bas add-in enables you to program a steady rest to follow behind the tool while roughing bar stocks. This add-in is not available in the library as it requires a customized post and machine model for each installation. For more information, contact the post-processor department of your local support office.
XBUILD improvements

FeatureCAM 2015 R1 contains the following changes and improvements to the XBUILD module:

- **Custom formats** (see page 236) — The Custom Format Name dialog has an enhanced user interface to support the creation of naturalistic process names.

- **Customizing cutting data from Wire EDM** (see page 237) — You can now configure the headings of the cutting data table for use with Wire EDM.

- **Saving CNC files** (see page 240) — Post numbers can be used to identify individual output files for Fanuc-style multi-turret lathes.

- **Configuring reserved words** (see page 242) — The Word Info dialog includes a new option that enables you remove all non-significant zeros from numeric outputs.

- **Using the Reserved Words dialog** (see page 243) — The Reserved Words dialog is easier and quicker to use.
Custom Formats

The Custom Format Name dialog now supports the use of underscores and periods in format names. This enables you to create more naturalistic process names and to accurately represent decimal measurements. In addition, space characters are automatically converted to underscores to ensure the names are unbroken.

To create a Custom Format:

1. In XBUILD, select the Formats > Custom > New menu option. The Custom Format Name dialog is displayed.
2. Enter a name for the custom format. You can use any upper- or lower-case character, periods, and underscores. For example:

   ![Custom Format Name dialog](image)

3. Click OK to create the format and close the dialog. The XBUILD Editor is displayed with the format name in the Title bar.
4. When you have finished creating the format, select the File > Quit menu option, and click Yes in the message dialog to save your changes.
Customizing cutting data for Wire EDM

The Wire EDM tab (see page 219) in FeatureCAM has been extended to include customizable fields, which can be used to record machine-specific settings as well as the original Feed, Water, Comp-num, and Comp-val values. To enable you to manage and customize all the fields, the Cutting Condition Names dialog has been redesigned, and it now lists the original settings followed by 16 fields that can contain numeric information and 6 fields that can contain strings.

To specify the condition names:

1. In XBUILD, select the CNC-Info > Machine menu option. The Machine Information dialog is displayed.
2. In the Machine type list, select Wire EDM and click OK to close the dialog.
3. Select the CNC-Info > Cutting Condition Names menu option. The Cutting Condition Names dialog is displayed.
4 In the **Reserved Word** column, click the setting you want to customize, and type a name for it in the box at the bottom of the table. The name is displayed in the custom name column of the table. For example:

![Cutting Condition Names dialog](image)

5 Repeat step 4 for each setting you want to customize.

6 Click **OK** to save your changes and close the dialog.

7 Select the **File > Save CNC** or **File > Save as CNC** menu option to save the post file.
When you next view the stock settings, the field names you specified are displayed on the Wire EDM tab of the Feeds/Speeds And Cutting Data Tables dialog. For example:
Saving CNC files

FeatureCAM 2014 R2 included the ability to display the post number of turrets throughout the user interface. In FeatureCAM 2015 R1, a new **Use P numbers in NC file name** option has been added to the **Turret Information** dialog that enables you to also include these post numbers in the names of saved NC files. In addition, a new **NC File Extension** box gives you the ability to customize the letter used as the post extension's prefix.

To specify the turret identifier for the CNC files:

1. In XBUILD, select the **CNC-Info > Turrets** menu option. The **Turret Information** dialog is displayed.

2. In the **Multi-turret programming** list, choose an option to specify the type of NC Program files you want to create. Select:
   - **None** for lathes with one turret.
   - **Okuma Style** for multi-turret lathes that require one program file for all turrets.
   - **Fanuc Style** for multi-turret lathes that require a separate program file for each turret.

3. By default, the turret identifier starts with **P**. If you want to use a different prefix, enter a new character in the **NC file extension** box.
4 Select the **Use P numbers in NC file name** check box to use the **P number** of each turret as the suffix of the **NC file extension**. Deselect the check box to use the default post numbers for the file extensions.

5 Complete the settings, and click **OK** to save your changes and close the dialog.

6 Save the post file.

7 In FeatureCAM, generate the NC code for your part, and select the **File > Save CNC** menu option. The **Save NC** dialog is displayed.

8 Enter the output settings and click **OK** to create the NC program files:

- **With Fanuc-style and Use P numbers in NC file name selected;** the P numbers are **1, 3, 11, 20**; and an **NC file extension** of **T**, FeatureCAM creates files named: %DocumentName%.T1.TXT, %DocumentName%.T3.TXT, %DocumentName%.T11.TXT, and %DocumentName%.T20.TXT.

- **With Fanuc-style selected and Use P numbers in NC file name deselected;** P numbers of **1, 3, 11, 20**; and an **NC file extension** of **T**, FeatureCAM creates files named: %DocumentName%.TXT, %DocumentName%.T2.TXT, %DocumentName%.T3.TXT, and %DocumentName%.T4.TXT.

- **With Okuma-style or None selected,** only one file is created.
Configuring reserved words

The Word Info dialog enables you to view and change the output format for reserved-word values. In FeatureCAM 2015 R1, the dialog has been redesigned, and now includes a **Minimize width** option, which allows you to omit all non-significant zeros from numeric outputs, and a **Preview** column, which displays the effect of the settings for each reserved word.

To configure the output of reserved words:

1. In XBUILD, select a **Words** option in the **CNC-Info** menu. The **Words Info** dialog displays the sub-set of reserved words for the option you selected.

2. For each reserve word you want to update, select the **Minimize width** check box. This removes leading zeros from decimal-only outputs and trailing zeros from integer-only outputs. For example, when the check box is selected, the reserved word outputs 4 as 4, and 0.2 as .2; when the check box is deselected, 4 is output as 4.0, and 0.2 is output as 0.2.

3. Check the effect of your changes using the **Preview** column:
   - To test the effect of the settings on different outputs, type a new value in the box above the column.
   - To test the effects of the **Inch format** and **Metric format** settings, select the preview options below the column.

4. Click **OK** to close the dialog and save your changes.
Using the Reserved Word dialog

The **Reserved Word** dialog of the **Formats** editor enables you to quickly add variables to the format you are editing.

In FeatureCAM 2015 R1, several new features have been added to the dialog that make it easier for you to find and add words to a format:

- Words are now identified by category: string words are followed by \((S)\); logical words are followed by \((L)\); and numeric words are followed by \((N)\); system words have no identifier.

- Tabs across the top of the dialog enable you to restrict the list to a specific category of word. For example, to list only system words, select the **System** tab; to list all reserved words again, select the **All** tab.

- In the **All** tab, words are listed in alphabetical order instead of by alphabetical order within category. This enables you to look for words by name without knowing the category it belongs to.

- A new search box below the tabs enables you to list only those words that contain a specified string. For example, type **spindle** in the box to list only those words that contain the string "spindle". When you select a word, the box is automatically cleared and the list scrolls to display the word's entry.

- In addition to being selectable, the **Modal delimiters** check box can now be toggled on and off using the **Control** key. To insert a word in modality brackets, press the **Control** key; select the word in the list, and release the key.
Reference Help

The FeatureCAM Reference Help is split into the following sections, which follow the recommended steps in the Steps panel (see page 1). You can follow these steps to create a part from start to finish and output the NC Code.

- **Reference Help Introduction** (see page 1) — This section covers the main concepts in FeatureCAM, such as the user interface, and creating and saving parts.
- **Stock** (see page 205) — This section covers stock (the material from which you machine the part), and indexing.
- **Geometry** (see page 274) — The basic shapes, such as lines and circles, from which you can create curves.
- **Curves** (see page 318) — Curves are continuous paths in 2D or 3D space. Use curves to create features, surfaces and solids.
- **Surfaces** (see page 381) — Surfaces are continuous sets of points in 2D or 3D space which have no thickness. Use surfaces to create surface milling features.
- **Solids** (see page 445) — Solids are groups of connected surfaces that make up a solid model.
- **AFR** (see page 495) (Automatic Feature Recognition) — Automatically extract machining features from solid models.
- **Features** (see page 529) — Use features to generate toolpaths without creating individual manufacturing operations.
- **Toolpaths** (see page 1516) — Simulate the toolpaths in FeatureCAM to see the finished part and check for collisions.
- **NC Code** (see page 1565) — Create the NC code and send it to the machine (see page 1583).
- **Customize Mfg.** (see page 1591) — Customize the manufacturing settings.
These steps are used for mill, turn, turn/mill, and wire documents; different steps are used for multiple fixture (see page 1872), tombstone machining (see page 1885), and machine simulation (see page 1899) documents.
Reference Help Introduction

This section covers the main concepts you need to use FeatureCAM:

- using the FeatureCAM interface (see page 1).
- creating a new part (see page 61), saving your part (see page 66), and importing and exporting parts (see page 75).
- coordinate systems (see page 109).
- document-level options (see page 128).
- add-ins (see page 145).
- fixing errors (see page 194) in the toolpaths.

FeatureCAM interface

The FeatureCAM interface contains a number of traditional Windows elements, such as toolbars, dialogs, context menus, and wizards.

1. Title bar
2. Menu bar (see page 2)
3. Results window
4. Assistance bar — Step-by-step instructions are displayed on the assistance bar.
As with other Windows programs, you can tell FeatureCAM what to do in several ways:

- Select a button on a toolbar;
- Select an option from a menu;
- Select an option from a context menu;
- Press a keyboard shortcut (see page 30).

As you master FeatureCAM, try combining several methods of issuing commands to get your work done faster.

Right-clicking displays a context menu. The menu varies depending on where you are in the program. The menu contains common commands and functions that are useful in that area.

**Menu bar**

The menu bar is displayed at the top of the screen.

Like many other Windows-based software packages, FeatureCAM includes a series of drop-down menus. These menus are unique to FeatureCAM and give one or more of the functions you need to use the program.

You can access many of these functions using the Steps panel and toolbars.

Some of the menus contain sub-menus, for example:
In the documentation, if you are instructed to move through a series of sub-menus, this is formatted with a chevron between each menu item. For example: Select Construct > Surface > Primitives > Cylinder from the menu.

**Toolbox**

The Toolbox is to the left of the Graphics window in FeatureCAM and contains three panels:

- Part View (see page 4)
- Steps (see page 6)
- Browser (see page 8)

To toggle the display of the Toolbox, click on the tab name to collapse or expand it.

To adjust the width of the toolbar, move the cursor over the Toolbox border. When it changes to ‘|’, click and drag the border.
Part View

The Part View panel displays a hierarchical view of the part. Each Setup is listed with each of the features of the Setup listed below. From this view you can select, show, hide, or edit features.

To use the part view:

- Click † next to an item to expand the view and show the item's sub-items. Click ‡ to collapse the view and hide the item’s sub-items.
- Move the cursor over an item's name to highlight it in green in the graphics window. Use this to distinguish between overlapping items and find items in complex documents.
- Click an item's name in the Part View to select the item. Selected features are highlighted in red in the graphics window.
- Right-click an item to display the context menu to perform an action on the item. Alternatively, click † next to the selected item.
- Features have a check box next to their name. When you deselect the feature, it is excluded from the next toolpath generation.
- All objects, except geometry, are represented in the Part View.
- You can select multiple items in the part view by using Shift+click and Ctrl+click.
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Document" /></td>
<td><strong>Document</strong></td>
<td>Displays the name of the current document. Use the right-click context menu to Include All Features or Exclude All Features in the current document.</td>
</tr>
<tr>
<td><img src="image" alt="Machining Attributes" /></td>
<td><strong>Machining Attributes</strong></td>
<td>Double-click the icon to display the Machining Attributes dialog (see page 1591) where you can specify the default machining attributes.</td>
</tr>
<tr>
<td><img src="image" alt="Stock" /></td>
<td><strong>Stock</strong></td>
<td>If you select the stock name in the Part View, the stock is highlighted in red in the graphics window. Double-click the stock name to open the Stock Properties dialog. You can show, hide, and center the stock from the context menu.</td>
</tr>
<tr>
<td><img src="image" alt="Setup" /></td>
<td><strong>Setup</strong></td>
<td>The features belonging to the Setup are listed below each Setup name.</td>
</tr>
<tr>
<td><img src="image" alt="Feature" /></td>
<td><strong>Feature</strong></td>
<td>If you select a feature name in the Part View, the feature is highlighted in red in the graphics window.</td>
</tr>
<tr>
<td><img src="image" alt="Pattern or Group" /></td>
<td><strong>Pattern or Group</strong></td>
<td>A pattern or group of features. If you select a pattern or group name in the Part View, the pattern or group is highlighted in red in the graphics window.</td>
</tr>
<tr>
<td><img src="image" alt="Stock Models" /></td>
<td><strong>Stock Models</strong></td>
<td>Lists any stock models (see page 266) in the document. Select Add Stock Model from the context menu to open the Add Stock Model dialog.</td>
</tr>
<tr>
<td><img src="image" alt="Turrets" /></td>
<td><strong>Turrets</strong></td>
<td>Lists the turrets for multi-turret Turn documents. (MTT (see page 10)). The turret names are taken from the solid names in the Machine Design file.</td>
</tr>
<tr>
<td><img src="image" alt="Curves" /></td>
<td><strong>Curves</strong></td>
<td>Lists the curves in the document. If you select a curve name in the Part View, the curve is highlighted in red in the graphics window.</td>
</tr>
<tr>
<td><img src="image" alt="Surface" /></td>
<td><strong>Surface</strong></td>
<td>If you select a surface name in the Part View, the surface is highlighted in red in the graphics window.</td>
</tr>
</tbody>
</table>
### Symbol

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏗️</td>
<td>STL</td>
<td>Lists STL solid model files that have been imported into FeatureCAM. Select an STL name in the Part View and the STL is highlighted in red in the graphics window.</td>
</tr>
<tr>
<td>🏗️</td>
<td>Solids</td>
<td>Lists the solids in the document. If you select a solid name in the Part View, the solid is highlighted in red in the graphics window.</td>
</tr>
<tr>
<td>🏗️</td>
<td>Layers</td>
<td>Lists the layers (see page 299) in the document.</td>
</tr>
</tbody>
</table>

### Steps panel

The Steps panel contains an ordered list of steps for creating part programs. Each step is a wizard that presents a series of dialogs for each process. They are listed in the order in which you should use them during the process of creating a part program.

- **Stock** — Click this step to open the Stock wizard (see page 205), which steps you through entering the shape and dimensions of the stock, the stock material, the Setup (part program zero), and the coordinate system for modeling.

- **Geometry** — Click this step to open the Geometry Constructors dialog (see page 275). Points, arcs, lines, and other shapes are used to describe the overall shape of parts. Many different geometry tools are available. You can also import geometry from CAD systems.

- **Curves** — Click this step to open the Curve Creation dialog (see page 319). Shapes that involve more than a single line or arc are described as curves. For 3D Milling customers, there are also Surfaces and Solids steps for creating 3D surface and solid models.

- **Surfaces** (3D LITE (see page 10)) — Click this step to open the Surface Wizard (see page 381), which steps you through creating surfaces from curves, primitive surfaces, surfaces from one surface, and surfaces from multiple surfaces.

- **Solids** (SOLID (see page 10)) — Click this step to open the Solid Wizard (see page 452), which enables you to create solids using numerous techniques.
**AFR (Automatic Feature Recognition) (RECOG (see page 10))** — Click this step to open the **Automatic Feature Recognition** wizard (see page 508), which enables you to create features automatically from solid models.

**Features** — Click this step to open the **New Feature** wizard (see page 530). Features are common shop terms like pocket, or thread. They are created from curves and dimensions. These objects describe your part in 3D and are used to generate toolpaths.

**Toolpaths** — Click this step to display the **Simulation** toolbar (see page 1516). Toolpaths are generated from collections of features. You can simulate them in FeatureCAM using toolpath centerlines, 2D shaded, or 3D solid shaded simulations.

**NC Code** — Click this step to open the **NC Code** dialog (see page 1565). Machine-specific G-codes are generated from the toolpaths. Translators are provided for many different NC controls and include a program for creating new translators.

**Customize Manufacturing** — Click this step to open the **Customize Manufacturing** dialog (see page 1591). FeatureCAM automates the entire part programming process, you can customize all of the system settings including feed/speed tables, tooling databases, or feature settings.
**Browser**

The **Toolbox** contains a **Browser**.

To open the browser, click the **Browser** tab inside the **Toolbox** window.

The **Browser** contains information on the latest features available in FeatureCAM, including example files that you can load straight into FeatureCAM. To load an example project from the **Browser**, click the preview picture.
Click the **Folder** icon to open a folder containing more files.

To resize the **Browser**, move the cursor over the **Toolbox** border until the cursor changes to ✂️, then click and drag the border.

![Browser Resize Arrow](image)

**Browser buttons**

The **Browser** contains the following buttons at the top:

- **Home** - Click to go home to the default Browser home page.
- **Website** - Click to open the FeatureCAM website (www.featurecam.com).
- **Release Center** - Click to open the FeatureCAM Release Center website (releasecenter.featurecam.com).
- **Forum** - Click to open the FeatureCAM user forum (forum.featurecam.com).
- **Email** - Click to email Delcam about non-support-related issues, or if you do not have the email address of your reseller.

You may need to go back to the top of the page to see these buttons by scrolling or using the **Top** button detailed below.

And the following button at the bottom:

- **Top** - click to go to the top of the current page.

**Context menu**

Right-click inside the browser to open a context menu that includes the following items:

- **Back** - the Browser returns to the previous page that you viewed.
- **Select All** - selects all the content on the Browser's current page.
Print - prints the Browser's current page.

Refresh - reloads the page to include any changes that have been made to the page.

Viewing other HTML files
To open an HTML file saved on your computer in the Browser:

1. Select File > Open from the menu.
   This displays the Open dialog.

2. Under Files of Type at the bottom of the dialog, select either HTML (*.html, *.htm) or All Files (*.*).

3. Browse to where the file is saved.

4. Either double-click the name of the file you want to open or select it and click Open.
   The file is displayed in the Browser.

To close a file that you have opened from your computer in this way, right-click inside the browser and select Back from the context menu.

Default browser content (see page 143)

Toolbars
Toolbars are usually located at the top, but you can dock them in other locations or undock them and leave them floating anywhere on the screen. Toolbars comprise one or more buttons, which each has a different function. You can quickly access many of the menu functions using the toolbars.

The following toolbars are available in FeatureCAM:

Standard (see page 11)
Advanced (see page 12)
Curves and Surfaces (see page 13)
Snap Mode (see page 15)
Display Mode (see page 16)
Geometry (see page 17)
Simulation (see page 17)
Steps (see page 22)
Solid (see page 22)
More Simulation (see page 22)
Only the **Standard** and **Advanced** toolbars are shown by default. Use the **Customize Toolbars** (see page 23) dialog to set which toolbars are displayed.

*Buttons are often grouped together to save space on the toolbars. Click the arrow \(\downarrow\) buttons to access the menu of all buttons in a group.*

### Standard toolbar

- The **New Part Document** button creates a new part file. You can control how files are created by selecting **Options > File Options** from the **Menu** bar, and customizing the settings on the **New Files** tab.

- The **Open** button opens an existing file. You can control how files are opened by selecting **Options > File Options** from the **Menu** bar, and customizing the settings on the **Existing Files** tab.

- The **Save** button saves the current file. You can control how files are saved by selecting **File > Save Options** from the **Menu** bar.

- The **View** menu enables you to select viewing modes for your part. Your cursor shows the same icon as the viewing mode you selected.

- The **Principal View** menu enables you to select one of seven predefined views for your part.

- The **Shade** button toggles display of shaded surfaces for solid modeling. You need to have the Solid Modeling module to use this option.

- The **Undo** button reverses the effect of the previous command. FeatureCAM remembers a long list of the commands that are performed, so you can undo more than one command.

- The **Delete** button erases the object that is selected on the screen. The object is removed from the system.
The **Select** menu enables you to select objects in the graphics window (see page 56), using the **Select**, **Select Partial**, or the **Drag Select** method. When you are in select mode, the mouse pointer is displayed as a standard arrow pointer in the graphics window.

The **Transform** button opens the **Transform** dialog, and enables you to move or copy the selected entity.

The **Options Dialog** button opens the **Options** dialog, and enables you to customize FeatureCAM.

The **Context Help** button switches on context-sensitive help. When the cursor has changed to a question mark (帮助), click a menu item, button, or dialog to receive more information.

The **FeatureCAM Help** button opens online help.

---

**Advanced toolbar**

The **Show** menu contains the object categories that can be displayed in the graphics window.

The **Hide** menu contains the object categories that can be hidden in the graphics window. Hiding objects does not delete them; it just removes them from display.

Click the **Curve Wizard** button to display the **Curve** wizard, which enables you to construct curves. The commands available in this wizard are also available from the **Curves and Surfaces** (see page 13) toolbar.

Click the **Surface Wizard** button to display the **Surface** wizard, which enables you to construct surfaces. The commands available in this wizard are also available from the **Curves and Surfaces** (see page 13) toolbar.
Click the **Solid Wizard** button to display the **Solid** wizard, which enables you to construct solids. This option is available if you have the **Solid Modeling** module. (SOLID (see page 10))

Click the **Toggle Geometry Bar** button to toggle the display of the **Geometry** toolbar (see page 17).

Click the **Snap Modes** button to display the **Snap Modes** dialog, which enables you to set the locations for point snapping.

Click the **New Feature Wizard** button to display the **New Feature** wizard, which enables you to create features.

Click the **UCS** button to display the **User Coordinate System** dialog, which enables you to create a new UCS or change an existing UCS.

Click the **Setups** button to display the **Setups** dialog, which enables you to create or edit a part program zero.

---

### Curves and Surfaces toolbar

The **Curves and Surfaces** toolbar enables you to quickly specify curves and surfaces. It is divided into two sections: the curve buttons are on the left section; the surface buttons are on the right.

To use the toolbar:

1. Display the **Curves and Surfaces** toolbar in one of these ways:
   - Select **View > Toolbars** from the menu to display the **Customize Toolbars** dialog. In the **Toolbars** list, select **Curves and Surfaces** and click **OK**.
   - Right-click in a space in the toolbars area and select **Curves and Surfaces** from the context menu.

2. Click **to list the options in a group.**

3. Click the curve or surface you want to create.

The button in the toolbar displays the icon of the item you last selected. Click the button again to create another item of the same type.
Curve from Other Methods Menu:
- Spline/interpolation (see page 367)
- Text (see page 368)
- Ellipse (see page 374)
- Rectangle (see page 375)
- Functions (see page 356)
- Cams (see page 364)
- Polygon (see page 376)
- Gears (see page 378)

Curve from Curve Menu:
- Join (see page 327)
- Curve Start/Reverse (see page 329)
- Offset (see page 332)
- Project to UCS (see page 333)
- Extract Font Curve (see page 334)
- Smooth/Reduce Curve (see page 335)
- Unwrap (see page 339)
- Merge (see page 341)

Curve from Surface Menu:
- Boundary (see page 343)
- Trimmed Edge (see page 344)
- Intersection (see page 345)
- Isoline (see page 347)
- Project onto Surface (see page 349)
- Surface Edges (see page 350)
- Surface Projection (see page 351)
- Revolved Surface Boundary (see page 353)

Surface Primitives Menu:
- Sphere (see page 406)
- Cylinder (see page 409)
- Flat (see page 410)
- Surface(s) from Feature (see page 411)

Surface from Curve Menu:
- Extrude (see page 385)
- Surface of Revolution (see page 386)
- Swept Surface (see page 389)
- Ruled Surface (see page 392)
- Coons (see page 395)
- Curve Mesh (see page 397)
- Lofted Surface (see page 400)
- Cap Surface (see page 403)
Surface from Surface Menu:
- Region from Surface (see page 413)
- Reverse Surface (see page 414)
- Offset Surface (see page 416)
- Extend Surface (see page 417)
- Trim Surface (see page 418)
- Untrim a Surface (see page 422)
- Split Surface (see page 424)

Surface from Surfaces Menu:
- Fillet (see page 427)
- Merge (see page 431)
- Surface-Surface Trim (see page 432)
- Modify Surface (see page 437)
- Corner Blend (see page 441)

To construct surfaces, you must have the FeatureCAM 3D module.

Snap Mode toolbar

Select Snap to Grid to enable snapping to points in the snapping grid, which is displayed on the stock. You can customize the snapping grid by selecting the Options > Snapping Grid menu option.

Select Snap to Point to enable snapping to point objects.

Select Snap to End Point to enable snapping to the end points of finite lines and arcs, including the corners of the stock and lines in STL objects.

Select Snap to Midpoint to enable snapping to the middle points of finite lines and arcs.
Select **Snap to Section** to enable snapping at equal intervals of a finite line. The number of intervals a line is split into is controlled by the **Sections** option in the **Snapping Grids** dialog.

Select **Snap to Intersection** to enable snapping to the intersections of lines, arcs, and circles.

Select **Snap to Center** to enable snapping to circle centers. This setting also controls the display of circle and arc center points.

Select **Snap to Quadrant** to enable snapping to the four points on a circle corresponding to 0, 90, 180, and 270 degrees.

Select **Snap to Object** to enable snapping to points on objects, such as surfaces or STL objects.

Select **Snap to Tangent** to enable snapping to objects such that the object you create is tangent to the snapped object.

Select **Snap to Toolpath** to enable snapping to points on a centerline toolpath simulation.

Select **Snap to cylinder end points** to enable snapping to the end points of a cylinder or cone axis.

Select **Snapping Discrimination Dialog** to display the **Snap Discrimination** dialog if the point you select could snap to more than one location.

---

**Display Mode toolbar**

The **Shade Selected** button shades objects selected on the screen. This is the only way to shade features.

The **Unshade Selected** button removes shading from the selected objects, and returns them to line drawings.

The **Unshade All** button returns all objects to line drawings.

The **Hidden Line** button toggles the view of solids to hidden line mode.
The **Draft Hidden Line** button toggles the view of solids to draft hidden line mode.

The **Show Normals** button shows the normals for selected surfaces in the model.

The **Unshow Normals** button hides the normals for selected surfaces in the model.

The **2D Turned Profiles** button shows turning features as 2D profile.

---

**Geometry toolbar**

The **Point** button creates a point at X Y Z coordinates.

The **Line** menu lets you create different types of lines.

The **Circle** menu lets you create different types of circles.

The **Fillet** menu lets you create different types of fillets.

The **Arc** menu lets you create different types of arcs.

The **Dimension** menu lets you create dimensions, or special text labels with attached lines to indicate your part's size.

The **Edit** menu lets you edit selected geometry.

The **Chain** menu lets you construct feature curves from selected geometry.

---

**Simulation toolbar**

The Simulation toolbar is displayed when you click the Toolpaths step in the Steps panel:
It is not docked by default, but you can dock it and display it as a normal toolbar.

![Simulation Toolbar]

Click the **Eject** button to remove the **Simulation** toolbar from the screen, and erase the simulation from the graphics window.

The **Show Centerline** button selects a centerline simulation. When you click the **Play** button, the simulation is performed using the current view to draw the toolpaths. A line drawing representing the center of the tool tip is displayed.

The **2D Simulation** button selects 2D simulation. When you click the **Play** button, a two-dimensional color simulation is performed showing the regions cut by each operation. The view is changed to the top view automatically, and anything on the screen is temporarily erased until the simulation is complete. You cannot change the view during the simulation. When the simulation is complete you can change the view, but the toolpaths are erased.

The **3D Simulation** button selects 3D simulation. When you click the **Play** button, a 3D shaded simulation is performed in the current view with the tool animated through all of its moves. You can dynamically change the view of the simulation at any point during or after the simulation. The simulation does not have to be recalculated, so the view change is instantaneous.

The **3D RapidCut** button selects rapidcut simulation. When you click the **Play** button, a 3D simulation is performed without animating the tool. Only the final results are displayed. For most parts, the simulation takes only a few seconds to complete. This simulation can be viewed dynamically.

This simulation type is available if you have the FeatureCAM3D module; it does not apply to turned parts. (3D LITE (see page 10))
The **Machine Simulation** button selects machine simulation. When you click the **Play** button, a full machine simulation is performed showing you how the machine cuts the part. Odd motions and collisions can be detected so that the program can be adjusted long before code is sent to the CNC machine.

This simulation type is available if you have licensed the Machine Simulation component. (MSIM (see page 10))

Click the **Stop** button to cancel a simulation.

Click the **Play** button to start a simulation, or resume a paused simulation. After you have clicked the **Play** button, it becomes the **Pause** button.

This button starts a simulation of the selected feature, or resumes a paused simulation.

Click the **Pause** button to pause the simulation. After you have clicked the **Pause** button, it becomes the **Play** button.

Click the **Fast Forward to End** button to accelerate the simulation, and fast forward it to the end.

Click this button to accelerate the simulation of the selected feature, and fast forward it to the end.

Click the **Single Step** button to move the simulation ahead by one tool move. The keyboard shortcut for this button is **Alt+F3**.

Click this button to move the simulation of selected feature ahead by one tool move.

Click the arrow of the **Simulation Next** menu to access a sub-menu of buttons:

- **Play to next operation** — Click this button to play the simulation and pause at the next operation.
- **Play to next rapid** — Click this button to play the simulation and pause at the next rapid.
- **Play to next tool change** — Click this button to play the simulation and pause at the next tool change.
- **Play to next Z level** — Click this button to play the simulation and pause at the next Z level.
Click the **Simulation Next** menu arrow to specify how the simulation is played.

Click the **Clear Toolpath** button to erase any centerline toolpaths shown on the screen.

Click the **Region of Interest** button to limit the portion of the part that is rendered during a 3D solid simulation or a rapidcut simulation.

Click the **Show Tool Load** button to display the **Tool Load** dialog during the next 3D simulation. This dialog graphs the horsepower requirements of the part program, and displays the current simulation time and instantaneous horsepower.

Deselect **Toggle Rapids in Centerline Simulation** to hide rapid moves in centerline simulations so that you can see cutting moves more easily in complicated toolpaths.

Click **Change the Simulation Tool Color** during a simulation to change the color of the simulation tool. This does not affect the color of cuts that have already been simulated. For example you can use this to display different passes of an operation in different colors to check for air cutting.

Use the **Sim Speed** slider to adjust the simulation speed. Move the bar to the right to speed up the simulation; move the bar to the left to slow it down.

When using **3D RapidCut**, the slider affects the simulation display. If the slider is all the way to the right, only the final simulation result is displayed. Move the slider further to the left to see intermediate results.

You can increase the length (see page 20) of the **Sim Speed** slider, to make it easier to control the speed.

**Lengthen Sim Speed slider**

You can increase the length of the simulation speed slider on the **Simulation** toolbar (see page 17), to make it easier to control the speed.

To do this:

1. Ensure the **Simulation** toolbar is displayed (see page 24).
2 Select View > Toolbars from the menu. The Customize Toolbars dialog is displayed, but you don't need to do anything in the dialog.

3 Click on the Sim Speed slider in the Simulation toolbar and it displays a border.

4 Hover over the border at the right of the button and the mouse pointer changes to a double arrow icon.

5 Drag the right border out as far as you want.

6 Click OK to save your changes and close the Customize Toolbars dialog.
**Steps toolbar**

The Steps toolbar displays the Steps available in the Steps panel (see page 6) in the Toolbox window.

*Using the Steps toolbar instead of the Steps panel enables you to use the Part View panel and still gives you quick access to the Steps in the Steps panel.*

**Solid toolbar**

- The Solid from Curve menu lets you construct solids from curves.
- The Solid from Surfaces menu lets you construct solids from surfaces.
- The Modify Solid menu lets you edit solids.
- The Manufacturing Solids menu lets you select a manufacturing category.

**More Simulation toolbar**

- This button toggles the display of the Simulation toolbar (see page 17), and lets you preview the toolpaths from start point.
- This button toggles the display of the Simulation toolbar, and lets you preview the toolpaths for selected Z level.
- This button toggles break points in the simulation at toolpath level.
- This button toggles break points in the simulation at Z level.
**Customize Toolbars dialog**

The **Customize Toolbars** dialog enables you to set which toolbars to display (see page 24), which buttons to show on a toolbar (see page 27), whether to show other interface features (see page 29), and which keyboard shortcuts to use (see page 30).

![Customize Toolbars dialog](image)

Use one of the following methods to display the **Customize Toolbars** dialog:

- Select **View > Toolbars** from the menu.
- Right-click on an empty part of the toolbar area and select **Customize** from the context menu.

The **Customize Toolbars** dialog has these tabs:

- **Toolbars** (see page 24)
- **Commands** (see page 27)
- **Misc.** (see page 29)
- **Keyboard Shortcuts** (see page 30)
**Toolbars tab**

You can use the **Toolbars** tab of the **Customize Toolbars** dialog (see page 23) to set which toolbars to display.

Only the **Standard** and **Advanced** toolbars are displayed by default. To display a toolbar, select the box next to its name. To hide a toolbar, deselect the box next to its name.

You can quickly change the toolbar display by right-clicking on an empty part of the toolbar area and selecting/deselecting the toolbar name in the context menu.

**New** — Click the **New** button to create a new, custom, toolbar. The **New Toolbar** dialog is displayed. Enter a **Toolbar name** and click **OK**. The new toolbar shows in the **Toolbars** list and is automatically displayed. Add buttons to your new toolbar using the **Commands** tab.
**Reset Selected** — Click the **Reset Selected** button to revert the selected toolbar to its default display of buttons after you have added/removed buttons.

**Delete** — You can delete a custom toolbar that you have added by selecting it and clicking the **Delete** button.

**Default Toolbars** — Set the toolbar display back to the default (just the **Standard** and **Advanced** toolbars).

**Toolbar name** — You can edit the name of a custom toolbar by selecting it in the list and entering a new name here.

**Button size** — Select the display size for the buttons on the toolbars to either **Small** or **Large**.

**Style** — Select your preferred style for the user interface from **Classic**, **Shaded Grey**, and **Glass**. The default style is **Shaded Grey**. When you change to a different style, FeatureCAM asks you if you want to change the background color scheme to one that matches.

**Classic**:

![Classic Style](image)
The Glass style is available only in Windows Vista and later.
**Commands tab**

Use the **Commands** tab of the **Customize Toolbars** dialog (see page 23) to add buttons to toolbars.

To add a button to a toolbar:

1. Display (see page 24) the toolbar you want to update.
2. On the **Commands** tab, select the category that the button belongs to in the **Categories** list.
   - The buttons belonging to the category are displayed in the **Buttons** section.
3. Select a button icon in the **Buttons** section to see the **Description** of the button.
4. Drag the button icon from the **Buttons** section and position it in the toolbar. The button is added to the toolbar.

To remove a button from a toolbar:

1. Display (see page 24) the toolbar you want to update.
2. Open the **Customize Toolbars** dialog on either the **Toolbars** or **Commands** tab.
3. Drag-and-drop the button you want to remove. The button is removed from the toolbar.

To revert to the default buttons on a toolbar, select the toolbar name on the **Toolbars** tab (see page 24) and click the **Reset Selected** button.
Creating toolbar buttons for macros

Some macros, such as the SelectHeight.bas and HoleRecog.bas macros do not have buttons in FeatureCAM. To use a macro you must create a custom toolbar button, add it to a toolbar, then assign the macro to the button.

For example, the macro SelectHeight.bas does not have a button. You need to create a button to use the macro.

To create a button for a macro:

1. Ensure the macro is selected in the Add-ins dialog:
   a. If the Customize Toolbars dialog is displayed, click Cancel to close it.
   b. Select Options > Add-Ins to display the Macro Add-ins dialog.
   c. In the Add-In Files list in the Macro Add-ins dialog, select the macro.
   d. Click OK to close the dialog.

2. Select View > Toolbars to display the Customize Toolbars dialog.

3. On the Commands tab, select Macros from the Categories list.

4. Click and drag the Custom toolbar button (the hammer symbol) onto the toolbar where you want it to appear.

5. Assign the macro to the button (see page 29).
Assigning a macro to a custom toolbar button

Use the **Macro Toolbar Button** dialog to assign a macro add-in to a custom toolbar button (see page 28).

![Macro Toolbar Button dialog](image)

To assign a macro add-in to a custom toolbar button:

1. Load the add-in (see page 145) you want to assign to the button.
2. Right-click a custom toolbar button. The **Macro Toolbar Button** dialog is displayed.
   
   *The dialog is also displayed when you click a custom toolbar button that does not have a macro add-in assigned to it*

3. In the **Macro name** list, select the add-in.
4. Select a button icon from the **Available icons**.
5. Click **OK** to save your changes and close the dialog. The macro is executed when you click the custom toolbar button.

**Misc. tab**

You can use the **Misc** tab of the **Customize Toolbars** dialog (see page 23) to control the display of other User Interface items.

![Customize Toolbars dialog](image)

**Toolbox** — Select this option to display the **Toolbox** (it is displayed by default). Deselect it to hide the **Toolbox**.
**Buttons size** — This controls the display of the buttons in the **Steps** Toolbox.

**Assistance Bar** — Select this option to display the Assistance Bar (it is displayed by default). Deselect it to hide the Assistance Bar.

**Status Bar** — Select this option to display the Status Bar (it is displayed by default). Deselect **Status Bar** to hide the Status Bar.

**Keyboard Shortcuts tab**

Use the **Keyboard Shortcuts** tab of the **Customize Toolbars** dialog (see page 23) to set keyboard shortcuts for FeatureCAM commands.

![Customize Toolbars dialog](image)

To set a new shortcut key:

1. Select a category from the **Categories** list.
2. Select a command from the **Commands** list.
   
   If the command already has a shortcut, it is listed under **Current keys**.
3. To assign a new key, select the **Press new shortcut key** field and press the keys that you want to use as the shortcut.

   *Press the keys on the keyboard, for example, press and hold down the **Alt** key and press the **N** key; do not type **ALT** + **N**.*

   *A warning displays if the shortcut you entered is already assigned to a command.*

4. Click the **Assign** button to save the new shortcut.
If you click Assign after receiving a warning that the shortcut is already assigned to a command, the shortcut is removed from the existing command and assigned to the new command.

Remove — Click this button to remove the shortcut assigned to the selected command.

Reset All — Click this button to reset all shortcuts to the FeatureCAM defaults.

Document — Click this button to open a *.txt file, containing a list of the current shortcuts, in your text editor. You can print or save this file.

Customizing toolbars

To customize an existing toolbar:

1. Select View > Toolbars from the menu.
2. In the Customize Toolbars dialog (Toolbars tab), select the check box next to the toolbar that you want to modify.
3. Click the Commands tab.

   a. Select the command category.
   b. Drag the button from the Buttons frame to a location on your toolbar.

1. Repeat Step 3 until you have added all necessary commands.
2. Click OK.
If you make a mistake, and want to revert to default settings, open the **Customize Toolbars** dialog again, select the toolbar, and click the **Reset Selected** button.

**To create your own toolbar:**

1. Select **View > Toolbars** from the menu.
2. In the **Customize Toolbars** dialog, click the **New** button on the **Toolbars** tab.
3. In the **New Toolbar** dialog, enter the name for your toolbar, and click **OK**.

![New Toolbar dialog](image)

A new empty toolbar is created.

4. Follow Steps 3 - 5 in the procedure above to add commands to your toolbar.

**Status bar**

The **Status** bar shows your current program status.

| Point 'pt1' selected | XZ | Inch | Layer1 | UCS_Setup1 | Setup1 | Maho 60.cnc | Horizontal 4Axis.md | basic |

You may find it useful while drawing or simulating the part. The status bar uses a text display for:

- Cursor coordinates during geometry creation
- The name of the object you are snapping to, for example **Point 'pt1'**
- The coordinate plane of the current view (**XY**, **XZ**, or **YZ**)
- Your drawing units (**Inch** or **Millimeter**)
- The name of the current layer. Click the name to change to a different layer, or open the **Layers** dialog.
- The name of the current UCS. Click the name to select a different UCS.
- The name of the current setup. Click the name to select a different setup.
- The name of the current CNC. Click the name to display the **Post Options** (see page 1857) dialog.
The name of the current MD file. Click the name to display the Setup - Simulation information (see page 219) dialog.

The name of the current tool crib. Click the name to select a different tool crib.

The number of cores being used. Click to open the Core Usage (see page 33) dialog and change the number of cores used.

Simulation information (tools, feeds/speeds, elapsed time)

The Status bar is not a toolbar and you cannot dock it. It forms the bottom part of the FeatureCAM window and displays information about the computer, the state of the program, or information about what you are doing. You can turn its display on or off by selecting View > Toolbars and selecting/deselecting Status Bar on the Misc. tab.

Core usage (3D)

FeatureCAM can use multiple core or multiple processor PCs. This multi-threading feature is available for the following 3D toolpath strategies:

- Parallel roughing and finishing
- Z-level roughing and finishing, and interleave
- 3D spiral

Toolpath application to stock models is multithreaded.

Our tests have found typical improvements for two cores of between 10% and 50% for toolpath creation time, with an average of about 23%.

The number of cores that you are currently using is displayed at the end of the Status bar:

Click this area to open the Core Usage dialog:
FeatureCAM uses the maximum number of cores by default, but you can limit the number of cores, if you want to use other cores for operations outside FeatureCAM.

**Keyboard shortcuts**

You can use the keyboard to navigate around the menus. To do this, press and hold the Alt key, and then press the letters on your keyboard that correspond to the letters underlined on the Menu bar and in the menu options. For example, to rotate your part, press and hold the Alt key, press the V key for the View menu, then press the V key again for Viewing Modes, then press the R key for Rotate.

Typically, use the Ctrl-key shortcuts for standard Windows commands (Ctrl+N to create a new file; Ctrl+S to save a file), and the Alt-key shortcuts to execute FeatureCAM-specific commands (Alt+R to refresh the view).

<table>
<thead>
<tr>
<th>Key sequence</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+click-and-drag on any toolbar button</td>
<td>Move button around in toolbar.</td>
</tr>
<tr>
<td>Alt+1 (2,3,4)</td>
<td>User View 1 (2,3,4)</td>
</tr>
<tr>
<td>Alt+→</td>
<td>Step simulation forward one step.</td>
</tr>
<tr>
<td>Alt+←</td>
<td>Step simulation backward one step.</td>
</tr>
<tr>
<td>Alt+Enter</td>
<td>Properties</td>
</tr>
<tr>
<td>Alt+F1</td>
<td>Centerline simulation.</td>
</tr>
<tr>
<td>Alt+F2</td>
<td>Play/pause simulation.</td>
</tr>
<tr>
<td>Alt+F3</td>
<td>Single-step simulation.</td>
</tr>
<tr>
<td>Alt+L</td>
<td>Last view.</td>
</tr>
<tr>
<td>Alt+R</td>
<td>Refresh</td>
</tr>
<tr>
<td>Alt+Shift+V</td>
<td>Save view.</td>
</tr>
<tr>
<td>Ctrl+click a column of any list box that does sorting</td>
<td>Activates the second level of sorting.</td>
</tr>
<tr>
<td>Ctrl+click a viewing mode button</td>
<td>Stay in that viewing mode.</td>
</tr>
<tr>
<td>Ctrl+click the 3D Simulation button. Release key and click the Play button.</td>
<td>Run 3D simulation in hidden line mode and do continuous looping.</td>
</tr>
<tr>
<td>Key sequence</td>
<td>Action</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl+click Fast Forward to End ⏯</td>
<td>Stop the simulation when it encounters the next rapid (in addition to the next operation).</td>
</tr>
<tr>
<td>Ctrl+click the Machine Simulation ⏯ button. Release key and click the Play ⏯ button.</td>
<td>Run machine simulation in hidden line mode and do continuous looping.</td>
</tr>
<tr>
<td>Ctrl+0</td>
<td>Bottom view</td>
</tr>
<tr>
<td>Ctrl+1</td>
<td>Isometric view</td>
</tr>
<tr>
<td>Ctrl+2</td>
<td>Front view</td>
</tr>
<tr>
<td>Ctrl+3</td>
<td>Isometric 2 view</td>
</tr>
<tr>
<td>Ctrl+4</td>
<td>Left view</td>
</tr>
<tr>
<td>Ctrl+5</td>
<td>Top view</td>
</tr>
<tr>
<td>Ctrl+6</td>
<td>Right view</td>
</tr>
<tr>
<td>Ctrl+7</td>
<td>Isometric 4 view</td>
</tr>
<tr>
<td>Ctrl+8</td>
<td>Back view</td>
</tr>
<tr>
<td>Ctrl+9</td>
<td>Isometric 3 view</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Center selected.</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Find (text in a text window). The cursor must be in a text window.</td>
</tr>
<tr>
<td>Ctrl+H</td>
<td>Replace (text in a text window). The cursor must be in a text window.</td>
</tr>
<tr>
<td>Ctrl+J</td>
<td>Hide selected</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Hide unselected</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Center all.</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>New file</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Open file</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Display the New Feature wizard.</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save file</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
</tr>
<tr>
<td>Key sequence</td>
<td>Action</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl+click the Pick Curve button</td>
<td>Causes the warp status for that dialog to toggle.</td>
</tr>
<tr>
<td>Ctrl+click the Pick Curve button</td>
<td>Toggles between simulation of the selection feature and the entire Setup.</td>
</tr>
<tr>
<td>Ctrl+click the Play button</td>
<td>Run simulation in hidden line mode.</td>
</tr>
<tr>
<td>Hold Ctrl while toolpath is</td>
<td>Temporarily turns off Toolpath Computation Minimization. Toolpaths are recomputed for all features even if that feature did not change.</td>
</tr>
<tr>
<td>Ctrl+Alt+click-and-drag on any</td>
<td>Duplicate and move button around in toolbar.</td>
</tr>
<tr>
<td>Ctrl+Shift+click the 3D Simulation</td>
<td>Continuous loop simulation for 3D simulation.</td>
</tr>
<tr>
<td>Play button</td>
<td>Release keys and click the Play button.</td>
</tr>
<tr>
<td>Ctrl+Shift+click the Machine</td>
<td>Continuous loop simulation for machine simulation.</td>
</tr>
<tr>
<td>Simulation button. Release keys</td>
<td>Release keys and click the Play button.</td>
</tr>
<tr>
<td>Ctrl+Shift+A</td>
<td>Shade selected.</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Unshade all.</td>
</tr>
<tr>
<td>Ctrl+Shift+N</td>
<td>Unshade selected.</td>
</tr>
<tr>
<td>Ctrl+Shift+P</td>
<td>Toggles perspective.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected object</td>
</tr>
<tr>
<td>Double-click a simulation button</td>
<td>Activate that simulation without clicking the play button.</td>
</tr>
<tr>
<td>Esc</td>
<td>Stop current simulation.</td>
</tr>
<tr>
<td>F1</td>
<td>Context-sensitive help.</td>
</tr>
</tbody>
</table>
### Key sequence

<table>
<thead>
<tr>
<th>Key sequence</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Middle-click-and-drag in the graphics window</td>
<td>Performs viewing based on the current viewing mode. The mouse wheel-click-and-drag also performs this function.</td>
</tr>
<tr>
<td>Mouse scroll wheel</td>
<td>Zoom</td>
</tr>
<tr>
<td>Shift+click an edge when filleting</td>
<td>Selects all edges of the face and adds them to the list.</td>
</tr>
<tr>
<td>Shift+click the NC Code tab</td>
<td>Show ACL instead of NC code.</td>
</tr>
<tr>
<td>Shift+click while clipping when <strong>Multiple Region is On</strong></td>
<td>Removes the entire picked region instead of to the nearest intersection.</td>
</tr>
<tr>
<td>Shift+right-click in graphics window</td>
<td>Dynamic viewing using current view mode.</td>
</tr>
<tr>
<td>Shift+click the Show button in the SCL dialog</td>
<td>Displays a dialog that shows the attributes of the model selected in SCL dialog.</td>
</tr>
</tbody>
</table>

### Viewing

There are several ways to control your view of objects in the graphics window (see page 1):

- **Show** menu (see page 37)
- **Hide** menu (see page 39)
- **View** menu (see page 40)
- **Principle View** menu (see page 41)
- User views (see page 42)
- Entities (see page 43)
- Viewing options (see page 44)
- Motion controller support (see page 53)
- Refreshing the view (see page 54)

**Show menu**

Show functions help control what is displayed. This is useful as you place and model intricate features in a complex part.
You access the show functions by selecting **View > Show** from the menu or using the **Show Menu** button on the **Advanced** toolbar:

- **Show All** — Use this menu option to show everything in the part model.
- **Show All Geometry** — Use this menu option to show all geometry (points, lines, arcs, and circles).
- **Show All Dimensions** — Use this menu option to show all dimension information added with the Dimension tools (see page 290).
- **Show All Curves** — Use this menu option to show all curves (see page 318).
- **Show All Surfaces** — Use this menu option to show all surfaces (available only in FeatureCAM 3D). 
  
  *Surfaces and features from surfaces are different.*

- **Show All Features** — Use this menu option to show all features.
- **Show All Solids** — Use this menu option to show all solids (see page 445).
- **Show All Vertical Surfaces** — Use this menu option to show the vertical surfaces in the model. This is useful for identifying surfaces that are part of 2.5D features like holes or pockets contained in a surface or solid model.
- **Show Stock** — Use this menu option to show the stock outline.
- **Show Current UCS** — Use this menu option to show the current UCS (see page 109) icon.
- **Show Current Setup** — Use this menu option to show only the features and drawing elements that are in the current Setup.
- **Show Selected** — Use this menu option to show only the selected elements.
Layers (see page 299)
Change layer (see page 303)

Hide menu

Hide controls what is displayed at any given time. This is useful as you place and model intricate features in a complex part. Besides the display factors, you can’t snap, select or build curves from hidden entities. The hide functions are not exclusive. You can click different buttons sequentially, hiding different entities until only the ones you want are still in view.

You access the hide functions by selecting View > Hide from the menu or using the Hide Menu button on the Advanced toolbar:

![Hide Menu](image)

Hide All — Use this menu option to hide all geometry, curves, features. The stock and axis icon remain visible. A common procedure is to Hide All, then Show only one type of entity, for example features.

Hide All Geometry — Use this menu option to hide all geometry. Other entities remain visible.

Hide All Dimensions — Use this menu option to hide all dimension information added with the FeatureCAM Dimension tools (see page 290).

Hide All Curves — Use this menu option to hide all curves (see page 318). Other entities remain visible.

Hide All Surfaces — Use this menu option to hide all surfaces in the part model. Only available in the 3D version.

Hide All Features — Use this menu option to hide all features.

Hide All Points — Use this menu option to hide all points.
**Hide All Nonvertical Surfaces** — Use this menu option to hide all surfaces that are not vertical relative to the current setup. This is helpful if you want to isolate the surfaces that are part of 2.5D features in a surface or solid model.

**Hide All Solids** — Use this menu option to hide all of the solid models.

**Hide Stock** — Use this menu option to hide the stock (see page 205) outline. All other entities remain visible.

**Hide Current UCS** — Use this menu option to hide the current user coordinate system.

**Hide Current Setup** — Use this menu option to hide the axis of the current Setup. All other entities remain visible.

**Hide Selected** — Use this menu option to hide all selected entities. Non selected entities are still visible.

**Hide Unselected** — Use this menu option to hide all entities other than the selected ones.

**View menu**

View changes the way you interact with the view of the part. Selecting any of the options from the View menu puts you in view mode. Your cursor shows the same icon as the viewing mode you selected. Viewing is performed interactively in FeatureCAM with the mouse.

You access the view functions by selecting View > Viewing Modes from the menu or using the View Menu button on the Standard toolbar:

Click and hold the mouse button, then move the mouse. Up or to the right changes the drawing one way, zooming or rotating clockwise for example. Down or to the left has the opposite effect.
Center All — Use this menu option to change to a complete view of the part, centering it in the graphics window. The view of the part automatically scales to fit in the window.

Center Selected — Use this menu option to center the entities you have selected in the graphics window. The view of the part is automatically scaled to fill the window with the selected items. The angle of view is not changed.

Center Selected Point — Use this menu option to center the view about the last location you selected in the graphics window.

**Principal View menu**

Principal View changes the main view to one of several commonly used views.

You access the Principal View functions by selecting View > Principal Views from the menu or using the Principal View Menu button on the Standard toolbar:

![Principal View Menu](image)

**Isometric** — Use this menu option to change the view to a three quarter view of the part showing the top and two sides with the current UCS near the bottom of the view area.

**Isometric 2, Isometric 3, Isometric 4** — Alternative isometric views

The following example shows all four isometric views:

- **Isometric:**
- **Isometric 2:**
Top — Use this menu option to change to a view of the part from the top only. Useful for drawing geometry, but harder to see the wireframe model of the part.

Bottom — Use this menu option to change the view to the bottom of the part. No sides of the part are visible from this perspective.

Front — Use this menu option to change to a view of the part from the front with no other surfaces visible.

Back — Use this menu option to change to a view of the part from the back with no other surfaces visible.

Left — Use this menu option to change to a view of the part from the left side with no other surfaces visible.

Right — Use this menu option to change to a view of the part from the right side with no other surfaces visible.

Selecting View > Principle Views from the menu gives you some extra options:

Perspective — If selected, the view is a perspective view. If deselected, the view is an orthographic view.

As on UCS — Use this menu option to change your view to that of the current UCS.

As on setup — If selected, the view is relative to the current Setup. If deselected, the view is relative to the world coordinate system.

As on STOCK — Use this menu option to change your view to that relative to the Stock.

User views

The User Views (View 1, View 2, View 3, and View 4) store various views of your model. When you select View > User Views > Save View, the current view is saved under the next available view number. Select one of these views to return to this view.
**Entities**

Another useful viewing tool in the View menu is **Entities**. Select **Entities** in the View menu to open the **Entities** dialog.

All geometry, curves, stock, features, and surfaces are listed. You can sort the list by clicking one of the title buttons. This makes it easy to select by layers, construction type or category of entity.

Select an item or multiple items with **ctrl+click** and then click a button to perform one of the following actions:

- **Close** — Click this button to exit the dialog.
- **Show** — Click this button to display the selected entities in the graphics window.
- **Hide** — Click this button to remove the selected entities from the display in the graphics window.
- **Delete** — Click this button to remove the selected entities from the part file.
- **Rename** — This button is available only for individual selections and opens the **Rename Object** dialog where you can enter a **New Name** for the entity.
- **Properties** — This button is available only for some kinds of entity and for individual selections. The properties dialog that opens depends on the kind of entity. For example, features open the Feature Properties dialog.
- **Help** — Click this button to open this help page.
Viewing options

As well as the Windows settings, you can control the quality of your part display in FeatureCAM after you have installed it. You have to balance the detail quality against the increased time it takes to generate more detail. Set these options in the Viewing Options dialog, accessed through Options > Viewing in the menu.

The Viewing Options dialog has three tabs:
- General (see page 44)
- Dynamic (see page 46)
- Machine (see page 49)

General tab
These are the options on the General tab:

**Curve fineness** — This option adjusts the length of line segments for displaying curves. The smaller the line segments, the smoother the curve appears.

With small Curve fineness values, more data is processed so the graphical performance slows down. If you increase the fineness value, graphical performance is improved but the display quality suffers, producing jagged, more notched curve representations.

Because it is easy to modify this value, you can use different settings at different stages of development.

**Surface fineness** — This option adjusts the area of flat polygons (plane segments) for displaying a surface.

FeatureCAM uses surfaces to display all features and stock models. The smaller the area of the polygons used to display a surface, the smoother the surface appears. There are separate surface fineness values for the shaded and wireframe representations of the surfaces.

With small Surface fineness values, more data is processed, so the graphical performance slows down. If you increase the fineness value, graphical performance is improved, but the display quality suffers, producing more faceted, rougher surface representations.

Because it is easy to modify this value, you can use different settings at different stages of development.

**Show surface boundaries only** — With this option selected, surfaces are displayed as only their outer boundaries and trimmed loops. No additional lines are drawn in the interior of the surface. This option makes the display of larger models much faster.

**Show feature dynamic highlight** — When this option is selected, moving the cursor over an object’s name in the Part View highlights the object in the graphics window.

**View animation** — This option provides smooth, animated transitions between principal views. If you select View animation, the part rotates smoothly between two principal views. If you deselect it, the view changes abruptly to the new view.

**Selection radius** — This option specifies the radius (in pixels) of the hit area for a selection pick. If this number is set small, then you must select very close to an object to select it. If it is set large, then picking may be more unpredictable.

**Point size** — Enter a Point size to specify the size of geometry point objects in the graphics window.

**Snapping Point Size** — Specify the size of snapping grid points in the graphics window.
Dimension text size — This setting controls the size of the dimension text and the dimension (see page 290) arrow heads. There are separate settings for English (inch) and Metric (mm) parts. When the part is scaled, the text and arrows are scaled along with the drawing.

Dynamic tab

These are the options on the Dynamic tab:

Viewing Mode on startup — Set the default viewing mode when FeatureCAM first opens. For example, if you select Trackball, the next time FeatureCAM starts up, the viewing mode is Trackball.

All the viewing modes are available, plus an option called Mode from Last Session. This option keeps track of the viewing mode last set before FeatureCAM was closed, and uses that viewing mode the next time FeatureCAM starts up. For example, if the option is set to Mode from Last Session, and you had set the viewing mode to Rotate before you closed FeatureCAM, Rotate is the viewing mode that is set in the toolbar the next time you open FeatureCAM.

Middle mouse button behavior — Set the viewing mode for the middle mouse button.

You can set a specific viewing mode such as Trackball, Rotate, Pan, Zoom, Pan, and Zoom, and so on, or choose the Current Viewing Mode option that allows the middle mouse button (along with key combinations) to perform the viewing mode that is currently set in the toolbar.

Middle mouse button with Shift — Set the viewing mode for the middle mouse button, when the Shift key is held down.
You can set a specific viewing mode such as Trackball, Rotate, Pan, Zoom, Pan, and Zoom, and so on, or choose the Current Viewing Mode option that allows the middle mouse button (along with key combinations) to perform the viewing mode that is currently set in the toolbar.

**Middle mouse button with Ctrl** — Set the viewing mode for the middle mouse button, when the Ctrl key is held down.

You can set a specific viewing mode such as Trackball, Rotate, Pan, Zoom, Pan, and Zoom, and so on, or choose the Current Viewing Mode option that allows the middle mouse button (along with key combinations) to perform the viewing mode that is currently set in the toolbar.

**Middle mouse button with Ctrl+Shift** — Set the viewing mode for the middle mouse button, when the Ctrl and Shift keys are held down.

You can set a specific viewing mode such as Trackball, Rotate, Pan, Zoom, Pan, and Zoom, and so on, or choose the Current Viewing Mode option that allows the middle mouse button (along with key combinations) to perform the viewing mode that is currently set in the toolbar.

**Reverse scroll wheel zoom**

This option in the Dynamic Viewing Options (see page 48) tab reverses the association of direction of the scroll wheel with the zoom direction.

**Reset Settings**

In the Dynamic Viewing Options tab, you can reset the settings to either the FeatureCAM or PowerMILL defaults:

<table>
<thead>
<tr>
<th>Viewing Mode on startup</th>
<th>FeatureCAM</th>
<th>PowerMILL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan and zoom</td>
<td></td>
<td>Trackball</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Middle mouse button behavior</th>
<th>Current Viewing Mode</th>
<th>Trackball</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan and Zoom</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Middle mouse button with Shift</th>
<th>Rotating</th>
<th>PowerMILL Pan &amp; Zoom</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Middle mouse button with Ctrl</th>
<th>Zoom</th>
<th>Box Zoom</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Middle mouse button with Ctrl+Shift</th>
<th>PowerMILL Pan &amp; Zoom</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box Zoom</td>
<td></td>
</tr>
</tbody>
</table>
Setting up dynamic viewing options

To customize the dynamic viewing options:
1. Select Options > Viewing from the menu.
2. In the Viewing Options dialog, click the Dynamic tab.
3. Customize the viewing mode used on startup.
   All standard viewing modes are available as options, plus an option called Mode from Last Session. This option keeps track of the viewing mode last set before FeatureCAM was closed, and uses that viewing mode the next time FeatureCAM starts up.
4. Customize the default behavior for the middle mouse button.
   You can set the behavior to be specific viewing modes such as Trackball, Rotate, Pan, Zoom, Pan and Zoom, or choose the Current Viewing Choice option that allows the middle mouse button (along with key combinations) to perform the viewing mode that is currently set in the toolbar.
   If you want to reverse the association of direction of the scroll wheel with the zoom direction, select the Reverse Scroll Wheel Zoom option.
5. Click OK.

To revert to default FeatureCAM settings:
1. Select Options > Viewing from the menu.
2. In the Viewing Options dialog, click the Dynamic Viewing Options tab.
3. Click the Reset Settings to FeatureCAM button.

To revert to default PowerMILL settings:
1. Select Options > Viewing from the menu.
2. In the Viewing Options dialog, click the Dynamic Viewing Options tab.
3. Click the Reset Settings to PowerMILL button.
**Machine tab**

These are the options on the **Machine** tab:

**Milling** — Select the type of milling machine from **Vertical** and **Horizontal**, to improve viewing during machine simulation and tool previews.

**Turning** — Select the type of turning machine from **Slant bed lathe** and **Vertical turret lathe**, to improve viewing during machine simulation and tool previews.

**Shading options**

Use the **Shading Options** dialog to control how surfaces are shaded.
To display the **Shading Options** dialog, select the **Options > Surface Shading** menu option.

For shading, we recommended the following procedure:

1. **By default deselect Depth Cue.**
2. **Adjust the Ambient material parameter to lighten or darken the shading.**
3. **If you are shading a model with many flat surfaces, select Depth Cue.**
4. **If Depth Cue is selected, adjust the \( k \) and linear parameters to lighten or darken the image.**

**Lighting**

**Two lights** — Select this option to use light from two separate sources for more even lighting effects.

The lighting model has two different modes. With **Depth Cue** turned off, the lighting model uses light vectors (or directions). In this mode, the shading is not affected by the position of the light, but rather only the direction of the light. In this case you can specify the two light vectors as **Light vector 1** and **Light vector 2**.
**Depth cue** — Select this option to use lighting positions for the lighting model. Both the lighting direction and distance from the surface to the light affect the shading of a surface. In this case you can specify the two light vectors as **Light position 1** and **Light position 2**. The amount that the light is diminished is determined by the following formula:

\[ \frac{1}{(k + \text{linear} \times \text{Distance of surface to light})} \]

Both \( k \) and \( \text{linear} \) variables are available for you to alter. Setting \( k \) or \( \text{linear} \) to larger values darkens the view.

**Display**

The shading performed by FeatureCAM translates surfaces into triangles for shading.

**Smooth shading** — Select this option to indicate that the shading of the triangles should be blended. If it is deselected, the individual triangles are visible.

**Smooth line** — Select this option to smooth out the jagged edges of lines. This applies to all line drawings including toolpaths.

> This option can be time-consuming.

**Backfaces removed** — Select this option to hide surfaces whose normals point into the screen. This option improves shading speeds for solid models. If portions of the model are visibly missing, turn this option off.

**Backface lighting** — Select this option to duplicate the light vectors in back of the model (for diffused lighting). This option applies when **Depth cue** is deselected.

**Backface highlight** — Select this option to duplicate the highlighting effects for the duplicate lights. This option applies when **Depth cue** is deselected.

**Z-buffer** — Select this option to sort surfaces by their depth. We recommend that you keep this setting selected.
**Z-buffer lines** — Select this option to enable the lines to be sorted along with the surfaces. This enables surfaces to occlude lines that are positioned behind. This option is provided for viewing toolpaths in conjunction with shaded surfaces.

**Use graphics hardware** — Select this option to try to use your graphics card to speed up shading. Many graphics cards are not reliable for shading. If your shading looks bad or performs slowly, turn off this setting.

**Dither** — Select this option to smooth the shading across the part. When deselected, discrete bands of shading are often evident.

**Z-buffer rubberband** — Select this option to Z-buffer rubberband geometry. Rubberband geometry are the forms of geometry that are interactively updated, such as when you drag a circle radius.

**Anti-alias tool window** — You may need to disable this option if your graphics card or driver cannot support the anti-aliasing well.

**Material**

**Transparent** — Select this option to enable the **Opacity** option.

**Opacity** — Enter how opaque the surface is from 0 (transparent) to 1 (opaque).

**Shininess** — Enter how a highlight spreads from 0 (tight) to 100 (broad).

**Ambient** — Enter the amount of light present in the shading process besides the two light settings. This is a cumulative setting with **Ambient** set in the **Lighting** section.

**Diffuse** — Enter how the light spreads in the area occupied by the surface. This setting combines with the same setting in **Lighting** to determine the overall diffusing effect.

**Specular** — Enter the amount of specular light reflection from 0 (no specular reflection) to 1 (full specular reflection).
Stock

Shade stock by default — Select this option to show the stock as shaded by default and enter a Stock Opacity between 0 (0% shaded) and 1 (100% shaded).

This is an example part with Shade stock by default deselected:

And with Shade stock by default selected with a Stock Opacity of 0.3 (30%):

Motion controller support

FeatureCAM supports advanced motion controllers from http://3dconnexion.com (http://3dconnexion.com). Supported controllers are the SpaceBall, SpaceMouse and SpaceTraveler.

When you use one of these controllers you can use one hand for your mouse and the other hand for viewing, enabling more efficient control of FeatureCAM.
How to Use 3Dconnexion Devices with FeatureCAM

The controller from 3Dconnexion comes with a CD that contains a device driver and simple test programs. Install the CD and use the test programs to make sure that your controller is installed properly and to make sure that you’ve got the idea of how to use the controller. After that, run FeatureCAM and you’ll be able to control the view in FeatureCAM in exactly the same way as the test programs.

Refreshing the view

When you zoom out, FeatureCAM simplifies the visual representation of the geometry in the graphics window to improve performance. For example, arcs, fillets, and circles are replaced with straight lines.

You can refresh the view to be suitable for the current zoom factor.

Use one of the following methods to refresh the view:

- Select View > Refresh from the menu.
- Press the ALT + R keys.

Smart dialogs

To provide you with more space in the graphics window, FeatureCAM automatically minimizes some dialogs by default. For example, the Select Stock Curve dialog minimizes into a small title bar when you click the Pick Curve button.

When the dialog is minimized, the cursor shape changes to . This indicates you need to select an object in the graphics window. When you select the object, the dialog is restored. If you want to restore the dialog without making a selection, click the button in the small title bar.

To disable auto-minimization, deselect Options > Warp Dialogs in the menu.

Managing your settings

You can customize the toolbars, view options, colors, and so on, but your changes last only for the duration of the current session, unless you instruct FeatureCAM to save them.

You can choose to save your changes automatically. To do this, select Options > Save on Exit from the menu.
If you don't want to save your changes every time you exit the program, deselect the **Save on Exit** option. Now you can choose **Options > Save Settings Now** to save the modified configuration.

FeatureCAM uses two `.ini` files to store your settings:

- `ezfm_ui.ini` contains toolbars, dialog locations, graphics settings, colors, and other user settings.

- `ezfm_mfg.ini` contains manufacturing defaults and `.cfg` settings.

The `ezfm_mfg.ini` file contains default values for both inch and metric attributes. For example, there is an entry for `zrapid` in inches and also an entry for `zrapid_mm` in mm. In general, the name for the metric attributes is the same as the inch name, with a suffix of `_mm`.

If you want to replace the current settings with the previously saved settings, select **Options > Reload Settings** from the menu.

You can make a backup copy of the `.ini` files before you save any changes; this way you can revert to the default settings if something goes wrong. Alternatively, you can delete the `.ini` files; when you restart FeatureCAM, these files are recreated automatically with the default settings.

**Enabling wizards**

You can switch some FeatureCAM wizards on and off.

**New Part Document wizard**

To turn the **New Part Document** wizard off, restart FeatureCAM, and deselect **Show this dialog on program start**.

To turn the **New Part Document** wizard back on, restart FeatureCAM, select **File > Part Wizard** from the menu, and select **Show this dialog on program start**.

**Stock wizard**

To turn the **Stock** wizard on/off:

1. Select **File > New** from the menu.
2. In the **New Part Document** dialog, for the **Initial stock dialog** option, select:
   - **Wizard** — Select this option to show the **Stock** wizard next. This is a default option.
   - **Properties** — Select this option to show the stock **Properties** dialog next. This dialog presents the pages of the **Stock** wizard in a more concise form.
None — Select this option and FeatureCAM does not ask you to set up the stock. You must select the Stock step from the Steps panel.

3 Click OK.

Selecting graphical objects

Many commands require you to select objects in the graphics window.

There are two selection modes, which you can access from the Standard toolbar:

- Select
- Select Partial
- Drag Select

Select

To select an object you can:

- Click the left mouse button on an object. This selects that object (by turning it red) and deselects any other object.
- Hold down the SHIFT key and click the left mouse button on an object. This adds that object to the selected set of objects. This method allows you to select more than one object.
- Click and drag a box around the objects you want to select. This method is called box select. As you drag the mouse, a green box is displayed in the graphics window.

All objects that are completely encompassed in the box are selected. If you hold down the SHIFT key while selecting, the objects are added to the selected set of objects.
**Select Partial**

This method enables you to box select multiple objects without fully enclosing them.

In the example below, all three features are selected:

![Select Partial Example](image)

**Drag Select**

This method enables you to select multiple entities by dragging the mouse pointer across them.

This example part contains different colored faces and geometry:

![Drag Select Example](image)

Other selection methods do not work well for this part. For example, if you use the **Select by Color/Type** (see page 59) dialog, you can select either the green lines or the gray lines, but not both at the same time:
If you use the **Select** button for a box selection of lines in a front view, you cannot select the lines without selecting some of the surfaces too:

Using the new **Drag Select** option, you can drag the mouse pointer over the lines to the left of the stock to select them all:

**Drag Select** can save time when selecting adjacent surfaces. With the standard **Select** mode, to select adjacent surfaces, you must use a box-select or **Ctrl+click** each surface. With **Drag Select**, just move the mouse pointer over adjacent surfaces. You can hold down the **Ctrl** key with **Drag Select** to add non-adjacent surfaces to the selection, or after you have released the mouse button, for example to change the view of the part.
Select by Color/Type

Select Edit > Select by Color/Type from the menu to open the Select by Color/Type dialog:

Use one or more of the options to control which entities are selected:

Color — To select entities of a particular color, select the color in the menu.

Entity Type — To select all entities of a particular type, select the type in the menu.

Hole Depth — To select all holes of a particular depth, first select a type of hole in the Entity Type menu, then enter the Hole Depth Value, and a Tolerance for how close to the Value the depth must be.

Hole Diameter — To select all holes of a particular depth, first select a type of hole in the Entity Type menu, then enter the Hole Diameter Value and a Tolerance for how close to the Value the diameter must be.

Select an entity in your part before opening the dialog to pre-populate the fields.

Selecting from within dialogs

Many commands require you to select curves, surfaces, or solids using a dialog containing an interface similar to this one with buttons and a list field:
— Click this button to add the entity or entities selected in the graphics window to the list.

— Click this button to remove the entity selected in the list.

— Click this button to pick curve or geometry from the graphics window.

— Click this button to pick surface from the graphics window.

— Click this button to pick solid from the graphics window.

To add an entity to the list, either:

- Select an entity in the graphics window and click the Add button.
- Click the Pick button and then select the entity in the graphics window.

*If you select the entity before opening the selection dialog, the entity is already listed.*

To remove an entity from the list, select it by clicking its name and click the Remove button.

Click Next or OK to continue.
New part

When you open FeatureCAM, the New Part Document Wizard (see page 61) is displayed, which enables you to specify the type of part file and the shape of the stock. While running FeatureCAM you can have more than one part file open simultaneously.

Creating a new part

Use one of the following methods to display the New Part Document (see page 63) dialog:

- Select File > New from the menu.
- Click New Part Document in the Standard toolbar (see page 11).
- Press the Ctrl + N keys.

When you have created a part, you can define the Stock (see page 205).

New Part Document Wizard

The New Part Document Wizard is displayed when you open FeatureCAM, or when you close all open documents.

You can use the New Part Document Wizard to create a new file or open an existing file.

To create a new file:

1. Select New file and click Next.
2. On the next page, select the kind of part that you want to make from:
   - Turn/Mill
- Vertical Mill/Turn
- Milling Setup
- Wire EDM Setup
- Multiple Fixture
- Tombstone Fixture
- Simulation Machine Design

The options available depend on which module(s) you have purchased.

3 Select the Unit of Measure.
4 Click Finish.

The Stock Wizard (see page 205) is displayed.

To open an existing file:
1 Select Open an existing file and click Next.
2 Browse to the folder containing the file you want to open.
3 Select the file you want to open and click Open.

If you do not want to see this wizard again, deselect Show this dialog on program start.

If you want to show the wizard again, select File > Part Wizard from the menu.

You can create a new file without using the Wizard (see page 61).
New Part Document dialog

You use the New Part Document dialog to begin a new part if you are not using the wizard (see page 61).

Use one of the following methods to display the New Part Document (see page 63) dialog:

- Select File > New from the menu.
- Click New Part Document in the Standard toolbar.
- Press the Ctrl + N keys.

To create a new part document:

1. Select the Type of your part from:
   - Turning Setup (TURN (see page 10)) for 2-axis turned parts. This is only the type of the first setup of your part. Your part can contain multiple setups and these setups can mix different manufacturing techniques.
   - Turn/Mill (TURNMILL (see page 10)) for turning that supports live tooling.
- **Vertical Mill/Turn** (TURNMILL (see page 10), MTT (see page 10), and 5AP (see page 10)) for a vertical mill/turn machine. This creates two Setups automatically, **Setup1** is a turning Setup and **Setup2** is a milling Setup.

- **Milling Setup** (25D (see page 10)) for 2.5D or 3D milled parts. Select this type for 5-axis positioning as well. This is only the type of your first setup.

- **Wire EDM Setup** (WIRE (see page 10)) for a 2-axis or 4-axis wire EDM part.

- **Multiple Fixture** (see page 1872) for laying out multiple parts on the table. You can mix different milled parts for multiple part manufacturing.

- **Tombstone Fixture** (TOMB (see page 10)) for a Tombstone Machining (see page 1885) part.

- **Simulation Machine Design** (MSIM (see page 10)) for a Machine Design document. Use this document to create a machine tool model for simulation.

> These options are limited by the FeatureCAM modules you have purchased.

2. Select the **Unit of Measure** you will use to model your part from:
   - Inch
   - Millimeter

   See System units (see page 64) for more information.

3. Select how you would like to set up your stock. Select from:
   - **Wizard** — Select this option to open the **Stock** wizard (see page 205) next. This option is best for novice users.
   - **Properties** — Select this option to open the **Stock Properties** (see page 220) dialog next. This dialog presents the pages of the stock wizard in a concise form.
   - **None** — Select this option if you want to set up the stock later using the **Stock Properties** (see page 220) dialog.

4. Click **OK**.

### System units

You choose dimension units when you create a new part file. You can choose from either Inch or Millimeter. If you wish to change the dimension units for new parts later, select **Options > File Options**. If you always produce parts in the same units, you can turn off the automatic display associated with a new file by deselecting **Always ask when a new document is created**.
**Inch** units set FeatureCAM to size the part, its features, and the tools in inches and fractions (decimal display) of inches. All measurements are in inches.

**Millimeter** units set FeatureCAM to size the part, its features, and the tools in millimeters. There is no option for setting larger metric units as the default.

**Thumbnail pictures**

When you select a part in the **Open** dialog, a preview image is displayed.

The image that is displayed depends on the options in the **Save Options** (see page 67) dialog. The image updates each time you save the part unless you specify a permanent image (see page 71) to store in the file.
Saving your work

You cannot save a FeatureCAM file unless you have a dongle. Saving your part file to disk and saving part documentation and part program are separate operations.

Saving a part file (see page 66)
Save options (see page 67)
Saving an NC part program (see page 1567)
Part documentation (see page 70)
Export (see page 102)

Saving a part file

You can’t save a FeatureCAM file unless you have a dongle. To save a FeatureCAM part file for the first time:

1. Select File > Save As from the menu to display the Save As dialog.
2. Navigate to where you want to save the file.
3. Enter a File name.
4. From the Save as type list, select FM Documents (*.fm) to automatically give the filename a suffix of .fm, or select All Files (*.*) to enter a suffix manually. You add any file extension to the end of the name, but the file is saved in FeatureCAM format.
5. Click Save to save the file.
Save Options

Select File > Save Options from the menu to display the Save Options dialog.

Create backup copy — Select this option to save a number of previous versions of your part as you work. Enter the **Number of copies to keep** and set the **Backup location**. When you save a file, the previous version(s) are saved to disk using the name, but prefixed with *Backup of*. The latest version of the file is always saved using the name of your FeatureCAM part.

Compress file — Select this option to reduce the size of the FeatureCAM files on disk.

*Compressed files cannot be read into earlier versions of FeatureCAM.*

Save preview picture in file — Select this option to store an image of the part in the file. This image is displayed in the **Open** (see page 65) dialog.

Always save as 32-bit — Select this option to ensure maximum compatibility between Windows Operating Systems. A file saved as 64-bit can be opened only with a 64-bit version of FeatureCAM. This option is available only in 64-bit FeatureCAM.

Save computed toolpath — For certain parts, generating toolpaths can be time-consuming and you may want to save them for the next time you open a part. The setting of **Save computed toolpath** controls the default behavior for saving toolpaths. Select from **Always save**, **Never save**, or **Ask me** to be prompted each time you save a part. The toolpath is saved as an .fmp file.
This is different than saving the NC text file that the NC machine reads. Instead you are saving the FeatureCAM internal toolpath representation.

If you upgrade to a newer version of FeatureCAM, the toolpath is disregarded and recomputed.

OK — Click the OK button to save your settings and close the dialog.

Cancel — Click the Cancel button to close the dialog without saving any changes.

Help — Click the Help button to open this Help topic.

Send Part Files dialog

To display the Send Part Files dialog, select File > Send from the menu.

Select the files you want to send from:

Part document — The current .fm file.

Milling post — The current Milling .cnc file.

Turning post — The current Turning .cnc file.

Wire EDM post — The current Wire EDM .cnc file.

User interface settings — The .ini file containing your user interface preferences.

Machine design files (.md) — the current .md file.

Crash and performance logs — Select this option to create a separate .zip file of your system’s crash and performance logs.
Select how you want to send the files:

**As individual files** — The individual files are attached to a new email.

**As a zip file** — The files are zipped and the .zip file is attached to a new email.

**Save to desktop** — The files are zipped and the .zip file is saved to your desktop.

**Size confirmation**

If you are sending .zip files, a **Size Confirmation** warning dialog is displayed:

**The average email server limits attachments to 10 MB.**

**The total size of the attachment(s) is:** \(N\) (where \(N\) is the size of your attachment(s))

**Would you like to continue sending?**

Click **Send** to attach the files to an email.

Click **Don't Send** to keep the files on your desktop.

Click **Cancel** to discard the files.

**FeatureCAM file types**

You can save several different types of files for your part.

- **.op** is the Manufacturing Operation Sheet and is the same information shown on the **Details** tab when you select **Operation List**.

- **.tl** is the Manufacturing Tool Detail Sheet and is the same information shown on the **Details** tab when you select **Tool List**.

- **.txt** is a text file containing the NC code for the particular part file.

- **.tdb** is a FeatureCAM tooling database that contains just the tools you used to create the part.

- **.fdb** is a FeatureCAM material database that contains the feed and speed tables used for the part.

- **.cdb** is a FeatureCAM machine configuration database that contains the settings for default attributes.

The filename of all files is the same as the part name. If you have a part called **part**, the files created are: **part.op**, **part.tl**, **part.txt**, **part.tdb**, **part.fdb**. When saving the NC code you are given the opportunity to change the NC file name. If you enter a different NC file name, the default file extension is **.txt**.
If a part has multiple setups, the Setup ID number is appended to the part name. For example, if you have a part called plate with three Sets, three different sets of files are created called plate, plate2, and plate3. So a .op, .tl, .txt, .tdb, .fdb, and .cdb file are created for each Setup for a total of eighteen files.

**Part Documentation**

The Part Documentation dialog enables you to add comments to the printed documentation and set a permanent preview picture for the part.

To display the Part Documentation dialog, select File > Part Documentation from the menu.

The Part Documentation dialog contains two tabs:
- **Documentation** (see page 70)
- **Preview Picture** (see page 71)

**Documentation tab**

On the Documentation tab of the Part Documentation (see page 70) dialog, optionally enter a **Title**, **Author**, **Company**, **Part/Drawing No.**, **Revision**, **Note 1**, **Note 2**, and **Comments**. To print these values along with the documentation, select **Comments** in the Printing Options (see page 106) dialog.

If you use the custom setup sheet add-in (see page 177), these values are copied to the Setup Sheet Options dialog.
**Preview Picture tab**

On the **Preview Picture** tab of the **Part Documentation** (see page 70) dialog, you can set a permanent preview image for the part. This image is displayed in the preview pane in the **File > Open** dialog when you select a file.

This image is normally updated each time you save the part. If you want to store a permanent image with the part:

1. Create the view of the part you want to store.
2. Click **Update preview picture**.

   The current view in the graphics window is displayed as the **Current preview picture**, for example:

   3. Click **OK** to save the preview picture or **Cancel** to close the dialog without saving the preview picture.

**Saving your settings**

FeatureCAM uses two `.ini` files to store your settings:

- `ezfm_ui.ini` contains toolbars, dialog locations, graphics settings, colors, and other user settings.
- `ezfm_mfg.ini` contains manufacturing defaults and `.cfg` settings.

The `ezfm_mfg.ini` file contains default values for both inch and metric attributes. For example, there is an entry for `zrapid` in inches and also an entry for `zrapid_mm` in mm. In general, the name for the metric attributes is the same as the inch name, with a suffix of `_mm`.

Three items from the **Options** menu affect the communication with the `ezfm_ui.ini` and `ezfm_mfg.ini` files:
Options > Save Settings Now — writes the current settings to the files.

Options > Reload Settings — reads the settings contained in the files into the program.

Options > Save on Exit — saves the current settings when you exit the program. If this option is not selected, the settings for your current session are not saved to the files when you exit.

In old versions of FeatureCAM all program options were stored in one file, the ezfm.ini file, located in the same folder that Windows is installed in. That file included the settings you chose for toolbars, the Viewing, Simulation, Default Attributes, and Post Options dialogs. When you run version 15 or later for the first time, it reads the existing ezfm.ini file and splits the contents into the two new .ini files. All changes are written to the new .ini files, the old .ini file does not change.
Command line options

The command line options enable you to start FeatureCAM in a specified mode; to run a script or add-in; or to pre-load information from file. FeatureCAM supports the following parameters:

- `b`: Loads a VB add-in from the specified path.
- `c`: Runs the script at specified path.
- `debug`: Sends the debug output to the console.
- `DebugToFile`: Sends the debug output to file `ezfm_debug.txt`.
- `?` or `-help`: Lists the command line options available for FeatureCAM.
- `i`: Loads the settings from the specified v14 ini file.
- `l`: Specifies the network license for FeatureCAM.
- `m`: Loads the manufacturing settings from the specified `ezfm_mfg.ini` file. Example:

```
ezfm -uc:\ProgramData\FeatureCAM\ezfm_mfg.ini
```
- `noflex`: Skips the flex/rms license checks.
- `RegServer`: Registers the FeatureCAM library.
- `u`: Loads the user-interface settings from the specified `ezfm_ui.ini` file. Example:

```
ezfm -uc:\ProgramData\FeatureCAM\ezfm_custom_ui.ini
```
- `viewal`: Sends debug graphics to this `ezfm` instance.

To open FeatureCAM using a command line option:

1. Open the Command Line window.
2 Type the name of the FeatureCAM executable followed by the parameter. For example:

![Image of command prompt](image)

You must enter the full path of the executable and any specified files used when they are not located in the currently selected directory. Commands are not case-sensitive.

3 Press the **Enter** key to execute the command.

> The path to the `.ini` file for versions of FeatureCAM older than 15 is `-lc:\path\ezfm.ini`. This is still available but is used only during initialization if the `ezfm_ui.ini` and `ezfm_mfg.ini` files are not found. If the new `.ini` files are found, the `-I` option is ignored.
Import/Export

You can import (see page 82) and export (see page 102) various file types into and from FeatureCAM.

The settings for import and export are in the Import/Export Options (see page 75) dialog. To open this dialog select File > Import/Export Options from the menu.

Import/Export Options

The Import/Export Options dialog contains settings for importing and exporting.

To display the Import/Export Options dialog select File > Import/Export Options from the menu.

The dialog has three tabs:

General (see page 75)
Solid Import (see page 77)
Digitized Data (see page 78)

General tab

The General tab controls how FeatureCAM imports or exports files. It contains the following options:

Always replace object on import — Select this option to overwrite objects of the same name when you import. Deselected prompts for every replacement. You can’t have two objects with the same name.
**Smooth EZ-MILL curves** — Select this option to improve EZ-MILL curves on import because FeatureCAM has a higher resolution curve format.

**Keep IGES import log file** — Select this option to keep a log of the import process for later review or troubleshooting.

**IGES log file name** — Enter the path and filename for saving a record of the import process.

**Import IGES entity of type:**

- **Logically dependent** — can exist by itself but is also referenced by another entity (case of groups or grouping situation).

- **Physically dependent** — generally, you should deselect this option to indicate you do not want physically dependent entities to be imported. But if you are having trouble with your IGES file and it is not importing properly, try selecting this option and re-importing. Entities in an IGES file are marked to be either physically dependent or not. Those that are marked to be physically dependent are entities that are used in the construction of other entities. For example, a trimming loop is physically dependent upon the trimmed surface that uses it. The trimming loop is not important all by itself, but is instead a building block of something else. The trimmed surface is in turn marked physically dependent to indicate that it is a building block of a parent entity, a solid. By selecting **Physically dependent**, you cause FeatureCAM to show everything in the IGES file - not just the top-level entities that are usually shown, but also all of the lower-level building blocks. This is generally not what you want. Generally you want only the top-level entity, for example the solid.

- **Both physically and logically dependent** — meets both logically and physically dependent criteria (is referenced by at least two other entities — the parent for the logical link cannot be the parent for the physical as well).

- **Center stock automatically** — Select this option to automatically size and position the stock so that it covers the imported data.

- **Number of decimal places in IGES export** — determines how finely data is exported to the IGES format.
**Solid Import tab**

The **Solid Import** tab contains the following options:

- **Heal Catia solids** — Select this option to try to repair the faces or surfaces contained in the CATIA .mod file. This option can be time-consuming because it attempts to:
  - retrim the surfaces/faces against each other.
  - force edges of surfaces to lie on the surface.
  - simplify surfaces like converting a general surface into a cylinder.

- **Import hidden Catia V5 solids** — Select this option to import all parts contained in the CATIA file even if those parts are hidden.

- **Import file as solids** — Select this option to import files as solid models. If this option is deselected, the models are imported as surface models. We recommend that you import models as solids. If this option is selected and the solid fails to import properly, you are asked if you would like to attempt to heal the solid to try and fix the import problem.

- **Import work planes** — When selected, planar surfaces in solids are imported. When deselected, planar surfaces in solids are ignored.

- **Stitch IGES surfaces into solids/sheets** — Select this option to try to create one or more solids or sheets from an IGES file. If an IGES file contains more than one solid or sheet, this is the most efficient way to create the multiple objects from the file.
**Digitized Data tab**

Digitized data is imported into FeatureCAM through DXF Polyline entities. The Digitized data import/export options affect how this data is imported. These settings affect only the import of the data. If you want to change one of these options, you must remove the old data and import the `.dxf` file again.

The **Digitized Data** tab contains the following options:

![Image of the Digitized Data tab]

**DWG/DXF Non-Smooth Polyline Import Method:**
- **As Curve** — Select this option to import a non-smooth polyline as a curve
- **As Connected Lines** — Select this option to import the non-smooth polyline as a series of line segments.

**DWG/DXF Smooth Polyline Import Method:**
If the polyline has smooth vertices, it is imported as a curve. There are two options:
- **Interpolation** — the curve passes through the data. If the data is very dense, interpolation sometimes causes the curve to wiggle in between the points. The spline interpolation (see page 367) technique is used to create the curve.
- **Approximation** — the curve comes very close to the data points and is unlikely to wiggle for densely-spaced data.

**DWG/DXF Polygonal Mesh Import Method:**
If the polyline is a polygonal mesh, it is imported as a surface. There are two options:
- **Interpolation** — the surface passes through all of the data points. If the data is very dense, some wiggles may appear in the surface. A cubic hermite technique is used to create the surface.

- **Approximation** — the surface comes close to the data points. The points are used as control points to the surface and the surface is unlikely to wiggle for densely-spaced data.

Example of digitized data format for a 3D point

`Text preceded by <--- is included only as a comment.`

```
0 SECTION 2
ENTITIES 0
POINT 10
 0.0000 <--- X
20
 0.0000 <--- Y
30
 0.0000 <--- Z
0
ENDSEC 0
EOF
```

Example of digitized data format for a two-point curve

`Text preceded by <--- is included only as a comment.`

```
0 SECTION 2
ENTITIES 0
POLYLINE 0
VERTEX 10
 0.0000 <--- x0
20
 0.0000 <--- y0
30
 0.0000 <--- z0
0
VERTEX 10
 1.0000 <--- x1
20
```
Example of digitized data format for a spline curve

At least four points are needed for a spline.

Text preceded by --- is included only as a comment.
Example of digitized data format for a surface defined by four corner points:

```
0
VERTEX
70
8
10
1.0000  <--- x3
20
2.0000  <--- y3
30
0.0000  <--- z3
0
SEQEND
0
ENDSEC
0
EOF
```

*Text preceded by <--- is included only as a comment.*
Importing files

Use the File > Import menu option to load a CAD model from file.

To import a CAD model from a file:

1. Open a new or existing part file. You must have a part open to import geometry.

2. If you want to set or change the import options, select File > Import/Export Options.

3. Select File > Import from the menu. The Import dialog is displayed.

4. Select the file you want to import, and click Open.
   A message asks if you want to review the log file: click Yes to display the results, or click No to continue. The Import Results wizard (see page 85) is displayed.

5. Follow the instruction in the wizard to complete the process.
FeatureCAM can import these formats. If the description is followed by (3D), you need FeatureCAM 3D or the Solid Modeling module to import it.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ddx (see page 88)</td>
<td>Delcam PowerSHAPE (Delcam Data Exchange (see page 87))</td>
</tr>
<tr>
<td>.dwg; .dxf (see page 89)</td>
<td>AutoCAD files (3D for embedded solids)</td>
</tr>
<tr>
<td>.iges (see page 91)</td>
<td>Industry standard neutral CAD files (3D for surface or solids)</td>
</tr>
<tr>
<td>.geo</td>
<td>Bridgeport EZ-CAM 2D geometry</td>
</tr>
<tr>
<td>.xmt and .xmb (see page 94)</td>
<td>Parasolid-based solid models (3D)</td>
</tr>
<tr>
<td>.sat and .sab (see page 94)</td>
<td>ACIS-based solid models (3D)</td>
</tr>
<tr>
<td>.sldprt (see page 95)</td>
<td>SolidWorks files (3D)</td>
</tr>
<tr>
<td>.sldasm (see page 96)</td>
<td>SolidWorks assembly files (3D)</td>
</tr>
<tr>
<td>.mod and .model (see page 96)</td>
<td>CATIA V4 files (This module is priced separately.)</td>
</tr>
<tr>
<td>.ipt and .iam (see page 97)</td>
<td>Autodesk Inventor files (3D)</td>
</tr>
<tr>
<td>.prt, .prt&lt;number&gt;, .asm and .asm&lt;number&gt; (see page 97)</td>
<td>Native Pro/ENGINEER files, PTC Creo files (This module priced separately.)</td>
</tr>
<tr>
<td>.catpart (see page 97)</td>
<td>CATIA V5 files (This module priced separately.)</td>
</tr>
<tr>
<td>.par and .asm (see page 98)</td>
<td>Native SolidEdge files (3D) and SolidEdge assembly files</td>
</tr>
<tr>
<td>.prt (see page 98)</td>
<td>NX (formerly Unigraphics) native files (priced separately)</td>
</tr>
<tr>
<td>.stp or .step (see page 98)</td>
<td>STEP files (priced separately)</td>
</tr>
</tbody>
</table>
You can import models from other file formats using the File > Import Using Exchange menu option (see page 87).

**Supported import formats**

This version of FeatureCAM supports at least the following import formats when using native import (not Delcam Exchange).

You may be running a service pack of FeatureCAM that supports a later version of a file format, but on the previous update of the help file these are the supported formats:

<table>
<thead>
<tr>
<th>File format:</th>
<th>First supported in version:</th>
</tr>
</thead>
<tbody>
<tr>
<td>SolidWorks 2016</td>
<td>22.4</td>
</tr>
<tr>
<td>SolidEdge ST7</td>
<td>21.8</td>
</tr>
<tr>
<td>DWG 2013</td>
<td>20.0</td>
</tr>
<tr>
<td>Parasolid v28.0</td>
<td>22.4</td>
</tr>
<tr>
<td>CATIA V5-6R2015</td>
<td>22.0</td>
</tr>
<tr>
<td>CATIA V5-6R2014</td>
<td>21.8</td>
</tr>
<tr>
<td>CATIA V5 R23</td>
<td>20.0</td>
</tr>
<tr>
<td>UG NX 10</td>
<td>22.0</td>
</tr>
<tr>
<td>UG NX 9.0</td>
<td>21.8</td>
</tr>
<tr>
<td>Autodesk Inventor 2016</td>
<td>21.8</td>
</tr>
<tr>
<td>Pro/E Creo3</td>
<td>21.8</td>
</tr>
<tr>
<td>Pro/E Creo2</td>
<td>19.1</td>
</tr>
<tr>
<td>Pro/E Creo</td>
<td>18.8</td>
</tr>
</tbody>
</table>

If you have an example file that does not import properly, please send it to your authorized support representative and they will send it to Delcam developers for examination and bug fixing as necessary.

**Working with imported geometry**

Imported geometry is often less exact than geometry you create directly in FeatureCAM. End points may not match and you may find that you have a lot of extraneous data on your screen. Deleting or hiding the extraneous data greatly speeds up the display of your part. You may also want to chain your data one piece at a time instead of using automatic chaining.
Gaps in your data make chaining your geometry into curves more difficult. With small gaps you may have to adjust the **Chaining tolerance** set in **Chaining** in the **Options** menu. This tolerance represents the distance between endpoints that will automatically be bridged by the chaining algorithm. By increasing this tolerance you may be able to automatically close the gaps between endpoints during chaining. You can change this tolerance in the **Chaining** dialog. With some data you may find that you must manually insert line segments or arcs to close the gaps in the data. After closing these gaps, you should find that the data will chain more easily.

**Import wizard**

When you import a file, FeatureCAM steps you through its import wizard. This wizard helps you:

1. Import the file into FeatureCAM.
2. Size the stock.
3. Orient the stock.
4. Position the part program zero.
5. Set up a part for indexing.
6. For some solid file formats, it helps you recognize and suppress some part features.

To use the wizard, select **File > Import** from the menu and follow the steps of the wizard.

**Import Results dialog**

After importing a file, the **Import Results** dialog is displayed.

The options available depend on the file you imported and include:
Use the wizard — Select this option and click Next to run the Import wizard (see page 85) to align the part to the stock, size the stock, and for some file formats, perform some initial feature recognition.

Accept the imported data ‘as is' and exit the wizard — To exit without using the wizard, select this option and click Finish.

Launch AFR after finish — If you want to run automatic feature recognition on the imported model, select this option. Automatic feature recognition runs after the import procedure is complete.

Use the same alignment as last import — If you are re-importing a part or importing parts that are part of an assembly, select this option. The alignment transformation is saved with each import and you can reapply it using this option.

*Undo does not reset the saved transformation.*

Stock Type page

Use the Stock Type page of the import wizard to specify the shape of the stock.

The following stock shapes are available:

- **Block:**
- **Round:**
- **N-Sided:**

To complete this page:

1. Select the stock shape as **Block**, **Round**, or **N-Sided**.
   - If you selected **Block** — Enter the Length (X dimension), Width (Y dimension), and Thickness (Z dimension).
   - If you selected **Round** — Select the Axis (see page 208) and enter the Length and OD (outside diameter). If you are working with tube stock, enter a positive number as the ID (inside diameter).
     
     *If wrapping (see page 243) or indexing (see page 234), the axis must match your index axis.*

     - If you selected **N-Sided** — Enter the Axis (see page 208), the OD (outside diameter), the number of Sides, and the Length of your stock.
     
     *You can skip this step and use the Stock Wizard (see page 205) later to define the stock.*
If you are running the offline version of FeatureCAM, you also have the option of automatically resizing the stock.

If you want to use a Curve or a Solid to define the stock, use the **Stock Properties** (see page 220) dialog.

2 Click **Next**, or click **Finish** (see page 206).

**Select Round Stock Center page**

Use the **Select Round Stock Center** page to specify the location of the central axis of the stock.

Use one of the buttons to locate the central axis:

- **Pick location** — Select a location in the graphics window that represents the round stock center point.

- **Center of revolved surface** — Select a revolved surface (see page 113) to use the axis about which it is revolved is as the center of the stock.

- **Center of imported data's bounding box** — Use the geometric center of the imported data as the center of the stock. Use this option to quickly position the stock when importing simple or symmetrical solids.

**Pick Initial Setup XYZ Location page**

Use the **Pick Initial Setup XYZ Location** page to specify the location of the setup.

Use the buttons to position the setup:

- **Pick location** — Select a location in the graphics window.

- **Center of revolved surface** — Select a revolved surface (see page 113) to position the setup in the center of the surface.

- Enter the X, Y, and Z coordinates of the setup.

- **Preview** — Display a preview of the setup location in blue in the graphics window.

**Import Using Exchange**

You can import files using Delcam Exchange. There is an option on the **File** menu. Select **File > Import Using Exchange**:
You must have Delcam Exchange installed to use this feature.

**Importing PDF files**

You can import curves from Adobe Acrobat files using Delcam Exchange.

To import curves from an acrobat file:

1. Open a document.
2. Select the **File > Import using exchange** menu option. The **Import** dialog is displayed.
3. In the **Files of type** list, select **PDF Files (*.pdf)**.
4. Locate and select the acrobat file containing the curves you want to import, then click **Open**.
5. A message asks if you want to review the import log. Click **Yes** to view the log, or click **No** to continue.
6. If the **Import Units** dialog is displayed to inform you the file was defined using different measurement units to those used in your document, select an option then click **OK** to continue. The **Import Results** dialog is displayed.
7. Select **Use the wizard to establish the initial setup location and stock size** and click **Next** to create a part using the **Import Wizard**, or click **Accept the imported data 'as is' and exit the wizard** and click **Finish** to complete the import process.

The curves are displayed in the graphics view and listed in the **Part View**.

**Importing Delcam PowerSHAPE files**

FeatureCAM supports the import of these *.ddx* entities:

- lines
- arcs
- NURBS curves
- any surface that can be converted into a 'NURBS surface' by the DGK2DGK function.
- any surface that can be converted into a 'trimmed NURBS surface' by the DGK2DGK function.
- Parasolid (X_T) information.
**Importing AutoCAD files**

FeatureCAM supports the import of the following .dwg and .dxf entities. .dxf files have both ASCII and binary forms, .dwg files have only binary form. If the entity has (3D) listed after it, then you need FeatureCAM 3D or the Solid Modeling module.

<table>
<thead>
<tr>
<th>.dxf entity</th>
<th>FeatureMILL object</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINE</td>
<td>line from 2 points</td>
</tr>
<tr>
<td>POLYLINE</td>
<td>lines from 2 points</td>
</tr>
<tr>
<td>POLYLINE with smooth vertices</td>
<td>curve</td>
</tr>
<tr>
<td>POLYGON MESH</td>
<td>surface</td>
</tr>
<tr>
<td>LINE3D</td>
<td>line from 2 points</td>
</tr>
<tr>
<td>POINT</td>
<td>point</td>
</tr>
<tr>
<td>SPLINE (DXF only)</td>
<td>curve</td>
</tr>
<tr>
<td>UCS</td>
<td>UCS</td>
</tr>
<tr>
<td>SEQEND</td>
<td>line from 2 points</td>
</tr>
<tr>
<td>LAYER</td>
<td>layer</td>
</tr>
<tr>
<td>VERTEX</td>
<td>line from 2 points</td>
</tr>
<tr>
<td>COLOR</td>
<td>object colors are maintained upon import</td>
</tr>
<tr>
<td>CIRCLE</td>
<td>circle center radius</td>
</tr>
<tr>
<td></td>
<td>arc center begin end</td>
</tr>
<tr>
<td></td>
<td>curve</td>
</tr>
<tr>
<td>ARC</td>
<td>arc center begin end</td>
</tr>
<tr>
<td></td>
<td>curve, if asymmetrically scaled</td>
</tr>
<tr>
<td>INSERT DXF BLOCK</td>
<td>trimmed surfaces (3D)</td>
</tr>
<tr>
<td>BODY</td>
<td>trimmed surfaces (3D)</td>
</tr>
<tr>
<td>SHEET 3DSOLID</td>
<td>trimmed surfaces (3D)</td>
</tr>
<tr>
<td>DIMENSION</td>
<td>dimension object</td>
</tr>
</tbody>
</table>
Importing dimensions

AutoCAD files can contain two different spaces, model space and paper space. Model space is where you draw up geometry, 3D solids, and so on. Paper space is the formatted space where multiple views are formatted. Most AutoCAD files have only model space. FeatureCAM can import dimensions in both model space and paper space.

AutoCAD dimensions are imported as FeatureCAM dimensions. That means that you can modify the color of the dimension, easily delete the entire dimension or use the Show or Hide pull-out menus to toggle the display of dimensions.

See Simplifying 3D AutoCAD data for 2D import (see page 90) for more details.

Importing solids

You can import ACIS solids from DWG files, such as 3DSOLID, REGION and BODY entities, by using the FeatureCAM native import.

When you import a DWG that contains solid entities, the AutoCAD Import Method dialog is displayed.

Select whether to import using Exchange or the FeatureCAM native import. The FeatureCAM native import is faster, and you can import solid entities as solids in FeatureCAM. Solids are imported as collections of surfaces when using Exchange.

Simplifying 3D AutoCAD data for 2D import

Many AutoCAD models comprise higher level objects such as 3DSOLIDs or BODYs. If you have licensed FeatureCAM 3D or the Solid Import module, you can import these entities directly into FeatureCAM. If not, you must simplify this data before importing.

To import the geometry that is used to create the 3DSOLIDs, select your model and then use the EXPLODE command, or the Explode pull-out from the Modify toolbar, to repeatedly reduce your model into these more primitive elements.

When exploding solids you often get duplicate lines and circles. Any edge that was shared between two different faces is duplicated. This repeated geometry causes trouble if you try to chain the geometry by double-clicking. To work around this, you can:

- Chain manually (see page 318), by picking each piece individually
- Use AutoCAD to explode specific faces of the model (not the entire model), and then do chaining normally with double-click or piece-to-piece
- Remove duplicate pieces in FeatureCAM and then do chaining normally.

To see if you have imported geometry:

1. Select a line or circle.
2. Look at the object’s name listed in the status bar. Imported lines have names that begin with _ln and imported circles have names that begin with _circ.
3. Select the object again.
4. See if the same name is listed in the status bar.
5. If a duplicate name appears and selected geometry is the same, delete the second occurrence of the geometry.

If your AutoCAD model contains layers, those layers are kept after import.

**Importing IGES files**

It is helpful to set the export settings of your CAD system for proper import.

- SolidWorks settings (see page 93)
- AutoCAD settings (see page 93)
- For other systems try and ensure that 3D surfaces are exported as trimmed NURBS.

If you are working with Pro/Engineer from Parametric Technology Corporation set the following IGES import options (see page 75):

- Physically dependent - OFF
- Logically dependent - ON
- Both physically and logically dependent - ON

See Import/Export Options for more details on these parameters.

FeatureCAM can read the following IGES entities. If the 3D column is selected in the table, then you need FeatureCAM 3D or the Solid Modeling module to read these entities.

<table>
<thead>
<tr>
<th>Entity</th>
<th>IGES Description</th>
<th>FM Object Type</th>
<th>3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Circular Arc</td>
<td>Circle and arc</td>
<td>3D</td>
</tr>
<tr>
<td>102</td>
<td>Composite Curve</td>
<td>Curve</td>
<td></td>
</tr>
<tr>
<td>104</td>
<td>Conic Arc</td>
<td>Curve</td>
<td></td>
</tr>
<tr>
<td>106</td>
<td>Copious Data</td>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>108</td>
<td>Plane</td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Line</td>
<td>Line, multiple lines</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Description</td>
<td>Type</td>
<td>Supported</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------</td>
<td>---------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>112</td>
<td>Parametric Spline Curve</td>
<td>Curve</td>
<td></td>
</tr>
<tr>
<td>114</td>
<td>Parametric Spline Surface</td>
<td>Surface</td>
<td>✓</td>
</tr>
<tr>
<td>116</td>
<td>Point</td>
<td>Point</td>
<td></td>
</tr>
<tr>
<td>118</td>
<td>Ruled Surface</td>
<td>Surface</td>
<td>✓</td>
</tr>
<tr>
<td>120</td>
<td>Surface of Revolution</td>
<td>Surface</td>
<td>✓</td>
</tr>
<tr>
<td>122</td>
<td>Tabulated Cylinder</td>
<td>Surface</td>
<td>✓</td>
</tr>
<tr>
<td>126</td>
<td>Rational B Spline Curve</td>
<td>Curve</td>
<td></td>
</tr>
<tr>
<td>128</td>
<td>Rational B Spline Surface</td>
<td>Surface</td>
<td>✓</td>
</tr>
<tr>
<td>141</td>
<td>Boundary</td>
<td>Curve</td>
<td>✓</td>
</tr>
<tr>
<td>142</td>
<td>Curve on Parametric Surface</td>
<td>Curve</td>
<td>✓</td>
</tr>
<tr>
<td>143</td>
<td>Bounded Surface</td>
<td>Surface</td>
<td>✓</td>
</tr>
<tr>
<td>144</td>
<td>Trimmed Surface</td>
<td>Surface</td>
<td>✓</td>
</tr>
<tr>
<td>186</td>
<td>Brep</td>
<td>Solid with Solid Modeling, Surfaces without Solid Modeling</td>
<td>✓</td>
</tr>
<tr>
<td>304</td>
<td>Line Font Definition</td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>408</td>
<td>Subfigure Instance</td>
<td>Geometry, curves, or surfaces</td>
<td></td>
</tr>
<tr>
<td>410</td>
<td>View</td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>502</td>
<td>Vertex</td>
<td>Point</td>
<td>✓</td>
</tr>
<tr>
<td>504</td>
<td>Edge</td>
<td>Curve</td>
<td>✓</td>
</tr>
<tr>
<td>508</td>
<td>Loop</td>
<td>Curve</td>
<td>✓</td>
</tr>
<tr>
<td>510</td>
<td>Face</td>
<td>Surface without Solid Modeling</td>
<td>✓</td>
</tr>
<tr>
<td>514</td>
<td>Shell</td>
<td>Surfaces without Solid Modeling, Solid with Solid Modeling</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Note:** The table lists various geometric entities supported in FeatureCAM 2016 R2.
Dimension entities from IGES files, such as labels, notes, and arrows are also imported. All other IGES entities are ignored. Look in the status bar and the log file for feedback about the IGES file import. After importing a *.iges file an alert displays either **The IGES file has been imported successfully** or **The file example.iges is corrupted and cannot be imported**. A log file is created which details the IGES import process. The name of this file is specified in the **Import Settings** dialog which is displayed with the **Import Settings** option of the **File** menu.

**AutoCAD IGES Export settings**

Use the following steps to set the IGES export settings in AutoCAD before exporting for FeatureCAM:

1. Select **IGES Out...** from the **File** menu.
2. Select **Edit Options**....
3. Select **Geometry**....
4. Set the parameters as follows:
   - For **3D Solid/Designer Part Mapping**, select **Surfaces**.
   - For **Trimmed Surface Mapping**, select **Trimmed Surface (144)**.
   - For **AutoSurf Augmented Line Mapping**, select **Copious Data 6-tuples (106: 13)**.
   - Select **Map Point Entities**.
   - Select **Map RAY and XLINE objects to 110:1,2 (Unbounded Line Forms)**.

**SolidWorks IGES Export settings**

Use the following steps to set the IGES export settings in SolidWorks before exporting for FeatureCAM:

1. In the SolidWorks menu, select **File > Save As**.
2. In the **Save As** dialog, select **IGES (*.igs)** as the **Save as type**.
3. Click the **Options** button. The **Export Options** dialog opens.
4. In the **Output as** section, select the **IGES solid/surface entities** option and select **Trimmed Surface(type 144)** from the list.
5. Select the **IGES wireframe (3D curves)** option and select **B-Splines (Entity type 126)** from the list.
6. For **Surface representation/System preference**, select **ANSYS**.
7. From the remaining options, select:
   - **Export 3D Curve features**
- Use high trim curve accuracy
- Save all components of an assembly in one file
- Flatten assembly hierarchy

8 Click OK to save your settings and close the Export Options dialog.

9 Continue to save your file, or click Cancel to return to SolidWorks.

**Importing Parasolid files**

You need FeatureCAM 3D or the Solid Modeling module to import Parasolid files.

CAD systems that use the Parasolid kernel can create files of type .xmt. These files contain the solid models created by systems including SolidWorks, SolidEdge, and Unigraphics. FeatureCAM can import ASSEMBLIES and PARTS that are made up of BODIES.

SolidWorks is a registered trade name of Solidworks Inc.
Parasolid, SolidEdge, and Unigraphics are registered trade names of Siemens AG.

**Importing ACIS files**

You need FeatureCAM 3D or the Solid Modeling module to import ACIS files.

CAD systems that use the ACIS kernel can create files of type *.sat. These files contain the solid models created by systems including Mechanical Desktop, CadKey and others. These solids can also be imported in *.dwg and *.dwf files.

FeatureCAM cannot import wireframe models, only solids. The normals of solids are reverse for ACIS models because the ACIS convention is opposite to the FeatureCAM convention.
Importing SolidWorks files

The files have a .sldprt extension. Only the final solid model is imported. Geometry, curves, and construction history are not imported. This means that you only get a single solid and not the individual design features from SolidWorks.

SolidWorks configurations are also supported. If there are multiple configurations, the **SolidWorks Configurations** dialog is displayed. Select which configuration you want to import and click **OK**.

*If you import a .sldprt or .sldasm file into FeatureCAM, colors are not honored. To keep colors, export an .X_T file from SolidWorks and import that file into FeatureCAM.*

Solid Source File dialog

FeatureCAM remembers the location of the file from which a SolidWorks file is imported. If the solid source .sldprt file is renamed or moved, you can set the new name and/or location here to keep the associativity.

1. Right-click the name of the solid in the **Part View** and select **Solid Source File** from the context menu: The **Solid Source File** dialog is displayed:

2. Click the **Browse** button to find the source file.

   If associativity is kept, FeatureCAM displays a warning when the source file is updated, to ask if you also want to update the .fm file.
**Importing SolidWorks assemblies**

You can import the solids contained in SolidWorks assemblies (files with an `.sldasm` extension) if you have the `.sldasm` file and all of the referenced `.sldprt` files.

Each solid of the assembly is loaded into a single FeatureCAM document.

See also Importing Solidworks files (see page 95).

**Importing CATIA V4 files**

You need the Catia Import module to import CATIA V4 files.

You can import CATIA version 4 (specifically versions 4.1.x or 4.2.x) files directly into FeatureCAM. These files must have a `*.mod` or `*.model` extension. In general, only 3D surface and solid models can be imported, but composite curves can also be imported. A log of the import is recorded in `windows\temp\catia.txt`.

<table>
<thead>
<tr>
<th>CATIA Object Type</th>
<th>FeatureCAM Object Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Not translated</td>
</tr>
<tr>
<td>Line</td>
<td>Curve</td>
</tr>
<tr>
<td>Circle</td>
<td>Curve</td>
</tr>
<tr>
<td>Ellipse, Hyperbola, Parabola</td>
<td>Curve</td>
</tr>
<tr>
<td>Curve</td>
<td>Curve</td>
</tr>
<tr>
<td>Composite curve</td>
<td>Curve</td>
</tr>
<tr>
<td>NURBS curve</td>
<td>Curve</td>
</tr>
<tr>
<td>Polynomial surface, B-spline</td>
<td>Surface</td>
</tr>
<tr>
<td>polynomial surface</td>
<td></td>
</tr>
<tr>
<td>NURBS surface</td>
<td>Surface</td>
</tr>
<tr>
<td>Skin</td>
<td>Surfaces or solid depending on option settings (see page 77)</td>
</tr>
<tr>
<td>Exact solid</td>
<td>Surfaces or solid depending on option settings (see page 77)</td>
</tr>
<tr>
<td>Polyhedral solid</td>
<td>Surfaces or solid depending on option settings (see page 77)</td>
</tr>
</tbody>
</table>
**Importing Autodesk Inventor files**

You can import Autodesk inventor *.ipt files directly into FeatureCAM. Only the final 3D solid model is imported, 2D geometry, assemblies, and sketches are not imported. You can also import solids contained in Autodesk Inventor assembly files directly from *.iam files.

**Importing Pro/E files**

You need the FeatureCAM ProE Import module to import Pro/E files.

These files must have an extension of *.prt, *.prt.<number> (for example foo.prt.8), *.asm, or *.asm.<number> (for example bar.asm.23). Only solid models are imported from Pro/E. The solid models are imported as surfaces or solids depending on the options you set in the Import/Export Options (see page 77) dialog. Only solids are read from a Pro/E file. Any curves or surfaces read must be part of a solid.

FeatureCAM can read Pro/E Family Tables, which are multiple configurations of a given part.

**Importing CATIA V5 files**

You need the FeatureCAM Catia V5 Import module to import CATIA V5 files.

CATIA V5 files can be imported directly. These files must have an extension of *.catpart. A log of the import is recorded in windows\temp\catia.txt. Only solid models are read from a CATIA V5 file. Any curves or surfaces read must be part of a solid. Colors are kept upon import.

Not all CATIA solids can be imported into FeatureCAM as solids. This is because the solid modeling technology used by FeatureCAM requires that a solid be truly watertight, and CATIA uses a different solid modeling technology that allows for solid models that aren't truly watertight. So the bottom line is that FeatureCAM won't be able to import every CATIA solid as a solid, but it should be able to bring them in as surfaces at the very least. If you import as surfaces, then you should be able to stitch the surfaces into a solid with some amount of retrimming/remodelling effort depending upon the quality of the original CATIA model.
Importing SolidEdge files

FeatureCAM can import the solid models directly from a native SolidEdge (*.par) file. The solid models are imported as Surfaces or Solids depending on option settings (see page 77).

FeatureCAM can also import SolidEdge assembly (*.asm) files.

Importing NX (Unigraphics) files

You need the FeatureCAM UniGraphics module to import NX (formerly Unigraphics files).

NX *.prt files can be imported directly into FeatureCAM. Only solid models are imported.

Importing STEP files

You need the Step Import module to import STEP files

FeatureCAM can import solid models via STEP AP203 or AP214. The solid models are imported as Surfaces or Solids depending on option settings (see page 77).

AP203 and AP214 contain the same geometry specifications. AP214 allows support for attributes which are not present in AP203 (color, line thickness, line type, and so on).

Importing STL files

STL (Standard Tessellation Language) is a file format native to stereolithography CAD software. You can import a standard format STL file directly into FeatureCAM with no special license or optional reader (STL import is part of the 2.5D Milling product). These files must have a *.stl extension. The result is an STL ‘blob’ which is all the triangles as a single pickable unit, that is, not separate solids, or separate faces. The blob can then be machined using 3D techniques for rapid prototyping (surface manufacturing - in the 3D product), or can be used as a stock model (in all products).

FeatureCAM supports both binary and ASCII STL.

Importing DMT files

DMT (Delcam's Machining Triangles) is a file format generated by Delcam (http://www.delcam.com)’s CAD software including PowerMILL, PowerSHAPE, and CopyCAD. The file has the extension of *.dmt and you can import it directly into FeatureCAM. The DMT file represents 3D models as triangles, similar to an STL (see page 98) file. Any function or operation that can be applied to an STL file can also be applied to a DMT file.
Hole recognition on imported parts

You can use the hole recognition to recognize holes in imported parts. Hole recognition is different from Feature Recognition because it uses additional data from the imported model, instead of using just the solid data. This enables you to recognize non-geometric information, such as threads for tapped holes.

Inventor hole recognition (see page 99)
SolidWorks hole recognition (see page 100)
SolidEdge hole recognition (see page 101)

Inventor hole recognition

You can use the Inventor Hole Recognition page of the Import wizard to recognize holes in imported Autodesk Inventor parts (see page 97), as shown in this example (see page 102).

Inventor hole recognition is different from Feature Recognition because it uses additional data from the Inventor model, instead of using just the solid data. This enables you to recognize non-geometric information, such as threads for tapped holes.

You must have Autodesk Inventor installed and licensed on your computer to use Inventor hole recognition.

Inventor hole recognition has this limitation:

- Only holes that were created using Inventor hole features are recognized automatically. Holes that were created as extrusions have to be recognized using FeatureCAM's automatic feature recognition.

To complete this page:

1. To use Inventor hole recognition, select Use Inventor to extract information about the hole types and dimensions.
2. Select Suppress recognized holes in the imported model to suppress the holes after they have been recognized. This removes the holes from the solid model so they are not recognized again if you use Feature Recognition.
3. If you do not want to perform hole recognition using Inventor, select Use FeatureCAM to recognize holes later.
4. Click Finish to close the wizard.

It may take some time to start up Inventor and recognize the holes, so please be patient.
**SolidWorks hole recognition**

You can use the **SolidWorks Hole Recognition** page of the Import wizard to recognize holes in imported SolidWorks parts, as shown in this example (see page 102).

SolidWorks hole recognition is different from Feature Recognition because it uses additional data from the SolidWorks model, instead of using just the solid data. This enables you to recognize non-geometric information, such as threads for tapped holes.

*You must have SolidWorks installed and licensed on your computer to use SolidWorks hole recognition.*

SolidWorks hole recognition has some limitations:

- Only holes that were created using SolidWorks hole wizard are recognized automatically. Holes that were created as extrusions must be recognized using FeatureCAM’s automatic feature recognition.
- FeatureCAM supports recognizing tapped, counter drill, and counter bore holes created in SolidWorks. Boring and Reaming are not supported because they are dependent on tolerance. Dowel holes are recognized, and machined with a Ream operation.
- Tapered taps are driven to a different depth than straight taps. For straight taps, a tip allowance is added to the thread depth so that the tool cuts the complete thread, this is not added for tapered taps so that the OD is not affected.
- FeatureCAM recognizes SolidWorks patterns only if those patterns can be mapped to a FeatureCAM pattern.

To complete this page:

1. To use SolidWorks hole recognition, select **Use SolidWorks to extract information about the hole types and dimensions.**
2. Select **Suppress recognized holes in the imported model** to suppress the holes after they have been recognized. This removes the holes from the solid model so they are not recognized again if you use Feature Recognition.
3. If you do not want to perform hole recognition using SolidWorks, select **Use FeatureCAM to recognize the holes later.**
4. Click **Finish** to close the wizard.

*It may take some time to start up SolidWorks and recognize the holes, so please be patient.*
SolidEdge hole recognition

You can use the **SolidEdge Hole Recognition** page of the Import wizard to recognize holes in imported SolidEdge parts (see page 98), as shown in this example (see page 102).

SolidEdge hole recognition is different from Feature Recognition because it uses additional data from the SolidEdge model, instead of using just the solid data. This enables you to recognize non-geometric information, such as threads for tapped holes.

You must have SolidEdge installed and licensed on your computer to use SolidEdge hole recognition.

SolidEdge hole recognition has some limitations:

- Only holes that were created using SolidEdge hole wizard are recognized automatically. Holes that were created as extrusions have to be recognized using FeatureCAM’s automatic feature recognition.
- FeatureCAM recognizes SolidEdge patterns only if those patterns can be mapped to a FeatureCAM pattern.

To complete this page:

1. To use SolidEdge hole recognition, select **Use SolidEDGE to extract information about the hole types and dimensions**.
2. Select **Suppress recognized holes in the imported model** to suppress the holes after they have been recognized. This removes the holes from the solid model so they are not recognized again if you use Feature Recognition.
3. If you do not want to perform hole recognition using SolidEdge, select **Use FeatureCAM to recognize the holes later**.
4. Click **Finish** to close the wizard.

It may take some time to start up SolidEdge and recognize the holes, so please be patient.
**Recognizing and suppressing holes on imported parts example**

This is an imported solid part:

The image below shows the solid part with the holes recognized and suppressed. The holes in the solid are filled in, but the recognized Hole features can be seen as circles:

The **Part view** shows the eight holes that were created:

**Exporting files**

You can export the following file formats from FeatureCAM:
DXF and DWG (see page 103)
IGES (see page 103)
STL (see page 104)

**Exporting .dxf and .dwg files**

The .dxf and .dwg files exported are version 11 files. .dxf files are exported in the ASCII form, the binary form is not exported.

<table>
<thead>
<tr>
<th>FeatureCAM object</th>
<th>DXF entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>POINT</td>
</tr>
<tr>
<td>Circle</td>
<td>CIRCLE</td>
</tr>
<tr>
<td>Arc</td>
<td>ARC (Note that all arcs are modified so that the normal points in the +Z direction)</td>
</tr>
<tr>
<td>Line</td>
<td>LINE</td>
</tr>
<tr>
<td>Layer</td>
<td>LAYER</td>
</tr>
<tr>
<td>UCS</td>
<td>UCS</td>
</tr>
</tbody>
</table>

**Exporting .iges files**

The different FeatureCAM categories of geometry, curves, features and so on are exported to .iges as shown in the following table. FeatureCAM exports .iges v4 files for easy compatibility with other systems.

<table>
<thead>
<tr>
<th>FeatureCAM Entity</th>
<th>IGES Entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5D Feature</td>
<td>144 = Trimmed surface(s) or 142 = Curve(s) on parametric surface</td>
</tr>
<tr>
<td>Surface</td>
<td>128 = NURBS surface</td>
</tr>
<tr>
<td>Curve</td>
<td>126 = NURBS curve</td>
</tr>
<tr>
<td>3D feature</td>
<td>144's and 142's</td>
</tr>
<tr>
<td>Point</td>
<td>116 = Point</td>
</tr>
<tr>
<td>Line</td>
<td>110 = Line</td>
</tr>
<tr>
<td>Arc/Circle</td>
<td>100 = Circular arc</td>
</tr>
<tr>
<td>Layer</td>
<td></td>
</tr>
<tr>
<td>Dimensions, &amp; other attributes</td>
<td>not exported</td>
</tr>
</tbody>
</table>
Save STL dialog

This option is available after you run a 3D simulation. It enables you to create an .stl file of the final simulation. An .stl file is a triangle file used by layered manufacturing machines. The accuracy of the model is controlled by the 3D simulation options.

To display the Save STL dialog:
1. Play a 3D simulation (see page 1519).
2. Select View > Simulation > Save simulation results from the menu.

To use the Save STL dialog to save an .stl file:
1. Click Save to current directory to write to the same folder as your part is being saved in or click Save to other directory and specify the folder.
2. Enter an STL File Name.
3. Select Save STL using short filename to limit your filename to 8 characters.
4. Select Create subfolder if you want to create a subfolder with the same name as your part.
5. Select Overwrite existing file to automatically overwrite any file with the same name.
6. Click OK.

Printing

There are several places to access printing options in FeatureCAM:
Print (see page 105) dialog — This is the main print dialog. Set the quality, number of copies and other settings and start printing. You can also access the Printing Options (see page 106) dialog from here, where you set what to print.
Print Preview (see page 107) — See a preview of the pages that will be printed.
Print Setup (see page 107) dialog — Set the printer, paper and orientation.

Print dialog

Select File > Print from the menu to display the Print dialog:

Printer — This displays the current printer. To set or change the printer, click the Setup button to open the Print Setup (see page 107) dialog.

Print Quality — Set the print resolution. Select from 600 dpi or 300 dpi.

Print to File — Select this option to open the Print to File dialog when you click the OK button. In the Print to File dialog, you can save the print settings as a .prn file to print later.

Copies — Enter the number of copies you want to print, or use the arrow buttons.

Collate Copies — If you are printing more than one copy, select Collate Copies to print all the pages of the first copy before moving on to the next copy. Deselect Collate Copies to print page 1 for all copies, then page 2, and so on.

Setup — Click this button to display the Print Setup (see page 107) dialog.

Options — Click this button to display the Printing Options (see page 106) dialog.

OK — Click OK to print.

Cancel — Click the Cancel button to close the dialog without saving any changes.

Help — Click the Help button to open this Help topic.
Printing Options dialog

To display the Printing Options dialog, select File > Print from the menu, then click Options in the Print (see page 105) dialog.

Print Range — Select the elements you want to print. Select All to print everything, or select Selection to choose which elements to print, from:

- Graphics Window
- Comments (see page 70)
- Operations List
- Tool List of All Setups
- Tool List of Each Setup
- NC Program

Use white background — Select this option to print the graphics window with a white background regardless of the background color that is set. Deselect this option to print the background color as you see it.

Print Tool Path — Select this option to print the tool path.

Print to Scale — Select this option to print the graphics window to scale.

OK — Click the OK button to save your settings and close the dialog.

Cancel — Click the Cancel button to close the dialog without saving any changes.

Help — Click the Help button to open this Help topic.
Print Preview
Select File > Print Preview to display a preview of the pages to be printed.

The preview has several buttons at the top:

Print — Click the Print button to open the Print (see page 105) dialog to print the previewed pages.

Next Page — Click this button to view the next page to be printed.

Prev Page — Click this button to view the previous page to be printed.

Two Page — Click this button to view two pages at the same time.

One Page — If you are viewing two pages, click this button to return to viewing one page at a time.

Zoom In — Click this button to zoom into the preview.

Zoom Out — If you are zoomed into the preview, click this button to zoom out of the preview.

Close — Click Close to exit the print preview.

Print Setup dialog
To open the Print Setup dialog, select File > Print Setup from the menu.

Printer
Name — Select the name of the printer you want to use.
Status — This displays the status of the selected printer.
Type — This displays the type of the selected printer.
Where — This displays the location of the selected printer.
Comment — This displays any comments associated with the selected printer.

**Paper**
Size — Select the paper size.
Source — Select the paper source.

**Orientation**
Select the paper orientation from Portrait or Landscape.

You can see how the Paper Size and Orientation settings affect the print output by doing a Print Preview (see page 107).

**Help** — Click the Help button to open this Help topic.
**Network** — Click the Network button to browse to a printer on the network.
**OK** — Click the OK button to save your settings and close the dialog.
**Cancel** — Click the Cancel button to close the dialog without saving any changes.
Coordinate systems

A User Coordinate System (see page 109) (UCS) is an origin, X direction, Y direction, and Z direction used for modeling and is displayed like this:

Setups (see page 114) can be anywhere in three-dimensional space. They can even exist in the same location as other Setups. When you create a Setup, you need to keep in mind what it means for the part. The Setup is the part origin (0, 0, 0) on the machine and in the NC code. You have to place the Setup where that origin also works with the manufacturing of features in the Setup.

A Setup is displayed like this:

The origin and coordinate system for each NC part program is determined by the Setup and its associated UCS. When you Save NC code, the part program and manufacturing documentation is generated and saved for all Setups of your part.

User Coordinate Systems (UCSs)

A User Coordinate System (UCS) is an origin, X direction, Y direction, and Z direction used for modeling. Two-dimensional geometry is usually created in the XY plane of the current UCS. You can use many different UCSs while modeling your part. When you create a manufacturing Setup, you select a single UCS to determine the part program zero and set the direction for the X, Y, and Z axes.

You can create UCSs in many different locations. You can create a UCS by explicitly transforming an existing UCS or by using the Alignment wizard (see page 112) to create UCSs at convenient locations on your part. The name of the current UCS is displayed in the Status bar (see page 32). To change to a different UCS, click the current UCS name in the status bar and select the new UCS from the context menu.
**UCS dialog**

The **UCS** dialog enables you to create and edit User Coordinate Systems.

Use one of the following methods to display the **UCS** dialog:

- Select **Construct > UCS** from the menu.
- Click **UCS** in the **Advanced** toolbar (see page 12).

**Current UCS** displays the name of the current coordinate system.

The **Parameters in world coordinate system** section displays the UCS coordinates in the World Coordinate System. Selecting a different UCS from the **Current UCS** list changes the current User Coordinate System (see page 111).

Click **New** to display the **New UCS** dialog, which enables you to create a new UCS (see page 110).

You can use the **Translate**, **Rotate**, **Align**, **Rename**, and **Reset** buttons to edit the current UCS (see page 111).

To delete the current UCS, select the UCS name in the **Current UCS** list and click **Delete**.

See User coordinate systems (see page 109) for more information on UCSs and How do setups relate to UCSs? (see page 127).

**Creating a User Coordinate System**

To create a User Coordinate System:

1. Click **UCS** in the **Advanced** toolbar to display the **UCS** dialog.
2. Click **New** in the **UCS** dialog to display the **New UCS** dialog.
3. In the **New UCS** dialog, enter a **Name** for the new UCS.
4 If you want to create a copy of an existing UCS:
   a Select **Create from UCS**.
   b Select a UCS from the list.
   c Click **OK** to close the **New UCS** dialog.
   d Modify your new UCS using the UCS dialog (see page 111).

5 If you want to use the alignment wizard:
   a Select **Create and go to alignment wizard**.
   b Click **OK** to display the **Align UCS** dialog.
   c Use the alignment wizard (see page 112) to position your new UCS.

**Changing User Coordinate Systems**
To change the current UCS using the **Status** bar:
1 Click the current UCS name in the **Status** bar (see page 32).
2 Select a UCS from the context menu.
To change the current UCS using the **UCS** dialog:
1 Click **UCS** in the **Advanced** toolbar to display the **UCS** dialog.
2 Select a UCS from the **Current UCS** list.

**Editing a User Coordinate System**
To edit a User Coordinate System:
1 Click **UCS** in the **Advanced** toolbar to display the **UCS** dialog.
2 Select a UCS from the **Current UCS** list.
3 Use the following buttons to edit the UCS:
   - **Translate** — Click this button to open the **Translate** dialog, where you can enter coordinates for the new UCS or click **Pick location** to select the point in the graphics window.
   - **Rotate** — Click this button to open the **Rotate** dialog. Enter the rotation angle in degrees (positive or negative) about the X, Y, and/or Z axes.
   - **Align** — Click this button to open the Align wizard (see page 112).
   - **Rename** — Click this button to open the **New UCS Name** dialog, where you can enter a new **Name** for the UCS.
   - **Reset** — Click this button to make the UCS equivalent to the **World Coordinate System**.
4 Click **Close** to close the dialog.

**Align (UCS) wizard**

The **Align Wizard** enables you to place a UCS using a number of methods. Select a method and click **Next**. The next page then prompts you for the information listed below.

<table>
<thead>
<tr>
<th>Method</th>
<th>Next Page Prompts To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock</td>
<td>Select a face, then select a corner of that face. You can graphically pick either the face or corner.</td>
</tr>
<tr>
<td>Feature</td>
<td>Select the feature from a list of features in the part, or select it graphically. The UCS is placed at predetermined locations on the feature.</td>
</tr>
<tr>
<td>Three points</td>
<td>Specify the locations of an origin, a point anywhere on the new X axis, and any point in the new XY plane.</td>
</tr>
<tr>
<td>Two lines</td>
<td>Select two intersecting lines in the model to specify the new X and Y axes.</td>
</tr>
<tr>
<td>Circle</td>
<td>Select a circle. The UCS is positioned at the center of the circle.</td>
</tr>
<tr>
<td>Curve</td>
<td>Select a curve. The UCS is positioned at the start point or end point of the curve. The Z axis is aligned with the curve normal.</td>
</tr>
<tr>
<td>UCS</td>
<td>Select another UCS. The new UCS is now a copy of the UCS you selected. You can then edit it with other functions in the UCS dialog.</td>
</tr>
<tr>
<td>Surface</td>
<td>Select the surface and a point on the surface. UCS is positioned at the point on the surface with the Z axis aligned with the surface normal.</td>
</tr>
</tbody>
</table>
Align to revolved surface

This method is typically used to align the UCS to the axis of a turned part. This alignment method works only for surfaces of revolution. For many imported models, flat disks are not represented as surfaces of revolution. For the model below you should select the cylindrical surfaces instead of the disk in order to position the UCS at the end of the part.

To complete the **Align to Revolved Surface** dialog:

1. Click **Pick surface**.
2. Select the surface of revolution in the graphics window.
3. If you want to use the other end of the surface, select **Flip direction**.
4. Click **Finish**.

If the selected surface is not a surface of revolution, the error message *Can’t construct UCS from the selected surface* is displayed. Repeat steps 1 to 4 and select a different surface.

**Using multiple UCS and Setups**

When you create features, they are added to the active Setup and UCS. You can create profile curves in any convenient UCS. For 2.5D features, create each curve in the XY plane (or parallel to the XY plane) of the UCS. You can then use a curve to create a feature in any Setup whose XY plane is parallel to the plane of the curve.

Click **Setups** in the **Advanced** toolbar to display the **Setups** (see page 114) dialog, where you can change the current UCS.

Click **UCS** in the **Advanced** toolbar to display the **UCS** (see page 110) dialog, where you can change the current UCS.
View Toolpaths for a Setup

Setups

You can use Setups to work in different orientations on the same part. You can have multiple Setups in a model.

When you create a feature, it is added to the active Setup. To change the active Setup, select a Setup in the Part View panel, or use the Setups dialog (see page 114).

To create a setup, use the Setups dialog (see page 114), or click Create new setup in the New Feature wizard.

To manage and delete setups, use the Setups dialog (see page 114), or right-click setups in the Part View and use the context menu.

If you have two parts that share most of the same design, you can create the common features in one Setup, and the unique features in two other Setups. Depending which Setups you include in the plan and manufacture, you can create two parts using only one FeatureCAM document.

Setups dialog

You can use the Setups dialog to change the active Setup, create new Setups and edit existing Setups.

Use one of the following methods to display the Setups dialog:

- Select Manufacturing > Setups from the menu.
- Click the Setups button on the Advanced toolbar.
- Double-click a Setup name in the Part View.
- Right-click a Setup name in the Part View and select Properties from the context menu.

![Setups dialog](image)
Click **New** to display the Setup wizard (see page 212), which you can use to create a new Setup.

To edit an existing setup, select the Setup from the **Current Setup** list, then click **Edit** to display the **Setup wizard** (see page 115).

To change the active Setup, select a Setup from the **Current Setup** list and click **Close**.

You can also change the active Setup in the **Status** bar (see page 32). Click the existing setup name and select a different setup from the context menu.

**Help** — Click the **Help** button to open this Help topic.

---

**Setup wizard**

The Setup wizard enables you to create or edit a Setup.

It contains these pages.

The pages that are displayed depend on the options that you select.

- **Definition** (see page 116)
- **Part Program Zero** (see page 118)
- **Pick Initial Setup Z Direction** (see page 121)
- **Pick Initial Setup X Orientation** (see page 121)
- **Pick Setup XYZ Location** (see page 121)
- **Part Program Offset** (see page 122)
- **Simulation Information** (see page 122)
- **Right Angled Head** (see page 123)
- **Posting**
Setup - Definition

**Setup Name** — Enter a name for the Setup. This name is used only as a label for the Setup.

**Fixture ID** — Verify the **Fixture ID** for the Setup. The default value should be correct because it is taken from the current *.cnc* post processor template file. If the default value is not correct, enter the correct value.

**Part Name** — Optionally enter a different **Part Name** for the part. This defaults to the file name, but you may need to override this for Fanuc controls to give the part a numeric part name.

Multi-axis Setups have these attributes:

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.
For example:

With an orientation angle of 0, the groove is cut in the machine's Y direction.

With an orientation angle of 90, the groove is cut in the machine's X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**5-axis position** menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the **Five Axis** dialog for the **Preferred orientation of the primary rotary axis** option.

Click **Next** to open the **Setup - Part Program Zero** (see page 118) page, or click **Finish**.
You can use the **Part Program Zero** page of the wizard to select a method of specifying part program zero. This is the origin of the coordinate system for the NC program.

To complete this page, select one of the options and click **Next**.

- **Align to Stock Face** (see page 119) — Select this option if you want to align the Setup with the center or corner of one of the Stock faces, or to explicitly pick a location.

- **Align to Index axis** (see page 120) — Select this option to align the Setup with the index axis. (This option is available only for a turn/mill or 4th-axis indexed (see page 211) part.)

- **Align with existing UCS** (see page 120) — Select this option if you want to align the Setup with a previously created user coordinate system (UCS).

- **Align to part geometry** (see page 121) — Select this option if you want to align the Setup relative to the part geometry.

- **Use current location** — Select this option if you want to leave the Setup at its current location.
**Align to Stock Face**

Align to Stock Face enables you to align the part program zero to a face on the Stock.

To complete this page:

1. In the **Stock Face** section, select the face that you want to use.
2. In the **XYZ Location** section, either click the **Pick location** button and select the location on the model or click the pointing finger button that corresponds to either the **Center** of the stock or one of the corners:
   - **UL** — upper left corner
   - **UR** — upper right corner
   - **LL** — lower left corner
   - **LR** — lower right corner
3. Click **Next** to open the **Setup - Part Program Offset** (see page 122) page, or click **Finish**.
**Align to Index axis**

![Align to Index axis diagram](image1.png)

To complete this page:

1. If you want to translate the origin off the axis, enter the **Radius from rotation axis**.
2. If you want to rotate the coordinate system around the **Stock axis** (see page 235), enter an **Angular location**.
3. Enter an **X Offset** if you want to translate the coordinate system along the X axis.
4. Click **Finish**.

**Align with existing UCS**

![Align with existing UCS](image2.png)

This page enables you to align the part program zero with an existing user coordinate system.

To complete this page:

1. Select the name of the UCS from the list or click the **Pick UCS** button and select it from the graphics window.
2. Click **Next** to go to the **Part Program Offset** (see page 122) page or click **Finish**.
Align to part geometry

Click one of the buttons to specify the Setup's Z direction using the method listed.

Click **Next** and the **Pick Initial Setup X Direction** page is displayed.

Click one of the buttons to specify the Setup's X direction using one of the methods listed.

Click **Next** and the **Pick Setup XYZ Location** page is displayed:

If you are using the center of a revolved surface, you can click **Opposite End** to create the Setup at the other end of the cylinder.

Click **Finish**.
Setup - Part Program Offset

This page enables you to translate the location of the Setup. One reason to translate the Setup is to model the extra stock on top of the part that is removed during a facing operation. You may also want to translate it to a location that you cannot easily snap to.

To complete this page:

1. If you want to translate the stock, enter the amount to offset the stock as the X Offset, Y Offset, and/or Z Offset.
2. Click the Preview button if you want to review the new location of the Setup.
3. Click Next to open the Setup - Simulation information (see page 122) page, or click Finish.

Setup - Simulation information

Use this page of the wizard to specify an offset for loading the part onto the machine and select the machine design file that is used for Machine Simulation.

This dialog is available in these places:

- In the Stock wizard
- In the Setup wizard
From the Status bar

### Setup - Simulation information

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Offset</td>
<td>0.0000</td>
<td>Convenient to think of these numbers as offsets (or a point in STOCK coordinates).</td>
</tr>
<tr>
<td>Y Offset</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Z Offset</td>
<td>-5.0000</td>
<td></td>
</tr>
</tbody>
</table>

**Simulation machine design file:**
- **Always use this one**
- **Use the one specified in the `.cnc` file**

A smart choice from `Examples\Machine Design` that matches the tool post info (or document indexer type) will be used if the selected option does not exist.

- **Notify me when a smart choice is made**

The X Offset, Y Offset, and Z Offset parameters represent offsets for loading the part onto the machine. For simulating single milling or turning setups these offsets are applied to the setup after the part is aligned with the top-most location (see page 1912). For indexed parts or turn/mill parts, the offset is relative to the stock axis.

Under **Simulation machine design file**, select **Always use this one** to specify an MD file to use for this setup, or select **Use the one specified in the `.cnc` file** to inherit the MD file from the CNC file for this setup.

If you select an MD that does not exist, or the CNC file refers to an MD file that does not exist, FeatureCAM selects an appropriate MD file from the `Examples\Machine Design` folder.

If a smart MD choice is made, a message dialog is displayed when you close the dialog and when you run a simulation. You can disable these messages by deseleting **Notify me when a smart choice is made**.

---

**Setup - Right Angled Head**

1. Select the option on this page if you want to allow the creation of features that can be cut only with a right-angled tool holder.
2. Click Finish.
Setup - Posting

Machine Z-zero is offset from the setup Z-zero by — This offsets the \texttt{<ARM-POS>} reserved word in Z.

Generate 4 axis toolpath at the wire guide planes:

By default, FeatureCAM outputs the upper and lower toolpaths at the same planes as the feature is programmed. For example, if the feature is at Z0 and has a depth of 1, then the upper toolpath is at Z0 and the lower toolpath is at Z-1.

Some machines need the output to be at the Z planes of the upper and lower wire guides, so FeatureCAM must project the toolpaths outwards to the location of the guides. For example, if the wire guides are at Z-2 and Z10, we need to project the upper toolpath to Z10 and the lower toolpath to Z-2.

For these machines, select Generate 4 axis toolpath at the wire guide planes and enter the Z planes of the Upper guide and Lower guide.
In the image below, ① is the original lower toolpath, ② is the toolpath at the wire guide plane.

**Fixture ID**

**Fixture ID** has two related contexts:

- One specifies the fixture offset used to model the part within FeatureCAM, especially in multiple fixture situations.
- The other specifies the fixture offset used to produce the part in NC code.

For NC code, FeatureCAM passes the **Fixture ID** to XBUILD, which uses the reserved word `<FIXTURE>` to pass the fixture offset information to the machine. While your part may have been displayed and modeled at one location, the fixture offset may override that location in actual production depending on your machine tool system.

You must set the **Fixture ID** to correspond to your machine tool. If your machine uses **G54** or **G55**, set the **Fixture ID** to **54** or **55**. If your machine uses **H1**, set the **Fixture ID** to **1**.

*The other fixture offset type reserved words, Datum Shift and Datum Set, are not supported. Datum Shift and Set are commonly seen as **G92**, or **G97** codes.*

**Part Name**

The **Part Name** defaults to be the same as the FeatureCAM part file name. This name is used in three places:
- The part name in the NC file comment.
- If the part has macros, the names of the macros are derived from the program name. A two-digit number is appended to the program name to form the macro name. For example, if the part is named plate the first macro would be named plate01.
- The name of the NC text file and documentation files (setup sheet and tooling list).

You can change the **Part Name** in the **Setups** (see page 114) dialog. Even though the name is changed in the **Setups** dialog, this name is the same for all Setups. A number is appended to subsequent Setups. Changing the **Part Name** changes the name of the NC file, tooling list and operations sheet that is generated. See Saving an NC part program to disk (see page 1567) for more information on output files.

![Fanuc control users: you need to use a numeric value for the NC program name. This gives you a numeric NC file name and appropriately named macros.]

**Setting up a part for multi-spindle turning**

**Setups**

You need at least two Setups (see page 114) for multi-spindle turning, one Setup for the main spindle and a second Setup for the sub-spindle. The Z axes of the two Setups must point in opposite directions.

![If your NC controller requires that both coordinate systems point in the same direction, this adjustment is made in the post processor.]

The origin of the two setups can be positioned at any convenient point on the part.

![FeatureCAM automatically creates setups with non-descriptive names like Setup1 or Setup2. You may want to rename your setups with more descriptive names like Main Spindle.]

The first Setup is automatically assigned to the main spindle. To perform the first operations on the sub-spindle, either:
- In the **Part View** panel, click and drag the sub-spindle Setup above the main spindle Setup.
- Select **Manufacturing > Process Plan** from the menu to display the **Process Plan** (see page 1492) dialog, and use the arrow buttons to change the order of the Setups in the **Process Plan** list.
**Associating features with Setups**
Features are associated with the current Setup. For multiple turret cutting, the Setup associated with the feature dictates which spindle holds the part while the feature is being cut. The Part View displays a list of the Setups in the model, with the Features on each Setup listed below the Setup name.

**Moving the part**
The part must be moved between the two spindles using a collection sub-spindle features (see page 843) and perhaps bar feed features (see page 828).

**Machine Simulation**
Machine simulation shows each Setup cut twice if there is a sub-spindle move.

**Setting up a part for multi-turret turning**
The following issues must be considered for multi-turret turning:
- Multi-turret machining can be performed with as few as one setup.
- The post processor that is loaded while you are creating your part must support multiple turrets.
- For pinch or follow turning, your post processor must have opposing turrets.
- For appropriate machine simulation the post processor must have the same turret and spindle description as the machine design file.
- With the exception of automatically synchronized features (see page 1561), features are automatically associated with the first turret. To move an operation to another turret, you must use the Tool Posts (see page 1557) tab.

**How Setups relate to UCSs**
A User Coordinate System (UCS) is an origin and three vectors (X, Y, and Z) that determine a position and orientation in three-dimensional space. You can use an unlimited number of these to model your part.

One particular UCS is associated with a Setup. A Setup is an orientation and part program zero for a physical setup on the machine tool. The orientation and program zero are determined by the associated UCS and the Setup contains additional information like the fixture ID and the name of the NC program that are generated.
If Setups are created directly by aligning with the stock, special UCSs are created with the string **UCS** appended to the Setup name. For example a UCS called **UCS_setup2** is automatically created for **Setup2**. These UCSs are used to store the location/orientation information for the Setup. They cannot be deleted if their Setup exists.

**Options menu**

The **Options** menu gives you access to all the option settings of FeatureCAM.

- **Viewing** (see page 44)
- **Surface shading** (see page 49)
- **Simulation** (see page 1525)
- **Coloring** (see page 128)
- **Chaining** (see page 324)
- **Snapping Modes** (see page 295)
- **Snapping Grids** (see page 298)
- **Update Op List** (see page 133)
- **File Options** (see page 136)

**Coloring**

You can change the default color used for many types of object (see page 131).

Select **Options > Coloring** from the menu then select one of the following:

- **Change Selected** (see page 128)
- **Default Colors** (see page 129)
- **Color Overrides** (see page 132)

**Change Selected**

You can use the **Selected Object Color Overrides** dialog to change the color of selected object(s).

To display the **Selected Object Color Overrides** dialog:

1. In the graphics window, select any objects you want to change the color of.
2 Select **Options > Coloring > Change Selected** from the menu:

![Selected Object Color Overrides dialog]

3 If you want to select a different object, click **Pick object** and select an object in the graphics window.

4 Click **More Colors** to display the **Colors** dialog.

5 Select a color from the **Basic colors** palette or click **Define Custom Colors** to pick a different color.

   Any **Custom colors** that you define are saved in the settings file (see page 71) and are available next time you use FeatureCAM.

6 Click **OK** to close the **Colors** dialog.

7 Click **Apply** to apply the color to the selected object.

8 If you want to reset the selected object to the default (see page 131) color, select **Remove override** and click **Apply**.

9 Click **Done** to close the dialog.

**Default Colors**

You can use the **Default Colors** dialog to change the default colors used in FeatureCAM.
To display the **Default Colors** dialog, select **Options > Coloring > Default Colors** from the menu.

To change the default colors using the **Default Colors** dialog:

1. Select an object type from the list, for example, **Feature**.
2. Click **More Colors** to display the **Colors** dialog.
3. Select a color from the **Basic colors** palette or click **Define Custom Colors** to pick a different color.
   
   *Any Custom colors that you define are saved in the settings file (see page 71) and are available next time you use FeatureCAM.*

4. Click **OK** to close the **Colors** dialog.
5. Click **Apply** to apply the color to the selected object.
   
   This color is used for any new objects of this type that you create in FeatureCAM.

6. If you want to change the color for the objects that already exist in FeatureCAM, select **Apply my choice to all existing Features**, then click **Apply**.

7. If you want to reset the selected object's color to its default value (see page 131), click **Reset**, then click **Apply**.

8. If you want to reset all colors to their default values (see page 131), click **Reset All**, then click **Yes**.

9. Click **Done** to close the dialog.
# Default color list

The following table displays the list of default colors in FeatureCAM. To change the default colors use the **Default Colors** dialog (see page 129).

<table>
<thead>
<tr>
<th>Object</th>
<th>Default color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
<td>Purple</td>
<td>This is the default color for a FeatureCAM feature such as a Hole, Face, or Side feature.</td>
</tr>
<tr>
<td>Geometry</td>
<td>Charcoal gray</td>
<td>This is the default color for a 2D object such as a circle, line, or arc.</td>
</tr>
<tr>
<td>Curve</td>
<td>Royal blue</td>
<td>This is the default color for a 2D or 3D curve.</td>
</tr>
<tr>
<td>Surface</td>
<td>Dark green</td>
<td>This is the default color for a 3D surface.</td>
</tr>
<tr>
<td>Solid</td>
<td>Light blue</td>
<td>This is the default color for a 3D solid. All faces of the solid use this color.</td>
</tr>
<tr>
<td>Dimension</td>
<td>Dark green</td>
<td>This is the default color for dimension objects such as linear, radial, and annotation dimension objects.</td>
</tr>
<tr>
<td>Stock</td>
<td>Mid blue</td>
<td>This is the default color for the stock that the part is cut from.</td>
</tr>
<tr>
<td>Selection</td>
<td>Red</td>
<td>This is the default color for an object that is selected in the Graphics window.</td>
</tr>
<tr>
<td>Highlight</td>
<td>Bright green</td>
<td>This is the default color used to emphasize objects that are currently active in a dialog, and the snapping cursor.</td>
</tr>
<tr>
<td>Lower Background</td>
<td>White</td>
<td>This is the default color of the lower portion of the graphics window. If it is a different color from the Upper Background color, the two are blended in a horizontal gradient.</td>
</tr>
<tr>
<td>Upper Background</td>
<td>Gray</td>
<td>This is the default color of the upper portion of the graphics window. If it is a different color from the Lower Background color, the two are blended in a horizontal gradient.</td>
</tr>
<tr>
<td>Construction</td>
<td>Bright green</td>
<td>This is the default color used for rubber-band objects during geometry construction.</td>
</tr>
<tr>
<td>Preview</td>
<td>Royal blue</td>
<td>This is the default color for temporary objects that are displayed when you click a <strong>Preview</strong> button.</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>Mid blue</td>
<td>This is the default color for text labels in warp dialogs (that is dialogs that allow the use of interrogation (see page 292) to obtain the value).</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Main Spindle Operations</td>
<td>Yellow/green</td>
<td>This is the default color for operations on the main spindle.</td>
</tr>
<tr>
<td>Sub Spindle Operations</td>
<td>Lilac</td>
<td>This is the default color for operations on the sub spindle.</td>
</tr>
<tr>
<td>Rapid</td>
<td>Green</td>
<td>This is the default color for a rapid toolpath move.</td>
</tr>
<tr>
<td>Toolpath</td>
<td>Black</td>
<td>This is the default color for a feed toolpath move.</td>
</tr>
<tr>
<td>Index</td>
<td>Red</td>
<td>This is the default color for a toolpath move that represents the rotation of an indexer.</td>
</tr>
<tr>
<td>Partline Program</td>
<td>Cyan</td>
<td>This is the default color for a toolpath that has partline programming (see page 1607, see page 1660) activated.</td>
</tr>
<tr>
<td>Ramps and Leads</td>
<td>Royal blue</td>
<td>This is the default color for ramps and leads.</td>
</tr>
<tr>
<td>Tool</td>
<td>Dark gray</td>
<td>This is the default color for a tool.</td>
</tr>
<tr>
<td>Tool Holder</td>
<td>Dark blue</td>
<td>This is the default color for a tool holder.</td>
</tr>
<tr>
<td>Tool Shank</td>
<td>Light gray</td>
<td>This is the default color for a tool shank.</td>
</tr>
<tr>
<td>Tool Spindle</td>
<td>Dark gray</td>
<td>This is the default color for a tool spindle.</td>
</tr>
<tr>
<td>Lathe Insert</td>
<td>Yellow</td>
<td>This is the default color for a lathe tool insert.</td>
</tr>
</tbody>
</table>

**Color Overrides**

You can use the **New Object Color Override** dialog to override the default color (see page 131) of new objects.
To display the **New Object Color Override** dialog, select **Options > Coloring > Color Overrides** from the menu.

![New Object Color Override dialog]

To override the default color of all new objects of a given type:

1. Select an object type from the list.
2. Click **More Colors** to display the **Colors** dialog.
3. Select a color from the **Basic colors** palette or click **Define Custom Colors** to pick a different color.

   *Any Custom colors that you define are saved in the settings file (see page 71) and are available next time you use FeatureCAM.*

4. Click **OK** to close the **Colors** dialog.
5. Click **Apply** to apply the color to the selected object.
6. If you want to reset the selected object to the default (see page 131) color, select **Remove override** and click **Apply**.
7. Click **Done** to close the dialog.

**Update Op List**

By default, the **Operation List** is updated automatically each time you modify a part. For large parts with many operations, updating the **Operation List** can take a long time.

You can use the **Update Operation List** dialog to stop the **Operation List** from updating automatically every time you change the part.

To display the **Update Operation List** dialog, select **Options > Update Op List** from the menu.

In the **Update Operation List** dialog, select one of the following options:
• **Never update** — Select this option to turn off updating.

• **Always update** — Select this option to update the list automatically each time you change the part.

• **Ask before update** — Select this option to confirm before updating.

Click **Update Now** to update the **Operation List**.

### Snapping modes and grids

When you create geometry, you can enter point coordinates directly from the **Feature/Geometry Edit** bar.

![Feature/Geometry Edit bar](image)

This method is exact but not always convenient or feasible. You can also pick points directly on the screen with the mouse, although this method may be less precise.

To increase the drawing precision, FeatureCAM uses the snap and grid functionality. Grid is a set of evenly spaced dots that serve as a visual distance reference. Snap is a set of evenly spaced invisible hot spots that restrict the points that you can pick with your mouse, and therefore helps you position lines, points or shapes more precise. To control how the cursor snaps, use the **Snap Mode** (see page 15) toolbar. Snapping to grid is the most common mode, and enables you to snap to a point on a coordinate system that is laid out on the stock. The grid plane rotates with the viewing plane: in a front or back view, the grid is in the X plane; in a right or left view, the grid is in the Y plane; and in the top or bottom view, the grid is in the Z plane. The procedure below allows you to adjust the grid size.

**To adjust the grid:**

1. Select **Options > Snapping Grids** from the menu.
2 In the **Snapping Grids** dialog, enter the grid coordinates.

![Snapping Grids dialog](image)

*Setting grid spacing too fine can slow the display down.*

3 In the **Section** field enter the number of segments to divide the open geometry into when snapping to sections.

4 To have the grid redrawn during view shifts, select the **Grid resizes to match block in standard views** option.

5 Choose the **Grid Display** option:
   - **Always show** displays the grid, even if you have turned off snapping to grid.
   - **Always unshow** hides the grid even if you have turned on snapping to grid.
   - **Automatic** displays the grid only when you are snapping to grid.

6 Click **OK**.
File Options dialog

Select **Options > File Options** from the menu to display the **File Options** dialog:

The **File Options** dialog contains these tabs:
- **New Files** (see page 137)
- **Existing Files** (see page 138)
- **Database** (see page 140)
- **Browser** (see page 143)
**New Files tab**

You can use the **New Files** tab of the **File Options** dialog (see page 136) to specify the default options for new part documents.

Select the default **Setup type**, **Unit of Measure**, and **Initial stock dialog**. Optionally deselect **Always ask when a new document is created**.

**OK** — Click the **OK** button to save your settings and close the dialog.

**Cancel** — Click the **Cancel** button to close the dialog without saving any changes.

**Apply** — Click the **Apply** button to save your changes and keep the dialog open.

**Help** — Click the **Help** button to open this Help topic.
**Existing Files tab**

You can use the Existing Files tab of the File Options dialog (see page 136) to specify the Tools and Feed/Speed options for existing files and change the default File Location.

![Image of File Options dialog]

When a part is opened in FeatureCAM:

1. The name of the tool crib that was originally used to create the file is saved in the .fm file. If there is a tool crib with the same name in the current installation of FeatureCAM, that tool crib is made current. If it does not exist, the last opened crib is used.

2. All tools that were explicitly overridden in the part file are copied to the current crib. These tools are temporary and are available only when the current part is open.

3. A new crib is created that contains only tools used for that part. This crib contains tools that were overridden and all tools that were automatically selected. The crib is called `<filename>_tools_from_last_save`. This crib is temporary and is available only when this part is opened.

4. If *Use the tool crib saved with the part document* is selected, then this new crib is the active crib.

*If you select Use the tool crib saved with the part document the part is cut with exactly the same tools. We do not recommend this if you are going to make modifications to your part because this small tool crib probably does not have enough tools to cut additional features.*

Feed and speed tables are handled similarly.

1. When a file is saved, the feed/speed tables for the part’s material are saved with the file.
2 If **Use the F/S tables saved with the part document** is selected, then this new table is used as your feed/speed database.

3 If **Use the F/S tables from FeatureCAM’s F/S database** is selected, then the existing databases are used.

The **File Location** is the default directory for opening, saving, and importing files. If you specifically set the **File Location** to a particular folder, then FeatureCAM starts in that folder whenever you start up FeatureCAM in the future and FeatureCAM ignores the **Start In** folder that is listed in the shortcut to FeatureCAM. The starting folder is used when you first open, import, or save a part. But if you navigate to a new folder during your session, then the new folder is used for subsequent opens, imports, and saves. FeatureCAM uses the idea of a current working folder, which means that if sometime during your session you navigate to some other folder to open a file, then any future opens or saves in that session use the new folder. But the **File Location** folder is always used as the starting folder for the next time you run FeatureCAM.

**OK** — Click the **OK** button to save your settings and close the dialog.

**Cancel** — Click the **Cancel** button to close the dialog without saving any changes.

**Apply** — Click the **Apply** button to save your changes and keep the dialog open.

**Help** — Click the **Help** button to open this Help topic.
**Database tab**

You can use the Database tab of the File Options dialog (see page 136) to change the location of the database where tool cribs and feed/speed information is stored. FeatureCAM supports the sharing of the tool and feed/speed database on a network so that multiple computers can use the same tool cribs and feed/speed information.

Specify the location of the database:

**Local** — Select this option to use the database on your PC.

**MSAccess** (see page 141) — Select this option to use an MS Access shared network database. Click **Browse** and browse to the location of the shared network database.

**SQL** (see page 142) — Select this option to use an SQL Server network database. Select the **Server Name** and the **Database Name**. To use SQL authentication, select **SQL Server** in the **Authentication Mode** list and enter your **SQL Username** and **SQL Password**. If you use SQL authentication, the **Database Name** list only displays databases to which you have access.

**Enter a network path** — Enter a valid network path in order to create a Workgroup configuration (see page 1741).

**OK** — Click the **OK** button to save your settings and close the dialog.

**Cancel** — Click the **Cancel** button to close the dialog without saving any changes.
Apply — Click the Apply button to save your changes and keep the dialog open.

Help — Click the Help button to open this Help topic.

**MS Access shared network database (SND)**

The shared network database is provided as an empty MDB format database, created by Microsoft Access and accessed using the Microsoft Jet database driver.

The database must be set up properly before it can be used:

1. Establish a location on your network for the database and copy a blank database from the FeatureCAM DVD to that location.

2. Fill the database with default tooling and feed/speed information. Do this by running INITDB on any computer that has access to the database and point INITDB to the database.

3. Set the location of the database for each user using the Browse button during installation (see page 1837), or after installation on the Database tab (see page 140) of the File Options dialog.

To set up a network database on a 64-bit machine:

1. Download the 32-bit Microsoft Access Database driver from internet. The 32-bit driver needs to be used on both 32 and 64-bit machines.

2. If a 64-bit driver is already installed on the machine (for example, if you have 64-bit MS Office installed), you must uninstall it.

   ![Uninstalling the 64-bit driver and installing the 32-bit driver, could break 64-bit MS Access.]

3. Install the 32-bit driver you downloaded in step 1.

4. Open the folder C:\Windows\SysWOW64.

5. Find and run the file odbcadm32.exe. The ODBC Data Source Administrator dialog is displayed.

6. Click Add on the User DSN tab. The Create New Data Source dialog is displayed.

7. Scroll down, select Microsoft Access Driver (*.mdb, *.accdb) and click Finish. The ODBC Text Setup dialog is displayed.

8. For the Data Source Name option, enter MS Access Database and click OK. The database is displayed in the list of User Data Sources on the User DSN tab.

9. Restart FeatureCAM.
Network database configuration is user-based. If there are multiple users on the machine, each user must go through the process above and configure it.

**SQL shared network database (SND)**

You can use SQL Server for your network database. This gives better performance and reliability for your network database.

Microsoft SQL Server 2014 Express is a free edition of SQL Server that you may use to host your Delcam tools and materials database used by FeatureCAM. It is available in 32-bit and 64-bit editions and in these languages:

- Chinese (simplified)
- Chinese (traditional)
- English
- French
- German
- Italian
- Japanese
- Korean
- Portuguese (Brazil)
- Russian
- Spanish

When using Microsoft SQL Express to host your FeatureCAM tools and materials you need a server computer to host the SQL Server software and the tools/materials database. This server computer should be a different computer from the client workstations where users are running FeatureCAM.

*The database server can host tools and materials databases from different versions of FeatureCAM, or different parts of your organization.*

**Installation**

1. Pick a computer at your facility that you want to host the FeatureCAM tools and materials database. We’ll call this the *database server*. The database server must meet these criteria:
   - It must be running Microsoft Windows.
   - It must be connected to your network.
   - It must be able to run Microsoft SQL Server Express 2014.

2. Find out the hostname of the database server.
3 Download either the **Express (Database Only)** or **Express with Tools** from
(http://www.microsoft.com/en-gb/download/details.aspx?id=42299). If your **database server** is a 32-bit Windows, then you’ll need to download the 32-bit version of SQL Server Express. If 64-bit, then download the 64-bit version instead.

   *The bitness of your download must match the bitness of the database server computer, and has nothing to do with the bitness of your client workstations. You may download the language of your choice.*

4 Install Microsoft SQL Server Express on your database server.

5 From any client workstation using FeatureCAM 2016 R2, find **INITDB** in the Start menu and run it.

6 In the **Tool and Material Setup** dialog, select **On a SQL Server** and enter the hostname of the database server computer as the **Server Name**.

7 After entering the **Server Name**, you can select an existing database on the database server in the **Database Name** menu, or create a new one.

8 The first time you run INITDB you can do one of the following:
   - Initialize a new database with all the default tools.
   - Import tools from another database elsewhere on your network
   - Upgrade an existing database to the latest version of FeatureCAM and load it with all of the default tooling.

Subsequent client installations default to this choice.

**Browser tab**

You can use the **Browser** tab of the **File Options** dialog (see page 136) to change the default **Browser** home page.
To change the default **Browser** home page:

Enter the path to the HTML page you want as the default home page, or click **Browse** to browse to where it is saved.

Alternatively you can enter the full URL of any website, for example **http://www.delcam.com**.

**Default** — Click this button to reset the location to `C:\Program Files\Delcam\FeatureCAM\Browser\DefaultFeatureCAMHTMLPage.html`.

**Use Blank** — Click this button to use a blank page for the default **Browser** home page.

**OK** — Click the **OK** button to save your settings and close the dialog.

**Cancel** — Click the **Cancel** button to close the dialog without saving any changes.

**Apply** — Click the **Apply** button to save your changes and keep the dialog open.

**Help** — Click the **Help** button to open this Help topic.

You may need to restart FeatureCAM for the new **Browser** home page to take effect.

**Parametric modeling**

You can use equations in numeric fields in FeatureCAM dialogs. In parametric mode, the equation is displayed. With parametric modeling off, the result of the equation is displayed.

To enable parametric modeling, select **Parametric Modeling** in the **Options** menu.
Using add-ins

Add-ins are external scripts and applications that extend the functionality of FeatureCAM and enable you to perform custom tasks. Use the Macro Add-ins dialog to specify which add-in you want to make available for this installation of FeatureCAM.

To work with add-ins:

1. Select the Options > Add-Ins menu option. The Macro Add-ins dialog is displayed.

2. Select the check box of the add-in you want to use. If the add-in is not listed in the dialog, click Library to load it from the add-in library (see page 146), or click to load it from file. One or more buttons may be added to the Macro toolbar.

   Use the Customize Toolbars dialog (see page 28) to create or change an add-in's toolbar button.

3. Deselect the check boxes of the add-ins you do not want to use.

   To remove the selected add-in from the list, click .

4. If you want to view or edit an add-in, click . The IDE Editor (see page 147) is displayed.

5. Click OK to save your changes and close the dialog.
To run an add-in, click its button on the Macro toolbar. Alternatively, select the View > Run Basic Macro menu option, select the add-in in the Run Macro dialog, and then click Run.

UDF add-ins (see page 857) do not have a toolbar button, you use them from within the New Feature wizard.

**Add-in Library**

The Add-in Library dialog lists all the macros and programming examples that are available with your installation of FeatureCAM. Use it to view information about an add-in and to specify which add-ins are available in the Macro Add-ins dialog (see page 145).

To use the Add-in Library:

1. In the Macro Add-ins dialog, click the Library button. The Add-In Library dialog is displayed.

   ![Add-in Library Dialog](image)

   The left column lists all available macros, categorized by type; macros already available in the Macro Add-ins dialog are marked by a check ✔️ icon.

2. Choose one or more actions:
   - To show programming examples in the list, select the Include programming examples check box.
To search the list, type a string in the **Search** box. For example, to restrict the list to only those macros that include NCCode in their name, type **NCCode**.

To display the **Description** of a macro, select its entry in the list.

To add a macro to the **Macro Add-ins** dialog, select its entry in the list and click **Load**. The entry is marked by a plus **+** icon.

To remove a macro from the **Macro Add-ins** dialog, select its entry in the list and click **Unload**. The entry is marked by a cross **×** icon.

3 Click **OK** to save your changes and close the dialog. Loaded macros are listed in the **Macro Add-ins** dialog; the unloaded macros are removed.

### Using the Integrated Development Environment (IDE)

FeatureCAM includes an Integrated Development Environment (IDE) that you can use to edit BASIC programs. Use this dialog to view, edit, and write subroutines, functions, macros, and add-ins.

To view and edit the code of an existing add-in:

1 Deselect the check box of the macro in the **Macro Add-ins** (see page 145) dialog.

> **You cannot edit a macro that is in use; [run] is displayed in the title bar of the editor if the macro is running.**
2 Select the View > Basic IDE menu option. The IDE Editor is displayed.

3 In the IDE Editor, select File > Open. The Open dialog is displayed.

4 Select the add-in you want to view and click Open. The add-in opens in design mode, where you can read and edit the BASIC code. Comments are prefixed with a ' character.

Probing

The FeatureCAM Probing Add-in enables you to integrate probing capabilities with your machining processes. Although the details of adding probing capabilities depend on the machines and probes selected, the FeatureCAM Probing Add-in provides much of the infrastructure you need and establishes a solid foundation that you can extend.

With the FeatureCAM Probing Add-in, you add probing features in the same way that you add other features. Graphical markers show the location, orientation, and type of each probing feature added. As design work continues, you can edit probe feature parameters to match design refinements. Throughout the design cycle, you can use FeatureCAM's simulation capability to animate the probing toolpaths along with other tooling sequences. When you are satisfied with the design, FeatureCAM generates NC code that includes information needed to interface with probing and machine hardware. You can add probing features at any stage of the design process.

Load (see page 145) the StandardProbing2.dll add-in, and click the StandardProbing2 button in the Utilities toolbar to display the Probing Settings dialog.
The *StandardProbing.dll* add-in is the old version of this add-in. Only use this version if you need backwards compatibility with probing features created in earlier versions of FeatureCAM than 21.1.

**Default Tool Name** — By default, the add-in looks for a lollipop tool, but you can override that here. Enter a tool name.

**Show Overtravel** — Select this option to show a representation of the overtravel in the preview in the graphics window and during simulation.

**Remachine If** — Specify the condition under which the machine can attempt to remachine a feature. This sets the default for the Remachine If option for Test Abort/Continue/Remachine features. Enter **LT** (for *Less Than*) to remachine features that are too small such as for Hole features, or enter **GT** (for *Greater Than*) to remachine features that are too large, such as for Boss features.
To create a probing feature, open the New Feature wizard and select User. Click Next to open the New Feature - User defined feature page:

The probing features are divided into five types. You can create all of these features in milling and turn/mill documents.

- **Measure Boss/Bore** (see page 150)
- **Measure Boss/Bore 3 Pt** (see page 152)
- **Measure Corner** (see page 154)
- **Measure Single Surface** (see page 155)
- **Measure Web/Pocket** (see page 157)

**Measure Boss/Bore**

The **Measure Boss/Bore** probe feature probes outside (Boss) or inside (Bore) from one, two, or four directions. The location of the feature should be at the level of the top of the Boss or Bore feature. The **Clear Height** is above this location and the **Measure Height** is below, so the total movement along the **Probe Direction** is \((\text{Clear Height} + \text{Measure Height})\).

\[ \text{Total Movement} = \text{Clear Height} + \text{Measure Height} \]

**Boss 1 point:**

**Boss 2 point:**

**Boss 4 point:**
To edit the values on this page:

1. Select the attribute name in the **Dimension** column.
2. For **New Value**, enter, pick, or select a value.
3. Click the **Set** button to save the new value.

**Feature Type** — Select **Boss**, **Bore**, or **Obstructed Bore**.

**Diameter** — Enter or pick the diameter of the feature.

**Probe Direction** — Select the probe direction from the **New Value** menu from -X, +X, -Y, +Y, X, Y, or XY.

**Standoff Distance** — Enter or pick the distance from the start of the probe stroke to the nominal probe point.

**Overtravel** — Enter or pick the distance from the nominal probe point to the end of the probe stroke.

**Clear Height** — Enter or pick the length of the clear stroke.
**Measure Height** — Enter or pick the distance the probe descends below the feature location before probing.

Specify the update options to pass to XBUILD:

- **MCS** — Enter the Machine Coordinate System you want to update.
- **Tool** — Enter the tool number for the tool you want to update.
- **Store** — Specify whether to store the results.
- **Print** — Specify whether to print the results.

**Update Parameter** — Enter a value to be passed through to XBUILD.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

**Unset** — Click this button to return the value of the selected attribute to its default value.

**Measure Boss/Bore 3Pt**

The Boss/Bore 3Pt probe feature probes outside (Boss) or inside (Bore) from three directions specified by the operator. The location of the feature should be at the level of the top of the Boss or Bore feature. The **Clear Height** is above this location and the **Measure Height** is below, so the total movement along the **Probe Direction** is (**Clear Height** + **Measure Height**).

**Boss 3 point:**

**Bore 3 point:**

**Obstructed Bore 3 point:**
To edit the values on this page:

1. Select the attribute name in the **Dimension** column.
2. For **New Value**, enter, pick, or select a value.
3. Click the **Set** button to save the new value.

**Feature Type** — Select **Boss**, **Bore**, or **Obstructed Bore**.

**Diameter** — Enter or pick the diameter of the feature.

**Angle A** — Enter the number of degrees from the X axis to the probe direction.

**Angle B** — Enter the number of degrees from the X axis to the probe direction.

**Angle C** — Enter the number of degrees from the X axis to the probe direction.

**Standoff Distance** — Enter or pick the distance from the start of the probe stroke to the nominal probe point.

**Overtravel** — Enter or pick the distance from the nominal probe point to the end of the probe stroke.

**Clear Height** — Enter or pick the length of the clear stroke.

**Measure Height** — Enter or pick the distance the probe descends below the feature location before probing.

Specify the update options to pass to XBUILD:

- **MCS** — Enter the Machine Coordinate System you want to update.
- **Tool** — Enter the tool number for the tool you want to update.
- **Store** — Specify whether to store the results.
- **Print** — Specify whether to print the results.

  **Update Parameter** — Enter a value to be passed through to XBUILD.

  **Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

  **Unset** — Click this button to return the value of the selected attribute to its default value.

**Measure Corner**

The Measure Corner probe feature probes inside or outside a corner using 2 or 4 probe points. The location of the feature should be at the corner which is probed. The **Clear Height** is the distance above the corner at which to begin the probe stroke and the **Measure Height** is the distance below the surface at which the probe touches (relative to the **Probe Direction**). The **Standoff Distance** is the distance away from the edge on each side, at which the probe touches.

**Corner inside 2 point:**

**Corner inside 4 point:**

**Corner outside 2 point:**

**Corner outside 4 point:**

To edit the values on this page:

1. Select the attribute name in the **Dimension** column.
For **New Value**, enter, pick, or select a value.

3. Click the **Set** button to save the new value.

**Inside Outside** — Select **Inside** to probe an inside corner or **Outside** to probe an outside corner. Click Set to save.

**Probe Direction** — Select the probe direction from -X-Y, -X+Y, +X-Y, or +X+Y; and click **Set** to save.

**Points per Side** — Select the number of points to probe for each side of the corner, from 2 or 4.

**Standoff Distance** — Enter or pick the distance from the start of the probe stroke to the nominal probe point.

**Overtravel** — Enter or pick the distance from the nominal probe point to the end of the probe stroke.

**Clear Height** — Enter or pick the length of the clear stroke.

**Measure Height** — Enter or pick the distance the probe descends below the feature location before probing.

Specify the update options to pass to XBUILD:

- **MCS** — Enter the Machine Coordinate System you want to update.
- **Tool** — Enter the tool number for the tool you want to update.
- **Store** — Specify whether to store the results.
- **Print** — Specify whether to print the results.

**Update Parameter** — Enter a value to be passed through to XBUILD.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

**Unset** — Click this button to return the value of the selected attribute to its default value.

---

**Measure Single Surface**

The Single Surface probe feature probes a single point along the direction you specify. The location of the feature should be at the point where the probe is expected to touch the surface.

**Single surface**

**Top:**

**Side:**
To edit the values on this page:

1. Select the attribute name in the **Dimension** column.
2. For **New Value**, enter, pick, or select a value.
3. Click the **Set** button to save the new value.

**Probe Direction** — Select the probe direction from -X, +X, -Y, +Y, or -Z; and click **Set** to save.

**Standoff Distance** — Enter or pick the distance from the start of the probe stroke to the nominal probe point.

**Overtravel** — Enter or pick the distance from the nominal probe point to the end of the probe stroke.

**Clear Height** — Enter or pick the length of the clear stroke.

Specify the update options to pass to XBUILD:

- **MCS** — Enter the Machine Coordinate System you want to update.
- **Tool** — Enter the tool number for the tool you want to update.
- **Store** — Specify whether to store the results.
- **Print** — Specify whether to print the results.

**Update Parameter** — Enter a value to be passed through to XBUILD.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

1. **Unset** — Click this button to return the value of the selected attribute to its default value.
**Measure Web/Pocket**

The Measure Web/Pocket probe feature probes outside (Web) or inside (Pocket) along the direction you specify. The location of the feature should be at the level of the top of the Pocket. The **Clear Height** is above this location and the **Measure Height** is below, so the total movement along the **Probe Direction** is \((\text{Clear Height} + \text{Measure Height})\).

### Web:

### Pocket:

### Obstructed Pocket:

To edit the values on this page:

1. Select the attribute name in the **Dimension** column.
2. For **New Value**, enter, pick, or select a value.
3. Click the **Set** button to save the new value.

**Feature Type** — Select the feature type from **Web**, **Pocket**, or **Obstructed Pocket**. Click **Set** to save.

**Feature Width** — Enter or pick the width of the Web of Pocket. Click **Set** to save.

**Probe Direction** — Select the probe direction from \(-X, +X, -Y, +Y, X, Y, XY\)

**Standoff Distance** — Enter or pick the distance from the start of the probe stroke to the nominal probe point.

**Overtravel** — Enter or pick the distance from the nominal probe point to the end of the probe stroke.
Clear Height — Enter or pick the length of the clear stroke.

Measure Height — Enter or pick the distance the probe descends below the feature location before probing.

Specify the update options to pass to XBUILD:

- **MCS** — Enter the Machine Coordinate System you want to update.
- **Tool** — Enter the tool number for the tool you want to update.
- **Store** — Specify whether to store the results.
- **Print** — Specify whether to print the results.

Update Parameter — Enter a value to be passed through to XBUILD.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

**Unset** — Click this button to return the value of the selected attribute to its default value.

### Test Abort/Continue

![Image of the Test Abort/Continue window]

**Comment** — The comment is output in the NC code at the start of the test feature.

**Result Register** — This is where the result of your probing measurement is placed. For example, if you know that your machine uses register 510, enter **510** for this value.

**Continue Label** — Enter the place to jump to in the code if the program wants to continue after this test feature. You can create a new jump label using the **Test Jump Label** (see page 160) feature.
Abort Label — Enter the place to jump to in the code if the program wants to abort after this test feature. You can create a new jump label using the Test Jump Label (see page 160) feature.

Test/Abort/Continue/Remachine

![Screenshot of FeatureCAM's Test/Abort/Continue/Remachine feature]

Comment — The comment is output in the NC code at the start of the test feature.

Nominal Value — Enter the measurement that you are testing, for example the diameter of a Bore feature.

Nominal Value Register — This is the register that the machine uses to store the Nominal Value

Remachine Flag Register — This is the register where the machine stores the count for the number of times the feature is remachined.

Result Register — This is the register where the machine stores the result of the probing measurement.

Continue Label — This is the label to jump to, to continue machining.

Remachine Label — This is the label to jump to, to remachine the feature.

Temporary Register — This is used to store any temporary logic needed to process the decision-making feature.
**Test Jump Label**

![Test Jump Label](image)

**Comment** — The comment is output in the NC code at the start of the test feature.

**Remachine Flag Register** — This is the register where the machine stores the count for the number of times the feature is remachined.

**Decision-making example**

This example part has many features.

![Decision-making example](image)

After milling a Face feature, the first Bore feature ① is milled, then the second Bore feature ②, followed by the rest of the features. To avoid unnecessary machining time, you can probe Bore ① after it is cut and make a decision whether to continue, remachine it, or abort the program, depending on the results of the probe.
1 Create a Test Jump Label feature to start the process.

The NC code for this Test Jump Label feature reads:

```
(Test Jump Label PROBEOPER TEST_JUMP_LABEL1)
(Start Bore)
#101=0
N11
```

2 You want the decision-making process to start after the Face feature, so set the Base priority for the Test Jump Label to 2, and drag the feature to the correct place in the Part View.

3 Create a Measure Boss/Bore feature to probe Bore1 after it has been milled.

4 Create a Test Abort/Continue/Remachine feature to control what happens after the probing. For this example the following values are set:

   - **Nominal Value** 27.000
   - **Tolerance Value** 0.050
   - **Continue Label** 12
   - **Remachine Label** 11 (the value that was set for the starting Test Jump Label)
   - **Size Error** 13

5 Set the Base priority to 5 because you want this to be the 5th feature (after the Face feature, starting Test Jump Label, Bore1 feature, and Measure Boss/Bore feature).

The NC code for this Test Abort/Continue/Remachine feature reads:

```
(Test Abort/Continue/Remachine PROBEOPER TEST_ABORT_CONTINUE_REMACHINE1 )
(Remachining check conditional)
```
(Begin decision sequence)

\#102=27  (nominal value)

\#104=\[\#102-\#510\]  (signed difference of actual from nominal)

\#103=0.05  (tolerance value)

(Decision 1)

IF [ABS[\#104]<\#103] GOTO 12  (within tolerance case)

(Decision 2)

IF [\#104<0] GOTO 13

(Decision 1 and 2 skipped)

\[\#101=\#101+1\]

IF [\#101=1] GOTO 11 (run toolpath again)

DPRNT[Error: Second Required Remachining]

GOTO 99999

(Decision 2 result)

N13

DPRNT[Error: Too Big]

GOTO 99999

(Decision 1 result)

N12

N835 M5 M9

N840 G91 Z0

N845 M01

6  Create an Abort label at the end of the NC code:

7  Set its Base priority to a large number, such as 100.
The NC code for this Test Jump Label feature reads:

```
( Test Jump Label PROBEOPER TEST_JUMP_LABEL3 )
(Abort)
#101=0
N99999
```

**FeatureCAM to Vericut add-in**

VERICUT is an application from CGTech-UK, which enables you to simulate, fix problems in, and optimize CNC toolpaths for more efficient machining. Use the FeatureCAMToVericut.bas add-in to export milling, turning and turn/mill documents as VERICUT projects.

To export a document as a vericut project:

1. License the Vericut verification product component, and ensure it is activated in the Evaluation Options dialog.
2. Open the .fm file you want to export.
3. Load the FeatureCAMToVericut.dll add-in (see page 145).
4. In the Post Options (see page 1857) dialog, select the post processor you want to use.
5. Run a simulation to generate the NC code, and ensure the part has no errors.
6. Create a UCS in the part to use as the VERICUT machine Attach component.
   - If you want to export multiple setups, you must create an Attach UCS for each setup. If you do not want to export a setup from the part, deselect the setup’s check box in the Part View.
   - For 5-Axis parts, all the setups are combined, so you need to create only one Attach UCS.
7. If the part must be moved between setups during simulation, create a rotational UCS to describe the movement.
8. Click the FeatureCAMToVericut button in the Utilities toolbar. The FeatureCAM to VERICUT dialog is displayed.
9. Specify the export settings in the FeatureCAM to VERICUT dialog (see page 165).
10. Click Export and Open in Vericut to export the document and open it in VERICUT.

The following files and folders are created:
**.vcproject file** — VERICUT project file containing all of the exported data that can be opened in VERICUT.

**.mcd files** — G code.

**.tls files** — tool library.

**.stl files** — all solid models and stock are exported as .stl files. Names of the .stl files either reflect name of the solid in FeatureCAM or name of the model (i.e., stock.stl).

**Clamps** folder — contains .stl files representing fixture/clamp models.

**Holders** folder — contains .stl files representing tool holders.

**.fcvini file** — FeatureCAM to VERICUT project settings file containing data entered into the form during project export.

**.log file** — Export log. Exporting problems are logged in this file.

If you report a problem with the FeatureCAM to VERICUT add-in, include the .log file, FeatureCAM .fm file and .cnc files, VERICUT template, control and machine files.

If you do not have VERICUT installed, select **File > Export** in the **FeatureCAM to VERICUT** dialog to export the document without opening it in VERICUT.

You can now use VERICUT to simulate the part.
**FeatureCAM to VERICUT dialog**

Use the **FeatureCAM To VERICUT** dialog to specify the options for exporting milling or turn/mill documents as Vericut projects:

Select output directory — Enter the path of the folder in which you want to save the project, or click **Browse** to select it.

Exported project will be based upon this VERICUT template — Click **Browse** and select a .VcProject file to use as the Vericut template. The information is loaded from the template into the add-in, such as the Attach components and the machine subsystems. You must select a Vericut template before defining the export settings.

Select UCS to use for Cut Stock Transition — If the part must be moved between setups during simulation, select a UCS from the list to describe the movement.

Combine setups — Select this option to combine multiple setups into one. You must select this option for 5-Axis parts.

Settings for setup — Select the setup for which you want to edit the settings. Edit the settings for each setup you want to export.

Exported setup properties will be based upon this VERICUT template — To specify a separate Vericut template for each setup, click **Browse** and select a template file to use for the selected setup. You can use this if you are using a different machine for each setup. This does not affect the global project settings.
Export NC Program — Select this option to generate and export the NC program with the document. If this is deselected, VERICUT uses the NC program specified in the template, or you can specify the NC program manually in VERICUT.

Export Tools — Select this option to export information for all the tools used in the document. If this is deselected, VERICUT uses the tools specified in the template, or you can specify them manually in VERICUT. Click Tool Options to display the Tool Export Options dialog (see page 167), which you can use to specify the options for identifying tools in VERICUT.

Establish UCS — Click UCSs to display the UCSs dialog (see page 167), which you can use to specify attach UCSs and Attach components.

Export initial stock and target part (design) solids — Select Stock and Design to display the Stock and Design Export Settings dialog (see page 168), which you can use to specify options for exporting the stock and part solids.

Export solids as clamps (fixtures) — Click Fixtures to display the Fixture Export Options dialog (see page 170), which you can use to specify the clamps and fixtures to export.

Establish work offsets — Click Work Offsets to display the Add Work Offset dialog (see page 171), which you can use to specify VERICUT work G code offsets.

Machine turret information — Click this button to display the Machine Turret Info dialog (see page 172), which you can use to specify the turret options. This is only available for multi-turret parts.

Menu bar

The menu bar is displayed at the top of the FeatureCAM to VERICUT dialog. It contains the following options:

- **File menu:**
  - Export — Exports the document and generates the .vcproject file, without opening VERICUT. You can use this option if you do not have VERICUT installed on your machine.
  - Export and Open in VERICUT — Exports the document and generates the .vcproject file, opens VERICUT and loads the exported project.
  - Exit — Closes the FeatureCAM to VERICUT dialog.

- **Options menu:**
  - VERICUT — Displays the VERICUT Options dialog, which you can use to select the location of the VERICUT batch file.
• **Tool** — Displays the **Tool Export Options** dialog (see page 167), which you can use to specify the options for identifying tools in VERICUT.

• **Save settings** — Saves the dialog settings in the .fm file. This enables you to close the dialog, edit the part and open the dialog again without losing the settings you entered.

• **Help** menu:
  - **Help** — Displays the Help file.

**Tool Export Options dialog**

Use the **Tool Export Options** dialog to specify the options for identifying tools in VERICUT.

To use the **Tool Export Options** dialog:

1. Select an option to specify how you want VERICUT to recognize the tools. This option must match the settings of your cnc file's Tool change format. Select from:
   - **Tool numbers (positions in the crib)** — Use the tool’s position in the tool crib to identify the tools in VERICUT.
   - **Tool numbers and names** — Use the tool number and tool name to identify the tools in VERICUT.
   - **Tool IDs** — Use the **Tool ID** specified in the **Tool Mapping** dialog (see page 1575) to identify the tools in VERICUT.
   - **Prefix tool ids with turret identifier (for multi-turret parts)** — Select this option to include the turret identifier before the tool id for multi-turret parts. This option is not available for Milling parts.

2. Click **OK** to close the dialog and save your changes.

**UCSs dialog**

Use the **UCSs** dialog to specify an attach point and Attach component.

The dialog displays different options for Milling and Turning or Turn/Mill parts.
Milling parts:

To use the UCSs dialog:

1. In the Select UCS to use as an attach point list, select the coordinate system to represent the position and orientation of the stock, design, fixture and clamp models on the machine in VERICUT.

2. In the Select component to attach UCSs to list, select a component to represent the Attach component of the machine in VERICUT.

3. For turning and Turn/Mill documents, select an attach UCS and Attach component for the sub spindle.

4. Click OK to close the dialog and save your changes.

Turning and Turn/Mill parts:

To use the UCSs dialog:

1. In the Select UCS to use as an attach point list, select the coordinate system to represent the position and orientation of the stock, design, fixture and clamp models on the machine in VERICUT.

2. In the Select component to attach UCSs to list, select a component to represent the Attach component of the machine in VERICUT.

3. For turning and Turn/Mill documents, select an attach UCS and Attach component for the sub spindle.

4. Click OK to close the dialog and save your changes.

Stock and Design Export Settings

Use the Stock and Design Export Settings dialog, which you can use to specify the options for exporting the stock and part solids.

The dialog displays different options for Milling and Turning or Turn/Mill parts.
Milling parts:

To use the Stock and Design Export Settings dialog:

1. To export the stock as an .stl file and use it as a stock model in VERICUT:
   - a. Select **Export Stock solid (.stl file)**.
   - b. In the **Attach component** list, select a component to represent the stock Attach component in VERICUT.
   - c. For Turn/Mill parts, select Attach components for the **Main spindle** and **Sub spindle**.

2. To export a part solid as an .stl file and use it as a Design solid in VERICUT:
   - a. Select **Export Design/Part solid (.stl file)**.
   - b. In the **Solid name** list, select the solid you want to export.
   - c. In the **Attach component**, select a component to represent the design Attach component in VERICUT.
   - d. For Turn/Mill parts, select Attach components for the **Main spindle** and **Sub spindle**.

3. Click **OK** to close the dialog and save your changes.
**Fixture Export Options dialog**

Use the **Fixture Export Options** dialog to specify the clamps and fixtures to export.

The dialog displays different options for Milling and Turning or Turn/Mill parts.

**Milling parts:**

![Fixture Export Options dialog for Milling parts](image)

**Turning and Turn/Mill parts:**

![Fixture Export Options dialog for Turning and Turn/Mill parts](image)

To use the **Fixture Export Options** dialog:

1. In the **Solid** list, find the solids you want to export.
2. In the **Export** list, select **Yes** next to the solids you want to export, and select **No** next to the solids you do not want to export.
To select multiple solids quickly, select the solids you want to export in FeatureCAM, then click **Select solids selected in the product** to change the **Export** value for all selected solids to **Yes**.

Solids which are marked as clamps in FeatureCAM have **Yes** selected in the **Export** list automatically.

3 In the **Attach to** list, select the component you want to use as the fixture Attach component in VERICUT.

To apply an Attach component to multiple solids, select an Attach component in the **Attach solids selected in the list to** list and click **Apply**.

4 For turning parts, in the **Spindle** list select **Main** or **Sub** to specify the spindle.

To specify the spindle for multiple solids, select a spindle in the **Solids selected in the list are entities of** list and click **Apply**.

5 Click **OK** to close the dialog and save your changes.

**Add Work Offset dialog**

Use the **Add Work Offset** dialog to specify VERICUT work G code offsets, which determines where the G code touch-off points are.

The currently defined work offsets are displayed in the **Work offsets** section.

To use the **Add Work Offset** dialog:

1 In the **Offset Name** list, select an option to determine the type of offset table to determine the **Table name**. Select from:

   - **Work Offsets** — Store the work coordinate system offset (fixture offset) values.
- **Program Zero** — Specify the programmed zero location of a G code NC program file, accounting for tool length compensation.

2 If **Work offsets** is selected, enter the corresponding fixture offset in the **Register** field (such as 54 for G54, or 55 for G55)

3 In the **Subsystem** field, enter the machine subsystem ID defined in the VERICUT machine file.

4 In the **'From' Component** list, select the VERICUT machine component that represents the From point for determining the program zero offset.

5 In the **'To' CSYS Origin** list, select the FeatureCAM UCS that represents the NC program origin. This is usually the name of the setup.

6 To:
   - create a new offset using the values you entered, click **Add new offset**.
   - overwrite the selected offset with the values you entered, click **Modify selected offset**.
   - delete the selected offset, click **Delete selected offset**.

7 Click **OK** to close the dialog and save your changes.

**Machine Turret Info dialog**

Use the **Machine Turret Info** dialog to specify the turret options. This dialog is only available for multi-turret parts.

To specify the turret options:

1 For each item in the **Turret/Spindle** list:
   - a In the **Type** list, select the turret type.
   - b In the **Subsystem** list, select the machine subsystem ID defined in the VERICUT machine file.

2 Click **OK** to close the dialog and save your changes.
FeatureCAM to NCSIMUL add-in

NCSIMUL machine is an application from Spring Technologies, which enables you to simulate, fix, and optimize CNC tool paths. Use the FeatureCAMToNCSIMUL.dll add-in to export milling or turning documents to NCSIMUL projects.

To export a document to an NCSIMUL project:

1. Install NCSIMUL on your computer and the NCSIMUL tool for reading FeatureCAM files.
2. Install the FeatureCAMToNCSIMUL.dll add-in. (see page 145)
3. In the milling or turn/mill document, run the simulation and generate the NC code. Fix any errors.
4. Click the FeatureCAM to NCSIMUL button on the Macros toolbar. The FeatureCAM to NCSIMUL dialog is displayed.
5. Use the FeatureCAM to NCSIMUL dialog to set the options for exporting your project.

The options displayed in the dialog depend on the type of part you are working with:

- Non-indexed part:
- 4-axis indexed part:

![FeatureCAM to NCSIMUL window for 4-axis indexed part](image)

- 5-axis indexed part:

![FeatureCAM to NCSIMUL window for 5-axis indexed part](image)

- **Select output directory** — By default, the NCSIMUL file is saved in the document folder. To save the file in a different folder, enter the location and name of the folder, or select **Browse** to select it.

- **NCSIMUL machine file** — Enter the path to the NCSIMUL machine file, or click **Browse** to select it.

- **Select solids to be exported as clamps** — Select any solids you want to export.
Post uses to identify tool — Select Tool number or Tool ID to specify how tools are identified in the post file.

Machine Zero offset from setup UCS — Enter the distance between the Setup UCS and the machine table 0.

Select Setup — For non-indexed parts, select the Setup you want to export from the menu.

Select whether post uses — For 5-axis indexed parts with the NC Code Reference Point set to each Setup’s own fixture, select an option to specify whether the post supports Individual fixture offset or DATUM shift and rotation.

Click Export to export the file. FeatureCAM simulates the part and exports the program files. When the export is finished, a message lists the files and their locations.

NCSIMUL always creates a separate project for each Setup in the document. If the Generate single program option is enabled, the add-in disables the option, creates the program files, and then returns the option to its original state.
FeatureCAM to CAMplete TruePath add-in

CAMplete TruePath is an application that you can use to analyze, modify, optimize, simulate and post 5-Axis toolpaths.

To export a document to use with CAMplete TruePath:
1 License the CAMplete verification product component, and ensure it is selected in the Evaluation Options dialog.
2 In the Post Options dialog, select the CAMplete_TruePath.cnc post in the /Posts/Mill/5-Axis folder.
3 Load the FeatureCAMToCAMplete.dll add-in (see page 145).
4 In the Utilities toolbar, click FeatureCAMToCAMplete.
   The FeatureCAM to CAMplete dialog is displayed.

5 Click Browse and select where you want to save the exported files.
6 In the Select solids to be exported as clamps list, select solids you want to export as clamps and fixtures.
   You can export multiple clamp and fixture solids.
To mark multiple solids as clamps, select them in the graphics window and click **Select solids selected in the part**.

7 Click **Export Part solid** to export a solid to use as the part in CAMplete. You can export only one part solid.

- To export a solid in the document as an .stl file, select **Select solid to export as part**, and select a solid from the list.
- To use an .stl file, select **Select existing .stl file** and click **Browse** and select it in the **Select part .stl file** document.

   *If want to machine a part made of multiple solids, you can use FeatureCAM’s solid modelling to combine (see page 475) them.*

8 Select whether you want the post to use the **Tool number** or **Tool ID** to identify tools.

9 Under **Offset from the setup UCS to pallet**, enter the offset distances in the X, Y and Z directions.

10 Click **Preview** to display a point in the graphics window which shows the offset from the setup UCS.

11 Click **Export** to export the document and close the dialog. The files are created in the selected output directory.

**Custom setup sheets add-in**

You can create custom setup sheets for milling, turning, and turn/mill parts using the **SetupSheet.dll** add-in.

The add-in extracts information from the **Part Documentation** (see page 70) dialog and enables you to take images for each Setup. You can use setup sheets to give information to the machine operator about the manufacturing, tooling, and toolpaths of a part.

To load and run the add-in:

1 Select **Options > Add-Ins** from the menu. The **Macro Add-ins** dialog is displayed.

2 Click the **Browse** button and browse to the **SetupSheet.dll** file. If you installed FeatureCAM in the default location, the file is at `C:\Program Files\Delcam\FeatureCAM\Addins\SetupSheet\SetupSheet.dll`.

3 In the **Macro Add-ins** dialog, in the **Add-In Files** list, ensure that the check box to the left of the **SetupSheet.dll** file address is selected.

4 Click **OK**.
The Utilities toolbar is displayed, containing the SetupSheet button.

5 Click the SetupSheet button to run the add-in.

The Setup Sheet Options dialog is displayed:

```
<table>
<thead>
<tr>
<th>Title</th>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>Part/Drawing No.</td>
</tr>
<tr>
<td>Note 1</td>
<td>Revision</td>
</tr>
<tr>
<td>Note 2</td>
<td>This information is copied from the File &gt; Part Documentation dialog and you can edit it there.</td>
</tr>
<tr>
<td>Comments</td>
<td></td>
</tr>
</tbody>
</table>
```

The Title, Author, Note 1, Note 2, Company, Part/Drawing No., Revision, and Comments values are copied from the Documentation (see page 70) tab of the Part Documentation dialog and you can edit them there.

You can use this dialog to capture an image for each Setup in the current document, as well as an image to represent the whole document.

To capture an image for a Setup, select the Setup name in the Setups list and click the Capture Setup Image button to capture the current contents of the graphics window.

💡 First run a simulation only for the Setup you want to capture by deselecting other Setups in the Part View; then adjust the view to show a good orientation of the Setup, and open the Setup Sheet Options dialog to capture the image in the graphics window.
You must use a template to create the setup sheets. Click the **Browse Template** button to find and set the template you want to use. There is a template, `SetupSheetTemplate.html`, in the `Addins\SetupSheet` folder.

To create the setup sheets, click the **Create Setup Sheets** button. The part is simulated to generate toolpaths and the setup sheet is displayed in your web browser. You can save the HTML file from your browser.

To open the setup sheet in the FeatureCAM Browser, select **File > Open** from the menu and browse to the setup sheet HTML file.

**Turn-curve tolerance add-in**

The TurnCurveTolerance.bas add-in enables you to tolerance turned or internal bore features according to ISO 282-2 standards or custom tolerances specified in design documents. Use it to quickly resize features without redrawing the curve.

To adjust a curve:

1. Install the **TurnCurveTolerance.bas** add-in. (see page 145)
2. Select the turning or internal bore feature in the **Part View**.
3. In the **Macros** toolbar, click the add-in's button. The **Fillet and Chamfer Limit** dialog is displayed.

4. Enter the size of the largest fillet or chamfer of the feature:
   - Diagonals and arcs shorter than or equal to this value are treated as chamfers and fillets. When neighboring segments are adjusted, the add-in translates them without changing their size or orientation.
   - Diagonals and arcs longer than this value are treated as stationary parts of the curve. They affect the tolerance limits of adjacent segments and are not translated.
5 Click OK. The Tolerance of Turned Segments dialog is displayed, and the vertical and horizontal segments are labeled in the Graphic View.

![Tolerance of Turned Segments dialog](image)

6 Adjust the labels:
   - To change the label size, enter a new value in the Set text size box, and click Set.
   - To label only the currently selected segment, deselect the Segment labels on check box.

7 In the Segments list, select the segment you want to adjust. The segment and its label are displayed in red.

8 Specify the adjustment for the segment:
   - To calculate the adjustment from specified tolerances, select the Upper tolerance - Lower tolerance option and enter the tolerance values.
   - To calculate the adjustment from standard tolerances, select the Upper tolerance - Lower tolerance option, and select the tolerance in the ISO 286-2 list.
- To specify the adjustment, select **Net tolerance**, and enter the distance by which you want to move the segment.

9 Click **Apply Tolerance**. The adjustment for the segment is displayed below the button.

10 Click **OK** to apply your changes and close the dialog.

FeatureCAM creates a new curve and feature, and displays the results in the Graphic window. For example:
Mill-curve tolerance add-in

You can use the MillCurveTolerance.bas add-in to resize milling features quickly to bring them into tolerance, without redrawing the feature curve.

To use the Mill-curve tolerance add-in:

1. Install the MillCurveTolerance.bas add-in.
2. Select a milling feature created from a curve in the XY plane.
3. In the Utilities toolbar, click the Tolerance button.

The Tolerance of Line Segments dialog is displayed, and the vertical and horizontal segments are labeled in the graphics window.

4. Adjust the labels:
   - To change the label size, enter a new value in the Set text size box, and click Set.
   - To label only the currently selected segment, deselect the Segment labels on check box.
5 In the Segments list, select the segment you want to adjust. The segment and its label are displayed in red in the graphics window, for example:

6 Specify the adjustment for the segment:
   - To calculate the adjustment from specified tolerances, select the Upper tolerance - Lower tolerance option and enter the tolerance values.
   - To calculate the adjustment from standard tolerances, select the Upper tolerance - Lower tolerance option, and select the tolerances in the ISO 286-2 list.
   - To specify the adjustment, select Net tolerance, and enter the distance by which you want to move the segment.

7 Click Apply Tolerance. The adjustment for the segment is displayed below the button.

8 Click OK to apply your changes and close the dialog.

FeatureCAM creates a new curve and feature, and displays the results in the graphics window, for example:
Notes

- You can use this only for features created from curves; Bosses, Chamfers, Grooves, Pockets, Rounds, and Sides.
- If a feature is created from multiple curves, only the first curve is used.
- Open and closed curves work the same.
- If you enter a tolerance that would break the feature, a message is displayed explaining the maximum tolerance you can enter for a segment.
- Non-vertical and non-horizontal lines and curves are translated to accommodate the tolerance but not altered.

**Vortex Milling Calculator add-in**

You can use the Vortex Milling Calculator to optimize a vortex toolpath to reduce the machining time while maintaining the cutting load on the tool.

You can find the maximum chip thickness based on tooling catalog input values, and calculate the feedrate and stepover required to maintain a specified maximum chip thickness.

To use the Vortex Milling Calculator:

1. Install the `VortexMillingCalculator.bas` add-in. (see page 145)
2. Select a feature for which you want to optimize a vortex toolpath.
3. In the Utilities toolbar, click `VortexMillingCalculator`.
The Vortex Milling Calculator dialog is displayed.

The tool information and the toolpath values are extracted from the document and displayed in the dialog.

4 In the MATERIAL list, select the stock material you are machining.

5 To calculate the maximum chip thickness, specify the INPUT VARIABLES and click Calculate.
   - Feedrate and Feed/Tooth — This is the Feed value on the F/S tab of the Feature Properties dialog.
   - Speed and Surface Speed — This is the Speed value on the F/S tab of the Feature Properties dialog.
   - Stepover — This is the Distance between cuts value on the Stepovers tab of the Feature Properties dialog.
   - Stepdown — This is the Z increment value on the Milling tab of the Feature Properties dialog.

A message is displayed that tells you the maximum chip thickness will be recalculated.
6 To apply an upper limit when calculating the maximum chip thickness, enter a **Maximum Chip Thickness**, click **Set Max**, and select **Do not exceed**. The calculated **Maximum Chip Thickness** will not exceed this value.

7 To calculate the values required to maintain a maximum chip thickness, specify a **Maximum Chip Thickness** and click **Calculate**. A message is displayed that tells you the new maximum chip thickness. Select whether you want to update the feedrate or stepover to maintain the new maximum chip thickness.

8 Click **Apply** to update the feature with the new values and update the toolpath time.

9 Click **OK** to close the dialog.

### Turning head tool holders

Turning-head tool holders are supported in FeatureCAM, which enable you to perform turning and boring operations on a milling machine.

For example, in the image below the piece is machined by the tool rotating around the stock.

![Turning head tool holder](image)

This requires the **Advanced Turn/Mill (MTT)** module, and it requires a modified Machine Design file (see page 1936) and CNC file to facilitate the U axis movement.

4-Axis indexing is supported, but 5-Axis positioning is not.

To create a turning head feature:

1. Create a Setup over the center of rotation of the turning head, so that the tool will rotate about the Setup Z axis.

2. Create a curve in the XZ plane that defines the profile of the turned shape.
3 Load the TurningHeadCS.dll add-in using the Macro Add-ins dialog.

4 In the New Feature wizard, under From Feature, select User and click Next.

The User defined feature page is displayed.

5 In the Registered features list, under Macro Add-ins, select Turn Head, and click Next.

The Curves page is displayed.

6 Select the curve in the graphics window and click Add from selected items.

7 Click Next to display the Location page.

8 Click Next to display the User defined feature page.

9 Specify the parameters to define the feature. To change a parameter, select the parameter name, select an option in the New Value list, then click Set.

Profile — Select a curve to define the turning feature profile.
**Toolpath Type** — Select whether you want to create an Inside Diameter or Outside Diameter feature.

**Rough Stock Curve** — Select the curve that defines the toolpath boundary for the feature. Leave this unset to machine to the stock boundary.

**Rough Pass** — Select True to include a rough operation.

**Finish Pass** — Select True to include a finish operation.

**Cycle Type** — Select the cycle type.

In a **Turn** cycle, the roughing tool feeds along the Z axis while stepping down the X axis.

In a **Face** cycle, the roughing tool feeds from the outside of the part to the center while stepping down in the negative Z direction.

**Cut Direction** — Select the direction along the Z axis you want to cut the feature.

**U Axis Sign** — Select which direction along the U axis the tool is cutting.

10 Click **Finish** to create the Turn Head feature and close the dialog.

11 When using two tools on the turning head, create a separate feature for each tool with opposite **U Axis Sign** selected.

12 Use the **Tool Block Selection** dialog (see page 1579) to select the tool block solid as a tool block for the turning tools.

13 You may need to adjust the **Start point** and **End point** on the **Turning** tab of the **Turn Head Properties** dialog for each operation to ensure the tool does not collide with the part at the start and end of the toolpath.

14 Run a simulation to check for collisions.
The rotation of the tool is not displayed in the simulation, but the tool is checked for collisions and gouges. For example, in this image the tool has gouged with the clamp at ①, and another gouge is displayed at ②.

**Nesting add-in**

Use the Nesting add-in to nest multiple parts and machine them from a single stock using PowerSHAPE's nesting tool.

You must have PowerSHAPE open to use the add-in, and you can only nest parts which have a solid model.

To use the Nesting add-in:
1. Load the **Nesting.bas** add-in.
2. On the **Utilities** toolbar, click **Nesting**.
The **Nesting To FeatureCAM** dialog is displayed.

3 In the **Stock** list, select the block in which you want to nest the parts.

Select an existing block to nest additional parts in a block you created previously, or select **New Block** to start a new block.

4 In the fields around the stock diagram, enter the dimensions of the block in which you want to nest the parts.

5 Enter the **Distance between parts** to specify the minimum distance you want to leave between the nested parts on the block.

6 Enter a **Text height** to specify the height of the text label on each part.

7 Click **Add** and use the **Open** dialog to select the parts you want to nest.

8 Enter the **Quantity** to specify how many duplicates of each part you want to nest in the block.

9 Enter the **Priority** to determine which parts to nest first. The parts with lowest **Priority** are nested first. For parts with the same **Priority**, the largest parts are nested first.
10 Enter the Rotation increment to specify the smallest increment by which the part can be rotated when nesting. You may be able to fit more parts in a block by reducing the Rotation increment.

11 To remove a part from the dialog, select the row and click Delete.

12 Click OK to nest the parts.

FeatureCAM opens each file and puts all the features in each file into a group, then adds the features to a new FM file. The solids are sent to PowerSHAPE and nested using PowerSHAPE's nesting tool.

When the nesting is completed in PowerSHAPE, a message dialog is displayed telling you to modify the positions of the parts in PowerSHAPE if necessary.

13 Modify the position of the parts in POWERSHAPE, then click OK to close the message dialog.

The positions of the parts are updated in FeatureCAM.

A message dialog is displayed asking if you want to save the stock.

14 Click Yes to run a 3D simulation and save the stock. This enables you to nest additional parts in this block later.

You can select saved stocks in the Stock list in the Nesting To FeatureCAM dialog to nest additional parts in a saved stock.

A message dialog is displayed saying the nesting is completed.

15 Click OK to close the dialog.

**Import vise add-in**

Use the Import Vise add-in to import vises into FeatureCAM for 3D simulation and gouge checking.

To import a vise into FeatureCAM:

1 Load the Import_Vise.bas add-in.

2 On the Utilities toolbar, click Import_Vise.
The **Import Vise** dialog is displayed.

3. In the **Vise** list, select the vise you want to import.

   A preview of the vise is displayed in the dialog.

**Vises**

1. Select an option in the **Part position in vise** list to specify how to align the part in the vise.

2. Under **Part along**, select the axis that you want to be perpendicular to the jaws to specify the orientation of the part in the vise.

3. Under **X offset from position**, enter the offset of the part along the axis parallel to the jaws. You can enter a negative value.

   For example, select a **Part position in vise** of **Left** and enter a **X offset from position** of **-1** to extend the part by 1 inch past the left edge of the jaws.

4. Under **Amount of part held**, enter the height at which to hold the part in the vise. If this value is set to 0 it is ignored and the part is held at the bottom of the vise. This option is unavailable when using parallels.

5. Under **Jaws position**, select how you want to position the jaws to hold the part.

   For **Selected Solid Faces**, **Selected Surfaces**, and **Selected geometry**, select items in the graphics window.

6. For vises with multiple holding positions, select **Alternative holding** to use the alternative holding position.

7. To add parallels to raise the part in the vise, select **Add parallels** and select the **Parallels dimensions** from the list.

   To add a custom parallel:
a Select **Custom** in the **Parallels dimensions** list.

b In the **Parallels dimensions** list, select **Custom**.

c Select **Metric** to enter the dimensions in cm, or deselect it to enter the dimensions in inches.

d Enter the width (W), length (L), and thickness (T) dimensions.

e Select **Save to library** to add your custom parallel to the **Parallel dimensions** list.

8 Click **Import** to import the vise.

**Turning chucks**

1 Under **Part along**, select the axis about which the chuck rotates to specify the orientation of the part in the vise.

2 Under **Z offset from position**, enter an offset to raise or lower the part in the jaws.

3 Under **Part length from Jaws Faces**, enter the length of part you want to extend past the top of the jaws.

4 Under **Jaws position**, select how you want the jaws to hold the part.
   For **Selected Solid Faces**, select solid faces in the graphics window.

5 Select the **Jaws types** you want to use.

6 Click **Import** to import the vise.

**Setup Activate add-in**

You may find the Setup Activate add-in (see page 194) useful when using the Import vise add-in. You can use the Setup Activate add-in to automatically hide vise solids associated with the non-active setup.
Setup Activate add-in

You can use the SetupActivate.bas add-in to automatically hide unnecessary solids when switching between setups.

To use the Setup Activate add-in:

1. Load the SetupActivate.bas add-in (see page 145) using the Macro Add-ins dialog.

2. Add the name of a setup to the start of a solid's name, such as setup1_solid1.

3. Select a setup in the Part View.
   Solids which have this setup at the start of their name are displayed.
   Solids which have another setup at the start of their name are hidden.

Errors and warnings

Because only one stage is displayed at a time, an error may occur in another stage in the document, but does not appear in the operation sheet currently displayed.

FeatureCAM does not switch stages to take you to the first error.

A single problem often results in multiple errors. When multiple errors occur, you should fix the tooling errors and regenerate the toolpaths. In many cases, the other errors are resolved.

Warnings are also shown in the operation sheet, but do not prevent FeatureCAM from continuing to generate toolpaths. FeatureCAM does not draw attention to the warnings it gives because the tool path generation was successful.

Manufacturing errors occur when FeatureCAM is unable to complete the toolpath generation for a part. When an error occurs, you cannot run any simulation, post to NC code, or save NC code. Errors are displayed between lines of asterisks (*) in the Operation Details sheet listed after the operation in which the error occurred. Errors are displayed in the Op List tab with a red exclamation point ! icon in the left margin and warnings are marked with exclamation point on a yellow triangle icon.

If an error is detected during toolpath generation, the Code generation failed dialog is displayed.
If you click **Yes** in this dialog, the first error in the operations list is highlighted. If you click **No**, the errors still appear in the operations list, but you must explicitly ask to step through the errors by clicking **Next Error**.

If an error occurs during toolpath generation, three error buttons display in a separate toolbar in the left-hand corner of the window to enable you to read and fix the errors. The buttons perform the following functions:

- Selects the next error in the operations list.
- Selects the previous error in the operations list.
- Provides options for fixing the error that is selected.

If you click **Hint** while an error is selected in the **Manufacturing Operations Sheet**, a series of dialogs appears to help you fix the error.

**Troubleshooting 3D toolpaths**

- Troubleshooting Z level roughing (see page 760)
- Troubleshooting isoline milling (see page 772)
- Troubleshooting projection milling methods (see page 747)
- Troubleshooting Z level finishing (see page 771)

### Warning codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Cause</th>
<th>Suggested Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCT02W</td>
<td>Bottoming tap required for this feature.</td>
<td>1 Accept 2 Modify feature</td>
</tr>
</tbody>
</table>
| TPAFITW | Arc fitting is incompatible with:  
- 3D cutter comp  
- 5-axis non-ball-end tool  
- Normal to surface lead-in  
- Z level finish scallop stepover  
- Steep and shallow finishing  | Use linear output options.             |
<p>| TPL01W  | <strong>Start point</strong> attribute not set for canned cycle for rough or finish pass.             | Set <strong>Start point</strong> attribute.         |</p>
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>TPL02W</td>
<td>Improperly defined stock curve. Stock curve is a point or is undefined somehow.</td>
<td>Define stock curve.</td>
</tr>
<tr>
<td>TPL03W</td>
<td>Profile lies outside stock boundary. No feature curve defined or feature curve does not overlap with stock curve.</td>
<td>Define feature curve.</td>
</tr>
<tr>
<td>TPL04W</td>
<td>Ignoring improperly specified start point.</td>
<td>Change start point.</td>
</tr>
<tr>
<td>TPL05W</td>
<td>Ignoring improperly specified end point.</td>
<td>Change end point.</td>
</tr>
<tr>
<td>TPL06W</td>
<td>Ignoring Tool Nose Radius Compensation. Cutter comp is enabled for the feature but disabled in Post Options (see page 1857).</td>
<td>Select <strong>Enable Cut Comp</strong> in Post Options (see page 1857).</td>
</tr>
<tr>
<td>TPL07W</td>
<td>Undercut detected. Unable to completely rough feature with this tool.</td>
<td></td>
</tr>
<tr>
<td>TPL08W</td>
<td>Undercut detected. Unable to completely finish feature with this tool. Operation did not completely cut the feature, some material remains.</td>
<td></td>
</tr>
<tr>
<td>TPP01W</td>
<td>Can’t extend ends of toolpath. The lead in/out distances cannot be applied to an open toolpath, because it would result in a gouge. No lead- in/out moves are applied to the toolpath. Note this can result in a posting error if you are using cutter compensation.</td>
<td><strong>1</strong> Use smaller endmill. <strong>2</strong> Change lead distances or angles (see page 985). <strong>3</strong> Set a plunge point (see page 994).</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Solutions</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| TPP02W  | Can’t find ramp-in arc. The ramp-in arc cannot be applied to a closed toolpath, because it would result in a gouge. No ramp-in moves are applied to the toolpath. | 1. Use smaller endmill. See How to change tools.  
2. Change stepovers (see page 985).  
3. Set a plunge point (see page 994). |
| TPP03W  | Can’t find ramp-out arc. The ramp-out arc cannot be applied to a closed toolpath, because it would result in a gouge. No ramp-out moves are applied to the toolpath. | 1. Use smaller endmill. See How to change tools.  
2. Change stepovers (see page 985).  
3. Set a plunge point (see page 994). |
| TSD02W  | Could not find a spiral tool, substituting with a gun style.                                       | Do one of:  
- Accept  
- Copy tool from another crib.  
- Create a tool.  
- Override with a different tool.  
- Select a different crib.  
- Modify feature. |
| TSD12W  | Could not find a plug tool, substituting a bottoming tap                                             | Do one of:  
- Accept  
- Copy tool from another crib.  
- Create a tool.  
- Override with a different tool.  
- Select a different crib.  
- Modify feature. |
<p>| TSH11W  | Tool must be ground before use, slotting operation.                                                 | Grind tool.                                                                                   |</p>
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>TSI02W</td>
<td>This tool must be adjusted by operator for correct diameter.</td>
<td>Adjust diameter prior to running part.</td>
</tr>
<tr>
<td>TSJ11W</td>
<td>Tool must be ground before use, zigzag operation.</td>
<td>Grind tool.</td>
</tr>
<tr>
<td>TSK03W</td>
<td>Tool can’t cut round.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Override with a different tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Copy tool from another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Modify feature.</td>
</tr>
<tr>
<td>TSK11W</td>
<td>Tool must be ground before use, profile milling operation.</td>
<td>Grind tool.</td>
</tr>
<tr>
<td>TSK12W</td>
<td>Chamfer tool cannot cut chamfer.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Override with a different tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Copy tool from another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Modify feature.</td>
</tr>
<tr>
<td>TSK22W</td>
<td>Counter sink tool cannot cut chamfer</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Override with a different tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Copy tool from another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Modify feature.</td>
</tr>
<tr>
<td>TSK42W</td>
<td>Facemill cannot cut Chamfer. The angle of the chamfered Face Mill tool is not suitable for cutting the Chamfer feature.</td>
<td>Select a Face Mill tool with a suitable chamfer angle.</td>
</tr>
</tbody>
</table>
### Error codes

*If an error code is suffixed SE, it is a soft error. A soft error does not prevent you from running a simulation and generating NC code, but it does prevent you saving the NC code (the File > Save NC menu option is unavailable). You should not use NC code containing soft errors.*

<table>
<thead>
<tr>
<th>Code</th>
<th>Cause</th>
<th>Suggested Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCT01</td>
<td>Feature was unable to be decomposed.</td>
<td>Fix tool selection error.</td>
</tr>
<tr>
<td>FS001</td>
<td>Feed/speed table not found for the given operation.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Add a new feed/speed table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Override the feeds and speeds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Select a different tool.</td>
</tr>
<tr>
<td>FS002</td>
<td>Feed/Speed table not found for the given operation. This error indicates that a BRIGHT tool material table could have been used but was unable to find it.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Add a new feed/speed table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Override the feeds and speeds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Select a different tool.</td>
</tr>
<tr>
<td>FST01</td>
<td>Feeds and speeds were not computed because a tool was not available.</td>
<td>Fix tool selection error.</td>
</tr>
<tr>
<td>TPD03</td>
<td>Successive moves on the same line</td>
<td>Check feature curve.</td>
</tr>
<tr>
<td>TPD04</td>
<td>Feature curve cannot end inside stock boundary</td>
<td>Look at boundaries or feature curve.</td>
</tr>
<tr>
<td>TPD12</td>
<td>Geometric error while computing turning offsets.</td>
<td>Check to see if the curve has any unnecessarily small segments.</td>
</tr>
<tr>
<td>TPD14</td>
<td>Tool insert is too large to cut curve cleanly.</td>
<td>Change selected tool</td>
</tr>
<tr>
<td>TPD18</td>
<td>No cutting area determined</td>
<td>Check feature or stock curve.</td>
</tr>
<tr>
<td>TPD19</td>
<td>The Feature's curve <strong>Start point</strong> or <strong>End point</strong> is in the stock material.</td>
<td>Move the <strong>Start point</strong> or <strong>End point</strong>.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Suggestion</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>TPD21</td>
<td>Unable to determine area to be machined.</td>
<td>Check feature curve or stock curve.</td>
</tr>
<tr>
<td>TPD22</td>
<td>Unable to cut in the specified direction.</td>
<td>Cut in a different direction.</td>
</tr>
<tr>
<td>TPD52</td>
<td>Illegal value for cut depth.</td>
<td>Check depth feature parameter.</td>
</tr>
<tr>
<td>TPD54</td>
<td>First infeed is too small</td>
<td>Check threading parameters.</td>
</tr>
<tr>
<td>TPD56</td>
<td>Second infeed is too small</td>
<td>Check threading parameters.</td>
</tr>
<tr>
<td>TPD58</td>
<td>Memory overflow</td>
<td>Contact distributor.</td>
</tr>
<tr>
<td>TPD60</td>
<td>Depth is smaller than infeed</td>
<td>Check threading parameters.</td>
</tr>
<tr>
<td>TPD61</td>
<td>Check retract/engage angles and depth</td>
<td>Change parameters</td>
</tr>
<tr>
<td>TPD64</td>
<td>Tool undefined</td>
<td>Change tool.</td>
</tr>
<tr>
<td>TPD65</td>
<td>Illegal value of engage or withdraw angle</td>
<td>Change parameters</td>
</tr>
<tr>
<td>TPD66</td>
<td>Illegal tool shape</td>
<td>Adjust tool.</td>
</tr>
<tr>
<td>TPD67</td>
<td>Tool wider than slot</td>
<td>Change tool.</td>
</tr>
<tr>
<td>TPD68</td>
<td>Slot deeper than max tool depth</td>
<td>Change tool or slot parameters.</td>
</tr>
<tr>
<td>TPD69</td>
<td>Unable to verify, check path</td>
<td>Check feature curve.</td>
</tr>
<tr>
<td>TPD70</td>
<td>Check tool diameter value</td>
<td>Check tooling parameters.</td>
</tr>
<tr>
<td>TPD71</td>
<td>Check zstep value</td>
<td>Check feature parameters.</td>
</tr>
<tr>
<td>TPDMK01</td>
<td>Library error</td>
<td>Check that the tool being used is not too big, or that the curvature of the edge is not smaller than the tool being used.</td>
</tr>
<tr>
<td>TPSRF01</td>
<td>Bad surface(s)</td>
<td>Try to fix the bad surfaces by right-clicking on them and selecting <strong>Fix Face</strong> from the context menu; or remove them from the Surface feature.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Actions</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TSA01</td>
<td>Tool not found for standard drilling operation</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Copy a tool from drilling operation another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Override with another tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modify feature.</td>
</tr>
<tr>
<td>TSA02</td>
<td>Tool not found for drilling operation before ream.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Copy a tool from drilling operation another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Override with another tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modify feature.</td>
</tr>
<tr>
<td>TSB01</td>
<td>Tool not found for spotdrilling operation.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Copy a tool from drilling operation another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Override with another tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modify feature.</td>
</tr>
<tr>
<td>TSC01</td>
<td>Tool not found for reaming operation.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Copy a tool from drilling operation another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Override with another tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modify feature.</td>
</tr>
<tr>
<td>TSD01</td>
<td>Tool not found for tapping operation.</td>
<td>Do one of:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Copy a tool from drilling operation another crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Override with another tool.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Select a different crib.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modify feature.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Solutions</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| TSE01  | Countersink tool not found for chamfer operation. | Do one of:  
  - Copy a tool from drilling operation another crib.  
  - Create a tool.  
  - Override (see page 981) with another tool.  
  - Select a different crib (see page 1745).  
  - Modify feature. |
| TSF01  | Tool not found for countersink operation.         | Do one of:  
  - Copy a tool from drilling operation another crib.  
  - Create a tool.  
  - Override (see page 981) with another tool.  
  - Select a different crib.  
  - Modify feature. |
| TSG01  | Tool not found for counterbore operation.         | Do one of:  
  - Copy a tool from drilling operation another crib.  
  - Create a tool.  
  - Override (see page 981) with another tool.  
  - Select a different crib.  
  - Modify feature. |
| TSH01  | Tool not found for slotting operation.            | Do one of:  
  - Copy a tool from drilling operation another crib.  
  - Create a tool.  
  - Override with another tool.  
  - Select a different crib.  
  - Modify feature. |
| TSH02  | Selected tool not valid for slotting operation.   | Do one of:  
  - Copy a tool from drilling operation another crib.  
  - Create a tool.  
  - Override with another tool.  
  - Select a different crib.  
  - Modify feature. |
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
</table>
| TSI01 | Tool not found and unable to create a custom tool for boring operation. | Do one of:  
- Copy a tool from drilling operation another crib.  
- Create a tool.  
- Override with another tool.  
- Select a different crib.  
- Modify feature. |
| TSJ01 | Tool not found for zigzag operation. | Do one of:  
- Copy a tool from drilling operation another crib.  
- Create a tool.  
- Override with another tool.  
- Select a different crib.  
- Modify feature. |
| TSK01 | Endmill tool not found for profile milling operation. | Do one of:  
- Copy a tool from drilling operation another crib.  
- Create a tool.  
- Override with another tool.  
- Select a different crib.  
- Modify feature. |
| TSK02 | Selected tool not valid for profile chamfering operation. | Do one of:  
- Copy a tool from drilling operation another crib.  
- Create a tool.  
- Override with another tool.  
- Select a different crib.  
- Modify feature. |
| TSK03 | Tool not found for profile rounding operation. | Do one of:  
- Copy a tool from drilling operation another crib.  
- Create a tool.  
- Override with another tool.  
- Select a different crib.  
- Modify feature. |
| TSK42 | Un chamfered Face Mill tool selected for chamfer operation. | Select a chamfered Face Mill tool or a Chamfer Mill tool. |
| TSM01 | Tool not found for profile milling operation during decomposition of the feature. | Do one of:  
- Copy a tool from drilling operation another crib.  
- Create a tool.  
- Override with another tool.  
- Select a different crib.  
- Modify feature. |
Stock

The Stock is the material block from which you machine the part. This can be a basic shape, or a detailed solid model (see page 223).

Use these methods to define the stock:

- Click the Stock step in the Steps panel to display the Stock wizard (see page 205)
- Double-click the stock in the graphics window to display the Stock Properties dialog (see page 220)

Stock models

You can use stock models (see page 266) to eliminate air cutting by limiting the toolpath boundaries where a previous feature has already been machined.

Stock wizard

The Dimensions (see page 207) page of the Stock wizard is displayed automatically when you create a new part file:
To display the Stock wizard, click the **Stock** step in the **Steps** panel.

The **Stock** wizard helps you specify the shape (see page 207), size (see page 207), and material (see page 209) of the Stock, control multi-axis positioning (see page 211), and create an initial Setup (see page 212).

**Finish stock button**

The **Finish** button closes the **Stock** wizard and creates the stock you defined. Click the down arrow to specify how the button works.

**Finish**

Select the **Finish** option to accept the default settings in the remaining pages of the wizard, create the Stock, and exit the wizard. You can edit the Stock attributes later in the **Stock Properties** (see page 220) dialog.

**Finish and Edit Properties**

Select the **Finish and Edit Properties** option to open the **Stock Properties** (see page 220) dialog, which contains the properties you specified in the wizard, and other, advanced attributes.

To display the **Stock Properties** (see page 220) dialog when creating Stock:

1. Click the down arrow in the **Finish** button. The menu is displayed:

   ![Finish menu](image)

2. Select **Finish and Edit Properties**. The **Stock Properties** (see page 220) dialog is displayed.

   *The Finish button remembers your last preference and the icon changes to [Finish] or [Finish] to indicate the current mode.*
Dimensions

The first page of the Stock wizard (see page 205) is the Dimensions page. Use this page to set up the shape and size of your stock.

The following stock shapes are available:

- **Block:**
- **Round:**
- **N-Sided:**

To complete this page:

1. Select the stock shape as **Block**, **Round**, or **N-Sided**.
   - If you selected **Block** — Enter the **Length** (X dimension), **Width** (Y dimension), and **Thickness** (Z dimension).
   - If you selected **Round** — Select the **Axis** (see page 208) and enter the **Length** and **OD** (outside diameter). If you are working with tube stock, enter a positive number as the **ID** (inside diameter).

   *If wrapping (see page 243) or indexing (see page 234), the axis must match your index axis.*

   - If you selected **N-Sided** — Enter the **Axis** (see page 208), the **OD** (outside diameter), the number of **Sides**, and the **Length** of your stock.

   *You can skip this step and use the Stock Wizard (see page 205) later to define the stock.*

   *If you are running the offline version of FeatureCAM, you also have the option of automatically resizing the stock.*
If you want to use a Curve or a Solid to define the stock, use the **Stock Properties** (see page 220) dialog.

2. Click **Next** to display the **Stock - Material** (see page 209) page of the Stock wizard, or click **Finish** (see page 206).

### Axis

For **Round** and **N-Sided** stock, the axis that corresponds to the length of the stock is specified as the **Axis**.

<table>
<thead>
<tr>
<th>Axis</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z axis:</td>
<td>Select <strong>Axis: Z</strong> for all turning, turn/mill parts or milling parts where you want the XY plane to correspond to the face of the part.</td>
</tr>
<tr>
<td>Y axis:</td>
<td>Select <strong>Axis: Y</strong> for all 4th axis wrapping parts where the Y axis is the wrapping axis.</td>
</tr>
<tr>
<td>X axis:</td>
<td>Select <strong>Axis: X</strong> for all 4th axis wrapping parts where the X axis is the wrapping axis.</td>
</tr>
</tbody>
</table>

See also 4th-axis wrapping (see page 243)
Material

The second page of the Stock wizard (see page 205) is the Material page:

This dialog is where you choose the material type for the stock. Advanced users can also add new materials or view feed/speed tables.

**Material** — Select a material from the list to view or edit its settings.

You can use the **Show/Hide Material** (see page 1512) dialog to specify which materials are displayed in the Material list.

**Unit Horsepower** or **Specific Cutting Force** (see page 210) — A default value is displayed for the selected material, or you can enter a new value for the material.

**Hardness** (see page 210) — A default Hardness is displayed for the selected material. If you know the specific hardness of the material, enter the numeric value in the Hardness field and then select the **Hardness Units** that the hardness is measured in.

For some materials, the hardness is used in determining feeds and speeds. If you underestimate this value, the automatically generated feeds and speeds could be overly aggressive.

**Hardness Units** — The scale the hardness setting is based on. The supported scales are **Brinell**, **Rockwell B**, **Rockwell C**, and **Tensile Strength (ksi)**. **Brinell** is the default hardness scale.

**New Material** button — Displays the **New Material Name** dialog. Enter the name of the new material and click **OK**. If the material does not have an entry in the database, a warning is displayed. If you want to create a new material click **Yes** to add feed and speed information for the material. The **Feeds/Speeds And Cutting Data Tables** dialog is displayed.
F/S Tables — Click this button to open the Feeds/Speeds and Cutting Data Tables (see page 1847) dialog.

Click Next to open the Multi-axis positioning (see page 211) page, or click Finish (see page 206).

**Unit Horsepower or Specific Cutting Force**

The power needed to perform a cut is based on the rate the material is being removed and a power constant that is dependent on the material. This constant is known as the Unit Horsepower or Specific Cutting Force. In FeatureCAM, this number is used to generate horsepower estimates for operations. These estimates are displayed in the Op Details report. If you enter an inaccurate value for the Unit Horsepower, no error is generated. The only consequence is that incorrect horsepower estimates are displayed.

For materials that are pre-defined in FeatureCAM, an approximate value is supplied that is independent of a material's hardness. For many materials, the Unit Horsepower is dependent on the hardness of the material, so you may have to adjust this constant to get more accurate horsepower estimates. A list of specific Unit Horsepower values can be found in a machinist's handbook. For defining new material tables, the Unit Horsepower constant must be supplied by the user.

**Hardness**

When you select a material name, the Hardness value displayed is low end of the defined hardness range for that material (if the material uses a range). Adjust the hardness to reflect the actual hardness of your material in the field. The feeds and speeds calculated for your part are influenced by the hardness of your material, but only if the material is defined using a hardness range (see page 1850).
Multi-axis positioning

You can use the Multi-axis positioning page of the Stock wizard (see page 205) to specify if you are creating your part with 4th-axis indexing or 5th-axis positioning.

To complete this page:

1 If you are not using 4th-milling or 5th-axis milling, select No, and click Next.

   The Setup - Definition (see page 212) page is displayed.

2 If you are using multi-axis positioning:
   - If you are using 4th-axis positioning, or 4th-axis wrapping select 4th-Axis Positioning, then select the axis you index around. See Indexing (see page 234) or 4th-axis wrapping (see page 243) for more information.
   - If you are using 5th-axis positioning, select 5th-Axis Positioning. See 5-axis positioning (see page 256) for more information.

3 Click Next.

   The Multi-axis options (see page 211) page is displayed.

Multi-axis options

On the Multi-axis options page of the Stock wizard, you can specify options for 4th-axis wrapping and indexing and 5th-axis positioning.

This page is only displayed if you selected 4th Axis Positioning or 5th Axis Positioning in the Multi-axis positioning (see page 211) page.

To complete this page for 4th-axis milling:

1 Select the dominance from:
   - Tool Dominant — If you want the order of operations to be tool dominant across all Setups, select this option.
You must also select **Minimize tool changes** in the **Automatic ordering options** dialog (see page 1553) for **Tool Dominant** to work correctly.

- **Setup Dominant** — If you want the order of operations to complete each Setup before moving on to another Setup, select this option. The milling ordering attributes determine the order in which operations are performed within a Setup.

Select **Generate Single Program** if you want to create a single 5-axis indexed program.

2 Click Next.

The **Setup - Definition** (see page 212) page is displayed.

To complete this page for 5th-axis milling:

1 If you want to use fixture offsets, follow steps 2-6 here (see page 265).

2 If you want to use a single coordinate system, follow steps 2-6 here (see page 263).

See Overview of 5-axis positioning (see page 256) for more information.

**Setup - Definition**

Use the **Setup - Definition** page of the **Stock** wizard (see page 205) to name the Setup and specify the fixture ID.

![Setup - Definition](image)

**Setup Name** — Enter a name for the Setup. This name is used only as a label for the Setup.
Fixture ID — Verify the Fixture ID for the Setup. The default value should be correct because it is taken from the current *.cnc post processor template file. If the default value is not correct, enter the correct value.

Part Name — Optionally enter a different Part Name for the part. This defaults to the file name, but you may need to override this for Fanuc controls to give the part a numeric part name.

Multi-axis Setups have these attributes:

Index X coordinate (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

Index Y coordinate (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

Index Z coordinate (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

Orientation angle — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine’s Y direction. With an orientation angle of 90, the groove is cut in the machine’s X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the **Preferred orientation of the primary rotary axis** option.

Click **Next** to open the Setup - Part Program Zero (see page 214) page, or click **Finish** (see page 206).

**Setup - Part Program Zero**

You can use the **Part Program Zero** page of the wizard to select a method of specifying part program zero. This is the origin of the coordinate system for the NC program.

To complete this page, select one of the options and click **Next**.

- **Align to Stock Face** (see page 215) — Select this option if you want to align the Setup with the center or corner of one of the Stock faces, or to explicitly pick a location.
- **Align to Index axis** (see page 216) — Select this option to align the Setup with the index axis. (This option is available only for a turn/mill or 4th-axis indexed (see page 211) part.)
- **Align with existing UCS** (see page 216) — Select this option if you want to align the Setup with a previously created user coordinate system (UCS).

- **Align to part geometry** (see page 217) — Select this option if you want to align the Setup relative to the part geometry.

- **Use current location** — Select this option if you want to leave the Setup at its current location. Click Next to open the Setup - Simulation information (see page 219) page, or click Finish (see page 206).

See Overview of setups (see page 114) for more information on part program zero.

**Align to Stock Face**

Align to Stock Face enables you to align the part program zero to a face on the Stock.

To complete this page:

1. In the Stock Face section, select the face that you want to use.
2. In the XYZ Location section, either click the Pick location button and select the location on the model or click the pointing finger button that corresponds to either the Center of the stock or one of the corners:
   - UL — upper left corner
   - UR — upper right corner
   - LL — lower left corner
   - LR — lower right corner
3 Click **Next** to open the **Setup - Part Program Offset** (see page 218) page, or click **Finish** (see page 206).

**Align to Index axis**

The **Part Program Zero** page (see page 214) of the **Stock** wizard (see page 205) for **Align to Index axis** enables you to specify the origin of the stock for a turn/mill or 4th-axis indexed part.

To complete this page:

1. If you want to translate the origin off the axis, enter the **Radius from rotation axis**.

2. If you want to rotate the coordinate system around the **Stock axis** (see page 235), enter an **Angular location**.

3. Enter an **X Offset** if you want to translate the coordinate system along the X axis.

4. Click **Finish** (see page 206).

**Align with existing UCS**

This page enables you to align the part program zero with an existing user coordinate system.
To complete this page:

1. Select the name of the UCS from the list or click the **Pick UCS** button and select it from the graphics window.

2. Click **Next** to go to the **Part Program Offset** (see page 218) page or click **Finish**.

**Align to part geometry**

If you select **Align to part geometry** on the **Part Program Zero** page (see page 214) of the **Stock** wizard (see page 205), the **Pick Initial Setup Z Direction** page is displayed:

Click one of the buttons to specify the Setup's Z direction using the method listed.

Click **Next** and the **Pick Initial Setup X Direction** page is displayed.

Click one of the buttons to specify the Setup's X direction using one of the methods listed.
Click **Next** and the **Pick Setup XYZ Location** page is displayed:

If you are using the center of a revolved surface, you can click **Opposite End** to create the Setup at the other end of the cylinder. Click **Finish** (see page 206).

**Setup - Part Program Offset**

This page enables you to translate the location of the Setup. One reason to translate the Setup is to model the extra stock on top of the part that is removed during a facing operation. You may also want to translate it to a location that you cannot easily snap to.

To complete this page:

1. If you want to translate the stock, enter the amount to offset the stock as the **X Offset**, **Y Offset**, and/or **Z Offset**.
2. Click the **Preview** button if you want to review the new location of the Setup.
3. Click **Next** to open the **Setup - Simulation information** (see page 219) page, or click **Finish** (see page 206).
Setup - Simulation Information

Use this page of the wizard to specify an offset for loading the part onto the machine and select the machine design file that is used for Machine Simulation.

This dialog is available in these places:

- In the Stock wizard
- In the Setup wizard
- From the Status bar

The X Offset, Y Offset, and Z Offset parameters represent offsets for loading the part onto the machine. For simulating single milling or turning setups these offsets are applied to the setup after the part is aligned with the top-most location (see page 1912). For indexed parts or turn/mill parts, the offset is relative to the stock axis.

Under Simulation machine design file, select Always use this one to specify an MD file to use for this setup, or select Use the one specified in the .cnc file to inherit the MD file from the CNC file for this setup.

If you select an MD that does not exist, or the CNC file refers to an MD file that does not exist, FeatureCAM selects an appropriate MD file from the Examples\Machine Design folder.

If a smart MD choice is made, a message dialog is displayed when you close the dialog and when you run a simulation. You can disable these messages by deselecting Notify me when a smart choice is made.
Setup - Right Angled Head

1. Select the option on this page if you want to allow the creation of features that can be cut only with a right-angled tool holder.
2. Click Finish (see page 206).

Stock Properties dialog

You can use either the Stock wizard (see page 205) or the Stock Properties dialog to set up the stock. The Stock Properties dialog contains all the same options as the Stock wizard.

Use one of the following methods to display the Stock Properties dialog:

- Right-click the stock in the Part View panel and select Properties from the context menu.
- Double-click the stock in the Part View panel.
- Right-click the stock in the graphics window and select Properties from the context menu.
- Double-click the stock in the graphics window.
By default, the stock is displayed in blue in the graphics window.

The **Stock Properties** dialog contains two tabs:

**Dimensions** (see page 222)

**Indexing** (see page 229)
Dimensions tab (Stock)

You can use the **Dimensions** tab of the **Stock Properties** dialog (see page 220) to specify the size, shape, material and location of the stock.

To complete the **Dimensions** tab:

1. Select the stock shape from the following:
   - **Block** — Enter the **Length** (X dimension), **Width** (Y dimension), and **Thickness** (Z dimension).
   - **Round** — Select the **Axis** and enter the **Length** and **OD** (outside diameter). If you are working with tube stock, enter a positive number as the **ID** (inside diameter).
   - **N-sided** — Enter the **Axis**, the **OD** (outside diameter), the number of **Sides** and the **Length** of your stock.
   - **User-defined** (see page 223) — Click **Stock Solid** to display the **Select Stock Solid** dialog.

2. Optionally click **Stock Curve** (see page 224) to display the **Select Stock Curve** dialog, where you can select a curve in the model to describe a custom profile stock of the part.
3 If you created or imported geometry, the **Resize** button is displayed. Optionally click **Resize** to resize the stock automatically. The **Stock Dimensions** (see page 226) wizard is displayed.

4 Optionally click **Material** to display the **Material** dialog. This contains the same options as the **Material** page (see page 209) of the **Stock** wizard.

5 If you want to move the stock, enter the **X**, **Y**, and **Z** coordinates of the new location or click **Pick Location** and select a point in the graphics window.

6 If the part is a Wire EDM part, the **Condition** button is displayed. Click **Condition** to display the **Condition** dialog (see page 228), which you can use to specify the material, wire properties, and machine type.

**User-defined stock**

You can use a solid to define the shape of the stock.

To use a stock solid:

1 Double-click the stock in the graphics window or **Part View** to display the **Stock Properties** dialog.

2 On the **Dimensions** tab (see page 222) of the **Stock Properties** dialog, select **User defined**.

3 Click **Stock Solid** to display the **Select Stock Solid** dialog.

   A list of solids is displayed. To display all solids in the model, select **Show all**.

4 Select a solid in the list, or click **Pick Solid** and select a solid in the graphics window.

5 Click **OK** to close the **Select Stock Solid** dialog.

6 Click **OK** to close the **Stock Properties** dialog.

If you create Side or Boss features when using a stock solid, the toolpaths are trimmed to the stock boundary to prevent air cutting, even when the stock solid has multiple regions.
For example, to machine this part:

The stock is a cylinder with a hole, and a Side feature is created.

In the 2D simulation top view, you can see the toolpaths are trimmed to the stock solid, the tool does not cut across the hole in the stock:

If you enable the Individual rough levels (see page 963) option, each z-level of the toolpath is trimmed to the stock boundary separately, which further prevents air cutting.

**Stock curve**

You can use the Select Stock Curve dialog to specify a curve to define the shape of the stock.
To display the **Select Stock Curve** dialog, click **Stock Curve** on the **Dimensions** tab (see page 222) of the **Stock Properties** (see page 220) dialog:

![Select Stock Curve dialog](image)

**Compute the Stock Boundary from the block stock** — This is the default option and uses the block stock.

**Use a Curve as the Stock Boundary** — Select this option to use a curve as the Stock Boundary and select a curve (see page 59) to use as the stock boundary. You can use this method to define the shape of irregular shaped stock, so the toolpaths do not air cut in regions without stock.

**Show all curves** — Select this option to display all available curves in the list.

**More about Stock curves**

Stock curves must be closed and lie in the world XY plane. You may use a full circle, but only a single curve or circle can be selected. Also, the curve must not self-intersect, although FeatureCAM does not detect this condition.

A stock curve is the default stock boundary for features on the top and bottom of the stock. For simplicity and flexibility, the stock curve should meet the positive X and Y axes. This location lets you easily calculate the width and length of the stock curve extent and position the origin at the corner of those rectangular extents.

To work from the sides of the stock, the **Width** and **Length** of the block stock must be set manually. They are measured from the world origin. If the stock curve’s extents do not align with the world origin, the length and width settings will not match the stock curve's location and dimensions.

Because of the nature of stock defined by a curve, aligning a UCS to custom stock ignores the stock curve and works with the rectangular extents.
**Stock Dimensions wizard**

You can use the **Stock Dimensions** wizard to resize the stock to fit objects in the model.

To display the **Stock Dimensions** dialog, clicking **Resize** on the **Dimensions** tab (see page 222) of the **Stock Properties** (see page 220) dialog.

The first page of the wizard has columns which display the size of the **Imported Data** (or created geometry), the **Stock Dimensions**, and the **Offset** of the imported data. The first column always shows you the dimensions of the data that is currently displayed in the graphics window. The other two columns differ depending on the type of stock.

**Block stock**

If you select **Enter specific stock dimension**, enter the **Length**, **Width** and **Thickness** of the stock in the **Stock Dimensions** column. You can also offset the part relative to the stock by entering the **X offset**, **Y offset**, and **Z offset** in the **Offset imported data** column. Optionally click the **Center** button, to move the part to the center of the stock.
If you select **Compute stock size from the size of the part**, the stock is automatically sized to fit the part.

![Stock Dimensions](image)

You can enter **Extra stock size** for any dimension.

Click **Next** to open the next page of the wizard and select one of the following options:

**Move geometry** — Select this option to move the geometry in relation to the stock.

**Move stock** — Select this option to move the stock in relation to the geometry.

**Round and N-sided stock**

For these two stock shapes, your only choice is to **Enter specific stock dimensions**. In the **Stock Dimensions** column, enter the stock dimensions and in the **Offset** column enter offsets for translating the part relative to the stock.

*For all stock shapes, this page addresses only the size of the stock. It does not affect the part programming origin.*
**Condition dialog (WIRE)**

Use the **Condition** dialog to specify the machine configuration for the stock. The combination of parameters determines the feed, water and cutter compensation values selected from the cut-data database.

To specify the machine condition:

1. In the **Stock Properties** dialog, select the **Dimensions** tab, and click **Condition**. The **Condition** dialog is displayed.

2. Select a list option for each parameter supported by your machine:
   - **Material** specifies the stock material. Alternatively, click \(\text{Create Material}\) to create a new material.
   - **Wire** specifies the wire type. Alternatively click \(\text{Create Wire}\) to create a new wire.
   - **Wire diameter** specifies the wire diameter. Alternatively, click \(\text{Create Wire Diameter}\) to create a new wire diameter.
   - **Machine** specifies the machine type. Alternatively, click \(\text{Create Machine}\) to create a new machine.
   - **Nozzle position** specifies a nozzle position. Alternatively, click \(\text{Specify Position}\) to specify a new position.
   - **Fluid** specifies the dielectric fluid. Alternatively, click \(\text{Specify Fluid}\) to specify the fluid.

   *If you are not setting the Feed, water and cutter compensation registers (see page 1509) from a cut-data database, you need only specify the **Wire diameter**. The value is used to determine the width of the cut in the 3D simulation.*

3. If you want to check the machine settings for this condition or want to specify the machine settings for a new combination of parameters, click **Cutting Data**. The **Feeds/Speeds and Cutting Data Tables** dialog (see page 1847) is displayed.
4 Click **OK** or **Next** to save your changes.

**Indexing tab (Stock)**

You can use the **Indexing** tab of the **Stock Properties** dialog (see page 220) to control multi-axis indexing:

![Indexing tab](image)

**No multi-axis positioning** — Select this option to perform no indexing.

For turn/mill or turn parts select **Generate Single Program with program stop between each setup** (see page 230) if you are using a sub-spindle to change between each Setup.

For milling and Wire EDM parts select **Generate Single Program with program stop between each setup** (see page 230) if you need to stop the machine to turn the part around and machine on both sides.

**4th-axis positioning** — Select this option to perform 4-axis indexing (see page 234).

- **Index axis UCS** — Select the UCS whose index axis you want to use for 4th-axis indexing.

**5th-axis positioning** (**5AP** (see page 10)) — Select this option to perform 5-axis positioning (see page 256).
Click **Fixture Location** to display the **5 Axis Fixture Location** dialog (see page 230), which you can use to specify a reference point for the NC code.

**Use Z-indexing** — Enable 5 axis Z-indexing (see page 232) for the document.

*For turn/mill parts, you must select 4th Axis Positioning.*

**Operation Ordering** — select the dominance from:

- **Tool Dominant** — If you want the order of operations to be tool dominant across all Setups, select this option. You must also select **Minimize tool changes in the Automatic ordering options** dialog (see page 1553) for Tool Dominant to work correctly.

- **Setup Dominant** — If you want the order of operations to complete each Setup before moving on to another Setup, select this option. The milling ordering attributes determine the order in which operations are performed within a Setup.

Select **Generate Single Program** if you want to create a single 5-axis indexed program.

**Generate Single Program with program stop between each setup**

Generate Single Program with program stop between each setup is an option on the **Indexing** tab (see page 229) of the **Stock Properties** dialog.

This option combines the toolpaths of all Setups into a single Setup. This means that when simulating the toolpaths, the toolpaths from all Setups are displayed and a single NC program is created. This option must be set if you are using a Sub-spindle (see page 843). If this option is deselected a separate NC file is created for each Setup.

If Generate Single Program with program stop between each setup is selected, FeatureCAM inserts a stop operation between each Setup. This enables the part to be flipped and machined on both sides within a single NC program. For a turn or turn/mill document, the stop operation is created if the Setups are on the same spindle and oriented opposite to each other. For a milling document, the Setups can be in any orientation.

**5 Axis Fixture Location dialog**

You can use the **5 Axis Fixture Location** dialog to specify a reference point for the NC code.
To display the 5 Axis Fixture Location dialog, select 5th-axis positioning on the Indexing tab (see page 229) of the Stock Properties dialog (see page 220), then click Fixture Location.

NC Code Reference Point — Select what to use for the reference point from:

- Pivot Point for table/table machines or Machine Zero for others
- Each setup’s own fixture (each setup’s origin)
- Touch-off Point

Use Origin of this Setup as the Touch-off Point — Select a setup from the list to use as the touch-off point.

Also use the setup as your part’s initial orientation on the machine tool — Select this option to use the selected setup as the initial orientation of the part on the machine tool. Deselect this option to use the STOCK axis as the part’s initial orientation.

Offset of Touch-point from Machine Zero — Enter the distance, in each direction, of the 5- Axis Touch-off Point from the center of the A-axis face. This distance is different for each part.

In this example, the X and Y offsets are negative and the Z offset is positive.

1. Center of A-axis face
2 Touch-off Setup origin

**First Axis Rotational Offset** — Enter the angle (measured counter-clockwise) between the spindle axis and the A axis when the B angle is set to 0.

For example, if the A-axis faces the spindle when B is set to 0, then enter 0. If it faces the door when B is set to 0, as in the example below, then enter -90. This offset is set the same for all parts machined on a specific machine.

![Diagram](image)

1. A-axis
2. Spindle axis
3. B-axis rotation

**5 Axis Z-indexing**

Select the **Use Z indexing** option to enable 5 Axis Z-indexing for the document.

This enables you index the part about the Z axis in 5-axis simultaneous parts, for example:

Cut feature using Y Axis coordinates selected  Cut feature using Y Axis coordinates deselected
The tool moves in X and Y to cut the features. The part is rotated about the index axis to cut the features.

To use Z-indexing:

1. Ensure you are using a CNC file that supports 5-axis positioning, 5-axis simultaneous and Z-indexing.

2. In the Stock Properties dialog, on the Indexing tab, select the new Use Z indexing option to enable Z indexing for the document.

3. For each feature, deselect Cut feature using Y Axis coordinates on the Dimensions tab of the Feature Properties dialog to enable the part to rotate about the Z axis during cutting.
4th-axis positioning (2.5D & 3D)

You must have a CNC control that supports a 4th axis, and a rotary table or native 4th axis that can be controlled by the CNC machine.

There are several ways to use the 4th axis:

Indexing (see page 234) — The 4th-axis is used as an indexer, to rotate the part between machining operations so that the machining takes place on different planes of the part.

Wrapping (see page 243) — The rotary table is used as a continuously moving axis. Rotation occurs during the machining operation and the tool movement is limited to either the X- or Y-axis and the Z-axis. The part itself is rotated to take the place of the axis not used. This feature is capable of wrapping any feature while the part is rotated.

4-axis simultaneous (see page 254) — Another method of using the rotary table’s rotational axis is to use all four degrees of freedom at once with FeatureCAM’s 4-axis simultaneous product. This enables you to directly machine surfaces without the need for unwrapping and may result in the machine moving in X, Y, Z, and A (for instance) all at once.

Indexing

Indexing uses the 4th axis to rotate the part between machining operations so that the machining takes place on different planes of the part. In FeatureCAM each face of the part can be assigned to a separate Setup (see page 238) or features can be placed radially (see page 240) around the center of rotation by using only one Setup.

Parts whose features can be accessed by rotating around a single axis are candidates for 4th-axis wrapping (see page 243).
You must have a CNC control that supports a 4th axis, and a rotary table or native 4th axis that can be controlled by the CNC machine in order to use indexing.

**The Stock Axis**

The Stock Axis corresponds to machine zero and the axis of rotation for an indexer. It is not normally displayed, but you can display it by selecting View > Show > Show Stock Axis from the menu. It is displayed as two vectors. One shows the axis of rotation and the other indicates the orientation of a $0^\circ$ rotation.

![Stock Axis Diagram](image)

**4th-axis index around Z example**

You can index around the Z axis for 2.5D machining, using, for example, a rotary table lying flat on a vertical milling machine. This means that you can mill large parts that exceed the travel of the machine in one direction, by milling them in stages.

This example shows a part being machined with no multi-axis positioning. When drilling holes near the edges of the part, the machine moves a lot in the X and Y directions:
And risks a collision at point ①:

By selecting **4th Axis Positioning** and **Index around the STOCK Z Axis**, you can cut the holes by rotating around the Z axis:

---

**Creating an indexed part**

To create an indexed part:

1. Display the Stock Axis. This is used for reference.

2. Click the **Stock** step.

3. Click **Next** twice.

4. Select the **4th Axis Positioning** option.

5. Decide what world coordinate axis to rotate about. The X-axis is recommended because most post processors support only X-axis indexing. (For the rest of this description we have assumed that you have selected the X axis.) For the X-axis, click **Index around the X-axis**. For the Y-axis, click **Index around the Y-axis**.

6. Position the stock (see page 238) appropriately.

7. Set the **Tool Change Location** (see page 242).

8. If you want to create Setups on each face:
   
   a. Create the Setups for indexing (see page 238).
b Switch to each Setup and create your features (see page 530).

9 If you want to use a single Setup, create each feature and follow this procedure (see page 240) to orient each feature.

10 Generate the toolpaths.

11 Click **Post Process** in the **Manufacturing** menu and select a post from the **4-Axis** directory.

12 Click the **NC** tab in the **Results** window.

**4th-axis rotation**

In this example, the part is indexed around the X axis.

*The X axes of each Setup are parallel to the X-axis of the Stock axis.*
Using multiple Setups

Normally each Setup generates a separate program. If the Setups of your part are a simple rotation around your machine's fourth axis as shown below you can use indexing to combine all the Setups into a single program that rotates each Setup into position using the 4th axis.

Indexing can be performed around the X or Y axis of the stock axis. The post processor you use must have the same indexing axis as your part. For each Setup the corresponding axis must be parallel to the indexing axis. For example, if you are indexing around the world coordinate X axis, the X axes of each Setup must be parallel to the stock axis.

When using indexing, the part documentation is combined for all Setups. This means that you have just one operations list, one tool list, and one NC part program for all Setups.

When positioning features (see page 534), use the XYZ or polar types of positioning.

You can combine milling and turning Setups using the Vertical mill/turn (see page 238) document type.

Vertical mill/turn (TURNMILL, MTT, 5AP)

The minimum components (see page 10) you need for vertical mill/turn are Turn/Mill, Advanced Turn/Mill, and 5 Axis Positioning. In addition, the 3D MX, 5AS, and MSIM components are recommended for a complete solution for your vertical mill/turn machine's capabilities.
FeatureCAM supports vertical mill/turn machines such as Okuma Vertical MILL/TURN VTM120YB, Mori Seiki SuperMILLER 400, Mori Seiki NMV5000 DBC, Mazak Integrex e-800V II (side spindle), Matsuura Cublex 25, and DMG FD Series.

Use the **Vertical Mill/ Turn** document type:

When you open a new Vertical Mill/Turn document, two Setups are created by default:

- **Setup1** is a turning Setup and **Setup2** is a milling Setup.

The **Vertical Mill/ Turn** option in **Stock Properties** is automatically selected for a Vertical Mill/Turn document, and the **Fixture Location** button is available for the milling part of the document:
Load and run the `VerticalMillTurnAddin.bas` add-in to access these two buttons:

![Utilities](image-url)

The **PostMillTurnSetups** button combines the two Setups into a single NC code file.

The **SimTurnMillingSetups** button combines the two Setups into one simulation for 3D or machine simulation.

**Using a single Setup**

**Positioning features**

When creating 4th-axis indexing or turn/mill parts, there is an option on the **Location** (see page 534) page of the Feature wizard (see page 530) for positioning called **Radial about the X axis** (or **Radial about the Y axis** if indexing around the Y axis). Use this method of positioning 4th-axis features, unless you want to create Setups on each face you want to machine. Use the angle and radius dimensions to orient the feature on the proper face.

![Diagram](image-url)

In the case of indexing around the X axis, the X coordinate moves the feature along the X axis and the Y coordinate translates the feature in the perpendicular direction.

![Diagram](image-url)

In the case of indexing around the Y axis, the Y coordinate moves the feature along the Y axis and the X coordinate translates the feature in the perpendicular direction.
Positioning the stock

Often, the initial part Setup is positioned at the same point as the Stock Axis (see page 235).

You can position the Setup axis at whatever point is convenient for locating part zero, but you must move the stock so that the Stock Axis is positioned at the center of rotation of your indexer. You do this in the Stock Properties dialog:

1. Open the Stock Properties dialog by selecting the stock in the Part Tree and then selecting Properties from the context menu.

The Stock Properties dialog is displayed.
On the **Dimensions** tab, adjust the X, Y, and Z coordinates to move the stock. In the example below, it is assumed that the center of the stock is aligned with the axis of the indexer. The stock is shifted by a negative amount in Y equal to half the stock width and a positive amount in Z equal to half the stock thickness.

3. Click the **Apply** button to see the results.
4. Click **OK** when the stock has been moved correctly.

**Tool Change Location**

You must set the **Tool Change Location** (see page 1857) correctly for the simulation of 4th-axis indexing parts to be accurate.

*This does not affect the NC code, only the graphics.*

The distance from the **Stock Axis** origin to the **Tool Change Location** must be long enough so that the tool clears the part as it rotates. The images below (with the **Tool Change Location** marked by an arrow) show the circle that would be formed by sweeping a tool change location around the stock axis. Notice that this circle clears the entire part.
How the clearance plane is calculated

In 4th-axis positioning and 5th-axis positioning, the tool must retract to a safe distance so that it does not collide with the part while it is indexing. To achieve this, FeatureCAM calculates the maximum stock radius \( \text{1} \) and adds to that the Z-index clearance \( \text{2} \) to determine the appropriate retract distance.

Restrictions of indexing

- You must use a post from the 4-Axis directory. Normal posts do not support indexing.
- The post CNC files have the indexing axis hard-coded. Most are setup to rotate about the X axis. The axis of rotation in your program must match the rotation axis of the post.
- If you are using multiple Setups and are rotating about the world X axis the X axes of the Setups must be parallel to the world X axis.
- If you are using multiple Setups and are rotating about the world Y axis the Y axes of the Setups must be parallel to the world Y axis.

Wrapping (3D)

4th-axis wrapping enables you to wrap a 2.5D feature around either the X or Y axis. You must have a machine with 4th-axis capabilities to use this feature.

4th-axis wrapping uses the rotary table as a continuously moving axis. Rotation occurs during the machining operation and the tool movement is limited to either the X or Y axis and the Z axis. Wrapping is limited to cylindrical stock. A side effect of wrapping is that all arc moves must be converted to linear moves for posting. This conversion is controlled by the Wrap tolerance (see page 1648) attribute.

You can wrap any milling feature using 4th-axis wrapping or turn/milling. This example shows a simple Groove feature that is wrapped around the X axis.
The features are not displayed as wrapped, but when you generate toolpaths for a wrapped Setup, the toolpaths are wrapped.

**Basic requirements**

These are the basic requirements for 4th-axis wrapping:

- Use Round shaped stock with an Axis of X or Y. Set this on the Dimensions (see page 207) page of the Stock wizard or the Dimensions tab of the Stock Properties (see page 220) dialog.

- Select the 4th axis positioning option either on the Multi-axis positioning (see page 211) page of the Stock wizard or the Indexing (see page 229) tab of the Stock Properties dialog.

- Indexing and wrapping occur about the Stock Axis. To help you understand this, you can display the Stock Axis by selecting View > Show > Show STOCK axis from the menu. The Stock Axis displays in blue.
All of your features need to be designed up off the Stock Axis, for example, at the OD of your round stock. You can get them there by translating the feature up in Z, or by making a Setup that is up off the stock axis.

- Select the **Wrap feature around X-axis** option of any feature you want to wrap.
- Use a 4-axis indexing post from .../Posts/Mill/4-Axis.

**Creating a part using 4th-axis wrapping**

To create a part using 4th-axis wrapping:

1. Select the **View > Show > Show Stock Axis** menu option.
2. Click the **Stock** step in the **Steps** panel to display the Stock wizard.
   a. On the **Dimensions** (see page 207) page of the **Stock wizard**, select a **Round** stock shape, and select an **Axis** to use as a wrapping axis.
   b. On the **Multi-axis positioning** (see page 211) page of the **Stock wizard**, select **4th-axis positioning**, and select the axis around which you want to index.

   > Most 4th-axis post processors provided with FeatureCAM index around the X axis.

3. Click **Finish** to close the wizard.

3. When creating a feature that you would like to wrap:
a Position it using the **Radial about axis** option on the **Location** (see page 534) page of the **New Feature** wizard or the **Location** tab of the **Feature Properties** dialog.

b Select **Wrap feature around axis** on the **Dimensions** (see page 905) tab of the **Feature Properties** dialog.

4 Select **Manufacturing > Post Process** from the menu. The **Post Options** (see page 1857) dialog is displayed.

5 Click the **Browse** button to specify your post processor.

6 Select a post from the **4-Axis** folder. Ensure that you select a post processor that matches the index axis you selected in the **Stock wizard**.

7 Click **OK**.

8 Run a centerline simulation (see page 1516). Notice that the toolpaths are wrapped around a cylinder. Centerline and 3D simulation allow you to preview the wrapped toolpaths.

9 If the wrapped feature is too chunky, you may need to lower the **Wrap tolerance** attribute on the **Misc.** (see page 1648) tab of **Machining attributes**.

10 Click the **NC Code** (see page 1557) tab in the **Results** window.

**Creating a 4th-axis wrapped feature from a 3D model**

To create a 4th-axis wrapped feature from a 3D model:

1 Pick a single feature that you want to machine on the part.
2 Check it is a wrapped feature. If the feature has all straight sides, it can be cut with a normal 2.5D feature.

1 Consider the restrictions of 4th-axis wrapping (see page 252) to make sure it is correct for cutting the feature.

2 Do the sides go through the center axis of wrapping? If you really need to cut these sides accurately, you must use Cut sides perpendicular to index axis (see page 251).

3 Use surface edges (see page 350) to extract a curve from the solid model.
4 Unwrap (see page 339) the curve. Make sure you use the option to project to the UCS. The curve may look strange to you, but it does work.

1 Make the feature opting to wrap around the index axis.

This option is not available in the Feature wizard. If you use the wizard, you must create a normal feature and edit it to change it into a wrapped feature.

2 Generate the toolpaths. If you have any problems consider the restrictions of 4th-axis wrapping (see page 252).
Cylindrical cams

You must have 4th-axis wrapping (see page 243) to cut cylindrical cams.

Cylindrical (or barrel) cams are specified as you would a normal cam. See Cams (see page 364) for more information on reciprocating cams. For simple cams, the rise and fall are radial distance. On cylindrical cams the rise and fall displacements are along the wrapping axis.

For example, if you create a barrel cam that is wrapped around the X axis with these parameters:

```
<table>
<thead>
<tr>
<th>Range (deg.)</th>
<th>Type</th>
<th>Duration (deg.)</th>
<th>Displacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 30</td>
<td>Rise</td>
<td>30.00</td>
<td>2.000</td>
</tr>
<tr>
<td>30 - 240</td>
<td>Dwell</td>
<td>210.00</td>
<td>0.000</td>
</tr>
<tr>
<td>240 - 270</td>
<td>Fall</td>
<td>30.00</td>
<td>2.000</td>
</tr>
<tr>
<td>270 - 360</td>
<td>Dwell</td>
<td>90.00</td>
<td>0.000</td>
</tr>
</tbody>
</table>
```

the following curve is created:
Notice that the displacement is in the X direction. If you create a groove feature using the barrel cam curve, you get the toolpath shown below.

Creating a cylindrical Cam

Follow the steps for How to create a NC program using 4th-axis wrapping (see page 245). For Step 3, Create your part features, follow these steps:

1. Open the Cam Properties dialog in one of these ways:
   - In the Curve Wizard (see page 325), select Other methods, then Cams, and click Next.
   - On the Curve toolbar (see page 13), click the Cams button in the Curve menu.
   - From the menu, select Construct > Curve > Other methods > Cams.

2. On the General tab, select Cylindrical Cam.

3. Specify the Base Radius as the radius of your cylindrical stock.

4. Specify either Wrap X-axis or Wrap Y-axis. Make sure that this setting matches the wrapping axis you specified in your setup.

5. On the Segments tab, enter the segment parameters.

6. Click OK or Finish.

7. Use this curve to create a groove.

You now have a feature that you can use for 4th-axis wrapping.
**Cut sides perpendicular to index axis**

When milling features are wrapped (see page 243) around the index axis, one coordinate axis is converted from linear moves into rotational moves. For wrapping around the X axis, the Y axis moves are converted into C axis rotations. For simple wrapping the NC code is relatively simple, but the walls of the resulting feature are not perpendicular to the index axis. The following image shows the front view of a wrapped pocket. The toolpath is calculated relative to the top curve causing the pocket to be overcut at the bottom. The overcut regions are shown in red. The blue lines show the extension of the cut walls and indicate that the walls are no longer perpendicular to the index axis.

To make the walls perpendicular to the index axis, as shown below, use the **Cut sides perpendicular to Index axis** attribute.
If you require perpendicular sides, you must have a lathe or mill with X-axis, C-axis, and Y-axis motion. To program your feature to have perpendicular sides you must select **Wrap feature around X-axis** and also select **Cut sides perpendicular to index axis**. Features cut with this option have sides that are perpendicular to the index axis. There are a number of restrictions (see page 252) for this type of feature.

**Restrictions for cut sides perpendicular**

- Simple slots and grooves are not supported.
- The first move of the toolpath should be perpendicular to the axis of rotation. Otherwise you end up with a really big offset move at the beginning of the ramp-in which can result in the tool traveling backwards with respect to the direction of the toolpath. This is because on the initial plunge move, we do not know the offset direction, so the Y offset is 0. The first move of the ramp is at close to 90° and needs almost a full tool radius offset. If you are doing a linear ramp at the start of a roughing operation, you end up with a full tool radius offset change on each ramp move.
- The feature you are cutting should have no sharp corners.
- Open profile sides should use the **insert arc** check box in the Stepovers tab (see page 985).
- Roughing operations create sharp corners on the inner stepovers if you use too large a tool. The default tool is always too large.
- There is a limit on depth of cut with a given tool. It is related to the no sharp corners rule. If you are cutting a rectangular pocket, when the tool moves along one side, the Y offset is 0. The corner radius must be large enough that the tool does not gouge the next side wall when it finishes the current cut. The limit is:
  - \[ R = \text{Radius (feature location to index axis)} \]
  - \[ CR = \text{Corner Radius of profile} \]
  - \[ TR = \text{Tool Radius} \]
  - \[ Diff = CR - TR \]
  - \[ A = \text{atan}(CR/R) \]
  - \[ \text{Max Depth} = \frac{Diff}{\tan(A)} \]
  - \[ \text{Max Depth} = Diff \times \frac{R}{CR} \]

**Restrictions of 4th-axis wrapping**

- You must use a post from the **4-Axis** directory. Normal posts do not support 4th-axis wrapping.
- The post CNC files have the indexing axis hard-coded. Most are set up to rotate about the X axis. The axis of rotation in your program must match the rotation axis of the post.

- If you are rotating around the stock X axis, the X axes of the setups must be parallel to the world X axis.

- If you are rotating around the stock Y axis the Y axes of the setups must be parallel to the world Y axis.

- 4th-axis wrapping is not simultaneous motion of four axes. Only three axes are active. In the case of X-axis wrapping, you get X and Z translational motion and a rotation around Y.

- 2D simulation does not work for 4th-axis wrapping.

If you are using Cut Sides perpendicular to index axis (see page 251) the following restrictions also apply:

- It does not apply to simple slots and grooves.

- The curve of the feature cannot have any sharp corners.

- If you are wrapping an open profile side, select the **Arc Lead** option on the **Stepovers** (see page 985) tab.

- If you preview the toolpaths and are getting wild moves at the feature edges, select a smaller tool. Often the automatically selected tool is too large. Most problems using **Cut sides perpendicular to index axis** are related to using a tool that is too large. Make sure the tool is small enough before making the changes discussed below.

- If the finishing pass for the walls of the feature does not immediately follow the roughing pass, you may need to adjust the plunge point for the finishing pass to ensure that it plunges near the center of the feature. You want to avoid plunging near the outside walls where the Y displacement is the greatest. If the initial move of the finish pass gouge, adjust the plunge point for the finish pass.
If your finish pass is starting in the center of the feature where there is no Y displacement, then no adjustment is necessary.

1 - Center of feature with no Y displacement

If the plunge move is out on the edges where the Y displacement is greater, then set a plunge point (see page 994) so that the tool plunges more toward the center of the feature.

1 - Edges with max Y displacement

4-axis simultaneous

A 4-axis simultaneous surface milling feature requires your machine to have four degrees of freedom. For FeatureCAM, the four degrees of freedom are restricted to moving in X, Y, and Z, and a rotation about the stock indexing axis (A, B, or C in the case of turn/mill). You may define 4-axis features in a turn/mill document with a tool that 'cuts from the OD'. You may also use 4-axis features in a 4-axis indexed milling environment in a milling document (see the Indexing tab of the Stock properties).
In an appropriate document type, with an appropriate post (.cnc file), some surface milling operations have a 4-axis (see page 1135) tab. The 4-axis tab enables you to control or specify the tool orientation. The default value is Vertical, which is used for standard 3-axis milling. However, it can also be a continuously changing orientation for 4-axis simultaneous machining. With 4-axis simultaneous, FeatureCAM tries to machine the feature's surfaces while tilting the tool axis in the way you specify.

FeatureCAM's 4-axis product is identical to its 5-axis (see page 256) product (there are no new terms, dialogs, or concepts to understand) with one important exception: during toolpath calculations, all tool axes are projected onto the appropriate plane. For instance, if the current document is an index-around-X type, then at a particular toolpath point, the tool axis is projected onto the STOCK YZ plane. This results in the toolpath point at (XYZ), and a tool axis of (0JK) so that (0JK) can be converted to an 'A' angle in the posting process.
5-axis positioning (5AP)

5-axis positioning enables you to mill 2.5D or 3D toolpaths at 5-axis orientations.

You must license the 5-axis positioning option to use 5-axis positioning.

5-axis positioning provides a convenient method of manufacturing parts that require milling on multiple faces by minimizing setups. The image below shows an example of a part that requires milling from four different orientations. With 5th-axis positioning, the whole part can be milled with a single program.

FeatureCAM provides two types of 5-axis positioning NC programs. The first method requires the operator to set only a single coordinate system (see page 263). The entire program is then generated with regard to this coordinate system. The advantage of this method is that it minimizes the setup time. The disadvantage is that the resulting NC programs are harder to read because the coordinates for milling each face are rotated.

The second method uses standard fixture offsets (see page 265) to determine the coordinate system for each face. The advantage of this method is that the code for each face is easier to read. The disadvantage is that the operator must touch-off each face.

5-axis machine types

The following 5-axis machine types are supported by FeatureCAM.
### Table on table machines

**Horizontal with stacked tables** — These horizontal milling machines rotate about the Y-axis, then around the X-axis. They are also called B over A machines.

**Vertical with stacked tables** — These machines are vertical mills that rotate about X-axis then around the Y-axis. These machines are also known as A over B machines.

### Machines with tilting heads

FeatureCAM supports tilting-head machines that have the following two capabilities:

- **3D coordinate transforms** — The control must allow programming of 2.5D features in the X and Y planes. This means that the depths of features are always in the Z or -Z directions.

- **Tool length offset** — The touch-off point (or zero point) of the tool must move with the rotated tool.

The machine architectures supported are as follows:
C rotary table and B tilting head — These machines rotate about Z and then the head rotates around the Y-axis.

C rotary table and A tilting head — These machines rotate about Z and the head rotates around X.
C swiveling and A tilting head — These machines rotate around Z with a table and then the head tilts around the X axis. They are also known as gimbal heads.

B and A tilting head — Rotates about Y using a table and then X in the head.
A and B tilting head — Rotates about X using a table and then Y in the head.

B and 45 Degree angled A tilting head — Rotate about Y, then rotate about X with a head that is angled by 45 degrees. This head is also known as a huron head.
A and 45 degree angled B tilting head — Rotate about X, then about Y with a head that is angled by 45 degrees. Also known as a huron head.

See machine dimensions for specific machine parameters.

Alternative 5-axis position

For some 5-axis machines, you can rotate the orientation of the machine axis by 180 degrees to address a particular face. FeatureCAM has a default orientation for each machine architecture.

To use the alternative orientation, specify the 5-axis position attribute at these levels:

- Operation level (see page 1161)
- Setup level (see page 212)
- Machine level (see page 1607)

As an example in the machine below, the default is to keep A in the 0 to 180 range and then find the suitable B.
With alternate enabled, we keep A in the 0 to -180 range and then find the suitable B.

The default and alternative orientations for each 5-axis machine type are shown below.

**Horizontal with stacked tables (rotate about Y then X)**
Default is to keep B 0 to 180, then find A. Alternative is to keep B 0 to -180, then find A.

**Vertical with stacked tables (rotate about X then Y)**
Default is to keep A 0 to 180, then find B. Alternative is to keep A 0 to -180, then find B.

**C rotary table and B tilting head**
Default is to keep B 0 to 180, then find C. Alternative is to keep B 0 to -180, then find C.

**C rotary table and A tilting head**
Default is to keep A 0 to 180, then find C. Alternative is to keep A 0 to -180, then find C.

**C swiveling and A tilting head**
Default is to keep A 0 to 180, then find C. Alternative is to keep A 0 to -180, then find C.

**B and A tilting head**
Default is to keep B 90 to -90 if Setup’s Z is positive and 90 to 270 if Setup's Z is negative, then find A. Alternative is to keep B 90 to 270 if Setup's Z is positive and 90 to -90 if Setup's Z is negative, then find A.

**A and B tilting head**
Default is to keep A 90 to -90 if Setup's Z is positive and 90 to 270 if Setup's Z is negative, then find B. Alternative is to keep A 90 to 270 if Setup's Z is positive and 90 to -90 if Setup's Z is negative, then find B.
5-axis positioning using a single coordinate system

This method minimizes setup time by requiring only a single touch-off point and is performed with the following steps:

1. Create a part with multiple Setups, then:
   - on the Multi-axis Positioning (see page 211) page of the Stock wizard, select 5th Axis Positioning and click Next; or
   - on the Indexing (see page 229) tab of the Stock Properties dialog, select 5th Axis Positioning, and click Fixture Location.

2. Select a Setup from the Use Origin of this Setup as the Touch-off Point list. The Z-axis of this setup must be parallel with the A-axis.

3. In the Offset of Touch-off Point from Machine Zero section, enter the distance, in each coordinate system direction, of the 5- Axis Touch-off Point from the center of the A-axis face. This distance is different for each part.

   In this example, the X and Y offsets are negative and the Z offset is positive.

   ![Diagram](image)

   1. Center of A-axis face
   2. Touch-off Setup origin

4. For the First Axis Rotational Offset, enter the angle (measured counter-clockwise) between the spindle axis and the A axis when the B angle is set to 0.
For example, if the A-axis faces the spindle when B is set to 0, then enter 0. If it faces the door when B is set to 0, as in the example below, then enter -90. This offset is set the same for all parts machined on a specific machine.

1. A-axis
2. Spindle axis
3. B-axis rotation

5. Select the dominance from:
   - **Tool Dominant** — If you want the order of operations to be tool dominant across all Setups, select this option.
     
     You must also select Minimize tool changes in the Automatic ordering options dialog (see page 1553) for Tool Dominant to work correctly.
   
   - **Setup Dominant** — If you want the order of operations to complete each Setup before moving on to another Setup, select this option. The milling ordering attributes determine the order in which operations are performed within a Setup.
     
     Select Generate Single Program if you want to create a single 5-axis indexed program.

6. Click Finish in the stock wizard or OK in the Stock Properties dialog.

7. Generate toolpaths. Ensure Minimize tool changes (see page 1553) is selected in the Automatic Ordering Operations dialog if you are using Tool-dominant toolpaths.
   
   The simulation works for both centerline and 3D simulation. In centerline simulation an arc is displayed for a 5-axis reorientation. In 3D simulation the part position and orientation stays fixed and the tool moves. The tool does not move smoothly between Setups, it reappears in the new Setup.

8. Select a 5-axis post processor and create NC code.
The NC code is generated with respect to the B-axis coordinate system. Only a single touch-off is required to locate the part.

The **Rotary Center Offset** values are contained in the post processor files. See five axis post processing variables for more information.

### 5-axis positioning using fixture offsets

To do 5-axis positioning using fixture offsets:

1. Create a part with multiple Setups, then:
   - on the **Multi-axis Positioning** (see page 211) page of the **Stock** wizard, select **5th Axis Positioning** and click **Next**; or
   - on the **Indexing** (see page 229) tab of the **Stock Properties** dialog, select **5th Axis Positioning**.

2. Click **Use Fixture Offset**. The **5-Axis Touch-off Setup** and **5-Axis Touch-off Setup Offset** do not apply to this method.

3. For the **B-Axis Rotational Offset**, enter the angle (measured counter-clockwise) between the spindle and the A-axis when the B angle is set to 0. For example, the A-axis faces the spindle when B is set to 0, then enter 0. If it faces the door when B is set to 0, as shown in this figure, then enter -90. This offset will be set the same for all parts machines on a specific machine.

4. Select the dominance from:
   - **Tool Dominant** — If you want the order of operations to be tool dominant across all Setups, select this option.
     
     You must also select **Minimize tool changes** in the **Automatic ordering options** dialog (see page 1553) for **Tool Dominant** to work correctly.
   - **Setup Dominant** — If you want the order of operations to complete each Setup before moving on to another Setup, select this option. The milling ordering attributes determine the order in which operations are performed within a Setup.
     
     Select **Generate Single Program** if you want to create a single 5-axis indexed program.

5. Click **Finish** in the stock wizard.

6. Generate toolpaths. Remember to select **Minimize tool changes**, if you want **Tool-dominant** toolpaths.
The simulation works for both centerline and 3D simulation. In centerline simulation an arc is displayed for a 5-axis reorientation. In 3D simulation the part position and orientation stays fixed and the tool moves. The tool does not move smoothly between setups, it simply reappears in the new setup.

7 Select a post processor that supports fixture offsets and create NC code.

8 The NC code is generated with respect to the coordinate system of each Setup. If you want to see the NC code for each Setup specified in machining coordinates (Y up and X to the right), then each Setup should be positioned so that the Setup coordinate system is aligned with the machine coordinates when that face is pointing toward the tool. The operator must touch-off each Setup individually.

**Rotation of primary axis**

The rotation of the primary axis (the B axis on an A over B machine) operates by default in the 0 - 90 and 90 - 180 quadrants. If you want to operate in 0 - -90 and -90 - -180 quadrants then use the following steps.

1 Hold down the **CTRL** key and click the right mouse button on the status bar at the bottom of the FeatureCAM screen.

2 Check the **Use -90 -180** for first axis rotation.

![Diagram of 4 quadrants](image)

**Stock models**

Stock models eliminate air cutting, save programming time, and save machining time by using more efficient toolpaths.

You can create stock models in FeatureCAM from:

- Stock
- Solid
- STL file
Some operation results:

- These 2.5D features' rough or finish operations: pocket, rectangular pocket, boss, side, chamfer, slot, step bore.
- A Z-level rough or parallel rough 3D operation

These operations can use a stock model:

3D surface milling operations:

- Z-level rough
- Parallel rough
- Parallel finish
- Z-level finish
- Isoline finish
- 2D spiral
- 3D spiral
- Radial

- Flowline
- Between 2 curves
- Horizontal + vertical
- Corner remachining
- Pencil
- Swarf
- Steep and shallow

2D rough or finish operations for these features:

- Boss
- Side

To create a stock model:

1. Right-click on Stock Models in the Part View (see page 4) and select Add Stock Model from the context menu.
The **Add Stock Model** dialog is displayed.

2 Enter a **Name** for the new stock model.

3 Enter a **Step Size** to edit the step between slices.

4 Enter a **Tolerance** to control the resolution of the stock model. Increasing the tolerance increases the precision of the slices which is useful for smaller parts, but this may cause FeatureCAM to run slower.

5 Select whether to create the stock model from:
   - **Stock** — This is the existing stock.
   - **Solid** — Select a solid in the menu.
   - **STL** — Select an .STL file in the menu.
   - **Operation results** — Select from the available 2.5D operations, a 3D Z-level rough, or a 3D parallel rough operation in the menu.

6 Click **OK** to create the new stock model.

The stock model is displayed below **Stock Models** in the **Part View**, for example:
To use a 2.5D stock model:

The stock model you created is available for you to use for subsequent Boss or Side features in the Select Stock Curve dialog, for example:

Open the Select Stock Curve dialog by clicking the Stock Curve button on the Dimensions (see page 905) tab of the Feature Properties dialog.

To use a 3D stock model:

The stock model you created is available for you to use for subsequent Z-level or parallel rough operations on the Stock (see page 1123) tab of the Surface Milling Properties dialog, for example:
**Stock Model Properties dialog**

You can open the **Stock Model Properties** dialog in one of these ways:

- Double-click the name of the stock model in the **Part View**.
- Right-click the name of the stock model in the **Part View** and select **Properties** from the context menu.

![Stock Model Properties dialog](image)

**Name** — This displays the name that you gave the stock model when you created it.

**Step Size** — Enter the step between slices. You can change the default by changing the **Stepover** attribute on the **Surface Mill** tab of the **Machining Attributes** dialog.

**Tolerance** — Enter the tolerance of a slice when a new stock model is created. The stock model is stored as a set of closed slices of the solid stock in X and Y. Increasing the tolerance increases the precision of the slices which is useful for smaller parts, but this may cause FeatureCAM to run slower. You can change the default by changing the **Tolerance (Rough)** attribute on the **Surface Mill** tab of the **Machining Attributes** dialog.

**Stock model operations** — This displays a list of the stock model operations.

**Available operations** — A list of operations that you can add to the stock model.

Click **+** to add the operation selected in the **Available operations** list to the **Stock model operations** list.

Click **-** to remove the selected operation from the **Stock model options** list. The operation is added to the **Available operations** list.
Stock model example

This example part uses a stock model to avoid air cutting:

The Z-level roughing toolpath of the initial Surface feature looks like this:
You can use these results to create a Stock Model.

If you create a second Surface feature with a Z-level rough using a tool half the size as for the first feature, the toolpath results look like this.

There is a lot of air cutting. You can use the stock model that you created from the first Z-level rough operation to avoid air cutting.
To do this, on the **Stock** tab for the second feature, select **Stock Model** and select the stock model name and the operation you want to use from the **Operations** list:

Using the stock model, the Z-level rough toolpath for the second feature has minimal air cutting:
Geometry

In FeatureCAM, geometry is the set of basic constructors you use to create shapes, from which you can create curves (see page 318). Geometry is displayed in black, for example:

Use these methods to create geometry:

- Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** dialog.

- Click the **Toggle Geometry Bar** button on the **Advanced** toolbar to display the **Geometry** toolbar.

- Select **Construct** from the menu to display the list of geometry creation tools.

When you are using any of the geometry tools, step-by-step instructions are displayed on the **Assistance** bar (see page 1), which explain how to use the active tool, for example:

Using the above methods, you can create points (see page 276), lines (see page 277), circles (see page 281), fillets (see page 285), arcs (see page 288), and dimensions (see page 290), and you can edit existing geometry (see page 314).
Snapping

Snapping (see page 295) enables you to snap the cursor to significant locations on existing geometry, and is necessary for creating smooth or continuous geometry. When you create geometry, it is aligned to the plane of the snapping grid (see page 296).

Geometry Constructors dialog

The **Geometry Constructors** dialog contains a selection of tools for creating and editing geometry:

![Geometry Constructors dialog](image)

To display the **Geometry Constructors** dialog, click the **Geometry** step in the **Steps** toolbar.

You can use these geometry tools:

- **Point** (see page 276)
- **Line** (see page 277)
- **Circle** (see page 281)
- **Fillet** (see page 285)
- **Arc** (see page 288)
- **Dimension** (see page 290)
- **Edit/Clip** (see page 314)

If you want to create multiple geometry objects without opening the **Geometry Constructors** dialog again, select **Create more than 1**.

Point input for geometry creation

When a point is needed, a message is displayed on the **Assistance** bar, such as **Pick first point**. The coordinates for that point are shown in yellow on the dialog bar.
Use one of the following methods to specify the location of a point:

- Enter the point coordinates into the yellow fields on the **Feature/Geometry Edit** bar, then click **Create**. This method is used for entering the exact location relative to the UCS, such as when reading from a drawing.
- Pick the point with the mouse in the graphics window. Use the appropriate snap mode (see page 295) to pick precise locations such as intersections or tangent points. This method is typically used when the point you want is relative to another piece of geometry.

### Exiting a geometry mode

When you enter a geometry creation mode, it remains enabled until you exit the mode. This enables you to create multiple geometry objects quickly without having to use the wizard or toolbars repeatedly.

Use one of these methods to exit geometry mode:

- In the **Standard** toolbar, click **Select**.
- Press the **Esc** key on your keyboard.
- Click a different step, toolbar or menu button.

*If you are using the **Geometry Constructors** dialog, deselect **Create more than 1** before selecting a tool to automatically exit geometry mode after using the tool.*

### Points

You can use these methods to create a point:

- Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click the **Point** button.
- In the **Geometry** toolbar, click **Point**.
- Select the **Construct > Point** menu option.

When a point is needed, a message is displayed on the **Assistance** bar, such as **Pick first point**. The coordinates for that point are shown in yellow on the dialog bar.

Use one of the following methods to specify the location of a point:
Enter the point coordinates into the yellow fields on the Feature/Geometry Edit bar, then click Create. This method is used for entering the exact location relative to the UCS, such as when reading from a drawing.

Pick the point with the mouse in the graphics window. Use the appropriate snap mode (see page 295) to pick precise locations such as intersections or tangent points. This method is typically used when the point you want is relative to another piece of geometry.

You do not usually need to create point objects, instead you can use snapping (see page 295) to locate points when creating geometry.

Lines

You can use these methods to create a line:

- Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click one of the line creation buttons.
- In the Geometry toolbar, click one of the buttons in the Line Menu.
- Select the one of the Construct > Line menu options.

You can draw the following types of lines:

- Two points (see page 277)
- Connected lines (see page 278)
- Horizontal line (see page 279)
- Vertical line (see page 279)
- Angle line (see page 279)
- Offset line (see page 280)

Two points line

Line from two points creates a finite (see page 316) line from two endpoints. To create the line:

1. Use one of these methods to enter line-creation mode:

   - Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Line from 2 Pts.
In the **Geometry** toolbar, click **Line from two Pts** in the Line Menu.

- Select the **Construct > Line > 2 Pts** menu option.

2 Pick or enter (see page 275) the location of the first point.

3 If you want to explicitly locate the second point, Pick or (see page 275) enter the location of the second point.

4 If you want to enter an angle and length (from which the second point is derived):
   - Enter the angle in degrees in the **A** field. The angle is specified counter-clockwise from the direction of the X axis.
   - Enter the length in the **L** field.

5 Press the **Enter** key or click the **Create** button.

6 When you have finished creating lines, exit line mode (see page 276).

**Connected lines**

**Connected lines** creates a series of finite (see page 316) lines from a series of points. The end point of one line becomes the start point of the next. To create the line:

1 Use one of these methods to enter line-creation mode:
   - Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click **Connected lines**.
   - In the **Geometry** toolbar, click **Connected Lines** in the Line Menu.
   - Select the **Construct > Line > Connected** menu option.

2 Pick or enter (see page 275) the location of the first point.

3 If you want to explicitly locate the next point, Pick or enter (see page 275) the location of the second point.

4 If you want to enter an angle and length (from which the next point is derived):
   - Enter the angle in degrees in the **A** field. The angle is specified counter-clockwise from the direction of the X axis.
   - Enter the length in the **L** field.

5 Press the **Enter** key or click the **Create** button.

6 Repeat steps 2 to 5 to create more lines.
7. When you have finished creating connected lines, exit line mode (see page 276).

**Horizontal line**

Horizontal line creates an infinite (see page 316) horizontal line through a point. To create the line:

1. Use one of these methods to enter line-creation mode:
   - Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Line horizontal.
   - In the Geometry toolbar, click Line Horizontal in the Line Menu.
   - Select the Construct > Line > Horizontal menu option.

2. Pick or enter (see page 275) the location of the point.

3. When you have finished creating horizontal lines, exit line mode (see page 276).

**Vertical line**

Vertical line creates an infinite (see page 316) vertical line through a point. To create the line:

1. Use one of these methods to enter line-creation mode:
   - Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Line vertical.
   - In the Geometry toolbar, click Line vertical in the Line Menu.
   - Select the Construct > Line > Vertical menu option.

2. Pick or enter (see page 275) the coordinates of the point.

3. When you have finished creating vertical lines, exit line mode (see page 276).

**Angle line**

Line at angle through point creates an infinite (see page 316) line through a point you select and at the angle you specify in degrees. To create the line:

1. Use one of these methods to enter line-creation mode:
Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Line at Angle thru Pt.

In the Geometry toolbar, click Pt, Angle in the Line Menu.

Select the Construct > Line > Pt, Angle from Horz/Vert/Line menu option.

Enter the angle in degrees in the A field. The angle is specified counter-clockwise.

To specify the angle relative to a vertical line passing through the point, select the From Vert. option.

To measure the angle relative to a horizontal line passing through the point, select the From Horiz. option.

To measure the angle relative to an existing line, select the From line option.

Pick or enter (see page 275) the coordinates of the point.

If you selected From line, you are prompted to select the line.

Click Create.

Repeat the process from step 2 to create more lines.

When you have finished creating lines, exit line mode (see page 276).

**Offset line**

**Offset** creates a new line, arc or circle by offsetting it from an existing line or arc.

Use one of these methods to enter offset mode:

Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Line Offset.

In the Geometry toolbar, click Line Offset in the Line Menu.

Select the Construct > Line > Offset menu option.

To offset an object by a specific distance:

1. Enter the distance in the Offset field.
2. Select an existing line, arc or circle in the graphics window.
You can also select a line from the stock even though there is no line explicitly there.

3  Move the cursor to the side of the selected object. A preview of the new object is displayed.

4  Left-click to create the offset.

To offset an object in real time:

1  Click and drag an object to the location you want the offset. A preview of the offset is displayed in the graphics window.
   You can use snapping (see page 295) to align the offset with existing geometry.

2  Release the mouse button to create the offset.

When you have finished creating offsets, exit the mode (see page 276).

**Circles**

You can use these methods to create a circle:

- Click the Geometry step in the Steps toolbar, then click one of the circle creation buttons in the Geometry Constructors (see page 275) dialog.
- Click one of the circle creation buttons in the Circle Menu in the Geometry toolbar.
- Select Construct > Circle from the menu and select one of the options.

You can draw these types of circles:

- Circle from radius and center (see page 282)
- Circle from center and edge (see page 282)
- Circle from diameter (see page 283)
- Circle tangent to two entities (see page 283)
- Circle from two points and radius (see page 284)
- Circle through three points (see page 284)
Circle from radius and center

**Circle from radius and center** creates a circle from a center point and a radius value.

To create the circle:

1. Use one of these methods to enter line-creation mode:
   - Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click **Circle from Rad, Center**.
   - In the **Geometry** toolbar, click **Circle from Rad, Center** in the **Circle Menu**.
   - Select the **Construct > Circle > Center, Radius** menu option.

2. Enter the radius at the **R** prompt in the dialog bar. If you are going to type the coordinate of the center point, press the **Tab** key.

3. Pick or type (see page 275) the point at the center of the circle.

4. When you have finished creating circles, exit circle mode (see page 276).

To specify the radius of the circle dynamically:

1. Click the mouse at the center point of the circle.

2. Drag the mouse to specify the radius of the circle.

Circle from center and edge

**Circle from center, edge** defines a circle by its center point and a point on the circle’s edge. The distance from the center point to the edge point is used as the radius of the circle. To create this type of circle:

1. Use one of these methods to enter circle-creation mode:
   - Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click **Circle from center, edge**.
   - In the **Geometry** toolbar, click **Circle from center, edge** in the **Circle Menu**.
   - Select the **Construct > Circle > Center, Edge** menu option.

2. Pick or type (see page 275) the **Center** point.

3. Optionally select **Concentric** to create more than one, concentric, circle.
4 Pick or type (see page 275) the **Edge** point. If you drag the mouse when locating the edge point, the circle interactively changes as you drag.

5 When you have finished creating circles, exit circle mode (see page 276).

**Circle from diameter**

**Circle from diameter** defines a circle from two points. The distance between the two points specifies the circle's diameter. The midpoint between the two points becomes the circle center. To create this circle:

1 Use one of these methods to enter circle-creation mode:
   - Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click **Circle from diameter**.
   - In the **Geometry** toolbar, click **Diameter** in the **Circle Menu**.
   - Select the **Construct > Circle > Diameter** menu option.

2 Pick or type (see page 275) the first point.

3 Pick or type (see page 275) the second point. If you drag the mouse when locating the second point, the circle changes interactively as you drag.

4 When you have finished creating circles, exit circle mode (see page 276).

**Circle tangent to two entities**

**Circle tangent two** defines a circle by snapping tangent to two existing objects. The location that you select the two objects determines the position of the new circle. Create this type of circle using these steps:

1 Use one of these methods to enter circle-creation mode:
   - Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click **Circle Tangent Two**.
   - In the **Geometry** toolbar, click **Circle tangent two** in the **Circle Menu**.
   - Select the **Construct > Circle > Tangent Two menu** option.
2 Enter the circle's radius in the dialog bar at the bottom of the screen.
3 Click the first object.
4 Click the second object.
5 When you have finished creating circles, exit circle mode (see page 276).

See also circles (see page 281)

**Circle from two points and radius**

Circle, two points, radius defines a circle of a specific radius and two individually defined point locations on the circle's circumference. The center of the circle is always placed to the left of the direction in which you define the two points through which the circle must pass.

If you want to create a circle that is tangent to two objects, use Circle tangent to two entities (see page 283).

1 Use one of these methods to enter circle-creation mode:
   - Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Circle Rad, 2 Pts.
   - In the Geometry toolbar, click 2 Pts, Radius in the Circle Menu.
   - Select the Construct > Circle > 2 Pts, Radius menu option.
2 Set the radius in the dialog bar.
3 Pick or type (see page 275) the first point.
4 Pick or type (see page 275) the second point.
5 When you have finished creating circles, exit circle mode (see page 276).

See also circles (see page 281)

**Circle through three points**

Circle from three points defines a circle with three points on the circle's circumference. A circle tangent to three existing circles or arcs can be created by selecting the existing elements with the tangent snap active. Use the following steps to create a circle through three points.

1 Use one of these methods to enter circle-creation mode:
Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click **Circle from 3 Pts**.

In the **Geometry** toolbar, click **3 Pts** in the **Circle Menu**.

Select the **Construct > Circle > 3 Pts** menu option.

2. Pick or type (see page 275) each point.

3. When you have finished creating circles, exit circle mode (see page 276).

See also circles (see page 281)

**Fillets**

2D Fillets create a rounded corner between other existing geometry and trim the existing geometry against the endpoints of the fillet. The figure on the left shows the original lines. The figure on the right shows these lines after the fillet has been inserted. Note that the lines are trimmed against the fillet.

You can use these methods to create a fillet:

- Click the **Geometry** step in the **Steps** toolbar to display the **Geometry Constructors** (see page 275) dialog, then click a fillet button.

- In the **Geometry** toolbar, click a button in the **Fillet Menu**.

- Select a **Construct > Fillet** menu option.

You can create these types of fillets:

- Corner fillet (see page 285)
- Two point fillet (see page 286)
- Three point fillet (see page 287)
- Chamfer (see page 287)

**Corner fillet**

**Corner fillet** creates a fillet (see page 285) in a corner originally defined by an intersection of lines or arcs.
1 Use one of these methods to enter fillet-creation mode:

- Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Corner Fillet.

- In the Geometry toolbar, click Corner Fillet in the Fillet Menu.

- Select the Construct > Fillet > Corner Fillet menu option.

2 Enter the radius in the R field.

3 Move the cursor over a corner or an intersection between two lines, arcs or circles. A preview of the fillet is displayed in the graphics window.

4 When the preview displays the fillet you want to create, left-click to create the fillet. Creating a fillet automatically trims the existing lines or arcs to the new fillet.

5 When you have finished creating fillets, exit fillet-creation mode (see page 276).

Two point fillet

Two point fillet creates a fillet (see page 285) in a corner originally defined by an intersection of lines or arcs. The corner fillet (see page 285) is usually easier to create, but the two point fillet may be easier to control if you are creating a fillet in a crowded area.

1 Use one of these methods to enter fillet-creation mode:

- Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click 2 Pt Fillet.

- In the Geometry toolbar, click 2 Pt Fillet in the Fillet Menu.

- Select the Construct > Fillet > 2 Pt Fillet menu option.

2 Enter the radius of the fillet in the R field.

3 Select an object.

4 Move the cursor over an object which intersects the first object. A preview of the fillet is displayed in the graphics window.

5 Left-click the second object to create the fillet. Creating a fillet automatically trims the existing lines or arcs to the new fillet.

6 When you have finished creating fillets, exit fillet mode (see page 276).
Three point fillet

Three points defines a fillet (see page 285) by selecting three points, similar to the three point circle (see page 284). To create this fillet:

1. Use one of these methods to enter fillet-creation mode:

   - Click the Geometry \( \text{\textbullet} \) step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click 3 Pt Fillet \( \text{\textbullet} \).
   - In the Geometry toolbar, click 3 Pt Fillet \( \text{\textbullet} \) in the Fillet Menu.
   - Select the Construct > Fillet > 3 Pt Fillet menu option.

2. Pick or enter (see page 275) the location of three points. The three points are the start, middle, and end points of the fillet. The points can be selected in clockwise or counter-clockwise order around the arc.

3. If the last point is entered in the dialog bar, click Create to create the fillet.

4. When you have finished creating fillets, exit fillet mode (see page 276).

2D Chamfer

To create a chamfer that trims surrounding geometry:

1. Use one of these methods to enter chamfer-creation mode:

   - Click the Geometry \( \text{\textbullet} \) step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Chamfer \( \text{\textbullet} \).
   - In the Geometry toolbar, click Chamfer \( \text{\textbullet} \) in the Fillet Menu.
   - Select the Construct > Fillet > Chamfer menu option.

2. Enter a Width and Height in the Geometry Edit bar.

3. Move the cursor over a corner or an intersection between two lines, arcs or circles. A preview of the chamfer is displayed in the graphics window.

4. When the preview displays the chamfer you want to create, left-click to create the chamfer. Creating a chamfer automatically trims the existing lines or arcs to the new chamfer.

5. When you have finished creating chamfers, exit chamfer mode (see page 276).
Arrows

Arrows create rounded curving segments defined as parts of circles. You can use these methods to create an arc:

- Click the Geometry step in the Steps toolbar to display the Geometry Constructors (see page 275) dialog, then click an arc button.
- In the Geometry toolbar, click a button in the Arc Menu.
- Select a Construct > Arc menu option.

If you want to create arcs at corners or intersections, see Fillets (see page 284).

You can create these types of arcs:

- Arc from three points (see page 288)
- Arc from two points and radius (see page 289)
- Arc from two points and center (see page 289)
- Arc from center, radius, begin, and end points (see page 290)

Arc from three points

Arc from three points constructs an arc (see page 288) through a start point, edge point, and a finish point.

To create an arc from three points:

1. Use one of these methods to enter arc-creation mode:
   - Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Arc from 3 Pts.
   - In the Geometry toolbar, click 3 Pts in the Arc Menu.
   - Select the Construct > Arc > 3 Pts menu option.
2. Pick or enter (see page 275) the location of each point.
3. Click Create to make the arc.
4. When you have finished creating arcs, exit arc mode (see page 276).

If you want to create an arc that is tangent to three objects, ensure the Snap to tangent snap mode is enabled.
Arc from two points and radius

Arc from two points, radius constructs an arc (see page 288) through two points with a specific radius.

1 Use one of these methods to enter arc-creation mode:

- Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Arc from Radius, 2 Pts.
- In the Geometry toolbar, click 2 Pts, Radius in the Arc Menu.
- Select the Construct > Arc > 2 Pts, Radius menu option.

2 Enter the radius of the arc in the R field.

3 Pick or enter (see page 275) the location of the beginning point. A display of the arc is displayed in the graphics window.

4 Pick or enter (see page 275) the location of the end point.

5 When you have finished creating arcs, exit arc mode (see page 276).

If you want to create an arc that is tangent to two objects, ensure the Snap to tangent snap mode is enabled.

Arc from two points and center

Arc from two points, center constructs an arc (see page 288) through two points with a specific center point.

1 Use one of these methods to enter arc-creation mode:

- Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Arc from Center, 2 Pts.
- In the Geometry toolbar, click Center, Beg, End in the Arc Menu.
- Select the Construct > Arc > Center, Beg, End menu option.

2 Pick or enter (see page 275) the location of the center point.

3 Pick or enter (see page 275) the location of the beginning point. A preview of the arc is displayed in the graphics window.

4 Pick or enter (see page 275) the location of the end point.
5  If you enter the last point in the dialog bar, click **Create** to make the arc.

6  When you have finished creating arcs, exit arc mode (see page 276).

**Arc from center, radius, begin, and end points**

This selection constructs an arc (see page 288) with a specific center and radius with the starting and ending points determined by angles.

1  Use one of these methods to enter arc-creation mode:

   - Click the **Geometry** step in the **Steps** panel to display the **Geometry Constructors** (see page 275) dialog, then click **Arc, Rad, Cen, Beg, End**.
   - In the **Geometry** toolbar, click **Center, Rad, Beg, End** in the **Arc Menu**.
   - Select the **Construct > Arc > Center, Rad, Beg, End** menu option.

2  Enter the radius in the **R** field.

3  Pick or enter (see page 275) the location of the center point.

4  Enter the **Begin Angle** in degrees. This angle is measured counter-clockwise from horizontal.

5  Enter the **End Angle** in degrees.

   - If the **Relative** option is deselected, the angle is absolute measured counter-clockwise from horizontal. If the **Relative** option is selected, the angle is measured relative to the **Begin Angle**.

6  Click **Create** to create the arc.

7  When you have finished creating arcs, exit arc mode (see page 276).

**Dimensions**

You can create dimensions in the graphics area which display various text labels or numerical dimensions on the model. Dimensions do not affect the behavior of the model, and cannot be used to create features or surfaces and so on.

You can use these methods to create a dimension:
Click the **Geometry** step in the **Steps** toolbar to display the **Geometry Constructors** (see page 275) dialog, then click a dimension button.

- In the **Geometry** toolbar, click a button in the **Dimension Menu**.
- Select a **Construct > Dimension** menu option.

You can create these types of dimensions:

- **Horizontal Distance** — dimension information only in the horizontal axis of the model.
- **Vertical Distance** — dimension information only in the vertical axis of the model.
- **Linear Distance** — dimension information based on the direct distance between two points, regardless of angle.
- **Radius** — dimension information for the radius of the selected object.
- **Diameter** — dimension information for the diameter of the selected object.
- **Angle** — dimension information for the angle between two selected lines.

You can create these types of text labels:

- **Text Label** — a floating text label, which is not pinned to an object.
- **Annotation** — a text label which is pinned to an object, with an arrow pointing to a specific location on the object. If you move the object, the annotation moves also.

**Curvature** samples the surface and computes the curvature in two directions to describe how the surface behaves at a point. Unlike the other dimensioning tools, **Curvature** is a real-time rubber-banding effect where you traverse the surface to find the point with the smallest curvature radius. From this information you can determine the smallest tool you need to manufacture the surface.

To use **Curvature**:

1. Select **Construct > Dimension > Curvature** from the menu.
2. Select a surface in the graphics window.
3. Move the cursor over a point on the surface, particularly in the tight constrained areas or joints. The properties of the point are displayed in the dialog bar.
4. Note the smallest value of the **Radius of curvature**. This is the smallest tool end radius you need to accurately machine the surface.
5 Set up rough and finish passes for the surface feature based on this knowledge, and ensure the tool is available for production. When using some dimension tools, you can enter information in the **Dimension** dialog bar (see page 292).

### Dimension dialog bar

When using some dimension tools, you can enter information in the **Dimension** dialog bar.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>0.123</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tolerance +</td>
<td></td>
<td>DX DY</td>
</tr>
</tbody>
</table>

You can enter the following information:

- **Prefix** — Text displayed before the numeric dimension in the graphics window. Leave a space at the end of the prefix if required.
- **Decimal Places** — The number of decimal places used when displaying the numeric dimension. The option **0.123** is selected by default.
- **Suffix** — Text displayed after the dimension in the graphics window. Leave a space at the beginning of the suffix if required.
- **Tolerance + and -** — The distance the dimension can deviate from the absolute listed dimension. The deviation allowances are displayed next to the dimension.
- **DX DY** — The distance from the previously selected point to the dimension text.

### Interrogation

Any numeric value in a dialog which has a blue label can be extracted from objects in the graphics window.

To use interrogation to extract a value from an object:

1. Click a blue label to hide the dialog.
2. Pick a point in the graphics window, use snapping modes (see page 295) to select the point you want.
3. If another point is required, repeat step 2.

When you have picked enough points for FeatureCAM to calculate the value for the field, the dialog is displayed, with the new value in the field.

Some values require one point to calculate, some require two:
<table>
<thead>
<tr>
<th>Value type</th>
<th>Number of points required</th>
<th>How FeatureCAM uses the point(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length or Width</td>
<td>2</td>
<td>Calculates the difference between either the X or Y coordinates of the points, depending on the type of dimension. If the dimension is shown vertically in the dialog, the Y coordinates are used. Horizontal dimensions use the X coordinates.</td>
</tr>
<tr>
<td>Angle</td>
<td>2</td>
<td>A line is created between the two points and the angle between that line and the Z axis is calculated.</td>
</tr>
<tr>
<td>Depth</td>
<td>2</td>
<td>The difference between the Z coordinates of the points is calculated.</td>
</tr>
<tr>
<td>X Y or Z</td>
<td>1</td>
<td>The X, Y or Z coordinate is extracted from the point.</td>
</tr>
<tr>
<td>Radius or Diameter</td>
<td>1</td>
<td>The radius or diameter of a circle can be extracted.</td>
</tr>
</tbody>
</table>

Alternatively, hold the Shift key and click a blue label to display the **Pick Dimension** (see page 293) dialog. When you click OK in the **Pick dimension** dialog, the value is automatically inserted into your dialog.

**Pick Dimension dialog**

The **Pick Dimension** dialog enables you to extract numbers from objects in the Graphics window using snapping modes (see page 295) and pick filters (see page 294). You can then copy these values and use them in other dialogs.

Use one of the following methods to display the **Pick Dimension** dialog:

1. Click the **Interrogation** button in the **Dimension Menu** in the **Geometry** toolbar.
2. Select **Construct > Dimension > Interrogation** from the menu.
If a dialog is displayed containing a field which has a blue label, hold the **Shift** key and click the blue label.

To use the **Pick Dimension** dialog:

1. Select a **Pick type** (see page 294), **Pick filter** (see page 294), and **Alignment** (see page 294).
2. Click **Pick location** and select any required points or items in the graphics window.
   - The measured dimension is displayed in the **Pick value** field.
3. Click **OK** to close the dialog.

**Pick types and pick filters for interrogation**

- **Location** — This extracts the X, Y or Z coordinate of a point. The coordinate extracted depends on the selected **Pick filter** setting. The coordinate system is based on the **Alignment** setting.

- **Distance** — This extracts the distance between two points. The **Pick filter** setting controls whether the distance is measured in the X, Y, Z directions, in the XY plane (2D filter) or in 3D. The coordinate system is based on the **Alignment** setting.

- **Same as** — This extracts either the radius or diameter of a circle or an arc, or the depth of a feature. In the case of blind holes, the overall depth of the hole is extracted, including the additional depth to represent the drill tip.

- **Length** — This extracts the length of a curve or geometry segment.

**Alignments for interrogation**

- **Grid** — The points are calculated in the plane of the snapping grid (see page 296).
- **UCS** — The points are calculated relative to the current UCS.
**Setup** — The points are calculated relative to the current Setup.

**None** — The points are calculated relative to the stock coordinate system.

## Snapping

Snapping helps you position lines, points, or shapes as you construct geometry for the part. Use it to select important points relative to existing geometry, such as intersections or end points.

To display the **Snap Modes** dialog:

- Select **Options > Snapping Modes** from the menu.
- Click the **Snap modes** button in the **Advanced** toolbar.

To display the **Snap Mode** toolbar (see page 15):

- Select **View > Toolbars** from the menu to display the **Customize Toolbars** dialog, select **Snap Mode** from the Toolbars list, then click **OK**.
- Right-click in a space in the toolbars area and select **Snap Mode** from the context menu.
- In the **Snap Modes** dialog, select **Show snap mode** toolbar.

The following buttons are displayed in the **Snap Modes** dialog and the **Snap Mode** toolbar:

- **Grid points** — Snaps the cursor to the rotating snapping grid (see page 296). You can specify the grid spacing in the **Snapping Grids** (see page 298) dialog.
- **Points** — Snaps the cursor to points (see page 276).
- **End points** — Snaps the cursor to the ends of line segments, arcs, and curves, and the corners of the stock.
- **Midpoints** — Snaps the cursor to the points equidistant from two ends of an open geometry object.
- **Even sections** — Divides open geometry objects into equal-sized segments and snaps the cursor to the ends of the segments. You can specify the number of segments in the **Section** field of the **Snapping Grids** dialog, the default is 5.
- **Toolpath** — Snaps the cursor to the toolpath lines.
- **Intersections** — Snaps the cursor to the points where geometry object meet.
- **Circle centers** — Snaps the cursor to the mathematical point equidistant from all points on a circle or an arc. If this button is selected, a cross is displayed at the centers of all arcs and circles in the graphics window. This option enables snapping to the center of circles displayed as Curvature (see page 290) dimensions.

- **Quadrants** — Snaps to the points on a circle or arc that the X and Y axes would pass through if the object was centered around the origin.

- **Objects** — Snaps the cursor to the nearest point on a geometry object.

- **Tangent to objects** — Snaps the cursor to the points on curved geometry which are on a tangent to the curve and the current mouse position.

- **Cylindrical center end point** — Snaps to the end points of a cylinder or cone axis.

- **Snapping Discrimination Dialog** — Displays the Snapping Discrimination (see page 297) dialog if more than one snapping option applies.

When you move the cursor over an object in the graphics window, the snapping mode applied to the cursor is displayed on the **Status** bar. A preview of the point is displayed in green, which changes shape depending on the snapping mode.

You can have more than one active snap mode. For example, you can snap tangent to a circle on one end of a line, then snap to an intersection at the other end of the line.

**Rotating snapping grid**

If you are snapping to the grid or locating general points without snapping to existing geometry, the points are placed in the plane of the snapping grid.

To show the snapping grid:

1. Select **Options > Snapping Grids** from the menu to display the **Snapping Grids** panel.

2. In the **Grid Display** section of the **Snapping Grids** panel, select **Always show**.

3. Click **OK** to close the panel.

The snapping grid rotates with the viewing plane and enables you to create geometry in different planes without having to create new user coordinate systems.
In the isometric view, the grid is on the top face:

![Isometric view diagram]

In the front view, the grid is on the front face:

![Front view diagram]

**Snap Discrimination Dialog**

If the *Snap Discrimination Dialog* option is selected in the *Snap Modes* dialog, when you select a point to which more than one snapping option applies, the *Snap Discrimination Dialog* is displayed. A list is displayed showing the snapping options which apply to the selected point.

![Snap Discrimination Dialog]

To use the Snap Discrimination Dialog:

1. Select a snapping option from the list.
2  Click OK.

Snapping Grids dialog

Select Options > Snapping Grids from the menu to display the Snapping Grids dialog.

X Origin — This sets where to start the grid points in the X direction in relation to the current UCS.

Y Origin — This sets where to start the grid points in the Y direction in relation to the current UCS.

X Spacing — This sets the distance between grid snap points in the X direction.

Y Spacing — This sets the distance between grid snap points in the Y direction.

High values of Spacing can result in the model displaying slowly.

X Length — This sets how far the grid displays in the X direction.

Y Length — This sets how far the grid displays in the Y direction.

Section — This sets how many segments to divide the open geometry into when snapping to sections.

Grid resizes to match — This sets whether the size of the grid is calculated from the Length values or the stock dimensions.

Grid Display — This sets when you see the grid and when you do not.

- Always show — This displays the grid, even if you have turned off snapping to grid.

- Always unshow — This hides the grid even if you have turned on snapping to grid.
- **Automatic** — This displays the grid when you are snapping to the grid, and hides the grid when you are not snapping to the grid.

You can change the size of the snapping cursor with the **Snapping Point Size** option on the **General** tab of the **Viewing Options** dialog (see page 44).

### Layers

Layers are useful for organizing the different elements in your part document.

Layers have a long history in CAD tools. Traditionally, layers are used to organize similar parts of a design or drawing.

*In FeatureCAM, for example, you could put geometry on one layer, named *geometry*, and features on another layer, named *features*.*

Layers are also useful for controlling the view. If your layers are well organized, you can turn the display of different layers on and off for even finer control than the **Show** (see page 37) and **Hide** (see page 39) menus offer. Setups and UCS can be used in similar ways.

*For example, you could put clamps on a layer, named *clamps*. The **Show** and **Hide** menus enable you to show/hide all solids, but you could show/hide clamps only by using a separate layer.*

Create and edit layers in the **Part View** (see page 300), or using the **Layers** (see page 301) dialog.

When you create a new element, it is created on all the layers that are active. Set which layers are active in the **Layers** (see page 301) dialog.

You can move an element from one layer to another by selecting it and dragging it to the new layer in the **Part View** or by using the **Change Layer** (see page 303) dialog.
Layers in the Part View

You can see a list of the document’s Layers in the Part View:

You can quickly show or hide layers using the check boxes.

- **System layer** — You cannot edit a System layer, but you can show or hide it.

- **User layer** — Add your own layers to organize your work. To add a new layer, right-click on the Layers item and select New Layer from the context menu.

- **Current layer** — New items are added to the current layer. Double-click on a user layer to make it the current layer. You cannot hide the current layer.

**Layers context menus**

Right-click on the **Layers** item in the Part View to display a context menu:

- **New Layer** — Select this option to create a new user layer.

- **Show All Layers** — Select this option to show the contents of all layers in the Graphics area.

- **Hide All Layers** — Select this option to hide the contents of all layers in the Graphics area.
Layers — Select this option to open the Layers dialog.

Right-click on a layer name in the Part View to display a different context menu:

Show Layer — Select this option to show the contents of the layer in the Graphics area.

Hide Layer — Select this option to hide the contents of the layer in the Graphics area.

Set as Current Layer — Select this option to set the layer as the current layer. New items are added to the current layer.

Rename — Select this option to rename the layer.

Delete — Select this option to delete the layer.

Select Contents — Select this option to select the contents of the layer. This is useful, for example, if you want to move them to another layer.

The Set as Current Layer, Rename, and Delete options are unavailable for system layers.

Layers dialog

Use the Layers dialog to create and edit the layers (see page 299) in your part document.

Use one of the following methods to display the Layers dialog:
Click the **Layers** button in the **Show Menu** of the **Advanced** toolbar.

Select **View > Layers** from the menu.

Click the current layer name on the **Status** bar (see page 32) and select **Layer Dialog** from the context menu.

Right-click **Layers** in the **Part View** and select **Layers** from the context menu.

**Current Layer** — This displays the name of the current layer. You can select a different layer from the list to make it the current layer.

**Active layers** — All layers in the document are listed in the lower part of the dialog. Selected layers, which have a check next to their names, are active and displayed in the graphics window. Any new elements that you create are created on all active layers. To create new elements on one or some layers only, deselect the layers you do not want to contain the new element to make them inactive.

For example, you could create a new layer called **Geometry** and make the other layers inactive, so that when you create new geometry it is drawn only on the geometry layer. If you have other existing geometry or points you need to use to construct your geometry, leave the other layers active.

**OK** — Click the **OK** button to save your settings and close the dialog.

**Cancel** — Click the **Cancel** button to close the dialog without saving any changes.

**New** — Click the **New** button to create a new layer.

**Delete** — Click the **Delete** button to delete the selected (highlighted in blue) layer(s).

**Rename** — Click the **Rename** button to change the name of the selected (highlighted in blue) layer.

**Preview** — Click the **Preview** button to preview the selected (highlighted in blue) layer(s).

**Help** — Click the **Help** button to open this Help topic.

**Name Layer dialog**
The **Name Layer** dialog is displayed when you click the **New** or **Rename** buttons in the **Layers** (see page 301) dialog.

Enter the name for the new layer or the new name for an existing layer. You can use upper case and lower case letter, number, and symbols.

**OK** — Click the **OK** button to save your settings and close the dialog.

**Cancel** — Click the **Cancel** button to close the dialog without saving any changes.

**Help** — Click the **Help** button to open this Help topic.

### Change Layer dialog

To open the **Change Layer** dialog, first select one or more entities in the Graphics window, then do one of the following:

- Right-click on the selected entity and select **Change Layer** from the context menu.

- Click the **Change Layer** button in the **Show Menu** of the **Advanced** (see page 12) toolbar.

- Select **Edit > Change Layer** from the menu.

Select the new layer from those listed.

**OK** — Click the **OK** button to save your settings and close the dialog.

**Cancel** — Click the **Cancel** button to close the dialog without saving any changes.

**Help** — Click the **Help** button to open this Help topic.

### Using math to define fields and shapes

In FeatureCAM, you can use a variety of mathematical tools to enter information into numeric fields, for example:

- Turning input modes (see page 304)
- Equations (see page 304)
- Variables and constants (see page 304)
- Operators (see page 305)
Mathematical (including trigonometric) functions (see page 307)  
Polar (see page 307) and Cartesian coordinates  
Degrees and radians  

**Turning input modes**  

Turning input modes determine how you enter coordinates when creating a Turning model.  
To change the turning input mode, select **Options > Turning Input Modes** from the menu and select one of the following options:  
- **3D (XYZ)** — Enter coordinates as X Y Z values.  
- **Radius (RZ)** — Enter coordinates as a radius and Z coordinate.  
- **Diameter (DZ)** — Enter coordinates as a diameter and Z coordinate.  

**Equations**  

You can use equations in numeric fields in FeatureCAM dialogs. In parametric mode (see page 309), the equation is always displayed. With parametric modeling off, the result of the equation is displayed.  
Equations are input similar to the DOS command line format. The operators are listed in the Operators table (see page 305). In a complex equation, multiplication and division operations are performed first, then addition and subtraction. Parentheses are also supported and can change the order of operation.  
You can specify real numbers in several ways, for example:  

1.  
   .1  
   1.234  
   1.e2  
   .1e3  
   .1e-4  
   1.2e+6  

Numeric arguments can be constants. The results of operators can be assigned to variables just like any other function:  

x = 1  
y = 2 * (x + 2)  
z = y * 47.5  

You can then use the variable in other numeric fields alone, or with other operations.
# Operators table

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>addition, adds two numbers</td>
</tr>
<tr>
<td>-</td>
<td>subtraction, subtracts two numbers</td>
</tr>
<tr>
<td>*</td>
<td>multiplication, multiplies two numbers</td>
</tr>
<tr>
<td>/</td>
<td>division, divides two numbers</td>
</tr>
<tr>
<td>sin(num)</td>
<td>Computes the sine of an angle (given in radians).</td>
</tr>
<tr>
<td>cos(num)</td>
<td>Computes the cosine of an angle (given in radians).</td>
</tr>
<tr>
<td>tan(num)</td>
<td>Computes the tangent of an angle (given in radians).</td>
</tr>
<tr>
<td>acosd(num)</td>
<td>Computes the arccosine (in degrees) of a number.</td>
</tr>
<tr>
<td>atand(num)</td>
<td>Computes the arctangent (in degrees) of a number. Result range is -90 to 90.</td>
</tr>
<tr>
<td>atan2d(y,x)</td>
<td>Computes the arctangent (in degrees) of y/x. Result range is -180 to 180.</td>
</tr>
<tr>
<td>ceil(num)</td>
<td>Returns the nearest integer greater than or equal to a number.</td>
</tr>
<tr>
<td>floor(num)</td>
<td>Returns the nearest integer less than or equal to a number.</td>
</tr>
<tr>
<td>fabs(num)</td>
<td>Returns the absolute value of a number.</td>
</tr>
<tr>
<td>sqrt(num)</td>
<td>Returns the square root of a number.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>sind(num)</strong></td>
<td>Computes the sine of an angle (given in degrees).</td>
</tr>
<tr>
<td><strong>cosd(num)</strong></td>
<td>Computes the cosine of an angle (given in degrees).</td>
</tr>
<tr>
<td><strong>tand(num)</strong></td>
<td>Computes the tangent of an angle (given in degrees).</td>
</tr>
<tr>
<td><strong>asin(num)</strong></td>
<td>Computes the arcsine (in radians) of a number.</td>
</tr>
<tr>
<td><strong>acos(num)</strong></td>
<td>Computes the arccosine (in radians) of a number.</td>
</tr>
<tr>
<td><strong>atan(num)</strong></td>
<td>Computes the arctangent (in radians) of a number.</td>
</tr>
<tr>
<td><strong>atan2(y,x)</strong></td>
<td>Computes the arctangent (in radians) of y/x. Result range is -pi/2 to pi.</td>
</tr>
<tr>
<td><strong>asind(num)</strong></td>
<td>Computes the arcsine (in degrees) of a number.</td>
</tr>
<tr>
<td><strong>mm2in(millimeters)</strong></td>
<td>Converts from millimeters to inches.</td>
</tr>
<tr>
<td><strong>exp(num)</strong></td>
<td>Returns e^x where e = 2.71828.</td>
</tr>
<tr>
<td><strong>log(num)</strong></td>
<td>Returns ln(x) where ln is the natural logarithm.</td>
</tr>
<tr>
<td><strong>log10(num)</strong></td>
<td>Returns the base-10 logarithm of a number.</td>
</tr>
<tr>
<td><strong>pow(base, power)</strong></td>
<td>Returns a base number raised to a power.</td>
</tr>
<tr>
<td><strong>degtorad(num)</strong></td>
<td>Returns an angle in radians as converted from degrees.</td>
</tr>
<tr>
<td><strong>radtodeg(num)</strong></td>
<td>Returns an angle in degrees as converted from radians.</td>
</tr>
<tr>
<td><strong>pi</strong></td>
<td>The mathematical value of pi to ten decimal places.</td>
</tr>
</tbody>
</table>
**Functions**

You can open the **Functions** dialog in one of these ways:

- Select **Construct > Curve > Other Methods > Functions** from the menu.
- Open the **Curve Wizard** (see page 325) and select **Other methods** as the method and **Function** as the constructor.

With functions, you create user-defined mathematical relationships to generate a graphical figure. Functions can be of several types:

- $y=F(x)$ (see page 357)
- $x=F(y)$ (see page 357)
- $r=F(a)$ (see page 358)
- $x=F(t)$, $y=G(t)$ (see page 360)
- $r=F(a)$, $Z=G(a)$ (see page 361)
- $x=F(t)$, $y=G(t)$, $z=H(t)$ (see page 362)

The variables $a$, $r$, $t$, $x$, and $y$ are local to the functions dialog. Any previous values that you have set for these variables are ignored. However, you are free to use any other previously defined variables. In addition to variables, you may use any predefined functions or constants discussed under **Equations** (see page 304).

Trigonometric functions are often used in constructing these functions. Be careful to use `sind()`, `cosd()`, and so on when using degrees and `sin()`, `cos()`, and so on when using radians.

**Polar coordinates**

You can input polar coordinates in any field that accepts point locations.

The coordinate input takes the form:

- `polarXd(r,\theta,Xc)` which is calculated as $r(\cos \theta) + Xc$.
- `polarYd(r,\theta,Yc)` which is calculated as $r(\sin \theta) + Yc$.

Where:

- `polar` specifies polar coordinates.
- `polarx`, is an X coordinate.
- `polary` is a Y coordinate.
- `d` specifies the angle in degrees.
polarxd is a polar coordinate for X with the angle of rotation specified in degrees.

polarx is a polar coordinate for X with the angle of rotation specified in radians.

For example, polarXd(1,45,2.5) polarYd(1,45,3.0) and polarX(1,π/4,2.5) polarY(1,π/4,3.0) describe the same point. the first in degrees, the second in radians.

the rotation is specified from, or parallel to, the x axis of the current Setup.

r is the length of the offset.

Ø is the rotation angle, which can be negative.

Xc, Yc an optional center point.

If you don’t specify a center point, the current origin for the Setup is used.
Editing a model

There are several ways to edit a model after you have created it. You can use the following methods to quickly make changes to the model:

- Select **Edit > Undo** from the menu to return FeatureCAM to the state before your previous change. **Undo** has multiple levels limited only by system resources.
- Select **Edit > Redo** from the menu to restore any changes you have undone.
- To modify a geometry object:
  1. Select an object in the graphics window or in the **Part View** panel.
  2. The object's properties are displayed in the **Geometry Edit** bar.
  3. Enter any values you want to change in the **Geometry Edit** bar.
  4. Click **Modify** to update the object with the new values.

Parametric modeling

When **Parametric modeling** is enabled, FeatureCAM remembers the connections between objects you create in the graphics window, so that updating one object automatically updates the linked object. For example, if a line was created tangent to two circles, this relationship is stored. If you change the location or radius of one of the circles, the line is updated to reflect that change.

By default, parametric modeling is off, to turn on parametric modeling, select **Options > Parametric Modeling** from the menu.

In the image below, a pocket was created from a curve, which was created from a series of circles connected by tangent lines:
By editing the diameter of one of the circles, the end points of the lines change, the curve changes and the pocket changes as shown below:

The Transform dialog enables you to move, rotate, scale, reflect or copy objects:

To display the Transform dialog, select the object(s) you want to transform, then:

- Click the Transform button in the Standard toolbar.
- Select Edit > Transform from the menu.
- Right-click on a selected object in the graphics window or the Part View panel and select Transform from the context menu.

You can transform geometry, curves, features, surfaces, or solids.

Features cannot be transformed using the Scale or To UCS methods.

To use the Transform dialog:
1. Select the transform method:
- **Translate** (see page 311) — Move selected objects to a new location. You can move an absolute distance as specified in XYZ vectors, or you can move from point to point.

- **Rotate** (see page 312) — Rotate selected objects by a specified angle about a point and axis.

- **Scale** (see page 312) — Scale the selected objects about a point, either uniformly, or along individual axes. This option is unavailable for features.

- **Reflect** (see page 313) — Mirror the selected objects about a line. The line can be an existing axis, or any other line.

- **To UCS** lets you transform objects from the current UCS into second UCS. Select either **Same Z** or **Oppose Z** to control the orientation of the Z axis of your object. This option is not available for features.

2 Select **Move** if you want to move the object to the new position.

3 Select **Copy** if you want to keep the original object and create a copy of it in the new position.

4 If you selected **Copy**, the **Copies** field is displayed. Enter the number of copies of the object you want to create.

   If you selected **Copy** and parametric modeling (see page 309) is on, the **Keep link to object** option is displayed. Select this option to link the new object to the original, so that changes to one object affect the other object.

To translate features, see Paste special (see page 1497).

**Translating an object**

To display the Transform dialog, select the object(s) you want to transform, then:

- Click the **Transform** button in the **Standard** toolbar.

- Select **Edit > Transform** from the menu.

- Right-click on a selected object in the graphics window or the Part View panel and select **Transform** from the context menu.

To translate an object:

1. Select **Translate** in the **Transform** dialog.

2. Select **Move** or **Copy**.

3. If you choose **Copy**, optionally select **Keep link to object**, and enter the number of **Copies**.

   **XYZ Distance** - enter the distance you want to move the entity in the X, Y, and Z directions.
**Distance from 2 points** - enter the coordinates of a point on the entity in the From fields or click in the From area and pick a point with the mouse. Enter the coordinates you want the selected point of the entity to appear in the To fields or click in the To area and pick that point with the mouse.

4 Click OK.

**Rotating an object**

To display the Transform dialog, select the object(s) you want to transform, then:

- Click the Transform button in the Standard toolbar.
- Select Edit > Transform from the menu.

Right-click on a selected object in the graphics window or the Part View panel and select Transform from the context menu.

To rotate an object

1 Select Rotate in the Transform dialog.
2 Select Move or Copy. If you choose Copy, optionally select Keep link to object, and enter the number of Copies.
3 Select Center point and X-axis to rotate around X.
4 Select Center point and Y-axis to rotate around Y.
5 Select Center point and Z-axis to rotate around Z.
6 To change the center point for either of these options, click the Pick location button and select the center point, or enter the coordinates.
7 If you would rather rotate about a line you have created, click Line and then click the Pick line button and then select the line in the graphics window.
8 Click OK.

**Scaling an object**

To display the Transform dialog, select the object(s) you want to transform, then:

- Click the Transform button in the Standard toolbar.
- Select Edit > Transform from the menu.

Right-click on a selected object in the graphics window or the Part View panel and select Transform from the context menu.

1 Select Scale in the Transform dialog.
2 If you want to scale the object the same amount in all directions, select **Uniform** and enter the **Scale XYZ factor**. (For example, a scale factor of 0.5 generates geometry at one half the size of the original for the first copy).

3 If you want to scale the object differently in each direction, deselect the **Uniform** check box and then enter separate X, Y and Z factors.

4 Scaling is performed relative to a point. Enter the coordinates of this point or click the **Pick location** button and select the point in the graphics window. Using a scale factor of 0.5, the distance between the point and the element would be decreased by half for the new element. When using multiple objects, you may want to select the centre point of the group of objects to maintain proportional spacing in the final drawing.

5 Select **Move** or **Copy**.

6 If you choose **Copy**, optionally select **Keep link to object**, and enter the number of **Copies**.

**Reflecting an object**

To display the **Transform** dialog, select the object(s) you want to transform, then:

- Click the **Transform** button in the **Standard** toolbar.
- Select **Edit > Transform** from the menu.

Right-click on a selected object in the graphics window or the **Part View** panel and select **Transform** from the context menu.

1 Select **Reflect** in the **Transform** dialog.

2 Select **Move** or **Copy**. If you choose **Copy**, optionally select **Keep link to object**, and enter the number of **Copies**.

3 Now you must specify the plane through which the objects are transformed. This plane can be specified by either selecting a plane (XZ, YZ or XY) and specifying the height of the plane (X, Y or Z respectively), or by picking a line and selecting one of the axis options (Line and X-axis, Line and Y-axis or Line and Z-axis).

4 Click **Finish**.
Multiple Regions

The **Multiple Regions** option affects how the **Trim**, **Extend**, and **Clip** functions work. When **Multiple Regions** is off, a clipped geometry is considered as multiple separate lines. When **Multiple Regions** is on, the clipped geometry is considered to be one line, even though it displays in multiple segments. Selecting either segment selects the entire line, or both segments. **Trim** and **Extend** can extend separate segments, or extend visible portions of lines depending on the setting of Multiple Regions.

To enable **Multiple Regions**, select **Options > Multiple Regions** from the menu.

Edit

You can use the **Edit** menu to modify existing geometry.

You can use these methods to edit geometry:

- Click the **Geometry** step in the **Steps** toolbar to display the **Geometry Constructors** (see page 275) dialog, then click an edit button.
- In the **Geometry** toolbar, click a button in the **Edit Menu**.
- Select a **Construct > Edit Geometry** menu option.

You can use the following edit tools:

- ![Clip](see page 315)
- ![Trim/extend](see page 315)
- ![Infinite](see page 316)

You can change how the edit tools behave by enabling or disabling parametric modeling (see page 309) and multiple regions (see page 314).
Clip

Clip removes a region of a line, arc, circle, or curve. A region is defined as a portion of an object between two intersection points. A region of a circle is highlighted between two lines in the figure below.

If you want to connect geometry into a curve using chaining, you do not need to completely trim the geometry.

To clip geometry:

1. Use one of these methods to enter clipping mode:
   - Click the Geometry step in the Steps panel to display the Geometry Constructors (see page 275) dialog, then click Clip.
   - In the Geometry toolbar, click Clip in the Edit Menu.
   - Select the Construct > Edit Geometry > Clip menu option.

2. Move the mouse over the object you want to clip. Note that as you move your mouse, the regions of geometric objects are highlighted. Click the mouse to remove a region.

3. When you have finished clipping, exit clipping mode (see page 276).

Restrictions

- You can trim curves against lines and arcs, but you cannot trim lines or arcs against curves.
- You cannot trim curves against other curves.
- You cannot clip infinite lines and circles unless they are crossed by a line or arc.
- Interactive feedback works only for lines and arcs.

Trim or extend

Trim/extend changes the length of a line or an arc. You can use Trim/extend to lengthen or shorten lines and arcs as follows:

1. Use one of these methods to enter trim/extend mode:
Click the Geometry step in the Steps panel to display the Geometry Constructors dialog, then click Trim/extend.

In the Geometry toolbar, click Trim/extend in the Edit Menu.

Select the Construct > Edit Geometry > Trim/extend menu option.

2 Click an endpoint of a line or an arc.

3 Click the new point. You can also drag the mouse to locate the new endpoint location.

*The new point does not have to be exactly on the line or arc. This does not change an element's orientation (location, angle, or radius).*

4 When you have finished trimming or extending lines and arcs, exit trim/extend mode (see page 276).

**Infinite**

*Infinite* changes arcs to full circles and finite lines (see page 316) into infinite lines (see page 316).

1 Use one of these methods to enter infinite mode:

- Click the Geometry step in the Steps panel to display the Geometry Constructors dialog, then click Infinite.

- In the Geometry toolbar, click Infinite in the Edit Menu.

- Select the Construct > Edit Geometry > Infinite menu option.

2 Click the arc or finite line you want to make infinite.

3 When you have finished with all the arcs and lines you want to make infinite, exit infinite mode (see page 276).

**Infinite and finite lines**

Finite lines are lines which have distinct endpoints. Geometry methods such as line from two points (see page 277) create finite lines using the endpoints you specify. Infinite lines do not have endpoints and therefore go on forever. No matter how much you zoom or pan, you never see the end of these lines. Infinite lines are used to represent lines with a particular slope, such as horizontal (see page 279) or vertical (see page 279) lines.
You can change an infinite line to a finite line using Clip (see page 315) or a finite line to an infinite line using Infinite (see page 316).

**Decimal Places dialog**

The **Decimal Places** dialog specifies the number of decimal places displayed.

To display the **Decimal Places** dialog, select **Options > Decimal Places** from the menu.

There are two lists:

- **English** — The number of decimal places displayed in models using English units (inches).
- **Metric** — The number of decimal places displayed in models using metric units (mm).

Select the number of decimal places from the lists. For example if you want four decimal places displayed, select **0.1234**.

*Some dialog fields may not be wide enough to display the selected number of decimal places. If this is the case, select the value in the field and press the left and right arrow keys on the keyboard to scroll.*
Curves

Curves are paths in 2D or 3D space from which you can create surfaces (see page 381), solids (see page 445), and features (see page 529). You can create them in FeatureCAM or import them from a CAD system. Curves are displayed in blue, for example:

Curves can be open or closed. Open curves have end points that do not meet. Some features must be created from a closed curve. A closed curve defines an area that is separate from the exterior of the curve.

Use these methods to create curves:

- Click the Curves step in the Steps panel to display the Curve Creation dialog (see page 319).
- Use the Curves and Surfaces toolbar (see page 13).
- Select the Construct > Curve menu option to display the list of curve creation tools.

You can create curves from geometry objects (see page 318), from other curves, from points (see page 367), from cam dimensions (see page 364), from Windows fonts (see page 368), or from surfaces (see page 343). Many curve creation methods are available from the Curve wizard (see page 325).

Any ambiguities such as overlapping or intersecting curve links can cause failures and unpredictable results in the machining routines in FeatureCAM.
Curve Creation dialog

To display the Curve Creation dialog, click Curves in the Steps panel.

![Curve Creation dialog]

- **Closed Curve** (see page 320) — Chain (see page 319) pieces of geometry into a closed boundary using a single mouse click.
- **Pick Curve Pieces** (see page 321) — Chain (see page 319) pieces of geometry into an open boundary using a mouse click at each end.
- **Curve Wizard** (see page 325) — Create curves using the curve wizard (see page 325).
- **Surface Projection** (see page 351) — Chain projections of vertical surfaces into curves using mouse clicks.

Chaining

Lines, circles, and arcs typically represent the shape of a part. To use a sequence of lines and arcs to create a feature, you must chain them into a curve. Chaining is the primary way of creating curves by connecting pieces of geometry. In many cases you do not need to trim the geometry before creating a curve; chaining works better with smooth, tangent-continuous paths because these paths are more conducive to manufacturing.

There are two chaining modes; **Closed Curve** (see page 320) and **Pick Curve Pieces** (see page 321).
You can use **Pick Curve Pieces** (see page 321) to select the geometry segments manually, or **Closed Curve** (see page 320) to automatically generate a closed path. You can also double-click when using **Pick Curve Pieces** (see page 321) to automatically generate a closed path.

- In the example below, left-clicking at point 1 in **Closed Curve** (see page 320) mode (or double-clicking at point 1 in **Pick Curve Pieces** (see page 321) mode) creates a closed curve around the geometry:

![Diagram of a closed curve]

- In the example below, left-clicking at point 1, then left-clicking at point 2 in **Pick Curve Pieces** (see page 321) mode creates an open curve along a path that connects the geometry:

![Diagram of an open curve]

You can continue to click on geometry segments to chain them to the curve. You can then complete the curve by clicking the **Create** button, or continue chaining to create a closed loop.

**Closed Curve**

**Closed Curve** enables you to automatically generate a closed path along a series of geometry segments and chain them into a closed curve.

To use **Closed Curve**:

1. Use one of the following methods to enter **Closed Curve** mode:
Click the Curves step in the Steps panel to display the Curve Creation dialog, then click the Closed Curve button.

Click the Closed Curve button in the Chain Menu in the Geometry (see page 17) toolbar.

Select Construct > Curve > Chaining > Closed Curve from the menu.

1. Enter a name for the curve in the Name field, or leave it as default to use the automatically generated name.

2. Select the Plane in which you want to create the curve.
   - Grid — Select this option to create the curve in the plane of the snapping grid (see page 296).
   - UCS — Select this option to create the curve in the plane of the UCS (see page 109).
   - Setup — Select this option to create the curve in the plane of the Setup (see page 114).
   - Unrestricted — Select this option to create a 3D curve.

3. Click on a geometry object in the graphics window to display a preview of the curve.

4. If the curve follows the wrong path, click Clear Pieces to deselect the created path, then repeat step 4.

5. Click Create or press the Enter key to create the curve.

**Pick Curve Pieces**

Pick Curve Pieces enables you to manually select a path along a series of geometry segments and chain them into either an open or a closed curve.

To use Pick Curve Pieces:

1. Use one of the following methods to enter Pick Curve Pieces mode:
   - Click the Curves step in the Steps panel to display the Curve Creation dialog, then click the Pick Curve Pieces button.
   - Click the Pick Curve Pieces button in the Chain Menu in the Geometry (see page 17) toolbar.
   - Select Construct > Curve > Chaining > Pick Pieces from the menu.
2 Enter a name for the curve in the **Name** field, or leave it as default to use the automatically generated name.

3 Select the **Plane** in which you want to create the curve.
   - **Grid** — Select this option to create the curve in the plane of the snapping grid (see page 296).
   - **UCS** — Select this option to create the curve in the plane of the UCS (see page 109).
   - **Setup** — Select this option to create the curve in the plane of the Setup (see page 114).
   - **Unrestricted** — Select this option to create a 3D curve.

4 Click on a series of geometry segments in the graphics window to create a path along them. A preview of the curve is displayed in blue in the graphics window.

5 If you select the wrong segment, or the curve follows the wrong path, do one of the following:
   - Click the **Undo** button in the **Standard** toolbar to clear the previously selected segment.
   - Click the **Clear Pieces** button in the dialog bar to deselect all segments.
   - Use **Unpick Curve Pieces** (see page 324) to unchain geometry segments. Repeat step 1 to enter **Pick Curve Pieces** mode.

6 Click **Create** or press the **Enter** key to create the curve.

**Restrictions of using pick pieces (chaining) for creating curves**

- All of the geometry must be shown on the screen.
- **Pick Curve Pieces** does not work for curve segments; you can only connect arcs, lines, and circles. To connect curve segments use Curve join (see page 327).
- The geometry must be tangent continuous (smooth). Even if your geometry looks smooth, it may not be. Make sure that you have used tangent snapping when creating the geometry.
- Chaining has a limit on its search path length in order to improve performance. If you are working with data with a lot of small pieces you may need to increase this limit.

**Troubleshooting pick pieces (chaining)**

- I cannot form a closed loop.
Your data may be too complex to use the double-click interface. If double-clicking (or single clicking in **Closed Curve** mode) does not work, click the start segment, then click the next segment you want to add to the curve, and proceed until you have selected the complete curve. If there is only one simple path between points, click a couple of segments apart and FeatureCAM finds the path that connects them.

The whole target curve must be visible on screen. Show the additional geometry if it is not displayed.

If you are working with data with many small pieces you may need to increase the **Double-click Depth** or **Single Click Depth** in the **Chaining Options** (see page 324) dialog. To see if this is the case, go into **Select** mode and then pick pieces of your geometry. Increasing the **Endpoint tolerance** setting should also help.

Arcs and fillets need to be tangent or chaining may choose the other branch. Make sure that the geometry is really tangent by recreating the geometry that does not chain by using the **Snap to tangent** snap mode. You may want to turn off the other snap modes to ensure that you are truly snapping to the tangent.

Gaps between the endpoints of geometry objects must be less than the **Tolerance** value, which you can specify in the **Chaining Options** (see page 324) dialog. Look for blue squares in the chaining data. They indicate that the curve is not connected to another piece at that point. Zoom in on that data. Select the pieces in the gap. If there are no pieces, you may need to increase the **Endpoint tolerance**.

The loop that is selected is wrong.

If double-clicking is selecting the wrong loop, the data may have sharp corners or the algorithm may just be making some wrong decisions. If double-clicking does not work, you can click the start segment, then click the next segment you want added to the curve and proceed until you have selected the complete curve. If there is only one simple path between points, you can click a couple of segments apart and FeatureCAM finds the path that connects them.

I cannot pick the pieces.

You are probably picking pieces that are already curves. You must use Curve join (see page 327).

Chaining does not work in 3D.

When you enter **Chaining** mode, select the **Unrestricted** button in the dialog bar. This enables chaining to pursue links that are not planar.

Chaining is working in the wrong plane.
The Grid, UCS and Setup buttons restrict the plane of chaining. Select a plane and re-chain.

Unpick Curve Pieces

Unpick Curve Pieces allows you to deselect geometry segments when chaining. This is useful if you select the wrong geometry segment when chaining, or the curve you are creating follows the wrong path.

To use Unpick Curve Pieces:

1. Click the Unpick Curve Pieces button in the Chain Menu in the Geometry (see page 17) toolbar.
2. Click on a selected geometry segment in the graphics window to deselect it.

Chaining Options dialog

The Chaining Options dialog contains settings which you can use to improve your chaining results.

Use one of the following methods to display the Chaining Options dialog:

- Select Options > Chaining from the menu.
- Click the Options button in the dialog bar when using chaining.

The Chaining Options dialog contains the following settings:

- Avoid sharp corners — This option causes the chaining process to select paths which do not contain sharp (acute) corners if possible.
- **Chain only on-screen geometries** — This option causes the chaining process to use only the geometry visible on screen for calculations. If you have a part which has many pieces of geometry, you can zoom in on the curve you want to chain to simplify the process. If deselected, chaining can be slow on parts with lots of geometry, because FeatureCAM considers all geometry in the part, even if you are chaining a single closed circle and it is the only visible geometry.

- **Endpoint tolerance** — Geometries separated by a distance less than this value are considered to intersect. You may need to use a higher value for imported data than for data created in FeatureCAM.

- **Double-click depth** — The number of segments FeatureCAM analyzes in each direction to connect your start and end points. You may need to use a higher value for imported data than for data created in FeatureCAM.

- **Single-click depth** — Enter the number of segments the program analyzes in each direction to connect your start and end points for manual chaining. You may need to use a higher value for imported data than for data created in FeatureCAM.

### Creating curves

Use one of the following methods to create curves:

- **Curve Wizard** (see page 325) dialog.
- **Curves and Surfaces** (see page 13) toolbar.
- From the menu, select **Construct > Curve** and select one of the options.

### Curve Wizard

The **Curve wizard** contains a list of all the curve creation tools, grouped by method of construction.

Use one of the following methods to display the **Curve Wizard** dialog:

- Click the **Curves** step in the **Steps** panel to display the **Curve Creation** dialog, then click the **Curve wizard** button.
- Click the **Curve Wizard** button in the **Advanced** toolbar.
Select **Construct > Curve > Curve Wizard** from the menu.

To use the **Curve Wizard** dialog:

1. Select a method of construction from the list at the top of the dialog, from the following:
   - **Curve from curve** (see page 327)
   - **Curve from surface** (see page 343)
   - **Other methods** (see page 356)
   A list of specific constructors for the selected method of construction is displayed at the bottom of the dialog.

2. Select a specific constructor from the list at the bottom of the dialog.

3. Click **Next** to display the selected constructor's dialog.
**Curve from curve**

You can use the **Curve wizard** (see page 325) to create curves from existing curves.

![Curves Wizard](image)

You can create the following types of curve from curves:

- **Join** (see page 327)
- **Curve Start/Reverse** (see page 329)
- **Offset** (see page 332)
- **Project to UCS** (see page 333)
- **Extract Font Curve** (see page 334)
- **Smooth/Reduce Curve** (see page 335)
- **Unwrap Curve** (see page 339)
- **Merge Curves** (see page 341)

**Join**

**Join** connects a series of curves and geometry objects into a single curve. If the end points are not in the same location, a straight line is drawn between them to create the curve. You can specify the order of the objects manually or allow FeatureCAM to calculate the path along them. You can only join whole curves and geometry objects, to connect segments see **Chaining** (see page 319).

To use **Join**:
Use one of the following methods to display the Join Curves dialog:

- In the Curve Wizard (see page 325), select Curve from curve, then Join, then click Next.
- Select Construct > Curve > From Curve > Join from the menu.
- Click the Join button in the Curve From Curve menu in the Curves and Surfaces (see page 13) toolbar.

Optionally enter a curve name in the Name field, or leave the default name.

Use one of the following methods to add the curves you want to join to the Objects list:

- Select a curve in the Curve list and click the Add item from list button.
- Select a curve in the graphics window or the Part View panel and click the Add item from list button.
- Click the Pick curve or geometry button and select a curve in the graphics window.

Select Show Preview to display a preview of the new curve in the graphics window.

To change the order of the objects, click the Move item up and the Move item down buttons.

To reverse the direction of an object, select it from the Object list and click the Reverse selected curve button.

To remove an object from the Objects list, select it and click the Delete item button.
7 Optionally select **Connect start and end**. This draws a straight line between the open end of the first curve and the open end of the last curve. A preview of this line is shown in the graphics window; ensure the line does not intersect the curve.

8 Click **OK** (or **Finish** if you are using the wizard).

The **Tolerance** is used in two ways:

- When FeatureCAM decides how to order the segments. If the distance between two segments is lower than the tolerance value, they are considered adjacent and are joined together; otherwise the closest segment is joined with a straight line.

- When creating the new curve from the ordered segments. If the distance between the first point of a segment and the last point of the previous segment is less than the tolerance value, the first point is not added; otherwise the first point is added to the new curve, resulting in a line segment between the two points.

When working with curves, FeatureCAM examines the last control point as compared to the first control point of the next object. Arcs are converted to curves and manipulated as curves. When comparing points, FeatureCAM uses a Manhattan distance.

**Curve Start/Reverse**

Curves have a start point, an end point, and a direction. You can use **Curve Start/Reverse** to change the direction of a curve (see page 329) or change the start point of a curve (see page 330).

Changing the direction (see page 329) of a curve has a number of possible uses:

- to change the direction of a sweep in a swept surface.
- to change the direction of a curve in a surface.
- to change the direction of a curve as you are joining curves together.

Changing the start point (see page 330) of a curve is helpful for operations such as **Ruled surface** (see page 392). The start points of the two curves are used to form a correspondence between the curves when the surface is created.

**Reversing a curve**

You can reverse the direction of open and closed curves:
1. Use one of the following methods to display the **Curve Start/Reverse** dialog:

- In the **Curve Wizard** (see page 325), select **Curve from curve**, then **Curve Start/Reverse**, and click Next.
- On the **Curves and Surfaces** (see page 13) toolbar, click the **Curve Start/Reverse** button in the **Curve from Curve** menu.
- From the menu, select **Construct > Curve > From Curve > Curve Start/Reverse**.

1. If you want to create a new curve, select **Create new curve**. Optionally enter a curve name in the **Name** field, or leave the default name.

2. If you want to replace the old curve with the new, select **Modify existing curve**.

3. Select the curve you want to use from the **Curve** menu, or click the **Pick Curve** button and select it in the graphics window. The direction of the curve is displayed in the graphics window.

4. Select **Reverse**.

5. Click **Preview**. The direction of the new curve is displayed.

6. Click **OK** (or **Finish** if you are using the wizard).

**Changing the start point of a curve**

You can change the start point of closed curves:
1 Use one of the following methods to display the **Curve Start/Reverse** dialog:

- In the **Curve Wizard** (see page 325), select **Curve from curve**, then **Curve Start/Reverse**, and click **Next**.
- On the **Curves and Surfaces** (see page 13) toolbar, click the **Curve Start/Reverse** button in the **Curve from Curve** menu.
- From the menu, select **Construct > Curve > From Curve > Curve Start/Reverse**.

1 If you want to create a new curve, select **Create new curve**. Optionally enter a curve name in the **Name** field, or leave the default name.

2 If you want to modify the existing curve, select **Modify existing curve**.

3 Select the curve you want to use from the **Curve** menu, or click the **Pick Curve** button and select it in the graphics window. The direction of the curve is displayed in the graphics window. The start point is at the tip of the direction arrow.

4 Select **Set start point**.

5 Enter the location of the new start point in the **Start point** fields, or click the **Pick new start point** button and select it in the graphics window.

6 Click **Preview**. The direction arrow moves to the new start point location.

7 Click **OK** (or **Finish** if you are using the wizard).
**Offset**

**Offset curve** offsets a curve in a specified direction by a specified distance.

> Offset is a mathematical function based on the curve. It is not necessarily a linear transformation. If you just want to move a curve, use the **Transform** (see page 310) dialog.

1. Use one of the following methods to display the **Offset Curve** dialog:

   - In the **Curve Wizard** (see page 325), select **Curve from curve**, then **Offset**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Offset** button in the **Curve from Curve** menu.
   - From the menu, select **Construct > Curve > From Curve > Offset**.

1. Optionally enter a curve name in the **Name** field, or leave the default name.

2. Select the curve you want to use from the **Curve** menu, or click the **Pick Curve** button and select it in the graphics window.

3. Enter the **Offset** distance.

4. Select **Left** or **Right** to offset the curve in the direction you want. The new curve is displayed in blue in the graphics window.
5 Offsetting a curve sometimes results in overlapping regions, for example:

To remove such regions, select **Eliminate self-intersections** and enter a **Tolerance**. The overlapping regions are trimmed away:

6 Click **OK** (or **Finish** if you are using the wizard).

> **Offsetting a curve can have somewhat surprising results depending on the nature of the curve, for example, arc sections of the curve might reverse themselves. Until you are familiar with the effects of **Offset**, you should save your work before performing the offset to be sure you can return to a good set of data for your part model.**

**Project to UCS**

Project to UCS displays a curve's 'shadow' in a different coordinate system. Projecting to UCS creates a new curve in the selected UCS, but does not affect the original.

This method assumes that you are projecting a curve from one UCS to the one you are currently in.
1 Use one of the following methods to display the Project to UCS dialog:

- In the Curve Wizard (see page 325), select Curve from curve, then Project to UCS, and click Next.
- On the Curves and Surfaces (see page 13) toolbar, click the Project to UCS button in the Curve from Curve menu.
- From the menu, select Construct > Curve > From Curve > Project to UCS.

1 Optionally enter a curve name in the Name field, or leave the default name.
2 Select the curve you want to use from the Curve menu, or click the Pick Curve button and select it in the graphics window.
3 Select the UCS from the list.
4 Select the plane you want to project the curve to from YZ Plane, XZ Plane, or XY Plane.
5 Click OK (or Finish if you are using the wizard).

**Extract Font Curve**

When you create text in FeatureCAM, it is created as a single curve. You can use Extract Font Curve to extract characters or segments from the curve so you can edit them.

To extract a font curve, the model must contain engraving text.

To extract a font curve:
1 Use one of the following methods to display the **Extract Font Curves** dialog:

- In the **Curve Wizard** (see page 325), select **Curve from curve**, then **Extract Font Curves**, and click **Next**.
- On the **Curves and Surfaces** (see page 13) toolbar, click the **Extract Font Curves** button in the **Curve from Curve** menu.
- From the menu, select **Construct > Curve > From Curve > Extract Font Curves**.

2 Optionally enter a curve name in the **Name** field, or leave the default name.

3 Select a text curve from the **Font** list, or click the **Pick Curve** button and select it in the graphics window.

   The font used to create the text determines some things about the behavior of the **Font Segment** option. If the character encloses open space such as the letter 'P', you can select either the inner or outer curve segment. If the **Machine Tool Sans Serif** font is used, many of the characters are drawn in separate segments so you can only select individual segments of that font with this function.

4 To extract a single segment or character, click the **Font Segment** button and select it in the graphics window.

5 To extract all characters in the selected text curve as separate curves, click the **Select All** button.

6 Click **OK** (or **Finish** if you are using the wizard).

### Smooth/Reduce Curve

To reduce curve data:
1 Use one of the following methods to display the **Smooth/Reduce Curve** dialog:

- In the **Curve Wizard** (see page 325), select Curve from curve, then Smooth/Reduce Curve, and click **Next**.
- On the **Curves and Surfaces** (see page 13) toolbar, click the Smooth/Reduce Curve button in the Curve from Curve menu.
- From the menu, select Construct > Curve > From Curve > Smooth/Reduce Curve.

2 Optionally enter a curve name in the **Name** field, or leave the default name.

3 Select the curve you want to use from the **Curve** menu, or click the **Pick Curve** button and select it in the graphics window.

4 If you want to create a new curve, select **Create new curve**.

5 If you want to replace the old curve with a new one, select **Modify existing curve**.

6 Select the curve reduction method (see page 338) by either:
   - Selecting **Smooth spline approximation**, or
   - Selecting **Arc/line approximation** and selecting **Chain arcs/lines**

7 Enter a **Tolerance**. This number indicates how closely the new curve approximates the original curve.

8 Click the **Preview** button.

9 The **Data reduction %** is displayed in the dialog, which shows you how much less data the new curves occupies versus the original curve.
10 If the **Tolerance** value results in a curve which has more data than the original, a warning dialog is displayed. To reduce the amount of data in the new curve, increase the tolerance. Creating a smoother curve requires more data. This frequently occurs with piecewise linear input curves where the tolerance is smaller than the linear pieces that comprise the curves. This operation performs a combination of both smoothing and data reduction.

11 If you want to see this curve extruded as a sample use of the new curve, select **Show preview surface** button and click **Preview** again. A surface is displayed. This surface can be shaded to check the quality of the curve.

12 Repeat steps 6 - 10 until you are happy with the resulting curve.

13 Click **OK** (or **Finish** if you are using the wizard).

**Approximating curves with lines and arcs**

How to approximate curves with lines and arcs:

1. Use one of the following methods to display the **Smooth/Reduce Curve** dialog:

   - In the **Curve Wizard** (see page 325), select **Curve from curve**, then **Smooth/Reduce Curve**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Smooth/Reduce Curve** button in the **Curve from Curve** menu.
   - From the menu, select **Construct > Curve > From Curve > Smooth/Reduce Curve**.

2. Select a curve from the **Curve** list or in the graphics window.

3. Select **Arc/line approximation**.
4 Deselect Chain arcs/lines.

5 Enter a Tolerance. This number indicates how closely the arcs and lines come to the original data. If you created the curve initially, try to use a tolerance that is larger than you used to create the curve.

6 Click the Preview button.

7 The data reduction % value is displayed which shows you how much less data the arcs and lines require than the original curve.

8 If the Tolerance value results in a curve which has more data than the original, a warning dialog is displayed. To reduce the amount of data in the new curve, increase the tolerance, but this is not essential if you want to use this tolerance value.

9 Select the Show preview surface then click Preview to display a preview of a surface extruded from the new curve. You can shade this surface to verify the quality of the curve.

10 Click OK (or Finish if you are using the wizard).

Reducing curve data

Curves that are created by approximations are often represented by a linear curve with hundreds or thousands of points. This data is accurate, but often very inefficient to work with. The Smooth/Reduce Curve command (available from the Curve wizard (see page 325) or the Construct menu) provides two methods for reducing these linear curves:

- **Smooth spline approximation** — This method approximates the curve with a smooth cubic spline curve. This method works best for three dimensional curves which are made up of many small linear segments.

- **Arc/line approximation** — This method approximates the curve with arcs and lines. It works best for planar curves that originally came from arcs and lines or piecewise linear curves from import, trim loop extraction or surface/surface intersection that are approximating arcs and lines. Arc/line works best when the arc/line tolerance is bigger than the original sampling tolerance. If you select Chain arcs/lines, the curve is approximated with lines and arcs and then chained into a curve.

See How to reduce curve data (see page 335) or How to approximate curves with lines and arcs (see page 337) for more information on uses of the Smooth/reduce curve dialog.
Unwrap Curve

If you are working with a curve that has been wrapped around an axis and you want to unwrap the curve into a planar curve, use Curve unwrap. Wrapped features in FeatureCAM require a planar curve, so this function is helpful if you want to generate toolpaths from data that is already wrapped (see page 340).

To construct a curve using Unwrap:

1. Use one of the following methods to display the Unwrap Curve dialog:
   - In the Curve Wizard (see page 325), select Curve from curve, then Unwrap Curve, and click Next.
   - On the Curves and Surfaces (see page 13) toolbar, click the Unwrap Curve button in the Curve from Curve menu.
   - From the menu, select Construct > Curve > From Curve > Unwrap Curve.

2. Optionally enter a curve name in the Name field, or leave the default name.

3. Select the curve you want to use from the Curve menu, or click the Pick Curve button and select it in the graphics window.

4. Select the Axis that the curve is wrapped around. This setting defaults to the wrapping axis specified in the Stock wizard (see page 205).

5. The Tolerance controls the accuracy of the unwrapped curve. All unwrapped curves are piece-wise linear, so the smaller the tolerance, the more points your curve has.
6 The Radial offset should normally be set to 0 because the curve is unwrapped in place. If you have extracted the curve at the bottom of the feature, then you need to set the Radial offset to the depth of the feature to offset the curve to the top.

7 Select Project to UCS plane if you are creating a 2D feature, or deselect it if you want a 3D curve.

8 Select Reduce/Smooth if you want to reduce the number of points in your curve.

9 Click OK (or Finish if you are using the wizard).

**Unwrap Curve example**

The following part is a solid model that has a pocket wrapped around the X axis.

The top curve is obtained by extracting the top trimming loop from the pocket.
This curve is then unwrapped into a flat curve that can be used to create a wrapped Pocket feature in FeatureCAM.

**Merge Curves**

You can use **Merge Curves** to chain large geometry datasets, without the need for lots of mouse clicks.

To create curves using **Merge Curves**:

1. Select the geometry and/or curves that you want to merge.
2. Use one of the following methods to display the **Merge Curve** dialog:
   - In the **Curve Wizard** (see page 325), select **Merge Curves**, then **Unwrap Curve**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Merge Curves** button in the **Curve from Curve** menu.
   - From the menu, select **Construct > Curve > From Curve > Merge**.
3. Optionally enter a curve name in the **Name** field, or leave the default name. This is the name of the first curve created. If more than one curve is created, the additional curves have a suffix of _1, _2, and so on.
4 Enter a **Tolerance** for the maximum variation of the new curve from the original curve.
5 Click the **Preview** button to display a preview of the new curves in the graphics window.
6 Click **OK** (or **Finish** if you are using the wizard).

**Merge Curves example**

This example part has geometry made up of many separate lines and circles:

With **Circle centers** enabled in the **Snap Modes** (see page 134) dialog, you can see that there are many circles in the design:

Creating the curves using normal curve chaining (see page 318) would be very difficult and time-consuming. By using **Curve Merge**, you can select all the geometry, then create all the curves at the same time in one step:
Curve from surface (3D)

You can use the Curve wizard (see page 325) to create curves from existing surfaces.

Surfaces are usually 3D objects in FeatureCAM 3D. There are several kinds of curves derived from surfaces. Curves from this set of categories are often used as building blocks for new surfaces or trimming surfaces.

You can create the following types of curves from surfaces:
- Surface Boundary (see page 343)
- Trimmed Edges (see page 344)
- Surface Intersection (see page 345)
- Surface Isoline (see page 347)
- Projected onto Surface (see page 349)
- Surface Edges (see page 350)
- Surface Projection (see page 350)
- Revolved Boundary (see page 353)

Surface boundary

Surfaces are defined in a rectangular array of rows and columns, even though the surface itself may not look like that. Because of this definition, you can extract individual curves in the surface, especially those on the boundaries.

Boundary curves are particularly useful as a step in building and modifying surfaces. For example, you probably want to extract boundary curves to build a cap surface.

Surface boundary extracts the curve from a surface's boundary:
1. Open the **Surface Boundary** dialog in one of these ways:

   - In the **Curve Wizard** (see page 325), select **Curve from surface**, then **Surface Boundary**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Boundary** button in the **Curve from surface** menu.
   - From the menu, select **Construct > Curve > From Surface > Boundary**.

1. Optionally enter a curve name in the **Name** field, or leave the default name.

2. Select the surface you want to use from the **Surface** menu, or use the **Pick Surface** button to select it in the Graphics window.

3. Use the **Pick Curve** button to pick a boundary in the graphics window, or select from:
   - **First Row**
   - **Last Row**
   - **First Column**
   - **Last Column**

   The selected boundary is highlighted in red in the graphics window.

4. Click **OK** (or **Finish** if you are using the wizard).

**Trimmed edge**

Surfaces are defined in a rectangular array of rows and columns, even though the surface itself may not look like that. Because of this definition, you can extract individual curves in the surface, in this case those on the first or last column or row.
Edge curves are particularly useful as a step in building and modifying surfaces. For example, you probably want to extract edge curves to build a cap surface.

1 Open the **Trimmed Edge** dialog in one of these ways:

- In the **Curve Wizard** (see page 325), select **Curve from surface**, then **Trimmed Edges**, and click **Next**.
- On the **Curves and Surfaces** (see page 13) toolbar, click the **Trimmed Edge** button in the **Curve from surface** menu.
- From the menu, select **Construct > Curve > From Surface > Trimmed Edge**.

1 Optionally enter a curve name in the **Name** field, or leave the default name.

2 Select the surface you want to use from the **Surface** menu, or use the **Pick Surface** button to select it in the Graphics window.

3 Click the **Pick Curve** button and pick an edge in the graphics window.

4 Optionally select **Join adjacent loops** to connect the curve to other trim loops that are present in the source surface. You may need to use **Undo** so you can select/deselect this option to get the required curve.

5 Click **OK** (or **Finish** if you are using the wizard).

### Intersection

Calculating the curve of intersection between two surfaces is useful for surface trimming (see page 418) or to use as a curve for a 3D groove feature (see page 689).
The intersection of two surfaces that meet is generally a 3D curve. As long as the surfaces are not tangent (like a surface and its fillet) or do not have a complete region of overlap you should be able to calculate their intersection curve using FeatureCAM. Intersection curves are often used for surface trimming (see page 418).

1. Open the **Surface Intersection** dialog in one of these ways:

   - In the **Curve Wizard** (see page 325), select **Curve from surface**, then **Surface Intersection**, and click **Next**.
On the **Curves and Surfaces** (see page 13) toolbar, click the **Intersection** button in the **Curve from surface** menu.

From the menu, select **Construct > Curve > From Surface > Intersection**.

1. Optionally enter a curve name in the **Name** field, or leave the default name.
2. Select the first surface in the **Surface 1** menu or use the **Pick Surface** button to select it in the graphics window.
3. Add each intersecting surface in one of these ways:
   - Select the intersecting surface in the **Intersecting Surfaces** menu and click the **Add** button to add it to the **Surface** list.
   - Click the **Pick Surface** button and select each surface in the graphics window.

To remove a surface from the **Surface** list, select it and click the **Delete item** button.

4. Click the **Preview** button to see the intersection curve highlighted in the graphics window.
5. Click **OK** (or **Finish** if you are using the wizard).

See also **Surface-surface trimming** (see page 432).

**Isoline**

Surfaces are defined using a rectangular array of points arranged in rows and columns; these points are not displayed. For any location on the surface, curves exist that travel from one surface boundary to another. These curves are called isolines. In this image, the 3 blue curves are row isolines and the 5 orange curves are column isolines.
To create an isoline curve:

1. Open the **Surface Isoline** dialog in one of these ways:
   - In the Curve Wizard (see page 325), select Curve from surface, then Surface Isoline, and click Next.
   - On the Curves and Surfaces (see page 13) toolbar, click the Isoline button in the Curve from surface menu.
   - From the menu, select Construct > Curve > From Surface > Isoline.

2. Optionally enter a curve name in the Name field, or leave the default name.

3. Select the surface you want to use from the Surface menu, or use the Pick Surface button to select it in the Graphics window.

4. Select Row or Column. The selected part of the surface is highlighted in the graphics window.

5. Select Multiple to create more than one isoline curve or Pt. to create one isoline curve that passes through a specific point.

6. If you selected Multiple, enter the Count number of isolines you want. Optionally select Include boundary to additionally create curves from the boundary isolines.

7. If you selected Pt, enter the coordinates of the point that you want the isoline to pass through, or use the Pick point button to select the point in the graphics window.

8. Click OK (or Finish if you are using the wizard).
Project onto surface

Often, you want the outline of one surface as traced against another surface. This function generates that curve for you. This function is often used as an intermediate step in constructing or modifying yet another surface.

1 Open the Project Onto Surface dialog in one of these ways:

- In the Curve Wizard (see page 325), select Curve from surface, then Project onto Surface, and click Next.
- On the Curves and Surfaces (see page 13) toolbar, click the Project onto Surface button in the Curve from surface menu.
- From the menu, select Construct > Curve > From Surface > Project onto Surface.

1 Optionally enter a curve name in the Name field, or leave the default name.
2 Select the surface you want to use from the Surface menu, or use the Pick Surface button to select it in the Graphics window.
3 Select the curve you want to use from the Curve menu, or click the Pick Curve button and select it in the graphics window.
4 Select the correct direction relative to the current UCS.
5 Click OK (or Finish if you are using the wizard).
Surface edges

Surface edges is useful for extracting trimming loops from 3D surface data, and projecting that curve onto the XY plane of the current UCS. You can use these curves to create 2.5D features.

IGES files often contain complete solid models of a part. Features such as pockets and holes are subtracted from part surfaces resulting in a collection of trimmed surfaces. In this model, the seven pockets have been subtracted from the surrounding surfaces.

Rather than manufacturing all of these surfaces using 3D surface manufacturing techniques, you should use 2.5D Pocket features for each pocket.

Surface edges enables you to extract trimming curves from a collection of surfaces, join them into a curve and then project the curve onto the XY plane of your current UCS. You can then use this curve to create features.

To extract curves from 3D data:

1. Open the Surface Edges dialog in one of these ways:

   - In the Curve Wizard (see page 325), select Curve from surface, then Surface Edges, and click Next.
On the **Curves and Surfaces** (see page 13) toolbar, click the **Surface Edges** button in the **Curve from surface** menu.

From the menu, select **Construct > Curve > From Surface > Surface Edges**.

1. Optionally enter a curve name in the **Name** field, or leave the default name.

2. Select the edge you want to use from the **Edges** menu, or use the **Pick curve on surface** button to select it in the graphics window. The edge is added to the table.

   - Applies to solids only (not a random collection of surfaces).
   - Ctrl+click two edges to select all edges that make up the shortest path between them.
   - Double-click an edge to select all tangential edges.

3. The location of the pick is used to select a surface and extract a trimming edge. Click the **Use next edge of surface** button if you picked the correct surface, but the wrong edge.

4. Continue selecting edges in order until you have selected all edges.

   Use the **Move item up** and **Move item down** buttons to reorder the edges if necessary.

5. If the edges are in the correct order, but the endpoints are matched up incorrectly, select the surface name in the table and click the **Reverse** button.

6. Select **Connect start and end** if you want the curve to be closed automatically.

7. Select from the **Project to UCS** menu to have the curve automatically projected to the 2D XY plane of the UCS.

8. If a hollow blue square is displayed at the intersection of two edges, then the edges have not quite matched up. You can correct this by either selecting the missing edge that will connect the endpoints, or if it is just an issue of floating point error, increase the **Tolerance** parameter.

9. Click **OK** (or **Finish** if you are using the wizard).

**Surface Projection**

Surface projection enables you to extract curves from vertical surfaces. You can use these curves to create 2.5D features from surface or solid models.
This method is a wizard that creates geometry by projecting straight-walled surfaces, for example:

The method performs these steps:
1. Identify straight vertical surfaces from the selected set or from all surfaces (depending on the option selected).
2. Project these surfaces on to the current UCS.
3. Convert the curves into lines and arcs.

To create a curve using surface projection:
1. Open the Surface Projection wizard in one of these ways:
   - In the Curve Wizard (see page 325), select Curve from surface, then Surface Projection, and click Next.
   - On the Curves and Surfaces (see page 13) toolbar, click the Surface Projection button in the Curve from surface menu.
   - From the menu, select Construct > Curve > From Surface > Surface Projection.
   The Surface Projection wizard opens on the first page.
2. If you are not extracting curves from drafted features, set both the Wall angle and Elevation to 0 and click Next.
3. If you want to extract curves from drafted surfaces, enter a Wall angle, or click the blue Wall angle label and click two points on the same vertical isoline in the graphics window.
4. For the Elevation enter the Z coordinate of the top of the feature or click the Elevation label and click the top of a wall of the drafted surface in the graphics window.
5. Click Next.
6. Select from:
   - All surfaces — to extract curves from all surfaces.
- **Only selected** — to extract curves from only the surfaces you have selected.

7. If you are working with a solid model, you have the option to **Remove hidden lines on solids**. It is generally a good idea to select this option. It prevents the creation of curves from blind features that are on the bottom of the part.

8. Click Next.

9. After you click the Finish button in this dialog, you must chain (see page 319) the geometry into curves. Select what to do with the geometry after chaining:
   - **Remove after chaining** — if you want the geometry you created to be removed when you have finished chaining.
   - **Keep all geometry** — if you want to permanently keep the geometry after chaining.

10. Click the Finish button.

### Revolved Boundary

Revolved surface boundary is used to create curves from revolved surfaces.

To create curves from revolved surfaces:

1. Open the **Revolved Surface Boundary** dialog in one of these ways:
   - In the Curve Wizard (see page 325), select Curve from surface, then Revolved Boundary, and click Next.
   - On the Curves and Surfaces (see page 13) toolbar, click the Revolved Boundary button in the Curve from surface menu.
   - From the menu, select Construct > Curve > From Surface > Revolved Surface Boundary.
2 Select a method from:
   - **Polygonal method.** This method uses the simulation engine to triangulate the file and create a profile curve. It is the recommended method for solid and STL models.
     
     *This method is available only for solid and STL models*

   - **Surface method**

   - **Solid method**
     
     *This method is available only for solid models.*

3 If you selected **Surface method**, select:
   - **All surfaces** — if you want to generate geometry from all of the surfaces and faces of your part.
   - **Only selected** — if you want to restrict the geometry creation to surfaces/faces that are currently selected.

4 If you selected **Polygonal method**, click the **Tolerances** button to enter tolerances.

5 Optionally select **Convert to geometry** to convert the curve into its geometry components.

6 Click the **Preview** button to see a preview of the curve in the graphics window.

7 Click **OK** (or **Finish** if you are using the wizard).

**Revolved surface boundary examples**

**Polygonal method**

This is the recommended method for solid and STL models; it uses the simulation engine to triangulate the file and create a profile curve. This example part is an imported .stl file.

With surface shading turned off, you can see the triangles that make up the .stl file:

To create the turned profile, select **Construct > Curve > From Surface > Revolved Surface Boundary** from the menu.

1 In the **Revolved Surface Boundary** dialog, select **Polygonal method**.

2 Optionally click the **Tolerances** button to change the default **Triangle tolerance** and **Arcline approx. tolerance** values.
3 Click the **Preview** button to see the boundary highlighted in dark blue in the graphics window:

FeatureCAM finds the correct profile height of the revolved square ends of the balustrade.

4 Click **OK** to create the curve.

You can use this curve to create a Turn feature.

**Solid method**

Turned parts that are imported as solids are typically modeled using a series of surfaces of revolution. In order to accelerate the creation of turned features from these solid models, FeatureCAM provides a method of intelligently extracting geometry from these revolved solids. This functionality can be invoked from the process of importing a solid model into a turn or turn/mill document or by using the **Revolved surface boundary** curve creation tool. The images below, from left to right, show the initial solid model, the geometry created using the **Surface method**, and the geometry created using the **Solid method**. The solid method can only be used for solid models. You can see from the images below that the solid method provides better trimming of the geometry versus the surface method.
Curves from other methods

You can use the Curve wizard (see page 325) to create curves from other methods.

These are the other methods of creating curves:

- **Function** (see page 356)
- **Cams** (see page 364)
- **Splines** (see page 367)
- **Text** (see page 368)
- **Ellipse** (see page 374)
- **Rectangle** (see page 375)
- **Polygon** (see page 376)
- **Gears** (see page 378)

**Function**

You can use functions to create curves from mathematical relationships that you define.

To create a curve using a function:

1. Open the Functions dialog in one of these ways:
   - In the Curve Wizard (see page 325), select Other methods, then Functions, and click Next.
   - On the Curve (see page 13) toolbar, click the Functions button in the Curve Menu.
   - From the menu, select Construct > Curve > Other methods > Functions.
2. Select the type of **Function** you want from the menu, from:

- \( y = F(x) \) (see page 357)
- \( x = F(y) \) (see page 357)
- \( r = F(a) \) (see page 358)
- \( x = F(t), y = G(t) \) (see page 360)
- \( r = F(a), Z = G(a) \) (see page 361)
- \( x = F(t), y = G(t), z = H(t) \) (see page 362)

The variables \( a, r, t, x, \) and \( y \) are local to the **Functions** dialog. Any previous values that you have set for these variables are ignored. However, you can use any other previously defined variables. As well as variables, you can use any predefined functions or constants discussed under **Equations** (see page 304).

Trigonometric functions are often used in constructing these functions. Be careful to use \( \text{sind}() \), \( \text{cosd}() \), and so on when using degrees and \( \text{sin}() \), \( \text{cos}() \), and so on when using radians.

**y = F(x) and x = F(y)**

In the **Function** list, select the kind of function you want to build. Use \( y = F(x) \) to specify \( y \) as a function of \( x \), and \( x = F(y) \) to specify \( x \) as a function of \( Y \).

![Functions dialog](image)

**F** — This is the field where you build your function. You can use the operations described in the **Equations** (see page 304) section.

**Start** — This sets the starting point for the range over which your function is evaluated.

**End** — This sets the ending point for the range over which your function is evaluated.

**Increment** — This sets the value added to or subtracted from the previous point evaluated for the function to determine the next value to be run through the function.
**Preview** — This generates the curve and displays it for your review but does not apply the generated function to the drawing as geometry. Depending on your start and end points and the increment, it may take a while to evaluate and build the preview image.

**Y=F(x) example:**

![Y=F(x) example](image)

\[ r = F(a) \]

The function \( r = F(a) \) is useful for describing polar functions where the radius is calculated as a function of the end angle or argument variable.

In the **Function** list, select \( r = F(a) \).

![Function list](image)

**F, G, and H** — These are the fields where you build your function. You use the operations described in the Equations (see page 304) section.

- **Degree** — Select this option to evaluate the function in degrees.
- **Radian** — Select this option to evaluate the function in radians.
- **Start** — This sets the starting point for the range over which your function is evaluated.
End — This sets the ending point for the range over which your function is evaluated.

Increment — This sets the value added to or subtracted from the previous point evaluated for the function to determine the next value to be run through the function.

Preview — This generates the curve and displays it for your review but does not apply the generated function to the drawing as geometry. Depending on your start and end points and the increment, it may take a while to evaluate and build the preview image.

\( r = f(a) \) example
\[ x = F(t), \; y = G(t) \]

In the **Function** list, select \( x=F(t), \; y=G(t) \) which models parametric functions.

\[ F, \; G, \; \text{and} \; H \] — These are the fields where you build your function. You use the operations described in the Equations (see page 304) section.

**Start** — This sets the starting point for the range over which your function is evaluated.

**End** — This sets the ending point for the range over which your function is evaluated.

**Increment** — This sets the value added to or subtracted from the previous point evaluated for the function to determine the next value to be run through the function.

**Preview** — This generates the curve and displays it for your review but does not apply the generated function to the drawing as geometry. Depending on your start and end points and the increment, it may take a while to evaluate and build the preview image.

**\( x = F(t), \; y = G(t) \) example**

For an example, consider an ellipse. You can use either radian- or degree-based math, but be sure you use the correct range for the system you selected. Using a radian system, but specifying the range from 0-360 (degrees) does not work.

A simple description of an ellipse in degrees is:
\[
x = \text{<width>} \ast \sin(t) + \text{<offset>}; \; y = \text{<height>} \ast \cos(t) + \text{<offset>}
\]
If you do not specify an offset, the ellipse is centred on the current UCS. The diagram below shows an ellipse defined and previewed in FeatureCAM.

You can also create an ellipse directly using the Ellipse curve (see page 374) tool.

\[ r = F(a), z = G(a) \]

Use the function \( r = F(a), z = G(a) \) for polar functions with a \( Z \) coordinate that is specified as a function of the angle.

In the Function list, select \( r = F(a), Z = G(a) \).

\( F, G, \) and \( H \) — These are the fields where you build your function. You use the operations described in the Equations (see page 304) section.

**Degree** — Select this option to evaluate the function in degrees.

**Radian** — Select this option to evaluate the function in radians.
Start — This sets the starting point for the range over which your function is evaluated.

End — This sets the ending point for the range over which your function is evaluated.

Increment — This sets the value added to or subtracted from the previous point evaluated for the function to determine the next value to be run through the function.

Preview — This generates the curve and displays it for your review but does not apply the generated function to the drawing as geometry. Depending on your start and end points and the increment, it may take a while to evaluate and build the preview image.

\[ r = F(a), \ Z = G(a) \] example

You can use the \( r = F(a), \ Z = G(a) \) function to model a helix, for example:

\[ x = F(t), \ y = G(t), \ z = H(t) \]

Use this function when \( x, y, \) and \( z \) are parametric functions.
In the **Function** list, select \(x = F(t), y = G(t), z = H(t)\).

\(F, G, \text{ and } H\) — These are the fields where you build your function. You use the operations described in the Equations (see page 304) section.

**Start** — This sets the starting point for the range over which your function is evaluated.

**End** — This sets the ending point for the range over which your function is evaluated.

**Increment** — This sets the value added to or subtracted from the previous point evaluated for the function to determine the next value to be run through the function.

**Preview** — This generates the curve and displays it for your review but does not apply the generated function to the drawing as geometry. Depending on your start and end points and the increment, it may take a while to evaluate and build the preview image.

**Example**

\(x = F(t), y = G(t), z = H(t)\) example
Cams

Use cams to create the geometric profile of various reciprocating cams. The shape of the cam is the actual profile of the cam, not the pitch curve (center line of the follower).

If you have 4th axis support (see page 243) you can also create Cylindrical or Barrel cams (see page 249).

Open the Cam Properties dialog in one of these ways:

- In the Curve Wizard (see page 325), select Other methods, then Cams, and click Next.
- On the Curves and Surfaces (see page 13) toolbar, click the Cams button in the Curve Menu.
- From the menu, select Construct > Curve > Other methods > Cams.

The Cam Properties dialog has three tabs: General (see page 364), Roller (see page 365), and Segment (see page 366).

General tab

The General tab contains options that define the basic dimensions on which the specific cam attributes are based.

1. Enter the Center coordinates for the cam. Center sets the X and Y coordinates for the center of the cam body.

2. Enter the Base Radius, the radius of the circle that defines the body of the cam. This dimension is the minimum distance between the cam's center and the follower.
3 Enter the **Start Angle**. Start angle defaults to **parallel to the X axis**. Enter an angle in degrees to move the start angle. The direction of rotation for the start angle is controlled by the **Clockwise Construction** option.

4 Cams have a counter-clockwise construction by default. Select **Clockwise Construction** to construct the cam from sequential segments arranged in a clockwise rotation. Note that the **Start Angle** is also affected by this setting.

5 If you have 4th-axis support, you can also create cylindrical cams (see page 249) or barrel cams. Design your cam as usual, and select **Cylindrical Cam**.

**Roller tab**

![Roller tab](image)

The **Roller** tab has options that describe how the cam is followed (by a roller).

1 Select the **Type** (see page 366) of follower motion and its associated acceleration diagram, commonly described as:

   - **Harmonic** (SH) (also known as **Simple Harmonic**)
   - **Parabolic** (PB)
   - **Cycloidal** (CY)
   - **Modified Sine** (MS)
   - **Modified Trapezoid** (MT)
   - **Polynomial 3-4** (4P) (also known as **4th Power Polynomial**)
   - **Polynomial 3-4-5** (5P) (also known as **5th Power Polynomial**)
   - **Polynomial 4-5-6-7** (7P) (also known as **7th Power Polynomial**)

2 Select the **Follower Type** for the kind of follower the cam is used with. It can be either **Flat** or **Roller**.

3 If you selected **Roller**, enter:
- **Offset** — This sets the distance between the center line of translation for the follower and the cam's center which controls the pressure angle on the follower. This is not the cutter offset.

- **Radius** — This sets the radius of the roller that follows the cam's shape. If you select a roller-type follower, then you must enter a radius. A zero roller radius simulates a knife-edge follower, or constructs the pitch curve of the cam.

See also Cam performance at high speeds (see page 366).

### Cam performance at high speeds

<table>
<thead>
<tr>
<th>Cam type</th>
<th>Performance at high speeds</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-4 Polynomial, 3-4-5 Polynomial, 4-5-6-7 Polynomial, Modified Trapezoid, Cycloidal</td>
<td>Excellent</td>
</tr>
<tr>
<td>Modified Sine</td>
<td>Good to excellent</td>
</tr>
<tr>
<td>Harmonic, Parabolic</td>
<td>Good</td>
</tr>
</tbody>
</table>

### Segments tab

The **Settings** tab defines the cam segments and their specific parameters. The segment arcs are listed in counter-clockwise sequence.

- Create new entries by clicking **New** button. The **Edit Cam Segment** (see page 367) dialog is displayed.

- To edit an entry, double-click the entry or select the entry and click the **Edit** button. The **Edit Cam Segment** (see page 367) dialog is displayed.

- To delete a segment, select it in the table and click the **Delete** button.
• To change the segment order, select a segment and click the Move Item Up or Move Item Down button.

**Edit cam segment**

Select the segment **Type**:

- **Dwell** indicates an arc of rotation that neither rises nor falls but whose diameter from the center is determined from the ending displacement of the directly preceding segment. **Duration** sets how many degrees of rotation the dwell lasts.

- **Rise** indicates that this segment rises to a greater diameter than the preceding segment. If this segment is the first segment, rise is calculated from the base circle defined in the **General** (see page 364) tab. **Duration** sets how many degrees across which the rise occurs. **Displacement** sets how far the rise deviates from the previous segment or the base circle if the segment is the first segment defined for the cam.

- **Fall** indicates that this segment decreases from some displacement to a lower displacement, but never less than the base circle defined in the **General** (see page 364) tab. So a fall should not be the first segment defined. Use **Cams** to create the geometric profile of various reciprocating cams. It is the actual profile of the cam, not the pitch curve (center line of the follower).

**Splines**

**Splines** automatically draws a curve, similar to a Bezier curve, through a series of points.

To use **Splines**:

1. Enter **Splines** mode in one of these ways:
   - In the **Curve Wizard** (see page 325), select **Other methods**, then **Splines**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the Spline/Interpolation button in the Curve Menu.
   - From the menu, select **Construct > Curve > Other methods > Spline/Interpolation**.
2 Click the **Options** button in the dialog bar to switch between the four spline modes which determine whether the curve is an open or a closed interpolation and an open or closed spline. The active spline mode is displayed next to the **Options** button.

3 Pick or enter (see page 275) the location of a series of points. A preview of the curve is displayed in the graphics window.

4 Click the **Create** button to create the curve.

The table below shows the effect of the different spline modes:

<table>
<thead>
<tr>
<th>Open interpolation:</th>
<th>Open approximation:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Open interpolation" /></td>
<td><img src="image2" alt="Open approximation" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Closed interpolation:</th>
<th>Closed approximation:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Closed interpolation" /></td>
<td><img src="image4" alt="Closed approximation" /></td>
</tr>
</tbody>
</table>

### Text

You can type in text in any TrueType font you have installed for Windows, and use the text as curves to engrave your part with customized text.

Engraving in FeatureCAM has two steps:

1. Create the text as a curve.
2. Use the curve to create a Groove (see page 689) feature.

Text can be created as:

- **Linear** (see page 369)
  
  Linear text can be horizontal:

  ![FeatureCAM](image5)

  at an angle:
or vertical:

- **Circular** (see page 371)

- **Curve** (see page 372)

  text is along a curve:

The fonts used are standard Windows outline fonts and a custom single line font included with FeatureCAM called Machine Tool Sans Serif. Single line fonts use single strokes for the letters. Outline fonts represent the boundaries of the letters. This image shows the difference between the two types of font.

Regardless of the font used, a Groove feature traces each line of the font, not the region between the outlines. If you are looking for simple engraving, we recommend the single line font.

After you create the text, use the resulting curve to create a simple groove to engrave the text into your part. Bosses and pockets are possibilities too, but any feature based on text may require specialized small tools for their manufacturing processes unless you use the Machine Tool Sans Serif font.

The settings for scaling, spacing and fonts are saved for the next time you create a text string.

OLF engraving fonts from our partner oneline.com are supported.

*Linear*

To create text along a line:
Open the **Engraving Text** dialog in one of these ways:

- In the **Curve Wizard** (see page 325), select **Other methods**, then **Text**, and click **Next**.
- On the **Curves and Surfaces** (see page 13) toolbar, click the **Text** button in the **Curve menu**.
- From the menu, select **Construct > Curve > Other Methods > Text**.

1. Enter the text you want to create in the **Text** field.
2. Optionally enter a curve name in the **Name** field, or leave the default name.
3. For the **Path type**, select **Linear**.
4. Enter the **Location** as X, Y, and Z coordinates or click the **Pick point** button to pick it in the graphics window. This point is used with the **Justification** setting to position the text.
5. To invert the text, select **Reverse**.
6. To rotate the text counter-clockwise around the **Location** point, enter an **Angle** between 0 and 360 degrees.
7. To create the text vertically, select **Vertical text**.
8. Select the **Justification** as **Left**, **Center**, or **Right**. These positions use the point you enter as the left end, center, or right end of the text.
9. Enter the **Alignment**. The alignment is a translation factor for X and Y for the entire text string. Use these fields to tweak the location of the string.
10 Enter the **Scaling** amount to control scaling of the text. A value of between 0 and 1 shrinks the text. Values greater than 1 expand the text. You can have different values in the fields to stretch text for special effects. A negative value reflects the text, useful for making molds. If you set the font to be 72 points, this number reflects the size in inches of the font in the given direction.

11 Enter the **Spacing**. The spacing is the size of the gap between the letters. It is uniform across the entire text string.

12 Click **Font** to change the font settings. The **Font** dialog is displayed, which you can use to change the text font to a Windows font on your system.

*For simple engraving, you can use the **Machine Tool Sans Serif** with a **Size** of 72 points, and control the size of the text with the **Scaling** options in the **Engraving Text** dialog.*

13 Click **OK** (or **Finish** if you are using the wizard).

**Circular**

To create text along a circle:

1. Open the **Engraving Text** dialog in one of these ways:
   - In the **Curve Wizard** (see page 325), select **Other methods**, then **Text**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Text** button in the **Curve menu**.
   - From the menu, select **Construct > Curve > Other Methods > Text**.

1 Enter the text you want to create in the **Text** field.
2 Optionally enter a curve name in the Name field, or leave the default name.

3 For the Path type, select Circular.

4 Enter the location of the Center of the circle as X, Y, and Z coordinates or click the Pick point button and pick it with the mouse. This point is used along with the Justification setting to position the text.

5 Enter the Radius of the circle.

6 To rotate the text counter-clockwise around the Center point, enter an Angle between 0 and 360.

7 To create text on the bottom quadrants of the circle, enter the appropriate angle and click Reverse.

8 Select the Justification as Left, Center, or Right. These positions use the point you enter as the left end, center, or right end of the text.

9 Enter the Alignment. The alignment is a translation factor for X and Y for the entire text string. Use these fields to tweak the location of the string.

10 Enter the Scaling amount to control scaling of the text. A value of between 0 and 1 shrinks the text. Values greater than 1 expand the text. You can have different values in the fields to stretch text for special effects. A negative value reflects the text, useful for making molds. If you set the font to be 72 points, this number reflects the size in inches of the font in the given direction.

11 Enter the Spacing. The spacing is the size of the gap between the letters. It is uniform across the entire text string.

12 Click Font to change the font settings. The Font dialog is displayed, which you can use to change the text font to a Windows font on your system.

   For simple engraving, you can use the Machine Tool Sans Serif with a Size of 72 points, and control the size of the text with the Scaling options in the Engraving Text dialog.

13 Click OK (or Finish if you are using the wizard).

 Curve

To create text along a curve:
1 Open the **Engraving Text** dialog in one of these ways:

- In the **Curve Wizard** (see page 325), select **Other methods**, then **Text**, and click **Next**.
- On the **Curves and Surfaces** (see page 13) toolbar, click the **Text** button in the **Curve menu**.
- From the menu, select **Construct > Curve > Other Methods > Text**.

1 Enter the text you want to create in the **Text** field.

2 Optionally enter a curve name in the **Name** field, or leave the default name.

3 For the **Path type**, select **Curve**.

4 Select the curve from the **Curve** menu or use the **Pick curve** button to select the curve graphically.

5 If you want to reflect the text to the other end of the curve, click **Reverse**.

   *Changing the justification moves the text to the other end of the curve without flipping the text.*

6 Select the **Justification** as **Left**, **Center**, or **Right**. These positions use the point you enter as the left end, center, or right end of the text.

7 Enter the **Alignment**. The alignment is a translation factor for **X** and **Y** for the entire text string. Use these fields to tweak the location of the string.
8 Enter the **Scaling** amount to control scaling of the text. A value of between 0 and 1 shrinks the text. Values greater than 1 expand the text. You can have different values in the fields to stretch text for special effects. A negative value reflects the text, useful for making molds. If you set the font to be 72 points, this number reflects the size in inches of the font in the given direction.

9 Enter the **Spacing**. The spacing is the size of the gap between the letters. It is uniform across the entire text string.

10 Click **Font** to change the font settings. The **Font** dialog is displayed, which you can use to change the text font to a Windows font on your system.

   For simple engraving, you can use the **Machine Tool Sans Serif** with a **Size** of 72 points, and control the size of the text with the **Scaling** options in the **Engraving Text** dialog.

11 Click **OK** (or **Finish** if you are using the wizard).

**Ellipse**

The **Ellipse** curve tool creates an elliptically-shaped curve in the plane of the current UCS or a plane parallel to the UCS plane.

1 Open the **Ellipse** dialog in one of these ways:

   - In the **Curve Wizard** (see page 325), select **Other methods**, then **Ellipse**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Ellipse** button in the **Curve menu**.
• From the menu, select Construct > Curve > Other Methods > Ellipse.

1 Optionally enter a curve name in the Name field, or leave the default name.
2 Enter the coordinates of the Axis endpoint 1, or click the Pick point button to pick it in the graphics window.
3 Enter the coordinates of the Axis endpoint 2, or click the Pick point button to pick it in the graphics window.
4 Enter the Height of the ellipse above the axis. The total height of the ellipse is 2*Height.
5 Optionally enter an Elevation amount, if you want the curve to be on a plane parallel to the current UCS plane.
6 Optionally select Create as arcs and lines, to convert the curve into arcs and lines.
7 Optionally click the Preview button to see the results of the current settings in the Graphics window.
8 Click OK (or Finish if you are using the wizard).

Rectangle

The Rectangle tool creates a rectangular shaped curve in the plane or parallel to the plane of the current UCS.

1 Open the Rectangle dialog in one of these ways:

   In the Curve Wizard (see page 325), select Other methods, then Rectangle, and click Next.
On the **Curves and Surfaces** (see page 13) toolbar, click the **Rectangle** button in the **Curve menu**.

From the menu, select **Construct > Curve > Other Methods > Rectangle**.

1. Optionally enter a curve name in the **Name** field, or leave the default name.

2. Select from:
   - **Use corner, width, and height** — Select this option to create the rectangle based on a corner point.
   - **Use center, width, and height** — Select this option to create the rectangle based on a center point.

3. Depending on the method option selected, enter the coordinates or click the **Pick Point** button and select a point in the graphics window to set the location of the **Corner point** or **Center point**.

4. Optionally enter a **Corner Radius** to give the rectangle round corners.

5. Optionally enter an **Angle** in degrees to rotate the rectangle counter-clockwise from the X axis.

6. Optionally enter an **Elevation** amount, if you want the curve to be on a plane parallel to the current UCS plane.

7. Optionally select **Create as arcs and lines**, to convert the curve into arcs and lines.

8. Optionally click the **Preview** button to see the results of the current settings in the Graphics window.

9. Click **OK** (or **Finish** if you are using the wizard).

### Polygon

The **Polygon** tool creates a curve in the shape of a regular polygon in the plane or parallel to the plane of the current UCS.

To create a polygonal curve:

1. Open the **Polygon** dialog in one of these ways:
   - In the **Curve Wizard** (see page 325), select **Other methods**, select **Polygon**, and click **Next**.
   - On the **Curves and Surfaces** (see page 13) toolbar, click the **Polygon** button in the **Curve menu**.
   - Select **Construct > Curve > Other Methods > Polygon**.
The **Polygon** dialog is displayed.

2 Enter a **Curve name**.

3 Enter the **Number of sides** in the polygon. For example, to create a regular hexagon, type **6**.

4 Enter the x and y coordinates of the **Center point**, or click ![Select Location](image) and select the location in the graphics window.

5 To fillet the corners, enter a **Corner Radius**.

6 To rotate the rectangle counter-clockwise from the X axis, enter an **Angle** in degrees.

7 By default the curve is created on the UCS plane. If you want to position the curve on a plane parallel to the UCS plane, enter an **Elevation**.

8 Size the polygon using one of these methods:
   - In the **Side length** box, enter the length of the sides.
   - In the **Center to side** box, enter the perpendicular distance between the curve center and the sides.
   - In the **Center to corner** box, enter the distance between the curve center and the corners.

9 To convert the curve into arcs and lines, select the **Create as curves and lines** check box.

10 Click **Preview** to display the polygon in the graphics window.

11 Click **OK** or **Finish** to close the dialog.
Gears

Use the Gears dialog to create AGMA involute spur gears, one of the most common types of gear designs.

To create a gear curve:

1. Open the Gears dialog in one of these ways:
   - In the Curve Wizard (see page 325), select Other methods, then Gears, and click Next.
   - On the Curves and Surfaces (see page 13) toolbar, click the Gears button in the Curve menu.
   - Select the Construct > Curve > Other Methods > Gears menu option.

   The Gears dialog displays the Curve tab.

2. Enter a Name for the curve.

3. Enter a Fineness value to determine the number of control points in the tooth profile. The smaller the value; the greater the number of control points used to sample the curve.

4. Enter the gear specification:
   - Number of teeth — Enter the number of teeth on the gear.
   - Pressure angle — Enter the acute angle, in degrees, between the tangent to the two base circles and a normal to the line connecting the gear centers.
   - Tip radius — Enter the radius of the tooth corner (see Diagram 2).
- **Addendum** — Enter the radial distance from the pitch circle to the outermost point of the tooth (see Diagram 2). Alternatively, select **Outer diameter** and enter the outside diameter of the gear.

- **Dedendum** — Enter the radial distance from the depth of the tooth trough to the pitch circle (see Diagram 2). Alternatively, select **Root diameter** and enter the root diameter of the gear.

- **Pitch diameter** — Enter the diameter of the pitch circle (see Diagrams 1 and 2). Alternatively, select **Module** and enter the pitch diameter divided by the number of teeth, or select **Diametric pitch** and enter the number of teeth divided by the pitch diameter.

- **Root fillet radius** — Enter the radius of the fillet at the bottom of each tooth (see Diagram 2).

- **Center point** — Enter the coordinates for the centre of the gear curve, or click and pick the curve in the Graphics window.

5 Optionally click the **Preview** button to see the results of the current settings in the Graphics window.

6 Select the **Analysis** tab to view the calculated dimensions of the gear, the calculated pin gauge diameter and the outside measurement over pins diameter.

![Image of the Analysis tab]

*The Analysis tab is not displayed when you create a gear using the Curve Wizard.*

7 Select whether you want to create an **External Gear** or an **Internal Gear**.

8 If you want to change the calculated diameter of the pin gauge, enter a new value in the **Actual pin diameter** box, and click **Recompute**.
9  Click **OK** (or **Finish** if you are using the wizard).

Diagram 1:

![Diagram 1 showing pressure angle, base diameter, and pitch diameter]

Diagram 2:

![Diagram 2 showing addendum, dedendum, tip radius, outside circle, pitch circle, root fillet radius, root circle, and base circle]

**Curve to geometry**

You can create geometry from curves. You can use geometry in ways you cannot use curves, such as for Chaining (see page 319).

To create geometry from a curve:

1  Select a curve in the graphics window.

2  Select **Construct > Curve > To Geometry** from the menu.

   The geometry is created in the graphics window behind the selected curve.
Surfaces

Surfaces are continuous sets of points in 2D or 3D space which have no thickness, which you can use to create surface milling features.

Use these methods to create surfaces:

- Click the Surfaces step in the Steps panel to display the Surface wizard (see page 381).
- Use the Curves and Surfaces toolbar (see page 13).
- Select the Construct > Surface menu option to display the list of surface creation tools.

Surfaces are defined by a rectangular mesh of control points, which determines the shape and smoothness of the surface.

The rectangular nature of the control point mesh means that a surface has four boundary curves. In some cases, surfaces are constructed where one or two (opposite) boundary curves are degenerate or form a single point such as the poles of a sphere. In other cases where surfaces wrap around, such as a cylinder, two opposite boundaries can be the same curve and are called seams. With seams and degeneracies, a surface may appear to have only three, or two, or even no boundaries (a sphere), but the four boundaries are always defined. With these four boundaries, you can break a surface into rows and columns so surfaces have a table-like structure.

Surface wizard

You can use the Surface wizard to create surfaces.

Use one of the following methods to display the Surface Wizard:

- Click Surfaces in the Steps panel.
- Click Surface Wizard in the Advanced toolbar.
Select Construct > Surface > Surface Wizard from the menu.

To use the Surface wizard:

1. At the top of the wizard, select a surface construction method from the following:
   - From curves (see page 384)
   - Primitive surface (see page 406)
   - From one surface (see page 412)
   - From multiple surfaces (see page 426)
   A list of constructors for the selected construction method is displayed at the bottom of the wizard.

2. Select a specific constructor from the bottom part of the wizard.

3. Click Next to display the selected constructor's dialog.

**Surface design tips**

Here are some concepts and techniques that have proved helpful in designing 3D surfaces.

- Design first, edit last. Put all the surfaces in place first, then trim and fillet the surfaces together to create the final shape and boundaries.

- Use quality source curves. Quality curves have as much detail as possible designed into the curves before the curves are used to make surfaces. Curves are much simpler to design and edit. With Parametric modeling active, changes to your source curves propagate automatically into the surface.
• Build as much detail into a single surface as possible. It’s easier to split and reduce surfaces than to merge and combine them. Similarly, machining with isoline operations uses one surface at a time and filleting and trimming work with two surfaces at a time so the more detail the better.

• Learn which surface methods are approximate and which are exact. Approximate methods are not better or worse than exact methods, but have more degrees of freedom in filling in the space between input curves or surfaces. Other surface methods are conditional. They are exact to what they do, but when used with approximate surfaces, the resulting surface is still approximate.

  ▪ **Approximate**: surface intersection, trim, untrim, fillet, lofting, merge, modify, offset. (Another key is any operation that includes a tolerance setting. That is a flag that the source material is being approximated.)

  ▪ **Exact**: extrude, surface of revolution, sweep, ruled, sphere, cylinder, flat, from a feature.

  ▪ **Conditional**: split, region, reverse, coons, cap. Coons is a mathematical definition of how four boundary curves describe a surface. Learn which dialogs give you the option to modify-in-place or create a new object.

• Learn when and how to use the option to **Modify-in-place** or **Create a new object**. Both methods have their uses. Modifying an object in place breaks the parametric link for which constructor was used for the original object and prohibit parametric modeling from updating an object in the future. This limits you to further modification operations only. Creating new objects can result in excessive clutter on the screen.

• Do not use self-intersecting curves or surfaces. Curves and surfaces with that characteristic are not viable for predictable editing, construction or machining.

**Surface editing**

There are a number of ways to edit surfaces. FeatureCAM supports filleting (see page 427), merging (see page 431), intersecting (see page 432), and direct modification (see page 437) of the surface. You can also derive a surface from a 2.5D feature.

**Surface editing tips**

Here are some hints for editing surfaces:
- Do not include portions of the boundary when constructing curves for trimming. Trimming curves may cross or end on boundaries.
- Do not use surface/surface intersection to get a boundary of a surface. Use surface boundary extraction.
- Intersecting tangent surfaces produces inaccurate or broken intersection curves, such as a fillet surface and the surface it’s tangent to. Instead, extract curves and trim with a curve instead.
- Do not intersect coincident surfaces (surfaces that overlap). Extract curves and trim with a curve instead.
- Avoid cutting through the pole of a surface with a degeneracy such as the tip of a sphere or surface of revolution.
- Avoid cutting along a seam of a surface (across is fine). A seam exists, for example, at the left/right boundary of a cylinder. You can detect seams with the curve extraction dialog, and then canceling out after you know where the seam is. Cutting a seam can usually be avoided by rotating the object.
- Surfaces can be trimmed multiple times.
- Curves for surface/curve trimming can extend off the surface and/or cut the surface multiple times.

**From curves**

You can use the **Surface wizard** (see page 381) to create surfaces from curves.

You can create the following types of surface from curves:

**Extrude** (see page 385)

**Surface of Revolution** (see page 386)
Extrude

Extrude creates a surface from a curve by extending that line sideways a specified distance. Sideways can be a linear distance in any direction. This is important as the extrude does not have to be only in the direction of an X, Y, or Z axis. Extruding along an axis is an easy way to build such a surface which you could then move or transform into the final position if you prefer. Extrudes are a shortcut to create a ruled surface between a curve and a transformation of the curve.

An extruded surface requires a source curve as input. If you have no curves or geometry in the drawing, you cannot create an extruded surface.

Extruded surfaces are exact (see page 382).

To create an extruded surface:

1. Use one of the following methods to display the Extruded Surface dialog:
   - Click the Surfaces icon in the Steps toolbox. In the Surface Wizard, select From curves and Extrude.
   - In the Advanced toolbar, click the Surface Wizard button. In the Surface Wizard, select From curves and Extrude.
   - In the Curves and Surfaces (see page 13) toolbar, click the Extrude button in the Surface from Curve Menu.
2. Optionally enter a name in the Surface name field.
3. Select the curve you want to use from the Curve menu, or click the Pick Curve button and select it in the graphics window.
4. Specify the dimensions of the extrude using one of the following methods:
   - Enter the dimensions of a vector along which to extrude the surface in the Vector X, Y and Z fields.
   - Enter the beginning and end locations of the extrude.
5 Click **OK** (or **Finish** if you are using the wizard).

**Example**

The handle on this hairdryer is an extruded surface:

![Image](image1.png)

The curve for the handle was drawn with the arcs and lines tools. The geometry was chained into a single curve which was then transformed down in Z to the depth where the handle exists. This transform operation puts a bounding curve in location for the top surface of the handle as well.

![Image](image2.png)

Then the handle curve was extruded along a vector -0.75 inches in Z.

**Surface of Revolution**

A surface of revolution is created by rotating a curve about a specified axis. The revolution is any amount from -360° to 360°. These are similar to a swept surface, and can be used to create other primitive shapes not provided such as a torus or a cone. These surfaces are exact.

While you can use a 3D curve as the curve to spin around an axis, there is a higher chance of creating a self-intersecting surface. Where possible, it's best to use a 2D curve for input to this surface.

*To create a surface of revolution, you need a curve and either the X or Y axis for rotation, or a custom line for the axis.*

To create a **Surface of Revolution**:
1 Use one of the following methods to display the **Surface of Revolution** dialog:

- Click the **Surfaces** icon in the **Steps** toolbox. In the **Surface Wizard**, select **From curves** and **Surface of Revolution**.
- In the **Advanced** toolbar, click the **Surface Wizard** button. In the **Surface Wizard**, select **From curves** and **Surface of Revolution**.
- In the **Curves and Surfaces** (see page 13) toolbar, click the **Surface of revolution** button in the **Surface from Curve Menu**.

2 Optionally enter a name in the **Surface name** field.

3 Select the curve you want to use from the **Curve** menu, or click the **Pick Curve** button and select it in the graphics window.

4 Enter the **Start angle** in degrees.

5 Enter the **End angle** in degrees.

6 In the **Construction method** section, select which axis the curve is rotated about. Select from **Custom line**, **X-Axis**, **Y-Axis** or **Z-Axis**.

7 If **Custom line** is selected, select the curve you want to use from the **Axis** list, or click the **Pick Curve** button and select it in the graphics window.

8 Click **Apply**.

9 Click **Preview** to display a preview of the surface in the graphics window.

10 Click **Finish**, or **OK** to create the surface.

*Revolved surfaces may have no cap on the ends depending on the source curve. Depending on the milling technique you select, such as Z-level roughing, you may need a cap surface (see page 403).*

More about revolved surfaces (see page 387).

Surface design hints (see page 382)

**More about revolved surfaces**

Surface of revolution is created by spinning a 2 dimensional curve about an axis that you specify. The revolution is any amount from 0° up to 360° degrees. These are similar to a swept surface, but can be used to create other primitive shapes not provided such as a torus or a cone.

These surfaces are exact (see page 382).
Revolved surfaces may have no cap on the ends depending on the source curve. Depending on the milling technique you select, such as Z-level roughing, you may need a cap surface.

An example of a revolved surface (see page 388).

**Revolved example**

The motor housing on the blow-dryer model is a surface of revolution. The source curve for the housing was created from a top view and then rotated 90° around the X axis to orient the curve for the revolve construction. A line was drawn from the center of the housing down in Z to act as the axis for the revolution. Later, this model uses a cap surface to complete the housing as an example of the cap surface.

Set the surface for a full 360° of revolution. Select the axis and the curve to pass around the axis and the result is shown in the second image. You could also have created this same surface as a sweep around the circle.

If the source curve had extended all the way to the rotation axis, the housing could be completed in one step. A drawback to this method is that the central boundary would be degenerate (a point) and may not provide good machining results.
Swept Surface

A swept surface creates a surface by replicating the shape of the curve at multiple positions along a path. The path is not necessarily a straight line. A sweep moves one curve along another and is useful for making many shapes. By creating complex curves for both the axis and the cross-section, complex fillets and blends can be directly achieved in a single surface.

Swept surfaces are exact (see page 382) unless the path or axis curve is a spline curve, not a curve built from lines, and arcs and chained together. Along a spline curve axis, the shape may deform.

There are two kinds of sweeps: a regular sweep and a translational sweep. Translational sweeps maintain the same relationship between the curve and axis normals at all points throughout the sweep. Otherwise, the sweep curve stays in its drawn position at all points on the axis.

The swept curve needs to be hooked to the axis curve at the start point of the curve. This figure shows an example of a cross-section curve that is properly defined. A UCS was created at the start point of the axis curve. The cross section curve was then defined relative to this UCS. Note that the setup axes were not changed. The UCS is used as a design coordinate system only.

The simplest way to create a curve at this location is to create a UCS at the start point of the axis curve and create your cross section curve in that UCS. See How to create a User Coordinate System (see page 110).

The model must contain two curves before you can create a swept surface.
To create a **Swept Surface**:

1. Use one of the following methods to display the **Swept Surface** dialog:
   - Click the **Surfaces** icon in the **Steps** toolbox. In the **Surface Wizard**, select **From curves** and **Swept Surface**.
   - In the **Advanced** toolbar, click the **Surface Wizard** button. In the **Surface Wizard**, select **From curves** and **Swept Surface**.
   - In the **Curves and Surfaces** (see page 13) toolbar, click the **Swept Surface** button in the **Surface from Curve Menu**.

2. Optionally enter a name in the **Surface name** field.

3. Select the curve that defines the axis the sweep will follow from the **Axis** list, or click the **Pick Curve** button and select it in the graphics window.

4. Select **Translational sweep** if you want to maintain the same relationship between the curve and axis normals at all points throughout the sweep.

5. Select the curve that defines the cross-section of the sweep from the **Cross section** list, or click the **Pick Curve** button and select it in the graphics window.

6. Select **Sweep from other end** to reverse the direction of the sweep.

7. Click **Preview** to display a preview of the surface in the graphics window.

   *If the previewed surface is not what you want, select or deselect the **Translational sweep** setting and click **Preview**.*

Click **OK** (or **Finish** if you are using the wizard).

More about swept surfaces

Surface design hints (see page 382)

An example of a swept surface (see page 391)

**More about swept surfaces**

Sweep (Constant Width) creates a surface by projecting a two dimensional curve along a path. The path is not necessarily a straight line. A sweep moves one curve along another and is useful for making many shapes. By creating complex curves for both the axis and the cross-section, complex fillets and blends can be directly achieved in a single surface.
You need to be sure and line up your cross section and your path curve. One way to do this is to create a UCS aligned with the start of the path curve and draw or transform your cross section curve into place.

Swept surfaces are exact (see page 382).

**Sweep example**

The speaker housing uses a swept surface to define the top, back, and bottom sides in one surface. The source curves are a large diameter circle segment (1000 inches) and a center line through the three sides (at maximum diameter of the segment). The **Translational sweep** switch was turned off for this surface to keep the bow in the same orientation relative to the axis throughout the sweep. The slightly bowed bottom is flattened later as a **Modify surface** operation.
Ruled Surface

A Ruled surface creates a linear surface between two curves. The curves can be open or closed, planar or non-planar. For closed curves, the starting points of the curves should line up or the surface may twist in odd ways.

The model must contain at least two curves before you can create a ruled surface pull-out.

To create a ruled surface:

1. Use one of the following methods to display the Ruled Surface dialog:
- Click the **Surfaces** icon in the **Steps** toolbox. In the **Surface Wizard**, select **From curves** and **Ruled Surface**.
- In the **Advanced** toolbar, click the **Surface Wizard** button. In the **Surface Wizard**, select **From curves** and **Ruled Surface**.
- In the **Curves and Surfaces** (see page 13) toolbar, click the **Ruled Surface** button in the **Surface from Curve Menu**.

2. Optionally enter a name in the **Surface name** field.

3. Select a curve on a bounding edge of the surface from the **Curve** list, or click the **Pick Curve** button and select it in the graphics window.

4. Repeat step 3 to select more curves. You need to select at least two curves to define a surface.

5. Use the **Move item up**, **Move item down**, **Reverse selected curve**, and **Delete item** buttons to set the sequence and direction of the curves in the ruled surface.

6. Optionally select **Reparameterize curves**.

7. Click **Preview** to display a preview of the surface in the graphics window.

8. Click **OK** (or **Finish** if you are using the wizard).

**More about ruled surfaces**

Ruled surface defines a surface by plotting rules between two different curves. The curves can be open or closed, planar or non-planar. For closed curves, the starting points of the curves must line up or the surface may twist in odd ways. See Twists in surfaces or solids with closed cross sections (see page 395) for more information. Ruled surfaces are useful for filling a region and blending between two curves and can be used with more than two curves to create a single surface where each section is the same as if each pair of curves were used to create a ruled surface.

Chained curves behave differently in a ruled surface than spline curves. If your surface does not look quite right in the **Preview**, select the **Reparameterize curves** check box and try the **Preview** again. **Reparameterize curves** analyzes the curves and may adjust the control points of the curves to yield a better surface result. Reparameterize affects both chained and spline curves, but the effect is stronger on chained curves.
Ruled surfaces are exact (see page 382).

**Ruled example**

The blow-dryer uses a ruled surface as a parting surface in the model. The two curves (lines in this case) are drawn along opposite sides of the stock and are then translated down in Z to the appropriate depth.

Then they are selected as the two curves for the ruled surface which passes under the other surfaces of the model to the extent of the part so there is a complete surface for use in the mold.
Twists in surfaces or solids with closed cross sections

When creating ruled surfaces of lofted surfaces or solids with closed cross sections, ensure that the start points of the curves are in the correct positions. This example shows a ruled surface created from cross sections with misaligned start points (marked with arrows):

![Ruled Surface with Misaligned Start Points]

After using Curve start/reverse (see page 329) to change the start point of the square center curve, the twist is removed, as shown:

![Ruled Surface with Correct Start Point]

Coons

Coons defines a surface between four bounding curves. Coons surfaces are useful for filling in the area bounded by curves. For planar curves, Cap surface (see page 403) is probably a better option, although the curves must be joined into a loop first. For a grid of curves, Coons surfaces do not produce smooth results because each surface is not influenced by its neighbors. Joining curves into cross-sections and using Lofted (see page 400) surfaces produces better results in that situation.

When using the three curve Coons option, the ordering of the curves makes a difference in the appearance of the surface. Try different sequences until the result is correct.

Chained curves behave differently in a Coons surface than spline curves. If your surface does not look correct in the Preview, select Reparameterize curves and try the Preview again. Reparameterize curves analyzes the curves and may adjust the control points of the curves to yield a better surface result. This option affects both chained and spline curves, but the effect is stronger on chained curves.

Coons surfaces are not as common in practice as they are in mathematical discussion. Coons surfaces are approximate (see page 382).
Creating a Coons surface

In general, you use four curves and the curves must each be open, but together form a closed loop. To use three curves, select 3 curves and the fourth curve field is disabled. If the corners do not match, you receive an error message, "unable to construct surface with these inputs."

To create a Coons surface.

1 Use one of the following methods to display the Coons dialog:
   - In the Surface (see page 381) wizard, select From curves and Coons, click Next.
   - Click the Coons button in the Surface from Curve Menu in the Curves and Surfaces (see page 13) toolbar.
   - Select Construct > Surface > From Curves > Coons.

2 Optionally enter a name in the Surface name field.

3 Optionally select 3 curves if you want to create a three-curve Coons surface.

4 Select a curve from the Curve 1 list, or click the Pick Curve button and select it in the graphics window.

5 Select a curve from the Curve 2 list, or click the Pick Curve button and select it in the graphics window. This curve must create a corner with Curve 1.

6 Select a curve from the Curve 3 list, or click the Pick Curve button and select it in the graphics window. This curve must create a corner with Curve 2, and if 3 curves is selected, this curve must create a corner with Curve 1.

7 If 3 curves is deselected, select a curve from the Curve 4 list, or click the Pick Curve button and select it in the graphics window. This curve must create a corner with Curve 1 and Curve 3.

8 Optionally select Reparameterize curves.

9 Click the Preview button to display a preview of the surface in the graphics window.

10 Click OK (or Finish if you are using the wizard).
**Coons example**

You might use a Coons surface to create a trough shape that necks down as shown below. This is easy to draw as two bounding curves on the stock surface, and two arcing end curves. You have less control over the behavior of the surface between curves than if you had used a lofted surface to create a similar shape.

![Coons example diagram](image)

**Curve Mesh**

Surface from curve mesh creates a surface from a grid of curves.

- Overview (see page 398)
- How to create a surface from a curve mesh (see page 399)
- Restrictions of surface from curve mesh (see page 399)
- See also Coons (see page 395).
Overview of surface from curve mesh

The curve mesh constructor makes a smooth surface from a mesh of row curves and column curves. For example, if you have the curves shown below:

![Curves](image1)

the curve mesh constructor creates the surface shown here:

![Surface](image2)

The mesh of curves may only partially intersect. This allows the surface to be built up incrementally. The figure below shows an example of such a surface.

![Surface](image3)
The surface is made up of Coons patches. If the input curves are smooth, the surface is smooth (equal tangent plane planes along the curves). The input curves must intersect at crossing points, but explicit curve points are not necessary at the crossings. The curves are reversed automatically. Triangular patches are supported when a pair of row or column curves meet at their ends.

**Creating a surface from a curve mesh**

To create a Curve Mesh:

1. Use one of the following methods to display the Curve Mesh dialog:
   - Click the Surfaces icon in the Steps toolbox. In the Surface Wizard, select From curves and Curve Mesh.
   - In the Advanced toolbar, click the Surface Wizard button. In the Surface Wizard, select From curves and Curve Mesh.
   - In the Curves and Surfaces toolbar, click the Curve Mesh button in the Surface from Curve Menu.

2. Optionally enter a name in the Surface name field.

3. Select a curve from the Row curve list, or click the Pick Curve button and select it in the graphics window.

4. Select a curve from the Column curve list, or click the Pick Curve button and select it in the graphics window.

5. Repeat steps 2 and 3 to select more curves. You need to select at least two row curves and column curves.

6. Use the Move item up, Move item down, and Delete item buttons to set the sequence of the curves in the mesh.

7. Enter a Tolerance. This determines the accuracy of the approximation to the curves.

8. Select Zero twists to minimize surface curvature.

9. Click Preview to display a preview of the surface in the graphics window.

10. Click OK (or Finish if you are using the wizard).

**Restrictions of surface from curve mesh**

The input curves must intersect at crossing points, but explicit curve points are not necessary at the crossings.
Lofted Surface

Lofting has its heritage from shipbuilders as they laid out ship hulls. They passed imaginary lines between multiple sequential cross-sections. A lofted surface creates a smooth surface from cross-sectional curve data. The curves can be non-planar as well.

To create a Lofted Surface:

1. Use one of the following methods to display the Lofted Surface dialog:
   - Click the Surfaces icon in the Steps toolbox. In the Surface Wizard, select From curves and Lofted Surface.
   - In the Advanced toolbar, click the Surface Wizard button. In the Surface Wizard, select From curves and Lofted Surface.
   - In the Curves and Surfaces (see page 13) toolbar, click the Lofted Surface button in the Surface from Curve Menu.

2. Optionally enter a name in the Surface name field.

3. Select a curve from the Curve list, or click the Pick Curve button and select it in the graphics window.

4. Repeat step 3 to select more curves. You need to select at least two curves to create a lofted surface.

5. Use the Move item up, Move item down, Reverse selected curve, and Delete item buttons to set the sequence and direction of the curves in the ruled surface.

6. Select Interpolated or Spline. Click Preview to see the difference.

7. Optionally select Uneven spacing. Click Preview to see the difference.

8. Optionally select Reparameterize curves.

9. Click Preview to display a preview of the surface in the graphics window.

10. Click OK (or Finish if you are using the wizard).

More about lofted surfaces (see page 401).
An example of a lofted surface (see page 402).
Surface design hints (see page 382)
More about lofted surfaces

Lofting defines surfaces that project between multiple curves. A lofted surface is used to create a smooth surface from cross-sectional curve data. The curves can be open or closed, but for closed curves the start points need to line up for good results. The curves can be non-planar as well.

Lofted surfaces are commonly used when there are many uniformly spaced cross-section curves available. A lofted surface has to fill in a lot of data between the cross-sections and so is an approximate surface. The data calculated to pass through the surface can be tweaked with the Uneven spacing switch for a better fit when the data points are not uniformly spaced.

The curves can be open or closed, but for closed curves the start points for each curve need to line up with the other curve start points for good results. See Twists in surfaces or solids with closed cross sections (see page 395) for more information.

Lofted surfaces are commonly used when there are many cross-section curves available. A lofted surface has to fill in a lot of data between the cross-sections so it is an approximate surface. The data calculated to pass through the surface can be tweaked with the Uneven spacing switch for a better fit when the input curves are not uniformly spaced.

Spline approximates the surface with input curves as control points/curves. They are smooth between points. Interpolate uses the input curves as explicit curves for the surface to pass through and the surface may wave, or bend between points. Setting the Uneven spacing switch might improve the fit if the input curves are not uniformly spaced. A lofted surface may be either exact (see page 382) or approximate (see page 382) depending on your settings.

The Select degree spinner allows you to vary the tightness by changing the degree of the polynomial used to calculate the resulting surface. A degree of one passes straight lines between curves (like a ruled surface). Higher degree curves allow a looser result between input curves. The highest degree possible is three or one less than the total number of curves, whichever is greater. If you are going to export the part file to another CAD package, some other software does not support degree values higher than three.

Chained or joined curves behave differently in a lofted surface than spline curves. If your surface does not look quite right in the Preview, set the Reparameterize curves check box and try the Preview again. Reparameterize curves analyzes the curves and may adjust the control points of the curves to yield a better surface result. Reparameterize affects both chained and spline curves, but the effect is stronger on chained curves.
Lofting should not be used when a sweep, or other more exact constructor could be used.

**Lofted example**

The soap dish model uses a lofted surface. Its source curves are worth understanding. Using a UCS on the side of the stock as shown in the diagram, simple geometry was drawn at depth (relative to the Setup) in Z. The geometry was then transformed in X to set the beginning, middle, and end curves of the top surface of the soap dish electrode. These curves were then used to build the lofted surface. The geometry may have to be reversed, to get the right surface.
**Cap Surface**

A cap surface takes a closed planar curve and makes a trimmed surface. It's a shortcut to build a flat surface trimmed with a custom-fit edge and for solid models. It is useful for making a planar trimmed surface to fill the area inside a curve.
You probably need to extract the source curve from an existing surface (see page 343) or surfaces.

To create a Cap Surface:

1. Use one of the following methods to display the Cap Surface dialog:
   - Click the Surfaces icon in the Steps toolbox. In the Surface Wizard, select From curves and Cap Surface.
   - In the Advanced toolbar, click the Surface Wizard button. In the Surface Wizard, select From curves and Cap Surface.
   - In the Curves and Surfaces (see page 13) toolbar, click the Cap Surface button in the Surface from Curve Menu.

2. Optionally enter a name in the Surface name field.

3. Select a closed curve from the Curve list, or click the Pick Curve button and select it in the graphics window.

4. Use the Move item up, Move item down, and Delete item buttons to set the sequence of the curves in the mesh.

5. Enter a Tolerance. This determines the accuracy of the approximation to the curves.

6. Click Preview to display a preview of the surface in the graphics window.

7. Click OK (or Finish if you are using the wizard).

More about cap surfaces

Cap surfaces can be used to make a cylinder into a closed solid, for example. Extract the boundary curve at each end of cylinder and make a cap surface out of each one. You can also create closed solids from extrudes, sweeps, and revolutions.
Supporting multiple curves in the cap surface allows you to nest your curves inside other curves. Depending on the direction of the curve, you can then include cutouts and surfaces within cutouts all in one operation. In the example below, the gray portion of the bullseye pattern contains surfaces, while the reversed clear rings have no surfaces of surfaces. Use **Preview with this feature** to get the curves directions right before you close the dialog.

![](image.png)

A cap surface may be either exact or approximate depending on your settings (see page 382).

Cap surface creates a surface to cover an 'open end' of another surface or surfaces. The surface(s) to be capped should form a closed surface by itself, or when considered as a group. While you can cap open surfaces, a straight line is drawn between the open points of the surface, and can generate inappropriate surfaces in cases where the endpoints cause the closing line to cross the surface boundary.

**Cap example**

The blow-dryer has a cap surface on the handle, but the handle is an open curve. So you have to close the curve and create a new curve from the handle curve and the geometry you used to close the curve. Snapping a line between the endpoints creates the needed geometry. Chain it all into a curve and build the Cap surface.
**Primitive surface**

You can use the **Surface wizard** (see page 381) to create primitive surfaces.

You can create the following types of primitive surfaces:
- **Sphere** (see page 406)
- **Cylinder** (see page 409)
- **Flat** (see page 410)
- **Surface(s) from Feature** (see page 411)

**Sphere**

**Sphere** constructs a spherical surface with a specified radius around a center point, or by using an existing circle as the 'equator' of the sphere you want to construct. Spheres are exact (see page 382) surfaces, but contain seams and degenerate curves at their poles.

To use **Sphere**:

1. **The model must contain an existing surface.**
2. Click the **Sphere** button in the **Surface Primitives Menu** in the **Curves and Surfaces** (see page 13) toolbar to display the **Sphere** dialog.
3. Optionally enter a name in the **Surface name** field.
4. Select a **Construction method**.
5. If **Center and radius** is selected:
   - Enter the coordinates of the center point in the **Center point** fields, or click the **Pick location** button and select it in the graphics window.
b  Enter the **Radius** of the circle.

5  If **Circle** is selected.

   Select a circle from the **Circle** list or click the **Pick circle** button and select it in the graphics window.

6  Click **Preview** to display a preview of the surface in the graphics window.

7  Click **OK** (or **Finish** if you are using the wizard).

   An example of a sphere surface (see page 408)

   Surface design hints (see page 382)
Sphere example

This blow-dryer example uses a spherical motor housing. So if the design called for 2.25 inch diameter sphere instead, you could create such a surface by drawing the 2.25 inch diameter circle at depth in the block. Now use that circle to construct a sphere, which you could trim with the ruled parting surface.
Cylinder

Cylinder creates a tube specified as a radius around a center line. You can specify the dimensions of the cylinder either with a start and point and a radius, or with a point, a direction, length and radius. It has no caps on the ends so you may need to use a Cap (see page 403) surface to complete your design. Cylinders are exact (see page 382) surfaces and contain a seam where two edge boundaries meet. Be careful not to trim across the seam. Editing along the seam is fine.

To use Sphere:

1. Click the Cylinder button in the Surface Primitives Menu in the Curves and Surfaces (see page 13) toolbar to display the Cylinder dialog.
2. Optionally enter a name in the Surface name field.
3. Select either Two points or Direction, length to specify the construction method.
4. If Two points is selected:
   a. Enter the coordinates of the start point in the Center fields, or click the Pick location button and select it in the graphics window.
   b. Enter the coordinates of the end point in the End point fields, or click the Pick location button and select it in the graphics window.
5. If Direction, length is selected.
   a. Enter the coordinates of the start point in the Center fields, or click the Pick location button and select it in the graphics window.
   b. Enter the X, Y and Z dimensions of a direction vector in the Direction fields.
   c. Enter the length of the cylinder in the Length field.
6. Enter the Radius of the cylinder.
7. Click Preview to display a preview of the surface in the graphics window.
8. Click OK (or Finish if you are using the wizard).

An example of a cylinder surface (see page 410)
Surface design hints (see page 382)
**Cylinder example**

You can model the vent tube of the blow-dryer example as a cylinder. Pick end and center points with the mouse and Pick buttons, or enter explicit coordinates. Set the points 2 inches in Z in the stock to create the cylinder at the right depth. Now set the radius to 1 inch. The cylinder can be trimmed to the rest of the model with the ruled surface.

---

**Flat Surface**

Flat Surface creates a flat rectangular surface between two corner points. The sides of the rectangle are aligned with the UCS axes.

To create a Flat Surface:

1. Click the Flat button in the Surface Primitives Menu in the Curves and Surfaces (see page 13) toolbar to display the Flat Surface dialog.
2. Optionally enter a name in the Surface name field.
3. Enter the coordinates of the top-right corner point in the X, Y and Z field, or click the Pick location button and select it in the graphics window.
4. Enter the coordinates of the bottom-left corner point in the X, Y and Z field, or click the Pick location button and select it in the graphics window.
5. Enter the Z elevation in the Elevation (Z) field, or click the Pick location button and select it in the graphics window. The elevation is uniform across the surface.
6. Click Preview to display a preview of the surface in the graphics window.
7. Click OK (or Finish if you are using the wizard).

More about flat surfaces (see page 411)
An example of a flat surface (see page 411)
Surface design hints (see page 382)
More about flat surfaces

Flat creates a rectangular surface between two diagonally opposite corners. This surface is a shortcut to create a ruled surface without having to build bounding curves if the surface is rectangular. Flat surfaces are exact (see page 382).

Flat example

The blow-dryer's parting surface can also be built with a flat surface. Simply create a flat surface at depth with corner points that align with two opposing block stock corners.

Surface(s) from Feature

You can create a 3D surface from any 2.5D feature.

The model must contain an existing 2.5D feature.

To create a surface from a feature:

1. Click the from Feature button in the Surface Primitives Menu in the Curves and Surfaces (see page 13) toolbar to display the Surface(s) from Feature dialog.
2. Optionally enter a name in the Surface name field.
3. Select a feature from the Feature list or click the Pick feature button and select it in the graphics window.
4. Click Preview to display a preview of the surface in the graphics window.
5. Click OK (or Finish if you are using the wizard).

More about turning features into surfaces (see page 412)
An example of a surface from a feature (see page 412)
More about turning features into surfaces

You can use these surfaces in your part modeling or even to manufacture them using the 3D techniques, or to modify with the Surface editing tools so you can join your 2.5D features to your 3D features.

Features can be a shortcut to create swept and cap surfaces with the familiar dimension driven feature interface. The draft angle, or radiused features produce a swept surface for the side walls (including chamfer and bottom/top radius) and a cap surface for the bottom in one operation.

Feature to surface example

The soap dish model can be built with a Boss feature for the side. In that method, you need to trim the fillet against the boss, but you have to create a surface to trim against. Select Surfaces from feature, name the new surface. Select the Boss feature as the source feature. FeatureCAM calculates the corresponding surface.

From one surface

You can use the Surface wizard (see page 381) to create surfaces from an existing surface.

You can create the following types of surface from one surface:
Region from Surface (see page 413)
Reverse Surface (see page 414)
Offset Surface (see page 416)
Extend Surface (see page 417)
Trim Surface (see page 418)
Untrim Surface (Fill Hole) (see page 422)
Split Surface (see page 424)

Surface Region

Surface Region derives a second surface from an original surface.

The model must contain an existing surface.

To use Surface Region:

1. Click the Region button in the Surface from Surface Menu in the Curves and Surfaces (see page 13) toolbar to display the Surface Region dialog.

2. Select Create new surface(s) to create a new surface or Modify existing surface(s) to trim the selected surface.

3. Optionally enter a name in the Surface name field. This field is available only if Create new surface(s) is selected.

4. Select a surface from the Surface list, or click the Pick surface button and select it in the graphics window.

5. Enter the coordinates of two points in the Isoline selection section, or click the Pick point on surface button and select them in the graphics window. The new surface is bound between the selected points.

6. Select Row or Column to orientate the selection region.

7. Click Preview to display a preview of the surface in the graphics window.

8. Click OK (or Finish if you are using the wizard).

More about surface regions. (see page 414)
An example of a surface region. (see page 414)
Surface editing hints (see page 383)
More about surface regions

Surface region derives a second surface from part of an original surface. A subregion of a surface is sometimes necessary for an auxiliary surface to use for surface/surface intersection, filleting, milling, and so on.

When you extract a region, you are getting a band of either columns or rows and this is an exact operation within the limits of the source surface.

Surface region is an exact process, however, if the source material is approximate, the resulting region can be no more precise than the source material.

Region example

For the top surface of the soap model, you could extract a row or column slice between any two points you choose. The picture below shows a potential region of rows from the Top surface of the model.

Reverse Surface

Surface Reverse is an exact (see page 382) operation.

The model must contain an existing surface.
To use **Surface Reverse**:

1. Click the **Reverse** button in the **Surface from Surface Menu** in the **Curves and Surfaces** (see page 13) toolbar to display the **Surface Reverse** dialog.

2. Select **Create new surface(s)** to create a new surface or **Modify existing surface(s)** to modify the selected surface.

3. Optionally enter a name in the **Surface name** field. This field is available only if **Create new surface(s)** is selected.

4. Select a surface from the **Surface list**, or click the **Pick surface** button and select it in the graphics window.

5. Select whether you want to:
   - Reverse normals.
   - Transpose row/column.
   - Reverse trim loops.

6. Click **OK** (or **Finish** if you are using the wizard).

   *Sheets (see page 445) can also be reversed using **Surface reverse**. You must select them from the **Surface list** and not in the graphics window.*

More about surface reverse (see page 415)

Surface editing hints (see page 383)

**More about surface reverse**

Because of the rectangular definition of surfaces, you have three options in the surface reverse process.

- You can keep the same surface, but reverse the direction of the calculated normals, thereby turning the surface inside out. This is perhaps the most common function as it affects isoline milling (see page 772).

- You can reverse the layout of the surface by swapping all the row and column layout with each other.

- You can also reverse the trim loops of the surface. This process takes a trimmed surface and changes the trim operation so that what was trimmed away before is now the retained surface and the discarded surface is the surface you selected for the surface reverse operation.
Surface Offset

Surface Offset offsets a surface along its surface normals. You may need to reverse the surface normals to get the offset you want. Surface offset is an approximate (see page 382) operation.

The model must contain an existing surface.

To use Surface Offset:

1. Click the Offset button in the Surface from Surface Menu in the Curves and Surfaces (see page 13) toolbar to display the Surface Offset dialog.
2. Select Create new surface(s) to create a new surface or Modify existing surface(s) to trim the selected surface.
3. Optionally enter a name in the Surface name field. This field is available only if Create new surface(s) is selected.
4. Select a surface from the Surface list, or click the Pick surface button and select it in the graphics window.
5. Enter the offset distance in the Offset field.
6. Enter a Tolerance. This determines the accuracy of the offset.
7. Click Preview to display a preview of the surface in the graphics window.
8. Click OK (or Finish if you are using the wizard).

More about surface offset (see page 416)
Surface editing hints (see page 383)

More about surface offset

An offset surface is a constant distance away from the original. The offset produces an approximation of this, which is why there is a tolerance. The original surface must be smooth (no sharp corners) or the offset result is not correct.

Use offsets to thicken an object or to account for shrinkage in mold-making.

Use offsets to intersect two (offset) surfaces to get the center curve of an implied fillet. This curve could be used for a groove milling operation to cleanly mill a fillet without actually making the fillet surface.

If an offset can be produced by an exact operation, for example, offsetting a curve and using revolution or a sweep, then use the exact operation.
Extend Surface

Extend Surface adds a linear extension to the selected surface similar to extruding the boundary curve of the surface however far you set. The direction of the extend is the tangent direction at the boundary. The surface is defined with rows and columns as you select which boundary to extend.

Extend surface removes all trim.

To use Extend Surface:

The model must contain an existing surface.

1. Click the Extend button in the Surface from Surface Menu in the Curves and Surfaces (see page 13) toolbar to display the Extend Surface dialog.
2. Select Create new surface(s) to create a new surface or Modify existing surface(s) to trim the selected surface.
3. Optionally enter a name in the Surface name field. This field is available only if Create new surface(s) is selected.
4. Select a surface from the Surface list, or click the Pick surface button and select it in the graphics window.
5. To pick the side to extend, select an option or click the Pick curve on surface button and select it in the graphics window.
6. Enter the extend distance in the Distance field.
7. Click Preview to display a preview of the surface in the graphics window.
8. Click OK (or Finish if you are using the wizard).

More about extending surfaces

Surface extends create extra surface to fill gaps or to be trimmed away cleanly by a nearby surface. For example, open fillets often have to be extended slightly before they cleanly trim the surfaces they fillet (and so they can be cleanly trimmed by another surface).

Extend is an exact operation.

More about extending surfaces

Surface extends create extra surface to fill gaps or to be trimmed away cleanly by a nearby surface. For example, open fillets often have to be extended slightly before they cleanly trim the surfaces they fillet (and so they can be cleanly trimmed by another surface). Extend is an exact operation.
**Extend example**

Consider the fillet in the soap dish model. If the top surface were undersized for some reason, or the fillet radius did not reach to the top surface, an extend operation could resolve the problem. In this case, select the **Extend surface** option from the **Curves and Surfaces** (see page 13) toolbar.

Unless you are sure of your process, it's safer to create a new surface instead of modify an existing surface. Select the **Create new surface** option and name it. Working through column and row options and previewing the results, the intended surface is achieved using First Column and an extension of 0.1 inch.

---

**Trim Surface**

Trimming cuts away a portion of a surface. The portion that is removed is determined by a trimming curve that lies on the surface. Trimming is useful for creating solid models or for simply removing an unwanted portion of a surface.

Overview (see page 419)
How to trim a surface with a curve (see page 420)
Trimming restrictions (see page 421)
Surface editing hints (see page 383)
Comparison with Surface/surface trimming (see page 436)
See also Surface/surface intersection (see page 345),
Surface/surface trimming (see page 432), and Fillets (see page 427).

**Overview of trimmed surface**

A trimmed surface is a surface that has a portion removed by an embedded curve. The curve divides the surface into two pieces. For example a square surface with a circular trimming loop forms either a square with a hole in it or a disk depending on which portion of the surface you want to keep.

This orange surface is the top portion of a soap bottle mold. It must be trimmed by the red curve to reflect the correct shape.
This blue surface shows the result of trimming the orange surface with the red curve.

See trimming restrictions (see page 421) for the rules for trimming surfaces.

**Trimming a surface with a curve**

To trim a surface, The model must contain a surface and a curve that bounds the area to be trimmed in the part model. The curve must cut across the surface boundary at two points for an open trim, or be contained completely within the surface.

To use Trim Surface:

1. Click the Trim button in the Surface from Surface Menu in the Curves and Surfaces (see page 13) toolbar to display the Trim Surface with Curve dialog.
2. Select Create new surface(s) to create a new surface or Modify existing surface(s) to trim the selected surface.
3. Optionally enter a name in the Surface name field. This field is available only if Create new surface(s) is selected.
4. Select a surface from the Surface list and click the Add item from list button, or click the Pick surface button and select it in the graphics window. Picking the surface in the graphics window tells FeatureCAM which side to keep.
5. Select a curve from the Trimming Curve list and click the Add item from list button, or click the Pick curve button and select it in the graphics window.
6 Enter a **Curve Tolerance**. This determines the accuracy of the approximation to the curve.

7 Enter a **Surface Tolerance**. This determines the accuracy of the approximation to the surface.

8 If you want to change which side of the surface is kept, select a surface from the **Surface** list and click to toggle whether trim is decided by pick location.

9 Click **Preview** to display a preview of the surface in the graphics window.

10 Click **OK** (or **Finish** if you are using the wizard).

**Trimming restrictions**

Trimming curves have two main restrictions:

1 The curve must lie on the surface. Convenient ways of getting a curve on a surface are:
   - If the surface is a flat surface, model the curve in the plane of the curve.
   - Project a curve onto the surface (see page 349).
   - Intersect two surfaces to get a curve (see page 345).

2 The curve must divide the surface in two distinct regions. If not, you will get the error **Can't trim, curve does not end on a boundary**. Think of the surface as a piece of paper and the trimming curve as a path for a pair of scissors. After the cutting operation, you should be left with two pieces of paper. The trimming curve must do one of the following:
   - Form a loop in the interior of the surface
   - Cut across two surface boundaries
   - Cut across the same boundary twice

Trimming examples:

**Valid:**

1

**Valid:**

1

**Valid:**

1

**Invalid:**

1

Additional trimming restrictions (see page 422)
**Additional trimming restrictions**

- Do not include portions of the boundary when constructing curves for trimming. Trimming curves may cross or end on boundaries.

- Avoid cutting through the degenerate boundary a surface such as the pole of a sphere or surface of revolution.

- Avoid cutting along a seam of a surface (across is fine). A seam exists, for example, at the left/right boundary of a cylinder. You can detect seams with the **Curve Extraction** dialog, and then canceling out after you know where the seam is. Avoid cutting a seam rotating the object because many objects with seams are symmetrical.

**Untrim surface**

Untrim removes one or all trimming loops from a trimmed surface and consequently adds area back to a surface.

Overview (see page 422)

How to untrim a surface (see page 423)

See also Overview of trimmed surface (see page 419) and Surface editing hints (see page 383).

**Overview of untrimming surfaces**

A trimmed surface is a surface with an embedded curve that removes a portion of the surface. See Overview of trimmed surfaces (see page 419) for more information.

When you untrim a surface you are removing the trimming curve from the surface and therefore adding the material back to the surface. The trimmed surface in the first image becomes the surface in the second image after you remove its circular trimming loop.
If you import a part model, it is often useful to untrim portions of the part that you would like to machine with 2.5D features. For example, in this simple part, surfaces are used to represent the geometry of the hole.

Because it is preferable to drill the hole using FeatureCAM's Hole feature (see page 637), we can untrim the surface by removing the entire trimming loop and mill it as if the hole did not exist and then later add in a Hole feature for drilling the hole.

For some parts, a feature such as a Hole may result in trimming edges in multiple surfaces. In this example, a hole trims away two surfaces:

Removing the entire outer trimming loop is undesirable because the notches at the top of the surfaces would also be removed. Instead, only the semi-circular edges from both surfaces need to be removed as shown here:

**Untrimming surfaces and filling holes**

**Untrim Surface** untrims a previously trimmed surface region to restore the entire surface.

*The model must contain a trimmed (see page 418) surface.*
To use **Surface Region**:

1. Click the **Untrim** button in the **Surface from Surface Menu** in the **Curves and Surfaces** (see page 13) toolbar to display the **Untrim a Trimmed Surface** dialog.

   All trimming loops are displayed.

2. Select **Create new surface(s)** to create a new surface or **Modify existing surface(s)** to trim the selected surface.

3. Optionally enter a name in the **Surface name** field. This field is available only if **Create new surface(s)** is selected.

4. Select a surface from the **Surface** list, or click the **Pick surface** button and select it in the graphics window.

5. To remove all trimming loops, select **Untrim all**.

6. To remove a single loop:
   a. Select **Untrim selected loop**.
   b. Click the **Pick curve on surface** button and select the loop in the graphics window.

7. To remove a single edge:
   a. Select **Untrim edge(s)**.
   b. Click the **Pick edges to untrim** button and select the edge in the graphics window.
   c. A button labeled **Untrim a Trimmed...** is displayed.
   d. Select the trim curve(s) in the graphics window.
   e. Double-click the button labeled **Untrim a Trimmed...** to display the **Untrim a Trimmed Surface** dialog.

8. Click **Preview** to display a preview of the surface in the graphics window.

9. Click **OK** (or **Finish** if you are using the wizard).

**Split Surface**

**Split Surface** breaks an existing surface into two new surfaces along a row or column division.

- The model must contain an existing surface.

To use **Split Surface**:

1. Click the **Split** button in the **Surface from Surface Menu** in the **Curves and Surfaces** (see page 13) toolbar to display the **Split Surface** dialog.
2 Optionally enter names in the **Surface name 1** and **Surface name 2** fields.

3 Select a surface from the **Surface** list, or click the **Pick surface** button and select it in the graphics window.

4 Enter the coordinates of two points in the **Isoline selection** section, or click the **Pick point on surface button** and select them in the graphics window. The new surface is bound between the selected points.

5 Select **Row** or **Column** to specify in which direction to split the surface.

6 Enter the coordinates of a point, or click **Pick point on surface** and select it in the graphics window.

7 A preview of the split is displayed in the graphics window.

8 Click **OK** (or **Finish** if you are using the wizard).

More about splitting surfaces (see page 425)

Surface editing hints (see page 383)

**More about splitting surfaces**

A subregion of a surface is sometimes necessary for an auxiliary surface to use for surface/surface intersection, filleting, milling, and so on. Split is an exact (see page 382) operation within the limits of the original surface.

Splitting the top surface of the soap dish model creates two surfaces. The pictures show a split along a column of the surface.
From multiple surfaces

You can use the **Surface wizard** (see page 381) to create surfaces from multiple existing surfaces.

You can create the following types of surface from multiple surfaces:

**Fillet Surfaces** (see page 427)
Fillet Surface

Fillet Surface creates a smooth curved transition surface between two adjacent surfaces.

Overview (see page 427)

How to create a fillet surface (see page 429)

Restrictions (see page 430)

See also surface-surface intersection (see page 345) and Trimming a surface with a curve (see page 418).

Overview of fillets

A fillet is a surface that creates a smooth tangent-continuous blend between two surfaces. This figure shows a fillet surface that blends two flat surfaces.
This figure shows the same fillet with the surfaces automatically trimmed against the two fillet boundaries.

Just like the case of an arc between two lines, there is more than one possible fillet between two surfaces. This figure shows the same two flat surfaces with a fillet on another corner.

A constant radius or rolling ball fillet is created by setting the Begin radius and End radius to the same value. A variable radius fillet is created by entering different values for the two radii.

Filleting multi-step process:

1 Intersect the two surfaces (see page 345). If you explicitly specify the intersection curve this step is skipped. The most common reason for explicitly entering the intersection curve is to calculate the curve separately and then extend it so that the fillet extends beyond the surface boundaries.

2 Construct fillet surface.

3 Optionally trim one surface against the top of the fillet. The top boundary curve of the fillet must be a valid trimming curve for the top surface.
4 Optionally trim the other surface against the bottom of the fillet. The bottom boundary curve must be a valid trimming curve for the bottom surface.

It is possible to create a valid fillet surface that does not allow you to trim the surfaces against the fillet. In this example, the fillet is in the middle of both surfaces and as a result the boundaries of the fillet are not valid trimming curves. See Trimming restrictions (see page 421) for the rules of valid trimming curves.

**Creating a Fillet Surface**

*The model must contain two surfaces that intersect to create a fillet.*

To create a Fillet Surface:

1 Click the Fillet button in the Surface from Surfaces Menu in the Curves and Surfaces (see page 13) toolbar to display the Fillet Surfaces dialog.

2 Optionally enter a name in the Surface name field.

3 Select a surface from the Surface 1 list, or click the Pick Surface button and select it in the graphics window.

4 Select a surface from the Surface 2 list, or click the Pick Surface button and select it in the graphics window.

5 If you want to trim the surfaces with the fillet:
   a Select Trim to fillet.
   b Enter a Trim tolerance. This determines the accuracy of the trimming. For most parts (less than 1 foot cubed), it is recommended that you enter a value between 0.001 and 0.0001 inches (0.0254 and 0.00254 mm).
   c Select Create new surface(s) to create a new surface or Modify existing surface(s) to trim the selected surface.

6 Optionally select a curve from the Intersection list or click the Pick curve button and select it in the graphics window. The fillet is limited along the selected curve.

7 Select Construct arcs only to create only the arcs that comprise the fillet. You can use these arc curves to create other surfaces later.

8 Select a corner from the list. This determines which corner the fillet is created in. The corner numbers in the list refer to the drawing.
9 Enter a **Tolerance**. This determines how accurately the fillet follows the original surface. For high quality fillets for parts that are approximately 1 foot cubed, the recommended settings are between **0.001** and **0.0001** inches (or **0.0254** and **0.00254** mm).

10 Specify an **Arc step**:
   - If **Variable** is selected, the spacing of the fillet cross sections are calculated automatically based on the **Tolerance**. More cross sections are placed in curved regions of the fillet as in this figure:

   ![Arc step variable](image1)

   - If **Variable** is deselected, enter an **Arc Step**. The spacing is constant between cross sections as in this image:

   ![Arc step variable](image2)

11 Enter a **Begin radius** and an **End radius**. For a closed fillet, these values must be equal.

12 Click **Preview** to display a preview of the surface in the graphics window.

13 Click **OK** (or **Finish** if you are using the wizard).

Surface editing hints (see page 383)

**Fillet restrictions**

- The fillet constructor works with two surfaces only.
- The surfaces must intersect.
- If trimming, the top and bottom boundary curves of the fillet must form a valid trimmed surface in the respective surfaces. See Trimming restrictions (see page 421) for the rules of valid trimming curves.
• Fillet creation does not consider trimmed portions of a surface so if you fillet a trimmed surface, the fillet extends for the complete length of the original surface. You can either trim the fillet away after it has been created or use an intersection curve to limit where the fillet runs.

• The input surfaces must be smooth with no sharp corners.

• The fillet radius should be less than the smallest radius of the intersection curve. If it is larger, the fillet may overlap itself.

See Surface design hints (see page 382) for additional recommendations.

Merge Surfaces

Merge Surfaces combines surfaces together to create a new surface.

The model must contain at least two surfaces.

To Merge Surfaces:

1. Click the Merge button in the Surface from Surfaces Menu in the Curves and Surfaces (see page 13) toolbar to display the Merge Surfaces dialog.

2. Optionally enter a name in the Surface name field.

3. Select a surface from the Surface 1 list, or click the Pick Surface button and select it in the graphics window.

4. Select a surface from the Surface 2 list, or click the Pick Surface button and select it in the graphics window.

5. Select a side for surface 1 from the Pick side to merge list, or click the Pick curve on surface button and select it in the graphics window.

6. Select a side for surface 2 from the Pick side to merge list, or click the Pick curve on surface button and select it in the graphics window.

7. Optionally select Flip surface 1.

8. Select Extract or Blend. Extract maintains the original surface in the final merge, Blend loses some of the original surfaces that are merged.

9. Click Preview to display a preview of the surface in the graphics window.

10. Click OK (or Finish if you are using the wizard).

More about merging surfaces (see page 432)
Surface editing hints (see page 383)

**More about merging surfaces**

You can merge with a blend so that the two surfaces transition into each other more gradually. Or you can make an exact merge so that the new surface keeps all of the original surface data of the two source surfaces.

Surfaces for a merge ideally have the same number of rows or columns so the two surfaces meet. The **Exact** option is best when the two surfaces share a common boundary curve. When they don't meet, exact inserts a ruled surface between the boundaries being merged.

If you had two neighboring flat surfaces, you could combine them with merge into one flat surface.

The **Blend** option is best when the surfaces don't meet. A fillet-like blend is created to fill the gap. Merging automatically untrims trimmed surfaces. Merged surfaces may be trimmed again as needed.

The **Exact** option is best when the two surfaces share a common boundary curve. When they don't meet, exact inserts a ruled surface between the boundaries being merged.

The **Blend** option is best when the surfaces don't meet. A fillet-like blend is created to fill the gap. Merging doesn't work for trimmed surfaces. Surfaces can be untrimmed, merged and then retrimmed.

**Surface-Surface Trimming**

**Surface-Surface Trimming** calculates the intersection of one surface against one or more surfaces and trims the surfaces with this curve.

Overview (see page 433)

How to trim surfaces against each other (see page 434)

Restrictions (see page 435)

Comparison with Trim a surface with a curve (see page 436)

See also Trim a surface with a curve (see page 418) and Surface-surface intersection (see page 345).
Overview of surface/surface trimming

Surface/surface trimming has two types of surfaces, trimming surfaces and trimmed surfaces. The trimming surface is the surface that does the cutting. Think of it as a pair of scissors or a knife. The trimmed surfaces are the surfaces that are cut. Think of them as the paper. You can have only one trimming surface, but you may have more than one trimmed surfaces.

The first step of surface/surface trimming is calculating the intersection of the trimming surfaces and the trimmed surface(s). This step happens behind the scenes and is only visible if you are previewing your calculation before actually performing it. This curve is then used to trim away a portion of the trimmed surfaces. If these surfaces are the original surfaces,

the blue curve in this figure is the intersection curve between the two surfaces.
These surfaces are the result of using the vertical surface as the trimming surface to cut the horizontal surface. If you select the Trim this surface also check box, the trimming surface is also trimmed using the intersection curve as in this image:

![Diagram of trimmed surfaces]

**Trimming surfaces against other surfaces**

Surface-Surface Trimming trims a surface against another surface. 

*The model must contain two intersecting surfaces.*

To use Surface-Surface Trimming:

1. Click the Surface-Surface Trim button in the Surface from Surfaces Menu in the Curves and Surfaces (see page 13) toolbar to display the Surface-Surface Trimming dialog.

2. Select Create new surface(s) to create a new surface or Modify existing surface(s) to trim the selected surface.

3. Optionally enter a name in the Surface name field. This field is available only if Create new surface(s) is selected.

4. Select a surface from the Trimming Surface list and click the Add item from list button, or click the Pick surface button and select it in the graphics window. Picking the surface in the graphics window tells FeatureCAM which side to keep.

5. Optionally select Trim this surface also, then select a side from the Side kept list.

6. Select a surface from the Trimmed Surface list and click the Add item from list button, or click the Pick surface button and select it in the graphics window. Picking the surface in the graphics window tells FeatureCAM which side to keep.

7. Repeat step 6 to select more surfaces to trim.

8. If you want to change which side of the surface is kept, select a surface from the Surface list and click to toggle whether trim is decided by pick location.

The options for Side kept are:
- **Picked side** - keeps the portion of the trimmed surfaces where you picked with the mouse.
- **Normal** - keeps the side of the trimmed surfaces that are on the opposite side as the normal of the trimming surface.
- **Reverse** - keeps the side of the trimmed surfaces that are on the same side as the normal of the trimming surface.

**9** Enter a **Tolerance**. This determines the accuracy of the trim.

**10** Click **Preview** to display a preview of the surface in the graphics window.

**11** Click **OK** (or **Finish** if you are using the wizard).

Surface editing hints (see page 383)

**Surface/surface trimming restrictions**

- The intersection curve is calculated using the surface/surface intersection technique. If you receive the message **No surface/surface intersection**, then FeatureMILL cannot determine the intersection curve for your surfaces. For additional details see these restrictions (see page 383).

- If you receive the message **Can’t trim, trim curve does not end on a boundary**, then an intersection curve has been calculated, but it is not a valid trimming curve for your surfaces. This figure shows an example.

![Diagram](image)

See Trimming restrictions (see page 421) for all the restrictions for trimmed surfaces.

- If you have multiple trimmed surfaces, the intersection curve must form a valid trimmed surface for each of the trimmed surfaces.

- If you have selected the **Trim this surface also** check box, then the intersection curve must form a valid trimmed surface with respect to the trimming surface.
**Comparison of Surface/surface trimming and Trim a surface with a curve**

Surface/surface trimming is more accurate and is the preferred method of trimming surfaces against each other.

Surface/surface trimming should be used if the intersection curve of the two surfaces is a valid trimming curve for the surface to be trimmed.

Surface/surface trimming performs surface/surface intersection as its initial step. The resulting curve is then used to trim the surfaces. This curve must be a valid trimming curve for the surfaces to be trimmed. See trimming restrictions (see page 421) for more information. If the intersection curve does not cut all the way across the surfaces to be trimmed, you may have to calculate the intersection curve separately and then join it with other curves to form a valid trimming curve for the surface.

Trim a surface with a curve should be used:

- If you only have a curve with which to trim a surface.
- If the surfaces are tangent at their intersection such as a fillet and its blending surfaces. In this case, extract the boundary curve of the fillet surface and use it to trim the other surface.
- Where one surface needs to be trimmed by multiple other surfaces before a complete loop is formed. You may need to extract trimmed edges or calculate surface/surface intersection curves and join them to create the trim loop. In this example, the orange revolved surface cannot be trimmed by either the blue or red surface alone.

Instead:
1 Create a curve at the intersection of the blue surface and the orange surface.
2 Create a curve at the intersection of the red surface and the orange surface.
3 Join the two curves.
4 Trim the orange surface with the joined curve.

**Modify Surface**

Modify Surface works with the surface by manipulating links and surface curves.

*The model must contain a surface.*

To use Modify Surface:

1 Click the Modify button in the Surface from Surfaces Menu in the Curves and Surfaces (see page 13) toolbar to display the Modify Surfaces dialog.
2 Select a surface from the Surface list, or click the Pick Surface button and select it in the graphics window.
3 Select Show surface to display a preview of the surface in the graphics window.
4 Select an operation type from the Operation list. You can select:
   - Move point (see page 437)
   - Change link to line (see page 438)
   - Change link to arc (see page 439)
   - Add surface curve (see page 439)
   - Delete surface curve (see page 440)
5 Follow the instructions in the dialog. Depending on which operation type is selected, enter or pick a point, link or curve. If Add surface curve is selected, Select Row or Column.
6 Click OK (or Finish if you are using the wizard).

More about modifying surfaces (see page 440)
An example of a modified surface (see page 441)
Surface editing hints (see page 383)

**Move Point**

Move Point enables you to change any intersection point on the surface to any other point.
To use **Move Point**:

1. In the **Modify Surface** (see page 437) dialog, select **Move Point**.
2. Select a surface from the **Surface** list, or click the **Pick Surface** button and select it in the graphics window.
3. Click the **Pick point on surface** button and select a point in the graphics window.
   The coordinates of the point are displayed.
4. Enter new coordinates for the point.
5. Click **OK** (or **Finish** if you are using the wizard).

The surface is redefined to maintain the overall smoothness of the surface so the shape is still tangent continuous.

This edit breaks the link between the surface and the method originally used to construct it. You cannot open the surface's **Properties** dialog and modify it based on the parameters that originally defined it as those parameters no longer apply directly to this surface.

---

### Change link to line

**Change link to line** converts any selected segment into a straight line between its end points.

To use **Change link to line**:

1. In the **Modify Surface** (see page 437) dialog, select **Change link to line**.
2. Select a surface from the **Surface** list, or click the **Pick Surface** button and select it in the graphics window.
3. Click the **Pick curve on surface** button and select a curve in the graphics window.
4. Click **OK** (or **Finish** if you are using the wizard).

The selected segment is converted into a straight line, and the surface shape is recalculated.

This edit breaks the link between the surface and the method originally used to construct it. You cannot open the surface's **Properties** dialog and modify it based on the parameters that originally defined it as those parameters no longer apply directly to this surface.
Change link to arc

*Change link to arc* converts a selected segment to an arc that has the same shape. This does not change the shape of the surface but you can use it to control surface behavior between defining curves, for example.

To use *Change link to arc*:

1. In the **Modify Surface** (see page 437) dialog, select *Change link to arc*.
2. Select a surface from the **Surface** list, or click the **Pick Surface** button and select it in the graphics window.
3. Click the **Pick curve on surface** button and select a curve in the graphics window.
4. Click **OK** (or **Finish** if you are using the wizard).

The selected segment is converted into an arc, and the surface shape is recalculated.

This edit breaks the link between the surface and the method originally used to construct it. You cannot open the surface's **Properties** dialog and modify it based on the parameters that originally defined it as those parameters no longer apply directly to this surface.

Add surface curve

*Add surface curve* adds another surface curve to a surface. You can then use the curve to modify the shape of the surface.

To use *Add surface curve*:

1. In the **Modify Surface** (see page 437) dialog, select *Add surface curve*.
2. Select a surface from the **Surface** list, or click the **Pick Surface** button and select it in the graphics window.
3. Click the **Pick point on surface** button and select a point in the graphics window.
   
   The coordinates of the point are displayed.
4. Select **Row** or **Column** to determine the orientation of the new curve.
5. Click **OK** (or **Finish** if you are using the wizard).
This edit breaks the link between the surface and the method originally used to construct it. You cannot open the surface’s Properties dialog and modify it based on the parameters that originally defined it as those parameters no longer apply directly to this surface.

**Delete surface curve**

Delete surface curve removes a surface curve from the surface. This can change the shape of the surface. You cannot delete a boundary curve.

To use Delete surface curve:

1. In the Modify Surface (see page 437) dialog, select Delete surface curve.
2. Select a surface from the Surface list, or click the Pick Surface button and select it in the graphics window.
3. Click the Pick curve on surface button and select a curve in the graphics window.
4. Click OK (or Finish if you are using the wizard).

This edit breaks the link between the surface and the method originally used to construct it. You cannot open the surface’s Properties dialog and modify it based on the parameters that originally defined it as those parameters no longer apply directly to this surface.

**More about modifying surfaces**

Modify works with the surface by manipulating links and surface curves. The links of a surface characterize the shape of the surface. The collection of links in one direction across the surface is known as a surface curve. When you select the surface to modify, a number of blue lines appear with intersection points. These are the links and surface curves. A link is any segment between two intersection points.

Isolines are displayed on the screen, but they are not the surface curves that are edited. To see the isolines while editing, select the Show surface option. With Modify you can change specific points in the surface to fine tune your surfaces to match your needs. Changing the surface with Modify breaks the parametric link of the surface to the original construction data.
**Modify example**

The speaker case, for example, has a slightly bowed bottom. With **Modify**, you can flatten that part of the model. Orient the model so you can see the bottom. The view of the model is shown on the left. On the right is an unshaded zoom of the model in the same orientation so you can see the result of the **Modify** operation. Using **Modify**, set **Change link to line** to make a straight line between the points and select the front edge of the bottom. Click **Apply**. Notice how the bottom surface flattened out in comparison to the source curve which is also visible. This surface can no longer be edited from the **Sweep** operation used to create it because the **Modify** operation breaks the relationship to the original data. Another **Modify** operation is needed to flatten the back edge of the surface.

**Corner Blend**

Blend surfaces are surfaces that create smooth transitions between two, three or four surfaces.
Overview of blend surfaces (see page 442)

Using Corner Blend (see page 443)

Restrictions on blend surfaces (see page 444)

See also Fillet (see page 427), Surface/surface trimming (see page 432), Curve from surface intersection (see page 345), Curve from surface isoline (see page 347), and Curve projected onto a surface (see page 349).

**Overview of blend surfaces**

A fillet (see page 427) is a type of blend surface, but it requires that the two surfaces actually intersect. They also have the restriction that they can only blend two surfaces. A blend surface is a more general blend of two, three or four surfaces. This surface constructor requires that you be familiar with creating curves on a surface and tangency, but it creates complex blends if these concepts are mastered by the user.

**Two-surface blends**

This figure shows a two-surface blend example. For this blend you must supply the curve on each surface to create this surface.

**Three-surface blends**

This figure shows a three-surface blend example. This blend is used to create what is known as a 'suitcase fillet'. This means that you want to create the intersection of three fillets like the corner of a suitcase. If you create the fillets with FeatureMILL3D, the curves can usually be automatically detected.
Four-surface blends

This figure shows a four-surface blend example. It is another suitcase fillet. In this case one surface is not a fillet.

The curve for this surface must be specified. Four-surface blends can also be used to join four distinct surfaces as in this figure.

Using Corner Blend

Corner Blend creates a blend surface between two surfaces.

To use Corner Blend:

1. Click the Corner Blend button in the Surface from Surfaces Menu in the Curves and Surfaces (see page 13) toolbar to display the Corner Blend dialog.

2. Optionally enter a name in the Surface name field.

3. Enter the number of surfaces you want to blend in the Surfaces field. This must be a number between 1 and 4.

4. Select a surface from the Fillet 1 list, or click the Pick Surface button and select it in the graphics window.

5. Select a curve from the Curve On Fillet 1 list, or click the Pick curve or geometry button and select it in the graphics window. Select **Automatic to use an automatically selected curve. See Restrictions on blend surfaces (see page 444) for further information.
6 Repeat steps 4 and 5 for **Fillet 2, Fillet 3 and Aux Srf**.

7 Enter a **Tolerance**. This determines the accuracy of the corner blend.

8 If you want the fillets to be trimmed against the blended surface:
   a select **Trim Fillets**.
   b Enter a tolerance in the **Trim Tol** field.
   c Select Create new srf(s) to create a new surface or Modify existing srf(s) to modify the existing surfaces.

9 Click **Preview** to display a preview of the surface in the graphics window.
   If the edges of the fillet are too coarse set the **Tolerance** to a smaller value.

10 Click **OK** (or **Finish** if you are using the wizard).

**Restrictions on blend surfaces**

For three or four surfaces, if you choose **Automatic** as the curve to indicate that the system should automatically calculate the curve then the following restrictions apply:

- The fillet surfaces must extend to where they intersect with the other fillet surfaces. This figure shows an example of surfaces that do not intersect.

- If the surfaces are not a FeatureCAM-created fillet (either not a fillet at all, or an imported surface), the automatic corner boundary calculation may fail. In these cases it is better to specify the curve-on-surface for that particular surface.

- FeatureCAM attempts to find a closed loop across the three or four surfaces by intersecting the rail curve boundaries of each fillet with the other fillet's rail curves. This figure shows rail curves.
Therefore, if any of the curves on surfaces are specified, they must intersect with these rail curves of the fillet surfaces where a curve on a surface is not supplied.

If a fourth surface is supplied, it is usually not a fillet surface. For these surfaces you must supply a curve on the fourth surface. The curve supplied must be on the fourth surface and should be tangent to the rail curves or the neighboring fillets.

If the automatic calculation fails, try a bigger tolerance, supplying more curves on the surfaces or extending the fillet surfaces so that they intersect. Sometimes it is helpful to recreate the fillet surfaces with a tighter tolerance or a variable arc step.

**General restrictions**

- With only two surfaces, you must indicate curves on each surface to connect.
- For three sided cases, if there is a natural pole as in this image, it is best to put the fillet surface that is furthest from the pole as the first surface.

**Solids (SOLID)**

Solids are groups of connected surfaces that make up a solid model within an enclosed volume.
You can create solids in FeatureCAM (see page 451), or imported them from CAD modeling systems (see page 82).

Use these methods to create solids in FeatureCAM:

- Click the **Solids** step in the **Steps** panel to display the **Solid** wizard.
- Use the **Solid** toolbar (see page 22).
- Select the **Construct > Solid** menu option to display the list of solid creation tools.

**Definitions**

A *solid* is a collection of surfaces (called *faces*) that define a 3D volume. The edges that join faces are shared between the faces. A solid cannot have any holes. If you filled it with water and tumbled it around, it would not leak. For example, a box is a solid, but a box with a missing face is not. FeatureCAM names these objects with a prefix of **solid**, for example **solid123**.

A *face* is an individual surface contained in a solid. FeatureCAM names these objects with a prefix of **face**, for example **face472**.

An *edge* is a curve that connects two faces. FeatureCAM names these curves with a prefix of **edge**, for example **edge857**. These curves are not normally displayed, but they are displayed by dialogs that need an edge.
A *sheet* is a group of surfaces that are created using the solid modeling tools, but that do not create a solid. Sheets have restrictions on how they can be used because they do not enclose a 3D volume. FeatureCAM names them with a prefix of *sheet*, for example *sheet902*. When you create a sheet, a dialog is displayed indicating that a *non-solid* result was created from the design operation.

A *surface* is a single 3D surface that is created with the tools of the FeatureCAM *Surface* wizard or imported from a CAD system (usually through IGES file transfer). These surfaces do not share edges with neighboring surfaces even though the boundaries may overlap. The edges are individually defined in each surface. Certain collections of surfaces may be converted into sheets or solids using the design features available in the From surfaces (see page 463) category of the Solid Wizard (see page 452).

**Comparison of surface and solid modeling**

The advantages of surface modeling are:

- For representing curved shapes, surface modeling tools are more powerful. Operators like Ruled Surface (see page 392), Curve Mesh (see page 397), Cap Surface (see page 403), and Modify Surface (see page 437) are available only for surface modeling. Lofted Surface (see page 400) is more powerful than the solid Fillet Edges (see page 470) design feature.
- With surfaces you are not forced to always work with 3D volumes. You can build your model face by face with surfacing tools without having to worry about 3D volumes.

The advantages of solid modeling are:

- Many surfaces are grouped together in a single solid, so solids can be a more efficient way to model.
- Modeling operations that need to know the connections between surfaces are more powerful in solids. Filleting is stronger in solids because you need only pick shared edges.
Useful modeling tools like **Combine Solids** (see page 475), **Shell** (see page 477), and **Silhouette Curves** (see page 483) are available only for solids.

### Part View for solids

All solids are listed under the **Solids** section of the **Part View**. Below each solid is a sequence of design features that were used to create the solid. The first design feature listed for a solid is the **base** feature. Base design features define the initial shape of the solid. Base design feature names have the suffix **base**. Subsequent design features listed under the solid, further modify the shape of the solid. The prefix of a design feature name indicates the type of design operation that was used to create it.

In the example below, **solid11** is made up of three separate design features. The first feature is named **stkbase1**. As the first feature of the solid, it is the base feature. The prefix, **stk**, indicates that the stock was used to create the feature. The second design feature is named **extcut1**. The name indicates that an extrude design operation was used to cut out the pocket shape. The final design feature is named **fillet1** and was created using a fillet design operation.

*The list of design features is available only for solids that are created in FeatureCAM. If you import a solid, only the resulting solid model is imported. You can access the faces of the solid, but you have no history of how the model was constructed.*
Unattached design features

If a solid design feature becomes disconnected from the solid, a question mark is displayed over its icon in the part view as shown below.

These disconnected design features are called *unattached* features. They can occur if you place a feature outside of the boundaries of a solid, or an edit to the solid makes a feature become unattached. For example, if you fillet an extrude feature and then delete the extrude feature, the fillet feature becomes unattached.

Unattached features do not cause any harm, but they are no longer contributing to the shape of the solid. If you select the solid, the faces of the unattached features are not selected.

Selecting and deleting solids

You can select solids in one of these ways:

- Hold down the *Space* bar and directly pick the solid in the graphics window. To select multiple solids in the graphics window, hold down the *CTRL* key and *Space* bar and then select each solid.
- Click the name of the solid or one of its design features in the Part View
- Right-click on a face of the solid and select *Select Solid* from the context menu.

*Clicking in the graphics window selects only a face of the solid.*

Solids can be deleted only by selecting them and either pressing the *DELETE* key or selecting *Delete* from the *Edit* menu.

Verifying that a solid is valid

Occasionally, a solid model can be imported that looks good, but is not a valid solid. That can cause problems performing further solid modeling operations or recognizing features from the solid. To check that the solid is valid:

1. Click the AFR (Automatic Feature Recognition) step in the Steps toolbox.
2 Click the **Verify** button.
   A dialog displays indicating whether the solid is valid.
3 Click **OK** to close the dialog.

If you want to see a visual representation of where any problems with a solid are:

1 Select **Construct > Solid > Verify Solid** from the menu.
   The **Verify Solid** dialog is displayed.

2 Select the solid that you want to verify from the list.
3 Select the **Color bad faces** option.
4 Click **Verify**.

   Any self-intersecting faces are shown in the color that is set for **Verify: self intersecting** in the **Default Colors** (see page 128) dialog.

   Any other bad faces are shown in the color that is set for **Verify solid bad face** in the **Default Colors** (see page 128) dialog.

### Invalid solids

If you try to import and invalid solid, an error is displayed and you can choose to import the solid as surfaces. You can then try to create a solid from these surfaces using the **Stitch** (see page 463) constructor.

Imported surfaces are named according to which solid they belong to. For example, the surfaces imported from a solid named **solid1** are named **solid1_1, solid1_2, solid1_3**, and so on in the **Part Tree**; and the surfaces from a solid named **solid2** are named **solid2_1, solid2_2, solid2_3**, and so on. This makes it easier to see which surfaces belong to which solid and to select all the surfaces from just one solid.
Fixing bad surface faces

If you see error **TPSRF01: Bad surface(s): face_name. Remove from feature** when trying to create a Surface feature, you have some bad faces in the surface.

You can try to 'fix' these faces in this way:

1. Select the faces that are a problem.
2. Right-click on one of the faces and select **Fix Face** from the context menu.

If this does not solve the problem, remove the bad surfaces from the Surface feature.

Transforming a solid

To transform a solid:

1. Select the solid (see page 449).
2. Click the **Transform** button in the **Standard** toolbar.
   
   The **Transform** (see page 310) dialog is displayed.
3. If you selected to move the solid, a solid operation is created in the Part View.
4. If you select to copy the solid, a new solid is displayed in the Part View.

Creating a solid

Solid modeling commands are available from the **Solid Wizard** (see page 452), the **Solid** (see page 453) toolbar, and the **Construct > Solid** menu.

The specific solid constructors are divided into four different methods:

**From Curves** (see page 454):

- Extrude Solid Design Feature (see page 455)
- Revolved Solid Design Feature (see page 456)
- Swept Solid Design Feature (see page 459)
- Lofted Solid Design Feature (see page 461)

**From Surfaces/Primitives** (see page 463):

- Stitch (see page 463)
- From 2.5D Feature (see page 466)
Stock (or Cube) (see page 465)
Extrude a Surface (see page 467)
Revolve a Surface (see page 469)

**Shape Modifiers (see page 470):**
Fillet Edges (see page 470)
Cut with Parting Surface (see page 473)
Combine Solids (see page 475)
Shell (see page 477)

**Manufacturing (see page 482):**
Silhouette Curves (see page 483)
Select Core/Cavity (see page 485)
Split Face (see page 488)
Delete Face (see page 489)
Explode (see page 491)
Parting Surface (see page 491)
Draft a Face (see page 493)

**Solid Wizard**

The **Solid Wizard** guides you through the steps needed to create a solid.

To use the **Solid Wizard**:

1. Open the **Solid Wizard** in one of these ways:
   - Click the **Solids** button in the **Steps** panel.
   - Click the **Solid wizard** button on the **Advanced** toolbar.
• Select Construct > Solid > Solid Wizard from the menu.

2 If you have not created a base solid a page is displayed that helps you create it. Select:
   • Use the stock as the base solid to create the base solid from the stock or make another cube shape.
   • Define a custom shape to continue with the solid wizard opens.

3 Select a method of solid construction.

4 Select a specific solid constructor.

5 Click Next to open the dialog for the solid constructor you selected.

6 When you have specified the settings for the solid, click Finish (see page 453) to create it. FeatureCAM uses the defaults for any remaining settings.

Finish solid button

Click the Finish button to create the solid you selected. If you click the button before completing all the options in the wizard, FeatureCAM uses the defaults for the remaining settings.

To specify how the button works, click the down arrow and choose an option. Select:
   • Finish to create the solid and close the wizard.
   • Finish and Edit Properties to close the wizard and open the properties dialog for the solid you created.
   • Finish and Create More to create the solid and return to the start of the wizard. You can then create a new solid.

FeatureCAM remembers your selection and, when you next use the wizard, the icon displayed on the button indicates its current state. For example: indicates the button is currently in Finish and Edit Properties mode.

Solid toolbar

The Solid toolbar lets you quickly access the dialog for the type of solid you want to create.

To use the Solid toolbar:

1 Display the Solid toolbar in one of these ways:
   • Select View > Toolbars from the menu, select Solid on the Toolbars tab and click OK.
• Right-click in a space in the toolbars area and select **Solid** from the context menu.

2 Click a solid constructor button on the toolbar.

*The constructors are grouped into four methods. Click the arrow buttons to access the menu of all buttons in a group.*

**From curves**

The following **From Curves** solid constructors are available:

- **Extrude** (see page 455)
- **Revolved Solid** (see page 456)
- **Swept** (see page 459)
- **Lofted** (see page 461)

All of the solid design features created from curves have the following options:

- **As new base solid** — This creates an independent base solid that is not subordinate to any other solid.
- **As add** — This create the design feature and appends it to the solid.
- **As cut** — This creates the design feature and subtracts it from the solid.

In this example a circle is extruded down into a block:

<table>
<thead>
<tr>
<th>If the extrude feature type is an <strong>add</strong> then the cylinder is trimmed against the surfaces of the box and the portions of the cylinder outside of the box is added to the solid.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>If the extrude feature type is a <strong>cut</strong> then the cylinder is trimmed against the surfaces of the box and the portions of the cylinder inside of the box are subtracted from the solid.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>
For **As add** or **As cut**, if there is more than one base solid, you must pick or select the base solid.

**Extrude**

**Extrude** creates a solid design feature by pushing a curve in a straight line. Below are examples of an *add* extrude with a circle as the curve and a *cut* extrude with a rectangle as the curve.

To create a solid extrude design feature:

1. Open the **Extruded Solid** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **From Curves**, then **Extrude**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Extrude** button in the **Solid from curve** menu.
   - From the menu, select **Construct > Solid > From Curves > Extrude**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. Select the type (see page 454) **As New Base Solid, As Add, or As Cut**.

4. Select the curve name in the **Curve** list or click the **Pick Curve** button and select the curve in the graphics window.

   *The curve must be planar.*
Specify the parameters of the extrude. You can do this in one of two ways:

- Enter the specific Vector of the extrude.
- Enter the points to extrude From and To.

If you want to draft the walls of the surface, enter a Draft Angle.

Click the Preview button to see a line drawing of the feature.

If you displayed this dialog from the Solid toolbar, you can click Apply to preview the feature as a solid. If the cut is on the wrong side of the curve, click Flip side to Cut and click Apply again to verify.

Click OK (or Finish if you are using the wizard).

You can also use open curves for solid extrudes.

You can use open curves for solid base extrudes or solid cut extrudes. You cannot use them for solid add extrudes. For base extrude solids, a sheet is created without any end caps.

For cut extrude solids, you must ensure that the cut will divide the solid into two distinct pieces like in this figure.

When working with open curves, an additional option called Flip Side to Cut is displayed. After previewing your result, you can select this option if you want to keep the solid on the other side of the extrude.

Revolve

Revolved Solid creates a solid design feature by revolving a curve around a line.

This example shows a base solid created with a curve on the axis revolved 360°. You can tell that the curve was on the axis because there is no hole in the middle.
This example is an extrude cut design feature rotated 180°:

This example shows a base solid created with a curve off the axis (note the hole in the middle) and revolved 270°:

To create a solid of revolution design feature:

1. Open the **Revolved Solid** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **From Curves**, then **Solid of Revolution**.
   - On the **Solid** (see page 453) toolbar, click the **Revolve** button in the **Solid from curve** menu.
   - From the menu, select **Construct > Solid > From Curves > Revolve**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. Select the curve name in the **Curve** list or click the **Pick Curve** button and select the curve in the graphics window.

   *The curve must be planar.*
4 Pick the **Construction** method. This is where you set what is revolved around, or the pole. You can pick a **Custom line**, **X-Axis**, **Y-Axis**, or **Z-Axis**.

5 If you selected **Custom line**, select the name of the line in the **Axis** list or click the **Pick Line** button and select the line in the graphics window.

6 Enter the **Start angle** in degrees.

7 Enter the **End angle** in degrees.

8 Select the type (see page 454) **As New Base Solid**, **As Add**, or **As Cut**.

9 Click the **Preview** button to see a line drawing of the feature.

10 If you displayed this dialog from the **Solid** toolbar, you can click **Apply** to preview the feature as a solid. If the cut is on the wrong side of the curve, click **Flip Side to Cut** and click **Apply** again to verify.

11 Click **OK** (or **Finish** if you are using the wizard).

**Using open curves for solids of revolution**

If the curve is open, a dialog is displayed with the following options:

- **Close curve using lines to axis** — This creates a straight line from the curve endpoints to the axis.
Close curve by joining endpoints — This creates a straight line between the endpoints of the curve.

Continue with curve as-is — No change is made to the curve and a sheet is created.

**Sweep**

A **Swept** solid takes a curve and runs it along another curve. The example below shows a circle swept along a curved path to create a groove shape.

To create a swept solid design feature:
1. Open the **Swept Solid** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **From Curves**, then **Swept**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Sweep** button in the **Solid from Curve** menu.
   - From the menu, select **Construct > Solid > From Curves > Sweep**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. Select the curve name in the **Axis** list or click the **Pick Curve** button and select the curve in the graphics window.

   *The curve must be planar.*

4. Select the curve name in the **Cross section** list or click the **Pick Curve** button and select the curve in the graphics window.

5. Select the type (see page 454) **As New Base Solid**, **As Add**, or **As Cut**.

6. Click the **Preview** button to check out your shape.

7. If the sweep does not follow the **Axis** curve, click **Sweep from the other end** and click **Preview** again. If you still receive an error see below.

8. If you displayed this dialog from the **Solid** toolbar, you can click **Apply** to preview the feature as a solid. If the cut is on the wrong side of the curve, click **Flip Side to Cut** and click **Apply** again to verify.

9. Click **OK** (or **Finish** if you are using the wizard).
Troubleshooting swept solids

If you use a cross section that is too large, it can result in surfaces that self-intersect. If sweeping from both ends of the curve does not work, cancel the swept solid and try creating a swept surface. If the result shows overlapping surface regions like shown below, then the cross section is too large.

![Cross section too large](image)

**Loft**

The **Lofted** design feature takes a series of curves and fits a surface to them.

![Lofted design feature](image)

To create a solid lofted design feature:
1 Open the **Lofting** dialog in one of these ways:

- In the **Solid Wizard** (see page 452), select **From Curves**, then **Lofted**, and click **Next**.
- On the **Solid** (see page 453) toolbar, click the **Loft** button in the **Solid from curve** menu.
- From the menu, select **Construct > Solid > From Curves > Loft**.

1 Optionally enter a **Name** for the solid, or leave the default name.
2 Select the type (see page 454) **As New Base Solid**, **As Add**, or **As Cut**.
3 Select the curve name in the **Curve** list and click the **Add** button, or click the **Pick Curve** button and select the curves in the graphics window.
4 If you want to connect the first and last curves, select the **Closed** option.

   The **Closed** option connects the first and last curves; you cannot repeat curves in a loft. In this example, the curves in the first image are lofted. In the second image, the loft is not closed. The loft on the third image shows a closed loft.

5 Click the **Preview** button to confirm that the surface is correct.
6 If you are working with open curves and surface twists, click the name of the curve in the curve list and click the Reverse Selected Curve button and click Preview again.

7 If you are working with closed curves and surface twists, you may need to change the start point of some of the curves.

8 If you displayed this dialog from the Solid toolbar, you can click Apply to preview the feature as a solid. If the cut is on the wrong side of the curve, click Flip Side to Cut and click Apply again to verify.

9 Click OK (or Finish if you are using the wizard).

If you cannot achieve the required shape, you may be able use a lofted surface (see page 400) to create the shape.

From surfaces

The following From Surfaces solid constructors are available:

- Stitch (see page 463)
- From 2.5D Feature (see page 466)
- From Stock (Cube) (see page 465)
- Extrude a Surface (see page 467)
- Revolve a Surface (see page 469)

Stitch

Stitching converts well-trimmed surface models with shared edges and shared boundaries into solid models. When the surfaces have been stitched together into a solid, you can perform any solid modeling operation on the solid.

The surfaces must not overlap or have gaps between them. The surfaces in this example will not stitch because they overlap.
The surfaces in this example will stitch because the overlap has been trimmed away.

Types of models that are good candidates for stitching are:

- IGES files containing trimmed surfaces from solid modeling packages
- Surfaces that you model and trim using FeatureCAM surfacing tools

To stitch surfaces into solids:

1. Open the Stitching dialog in one of these ways:
   - In the Solid Wizard (see page 452), select From Surfaces/Primitives, then Stitch, and click Next.
   - On the Solid (see page 453) toolbar, click the Stitch button in the Solid from surface(s) menu.
   - From the menu, select Construct > Solid > From Surfaces > Stitch.

2. Optionally enter a Name for the solid, or leave the default name.
3. Optionally select Log all errors and enter a file name and location.
4 If the surfaces form a sheet instead of a solid, select the **Non-solid Results OK** option. If you do not select this box, you are given an error if the surfaces do not form a complete solid. See Overview of solids (see page 445) for further information.

5 Select the surface in the **Surface** list and click the **Add** button, or click the **Pick Surface** button and pick the surfaces in the graphics window. Each surface you pick will be entered in the surface list.

   *If you have already selected the surfaces before opening the dialog, they are listed in the **Surface** list.*

6 Optionally, click the **Preview** button to confirm that the surface is correct.

7 Click **OK** (or **Finish** if you are using the wizard).

8 If the surfaces form a solid, a new solid is listed in the **Part View**. If the surfaces do not form a solid or a sheet, an error message is displayed.

**Troubleshooting**

- Ensure that no duplicate surfaces are displayed.
- Ensure that the surfaces do not overlap. In this case, you must trim the surfaces before stitching.

**Stock**

To create a solid from your stock or a cube:

1 Open the **Solid Cube** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **From Surfaces/Primitives**, then **From Stock (Cube)**, and click **Next**.
On the Solid (see page 453) toolbar, click the Stock button in the Solid from surface(s) menu.

From the menu, select Construct > Solid > From Surfaces > Stock.

2 Optionally enter a Name for the solid, or leave the default name.

3 Select whether you want to use your Stock or a Cube.

4 If you selected Stock, click OK or Finish.
   If you selected Cube, enter the coordinates of each corner or click the Pick Point button and pick the point in the graphics window.

5 Click OK (or Finish if you are using the wizard).

**From 2.5D feature**

When a 2.5D feature is created, a 3D surface representation is created for display. Although you can generate toolpaths and create a 3D shaded simulation of the part, you must convert the features into solid modeling operations to subtract them from a solid. In the example below, a Boss feature and three holes were converted to a solid.

All solids created from 2.5D features are **subtractive**, even Boss features.

To create a solid modeling operation for a 2.5D feature:
1 Open the **Solid from Feature** dialog in one of these ways:

- In the **Solid Wizard** (see page 452), select **From Surfaces/Primitives**, then **From 2.5D Feature**, and click **Next**.
- On the **Solid** toolbar (see page 453), click the **From Feature** button in the **Solid from surface(s)** menu.
- From the menu, select **Construct > Solid > From Surfaces > From Feature**.

2 Optionally enter a **Name** for the solid, or leave the default name.

3 Select the feature name in the **Feature** list or click the **Pick Feature** button and pick the feature in the graphics window. You can convert all 2.5D features except Side features. Patterns of features are also supported.

4 If you have more than one base solid created, select or pick the **Solid to Cut**.

5 Click **OK** (or **Finish** if you are using the wizard).

   *All features are subtracted from the solid, even bosses.*

**Extrude a Surface**

Extrude creates a solid design feature by pushing a surface in a straight line. This operation is identical to Extrude solid design feature (see page 455) except it works with surfaces not curves as the input. Below are examples of a surface and its extrusion.
To create a solid extrude design feature:

1. Open the ** Extruded Solid** dialog in one of these ways:
   - In the **Solid Wizard** (see page 452), select **From Surfaces/Primitives**, then **Extrude a Surface**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Extrude a surface** button in the **Solid from surface(s)** menu.
   - From the menu, select **Construct > Solid > From Surfaces > Extrude a surface**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. Select the type (see page 454) **As New Base Solid**, **As Add**, or **As Cut**.

4. Select the surface name in the **Surface** list or click the **Pick Surface** button and select the surface in the graphics window.

   *You cannot use a face of a solid.*

5. Specify the parameters of the extrude. You can do this in one of two ways:
   - Enter the specific vector of the extrude.
   - Enter the point to extrude from and then enter the point where the extrude ends.
6 If you want to draft the walls of the surface, enter a Draft Angle.
7 Click the Preview button to see a line drawing of the feature.
8 If you displayed this dialog from the solid toolbar, you can click Apply to preview the feature as a solid. If the cut is on the wrong side of the curve, click Flip side to cut and click Apply again to verify.
9 Click OK (or Finish if you are using the wizard).

Revolve a Surface

Solid of revolution creates a solid design feature by revolving a surface around a line.

To create a solid of revolution:
1 Open the Revolved Solid dialog in one of these ways:

- In the Solid Wizard (see page 452), select From Surfaces/Primitives, then Revolve a Surface, and click Next.
- On the Solid (see page 453) toolbar, click the Revolve a Surface button in the Solid from surface(s) menu.
- From the menu, select Construct > Solid > From Surfaces > Revolve a surface.
2 Optionally enter a Name for the solid, or leave the default name.
3 Select the surface name in the **Surface** list or click the **Pick surface** button and select the surface in the graphics window.  

   *You cannot use a face of a solid.*

4 Pick the **Construction method**. This is where you set what is revolved around, or the pole. You can pick a **Custom line**, or the X-, Y-, or Z-axis.

5 Select the type as **New base solid**, **Add**, or **Cut**. See Type of design feature for further information.

6 Set the **Start angle** in degrees.

7 Set the **End angle** in degrees.

8 If you select **Custom line**, select the name of the line in the **Axis** menu or click the **Pick line** button and select the line in the graphics window.

9 Click the **Preview** button to see a line drawing of the feature.

10 If you displayed this dialog from the **Solid** toolbar, you can click **Apply** to preview the feature as a solid. If the cut is on the wrong side of the curve, click **Flip side** to cut and click **Apply** again to verify.

11 Click **OK** (or **Finish** if you are using the wizard).

**Shape Modifiers**

The following **Shape Modifiers** solid constructors are available:

- **Fillet Edges** (see page 470)
- **Cut with Parting Surface** (see page 473)
- **Combine Solids** (see page 475)
- **Shell** (see page 477)
- **Offset** (see page 479)
- **Offset Faces** (see page 480)
- **Chamfer** (see page 482)

**Fillet**

Because solids share edges among faces, solid filleting is simpler and more powerful than surface filleting. You simply select edges of the solid and enter fillet radii. The surfaces are then blended across the edge and the faces are automatically trimmed. You can create constant radius fillets as shown on the left or variable radius fillets as shown on the right.
To create a fillet-edged solid:

1. Select the solid (see page 449) in the Part View.
2. Open the **Edge Fillet** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **Shape Modifiers**, then **Fillet Edges**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Fillet** button in the **Modify solid** menu.
   - From the menu, select **Construct > Solid > Modifiers > Fillet**.

   When the dialog is displayed, the edges of the solid are highlighted in blue in the graphics window.

3. Optionally enter a **Name** for the solid, or leave the default name.

4. Select the fillet type from **Constant** or **Variable**.

   - If you selected **Constant**, enter the **Radius**.
   - If you selected **Variable**, enter the **Begin radius** and the **End radius**.

5. If you want to fillet all the edges of a face, select it in the **Face** list, or click the **Pick surface** button and pick the face in the graphics window.
6 If you want to set the radius for an edge, select it in the Edge list, or click the Pick curve button and pick the edge in the graphics window.

- Ctrl+click two edges to select all edges that make up the shortest path between them.

- Double-click an edge to select all tangential edges.

7 Click the Add button to accept the face or edge and its radius/radii.

The name of the edges and their fillet radii show in the Edge/Radius box and the edge is shown as a red arrow in the graphics window. For variable fillets, both the Begin radius and the End radius show in the Radius column and are comma-separated.

8 Add any other edges you want to fillet. If you want to use a different radius on the next edge, enter a different Radius.

9 Click Preview if you want to preview the fillet before committing to the changes.

10 If you need to change the radius on an edge, select the edge in the Edge/Radius box, enter a new Radius, or Begin radius and End radius, and click the Set radius on selected button.

11 If you want to change the radius of all the edges, enter the new radius and click the Set radius on all button.

12 Click OK (or Finish if you are using the wizard).

**Controlling the shape of fillet joints**

The joints where fillets intersect can either be mitered or blended.

To create a mitered fillet, fillet the adjacent edges in different fillets. The fillets are intersected and trimmed against each other.
To create a blended fillet, fillet the adjacent edges in a single fillet. The blend is calculated automatically based on the radii or the fillets.

**Cut with Surface**

When you have a solid, you can cut it with a surface or a collection of surfaces with common edges. This is useful for separating the solid into two mold halves.

In the example below, the solid is a revolved glass that was subtracted from a box.

This solid is then cut with a flat surface resulting in half of the solid being cut away.
You can also cut a solid with a collection of surfaces that have common edges. The surfaces are stitched together and the solid is then cut with the resulting surfaces.

To cut a solid with a parting surface:

1. Open the **Cut with a parting surface** dialog in one of these ways:
   - In the **Solid Wizard** (see page 452), select **Shape Modifiers**, then **Cut with Parting Surface**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Cut with surface** button in the **Modify solid** menu.
   - From the menu, select **Construct > Solid > Modifiers > Cut with surface**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. Select the name of the solid in the **Cut this solid** list or click the **Pick solid** button and pick the solid in the graphics window.
4 Select the name of the surface in the **Surface** list and click the **Add** button or click the **Pick surface** button and pick the surface in the graphics window.

5 If you have additional surfaces to cut with, repeat the previous step.

> The surfaces must have common edge curves that allow them to be stitched together.

6 If you want to create a solid for both sides, select **Keep both sides**.

7 Click the **Preview** button to preview the cut. The result is shown in thick blue lines. If you want to cut on the other side of the surface(s), click the surface name and click the **Reverse selected surface** button.

8 Click **OK** (or **Finish** if you are using the wizard).

**Combine Solids**

Normally you work only on a single solid model. You start with a base and create additional design features that alter the shape of the solid. Sometimes it is convenient to work on two different solids separately and then combine them into a solid, for example combining an imported solid and a mold base.

This is an example of a solid mold base:

![Solid Mold Base](image)

This is the cavity solid:
This is the result of combining the mold base and the cavity.

Combine solids allows you to combine solids in three different ways.  
**A Difference B** is A minus the portion of B that is inside of A.  
**A Union B** is A plus the portion of B that is outside of A.  
**A Intersection B** is the volume that is common to both A and B.

**Examples**

<table>
<thead>
<tr>
<th>Initial solids</th>
<th>Square <strong>Difference</strong> Cube</th>
<th>Cube <strong>Difference</strong> Square</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cube Union Cylinder or Cylinder <strong>Union</strong> Cube</td>
<td>Cube <strong>Intersection</strong> cylinder or Cylinder <strong>Intersection</strong> Cube</td>
<td></td>
</tr>
</tbody>
</table>

To combine solids:
1 Open the Combine Solids dialog in one of these ways:

- In the Solid Wizard (see page 452), select Shape Modifiers, then Combine Solids, and click Next.
- On the Solid (see page 453) toolbar, click the Combine Solids button in the Modify solid menu.
- From the menu, select Construct > Solid > Modifiers > Combine solids.

2 Enter a New solid name.

3 Select an Operation:
   - Difference — Subtract a solid from another solid. Solid2 is subtracted from Solid1.
   - Union — Add multiple solids together.
   - Intersection — Create a solid at the intersection of multiple solids.

4 Add the solids you want to combine:
   - To add a solid by name, select it in the Solid list and click Add item from list.
   - To add solids graphically, click Pick solid and select the solids (see page 449) in the graphics window.

5 Click Preview to preview the results.

6 Click OK (or Finish if you are using the wizard).

**Shell**

Shell creates a thin-walled solid from another solid. In this example, all the walls of the box are offset to create a rectangular void in the center of the solid.
If you are using a hidden line view or shaded view, results of the shell design feature are not visible, but if you cut the solid, you can see the void.

You can optionally select faces of the solid not to offset. The faces that are not offset create openings into the void.

To create a shell:

1. Open the **Shell** dialog in one of these ways:
In the **Solid Wizard** (see page 452), select **Shape Modifiers**, then **Shell**, and click **Next**.

- On the **Solid** (see page 453) toolbar, click the **Shell** button in the **Modify solid** menu.
- From the menu, select **Construct > Solid > Modifiers > Shelling**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. Enter the **Offset distance**. A negative distance offsets the faces into the solid. A positive distance offsets the surfaces out of the solid.

   - For solids with tight regions or fillets, you cannot offset the faces more than the smallest fillet radius or the smallest gap between faces.

4. Select the name of a solid from the **Offset this solid** list or click the **Pick solid** button and select the solid (see page 449) in the graphics window.

5. If you want to exclude any faces, select the name of the face in the **Faces to not offset** list and click the **Add** button or click the **Pick surface** button and pick the faces in the graphics window.

6. Click **Preview** to preview the results.

7. Click **OK** (or **Finish** if you are using the wizard).

   - If the **Offset distance** is too large, the offset surfaces intersect and cause an error. Your only choice in this situation is to use a smaller **Offset distance**.

---

**Offset**

To offset a solid:
1 Open the Offset dialog in one of these ways:

- In the Solid Wizard (see page 452), select Shape Modifiers, then Offset, and click Next.
- On the Solid (see page 453) toolbar, click the Offset button in the Modify solid menu.
- From the menu, select Construct > Solid > Modifiers > Offset.

2 Optionally enter a Name for the solid, or leave the default name.

3 Enter the Offset distance. A negative distance offsets the faces into the solid. A positive distance offsets the surfaces out of the solid.

4 Select the name of a solid from the Offset this solid list or click the Pick solid button and select the solid (see page 449) in the graphics window.

5 Click Preview to preview the results.

6 Click OK (or Finish if you are using the wizard).

**Offset Faces**

To offset a face or faces of a solid:
1 Open the **Offset Faces** dialog in one of these ways:

- In the **Solid Wizard** (see page 452), select **Shape Modifiers**, then **Offset Faces**, and click **Next**.
- On the **Solid** (see page 453) toolbar, click the **Offset Faces** button in the **Modify solid** menu.
- From the menu, select **Construct > Solid > Modifiers > Offset Faces**.

2 Optionally enter a **Name** for the solid, or leave the default name.

3 Enter the **Offset distance**. A negative distance offsets the faces into the solid. A positive distance offsets the surfaces out of the solid.

4 Select the name of the face you want to offset from the menu and click the **Add item** button or click the **Pick surfaces** button and select the surface in the graphics window.

5 Optionally click the **Preview** button to see the results of the current settings in the Graphics window.

6 Click **OK** (or **Finish** if you are using the wizard).
Chamfer

1. Open the **Edge Chamfer** dialog in one of these ways:

   - In the **Solid Wizard**, select **Shape Modifiers**, then **Chamfer**, and click **Next**.
   - On the **Solid** toolbar, click the **Chamfer** button in the **Modify solid** menu.
   - From the menu, select **Construct > Solid > Modifiers > Chamfer**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. If you want to chamfer all the edges of a face, select it in the **Face** list, or click the **Pick surface** button and pick the face in the graphics window.

4. If you want to chamfer a single edge, select it in the **Edge** list, or click the **Pick curve** button and pick the edge in the graphics window.

5. Click the **Add** button to accept the face or edge.

   The name of the edges and their fillet radii are displayed in the **Edge/Radius** box and the edge is shown as a red arrow in the graphics window.

**Manufacturing**

These **Manufacturing** solid constructors are available:

- **Silhouette Curves** (see page 483)
- **Select Core/Cavity** (see page 485)
- **Split Face** (see page 488)
- **Delete Face** (see page 489)
Explode (see page 491)
Parting Surface (see page 491)
Draft a Face (see page 493)

**Silhouette Lines**

Silhouette curves represent the widest part of a solid and serve as useful parting curves for molds. You can also use these curves to split the faces of a solid.

1. Silhouette curve

One of the tasks in creating a mold for a solid model is determining the parting lines and splitting the part into at least two parts. Silhouette curves represent the widest extent of a part when viewed from the +Z direction. These curves often are helpful for determining parting lines.

The first image shows a solid model. Initially, the side of the part is a single surface. As a first step in creating two mold halves, we would like to split the side face at its widest part. The second image shows the silhouette curve for the solid.

1. Silhouette curve

In the **Silhouette Curves** dialog, you can also use the calculated silhouette curves to split the faces of the solid. The figures below show that the side face is now split into two separate pieces along the silhouette curve.

See Select core/cavity (see page 485) for more information on splitting solids into two halves.
This curve can then be used to create parting surfaces (see page 491).

To create a silhouette curve:

1. Open the Silhouette Curves dialog in one of these ways:
   - In the Solid Wizard (see page 452), select Manufacturing, then Silhouette Curves, and click Next.
   - On the Solid (see page 453) toolbar, click the Silhouette Curves button in the Manufacturing Solids menu.
   - From the menu, select Construct > Solid > Manufacturing > Silhouette Lines.

2. Optionally enter a Curve name, or leave the default name.

3. Select the name of a solid from the Solid list or click the Pick solid button and select the solid (see page 449) in the graphics window.

4. If you want to extract hidden silhouettes, select Include hidden silhouettes.

   With this option deselected, only silhouettes that are visible from the top are extracted. With it selected, all silhouettes are extracted. The first image shows a tube without the hidden silhouettes. The second image shows both hidden and visible silhouettes.
5 The silhouette curves are determined from the +Z direction of the UCS. Select the UCS from the UCS list.

6 If you want to split the faces of the solid at silhouette curves, select Split Faces at Silhouettes.

7 Silhouette curves can often be made up of many small pieces. To reduce the number of these pieces (see page 338), check Smooth/Reduce. The number after the Smooth/Reduce label is the tolerance for data smoothing. The smaller the number, the tighter the curve approximates the original silhouette. This option can smooth out sharp corners in your curve, so use it with caution.

8 If you want to join (see page 327) the resulting curves that touch into a single piece, select Join Resulting Curves.

9 The Tolerance affects how tightly the silhouette curve approximates the actual silhouette. Reduce this number if the silhouette misses regions of your part.

10 Click OK (or Finish if you are using the wizard).

Core/Cavity

Select core/cavity uses surface orientation to extract surfaces for the core or cavity portion of a mold.

It segregates the surfaces of a solid into one of three different types.

Original example
**Top**
All surfaces (or portions of surfaces if the **Automatic Split** option is enabled) that are visible from the top.

**Bottom**
All surfaces (or portions of surfaces if the **Automatic Split** option is enabled) that are visible from the top.

**Other**
All surfaces that do not fall into either the top or bottom category. These surfaces are usually referred to as the core.

We recommend using the **Automatic split** option. This option splits the faces of the solid at either the silhouette of the solid, or along a parting surface that you provide as the **Part Srf**. With the **Part Srf** option set to **Automatic**, the silhouette curve is automatically calculated and used to split the faces before the classification into the top, bottom or other category.
If you specify a parting surface for the Automatic splitting, this surface must pass all the way through the solid.

To select a core/cavity:

1. Open the **Select Core/Cavity** dialog in one of these ways:
   - In the **Solid Wizard** (see page 452), select **Manufacturing**, then **Select Core/Cavity**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Core/Cav** button in the **Manufacturing Solids** menu.
   - From the menu, select **Construct > Solid > Manufacturing > Core/Cavity**.

2. Choose whether to you want to **Select** the **Bottom**, **Top**, or **Other** surfaces.

3. Select the name of a solid from the **Solid** list or click the **Pick solid** button and select the solid (see page 449) in the graphics window.

4. The silhouette curves are determined from the +Z direction of the **UCS**. Select the appropriate UCS from the **UCS** list.
5 If there are surfaces you want to exclude, click the **Pick surface** button, select the surfaces in the graphics window and click the **Add** button.

6 If you want to include the vertical surfaces, select **Include vertical surfaces**.

7 Optionally select **Make solid from result**.

8 If you want to split the surfaces at the silhouette curve, check **Automatic split** and leave the **Part srf** field set to **Automatic**.

9 If you want to split the surfaces at a parting line check **Automatic split** and set the **Parting surface** field to the name of the parting surface.

10 Click **OK** (or **Finish** if you are using the wizard).

The appropriate surfaces are now selected so that you can easily create 3D surface milling features.

**Split Face**

*Split face* takes a curve or list of curves, projects them onto the selected face and splits the face into multiple faces using the projected curves as the boundaries.

To create a split face design feature:

1 Open the **Split Face** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **Manufacturing**, then **Split Face**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Split Face** button in the **Manufacturing Solids** menu.
• From the menu, select **Construct > Solid > Manufacturing > Split Face.**

2 Optionally enter a **Name** for the solid, or leave the default name.

3 Select a face name in the **Face** list or click the **Pick surface** button and select the face in the graphics window.

4 Select the curve name in the **Curve** list and click the **Add** button, or click the **Pick Curve** button and select the curves in the graphics window.

5 Repeat the previous step if you want to use more than one curve to split the face.

6 Click the **Preview** button to confirm that the surface is correct.

7 Click **OK** (or **Finish** if you are using the wizard).

**Delete Face**

If you have a solid that you designed in FeatureCAM, you can easily delete a design feature (see page 449). If you delete an extrude feature, that cuts a slot in a part, the slot is removed and the material is filled back in that region. If you have a solid model that you imported or stitched, it is difficult to remove a design feature because you do not have the design features that were used to create the part, so you must use delete faces to remove the feature and heal the model back together.

This example was an imported surface model that was stitched into a solid.

The first image is the original solid and the second image shows the same model with the faces that represent the three holes deleted.

Most of the regions that you want to remove are the equivalent of 2.5D features in your solid. This includes extruded holes, pockets, or bosses. It is important that you select all surfaces that represent the feature in the solid. For example for a blind hole, the walls and bottom must be removed. If you only select the walls to be removed, the bottom would be left floating in space and cannot be healed back into the model.
To delete faces from your solid:

1. Open the **Delete Face** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select Manufacturing, then **Delete Face**, and click Next.
   - On the **Solid** (see page 453) toolbar, click the **Delete Face** button in the **Manufacturing Solids** menu.
   - From the menu, select **Construct > Solid > Manufacturing > Delete Face**.

2. If you want to create a new solid with the faces removed, select **Create new solid**. Enter a **Solid name** for the new solid, or leave the default name.

3. If you want to modify an existing solid, select **Modify existing solid**.

4. Select the faces in one of these ways:
   - Selecting the surface name and clicking the Add button.
   - Picking the surfaces in the graphics window and clicking the Add button.
   - Clicking the Pick surface button and picking the surfaces in the graphics window.

5. If you want the gaps left by the deleted surfaces to be filled in, select **Heal remaining faces**.

6. Click the **Preview** button.

7. If you get an error message, it is probably because you left out some of the surfaces that need to be removed. Add the other surfaces and try **Preview** again.
8 Click **OK** (or **Finish** if you are using the wizard).  

**Explode Solid**  
This constructor copies the faces of a solid into surfaces.

To explode a solid:

1 Open the **Explode into surfaces** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **Manufacturing**, then **Explode**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Explode** button in the **Manufacturing Solids** menu.
   - From the menu, select **Construct > Solid > Manufacturing > Explode**.

2 Optionally enter a **Surface name**, or leave the default name.
3 Select the name of a solid from the **Solid** list or click the **Pick solid** button and select the solid (see page 449) in the graphics window.
4 If you only want to copy the selected faces, select the **Selected faces only** option.
5 Click **Preview** to preview the results.
6 Click **OK** (or **Finish** if you are using the wizard).

**Parting Surface**  
This function creates a parting surface from a curve.
The parting surface constructor does not part the model. Use Cut solid with parting surface or Select core/cavity for that functionality. The curve can be a 2D or 3D curve. The curve can be obtained in many ways including Silhouette Curves (see page 483), Surface Edges (see page 350), and Curve projected onto a surface (see page 349). The Z axis of the UCS indicates the parting direction of the mold. For 3D curves the curve is divided at any corners.

To create a parting surface:

1. Open the Parting surface dialog in one of these ways:
   - In the Solid Wizard (see page 452), select Manufacturing, then Parting Surface, and click Next.
   - On the Solid (see page 453) toolbar, click the Parting Surface button in the Manufacturing Solids menu.
   - From the menu, select Construct > Solid > Manufacturing > Parting Surface.

2. Optionally enter a Name for the solid, or leave the default name.

3. Enter the Land Width. This is the width of your parting surface.

4. Select the UCS you would like to use in the UCS list. The Z axis of this UCS is used as the parting direction.

5. Select the Parting Curve from the list and click the Add button or use the Pick curve button to select the curve in the graphics window.
6 If your curve is 3D, it is broken up, and subdivided at sharp corners, into a number of curves. Each of these names is listed under your curve name.

7 Click the Preview button to see your surface.

    If a section of your curve seems to be oriented incorrectly follow the steps below.

8 Click OK (or Finish if you are using the wizard).

To change the direction of a segment of a parting surface.

1 Select the curves in the Curve list to highlight the segment.  
The direction is displayed in the Extrude direction field.

2 To change the direction, enter a new vector in the form \((X,Y,Z)\).  
   You must enter the parentheses and the commas. For example \((1,0,0)\) is the X direction.

3 Click the Set button.

4 Click the Preview button to see the results.

Draft a Face

Many of the solid design features allow you to include a draft angle, but they require that all faces be drafted the same amount. Draft a face allows you to set a draft angle on one or more faces individually.

To draft a face properly, the Fixed reference surface determines how the face is rotated. When a face is drafted, the surface must be rotated around a particular axis. This axis is determined by the intersection of the face and the fixed reference surface. By default a face is rotated around its intersection with the XY plane of the current UCS. This means that for a face that intersects the XY plane, a positive angle keeps the top of the face fixed and rotates the bottom of the face in. The same result is calculated if a surface connected to the top edge of the face is selected as the fixed reference face.
If the surface connected to the bottom edge of the face is selected as the fixed reference, the bottom of the face stays fixed and the top edge of the face is moved out.

To draft a face:

1. Open the **Draft existing face** dialog in one of these ways:

   - In the **Solid Wizard** (see page 452), select **Manufacturing**, then **Draft a Face**, and click **Next**.
   - On the **Solid** (see page 453) toolbar, click the **Draft Face** button in the **Manufacturing Solids** menu.
   - From the menu, select **Construct > Solid > Manufacturing > Draft Face**.

2. Optionally enter a **Name** for the solid, or leave the default name.

3. Enter the **Draft Angle** in degrees.

4. Select the faces to draft in one of these ways:
   - Select the surface name in the **Faces to draft** list and click the **Add** button.
   - Pick the surfaces in the graphics window and click the **Add** button.
   - Click the **Pick surface** button and pick the surfaces in the graphics window.
5 To keep the top of the face fixed, select the surface connected to the top of the face in the Fixed Reference list or click the Pick surface button and pick it in the graphics window.

6 To keep the bottom of the face fixed, select the surface connected to the bottom of the face in the Fixed Reference list by clicking the Pick surface button and pick it in the graphics window.

7 Click the Preview button to review the results.

8 Click OK (or Finish if you are using the wizard).

---

**Feature Recognition (REC/3D MX)**

You can use Feature Recognition to extract manufacturing features and their operations from existing solid or surface models and automatically create toolpaths. You do not need to create geometry or curves to use Feature Recognition, you can make use of the information contained in the CAD model.

*Feature Recognition requires the FeatureRECOGNITION option for FeatureMILL 25D. It is included in FeatureMILL 3D MX and 3D HSM.*

There are two types of Feature Recognition in FeatureCAM:

- Use **Automatic Feature Recognition** (see page 508) (AFR) to recognize all features in a part at the same time.
- Use **Interactive Feature Recognition** (see page 499) (IFR) to recognize a specific feature type.
This is a solid model imported into FeatureCAM. It contains only surface information.

This shows the part after using Automatic Feature Recognition. The Face, Hole, Pocket and Side features have been automatically created.

**Types of Feature Recognition**

These types of Feature Recognition are available in FeatureCAM.

- **Automatic Feature Recognition** (see page 508) wizard — The Automatic Feature Recognition (AFR) wizard tries to create all features for milling a part. It creates features by dividing the model into horizontal slices. All features of the model are recognized at the same time. It creates plain, counter drilled, counter bored and counter sunk holes and all milling features are created as Side features. It often creates a set of features that completely cut your solid, but it may create more features that you might create if you modeled the features.

- **Interactive Feature Recognition (IFR)** (see page 499) via the **New Feature** wizard — The IFR option of the New Feature wizard is applicable to Hole, Pocket, Boss, Side, and Face features. It is more limited to how much of the part can be automatically recognized and you must recognize each type of feature with separate runs of the wizard.

- Automatic recognition of turned features — This option is available only through the **Import** (see page 85) wizard.
Example
The following example shows the milling features that are extracted using AFR and IFR method. The image below shows the three side features created by the Automatic Feature Recognition wizard. The model has the advantage that the two slots are cut by the top feature. It has the disadvantage that top pocket is not represented by a single pocket.

The image below shows the same example after using IFR. Each pocket is represented by a separate pocket, but the two slots are ignored.

Feature recognition examples
The following examples show features that have been recognized using feature recognition.

1. Pockets
2. Holes
3. Sides
4. Slots
IFR using the New Feature wizard

You can use these methods of Interactive Feature Recognition:

1. Recognition from surfaces (see page 500) — Select surfaces that represent the shape and depth of a feature. For holes and slots this is the only applicable method.

2. Recognition using curve chaining (see page 502) — For milled features that require curves (bosses, pockets and sides) the shape of the features can be determined by chaining the curves in the plane of the current UCS. Use this technique for features that are made up of too many surfaces to conveniently pick.

To use IFR (Interactive Feature Recognition):
1. Click the **Features** step in the **Steps** panel.
2. Select **Hole**, **Boss**, **Pocket**, **Side**, **Chamfer**, or **Face**.
3. Select **Extract with FeatureRECOGNITION** and click **Next**.
4. Follow the steps in the wizard.

You can click the **Help** button on each page of the wizard to get more help for that page.

For more information about recognizing specific types of features, see Features that can be recognized (see page 511).

### Recognizing features from surfaces

1. Click the **Features** step in the **Steps** panel.
2. Select your feature type. You can recognize **Holes**, **Slots**, **Pockets**, **Bosses**, **Sides**, and **Faces**.
3. Select **Extract with FeatureRECOGNITION** and click **Next**.
4. If you are extracting a single **Hole** or a **Hole** pattern, click **Extract a single hole or pattern of holes and click Next**.
   - If you want to recognize all **Holes** in your part, see How to recognize all **Holes** in a Setup (see page 512).
   - If you are creating a **Pocket**, **Boss** or **Side**, you are presented with a choice of methods. Click **Select surfaces** and click **Next**.
5. Select the surfaces and click **Next**. For more information see Feature recognition - surface selection.

This page enables you to select the surfaces to represent a feature. The list contains the names of selected surfaces.

To complete this page

1. Select a surface (see page 56) in the graphics window. Any surfaces that were selected before displaying the wizard are listed.
2. Click **+** to add the surfaces to the selected list. The surfaces change to the highlight color (green by default).
3. If you prefer to pick surfaces one at a time, click the **Pick surface** button and select a surface in the graphics window. Repeat this step for each surface you want to pick.
4. To remove a surface from the list, select the surface in the graphics window or click the name in the list and click **x**.

*Hold the **Shift** key to select multiple surfaces.*
5 Optionally select **Hide surfaces when finished** to hide the selected surfaces after creating the feature. This is useful if you want to clear the screen to for selecting additional surfaces.

   To show any hidden surfaces, select **Show All** or **Show All Surfaces** from the **Show Menu** in the Advanced toolbar.

6 Click **Next**.

7 Click **Preview** to display a wireframe preview of the features in the graphics window.

8 If you are making a feature other than a Hole, the top and bottom page is displayed. The top and bottom surfaces are extracted from the surfaces, but you can select different points to change the top and bottom heights of the feature. For more information see Feature recognition - top & bottom.

9 Click **Next**.

10 Confirm the extracted dimensions of the feature. Optionally edit the feature’s dimensions and click **Next**.

11 The **Strategies** page is displayed. Specify the attributes to modify the machining process, then click **Next**. See the **Strategy tab** for information on the specific attributes.

12 The **Operations** page is displayed. This page displays the operations used to manufacture the feature along with the names of the selected tools and calculated feed and speed values. If these values are acceptable, click **Finish**. If you want to change the tooling or feeds and speeds click **Next** and follow the instructions on the screen.

Some additional things to keep in mind are:

- It is often easiest to select the surfaces from the top view after clicking **Hide all nonvertical surfaces** from the **Hide** menu.

- Pockets require a closed curve. After you select your surfaces, view them from the top. The selected surfaces should form a loop as shown in this example. If you don’t see a loop as in this example, you must select additional surfaces to fully define the Pocket.

- For Pockets there is no automatic island detection. Do not include island surfaces in your selection. Instead create your Pocket without the island and then add the island separately by editing the feature.

- Chamfers and draft angles are not recognized, but you can add these parameters to the feature in the **Dimensions** page of the **New Feature** (see page 530) wizard.
If you select surfaces that define more than one cavity, a single Pocket feature is created that contains multiple pocket cavities. The collection of features is then milled one z-level at a time.

**Recognizing features from surfaces using curve chaining**

1. Click the **Features** step in the **Steps** panel.
2. Select your feature type. Only Pocket, Boss, and Side features can be recognized using curve chaining.
3. Click **Extract feature from solid model** and click **Next**.
4. Click **Chain curves** and click **Next**.
5. The geometry for the features is projected onto the plane of the UCS.
6. The top and bottom page is displayed. Enter the top and bottom values or click the **Pick** buttons and graphically pick the locations. Click **Next**. For more information see Feature recognition - top & bottom.
7. Confirm the extracted dimensions of the feature. Modify the feature's dimensions if required and click **Next**.
8. The **Strategies** page is displayed. select the attributes you want to use and click **Next**.
9. The **Operations** page is displayed. This page displays the operations used to manufacture the feature along with the names of the selected tools and calculated feed and speed values. If these values are acceptable, click **Finish**. If you want to change the tooling or feeds and speeds click **Next** and follow the instructions on the screen.

**Feature recognition surface requirements**

The following requirements apply for the recognition of surfaces for milling features:

- Only straight-walled surfaces are recognized. If a single surface also contains the bottom radius or a chamfer it is not recognized.
- Tapered surfaces are not recognized.
- The current Setup must be oriented so that the vertical walls of feature surfaces are parallel to the Z-axis.
- You can include surfaces other than straight walls and they are used to calculate the depth of the feature. These surfaces are not used in determining the feature shape.
Recognizing Pockets and Bosses from top or bottom surfaces

1 Import your solid model or IGES file.
2 If necessary, transform the part so that the surfaces that represent the features are facing toward the Z axis.
3 Click the Features step in the Steps panel.
4 Select a Boss or Pocket feature type. Click Extract with FeatureRECOGNITION and click Next.
5 Click Use horizontal surface and click Next.
6 For a boss, select the flat top surface of the boss.

1 For a pocket, select the flat bottom surface. For more information see Feature recognition - surface selection. Click Next.

This page enables you to select the surfaces to represent a feature. The list contains the names of selected surfaces.

To complete this page
1 Select a surface (see page 56) in the graphics window. Any surfaces that were selected before displaying the wizard are listed.
2 Click to add the surfaces to the selected list. The surfaces change to the highlight color (green by default).
3 If you prefer to pick surfaces one at a time, click the Pick surface button and select a surface in the graphics window. Repeat this step for each surface you want to pick.
4 To remove a surface from the list, select the surface in the graphics window or click the name in the list and click .

Hold the Shift key to select multiple surfaces.

5 Optionally select Hide surfaces when finished to hide the selected surfaces after creating the feature. This is useful if you want to clear the screen to for selecting additional surfaces.
To show any hidden surfaces, select Show All or Show All Surfaces from the Show Menu in the Advanced toolbar.

6 Click Next.

1 The top and bottom page is displayed. Enter the top and bottom values or click the Pick buttons and graphically pick the locations. Click Next. For more information see Feature recognition - top & bottom.

2 Specify the feature's dimensions and click Next.

3 The Strategies page is displayed. Specify the options to determine how the feature is machined, and click Next.

4 The Operations page is displayed, which shows a list of operations in the feature, the tool used to machine each operation, and the calculated feed and speed values. To accept these values, click Finish to create the feature and close the wizard. To change the tooling or feeds and speeds, click Next and complete the rest of the wizard.

Chamfer recognition

In FeatureCAM, you can create chamfering/deburring operations, even when the model does not contain these chamfers or deburr regions.

For example, the following model contains various bosses, pockets, and sides, and has lots of sharp edges:
There are no chamfers on the model itself or on the features:

To create automatic chamfers:

1. Select **Chamfer** in the **New Feature** wizard and select **Extract with FeatureRECOGNITION**:

![New Feature Wizard](image)
2 Click **Next** to open the **New Feature - Feature Recognition Options** page:

Here you can enter the width of the chamfers and other options. The chamfers are highlighted on the model, for example:

3 To accept the highlighted chamfers, click **Select All**, then **Finish**.

The chamfers are created and are shown in the **Part View**. FeatureCAM deburrs the edges using 3D chamfers without gouging neighboring edges, for example:
Recognizing drafted features

1. Import your solid model or .iges file.

2. If necessary, transform the part so that the surfaces that represent the features are facing toward the Z axis.

3. Click the **Features** step in the **Steps** panel.

4. Select your feature type. Only Pocket, Boss, and Side features can be recognized using curve chaining.

5. Click **Extract with FeatureRECOGNITION** and click **Next**.

6. Click **Chain curves**. Wall angle and elevation values are shown.

7. If you know the angle, enter it. If not, click the **Draft Angle** label. The dialog warps out of the way. Click two points on the same vertical isoline as shown below. The dialog returns.

8. For the **Elevation** enter the Z coordinate of the top of the feature or click the **Elevation** label and click the top of a wall of the drafted surface. Click **Next**.

9. The geometry for the features is projected onto the plane of the UCS. Chain the appropriate geometry.

10. The top and bottom page is displayed. Enter the top and bottom values or click the **Pick** buttons and graphically pick the locations. Click **Next**. For more information see Feature recognition - top & bottom.

11. Confirm the extracted dimensions of the feature. Modify the feature's dimensions if required and click **Next**.

12. The **Strategies** page is displayed. Select the attributes you want to use, then click **Next**.
The Operations page is displayed. This page displays the operations used to manufacture the feature along with the names of the selected tools and calculated feed and speed values. If these values are acceptable, click Finish. If you want to change the tooling or feeds and speeds click Next and follow the instructions on the screen.

**AFR wizard**

Use Automatic Feature Recognition to automatically create features from a solid model.

To use the Automatic Feature Recognition wizard:

1. Click the AFR step in the Steps toolbox to display the Automatic Feature Recognition wizard:

2. Select the solid you want to recognize from the list, or click the Pick solid button and pick it in the graphics window.

3. Optionally click the Verify button to ensure that the solid is valid.

4. Click Options to display the AFR Options dialog (see page 509).

5. To complete the wizard and create all features, click Finish.

To select which features you want to create on each setup:

a. Click Next to display the setups page of the wizard.

b. Select the setups for which you want to create features.

c. Click Next to display the first setup page of the wizard.

The setup name is displayed at the top of the wizard, and available features are displayed in blue in the graphics window.
d  In the list, select the features you want to create on this setup. Selected features are highlighted in orange in the graphics window.

e  If you selected multiple setups in step b, click Next and use the wizard to select features for each setup.

f  When finished, click Finish to complete the wizard and create the features.

**AFR Options dialog**

Use the **AFR Options** dialog to specify how features are recognized and created during feature recognition.

To display the **AFR Options** dialog, select the **Options > Feature Recognition** menu option.

![AFR Options dialog](image)

**Create face feature** — Select this option to create a Face feature to automatically level the top of the part.

**Create hole pattern** — Select this option if you want to group Holes into Patterns.

**Bottom radius suppression** — Select this option to ignore the radius at the bottom of a Pocket.

**Maximum Hole diameter** — This is the threshold between Holes and Pockets. For cylinders larger than the value entered, a Side feature is created instead of a Hole feature.

**Create 3D feature** — Select this option to create a 3D feature.

**Add rough operation** — Select this option to add a rough operation.
Single feature, single operation — Select this option to create all found features as one feature with one operation.

Single feature, multiple operation — Select this option to create all found features as one feature with multiple operations.

Multiple feature — Select this option to create multiple features. This uses more memory.

Display error messages if recognition fails — Select this option to receive an error message if recognition fails.

Use edge-based FR — If feature recognition is not working correctly for your solid, select this option to use the body outline of a solid for feature recognition, instead of using the faces. This may give you better feature recognition results, but it is slower than the other method.

**Feature recognition - surface selection**

This page enables you to select the surfaces to represent a feature. The list contains the names of selected surfaces.

To complete this page

1. Select a surface (see page 56) in the graphics window. Any surfaces that were selected before displaying the wizard are listed.

2. Click to add the surfaces to the selected list. The surfaces change to the highlight color (green by default).

3. If you prefer to pick surfaces one at a time, click the Pick surface button and select a surface in the graphics window. Repeat this step for each surface you want to pick.

4. To remove a surface from the list, select the surface in the graphics window or click the name in the list and click .

   Hold the Shift key to select multiple surfaces.

5. Optionally select Hide surfaces when finished to hide the selected surfaces after creating the feature. This is useful if you want to clear the screen to for selecting additional surfaces.

   To show any hidden surfaces, select Show All or Show All Surfaces from the Show Menu in the Advanced toolbar.

6. Click Next.
Automatic feature recognition error

The type of automatic feature recognition performed by the AFR wizard provides a solution for many types of models, but it is not the best method for every model. If the AFR wizard fails for your model, try other automatic feature recognition methods (see page 496) or try Interactive Feature Recognition in the New Feature wizard.

Features that can be recognized

FeatureCAM can recognize the following feature types:

- Holes (see page 511)
- Slots (see page 518)
- Bosses (see page 519)
- Pockets (see page 521)
- Sides (see page 524)
- Faces (see page 525)

This set of features should cover the features contained in most parts. If you need to extract other features from a solid or surface model, you should use the Curve from surface (see page 343) tools and then create your features from this geometry.

Hole recognition

FeatureCAM can recognize four types of hole:

<table>
<thead>
<tr>
<th>Hole type</th>
<th>Surfaces recognized from</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Cylindrical surfaces with an optional 45° chamfer surface.</td>
</tr>
<tr>
<td>Counterbore</td>
<td>Two cylinders (larger diameter on top) with an optional 45° chamfer on the top.</td>
</tr>
<tr>
<td>Countersink</td>
<td>A cylinder with a cone on top that is not 45°.</td>
</tr>
<tr>
<td>Counterdrl</td>
<td>A cylinder on top of a cone, on top of another cylindrical surface. A 45° chamfer is optional on top.</td>
</tr>
</tbody>
</table>

Example hole surfaces are shown below.
The cylinders can be comprised of one or more surfaces.

Holes are recognized automatically using either the **Automatic Feature Recognition** (see page 508) wizard or IFR option in the **New Feature** (see page 499) wizard. You should get the same results using either method. Using the AFR wizard recognizes Hole features along with other features, but using the IFR option recognizes only holes. You can recognize Hole features from surface or solid models.

Follow the steps listed here (see page 500) to use the IFR option.

See **Hole features** (see page 637) for complete details on all hole types; **How to recognize features from surfaces** (see page 500) for a description of the overall process; and **Feature recognition surface requirements** (see page 502) for information on how surfaces are used in feature recognition.

FeatureCAM uses the **Spline Tolerance** (see page 1648) machining attribute to determine whether a surface is a hole.

**Recognizing all holes in a Setup**

1. Import your solid model or *.iges file.
2. If necessary, transform the part so that the surfaces that represent the features are facing toward the Z axis.
3. Click the Features step in the Steps panel.
4. Select the Hole feature type.
5. Select Extract with FeatureRECOGNITION and click Next.
6. Select Recognize and construct multiple holes and click Next.
7. See New Feature - Hole recognition options (see page 516) for information on completing this process.
New Feature - Hole recognition method

The **Hole Recognition Method** page provides the choice of recognizing one or all holes for the current Setup.

**Which method would you like to use?**

- **Extract a single hole or a pattern of holes** — Use IFR to create individual Hole features, and optionally create a pattern from them.

- **Recognize and construct multiple holes** — Use AFR to recognize all holes in the solid. The **Hole Recognition Options** dialog (see page 516) is displayed when you click Next.

**Make all holes be created at a constant z height** — Create all Hole features at the same z height, regardless of the position of the hole in the solid.

**Merge disjoint holes** — Select this option to merge disjoint holes into a single feature. Disjoint holes are coaxial holes that are stacked on top of each other and share the same diameter and center location. This is only available for AFR.

The following example contains disjoint and hidden holes. This is the unshaded view of the solid model:
IFR with **Merge disjoint holes** deselected produces this result:

This is the result with **Merge disjoint holes** selected:

This is the result with **Merge disjoint holes** and **Merge hidden holes** selected:

**Merge hidden holes** — Select this option to merge disjoint holes, even if there is material between the holes in the solid. For example, select this option to merge two holes on opposite sides of a solid into a single Hole feature all the way through the solid. This is only available when **Merge disjoint holes** is selected.
The following example contains disjoint and hidden holes. This is the unshaded view of the solid model:

IFR with **Merge disjoint holes** deselected produces this result:

This is the result with **Merge disjoint holes** selected:
This is the result with **Merge disjoint holes** and **Merge hidden holes** selected:

Excluding holes with diameter greater than — Ignore holes outside the specified size range. This is only available for AFR.

**New Feature - Hole Recognition Options**

This page lets you control the feature recognition process and select which of the recognized holes to keep. To complete this page:

1. Optionally select **Include partial holes**.
   - If you want to recognize only holes with 360 degree cross-sections, deselect **Include partial holes**. This option typically recognizes all the holes in your model.
Partial hole features are recognized from pieces of cylinders. This includes holes that have been partially cut away or corners pockets. See example. If you would like to have holes recognized from these surfaces, select **Include partial holes**.

2 Next determine if you would like to ignore blind holes that are on the opposite of the part. Select **Exclude hidden holes** to turn on this option.

   *This option is available only if your part model is a solid model.*

3 You can also create patterns and/or groups.
   - If holes with identical dimensions are recognized and you want to create patterns for these holes, select **Merge holes of the same parameters into a pattern**. By creating a pattern, you can later edit the whole pattern in a single dialog.
   - If you would like to create a group of all of the holes select **Add all new holes into a group if there is more than one**.

4 All of the recognized holes are highlighted in thick lines. You must select which of these holes you would like to keep.
   - If you want to keep all of the recognized holes, click **Select all** and click **Finish**.
   - If you want only some of the recognized holes, select the holes in the graphics window and click **Finish**.
Slot recognition

FeatureCAM can recognize only straight slots. They are recognized from straight, parallel side surfaces. You must select surfaces on both sides of the slot. In the example below, the shaded surfaces are the selected surfaces. The extent of the slot is defined by these surfaces. Note that the flat bottom surface is ignored.

For interrupted slots, select surfaces on each end. In the image below, the slot is interrupted, but can be created by selecting the wall surfaces at either end.
If the feature you are trying to recognize is a straight cut that extends off the side of the part, as in the yellow region of the part shown below, use a Side feature (see page 524). You cannot recognize such a feature as a slot because it does not have opposing side walls.

You cannot recognize chamfers, draft angles, and bottom radii, but you can add these parameters to the slot in the Dimensions page of the New Feature (see page 530) wizard. See:

- **Slot (see page 661)** feature for more general information on slots.
- How to recognize features from surfaces (see page 500) for a description of the overall process.
- Feature recognition surface requirements (see page 502) for further information on how surfaces are used in feature recognition.

**Boss recognition**

Bosses are features that must be closed. This means that the cross-section of the feature must form a loop.

Bosses can be created by recognizing features directly from surfaces (see page 500) by using curve chaining from the solid model (see page 502) or automatically (see page 521).

If you are recognizing the feature directly from surface data keep in mind:

- It is often easiest to select the surfaces from the top view after clicking **Hide All Nonvertical Surfaces** from the **Hide** menu.
- Bosses require a closed curve. After you select your surfaces, view them from the top. The selected surfaces should form a loop, for example.

- If you do not see a loop as in the following example, you must select additional surfaces to fully define the pocket.

- You cannot recognize chamfers, draft angles, and bottom radii, but you can add these parameters to the feature in the **Dimensions** page of the **New Feature** (see page 530) wizard.

- If the part has multiple bosses at the same height, you should select all the surfaces of each boss and create a single Boss feature. The collection of features is then milled at one z-level at a time. If you accidentally create more than one boss at the same height, the first boss cuts away the second boss.

- You can recognize drafted Boss features. See How to recognize drafted features (see page 507) for more information.

See also Boss feature (see page 679) and Feature recognition surface requirements (see page 502)
**Automatic Boss recognition on solid models**

If you are working with a solid model, you can recognize a limited set of Boss features automatically. In general, it is recommended that you use the AFR (see page 508) wizard for parts with Boss features. For a set of faces to be recognized as a Boss automatically, the following conditions must be met:

- The Boss must have a flat top.
- The Boss must have walls all the way around it.
- If the part has multiple bosses at the same Z height, they must be included in a single Boss feature. (If they are not, each boss cuts away the other). The surface of each individual boss must be the same for them to be included as a single feature.

Bottom radii are recognized. Chamfers are not recognized, but you can add them in the Feature Properties dialog. Drafted bosses cannot be recognized automatically. You must use Chain feature curves option (see page 507) to recognize drafted features.

**Pocket recognition**

Pockets are features that must be closed. This means that the cross-section of the feature must form a loop.

You can recognize Pockets using one of these methods:

- Pockets with bottoms and walls all around can be automatically recognized (see page 521) from solid models. This is the only method that can recognize islands and bottom radii.
- Recognition from selected bottom surfaces (see page 503).
- Recognition from selected side surfaces (see page 500).
- By extracting feature geometry and chaining curves (see page 502). This is the only method that can be used to recognize drafted pockets (see page 507).

See also Pocket feature (see page 700) and Feature recognition surface requirements (see page 502).

**Automatic Pocket recognition on solid models**

If you are working with a solid model, you can recognize blind Pockets automatically. For a cavity to be recognized as a Pocket automatically, the following conditions must be met:

- The Pocket must have a flat floor. A cavity that passes all the way through the stock cannot be recognized. Through cavities can be recognized only as Side features.
- The Pocket must have walls all the way around it.
For cavities that meet these conditions the automatic recognition finds:

- The Pocket boundary and the island boundaries. Note that the islands must be distinct from the boundary, but they can be of different heights. The island of this example solid is recognized automatically:

![Example solid with recognized island](image1)

This island is not recognized automatically.

![Example solid with unrecognised island](image2)
The Pocket depth is determined by the tallest pocket wall. If you want to force all the features you are recognizing to start at the same Z coordinate, then select **Force same Z height** and then enter an elevation. If the Pockets you are trying to recognize, share a wall with a Boss, you should control the depth in this way. This image shows the pocket that is automatically recognized.

This image shows the Pocket that is recognized if an elevation is set to the bottom of the Boss.

If the Pocket has a consistent bottom radius, it is recognized automatically.

Chamfers are not recognized, but you can add them in the Feature Properties dialog. Drafted Pockets cannot be recognized automatically. You must use Chain feature curves option (see page 507) to recognize drafted features.

**Recognizing Pockets automatically from solids**

1. Import your solid model. Pockets can only be recognized from solids.
2. If necessary, transform the part so that the surfaces that represent the features are facing toward the Z axis.
3. Click the Features step in the Steps panel.
4. Select a Pocket feature type. Select Extract with FeatureRECOGNITION and click Next.
5. Click Automatic and click Next.
6 The Pocket features are recognized and highlighted, and the Pocket recognition options dialog is displayed.
7 After completing this dialog, click Finish.

Side recognition

Side features can be created using the Automatic (see page 524) method, or from side surfaces.

Use a boss (see page 519) or pocket (see page 521) for closed features.

If you are recognizing the feature directly from the side surfaces, keep in mind:

- It is often easiest to select the surfaces from the top view after clicking Hide All Nonvertical Surfaces from the Hide menu.
- Chamfers, draft angles and bottom radii cannot be recognized, but you can add these parameters to the feature in the Dimensions page of the New Feature (see page 530) wizard.

See also Boss feature (see page 679) and Feature recognition surface requirements (see page 502).

Automatic Side recognition on solid models

Some Side features can be recognized using the Automatic Feature Recognition option of the New Feature wizard. In general, the AFR (see page 508) wizard is better at recognizing Side features.

Three types of Side feature are recognized using this method:

- Through cavities — Pockets that go all the way through the part are recognized as Side features, for example the light blue region of the image below.
- Open Side features that are on the border of the part — The yellow region of the image below is such a feature.
• Outer boundaries — The material from the stock boundary to the part boundary is removed using a Side feature. If the stock boundary and part boundary are the same, a Side feature is recognized, but no toolpaths are generated.

Blind Pocket and Boss features formed from closed curves are recognized as Pockets and Bosses, not Side features.

**Face recognition**

Milling Face features can be created from flat faces of a solid or from flat surfaces using the **Feature Recognition** wizard. It works best on solid models because the other faces of the model are avoided when the toolpaths are created. An example of Face feature recognition from a solid model is shown below. Face features created from surfaces do not take other surfaces into account.

**Recognizing a Face feature from a solid**

To recognize a Face feature from a solid:
1. Import a solid model or .iges file.

2. If necessary, transform the part, so that the surfaces that represent the features are facing toward the Z axis.

3. Click the Features step in the Steps panel.

4. In the From Dimensions section, select Face.

5. Select Extract with FeatureRECOGNITION.

6. Click Next to open the Surfaces page.

7. Select a flat surface then click Next.

This page enables you to select the surfaces to represent a feature. The list contains the names of selected surfaces.

To complete this page

1. Select a surface (see page 56) in the graphics window. Any surfaces that were selected before displaying the wizard are listed.

2. Click to add the surfaces to the selected list. The surfaces change to the highlight color (green by default).

3. If you prefer to pick surfaces one at a time, click the Pick surface button and select a surface in the graphics window. Repeat this step for each surface you want to pick.

4. To remove a surface from the list, select the surface in the graphics window or click the name in the list and click .

   Hold the Shift key to select multiple surfaces.

5. Optionally select Hide surfaces when finished to hide the selected surfaces after creating the feature. This is useful if you want to clear the screen to for selecting additional surfaces.

   To show any hidden surfaces, select Show All or Show All Surfaces from the Show Menu in the Advanced toolbar.

6. Click Next.

   If you select the highest surface in the part, a simple Zigzag toolpath is used to face the selected surface without avoiding collisions with the rest of the part, and you cannot change the toolpath type.

   Otherwise, a standard Milling toolpath is used to face the selected surface only, without cutting into the rest of the part. You can change the toolpath type on the Strategy tab (see page 936) of the Feature Property dialog.
7 Follow the instructions in the wizard, then click Finish to create the Face feature.

**Rerecognition wizard**

You can use the Rerecognition wizard to compare a new solid model with an existing set of features. This is useful if you want to import a new solid model that is a variation on the initial model.

Select the Construct > Rerecognition Wizard menu option to display the Rerecognition wizard.

![Rerecognition Wizard](image)

*When rerecognizing features in a new model, ensure you use the same alignment (see page 85) as the original.*

FeatureCAM recognizes features from the new solid and compares them to the existing features. The new features are classified into these categories:

- **unchanged features** — These features are identical to existing features. They are ignored in the rerecognition process.
- **new features** — These features are not part of the existing features and therefore are assumed to be new. You can create these features in the Rerecognition wizard.
- **modified features** — These features have the same shape or size as existing features, but parameters like depth, bottom radius or chamfer distance have been modified. The Rerecognition wizard asks you if want to replace the existing features with their modified versions.
• **deleted features** — These features exist in the current set of part features, but were not found in the new model. You are offered by the Rerecognition wizard the option of deleting these features. There are many possible reasons that this feature is in your existing set of features but was not automatically recognized, so you should be careful about deleting these features. If the feature has clearly been deleted, you can comfortably remove it. If the feature was created through interactive methods, you probably want to keep this feature. If you are uncertain, you should preview each feature and decide on an individual basis.
Features

Create features, such as holes, pockets, slots, and step bores, and FeatureCAM generates the toolpaths to machine them, so you do not need to specify individual manufacturing operations.

1. Pocket feature
2. Step Bore feature
3. Slot feature
4. Hole feature

To create features, use the **New Feature** wizard (see page 530).
To edit and customize features, use the **Feature Properties** dialog (see page 884).
Use Feature Recognition (see page 495) to recognize features automatically from solids and surfaces.

**New Feature wizard**

Use the **New Feature** wizard to create features.

Click the **Features** step in the **Steps** panel to display the **New Feature** wizard.

![New Feature wizard](image)

Alternatively press the **Ctrl+R** keys.

The pages available in the wizard vary depending on the document type:

- Mill (see page 531)
- Turn (see page 573)
- Turn/mill (see page 607)
- Wire (see page 608)

On most pages of the wizard, you can click **Finish** (see page 531) to close the wizard and accept the default settings in any remaining pages. You can edit the feature attributes later in the **Feature Properties** (see page 884) dialog.
**Finish button**

You can close the wizard in several ways depending what you want to do next.

![Finish button](image)

Click the arrow on the **Finish** button, and then click one of these options:

- **Finish** — Create the feature and close the wizard, using the default values in the remaining pages of the wizard.

- **Finish and Edit Properties** — Create the feature and display the **Feature Properties** dialog. You can use the **Feature Properties** dialog to edit the feature quickly, and it contains some advanced options that are not available in the wizard.

- **Finish and Create More** — Create the feature and display the first page of the wizard. This enables you to create multiple features quickly.

Your selection is remembered the next time you use the wizard.

**New Feature wizard (MILL)**

For Milling documents, you can create the following types of features:
• **From Dimensions** — create features by specifying numeric dimensions.

• **From Curve** — create features by selecting curves.

• **From Feature** — create these features:
  - **Group** (see page 869) — create a group of existing features.
  - **Pattern** (see page 869) — duplicate an existing feature to create a pattern.
  - **User** (see page 857) — create a User Defined Feature (see page 857) (UDF) or insert a Part Library object (see page 1501).
  - **Toolpath** (see page 633) — create a toolpath directly.

• **From Surface** — create a 3D Surface Milling (see page 734) feature.

Optionally select these options:

• **Make a pattern from this feature** — Select this option to create a pattern from the new feature. There are extra pages in the wizard to set up your pattern.

• **Extract with FeatureRECOGNITION** — Recognize features from a solid model using the FeatureRECOGNITION module.

  You can only recognize specific feature types (see page 511).

  You can use the Automatic Feature Recognition (see page 495) wizard to recognize all features in the model automatically.

• **Create new setup** — Click this button to display the Setup wizard. This button is only available when Extract with FeatureRECOGNITION is selected.

**New Feature - Dimensions page (MILL)**

If you are creating a From Dimensions feature, the second page of the wizard is the New Feature - Dimensions page. The page is different for each of the From Dimensions feature types. See the specific feature creation topics for how to complete this page:

- **Hole** (see page 639)
- **Rectangular Pocket** (see page 656)
- **Slot** (see page 661)
- **Step Bore** (see page 668)
- **Thread Milling** (see page 672)
**Face** (see page 677)

**New Feature - Curves page (MILL)**

If you are creating a **From Curve** feature, the second page of the wizard is the **New Feature - Curves** page.

This page is where you specify the curve that dictates the shape of your feature. This page is the same for all **From Curve** feature types.

To complete this page:

1. If you still need to chain (see page 319) your geometry into a curve, click the **Curve chaining** button and chain the curve.

2. Select the curves(s) in the graphics window. Any curves that were selected before opening the wizard are already listed.

3. Click **Add** to add selected curves to the list. In the graphics window, the added curves change to the highlight color (green by default).

4. To remove a curve from the list, select the curve in the graphics window or in the list and click **Delete**. To select a range of names from the list, select the top name and then hold down the SHIFT key and select the bottom name.

5. To select the curves one at a time, click **Pick curve**, then select the geometry or curve in the graphics window. Repeat this procedure to select each curve.

6. When you have selected the curves required to define the feature, click **Next** to open the **New Feature - Location** page.
**New Feature - Machining Side page (MILL, WIRE)**

For some **From Curve** features, you must specify the machining side. You do this on the **New Feature - Machining Side** page of the wizard.

To complete this page:

1. Review the default machining side for each curve in the table by selecting it and viewing the blue arrow in the Graphics window, for example:

   ![Illustration of machining side](image)

2. If you are happy with the machining side, click **Next** to open the **New Feature - Location** (see page 534) page.

3. If you want to change the machining side of a curve, select it in the table and click the **Switch machining side** button.

   ![Illustration of machining side](image)

   The arrow in the Graphics window switches and the table updates the **Machining Side** from **Normal** to **Reverse** for the selected curve.

4. Click **Next** to open the **New Feature - Location** (see page 534) page.

**New Feature - Location page**

Specify the location of the feature:
- **XYZ** — The feature is aligned so that its depth is parallel with the -Z direction of the Setup. You position it by specifying the X, Y, and Z coordinates in the plane of the Setup.

- **Polar** — The feature is aligned so that its depth is parallel with the -Z direction of the Setup. It is positioned by specifying a **Radius** and **Angle**.

  1. - Radius
  2. - Angle

- **Polar on the OD** — The **Radius** specifies the distance of the feature from the Z axis. The **Angle** is the counter-clockwise angle, in degrees, from the X axis. The **Y shift** distance is the distance the feature is translated from the radius in Y. The **Z coordinate** is the distance the feature is translated in the Z direction. This option is available only for turn/mill documents.
- **Radial about axis** — For 4th-axis (see page 234) parts. This point that you are specifying corresponds to the symbol in the diagrams.

To complete this page:
1. Enter the location of a point in the X, Y, and Z fields, or click **Pick location** and select a point in the graphics window. Use snap modes (see page 295) to select precise locations.
2. If you are creating a Mill feature, enter an angle in the A field, that represents a counter-clockwise rotation around the feature location.
3. Click Next.

**New Feature - Part Surfaces page**

Use the **Part Surfaces** page of the **New Feature** wizard to select surfaces that define the shape of the feature.

Add surfaces you want to machine to the list using the buttons:

- **Add from selected items** — Select surfaces in the graphics window and click this button to add them to the list.
- **Delete from selected items** — Select surfaces in the list and click this button to remove them.
- **Pick Surface** — Click this button to hide the dialog, then pick a surface in the graphics window.

Consider the following when specifying part surfaces:

- You cannot manufacture undercut surfaces using 3-axis machining, so select only surfaces in the feature that can be cut from the setup.
Some surfaces may be cut from multiple setups to manufacture all parts of the surface. In such situations, a Stock Curve is helpful in limiting the machining area to just those spots that need it.

**New Feature - Strategies page (MILL)**

Use the New Feature - Strategies page of the New Feature wizard to specify the machining strategy for the feature.

After you have created the feature, you can edit these options in the Strategy tab of the Feature Properties dialog (see page 936).

- **Climb mill** — Enable this option to have the tool on the left side of the machined edge (in the direction of tool travel). Disable it for conventional milling, with the tool on the right side of the machined edge.

- **Individual rough levels** (see page 963) — Select this option to list each Z-level of the rough pass separately, which enables you to specify separate attributes and tools for each Z-level.

- **Depth first** (see page 965) — Enable this option to cut each region of a feature completely before moving on to another region. The toolpaths descend in Z.

- **Minimize tool retract** (see page 966) — Select this option to reduce the amount of retracting that the tool does while milling a feature. Instead of retracting, the tool continues feeding to its next location.
**Partline prog** — Select this option to use the drawing dimensions of the feature for the toolpath instead of the centerline of the tool. You can only use this option when cutter compensation is enabled.

Partline programming is a particular kind of cutter compensation for milled features. If enabled, the actual drawing dimensions of the feature are output as the toolpath instead of the center line of the tool. If Cutter compensation is not enabled for any of the operations in a feature, selecting **Partline program** does not affect the NC Code.

The tool selected to cut the feature is still important even when using part line programming. If the same tool is used for roughing, ensure that the actual tool diameter does not deviate too far from the diameter of the tool used by FeatureCAM to ensure proper area coverage for the roughing passes. Also ensure that the diameter of the selected finishing tool is small enough to cut the whole feature. If you have selected a tool too large to fit into a tight corner, you cannot correct the toolpath with just cutter compensation.

FeatureCAM automatically calculates the entrance point of the Finish pass and adds a linear move and a ramping move (based on the **Ramp diameter** value) to your Finish pass to accommodate cutter compensation. If you receive a warning in the operations list such as **Can't find ramp in/out arc** or **Can't extend end of open profile** then correct the problem by decreasing the **Ramp diameter** value or changing the **Pre-drill point**.

**Finish Cutter comp** — Select this option to use cutter compensation for the finish and semi-finish operations.

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool's actual diameter and the diameter specified. For example, if the specified diameter is 0.500, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.

The direction of the compensation depends on the value of **Climb mill**. If **Climb mill** is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select **Enable Cut Comp** in **Post Options** (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the **Cutter Comp** attribute selected. If the **Cutter Comp** option is deselected in the **Post Options** dialog, then cutter compensation is disabled for the entire part regardless of the value of the **Cutter Comp** attributes on each feature.
If you select **Part line program**, you get a special kind of cutter compensation known as part line programming.

If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

### Operations

**Pre-drill** — Enable this option to add a pre-drill operation to the feature.

The location for a pre-drill point is set automatically, but you can override it for a Spiral type toolpath using the **Plunge point(s)** operation attribute.

*A Pre-drill operation is not available with a Zigzag stepover toolpath.*

*Zigzag ramping is automatically disabled when you use a Pre-drill operation with an NT style toolpath. This is not supported for the Spiral toolpath and you must set the Max. ramp angle (see page 1161) to 0 to disable zigzag ramping when using a Pre-drill operation.*

*The Pre-drill operation for the NT style toolpaths includes the tops of multi-height islands. This is not supported for the original Spiral and Zigzag stepover toolpaths.*

**Pre-drill diameter** — Enter the diameter for pre-drill holes. Ensure the diameter is large enough to allow the milling tool to enter the stock.

### Roughing

**Rough pass** — Enable this option to add a Rough operation to the feature.

**Stepover** — Select the **Stepover** type for the roughing operations.

#### Traditional toolpaths

- **Spiral** — This toolpath type is based on a series of offset curves.
For a Boss feature, the curves of the Boss are offset and then clipped against the shape of the stock. When using a square piece of stock the toolpaths tend to cut the four corners first, and then work their way inward. You can alter the extent of the toolpaths by using a stock curve of total stock.

For a Pocket feature, the boundary of the Pocket is offset and the toolpaths are cut starting from the center of the pocket. The shape of the stock does not affect the toolpaths.

- **Zigzag** — This toolpath type uses straight toolpaths that are parallel to each other.
For a Boss feature, the toolpaths are laid in parallel lines across the stock and clipped against the boundaries of the Boss.

The starting point is one of the four corners of the stock. You can change the angle of the toolpaths, but the neighboring toolpaths are always parallel.

For a Pocket feature, the parallel toolpaths are laid inside the Pocket boundary.

After the parallel paths, a clean-up pass is then performed around the boundaries of Bosses, Pockets, and Pocket islands.
The Zigzag roughing pass has two phases, the parallel roughing phase and the boundary clean-up phase. The clean-up phase, marked 1, cleans up the boundaries of the feature to ensure a uniform finish allowance:

The tree view for the feature only shows a single feature, so the clean-up phase uses the same feed and speed values as the roughing pass. The number of clean-up passes is determined by the Cleanup passes (see page 1161) attribute. If Cleanup passes is set to 0, the clean-up pass is not performed. If set to 1, a single pass is performed along the boundaries of the roughing region:

The roughing region is determined by offsetting the boundaries of the feature by the Finish allowance.

If set to a number larger than 1, multiple clean-up passes are performed. The default spacing of these passes is controlled by the Cleanup stepover (see page 1161) attribute. To more finely control the spacing of multiple clean-up passes, set the Cleanup stepover attribute.

The ramping onto the clean-up pass is controlled by the Ramp diameter (see page 985) attribute.
The direction of the Zigzag path is controlled by the relationship between the Zigzag angle (see page 994) and the Climb mill (see page 936) attributes.

The table shows the relationship between the zigzag angle and the Climb mill setting. The image in the Path column indicates the direction, the start point, and the sequencing of the toolpaths.

For example, indicates toolpaths that are parallel to the X axis. The start point is the lower left and the paths are sequenced from the bottom to the top. In the images, the X axis of the Setup is the horizontal axis, and the Y-axis is the vertical axis.

<table>
<thead>
<tr>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No</td>
<td></td>
<td>180</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>Yes</td>
<td></td>
<td>180</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>Yes</td>
<td></td>
<td>-90</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>No</td>
<td></td>
<td>-90</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

If the Bi-directional cut (see page 936) or the Reorder (see page 1607, see page 1660) attribute is selected, the toolpath is reordered so that it completes one region before moving on to the next.

For example, with this Boss feature the toolpaths finish the region on the right of the Boss before moving on to the region on the left side.
If Bi-directional cut and Reorder are deselected, the toolpaths move across the part without any reordering.

When roughing a Boss with the Zigzag method, the amount that the tool overlaps the stock boundary is controlled by the Finish allowance (see page 994).

The Zigzag technique applies to a finishing pass only if the bottom of the feature is being finished. In this case, it behaves just like a single roughing pass.

**NT (New Technology) toolpaths**

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional Spiral toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional Zigzag toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional Spiral toolpath, but eliminates nearly all stepovers.

- **Vortex** (see page 725) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.
Set the default type in **Machining Attributes** on the **Stepover** tab using the **Stepover Options** button.

Click the **Stepover Options** button to open the **Rough Stepover Options** dialog:

The **NT** toolpaths are available in the **Stepover** menu along with the traditional **Spiral** and **Zigzag** toolpaths.
At feature level, you can override the default Stepover type in the menu on the Strategy tab of the feature's Properties dialog.
You can override this at operation level on the **Stepovers** tab. If you are using **Individual rough levels**, you can set the **Cut type** for each individual rough pass.

Regardless of the roughing method selected, the feature is roughed to within the **Finish allowance** (see page 1161) of the boundary.

There are some key differences between Traditional and NT toolpaths (see page 727).

**Bi-directional rough** — Select this option to machine the feature in both directions.

Enable this option to mill in both directions. If disabled, conventional roughing happens and the cutting path moves in one direction with rapid, above-stock return movements to set up for the next pass. **Climb mill** controls the cutting direction.

**Rough cutter comp** — Select this option to use cutter compensation for the rough operations.

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool's actual diameter and the diameter specified. For example, if the specified diameter is **0.500**, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.
The direction of the compensation depends on the value of **Climb mill**. If **Climb mill** is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select **Enable Cut Comp** in **Post Options** (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the **Cutter Comp** attribute selected. If the **Cutter Comp** option is deselected in the **Post Options** dialog, then cutter compensation is disabled for the entire part regardless of the value of the **Cutter Comp** attributes on each feature.

If you select **Part line program**, you get a special kind of cutter compensation known as part line programming.

If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

**Finishing**

**Finish pass** — Enable this option to add a finish operation to the feature.

**Finish bottom** — Select this option to use a flat endmill to finish the bottom of the feature. When this is selected, use the **Bottom finish allowance** on the **Milling** tab to specify the amount of material to leave after the roughing pass.

By default, the bottom of a feature is not machined during the Finish pass. Enable this option to finish the bottom of the feature with a flat endmill, up to the **Bottom Radius**, if the feature has one. You can enter a positive or negative value.

**Stepover** — Select the stepover type for the finish passes.

**Traditional toolpaths**

- **Spiral** — This toolpath type is based on a series of offset curves.
For a Boss feature, the curves of the Boss are offset and then clipped against the shape of the stock. When using a square piece of stock the toolpaths tend to cut the four corners first, and then work their way inward. You can alter the extent of the toolpaths by using a stock curve of total stock.

For a Pocket feature, the boundary of the Pocket is offset and the toolpaths are cut starting from the center of the pocket. The shape of the stock does not affect the toolpaths.

- **Zigzag** — This toolpath type uses straight toolpaths that are parallel to each other.
For a Boss feature, the toolpaths are laid in parallel lines across the stock and clipped against the boundaries of the Boss.

The starting point is one of the four corners of the stock. You can change the angle of the toolpaths, but the neighboring toolpaths are always parallel.

For a Pocket feature, the parallel toolpaths are laid inside the Pocket boundary.

After the parallel paths, a clean-up pass is then performed around the boundaries of Bosses, Pockets, and Pocket islands.
The Zigzag roughing pass has two phases, the parallel roughing phase and the boundary clean-up phase. The clean-up phase, marked ①, cleans up the boundaries of the feature to ensure a uniform finish allowance:

![Diagram showing the clean-up phase](image)

The tree view for the feature only shows a single feature, so the clean-up phase uses the same feed and speed values as the roughing pass. The number of clean-up passes is determined by the **Cleanup passes** (see page 1161) attribute. If **Cleanup passes** is set to 0, the clean-up pass is not performed. If set to 1, a single pass is performed along the boundaries of the roughing region:

![Diagram showing cleanup passes](image)

- **①** - Roughing region
- **②** - Finish allowance

The roughing region is determined by offsetting the boundaries of the feature by the **Finish allowance**.

If set to a number larger than 1, multiple clean-up passes are performed. The default spacing of these passes is controlled by the **Cleanup stepover** (see page 1161) attribute. To more finely control the spacing of multiple clean-up passes, set the **Cleanup stepover** attribute.

The ramping onto the clean-up pass is controlled by the **Ramp diameter** (see page 985) attribute.
The direction of the Zigzag path is controlled by the relationship between the Zigzag angle (see page 994) and the Climb mill (see page 936) attributes.

The table shows the relationship between the zigzag angle and the Climb mill setting. The image in the Path column indicates the direction, the start point, and the sequencing of the toolpaths.

For example, indicates toolpaths that are parallel to the X axis. The start point is the lower left and the paths are sequenced from the bottom to the top. In the images, the X axis of the Setup is the horizontal axis, and the Y-axis is the vertical axis.

<table>
<thead>
<tr>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No</td>
<td>↑</td>
<td>180</td>
<td>Yes</td>
<td>↓</td>
</tr>
<tr>
<td>0</td>
<td>Yes</td>
<td>↑</td>
<td>180</td>
<td>No</td>
<td>↑</td>
</tr>
<tr>
<td>90</td>
<td>Yes</td>
<td>←</td>
<td>-90</td>
<td>No</td>
<td>→</td>
</tr>
<tr>
<td>90</td>
<td>No</td>
<td>→</td>
<td>-90</td>
<td>Yes</td>
<td>←</td>
</tr>
</tbody>
</table>

If the Bi-directional cut (see page 936) or the Reorder (see page 1607, see page 1660) attribute is selected, the toolpath is reordered so that it completes one region before moving on to the next.

For example, with this Boss feature the toolpaths finish the region on the right of the Boss before moving on to the region on the left side.
If **Bi-directional cut** and **Reorder** are deselected, the toolpaths move across the part without any reordering.

When roughing a Boss with the Zigzag method, the amount that the tool overlaps the stock boundary is controlled by the **Finish allowance** (see page 994).

The Zigzag technique applies to a finishing pass only if the bottom of the feature is being finished. In this case, it behaves just like a single roughing pass.

**NT (New Technology) toolpaths**

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional **Spiral** toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional **Zigzag** toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional **Spiral** toolpath, but eliminates nearly all stepovers.

- **Vortex** (see page 725) (**REC/3D MX** (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.
Set the default type in **Machining Attributes** on the **Stepover** tab using the **Stepover Options** button.

![Stepover Options dialog]

Click the **Stepover Options** button to open the **Rough Stepover Options** dialog:

![Rough Stepover Options dialog]

The **NT** toolpaths are available in the **Stepover** menu along with the traditional **Spiral** and **Zigzag** toolpaths.
At feature level, you can override the default **Stepover type** in the menu on the **Strategy** tab of the feature's **Properties** dialog.
You can override this at operation level on the Stepovers tab. If you are using Individual rough levels, you can set the Cut type for each individual rough pass.

Regardless of the roughing method selected, the feature is roughed to within the Finish allowance (see page 1161) of the boundary.

There are some key differences between Traditional and NT toolpaths (see page 727).

**Wall pass** — Enable this option to finish the bottom of the feature up to the Finish allowance on the wall, then finish the walls in a separate pass.

**NT toolpaths** — Select this option to use NT toolpaths for the Finish pass.

There are several types of NT (New Technology) toolpath:

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional Spiral toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional Zigzag toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional Spiral toolpath, but eliminates nearly all stepovers.
• **Vortex** (see page 961) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.

**Semi-finish pass** — Enable this option to add a Semi-Finish operation to the feature.

Enable this option to add a Semi-finish (see page 969) operation to the feature.

**Use finish tool** — Select this option to create a separate tool for the finish operation.

If disabled, the same tool is used for both the Rough and Finish passes. Enable **Use finish tool** to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with **-finish**. For example if the roughing tool is named **endmill1.0**, the finishing tool is called **endmill1.0-finish**. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.

*If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable **Use finish tool** and explicitly change the tool to use for finishing.*

**Ramp from top** — Select this option to ramp the tool to the cutting depth from the top of the feature.

Disable this option to avoid ramping to depth on the Finish and Semi-finish pass of a 2.5D feature. This saves machining time.

This example shows the Finish operation for a Side feature.

Ramp from top on:  
Ramp from top off:

*You must deselect the **NT toolpaths** option to access this option.*

**Helical side finish** — Enable this option to use a continuous spiral for the Finish pass. Enter a **Pitch** to control the tightness of the spiral.
This option enables a small depth of cut and a continuous toolpath. It also avoids marks on the feature, which stepping down in Z depths may cause.

You must deselect the **NT toolpaths** option to access this option.

**Wind Fan** — Click this button to open the **Wind Fan Finish Options** (see page 1643) dialog.

**Face features**

**Connect stepovers with arc** — Select this option to use an arc to connect stepovers to prevent sharp direction changes.

When cutting Face features, you can optionally select **Connect stepovers with arc**.

This example shows a Face feature with **Connect stepovers with arc** selected:
Compare this to the example with Connect stepovers with arc deselected (the default setting):

Thread mill features

Feed Dir — Select from Negative Z or Positive Z. The direction depends on the handedness of the tool, the thread, and whether it is an OD or ID thread.

Simple Groove features (Engraving)

Reverse cut — Select this option to reverse the direction that the feature is cut. Engraving features are cut in a single pass.

New Feature - Strategies page (Drilling)

Use the New Feature - Strategies page of the New Feature wizard to specify the machining strategy for the feature.
After you have created the feature, you can edit these options in the **Strategy** tab (see page 889) of the **Feature Properties** dialog.

**Combine with similar holes into canned cycle** (see page 891) — By default, a tool retracts to the **Z rapid plane** between operations. Enable this option and then select whether to **Retract to the Z rapid plane** or the lower **Plunge clearance** plane after drilling each hole. This option also creates more efficient NC code by entering the canned cycle mode only once.

**Machining Type** — Select from:

- **Drill only** — All Hole features are drilled in the traditional way using a drill that is the same size as the hole diameter.
- **Drill/Mill** — This option allows Hole features to be drilled or milled, to minimize the number of tools needed.

> When using **Drill/Mill**, **FeatureCAM adds a rough operation to the tree view and you can access the Stepovers (see page 985) and Milling (see page 1161) tabs**.

Click **Drill/Mill Options** to display the **Drill/Mill Options** dialog (see page 895), where you can edit drill/mill parameters.

> **You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. Set it on the Drilling (see page 1598, see page 889) tab**.

**Spot Drill** — Enable this option to add a spot drill operation to the Hole feature.

This operation has some wide-ranging effects, however, especially when used with the **Attempt chamfer w/ spot** and tool optimization. Of those three settings, tool optimization has the highest priority and its decisions override settings with a lower priority.

For example, a spot drill operation could be performed with either a spot drill or a center drill. Spot drills with a tip angle of 90° can also perform a chamfering operation. You specify a specific tool to cut the hole's chamfer and also turn on **Attempt Chamfer /w Spot** and tool optimization. If there is an appropriate spot drill in the tool crib, FeatureCAM optimizes things and use this tool in spite of your lower priority override. Even though you selected a specific tool, your other settings conflicted with and superseded your choice.

This is the advantage of the optimization and simulation functions in FeatureCAM. As you work through the optimization settings, and see where you can optimize automatically and where you cannot, you can find ways to group your parts for faster production, but still use specific tools for specific effects when needed.
You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Drilling** (see page 1598, see page 889) tab.

**Attempt chamfer w/ spot** — Enable this option to try to cut the chamfer during spot drilling. If no available tool can spot and chamfer without gouging the hole, a separate chamfer operation is created.

**Pilot Drill** — Enable this option to add a pilot drill operation to the Hole feature.

**Pilot drill diameter(s)** — This enables and sets a list of drill sizes used to drill pilot holes. Enter a list of drill diameters to use for pilot drilling, with a comma between each.

For example, enter 0.5, 1, 1.5 in inches, to pilot drill with the half inch drill for final hole sizes up to an inch. A hole bigger than 1.5 inches is pilot drilled with all three of the specified drills before being drilled to size.

**Drill** — Enable this option to add a drilling operation to the manufacture of the hole. This operation is usually undersized in preparation for later reaming or boring.

**Drill large counterdrill first** — For Counter Drill holes, select this option to do the counterdrill operation before the drill operation.

**Ream** — Enable this option to add a Ream operation to the Hole feature. This option drills a Hole undersized and then reams it to size. The diameter of the drill is between 93% and 97% of the final Hole diameter.

**Ream before chamfer** — Enable this option to do the Ream operation before the Chamfer operation. This avoids pushing any kind of burr or edge back up onto the chamfer if the chamfer is a sealing surface.

**Tap type** — This option is available for Tapped Hole features. Select the type of tap from:

- **Cutting** — The tool cuts the threads into the material.
- **Rolled** — The tool presses or forms the threads into the material.
- **Helicoil** — The size of the Drill and Tap operations are larger to fit the helicoil insert.

**Bore** — Enable this option to add a Bore operation to the Hole feature. Boring places a hole very accurately.

The options on this tab are the same as the options on **New Feature - Strategies** page for a Hole feature in the **New Feature** wizard.
New Feature - Strategies page (Thread Milling)

Use the New Feature - Strategies page of the New Feature wizard to specify the machining strategy for the Thread Milling feature.

After you have created the feature, you can edit these options in the Strategy tab (see page 959) of the Feature Properties dialog.

Cutter comp — Select this option to enable cutter compensation.

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool's actual diameter and the diameter specified. For example, if the specified diameter is 0.500, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.

The direction of the compensation depends on the value of Climb mill. If Climb mill is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select Enable Cut Comp in Post Options (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the Cutter Comp attribute selected. If the Cutter Comp option is deselected in the Post Options dialog, then cutter compensation is disabled for the entire part regardless of the value of the Cutter Comp attributes on each feature.
If you select **Part line program**, you get a special kind of cutter compensation known as part line programming.

If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

**Partline prog** — Select this option to create the toolpath from the drawing dimensions of the feature instead of the center line of the tool.

Partline programming is a particular kind of cutter compensation for milled features. If enabled, the actual drawing dimensions of the feature are output as the toolpath instead of the center line of the tool. If Cutter compensation is not enabled for any of the operations in a feature, selecting **Partline program** does not affect the NC Code.

The tool selected to cut the feature is still important even when using part line programming. If the same tool is used for roughing, ensure that the actual tool diameter does not deviate too far from the diameter of the tool used by FeatureCAM to ensure proper area coverage for the roughing passes. Also ensure that the diameter of the selected finishing tool is small enough to cut the whole feature. If you have selected a tool too large to fit into a tight corner, you cannot correct the toolpath with just cutter compensation.

FeatureCAM automatically calculates the entrance point of the Finish pass and adds a linear move and a ramping move (based on the **Ramp diameter** value) to your Finish pass to accommodate cutter compensation. If you receive a warning in the operations list such as **Can't find ramp in/out arc** or **Can't extend end of open profile** then correct the problem by decreasing the **Ramp diameter** value or changing the **Pre-drill point**.

**Feed direction** — Select the direction in which you want to machine the feature. Depending on the direction the tool is rotating, this determines whether climb milling or conventional milling is used.

- **Negative Z** — Start with the tool at the top of the feature (at the highest Z location) and machine downwards.
- **Positive Z** — Start with the tool at the bottom of the feature (at the lowest Z location) and machine upwards.
Rough pass — Select this option to include a Rough operation in the feature.

Finish pass — Select this option to add a Finish operation to the feature.

Use finish tool — Deselect this option to use the same tool for the Rough and Finish passes.

Spring passes — Enter the number of spring passes to include in the finish pass. A spring pass is a duplicate of the final threading pass.

**New Feature - Operations page (MILL, TURN)**

This page contains a summary of the operations that are created to manufacture the feature, the names of the tools that have been automatically selected, and the feed and speed values that were calculated automatically. Each row of the table represents an operation.

To complete this page:

1. If you are familiar with the tooling names and satisfied with the selected tooling and feeds and speeds, click Finish (see page 531).

2. If you want to take a closer look at the tooling or feeds and speeds, click Next to display the New Feature - Default Tool (see page 564) page.

**New Feature - Default Tool page (MILL)**

This page displays details on the automatically selected tool. The image shows a preview of the tool. If your display is set to more than 256 colors this diagram is shaded. Otherwise, it is shown as a line drawing. To the right of the image, you can see the Tool Parameters.

To complete this page:

1. If you want to use the tool displayed in the dialog, select Use the default tool, then click Next to display the Feed/Speed (see page 567) page.

2. If you want to select a different tool, select Search for another tool or make a new one and click Next to display the New Feature - Tool Search (see page 565) page.
New Feature - Tool search (MILL)

You can use the New Feature - Tool Search page of the New Feature wizard to specify the tool to machine a feature.

To display this page, select Search for another tool or make a new one on the New Feature - Default Tool (see page 564) page and click Next.

The table lists the default recommended tool (marked with a D) and other tools in the current tool crib that fit the tool selection criteria. If you do not want to use the recommended tool, select the check box next to the tool name you want in the table. The tools that are listed in the table are controlled by the filter settings.

The tools displayed in the table are chosen from the database based on the criteria listed above the table. If you would like to choose from different tools, change the filter criteria. The criteria are:

- **Tool Group** — The tooling in the tooling database is separated into different groups. Select a group from the list or select Anything to show tooling from all groups.
- **Diameter** — Enter a specific diameter or select Anything to see tools of all diameters.
- **End radius** — Enter a specific end radius or select Anything to see tools of all radii.

Regardless of the filtering criteria, the automatically selected tool stays in the list.

Select a tool in the table to see the preview image in the upper right-hand corner of the dialog. You can pan and zoom this display by left-clicking and dragging the mouse cursor in the tool graphic window. Right-click in the tool graphic window and select Center all to center the entire tool and holder.
You can sort the tools listed in the table by any column by clicking the title of the column.

You can adjust the column widths by clicking and dragging the borders of the column titles. FeatureCAM remembers your width preferences.

**Undo tool override** — Click this button to revert the selected tool back to the default recommended tool (marked with a D).

**New tool** — Click this button to create a brand new tool and add it to the current crib. The tool that is selected in the table is used to fill in the initial values for the tool.

**Tool manager** — Click this button to open the Tool Manager (see page 1745) dialog.

**Properties** — Click this button to open the Tool Properties (see page 1749, see page 1795) dialog for the selected tool.

**Recent tools** — Select this option to filter the list and show only recently used tools.

To override the automatically selected tool to one of your choice:

1. Select the **Tool Group**.
2. Select or enter the tool **Diameter**.
3. Select or enter the tool’s **End-Radius**.
4. Optionally select the **Recent tools** option to filter your tool search further.
5. Scroll through the table.
6. To preview a tool:
   - Select a tool in the table to view it in the small graphics window. You can pan and zoom this view.
   - Select a tool in the table and click the Properties button or double-click a tool in the table to open its Tool Properties (see page 1749) dialog. You can edit the tool's properties if you want to.
7. To change the tool, select the check box next to the **Name** of the tool you want to use in the table.
8. If you cannot find the tool you want, click the **New tool** button and create a new tool (see page 1749).

To revert back to the automatically selected tool, click the **Undo tool override** button. The override tool is deselected in the table and FeatureCAM uses the default tool marked D.
**New Feature - Feed/Speed page (MILL)**

This page shows you the automatically calculated feed and speed values.

To complete this page:

1. If you are satisfied with the feed and speed settings, click **Next**.
2. If you want to change the values, enter new values.
   - If you enter new values, the **override** option is selected automatically. To return to the automatically calculated feeds and speeds, deselect **override**.
   
   *You can change the Speed units from RPM to SFM by selecting the **Use SFM** option, and you can change the Feed units from IPM to IPR by selecting the **Use IPR** option.*

3. Click **Next**.

**New feature - Coolant page**

Use this page to specify the coolant types you want to use for the operation.

Select the coolant types you want to enable for the operation. The available coolant types are specified in the CNC file.

Deselect **Override** to use the default coolant types set in the **Coolant** tab in the **Tool Properties** dialog and the **Machining Attributes** dialog.

**New Feature - Summary**

This is the final page of the **New Feature** wizard. A table is displayed showing a list of the operations for the feature. The name of the tool and the feed and speed values are listed for each operation.

To complete this page:

1. If you are satisfied with the tooling and feed and speed values, click **Finish** (see page 531) and the feature is created.
2. If you want to make changes, click the **Back** button until you come to the wizard page you want to alter.
New Feature - Feature Extraction page (IFR) (MILL)

Use the Feature Extraction page of the New Feature wizard to select the method you want to use to recognize features from a solid model.

Select a method of recognizing features:

- **Select side surfaces** — Select the surfaces that represent the sides of the feature, such as the walls of a pocket.

- **Use horizontal surface** — Select a horizontal surface that represents the shape of the feature, such as the bottom of a pocket or the top of a boss.

- **Automatic recognition** — Automatically recognize features.

  To create all recognition features at the same height, select **Force same Z height** and enter an **Elevation** to specify the height at which you want to create the features.

- **Chain feature curves** — Pick curves from a solid to define the shape of the feature.

  Enter a **Wall Angle** to angle the walls of the feature.

  Enter an **Elevation** to create the feature at a different height to the curves you select.

- **Use horizontal section** — Create features from a Z-slice through a solid.

  Enter the **Elevation** at which you want to create the features.

The image on the right of the dialog displays an example of the selected recognition method.
New Feature - Feature Alignment page

Use the Feature Alignment page of the New Feature wizard to select the alignment on which you want to recognize features in turn/mill parts.

Select the alignment:

- **Along the setup Z-axis** — select this option to recognize features aligned with the setup Z axis. For round stock this enables you to machine the end faces of the part.

- **Around the index axis** — select this option to recognize features aligned radially around the index axis. For round stock this enables you to machine the OD face of the part.

If you are aligning the feature around the index axis, specify the angle:

- **Automatic** — Select this option to use Automatic Feature Recognition to recognize features at all angles. This is available only for Hole features.

- **Specify angles** — enter the Index Angle and B Angle of the feature, or click the blue Index Angle label and pick two points in the graphics window that represent the direction of the feature's Z axis.

- **Normal to surface** — click Pick surface and select a surface in the graphics window to align the feature perpendicular to it. If you selected the back of the surface, select Reverse direction to reverse the direction of the alignment.

New Feature - Surfaces page (IFR)

Use the Surfaces page of the New Feature wizard to select surfaces that define the shape of the feature.

Add surfaces you want to machine to the list using the buttons:

- **Add from selected items** — Select surfaces in the graphics window and click this button to add them to the list.

- **Delete from selected items** — Select surfaces in the list and click this button to remove them.

- **Pick Surface** — Click this button to hide the dialog and select a surface in the graphics window.

Hide surfaces when finish — Select this option to hide surfaces used to create the feature when you finish the wizard.

Preview — Display a preview of the feature in blue in the graphics window.
**New Feature - Location page (IFR)**

Use the Location page of the New Feature wizard to specify the vertical location of a recognized feature.

Enter the Top and Bottom Z heights of the feature, or use the Pick Z location button to pick the locations in the graphics window.

Click Preview to display a preview of the feature in blue in the graphics window.

**New Feature - Feature Recognition Options page (IFR)**

Use the Feature Recognition Options page of the New Feature wizard to specify the options for automatically recognizing features from solids.

To use the Feature Recognition Options page:

1. Specify the options for automatically recognizing features. The options are different depending on the feature type.

   **Boss, Pocket and Side features**

   The dialog contains these options for Boss, Pocket and Side features:

   - **Exclude features smaller than** — Features whose maximum dimension is smaller than the distance you specify are not created. For example, you can use this to ignore blind holes that you would rather drill.
• **Merge features of the same height into a single feature** — Select this option to create one feature with multiple boundary curves, or deselect it to create separate features.

• **Add all new features into a group if there is more than one** — Select this option to create a group (see page 869) of features, or deselect it to create individual features.

Chamfer features

The dialog contains these options for Chamfer features:

• **Add all new features into a group** — Select this option to create a group (see page 869) of features, or deselect it to create individual features.

• **Create chamfers (debur) with width** — Enter the width of the chamfers you want to create.

• **Exclude chamfer if curve is a single, closed circle** — Select this option if the model contains small holes that you do not want to chamfer. Enter the minimum size of hole on which you want to create a chamfer.

• **Largest tool diameter** — Surfaces within this distance of the Chamfer feature are selected as check surfaces to ensure they are not gouged when machining the Chamfer. Use this option to prevent including unnecessary check surfaces in the feature that would not be affected, it does not affect tool selection.

Recognized features are shown in blue in the graphics window.

2 Select the features you want to create in the graphics window, or use the Select All and Unselect All buttons if there are multiple features.

Selected features are shown in orange in the graphics window.

3 Click **Finish** to create the selected features and close the wizard.

---

**New Feature - Chaining page (IFR)**

Use the Chaining page of the New Feature wizard to pick curves from solid models to define the shape of a feature.

To create curves:

1 Use the chaining edit bar to select the chaining (see page 319) type.

2 Click on curves, geometry segments or solids in the graphics window to create curves.

3 Optionally click **Switch to Top View** to change the view to make it easier to create curves.

4 Click **Create** in the chaining edit bar to create the curve.
5  Repeat the previous steps to create multiple curves.
6  When finished, click Next.

**New Feature - Horizontal Section page (IFR)**

Use the Horizontal Section page of the New Feature wizard to specify a Z-slice through a solid. You can create curves within the Z-slice and use them to create features.

![New Feature - Horizontal Section page](image)

**Part solid** — Select the solid from which you want to recognize features.

**Slice location** — Specify the height at which you want to take a Z slice.

*To use a Z slice at the edge of a solid, such as on the surface, you must enable the Use edge-based FR option in the AFR Options dialog (see page 508).*

**Preview** — Display a preview of the curves in blue in the graphics window.
New Feature wizard (TURN)

The first page of the New Feature wizard for turning contains a list of possible features, divided into sections:

From Dimensions lists features that are created from numeric dimensions. Select a feature type and click Next to open the New Feature - Dimensions (see page 573) page.

From Curve lists features that are created from curves and possibly some additional dimensions. Select a feature type and click Next to open the New Feature - Curve (see page 574) page.

The third section contains these other features:

- Part Handling (see page 848)
- User (see page 857)
- Toolpath (see page 633)
- Sub-spindle (see page 846)
- Misc (see page 854)

New Feature - Dimensions page (TURN)

If you are creating a From Dimensions turn feature, the second page of the wizard is the New Feature - Dimensions page. The page is different for each of the From Dimensions feature types. See the specific feature topics for how to complete this page:

Hole (see page 805)
Groove (see page 810)
Thread (see page 818)
Face (see page 824)
Cutoff (see page 826)
Bar Feed (see page 829)/Bar Pull (see page 830)

**New Feature - Curve (TURN)**

If you are creating a From Curve feature, the second page of the wizard is the **New Feature - Curves** page.

This page is where you specify the curve that dictates the shape of your feature. This page is the same for all From Curve turn feature types.

To complete this page:

1. If you still need to chain (see page 319) your geometry into a curve, click the Curve chaining button and chain the curve.
2. Select the curve you want to base your feature on in the Curve list, or click the Pick curve button to pick the curve in the Graphics window.
   - The curve is highlighted in red in the Graphics window.
3. Click Next to open the **New Feature - Location** (TURN) (see page 574) page.

**New Feature - Location (TURN)**

The default shape and location of the feature are determined by the feature's curve and the curve's position.

1. If you want to create the feature in the same location as the curve, click Next.
2. If you want to change the top of the feature, enter a value for Offset from curve Z location. This can be a positive or negative number.
3 Click Next.

**New Feature - Strategies page (TURN)**

Use the **New Feature - Strategies** page of the **New Feature** wizard to specify the machining strategy for the feature.

After you have created the feature, you can edit these options in the **Strategy** tab (see page 1367) of the **Feature Properties** dialog.

**Below centerline** — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Use canned cycle**

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

*For support of canned cycles in Fanuc controllers, use the *fanucez.cnc* post.*

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.
Hole features

If Enable drilled canned cycles is deselected in the Post options dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If Enable drilled canned cycles is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.

Turn/Bore features

Canned cycles for Turn and Bore features must be enabled by selecting Enable turn canned cycles in the Post options dialog. You must then go to the Properties dialog for each Turn/Bore feature, click the Strategy tab and select Use canned cycle. Also select Reuse path in canned cycle if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

Groove features

Enable grooving canned cycles in the Post options dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature’s Property dialog, clicking the Strategy tab, and then clicking Use path canned cycle. You can also set this attribute on the Groove tab of the default attributes, but this will only apply to features you create after changing this setting.

Thread features

Thread features always use canned cycles.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/bore (see page 1689) tab.

Reuse path in canned cycle — Relates to Use canned cycle. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

Cycle — Select from:
• **Turn/Bore** — This cycle roughs within the defined material boundaries by feeding parallel to the part's center line along the Z axis while stepping down in the X axis. If you select **Negative**, the tool moves from right to left. If you select **Positive**, the tool moves from left to right. If the **Total stock** (see page 1445) attribute is set, then the part is roughed using curves that are offset from the feature's profile.

Turn cycle rough operation with **Positive** feed direction:

![Positive Feed Direction Diagram]

Turn cycle rough operation with **Negative** feed direction:

![Negative Feed Direction Diagram]
- **Face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the negative direction.

- **Back face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the positive direction.

**Toolpath** — Select from:

- **Turning** — Normal roughing passes are enabled. Each roughing pass is cut in the same direction. For finishing, the tool traces the contour of the feature from right to left and is withdrawn from the part.

- **Roughing**

  If the **Toolpath** attribute is set to **Turning**, the normal roughing passes are enabled. Each roughing pass is cut in the same direction.
1. Feed straight down into the part. The distance is based on the depth of cut.
2. Cut down the right-hand wall.
3. Feed straight across.
4. Feed up the left-hand wall.
5. Withdraw from the wall, retract all the way across the feature.

**Finishing**

If the **Toolpath** attribute is set to **Turning**, the toolpath is generated as shown below.

1. The tool traces the contour of the feature from right-to-left.
2. The tool is withdrawn from the part based on withdraw angle and withdraw length.

**Offset** — Roughing toolpaths are created using offsets of the Turn feature's curve. These offsets are clipped against the stock.

For the **offset** toolpath type, the roughing toolpaths are created using offsets of the Turn feature's curve. These offsets are clipped against the stock.
**Cut-Grip** — Roughing with Iscar cut grip tools is bi-directional. The cut grip finishing style is performed using a unique strategy that is enabled by having a grooving tool that cuts in both directions.

**Roughing**

Roughing with Iscar cut grip tools is bi-directional. The steps of the cuts are as follows.

1. Feed straight down into the part. The distance is based on the depth of cut.
2. Feed straight over in Z.
3. Withdraw away from the wall and rapid back slightly in Z.
4. Feed straight down again based on the depth of cut.
5. Feed straight in the -Z direction.

**Finishing**

The cut grip style of finishing is performed using a unique strategy that is enabled by having a grooving tool that cuts in both directions.

1. Cut down the left hand wall up to the bottom radius.
2. Rapid up and over and plunge a relief groove.
3. Cut down the right-hand wall, through the bottom radius into the relief groove.
4. Cut along the bottom of the groove. This move is offset by a deflection amount.
5. Cut up the left-hand bottom radius. This move is offset by a deflection amount.
If the Turn feature has multiple groove cavities, each cavity is cut in this way and the cavities are ordered from left to right:

![Diagram of cavity cutting process]

**Round Insert** — Round tool roughing toolpaths are designed to ease the tool more gently into a groove shape. Round tool roughing toolpaths are designed to ease the tool more gently into a groove shape. Instead of plunging straight into the material, part entry is controlled by the **Engage angle** (see page 1416) turning attribute.

> A round tool is required and you must manually select the tool for this toolpath type.

**Engage angle**

> Round insert tool finish toolpaths are the same as **Turning finish toolpaths**.

**Turnmilling** — Uses a rotating endmill tool with rotating stock. Control the turning spindle speed on the **Turn F/S** tab. Control the milling spindle speed on the **Mill Speed** tab.

**Rough pass** — Enable this option to add a Rough operation to the feature.

**Semi-finish pass** — Enable this option to add a Semi-finish (see page 969) operation to the feature.
Finish pass — Enable this option to add a Finish operation to the feature. When this option is deselected, the rough pass is still machined as if the finish pass were included. The Finish allowance is left on the roughing pass, and the Bottom finish allowance is left on the roughing pass when Finish bottom is selected, even though the check box is unavailable.

Conventional — The feed moves in the +X direction, followed by the -Z direction, and so on, until it reaches the end of the stair step.

No drag — Using the Conventional finish type can reduce the tool life and also result in chips being dragged along the face of the part. Select the No drag finish, to cut the vertical faces first, in the -X direction, then the horizontal -Z areas.

Feed dir — This is the direction that the tool feeds for the operation. Select Negative (-Z direction) or Positive (+Z direction). Set this separately for the Rough, Semi-finish, and Finish operations.

Use finish tool
If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.
If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable **Use finish tool** and explicitly change the tool to use for finishing.

**TNR Comp**

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want **TNR comp** for **Rough**, **Semi-Finish**, and **Finish** operations. Enter the **Lead-in angle**, **Lead-out angle**, and **Lead distance** parameters for **TNR comp**.

**Turn feature example**

If you select **TNR comp** on the **Strategy** tab, the related attributes **Lead distance**, **Lead-in angle**, and **Lead-out angle** become available on the **Turning** (see page 1420) tab (for a rough pass) or the **Leads** (see page 1416) tab (for a finish pass).

*You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog.* See the **Turn/Bore** (see page 1689) tab.
New Feature - Strategies page (Bore)

Use the New Feature - Strategies page of the New Feature wizard to specify the machining strategy for the feature.

After you have created the feature, you can edit these options in the Strategy tab (see page 1376) of the Feature Properties dialog.

Below centerline — Enable this option to make the tool work on the negative X side of the spindle centerline.

Use canned cycle

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

For support of canned cycles in Fanuc controllers, use the fanucez.cnc post.

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.
**Hole features**

If **Enable drilled canned cycles** is deselected in the **Post options** dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If **Enable drilled canned cycles** is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.

**Turn/Bore features**

Canned cycles for Turn and Bore features must be enabled by selecting **Enable turn canned cycles** in the **Post options** dialog. You must then go to the **Properties** dialog for each Turn/Bore feature, click the **Strategy** tab and select **Use canned cycle**. Also select **Reuse path in canned cycle** if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

**Groove features**

Enable grooving canned cycles in the **Post options** dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature's **Property** dialog, clicking the **Strategy** tab, and then clicking **Use path canned cycle**. You can also set this attribute on the **Groove** tab of the default attributes, but this will only apply to features you create after changing this setting.

**Thread features**

Thread features always use canned cycles.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Turn/bore** (see page 1689) tab.

**Reuse path in canned cycle** — Relates to **Use canned cycle**. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

**Cycle** — Select from:
Turn/Bore — This cycle roughs within the defined material boundaries by feeding parallel to the part's center line along the Z axis while stepping down in the X axis. If you select **Negative**, the tool moves from right to left. If you select **Positive**, the tool moves from left to right. If the **Total stock** (see page 1445) attribute is set, then the part is roughed using curves that are offset from the feature's profile.

**Turn cycle rough operation with Positive feed direction:**

![Positive Feed Direction Diagram]

**Turn cycle rough operation with Negative feed direction:**

![Negative Feed Direction Diagram]
- **Face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the negative direction.

- **Back face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the positive direction.

**Toolpath** — Select from:
- Turning
- Offset
- Turnmilling
- Cut-Grip
- Round Insert

**Pre-drill** — Select this option to have a pre-drill operation for a Bore feature. Enter the **Dia** (diameter), **Depth**, and **Z** position of your pre-drilled hole.

**Rough pass** — Enable this option to add a Rough operation to the feature.
Semi-finish pass — Enable this option to add a Semi-finish (see page 969) operation to the feature.

Finish pass — Enable this option to add a Finish operation to the feature.

When this option is deselected, the rough pass is still machined as if the finish pass were included. The Finish allowance is left on the roughing pass, and the Bottom finish allowance is left on the roughing pass when Finish bottom is selected, even though the check box is unavailable.

Conventional — The feed moves in the +X direction, followed by the -Z direction, and so on, until it reaches the end of the stair step.

No drag — Using the Conventional finish type can reduce the tool life and also result in chips being dragged along the face of the part. Select the No drag finish, to cut the vertical faces first, in the -X direction, then the horizontal -Z areas.

Feed dir — This is the direction that the tool feeds for the operation. Select Negative (-Z direction) or Positive (+Z direction). Set this separately for the Rough, Semi-finish, and Finish operations.

Use finish tool

If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.
If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable Use finish tool and explicitly change the tool to use for finishing.

Tool nose radius compensation

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want TNR comp for Rough, Semi-Finish, and Finish operations. Enter the Lead-in angle, Lead-out angle, and Lead distance parameters for TNR comp.

Turn feature example

If you select TNR comp on the Strategy tab, the related attributes Lead distance, Lead-in angle, and Lead-out angle become available on the Turning (see page 1420) tab (for a rough pass) or the Leads (see page 1416) tab (for a finish pass).

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/Bore (see page 1689) tab.
New Feature - Strategies page (Groove)

Use the New Feature - Strategies page of the New Feature wizard to specify the machining strategy for the feature.

After you have created the feature, you can edit these options in the Strategy tab (see page 1382) of the Feature Properties dialog.

Below centerline — Enable this option to make the tool work on the negative X side of the spindle centerline.

Rough pass — Enable this option to add a Rough operation to the feature.

Feed dir — This is the direction that the tool feeds for the operation. Select Negative (-Z direction) or Positive (+Z direction). Set this separately for the Rough, Semi-finish, and Finish operations.

Plunge center first — This attribute is available for Groove features.

Plunge center first — For groove features, if this option is selected, the straight portion of the groove is roughed first and then the angled portions are roughed separately. If Plunge center first is set, the red region of this image is roughed first and then the yellow regions are roughed.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Grooving (see page 1702) tab.

Output dwell on rough — Select this option to have a Dwell amount on the rough operation of a Groove feature.
**Finish pass** — Enable this option to add a Finish operation to the feature.
When this option is deselected, the rough pass is still machined as if the finish pass were included. The **Finish allowance** is left on the roughing pass, and the **Bottom finish allowance** is left on the roughing pass when **Finish bottom** is selected, even though the check box is unavailable.

**Use finish tool**

If disabled, the same tool is used for both the Rough and Finish passes. Enable **Use finish tool** to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with `-finish`. For example if the roughing tool is named `endmill1.0`, the finishing tool is called `endmill1.0-finish`. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.

*If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable **Use finish tool** and explicitly change the tool to use for finishing.*

**New Feature - Strategies page (Thread)**

Use the **New Feature - Strategies** page of the **New Feature** wizard to specify the machining strategy for the feature.

After you have created the feature, you can edit these options in the **Strategy** tab (see page 1384) of the **Feature Properties** dialog.
Below centerline — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Turn to diameter**

Optionally create a rough and/or finish pass to turn the part down to the diameter of the thread. The creation of these operations is controlled by the **Turn to diameter: Rough** and **Finish** options on the *Strategy* page. See How a turn feature is manufactured (see page 833) for more details.

**Chamfer** — Enable the **Chamfer** option to add a chamfer to your Thread feature.

The chamfer slopes into the thread for OD threads (turn) and away from the thread for ID threads (bore).

You must select either **Rough** or **Finish** to access the **Chamfer** option.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. Set it on the **Threading** (see page 1699) tab.

**Relief Groove**

Optionally generate a roughing (see page 814) pass for the relief groove. The **Width** controls the Z-axis dimension, the **Depth** controls the X-axis dimension and the **Side Wall Angle** controls the angle of the wall closest to the thread.

**Thread** — Enable this option to have a thread operation on the feature.

**Feed** — This is the direction of the feed moves, select from:

- **Towards chuck** — the threading is performed in the direction toward the chuck.
- **Away from chuck** — the threading is performed in the direction away from the chuck.

**passes** — This is the number of steps to the bottom of the thread. Select either **Fixed** or **Calculated**.

**Fixed** — refers to a fixed rate of material removal. As the tool cuts further into the part, the area of contact of the tool increases. FeatureCAM reduces the infeed on each pass so that the tool loading remains constant. Enter the number of passes in **Count**.

**Calculated** — the number of steps is calculated automatically by FeatureCAM.

**Step1** is used to specify the incremental step for the first pass across the thread.
**Step2** specifies the second pass and is used by the system to determine subsequent passes on the thread, reducing in depth until the **Min Infeed** value is reached.

**Spring passes** — A spring pass is a duplicate of the final threading pass. Enter the number of Spring passes that you want.

**New Feature - Strategies page (Face)**

Use the **New Feature - Strategies** page of the **New Feature** wizard to specify the machining strategy for the feature.

![New Feature - Strategies page](image)

After you have created the feature, you can edit these options in the **Strategy** tab (see page 1386) of the **Feature Properties** dialog.

**Below centerline** — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Use canned cycle**

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

*For support of canned cycles in Fanuc controllers, use the fanucez.cnc post.*

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.
Hole features

If Enable drilled canned cycles is deselected in the Post options dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If Enable drilled canned cycles is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.

Turn/Bore features

Canned cycles for Turn and Bore features must be enabled by selecting Enable turn canned cycles in the Post options dialog. You must then go to the Properties dialog for each Turn/Bore feature, click the Strategy tab and select Use canned cycle. Also select Reuse path in canned cycle if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

Groove features

Enable grooving canned cycles in the Post options dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature's Property dialog, clicking the Strategy tab, and then clicking Use path canned cycle. You can also set this attribute on the Groove tab of the default attributes, but this will only apply to features you create after changing this setting.

Thread features

Thread features always use canned cycles.

Reuse path in canned cycle — Relates to Use canned cycle. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

Rough pass — Enable this option to add a Rough operation to the feature.

Finish pass — Enable this option to add a Finish operation to the feature.

When this option is deselected, the rough pass is still machined as if the finish pass were included. The Finish allowance is left on the roughing pass, and the Bottom finish allowance is left on the roughing pass when Finish bottom is selected, even though the check box is unavailable.
Use finish tool

If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.

If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable Use finish tool and explicitly change the tool to use for finishing.

Tool nose radius compensation

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want TNR comp for Rough, Semi-Finish, and Finish operations. Enter the Lead-in angle, Lead-out angle, and Lead distance parameters for TNR comp.

Turn feature example

If you select TNR comp on the Strategy tab, the related attributes Lead distance, Lead-in angle, and Lead-out angle become available on the Turning (see page 1420) tab (for a rough pass) or the Leads (see page 1416) tab (for a finish pass).

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/Bore (see page 1689) tab.
**New Feature - Strategies page (Cutoff)**

Use the New Feature - Strategies page of the New Feature wizard to specify the machining strategy for the feature.

![New Feature - Strategies](image)

After you have created the feature, you can edit these options in the Strategy tab (see page 1389) of the Feature Properties dialog.

**Part catcher** — If enabled, the part catcher code is output after the Cutoff operation. The code for activating the parts catcher must be listed in your .cnc file.

**Plunge rough edge break** — If there is a chamfer or radius on a Cutoff feature and Plunge rough edge break is enabled:

1. The Cutoff groove is plunged down to the depth of the chamfer/radius
2. The chamfer/radius is plunge-roughed.

**New Feature - Strategies page (Part Handling)**

Use the New Feature - Strategies page of the New Feature wizard to specify the machining strategy for the feature.
**Slug transfer**

Part catcher — Enable this option if you want to instigate the part catcher.

Already Supported — Enable this option to indicate that the part is already supported.

Push/Press — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the **Grab distance**.

Open dwell — Optionally enter the time, in seconds, to dwell after opening the spindle.

Close dwell — Optionally enter the time, in seconds, to dwell after closing the spindle.

**Spindle Action** — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

**Main Angle** — Enter the angle that you want the main spindle to rotate to before the part is collected.

**Sub Angle** — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

**Spindle Speed** — Enter the spindle speed.

**Sub-spindle feed rate** — Enter the subspindle feed rate.
Transfer turret — If your machine has multiple turrets, select the correct transfer turret.

Turret control — Click the button to open the Transfer Turret Control (see page 1397) dialog.

Reverse slug transfer

Part catcher — Enable this option if you want to instigate the part catcher.

Leave Supported — Enable this option if you want to keep the part supported.

Push/Press — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the Grab distance.

Open dwell — Optionally enter the time, in seconds, to dwell after opening the spindle.

Close dwell — Optionally enter the time, in seconds, to dwell after closing the spindle.

Spindle Action — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

Main Angle — Enter the angle that you want the main spindle to rotate to before the part is collected.
**Sub Angle** — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

**Spindle Speed** — Enter the spindle speed.

**Sub-spindle feed rate** — Enter the subspindle feed rate.

**Transfer turret** — If your machine has multiple turrets, select the correct transfer turret.

**Turret control** — Click the button to open the **Transfer Turret Control** (see page 1397) dialog.

### Bar pull

**Already Supported** — Enable this option to indicate that the part is already supported.

**Leave Supported** — Enable this option if you want to keep the part supported.

**Part catcher** — Enable this option if you want to instigate the part catcher.

**Push/Press** — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the **Grab distance**.

**Open dwell** — Optionally enter the time, in seconds, to dwell after opening the spindle.

**Close dwell** — Optionally enter the time, in seconds, to dwell after closing the spindle.
Spindle Action — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

Main Angle — Enter the angle that you want the main spindle to rotate to before the part is collected.

Sub Angle — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

Spindle Speed — Enter the spindle speed.

Sub-spindle feed rate — Enter the subspindle feed rate.

Transfer turret — If your machine has multiple turrets, select the correct transfer turret.

Turret control — Click the button to open the Transfer Turret Control (see page 1397) dialog.

Part support on

Support type — Select the type of support from:

- Subspindle
- Tailstock
- Steadyrest
**Jaws Only** — For steady rests, select this option to operate the jaws without moving the steady rest.

**Push/Press** — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the **Grab distance**.

**Open dwell** — Optionally enter the time, in seconds, to dwell after opening the spindle.

**Close dwell** — Optionally enter the time, in seconds, to dwell after closing the spindle.

**Spindle Action** — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

**Main Angle** — Enter the angle that you want the main spindle to rotate to before the part is collected.

**Sub Angle** — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

**Spindle Speed** — Enter the spindle speed.

**Sub-spindle feed rate** — Enter the subspindle feed rate.

**Transfer turret** — If your machine has multiple turrets, select the correct transfer turret.

**Turret control** — Click the button to open the **Transfer Turret Control** (see page 1397) dialog.
### Part support off

![New Feature - Strategies dialog box](image)

**Support type** — Select the type of support from:
- **Subspindle**
- **Tailstock**
- **Steadyrest**

**Jaws Only** — For steady rests, select this option to operate the jaws without moving the steady rest.

**Open dwell** — Optionally enter a dwell time after opening the spindle.

**Transfer turret** — If your machine has multiple turrets, select the correct transfer turret.

After you have created the feature, you can edit these options in the **Strategy** tab (see page 1391) of the **Feature Properties** dialog.
**New Feature - Strategies page (Air blast)**

Use the **New Feature - Strategies** page of the **New Feature** wizard to specify the strategy for the Air Blast feature.

![New Feature - Strategies page](image)

After you have created the feature, you can edit these options in the **Strategy** tab of the **Feature Properties** dialog.

**New Feature - Default Tool page (TURN)**

This page displays details on the automatically selected tool. The image shows a preview of the tool. If your display is set to more than 256 colors this diagram is shaded. Otherwise, it is shown as a line drawing. To the right of the image, you can see the **Tool Parameters**.

To complete this page:

1. If you are satisfied with this tool, select **I want to use the default tool** and click **Next** to open the **Feed/Speed** (see page 606) page.

2. If you want to change tooling, select **I want to search for another tool or make a new one** and click **Next** to open the **New Feature - Tool Search** (see page 604) page.
**New Feature - Tool Search page (TURN)**

You see the **New Feature - Tool Search** page of the wizard only if you select **I want to search for another tool or make a new one** on the **New Feature - Default Tool** page.

The table lists the default recommended tool (marked with a D) and other tools in the current tool crib that fit the tool selection criteria. Other tools can be selected from the table by selecting the check-box next to the tool name. The tools that are listed in the table are controlled by the filter settings.

The tools displayed in the table are chosen from the database based on the criteria listed above the table. To choose from different tools, change the filter criteria. The criteria are:

- **Orientation** — Select an orientation from among the icons. Select **Anything** to see tools of all orientations.
- **Insert shape** — Select an insert shape from among the icons. Select **Anything** to see tools with all insert shapes.
- **Presentation angle** — Enter a number for the presentation. Select **Anything** to see tools with all presentation angles.

Regardless of the filtering criteria, the automatically selected tool stays in the list.

Select a tool in the table to see the preview image in the upper right-hand corner of the dialog. You can pan and zoom this display by left-clicking and dragging the mouse cursor in the tool graphic window. Right-click in the tool graphic window and select **Center all** to center the entire tool and holder.

You can sort the tools listed in the table by any column by clicking the title of the column.
You can adjust the column widths by clicking and dragging the borders of the column titles. FeatureCAM remembers your width preferences.

Undo tool override — Click this button to revert the selected tool back to the default recommended tool (marked with a D).

New tool — Click this button to create a brand new tool and add it to the current crib. The tool that is selected in the table is used to fill in the initial values for the tool.

Tool manager — Click this button to open the Tool Manager (see page 1745) dialog.

Properties — Click this button to open the Tool Properties (see page 1749, see page 1795) dialog for the selected tool.

Recent tools — Select this option to filter the list and show only recently used tools.

Turnmilling tool orientation button — available when you select Turnmilling as the turn Toolpath type on the Strategy (see page 1366) tab. Click this button to open the B-Axis Tool Orientation (see page 1403) dialog.

To override the automatically selected tool to one of your choice:

1 Select the Orientation.
2 Select or enter the tool Insert Shape.
3 Select or enter the tool's Presentation Angle.
4 Optionally select the Recent tools option to filter your tool search further.
5 Scroll through the table.
6 To preview a tool:
   • Select a tool in the table to view it in the small graphics window. You can pan and zoom this view.
   • Select a tool in the table and click the Properties button or double-click a tool in the table to open its Tool Properties dialog. You can edit the tool's properties if you want to.
7 To change the tool, select the check box next to the Name of the tool you want to use in the table.
8 If you cannot find the tool you want, click the New tool button and create a new tool (see page 1749).
To revert back to the automatically selected tool, click the **Undo tool override** button. The override tool is deselected in the table and FeatureCAM uses the default tool marked D.

**New Feature - Feed/Speed page (TURN)**

This page allows you to review and change the automatically calculated feeds and speeds.

To complete this page:

1. If you are satisfied with the feed and speed values, click **Next**.
2. If you want to change the speed:
   - Select **Constant Surface Speed** and enter the **Surface Speed**.
   - Optionally specify the **CSS Maximum RPM**. This is the maximum revolutions per minute that the machine can generate.
   - Optionally specify the **CSS Approach RPM**. This is the initial speed for the operation while still off the part.
3. If you want to enter the speed as a single revolution per minute value:
   - Deselect **Constant Surface Speed** and enter the **Spindle Speed**.
4. If your machine has explicit spindle speed ranges, you may want to set the **RPM Range**.

Some turning centers have gear boxes that set the maximum spindle speed of the machine. The **RPM Range** list sets the gear box to a specific maximum range. If you set **RPM Range** to a value of 1-4, then the range is set explicitly. If **RPM Range** is set to **Auto** then FeatureCAM sets the range for you based on the following rules:

1. If the feature is a turned Hole or another turned feature without **Constant Surface Speed** set, then the range is determined based on the **Spindle Speed**.
2. If the feature is a turned feature with **Constant Surface Speed** set, then the range is determined based on the **Max RPM**.
3. If you want to change the feed:
   - If you want to specify the speed as feed per revolution, select **IPR** and enter the **Feed Rate**.
   - If you want to specify the speed as feed per minute, deselect **IPR** and enter the **Feed Rate**.
4. Click **Next**.
**New Feature - Tool Usage (TURN)**

This page enables you to change how the tool is used.

- **Tool** — This displays the name of the tool used for the operation.
- **Turret** — Select the tool's turret.
- **Turret Direction** — Select the direction that the turret turns. If set to **Auto**, the machine determines the most efficient direction.

**New Feature wizard (TURNMILL)**

FeatureCAM TURN/MILL (see page 856) classifies features as either **Turn/Mill** features or pure **Turning** features. Turn/mill features (see page 856) assume powered tools and turning features assume that the tool does not spin.

For example, you can make a hole along the Z-axis with both feature types, but the milled one uses rotary tools, and the turned hole uses a drill that does not spin.

To use the **New Feature** wizard for Turn/Mill documents:

1. Select the feature type:
   - **Turn/Mill** — use the Milling **New Feature** wizard (see page 531).
   - **Turning** — use the Turning **New Feature** wizard (see page 573).
2 Click Next.

New Feature wizard (WIRE)

The first page of the New Feature wizard for wire EDM contains a list of possible features, divided into categories:

- **2 Axis**
- **4 Axis**
- **From Feature**

There are additional options:

- **Make a pattern from this feature** — Select this option to create a pattern from the new feature at the same time. The wizard uses extra pages to set up your pattern.

- **Extract with FeatureRECOGNITION** (see page 868) - Select this option if you are creating features from a solid model using the FeatureRECOGNITION module.

  There is also an **Automatic Feature Recognition** (see page 495) wizard that tries to recognize all features of the model automatically.

- **Create new setup** — Click this button to display the Setup wizard. This button is only available when Extract with FeatureRECOGNITION is selected.

To complete this page of the wizard:

1 Select the feature type that you want to create.
2 Optionally select Make a pattern from this feature and Extract with FeatureRECOGNITION.

3 Click Next to continue with the rest of the wizard. If you are creating a 2 Axis feature, the next page of the wizard is the New Feature - Curves (see page 609) page. If you are creating a 4 Axis feature, the next page of the wizard is the New Feature - Upper Curve (see page 610).

**New Feature - Curves page (WIRE)**

If you are creating a 2 Axis feature, the second page of the wizard is the New Feature - Curves page. This page is where you specify the curve that dictates the shape of your feature. This page is the same for all From Curve feature types.

To complete this page:

1 If you still need to chain (see page 319) your geometry into a curve, click the Curve chaining button and chain the curve.

2 Select the curves(s) in the graphics window. Any curves that were selected before opening the wizard are already listed.

3 Click Add \(\mathbb{+}\) to add selected curves to the list. In the graphics window, the added curves change to the highlight color (green by default).

4 To remove a curve from the list, select the curve in the graphics window or in the list and click Delete \(\mathbb{\times}\). To select a range of names from the list, select the top name and then hold down the SHIFT key and select the bottom name.

5 To select the curves one at a time, click Pick curve \(\mathbb{\leftarrow}\), then select the geometry or curve in the graphics window. Repeat this procedure to select each curve.

6 When you have selected the curves required to define the feature, click Next to open the New Feature - Location page.
New Feature - Machining Direction page (WIRE)

For rapid features, you must set the machining direction. You do this on the New Feature - Machining Direction of the wizard.

To complete this page:

1. Review the default machining direction for each curve in the table by selecting it and viewing the blue arrow in the Graphics window.
2. If you are happy with the machining direction, click Next to open the New Feature - Location (see page 612) page.
3. If you want to change the machining direction of a curve, select it in the table and click the Switch machining direction button. The arrow in the Graphics window switches and the table updates the Machining Direction from Normal to Reverse for the selected curve.
4. Click Next to open the New Feature - Location (see page 612) page.

New Feature - Upper/Lower Curve page (WIRE)

If you are creating a 4-axis feature, you must specify both an upper and lower curve. The second page of the wizard for 4-axis features is the New Feature - Upper Curve page.

To complete this page:

1. If you still need to chain (see page 319) your geometry into a curve, click the Curve chaining button and chain the curve.
2. Select the curve that you want to define the upper boundaries of the feature in the Upper curve list or use the Pick curve button to pick the curve in the Graphics window.
3. Click Next to open the New Feature - Lower Curve.
4 Repeat steps 1 and 2, this time for the lower curve.
5 Click Next to open the New Feature - Location page.

**New Feature - Surface Boundaries (WIRE)**

This page is part of the new feature wizard and it assists you in creating 4-axis wire EDM features from ruled surfaces. It can be performed on both surface and solid models. When you enter this dialog, the edges of all ruled surfaces in the model are displayed in blue.

![Image of ruled surfaces](image)

To complete the dialog:

1. Click the Pick Curve button. The dialog warps into just a title bar.
2. Select the Upper curves of the feature in order.
3. Click the Pick button in the title bar of the warped dialog to complete the picking.
4. Click the Preview button to make sure you have selected the correct curves.
5. Click Next and complete the wizard.
6. As you select curves, the ruled surfaces are entered into a table in the middle of the dialog. This table lists the surface name, the number of the boundary selected and whether or not the curve has been reversed. There are a number of additional operations that can be performed on a selected row of the table.

- The delete button removes the boundary currently selected in the tables.
- This button moves the selected boundary up in the table.
- This button moves the selected boundary down in the table.
This button selects an alternative boundary of the surface.

This button reverses the direction of the selected curve. Note that FeatureCAM automatically sets the direction of the curves so this option should not be necessary most of the time.

There are two additional options:

Use **Show lower curve** option to display the corresponding bottom curve for each curve selected.

Use **Hide surfaces when finish** option to have the surfaces hidden after you leave this dialog.

**New Feature - Location page (WIRE)**

The default shape and location of the feature are determined by the feature's curve and the curve's position.

1. If you want to create the feature in the same location as the curve (or the upper curve for 4-axis features), click **Next**.
2. If you want to change the top of the feature, enter a value for **Offset from (upper) curve Z location**. This can be a positive or negative number.
3. Click **Next** to open the **New Feature - Dimensions** page.

**New Feature - Dimensions page (WIRE)**

The **New Feature - Dimensions** page is where you enter the **Thickness** of your wire feature.

For 2-axis features:

- If your curve is at the bottom of the feature, select **Curve at bottom**.
- Optionally set a **Taper** (see page 613).
**Wire EDM Taper**

**None** — Select this option if there is no taper on the feature.

**Constant** — With this option, the feature has a constant taper angle all the way around the feature. The taper is specified by an angle, specified in degrees, and taper type (see page 613).

**Variable** — If you want to specify a different taper value for each line and arc of your curve, select **Variable** and click the **Variable Taper** button to display the variable taper table (see page 614).

**Types of wire EDM tapers**

All left tapers are performed to the **left** of the curve (at the bottom of the feature) relative to the **Primary Cut Direction**, and all right tapers are performed to the **right** of the curve (at the bottom of the feature) relative to the **Primary Cut Direction**.

- **Left** — Sharp corners tapered into sharp corners (**G29** on a Charmilles machine) and arcs tapered into conical corners (see page 614) (**G28**).
- **Right** — Sharp corners tapered into sharp corners and arcs tapered into conical corners (see page 614).
- **Rounded-Left** — Sharp corners tapered into arcs (**G28**) and arcs tapered into conical corners (see page 614) (**G28**).
- **Rounded-Right** — Sharp corners tapered into arcs and arcs tapered into conical corners (see page 614).
- **ISO-Left** — Arcs tapered into cylindrical corners (see page 614) (**G29**) and sharp corners tapered into sharp corners (**G29**).
- **ISO-Right** — Arcs tapered into cylindrical corners (see page 614) and sharp corners tapered into sharp corners.
- **ISO/Rounded-Left** — Arcs tapered into cylindrical corners (see page 614) (**G29**) and sharp corners tapered into arcs (**G28**).
- **ISO/Rounded-Right** — Arcs tapered into cylindrical corners (see page 614) and sharp corners tapered into arcs.
**Default conical corner**

The normal taper has corners that are shaped like a cone. The arc of the top curve is different from the arc of the bottom curve.

![Image of a conical corner]

**ISO cylindrical corner**

An ISO taper has cylindrical corners. The arcs of the top and bottom curves have the same radius.

![Image of an ISO cylindrical corner]

**Variable taper table**

If the feature has multiple curves, select the appropriate curve from the Curve list. The curve is broken down into arc and line segments and each segment is represented by a row in the table. As you click a row of the table, the segment of the curve is highlighted in the graphics window. To find the row of the table that corresponds to a segment, click the Pick curve piece button and select the segment. The row of the table is then selected.

The columns of each table are:

- **Status** — Double-click box in the status column to display a list of Types of wire EDM tapers (see page 613).
- **First Angle** — This is the taper angle, specified in degrees, for the first end point of the segment.
- **Second Angle** — This is the taper angle, specified in degrees, for the second end point of the segment.
**Taper reg** — This is the register on the machine containing taper information for this segment.

> If you want smooth walls of your part, the angle of one segment must match the first angle of the next segment.

**New Feature - Start page (WIRE)**

The **New Feature - Start** page is where you set the start point and curve piece where you want the wire to start cutting the feature.

> Leads are non-perpendicular by default. If you want the lead to be perpendicular, select the **Pick only perpendicular lead** box before you click the **Pick location** button. Click the start point and FeatureCAM highlights the corresponding perpendicular point when you mouse-over the curve segment. **Click to accept it.**

**Die and Punch Features**

For 2 and 4-axis Die or Punch features, a start point is automatically calculated. You can change the start point for a Die or Punch feature using the following procedure:

1. If the feature has multiple curves, select the appropriate curve from the **Curve** list.
2. Click the **Pick location** button.
3. Click the new **Start point**.

> You must pick on the appropriate side for the feature type. For die features, pick on the inside. For punch features, pick on the outside. For side features pick on the machining side. If you pick a point in the incorrect side, the approach moves will gouge the part.

4. Select the segment of the curve to connect the start point to by moving the mouse over the feature until the segment of the curve you want is highlighted and then click the mouse.

5. The X and Y coordinates of the new start point are displayed in the dialog.

If you want to force the wire to start on the curve, you cannot simply double-click. You must move your second pick (the one that indicates the curve segment) slightly so that you are not picking the same point twice.

If you are creating a 4-axis feature, follow the above procedure for both the upper and lower curves.
Side Features

For 2 and 4-axis side features, the default is to start at the first point of the curve. To add new linear moves at the start or end of a curve:

1. If the feature has multiple curves, select the appropriate curve from the Curve drop down list.
2. Click the Pick point button for either the start or end point. A line will rubber-band from the current start of end point.
3. Click a point at the new location. Alternatively, you can simple enter the new end point coordinates.

New Feature - Match Curves page (WIRE)

FeatureCAM tries to match up the upper and lower curves for 4-axis features. You can edit the default match on the New Feature - Match Curves page.

A Side feature must have at least three moves in it including lead moves. If it does not, then no feature is displayed in the wizard start page.

For example, if you are creating a feature from a single line, you must change the start point and end point so that the feature has three moves.

FeatureCAM attempts to match up the points of the upper and lower curves of a 4-axis feature. If the curves are not matched as you want, then you can manually match the two curves.

Before starting to manually match your points, first make sure that the start points of each curve are close to each other when viewed from the top. Use the New Feature - Start (see page 615) page to do this.

To match two curves:

1. Click the Pick curve point button. All of the endpoints of the two curves are displayed as green dots and existing connections are shown as thick green lines.
2. Click an endpoint on the lower curve.
3. Click the corresponding endpoint on the upper curve. These points are connected with a green line.
4. Repeat these steps until you have matched all the points you want to change.
If you want to see how the feature looks with your new matches, click the **Next** button. If you want to make further changes, click the **Back** button and repeat steps 1-4.

If you want to connect a point on the bottom curve to multiple points on the top curve, hold down the SHIFT key when you select the bottom point and each top point.

*You cannot change the start points of the curves by adjusting the matching points. Use the **New Feature - Start** (see page 615) page to change the start points.*

**Curve Pieces Management**

To break a curve piece into equal pieces:

1. Specify the number of pieces you want by entering the number or using the arrow buttons.

2. Click the **Pick curve piece** button.

3. Select the curve piece that you want to break, in the Graphics window.

To add a single point to a 4-axis wire curve piece:

1. Click the **Pick curve piece then location** button.

2. Select the curve piece in the Graphics window.

3. Slide the cursor along the piece and click the location.

4. A new point is inserted at this location.

To remove curve pieces from a 4-axis wire curve:

1. Click the **Merge broken pieces** button.

2. Click the first curve piece.

3. Click the last curve piece. The portion of the curve is highlighted as you move the cursor to preview the selected region of the curve.

4. All internal points within these pieces are removed.

*You cannot remove the segment that contains the start point.*

**New Feature - Feature Extraction page (IFR) (WIRE)**

Use the **Feature Extraction** page of the **New Feature** wizard to select the method you want to use to recognize features from a solid model.

Select a method of recognizing features:

- **For solid faces** — Extract features from the faces of a solid.
• For all surfaces types — Extract features from trimmed surfaces, or from a mix of trimmed and untrimmed surfaces.

• For untrimmed ruled surfaces — Extract features from untrimmed surfaces.

Hide horizontal surfaces — Select this option to hide horizontal surfaces in the graphics window to make other surfaces easier to select. Enter an angle to hide surfaces that are almost horizontal. Surfaces within the specified range are hidden when you click Next.

New Feature - Solid Faces page (IFR)

Use the Solid Faces page of the New Feature wizard to select solid faces that represent a feature.

Add faces you want to machine to the list using the buttons:

• Click Pick surface to hide the dialog and select solid faces in the graphics window, then click Add from selected items to add them to the list.

• Select faces in the list and click Delete from selected items to remove them.

Slicing heights — Select Manual and specify the top and bottom heights of the feature, or select Automatic to use the height of the surfaces as the height of the feature.

Hide surfaces when finish — Select this option to hide surfaces used to create the feature when you finish the wizard.

Preview — Display a preview of the feature in blue in the graphics window.

New Feature - Upper Surface Edges page

Use the Upper Surface Edges page of the New Feature wizard to select surface edges that define the shape of the top of the feature.

Use the buttons to select surface edges you want to machine:

— Hide the dialog and pick surface edges in the graphics window.

— Remove the selected item from the list.

— Move the selected item up in the list.

— Move the selected item down in the list.

— For the item selected in the list, change the edge of the surface.
— Reverse the direction of the selected item.

Hide surfaces when finish — Select this option to hide surfaces used to create the feature when you finish the wizard.

**New Feature - Lower Surface Edges**

Use the Lower Surface Edges page of the New Feature wizard to select surface edges that define the shape of the bottom of the feature.

Use the buttons to select surface edges you want to machine:

— Hide the dialog and pick surface edges in the graphics window.

— Remove the selected item from the list.

— Move the selected item up in the list.

— Move the selected item down in the list.

— For the item selected in the list, change the edge of the surface.

— Reverse the direction of the selected item.

Hide surfaces when finish — Select this option to hide surfaces used to create the feature when you finish the wizard.

**New Feature - Upper Surface Boundaries**

Use the Upper Surface Boundaries page of the New Feature wizard to select surface boundaries that define the shape of the top of the feature.

Use the buttons to select surface edges you want to machine:

— Hide the dialog and pick surface edges in the graphics window.

— Remove the selected item from the list.

— Move the selected item up in the list.

— Move the selected item down in the list.

— For the item selected in the list, change the edge of the surface.

— Reverse the direction of the selected item.

Hide surfaces when finish — Select this option to hide surfaces used to create the feature when you finish the wizard.
New Feature - Strategies page (WIRE)

FeatureCAM has a variety of machining cycles for different purposes. Each operation type has a whole range of parameters and options.

Operations — Select the operation that you want to use to cut the feature.

- Retract (see page 625)
- Stop (see page 625)
- Pocketing (see page 626)
- Zigzag (see page 628)
- Cutoff (see page 630)
- Contour (see page 631)

You can have more than one operation by selecting the primary operation in the Operations list and then selecting the Cutoff or Contour options.

Primary Cut/Offset Dir

For closed curves, the Primary Cut Dir attribute controls the direction of a cut. The options are CW (clockwise) or CCW (counter-clockwise).

For open curves the Primary Offset Dir attribute controls the direction of a cut. The options are Left or Right. These settings are relative to the machining-side setting.

1. - Machining side
2. - Primary offset direction is Right

1. - Machining side
2. - Primary offset direction is Left
You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Settings (see page 1717) tab.

Retract Length

The Retract Length attribute is used for Retract, Stop, and Cutoff operations.

Use on both ends of skim passes — This applies the Retract Length to both ends of skim passes (the wire does not return to the start point at one end). See example.

Stop Length

This parameter is used for Retract, Stop, and Cutoff operations.

Repart operation:
Stop operation:

- Contour
- Wire path
- Stop length
- Contour start/end position
- Inserted stop positions

Cutoff operation (CW):

- Contour
- Wire path
- Stop length
- Normal contour start/end position
- Inserted end position
- Run-out

Cutoff operation (CCW):

- Contour
- Wire path
- Stop length
- Normal contour start/end position
- Inserted end position
- Run-out

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Settings (see page 1717) tab.

Stop code — For Stop operations you can choose from:

- **M00** is program stop. This stop is always performed.
- **M01** is optional program stop. There is a setting on the machine tool to observe or skip these stops.

Overlap

Stop operation:
The run-off back to the end position of the contour is at an angle. On some machines (for example, Agie), an angled run-off may not be allowable.

If the overlap is too large, a triangular piece of material is left, which may fall and halt the machine.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Settings (see page 1717) tab.
Contour overlap — This is used only by the Contour operation. It is the amount by which the Contour operation overlaps.

Total Stock applies to pocketing and zigzag operations.

This parameter sets the amount of material removed from the contour when using the Offset Method of Offset Toolpath. When the value is 0, only one cutting pass is made.

*The calculated wire path represents the center of the wire; the amount remaining on the curve is dependent on the cutter compensation values.*

![Diagram of wire path with contour overlap]

1 - Leave allowance
2 - Contour stock
3 - Total stock

Stepover — Enter the stepover amount between passes for Pocketing and Zigzag operations.

Finish allowance — This is the amount of material left after a Pocketing or Zigzag pass. Even if a Cleanup Pass is used, the finish allowance still remains.

Cleanup Pass is for zigzag operations.

The contour is cut with a contour parallel finishing path to remove any rough edges left by the stepover between passes.
- Cleanup Pass

**Islands** (see page 627) button for pocketing and zigzag operations.

**Skim Pass Options** (see page 1475) button.

**Retract**

The retract operation is available for both 2-axis and 4-axis features.

The contour is not cut completely but is stopped shortly before the contour end point. The distance of this position from the contour end point is set in the **Stop Length** field. This option is generally used when cutting multiple contours whereby the cut part should not be separated from the workpiece, such as when the program should run automatically overnight.

![Diagram of retract operation](image)

A Cutoff operation is normally used after this operation to cut the part of the contour that is not cut by the retract operation. The Cutoff operation machines the left over part in the opposite direction to the machining curve.

**Stop**

The stop operation is available for both 2-axis and 4-axis features.

A stop command is inserted into the wire path together with a further stop at the end of the contour. The distance of the new stop position from the contour end point is defined in the **Stop Length** field. If you want to overcut the contour end position, you can also define an **Overlap**. In centerline simulation, the locations where the wire stops are shown as small squares.

A stop operation has two different locations where the wire stops:
Pocketing

The Pocketing operation is available only for 2-axis features.

The Pocketing operation enables contour parallel area clearance of a closed curve.

Stepover

\[ \text{Stop length} \]
\[ \text{Wire path} \]
\[ \text{Contour} \]
\[ \text{Contour start/end position} \]
\[ \text{Inserted stop positions} \]
General rules

- The machining curve must define a closed pocket.
- The start position of the cut is set automatically to a point on the boundary. The wire then feeds to the center of the pocket and then cuts from the inside toward the boundary.
- To ensure that the wire starts in a particular position (to thread the wire for example) you should define a start point. The toolpath then starts at the start point and then feed to the center of the pocket.

   No attempt is made to check if the stepover value is larger or smaller than the wire diameter.

Cutter compensation does not apply to a pocketing operation because it outputs a wire path that is already corrected (that is, no compensation is entered on the machine).

Islands for pocketing and zigzag

You can use Islands with Pocketing and Zigzag operations to indicate areas where there is no stock and so avoid air cutting.

When you select either Pocketing or Zigzag as the operation on the Strategies page of the New Feature wizard (or the Strategy tab of the feature Properties dialog), you see a button labelled Islands.
Click this button to open the **Select Islands** dialog where you specify the curves that you want to act as islands:

![Select Islands dialog]

The toolpath avoids the area within the island.

### Zigzag

*The Zigzag operation is available only for 2-axis features.*

The Zigzag operation defines a zigzag area clearance cycle for a closed curve.

1. Offset
2. Stepover

### General Rules

- The machining curve must define a closed pocket.
- The start position of the cut is set automatically to a point on the boundary. The wire then feeds to the beginning of the zigzag pattern.
To ensure that the wire starts in a particular position (to thread the wire for example) you should define a start point. The toolpath then starts at the start point and then feeds to the beginning of the zigzag pattern.

By the definition of the Cut Angle you can control the direction of the wire path and also the start point of the cycle (see page 629).

The angle is defined from the X-positive axis of the current UCS. Enter the angle in degrees.

No attempt is made to check if the stepover is larger or smaller than the wire diameter.

Cutter compensation does not apply to a pocketing operation because it outputs a wire path that is already corrected (that is, no compensation is entered on the machine).

Start point for zigzag

The start position that is automatically calculated by the software depends on the Cut Angle of the wire path.

If the Cut Angle is $0^\circ$, the start point of the cycle is at the bottom left.

If the Cut Angle is $90^\circ$, the start point of the cycle is at the bottom right.
If the Cut Angle is 180°, the start point of the cycle is at the top right.

If the Cut Angle is 270°, the start point of the cycle is at the top left.

The chosen angle can naturally lie between the examples shown above. In this case the start point is set to the nearest of the positions shown. On extremely complex contours it may be necessary to experiment with the cut angle to find the optimum start point.

**Cutoff**

The Cutoff operation is available for both 2-axis and 4-axis features. This option is normally used after a contour has been cut with a retract operation.

Cutoff cuts the part of the contour left by the retract option. Machining is in the reverse direction to that of the machining curve, from the contour end point to the stop position. The wire stops before pulling away from the part. The stop location is shown as a small square.

[Diagram showing Cutoff operation with labels for Retract length and Stop length]
Contour

The contour operation is available for both 2-axis and 4-axis features.

This cycle is the generally applicable cycle for cutting contours.

General Rules

The curve can be open or closed. A contour operation traces the entire length of the curve. The number of passes is determined by Contour passes. A contour operation can be optionally added to retract, stop, pocket, zigzag or cutoff operations by selecting the Contour option on the Strategy tab.

If you want the contour to overlap, enter the amount of overlap you want as the Contour Overlap.

New Feature - Operations page (WIRE)

This page lists the operations that you have chosen on the Strategies (see page 620) page to manufacture the feature.

To complete this page:

1. If you are happy with the operations, click Finish (see page 531).
2. If you would like to take a closer look at the cutting data, click Next to open the New Feature - Cutting Data page.
The **New Feature - Cutting Data (WIRE)** page provides the feed, water and cutter compensation registers for each pass of the operation. The use of all these settings depends on the machine and controller type. You can set these values automatically from the current material database, or enter them manually.

Most modern NC machines have an integrated technology database which the machine uses to set up the optimum cutting conditions for the workpiece. In this way the cutting is accurate and uses the full power of the machine. These settings for the cutting conditions are usually stored in **Registers** in the controller and are activated by particular codes in the NC program. FeatureCAM enables you to define these codes for up to nine cuts (either backwards/forwards cutting or with sub-programs). You can also load pre-defined settings from a database you have prepared.

**Feed** — This is used to select the generator setting on the wire machine. The generator setting controls the cutting speed of the machine by setting parameters such as strength, pulse time, and pause time between pulses of the electrical current used to produce the spark. These parameters vary with the workpiece material, height, and so on.

**Water** — This is used to select the machine register that defines the water flow during cutting. The parameters that are controlled include the water pressure, flow rate, and so on.

**Comp. Reg.** — This sets the number of the Compensation Register of the NC machine, which is used for wire radius compensation. The value held within this register is the amount by which the wire is corrected to the left or right of the defined wire path when the function for wire correction on the machine is switched on (normally **G41** or **G42**).
Comp. Val. — This sets the wire radius correction value for the given offset register on the machine. The value is normally the sum of the wire radius + spark gap + any finishing allowance required. For most machines, the compensation value is referenced through the compensation register, so there is no need to set this value.

You can change the labels of these columns in the Cutting Conditions Names dialog in XBUILD. Select CNC-Info > Cutting Conditions Names from the XBUILD menu.

New Feature - Summary (WIRE)

This is the final page of the New Feature wizard. It shows a list of the operations for the feature.

To complete this page:

1. If you are happy, click Finish (see page 531) and the feature is created.

   You can edit (see page 884) the feature later.

2. If you want to make changes, click the Back button until you come to the wizard page you want to alter.

Specific features

FeatureCAM features can be divided into the following groups:

- Toolpath feature (see page 633)
- 2.5D milling features (see page 636)
- 3D milling features (see page 734)
- Turning features (see page 804)
- Turn/Mill features (see page 856)
- User-defined features (see page 857)
- Wire features (see page 858)

Toolpath feature

Use a Toolpath feature to directly create a single toolpath movement. You can create the moves of a toolpath in three ways:

- Create each move individually. You would typically do this if you have a simple, but very precise tool movement that cannot be easily created using a FeatureCAM feature.
- Create a curve. This lets you use the drawing tools of FeatureCAM to control the path of the tool precisely.
- Import an operation of an existing feature. This technique lets you make changes to the toolpaths that FeatureCAM generates automatically. You can import toolpaths from either milling or turning features.

If the toolpath is created from a curve or a feature, it is not linked to the original source regardless of the parametric modeling (see page 309) setting. As a result, this is a mechanism for storing a toolpath that will never be automatically modified by FeatureCAM.

You must simulate toolpaths to check for gouging on any modified toolpaths.

To create a Toolpath feature:

1. Click the Features step in the Steps panel. The New Feature dialog is displayed.

2. In the From Feature section, select Toolpath and click Next. The New Feature - Curve or Operation page is displayed.
   - If you want to use a curve, select Curve and select the name of the curve from the list.
   - To edit the toolpaths of an operation, select Operation and select the operation name from the list.
   - Select NC code text to enter NC code directly, such as program stop code M00 or M01.

3. Follow the steps of the wizard to pick a tool and feed and speed rates for the toolpath.
Each Toolpath feature creates a single toolpath operation. Each toolpath operation has a Tools, F/S, and Toolpaths (see page 1037) tab. Use the Toolpaths tab to edit the Toolpath feature.

If you are creating the toolpath from manually entered moves or from a curve, you must manually select tools and the feed and speed values.

If the toolpath was imported from another FeatureCAM operation, the tooling and machining parameters are kept.

Program stop code example

To enter program stop code directly into the NC program:

1. Click the Features step in the Steps panel. The New Feature dialog is displayed.

2. In the From Feature section, select Toolpath and click Next. The New Feature - Curve or Operation page is displayed.

3. Select the NC code text option and enter M00 (or M01).
4 Click Next. The **New Feature - Toolpath feature** page is displayed.

This page has the same toolpath editing buttons as the **Toolpaths** (see page 1037) tab in the **Toolpath Properties** dialog.

5 Click **Finish**. The Toolpath feature is listed in the **Part View** and on the **Op List** tab.

6 Simulate the Toolpath feature. In this example, there are no toolpaths to see, but you must simulate the feature to produce the NC code.

7 View the NC code on the **NC Code** tab.

*If a Toolpath feature consists only of G-code, FeatureCAM does not display the **Tools** or **F/S** tabs in the **Toolpath Properties** dialog.*

### 2.5D milling features (25D & 3D)

**Hole** (see page 637) — A Hole feature is created by drilling or boring and may have other characteristics such as a chamfer or tapped threads. They may be manufactured using canned drilling cycles.

**Boss** (see page 679) — Mills a boss whose shape is determined by a curve.

**Chamfer** (see page 684) — Mills a chamfer that follows a curve. Most features include a chamfer option which you should use for chamfering entire features.

**Face** (see page 676) — Is a milling operation to cut a smooth finish on a face of the stock and to cut the stock to exact dimensions.

**Groove** (see page 689) — Is a groove that follows a curve. The curve is the centerline of the groove. Also used for engraving. Grooves support open or closed curves.
Pocket (see page 700) — Mills an arbitrarily shaped cavity. It may contain a collection of island curves or bosses within the pocket. The islands can be at different heights.

Round (see page 705) — Mills a rounding operation that follows a curve.

Side (see page 709) — Is a general milling operation to cut all the material on one side of a curve. This feature works with open or closed curves.

Rectangular pocket (see page 656) — Mills a rectangular pocket with rounded corners. No curve is needed for this pocket.

Slot (see page 661) — Is a straight slot with rounded ends. No curve is needed for a slot.

Step bore (see page 666) — Is a nested series of round pockets with a common center. No curve is needed for a step bore.

Thread mill (see page 670) — Mills a thread on an inner or outer diameter.

You can create patterns (see page 874) of features as well as groups (see page 869) of features which, in turn, can become the basis feature for even more sophisticated patterns.

Hole

There are multiple Hole feature types:

Plain hole

Counter-bore hole
Counter-sink hole

1 - Sink diameter
2 - Angle
3 - Depth
4 - Through
5 - Diameter

Counter-drill hole

1 - (Counter) **Drill diameter**
2 - (Counter) **Drill depth**
3 - **Chamfer** (depth of 45° chamfer)
4 - Depth
5 - Through
6 - Diameter

Tapped hole

1 - **Thread depth**
2 - **Chamfer** (depth of 45° chamfer)
3 - Depth
4 - Through
5 - Diameter
Counter-drilled Tapped hole

- (Counter) **Drill diameter**
- (Counter) **Drill depth**
- **Thread depth**
- **Chamfer** (depth of $45^\circ$ chamfer)
- **Depth**
- **Through**
- **Diameter**

Thread Milled Hole

- **Minor Diameter**
- **Thread Height**
- **Thread Depth**
- **Thread Pitch**
- **Chamfer**
- **Depth**
- **Through**

Back Bore Hole

- **Bore Diameter**
- **Bore Depth**
- **Diameter**
- **Depth**

The different types of holes are defined by dimensional attributes. Not every hole has every attribute. This table (see page 651) shows all the hole types and dimension attributes associated with them.

**Creating a Hole feature**

To create a Hole feature:
1 Click the **Features** step in the **Steps** panel. This displays the **New Feature** wizard.

![New Feature wizard](image)

2 In the **From Dimensions** section, select **Hole** and click **Next** to open the **New Feature - Dimensions** page.

![New Feature - Dimensions](image)

*If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.*
Select the type of hole from the **Type** list.

- **A Plain Hole** is a simple Hole with an optional chamfer.
- **A Counter Bore Hole.**

![Counter Bore Hole](image)

- **A Counter Sink Hole.**

![Counter Sink Hole](image)

- **A Counter Drill Hole.**

![Counter Drill Hole](image)
- **A Tapped Hole** is a Hole that is under-sized drilled and then tapped.

- **A CD Tapped Hole** is a counter drilled hole with the bottom part of the Hole tapped.
- **A Thread Milled Hole.**

  ![Thread Milled Hole Diagram]

  - Enter a **Diameter** value.
  - If you are building Hole features from circles, select the circle before opening the wizard to pre-populate this field.
  - Enter how deep the **Hole** is in the **Depth** field.
  - Select **Through** to increase the hole length by 10% of the hole diameter to account for the drill tip and prevent burring.

- **A Back Bore Hole.**

  ![Back Bore Hole Diagram]

  4 Enter a **Diameter** value.
  5 Enter how deep the **Hole** is in the **Depth** field.
  6 Select **Through** to increase the hole length by 10% of the hole diameter to account for the drill tip and prevent burring.
Depending on the type of Hole you selected, you may have other dimensions (see page 651) to fill in such as **Chamfer** and **Drill Depth**. For Tapped Holes and Thread Milled Holes, you can select **Standard Threads** and select a thread type. Each thread type sets the **Thread depth**, **TPI**, and **Diameter** dimensions.

7 For Tapped Holes and Thread Milled Holes, select **Tapered** if the thread is tapered.

> Tapered taps are driven to a different depth than straight taps. For straight taps, a tip allowance is added to the thread depth so that the tool cuts the complete thread, this is not added for tapered taps so that the OD is not affected.

8 Click **Next** to open the New Feature - Location page. Select whether you want to enter the location as **XYZ** or **Polar**.

- For **XYZ**, enter the **X**, **Y**, and **Z** coordinates or pick the location in the Graphics window.
- For **Polar**, enter the **Radius** (the distance along the X axis), the **Angle**, and the **Z** location.

9 Click **Next** to open the New Feature - Strategies page. The options on this page are the same as those on the **Strategy** (see page 889) tab of the Hole Feature Properties dialog.

10 Click **Next** to open the New Feature - Operations (see page 564) page.

11 Click **Next** to open the New Feature - Default Tool (see page 564) page.

12 Click **Next** to open the New Feature - Feed/Speed (see page 567) page.

13 Click **Next** to open the New Feature - Summary (see page 567) page.

14 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

> You can edit (see page 884) the feature later.

> You can click **Finish** (see page 531) at any stage during the wizard to accept the default settings for the remaining pages and exit.

**Hole macros**

Macros can be generated in the NC code for patterns of holes. To generate these macros, your post processor must support them, and you must turn this function on for the post.
1 Enable **Retract to plunge clearance** (see page 889) for the hole pattern.

2 Select the **Manufacturing > Post Process** menu option to display the **Post Options** dialog.

3 Select your post processor.

4 Deselect the **Disable Macros** option.

5 Change any other appropriate settings.

6 Click **OK**.

7 Select **Manufacturing > Machining Attributes** from the menu.

8 On the **Operations** tab, click the **Automatic Options** button and select the **Minimize tool changes** option.

   You could set **Minimize tool changes** in the **Ordering** (see page 1495) dialog instead. Using the Default Attributes setting includes macros for any parts you create.

9 Disable **Minimize rapid distance**.

10 Click **OK**.

Macros cause FeatureCAM to analyze the NC code and generate macros for hole operations if it finds sets of repetitive tasks. This method may ignore sets of operations that don’t have one-to-one correspondence with the other sets in the macro. For example, if you are drilling and reaming a pattern of six holes, and another hole in the Setup also uses the same tool, the operation set that shares the same tool, is not included in the macro because there are seven operations in that set, not the six that the other sets of operations used in the macro.

**How holes are manufactured**

FeatureCAM follows this process for creating holes:

1 Conducts an analysis of the hole size, type, and attributes to determine what tool to use (see page 649).

2 Picks feeds and speeds (see page 647) based upon the material being drilled.

3 Prepares the site (see page 647) with spot drill and pilot drill operations.

4 Twistdrills to depth (see page 648).

5 Sizes and does counter cutting (see page 648) operations.

6 Taps, or bores/reams (see page 648) if set.

7 Holes are output as either canned cycles or computed moves.
There are many variations on this process, particularly with patterns of holes and hole macros. You can edit the basic hole process in these places:

- To edit all Hole features in the current document, use the Drilling (see page 1598, see page 889) tab in Machining Attributes.
- To edit a single Hole feature, use the Tools, Drilling (see page 900), Strategy, and Misc. tabs in the Feature Properties (see page 884) dialog.

The tooling database also has a large impact on how a hole is drilled, and the feed/speed database helps to determine the feeds and speeds used.

**Drill selection for tapped holes**

The formula FeatureCAM uses is from the Machinery's Handbook Ed. 20 Pg. 1435:

\[
drill\ size = outside\ dia \times 1.299 \times thread\_percent \times \frac{1}{threads\_per\_inch}
\]

- **drill\_size** is the size of the drill that is used to rough the hole.
- **outside\_dia** is the size of the tapped hole, so for a "1/4-20", it would be 1/4in.
- **thread\_percent** is Thread % for tap drill from the tool selection page of default attributes. By default it is 77%.
- **threads\_per\_inch** is just that. In the "1/4-20" example, it is 20.

The drill size table is based on 77% thread. Switch to 75% if you want the same behavior as the Machinery's Handbook.

Also, it should be noted that FeatureCAM's tool selection tolerance is 0.002 inches. This tight tolerance occasionally results in the failure to automatically select a tool. For example, for a 5/8" hole, the formula results in a number that is very close to a standard drill size given in the handbook's table, but not quite within 0.002. Hence tool selection fails. In this case, you must explicitly select a tool.

**Hole: Feeds and Speeds**

FeatureCAM chooses feeds and speeds for all of its drilling using the F/S database that you can customize. Feeds and speeds are determined based upon the stock material.

**Hole: Site preparation**

The important aspects of roughing are as follows:
• **Spot drilling** — Aids later drill operations and is set with the **Spot drill** attribute at machine-level (see page 1598, see page 889) or feature-level (see page 889). If you have selected **Attempt chamfer w/ spot**, then the chamfer operation may be combined with this operation if the tool has the correct angle and size.

• **Pilot drilling** — Is enabled by setting the **Pilot drill** (see page 889) attribute. How pilot drilling is performed is influenced by **Chip break/Deep hole** and similar settings.

**Hole: Drill to depth**

This is shown as a drill operation in the tree view and is turned on or off with the **Drill** attribute. The **Chip Break** and **Deep Hole** cycles (see page 898) also affect the behavior. Actual diameter may be undersized depending on later actions such as tapping or reaming operations.

The actual depth of the twistdrill operation is determined as follows:

- **Drilled Depth** = \( \text{depth} + \left( \frac{\text{diameter}}{2.0} \right) / \tan\left( \frac{\text{Angle of drill}}{2.0} \right) \)
- If the **Through** option is selected, then add \( 0.1 \times \text{Diameter} \).

**Hole: Size effects**

Depending on the type of hole, a counterbore, counterdrill, or countersink operation may be performed.

If a **Chamfer** was set, but not performed with the spotdrill operation, it happens now. If the hole is too large to chamfer with a countersink, it is cut by circular interpolation with a chamfer mill.

**Hole: Threading, boring, and reaming**

The Tap, Bore, or Ream operation occur last for a Hole feature. If the Hole is tapped, then no Bore operations are possible.

Tap cuts threads in the Hole and is measured in TPI (threads per inch) in inch units or Pitch (millimeters per thread) in metric units. Ensure you set the **Max tap spindle RPM** attribute on the **Drilling** (see page 900) tab.

For a tapping operation, the depth is determined as follows:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Diameter</th>
<th>Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plug point tap</td>
<td>Less than 3/8 inch (9.5mm)</td>
<td>((\text{diameter} - 1.1047 \times \text{Pitch})/2 + 4.75 \times \text{Pitch})</td>
</tr>
<tr>
<td>Plug point tap</td>
<td>3/8 - 7/16 inches (9.5 - 11 mm)</td>
<td>4.75xPitch</td>
</tr>
</tbody>
</table>
Plug point tap | >=7/16 inches (11.1mm) | 4.75xPitch + .2xDiameter
--- | --- | ---
Bottom point tap | < 7/16 inches (11.1mm) | 1.75xPitch
Bottom point tap | >= 7/16 inches (11.1mm) | 1.75xPitch + .2xDiameter

Bore uses a boring bar to position a Hole exactly. Bore and Ream settings are not normally used together.

Ream drills a Hole feature undersized and then reams it to size. The diameter of the drill is between 93% and 97% of the final hole diameter. Bore and Ream settings are not normally used together.

**Summary of ways you can make Holes in FeatureCAM**

There are many ways to create holes in FeatureCAM:

- From dimensions (see page 639).
- In patterns (see page 872).
- From a list of points. If you select points before opening the Feature Wizard (see page 530), these points are used to create a Point list pattern (see page 879).
- You can create a point list pattern of holes by selecting all circles of the same radius (see page 884) before entering the Feature wizard.
- Extract individual Holes from a 3D solid or surface model (see page 511) using the FeatureRECOGNITION option. By using the FeatureRECOGNITION option you can also automatically recognize all the holes from a 3D solid or surface model (see page 512).

**Hole: Tool Selection**

The first step of drilling a Hole is to determine what kind of hole it is. Then collect a list of operations to produce that hole. After the analysis, FeatureCAM picks tools. The table below shows the tooling types that can be used for each operation type.
<table>
<thead>
<tr>
<th><strong>Operation type</strong></th>
<th><strong>Automatically selected tool</strong></th>
<th><strong>Possible user overrides</strong></th>
<th><strong>Notes</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>spotdrill</td>
<td>Spot or Center Drill (see page 1774)</td>
<td>spotdrill, centerdrill, countersink</td>
<td>Automatic behavior is dependent on the prefer spotdrill or prefer centerdrill attributes.</td>
</tr>
<tr>
<td>chamfer</td>
<td>Countersink (see page 1758)</td>
<td>spotdrill, centerdrill, countersink, chamfer</td>
<td>If the tool diameter is smaller than the hole diameter, circular interpolation is performed. You can override the automatically selected tool with a tool that does not have a 90 degree included angle, but the chamfer is not a 90 degree chamfer. The tool diameter is found by multiplying the chamfer's outer diameter by 1.1 to ensure the end of the chamfer tool is not used for cutting.</td>
</tr>
<tr>
<td>twistdrill</td>
<td>Twist drill (see page 1780)</td>
<td>twistdrills, endmills</td>
<td>No circular interpolation is performed with endmills, even if the diameter is smaller than the hole's. See Step Bore feature (see page 666) if you want to mill a circular pocket.</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------</td>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>bore</td>
<td>Boring bar (see page 1754)</td>
<td>boringbar</td>
<td></td>
</tr>
<tr>
<td>counterbore</td>
<td>Counter bore (see page 1757)</td>
<td>counterbore, endmill</td>
<td>Circular interpolation is performed if the tool's diameter is smaller than the counterbore's.</td>
</tr>
<tr>
<td>ream</td>
<td>Ream (see page 1769)</td>
<td>ream</td>
<td></td>
</tr>
<tr>
<td>tap</td>
<td>Tap (see page 1776)</td>
<td>tap</td>
<td>For blind holes a fast spiral, plug tap is preferred. Through holes require a gun style plug tap.</td>
</tr>
</tbody>
</table>

For drilling, the most important criteria are diameter and length. If a tool can't be found that satisfies the criteria, then you receive a tool selection error.

The size of the tool selected may be affected by the Tool diameter tolerance attribute on the Tool Selection tab of the Machining Attributes dialog.

See also:

Tool Groups (see page 1751) for details on the different tooling types

Hole attribute table
<table>
<thead>
<tr>
<th>Feature</th>
<th>Plain</th>
<th>Count bore</th>
<th>Count sink</th>
<th>Count drill</th>
<th>Tapped</th>
<th>CD Tapped</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Angle</strong> refers to the included angle of the counter sink. This value helps select an appropriate countersink tool.</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Back</strong> views the settings of the pattern object that contains the hole.</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Bore depth</strong> refers to the depth of the counter bore.</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Bore diameter</strong> refers to the diameter of the counter bore.</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Chamfer</strong> sets the depth of a 45° chamfer at the top of the hole. If set to 0, no chamfer is cut.</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Counter drill diameter</strong> sets the diameter of the counter drill.</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>--------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Counter drill depth</td>
<td>sets the depth of the counter drill.</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Depth</td>
<td>refers to the overall depth of the hole. It is measured from the top to the bottom of the hole and includes other parameter values such as the hole's Chamfer depth.</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diameter</td>
<td>sets the finished diameter of the hole.</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>specifies location by coordinates. Click to select the point with the mouse.</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metric</td>
<td>toggles TPI (Threads Per Inch) and pitch for metric threads.</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relative position</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>indicates that the X, Y, and Z coordinates are relative to the current UCS. Otherwise, coordinates are relative to the World Coordinate System.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sink diameter</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>refers to the diameter of the counter sink of the hole.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The Tapered option is available on tapped holes. Select it and enter an Angle to specify a threaded tapered hole.</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thread depth sets how much of the hole is threaded.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TPI/Pitch sets the threads-per-inch or metric pitch of the hole's threads.</th>
<th>Text</th>
</tr>
</thead>
</table>

Yes | Yes | Yes | Yes | Yes | Yes | Yes |
### Thread diameter

Refers to the nominal diameter of the tap tool used to thread the hole. Underlying details such as selecting an under-sized drill for creating the initial hole are automatically computed.

| Through is an option that controls the display of holes. For manufacturing it is only used for tapped holes. | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |

### XYZ Coordinates

Refer to the XYZ coordinate location of the top center of the hole. These values are relative to the World Coordinate System.

| ✓ | ✓ | ✓ | ✓ | ✓ | ✓ | ✓ |
Rectangular Pocket

Use the Rectangular Pocket feature to create a rectangular pocket.

1 - Length
2 - Width
3 - Corner radius
4 - Chamfer
5 - Depth
6 - Bottom radius

For a Pocket with a non-rectangular curve, use the more general Pocket (see page 700) feature.

To do so, enter the pocket diameter in both the length and width fields, and enter the Pocket radius in the corner radius field.

Creating a Rectangular Pocket feature

1 Click the Features step in the Steps panel.
This displays the **New Feature** wizard.

2. Select **Rectangular Pocket** and click **Next** to open the **New Feature - Dimensions** page. Enter the following attributes:

- **Length** — Enter the X dimension of the feature.
- **Width** — Enter the Y dimension of the feature.
- **Depth** — Enter the distance cut into the material in Z.
- **Corner radius** — Enter the radius for all four corners of the Rectangular Pocket.
- **Chamfer** — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.
• **Draft angle** — Optionally set an angle for the feature wall. Use only positive numbers.

• **Bottom Radius** - Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.

3 Click **Next** to open the **New Feature - Location** (see page 534) page.

4 Click **Next** to open the **New Feature - Strategies** (see page 537) page.

5 Click **Next** to open the **New Feature - Operations** (see page 564) page.

6 Click **Next** to open the **New Feature - Default Tool** (see page 564) page for the first operation.

7 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page for the first operation.

8 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

9 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

If you want the wall of your feature to have a special cross section:

1 After you have created the feature, open the **Feature Properties** dialog and click the **Dimensions** tab.

2 Click the **X Section** button to open the **Select Side Curve** dialog.

3 Select the curve that matches your cross-section shape.

4 Click **OK**.

See also:

Cross section (X section) for Boss, Side, or Pocket for restrictions on the curve (see page 928)
How Rectangular Pockets are manufactured

FeatureCAM follows this general process:

1. Conducts an analysis of the dimensions to determine what tool to use (see page 659).
2. Picks feeds and speeds (see page 660) based upon the material being machined.
3. Generates a roughing (see page 660) pass possibly in multiple Z steps depending on the depth of the step.
4. Generates a finishing (see page 661) pass.

You can edit this process in these places:

- To edit all instances of this type of feature in the current document, use the Machining Attributes dialog.
- To edit a single feature, use the Tools, Milling, Strategy, and Misc. property tabs for the feature in the Feature Properties (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

Rectangular Pocket: Tool Selection

The first step is to pick a tool from the current tool crib (see the Manufacturing menu). The most important criteria are diameter and length. If a tool can’t be found to meet the criteria, then you get an error and NC code is not generated.

**Tool diameter** — FeatureCAM conducts an analysis of the dimensions that define the pocket to determine what size tool to use. FeatureCAM prefers large tools for pockets but is influenced by the corner radius. The largest tool that can cut the pocket without gouging is selected.

**Tool length** — FeatureCAM picks a tool that has flutes long enough to cut to the bottom of the pocket.

<table>
<thead>
<tr>
<th>Operation type</th>
<th>Automatically selected tool</th>
<th>Possible user overrides</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roughing</td>
<td>endmill</td>
<td>face mill, endmill</td>
<td></td>
</tr>
<tr>
<td>Finishing</td>
<td>endmill</td>
<td>face mill, endmill</td>
<td></td>
</tr>
</tbody>
</table>
The size of the tool selected may be affected by the Tool diameter tolerance attribute on the Tool Selection tab of the Machining Attributes dialog.
See also:
Tool % of arc radius (see page 973)
Tool Groups (see page 1751) for details on the different tooling types.

Rectangular Pocket: Feeds and Speeds
FeatureCAM chooses feeds and speeds for all of its milling using the Feed/Speed database (see page 1508) that you can customize.
Feeds and speeds are determined based on the stock material.

Rectangular Pocket: Roughing
The important aspects of roughing are:
- **Getting to depth** — The tool needs to get to depth, and this can be accomplished by a zigzag in Z (the default setting and influenced by Max ramp angle), by plunging, or by pre-drilling.
  Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.
- **Vertical step** — FeatureCAM's cut depth is no more than 100% of the tool radius.
- **Horizontal stepover** — FeatureCAM moves over laterally a percentage of the tool diameter (controlled with Rough pass %), as it steps across the feature.
  Spiral % is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.
- **Finish allowance** (see page 994) — This controls how much material to leave for the finishing pass. By default this is 0.02.

These attributes affect roughing:
- **Pre-drill diameter** (see page 1161)
- **Pre-drill point** (see page 994)
- **Rough pass Z increment** (see page 994)

For Boss and Pocket features, FeatureCAM provides several different milling methods for roughing (see page 716).
Rectangular Pocket: Finishing

By default, the bottom is not finished. The roughing tool removes all of the material in Z. This is controlled by the Finish bottom (see page 936) attribute.

- **Tool selection**, after roughing, the roughing tool is used to finish the pocket. Select *Use finish tool* (see page 936) to choose a separate finishing tool (that has the same characteristics unless you override them).
- The finish pass ramps onto the material with an arc equal to a percentage of the tool diameter, controlled by Ramp diameter (see page 994).
- **Finish passes and overlap** makes the tool go around the pocket a number of times set by Finish passes (see page 994), and overlaps the starting point by an amount controlled by Finish overlap (see page 994).
- To move the tool away from the finished wall, the finish pass ramps off using an arc of the same size as the arc used to ramp on.
- **Retract** removes the tool from the stock area and sets up for the next operation.

Slot

Slot features are similar to rectangular pockets but have round ends equal in diameter to the width of the slot.

```
1 Length
2 Width
3 Chamfer
4 Depth
5 Bottom radius
```

Creating a Slot feature

1 Click the Features step in the Steps panel.
This displays the **New Feature** wizard.

2. Select Slot and click **Next** to open the **New Feature - Dimensions** page.

   - If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.
   - **Simple** — This option simplifies the manufacturing strategy for the feature. Select this option to machine the feature by making a single pass down the center of it with a tool whose radius is equal to the width of the feature.
   - **Length** — Enter the X dimension of the feature.
- **Width** — Enter the Y dimension of the feature.

  The width of a slot does not have to match the diameter of a standard available endmill, unless you are making a **Simple** slot. If an exact match cannot be found, then a smaller tool is selected and multiple horizontal passes are performed.

- **Depth** — Enter the distance cut into the material in Z.

- **Chamfer** — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

- **Bottom radius** - Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

- **Draft angle** — Optionally set an angle for the feature wall. Use only positive numbers.

3 Click **Next** to open the **New Feature - Location** (see page 534) page and set the location of the center of the left corner arc of the feature.

4 Click **Next** to open the **New Feature - Strategies** (see page 537) page.

5 Click **Next** to open the **New Feature - Operations** (see page 564) page.

6 Click **Next** to open the **New Feature - Default Tool** (see page 564) page for the first operation.

7 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page for the first operation.

8 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

9 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

**How Slots are manufactured**

FeatureCAM follows this general process:
1. Conducts an analysis of the dimensions to determine what tool to use (see page 664).
2. Picks feeds and speeds (see page 665) based upon the material being machined.
3. Generates a roughing (see page 665) pass possibly in multiple Z steps depending on the depth of the step.
4. Generates a finishing (see page 665) pass.

You can edit this process in these places:
- To edit all instances of this type of feature in the current document, use the **Machining Attributes** dialog.
- To edit a single feature, use the **Tools, Milling, Strategy, and Misc.** property tabs for the feature in the **Feature Properties** (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

### Slot: Tool Selection

The first step is to pick a tool from the current tool crib (see the **Manufacturing** menu). The most important criteria are diameter and length. If a tool can’t be found to satisfy the criteria, then you get an error and NC code is not generated.

**Tool diameter FeatureCAM** analyzes the dimensions that define the Slot feature to determine what size tool to use. For a **Simple Slot**, the tool must match the width of the slot, which also guarantees the correct radius at the ends of the Slot. For normal Slots, the largest tool that can cut the slot to width and still leave the Finish allowance is selected.

**Tool length FeatureCAM** picks a tool that has flutes long enough to cut to the bottom of the Slot.

<table>
<thead>
<tr>
<th>Operation type</th>
<th>Automatically selected tool</th>
<th>Possible user overrides</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roughing</td>
<td>endmill</td>
<td>face mill, endmill</td>
<td></td>
</tr>
<tr>
<td>Finishing</td>
<td>endmill</td>
<td>face mill, endmill</td>
<td></td>
</tr>
<tr>
<td>Chamfer</td>
<td>chamfer mill</td>
<td>spotdrill, centerdrill, countersink, chamfer mill</td>
<td></td>
</tr>
</tbody>
</table>
The size of the tool selected may be affected by the Tool diameter tolerance attribute on the Tool Selection tab of the Machining Attributes dialog. See also:

**Tool % of arc radius** (see page 973)

Tooling groups (see page 1751) for details on the different tooling types.

**Slot: Feeds and Speeds**

FeatureCAM chooses feeds and speeds for all of its milling using the Feed/Speed database (see page 1508) that you can customize. Feeds and speeds are determined based on the stock material.

**Slot: Roughing**

The important aspects of roughing are:

- **Getting to depth** — The tool needs to get to depth, and this can be accomplished by a zigzag in Z (the default setting and influenced by Max ramp angle), by plunging, or by pre-drilling.

Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.

- **Vertical step** — FeatureCAM's cut depth is no more than 100% of the tool radius.

- **Horizontal stepover** — FeatureCAM moves over laterally a percentage of the tool diameter (controlled with Rough pass %), as it steps across the feature.

**Spiral %** is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.

- **Finish allowance** (see page 994) — This controls how much material to leave for the finishing pass. By default this is 0.02.

  *For a simple slot, Finish allowance has no effect.*

These attributes affect roughing:

- **Pre-drill diameter** (see page 1161)
- **Pre-drill point** (see page 994)
- **Rough pass Z increment** (see page 994)

**Slot: Finishing**

By default, the bottom is not finished. The roughing tool removes all of the material in Z. This is controlled by Finish bottom (see page 936).
- **Tool selection**, after roughing, the roughing tool is used to finish the slot. Use finish tool (see page 936) commands in FeatureCAM to choose a separate finishing tool (that has the same characteristics unless you override them).

- The finish pass ramps onto the material with an arc equal to a percentage of the tool diameter, controlled by **Ramp diameter (see page 994)**.

  *Not available for a Simple slot.*

- **Finish passes and overlap** makes the tool go around the slot a number of times set by Finish passes (see page 994), and overlaps the starting point by an amount controlled by Finish overlap (see page 994).

  *Not available for a Simple slot.*

- **Ramp off** uses another arc of the same size as the ramp on to move the tool away from the finished wall.

  *Not available for a Simple slot.*

- **Retract** removes the tool from the stock area and sets up for the next operation.

**See also:**
Ramp diameter (see page 994)

**Step Bore**

A Step Bore feature is a series of nested circular pockets. You can specify a Step Bore, step by step, or use a number of concentric circles as the part's curve where each circle defines a level's diameter.

1. - Diameter
2. - Chamfer
3. - Depth
4. - Radius
FeatureCAM follows this general process to create a Step Bore feature:

1. Conducts an analysis of the curve and using tool diameter and length as the selection criteria, and from the current tool crib selects the tool to use.
   - For tool diameter, the largest tool that can cut the step without gouging is selected.
   - For tool length, FeatureCAM picks a tool that has flutes long enough to cut to the bottom of the Step Bore depth for that level.

2. FeatureCAM chooses feeds and speeds for all of its milling using the Feed/Speed database (see page 1508) that you can customize. Feeds and speeds are determined based on the stock material.

3. Generates a roughing pass possibly in multiple Z steps depending on the depth of the step.
   
   The important aspects of roughing are:
   - **Getting to depth** — The tool needs to get to depth, and this can be accomplished by a zigzag in Z (the default setting and influenced by **Max ramp angle**), by plunging, or by pre-drilling.
     
     Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.
     
     - **Vertical step** — FeatureCAM's cut depth is no more than 100% of the tool radius.
     - **Horizontal stepover** — FeatureCAM moves over laterally a percentage of the tool diameter (controlled with Rough pass %), as it steps across the feature.

   **Spiral %** is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.
     
     - **Finish allowance** (see page 994) — Controls how much material to leave for the finishing pass. By default this is 0.02.

1. Generates a finishing pass. By default, the bottom is not finished. The roughing tool removes all of the material in Z. This is controlled by **Finish bottom** (see page 936). Setting the **Single Point Bore option** for a step disables the other finishing options.
   
   The important aspects of finishing are:
Tool selection, after roughing, the roughing tool is used to finish the Step Bore unless it is finished as a Single Point Bore. Use finish tool (see page 936) commands FeatureCAM to choose a separate finishing tool (that has the same characteristics unless you override them).

Ramp on has the finish pass ramp into the material with an arc equal to a percentage of the tool diameter.

   Disabled for a Single Point Bore finish operation.

Finish passes and overlap has the tool go around the step a number of times set by Finish passes (see page 994), and overlaps the starting point by an amount controlled by Finish overlap (see page 994).

   Disabled for a Single Point Bore finish operation.

Ramp off uses another arc of the same size as the ramp on to move the tool away from the finished wall.

   Disabled for a Single Point Bore finish operation.

Retract removes the tool from the stock area and sets up for the next operation.

The Step Bore feature may also be used to produce a single depth round pocket.

A Step Bore feature initially has two steps. Delete the second step and enter the dimensions for your round hole as the first step.

You can edit this process in these places:

- To edit all instances of this type of feature in the current document, use the Machining Attributes dialog.
- To edit a single feature, use the Tools, Milling, Strategy, and Misc. property tabs for the feature in the Feature Properties (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

Creating a Step Bore feature

To create a Step Bore feature:

1. Click the Features step in the Steps panel.
This displays the **New Feature** wizard.

![New Feature wizard](image)

2. Select **Step Bore** and click **Next** to open the **New Feature - Dimensions** page.

![New Feature - Dimensions](image)

The default Step Bore feature has two steps. Each step corresponds to a row of the table.

**To modify the top step:**

1. Click the top row in the dialog. The initial values for this step are entered into the dimensioned drawing.

2. Edit the **Diameter**, **Radius** (see page 733), and **Depth** for this step.
The depth is measured from the top of the Step Bore feature, not the top of the current step.

3 Chamfer — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

4 Optionally select Through and Single Point Bore:
   - Through — This sets the display of the Step Bore without a bottom.
     Selecting Through does not make the feature pass all the way through the stock. You must set the depth value deep enough.
   - Single Point Bore — This sets the step to be finished with a boring bar. This mills the step to a tight tolerance. Select the option if you want to finish the step with this technique.

5 Click Set to update the values in the table.

6 To modify the second step, repeat this process on the second row of the table.

To add an additional step:
1 Click the row in the table after which you want to insert.
2 Enter the parameters and click Add to insert the step parameters into the table.

To delete a step:
1 Select the row in the table.
2 Click Delete.

When you have finished entering the Step Bore dimensions:
1 Click Next and to open the New Feature - Location (see page 534) page and set the location of the center of the top bore.
2 Click Next to specify more manufacturing details or click Finish to accept FeatureCAM’s automatic selections.

You can edit (see page 884) the feature later.

Dimensions that have blue labels can be extracted from objects in the graphics window.

Thread Mill

The Thread Mill feature mills a thread on an inner diameter (ID) or on an outer diameter (OD).
FeatureCAM follows this process to create a single **Thread Mill** feature:

1. An appropriate tool is selected. The tool selected by default has:
   - the same pitch as the thread.
   - the internal/external classification matches the feature.
   - an overall length greater than the thread length.

   *If the thread is tapered, the tool must have the same taper.*

   *A tool with a longer cutter length is preferred.*

2. Using the Feed/Speed tables (see page 1508), calculates feeds and speeds based on the stock material being machined.

3. The tool then ramps onto the feature according to the attributes (see page 674).

4. The tool spirals either up or down the feature depending on the setting of Feed Dir (see page 936). Cutter compensation is used on the toolpaths if cutter comp (see page 936) is turned on. Both of these settings are found on the **Strategy** page.
The overlap between revolutions is controlled by the Tooth overlap attribute.

1 Thread feature
2 Tool revolution 1
3 Tool revolution 2
4 Tooth overlap

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Milling tab.

1 The tool then ramps out. This move is controlled by the same attributes as the ramp in.

Thread Milling restrictions — The toolpaths are accurate for UN or ISO metric threads. Adjustments must be made to the thread height or diameter to adjust for the different thread forms.

Creating a Thread Mill feature

1 Create a rounded Step Bore (see page 668) or Pocket (see page 702) feature or a round Boss (see page 682) to thread.

2 Click the Features step in the Steps panel.
This displays the **New Feature** wizard.

3 Select **Thread Milling** and click **Next** to open the **New Feature - Dimensions** page.

4 Specify the Thread dimensions:
   - **Type** — Select **ID** for an inner diameter thread or **OD** for an outer diameter thread.
   - **Custom** — Enter the thread dimensions.
   - **Standard Thread** — Select a thread from the list to use its dimensions.
• **Thread** — Select a **Left hand** or **Right hand** thread. When viewed from the end of the part toward the chuck, on a left hand thread the tool winds counter-clockwise as it moves towards the chuck, on a right hand thread the tool winds clockwise as it moves towards the chuck.

• **Minor/Major Diameter** — Enter the **Minor Diameter** for an ID feature or the **Major Diameter** for an OD feature.

• **Pitch** — Enter the pitch of the thread.

• **Thread Length** — Enter the length of the thread.

• **Thread Height** — Enter the height of the thread.

• **Tapered** — If your thread is tapered, select this option and enter the taper **Angle**.

  Tapered taps are driven to a different depth than straight taps. For straight taps, a tip allowance is added to the thread depth so that the tool cuts the complete thread, this is not added for tapered taps so that the OD is not affected.

5 Click **Next** to open the **New Feature - Location** (see page 534) page to set the location of the center of the top of the feature.

6 Click **Next** to open the **New Feature - Strategies** (see page 537) page.

7 Click **Next** to open the **New Feature - Operations** (see page 564) page.

8 Click **Next** to open the **New Feature - Default Tool** (see page 564) page.

9 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page.

10 Click **Next** to open the **New Feature - Summary** (see page 567) page.

11 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

   *You can edit (see page 884) the feature later.*

**Thread Milling feature-level attributes**

The following feature-level attributes are relevant to thread mill features:

- **Helix linear approx tol**
- **Helical ramping**
- **Linear approx**
- **Linear ramp distance**
Plunge point(s)
Priority
Ramp angle offset
Ramp diameter %
Retract point
Start angle
Start threads
Taper approx angle
Through
Tooth outside
Tooth overlap

Set these attributes on the **Milling** (see page 994) tab of the **Thread Milling Properties** dialog.

The **Feed Dir** attribute is also relevant. Set this on the **Strategy** (see page 936) tab of the **Thread Milling Properties** dialog.

**Thread Milling manufacturing attributes**

The following machine-level manufacturing attributes are relevant to thread mill features:

- **Cutter comp**
- **Finish allowance**
- **Linear ramp distance**
- **Ramp angle offset**
- **Ramp diameter %**
- **Starts**
- **Start angle**
- **Taper approx. angle**
- **Through**
- **Tooth outside**
- **Tooth overlap**

Set these attributes on the **Thread Mill** (see page 1660) tab of the **Machining Attributes** dialog.
**Face (mill)**

FeatureCAM has a fully integrated Face feature performed with facing tools, and uses the facing feeds and speeds provided in the database.

1 - Thickness

Facing removes all of the stock down to the \( Z=0 \) plane.

*If your stock does not extend above the \( Z=0 \) plane, or you do not set a negative Z value for the feature, the machining simulation does not show cut movements.*

Curves for a Face feature define the regions to be faced. Curves must be closed (beginning and end points are the same).

FeatureCAM typically follows this process to create a Face feature:

1. Selects a face mill tool from the current tool crib using the tool diameter and cutter height as the selection criteria.
   - Tool diameter is usually large for face operations as there are no tight spots or complex shapes to create.
   - Cutter height is usually small for facing tools. This prevents them from being used to cut inappropriately deep features and affects how many passes it might take to face the stock.

   If a tool that meets the criteria cannot be found, an error is displayed and NC code is not generated.

   *You can change the default tool on the Default Tool page (see page 564) of the New Feature wizard (see page 531).*

2. Using the Feed/Speed tables (see page 1508), calculates feeds and speeds based on the stock material being machined.

3. Generates a facing pass, possibly in multiple Z steps depending upon the amount of material to remove. Face features can contain both a Rough and Finish pass.

   The important aspects of a face operation are:
   - Getting to depth — The tool needs to get to depth. This is accomplished by a plunging move.
• Vertical step — The Rough pass can have vertical steps that are controlled by the **Rough pass Z increment** (see page 1161) attribute.

• Horizontal stepover is controlled in both the X and Y directions with **Last pass overcut %** (see page 994) and **Lateral overcut %** (see page 994).

• **Finish allowance** — The Rough pass takes into account the **Finish allowance** (see page 1161) attribute, which controls how much material to leave for the finishing pass.

• Retract removes the tool from the stock area and sets up for the next operation.

4 Performs a finish pass for the final cut.

There are some variations on this process. The process can be controlled in the **Stepover** tab (see page 1618) of the **Machining Attributes** dialog, and on the **Tools, Milling, Strategy**, and **Misc** property tabs of the **Feature Properties** dialog (see page 884). The tooling database also affects the decisions.

**See also:**

Tool Groups (see page 1751) for details on the different tooling types.

FeatureMILL 2D Milling algorithms (see page 716).

*Creating a Face feature*

To create a Face feature:

1 Click the **Features** step in the **Steps** panel.
2 In the **From Dimensions** section, select **Face**.

3 Optionally select **Extract with FeatureRECOGNITION** to recognize a Face feature from a solid (see page 525) (REC).

4 Click **Next** to open the **New Feature - Location** (see page 534) page.

5 Click **Next** to open the **New Feature - Dimensions** page.

![New Feature Dimensions](image)

*If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.*

6 Enter the **Thickness** of the Face feature.

7 Click **Next** to open the **New Feature - Strategies** (see page 537) page.
8 Click **Next** to open the **New Feature - Operations** (see page 564) page.

9 Click **Next** to open the **New Feature - Default Tool** (see page 564) page.

10 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page.

11 Click **Next** to open the **New Feature - Summary** (see page 567) page.

12 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

**Boss**

The Boss feature removes all material between the boss curve and the stock boundary.

1. Chamfer
2. Height
3. Bottom radius

To create multiple bosses on a surface, use multiple curves to create one boss feature only. This prevents the toolpaths from overlapping with each other, and enables you to specify the material you want to remain unmachined. None of the boss curves should intersect or contain each other. When building multiple bosses at the same height in the part, include all of the boss curves in the same Boss feature.

Boss features remove material all the way to the stock boundary, including any other features you may have placed above the boss shoulder height. To limit the area milled away by the Boss feature, use a stock curve (see page 224), or set the **Total Stock** (see page 1161) attribute.

If you use a , the toolpaths are trimmed to the stock to prevent air cutting.

FeatureCAM follows this general process to create a Boss feature:
1 Conducts an analysis of the curve and, using tool diameter and length as the selection criteria, determines the tool to use.
   - For tool diameter, FeatureCAM analyzes the curve that defines the Boss and selects the largest tool that can cut the boss without gouging. (see Tool % of arc radius (see page 973)).
   - For tool length, FeatureCAM picks a tool that has flutes long enough to cut to the bottom of the Boss height.

If a tool that meets the criteria cannot be found, an error is displayed and NC code is not generated.

Endmills are automatically selected for the roughing and finishing passes, but you can override the automatically (see page 682) selected tool to specify a face mill.

2 Chooses feeds and speeds using the Feed/Speed database (see page 1508) that you can customize. Feeds and speeds are determined based upon the stock material.

3 Performs a roughing pass, possibly in multiple Z steps based on the height of the Boss.

   The important aspects of roughing are:
   - **Getting to depth** — The tool needs to get to depth, and this can be accomplished by a zigzag in Z (the default setting and influenced by Max ramp angle), by plunging, or by pre-drilling (see Pre-drill diameter (see page 1161) and Pre-drill point (see page 994)).

   Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.
   - **Vertical step** — The rough pass can have vertical steps with cut depth not more than 100% of the tool radius (see Rough depth (see page 994) and Rough pass Z increment (see page 994)).
   - **Horizontal stepover** — FeatureCAM moves over laterally a percentage of the tool diameter (controlled with Rough pass %), as it steps across the feature.

   **Spiral %** is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.
   - **Finish allowance** — The rough pass contains a Finish allowance attribute which controls how much material to leave for the finishing pass. By default this is 0.02.
Performs a finishing pass. By default, the bottom is not finished. The roughing tool removes all of the material in Z. This is controlled by **Finish bottom**, which finishes the bottom of a feature with a flat endmill up to the beginning of any bottom radius if present.

The important aspects of finishing are:

- **Tool selection** — After the roughing pass, the roughing tool is used to finish the boss. **Use Finish Tool** (see page 936) commands FeatureCAM to choose a separate finishing tool (that has same characteristics unless you override them).

- **Ramp on** — The finish pass ramps into the material with an arc equal to a percentage of the tool diameter (see **Ramp diameter** (see page 994)).

- **Finish passes and overlap** — The tool goes around the boss a number of times set by **Finish passes** (see page 994), and overlaps the starting point by an amount controlled by **Finish overlap** (see page 994).

- **Ramp off** — Uses another arc of the same size as the ramp on to move the tool away from the finished wall.

- **Retract** — Removes the tool from the stock area and sets up for the next operation.

You can edit this process in these places:

- To edit all instances of this type of feature in the current document, use the **Machining Attributes** dialog.

- To edit a single feature, use the **Tools, Milling, Strategy, and Misc.** property tabs for the feature in the **Feature Properties** (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

To create multi-height Boss features or islands in a Pocket feature with different heights:

1. Create the curves for the Boss or island and translate it to its proper location in Z.

2. Use this curve as a Boss curve or island curve for a pocket.

**See also:**

FeatureCAM 2.5D Milling algorithms (see page 716)
Tool override options

<table>
<thead>
<tr>
<th>Operation type</th>
<th>Automatically selected tool</th>
<th>Possible user overrides</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roughing</td>
<td>endmill</td>
<td>face mill, endmill</td>
<td></td>
</tr>
<tr>
<td>Finishing</td>
<td>endmill</td>
<td>face mill, endmill</td>
<td></td>
</tr>
<tr>
<td>Chamfer</td>
<td>chamfer mill</td>
<td>spotdrill, centerdrill, countersink, chamfer mill</td>
<td></td>
</tr>
</tbody>
</table>

See also:
Tool Groups (see page 1751) for details on the different tooling types.

Creating a Boss feature

1. Click the **Features** step in the **Steps** panel. This displays the **New Feature** wizard.

2. Select **Boss** and click **Next** to open the **New Feature - Curves** (see page 533) page.

3. Select the curve that represents the shape of the feature. The curve you select controls the shape of the Boss feature.
If you have multiple features at the same height, you can create them as one feature by selecting multiple curves.

4. Click Next to open the New Feature - Location page.

5. Click Next to open the New Feature - Dimensions page.

If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.

- Enter the Height of the boss. This sets the overall height of the boss.
- **Bottom Radius** — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing step pass is made with the radiused mill. The default value is 0, which cuts a square corner.
- **Draft angle** — Optionally set an angle for the feature wall. Use only positive numbers.
- **Chamfer** — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

6. Click Next to open the New Feature - Strategies (see page 537) page.

7. Click Next to open the New Feature - Operations (see page 564) page.

8. Click Next to open the New Feature - Default Tool (see page 564) page for the first operation.

9. Click Next to open the New Feature - Feed/Speed (see page 567) page for the first operation.
10 If you have more than one operation, clicking Next opens the New Feature - Default Tool page for the next operation. If you have no more operations, clicking Next opens the New Feature - Summary (see page 567) page.

11 Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

You can edit (see page 884) the feature later.

By default, a boss uses the stock boundary as the outer extent of the feature. To bound the extent of the boss cut:

1 After you have created the feature, open the Feature Properties (see page 884) dialog and click the Dimensions (see page 905) tab.

2 Click the Stock curve button. Select the name of the curve you want to use as the outer extent of the boss.

If Stock Boundary is selected, it indicates that the stock boundary is used as the outer extent. The stock boundary is automatically used as the outside extent of the boss only when the current UCS is parallel to one of the block faces. If your UCS is not parallel to a stock face, boss features need to include a stock curve with them.

3 If you want the wall of your feature to have a special cross section, click the X Section (see page 928) button to open a dialog to select the curve that matches your cross-section shape.

4 Click OK.

Chamfer

The Chamfer feature creates an edge break along a curve with a chamfering tool. To chamfer the entire upper edge of a curved feature, use the optional Chamfer parameter on that feature. Use the Chamfer feature to chamfer only a portion of the edge of a feature.

1 - Width
FeatureCAM follows this general process to create a Chamfer feature:

1. Chooses a chamfermill tool (see page 1755) automatically from the current tool crib, based on:
   - the width and depth of the Chamfer,
   - the tightest bend in the curve,
   - and the corner radius and inner diameter of the rounding tool.

   FeatureCAM considers the tool and inner diameter to pick a tool that has the exact width definitions to cut the Chamfer feature. The inner radius of the tool is important because the tool must fit into tight corners of the curve.

   The width of the tool must be large enough to cut the depth and width set for the chamfer.

If a tool that meets the criteria cannot be found, an error is displayed and NC code is not generated.

You can override the automatic tool selection and select a countersink tool (see page 1758). If you are using a countersink tool, you may need to adjust your touch-off point to mill an accurate chamfer.

You can change the default tool used for chamfer operations on the Tool Selection tab (see page 1676) of the Machining Attributes dialog.

2. Determines feeds and speeds based on the stock material being machined. FeatureCAM chooses feeds and speeds for all of its milling using the Feed/Speed database (see page 1508) that you can customize.

3. Generates a roughing pass.

   The important aspects of roughing are as follows:
   - **Getting to depth** — The tool needs to get to depth. This is accomplished by a plunging move.
   - **Horizontal step** — The horizontal step size is controlled by the Distance between cuts attribute on the Stepovers tab (see page 985). If there is only one pass, there is no horizontal step move.
For roughing, the **Distance between cuts** is the horizontal distance between roughing toolpaths. The automatically calculated distance is based on the setting of Rough pass stepover %. For finishing, it is fixed to be the Finish allowance (see page 994). See Default ramping for milled finish passes (see page 993) for more information on finish pass ramping.

For Chamfers and Rounds this attribute enables multiple rough or finish passes. The default value for roughing is the radius of the Round feature or the largest dimension of the Chamfer feature. The default value for finishing is the Finish allowance (see page 994). By decreasing this value multiple roughing or finishing passes are created by stepping in horizontally.

- **Finish allowance** — The **Facing** parameter that determines the amount of material to leave after the roughing pass. By default this is **0.02**.

1 Generates a finishing pass. By default, the finish pass is turned off and the entire feature is machined by the roughing pass. You can change this on the **Strategy** page.

The important aspects of finishing are:

- **Tool selection** — After roughing, the roughing tool is used to finish the Chamfer. Use **Finish Tool** (see page 936) commands FeatureCAM to choose a separate finishing tool (that has the same characteristics unless you override them).

- **Horizontal step** — The horizontal step size is controlled by the **Distance between cuts** attribute on the **Stepovers** tab (see page 985). With only one pass, there is no horizontal step. The contact point of the tool is controlled by the **Through depth** attribute.

For roughing, the **Distance between cuts** is the horizontal distance between roughing toolpaths. The automatically calculated distance is based on the setting of Rough pass stepover %. For finishing, it is fixed to be the Finish allowance (see page 994). See Default ramping for milled finish passes (see page 993) for more information on finish pass ramping.

For Chamfers and Rounds this attribute enables multiple rough or finish passes. The default value for roughing is the radius of the Round feature or the largest dimension of the Chamfer feature. The default value for finishing is the Finish allowance (see page 994). By decreasing this value multiple roughing or finishing passes are created by stepping in horizontally.

- **Finish passes and overlap** — The tool goes around the chamfer a number of times set by **Finish passes** (see page 994), and overlaps the starting point by an amount controlled by **Finish overlap** (see page 994).
• **Retract** — This removes the tool from the stock area and sets up for the next operation.

You can edit this process in these places:

• To edit all instances of this type of feature in the current document, use the **Machining Attributes** dialog.

• To edit a single feature, use the **Tools, Milling, Strategy, and Misc.** property tabs for the feature in the **Feature Properties** (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

**Creating a Chamfer feature**

1. Click the **Features** step in the **Steps** panel.
   
   This displays the **New Feature** wizard.

2. Click **Chamfer** and then click **Next** to open the **New Feature - Curves** (see page 533) page and select a curve from the **Curve** list.

3. Click **Next** to open the **New Feature - Machining Side** (see page 534) page.

4. Click **Next** to open the **New Feature - Location** (see page 534) page.
5 Click Next to open the New Feature - Dimensions page.

![New Feature - Dimensions](image)

If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.

Select the Select the chamfer type:

- **2D Chamfer** — Create a chamfer on a curve in the XY plane.
  
  For a 2D Chamfer, enter the **Width** and **Depth** of the chamfer edge break. **Width** and **Depth** settings are related to each other as they must match the shape of a tool you have in your tool crib in order to cut the described chamfer. For a 45° tool, **Width** and **Depth** must be equal.

- **3D Chamfer** — Create a chamfer on a planar curve that is not in the XY plane, or on a non-planar curve.
  
  For a 3D Chamfer, enter the **Depth** and **Tip offset**.

A 3D milling license is required to create chamfers on non-planar curves.

6 Click Next to open the New Feature - Strategies (see page 537) page.

7 Click Next to open the New Feature - Operations (see page 564) page.

8 Click Next to open the New Feature - Default Tool (see page 564) page.

9 Click Next to open the New Feature - Feed/Speed (see page 567) page.

10 Click Next to open the New Feature - Summary (see page 567) page.

11 Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.
You can edit (see page 884) the feature later.

3D Chamfer tips

- The 3D Chamfer feature works best with small chamfer sizes, as an edge break simply to remove a sharp burr. The toolpath produces only an approximation of a 3D chamfer and the width of the chamfer varies based on the geometry of the 3D curve and the surrounding surfaces. At larger chamfer depths the variation in size of the chamfer is magnified.

- The current toolpath uses an XY offset (from the top view) of the 3D curve. The direction of this offset is determined by the Machining Side (see page 534) chosen for each curve. If the part requires the chamfer tool to be on one side of the curve in one region and the other side of the curve in another region, the full chamfer cannot be cut with this technique. In these situations it may be possible to split the chamfer curve into multiple curves and use different machining sides for each curve, but this may still prove difficult. A better solution, if possible, is to change the Setup (5-axis position, index angle, B-axis angle and so on.) so that the Machining Side becomes consistent for the whole curve when viewed in the new orientation.

- When using a spotdrill, the more the edge break deviates out of the XY plane, the worse the results are. For this reason a ball-end mill is recommended when machining a 3D edge break that deviates significantly from the XY plane. This isn’t because of any deficiencies in our software, but due to the nature of the tool geometry in general. When using drills or chamfered tools, it is recommended that you use the smallest tool you can.

- To get the best result, adjust your index position so that the deviation from the XY plane is balanced along the extent of the curve.

- Selecting the part surfaces on either side of the chamfer, for best results. This is especially true if the curve has steep or vertical sections.

Groove

The Groove feature creates a groove of any shape. FeatureCAM enables you to create two types of Groove feature. They are:

- Face (see page 690) grooves (Regular and Simple).
- Inside/outside (see page 695) grooves (Simple only).
The centerline of a Groove is defined by a curve. Select more than one curve if you want to create multiple grooving cuts with one Groove feature. The curves can be open (ends do not touch) or closed (beginning and end points are the same).

**Face grooves**

Face groove properties:
- They can be of any shape and can even intersect with itself.
- Regular grooves can be cut to any width using multiple passes.
- If the groove is Simple, the curve can be 3D.

Face grooves can be:

Regular Face grooves — These can have a **Width**, **Depth**, **Bottom Radius**, and **Chamfer**.

Simple Face grooves — These cannot have a **Chamfer**.
Simple face grooves are cut with one horizontal pass, with a tool, whose diameter matches the groove's width. For one-pass engraving, select a **Simple** groove; this performs a single manufacturing pass along the curve.

*Plunge points* (see page 994) and ramping parameters are ignored for **Simple** grooves.

**Regular Face grooves**

Regular grooves are machined similarly to pockets, and include both a roughing and a finishing pass.

For a regular groove, FeatureCAM uses the following process:

1. Determines the type of tool to use based on the groove width and depth. Using the tool diameter and tool length as the tool selection criteria, selects the tool from the current tool crib.
   - For tool diameter FeatureCAM uses the width of the groove to determine what diameter tool to use. The tool needs to fit into the groove, but still allow room for a finish allowance on both walls of the groove.
   - For tool length FeatureCAM picks a tool that has flutes long enough to reach the bottom of the groove.

   *If a tool that meets the criteria cannot be found, an error is displayed and NC code is not generated.*

   *You can override the automatically (see page 682) selected tool.*

2. Chooses feeds and speeds using the Feed/Speed database (see page 1508) that you can customize. Feeds and speeds are determined based upon the stock material.

3. Performs a roughing pass, possibly in multiple Z steps depending upon the depth of the groove.

   The important aspects of roughing are as follows.
   - **Getting to depth** — The tool needs to get to depth, and this can be accomplished by a zigzag in Z (the default setting and influenced by Max ramp angle), by plunging, or by pre-drilling (see Pre-drill diameter (see page 1161) and Pre-drill point (see page 994)).

   Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.

   *Zigzag is not an option if the groove has no linear portion. Simple grooves support only plunging.*
• **Vertical step** — The rough pass can have vertical steps with cut depth not more than 100% of the tool radius (see **Rough depth** (see page 994) and **Rough pass Z increment** (see page 994)).

• **Horizontal stepover** — Although not typically necessary, FeatureCAM can perform a horizontal stepover to manufacture a groove. FeatureCAM moves a percentage of the tool diameter laterally (controlled with Rough pass %), as it steps across the feature.

*Spiral %* is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.

• **Finish allowance** — The rough pass contains a **Finish allowance** attribute which controls how much material to leave for the finishing pass. By default this is 0.02.

1 Performs a finishing pass. By default, the bottom is not finished. The roughing tool removes all of the material in Z. This is controlled by **Finish bottom** (see page 936).

• **Tool selection** — After the roughing pass, the roughing tool is used to finish the boss. **Use finish tool** (see page 936) commands FeatureCAM to choose a separate finishing tool (that has same characteristics unless you override them).

• **Ramp on** — The finish pass ramps into the material with an arc equal to a percentage of the tool diameter (see **Ramp diameter** (see page 994)).

• **Finish passes and overlap** — The tool goes around the groove a number of times set by **Finish passes** (see page 994), and overlaps the starting point by an amount controlled by **Finish overlap** (see page 994).

• **Ramp off** — Another arc of the same size as the ramp on moves the tool away from the finished wall.

• **Retract** — This removes the tool from the stock area and sets up for the next operation.

You can edit this process in these places:

• To edit all instances of this type of feature in the current document, use the **Machining Attributes** dialog.

• To edit a single feature, use the **Tools, Milling, Strategy, and Misc.** property tabs for the feature in the **Feature Properties** (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.
Simple face grooves

Simple face grooves, also called engraving grooves, offer a single-pass approach to milling a groove. Simple face grooves are cut with one horizontal pass with a tool whose diameter matches the groove's width.

Plunge points (see page 994) and ramping (see page 994) parameters are ignored for Simple grooves.

For a simple groove, FeatureCAM uses the following process:

1. Determines what tool to use based only on the groove width. This is the same as for a regular groove (see page 691), except that the tool diameter must equal the groove width. You can override the automatically (see page 682) selected tool.

2. Uses slotting feeds and speeds based upon the material being machined. This is the same as for a regular groove, except that slotting feeds and speeds are used.

3. Generates a single pass, possibly in multiple Z steps depending on the depth of the groove. Roughing and finishing are performed in a single pass. There is only one operation shown in the tree view, and it is called Slot. The critical aspects are as follows.

   - **Getting to depth** — The tool needs to get to depth. This is accomplished by a plunging move.
   - **Direction of cut** — This can be controlled on the Strategy page.
   - **Horizontal stepover** — Is not available for this feature type. The tool diameter must be equal to the groove width.
   - **Finish allowance** — Is not available for this feature type. The tool diameter must be equal to the groove width.

3D simple face grooves are approximated with lines and arcs, if the arcs lie in the XY, YZ or XZ planes.
Simple grooves have an option of using a trochoidal toolpath. Instead of a simple slotting cut, the tool uses a series of circles to clear away the metal, as shown below. This toolpath has the advantage of reducing the load on the tool.

Using zigzag ramping to mill a helical path for a simple Groove

Zigzag ramping can be used with a simple Groove feature to create a generalized helical toolpath.

To produce this toolpath:

1. Set Max ramp angle to 90°.
2. Set Max ramp distance to a very large number like 1000.
3. Set Rough pass Z increment to a value less than the depth of the feature. In one pass around the Groove, the tool spirals down in Z an amount equal to Rough pass Z increment.

An alternative way to create the generalized helical toolpath is to:

1. Set Max ramp distance to 1000.
2. Set Rough pass Z increment to the depth of the feature.
3. Use the Max ramp angle to control the slope of the toolpath.
Inside/Outside grooves

Inside/Outside grooves are side grooves machined using keyseat cutters, and include both a roughing and finishing pass.

They can:

- be of any non-intersecting shape that is open enough to allow a cutter to enter, operate, and exit;
- only cut to widths of tools you have available;
- and only cut to the tool's shape by default.

If you load special tools and create multiple grooves, you can achieve special effects.

For an ID/OD groove, FeatureCAM uses the following process:

1. Determines what tool to use based on the width and depth of the groove, and from the current tool crib, picks a keyseat tool using the length and diameter as the tool selection criteria.
   - Tool length is determined based on the depth of the groove. The tool needs to fit all the way into the depth of the groove. If multiple steps need to be taken to manufacture the groove, then those steps can be made to reach the full depth.
   - Tool width is matched to the width of the groove within a small tolerance. If the groove is too big, then you get a tool selection error.

   If a tool can't be found that meets the criteria, then you get an error and NC code isn't generated.

2. Chooses feeds and speeds for milling using the customizable Feed/Speed database (see page 1508). Feeds and speeds are determined based on the stock material.
3 Generates a roughing pass. The groove is first cut down the center of the groove, with subsequent passes alternating on either side of the center. Different allowances are possible on the walls and bottom (see page 994) of the groove.

The amount of material to leave on the walls of an ID/OD groove.

The important aspects of roughing are as follows:

- **Getting to depth** — There are two aspects to getting the keyseat cutter to depth. The tool must first move down in Z, and then it must plunge into the metal. For the down move, the keyseat cutter simply plunges down. You must have air underneath the cutter for this move. You may set the pre-drill point to determine where the keyseat cutter is lowered in Z. Then the tool plunges into the material horizontally. There are no options to control the plunge into the material.

- **Vertical step** — No vertical steps are taken. You get a tool selection error if the tool width is not exactly as wide as the groove.

- **Horizontal stepover** — Rough pass stepover can override the horizontal stepover into the groove. Otherwise FeatureCAM automatically takes as many steps as it needs to cut to the full depth of the groove. The default is 33% of the tool diameter.

Spiral % is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.

- **Finish allowance** — The Facing parameter that determines the amount of material to leave after the roughing pass. By default this is 0.02.
1 Generate a finishing pass. The finishing pass is based on the Finish walls (see page 969) and Wall pass attributes.

**Wall pass** applies only to the finishing passes of milling features where the bottom is finished.

If Wall pass is disabled, then the floor is finished all the way out to the wall in a single pass. The wall is not finished separately.

For OD/ID grooves if this attribute is selected, then the bottom is finished separately from the walls of the groove.

- **Tool selection** — After roughing, the roughing tool is used to finish the groove. Use Finish Tool (see page 936) commands FeatureCAM to choose a separate finishing tool (that has the same characteristics unless you override them).

- **Ramp on** — This makes the finish pass ramps into the material with an arc equal to a percentage of the tool diameter (see Ramp diameter (see page 994)).
- **Finish passes and overlap** — The tool goes around the groove a number of times set by **Finish passes** (see page 994), and overlaps the starting point by an amount controlled by **Finish overlap** (see page 994).

- **Ramp off** — This uses another arc of the same size as the ramp on to move the tool away from the finished wall.

- **Retract** — This removes the tool from the stock area and sets up for the next operation.

You can edit this process in these places:

- To edit all instances of this type of feature in the current document, use the **Machining Attributes** dialog.

- To edit a single feature, use the **Tools, Milling, Strategy**, and **Misc.** property tabs for the feature in the **Feature Properties** (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

**Creating a Groove feature**

To create a Groove feature:

1. Click the **Features** step in the **Steps** panel. This displays the **New Feature** wizard.

2. Click **Groove**, then click **Next** to open the **New Feature - Curves** (see page 533) page.
3 Click **Next** to open the **New Feature - Location** (see page 534) page.

4 Click **Next** to open the **New Feature - Dimensions** page.

![](image)

*If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.*

5 Select whether your groove is a **Face**, or **Inside/Outside** groove.

   - **Face** — This sets the groove to cut on the XY plane of the current Setup.
   - **Inside/Outside** — This sets the groove to run on the inside or outside of a closed curve.

6 If you are creating a **Face** groove:

   - If your groove is a simple groove, select **Simple**. **Simple** designates the groove to be cut with a single pass along the curve with a tool diameter equal to the **Width** of the groove.
   - **Width** — Enter the width of the Groove feature.
   - Optionally select **Through** to change the modeling of the groove if it helps you display your part better.
     
     Through controls the graphical representation of the part. If **Through** is set, the **Curve Groove** is modelled with a bottom.
   - Optionally enter a **Bottom Radius** (see page 733).
   - For a non-simple groove, optionally enter a **Chamfer**, which sets the depth of a 45° chamfer cut at the top edge of the feature.

7 If you are creating an **Inside/Outside** groove:
- If the curve is at the bottom of the groove, select the **Curve at bottom** option.
- **Depth** — Enter the depth of the Groove feature.
- **Width** — Enter the width of the Groove feature.
- Click **Next** to open the **New Feature - Machining Side** (see page 534) and preview the groove in the Graphics window.
- An outside groove uses the curve as the outside of the groove. An inside groove uses the curve as the inside of the groove. Click the **Switch machining side** button to toggle between the two types of grooves.

8  Click **Next** to open the **New Feature - Strategies** (see page 537) page.
9  Click **Next** to open the **New Feature - Operations** (see page 564) page.
10 Click **Next** to open the **New Feature - Default Tool** (see page 564) page.
11 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page.
12 Click **Next** to open the **New Feature - Summary** (see page 567) page.
13 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

**Pocket**

The **Pocket** feature creates a pocket of any shape. If you want to create a simple pocket with a rounded-rectangular cross-section, use the **Rectangular Pocket** feature. A **Pocket** can have an arbitrary number of islands within the outer boundary.

1 - Chamfer
2 - Depth
3 - Bottom radius
The island curves must be contained within the boundary curve and the island curves may not touch.

FeatureCAM follows this general process:

1. Conducts an analysis of the curve and using tool diameter and length as the selection criteria, selects a tool from the current tool crib.
   - For tool diameter, FeatureCAM analyzes the curve that defines the pocket to determine what size tool to use. FeatureCAM uses the largest tool that can fit in the corner and the tightest passage of the feature. The largest tool that can cut the pocket without gouging is selected (See **Tool % of arc radius** (see page 973)).
   - For tool length, FeatureCAM picks a tool that has flutes long enough to cut to the bottom of the pocket.

2. Chooses feeds and speeds using the Feed/Speed database (see page 1508) that you can customize. Feeds and speeds are determined based upon the stock material.

3. Performs a roughing pass, possibly in multiple Z steps based on the height of the boss.

   The important aspects of roughing are:
   - **Getting to depth** — The tool needs to get to depth, and this can be accomplished by a zigzag in Z (the default setting and influenced by **Max ramp angle**), by plunging, or by pre-drilling (see **Pre-drill diameter** (see page 1161) and **Pre-drill point** (see page 994)).
     Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.
   - **Vertical step** — The rough pass can have vertical steps with cut depth not more than 100% of the tool radius (see **Rough depth** (see page 994) and **Rough pass Z increment** (see page 994)).
   - **Horizontal stepover** — FeatureCAM moves over laterally a percentage of the tool diameter (controlled with Rough pass %), as it steps across the feature.

   **Spiral %** is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.
   - **Finish allowance** — The rough pass contains a Finish allowance attribute which controls how much material to leave for the finishing pass. By default this is **0.02**.
1 Generates a finishing pass. By default, the bottom is not finished. The roughing tool removes all of the material in Z. This is controlled by Finish bottom (see page 936).

The important aspects of finishing are:

- **Tool selection** — After the roughing pass, the roughing tool is used to finish the pocket. Use Finish Tool (see page 936) commands FeatureCAM to choose a separate finishing tool (that has the same characteristics unless you override them).

- **Ramp on** — The finish pass ramps into the material with an arc equal to a percentage of the tool diameter (see Ramp diameter (see page 994)).

- **Finish passes and overlap** — The tool goes around the pocket a number of times set by Finish passes (see page 994), and overlaps the starting point by an amount controlled by Finish overlap (see page 994).

- **Ramp off** — Uses another arc of the same size as the ramp on to move the tool away from the finished wall.

- **Retract** — Removes the tool from the stock area and sets up for the next operation.

You can edit this process in these places:

- To edit all instances of this type of feature in the current document, use the Machining Attributes dialog.

- To edit a single feature, use the Tools, Milling, Strategy, and Misc. property tabs for the feature in the Feature Properties (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

### Creating a Pocket feature

To create a Pocket feature:

1 Click the **Features** step in the **Steps** panel.
This displays the **New Feature** wizard.

2 Select **Pocket** and then click **Next** to open the **New Feature - Curves** (see page 533) page. You can use one curve for the boundary, or if you have multiple pockets that have the same depth, you can select multiple curves. Press and hold the **Ctrl** key while you select the curves with the mouse to select multiple curves.

3 Click **Next** to open the **New Feature - Location** (see page 534) page. The **Location** page shows you the Z height of the curve. Enter an **offset** value if you want to change the height of the pocket.

4 Click **Next** to open the **New Feature - Dimensions** page.
If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.

- **Depth** — Enter the distance cut into the material in Z.
- **Draft angle** — Optionally set an angle for the feature wall. Use only positive numbers.
- **Chamfer** — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.
- **Bottom Radius** (see page 733) — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

5 Click **Next** to open the **New Feature - Strategies** (see page 537) page.

6 Click **Next** to open the **New Feature - Operations** (see page 564) page.

7 Click **Next** to open the **New Feature - Default Tool** (see page 564) page for the first operation.

8 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page for the first operation.

9 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

10 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

If you need to specify **Islands** for the pocket or a different cross section for the walls:

Islands are regions left uncut with a pocket. Island curves must be contained within the boundary curve and they cannot touch or overlap. Clicking **Islands** opens the **Select Islands** dialog. There are a number of methods of selecting curves in the select curve dialog box. To remove all of the islands from a pocket, click **Unselect All**.
1 After you have created the feature, open the **Feature Properties** (see page 884) dialog and click the **Dimensions** (see page 905) tab.

2 On the **Dimensions** tab, you can:
   - Set boundaries, defined by curves, that are not milled with the rest of the pocket.
   - Click **X section** (see page 928) to enter a cross section curve for the feature.

3 Click **OK**.

**Round**

A **Round** feature creates an edge break along a curve with a rounding tool.

The shape of the Round is defined by a curve. Select more than one curve if you want to create a Round along multiple curves with one feature. The curves can be open (the ends do not touch) or closed (the beginning and the end points are the same).

In general, FeatureCAM uses the following process to create a Round feature:

1 Conducts an analysis of the curve and based on the specified radius of the round and on the tightest bend in the curve, using corner radius and inner diameter of the rounding tool as the tool selection criteria, selects a tool from the current tool crib.
   - For corner radius, FeatureCAM picks a tool that has exactly the same corner radius as the Round feature.
   - For inner radius, FeatureCAM analyzes the curve that defines the rounds and determines the tool that fits into the tightest corners of the curve.
When no tool meets the criteria, an error is displayed and NC code is not generated.

2 Chooses feeds and speeds using the Feed/Speed database (see page 1508) that you can customize. Feeds and speeds are determined based on the stock material.

3 Generates a roughing pass. The important aspects of roughing are as follows:
   - **Getting to depth** — The tool needs to get to depth and this is accomplished by plunging.
   - **Vertical step** — There is no vertical step, but the horizontal step size is controlled by the Distance between cuts attribute on the Stepovers (see page 985) tab.

For roughing, the **Distance between cuts** is the horizontal distance between roughing toolpaths. The automatically calculated distance is based on the setting of Rough pass stepover %. For finishing, it is fixed to be the Finish allowance (see page 994). See Default ramping for milled finish passes (see page 993) for more information on finish pass ramping.

For Chamfers and Rounds this attribute enables multiple rough or finish passes. The default value for roughing is the radius of the Round feature or the largest dimension of the Chamfer feature. The default value for finishing is the Finish allowance (see page 994). By decreasing this value multiple roughing or finishing passes are created by stepping in horizontally.

   - **Finish allowance (see page 994)** — The rough pass contains a Finish allowance attribute which controls how much material to leave for the finishing pass. By default this is 0.02.

1 If activated, generates a finish pass. By default, the finish pass is turned off and the entire feature is machined by the roughing pass. This can be changed on the Strategy page.

The important aspects of finishing are:

   - **Tool selection** — After roughing, the roughing tool is used to finish the round. Use Finish Tool (see page 936) commands FeatureCAM to choose a separate finishing tool (that has the same characteristics unless you override them).

   - **Vertical Step** — There is no vertical step, but the horizontal step size is controlled by the Distance between cuts attribute on the Stepovers (see page 985) tab.
For roughing, the **Distance between cuts** is the horizontal distance between roughing toolpaths. The automatically calculated distance is based on the setting of Rough pass stepover %. For finishing, it is fixed to be the Finish allowance (see page 994). See Default ramping for milled finish passes (see page 993) for more information on finish pass ramping.

For Chamfers and Rounds this attribute enables multiple rough or finish passes. The default value for roughing is the radius of the Round feature or the largest dimension of the Chamfer feature. The default value for finishing is the Finish allowance (see page 994). By decreasing this value multiple roughing or finishing passes are created by stepping in horizontally.

- **Finish passes and overlap** — The tool goes around the Round a number of times set by **Finish passes** (see page 994), and overlaps the starting point by an amount controlled by **Finish overlap** (see page 994).

- **Retract** — Removes the tool from the stock area and sets up for the next operation.

You can edit this process in these places:

- To edit all instances of this type of feature in the current document, use the **Machining Attributes** dialog.

- To edit a single feature, use the **Tools, Milling, Strategy, and Misc.** property tabs for the feature in the **Feature Properties** (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

---

**Creating a Round feature**

To create a Round feature:

1. Click the **Features** step in the **Steps** panel.
This displays the **New Feature** wizard.

2 Select **Round**, then click **Next** to open the **New Feature - Curves** (see page 533) page.

3 Click **Next** to open the **New Feature - Machining Side** (see page 534) page.

4 Click **Next** to open the **New Feature - Location** (see page 534) page. The **Location** page shows you the Z height of the curve. Enter an **offset** value if you want to change the height of the round.

5 Click **Next** to open the **New Feature - Dimensions** page.

![New Feature - Dimensions](image)

*If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.*

1 Enter a value for the **Radius** of the edge break. This corresponds to the radius of the rounding tool selected to cut the feature.
2 Click **Next** to open the **New Feature - Strategies** (see page 537) page.

3 Click **Next** to open the **New Feature - Operations** (see page 564) page.

4 Click **Next** to open the **New Feature - Default Tool** (see page 564) page for the first operation.

5 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page for the first operation.

6 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

7 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

> *You can edit (see page 884) the feature later.*

### Side

The Side feature provides low-level manufacturing control when you need customized manufacturing that is not addressed by either the Boss feature or the Pocket feature.

![Diagram](image)

1 - Chamfer
2 - Depth
3 - Bottom radius

The Side feature is useful for:

- Outside part boundaries where the Side feature has special attributes for controlling the starting point of the cut and for controlling the region that is cut.
- Features defined by open curves have endpoints which do not meet.

The region that is cut for a **Side** feature is controlled by one of the following:

- The stock boundary, which is extracted automatically for you if you do not explicitly specify a **Stock Curve**.
- The **Stock Curve** that you provide for the Side feature.
- The offset distance specified by the **Total Stock** attribute.

If you set the **Total Stock** attribute to a positive number, then a roughing pass and finish pass are performed in the region between your Side feature and a curve offset by the **Total Stock** value. To perform only a single pass around your feature, set the **Total Stock** attribute to a positive value and set **Finish Allowance** to 0 to turn off the finish cut.

*Do not create a Side feature from a curve that extends more than a tool radius from the stock boundary. The manufacturing of these features is unpredictable. To correct this problem, move your curve onto the stock boundary or to within a tool radius of the boundary.*

If you use a Side feature with a stock solid (see page 223), the toolpaths are trimmed to the stock to prevent air cutting.

FeatureCAM follows this general process to create a **Side** feature:

1. Conducts an analysis of the curve and using tool diameter and length as the selection criteria, selects a tool from the current tool crib. The most important criteria are diameter and length.
   - For tool diameter, FeatureCAM analyzes the curve that defines the Side to determine what size tool to use. The smallest corner and tightest passage determine the largest tool that can cut the Side without gouging (See **Tool % of arc radius** (see page 973)).
   - For tool length FeatureCAM picks a tool that has flutes long enough to cut to the bottom of the side.

   If no tool meets the criteria, an error is displayed and NC code is not generated.

2. Chooses feeds and speeds for all of its milling using the Feed/Speed database (see page 1508) that you can customize. Feeds and speeds are determined based on the stock material.

3. Generates a roughing pass, possibly in multiple Z steps based on the depth of the Side feature.

   The important aspects of roughing are:
   - **Getting to depth** — The tool needs to get to depth, and this is accomplished by a zigzag in Z (the default setting and influenced by **Max ramp angle**), by plunging, or by predrilling (see **Pre-drill diameter** (see page 1161) and **Pre-drill point** (see page 994)). For open curves, **Lead distance** and **Lead in/out** angles control the horizontal approach to the material.
The **Lead-out angle** applies only over the **Lead-out distance**, so if the **Lead-out distance** is **0**, the **Lead-out angle** has no effect. The **Lead-out angle** is applied to the end of the finish pass for an open toolpath. It also applies to the last toolpath of a roughing pass if the **Finish allowance** is set to **0**.

The **Lead-in angle** applies only over the **Lead-in distance**, so if the **Lead-In distance** is **0**, the **Lead-in angle** has no effect.

**Lead distance in/out** is the linear distance that a tool path extends beyond the ends of an open toolpath or toolpaths that are clipped against the stock profile. This parameter is specified as a percentage of the tool's diameter. If **Lead Distance** is set to **0.0**, the toolpath starts or stops exactly at the ends of the profile.

Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to **0** to cause a plunge cut.

- **Vertical step** — FeatureCAM's cut depth is no more than 100% of the tool radius (see **Rough depth** (see page 994) and **Rough pass Z increment** (see page 994)).

- **Horizontal stepover** — FeatureCAM moves over laterally a percentage of the tool diameter (controlled with **Rough pass %**) as it steps across the feature.

**Spiral %** is the percentage of tool diameter to use for radial depth of cut for rough milling or finishing the bottom of a milled feature when using the offset method.

- **Finish allowance** (see page 994) — The rough pass contains a **Finish allowance** attribute which controls how much material to leave for the finishing pass. By default this is **0.02**.

1 Generates a finishing pass. By default, the bottom is not finished. The roughing tool removes all of the material in Z. This is controlled by **Finish bottom** (see page 936).
• **Tool selection** — After the roughing pass, the roughing tool is used to finish the side. **Use finish tool** (see page 936) commands FeatureCAM to choose a separate finishing tool (that has the same characteristics unless you override them).

• **Ramp on** — The finish pass ramp into the material with an arc equal to a percentage of the tool diameter (see **Ramp diameter** (see page 994)). For open curves, **Lead distance** and **Lead in/out** angles control the horizontal approach and exit from the material.

The **Lead-out angle** applies only over the **Lead-out distance**, so if the **Lead-out distance** is 0, the **Lead-out angle** has no effect. The **Lead-out angle** is applied to the end of the finish pass for an open toolpath. It also applies to the last toolpath of a roughing pass if the **Finish allowance** is set to 0.

The **Lead-in angle** applies only over the **Lead-in distance**, so if the **Lead-in distance** is 0, the **Lead-in angle** has no effect.

**Lead distance in/out** is the linear distance that a tool path extends beyond the ends of an open toolpath or toolpaths that are clipped against the stock profile. This parameter is specified as a percentage of the tool’s diameter. If **Lead Distance** is set to 0.0, the toolpath starts or stops exactly at the ends of the profile.

![Diagram](image.png)

1. Lead-in/out angle
2. Lead distance in/out

• **Finish passes and overlap** — The tool goes across or around the side a number of times set by **Finish passes** (see page 994), and overlaps the starting point by an amount controlled by **Finish overlap** (see page 994).

• **Ramp off** — Uses another arc of the same size as the **Ramp on** to move the tool away from the finished wall.

• **Retract** — Removes the tool from the stock area and sets up for the next operation.

You can edit this process in these places:

• To edit all instances of this type of feature in the current document, use the **Machining Attributes** dialog.
To edit a single feature, use the Tools, Milling, Strategy, and Misc. property tabs for the feature in the Feature Properties (see page 884) dialog.

The tooling database also has a large impact on how a feature is machined, and the feed/speed database helps to determine the feeds and speeds used.

**Creating a Side feature**

To create a Side feature:

1. Click the **Features** step in the **Steps** panel. This displays the **New Feature** wizard.

2. Select **Side** and click **Next** to open the **New Feature - Curves** (see page 533) page. Select a curve from the **Curve** list. The curve can be a closed loop or an open curve in which the end points do not meet.

3. Click **Next** to open the **New Feature - Machining Side** (see page 534) page.

4. Click **Next** to open the **New Feature - Location** (see page 534) page. The Z height of the curve is displayed. If you want to offset the feature in Z, specify an **Offset value**.
5 Click **Next** to open the **New Feature - Dimensions** page.

![New Feature - Dimensions](image)

*If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.*

- **Depth** — Enter the distance cut into the material in Z.
- **Bottom Radius** - Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.
- **Draft angle** — Optionally set an angle for the feature wall. Use only positive numbers.
- **Chamfer** — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

6 Click **Next** to open the **New Feature - Strategies** (see page 537) page.

7 Click **Next** to open the **New Feature - Operations** (see page 564) page.

8 Click **Next** to open the **New Feature - Default Tool** (see page 564) page for the first operation.

9 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page for the first operation.

10 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

11 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.
You can edit (see page 884) the feature later.

By default, an outer Side feature uses the stock boundary as the outer extent of the feature. You can limit the extent of the Side cut using a Stock Curve (see page 224). If the UCS is not parallel to the Stock face, you must use a Stock Curve for Side features.

You can select a Side Curve (see page 928) to describe the shape of the feature's cross-section.

**Cross section (X section) for Boss, Side, or Pocket**

You can define the shape of the walls of a Boss, Side, or Pocket feature by specifying a cross-section curve. This curve is swept along the curve of the feature to create the overall shape. The curve must be:

- in the XY plane, with the starting point of the curve at (0,0) in the setup axis; or

For example,
use this cross-section curve: to create this feature:

- in place on the feature curve.

For example,
use this cross-section curve: to create this feature:
The curve must be a function in X and Y. This means that when you draw a vertical line parallel to the X or Y-axis through the curve at any point, it can only intersect the curve once.

2.5D roughing toolpaths overview

For Pocket, Rectangular Pocket, and Boss features, FeatureCAM provides several different milling methods for roughing.

Traditional toolpaths

- **Spiral** — This toolpath type is based on a series of offset curves. For a Boss feature, the curves of the Boss are offset and then clipped against the shape of the stock. When using a square piece of stock the toolpaths tend to cut the four corners first, and then work their way inward. You can alter the extent of the toolpaths by using a stock curve of total stock.
For a Pocket feature, the boundary of the Pocket is offset and the toolpaths are cut starting from the center of the pocket. The shape of the stock does not affect the toolpaths.

- **Zigzag** — This toolpath type uses straight toolpaths that are parallel to each other.

For a Boss feature, the toolpaths are laid in parallel lines across the stock and clipped against the boundaries of the Boss.

The starting point is one of the four corners of the stock. You can change the angle of the toolpaths, but the neighboring toolpaths are always parallel.
For a Pocket feature, the parallel toolpaths are laid inside the Pocket boundary.

After the parallel paths, a clean-up pass is then performed around the boundaries of Bosses, Pockets, and Pocket islands.

The Zigzag roughing pass has two phases, the parallel roughing phase and the boundary clean-up phase. The clean-up phase, marked 1, cleans up the boundaries of the feature to ensure a uniform finish allowance:

The tree view for the feature only shows a single feature, so the clean-up phase uses the same feed and speed values as the roughing pass. The number of clean-up passes is determined by the Cleanup passes (see page 1161) attribute. If Cleanup passes is set to 0, the clean-up pass is not performed. If set to 1, a single pass is performed along the boundaries of the roughing region:
The roughing region is determined by offsetting the boundaries of the feature by the **Finish allowance**.

If set to a number larger than 1, multiple clean-up passes are performed. The default spacing of these passes is controlled by the **Cleanup stepover** (see page 1161) attribute. To more finely control the spacing of multiple clean-up passes, set the **Cleanup stepover** attribute.

The ramping onto the clean-up pass is controlled by the **Ramp diameter** (see page 985) attribute.

The direction of the Zigzag path is controlled by the relationship between the **Zigzag angle** (see page 994) and the **Climb mill** (see page 936) attributes.

The table shows the relationship between the zigzag angle and the **Climb mill** setting. The image in the **Path** column indicates the direction, the start point, and the sequencing of the toolpaths.

For example, indicates toolpaths that are parallel to the X axis. The start point is the lower left and the paths are sequenced from the bottom to the top. In the images, the X axis of the Setup is the horizontal axis, and the Y-axis is the vertical axis.

<table>
<thead>
<tr>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No</td>
<td>↑</td>
<td>180</td>
<td>Yes</td>
<td>↓</td>
</tr>
<tr>
<td>0</td>
<td>Yes</td>
<td>↑</td>
<td>180</td>
<td>No</td>
<td>↓</td>
</tr>
<tr>
<td>90</td>
<td>Yes</td>
<td>←</td>
<td>-90</td>
<td>No</td>
<td>→</td>
</tr>
</tbody>
</table>
If the **Bi-directional cut** (see page 936) or the **Reorder** (see page 1607, see page 1660) attribute is selected, the toolpath is reordered so that it completes one region before moving on to the next.

For example, with this Boss feature the toolpaths finish the region on the right of the Boss before moving on to the region on the left side.

If **Bi-directional cut** and **Reorder** are deselected, the toolpaths move across the part without any reordering.

When roughing a Boss with the Zigzag method, the amount that the tool overlaps the stock boundary is controlled by the **Finish allowance** (see page 994).

The Zigzag technique applies to a finishing pass only if the bottom of the feature is being finished. In this case, it behaves just like a single roughing pass.

**NT (New Technology) toolpaths**

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional **Spiral** toolpath, but can use stepovers larger than 50%.
- **NT Zigzag** — This toolpath is similar to the traditional **Zigzag** toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.
- **NT Continuous Spiral** — This toolpath is similar to the traditional **Spiral** toolpath, but eliminates nearly all stepovers.
- **Vortex** (see page 725) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.

Set the default type in **Machining Attributes** on the **Stepover** tab using the **Stepover Options** button.

![Machining Attributes](image)

Click the **Stepover Options** button to open the **Rough Stepover Options** dialog:

![Rough Stepover Options](image)

The **NT** toolpaths are available in the **Stepover** menu along with the traditional **Spiral** and **Zigzag** toolpaths.
At feature level, you can override the default Stepover type in the menu on the Strategy tab of the feature's Properties dialog.
You can override this at operation level on the Stepovers tab. If you are using Individual rough levels, you can set the Cut type for each individual rough pass.

Regardless of the roughing method selected, the feature is roughed to within the Finish allowance (see page 1161) of the boundary.

There are some key differences between Traditional and NT toolpaths (see page 727).

**NT Spiral example**

This example part includes a Boss feature and a Pocket feature, outlined in red:
This is a centerline simulation of the Boss feature using the traditional **Stepover type** of **Spiral**:

This is the same feature cut using the new technology **Stepover type** of **NT Spiral**:

This is a centerline simulation of the left Pocket feature using the traditional **Stepover type** of **Spiral**:

This is the right Pocket cut using the new technology **Stepover type** of **NT Spiral**:
2.5D Vortex toolpaths

To create a 2.5D Vortex toolpath, select Vortex from the Stepover list on the Strategy tab (see page 936) of the Feature Properties dialog:

You must have the FeatureRECOGNITION module to use Vortex for 2.5D roughing.

The 3D HSM and 3D MX modules include FeatureRECOGNITION, 3D LITE does not.

You can use Vortex to machine most 2.5D feature types.

You can use Vortex to machine a Side feature only if the curve is closed. If the curve is open and you select a Stepover of Vortex, NT Spiral is used instead.

2.5D Vortex example

This example shows how Vortex machines pockets, channels, and narrow corners.

For more information on the general principles of Vortex machining, see the 3D Vortex and step cutting example.
Using a 2.5D model:

Create a Vortex toolpath:
For pockets, the tool spirals down into the pocket before using trochoidal paths over the full-width cuts.

On completion of the initial full-width cut, the trochoids are placed in the corners where the maximum tool engagement angle would otherwise be exceeded.

**Differences between Traditional and NT toolpaths**

**Pre-drill differences**

There are some differences with how the Pre-drill operation works with the NT toolpaths compared to the traditional toolpaths.

- You can use a Pre-drill operation with the NT Zigzag toolpath. It is not available for the traditional Zigzag toolpath.
- With the NT toolpaths, zigzag ramping is automatically disabled when you use a Pre-drill operation. This is not supported for the original Spiral toolpath and you must set the Max. ramp angle to 0 to disable zigzag ramping when using a Pre-drill operation.
- The Pre-drill operation for the NT toolpaths includes the tops of multi-height islands (not supported for the original toolpaths).
- The traditional Spiral toolpath supports manual plunge points for the pre-drill locations using the Plunge point(s) attribute. The NT toolpaths support only automatic locations.

**Stepover differences**

There are some differences in the attributes available for NT toolpaths on the feature Stepover tab:

There are two Ramp type options for the NT toolpaths:
- **Smooth** — This is similar to the traditional toolpath option S-type
- **Direct** — This is similar to the traditional toolpath option Line.

You can specify separate Lead-in and Lead-out options for NT toolpaths:

The NT toolpaths have an Approach from outside option. This option automatically adds a very small lead-in whenever the tool is plunging off the stock. When you select this option, the lead-in options are disabled. Deselect it to manually specify the lead-in as a line, arc, and/or toolpath extension.
The Angle attribute for NT toolpaths supports only positive angles. The direction relative to the toolpath is determined automatically.

Minimize tool retract differences

Using the Minimize tool retract options with the NT toolpaths gives better results than with the traditional toolpaths.

Pocket feature

For a Pocket feature, the toolpath slot cuts following the offsets instead of just a straight line. There are fewer plunges than with traditional toolpaths.

Traditional toolpath example:

![Traditional toolpath example](image1)

NT toolpath example:

![NT toolpath example](image2)
**Boss feature**

For a Boss feature, the toolpath has a lot fewer retracts and plunges at the edge of the Stock.

Traditional toolpath example:

NT toolpath example:
Other differences

On the Milling (see page 1161) tab, NT toolpaths have a Stepover rapid distance attribute, which controls when to retract and plunge on Boss stepovers. This is an absolute distance and replaces the Min. rapid distance % attribute used by the traditional toolpaths.

You can use the Output Options dialog to control how the points of a toolpath are processed in the NC program. For 2.5D features, this dialog is only available for NT toolpaths.

Draft angles

Draft angle — Optionally set an angle for the feature wall. Use only positive numbers. Using tapered tools or ball end taper tools improves the quality of tapers and bottom and corner radii. These manufacturing attributes affect draft angles:

- **Draft flat scallop height**

![Diagram of draft angles](image)

1. Rough pass
2. Draft flat
3. Draft radius
4. Flat bottom
5. Finish pass
6. Corner

See also:
Manufacturing steps for milled features with bottom radius regions (see page 733)

- **Draft radius scallop height**

![Diagram of draft angles](image)

1. Finish pass
2. Draft taper
3. Draft radius
4. Corner
5. Flat bottom
6. Rough pass
See also:
Manufacturing steps for milled features with bottom radius regions (see page 733)

- Radius tool scallop height

![Diagram showing manufacturing steps]

Draft angles are cut as much as possible with flat tools and floors are finished with flat tools. Tapered operations are used only if requested and an appropriate tapered tool exists. An error is displayed if the operation is requested and an appropriate tool is not found.

Bull-nosed tools are supported and used if no ball-end tools are found. No differentiation is made between bull-nosed and ball-end tools.

**More about draft angles**

Here is a short list of criteria that affect the manufacture of draft angles:

- A tool of the exact size radius is not required to finish the feature, but without the exact size, the pass generally leaves a scallop.
- The finish operation with a tapered tool only goes down to the intersection of the straight side and the bottom radius.
- The rough operations are generated unless the scallop height is set to 0.
- Scallops are never at the top edge of the feature except when cut with flat-end tools.
**Bottom radius**

**Bottom radius** — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

**Manufacturing steps for milled features with bottom radius regions or cross sections**

Features with a bottom radius have additional steps:

1. Rough up to bottom radius with flat end tool leaving finish allowance on bottom.
   - a Rough down to bottom radius with flat end tool.
   - b Rough bottom radius region with radius tool to reduce stair steps on wall.
2. Finish floor with flat end tool.
3. Finish tight corners missed by steps 1 and 2 using a radiused tool
4. Finish corner radius and walls with radius tool.
3D surface milling feature (3D LITE)

The options available to you for 3D milling depend on which 3D milling product you have.

The main differences between the three 3D products are:

<table>
<thead>
<tr>
<th>3D Lite</th>
<th>3D MX</th>
<th>3D HSM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single surface</td>
<td>Everything in 3D Lite, plus:</td>
<td>Everything in 3D MX, plus:</td>
</tr>
<tr>
<td>Z-level rough</td>
<td>- Multiple surfaces</td>
<td>- Plunge roughing</td>
</tr>
<tr>
<td>Parallel rough</td>
<td>- Feature Recognition</td>
<td>- Pencil</td>
</tr>
<tr>
<td>Parallel finish</td>
<td>- Z-level finish</td>
<td>- Remachine</td>
</tr>
<tr>
<td>Isoline</td>
<td>- Radial</td>
<td>- Steep and shallow</td>
</tr>
<tr>
<td>2D spiral</td>
<td>- Flowline</td>
<td>- 3D spiral</td>
</tr>
</tbody>
</table>

You need 3D MX or 3D HSM to use 5-axis Simultaneous.

To mill a 3D surface, you must create a Surface milling feature from the surface(s). A Surface milling feature enables you to generate toolpaths using a number of 3D toolpath techniques.

A 3D surface milling feature is made up of one or more 3D milling operations. For example, a single feature may both rough and finish the part surfaces. The New Feature (see page 735) wizard helps you create a feature and its initial operation. After the initial feature is created, you can edit the feature to further control how it is manufactured, or add additional operations.

3D Milling methods

You have a number of options for milling a 3D feature. The object is to select a method that is efficient for your feature's shape and that also gives an acceptable finish.

Z level rough (see page 759)
Z level finishing (see page 771)
Isoline milling (see page 772)
Pencil milling (see page 776)
Remachining (see page 789)
Recommended Machining Strategies
Roughing
Semi-finishing and finishing strategies
Finishing models with few surfaces
Finishing walls of pocket or boss shapes with a 3D floor

Creating a 3D surface milling feature
To create a 3D surface milling feature:

1. Click the Features step in the Steps panel. This displays the New Feature wizard.

2. Select Surface Milling, then click Next to open the New Feature - Part Surfaces page. Pick or add the surface, or surfaces (3D MX (see page 10)), that you want to machine.

3. Click Next to open the New Strategy page. Choose whether to use a rough, semi-finish, and finish operations to completely machine the feature or just a single operation.

   You can add or remove strategies later on the Process (see page 1054) tab of the Feature Properties (see page 884) dialog.

4. If you select Choose rough, semi-finish, and finish operations to completely machine this feature, the wizard takes you through three separate pages:
- **New Strategy - Rough** (see page 739)
- **New Strategy - Semi-Finish** (see page 740)
- **New Strategy - Finish** (see page 741)

5 If you select **Choose a single operation**, there is just one page where you can choose a strategy (see page 742). Some strategies have additional options on the following **Strategy** page. The options on the **Strategy** page of the wizard are the same as the **Strategy** (see page 1060) tab in the **Feature Properties** (see page 884) dialog.

6 Depending on the strategy you choose, you may see the **Edges**, **Stock**, and **Slopes** pages. These pages of the wizard contain the same options as the **Edges** (see page 1115), **Stock** (see page 1123), and **Slopes** (see page 1133) tabs in the **Feature Properties** (see page 884) dialog.

7 Click **Next** to open the **New Feature - Operations** (see page 564) page.

8 Click **Next** to open the **New Feature - Default Tool** (see page 564) page for the first operation.

9 Click **Next** to open the **New Feature - Feed/Speed** (see page 567) page for the first operation.

10 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

11 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

*You can edit (see page 884) the feature later.*
**New Strategy**

Use the **New Strategy** page of the **New Feature** wizard to specify the machining strategy for the 3D Surface Milling feature you are creating.

Select an option:

- **Choose rough, semi-finish, and finish operations to completely machine this feature** — Create a surface milling feature that contains multiple operations. This enables you to create the roughing, semi-rough and finish operations quickly using the wizard.

- **Choose a single operation** — Create a feature which contains a single operation. For example, you can create just the roughing operation, and create the finishing operations later.

**New Strategy (single operation)**

Use the **New Strategy** page of the **New Feature** wizard to specify the machining strategy for a 3D Surface Milling feature with a single operation.

Select a machining strategy:

**Finishing Strategies**

- Parallel (see page 745) - toolpaths that are parallel to the X or Y axes.
- Z level finish (see page 771) - toolpaths that are parallel to the XY plane.
- Isoline milling (see page 772) - toolpaths that follow the rows or columns of individual surfaces.
- 2D spiral (see page 749) - Toolpaths that move in a spiral toward or away from the center of the part. Stepover is constant from the top view.
- 3D spiral (see page 755) - Toolpaths that move in a spiral toward or away from the center of the part. Stepover is constant in 3D.
- Radial milling (see page 759) - toolpaths that move out radially from the center of the feature.
- Flowline milling (see page 773) - toolpaths that follow the rows or columns of a flowline surface which are then projected onto the part.
- Between 2 curves (see page 776) - toolpaths that are created between two specified curves.

**Roughing Strategies**
- Z level rough (see page 759) - toolpaths that are parallel to the XY plane.
- Plunge roughing (see page 779) - toolpaths which remove large amounts of material from a component through a series of vertical plunging movements.
- Parallel (see page 745) - toolpaths that are parallel to the X or Y axes.

**Specialized Strategies**
- Horizontal + Vertical (see page 778) - machine steep and shallow regions using different techniques.
- Corner Remachining (see page 786) - A remachining technique used to clean up corners that occur between non-tangential surfaces.
- Pencil milling (see page 776) - a single clean-up pass for corners.
- 4-Axis Rotary (see page 781) - used in turnmill to machine round surfaces with an X tool.
- Swarf (see page 794) - toolpaths are cut using the side of the tool. The tool is in constant contact with the surface.
- 5-Axis Trim (see page 800) - toolpaths that are along the edges of surfaces. There is the option to cut on the inside or outside edge of the surface.
For more details on these options, see operations overview (see page 742).

**New strategy — Rough**

This page helps you select the roughing stage. In this stage you remove the majority of the material.

1. Enter the **Tool Diameter**. This is the diameter of the tool. The tool is a flat end tool for Z level rough and a ball end tool for all other operations.

2. Enter the **Finish Allowance**. This is the amount of material left after a 3D roughing pass.

3. Enter the **Tolerance**. This sets how close the milling is to the mathematically ideal surface. This does not guarantee that your feature is machined to this tolerance in all locations if the tool you select is incapable of cutting within that tolerance in constrained areas. If your part shows a faceted appearance, set the tolerance to a lower value.

4. Select the roughing operation type from:

   - **Z Level Rough** (see page 759) — You must set **Classify slices as either 3D Pocket or 3D Boss**.

You can tell FeatureCAM to rough your part as a **3D Pocket**, or as a **3D Boss**. If you select **3D Pocket**, the tool plunges or ramps onto the part and cuts from the inside of the part out toward the boundary of the part. A **3D Boss** typically plunges off the part and cuts from the outside toward the center.

Even if the surfaces of your part create a boss shape (meaning it protrudes instead of being a cavity), you can still select **3D Pocket**. The first image below shows the slices of a part being cut as a boss, and the second as a pocket. Notice that the slices of the boss go all the way around the part at each slice, but the pocket example has slices that just cut a region of the part.
- **Plunge** (see page 779) (3D HSM (see page 10)) — You must also decide if you want a **Honeycomb** pattern.

Plunge roughing is performed in either a straight rectangular pattern, as shown below:

![Plunge pattern diagram](image1)

or a honeycomb pattern in which each row is offset horizontally by half the rough pass stepover amount:

![Honeycomb pattern diagram](image2)

The honeycomb pattern is usually preferable. The **Honeycomb pattern** attribute controls the pattern type.

- **None** — Select this option if you don’t want a rough pass.

**New strategy — Semi-Finish**

Use this page to select the semi-finish strategy. The semi-finish stage is used to cut the part to within the finish allowance.

To complete this page:

1. **Enter the Tool Diameter.** This is the diameter of the tool. The tool is a flat end tool for Z level rough and a ball end tool for all other operations.
2. **Enter the Finish Allowance.** This is the amount of material left after a 3D roughing pass.
3. **Enter the Tolerance.** This sets how close the milling is to the mathematically ideal surface. This does not guarantee that your feature is machined to this tolerance in all locations if the tool you select is incapable of cutting within that tolerance in constrained areas. If your part shows a faceted appearance, set the tolerance to a lower value.
4. Select the semi-finishing operation type from among:
• **Parallel** (see page 745) — For Direction, select X parallel to cut parallel to the X-axis or Y parallel to cut parallel to the Y-axis. You can also optionally enter a **Parallel angle**.

• **Z Semi** (see page 761) — Perform a single Z level semi-finish operation.

• **Z Finish** (see page 771) (3D MX (see page 10))

• **None** — Select this option if you don't want a semi-finish pass.

**New strategy — Finish**

Select the finishing strategy to finish the manufacturing of your part.

To complete this page:

1. Select **Compute tool diameter based on surface curvature** for automatic tool selection.

2. Select **Set tool diameter** and enter a specific diameter to override automatic tool selection.

3. Enter the **Tolerance**. This sets how close the milling is to the mathematically ideal surface. This does not guarantee that your feature is machined to this tolerance in all locations if the tool you select is incapable of cutting within that tolerance in constrained areas. If your part shows a faceted appearance, set the tolerance to a lower value.

4. Select the finishing operation type from:
   - **Horizontal + Vertical** (see page 778) (3D MX (see page 10)) — Enter **Slope boundary** and **Slope overlap** parameters.
   - **Isoline** (see page 772)
   - **Parallel** (see page 745)
   - **Z level** (see page 771) (3D MX (see page 10))
   - **None** — Select this option if you don't want a finish pass.

**Tool selection for 3D milling features**

FeatureCAM selects a default tool for all 3D finish operations.

On the **Tools** tab, there is an option to use the part’s curvature to select the default tool. If you select this option, FeatureCAM analyzes all included surfaces and finds the smallest concave radius of curvature and a ball-end tool closest to that radius is selected.

> Tool selection looks at the sides of the surfaces you are machining. If you flip to the other side, a different tool might be selected.
### Types of 3D milling strategy

<table>
<thead>
<tr>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.jpg" alt="Parallel Finish" /></td>
<td><strong>Parallel Finish</strong> (3D LITE) — This is best suited to rectangular models and works by taking a pattern of curves, within a boundary, and projecting points from these curves onto the model. Parallel toolpaths are often used on open parts, whereas 3D Spiral toolpaths work well in the bottom of pockets. This is a robust machining strategy that works well on many models, except for areas that are vertical (or near-vertical). More about Parallel (see page 745).</td>
</tr>
<tr>
<td><img src="image2.jpg" alt="Z level finish" /></td>
<td><strong>Z level finish</strong> (3D MX) — This creates a toolpath by slicing the model at specific Z heights. This works well on near-vertical surfaces that require a consistent depth of cut. More about Z level finish (see page 771).</td>
</tr>
<tr>
<td><img src="image3.jpg" alt="2D Spiral" /></td>
<td><strong>2D Spiral</strong> (3D LITE (see page 10)) — This strategy projects a spiral pattern onto the model, which is then machined. More about 2D Spiral (see page 749).</td>
</tr>
<tr>
<td><img src="image4.jpg" alt="3D Spiral" /></td>
<td><strong>3D Spiral</strong> (3D HSM (see page 10)) — This strategy is best suited to machining areas that require a constant stepover and works well on near-horizontal surfaces. It creates a series of offsets starting at the outer boundary and offsetting towards the center. More about 3D Spiral (see page 755).</td>
</tr>
<tr>
<td><img src="image5.jpg" alt="Isoline" /></td>
<td><strong>Isoline</strong> (3D LITE) — This strategy uses the isoline curves of a surface to mill the surface. These curves can be in the row direction or column direction. More about Isoline milling (see page 772) and isoline curves (see page 347).</td>
</tr>
<tr>
<td><strong>Radial (3D MX)</strong> — This strategy creates a radial pattern within a boundary and projects it onto the model. More about Radial (see page 759).</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Radial Image" /></td>
<td></td>
</tr>
<tr>
<td><strong>Flowline (3D MX)</strong> — This strategy drives surface machining. Creates a pattern from the flowline surface and projects it onto the model. More about Flowline (see page 773).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Flowline Image" /></td>
<td></td>
</tr>
<tr>
<td><strong>Between 2 curves (3D MX (see page 10))</strong> — This strategy limits machining to be between two curves. You can set the direction of toolpath to along or across. More about Between 2 curves (see page 776).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Between 2 curves Image" /></td>
<td></td>
</tr>
<tr>
<td><strong>Pencil (3D HSM)</strong> — This strategy creates a single trace corner toolpath. It is used to clean up corners that occur between non-tangential surfaces. They are automatically calculated inside any existing boundary. More about Pencil (see page 776).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Pencil Image" /></td>
<td></td>
</tr>
<tr>
<td><strong>Z level roughing (3D LITE)</strong> — This strategy clears an area with contours generated by repeatedly offsetting the initial slice until no further offset is possible. More about Z level roughing (see page 759).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Z level roughing Image" /></td>
<td></td>
</tr>
<tr>
<td><strong>Plunge roughing (3D HSM)</strong> — A specialized cutting tool is used to remove large amounts of material through a series of vertical plunging movements. More about Plunge roughing (see page 779).</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Plunge roughing Image" /></td>
<td></td>
</tr>
<tr>
<td>Strategy</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Corner Remachine</strong> (3D HSM (see page 10))</td>
<td>This strategy creates a multiple trace corner toolpath with Across or Along options. More about Corner (see page 786) remachining.</td>
</tr>
<tr>
<td><strong>Horizontal + Vertical remachining</strong> (3D MX)</td>
<td>This strategy combines two different toolpath operations, one for finishing shallow portions of the part and a Z-level for finishing the steep regions. More about Horizontal + Vertical (see page 778) remachining.</td>
</tr>
<tr>
<td><strong>5-axis trim</strong> (5AS (see page 10))</td>
<td>This strategy enables you to pick a selection of surfaces and profile around the outside of these surfaces. More about 5-Axis Trim (see page 800).</td>
</tr>
<tr>
<td><strong>Swarf</strong> (3D MX)</td>
<td>This strategy cuts with the side of the tool and works only on developable surfaces because the tool needs to be in contact with the surface for the whole cutting depth. For a tool to swarf cut, it has to be able to have contact with the surface at all points along the cutting edge of the tool. For non-developable surfaces, FeatureCAM always leaves material on or produce fragmented toolpaths (rather than gouge).</td>
</tr>
<tr>
<td><strong>Four-axis Rotary</strong> (3D MX (see page 10))</td>
<td>This strategy creates a toolpath by rotating the model around the index axis, with linear motion provided by the non-index axis coordinate pairs. More about Four-axis Rotary (see page 781).</td>
</tr>
</tbody>
</table>
**Steep and Shallow** (3D HSM) — This strategy calculates a shallow boundary, and then creates a Z-level toolpath in the steep areas of the model and a Parallel or 3D Spiral toolpath in the shallow areas.

**Parallel milling**

Projection milling techniques are a robust and easily understood method of generating 3D toolpaths. They work by taking a pattern of curves and projecting points from these curves onto the surfaces of the part.

**Advantages**

- It is robust.
- It handles overlapping surfaces well.
- It is good for multiple surface manufacturing.
- It lets you specify planar stepover distances or scallop heights for finishing.
- Surface normals are not considered for the manufacturing computation.

**Disadvantages**

- It has poor handling of near-vertical surfaces.
- It does not handle vertical surfaces because they are invisible from above.

**Parallel toolpaths**

Parallel toolpaths are parallel to the X axis or Y axis of the current Setup. To slant the toolpaths relative to the axis, set the **Parallel angle** attribute on the **Strategy** (see page 1060) tab.

The value can be anywhere from **-360** to **360** degrees, the default is **0.0**. A positive value rotates counter-clockwise from the principle axis, and a negative value rotates clockwise from the axis.
- Setting the angle to 90 on an X-parallel operation causes it to effectively become a Y-parallel operation.
- Setting the angle to 180 causes the toolpaths to be cut from the opposite side of the part. For example, an X-parallel operation with the angle set to 0 starts at the minimum Y coordinate. With the angle set to 180, the toolpaths start at the maximum Y coordinate.

This example uses the soapmod.fm file from the Examples folder.

You can have the toolpath at any angle. Enter a Parallel angle. The angle is measured counter-clockwise from the X axis if X parallel is selected or counter-clockwise from the Y axis if Y parallel is selected.
For example
X parallel, Parallel angle 20
Y parallel, Parallel angle 20

This method mills only the area above and down to the surface(s) in the feature. If part of the stock does not have a feature surface in it, that area is not milled away, except perhaps incidentally to the manufacturing of another surface feature.

Restrictions of projection milling techniques
Vertical surfaces are almost invisible to projected manufacturing methods because the vertically projected lines may not detect the vertical surface. The top edge of such a surface is protected, but the actual surface may not be milled. You must machine surfaces that are exactly and completely vertical with another technique. Vertical surfaces might be better candidates for a Side (see page 709) feature instead of a surface.

Troubleshooting projection milling methods
1 Bad surface finish on nearly vertical walls. If you are finishing across a nearly vertical surface, portions of a surface have larger scallops than other parts of the surface. Possible solutions include:
   - Use Scallop stepover instead of fixed planar distance stepovers. This gives a constant scallop height over surfaces of the model. See item 3 below.

The Scallop stepover option is available for certain finish operations. For projection milling methods, it toggles the way that you specify how far the tool moves over between passes. With the Scallop stepover option disabled, you specify the Stepover. With it enabled, you specify the Scallop height.

For Z-level finish operations, it toggles options for you to specify tool movements down in Z. With Scallop stepover disabled, you specify the Z-increment. With it enabled, you specify the Scallop height.

With the Scallop stepover option enabled, spacing of the toolpaths is calculated along the surfaces to provide a uniform surface finish.
These images show surfaces cut without using scallop stepover:

These images show the same surfaces cut with scallop stepover:

- Finishing the surface with isoline milling (see page 772)
- Finishing the surface in another direction with a projection technique. Finish going up the steep slope rather than across. Use a stock curve if you want to only mill a small portion of the surface milling feature.
- Finishing the surface again with the same technique using a much smaller stepover value.

This is the distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature. This attribute does not apply if **Scallop height** is enabled.

1. The toolpaths extend beyond the Edge of the surface.
2. Bad finishing of vertical walls. Projection techniques do not finish vertical walls. Finish vertical walls with Isoline (see page 772) (3D LITE) or Z level finishing (see page 771) (3D MX).
**2D spiral toolpaths**

2D Spiral toolpaths mill a feature with a pattern of offset toolpaths. The pattern is obtained by taking the stock boundary, the feature boundary or the curve specified on the **Stock** (see page 1123) tab and offsetting this curve toward the center of the part. The pattern can be cut either towards the feature center or away from the feature center.

The steps between the passes are calculated in 2D. For spiral toolpaths that use a 3D stepover use the 3D spiral technique (see page 755). To use the stock boundary, select **Use stock dimensions** on the **Stock (see page 1123)** tab. This results in a square shape to the toolpaths.
To automatically calculate the silhouette boundary of the surfaces of your feature, select **Use part surface dimensions**. This toolpath mimics the boundary of your feature.

If you want to use a different curve as your toolpath shape, select the **Select curves for boundaries** option on the **Stock** (see page 1123) tab. The options for using a curve are different for spiral milling (see page 750) and other techniques (see page 1129).

**See also:**

Troubleshooting projection milling methods (see page 747)

**Boundaries for 2D spiral toolpaths**

The shape of spiral toolpaths (see page 749) are determined by the boundary and island curves and the classifications of 3D pocket (see page 751), 3D boss (see page 751), 3D side (see page 752), or **Wall only** (see page 752). You can specify multiple boundary curves, but these curves must not touch. If none is specified, then the stock boundary is used.

**Boundary Curve Allowance** — The distance to stay away from the boundary or island curves.

Spiral Boss feature with **Boundary Curve Allowance**. Notice the gap between the Boss features and the toolpaths.
For Wall only profile types, click the Other side button to offset the other direction. For Boss features, use the stock Overcut % (see page 1123) option to control how close you come to approaching the stock boundary.

**Total offset** — This is the total distance away from the boundary curve to cut for boss or side profile types.

### 3D pocket

The 3D pocket projects the boundary curve onto the surface and spirals inside of this closed curve as shown in this image.

If you specify an island curve, that region is avoided.

### 3D boss

The 3D boss setting cuts between the stock boundary and the boundary curve by projecting the boundary curve onto the surface, for example:
3D side

The 3D side setting projects the boundary curve onto the surface and then cuts on one side or the other as shown in this figure.

Wall only

The **Wall only** setting traces along the curve, for example:

Boundary Curve Allowance

Spiral Boss feature with **Boundary Curve Allowance**. Notice the gap between the Boss features and the toolpaths.
Creating a 3D boss from font curves

1. Create the surface or surfaces you want to use as the floor of your feature.
2. Create your text (see page 368).
3. Use Extract font curve (see page 334) and extract the outer boundaries of the text.
4. Use Extract font curve again and extract the islands.
5. Create a spiral out 3D boss operation (see page 735) for the floor surfaces using the outer boundary curves as the boundaries.
6. Set the curve allowance to the tool radius.
7. Create another spiral out 3D pocket operation for the floor surfaces using the island surfaces as the boundaries.
8. Again, set the curve allowance for this operation to the tool radius.

5-axis engraving

You can perform 5-axis engraving using a 2D spiral toolpath. This enables you to use a tool axis angle normal to the surface to ensure the engraving has a uniform cross-section and depth of cut.

To create a 5-axis surface engraving feature:
1 Create a surface below the stock boundary to determine the depth of the engraving, for example:

2 Create the curve to define the shape of the engraving feature, for example:

You can use the Construct > Curve > From Surface > Project onto Surface menu option to project a curve onto a surface.

3 Create a surface milling feature with a 2D spiral operation.

4 Double-click the feature in the Part View to display the Feature Properties dialog, and select spiral2d in the Tree View.

5 In the Stock tab, under Choose the drive curve, select Select curves for boundaries and click Curve Options.

   The Boundary Curve dialog is displayed.

6 Under Boundary curve type, select Wall only.

   This creates a toolpath along the curve, instead of an area clearance toolpath inside or outside the curve.

7 Under Boundary curves, click Boundaries.
The Select Boundary Curves dialog is displayed.

8 Select the curve that defines the shape of engraving, and click OK to close the Select Boundary Curves dialog.

9 Click OK to close the Boundary curves dialog.

10 On the 5-Axis tab, select Use Lead and Lean, and in the from list, select Contact normal.

This keeps the tool axis normal to the surface.

11 Click OK to close the Feature Properties dialog.

3D spiral

This finishing technique is best suited to machining areas that need a constant stepover and works well on near-horizontal faces.

Spiral toolpaths mill a feature in a series of offsets towards the feature center. The initial pattern is specified by taking the stock boundary, the feature boundary, or the curve specified on the Stock (see page 1123) tab.

To use the stock boundary, click Use stock dimensions on the Stock (see page 1123) tab. This results in an initial square shape to the toolpaths. The next and subsequent toolpaths are obtained by offsetting the initial shape in 3D (along the surfaces being cut). This differs from 2D spiral operations (see page 749) which offset the initial shape in 2D and then project this shape onto the surfaces.

Select Use part surface Dimensions in order to use the silhouette of the part surfaces as the initial boundary shape as shown in the simple figure on the left. The figure on the right shows the toolpaths that would result if Use stock dimensions was used instead.
The **Continuous spiral** option on the milling attributes page eliminates the stepover between the offsets, and morphs the pattern into a continuous spiral. With the **Continuous spiral** option selected, you get the result shown below. You can see that this minimizes the number of tool retracts and converts the original closed contours into one long spiral.

With the **Continuous spiral** option deselected, you get the following result. Notice that there is a retract between each contour.
You can also use boundary curves to control the shape of the spiral. All of these options are accessed by clicking the **Curve options** button on the Stock tab. By specifying a boundary curve, this shape is used as the initial contour of the spiral.

The boundary curve is clipped against part surfaces as shown in the figure below. If the curve is entirely outside of the stock, the silhouette of the surfaces is used as the boundary curve.
If the operation is specified as a boss, then boundary curves determine regions that are avoided.

If the operation is specified as a pocket, then the boundary curves represent the shape of each region. Any island curves are avoided. In the example below, the operation is specified as a pocket with three boundary curves. The lower left region also has a circular island region.

Details of 3D spiral milling
- The Z height of any boundary curve is ignored. This means that the curve can be above, below, or even inside of the part.
- The Total offset option in the Boundary curve (see page 750) dialog is disabled for 3D spiral milling.
- Curve allowance is the same as described for 2D spiral milling (see page 750).
Radial toolpaths

Radial toolpaths are created from the center of the part toward the boundary. This image shows a radial toolpath example.

![Radial toolpath example](image)

The center of the radial pattern is calculated automatically unless you enter a value for the **Center point** attribute on the **Milling** (see page 1229) tab.

Not all feature shapes lend themselves to this manufacturing style. Long thin features probably are not best milled in this way. The radial term is only a rough description of the path as not all feature shapes lend themselves to a radial pattern.

Z-level rough

Z level roughing takes slices of the model at various heights on the Z axis, and then generates toolpaths to machines each slice.

How to create a Z level rough operation. (see page 759)

Creating a Z level roughing operation

To create a Z level rough operation:

1. Click the **Features** step in the **Steps** panel to display the **New Feature** wizard.

2. In the **New Feature** wizard, select **Surface Milling** and click **Next**.

3. Use the **Part Surfaces** page of the wizard to select the surfaces you want to machine, then click **Next**.

4. In the **New Strategy** page, select **Choose a single operation**, then click **Next**.
5 Under **Roughing Strategies**, select **Z Level**, then click **Next**.

![Roughing Strategies](image)

6 Use the **Strategy** page to specify the machining strategy for the surface.

   If the surfaces represent a cavity, select the **3D pocket** option. If your surfaces represent a 3D boss, select the **3D boss** option.

7 Complete the rest of the pages of the wizard, or click **Finish** to create the feature and accept the default options.

**Troubleshooting Z level roughing**

FeatureCAM has different methods of Z level roughing (see page 762).

1 Mills the wrong side of the surfaces.
   - Toggle the **Classify slices as** attribute on the **Strategy** (see page 1060) tab.
   - If the **Classify slices as** attribute is set correctly, make sure that the normals of the vertical surfaces are pointing out. Use the **Surface Control** (see page 1159) tab to reverse the surfaces.

2 Slices are very coarse.
   - Decrease the **Tolerance** attribute on the **Milling** (see page 1163) tab.

3 The slices look strange around holes or passages in the walls of the feature.
   - Use a cap surface to plug holes (or untrim (see page 422) the surface), or use a larger diameter tool.
Notes:

For a generalized boss, FeatureCAM uses the stock boundary or stock curve as the outer boundary of the boss.

Control Z-level roughing with the Corner radius %, Tool corner %, and Trochoidal cut attributes on the Milling (see page 1163) tab of the Surface Milling Properties dialog.

Z-level roughing with multiple tools

Z-level roughing can be performed with multiple tools. After a larger tool is used to rough out the majority of the part, FeatureCAM can automatically apply a semi-roughing pass to the uncut regions of the part without recutting the previously roughed region. The smaller tool roughs around the walls of the part with a smaller Z-increment than the previous tool and roughs regions where the larger tool does not fit.

This example shows a bottle that is first roughed with a 0.75 inch endmill and then roughed with a 0.25 endmill:

Roughing with multiple roughing tools is much more efficient than simply roughing with a small tool. In the case of the bottle, roughing with two tools takes 9 minutes and 34 seconds, while roughing the entire part with only the smaller tool takes 19 minutes and 8 seconds.

To perform Z-level roughing with multiple tools:

1. On the Strategy tab of the New Feature wizard or the Feature Properties dialog, select the Multiple rough option.

2. Enter a list of Tool diameters. Separate the diameters with a comma. Each diameter must be smaller than the preceding diameter.

Each of the roughing passes is listed in feature's tree view so you are able to further edit these operations to customize attributes such as stepover values or Z increments.
Methods of Z-level roughing

Zigzag — This is more like an X parallel rough. Roughs each Z level raster-style with an optional profile pass around each slice.

Offsets — Each slice is offset repeatedly to form the toolpaths.

Vortex (3D HSM) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.
3D Vortex toolpaths (3D HSM)

Vortex machining is an area clearance strategy that rapidly removes material from a 3D part while controlling tool load. Vortex is best suited to solid carbide tools and is frequently used in combination with step cutting.

It is an offset-style toolpath and has these main features:

- The engagement angle never exceeds, by more than 15%, that produced by a straight line cut with a given stepover. This eliminates excessive tool load and all full-width cuts. This enables you to increase feed rates. For other area clearance toolpaths, the cutting values are based on the tool manufacturer's slot cutting parameters to ensure the tool can sustain full cutting engagement. As the tool approaches the maximum engagement angle for optimum machining, the toolpath changes to a trochoidal path to avoid tool overload.

- The machine tool almost always runs at the specified feed rate. With other area clearance toolpaths, the machine tool automatically slows down as it approaches a corner and the engagement angle increases. Vortex modifies the toolpath so the tool engagement angle is never exceeded and the machine tool achieves the specified feed rate. The only time the machine tool does not run at the specified feed rate is when the model geometry (a slot or corner) is smaller than the smallest radius that the machine can run at full speed.

- Vortex machining cuts with the side of the tool so it is designed for solid carbide tools, but you may be able to use other tools.
Because FeatureCAM controls the tool engagement, you can increase the depth of cut, which minimizes machining time.

Vortex machining is frequently used in combination with Step cutting to minimize terracing while maximizing the removal rate.

Vortex toolpaths are automatically checked for safety. FeatureCAM checks for:
  - plunges into stock.
  - excess tool engagement.
  - excess depth of cut.
  - small arc movements.

To maximize the benefits of Vortex machining:
  - Configure the Vortex parameters to suit each machine tool.
  - Use Step Cutting to minimize terracing caused by the increased depth of cut.

With optimum settings, Vortex machining greatly reduces machining times.

Creating a 3D Vortex toolpath

To create a 3D Z-level roughing Vortex toolpath, select Vortex on the Strategy tab (see page 1060) of the Surface Milling Properties dialog:

You must have the 3D HSM module to use Vortex for 3D Z-level roughing.

The following attributes are available for Vortex toolpaths in the Feature Properties dialog:

F/S tab (see page 983):
  - Feed — Enter the speed the tool cuts into the material. Vortex toolpaths are machined at this cutting feed rate almost all of the time.
**Milling** tab (see page 1161):

- **Vortex min point spacing** — Enter the minimum point spacing at which the machine tool can move at the specified feed rate. If the machine tool has too many points to process, it cannot sustain the specified feed rate.

- **Vortex min radius** — Enter the minimum radius of the internal trochoids. Vortex toolpaths use trochoidal moves to maintain a constant feed rate. Higher feed rates require a larger minimum radius. If you do not override this value, a default value is used, which is suitable for a typical machine tool at the feed rate specified for the operation.

- **Vortex Z lift distance** — Enter a Z distance to lift the tool during trochoidal moves to avoid contact between the tool and the surface.

**Strategy** tab (see page 1061)

- **Non-Cutting Moves** — Displays the Vortex Non-Cutting Moves dialog (see page 1069) where you can specify whether to retract and increase the feed rate on non-cutting moves.

**3D Vortex example**

This example shows you how to combine Vortex machining with step cutting to rapidly remove material.

Because Vortex machining cuts with the side of the tool, it is designed for solid carbide tools, but there may be other types of tools suitable for Vortex. These tools work best when taking deep cuts with a relatively small stepover.
To machine effectively when taking large depths of cut, you must ensure the tool engagement angle never exceeds the specified value. This eliminates excessive tool load and all full-width cuts. FeatureCAM achieves this by introducing trochoidal moves to prevent the tool from exceeding the maximum tool engagement value.
Using a 3D model:

Creating a Vortex toolpath without step cutting.
This removes vast quantities of material quickly, but leaves large terraces of unmachined stock on the part.

You can minimize the size of these terraces using the Step cutting options.
This adds extra machining slices up the part. Looking at a detail of the side view:

1. Original Vortex pass
2. Step cutting passes

It also machines more of the excess stock.
Vortex approaches flats from outside stock

Vortex toolpaths can approach flat areas from outside of stock instead of always ramping into it. This enables you to create Vortex toolpaths that are faster to machine and are compatible with a wider selection of tools.

The tool ramping into the part

The tool approaching from the outside

To approach from outside the stock, FeatureCAM:

- extends a section of the flat area beyond the stock and into an area already machined; and;
- fills the extended section with cutting moves.

*By extending the section to an area already machined, the machine tool can approach the flat area in open space.*

1. Edge of flat area
2. Stock
3. Extended section of flat area filled with cutting moves
4. Outside edge of extended section
5. Area already machined
Criteria for toolpath to approach from outside stock

FeatureCAM only extends a section of the flat area if the extended section:

- has an outside edge that the machine tool can approach.
- does not gouge the model.
- is wide enough to be profile smoothed successfully.
- can reach an area already machined within the distance of one tool diameter.

If the extended section fails to meet the criteria, FeatureCAM does not extend the flat area and instead uses a ramp move to approach the toolpath.

Z-level finish

The Z-level finishing method slices the feature at various depths, and then mills each slice.

This is a good technique for finishing steep walls or when you require a consistent depth of cut. This technique is sometimes called waterline milling. Just like Z-level rough (see page 759), it starts with slicing the model and then creating toolpaths from the slices.

Here is an example of Z-level finishing:

Troubleshooting Z level finishing

1. Z level finish cuts both sides of part.
   - Use a boundary curve to limit cutting to the inside or select the internal only edge boundary.
**Isoline milling**

Isoline milling is a good technique for finishing surfaces. An example of isoline toolpaths on a single surface:

Isoline milling uses the isoline curves (see page 347) of a surface to mill the surface. These curves can be in the row direction or column direction.

**Advantages**
- Uniform finish with scallop height control. The toolpaths are spaced based on the distance along the surface.
- Nearly-vertical walls handled well. Because this is not a projection technique, nearly vertical walls are cut correctly.

**Disadvantages**
- Toolpaths generated on a surface-by-surface basis.

**Restrictions of isoline milling**
Isoline milling works on a surface-by-surface basis. This can result in numerous retracts.

The orientation of the surfaces matters. Toolpaths are generated for surfaces whose normals point up. **Surfaces** are 'auto-flipped' where possible, but for vertical and some other cases, you must specify the machining side. Select the surface in the list and click **Switch machining side**. Isoline milling may mill on the wrong side of the surface or if certain flags are set, it may skip the surface.

**Troubleshooting isoline milling**
1. The toolpaths are on the wrong side of the surface.
- On the **Surface control** (see page 1159) tab, change the machining side to **Reverse** using the **Cut direction** button.

2 Toolpaths should go the other direction or start at the other end of the surface.
- On the **Surface control** (see page 1159) tab, the **Start Curve** column has the options of **First Row, Last Row, First Col, Last Col**. Select the surface in the table and click the **Set isoline row/col** button to cycle through the options. The start point and direction of the first toolpath is marked with an arrow in the Graphics Window.

3 Performance is slow.
- If you do not need the **Avoid self-gouging milling** option, turn it off.

4 Surfaces are cut in the wrong order.
- On the **Surface control** (see page 1159) tab, use the arrow buttons to rearrange the order of the toolpaths.

5 Toolpaths for a surface are reordered strangely.
- Select the operation in the feature’s tree view. Go to the **Milling** tab. Deselect the **Reorder** option.

**Flowline**

The **Flowline** technique projects the isolines from one surface onto the surfaces of the feature. The isolines are projected in the direction of the surface normal. In the example below, the isolines of a flat surface are projected onto the part. By using a side mill cutter, Flowline machining can be used to machine undercut regions.
**Machining undercut regions**

You can cut undercut regions with either an Isoline operation or a Flowline operation.

To machine undercut regions, you must.

1. Create an **Isoline** or **Flowline** operation.
2. Select an appropriate side mill cutter. FeatureCAM does not automatically select side mill cutters.
3. Specify a **Horizontal** lead-in/out plane on the **Leads (see page 1342)** tab. You may also have to experiment to determine an appropriate **Ramp diameter** to prevent gouging.

**Creating a flowline milling operation**

A Flowline milling operation is created using the following steps:

1. Click the **Features** step.
2. Click **Surface Milling**. Click **Next**.
3 Select the part surfaces and click **Next**.
4 Click **Choose a single operation** and click **Next**.
5 Click **Flowline** and click **Finish**.
6 Double-click the feature to edit it.
7 In the operation tree-view, select **flowline** and select the **Surface control** tab.
8 Click the **Pick surface** button and select the flowline guide surface.
9 The normal of the flowline guide surface must point toward the surfaces of the part. When you click the surface control tab, two arrows are displayed on the flowline guide surface. In the image below, the normal correctly points toward the part surfaces. If the normal needs to be reversed, click the **Switch machining side** button.

The arrows also indicate the starting point of the surface isolines and their direction. In the image above, the projected toolpath starts in the lower left and follows the rows of the surface. Use the **Set isoline row/col** button to change the starting point of the pattern and use the **Cut direction** button to change the direction of the cuts.
**Between Two Curves**

**Between two curves** calculates toolpaths that are bounded by two curves. This finishing operation is used to control the shape of the toolpath over multiple surfaces by restricting the machining of the surface to be between the two specified curves. The toolpaths mill a feature in a series of offsets starting from the first or **start curve** towards the second or **end curve**.

The toolpaths can be generated to run in two directions:

- **Along curves** — The toolpath is similar to an offset toolpath radiating out from the start curve to the end curve.
- **Across curves** — The toolpath goes from a point on the start curve to a point on the second curve.

You can limit the pattern by selecting **Tool center** on the **Strategy** tab to generate the pattern based on the center of the tool. Select **Contact point** to generate the toolpath based on the last point of contact between the tool and the surface.

On the **Milling** tab, you can set **Edge tolerance** which is the trimming tolerance used to reduce the noise of resulting toolpath near the start and end curves. The **Stepover** attribute is blank by default and the value is automatically determined based on the tool radius and tolerance. However, if you want to override the automatically generated stepover, you can set **Stepover** to a particular value. If the automatically generated stepover is too large, you can restrict it by specifying a **Max stepover**.

**Pencil milling**

Pencil milling is used to clean up corners or fillets of a part. Pencil milling operations automatically detect corners less than or equal to the specified radius (including sharp corners) and then create a single toolpath to clean out these corners.

Applications of pencil milling include:

- Finishing fillets in a part with a single toolpath.
- Cleaning up sharp concave corners.
- Pre-relieving corners before high-speed finishing the part with a small tool.
- Roughing fillets by using the **Finish allowance**.
The first step is to determine the regions that contain the corners.

Depending on the number of surfaces in the model, this step may take some time.

After the regions are detected, a single toolpath is created that cleans out the corners regardless of the number of surfaces contained in the region.

Creating a Pencil mill operation

1 Create a Surface milling (see page 735) feature.

2 Click the New button on Process page to open the New Strategy dialog.

3 Select Pencil milling and click Finish to close the New Strategy dialog.

4 Select the Leads (see page 1342) tab on the Surface Milling Properties dialog and set options for the moves between toolpaths.

5 Click OK.

6 Generate toolpaths. If you receive an error, see Trouble shooting pencil milling (see page 777).

Troubleshooting pencil milling

1 Calculating the regions takes too long.
   
   - Use a stock boundary on the Remachine tab to limit the search for remachining regions or create a separate feature with only the surfaces of interest.
2 Some fillets/corners are not being detected.
   - Decrease the tolerance.

**Horizontal + vertical**

This strategy combines two different toolpath operations, one for finishing shallow portions of the part and one for finishing the steep regions.

An X parallel or spiral toolpath is applied to the shallow regions, and a Z level finishing operation cuts the steep regions.

The **Slope boundary** option on the **Strategy** (see page 1060) tab indicates the angle that divides the two regions. Portions of the surfaces with slopes less than this angle are machined with the parallel toolpaths, and the steeper slopes are machined by the Z level.

The **Slope overlap** option indicates how much the two regions overlap. An overlap of 0 means that the two regions are distinct. A value of 10 means that the two passes overlap by 10 degrees.

The parallel pass is parallel to the X axis unless you enter the **Parallel angle**. Set the **Parallel** angle to 90° to be parallel to the Y axis. If you are using a spiral-in or spiral-out toolpath for shallow regions, the shape of those regions are automatically calculated based on the slope region boundaries.

- Combo example with parallel
• Combo example with spiral

**Plunge rough**

**Plunge roughing** provides an alternative form of roughing. With this technique, roughing is performed with a series of overlapping holes. The advantage of using this technique is that parts can be roughed quickly because the force of the operation is directly up the spindle. This figure shows a sphere that is being plunge roughed with a flat end tool.

The pattern of drilling operations is parallel to the X or Y axes just like parallel milling (see page 745). Neighboring rows of the pattern can be offset horizontally to better cover the part.
Plunge roughing is performed in either a straight rectangular pattern, as shown below:

![Rectangular Pattern](image1)

or a honeycomb pattern in which each row is offset horizontally by half the rough pass stepover amount:

![Honeycomb Pattern](image2)

The honeycomb pattern is usually preferable. The **Honeycomb pattern** attribute controls the pattern type.

The **Rough pass stepover %** attribute controls how far the holes in the same row are spaced. It is specified as a percentage of the tool's diameter.

![Rough Pass Stepover](image3)

*Restrictions of plunge roughing*

1. The initial implementation of plunge roughing is limited to center cutting tools. While you could use non-center cutting tools, nothing is done to specifically accommodate the use of such tools.

2. There is no control of the retract distance. Retracts are performed in the Z-direction.

3. There is no pecking. Each plunge is performed as a straight linear move.

4. The **Uphill Only** and **Downhill Only** settings do not apply.
Four Axis Rotary overview

Creates a toolpath by rotating the job around the index axis. This axis is often the Z-axis in a turn/mill document and often the X-axis in a milling document. Rotary milling creates toolpaths that cut surfaces without the need for wrapping (see page 243). In a turn/mill document, the feature must have the Cut with X-tool option selected in the Feature Location tab before you can create a rotary operation. The angle of the X-tool must also be 0°.

You can control four axis rotary milling with the following settings.

Strategy options

These attributes are available on the Strategy page of the New Feature wizard and the Strategy (see page 1097) tab in the Feature Properties dialog.

Select a cutting style from:

- **Linear**

  Linear rotary milling causes the tool to traverse along the index axis in straight lines, with the rotary axis only used at the end of each pass to reposition the job.

- **Circular**

  In circular milling the job rotates with the tool at a fixed position, effectively machining a circle. The tool then steps over the required amount and machines the next circle.

- **Spiral**
A continuous spiral is cut along the length of the job when spiral milling is used. To ensure a clean finish a full circle is cut at the two ends. Because rotation is continuous, only Climb and Conventional milling are available (so, you must have a rotary head that can make an unlimited number of rotations).

**Y offset** is a distance to avoid cutting on the center of the tool. A **Y offset** of 0 cuts using the center of the tool.
A **Y offset** of 10 cuts using the position on the tool located 10mm from its center.

**Milling options**
These attributes are available on the **Milling** (see page 1284) tab in the Feature Properties dialog.

**Angle start/end** — Enter the angular positions where you want machining to start and end. It applies only to **Linear** or **Circular** milling. The angular limits are measured in a counter-clockwise direction when viewed along the positive Z axis. The area machined is between the start and end angles.

If **Angle end** is greater than **Angle start**, the tool travels counter-clockwise.

1. **Angle start** = 0°
2. **Angle end** = 120°
3. Tool moves counter-clockwise
If **Angle end** is less than **Angle start**, the tool moves clockwise.

1. **Angle end** = $0^\circ$
2. **Angle start** = $120^\circ$
3. Tool travels clockwise

To machine an area counter-clockwise starting at $350^\circ$ and ending at $10^\circ$ you need to think about the values you enter. If you enter an **Angle start** of $350^\circ$ and an **Angle end** of $10^\circ$ then the tool travels clockwise and machines the opposite of what you want. So you must enter an **Angle start** of $350^\circ$ and an **Angle end** of $370^\circ$ to get the result you want.

**Index start/end coord** — To limit the cutting area along the index axis, set **Index start coord** and **Index end coord**. For a turn/mill document these parameters control the extend of the toolpaths along the Z axis. For a 4-axis milling document, they are values along the index axis.
**Index end coord**

**Stepover** — For **Circular** milling, enter the distance between circular cuts. For **Spiral** milling, enter the distance the tool travels in a full revolution along the index axis.

**Stepover angle** — For **Linear** milling, enter the distance between the linear cuts as an angle around the index axis.

**Options for rotary milling**

**Angle start** and **Angle end** — Enter the start and end positions for **Linear** or **Circular** milling: The angles are measured from the x axis in a counter-clockwise direction when viewed along the positive Z axis.

1. **Angle start** = 0
2. **Angle end** = 90
**Index start coord** and **Index end coord** — Enter the start and end positions for machining along the index axis. For a turn/mill document, these parameters control the extent of the toolpaths along the Z axis. For a 4-axis milling document, they are values along the index axis.

![Index start coord and Index end coord diagram](image)

1. **Index start coord**
2. **Index end coord**

**Stepover** — For **Circular** milling, enter the distance between circular cuts. For **Spiral** milling, enter the distance the tool travels in a full revolution along the index axis.

**Stepover angle** — For **Linear** milling, enter the distance between the linear cuts as an angle around the index axis.

**Corner Remachining**

Remachining is used to automatically mill regions that were not cut by previous operations. You provide the diameter of the previous tool that was used to cut the part and FeatureCAM automatically determines the uncut regions and applies a toolpath to them.

Corner remachining is used to clean up corners that occur between non-tangential surfaces. Each corner edge is called a trace line. By using the options on the strategy page, you may cut in various directions relative to the trace lines.

Corner remachining is available in four different styles: **Along**, **Across**, **Combo along and across**, and **Multi pencil**.
**Along**
This style of remachining creates a corner toolpath which follows the trace lines.

**Across**
Across remachining creates corner toolpaths that zigzag across the trace lines.

**Combo along and across**
The combo corner toolpath creates a corner toolpath which produces **Across** toolpaths on the steep areas of the trace line and **Along** toolpaths on the shallow areas of the trace line.

**Multi-pencil**
This creates a corner toolpath which follows along the trace lines. This is similar to **along**, but it behaves differently at intersections of more than two trace lines, for example:

- Along
- Multi-pencil
The slope boundaries (see page 1133) tab is available, so that a horizontal-only corner operation is possible.

**Detection angle** — only corners below the angle specified are found.

**Detection angle** is the largest angle between adjacent, non-tangential surfaces that is detected as part of a pencil or remachining operation. It is used to set the sensitivity of the region detection. Generally, **Detection angle** should be set as big as possible to detect the unmachined regions.

The tool used for the corner remachining must be smaller than the **Previous** tool diameter.

**Remachining overview**

You can create remachining toolpaths that automatically mill regions that were not cut by previous operations.

There are several types of remachining:

- **Planar remachining** (see page 789).
  
  This is Parallel (see page 745), Z finish (see page 771), or 3D spiral (see page 755) operations with the **Remachining** option enabled in the **Remachining** dialog (see page 1112).
  
  You specify the diameter of the previous tool that was used to cut the part and FeatureCAM automatically determines the uncut regions and applies a toolpath to them.

- **Corner remachining** (see page 786).
  
  Corner remachining is used to clean up corners that occur between non-tangential surfaces. You can specify the whether the tool cuts across or along the trace lines.

- **Pencil milling** (see page 776).
  
  Pencil milling is a single-line toolpath used to clean up corners and fillets.
Planar remachining

Remachining is used to automatically mill regions that were not cut by previous operations. Planar remachining can be performed with a Parallel (see page 745), Z finish (see page 771), or 3D spiral toolpath (see page 755).

You specify the diameter of the previous tool that was used to cut the part and FeatureCAM automatically determines the uncut regions and applies a toolpath to them.

There are other types of remachining (see page 788).

Remachining is useful for:

- Remove material that could not be reached with a larger tool for both finishing and roughing.
- Pre-relieve corners roughed with a larger tool for high speed finishing with a smaller tool.

Examples

In the example below, the trough region is automatically calculated and the parallel toolpath is limited to this region.
For parallel and Z-level remachining, the previous tool diameter is used to calculate the uncut region and the toolpath is clipped to that region as shown in the figures below.
For 3D spiral remachining, the outer boundary of the uncut region is automatically calculated from the previous tool diameter. A toolpath is then created that spirals inward from the boundary. 3D spiral remachining creates a toolpath that is similar to corner remachining (see page 786), but in some cases, the 3D spiral has fewer retracts.

Creating a remachining operation

To create a remachining operation:

1. Create an X-parallel, Y-parallel milling operation, a Z-level finish (see page 771), or a 3D spiral (see page 755) operation using the Features step. Alternatively, a corner remachining (see page 786) operation may be created.

2. On the Strategy page (see page 1060), click Remachining. The Remachining dialog is displayed.

3. Select Remachining and enter a Previous Tool Diameter. This diameter is used to calculate the region for remachining.

4. Click OK to close the dialog.

5. Click Finish.

If the toolpaths do not look correct see Troubleshooting remachining (see page 793) for hints.

Remachining settings

Remachining is controlled by the following Strategy tab settings:

Previous tool diameter — This is the diameter of the tool that was used to previously cut the part. This parameter applies to all remachining methods.
**Overcut percent** — Use this option to expand the remachining region by overstating the Previous tool diameter. It is specified as a percentage of the Previous tool diameter. It is usually a good idea to overcut a little to ensure complete coverage.

**Minimum rest material**

*This parameter does not apply to corner remachining. It applies only to parallel, Z-level and 3D spiral remachining.*

This setting can be used to filter out regions that have a minimal amount of rest material left by the previous tool. The default is 0 which means it tries to cut anywhere the previous tool had a double contact with the part surfaces, including a fillet of the same size as the previous tool (assuming Overcut percent is also set to 0). If Minimum rest material is set to a positive number, the remachining only includes tool paths that remove rest material that is greater than this depth. Its main use is to handle the case where you have some part fillets exactly the size of the previous tool and some that are smaller. If you do not want to remachine the part fillets that are exactly the size of the previous tool you can set Overcut percent to 0 and Minimum rest material to 1 or 2 times the machining tolerance to make sure the previous tool radius sized fillets are not remachined.

The following example part has some fillets that have a 10 mm radius and some smaller fillets. Remachining with a Previous tool diameter of 20 mm and the default Overcut percent of 5 remachines all the fillets:

If you set Overcut percent to 0 to avoid cutting the 10 mm fillets we may get some unwanted tool paths, depending on the machining tolerance and the accuracy of the part model. Here the machining tolerance is set to 0.01 mm and we have some unwanted tool paths:
Generally, setting the **Minimum rest material** to twice the tolerance (0.02 mm in this case) eliminates these extra tool paths.

Another use for **Minimum rest material** is to eliminate noise from the remachining tool paths due to inaccuracies in the part surfaces, non-solid models, poor tolerances, and so on.

**Limitations of planar remachining**

- **Parallel** and **Remachining** operations use projection toolpath techniques and have the same limitations (see page 747) as those techniques.
- **Z-level** finishing **Remachining** has the same limitations **Z-level** finishing (see page 771).

**Troubleshooting planar remachining**

1. Remachining is not generating toolpaths.
   - Examine your part and make sure there are really regions where the previous tool diameter would not fit. A fillet is specified by its radius and a tool is specified by its diameter.

2. Calculating the regions takes too long.
Use a stock boundary on the **Remachine** tab to limit the search for remachining regions or create a separate feature with only the surfaces of interest.

3 Regions that are exactly the same diameter as the previous tool are being ignored.

- If there is a region that you would like to remachine that the previous tool exactly fits into it is best to slightly overstate the **Previous** tool diameter to ensure that the region is properly remachined. For example if you have a pocket with a 0.25 radius corner fillet, you should set the **Previous tool diameter** to **0.51** inches. The region is larger than necessary, but the remachining boundaries are more predictable. Increasing the overcut percentage can also help with this issue.

**Swarf milling**

Swarf cutting calculates toolpaths that cut with the side of the tool and works only on developable surfaces because the tool needs to be in contact with the surface for the whole cutting depth.

For a tool to swarf cut, it has to be able to have contact with the surface at all points along the cutting edge of the tool. For a non-developable surface, FeatureCAM always leaves material on or produces fragmented toolpaths (rather than gouge). This means that you need to look at parts carefully before trying to swarf cut them. It may be that rotating the part (cutting from the side rather than the top of an aerofoil blade) produces the required result.

Swarf machining makes every attempt to machine the selected surfaces but you may have to consider running more commands including ones with different options for swarf milling to obtain the best machining results.

It is possible to identify approximately whether a surface is developable and ruled by shading and also displaying its wire frame geometry within FeatureCAM. You can then orientate the view to be roughly down the expected tool axis vector.
If the surface top edge and the surface bottom edge appear to be parallel at all points, on both edges, and no shaded elements are visible, then the surface is roughly developable and ruled.

Selected Surface
Use the Surface control tab to determine whether you swarf cut:
- on the inside:
or outside of the surface:

On the **Milling** (see page 1268) tab you can set:

- **Axial offset** — offsets the lowest position of the toolpath along the tool axis.
- **Leave allowance** — specifies the amount of stock material to leave after the cut. In PowerMILL this attribute corresponds to **Radial offset**.

1. Using **Leave allowance**
2. No **Leave allowance**

- **Multiple Cuts** — This allows multiple toolpaths with a Z-increment setting.

*Restrictions of swarf milling*

In a non-indexed milling document, swarf machining is limited to a vertical tool axis.
The orientation of the surfaces is quite important in swarf machining. Toolpaths are generated on the outer side of surfaces, that is, on the side of the positive surface normal. Stand-alone surfaces are not 'auto-flipped' (because FeatureCAM does not know which side you want to machine), whereas faces in a solid should have outward pointing normals. In most cases of swarf milling stand-alone surfaces, you must specify the machining side manually.

Swarf machining makes every attempt to machine the part surfaces, even though the part surfaces may not be entirely ruled or developable. This may lead to wild toolpaths (paths that retract a lot and are cut in unintended places). For this reason, we recommend that you include only the ruled surfaces in the feature's part surfaces. You may include other, non-developable surfaces as check surfaces.

Swarf milling works best with ruled surfaces where the parameterization of the surfaces is well-behaved.

Although this appears to be a ruled, developable surface, the isolines are curved. This may lead to strange looking toolpaths, because FeatureCAM tries very hard to keep the entire side of the tool in contact with the surface, in other words, the tool axis may vary radically.

The parameterization below produces toolpaths that are closer to the expected results:

Troubleshooting Swarf

Swarf is a very powerful technique. Unfortunately, in a five-axis simultaneous situation, there are, perhaps, many different correct answers to the swarf problem. FeatureCAM attempts to pick an intelligent answer, but sometimes picks a different answer than what you had in mind. For instance, a single plane can be swarfed in the U direction or the V direction.
In the image below, the feature consists of two magenta surfaces and a red surface. The swarf correctly cuts the required edge of the magenta surfaces, and then (mathematically, correctly) cuts an incorrect edge of the red surface.

There are several things you can try:

- Break the feature into many features (at the limit, you might have one swarf feature per surface). In this case, you may end up with three features.
- In a turnmill document, you may sometimes get the required answer by choosing to cut the feature with an X tool. This is the case for a single planar surface that cuts the U direction instead of the V direction.
- Construct a ruled surface and use it as the part surface(s).
- Additional surfaces can sometimes help FeatureCAM select the correct face. In this picture, the previous hint was also used (the green ruled surface replaced the three faces of the solid).
Eliminate any fillets in the model, and use a ball-end of the appropriate size.

- Decrease or increase the **Tolerance** (see page 1268). Because the surface(s) in between its edge curves may not be perfectly ruled, swarf is very dependent on the tolerance setting.

- Often, the tool is upside down of the required toolpath. Select **Reverse tool axis** on the **Strategy** (see page 1096) tab.

- In cases like the above, the floor of the swarf must not be touched. This is very difficult to do especially with a flat-end tool. You may include the floor as a **Check surface** (see page 1048), but you may not get the complete toolpath. In this situation, you can get close by using **Multiple Cuts** (see page 1268) and a fairly small Z-increment. You may also use a slightly negative **Check allowance** (see page 1268).

- Increase the **Degouge tolerance** (see page 1268). The regular tolerance controls the accuracy of the tessellation. That is, curved surfaces are first flattened out to triangles, and it's the triangles that are machined. The **Degouge tolerance**, tells FeatureCAM that, in order to get a better, smoother toolpath, it's okay to gouge the triangles by up to that much.

**5-Axis Trim**

This technique allows you to profile (or trim) around the outside of a set of surfaces. This technique only works on surface models (not triangle models). On the **Strategy** (see page 1108) page of the trim operation, select whether to profile on the **Inside edge** of the surface:
or the **Outside edge** of the surface:

![Diagram](image)

*The trim operation computes toolpaths only for unconnected edges in the feature’s surface set. For instance, if all six faces of a cube are part surfaces in a shell milling feature, the trim operation does not generate any toolpaths (because all edges are connected to other edges in the feature). That is, to trim the top face of a cube, select only the top face for the feature, so the feature should consist of one part surface.*

### 5-axis Hole feature (5AP)

You can create 5-axis Hole features from simple circles in space. You do not need to use solids, Feature Recognition, or surfaces.

The following 5-axis part example was created with only geometry and curves:

![Part example](image)

To create a 5-axis Hole feature on the drafted corner side area, you just need a circle in the correct position, in this example parallel with the drafted face:

![Circle diagram](image)

This circle lies at a different vector orientation to the Z-axis Setup. You can create a Hole feature that is normal to the selected circle.

To create a Hole feature from a circle:

1. Select the circle.
2. Click the **Features** step.
The New Feature wizard is displayed, with Hole in the From Dimensions section selected:

3 Click Next.

The New Feature - Dimensions page is displayed. FeatureCAM uses the Diameter from the circle by default, for example:

4 Optionally change the Diameter, and any other options you need.

5 Click Finish.
The direction of the Hole is based on how the geometry was created, and may be created in the wrong direction, for example:

6 If the Hole is created in the wrong direction, use the **Reverse direction** button on the **Location** tab of the **Feature Properties** dialog to reverse it.
Turning features (TURN)

The following features are available for turning:

**From Dimensions**
- Hole (see page 805)
- Groove (see page 807)
- Thread (see page 816)
- Face (see page 822)
- Cutoff (see page 825)
- Bar Feed/Bar Pull (see page 828)

**From Curve**
- Turn (see page 832)
- Bore (see page 840)
- Groove (see page 807)
- Thread (see page 816)

**Other**
- Sub-spindle (see page 843)
- Misc
- User (see page 857)
- Toolpath (see page 633)
Part Handling (see page 848)

Turning canned cycles (see page 854)

Hole (TURN)

Turned Hole features are created and controlled in the same way as milled hole (see page 637) features. They are manufactured in a similar manner, with the exception that the material instead of the tool is rotating when turning.

To create a turned Hole feature:

1. Click the Features step in the Steps panel.

The New Feature wizard is displayed.
2. In the **From Dimensions** section, select Hole and click *Next* to open the **New Feature - Dimensions** page.

3. Select the type of Hole from the **Type** list.
   - A **Plain Hole** is a simple Hole with an optional chamfer.
   - A **Counter Bore** Hole.
   - A **Counter Sink** Hole.
   - A **Counter Drill** Hole.
   - A **Tapped Hole** is a Hole that is under-sized drilled and then tapped.
   - A **CD Tapped** Hole is a counter drilled Hole with the bottom part of the hole tapped.

4. Enter a **Diameter** value.

   *If you are building holes from circles, select the circle before opening the wizard to pre-populate this field.*

5. Enter how deep the Hole is in the **Depth** field.

6. Select **Through** to increase the hole length by 10% of the hole diameter to account for the drill tip and prevent burring.

   Depending on the type of hole you selected, you may have other dimensions (see page 651) to fill in such as Chamfer and Drill Depth. For tapped holes, you can click the **Standard Threads** button and select a thread type. Each thread type sets the Thread depth, TPI, and Diameter dimensions.
7 Click **Next** to open the **New Feature - Location** page.

8 Enter the location of the hole.

9 Click **Next** to open the **New Feature - Strategies** page. The options on this page are the same as those on the **Strategy** (see page 889) tab of the **Hole Feature Properties** dialog.

10 Click **Next** to open the **New Feature - Operations** (see page 564) page.

11 Click **Next** to open the **New Feature - Tool Usage** page.

12 Click **Next** to open the **New Feature - Summary** (see page 567) page.

13 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

You can click **Finish** (see page 531) at any stage during the wizard to accept the default settings for the remaining pages and exit.

### Groove (TURN)

The Groove feature is used to machine smaller slots or undercut regions.

You can create a turned Groove feature from dimensions or from a curve. There are four types of turned Groove feature:

**OD dimensioned Groove**

1 - Depth
2 - Width
3 - Chamfer
4 - Angle
5 - Radius

**ID dimensioned Groove**

1 - Depth
2 - Width
3 - Chamfer
4 - Angle
5 - Radius
When creating a turned Groove feature, FeatureCAM does the following:

1. Determines what tool to use (see page 808).
2. Determines feed and speed values based on the material being machined.
   The recommended feed and speed values for an operation are displayed on the Feed/speed tab. The recommended feeds and speeds are derived from the Groove column of the turning feed/speed tables.
3. Generates a Rough (see page 814) pass, possibly in multiple Z steps depending upon the depth of the feature.
4. Generates a Finish (see page 815) pass.

**Turned groove tool selection**

The default selected tool for turning has:

1. **Lathe - Groove/Cut** type.
2. An Insert with a Width of at least the Groove feature's Width - Z finish allowance.
3. The shortest depth that can cut to the bottom of the Groove feature.
4. The correct orientation for the type of cut.
5. For ID Groove features, the length of the groove is checked against the length of the holder to ensure that it will extend far enough into the part.
For Face Groove features cut in the positive direction, the inside edge of the Groove feature is between the Min plunge diameter and Max plunge diameter values.

Many Face Groove tools have curved holders. Due to the curvature of the holders the tools have a limited set of diameters at which they can plunge. The image below shows the curved shape of the supporting holder.

These two diameters are the minimum and maximum diameters between which the tool can plunge.

The tool inside edge of the groove must be between the **Min plunge diameter** and **Max plunge diameter** if the Groove is being cut in the positive direction. The outside edge must be between these two diameters if the Groove is being cut in the negative direction.

For Face Groove features cut in the negative direction, the outside edge of the Groove feature is between the Min plunge diameter and Max plunge diameter values.

Many Face Groove tools have curved holders. Due to the curvature of the holders the tools have a limited set of diameters at which they can plunge. The image below shows the curved shape of the supporting holder.

These two diameters are the minimum and maximum diameters between which the tool can plunge.
The tool inside edge of the groove must be between the Min plunge diameter and Max plunge diameter if the Groove is being cut in the positive direction. The outside edge must be between these two diameters if the Groove is being cut in the negative direction.

*The Tip radius and insert grade do not affect the choice of tool.*

Creating a Groove feature (TURN)

You can create a Groove feature either From Dimensions or From Curve.

**From Dimensions**

To create a Groove feature from dimensions:

1. Click the Features step in the Steps panel.

   The New Feature wizard is displayed.
2 In the **From Dimensions** section, select **Groove**, then click **Next** to open the **New Feature - Dimensions** page. Set these attributes:

- **Diameter** — Enter the diameter of the Groove feature.
- **Depth** — Enter the depth of the Groove feature.
- **Width** — Enter the width of the Groove feature.
- **Angle** — Optionally enter the angle of the Groove feature.
- **Location** — Select **ID** for an inside diameter Groove or **OD** for an outside diameter Groove.
- **Orientation** — Select the orientation of the Groove feature from **X axis**, **Face**, or **Backface**.

3 If your curve is a simple groove, select **Simple Groove** as the **Type**. This option simplifies the manufacturing strategy for the feature. Select this option to machine the feature by making a single pass down the center of it with a tool whose radius is equal to the width of the feature.

4 If your curve is a regular groove, select **From dimensions** and set these attributes:

- **Chamfer/Radius** — Optionally add a chamfer or a radius to the top of the Groove at each side. Select **Chamfer** or **Radius** from the menu and enter the value.
- **Angle** — Optionally enter an angle for each side wall of the Groove.
- **Radius** — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner. You can have a different bottom radius for each side of the Groove.

5. Click **Next** to open the **New Feature - Location** (see page 574) page.

6. Click **Next** to open the **New Feature - Strategies** (see page 575) page.

7. Click **Next** to open the **New Feature - Operations** (see page 564) page.

8. Click **Next** to open the **New Feature - Default Tool** (see page 603) page for the first operation.

9. Click **Next** to open the **New Feature - Feed/Speed** (see page 606) page for the first operation.

10. Click **Next** to open the **New Feature - Tool Usage** (see page 607) page for the first operation.

11. If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

12. Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

   You can edit (see page 884) the feature later.

**From Curve**

To create a Groove feature from a curve:

1. Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 530) wizard.

2. In the **From Curve** section, select **Groove**, then click **Next** to open the **New Feature - Curve** (see page 574) page.

3. Click **Next** to open the **New Feature - Location** (see page 574) page.

4. Click **Next** to open the **New Feature - Dimensions** page.

   - **Location** — Select **ID** for an inside diameter Groove or **OD** for an outside diameter Groove.

   - **Orientation** — Select the orientation of the Groove feature from **X axis, Face, or Backface**.
5 Click **Next** to open the **New Feature - Strategies** (see page 575) page.

6 Click **Next** to open the **New Feature - Operations** (see page 564) page.

7 Click **Next** to open the **New Feature - Default Tool** (see page 603) page for the first operation.

8 Click **Next** to open the **New Feature - Feed/Speed** (see page 606) page for the first operation.

9 Click **Next** to open the **New Feature - Tool Usage** (see page 607) page for the first operation.

10 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

11 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

*You can edit (see page 884) the feature later.*

**Cutting wide Face Groove features (TURN)**

FeatureCAM roughs a Groove feature in only one direction. The Groove can be cut in the positive X or negative X direction. Due to the curved shape of the face groove tool holders, face grooving tools have a limited range (between the Min plunge diameter and Max plunge diameter) in which they can plunge.

Many Face Groove tools have curved holders. Due to the curvature of the holders the tools have a limited set of diameters at which they can plunge. The image below shows the curved shape of the supporting holder.

![Image of Face Groove tool holder](image)

These two diameters are the minimum and maximum diameters between which the tool can plunge.
The tool inside edge of the groove must be between the Min plunge diameter and Max plunge diameter if the Groove is being cut in the positive direction. The outside edge must be between these two diameters if the Groove is being cut in the negative direction.

To cut wide Face Grooves you may need to create three grooves:

1. The groove you want to machine has Diameter $D$ and the Width $W$.
2. The plunge diameter $P$ is a value between the Min plunge diameter and Max plunge diameter of the tool.
3. Create a Groove feature with Diameter $P$ and Width $W - (D-P)$. On the Strategy tab select a Rough pass only and set its Feed dir to Negative.
4. Create a second Groove feature and set the Diameter to $D$ and the Width to $(D-P)$. On the Strategy tab select a Rough pass only and set its Feed dir to Positive.
5. Create a third Groove feature and set the Diameter set to $D$ and Width set to $W$. On the Strategy tab, select a Finish pass only.

**Groove roughing (TURN)**

Groove features are roughed by plunging parallel to the X-axis retracting, stepping over in the -Z direction and then plunging again. This figure shows the groove roughing algorithm and the manufacturing attributes that control the process.
If your Groove feature has angled walls, the rectangular middle portion of the groove is roughed first and then the slanted walls are roughed as shown in this figure.

The details of this operation are controlled by the manufacturing attributes contained on the **Turning** (see page 1420) tab of the **Feature Properties** (see page 884) dialog.

**Groove finishing (TURN)**

The Finish pass cuts a path that is offset from the Groove feature's profile to the tool's tip center for the entire (defined) curve. The offset value is just the tool tip radius. Groove features are finished using a technique called *shoulder stroking*. This technique ensures that the grooving tool never cuts in the upward direction. Profiling proceeds in the -Z direction until the curve moves up in X. The tool then rapids to the highest point and cuts back in the +Z direction. This process repeats until the entire Groove is finished. This figure shows an example for a symmetric Groove with angled walls:

![Diagram of groove finishing](image)

This image shows an example of a groove with multiple valleys:

![Diagram of multiple valleys](image)

The following attributes affect turn groove finishing:

**On the Turning** (see page 1420) tab:

- Clearance
- Side liftoff dist
- Start point
- End point
- Tool change location
- Post Vars

**On the Strategy** (see page 1366) tab:

- Clearance
- Side liftoff dist
- Start point
- End point
- Tool change location
- Post Vars
Feed dir
Use finish tool

**Thread feature (TURN)**

The **Thread feature** allows you to put threads on either the:

**ID**

- 1. Thread height
- 2. Thread length
- 3. Pitch
- 4. Minor diameter

**OD**

- 1. Thread height
- 2. Thread length
- 3. Pitch
- 4. Major diameter

**From Dimensions and From Curves**

Standard thread features created using **From Dimensions** are cut with tools whose shape exactly match the shape of the thread form.

Thread features created **From Curves** have a more general profile and are cut in multiple passes in both X and Z.

This feature supports:

**OD threads**
ID threads

Tapered threads

There is no explicit designation of the type of thread. Instead, the type of thread is inferred from the profile (see page 820) that is provided.

If you are creating a Thread feature to cut with a form tool that perfectly matches the shape of the thread, use a standard thread that is created From Dimensions. The simulation does not show the proper thread cross-section, but the toolpaths generated are correct.

How a Thread feature is manufactured

FeatureCAM follows this general process to create a Thread feature:

1. Determines what tool to use (see page 821).
2. Picks feeds and speeds based on the material being machined.

To view the recommended speed value for a threading operation, click the operation in the tree view and select the Feed/speed tab. The recommended speeds are derived from the Thread column of the turning feed/speed tables. Feed values are determined by the canned cycle on the machine tool.
3 Optionally creates a Rough and/or Finish pass to turn the part down to the diameter of the thread. The creation of these operations is controlled by the Rough and Finish options on the Strategy page. See How a turn feature is manufactured (see page 833) for more details.

4 Optionally generates a roughing pass for the relief groove. The existence of this operation is controlled by the Relief groove option on the Strategy page.

5 Generates a Thread (see page 822) pass.

Creating a Thread feature

You can create a Thread feature either From Dimensions or From Curve.

From Dimensions

To create a Thread feature from dimensions:

1 Click the Features step in the Steps panel.

   The New Feature wizard is displayed.

   ![New Feature Wizard](image)

2 In the From Dimensions section, select Thread, then click Next to open the New Feature - Dimensions page for a Thread.

3 Specify the dimensions of the Thread:
   
   ▪ **Type** — select ID for an inner diameter Thread or OD for an outer diameter Thread.
   
   ▪ **Custom** — Enter the thread dimensions.
   
   ▪ **Standard Thread** — Select a thread from the list to use standard dimensions.
- **Thread** — Select a **Left hand** or **Right hand** thread. When viewed from the end of the part toward the chuck, on a left hand thread the tool winds counter-clockwise as it moves towards the chuck, on a right hand thread the tool winds clockwise as it moves towards the chuck.

- **Minor/Major Diameter** — Enter the **Minor Diameter** for an ID feature or the **Major Diameter** for an OD feature.

- **Pitch** — Enter the pitch of the thread.

- **Thread Length** — Enter the length of the thread.

- **Thread Height** — Enter the height of the thread.

- **Tapered** — If your thread is tapered, select this option and enter the taper **Angle**.
  
  Tapered taps are driven to a different depth than straight taps. For straight taps, a tip allowance is added to the thread depth so that the tool cuts the complete thread, this is not added for tapered taps so that the OD is not affected.

4 Click **Next** to open the **New Feature - Location** (see page 574) page.

5 Click **Next** to open the **New Feature - Strategies** (see page 575) page.

6 Click **Next** to open the **New Feature - Operations** (see page 564) page.

7 Click **Next** to open the **New Feature - Default Tool** (see page 603) page for the first operation.

8 Click **Next** to open the **New Feature - Feed/Speed** (see page 606) page for the first operation.

9 Click **Next** to open the **New Feature - Tool Usage** (see page 607) page for the first operation.

10 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

11 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

*You can edit (see page 884) the feature later.*

**From Curve**

To create a Thread feature from a curve:
1 Click the Features step in the Steps panel to open the New Feature (see page 530) wizard.

2 In the From Curve section, select Thread, then click Next to open the first New Feature - Curve (see page 574) page.

3 Click Next to open the New Feature - Dimensions page.
   a For Thread, select either Left hand or Right hand. When viewed from the end of the part toward the chuck, on a left hand thread the tool winds counter-clockwise as it moves towards the chuck, on a right hand thread the tool winds clockwise as it moves towards the chuck.
   b Enter the Thread Length and the Pitch (Pitch = 1/TPI). For threads from curves (see page 820), the pitch is the distance between replications of the curve. The pitch must be greater than or equal to the length of the curve.

   If you are creating a Thread from a curve, the Taper option is unavailable. The taper of a thread from curves is determined by the X angle between the start and end points of the curve.

4 Click Next to open the New Feature - Location (see page 574) page.

5 Click Next to open the New Feature - Strategies (see page 575) page.

6 Click Next to open the New Feature - Operations (see page 564) page.

7 Click Next to open the New Feature - Default Tool (see page 564) page.

8 Click Next to open the New Feature - Feed/Speed (see page 567) page.

9 Click Next to open the New Feature - Summary (see page 567) page.

10 Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

   You can edit (see page 884) the feature later.

**Thread curve types**

The curve for a Thread feature must represent a single groove of the thread. The images below are examples for OD thread curves.
This curve is replicated along the curve. The curve length must be greater than or equal to the thread pitch. If the thread length is less than the pitch, a linear segment is inserted between the grooves, for example.

When creating a Thread feature from a curve, the distinction between an OD and ID feature is determined from the curve. For OD features, you should model an upward facing groove. ID curves should be downward facing grooves. As an example, if you are creating a rope thread, the basic shape of the groove is a sine wave.

If you want to create this thread on the OD you should use the red curve shown below.

To create an ID thread, you should use the downward facing curve shown in red in the following image.

The taper angle of the Thread is determined by the X angle between the first and last points of the curve. For straight tapers, the two points should have the same X coordinate. For tapered threads, the angle between the endpoints will be used as the thread taper. In the image below, the thread has a 5 degree taper.

**Thread tool selection**

The default selected tool for turning has:
1 Lathe - Thread tool type.
2 The insert must have a TPI range that contains the pitch of the required thread.
3 The proper orientation for the type of cut. See turn roughing, semi-finishing and finishing, face roughing, or backface roughing for more information.

* Currently tip radius, tool length, and insert grade are not taken into account.*

**Thread operation**

The number of passes is controlled by the **Passes** option on the **Strategy** tab. You can specify either **Fixed** or **Calculate**.

- If you select **Fixed**, you must enter the total steps **Count** needed for the Thread operation. In this case, the passes are of a fixed depth.
- If you select **Calculate**, then the number of steps for the threading operation is calculated by the system. Additionally, if you select **Calculate**, then you must supply data for the **Step 1**, **Step 2** and **Minimum Infeed** fields. In this case, the first step is cut at a depth of **Step 1**. The second and successive cuts are at a depth of **Step 2**. When the remaining depth is less than **Minimum Infeed**, it is cut with a single pass.

The other details of this operation are controlled by the manufacturing attributes on the **Threading** (see page 1459) tab.

**Face (TURN)**

A turn Face feature is a straight cut that cleans up the front of the part.

1 Outer diameter
2 Thickness
3 Inner diameter

FeatureCAM follows this general process:

1 Determines what tool to use. The default selected tool for turning has:
- **Lathe - Turning** tool type.
- The proper orientation for the type of cut. See Turn Face feature tool orientations for more information.

<table>
<thead>
<tr>
<th>Turret</th>
<th>Cut direction</th>
<th>Orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>-Z</td>
<td>OR</td>
</tr>
<tr>
<td>Front</td>
<td>-Z</td>
<td>OR</td>
</tr>
</tbody>
</table>

- An 80° diamond is preferred but the default selected tool must have an included tip angle of at least 55°. You can override the tooling selection with a tool that has a narrower diamond insert, but such a tool is not automatically selected.

> *Currently tip radius, tool length, and insert grade are not taken into account.*

1. Picks feeds and speeds based upon the material being machined.

To view the recommended feed or speed value for a turned Face operation, select the operation in the tree view and then select the **Feed/speed** tab. The recommended feeds and speeds are derived from the Face column of the turning feed/speed tables.

2. If roughing has been requested, generate a roughing pass possibly in multiple X steps depending upon the depth of the feature.

The roughing pass of the turn Face feature is turned off by default. Click the **Strategy** tab and select **Rough** to turn on the roughing pass.

   - If the **Positive Feed Direction** is selected on the **Dimensions** tab, the roughing is performed in the +X direction.
   - If the **Negative** direction is selected, the roughing is performed in the -X direction.

The algorithm is the same as the Turn feature roughing (see page 834), except that the Withdraw Angle is fixed at 90° and the Engage Angle defaults to 45° and must be set to less than 90°.

3. Generates a finishing pass.

   If **ID** is selected on the **Dimensions** tab, the finishing is performed in the +X direction. If **OD** is selected, the finishing is performed in the -X direction. The algorithm is the same as Turn and Bore feature finishing (see page 839).
Creating a turned Face feature

1. Click the **Features** step in the **Steps** panel. The **New Feature** wizard is displayed.

   ![New Feature Wizard](image)

2. Select **Face** as the **Feature type** and click **Next** to open the **New Feature - Dimensions** page.

   ![New Feature - Dimensions](image)

   - **Feed direction** — Select **Positive** if you want to cut in the +X direction or select **Negative** if you want to cut in the -X direction.
   - **Outer Diameter** — Enter the top X value as the Outer Diameter.
   - **Inner Diameter** — Enter the inner diameter.
   - **Thickness** — Enter the amount of material to remove in Z.
3 Click Next to open the **New Feature - Location** (see page 574) page. Enter the Z coordinate of the left edge of the feature.

4 Click **Next** to open the **New Feature - Strategies** page. By default, face features only generate a **Finish** pass. If you want a roughing pass as well, select **Rough**.

5 Click **Next** to open the **New Feature - Operations** (see page 564) page.

6 Click **Next** to open the **New Feature - Default Tool** (see page 564) page.

7 Click **Next** to open the **New Feature - Feed/Speed** (see page 606) page.

8 Click **Next** to open the **New Feature - Tool Usage** (see page 607) page.

9 Click **Next** to open the **New Feature - Summary** (see page 567) page.

10 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

*You can edit (see page 884) the feature later.*

**Cutoff feature**

The **Cutoff** feature cuts the part off with a plunge cut with an optional back chamfer.

1 - Chamfer  
2 - Diameter  
3 - Width  
4 - Inner diameter

FeatureCAM follows this general process to create a **Cutoff** feature:

1 Determines what tool to use (see page 827).

2 Picks feeds and speeds based upon the material being machined.
To view the recommended feed or speed value for a cutoff operation, click the operation in the tree view and then click the Feed/speed tab. The recommended feeds and speeds are derived from the Cutoff column of the turning feed/speed tables.

3 Generates a cutoff (see page 828) finishing pass.

Creating a Cutoff feature

To create a Cutoff feature:

1 Click the Features \( \square \) step in the Steps panel.
The New Feature wizard is displayed.

2 In the From Dimensions section, select Cutoff and click Next to open the New Feature - Dimensions page.
- **Chamfer/Radius** - Optionally add a chamfer or a radius to the Cutoff feature. Select Chamfer or Radius from the menu and enter the value.
- **Diameter** - Enter the (outer) diameter.
- **Inner Diameter** — Enter the inner diameter.
- **Width** - Enter the width of the Cutoff tool.

3 Click **Next** to open the **New Feature - Location** (see page 574) page. Enter the Z coordinate as the left edge of the Cutoff feature.

4 Click **Next** to open the **New Feature - Strategies** (see page 575) page.

5 Click **Next** to open the **New Feature - Operations** (see page 564) page.

6 Click **Next** to open the **New Feature - Default Tool** (see page 603) page.

7 Click **Next** to open the **New Feature - Feed/Speed** (see page 606) page.

8 Click **Next** to open the **New Feature - Tool Usage** (see page 607) page.

9 Click **Next** to open the **New Feature - Summary** (see page 567) page.

10 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

   *You can edit (see page 884) the feature later.*

**Cutoff feature tool selection**

The default selected tool for turning has:

1 Lathe - groove/cutoff type.
2 An insert Width equal to the Cutoff feature Width.
3 The shortest depth that cuts to the bottom of the feature.
4 The proper orientation for the type of cut. For Back turrets, the orientation is required. For Front turrets, the orientation is required.

*Tip radius, and insert grade are not taken into account.*
**Cutoff feature finishing operation**

If there is no chamfer, the cutoff is performed as a simple plunge.

If there is a chamfer:

1. The cutoff groove is plunged down to the depth of the chamfer.
2. The tool traces along the chamfer and then down the cutoff groove.

If there is a chamfer and **Plunge Rough Chamfer** is selected on the **Strategy** page:

1. The cutoff groove is plunged down to the depth of the chamfer.
2. The chamfer is plungedroughed.
3. The tool traces along the chamfer and then down the cutoff groove.

**Bar Feed/Bar Pull**

A **Bar Feed** feature provides support for both:

**Bar Feeder**

1 - Diameter  
2 - Feed amount

**Bar Puller**

1 - Overlap  
2 - Pull amount
How a Bar Feed/Bar Pull is performed:

1. For:
   - Bar Feed operations, the tool rapids to the point (Diameter, 0, Z-Clearance).
   - Bar Pull operations, the tool rapids to a point in front of the stock along the Z-axis and then feeds to the point (0, 0, Z-Clearance-Overlap).

2. The tool then feeds out the **Pull amount** or the **Feed amount**.

3. The feedrate is controlled by the **FPM** attribute.

*Bar Feed features are only simulated with centerline simulations. 2D and 3D simulations ignore these operations.*

Creating a Bar Feed feature

1. Click the **Features** step in the **Steps** panel.
   The **New Feature** wizard is displayed.
2 Select Bar Feed, then click Next to open the New Feature - Dimensions page and select Bar Feeder from the Type menu.

- **Diameter** - Enter the Y coordinate for the bar feed.
- **Feed Amount** - Enter the amount of material you want to feed in the Z direction.

3 Click Next to open the New Feature - Operations (see page 564) page.

4 Click Next to open the New Feature - Default Tool (see page 564) page.

5 Click Next to open the New Feature - Tool Usage page.

6 Click Next to open the New Feature - Summary (see page 567) page.

7 Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

   You can edit (see page 884) the feature later.

**Creating a Bar Pull feature**

1 Click the Features step in the Steps panel.
The **New Feature** wizard is displayed.

![New Feature wizard](image)

2. Select **Bar Feed**, then click **Next** to open the **New Feature - Dimensions** tab and select **Bar Puller** from the **Type** menu.

![New Feature - Dimensions](image)

- **Overlap** - Enter the amount of material to hold in the puller (in the Z direction).
- **Pull Amount** - Enter the amount of material you want to pull in the Z direction.

3. Click **Next** to open the **New Feature - Operations** (see page 564) page.

4. Click **Next** to open the **New Feature - Default Tool** (see page 564) page.

5. Click **Next** to open the **New Feature - Tool Usage** page.
6 Click **Next** to open the **New Feature - Summary** (see page 567) page.

7 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

**Turn feature**

The **Turn feature** roughs, semi-finishes, and finishes an outer diameter (OD) curve.

**Manufacturing hints for Turn features**

We recommend that you select the **Undercut check** option for Turn or Bore features. This attribute uses the geometry of the insert to prevent gouging.

If the entire feature was not cut, it could be that the feature could not be cut entirely with the selected tool. FeatureTURN checks the toolpath to make sure that the tool can cut the specified path without crashing into the part itself.
If a conflict is found, the system automatically alters the toolpath so that a safe path is maintained. A message is displayed warning the user that the path has been changed.

**Turn features restrictions**

- The curve must not cross the X-axis.
- For **Face** or **Backface** roughing, the curve must cross the top of the stock or the max diameter must be set to the maximum X of the curve.

**How a turn feature is manufactured**

FeatureTURN follows this general process:

1. Determines what tool to use (see page 833).
2. Picks feeds and speeds (see page 833) based upon the material being machined.
3. Generates a Rough (see page 834) pass, possibly in multiple Z steps depending upon the depth of the feature.
4. Generates a Semi-finish (see page 838) pass.
5. Generates a Finish (see page 839) pass.

**Turn feature tool selection**

The default selected tool for turning has:

1. **Lathe - Turning** tool type.
2. The proper orientation for the type of cut. See turn roughing, semi-finishing and finishing, face roughing or backface roughing for more information.
3. An 80° diamond is preferred but the default selected tool must have an included tip angle of at least 55°. You can override the tooling selection with a tool with a narrower diamond insert, but such a tool will not be automatically selected.

*Tip radius, tool length and insert grade are not taken into account.*

**Turn feature feeds and speeds**

To view the recommended feed or speed value for a turning operation, select the operation in the tree view and then select the **Feed/speed** tab. The recommended feeds and speeds are derived from the OD column of the turning feed/speed tables.

See also:
Explicitly setting a feed or speed value for a turned operation (see page 1510)
All about feeds and speeds (see page 1508)

New Turn feature - Strategies page

Use canned cycle

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

For support of canned cycles in Fanuc controllers, use the fanucez.cnc post.

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.

Hole features

If Enable drilled canned cycles is deselected in the Post options dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If Enable drilled canned cycles is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.
Turn/Bore features
Canned cycles for Turn and Bore features must be enabled by selecting **Enable turn canned cycles** in the **Post options** dialog. You must then go to the **Properties** dialog for each Turn/Bore feature, click the **Strategy** tab and select **Use canned cycle**. Also select **Reuse path in canned cycle** if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

Groove features
Enable grooving canned cycles in the **Post options** dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature's **Property** dialog, clicking the **Strategy** tab, and then clicking **Use path canned cycle**. You can also set this attribute on the **Groove** tab of the default attributes, but this will only apply to features you create after changing this setting.

Thread features
Thread features always use canned cycles.

**Reuse path in canned cycle** — Relates to **Use canned cycle**. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

**Cycle** — Select from:

- **Turn/Bore** — This cycle roughs within the defined material boundaries by feeding parallel to the part's center line along the Z axis while stepping down in the X axis. If you select **Negative**, the tool moves from right to left. If you select **Positive**, the tool moves from left to right. If the **Total stock** (see page 1445) attribute is set, then the part is roughed using curves that are offset from the feature's profile.
**Turn** cycle rough operation with **Positive** feed direction:

- **Face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the negative direction.

**Turn** cycle rough operation with **Negative** feed direction:
- **Back face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the positive direction.

If you are creating your part from a casting instead of from bar stock, use the Stock Curve to limit the extent of the roughing pass.

A stock curve controls the boundaries of the roughing pass. This figure shows roughing without a stock curve.

This figure shows the use of a stock curve to limit the area that is roughed.

For a turn roughing pass the curve must have a single value of X for every value of Z. For a facing pass or back facing pass the curve must have a single value of Z for every X. Stock curves can be used for both turning and boring features.

The Boundaries parameter further restricts the region that is roughed.
The **Left boundary**, **Right boundary**, and **Max radius boundary** parameters limit the portion of the feature that is roughed. These boundaries are displayed in blue whenever you select the rough operation in the tree view. When the material boundaries are defined to machine a part, the boundary must be specified so that it completely encloses the path (for example, the path cannot start or end in the middle of the rectangular box; it must start on, or outside of the boundary).

When the path is defined, it may extend beyond the material boundary. This is a powerful technique, because a long path can be defined, then an area in which a specific portion is roughed only between material boundaries can be established. In a second segment, the path could be copied, then the boundaries to rough another section of the path can be redefined, and so on.

**Turn feature semi-finishing**

The semi-finishing pass cuts a path that is offset from the part's surface to the tool's tip center for the entire (defined) curve. The offset value is $\frac{1}{2} \times$ the **X finish allowance** (see page 1420) and $\frac{1}{2} \times$ the **Z finish allowance** (see page 1420) of the Rough pass. Profiling proceeds in the -X direction unless you select **Positive** for the **Feed direction** on the **Strategy** page.
Turn and Bore feature finishing

The Finish pass cuts a path that is offset from the part's surface to the tool's tip center for the entire (defined) curve. The offset value is just the tool tip radius. Profiling proceeds in the -Z direction unless you select Positive for the Feed direction is selected on the Strategy (see page 1367) tab.

Creating a Turn feature

To create a Turn feature:

1. Create the curve that defines the shape of the feature.

2. Click the Features step in the Steps panel. The New Feature wizard is displayed.

3. In the From Curve section, select Turn, then click Next to open the New Feature - Curve page (see page 574).

4. Click Next to open the New Feature - Location page.

5. Click Next to open the New Feature - Strategies page. A turned feature automatically creates a roughing, and finishing operations. If you want to create fewer operations, select the appropriate operations. The other attributes on this page are the same as those on the Strategy (see page 1366) tab of the Feature Properties (see page 884) dialog.

6. Click Next to open the New Feature - Operations page.

7. Click Next to open the New Feature - Default Tool page for the first operation.
8 Click **Next** to open the **New Feature - Feed/Speed** (see page 606) page for the first operation.

9 Click **Next** to open the **New Feature - Tool Usage** (see page 607) page for the first operation.

10 If you have more than one operation, clicking **Next** opens the **New Feature - Default Tool** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 567) page.

11 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

   You can edit (see page 884) the feature later.

If you are working from a casting, you can include a stock curve to limit the extent of the roughing pass. To set a stock curve:

1 After you have created the feature, open the **Feature Properties** (see page 884) dialog and click the **Dimensions** tab.

2 Click the **Stock Curve** button and select the curve from the **Curve** list.

3 Click **OK**.

**Bore feature**

The **Bore feature** roughs, semi-finishes, and finishes either an inner diameter (ID) curve.

FeatureCAM follows this general process:

1 Determines what tool to use (see page 842).

2 Picks feeds and speeds based on the material being machined.

   To view the recommended feed or speed value for a Bore operation, click the operation in the tree view and then click the **Feed/speed** tab. The recommended feeds and speeds are derived from the **ID** column of the turning feed/speed tables.
3 Generates a Rough (see page 834) pass, possibly in multiple Z steps depending upon the depth of the feature. The toolpaths are the same as a Turn feature.

4 Generates a Semi-finish (see page 838) pass. The toolpaths are the same as a Turn feature.

5 Generates a Finish (see page 839) pass. The toolpaths are the same as a Turn feature.

**See also:**

Feeds and speeds (see page 1508)

Explicitly setting a feed or speed value for a turned operation (see page 1510)

*Creating a Bore feature (TURN)*

To create a Bore feature:

1 Create the curve that defines the shape of the feature.

2 Click the **Features** step in the **Steps** panel. The **New Feature** wizard is displayed.

3 In the **From Curve** section, select **Bore**, then click **Next** to open the **New Feature - Curve** (see page 574) page.

4 Click **Next** to open the **New Feature - Location** (see page 574) page.
Click Next to open the New Feature - Strategies (see page 575) page. A bore feature automatically creates a roughing, and a finishing operation. If you want to create fewer operations, select the appropriate operations. The other attributes on this page are the same as those on the Strategy (see page 1366) tab of the Feature Properties (see page 884) dialog.

Click Next to open the New Feature - Operations (see page 564) page.

Click Next to open the New Feature - Default Tool (see page 603) page for the first operation.

Click Next to open the New Feature - Feed/Speed (see page 606) page for the first operation.

Click Next to open the New Feature - Tool Usage (see page 607) page for the first operation.

If you have more than one operation, clicking Next opens the New Feature - Default Tool page for the next operation. If you have no more operations, clicking Next opens the New Feature - Summary (see page 567) page.

Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

You can edit (see page 884) the feature later.

If you are working from a casting, you can include a stock curve to limit the extent of the roughing pass. To set a stock curve:

1 After you have created the feature, open the Feature Properties (see page 884) dialog and click the Dimensions tab.
2 Click the Stock Curve button and select the curve from the Curve list.
3 Click OK.

**Bore feature tool selection**

The default selected tool for turning has:

1 Lathe - Boring tool type.
2 The proper orientation for the type of cut. If you have a Back turret the orientation is preferred. For Front turrets, the orientation is preferred.
3 An 80° diamond is preferred but the default selected tool must have an included tip angle of at least a 55°. You can override the tooling selection with a tool with a narrower diamond insert, but such a tool is not automatically selected.

*Tip radius, tool length, and insert grade are not taken into account.*

**Sub-spindle feature**

A **Sub-spindle** feature enables you to manipulate the main and sub spindles. Often these features are used to transfer the stock from one spindle to the other. There are two ways to transfer operations in FeatureCAM:

- You can program each operation by using Sub-spindle features. To do this you must create the appropriate sequence of Sub-spindle features for your part. You must also use a post that fills in all the required sub-spindle formats properly.

- You can use an add-in (macro) that emits a full block of G-code describing the transfer from a custom format in the post. Machine simulation is provided by the add-in. This method can usually be programmed more quickly, but retains plenty of flexibility for many types of transfer. It is also convenient if you already have a standard transfer sequence in G-code that you would like to just *drop in* to your NC program. We expect to provide this method directly in FeatureCAM in the future.

In order to use the second method, you must load one of the following add-ins:

- **Subspindle_Transfer_UDF_1Turret.bas**, for machines with a single turret

- **Subspindle_Transfer_UDF_2Turret.bas**, for machines with twin turrets

These files are in the **Addins** folder of your FeatureCAM installation, which also contains documentation (**Subspindle_Transfer_UDF.doc**) for using the add-ins. See also User-defined features (see page 857) for more information.

There is only one feature-type for sub-spindles, but it performs many different tasks.

First, you specify the spindle you want to control, either the main or sub spindle; you then select the action you want to perform:

- **Open the spindle** — Select this option to open the current spindle.

- **Close the spindle** — Select this option to close the current spindle.
- **Orient the spindle** — Select this option to rotate the current spindle.

  *FeatureCAM orients the spindle during cutting. This feature type is needed only to orient the spindle before grabbing the part or initializing the spindle position.*

- **Turn spindle on/off** — Select this option to have direct control over rotating the spindle or turning it off. FeatureCAM automatically controls the spindle, but this feature type may be necessary to provide precise control of the spindle when moving from one spindle to the other.

- **Position the spindle** — Select this option to position the current spindle.

- **Synchronize the spindles** — Select this option to synchronize spindle rotations for milling or turning.

**Sub-spindle overview**

Sub-spindles can be used to support the part from both ends of the stock or to change which spindle is used to hold the stock. To cut features on two different ends of your stock, you must first create setups at each end of your part with the Z directions pointing out from the stock, as shown below. (If your machine requires that the Zs of each setup point in the same direction, this can be changed in the post.)

Stock held by main spindle

![Diagram of main spindle](image1)

1. Main spindle
2. Sub-spindle

Stock held by sub-spindle

![Diagram of sub-spindle](image2)

1. Main spindle
Sub-spindle

The features must be included in the proper Setups. The sub-spindle commands can be located at the end of the main Setup or the beginning of the sub-spindle Setup. The Part View, shown below, has the sub-spindle commands at the end of the first Setup.

If you are using the sub-spindle to support the end of the stock, order the sub-spindle features so that they occur when you need the extra support.

**Sub-spindle feature examples**

FeatureTURN provides individual control over the different sub-spindle functions.

Switch from the main spindle to the sub-spindle is:

1. Sub-spindle position
2. Sub-spindle close
3. Main spindle open
4. Sub-spindle position

Switch from the main spindle to the sub-spindle using a Cutoff feature to cut the stock from the bar:

1. Sub-spindle position
2. Sub-spindle close
3. Cutoff feature
4. Sub-spindle position
Creating a Sub-spindle feature

To create a Sub-spindle feature:

1. Click the Features step in the Steps panel. The New Feature wizard is displayed.

2. Select Sub-spindle as the Feature type and click Next to open the New Feature - Dimensions page.

   - Select which spindle you want to control, either the Main spindle or the Sub spindle.
   - Select the action you want to perform.
c Click Next.

3 If you selected the action as:
   - **Open the spindle**, optionally select **Extend the part catcher before opening spindle** and optionally enter a **Dwell after opening spindle**.
   - **Close the spindle**, optionally enter a **Dwell after closing spindle**.
   - **Orient the spindle**, enter an angle for **Set spindle angle to**.
   - **Turn the spindle on/off**, select **Off**, **CW** (Clockwise), or **CCW** (Counter-Clockwise). If you are turning on the spindle, you must enter the **Spindle speed**.
   - **Position the spindle**, the **New Feature - Location** (see page 847) page for a sub-spindle opens.
   - **Synchronize the spindles**, specify the type of synchronization to use.

4 Click **Finish** (see page 531).

   You can edit (see page 884) the feature later.

*New Feature - Location page for sub-spindle*

The **New Feature - Location** page controls the position of the sub-spindle.

1 Determine the final location specified in the coordinates of the main spindle user coordinate system. This can be done by any of the following methods:
   - Select the **Send the sub-spindle home** option. The coordinates are automatically entered in the point location shown at the top of the dialog.
   - Click the **Pick point** button and select the point on the screen.
   - Type in the coordinates directly. The coordinates are relative to the main spindle user coordinate system.

2 Decide how you want the sub-spindle to arrive at the final location. Select one of the following:
   - **Rapid directly to final location** — The spindle makes a single rapid move from its current location to the final sub-spindle location.
   - **Feed to intermediate location, then rapid to final location** — The spindle feeds to the intermediate location and then rapids to the final location. This is useful for gradually removing the support of one of the spindles.
- **Rapid to intermediate location, then feed to final location** — The spindle rapids to the intermediate location and then feeds the rest of the way. This can be applied to approach the part. Optionally select **Use Push/Press Function**.

3 If you have selected a strategy that requires an intermediate point, specify the **intermediate location** by either picking the point or entering the coordinates relative to the main spindle user coordinate system.

4 At the bottom of the dialog, FeatureCAM automatically shows you the Z coordinates that it is output in the NC code. If these are not the coordinates you want, you can enter the Z values for the **Final Z value** and **Intermediate Z value**. These values are used in the NC code, but the values shown at the top of the dialog are used for the toolpath simulation.

**Part Handling feature**

These transfer types are available:
- Slug transfer
- Reverse slug transfer
- Bar pull
- Part support on
- Part support off

Post and simulation are supported.

To create a Part Handling feature:

1 Click the **Features** step in the **Steps** panel.

The **New Feature** wizard is displayed.
2 Select **Part Handling** then click **Next** to open the **New Feature - Dimensions** page:

![New Feature - Dimensions](image)

3 Select the type of Part Handling feature you want to create and enter the dimensions.

4 Click **Next** to open the **New Feature — Strategies** page:

![New Feature - Strategies](image)

5 Set the attributes for the Part Handling feature, for example:
   - **Part catcher** — Select this option if you want to instigate the part catcher.
   - **Already Supported** — Select this option to indicate that the part is already supported.
   - **Sub Angle** — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

6 Click **Finish** to save the **Part Handling** feature.

   *You can edit (see page 884) the feature later.*
Controlling steady rests and tailstocks

You can program and simulate steady rests and tailstocks and check for collisions.

This example part is 1.5 m long:

Looking at a machine simulation, you can see that there is a long length of the part sticking out of the jaws:

You can use a steady rest to support the part as you machine each feature. To use a steady rest, you create a Part Handling feature with a type of Part support on and a Support type of Steadyrest.

In the example, the steady rest is turned on before the features at the end of the part are created.

You can move the steady rest by creating an additional Part support on feature.

In the example, the steady rest is moved further down the part to support the Turn operation:
An additional **Part support on** feature is created to move the steady rest back to the original position, to cut the other Turn feature and the Groove features:

![Diagram of a part with steady rest and tailstock](image)

You can use a tailstock in a similar way. You create a **Part Handling** feature with a type of **Part support on** and a **Support type** of **Tailstock**.

In the example, the tailstock is used to support the end of the part while the steady rest is supporting the middle:

![Diagram of a part with steady rest and tailstock](image)

To send the steady rest or tailstock home, you create a **Part Handling** feature with a type of **Part support off**.

**To enable a steady rest:**

1. In the turning **New Feature** wizard, select the **Part Handling** feature and click **Next**.
2. Select **Part Support On** and enter a value for the **Grab distance**. This is the distance in Z where you want to use the steady rest.
3. Click **Next**.
4. For the **Support type**, select **Steadyrest**.
5. If your machine has multiple turrets, select the correct **Transfer turret**.
6. If your steady rest is fitted to a turret, click the **Turret control** button and set the correct **Index** position.
7. Click **Finish**.

A **part_support_on** feature is added to the **Part View**. You may need to drag the feature to a different position in the **Part View** and set a **Base priority** for the feature to set the correct order of features.
To disable a steady rest:

1. In the turning **New Feature** wizard, select the **Part Handling** feature and click **Next**.
2. Select **Part Support Off** and enter a value for the **Grab distance**. This is the distance in Z where you want to use the steady rest.
3. Click **Next**.
4. For the **Support type**, select **Steadyrest**.
5. If your machine has multiple turrets, select the correct **Transfer turret**.
6. If your steady rest is fitted to a turret, click the **Turret control** button and set the correct **Location** and **Index** position.
7. Click **Finish**.

A **part_support_off** feature is added to the **Part View**. You may need to drag the feature to a different position in the **Part View** and set a **Base priority** for the feature to set the correct order of features.

To enable a tailstock:

1. In the turning **New Feature** wizard, select the **Part Handling** feature and click **Next**.
2. Select **Part Support On** and enter a value for the **Grab distance**. This is the distance in Z where you want to use the steady rest.
3. Click **Next**.
4. For the **Support type**, select **Tailstock**.
5. If your machine has multiple turrets, select the correct **Transfer turret**.
6. If your tailstock is fitted to a turret, click the **Turret control** button and set the correct **Index** position.
7. Click **Finish**.

A **part_support_on** feature is added to the **Part View**. You may need to drag the feature to a different position in the **Part View** and set a **Base priority** for the feature to set the correct order of features.

To disable a tailstock:

1. In the turning **New Feature** wizard, select the **Part Handling** feature and click **Next**.
2. Select **Part Support Off** and enter a value for the **Grab distance**. This is the distance in Z where you want to use the steady rest.
3. Click **Next**.
4. For the **Support type**, select **Tailstock**.

5. If your machine has multiple turrets, select the correct **Transfer turret**.

6. If your tailstock is fitted to a turret, click the **Turret control** button and set the correct **Location** and **Index** position.

7. Click **Finish**.

   A `part_support_off` feature is added to the **Part View**. You may need to drag the feature to a different position in the **Part View** and set a **Base priority** for the feature to set the correct order of features.

---

**Opening and closing steady rest jaws**

You can open and close the jaws of a steady rest without moving it. This is useful for turning operations on long parts. For example, you can machine up to the steady rest, open the steady rest and machine past it, then close the steady rest and machine to the end of the part.

Steady rest open:  
Steady rest closed:

To control the jaws of a steady rest without moving it:

1. Click the **Features** step in the **Steps** panel to display the **New Feature** wizard.

2. Select **Part Handling** and click **Next**.

   The **Dimensions** page is displayed.

3. To close a steady rest, select **Part Support On**.

   To open a steady rest, select **Part Support Off**.

4. Click **Next**.

   The **Strategies** page is displayed.

5. In the **Support type** list, select **Steadyrest**.

6. Select **Jaws only**.
7 Click Finish to close the wizard.

8 To specify when the Part Handling feature is performed, click and drag the feature in Part View, or change the Base Priority attribute on the Misc tab of the Part Handling Properties dialog.

**Turn Format feature**

A Turn Format feature enables you to manipulate the upper and lower turret.

To create a Turn Format feature:

1 Click the Features step in the Steps panel. The New Feature wizard is displayed.

2 Select Misc and click Next. The New Feature - Dimensions page is displayed.

3 Select whether you want to control the Upper turret or the Lower turret.

4 Select what you want to do:
   - Turret home — sends the turret to the home position.
   - Index the turret — Indexes the turret. Enter the Tool Index for the tool you want to index.
   - Air Blast — Creates an air blast. Click Next to display the New Feature - Strategies (see page 575) page. Select a spindle and an operation.

5 Click Finish to create the feature.

**Turning canned cycles**

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles on the feature level.

**Hole features**

Canned cycles for drilling (spotdrill, drill, bore, ream, and tap operations) are used only if the post has G-codes defined on the NC Codes page for these operations. If the G-codes are not defined, the hole operations are still computed. See Hole canned cycles in XBUILD or Computed tapping cycles in turning for more information.

There is no way to control the output of canned cycles on an individual feature basis.
**Turn/Bore features**

Canned cycles for turn and bore features must be enabled by going to the Properties dialog for each turn/bore feature, clicking the Strategy tab and selecting **Use canned cycle**. Also select **Reuse path in canned cycle** if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but remember these values only apply to features you create after making this change.

**Groove features**

Enable grooving canned cycles for each groove by bringing up the feature's Property dialog, clicking on the Strategy tab, and then clicking **Use path canned cycle**. You can also set this attribute on the Groove tab of the default attributes, but remember this will only apply to features you create after changing this setting.

**Thread features**

Thread features always use canned cycles.
**Turn/milling (TURN/MILL)**

FeatureTURNMILL allows the combination of turning and milling features on lathes with powered rotary tools. FeatureTURNMILL supports the normal Z and X axes of turning combined with the C and optional Y-axis.

The yoke shown in the first image, could be manufactured with a C axis lathe in two setups or using a C axis lathe with a subspindle (see page 843). The second image is a piece that requires a Y-axis due to the flat pockets on the top and bottom of the piece. (If these pockets were wrapped, they would have a curved bottom and then they could be manufactured without a Y-axis).

![Image of yoke and piece](image)

When creating features, you are given the choice of creating turning features or turn/mill features (see page 607). Turning and turnmill features can be mixed in a single setup. Turning features are identical to those on a 2-axis lathe and milling features are created the same as for a 3-axis mill, except that you are given new choices for positioning and orienting (see page 534) the features either on the OD or on the face of the part.

Tool selection in FeatureTURNMILL is very similar to FeatureMILL and FeatureTURN, except that rotary tools are automatically classified (see page 1829) as either parallel to the X-axis or Z-axis.

All forms of simulation (Centerline, 2D and 3D solid) are supported. In 3D simulation the rotation of the part is accurately simulated.

*Turn/mill parts require specially written posts. Two axis turning posts or milling posts will not work correctly.*

**Features appropriate for turn/mill**

Milling features can be performed in turn/mill with the following considerations:
- Milled features on the Z face. FeatureCAM can make any feature on the face of a part by using only XZC moves, for machines that do not have a Y-axis. If you want to use Y-axis on the face of a feature, you must select Cut feature using Y Axis coordinates on the Dimensions tab of the Feature Properties (see page 884) dialog.

- You can create drilled features on the Z face or OD without any restrictions.

- Unwrapped milled features on the OD. These features are output in X, Y, and Z moves. If your machine does not have a Y axis, the only features you can cut on the OD (without wrapping) is a simple slot whose length is aligned with the Z axis. If your machine has Y-axis capabilities, you can cut the full set of milling features on the OD.

- Wrapped features (see page 243) are supported (using a live tool), with known limitations - the same limitations that FeatureCAM has with wrapped 4th- axis features (see page 252). To use wrapping, you must select the Wrap feature around Z-axis option on the Dimensions page of the Feature Properties (see page 884) dialog.

**User-defined feature (UDF)**

You can use User Defined Features (UDFs) to create features from Macro add-ins, or to insert features from the Part Library (see page 1501).

Macro add-ins features are created using FeatureCAM's application programming interface (API). These features are loaded into FeatureCAM using the Macro Add-ins dialog (see page 145); this allows FeatureCAM's standard interface to remain as streamlined as possible.

Examples of add-in features include: helical bores with cutter compensation, thin-walled pockets and bosses, and pulley grooves.


**Creating a User Defined Feature (UDF)**

**Macro Add-in features**

Macro add-in User Defined Features are implemented as a Sax Basic add-in using FeatureCAM's API. If you already have an add-in for a UDF and it is loaded into FeatureCAM, then you can create an instance of the feature it defines by using the following steps:
1 Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 530) wizard.

2 In the **From Feature** section, select **User** and click **Next** to open the **New Feature - User defined feature** page.

3 Select the name of the user-defined feature and click **Next**.

   *If the feature you want is not listed, you must load it first (see page 857).*

4 To set a parameter, click the parameter name, enter the new value and click **Set**.

5 Continue through the wizard and click **Finish** when you are done.

For information on using FeatureCAM's API to create user-defined features, select **Help > FeatureCAM API Help**.

**Part Library features**

You can insert Part Library features into the document using the **New Feature** wizard:

1 Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 530) wizard.

2 In the **From Feature** section, select **User** and click **Next** to open the **New Feature - User defined feature** page.

3 Select a feature in the list and click **Next**.

   The **Paste Special** dialog is displayed.

4 Use the **Paste Special** dialog (see page 1497) to insert the selected feature into the document or apply it's machining attributes to an existing feature, then click **Finish** to close the dialog.

5 The **User defined feature** page of the **New Feature** wizard is displayed.

6 Use the wizard to insert more features from the Part Library, or click **Cancel** to close the wizard.

**Wire features (WIRE)**

The Wire feature types offered by FeatureCAM are:

- 2-axis Die (see page 859)
- 2-axis Punch (see page 860)
- 2-axis Side (see page 861)
- 2-axis Rapid (see page 863)
4-axis Die (see page 864)
4-axis Punch (see page 865)
4-axis Side (see page 866)
4-axis Rapid (see page 867)

The shape of the features is defined by the curve.

These features can create a number of wire EDM operations (see page 620). The types of operation are controlled by the Strategy (see page 1468) tab.

Multiple curves in a single 2-axis wire feature

All wire EDM curves must lie in the XY plane or a plane parallel to the XY plane.

A single 2-axis Die, Punch, or Side feature can contain multiple curves. In this case you have the option of setting separate start points and variable taper values for each curve, but all other settings apply to all of the curves.

If the feature has multiple operations, such as a retract followed by a cutoff, each operation is performed on each curve before moving on to the next operation. To change this ordering, manually reorder the operations in the Operations List (see page 1494).

2-axis Die

The 2-axis Die feature requires one or more closed curves. It is assumed that the region(s) outside of the curve(s) is the part that you keep, so the wire travels on the inside of the curve(s).

The thickness parameter is used to access the appropriate cutting data table (see page 1509).

The A parameter is used to rotate the feature around the Z-axis of the current Setup.

A 2-axis Die feature can create a number of cutting operations. These are specified on the Strategy (see page 1468) tab.

A 2-axis Die feature can have a taper (see page 613).

To create a 2-axis Die feature:
1. Create the curve that defines the shape of the feature.

2. Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 608) wizard.

3. In the **2 Axis** section, select **Die**, then click **Next** to open the **New Feature - Curves** (see page 609) page. Select the curve(s) for the feature.

4. Click **Next** to open the **New Feature - Location** (see page 612) page.

5. Click **Next** to open the **New Feature - Dimensions** (see page 612) page.

6. Click **Next** to open the **New Feature - Start** (see page 615) page.

7. Click **Next** to open the **New Feature - Strategies** (see page 620) page.

8. Click **Next** to open the **New Feature - Operations** (see page 631) page.

9. Click **Next** to open the **New Feature - Cutting Data** (see page 632) page for the first operation.

10. If you have more than one operation, clicking **Next** opens the **New Feature - Cutting Data** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 633) page.

11. Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

   *You can edit (see page 884) the feature later.*

### 2-axis Punch

The **Punch** feature requires one or more closed curves. The wire travels on the outside of the curve(s).

The **Thickness** parameter is used to access the appropriate cutting data table (see page 1509).

The **A** parameter is used to rotate the feature around the Z-axis of the current Setup.

A 2-axis Punch feature can create a number of cutting operations. These are specified on the **Strategy** (see page 1468) tab.
A 2-axis Punch feature can have a taper (see page 613).

To create a 2-axis Punch feature:

1. Create the curve that defines the shape of the feature.

2. Click the Features step in the Steps panel to open the New Feature (see page 608) wizard.

3. In the 2 Axis section, select Punch, then click Next to open the New Feature - Curves (see page 609) page. Select the curve(s) for the feature.

4. Click Next to open the New Feature - Location (see page 612) page.

5. Click Next to open the New Feature - Dimensions (see page 612) page.

6. Click Next to open the New Feature - Start (see page 615) page.

7. Click Next to open the New Feature - Strategies (see page 620) page.

8. Click Next to open the New Feature - Operations (see page 631) page.

9. Click Next to open the New Feature - Cutting Data (see page 632) page for the first operation.

10. If you have more than one operation, clicking Next opens the New Feature - Cutting Data page for the next operation. If you have no more operations, clicking Next opens the New Feature - Summary (see page 633) page.

11. Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

   You can edit (see page 884) the feature later.

2-axis Side

The Side feature can use one or more closed or open curves. The Punch or Die features provide more cutting options for closed curves. You can optionally place the wire on either side of the curves. A Side feature must have at least three arcs or lines in it including the lead moves.
The **Thickness** parameter is used to access the appropriate cutting data table (see page 1509).

The **A** parameter is used to rotate the feature around the Z-axis of the current Setup.

A 2-axis Side feature can create a number of cutting operations. These are specified on the **Strategy** (see page 1468) tab.

A 2-axis Side feature can have a taper (see page 613).

A Side feature must have at least three moves in it including the lead moves. If it does not, then no feature is displayed in the start page that is displayed in the wizard. For example, if you are creating a feature from a single line, you must change the start point and end point so that the feature has three moves. If you add these moves and click the **Next** button in the wizard, the feature displays.

To create a 2-axis Side feature:

1. Create the curve that defines the shape of the feature.
2. Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 608) wizard.
3. In the **2 Axis** section, select **Side**, then click **Next** to open the **New Feature - Curves** (see page 609) page. Select the curve(s) for the feature.
4. Click **Next** to open the **New Feature - Machining Side** (see page 534) page.
5. Click **Next** to open the **New Feature - Location** (see page 612) page.
6. Click **Next** to open the **New Feature - Dimensions** (see page 612) page.
7. Click **Next** to open the **New Feature - Start** (see page 615) page.
8. Click **Next** to open the **New Feature - Strategies** (see page 620) page.
9. Click **Next** to open the **New Feature - Operations** (see page 631) page.
10. Click **Next** to open the **New Feature - Cutting Data** (see page 632) page for the first operation.
11. If you have more than one operation, clicking **Next** opens the **New Feature - Cutting Data** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 633) page.
12. Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.
You can edit (see page 884) the feature later.

2-axis Rapid

A Rapid feature is used to rapid along the length of a curve to the start point of the next feature. You can use Rapid features to quickly move around a part using curves to avoid possible collision with fixtures.

FeatureCAM programs a Rapid in a very similar way to a Side (see page 861) feature. The wizard pages are similar, but fewer options are needed.

To create a 2-axis Rapid feature:

1. Create the curve that defines the shape of the feature.

2. Click the Features step in the Steps panel to open the New Feature (see page 608) wizard.

3. In the 2 Axis section, select Rapid, then click Next to open the New Feature - Curves (see page 609) page. Select the curve(s) for the feature.

4. Click Next to open the New Feature - Machining Direction (see page 610) page.

5. Click Next to open the New Feature - Location (see page 612) page.

6. Click Next to open the New Feature - Dimensions (see page 612) page.

7. Click Next to open the New Feature - Operations (see page 631) page.

8. Click Next to open the New Feature - Cutting Data (see page 632) page.

9. Click Next to open the New Feature - Summary (see page 633) page.

10. Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

You can edit (see page 884) the feature later.
4-axis Die

The 4-axis Die feature needs two closed curves, an upper curve and a lower curve. It is assumed that the region outside of the curve is the part that you want to keep. The wire travels on the inside of the curves.

The **Thickness** parameter is used to access the appropriate cutting data table (see page 1509).

The **A** parameter is used to rotate the feature around the Z-axis of the current Setup.

To create a 4-axis Die feature:

1. Create the upper and lower curves that define the shape of the feature.
2. Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 608) wizard.
3. In the **4 Axis** section, select **Die**.
4. Click **Next** to open the **New Feature - Upper Curve** (see page 610) page.
5. Click **Next** to open the **New Feature - Lower Curve** (see page 610) page.
6. Click **Next** to open the **New Feature - Location** (see page 612) page.
7. Click **Next** to open the **New Feature - Dimensions** (see page 612) page.
8. Click **Next** to open the **New Feature - Start** (see page 615) page.
9. Click **Next** to open the **New Feature - Match Curves** (see page 616) page.
10. Click **Next** to open the **New Feature - Strategies** (see page 620) page.
11. Click **Next** to open the **New Feature - Operations** (see page 631) page.
12. Click **Next** to open the **New Feature - Cutting Data** (see page 632) page for the first operation.
If you have more than one operation, clicking Next opens the New Feature - Cutting Data page for the next operation. If you have no more operations, clicking Next opens the New Feature - Summary (see page 633) page.

Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

You can edit (see page 884) the feature later.

4-axis Punch

A 4-axis Punch feature needs two closed curves, an upper curve and a lower curve. The wire travels on the outside of the curves.

The Thickness parameter is used to access the appropriate cutting data table (see page 1509).

The A parameter is used to rotate the feature around the Z-axis of the current Setup.

To create a 4-axis Punch feature:

1. Create the upper and lower curves that define the shape of the feature.
2. Click the Features step in the Steps panel to open the New Feature (see page 608) wizard.
3. In the 4 Axis section, select Punch.
4. Click Next to open the New Feature - Upper Curve (see page 610) page.
5. Click Next to open the New Feature - Lower Curve (see page 610) page.
6. Click Next to open the New Feature - Location (see page 612) page.
7. Click Next to open the New Feature - Dimensions (see page 612) page.
8. Click Next to open the New Feature - Start (see page 615) page.
9. Click Next to open the New Feature - Match Curves (see page 616) page.
10. Click Next to open the New Feature - Strategies (see page 620) page.
11 Click **Next** to open the **New Feature - Operations** (see page 631) page.

12 Click **Next** to open the **New Feature - Cutting Data** (see page 632) page for the first operation.

13 If you have more than one operation, clicking **Next** opens the **New Feature - Cutting Data** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 633) page.

14 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

### 4-axis Side

The 4-axis Side feature needs and upper and lower curve and can use closed or open curves. Punch or Die features provides more cutting options for closed curves. You can optionally place the wire on either side of the curve. A Side feature must have at least three arcs or lines in it including the lead moves.

![4-axis Side Diagram](image)

The **Thickness** parameter is used to access the appropriate cutting data table (see page 1509).

The **A** parameter is used to rotate the feature around the Z-axis of the current Setup.

To create a 4-axis Side feature:

1. Create the upper and lower curves that define the shape of the feature.

2. Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 608) wizard.

3. In the **4 Axis** section, select **Side**.

4. Click **Next** to open the **New Feature - Upper Curve** (see page 610) page.

5. Click **Next** to open the **New Feature - Lower Curve** (see page 610) page.

6. Click **Next** to open the **New Feature - Machining Side** (see page 534) page.
7 Click **Next** to open the **New Feature - Location** (see page 612) page.

8 Click **Next** to open the **New Feature - Dimensions** (see page 612) page.

9 Click **Next** to open the **New Feature - Start** (see page 615) page.

10 Click **Next** to open the **New Feature - Match Curves** (see page 616) page.

11 Click **Next** to open the **New Feature - Strategies** (see page 620) page.

12 Click **Next** to open the **New Feature - Operations** (see page 631) page.

13 Click **Next** to open the **New Feature - Cutting Data** (see page 632) page for the first operation.

14 If you have more than one operation, clicking **Next** opens the **New Feature - Cutting Data** page for the next operation. If you have no more operations, clicking **Next** opens the **New Feature - Summary** (see page 633) page.

15 Click **Finish** (see page 531) to create the feature and exit the wizard or click **Back** to return to previous pages.

You can edit (see page 884) the feature later.

### 4-axis Rapid

A 4-axis Rapid feature is used to rapid along the length of upper and lower curves to the start point of the next feature. You can use Rapid features to quickly move around a part using curves to avoid possible collision with fixtures.

FeatureCAM programs a **Rapid** in a very similar way to a **Side** (see page 861) feature. The wizard pages are similar, but fewer options are needed.

To create a 4-axis Rapid feature:

1 Create the upper and lower curves that define the shape of the feature.

2 Click the **Features** step in the **Steps** panel to open the **New Feature** (see page 608) wizard.

3 In the **4 Axis** section, select **Rapid**.

4 Click **Next** to open the **New Feature - Upper Curve** (see page 610) page.

5 Click **Next** to open the **New Feature - Lower Curve** (see page 610) page.
6 Click Next to open the **New Feature - Machining Direction** (see page 610) page.

7 Click Next to open the **New Feature - Location** (see page 612) page.

8 Click Next to open the **New Feature - Dimensions** (see page 612) page.

9 Click Next to open the **New Feature - Match Curves** (see page 616) page.

10 Click Next to open the **New Feature - Operations** (see page 631) page.

11 Click Next to open the **New Feature - Cutting Data** (see page 632) page.

12 Click Next to open the **New Feature - Summary** (see page 633) page.

13 Click Finish (see page 531) to create the feature and exit the wizard or click Back to return to previous pages.

You can edit (see page 884) the feature later.

**Wire EDM feature recognition**

There are two forms of interactive feature recognition available for wire EDM features.

For two axis, you can project the vertical surfaces from a solid model.

In the **New feature** dialog:

1 Select the 2 axis feature type, check **Extract with FeatureRECOGNITION** and click Next.

2 Select the solid and click Next.
3 Geometry is created from the vertical surfaces of the solid as shown below. Chain the curves you want to use in the Feature and complete the wizard.

![Geometry diagram](image)

4-axis features can be recognized from a collection of ruled surfaces.

In the New feature dialog:

1 Select the 4 axis feature type, check Extract with FeatureRECOGNITION and click Next.
2 Select the boundary curve in the Surface boundaries (see page 611) dialog and then complete the wizard.

**Groups and Patterns**

To help you to model parts with repeated geometry elements in their design, FeatureCAM enables you to specify groups of different features, in addition to feature patterns.

A Group (see page 869) is a collection of objects that is treated as one object. Members of groups do not have to be the same type of object. When you group unlike features, you are creating your own (user-defined) feature, which can be used as the basis for a pattern.

A Pattern (see page 872) enables you to quickly create the same feature at multiple locations.

**Creating a Group**

To create a Group of unlike features:

1 Create the features you want to group.
2 Select the features you want to group in the graphics window.

   ![Tip icon]  
   *Hold shift and click to select more than one object.*
3 Select **Construct > Pattern and Group > Group** from the menu. The **Dimensions** tab of the **Feature Group Properties** dialog is displayed:

4 Ensure the Group is selected in the Tree View on the left of the dialog.

5 If you want the objects in the group to be machined in the order they are displayed in the **Objects List**:
   a Select **Ordered**.
   b Select an object in the **Objects** list.
   c Click **Up** or **Down** to move the object up or down by one place in the list.
   d Repeat steps b and c to reorder the objects.

6 To remove a feature from the Group, select it in the **Objects** list and click **Delete**.

7 To add a feature to the Group, select it from the Model Objects list below the **Objects** list, then click **Add**.

8 Click **OK** to close the dialog.

Alternatively, you can create a Group using the **New Feature** wizard:

1 Create any features you want to group.

2 Click the **Features** step in the **Steps** panel.
3 Select **Group** in the **From Feature** section.
4 Click **Next** and follow the instructions in the wizard.

**Group Properties dialog**

You can use the **Feature Group Properties** dialog to create groups from multiple objects.

To display the **Feature Group Properties** dialog, select any features you want to group in the graphics window, then select **Construct > Pattern and Group > Group** from the menu.

The **Dimensions** tab contains the following options:

**Objects** list — A list of objects in the Group.

Model Objects list (below the **Objects** list) — A list of objects in the model.

**Ordered** — Select this option to machine the objects in the order they are displayed in the **Objects** list.

**Up** — Moves the selected Object in the **Objects** list up by one place.

**Down** — Moves the selected Object in the **Objects** list down by one place.

**Add** — Adds the selected Object in the Model Objects list to the group.
Delete — Removes the selected Object in the Objects list from the Group.

Tree View — Displays the Objects in the group. You can select an Object in the Tree View to display options for editing the Object.

**Ungrouping objects**

After you have created a group, you cannot select the objects individually.

To ungroup objects without deleting them:

1. Select a Group in the graphics window.
2. Select Construct > Pattern and Group > Ungroup from the menu.

*If you select the group and press Del, you remove the group AND delete the objects in the group.*

**Creating a Pattern**

You can create a Pattern from a new feature or from an existing feature:

To create a pattern from a new feature:

1. Click the Features step in the Steps panel to display the New Feature Wizard (see page 530).
2. Select the feature type you want to create a pattern from.
3. Select Make a pattern from this feature.
4. Click Next.
5. Follow the steps in the Wizard to create the Pattern.

To create a pattern from an existing feature using the New Feature Wizard:

1. Click the Features step in the Steps panel to display the New Feature Wizard (see page 530).
2. Select Pattern in the From Feature section.
3. Click Next.
4. Follow the steps in the Wizard to create the Pattern.

To create a pattern from an existing feature using the menu:

1. Select the feature you want to create a Pattern from in the graphics window.
2. Select Construct > Pattern and Group > Pattern from the menu.
3 Use the **Pattern Properties** dialog (see page 873) to create a Pattern.

**Pattern Properties dialog**

You can use the **Pattern Properties** dialog to create patterns from a single object.

![Pattern Properties dialog](image)

To use the **Pattern Properties** dialog to create a Pattern:

1 Ensure the Pattern is selected in the Tree View on the left of the dialog.

   You can select items in the Tree View to display the pattern properties, the object properties, and the manufacturing operation properties.

2 On the **Dimensions** tab, you can modify the shape of the pattern using the **Number**, **Spacing**, **Angle**, and other properties. Optionally select **Local Offset** to create the pattern around the location of the original feature.

3 On the **Location** tab:

   - **Relative Position** — select to enter the coordinates of a point relative to the Local Coordinate System, deselect to enter the coordinates of a point relative to the World Coordinate System.
- **XYZ location** — you can move the object to a new location. If the X Y Z coordinate position is \((0,0,0)\), then the group’s objects all remain in the same location at which they were independently defined.

- For **Polar location**, **Angle** rotates the current group counter-clockwise from its X-axis location by the angle specified at the **Radius** specified.

4 On the **Strategy** tab:

- If you want to use macros (also known as NC subroutines or subprograms) to reduce the size of the code created for the pattern, select **Use macro calls for each instance in the pattern**. This setting requires you to use a post that supports incremental programming or local coordinate systems (see page 1569).

  Ensure that macros are enabled in the **Post Options** (see page 1858) dialog.

- If you are using macros, you can reduce calculation time by also selecting **Reuse toolpaths from first Instance in the pattern**. In this situation, toolpaths are only calculated for the first feature and reused for the subsequent features of the pattern.

5 Click **OK** to close the dialog.

### Types of pattern

You can create the following types of Pattern:

- **Linear** (see page 874)
- **Radial in the setup XY plane** (see page 875)
- **Radial around index axis** (see page 875)
- **Radial around arbitrary axis** (see page 875)
- **Rectangular** (see page 878)
- **Points list pattern in the XY plane** (see page 879)

**Linear**

A **Linear** Pattern arranges the specified number of objects in a line, at the specified distance apart, starting at the specified XYZ location.

Use the treeview pane to control whether you are looking at the pattern, the object, or the manufacturing operations for the pattern. Simply highlight your choice with the mouse. The rest of the dialog changes to reflect your choice.
Angle — Enter the angle of rotation around the Z-axis, measured counter-clockwise from the X-axis, for the first object in the pattern.

Local offset — This controls whether the initial position of the object of the pattern is ignored. The position of the object is completely determined by its position in the pattern. If Local offset is selected, then the feature's position influences the created pattern.

Using an object’s position in a pattern can be tricky. For example, use local offsets to create a pattern of profiled features, say, a radial pattern of profile pockets.

The recommended procedure is:
1. Create the profile relative to the UCS.
2. Enter the center of the pattern as XYZ coordinates.
3. Enter 0.0 as the radius.

The pockets share the relative position to their center as the initial curve did to its UCS.

Object list — This highlights the name of the object repeated in the pattern. To change the object, click the down-arrow, then select the object to use in the pattern.

Number — This sets the number of objects in the pattern.

Spacing angle — This sets the space between the objects specified in degrees.

XYZ — This sets the location of the lower left-hand object of the pattern, or click to pick a point with the mouse.

**Radial**

A Radial pattern arranges the specified features spaced along the circumference of a circle. The spacing can be set so you only arrange features along an arc instead of the whole circle. Spacing and angles are set with dimensions settings.

Use the treeview pane to control whether you are looking at the pattern, the object, or the manufacturing operations for the pattern. Simply highlight your choice with the mouse. The rest of the dialog changes to reflect your choice.
Angle — This sets the angle of rotation around the Z-axis, measured counter-clockwise from the X-axis, for the first object in the pattern.

Local offset — This controls whether the initial position of the object of the pattern is ignored. The position of the object is completely determined by its position in the pattern. If Local offset is selected, then the feature's position influences the created pattern.

Using an object's position in a pattern can be tricky. For example, use local offsets to create a pattern of profiled features, say, a radial pattern of profile pockets. The recommended procedure is:

1. Create the profile relative to the UCS.
2. Enter the center of the pattern as XYZ coordinates.
3. Enter 0.0 as the radius.

The pockets share the relative position to their center as the initial curve did to its UCS.

Object list — This highlights the name of the object repeated in the pattern. To change the object, click the down-arrow, then select the object to use in the pattern.

Diameter — This sets the overall diameter of the pattern.

Number — This sets the number of objects in the pattern.

Spacing Angle — This sets the space between the objects specified in degrees.

XYZ — This sets the location of the lower left-hand object of the pattern, or click to pick a point with the mouse.
Radial Pattern Types

**Radial in the setup XY plane** — This option orients the features in the XY plane of the Setup. The two hole patterns in the image below are parallel to the Z-axis of the Setup.

![Radial in the setup XY plane](image1)

**Radial around the index axis** — This option aligns the features on the OD of the part, pointing toward the index axis. The slot and hole patterns in the figure below are radial.

![Radial around the index axis](image2)

*This option is available only with 4th axis wrapping.*
Radial around arbitrary axis — This option positions the features around a specified origin in a specified axis. It is only available only for 5th axis machining.

Rectangular

A Rectangular Pattern arranges the specified number of like objects in two linear rows, with each row separating the objects at the specified spacing, and with the rows spaced as specified in row spacing, starting at the specified XYZ location.

Use the treeview pane to control whether you are looking at the pattern, the object, or the manufacturing operations for the pattern. Simply highlight your choice with the mouse. The rest of the dialog changes to reflect your choice.

1. **Number** — This is the number of objects you want in each row of the rectangular pattern
2. **Row Number** — This is the number of rows you want in the rectangular pattern
3. **Spacing** — This is the distance between objects in the row
4. **Row Spacing** — This is the distance between the rows
5. **Angle** of the rectangular pattern position

**Angle** — This sets the angle of rotation around the Z-axis, measured counter-clockwise from the X-axis, for the first object in the pattern.

Local offset controls whether the initial position of the object of the pattern is ignored. The position of the object is completely determined by its position in the pattern. If **Local offset** is selected, then the feature's position influences the created pattern.
Using an object's position in a pattern can be tricky. For example, use local offsets to create a pattern of profiled features, say, a radial pattern of profile pockets. The recommended procedure is:

1. Create the profile relative to the UCS.
2. Enter the center of the pattern as XYZ coordinates.
3. Enter 0.0 as the radius.

The pockets share the relative position to their center as the initial curve did to its UCS.

**Object list** — This highlights the name of the object repeated in the pattern. To change the object, click the down-arrow, then select the object to use in the pattern.

**Number** — This sets the number of objects in the pattern.

**Row Number** — This sets the number of rows of objects.

**Row Spacing** — This sets the spacing between the rows. If you are creating a pattern in the standard **Top view** with the Y axis pointing up and the X axis pointing to the right, the **Row Spacing** is a distance in the Y direction.

**Spacing** — This sets the spacing between the columns. If you are creating a pattern in the standard **Top view** with the Y axis pointing up and the X axis pointing to the right, the **Spacing** is a distance in the X direction.

**XYZ** — This sets the location of the lower left-hand object of the pattern, or click to pick a point with the mouse.

**Points list**

A **Points list** pattern enables you to specify the locations of individual points.

Select **Points list pattern in the setup XY plane** in the New Feature - Patterns (see page 874) dialog to display the **Pattern - Dimensions** dialog.

Use the tree view to move between the pattern properties, the object properties, and the manufacturing operation properties. Select the item in the tree view whose properties you want to see. There is a shortcut for some points patterns of holes (see page 884).

The different fields and buttons are:

**Angle** — This sets the angle of rotation around the Z-axis, measured counter-clockwise from the X-axis, for the first object in the pattern.
Local offset — This controls whether the initial position of the object of the pattern is ignored. The position of the object is completely determined by its position in the pattern. If Local offset is selected, then the feature's position influences the created pattern.

Using an object's position in a pattern can be tricky. For example, use local offsets to create a pattern of profiled features, say, a radial pattern of profile pockets. The recommended procedure is:

1. Create the profile relative to the UCS.
2. Enter the center of the pattern as XYZ coordinates.
3. Enter 0.0 as the radius.

The pockets share the relative position to their center as the initial curve did to its UCS.

Object list — This highlights the name of the object repeated in the pattern. To change the object, click the down-arrow, then select the object to use in the pattern.

Sorting — This displays the Point List Sorting dialog. This dialog allows you to sort the objects in the following ways:

- **Shortest path** — Starting with the first object in the list, a path is created by moving to the next closest object.
- **X ascending** — Objects are sorted in increasing order according to their X coordinates.
- **X descending** — Objects are sorted in decreasing according to their X coordinates.
- **Y ascending** — Objects are sorted in increasing order according to their Y coordinates.
- **Y descending** — Objects are sorted in decreasing according to their Y coordinates.

The left-hand figure shows a Shortest Path sorting. The figure on the right shows a y descending ordering.

The transitions for these four options can be **Unidirectional** or **Bidirectional** and you can edit the Location comparison tolerance to control how strict the comparisons are.

In this example, **Unidirectional** is selected. After cutting the three holes in the first 'column', the tool then rapids back down to the bottom of the next 'column' to cut the next feature:

These rapid moves are a particular problem with long parts, when the machine can be accelerating and decelerating over long distances.
Selecting **Bidirectional** lets the tool cut in both directions, and results in a lot less rapiding, for example:

With this example, you can make the toolpath yet more efficient by entering a **Location comparison tolerance**:

The tolerance lets FeatureCAM cut the next nearest feature, as long as it is within the tolerance.

**Point List** — This displays the location and angle of the selected points. If you pre-selected holes or points, the order in which you picked these objects is reflected in the **Point List**. Clicking a row of the table displays the values in the X, Y, Z, and A options in the dialog. You can then modify the values using the **Set**, **Add**, **Delete**, **Up**, and **Down** options.

**Pick Feature** button — Use to determine which row of the point list contains the location of a specific feature. Click the button and then select a feature in the graphic window to highlight the row in the table containing that feature.

**Set** — Applies the values in the X, Y, Z, and A fields to the selected row in the **Point List**.

To change a location in the **Point List** table:

1. Click the row in the table you want to change. The values are inserted into the X, Y, Z, and A fields.
2. Change the values in the X, Y, Z, and A fields.
3. Click Set.

Add — Creates a new point in the Point List with the values in the X, Y, Z, and A fields.

Delete — Removes the selected row from the Point List.

Up — Moves the selected row of the Point List up one row in the list.

Down — This moves the selected row of the Point List table down one row in the table.

X, Y, Z — The X, Y, Z coordinates of a point.

A — The local Z rotation about the object's center.

Cut feature using Y Axis coordinates — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

Cut feature using Y Axis coordinates selected

Cut feature using Y Axis coordinates deselected

C Angle — If Cut feature using Y Axis coordinates is selected, enter the spindle C angle at which to cut the feature.

Curves (points pattern)

Curves loads point locations from a linear profile. Click Curves to bring up the Select Curves dialog. Select the profiles that contain points you want to use as feature locations.

Hold down the CTRL key to select multiple profiles.
Select Circles

Select the **Edit > Select Circles** menu option to display the **Select Circles** dialog, which you can use to select multiple circles of a similar size.

To select circles of similar sizes:

1. Select the **Edit > Select Circles** menu option.
   
   The **Select Circles** dialog is displayed.

2. Enter the **Radius** of the circles you want to select.
   
   To use the radius of a specific circle, click the blue label and select it in the graphics window.

3. Enter the **Tolerance** for the specified radius.

4. Click **OK** to close the dialog and select all visible circles in the current setup that have the specified radius.

You can now use these circles to create patterns of holes. See Creating patterns (see page 872) or Point list pattern (see page 879) for additional information. See also Interrogating numeric values (see page 292).

Editing features

You can edit existing features using the **Feature Properties** (see page 884) dialog. This dialog contains the same options as the **New Feature** (see page 530) wizard, which enables you to edit the physical properties and machining attributes of a feature.

*You can also change the default settings for some attributes at a global level using the **Machining Attributes** (see page 1591) dialog. If you set an attribute at feature level, it overrides any default global attributes set in the **Machining Attributes** dialog. This is recommended for advanced users only.*

Feature Properties dialog

The **Feature Properties** dialog enables you to edit the attributes of existing features.

Use one of the following methods to display the **Feature Properties** dialog:

- Double-click the feature in the graphics window or the **Part View**.
- Right-click the feature in the **Part View** and select **Properties** from the context menu.
- Select the feature in the graphics window or the Part View and click the Properties button in the Feature/Geometry Edit bar.
- Click Finish and Edit Properties (see page 531) in the New Feature wizard (see page 530).

The Feature Properties dialog has a tree view on the left and tabs on the right:

1. tree view
2. tabs

The tree view displays a list of the operations and passes for the feature. The tabs displayed in the dialog change depending on what level in the tree view is selected.

The feature-level attributes available in the Feature Properties dialog depend on the type of feature:
- milling (see page 903)
- drilling (see page 886)
- 3D milling (see page 1045)
- turning (see page 1351)
- wire (see page 1468)
**Drilling feature attributes (25D)**

You can use the **Hole Feature Properties** dialog to edit the properties of a drilling feature.

Use one of the following methods to display the **Hole Feature Properties** dialog:

- Right-click a Hole feature in the graphics window or **Part View** panel and select **Properties** from the context menu.
- Double-click a Hole feature in the graphics window or **Part View** panel.

The drilling tree view lists the different operations for the feature:

1. **Feature**
2. **Operation**

The tabs displayed in the dialog change depending on the level in the tree view you have selected.
**Feature-level tabs**

Select the feature name at the top level of the tree view to access these tabs:

- **Dimensions** (see page 905) — This tab contains critical dimensions for defining the feature's shape.
- **Location** (see page 888) — This tab is where you enter the location of the feature.
- **Strategy** (see page 889) — This tab controls the types of operations that are used to cut the hole.
- **Misc** (see page 973) — This tab contains various parameters for the feature.

**Operation-level tabs**

Select an operation in the tree view to access these tabs:

- **Tools** (see page 981) — This tab controls tool selection.
- **F/S** (see page 983) — This tab controls feed and speed values.
- **Cycle** (see page 898) — This tab is where you choose which drill cycle to use for the operation.
- **Drilling** (see page 900) — This tab contains attributes for drilling.
**Location tab (5AP)**

Use the **Location** tab of the **Hole Feature Properties** dialog (see page 886) to edit the location of a 5 axis hole feature.

![Hole Feature Properties - hole1](image)

**Relative Position** — This sets the XYZ coordinates relative to the UCS (or Setup origin). If deselected, the coordinates are relative to the World Coordinate System.

**Direction** — Enter the dimensions of the direction vector to specify the direction of the hole, or click **Pick location** and select two points in the graphics window to represent the direction.

**Position** — Enter the coordinates of the top of the Hole feature, or click **Pick location** and select a point in the graphics window.

**Reverse direction** — If a 5-axis hole is created in the wrong direction, click this button to reverse it.
Strategy tab (Drilling) (25D)

You can use the Strategy tab of the Hole Feature Properties dialog (see page 886) to edit the machining strategy of a Hole feature.

Combine with similar holes into canned cycle (see page 891) — By default, a tool retracts to the Z rapid plane between operations. Enable this option and then select whether to Retract to the Z rapid plane or the lower Plunge clearance plane after drilling each hole. This option also creates more efficient NC code by entering the canned cycle mode only once.

Machining Type — Select from:

- **Drill only** — All Hole features are drilled in the traditional way using a drill that is the same size as the hole diameter.
- **Drill/Mill** — This option allows Hole features to be drilled or milled, to minimize the number of tools needed.

When using Drill/Mill, FeatureCAM adds a rough operation to the tree view and you can access the Stepovers (see page 985) and Milling (see page 1161) tabs.

Click Drill/Mill Options to display the Drill/Mill Options dialog (see page 895), where you can edit drill/mill parameters.
You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. Set it on the Drilling (see page 1598, see page 889) tab.

Spot Drill — Enable this option to add a spot drill operation to the Hole feature.

This operation has some wide-ranging effects, however, especially when used with the Attempt chamfer w/ spot and tool optimization. Of those three settings, tool optimization has the highest priority and its decisions override settings with a lower priority.

For example, a spot drill operation could be performed with either a spot drill or a center drill. Spot drills with a tip angle of 90° can also perform a chamfering operation. You specify a specific tool to cut the hole's chamfer and also turn on Attempt Chamfer /w Spot and tool optimization. If there is an appropriate spot drill in the tool crib, FeatureCAM optimizes things and use this tool in spite of your lower priority override. Even though you selected a specific tool, your other settings conflicted with and superseded your choice.

This is the advantage of the optimization and simulation functions in FeatureCAM. As you work through the optimization settings, and see where you can optimize automatically and where you cannot, you can find ways to group your parts for faster production, but still use specific tools for specific effects when needed.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Drilling (see page 1598, see page 889) tab.

Attempt chamfer w/ spot — Enable this option to try to cut the chamfer during spot drilling. If no available tool can spot and chamfer without gouging the hole, a separate chamfer operation is created.

Pilot Drill — Enable this option to add a pilot drill operation to the Hole feature.

Pilot drill diameter(s) — This enables and sets a list of drill sizes used to drill pilot holes. Enter a list of drill diameters to use for pilot drilling, with a comma between each.

For example, enter 0.5, 1, 1.5 in inches, to pilot drill with the half inch drill for final hole sizes up to an inch. A hole bigger than 1.5 inches is pilot drilled with all three of the specified drills before being drilled to size.
Drill — Enable this option to add a drilling operation to the manufacture of the hole. This operation is usually undersized in preparation for later reaming or boring.

Drill large counterdrill first — For Counter Drill holes, select this option to do the counterdrill operation before the drill operation.

Ream — Enable this option to add a Ream operation to the Hole feature. This option drills a Hole undersized and then reams it to size. The diameter of the drill is between 93% and 97% of the final Hole diameter.

Ream before chamfer — Enable this option to do the Ream operation before the Chamfer operation. This avoids pushing any kind of burr or edge back up onto the chamfer if the chamfer is a sealing surface.

Tap type — This option is available for Tapped Hole features. Select the type of tap from:
- Cutting — The tool cuts the threads into the material.
- Rolled — The tool presses or forms the threads into the material.
- Helicoil — The size of the Drill and Tap operations are larger to fit the helicoil insert.

Bore — Enable this option to add a Bore operation to the Hole feature. Boring places a hole very accurately.

The options on this tab are the same as the options on New Feature - Strategies page for a Hole feature in the New Feature wizard.

Combine similar holes into canned cycle

The Combine similar holes into canned cycle attribute applies to drilling operations.

In previous versions of FeatureCAM this attribute was called Retract to Plunge Clearance. The Retract to Plunge Clearance attribute still applies to milling operations.

By default, FeatureCAM retracts the tool to the higher Z rapid plane between operations. Although this is a safe assumption, it can result in inefficient NC part programs because between each operation the program cancels (G80) and then re-establishes (G81, G83, and so on) the canned cycle mode. The figure below shows such an inefficient program.
The **Combine with similar holes into canned cycle** attribute serves two functions. First it creates more efficient NC code by entering canned cycle mode only once. It also causes the tool to retract to the lower **Plunge Clearance** plane after drilling each hole.

If the **Disable Macros** is deselected in the **Post Options** dialog, the hole locations are included in a macro as shown in the Fanuc NC code sample below.
If Disable Macros is selected, the NC code is still efficient, because canned cycle mode is entered only once. The code sample shown below is Fanuc NC code for a hole pattern with Combine with similar holes into canned cycle enabled, but without macros.

:10
(9-13-2001)
N25G00G17G40G49G80
N30G30G91Z0
N35T1M6
N40G00G54G90X0.Y0.S3819M03
N45G43H1Z1.0M08
N50Z0.1
N55G83R0.1Z-1.0Q0.25F14.3
N60P1001M98
N65G80
N70G00Z1.0
N75G0G91G28Z0M09
N80G49G90
N85M30
:1001
N90G91
N95X0.5
N100X1.0
N105G90
N110M99
After Combine with Similar holes into canned cycles is selected on a feature, you can specify the retract plane for the whole feature on the Hole Feature Properties Strategy (see page 889) tab or for each of the feature's operations individually in the Retract column of the Op List (see page 1548) tab. If you are using a post that supports Fanuc-style G99 "R point level return" and G98 "Initial level return", then these codes are used by FeatureCAM. Otherwise the canned cycle is cancelled and reinstated as necessary. To set the retract plane for the feature, you have two options on the Strategy tab:

<table>
<thead>
<tr>
<th>Retract to Z rapid plane</th>
<th>The tool retracts to the higher Z Rapid Plane (G98, &quot;Initial level return&quot;, on a Fanuc control) after performing the operation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retract to plunge clearance</td>
<td>The tool retracts to the lower plunge clearance plane (G99, &quot;R point level return&quot;, on a Fanuc control) after performing the operation.</td>
</tr>
</tbody>
</table>

To set the retract plane for individual operations, the Retract column of the Op List (see page 1548) tab contains one of the following symbols:

- This short green up arrow indicates that the tool retracts to the lower plunge clearance plane (G99, "R point level return", on a Fanuc control) after performing the operation. You can toggle this arrow to a tall arrow by clicking the arrow with the left mouse button and selecting Retract to Z rapid plane from the context menu.

- This tall green up arrow means that the tool retracts to the higher Z Rapid Plane (G98, "Initial level return", on a Fanuc control) after the operation. You can toggle this arrow to a short arrow by clicking the arrow with the left mouse button and selecting Retract to Plunge clearance from the context menu.

- This gray arrow indicates the tool retracts to the higher Z Rapid Plane after the operation; you cannot change it because it is typically shown at the end of a canned cycle.
The figure below shows two hole patterns. The first pattern that contains holes 1, 2 and 3 has **Combine with Similar holes into canned cycles** selected. Hole 2 has been modified to retract to the Rapid plane.

1. Tool change point
2. Rapid plane
3. Retract plane

If you are using a post that supports different rapid planes inside a canned cycle, that is a Fanuc post that supports \texttt{G98/G99}, then you can create G-code that is more efficient. Fanuc supports \texttt{G98} for retracting to the higher Z rapid plane and \texttt{G99} for retracting to the lower plunge clearance plane. These G-codes are entered in the post processor as the R plane retract (for the lower plunge clearance plane, \texttt{G99}) and Z rapid retract (for the higher Z Rapid Plane, \texttt{G98}). The resulting program is as follows:

```gcode
N65 G83 G98 Z-1.0751 R0.1 Q0.25 F14.3
N70 X0.0
N75 X0.5
N80 X1.0 G99
N85 X1.5 G98
N90 X2.0
N95 X2.5 G99
N100 G80
```

**Drill/Mill Options (feature level)**

You can use the **Drill/Mill Options** dialog to edit the feature-level drilling and milling options.
To display the Drill/Mill Options dialog, select Drill/Mill on the Strategy tab (see page 889) of the Hole Feature Properties dialog, then click Drill/Mill Options.

Select the strategies that you want to enable. The options are:

- **Drill full diameter**
- **Rough with Drill, Finish with Bore**
- **Rough with Drill, Finish with Ream**
- **Rough with Endmill, Finish with Bore**
- **Rough with Endmill, Finish with Ream**
- **Rough with Endmill, Finish with Endmill**
- **Finish Bottom**
- **Rough with Endmill to full diameter** — this option lets FeatureCAM rough to the final hole diameter without having a finish pass.
- **Use hole milling canned cycle if available** — For machines that support hole/bore milling, such as Heidenhain Cycle 208, Siemens POCKET4, Fagor G88, and Haas G12/13. The hole milling canned cycle is posted using the hole milling format in XBUILD. If you enter a G code, for example G208, for the Hole Milling cycle in the NC Codes dialog in XBUILD, that code displays in the brackets after this attribute name, for example Use hole milling canned cycle if available (G208).

If you select more than one strategy, FeatureCAM works down the strategy list in the dialog until it finds a strategy that can complete the hole.

**Spot Drill** — Enable this option to add a spot drill operation to the Hole feature.
This operation has some wide-ranging effects, however, especially when used with the Attempt chamfer w/ spot and tool optimization. Of those three settings, tool optimization has the highest priority and its decisions override settings with a lower priority.

For example, a spot drill operation could be performed with either a spot drill or a center drill. Spot drills with a tip angle of 90° can also perform a chamfering operation. You specify a specific tool to cut the hole's chamfer and also turn on Attempt Chamfer /w Spot and tool optimization. If there is an appropriate spot drill in the tool crib, FeatureCAM optimizes things and use this tool in spite of your lower priority override. Even though you selected a specific tool, your other settings conflicted with and superseded your choice.

This is the advantage of the optimization and simulation functions in FeatureCAM. As you work through the optimization settings, and see where you can optimize automatically and where you cannot, you can find ways to group your parts for faster production, but still use specific tools for specific effects when needed.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Drilling (see page 1598, see page 889) tab.

Attempt chamfer w/ spot — Enable this option to try to cut the chamfer during spot drilling. If no available tool can spot and chamfer without gouging the hole, a separate chamfer operation is created.

Ream before chamfer — Enable this option to do the Ream operation before the Chamfer operation. This avoids pushing any kind of burr or edge back up onto the chamfer if the chamfer is a sealing surface.

Cutter comp.

Use continuous spiral — Select this option to use an NT Continuous Spiral toolpath, which eliminates nearly all stepovers.
You can use **Helical ramping** with **Use continuous spiral**, for example:

Traditional spiral toolpaths can produce spikes in tool load. Another advantage of NT continuous spiral is that the tool load increases gradually.

**Cycle tab (25D)**

You can use the **Cycle** tab of the **Hole Feature Properties** dialog (see page 886) to edit the Drill Cycle attributes for an Operation.

![Cycle tab](image)

**Drill** (**G81**) — This is a straight up and down motion without any pecking.

**Spot Face** (**G82**) — This is a drilling cycle with an optional dwell.
Deep Hole (G83) — The drill retracts all the way to the Plunge clearance plane a number of times during the process to clear debris from the Hole. You can override the tool's pecking options (see page 1794) for each operation, but the peck style is specified in the CNC file.

Tap (G84) — Select the tap type using the Tap Cycle option. The choices are Floating, Rigid, Deep Hole, and Chip Break. All cycles use the same Tap program format, but logical reserved words exist in XBUILD to distinguish the specified tap type.

Reverse Tap (G74) — This is a left-handed tapping cycle.

If you do not enter a G-code for the Reverse Tap cycle in the NC Codes dialog in XBUILD, computed canned moves are performed.

Chip Break (G87) — In this cycle, the drill retracts a short distance to clear chips before plunging again.

Ream — This cycle affects how a ream is performed. The choices are Ream FDF (feed-dwell-feed) (G89), Ream FF (feed-feed) (G85), and Ream FSR (feed-stop spindle-retract) (G86).

If you select Ream FF, the cycle is posted using the Bore (FF) format in XBUILD. Ream FDF uses the Bore (FDF) format, and Ream FSR uses the Bore (FSR) format.

Bore cycle affects how a bore is performed. Select one of the following from the menu:

- FDF — The cycle is posted using the Bore (FDF) (feed-dwell-feed) (G89) format in XBUILD.
- FF — The cycle is posted using the Bore (FF) (feed-feed) (G85) format in XBUILD.
- FSR — The cycle is posted using the Bore (FSR) (feed-stop spindle-retract) (G86) format in XBUILD.
- No Drag — The cycle is posted using the Bore (No Drag) (G76) format in XBUILD.
- FDSJ — The cycle is posted using the Bore (FDSJ) (G88) format in XBUILD.
**Back Bore** (G87) — Use the Back Bore cycle to machine back bore holes using a single Setup.

**Drilling tab (25D)**

You can use the **Drilling** tab of the **Hole Feature Properties** dialog (see page 886) to edit the drilling attributes for an Operation.

**Drill operation:**

![Hole Feature Properties dialog]

- **Drill depth** — Enter the absolute depth that the tool is driven into the stock, not including a point allowance. The **Depth** setting in the dimension attributes automatically includes a point allowance so use this attribute to override the point allowance. Alternatively use **Drill depth adjust**. This applies to Drill, Ream, Countersink, and Boring operations.

- **Drill depth adj.** — Enter a positive or negative drill depth adjustment relative to the Hole feature’s **Depth** dimension. Use this attribute instead of **Drill depth** if you prefer.

> If you enter both a **Drill depth** and a **Drill depth adj.**, the adjustment is applied to the **Drill depth** value not the **Depth** dimension.
Spotdrill operation:

Spot drill depth — Enter the absolute depth that the spotdrill operation is driven into the stock.

Spot drill depth adj. — Enter the spot drill depth adjustment. You can enter a relative positive or negative spot drill depth adjustment to the Hole feature’s Depth dimension instead of a Spot drill depth if you prefer.

If you enter both a Spot Drill depth and a Spot Drill depth adj. the adjustment is applied to the Spot drill depth value not the Depth dimension.

Tap operation:

Max. tap spindle RPM — Enter the maximum speed, in RPM, for the tap operation.
**Tap depth** — This is an override for setting the depth of a tap operation.

By default, the system automatically sets a depth based on the thread depth and the geometry of the tap that is chosen. If it is a plug tap, five pitches are added to the requested tap depth. If it is a bottoming tap, three pitches are added to the requested tap depth.

If you enter a **Tap depth** value, no additional adjustment is made for the tap geometry, the **Tap depth** is passed straight to the NC code.

**Tap plunge clearance** — Enter the height above the feature where the tapping tool starts to feed into the feature.

**Post Vars** (see page 1656) button

### Multi-axis drilling attributes

Multi-axis milling and drilling features have these attributes.

**5-axis position** menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

If you do not enter a coordinate, the **Z index clearance** (see page 1648) value is used for the index retract move. **Z index clearance** is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:
With an orientation angle of 0, the groove is cut in the machine's Y direction.

With an orientation angle of 90, the groove is cut in the machine's X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Milling feature attributes (25D)**

You can use the **Milling Feature Properties** dialog to edit the properties of a Milling feature.

Use one of the following methods to display the **Milling Feature Properties** dialog:

- Right-click a Milling feature in the graphics window or **Part View** panel and select **Properties** from the context menu.
Double-click a Milling feature in the graphics window or Part View panel.

The 2.5D milling tree view lists the different operations and passes for the feature:

1. Feature
2. Operation
3. Pass

The tabs displayed in the dialog change depending on the level in the tree view you have selected.

**Feature-level tabs**
Select the feature name at the top level of the tree view to access these tabs:
Dimensions (see page 905) — This tab contains critical dimensions for defining the feature’s shape. This tab changes based on the feature type.

Location (see page 934) — This tab is where you enter the location of the feature.

Misc (see page 973) — This tab contains various parameters for the feature.

Strategy (see page 936) — This tab controls the types of operations that are created from the feature.

Operation-level tabs
Select an operation in the tree view to access the following tabs:

- Tools (see page 981) — This tab controls tool selection.
- F/S (see page 983) — This tab controls feed and speed values.
- Stepovers (see page 985) — This tab contains attributes for connection and lead moves.
- Milling (see page 994) — This tab contains attributes for milling.

Pass-level tabs
If the milling operation has more than one pass, you set the attributes on the following tabs at pass level. Select the pass in the tree view.

- Tools (see page 981)
- F/S (see page 983)
- Coolant (see page 985)
- Stepovers (see page 985)
- Milling (see page 994)

Dimensions tab (25D)
You can use the Dimensions tab of the Milling Feature Properties dialog (see page 903) to edit the physical properties of features. The Dimensions tab is different for each Milling feature type, and contains the attributes on the New Feature - Dimensions (see page 532) page of the New Feature (see page 530) wizard, as well as other advanced attributes.

If a dimension field has a blue label (see page 293), you can click it and 'pick' the dimension from objects in the graphics window.
Rectangular pocket

Length — Enter the X dimension of the feature.

Width — Enter the Y dimension of the feature.

Corner radius — Enter the radius for all four corners of the Rectangular Pocket.

Depth — Enter the distance cut into the material in Z.

Chamfer — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

Draft angle — Optionally set an angle for the feature wall. Use only positive numbers.

Bottom Radius — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

X Section — Click this button to open the Select Side Curve dialog, where you can select a curve to create a cross section (see page 928) for the wall of your feature.

A — If the feature does not align with the X axis, enter the angle of the feature from the X axis.
Wrap feature around X/Y axis — This option is available for 4th-axis wrapping (see page 243).

Wrap Options — Click this button to display the Wrapped toolpath options dialog.

Cut feature using Y Axis coordinates — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

Cut feature using Y Axis coordinates selected

Cut feature using Y Axis coordinates deselected

The tool moves in X and Y to cut the features.

The part is rotated about the index axis to cut the features.

C Angle — If Cut feature using Y Axis coordinates is selected, enter the spindle C angle at which to cut the feature.
Slot

This option simplifies the manufacturing strategy for the feature. Select this option to machine the feature by making a single pass down the center of it with a tool whose radius is equal to the width of the feature.

Length — Enter the X dimension of the feature.

Width — Enter the Y dimension of the feature.

The width of a slot does not have to match the diameter of a standard available endmill, unless you are making a Simple slot. If an exact match cannot be found, then a smaller tool is selected and multiple horizontal passes are performed.

Depth — Enter the distance cut into the material in Z.

Chamfer — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

Draft angle — Optionally set an angle for the feature wall. Use only positive numbers.
**Bottom Radius** — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

A — If the feature does not align with the X axis, enter the angle of the feature from the X axis.

Wrap feature around X/Y axis — This option is available for 4th-axis wrapping (see page 243).

Wrap Options — Click this button to display the Wrapped toolpath options dialog.

Cut feature using Y Axis coordinates — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

Cut feature using Y Axis coordinates selected
Cut feature using Y Axis coordinates deselected

The tool moves in X and Y to cut the features.

The part is rotated about the index axis to cut the features.

**C Angle** — If Cut feature using Y Axis coordinates is selected, enter the spindle C angle at which to cut the feature.
Step Bore

The default Step Bore feature has two steps. Each step corresponds to a row of the table.

**Diameter** — Enter the diameter of the selected step.

**Chamfer** — Optionally enter the depth of a 45 degree chamfer cut at the top edge of the selected step. Leave this value at the default, 0, for no chamfer.

**Depth** — Enter the distance cut into the material in Z.

*The Depth is measured from the top of the Step Bore feature, not the top of the current step.*

**Radius** — Optionally set the bottom radius for the selected step. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

**Through** — This sets the display of the Step Bore without a bottom.

*Selecting Through does not make the feature pass all the way through the stock. You must set the depth value deep enough.*
**Single Point Bore** — This sets the step to be finished with a boring bar. This mills the step to a tight tolerance. Select the option if you want to finish the step with this technique.

**Set** — This saves the dimensions for the current step and updates them in the table.

**Delete** — This removes the step that is selected in the table from the Step Bore feature.

**Add** — This adds a step to the Step Bore feature.

**A** — If the feature does not align with the X axis, enter the angle of the feature from the X axis.

**Wrap feature around X/Y axis** — This option is available for 4th-axis wrapping (see page 243).

**Wrap Options** — Click this button to display the Wrapped toolpath options dialog.

**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

---

*Cut feature using Y Axis coordinates selected* | *Cut feature using Y Axis coordinates deselected*

The tool moves in X and Y to cut the features. | The part is rotated about the index axis to cut the features.

**C Angle** — If Cut feature using Y Axis coordinates is selected, enter the spindle C angle at which to cut the feature.
Thread mill

Type — Select ID for an inner diameter thread or OD for an outer diameter thread.

Custom — Enter the thread dimensions.

Standard Thread — Select a thread from the list to use standard dimensions.

Pitch — Enter the pitch of the thread.

Thread Length — Enter the length of the thread.

Thread Height — Enter the height of the thread.

Minor/Major Diameter — Enter the Minor Diameter for an ID feature or the Major Diameter for an OD feature.

Tapered — If your thread is tapered, select this option and enter the taper Angle.

Tapered taps are driven to a different depth than straight taps. For straight taps, a tip allowance is added to the thread depth so that the tool cuts the complete thread, this is not added for tapered taps so that the OD is not affected.
Thread — Select a **Left hand** or **Right hand** thread. When viewed from the end of the part toward the chuck, on a left hand thread the tool winds counter-clockwise as it moves towards the chuck, on a right hand thread the tool winds clockwise as it moves towards the chuck.

A — If the feature does not align with the X axis, enter the angle of the feature from the X axis.

**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

**Cut feature using Y Axis coordinates** selected

The tool moves in X and Y to cut the features.

**Cut feature using Y Axis coordinates** deselected

The part is rotated about the index axis to cut the features.

C Angle — If **Cut feature using Y Axis coordinates** is selected, enter the spindle C angle at which to cut the feature.
Face

**Boundaries** — Click this button to open the Select Boundary Curves (see page 926) dialog, where you can select a curve to limit your feature.

**Thickness** — Enter the thickness of the feature.

**A** — If the feature does not align with the X axis, enter the angle of the feature from the X axis.

**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

- **Cut feature using Y Axis coordinates** selected
- **Cut feature using Y Axis coordinates** deselected
The tool moves in X and Y to cut the features. The part is rotated about the index axis to cut the features.

**C Angle** — If **Cut feature using Y Axis coordinates** is selected, enter the spindle C angle at which to cut the feature.

**Boss**

- **Stock Curve** — Click this button to open the **Select Stock Curve** (see page 930) dialog, where you set the stock boundary for the feature.

- **Curves** — Click this button to display the **Ordering** (see page 929) dialog.

- **X Section** — Click this button to open the **Select Side Curve** dialog, where you can select a curve to create a cross section (see page 928) for the wall of your feature.

- **Check surfaces** — Click this button to open the **Select Check Surfaces** (see page 931) dialog. This button is available only for NT toolpaths (see page 936).

- **Draft angle** — Optionally set an angle for the feature wall. Use only positive numbers.

- **Chamfer** — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

- **Height** — Enter the height of the feature.
**Bottom Radius** — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

A — If the feature does not align with the X axis, enter the angle of the feature from the X axis.

**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

>Cut feature using Y Axis coordinates selected  
>Cut feature using Y Axis coordinates deselected

The tool moves in X and Y to cut the features.  
The part is rotated about the index axis to cut the features.

**C Angle** — If **Cut feature using Y Axis coordinates** is selected, enter the spindle C angle at which to cut the feature.
Chamfer

Chamfer Type — Select the chamfer type from:

- **2D Chamfer** — Create a chamfer on a curve in the XY plane.
- **3D Chamfer** — Create a chamfer on a planar curve that is not in the XY plane, or on a non-planar curve.

_A 3D milling license is required to create chamfers on non-planar curves._

Curves — Click this button to display the Ordering (see page 929) dialog.

Width — Enter the Y dimension of the feature.

Depth — Enter the distance cut into the material in Z.

A — If the feature does not align with the X axis, enter the angle of the feature from the X axis.

Cut feature using Y Axis coordinates — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

Cut feature using Y Axis coordinates selected
Cut feature using Y Axis coordinates deselected
The tool moves in X and Y to cut the features.

The part is rotated about the index axis to cut the features.

**C Angle** — If **Cut feature using Y Axis coordinates** is selected, enter the spindle C angle at which to cut the feature.

**Groove**
Select the type of Groove from:

**Face** — This sets the groove to cut on the XY plane of the current Setup.

**Inside/Outside** — This sets the groove to run on the inside or outside of a closed curve.

**Curves** — Click this button to display the **Ordering** (see page 929) dialog.
Face Groove

Simple (Engrave) — This option simplifies the manufacturing strategy for the feature. Select this option to machine the feature by making a single pass down the center of it with a tool whose radius is equal to the width of the feature.

Width — Enter the width of the Groove feature.

Depth — Enter the depth of the Groove feature.

Bottom Radius — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

Cut feature using Y Axis coordinates — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

Cut feature using Y Axis coordinates selected  Cut feature using Y Axis coordinates deselected
The tool moves in X and Y to cut the features.

The part is rotated about the index axis to cut the features.

**C Angle** — If **Cut feature using Y Axis coordinates** is selected, enter the spindle C angle at which to cut the feature.

**Inside/Outside Groove**

**Depth** — Enter the depth of the Groove feature.

**Width** — Enter the width of the Groove feature.

**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.
Cut feature using Y Axis coordinates selected

The tool moves in X and Y to cut the features.

Cut feature using Y Axis coordinates deselected

The part is rotated about the index axis to cut the features.

C Angle — If Cut feature using Y Axis coordinates is selected, enter the spindle C angle at which to cut the feature.

Pocket

Boundaries — Click this button to open the Select Boundary Curves (see page 926) dialog, where you can select a curve to limit your feature.
X Section — Click this button to open the Select Side Curve dialog, where you can select a curve to create a cross section (see page 928) for the wall of your feature.

Check surfaces — Click this button to open the Select Check Surfaces (see page 931) dialog. This button is available only for NT toolpaths (see page 936).

Draft angle — Optionally set an angle for the feature wall. Use only positive numbers.

Chamfer — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

Depth — Enter the distance cut into the material in Z.

Bottom Radius — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.

Wrap feature around Z axis — When using 4th-axis positioning (see page 234), select this option to wrap the feature around the axis.

For example, this part has four Pockets:

Select Wrap feature around Z axis and a 3D simulation looks like this:
Cut feature using Y Axis coordinates — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

Cut feature using Y Axis coordinates selected

The tool moves in X and Y to cut the features.

Cut feature using Y Axis coordinates deselected

The part is rotated about the index axis to cut the features.

C Angle — If Cut feature using Y Axis coordinates is selected, enter the spindle C angle at which to cut the feature.

Round
**Curves** — Click this button to display the **Ordering** (see page 929) dialog.

**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

**Cut feature using Y Axis coordinates selected**

The tool moves in X and Y to cut the features.

**Cut feature using Y Axis coordinates deselected**

The part is rotated about the index axis to cut the features.

**C Angle** — If **Cut feature using Y Axis coordinates** is selected, enter the spindle C angle at which to cut the feature.
Side

**Stock Curve** — Click this button to open the Select Stock Curve (see page 930) dialog, where you set the stock boundary for the feature.

**X Section** — Click this button to open the Select Side Curve dialog, where you can select a curve to create a cross section (see page 928) for the wall of your feature.

**Check surfaces** — Click this button to open the Select Check Surfaces (see page 931) dialog. This button is available only for NT toolpaths (see page 936).

**Draft angle** — Optionally set an angle for the feature wall. Use only positive numbers.

**Chamfer** — Optionally enter the depth of a 45° chamfer cut at the top edge of the feature. Leave this value at the default, 0, for no chamfer.

**Depth** — Enter the distance cut into the material in Z.

**Bottom Radius** — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner.
**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

**Cut feature using Y Axis coordinates selected**

- The tool moves in X and Y to cut the features.

**Cut feature using Y Axis coordinates deselected**

- The part is rotated about the index axis to cut the features.

**C Angle** — If **Cut feature using Y Axis coordinates** is selected, enter the spindle C angle at which to cut the feature.

**Dimensions tab dialogs**

You can display these dialogs from the **Dimensions** tab:

- **Select Islands** dialog (see page 927)
- **Select Side Curve** dialog (see page 928)
- **Select Check Surfaces** dialog (see page 931)
- **Select Part Surfaces** dialog (see page 1051)
- **Select Stock Solid** dialog (see page 223)

**Select Boundary Curves dialog**

You can use the **Select Boundary Curves** dialog to specify which curves define a feature boundary.
To display the **Select Boundary Curves** dialog, click **Boundaries** on the **Dimensions** tab (see page 905) of the **Milling Feature Properties** dialog.

![Select Boundary Curves dialog](image)

**Show all** — Select this option to show all curves in the current document.

**Ordering**

You can use a single feature to machine multiple curves if they are at the same height and do not intersect. For features with multiple curves, use this section to control the order in which the curves are machined:

- **Automatic ordering** — Select this option to enable FeatureCAM to determine the machining order of the curves, starting with the first in the list. This order is not affected by the options in the **Automatic Ordering Options** dialog (see page 1553).

- **Manual ordering** — Select this option to machine the curves in the order they are displayed in this dialog. You can change the order by selecting a curve in the list and using the **Move item up** and **Move item down** buttons. To sort the features in the list, click **Sorting** and use the **Curve Sorting Options** dialog.

**Select Islands dialog**

You can use the **Select Islands** dialog to create islands inside pockets which are left uncut.

To display the **Select Islands** dialog, click **Islands** on the **Dimensions** (see page 905) tab of the **Milling Feature Properties** dialog.
You can do this only for Pockets created from curves.

To use the dialog:

1. Select the curve (see page 59) to use as the pocket island.
   Islands are regions left uncut within a pocket. Island curves must be contained within the boundary curve and they cannot touch or overlap.

2. To remove all of the islands from a pocket, click **Unselect All**.

3. Click **OK** to close the dialog.

**Select Side Curve dialog**

You can use the **Select Side Curve** dialog to specify a curve to define the cross-section of a feature.

To display the **Select Side Curve** dialog, click the **X Section** button on the **Dimensions** (see page 905) tab of the **Milling Feature Properties** dialog.

You can define the shape of the walls of a Boss, Side, or Pocket feature by specifying a cross-section curve. This curve is swept along the curve of the feature to create the overall shape. The curve must be:

- in the XY plane, with the starting point of the curve at (0,0) in the setup axis; or

For example,
use this cross-section curve: to create this feature:

- in place on the feature curve.

For example, use this cross-section curve: to create this feature:

The curve must be a function in X and Y. This means that when you draw a vertical line parallel to the X or Y-axis through the curve at any point, it can only intersect the curve once.

To use the dialog:

1. Select the curve (see page 59) you want to use as the cross-section.
2. To remove a cross-section curve, click Unselect.
3. Click OK to close the dialog.

**Ordering dialog**

You can use the **Ordering** dialog to specify which curves define the shape of a feature.

To display the **Ordering** dialog, click **Curves** on the **Dimensions** (see page 905) tab of the **Milling Feature Properties** dialog.
For Pocket features, use the Select Boundary Curves dialog (see page 926).

Show all — Select this option to show all curves in the current document.

Ordering
You can use a single feature to machine multiple curves if they are at the same height and do not intersect. For features with multiple curves, use this section to control the order in which the curves are machined:

- **Automatic ordering** — Select this option to enable FeatureCAM to determine the machining order of the curves, starting with the first in the list. This order is not affected by the options in the Automatic Ordering Options dialog (see page 1553).

- **Manual ordering** — Select this option to machine the curves in the order they are displayed in this dialog. You can change the order by selecting a curve in the list and using the Move item up and Move item down buttons. To sort the features in the list, click Sorting and use the Curve Sorting Options dialog.

Select Stock Curve dialog
You can use the Select Stock Curve dialog to specify a curve to define the shape of the stock.

To display the Select Stock Curve dialog, click Stock Curve.
You can use this dialog for Boss and Side features only.

Compute the Stock Boundary from the block stock — This is the default option and uses the block stock.

Use a Curve as the Stock Boundary — Select this option to use a curve as the Stock Boundary and select a curve (see page 59) to use as the stock boundary. You can use this method to define the shape of irregular shaped stock, so the toolpaths do not air cut in regions without stock.

Show all curves — Select this option to display all available curves in the list.

Compute the Stock Boundary from a stock model — Select this option to use a stock model as the Stock Boundary. Boss and Side features can use stock models.

Select Check Surfaces dialog

You can use the Select Check Surfaces dialog to specify areas you do not want to machine.

To display the Select Check Surfaces dialog, click Check Surfaces on the Dimensions (see page 905) tab of the Milling Feature Properties dialog.

This dialog is available for 3D milling features, and 2.5D NT roughing toolpaths for these features:

- Boss
- Pocket
- Side
- Face features created with feature recognition (if the plane of the face intersects the clamp solids)

To specify check surfaces:

1. Select the surface(s) in the list box or click **Pick** and select a surface with the mouse. To pick additional surfaces, click **Pick** again before selecting each additional surface.

   Select surfaces that are more horizontal than vertical. If you select a vertical check surface the milling may resume on the other side of it if the surface to be milled extends beyond the check surface.

2. Click **OK** to return to the **Feature Properties** dialog.

   If you are using check surfaces to avoid clamps, you can do this automatically using the **Clamp avoidance** (see page 1615) dialog.
Curve Sorting Options dialog

Use the Curve Sorting Options dialog to sort the features in the Ordering and Select Boundary Curves dialogs.

To display the Curve Sorting Options dialog, in the Ordering or Select Boundary Curves dialog, select Manual ordering and click Sorting.

To sort the features:

1. Select how to sort the features:
   - Shortest path — Sort the features to reduce the movement between features.
   - X/Y/Z ascending/descending — Sort the features by position.

2. For rows or columns of features, select how to transition between rows and columns:
   - Unidirectional — Cut all rows of features in the same direction, with a rapid move to the start of the next row.
   - Bidirectional — Cut rows of features in alternating directions to reduce the rapid movement distance.
   - Location comparison tolerance — Specify the tolerance within which a range of positions is considered a row or column.

3. Click OK to close the dialog and sort the features.
Location tab (25D)

Use the Location tab of the Feature Properties dialog to specify the location of a feature.

Specify the location of the feature:

- **XYZ** — The feature is aligned so that its depth is parallel with the -Z direction of the Setup. You position it by specifying the X, Y, and Z coordinates in the plane of the Setup.

- **Polar** — The feature is aligned so that its depth is parallel with the -Z direction of the Setup. It is positioned by specifying a Radius and Angle.
- **Polar on the OD** — The **Radius** specifies the distance of the feature from the Z axis. The **Angle** is the counter-clockwise angle, in degrees, from the X axis. The **Y shift** distance is the distance the feature is translated from the radius in Y. The **Z coordinate** is the distance the feature is translated in the Z direction. This option is available only for turn/mill documents.

- **Radial about axis** — For 4th-axis (see page 234) parts.

**Relative Position** — This sets the XYZ coordinates relative to the UCS (or Setup origin). If deselected, the coordinates are relative to the World Coordinate System.
Strategy tab (Milling) (25D)

Use the **Strategy** tab of the **Milling Feature Properties** dialog to edit the machining strategy of a Milling feature.

Climb mill — Enable this option to have the tool on the left side of the machined edge (in the direction of tool travel). Disable it for conventional milling, with the tool on the right side of the machined edge.

Individual rough levels (see page 963) — Select this option to list each Z-level of the rough pass separately, which enables you to specify separate attributes and tools for each Z-level.

Depth first (see page 965) — Enable this option to cut each region of a feature completely before moving on to another region. The toolpaths descend in Z.

Minimize tool retract (see page 966) — Select this option to reduce the amount of retracting that the tool does while milling a feature. Instead of retracting, the tool continues feeding to its next location.

Partline prog — Select this option to use the drawing dimensions of the feature for the toolpath instead of the centerline of the tool. You can only use this option when cutter compensation is enabled.
Partline programming is a particular kind of cutter compensation for milled features. If enabled, the actual drawing dimensions of the feature are output as the toolpath instead of the center line of the tool. If Cutter compensation is not enabled for any of the operations in a feature, selecting Partline program does not affect the NC Code.

The tool selected to cut the feature is still important even when using part line programming. If the same tool is used for roughing, ensure that the actual tool diameter does not deviate too far from the diameter of the tool used by FeatureCAM to ensure proper area coverage for the roughing passes. Also ensure that the diameter of the selected finishing tool is small enough to cut the whole feature. If you have selected a tool too large to fit into a tight corner, you cannot correct the toolpath with just cutter compensation.

FeatureCAM automatically calculates the entrance point of the Finish pass and adds a linear move and a ramping move (based on the Ramp diameter value) to your Finish pass to accommodate cutter compensation. If you receive a warning in the operations list such as Can't find ramp in/out arc or Can't extend end of open profile then correct the problem by decreasing the Ramp diameter value or changing the Pre-drill point.

Finish Cutter comp — Select this option to use cutter compensation for the finish and semi-finish operations.

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool's actual diameter and the diameter specified. For example, if the specified diameter is 0.500, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.

The direction of the compensation depends on the value of Climb mill. If Climb mill is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select Enable Cut Comp in Post Options (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the Cutter Comp attribute selected. If the Cutter Comp option is deselected in the Post Options dialog, then cutter compensation is disabled for the entire part regardless of the value of the Cutter Comp attributes on each feature.

If you select Part line program, you get a special kind of cutter compensation known as part line programming.
If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

**Operations**

**Pre-drill** — Enable this option to add a pre-drill operation to the feature.

The location for a pre-drill point is set automatically, but you can override it for a Spiral type toolpath using the **Plunge point(s)** operation attribute.

A *Pre-drill* operation is not available with a *Zigzag* stepover toolpath.

Zigzag ramping is automatically disabled when you use a *Pre-drill* operation with an NT style toolpath. This is not supported for the Spiral toolpath and you must set the **Max. ramp angle** (see page 1161) to 0 to disable zigzag ramping when using a *Pre-drill* operation.

The *Pre-drill* operation for the NT style toolpaths includes the tops of multi-height islands. This is not supported for the original Spiral and Zigzag stepover toolpaths.

**Pre-drill diameter** — Enter the diameter for pre-drill holes. Ensure the diameter is large enough to allow the milling tool to enter the stock.

**Roughing**

**Rough pass** — Enable this option to add a Rough operation to the feature.

**Stepover** — Select the **Stepover** type for the roughing operations.

**Traditional toolpaths**

- **Spiral** — This toolpath type is based on a series of offset curves.
For a Boss feature, the curves of the Boss are offset and then clipped against the shape of the stock. When using a square piece of stock the toolpaths tend to cut the four corners first, and then work their way inward. You can alter the extent of the toolpaths by using a stock curve of total stock.

For a Pocket feature, the boundary of the Pocket is offset and the toolpaths are cut starting from the center of the pocket. The shape of the stock does not affect the toolpaths.

- **Zigzag** — This toolpath type uses straight toolpaths that are parallel to each other.
For a Boss feature, the toolpaths are laid in parallel lines across the stock and clipped against the boundaries of the Boss.

The starting point is one of the four corners of the stock. You can change the angle of the toolpaths, but the neighboring toolpaths are always parallel.

For a Pocket feature, the parallel toolpaths are laid inside the Pocket boundary.

After the parallel paths, a clean-up pass is then performed around the boundaries of Bosses, Pockets, and Pocket islands.
The Zigzag roughing pass has two phases, the parallel roughing phase and the boundary clean-up phase. The clean-up phase, marked \[\textnumero\], cleans up the boundaries of the feature to ensure a uniform finish allowance:

The tree view for the feature only shows a single feature, so the clean-up phase uses the same feed and speed values as the roughing pass. The number of clean-up passes is determined by the \textit{Cleanup passes} (see page 1161) attribute. If \textit{Cleanup passes} is set to 0, the clean-up pass is not performed. If set to 1, a single pass is performed along the boundaries of the roughing region:

The roughing region is determined by offsetting the boundaries of the feature by the \textit{Finish allowance}.

If set to a number larger than 1, multiple clean-up passes are performed. The default spacing of these passes is controlled by the \textit{Cleanup stepover} (see page 1161) attribute. To more finely control the spacing of multiple clean-up passes, set the \textit{Cleanup stepover} attribute.

The ramping onto the clean-up pass is controlled by the \textit{Ramp diameter} (see page 985) attribute.
The direction of the Zigzag path is controlled by the relationship between the Zigzag angle (see page 994) and the Climb mill (see page 936) attributes.

The table shows the relationship between the zigzag angle and the Climb mill setting. The image in the Path column indicates the direction, the start point, and the sequencing of the toolpaths.

<table>
<thead>
<tr>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No</td>
<td></td>
<td>180</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>Yes</td>
<td></td>
<td>180</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>Yes</td>
<td></td>
<td>-90</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>No</td>
<td></td>
<td>-90</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

For example, indicates toolpaths that are parallel to the X axis. The start point is the lower left and the paths are sequenced from the bottom to the top. In the images, the X axis of the Setup is the horizontal axis, and the Y-axis is the vertical axis.

If the Bi-directional cut (see page 936) or the Reorder (see page 1607, see page 1660) attribute is selected, the toolpath is reordered so that it completes one region before moving on to the next.

For example, with this Boss feature the toolpaths finish the region on the right of the Boss before moving on to the region on the left side.
If Bi-directional cut and Reorder are deselected, the toolpaths move across the part without any reordering.

When roughing a Boss with the Zigzag method, the amount that the tool overlaps the stock boundary is controlled by the Finish allowance (see page 994).

The Zigzag technique applies to a finishing pass only if the bottom of the feature is being finished. In this case, it behaves just like a single roughing pass.

**NT (New Technology) toolpaths**

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional Spiral toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional Zigzag toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional Spiral toolpath, but eliminates nearly all stepovers.

- **Vortex** (see page 725) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.
Set the default type in **Machining Attributes** on the **Stepover** tab using the **Stepover Options** button.

Click the **Stepover Options** button to open the **Rough Stepover Options** dialog:

The **NT** toolpaths are available in the **Stepover** menu along with the traditional **Spiral** and **Zigzag** toolpaths.
At feature level, you can override the default **Stepover type** in the menu on the **Strategy** tab of the feature's **Properties** dialog.
You can override this at operation level on the Stepovers tab. If you are using Individual rough levels, you can set the Cut type for each individual rough pass.

Regardless of the roughing method selected, the feature is roughed to within the Finish allowance (see page 1161) of the boundary.

There are some key differences between Traditional and NT toolpaths (see page 727).

**Bi-directional rough** — Select this option to machine the feature in both directions.

Enable this option to mill in both directions. If disabled, conventional roughing happens and the cutting path moves in one direction with rapid, above-stock return movements to set up for the next pass. **Climb mill** controls the cutting direction.

**Rough cutter comp** — Select this option to use cutter compensation for the rough operations.

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool's actual diameter and the diameter specified. For example, if the specified diameter is 0.500, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.
The direction of the compensation depends on the value of **Climb mill**. If **Climb mill** is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select **Enable Cut Comp** in **Post Options** (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the **Cutter Comp** attribute selected. If the **Cutter Comp** option is deselected in the **Post Options** dialog, then cutter compensation is disabled for the entire part regardless of the value of the **Cutter Comp** attributes on each feature.

If you select **Part line program**, you get a special kind of cutter compensation known as part line programming.

If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

**Finishing**

**Finish pass** — Enable this option to add a finish operation to the feature.

**Finish bottom** — Select this option to use a flat endmill to finish the bottom of the feature. When this is selected, use the **Bottom finish allowance** on the **Milling** tab to specify the amount of material to leave after the roughing pass.

By default, the bottom of a feature is not machined during the Finish pass. Enable this option to finish the bottom of the feature with a flat endmill, up to the **Bottom Radius**, if the feature has one. You can enter a positive or negative value.

**Stepover** — Select the stepover type for the finish passes.

**Traditional toolpaths**

- **Spiral** — This toolpath type is based on a series of offset curves.
For a Boss feature, the curves of the Boss are offset and then clipped against the shape of the stock. When using a square piece of stock the toolpaths tend to cut the four corners first, and then work their way inward. You can alter the extent of the toolpaths by using a stock curve of total stock.

![Boss Feature Diagram](image)

For a Pocket feature, the boundary of the Pocket is offset and the toolpaths are cut starting from the center of the pocket. The shape of the stock does not affect the toolpaths.

- **Zigzag** — This toolpath type uses straight toolpaths that are parallel to each other.
For a Boss feature, the toolpaths are laid in parallel lines across the stock and clipped against the boundaries of the Boss.

The starting point is one of the four corners of the stock. You can change the angle of the toolpaths, but the neighboring toolpaths are always parallel.

For a Pocket feature, the parallel toolpaths are laid inside the Pocket boundary.

After the parallel paths, a clean-up pass is then performed around the boundaries of Bosses, Pockets, and Pocket islands.
The Zigzag roughing pass has two phases, the parallel roughing phase and the boundary clean-up phase. The clean-up phase, marked \( 1 \), cleans up the boundaries of the feature to ensure a uniform finish allowance:

![Diagram of Zigzag roughing pass phases](image)

The tree view for the feature only shows a single feature, so the clean-up phase uses the same feed and speed values as the roughing pass. The number of clean-up passes is determined by the Cleanup passes (see page 1161) attribute. If Cleanup passes is set to 0, the clean-up pass is not performed. If set to 1, a single pass is performed along the boundaries of the roughing region:

![Diagram of clean-up pass](image)

The roughing region is determined by offsetting the boundaries of the feature by the Finish allowance.

If set to a number larger than 1, multiple clean-up passes are performed. The default spacing of these passes is controlled by the Cleanup stepover (see page 1161) attribute. To more finely control the spacing of multiple clean-up passes, set the Cleanup stepover attribute.

The ramping onto the clean-up pass is controlled by the Ramp diameter (see page 985) attribute.
The direction of the Zigzag path is controlled by the relationship between the Zigzag angle (see page 994) and the Climb mill (see page 936) attributes.

The table shows the relationship between the zigzag angle and the Climb mill setting. The image in the Path column indicates the direction, the start point, and the sequencing of the toolpaths.

For example, indicates toolpaths that are parallel to the X axis. The start point is the lower left and the paths are sequenced from the bottom to the top. In the images, the X axis of the Setup is the horizontal axis, and the Y-axis is the vertical axis.

<table>
<thead>
<tr>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No</td>
<td>-</td>
<td>180</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>0</td>
<td>Yes</td>
<td>-</td>
<td>180</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>90</td>
<td>Yes</td>
<td>-</td>
<td>-90</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>90</td>
<td>No</td>
<td>-</td>
<td>-90</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

If the Bi-directional cut (see page 936) or the Reorder (see page 1607, see page 1660) attribute is selected, the toolpath is reordered so that it completes one region before moving on to the next.

For example, with this Boss feature the toolpaths finish the region on the right of the Boss before moving on to the region on the left side.
If Bi-directional cut and Reorder are deselected, the toolpaths move across the part without any reordering.

When roughing a Boss with the Zigzag method, the amount that the tool overlaps the stock boundary is controlled by the Finish allowance (see page 994).

The Zigzag technique applies to a finishing pass only if the bottom of the feature is being finished. In this case, it behaves just like a single roughing pass.

**NT (New Technology) toolpaths**

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional Spiral toolpath, but can use stepovers larger than 50%.
- **NT Zigzag** — This toolpath is similar to the traditional Zigzag toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.
- **NT Continuous Spiral** — This toolpath is similar to the traditional Spiral toolpath, but eliminates nearly all stepovers.
- **Vortex** (see page 725) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.
Set the default type in **Machining Attributes** on the **Stepover** tab using the **Stepover Options** button.

Click the **Stepover Options** button to open the **Rough Stepover Options** dialog:

The **NT** toolpaths are available in the **Stepover** menu along with the traditional **Spiral** and **Zigzag** toolpaths.
At feature level, you can override the default Stepover type in the menu on the Strategy tab of the feature's Properties dialog.
You can override this at operation level on the **Stepovers** tab. If you are using **Individual rough levels**, you can set the **Cut type** for each individual rough pass.

Regardless of the roughing method selected, the feature is roughed to within the **Finish allowance** (see page 1161) of the boundary.

There are some key differences between **Traditional** and NT **toolpaths** (see page 727).

- **Wall pass** — Enable this option to finish the bottom of the feature up to the **Finish allowance** on the wall, then finish the walls in a separate pass.

- **NT toolpaths** — Select this option to use NT toolpaths for the Finish pass.

There are several types of NT (New Technology) toolpath:

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional **Spiral** toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional **Zigzag** toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional **Spiral** toolpath, but eliminates nearly all stepovers.
- **Vortex** (see page 961) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.

**Semi-finish pass** — Enable this option to add a Semi-Finish operation to the feature.

Enable this option to add a Semi-finish (see page 969) operation to the feature.

**Use finish tool** — Select this option to create a separate tool for the finish operation.

If disabled, the same tool is used for both the Rough and Finish passes. Enable **Use finish tool** to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with `-finish`. For example if the roughing tool is named `endmill1.0`, the finishing tool is called `endmill1.0-finish`. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.

*If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable **Use finish tool** and explicitly change the tool to use for finishing.*

**Ramp from top** — Select this option to ramp the tool to the cutting depth from the top of the feature.

Disable this option to avoid ramping to depth on the Finish and Semi-finish pass of a 2.5D feature. This saves machining time.

This example shows the Finish operation for a Side feature.

**Ramp from top on:**  
**Ramp from top off:**

---

*You must deselect the **NT toolpaths** option to access this option.*

**Helical side finish** — Enable this option to use a continuous spiral for the Finish pass. Enter a **Pitch** to control the tightness of the spiral.
This option enables a small depth of cut and a continuous toolpath. It also avoids marks on the feature, which stepping down in Z depths may cause.

You must deselect the NT toolpaths option to access this option.

Wind Fan — Click this button to open the Wind Fan Finish Options (see page 1643) dialog.

**Face features**

**Connect stepovers with arc** — Select this option to use an arc to connect stepovers to prevent sharp direction changes.

When cutting Face features, you can optionally select Connect stepovers with arc.

This example shows a Face feature with Connect stepovers with arc selected:
Compare this to the example with Connect stepovers with arc deselected (the default setting):

**Thread mill features**

**Feed Dir** — Select from **Negative Z** or **Positive Z**. The direction depends on the handedness of the tool, the thread, and whether it is an OD or ID thread.

**Simple Groove features (Engraving)**

**Reverse cut** — Select this option to reverse the direction that the feature is cut. Engraving features are cut in a single pass.

**Side Groove features**

**Finish walls** (see page 969)

**Plunge gouge check** — Deselect to disable gouge checking on the plunge and retract moves. This is available only when **Use new ID/OD groove toolpath** is selected on the **Milling** tab of the **Machining Attributes** dialog.
Strategy tab (Thread Milling) (25D)

Cutter comp — Select this option to enable cutter compensation.

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool’s actual diameter and the diameter specified. For example, if the specified diameter is 0.500, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.

The direction of the compensation depends on the value of Climb mill. If Climb mill is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select Enable Cut Comp in Post Options (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the Cutter Comp attribute selected. If the Cutter Comp option is deselected in the Post Options dialog, then cutter compensation is disabled for the entire part regardless of the value of the Cutter Comp attributes on each feature.

If you select Part line program, you get a special kind of cutter compensation known as part line programming.
If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

**Partline prog** — Select this option to use the drawing dimensions of the feature for the toolpath instead of the center line of the tool.

Partline programming is a particular kind of cutter compensation for milled features. If enabled, the actual drawing dimensions of the feature are output as the toolpath instead of the center line of the tool. If Cutter compensation is not enabled for any of the operations in a feature, selecting **Partline program** does not affect the NC Code.

The tool selected to cut the feature is still important even when using part line programming. If the same tool is used for roughing, ensure that the actual tool diameter does not deviate too far from the diameter of the tool used by FeatureCAM to ensure proper area coverage for the roughing passes. Also ensure that the diameter of the selected finishing tool is small enough to cut the whole feature. If you have selected a tool too large to fit into a tight corner, you cannot correct the toolpath with just cutter compensation.

FeatureCAM automatically calculates the entrance point of the Finish pass and adds a linear move and a ramping move (based on the **Ramp diameter** value) to your Finish pass to accommodate cutter compensation. If you receive a warning in the operations list such as **Can’t find ramp in/out arc** or **Can’t extend end of open profile** then correct the problem by decreasing the **Ramp diameter** value or changing the **Pre-drill point**.

**Feed direction** — Select the direction in which you want to machine the feature. Depending on the direction the tool is rotating, this determines whether climb milling or conventional milling is used.

- **Negative Z** — Start with the tool at the top of the feature (at the highest Z location) and machine downwards.
- **Positive Z** — Start with the tool at the bottom of the feature (at the lowest Z location) and machine upwards.

**Wind fan** — Select this option to have a single point that is used as both the start and end point of the Finish path. This is useful for machines which require large lead moves to enable cutter compensation.
Rough pass — Select this option to include a Rough operation in the feature.

Finish pass — Select this option to add a Finish operation to the feature.

Use finish tool — Deselect this option to use the same tool for the Rough and Finish passes.

Spring passes — Enter the number of spring passes to include in the finish pass. A spring pass is a duplicate of the final threading pass.

NT toolpaths

There are several types of NT (New Technology) toolpath:

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional Spiral toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional Zigzag toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional Spiral toolpath, but eliminates nearly all stepovers.

- **Vortex** (see page 961) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.

Vortex example

This example shows how Vortex machines pockets, channels, and narrow corners.

For more information on the general principles of Vortex machining, see the 3D Vortex and step cutting example.
Using a 2.5D model:

Create a Vortex toolpath:
For pockets, the tool spirals down into the pocket before using trochoidal paths over the full-width cuts.

On completion of the initial full-width cut, the trochoids are placed in the corners where the maximum tool engagement angle would otherwise be exceeded.

*Individual rough levels*

Select the **Individual rough levels** option to list each Z-level of the rough pass separately, which enables you to specify separate attributes and tools for each Z-level.
When **Individual rough levels** is deselected, you can edit the attributes on the **Milling** tab to edit all Z-levels.

When **Individual rough levels** is selected, you can edit the attributes on the **Milling** tab individually for each Z-level.

If **individual rough levels** is selected, FeatureCAM uses the shortest tool available in the current tool crib for each level. For example, if you are cutting a 1 inch deep Pocket feature with 0.25 inch corner radii with a Z increment of 0.25 inches, these tools are used:

<table>
<thead>
<tr>
<th>Individual levels off</th>
<th>Individual levels on</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operation</strong></td>
<td><strong>Tool Name</strong></td>
</tr>
<tr>
<td>Rough</td>
<td>Endmill037 5:high+</td>
</tr>
<tr>
<td>Rough pass 1-1</td>
<td>Endmill037 5:reg</td>
</tr>
<tr>
<td>Rough pass 1-2</td>
<td>Endmill037 5:high</td>
</tr>
<tr>
<td>Rough pass 1-3</td>
<td>Endmill037 5:high+</td>
</tr>
</tbody>
</table>

**Individual rough levels** also controls clipping of Boss and Side features against the stock model including both STL and solid stock models.

When **Individual rough levels** is deselected, all Z levels are trimmed together, which causes air cutting.

When **Individual rough levels** is selected, each Z level of the toolpath is trimmed to the stock boundary.
Depth first

If this option is deselected then all regions of a feature are cut at one Z level before descending to a deeper Z-level.

*This attribute has no effect if the toolpaths for your feature do not rapid between regions of the feature.*

The images below show how regions of a feature are completely cut before moving on to another region.

For an NT toolpath, **Depth first** cuts by region, so it cuts a Pocket feature in the same way as a traditional toolpath. However for a Boss feature, a traditional toolpath cuts depth-first for each toolpath before moving to the next stepover, not by region.

If you are using **Multiple roughing tools** (see page 994) or **Multiple finishing tools** (see page 994), to efficiently rough out tight corners, **Depth first** is also useful. The images below show a tool finishing tight corners in a depth first manner.
You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Milling** (see page 1607, see page 1660) tab.

**Min. retract**

This example shows normal retracting.

This is the same example with **Minimize tool retract** enabled.

Setting this attribute can result in more slot cutting. Study the toolpaths carefully before cutting.

This feature is helpful for 2-axis mills.

If **Minimize tool retract** is selected, the setting for the default attribute, **Min. rapid distance**, is ignored. The tool does not retract unless to prevent gouging.

This attribute only affects how the tool retracts within a single operation. It does not control how operations are ordered. For this functionality, see **Min. rapid distance**.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. Set it on the **Milling** (see page 1607, see page 1660) tab.

**NT toolpaths**

Using the **Minimize tool retract** options with the NT toolpaths gives better results than with the traditional toolpaths.
**Pocket feature**

For a Pocket feature, the toolpath slot cuts following the offsets instead of just a straight line. There are fewer plunges than with traditional toolpaths.

Traditional toolpath example:

![Traditional toolpath example](image)

NT toolpath example:

![NT toolpath example](image)

**Boss feature**

For a Boss feature, the toolpath has a lot fewer retracts and plunges at the edge of the Stock.
Traditional toolpath example:

NT toolpath example:
Semi-finish pass

The **Semi-finish** attribute of the **Strategy** tab toggles the existence of a semi-finishing operation for the feature. Cutter compensation can be applied to this operation. This operation helps to ensure a consistent width of cut for the finish pass. If the finish pass is cut at multiple Z depths, a semi-finish pass is also cut as each Z depth. See **Finish pass Z increment** (see page 1161) for more information.

![Semi-finish pass diagram](image)

1. Semi-finish pass
2. Finish pass
3. Semi-finish allowance

Finish walls

If this attribute is selected, then the finish allowance is left on the walls of the groove. Selecting this attribute also enables the Wall pass option.

**Wall pass** applies only to the finishing passes of milling features where the bottom is finished.

![Finish walls diagram](image)

1. Finish allowance
2. Wall pass
3. Floor pass

If **Wall pass** is disabled, then the floor is finished all the way out to the wall in a single pass. The wall is not finished separately.
For OD/ID grooves if this attribute is selected, then the bottom is finished separately from the walls of the groove.

1. **Finish allowance**
2. Bottom
3. Wall
4. Wall finish allowance

**Spring passes**

A 'spring pass' is a duplicate of the final threading pass. **Spring passes** indicates the number of spring passes that are to occur at the completion of the thread.

**Wall finish allowance**

The amount of material to leave on the walls of an ID/OD groove.

1. **Finish allowance**
2. Bottom
3. Wall
4. Wall finish allowance
Side control tab (25D)

You can use the Side control tab of the Milling Feature Properties dialog (see page 903) to specify the machining side of some features created from curves.

Select a Curve name in the table. A red arrow is displayed in the graphics window to show the current machining side, for example:

If you want to machine the other side of the curve, click Switch machining side. The machining side is reversed:
Right Angle Head tab (25D)

To display the Right Angled Head tab, you must allow right-angled tool holders (see page 220) on the Right Angled Head page of the Setup wizard.

Use right angle head — Select to use a right-angled head tool.

Feature location is on ID — Select if the feature is on the inside diameter of the part.

Holder orientation in spindle — Enter the holder orientation in the spindle in degrees.
You can use the Misc tab of the Milling Feature Properties dialog (see page 903) to edit the machining options of a Milling feature.

**B-axis fixture location** — This applies to B-axis turn/mill features.

To set the origin of the coordinate system for a B-axis turn/mill feature, select **B-axis fixture location** in the attributes list and use the **Pick point** button to pick the location in the Graphics window.

When it is set, the **B-axis fixture location** point is used as the origin instead of the natural anchor for the B-axis feature.

- **This attribute is shown only when the feature is on the OD (B != 0).**
- **If B == 90, then it is shown only if Use coordinate transformation for B-axis on OD is selected in XBUILD.**
- **This attribute is dominant if it is set and Offset fixture to feature origin is selected in XBUILD.**

**Chamfer before finish** — Enable this option to do the Chamfer operation before the Finish operation.
**Deburr radius** — Enter a radius to automatically round sharp outside corners of the feature by the specified radius. The feature shape does not change, but the toolpaths are modified to reflect the rounding.

*To automatically round inside corners, use Min. corner radius.*

**Equal depth of cut** — Enable this option to make each Z step equal depth.

If **Equal depth of cut** is selected, FeatureCAM calculates the depth of cut like this:

1. Divides the feature depth, for example 10 mm, by the depth of cut (see page 1023) you set to get the number of steps.
2. Divides the depth by the number of steps to get the actual depth of cut (the depth of cut for each step is equal).

For example:

If the feature depth is 10 mm and you set a depth of cut of 3 mm, the number of steps is calculated as \((10/3) + 1 = 4\) steps. The actual depth of cut is \(10 / 4 = 2.5\) mm. The steps are cut at 2.5 mm, 5 mm, 7.5 mm, and 10 mm.

*If the second to last pass is within 10% of the depth of cut, it is ignored.*

For a feature depth of 10 mm with a depth of cut of 3.3 mm, the steps are cut at 3.3 mm, 6.6 mm, and 10.0 mm.

For a feature depth of 10 mm with a depth of cut of 3.2 mm, the steps are cut at 3.2 mm, 6.4 mm, 9.6 mm, and 10 mm.

To set an exact depth of cut, deselect **Equal depth of cut**.

Using the same example, with **Equal depth of cut** deselected:

If the feature depth is 10mm and you set a depth of cut (see page 1023) of 3mm, the number of steps is calculated as \((10/3) + 1 = 4\) steps. FeatureCAM uses the actual depth of cut you set (3 mm) for each pass, then cuts any remainder depth. The steps are cut at 3 mm, 6 mm, 9 mm, and 10 mm.

These features support exact depth of cut:
• Profile boss
• Profile pocket
• Profile side
• Profile groove (Face groove only)
• Slot

• Rectangular pocket
• Step bore
• Counter bore hole
• Plain hole with drill/mill roughing
• Tapped hole with drill/mill roughing

**Feed override %** — Enter a scaling factor for the feed rates generated by the system. A value of less than 100 reduces the calculated feed rates. A value of more than 100 increases the rates.

**Max. spindle RPM** — Enter the maximum spindle speed (in RPM) that you want to use.

**Min. corner radius** — Enter a radius to automatically round the inside corners of a feature by the specified radius. The feature shape does not change, but the toolpaths are modified to reflect the rounding.

*To automatically round outside corners, use Deburr radius.*

**Plunge clearance** — Enter the distance above the operation at which the tool feeds. You can override this value for the Finish operation on the **Plunge** (see page 1028) tab.

This is marked as L1 in the diagram.

For deep hole drilling, the drill retracts to this distance between pecks. For milling features, the default is to use the same value for roughing and finishing. As a result, the tool feeds from the top of a feature to the floor before cutting. To make the tool feed down into the feature, set the **Plunge clearance** for an operation to a negative value, but ensure the value is above the floor of the feature.

To rapid to depth, you can use a negative **Plunge clearance**, or select Relative plunge.

**Plunge feed override %** — This gives the scaling value for the feed rate used during the initial plunge into the material for milling operations.

**Relative plunge**
The **Relative plunge** attribute in 3D machining affects how the **Plunge clearance** attribute is used.

When **Relative plunge** is deselected, the tool plunges to the **Plunge clearance** as an absolute value. This can cause the tool to feed an unnecessary amount for parts that are not flat. For example, in this uphill only surface toolpath the tool rapids to a set Z value and then feeds to the part on each end:

![Diagram 1](image1.png)

When **Relative plunge** is selected, **Plunge clearance** is used as a relative distance from the surface. For example, here the tool plunges down closer to the part.

![Diagram 2](image2.png)

**Retract to plunge clearance** — Enable this option to retract to the **Plunge clearance** instead of the higher **Z rapid plane** after cutting.

![Diagram 3](image3.png)

**Spindle RPM override %** — Enter a scaling factor for the speed rates generated by the system. A value of less than 100 reduces the speed rate, and a value of greater than 100 increases it.

**Spline tolerance** — If a profile is defined as a spline, it is approximated with arcs and lines. Enter a tolerance value for the approximation. The smaller the tolerance, the smoother the profile.
**Subfixture ID** — This enables you to use a separate fixture offset for each feature, and corresponds to the `<SUBFIXTURE>` reserved word in XBUILD. For example, if the **Fixture ID** is 54 and you enter a **Subfixture ID** of 1, the output is 54.1.

For patterns, enter a **Subfixture ID start** value and a **Subfixture ID increment** value. For example, if the **Fixture ID** is 54 and you enter a **Subfixture ID start** of 1 and a **Subfixture ID increment** of 1, the output is 54.1, 54.2, 54.3, and so on.

**Subfixture ID increment** — See **Subfixture ID**.

**Subfixture ID start** — See **Subfixture ID**.

**Tool % of arc radius** — This controls the size of the tool that is automatically selected.

![In earlier program versions this attribute was called Default tool %.]()

**Z rapid plane** — Enter the minimum safe distance in Z above your part.

Before performing a rapid move away from a feature, the tool retracts to the **Z rapid plane** setting for that feature. The rapid move to the next feature changes in Z height, that is, changes Z coordinates, if the next feature has a different **Z rapid plane** setting. So that when it arrives at the next feature it is at the **Z rapid plane** for that next feature.

This value is relative to the top of your stock in the current user coordinate system. Compare with **Plunge clearance**.
**Wall tab (25D)**

You can use the **Wall** tab of the **Milling Feature Properties** dialog (see page 903) to control the roughing and finishing of milled features with a draft angle or bottom radius.

![Image of Wall tab](image-url)

**Side Roughing**

**Auto** — This automates the roughing of features with a bottom radius or a draft angle. FeatureCAM automatically chooses tools, and the number of steps to manufacture the part. If you want specific control, turn off **Auto** and the other fields become active.

**Flat-end mill** — Enable this option to create a **draft flat** operation, which roughs the bottom radius and possibly the walls with a flat-end mill. Enter a number of **Steps** to use (in the Z direction) or leave the **Steps** field blank to use the **Draft flat scallop height** attribute on the **Milling** (see page 994) tab to control the number of steps.

**Radius mill** — Enable this option to create a **draft radius** operation which roughs the bottom radius and possibly the walls with a ball-end or bull nose mill. Enter a number of **Steps** to use (in the Z direction) or leave the **Steps** field blank to use the **Draft radius scallop height** attribute on the **Milling** (see page 994) tab to control the number of steps.
**Tapered mill** — Select this option to create a draft taper operation, which roughs the walls with a tapered endmill. Enter a number of Steps to use (in the Z direction). This option is available only for tapered features.

**Bottom up** — Enable this option to rough the bottom radius or tapered region from the bottom up, otherwise the roughing is performed from the top down.

**Side Finishing**

These settings affect how FeatureCAM performs finishing of a draft angle feature including bottom radius features.

Choose from the following options:

**Automatic** — Enable this option to let FeatureCAM decide how to finish the side wall and/or bottom radius of the feature.

**Radius mill** — Enable this option to create a finish pass operation that finishes the wall and bottom radius with a radius tool. This could be either a finish pass bull nose or ball end tool. The **Radius tool scallop height** attribute on the **Milling** (see page 994) tab controls the scallop height of the operation.

**Tapered mill** — Enable this option to create a finish taper operation that finishes the side wall up to the bottom radius, if any, with a tapered mill that matches the feature's defined taper. If no tool matches the draft angle, an error message is displayed.

**Bottom up** — Enable this option to finish the walls starting at the bottom of the feature, otherwise the finishing is performed from the top down.

**Manufacturing milled features with tapered walls**

Features with tapered walls are manufactured similarly to those with just a bottom radius. In addition to the bottom radius operations there is an optional Draft taper operation shown below.
The Draft taper operation is a roughing operation for the tapered wall region. Typically, you would either use a draft taper operation or a draft radius operation.

For tapered features, the Finish Pass can be performed with a tapered or ball-end tool.

*Manufacturing steps for milled features with bottom radius regions or cross sections*

Features with a bottom radius are manufactured with some combination of the operations shown below.

1. The **Rough pass** cuts starting at the top and either roughs down to the bottom of the feature (if you are not finishing the bottom) or leaves a finish allowance at the bottom.

2. The stair steps of the roughing operation are knocked down by the **Draft flat** operation. This operation takes only a single pass at each Z level.

3. The stair steps of the **Draft flat** operation can be further smoothed by the **Draft radius** operation. This operation also takes only a single pass at each Z level.

4. If the bottom of the feature is finished the **Flat bottom** operation is performed next with a flat-end mill.

5. The bottom radius and the walls of the feature are finished by the **Finish pass**.

6. If the feature has a tight corner on the floor that could not be finished by the flat bottom operation, a **Corner** operation is performed.
Tools tab (25D)

You can use the Tools tab of the Milling Feature Properties dialog (see page 903) to select a tool to machine a feature or create a new tool.

The table lists the default recommended tool (marked with a D) and other tools in the current tool crib that fit the tool selection criteria. If you do not want to use the recommended tool, select the check box next to the tool name you want in the table. The tools that are listed in the table are controlled by the filter settings.
The tools displayed in the table are chosen from the database based on the criteria listed above the table. If you would like to choose from different tools, change the filter criteria. The criteria are:

- **Tool Group** — The tooling in the tooling database is separated into different groups. Select a group from the list or select **Anything** to show tooling from all groups.
- **Diameter** — Enter a specific diameter or select **Anything** to see tools of all diameters.
- **End radius** — Enter a specific end radius or select **Anything** to see tools of all radii.

Regardless of the filtering criteria, the automatically selected tool stays in the list.

Select a tool in the table to see the preview image in the upper right-hand corner of the dialog. You can pan and zoom this display by left-clicking and dragging the mouse cursor in the tool graphic window. Right-click in the tool graphic window and select **Center all** to center the entire tool and holder.

You can sort the tools listed in the table by any column by clicking the title of the column.

![You can adjust the column widths by clicking and dragging the borders of the column titles. FeatureCAM remembers your width preferences.](image)

- **Undo tool override** — Click this button to revert the selected tool back to the default recommended tool (marked with a D).
- **New tool** — Click this button to create a brand new tool and add it to the current crib. The tool that is selected in the table is used to fill in the initial values for the tool.
- **Tool manager** — Click this button to open the **Tool Manager** (see page 1745) dialog.
- **Properties** — Click this button to open the **Tool Properties** (see page 1749, see page 1795) dialog for the selected tool.

**Recent tools** — Select this option to filter the list and show only recently used tools.

To override the automatically selected tool to one of your choice:

1. Select the **Tool Group**.
2. Select or enter the tool **Diameter**.
3. Select or enter the tool's **End-Radii**.
4 Optionally select the **Recent tools** option to filter your tool search further.

5 Scroll through the table.

6 To preview a tool:
   - Select a tool in the table to view it in the small graphics window. You can pan and zoom this view.
   - Select a tool in the table and click the **Properties** button or double-click a tool in the table to open its **Tool Properties** (see page 1749) dialog. You can edit the tool’s properties if you want to.

7 To change the tool, select the check box next to the **Name** of the tool you want to use in the table.

8 If you cannot find the tool you want, click the **New tool** button and create a new tool (see page 1749).

To revert back to the automatically selected tool, click the **Undo tool override** button. The override tool is deselected in the table and FeatureCAM uses the default tool marked D.

**F/S tab (25D)**

You can use the F/S tab of the Milling **Feature Properties** dialog (see page 1749) to view and edit feed and speed settings for the operation selected in the tree view (see page 884).
Speed

The **Speed** section is for setting how fast the tool spins. The default units are **RPM** (revolutions per minute). Optionally select **Use SFM** (surface feet per minute) to change the units. FeatureCAM uses the **Recommended** speed value by default. You can optionally enter a different value and the **override** option is automatically selected. If you want to revert back to the recommended value, deselect **override**.

Feed

The **Feed** section is for setting how fast the tool moves through the stock. The default units are **IPM** (inches per minute) or **MMPM** (mm per minute). Optionally select **Use IPR** (inches per revolution), **Use IPT** (inches per tooth), **Use MMPR** (mm per revolution), or **Use MMPT** (mm per tooth) to change the units.

FeatureCAM uses the **Recommended** feed value by default. You can optionally enter a different value and the **override** option is automatically selected. If you want to revert back to the recommended value, deselect **override**.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. Set the **Feed unit** on the **Misc.** (see page 1648) tab.

**Reset All** clears any overrides you made to the feeds and speeds and returns the settings to the default value for tool attributes listed on that page.
Coolant tab

You can use the Coolant tab of the Feature Properties dialog to select which coolant types to use for each operation.

Select the coolant types you want to enable for the operation. The available coolant types are specified in the CNC file.

Deselect Override to use the default coolant types set in the Coolant tab in the Tool Properties dialog and the Machining Attributes dialog.

Stepovers tab (25D)

You can use the Stepovers tab of the Milling Feature Properties (see page 1749) dialog to control the toolpath transitions for 2.5D milling. The type of transitions that occur at the beginning and ending of a toolpath depend on whether that portion of the toolpath is a closed or an open toolpath (see page 993).
**Traditional toolpaths:**

*Cut type* — Here you can override the feature-level *Stepover type* that you set on the *Strategy* (see page 936) tab for each operation. If you are using *Individual rough levels*, you can set the *Cut type* for each individual rough pass.

*Non-Cutting Moves* — Click this button to display the Vortex *Non-Cutting Moves* dialog (see page 1069) where you can specify whether to retract and increase the feed rate on non-cutting moves for vortex toolpaths.

**Distance between cuts**

For roughing, the *Distance between cuts* is the horizontal distance between roughing toolpaths. The automatically calculated distance is based on the setting of Rough pass stepover %. For finishing, it is fixed to be the Finish allowance (see page 994). See Default ramping for milled finish passes (see page 993) for more information on finish pass ramping.

For Chamfers and Rounds this attribute enables multiple rough or finish passes. The default value for roughing is the radius of the Round feature or the largest dimension of the Chamfer feature. The default value for finishing is the Finish allowance (see page 994). By decreasing this value multiple roughing or finishing passes are created by stepping in horizontally.

**Connection moves for cuts with closed ends:**
Ramp type — Select the stepover style from the list.

Direct
The Direct stepover connection type creates a straight linear transition that is perpendicular to the toolpath.

Arc
The Arc stepover connection type creates an arc transition. Set the Diameter parameter to specify the radius of the arc as a percentage of the tool diameter. This example has the Ramp diameter set to 55%:

This example has the Ramp diameter set to 600%:

Line
The Line stepover connection type creates a linear stepover at an angle. The length of the line is determined by multiplying the diameter of the tool by the Ramp diameter parameter.
**S-shape**

The **S-shape** stepover connection type creates a stepover move that consists of two arcs. As a result this transition makes a smooth exit from the existing contour to the new contour. The diameter of the arcs is determined by the **Ramp diameter** parameter.

**Ramp diameter** — See **Ramp type**.

**Lead moves for cuts with open ends:**

**Extension distance**

Enter a distance if you want to move the tool off the part by that distance at the end of each pass.

In this Side feature example, we used an extension distance of **1 inch**:
Compare it to the same example with no extension distance added:

![Image](Image)

**Arc Lead**

*Arc Lead* changes the lead-in or lead-out move to be an arc. The endpoint of the arc is determined by the **Lead distance** and either the **Lead-in angle** or **Lead-out angle**.

1. - Lead in/out angle
2. - Lead distance

**Lead distance in/out**

*Lead distance in/out* is the linear distance that a tool path extends beyond the ends of an open toolpath or toolpaths that are clipped against the stock profile. This parameter is specified as a percentage of the tool’s diameter. If **Lead Distance** is set to 0.0, the toolpath starts or stops exactly at the ends of the profile.
Add 90-deg, comp. move
Select this option and enter a Distance to add a straight line move to the start and end of the pass so that cutter compensation is applied during the lead into and out of the Arc Lead moves.

To enable this option, Arc Lead must be selected.

For example, this Side feature:

Enabled:

Disabled:

All Stepover
The All Stepover attribute adds a lead-in and lead-out to each stepover move for an open feature.
This example shows the behavior with **All Stepover** deselected.

And with **All Stepover** selected:

**Lead In** — Select **Lead In** to have a lead-in move and enter a **Lead-in angle**. The **Lead-in angle** applies only over the **Lead-in distance**, so if the **Lead-in distance** is 0, the **Lead-in angle** has no effect.

**Lead Out** — Select **Lead Out** to have a lead-out move and enter a **Lead-out angle**. The **Lead-out angle** applies only over the **Lead-out distance**, so if the **Lead-out distance** is 0, the **Lead-out angle** has no effect. The **Lead-out angle** is applied to the end of the finish pass for an open toolpath. It also applies to the last toolpath of a roughing pass if the **Finish allowance** is set to 0.

Default ramping for milled finish passes (see page 993)
NT (new technology) toolpaths:

![Image of NT toolpaths interface]

**Cut type** — Here you can override the feature-level **Stepover type** that you set on the **Strategy** (see page 936) tab for each operation. If you are using **Individual rough levels**, you can set the **Cut type** for each individual rough pass.

Connection moves for cuts with closed ends — There are two **Ramp type** options for the NT toolpaths:

- **Smooth** — This is similar to the traditional toolpath option S-type
- **Direct** — This is similar to the traditional toolpath option Line.

**Approach from outside** — This option automatically adds a very small lead-in whenever the tool is plunging off the stock. When you select this option, the **Lead-in** options are disabled. Deselect it to manually specify the lead-in as a line, arc, and/or toolpath extension.

**Angle** — This option supports only positive angles. The direction relative to the toolpath is automatically determined.

**Transitions for 2.5D milling toolpaths**

The type of transitions that occur at the beginning and ending of a toolpath depend on whether that portion of the toolpath is a loop or an open toolpath. The transitions for open toolpaths are linear and are controlled by Lead in angle and Lead distance. Transitions between closed toolpaths are arcs. See Default ramping for milled finish passes (see page 993) for more information on the parameters controlling closed loop toolpaths.
**Lead distance in/out** is the linear distance that a tool path extends beyond the ends of an open toolpath or toolpaths that are clipped against the stock profile. This parameter is specified as a percentage of the tool's diameter. If **Lead Distance** is set to 0.0, the toolpath starts or stops exactly at the ends of the profile.

![Diagram showing lead distance in/out and lead-in/out angle](image)

- **1** - Lead-in/out angle
- **2** - Lead distance in/out

The **Lead-in angle** applies only over the **Lead-in distance**, so if the **Lead-in distance** is 0, the **Lead-in angle** has no effect.

**Open and closed portions of toolpaths**

An open toolpath plunges at one point and retracts at another point. A closed toolpath forms a loop and begins and ends at the same point.

*Rough or finish passes can contain closed, open or both types of toolpaths.*

![Diagram showing closed loop toolpaths and open toolpath](image)

- **1** Closed loop toolpaths
- **2** Open toolpath

**Default ramping for milled finish passes**

The lead in moves for finish passes for closed milled features such as pockets and bosses consist of a short linear move and an arc ramp on move. These moves are included to accommodate the cutter compensation requirements of many controllers.
The radius of the arc \(^1\) is controlled by the **Ramp diameter %** in the Stepover/Lead tab (see page 985), which is specified as a percentage of the tool diameter.

The default length of the linear move \(^2\) is the **Finish allowance** of the roughing pass of the feature.

![Diagram showing radius control]

You can change the length of the linear move by setting the **Minimum ramp distance** milling attribute on the finish pass to an explicit distance, or by setting the **Minimum ramp distance %** default attribute as a percentage of the tool diameter.

If you set a **Minimum ramp distance**, the arc and linear move make up a quadrant of a circle that has a radius equal to the **Minimum ramp distance**.

![Diagram showing minimum ramp distance]

**Milling tab (25D)**

You can use the **Milling** tab of the **Milling Feature Properties** dialog (see page 903) to edit the Milling attributes for an Operation.
The attributes displayed on the **Milling** tab depend on the feature and the operation/pass selected in the tree view.

![Rectangular Pocket Properties - rect_pock1](image)

**General attributes**

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s) (see page 931). If left blank, FeatureCAM uses the **Finish allowance** value.

*This attribute is available for NT roughing toolpaths for Boss, Pocket, and Side features. Also for Face features created with feature recognition (if the plane of the face intersects the clamp solids).*

**Cutter comp.** — Enable this option to enable Cutter compensation for the operation.

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool's actual diameter and the diameter specified. For example, if the specified diameter is **0.500**, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.
The direction of the compensation depends on the value of **Climb mill**. If **Climb mill** is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select **Enable Cut Comp** in **Post Options** (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the **Cutter Comp** attribute selected. If the **Cutter Comp** option is deselected in the **Post Options** dialog, then cutter compensation is disabled for the entire part regardless of the value of the **Cutter Comp** attributes on each feature.

If you select **Part line program**, you get a special kind of cutter compensation known as part line programming.

If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. Set it on the **Milling** (see page 1607, see page 1660) tab.

**Min. corner radius** — Enter a radius to automatically round the inside corners of a feature by the specified radius. The feature shape does not change, but the toolpaths are modified to reflect the rounding.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves.
Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. Set it on the Misc. (see page 1648) tab.

NT toolpaths do not have the Min. rapid distance % attribute. They use Stepover rapid distance instead.

Priority
Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Stepover rapid distance** — This option controls when to retract and plunge on Boss stepovers for NT toolpaths. Enter an absolute distance.

*Traditional toolpaths (Spiral and Zigzag) do not have the Stepover rapid distance attribute. They use Min. rapid distance % instead.*

**Target horsepower** (see page 1574) — Enter the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Through depth** — Enter a value to add extra depth to the feature. All operations in the feature are updated to have the same value for this attribute.

It applies to Slot, Step Bore, Groove, Sides, and Chamfer features.

**Total stock** — Enter an offset distance around a profile feature to use instead of the stock boundary for the current operation. This applies to rough operations and finish operations where Finish bottom is enabled.

**Total stock** changes the rough or finish operation to use a constant offset distance from the profile of a profile feature. So instead of cutting to the stock boundary, which may already have been cut away, and without having to specify a stock curve, you can still minimize redundant cutting by using **Total stock**.
This example shows a toolpath without the **Total stock** attribute set.

This is the same example with **Total stock** set to **0.25** inches:

This is the same example with **Total stock** set to **1.0** inches:

**Post Vars.** (see page 1656) button

**Pre-drill diameter** — Enter the diameter for pre-drill holes. Ensure the diameter is large enough to allow the milling tool to enter the stock.

**Roughing attributes**

These attributes are available to you on the **Milling** tab when you select a **rough pass** in the tree view.
**Bottom finish allowance** — Enter the amount of material to leave on the bottom of a feature after the rough pass. This is only available when **Finish bottom** is selected on the **Strategy** tab.

**Cleanup passes** — Used with a **Stepover type** (see page 936) of **Zigzag**, enter the number of cleanup passes to machine.

**Curly Corner** (see page 1019) dialog

**Finish allowance** — Enter the amount of material to leave on a feature after the Rough pass. You can enter a positive or negative value.

![Diagram of Roughing region and Finish allowance]

1. Roughing region
2. Finish allowance

The roughing region is determined by offsetting the boundaries of the feature by the **Finish allowance**.

**HSM max tool overload %** — When the tool approaches overload, a trochoidal path is inserted to avoid the overload. Enter the maximum allowable overload as a percentage of the existing stepover. For example, if you enter an **HSM Max tool overload %** of **10**, trochoidal moves start when an overload condition of **10%** is exceeded. This attribute instigates trochoidal machining for NT Spiral and NT Continuous Spiral toolpaths.

**HSM profile corner %** — Enter the value as a percentage of the tool's diameter. This enables arc fitting of profiles to avoid sharp changes of direction in internal toolpaths. This attribute applies to NT Spiral, NT Continuous Spiral, NT Zigzag and Vortex toolpaths.

**HSM smoothing allowance %** — Enter the smoothing allowance as a percentage of the existing stepover, to replace the standard offset with a smoother one that can achieve higher feed rates. The percentage defines the maximum deviation from the existing stepover. For example, if you enter an **HSM smoothing allowance %** of **40**, and the existing stepover is **10** mm, the maximum deviation from the original to the smoothed offset is **4** mm.
The advantages are that rounded corners replace sharp corners and curve continuity (not just tangency continuity) is maintained to prevent abrupt changes in force on a machine tool caused by sharp turns in a toolpath. This attribute applies to NT Spiral and NT Continuous Spiral toolpaths.

**Mult. rough diameter(s)** (see page 1016) — Enter a list of roughing tool diameters separated by commas, to enable multiple Rough passes.

![Image](the last diameter is also used for the Finish pass. If you want the system to select the tool for the final roughing pass, enter the last diameter as 0.]

**Rough pass Z increment** — This sets the depth of cut for the rough pass. Enter a step increment for each pass that the roughing routine performs on the part. You can set the depth of cut (see page 1023) in several places.

**Stock Model Options** — Click this button to open the Stock Model Settings (see page 1026) dialog. This button is available when you are using a stock model (see page 930) with an NT toolpath (see page 936) for a rough operation.

**Toolpath corner %** — To round sharp corners, enter a percentage of the tool diameter. Smoothing the sharp corners of the toolpaths gives a more constant tool velocity and reduces the tool load. Enter a toolpath radius larger than the tool radius to minimize the percentage of the tool that contacts the part. This enables enough cooling to take place and avoiding sharp increases in tool load as the tool enters the corners.

It applies to all 2.5D milling features. This image shows a feature without Toolpath corner % set:
This image shows the same feature with **Toolpath corner %** set:

See also High speed machining application of toolpath corner %.

You can set **Toolpath corner %** to any positive percentage. Setting it to a large percentage like 200% or 300% provides a high degree of toolpath smoothing. In this case, where the radius of the cutter is significantly less than the radius of the corner, the percentage of the tool that contacts the part is minimized. This allows the tool to cool and also avoids sharp increases in tool load as it enters the corners.

For high speed machining applications:

1. Create at least two roughing passes using **Mult. rough diameters** parameter. You can set the tool diameters to be the same if you want to use the same diameter for each pass.

2. Set the **Toolpath corner %** to a high value (for example **200%**) for the initial roughing pass. This pass covers the majority of the part with smooth toolpaths. This image shows an example of smoothing toolpaths using a high corner %.
3 Set Toolpath corner % to lower values for subsequent roughing passes. These toolpaths cover only the remaining regions of the part. This image shows the second roughing toolpaths.

4 It is best to set Tool corner % to less than 25% for the last roughing pass to ensure that the entire part is roughed. These toolpaths initially have more inconsistent tool loads, but you can adjust the stepovers (see page 985), depth of cut (see page 994), or feed rate separately for these passes to create acceptable tool loads. You can use the tool loads dialog (see page 1545) during 3D simulation to verify the tool loads of your paths before cutting.

**Trochoidal cut** — Enable this option to use a trochoidal cut on a Simple Groove. Select the direction of the trochoids for a trochoidal cut, from CW (clockwise) or CCW (counter-clockwise).

Instead of a simple slotting cut, the tool uses a series of circles, for example:

A trochoidal toolpath reduces the load on the tool.

**Trochoidal stepover** — Enter the amount to step over between adjacent circles in a Trochoidal cut toolpath.

**Vortex min point spacing** — Enter the minimum point spacing at which the machine tool can move at the specified feed rate. If the machine tool has too many points to process, it cannot sustain the specified feed rate.

**Vortex min radius** — Enter the minimum radius of the internal trochoids. Vortex toolpaths use trochoidal moves to maintain a constant feed rate. Higher feed rates require a larger minimum radius. If you do not override this value, a default value is used, which is suitable for a typical machine tool at the feed rate specified for the operation.
Vortex Z lift distance — Enter a Z distance to lift the tool during trochoidal moves to avoid contact between the tool and the surface.

**Finishing attributes**

These attributes are available to you on the **Milling** tab when you select a **finish** operation in the tree view.

**Bottom leave allowance** — Enter the amount of material to leave on the floor of the feature after the Finish pass. You can enter a positive or negative value.

**Bottom semi-finish allowance** — This is the amount of material to leave on the floor of a milled feature after the semi-finish operation. It only applies if the **Semi-Finish** and **Finish bottom** attributes are selected on a mill feature’s **Strategy** (see page 936) tab. The attribute **Finish allowance** controls the allowance on the walls of a feature. You can enter a positive or negative value.

**Finish allowance** — This is a facing parameter for the amount of material to leave after the rough pass. You can enter a positive or negative value.

**Finish overlap** — This attribute applies to features defined by closed profiles and is the distance that the tool overlaps its starting point on the finish pass. Enter the absolute distance.

---

*The toolpath runs counter-clockwise.*
**Finish pass Z increment** — By default, a milling feature is finished with a single pass along the wall of the feature.

Enter a positive number for **Finish pass Z increment** to finish the feature with a series of vertical passes. Each pass has a depth of the value entered.

- The finishing tool needs a cutter length greater than or equal to **Finish pass Z increment**.
- This sets the depth of cut for the finish pass. You can set the depth of cut (see page 1023) in several places.

**Finish passes** — Enter the number of duplicate finish passes to make. If you want to compensate for tool deflection, set **Finish passes** to more than 1.

**HSM max tool overload %** — This attribute instigates trochoidal machining for NT Spiral and NT Continuous Spiral toolpaths. When the tool approaches overload, a trochoidal path is inserted to avoid the overload.

**HSM profile corner %** — This attribute applies to NT Spiral, NT Continuous Spiral, and NT Zigzag toolpaths. Select to allow the arc fitting of profiles to avoid sharp changes of direction in internal corners.

**HSM smoothing allowance %** — This attribute applies to NT Spiral and NT Continuous Spiral toolpaths. Select this option to replace the standard offset with a smoother one that can achieve higher feed rates.

- Rounded corners replace sharp corners.
• Changes the stepover from a fixed to a variable distance. The percentage defines the maximum deviation from the specified stepover. The maximum percentage is 40% of stepover. So, if you have a 10 mm stepover the maximum deviation from the original to the smoothed offset is 4 mm.

• Maintains curvature continuity (not just tangency continuity) to prevent abrupt changes in force on a machine tool caused by sharp turns in a toolpath.

**Minimum ramp distance** — This attribute applies to the Finish operation. Enter the minimum horizontal distance for ramping. If the computed horizontal ramp distance is less than this, the tool plunges instead of ramping.

**Mult. finish diameter(s)**

**Mult. finish diameter(s)** controls the use of multiple finishing tools. Enter a list of diameters separated by commas. If you want FeatureCAM to select the tool to use for the last pass, set the last Tool diameter to 0.

Enter the largest tool you want to use first, followed by gradually smaller tools until the required finish tool. For example, you can let the system pick the tooling initially, then set up your diameter list to work gradually toward the last value. If the system recommends a 0.125 inch endmill, set your Tool diameter attribute to 1.0, 0.5, 0.

By default, FeatureCAM creates one finish pass for all of the milled features. If you use multiple finishing tools, FeatureCAM cuts all the parts of a feature that it is capable of cutting with the larger tool, and cuts only the remaining portions of the feature with the smaller tool. You do not have to manually create these separate regions. FeatureCAM automatically calculates them for you.

Default ramping for milled finish passes (see page 993)

**Ramp diameter** — This sets a percentage of the tool diameter to generate a tool motion that approaches the stock along a curve on the finishing pass. The tool arcs only within the distance set in the finish pass allowance, so the ramping effect is small.

**Side leave allowance** — Enter the amount of material to leave on the walls of the feature after the Finish pass. You can enter a positive or negative value.

**Facing attributes**

**Last pass overcut %** — This attribute applies to a Face feature. Enter the distance, as a percentage of the tool radius, that the tool moves past the stock boundary perpendicular to the cut, in the Y direction (unless you have changed the Zigzag angle). The default value is 20% of the tool radius.
This example shows a Face feature top view centerline simulation using the default \textbf{Last pass overcut} \% value of 20\% of the tool radius (the distance marked with the arrows):

This is the same example with the \textbf{Last pass overcut} \% value set to 50 \% of the tool radius:

\textbf{Lateral overcut} \% — Enter the distance, as a percentage of the tool radius, that the tool cuts past the stock boundary in the direction of the cut, on the X axis (unless you have changed the \textbf{Zigzag angle}). The default value is 100\% of the tool radius.
This example shows a Face feature top view centerline simulation using the default **Lateral overcut %** value of 100% of the tool radius (the distance marked with the arrows):

This is the same example with the **Lateral overcut %** value set to 150% of the tool radius:

**Stepover %** — Enter the width of cut as a percentage of the tool diameter. The default value is 85%.

**Z Increment** is the depth of each cut of the facing operation.

**Zigzag angle** — Enter the angle in degrees (counter-clockwise from X) that you want to use to cut the Face feature.
An example of a Face feature with **Zigzag angle** set to the default 0 deg:

The same example with **Zigzag angle** set to 30 deg:

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. Set it on the **Facing** (see page 1681) tab.

**Thread Milling attributes**

The following attributes are available on the **Milling** tab for thread mill features.

**Feed to depth override %** — Enter the percentage of the **Feed** setting to use when feeding to depth.

**Linear ramp dist.** — Enter the length of the linear approach move to a Thread feature.
To activate this attribute, you must set **Ramp diameter %** to **0**.

**Ramp diameter %** — This attribute controls the diameter of the arc along which the tool ramps on and off the Thread Milling feature. Enter a percentage of the tool diameter.

Negative angles create a ramp on a clockwise arc. If set to a value greater than **1000**, the tool moves in on a straight line tangent to the initial cutting move. If set to **0**, the tool approaches perpendicular to the initial cutting move.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Thread Mill** (see page 1660) tab.

**Ramp angle offset** — This angle controls the starting and ending points of the ramp moves of a Thread Milling feature. The tool starts ramping along the arc of radius **Ramp diameter %** using the **Ramp angle offset** to determine the start point of the ramping move. If positive, the arc is counter-clockwise.
**Start angle** — Measured counter-clockwise, the Start angle determines the starting point of the thread.

Measured counter-clockwise, the Start angle determines the starting point of the thread.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Thread Mill** (see page 1660) tab.

**Start threads** — Enter a value greater than 1 for multiple start threads.

**Taper approx angle** — For tapered threads, the toolpath is increases in diameter as well as moving in Z. These moves are approximated with 3D arcs. The Taper approx angle is the angle around the thread that is approximated by a single arc. A 360 must be evenly divisible by the Taper approx angle. For example, if set to 90, a single revolution of the tool is broken into four arcs.

**Through** — Select Through to increase the hole length by 10% of the hole diameter to account for the drill tip and prevent burring. If Through is deselected, the toolpaths are generated to ensure that the tool does not cut past the end of the thread.

**Tooth outside** — Enter the number of teeth that are above (if feeding in negative Z) or below (if feeding in positive Z) the thread mill feature for the first pass.

**Tooth overlap** — Enter the number of threads that one revolution of a multi-thread tool overlaps the previous revolution. An overlap of at least one thread is recommended.
Tool revolution 1
Tool revolution 2

Tooth overlap

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Thread Mill (see page 1660) tab.

Ramp in feed override % — Enter the percentage of the Feed setting to use when ramping into a feature.

Ramp out Feed override % — Enter the percentage of the Feed setting to use when ramping out of a feature.

Wind fan radius — Enter the radius to use for the wind fan shape. Increasing the Wind fan radius moves the toolpath’s start point further from the feature boundary.

Wind fan angle — Enter the angle to use for the wind fan shape. The wind fan angle is a combination of the lead-in and lead-out arc angles.

Chamfer, draft angle, and bottom radius attributes

Chamfer depth

For milled chamfers, Chamfer depth controls the depth of the tool and therefore the contact point. The default Chamfer depth for a chamfer is 0.1 inches or 3 mm. This means that the tool extends 0.1 inches or 3 mm below the bottom of the chamfer. A setting of 0.0 places the bottom of the tool at the bottom of the chamfer. A larger value moves the contact point down the tool.

Through depth
You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Misc (see page 1648) tab.

Manufacturing steps for milled features with bottom radius regions or cross sections.

Features with a bottom radius are manufactured with some combination of the operations shown below.

1. The **Rough pass** cuts starting at the top and either roughs down to the bottom of the feature (if you are not finishing the bottom) or leaves a finish allowance at the bottom.

2. The stair steps of the roughing operation are knocked down by the **Draft flat** operation. This operation takes only a single pass at each Z level.

3. The stair steps of the **Draft flat** operation can be further smoothed by the **Draft radius** operation. This operation also takes only a single pass at each Z level.

4. If the bottom of the feature is finished the **Flat bottom** operation is performed next with a flat-end mill.

5. The bottom radius and the walls of the feature are finished by the **Finish pass**.

6. If the feature has a tight corner on the floor that could not be finished by the flat bottom operation, a **Corner** operation is performed.

---

**Draft flat scallop height** — For a feature with a taper or bottom radius, enter the maximum allowable height of any scallops left after the **Draft flat** pass.
Draft radius scallop height — For a feature with a taper or bottom radius, enter the maximum allowable height of any scallops left after the Draft radius pass.

Radius tool scallop height —
Multi-axis milling attributes

Multi-axis milling and drilling features have these attributes.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine's Y direction.
- With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.

- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Mult. rough diameters**

Enter a list of roughing tool diameters separated by commas, to enable multiple Rough passes.

*The last diameter is also used for the Finish pass. If you want the system to select the tool for the final roughing pass, enter the last diameter as 0.*

The system works down the list to the finish tool. One way is to let the system pick the tooling initially, then set up your diameter list to work gradually toward the last value. For example, if the system recommends a 0.125 inch endmill, enter 1.0, 0.5, 0.

By default, FeatureCAM creates one roughing and one finish pass for all of the milled features. If you use multiple roughing tools, FeatureCAM cuts all the parts of a feature that it is capable of cutting with the larger tool, and cuts only the remaining portions of the feature with the smaller tool. You do not have to manually create these separate regions. FeatureCAM automatically calculates them for you.
For cutting Pocket or Boss features, FeatureCAM automatically selects a single tool diameter for roughing and finishing. For a large feature with small corner diameters, this method results in a small tool cutting the middle of the pocket and wastes time. A better strategy uses a larger tool for the wide areas and a smaller tool for the tight corners.

**Output Options dialog**

**Filter linear moves** — This automatically removes unnecessary points in the toolpath while maintaining tolerance. The points are not equispaced because unnecessary points are deleted.

**Filter linear moves and convert arcs to linear** — This is similar to the first option except that all arcs are replaced by straight line segments. This option is suitable for machine tools which do not handle arcs well.

**Redistribute points after filtering linear moves. Convert arcs to linear** — This option allows the insertion of new points. This ensures a constant distance between points, only inserting extra points if they are necessary to keep tolerance. This option may increase toolpath creation time, but reduce time on the machine tool. This option is suitable for machine tools that can handle large numbers of equispaced points.

**Preview** — Click this button to display the points of the toolpath in the graphics window.
Approximate linear moves with arcs and lines — Select this option to create an arc line approximation for toolpaths that are contained in the XY, YZ, and XZ plane. This allows 3D programs to be smaller and to result in smoother surface finishes for certain types of parts. Arc/line approximation applies to the following 3D techniques:

- X-parallel and Y-parallel roughing or finishing with Parallel Angle set to 0.
- Z-level roughing and finishing.
- Isoline finishing where the toolpaths line in a plane.

More about output options

A toolpath is made up of a series of point connections that lie within a tolerance of the surface to be machined. Toolpaths with a low Tolerance value usually have more points to follow the surface more closely.

A toolpath's point distribution controls the number of points in the toolpath. There are a number of options that can influence the output, which you can change depending on how the controller handles the points. Older controllers struggle to deal with a large number of points as they cannot handle the large amounts of information being fed to them from the NC code. Newer controllers often have a much better capacity for point handling, but require more evenly distributed points to achieve smoother machine kinematics.

We recommend the following advice for point distribution:

- The Tolerance value relates to how closely the redistributed toolpath follows the original toolpath tolerance. For example a toolpath, calculated with an original Tolerance of 0.01, which is redistributed with an Output filter tolerance % of 50, has a final toolpath tolerance of between 0.005 and 0.015 (that is, the final toolpath tolerance = original toolpath Tolerance +/- (original toolpath Tolerance * Output filter tolerance %)).

- For newer Heidenhain (such as TNC 530) and Siemens (such as 840D) controllers, we recommend you use the Redistribute option, with the Limit linear moves selected (that is, points are inserted and limited to a maximum gap between points) and a Maximum length of 0.3 mm (0.012 in). This inserts points into the toolpath to ensure a constant distance between points with a maximum gap of 0.3 mm. This process inserts extra points only if they are needed to keep tolerance. This is generally for the more simple '2.5D-type' 3D toolpaths such as Parallel, Z Level Roughing, and so on.
For newer Fanuc controllers (such as 31i) the same as above applies only with a larger gap of, say, 0.5 mm. Though these controllers can handle more points than the normal toolpath output, they are generally slower than the Heidenhain and Siemens equivalent, and as a result need a bigger separation gap. This is generally for the more simple '2.5D-type' 3D toolpaths such as Parallel, Z Level Roughing, and so on.

For 3D Spiral type toolpaths, we recommend that you still use **Redistribute**, but that you deselect **Limit linear moves**. This also goes for older machines with the previously mentioned '2.5D-type' 3D toolpaths.

For really old machines we recommend the **Filter linear moves** option, which automatically removes unnecessary points in the toolpath while maintaining tolerance. The **Filter linear moves and convert arcs to linear** option is similar to **Filter linear moves** except that all arcs are replaced by straight line segments (polylines). This option is suitable for machine tools which don't handle arcs well.

The **Approximate linear moves with arcs and lines** option produces toolpaths with arcs inserted wherever possible. This option is suitable for machine tools which handle arcs well, but is only available for 3-axis toolpaths (that is, none of the true 2.5D toolpaths).

The **Surface triangle tolerance %** defines the size of the mesh relative to the machining tolerance. The smaller the value, the finer the mesh, and consequently the toolpath takes longer to calculate, but it is more accurate.

**Curly Corner dialog**

You can use the **Curly Corner** dialog to create curly corner toolpaths.

*The curly corner toolpath is applicable to 2.5D Pocket, Boss, and Side features.*

To display the **Curly Corner** dialog:

1. In the **Milling Feature Properties** dialog, select a pass in the Tree View.
2 Click **Curly Corner** on the **Milling** tab (see page 994) to display the **Curly Corner** dialog.

To enable this technique:

1. Select **Enable curly corner toolpath**.
2. Click **OK** to close the dialog.
You can achieve a uniform cutting condition by carefully controlling the width of cut. Limiting and controlling the width of cut is important when machining hard stock material where the programmed peripheral stepover is small. The **Curly corner** toolpath is excellent for controlling the width of cut. Going from a small stepover to a tight corner or slot cutting produces a high percentage increase of the width of cut, up to the reciprocal of the stepover percent setting in FeatureCAM. For example, a 25% stepover can produce 4 times increase in the tool load, whereas a 5% stepover can produce up to 20 times increase in the tool load. The following images show the varying width of cut for a corner move and the consistent width of the cuts of the curly corner toolpath.
This is called a **Curly corner** toolpath because of the tool's swirling motions around corners while moving forward. With the rounded corners and the curly corners, there are no sharp angles in the toolpath and the width of cut is limited by the specified stepover size. Because of the extra circular motions and the bounded tool load, it is expected to take more time to machine the same pocket than the previous two types of toolpaths. The Curly corner toolpath machines the corners and slots multiple times. Each time, the tool cuts no more than the specified width of cut. The image below shows the shape of the toolpath for cutting a corner using the curly corner toolpath.

![Curly Corner Toolpath](image)

**Curly corner options**

The **Corner Radius** is the radius of the circular toolpaths (or trochoids) that are inserted. The corner radius must be greater than or equal to the **Stepover**.

The **Minimum Angle** is the threshold for inserting the trochoids. If the angle between two toolpath moves is less than this angle, no circular paths are inserted between the moves.

![Minimum Angle](image)

The **Stepover** is the same as the **Distance between cuts**. It is displayed in this dialog so that you can view it along with other relevant parameters.
Overriding the depth of cut

The Rough depth of cut is normally calculated as the tool Diameter multiplied by the Depth % attribute set on the Stepover tab of Machining Attributes.

The default Finish behavior is a single pass around the profile of the feature, up to the Cutter Length of the tool. This is to avoid leaving a mark on the side wall of the feature.

You can override both the Rough and Finish depth of cut in several places, from lowest to highest precedence:
- Tool level: **Depth of cut** attribute on the **Overrides** tab of the **Tool Properties** dialog.
- Tool level: Material-specific **Depth** attribute on the **Feed/Speed** tab of the **Tool Properties** dialog. Feature operation level: **Rough/Finish pass Z increment** on the **Milling** tab of the **Feature Properties** dialog.

The final depth of cut depends on whether **Equal depth of cut** is selected on the **Misc.** (see page 973) tab of the **Feature Properties** dialog.
**Stock Model Settings dialog**

You can use the **Stock Model Settings** dialog to edit the settings of a stock model.

To display the **Stock Model Settings** dialog, click **Stock Model Options** on the **Milling** tab (see page 994) of the Milling **Feature Properties** dialog.

> *This dialog is available when you are using a stock model (see page 930) with an NT toolpath (see page 936) for a rough operation.*

![Stock Model Settings dialog](image)

**Stock model rest roughing**

These attributes apply to the rough operation.

**Expand area by** — Enter a value to expand rest areas by the specified distance (measured along the surface). A negative value reduces the size of rest areas.

**Detect material thicker than** — Enter a threshold value. FeatureCAM ignores rest material that is thinner than the specified threshold.

**Minimum gap length** — Enter the gap length, which controls fragmentation by replacing gaps shorter than this distance with a toolpath segment. A large value reduces fragmentation, but increases the length of the toolpath that is not cutting material. A small value produces shorter toolpaths, but increases the number of toolpath lifts.
A Minimum gap length of 0:

A Minimum gap length of the default value:

Stock model engagement for finishing

These attributes apply to the finish operation. They reduce tool wear, improve surface finish, and stop the tool engaging with the material excessively.

**Machine stock only** — Select this option to limit the toolpaths to areas where a minimum amount of stock is being removed from the stock model.

**Detect material thicker than** — Enter a threshold value. FeatureCAM ignores rest material that is thinner than the specified threshold.

**Minimum length removed** — Enter a threshold value. FeatureCAM ignores toolpath portions that are shorter than this.

**Use depth of cut** — Select this option to limit the depth of cut to the value you enter.
Plunge tab (25D)

You can use the **Plunge** tab of the **Milling Feature Properties** dialog (see page 903) to edit the plunge settings for a Milling feature.

**Plunge clearance** — Enter the distance above the operation at which the tool feeds.

This is marked as \( L1 \) in the diagram.

For deep hole drilling, the drill retracts to this distance between pecks. For milling features, the default is to use the same value for roughing and finishing. As a result, the tool feeds from the top of a feature to the floor before cutting. To make the tool feed down into the feature, set the **Plunge clearance** for an operation to a negative value, but ensure the value is above the floor of the feature.

To rapid to depth, you can use a negative **Plunge clearance**, or select **Relative plunge**.
**Relative plunge** — Select this option to measure the **Plunge clearance** from the bottom of the feature instead of the top. Select **Relative plunge** and use a **Plunge clearance** of 0 to rapid to depth.

**Plunge feed override** — Enter the percentage of the **Feed** setting to use during a plunge into the material. For example, with a **Feed** (see page 983) attribute of 2000 MMPM and a **Plunge feed override** of 50%, the plunge feed rate is 1000 MMPM.

**First step** — To protect the tool from a hardened surface, enter the percentage by which you want to reduce the calculated **Plunge feed override** for the initial plunge. For example, with a **Feed** attribute of 2000 MMPM, a **Plunge feed override** of 50%, and a **First step** of 20%, the feed rate of the first plunge move is 200 MMPM; and the feed rate of subsequent plunges is 1000 MMPM.

**Z ramp clearance** — Enter the distance above the operation at which ramping starts. **Z ramp clearance** is bound by **Plunge clearance**. This is marked as L2 in the diagram.
Max. ramp angle — Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.

MAX. RAMP ANGLE

Theta — Maximum ramp angle

Max. ramp distance — This applies to linear or helical ramping.

Max ramp distance applies to linear or helical ramping.

For linear ramping it is the distance for each linear move:

For helical ramping it is the diameter of the helix:

If this attribute is not set, then Max ramp distance is initialized to the tool diameter. If ramping at this distance would cause a gouge, then the distance is reduced by a percentage of the initial setting. Several different percentages are tried by FeatureCAM.

You cannot control the percentages.

If a gouge-free ramping location cannot be found, then FeatureCAM ramps to depth using helical moves that follow the shape of the toolpath. In order for this to work, your machine must be able to do helical interpolation.
If, after reducing the ramping distance, a ramping location still cannot be found, then a direct plunge may occur. If you observe direct plunges, then you can set Max ramp distance to be smaller than the default. So, for example, if your tool is 6 mm in diameter, then the default of Max ramp distance is initially 6 mm. If you observe direct plunges at 6 mm, then try setting Max ramp distance to something smaller, say 3 mm. If a gouge-free ramping location cannot be found at 3 mm, then the Max ramp distance is reduced using the same percentages as before, but using an initial value of 3 mm instead of 6 mm. In this way, you have a better chance at getting a successful ramp to depth. The unfortunate trade-off is that by setting Max ramp distance to 3 mm, then all of your ramps to depth use this smaller distance.

See also Max. ramp angle.

Minimum Ramp — Click this button to display the Minimum Ramp Distances (see page 1034) dialog.

Plunge points and Pre-drill points — Specify a point to override the location that the tool plunges or pre-drills into the stock.

This attribute is ignored if there is no plunge move in the operation. For example, if there is no plunge move between a rough and finish operation, the plunge point would be ignored for the finish operation.

A plunge point is ignored if it would result in a gouge to the part, or if the tool would gouge when moving to the starting point of the toolpath. For example if you specify a plunge point that is closer to a wall than the tool radius, the plunge point is ignored.

A warning is displayed in the Operations sheet when FeatureCAM ignores a plunge point.

You can use a curve to specify multiple plunge points (see page 1035).

Start point(s) — Specify a point to override the starting location for a finish operation.

If this attribute is not set the start point is calculated automatically.

You can use a curve to specify multiple start points (see page 1035).

This example shows how the Start point interacts with the Plunge point and Retract point:

Plunge point — If the tool retracts after the rough pass, it will plunge at the plunge point. If the tool feeds to the start of the finish pass, it goes straight to the start point.
Start point — This point is the contact point of the tool with the finish pass. The tool ramps onto the feature at this point.

Retract point — After ramping off the part, the tool moves to the retract point before withdrawing from the feature.

Retract point — This is the point that the tool retracts to after the operation.

Helical ramping — Enable this option to use helical ramping. Disable it to use zigzag ramping.

The exceptions to this rule are listed below. These rules apply to 2.5D milling features.

- Zigzag ramping is not performed for NT Spiral, NT Zigzag, NT Continuous Spiral toolpaths and Vortex when pre-drilling points are used.
- If Max. ramp angle is 0 the tool plunges directly into the feature.
- If you request zigzag ramping (by deselecting the Helical ramping check box), but FeatureCAM determines that there is not adequate room for zigzagging then there are two cases:
  - if machine can do a helix is selected then zigzag ramp to depth while following the contour of the feature.
  - if machine can do a helix is deselected then FeatureCAM plunges directly.
- If Helical ramping is requested, but FeatureCAM determines that there is not enough room, then FeatureCAM follows the rules for zigzag ramping (rule 2).

Zigzag ramping
Zigzag ramping occurs when the **Helical ramping** option is deselected. Zigzag ramping typically moves in linear segments. You control the length of these segments with **Max. ramp distance** and the slope of the linear moves with **Max. ramp angle**. If you specify a **Plunge point**, zigzag ramping is still available, but the distance of the ramping moves is calculated automatically. FeatureCAM determines the starting point for milling the feature and the tool zigzags between the plunge point and the automatically calculated start point.

For simple grooves or for plunge points that are located in narrow regions of a feature, straight, linear zigzag ramping may not be possible since these moves would gouge the feature. Instead, the tool will zigzag along a 3D arc or a combination 3D arcs and lines that would follow the shape of the feature. In this case, 3D arc moves are output in the NC code. There is currently no way to approximate these moves with 3D line segments. The **Linear approx.** parameter only applies to helical ramping.

See also Using zig-zag ramping to mill a helical path for a simple groove (see page 694).

**Helical and zigzag ramping restrictions**

FeatureCAM tries to automatically determine locations for ramping into the part using the following criteria:

1. The ramping move should not gouge.
2. For zigzag ramping, the XY distance of each linear move must be at least one tool diameter for non-center cutting tools. Center cutting tools only need an XY move of 20% of the tool diameter.
3. For helical ramping, the same restrictions mentioned above apply, except that the distance applies to each 360° helical move.

If you ask for ramping and do not receive the ramping move set a **Plunge point** or pre-drill the entry point.

*Helical ramping is not available for zigzag milling.*

**Helical Options** — Click this button to open the **Helical Ramp Options** dialog.
**Minimum Ramp Distances dialog**

You can use the **Minimum Ramp Distances** dialog to specify the minimum Z ramp distance, below which plunging occurs.

To display the **Minimum Ramp Distances** dialog, click **Minimum Ramp** on the **Plunge** tab (see page 1028) of the **Milling Feature Properties** dialog.

![Minimum Ramp Distances dialog](image)

**Minimum Z ramp distance** — This is the minimum vertical ramp distance allowed. If **Minimum Z ramp distance** is greater than the calculated ramp distance or **Max ramp distance**, the tool plunges.

**Helical Ramp Options dialog**

You can use the **Helical Ramp Options** dialog to edit the helical ramping options for a Milling feature.

To display the **Helical Ramp Options** dialog, select **Helical Ramping** on the **Plunge** tab (see page 1028) of the **Milling Feature Properties** dialog, then click **Helical Options**.

![Helical Ramp Options dialog](image)

Select the direction for helical ramping from **CW** (clockwise) or **CCW** (counter-clockwise).

**Linear approximation** — Select this option to approximate arc moves with linear moves.
Linear approximation tolerance — Enter a tolerance to control the accuracy of Linear approximation relative to the theoretical helix. The lower the value, the more accurate the approximation.

Multiple Plunge points and Start points

You can use a curve to specify multiple Plunge points or Start points for an operation.

To specify multiple plunge or start points:

1. Create lines with end-points on the locations you want to use as the plunge or start points.
2. Chain the lines into a curve.
3. In the Feature Properties dialog, in the Plunge tab, select your curve as the Plunge points or Start Point attribute, for example:

Example

This is a single Slot feature created from multiple curves:
The pre-drill points specified by FeatureCAM are at the edges of the slots:

To change the pre-drill location for all the slots, create a curve that touches the center of each slot, and select this curve as the **Plunge points** option in the **Plunge** tab of the **Feature Properties** dialog.

The tool now pre-drills at the center of each slot instead of at the edge:
Toolpaths tab (25D)

You can use the Toolpaths tab of the Milling Feature Properties dialog to edit a Toolpath feature.

*The Toolpaths tab is available for Toolpath features only.*

When you select this tab, the Toolpath feature is shown in blue on the part, for example:

![Diagram of Toolpath feature in blue on part]

**Data column**

This shows the coordinates of the move. The coordinates have one of these icons on the left side.

- rapid move
- linear move
- arc move
- G-code, single line
- G-code, multiple line

**Feed column**

This shows the feed rate. If it is listed as a rapid move, this column displays Rapid.
**Comp column**

This lists the cutter compensation state for this move. It can be left, right, off, or blank. If the entry is blank, then this move does not change the cutter compensation status.

**Coolant column**

This records the coolant setting for each move. To change the coolant setting, right-click a row and select **Set coolant** to display the **Set coolant** dialog.

*You can edit the feed rate and coolant for multiple segments. Use CTRL+select or SHIFT+select to select the segments you want to edit, right-click the selection and use the context menu.*

The toolpath is displayed as a series of points. If you select a row in the table, the move is shown in red in the graphics area.

To locate a particular point, or series of points in the table, drag-select the points in the graphics window and the appropriate rows of the table are highlighted.

*If you want to pick a single point, you must still drag-select a single point. Just selecting it does not work.*

**Toolpath editing commands**

- The **Edit segment** button opens the **Edit Toolpath Segment** (see page 1039) dialog to enable editing.
- The **Delete segment** button opens the **Delete Toolpath Segment** (see page 1040) dialog.
- The **Split segment** button opens the **Split Toolpath Segment** (see page 1041) dialog.
- The **Add curve** button opens the **Add Toolpath Curve** (see page 1041) dialog.
The **Add segment** button opens the **Add Toolpath Segment** (see page 1042) dialog.

The **Add NC code text** button opens the **Add NC Code Text** (see page 1042) dialog.

The **Export toolpath as curve** button opens the **Extract Toolpath Curve** (see page 1043) dialog.

The **Add operation** button opens the **Add Operation to Toolpath** (see page 1044) dialog.

The **Options** button opens a context menu (see page 1045).

*Edit Toolpath Segment dialog*

To display the **Edit Toolpath Segment** dialog, select a toolpath segment in the **Toolpaths** tab (see page 1037) of the **Milling Feature Properties** dialog and click **Edit segment**.

![Edit Toolpath Segment dialog](image)

**Point** — Enter the new coordinates of the point, or click **Pick point** and pick the location in the graphics window.

**Feed Rate** — Specify the feed rate:
- **Rapid** — Select this option to set this segment as a rapid move.
- **Feed** — Enter the feedrate.
- **Dwell** — Enter a dwell time in seconds.

**Compensation** — Specify the type of cutter compensation:
- **Comp left** — Include a left compensation code for this toolpath segment.
- **Comp right** — Include a right compensation code for this toolpath segment.
- **Comp off** — Include a compensation off code for this toolpath segment.
- **Clear comp** — Remove the cutter compensation setting for this toolpath segment.

**Active Coolants** — Select the coolant types you want to enable for the toolpath segment. The available coolant types are specified in the CNC file using the Coolant dialog in XBUILD. Deselect Override to use the default coolant types set in the Coolant tab in the Tool Properties dialog and the Machining Attributes dialog.

### Delete Toolpath Segment dialog

To display the **Delete Toolpath Segment** dialog, click **Delete segment** on the Toolpaths tab (see page 1037) of the Milling Feature Properties dialog.

When you delete a toolpath segment, you must select how to connect the remaining segments from these options:
- **Direct move between the 2 segments**
- **Retract to rapid plane, rapid move to next segment**
- **Retract to specified Z value, rapid move to next segment**, and enter a Z value
**Split Toolpath Segment dialog**

To display the **Split Toolpath Segment** dialog, click **Split segment** on the **Toolpaths** tab (see page 1037) of the **Milling Feature Properties** dialog.

This dialog splits one move into multiple moves to enable finer editing.

You can split the move into two equal pieces, or specify the number of equal pieces you want. You can also split the segment into two pieces at a particular point or at a specific distance from the end point.

**Add Toolpath Curve dialog**

To display the **Add Toolpath Curve** dialog, click **Add curve** on the **Toolpaths** tab (see page 1037) of the **Milling Feature Properties** dialog.

In this dialog, you can add a new curve to the toolpath. Select the **Curve** from the list or use the **Pick curve** button to select it graphically. Select **Reverse curve** to change the direction of the curve. A curve is added to a toolpath in one of three ways:

- **Replace all toolpath points** — The curve is added as a replacement for the entire path.
- **Add curve points before selected toolpath point** — The curve is added before the curve that you selected in the table on the **Toolpaths** tab.
- **Add curve points after selected toolpath point** — The curve is added after the curve that you selected in the table on the Toolpaths tab.

**Add Toolpath Segment dialog**

To display the Add Toolpath Segment dialog, click Add segment on the Toolpaths tab (see page 1037) of the Milling Feature Properties dialog.

This dialog enables you to insert a new point before the currently selected point. For each point you want to create, enter the new Point coordinates, specify a Feed rate or select the Rapid option, optionally enter a Dwell in seconds, and click the Create button. When you have finished creating points, click OK.

*If you are creating only one point, you must click the Create button and the OK button.*

**Add NC Code Text dialog**

To display the Add NC Code Text dialog, click Add NC code text on the Toolpaths tab (see page 1037) of the Milling Feature Properties dialog.

This dialog enables you insert single or multiple lines of NC code before the selected point and optionally add a comment.
For example, you could enter a M00 conditional stop at a particular point in order to check the tool.

Click the Apply button, then the OK button, and the NC code and comment are added to the Toolpaths tab to the row above the selected row, for example:

Single lines of NC code have the icon and multiple lines of code have the icon.

After simulation, you can see the code on the NC Code tab, for example:

Extract Toolpath Curve dialog

To display the Extract Toolpath Curve dialog, click Export toolpath as curve on the Toolpaths tab (see page 1037) of the Milling Feature Properties dialog.
The **Extract curve** dialog allows you to create a curve from a toolpath. If you want to create a single curve, enter the name for the curve and click **OK**. If you want to create arcs and lines, click the **Convert** geometry. If you want to output only a few segments of a toolpath, select a range of moves and select the **Selected segments only** option.

**Add Operation to Toolpath dialog**

Use the **Add Operation to Toolpath** dialog to import an existing operation into a toolpath feature.

To display the **Add Operation to Toolpath** dialog, click **Add operation** on the **Toolpaths** tab (see page 1037) of the **Milling Feature Properties** dialog.

To import toolpath points from an operation:

1. In the **Operation list**, select the operation from which you want to import the toolpath points.

2. Select where you want to locate the imported toolpath points:
   - **Replace all toolpath points** — Delete all existing toolpath points and import the toolpath points from the operation.
   - **Add operation points before selected toolpath point** — Import the toolpath points from the operation and insert them before the toolpath point selected in the **Toolpath Properties** dialog.
   - **Add operation points after selected toolpath point** — Import the toolpath points from the operation and insert them after the toolpath point selected in the **Toolpath Properties** dialog.

3. Click **OK** to close the dialog and import the toolpath points.

For drilling operations, canned cycles are replaced with linear moves.

*All safety rail moves for turning operations are removed before the operation is copied. You must draw the safety rail moves.*
Options

When you create a Toolpath feature and select the Toolpaths tab, the full lines of the toolpath are displayed in the graphics window by default, for example:

To turn the toolpath lines off, click Options and deselect Display lines:

If Display lines is deselected, toolpath points only are displayed, for example:

3D milling feature attributes (3D LITE)

You can use the Surface Milling Properties dialog to edit the properties of a 3D Surface Milling feature.

Use one of the following methods to display the Surface Milling Feature Properties dialog:

- Right-click a Surface Milling feature in the graphics window or Part View panel and select Properties from the context menu.
- Double-click a Surface Milling feature in the graphics window or **Part View** panel.

The 3D **Surface Milling Properties** dialog lists the strategies and operations in the tree view. The tabs displayed in the dialog change depending on which level in the tree view you select.

1. **Feature**
2. **Strategy**
3. **Operation**

**Feature-level tabs**

The top level of the tree view is the feature level. Select the feature name at the top of the tree view to access these tabs:

- **Dimensions** (see page 1048) — Use this tab to specify the part and check surfaces
Location — Use this tab to reposition the feature relative to the surface

Process (see page 1054) — Use this tab to create, delete and reorder the operations of the feature

Machining Side (see page 1056) — Use this tab to control which side of surfaces to machine

Misc (see page 1058) — Use this tab for a variety of feature-level attributes

Strategy-level tabs
The next level is the strategy level. Select a strategy in the tree view to access the following tabs:

Strategy (see page 1060) — Use this tab for rough/finish classification, edge protection, and re-machining

Edges (see page 1115) — Use this tab to choose how the tool behaves at the limits of the part surfaces as seen from the top view.

The Edges tab is not available for Z-level roughing or Swarf finishing operations.

Stock (see page 1123) — Use this tab to choose the clipping curves for the material to be removed

Slopes (see page 1133) — Use this tab to set slope angle limits for restricting toolpaths

The Slopes tab is not available for Z-level roughing, Plunge roughing, Isoline finishing, Flowline finishing, Horizontal + Vertical and Swarf strategies.

Surface Control (see page 1159) — Use this tab to exclude feature surfaces for specific operations

Operation-level tabs
The third level is the operation level. Select an operation in the tree view to access the following tabs:

Tools (see page 981) — Use this tab to view selected tool or change to a different one

F/S (see page 983) — Use this tab to view automatically calculated feed or speed or change feed or speeds

Coolant (see page 985) — Specify which coolant types to use.
Milling (see page 1161) — Use this tab to set operation-level attributes

Leads (see page 1342) — Use this tab to control leads and ramps

**Dimensions tab (3D LITE)**

You can use the Dimensions tab of the Surface Milling Properties (see page 1045) dialog to change which surfaces are machined.

![Surface Milling Properties dialog](image)

The Dimensions tab has two buttons that open dialogs where you select surfaces to manufacture, and surfaces to use as protected areas where the tool must not go.

**Part surfaces** — Click this button to open the Select Part Surfaces (see page 1051) dialog.

**Check surfaces** — Click this button to open the Select Check Surfaces dialog (see page 931).

**Cut feature using Y Axis coordinates** — In Turn/Mill, 4 axis, or 5 axis parts with Z-indexing (see page 232), select this option to cut in X and Y, or deselect it to rotate the part about the index axis.

Cut feature using Y Axis coordinates selected

Cut feature using Y Axis coordinates deselected
The tool moves in X and Y to cut the features.

The part is rotated about the index axis to cut the features.

C Angle — If Cut feature using Y Axis coordinates is selected, enter the spindle C angle at which to cut the feature.

**Dimensions tab (3D chamfer)**

You can use the Dimensions tab of the Chamfer Properties dialog (see page 1045) to change the dimensions of a chamfer feature.

Use a 3D chamfer feature to create chamfers from curves that are not in the XY plane, or from non-planar curves.
A 3D milling license is required to create chamfers on non-planar curves.

Enter the Depth of the 3D chamfer, which is a horizontal and vertical (negative) tool offset from the contact point on the input curve (the default is 0.020" or 0.5 mm).

Optionally enter a Tip offset, which is an additional negative vertical tool offset. The default is 0.0.

The horizontal offset is compensated so that the horizontal offset remains a constant (the Depth dimension).

The Part surfaces and Check surfaces buttons work in the same way as for a 3D surface milling feature, but they are optional for 3D chamfers.

Part surfaces

Use this dialog to pick surfaces you want to gouge-check in your 3D part feature.

1. Select the surface(s) in the list or click the Pick surface button and select a surface with the mouse. To pick additional surfaces, click the Pick surface button again before selecting each additional surface.
2. Click OK to return to the Feature Properties dialog.
3. Click OK and Apply to apply your surface selection to the feature and return to the Feature Properties dialog.

Check surfaces

Check surfaces are surfaces that denote areas that are not milled away. Use this dialog to select surfaces you want to use to limit machining in a 3D feature.

1. Select the surface(s) in the list box or click Pick and select a surface with the mouse. To pick additional surfaces, click Pick again before selecting each additional surface.
2. Click OK to return to the Feature Properties dialog.
3. Click OK and Apply to apply your surface selection to the feature and return to the Feature Properties dialog.

If you select any Part surfaces, they are allowed to be cut to the depth of the chamfer (in other words, the allowance is equal to -Depth).

If you select any Check surfaces, there is a Check allowance attribute on the Milling tab (the default is 0).
Select Part Surfaces dialog

You can use the 3D Part Surfaces dialog to pick surfaces you want to include in your 3D part feature.

1. Select the surface(s) in the list or click the Pick surface button and select a surface with the mouse. To pick additional surfaces, click the Pick surface button again before selecting each additional surface.

2. Click OK to return to the Feature Properties dialog.

3. Click OK and Apply to apply your surface selection to the feature and return to the Feature Properties dialog.

You need to consider the following when specifying part surfaces:

- You cannot manufacture undercut surfaces using 3-axis machining, so it is a good idea to use only surfaces in the feature that can be cut from the setup.

- Some surfaces may be cut from multiple setups to manufacture all parts of the surface. In such situations, a Stock Curve is helpful in limiting the machining area to just those spots that need it.
**Tool Axis tab**

The **Tool Axis** tab controls the orientation of the tool relative to the part when using the Four Axis Rotary strategy.

![Screen capture of Tool Axis tab](image)

**Use rotary Z tool** — Select this option to align the tool with the Z axis of the active Setup.

**Use rotary X tool** — Select this option to align the tool with the X axis of the active Setup.

**Specify angles** — You can set the angle in one of these ways:

- **Index Angle** — Enter the index angle to set the angle. If the angle is set to 0.0 then the tool is aligned with the X axis. The Index Angle is relative to the setup axis, just as it is with any feature alignment. The actual angle that is output in the code is relative to the stock axis.

- **B Angle** (see page 1052) — Enter an angle to set the B-axis angle.

- **Normal to surface** — Set the angle as normal to the surface you pick using the Pick surface button. Optionally select Reverse direction.

*Turn/Mill B-axis rotary example*

You can set the tool used on a rotary surface milling feature to be a fixed B angle.
To use this method you need the 3D, Turn/Mill and Advanced Turn/Mill components. You do not need the 5-axis Simultaneous component.

This example cast part has a 3D Surface feature, shown in red:

The shaft on the front of the part makes it difficult to machine with the default angle.

Using a 4-axis rotary strategy with the default angle, the head of the machine collides with the chuck, at the point marked with a pink arrow:
Using a fixed B-angle tool axis of 45 degrees, the tool tilts over and avoids any collisions:

**Process tab (3D LITE)**

The **Process** tab lists the operations that are included for milling the feature in the order they happen. You can remove operations by deselecting them. This enables you to customize operations and then turn them off to reduce screen clutter when working on subsequent operations.

The buttons have these functions:
New operation
Select a machining strategy:

Finishing Strategies
- Parallel (see page 745) - toolpaths that are parallel to the X or Y axes.
- Z level finish (see page 771) - toolpaths that are parallel to the XY plane.
- Isoline milling (see page 772) - toolpaths that follow the rows or columns of individual surfaces.
- 2D spiral (see page 749) - Toolpaths that move in a spiral toward or away from the center of the part. Stepover is constant from the top view.
- 3D spiral (see page 755) - Toolpaths that move in a spiral toward or away from the center of the part. Stepover is constant in 3D.
- Radial milling (see page 759) - toolpaths that move out radially from the center of the feature.
- Flowline milling (see page 773) - toolpaths that follow the rows or columns of a flowline surface which are then projected onto the part.
- Between 2 curves (see page 776) - toolpaths that are created between two specified curves.

Roughing Strategies
- Z level rough (see page 759) - toolpaths that are parallel to the XY plane.
- Plunge roughing (see page 779) - toolpaths which remove large amounts of material from a component through a series of vertical plunging movements.
- Parallel (see page 745) - toolpaths that are parallel to the X or Y axes.

Specialized Strategies
- Horizontal + Vertical (see page 778) - machine steep and shallow regions using different techniques.
- Corner Remachining (see page 786) - A remachining technique used to clean up corners that occur between non-tangential surfaces.
- Pencil milling (see page 776) - a single clean-up pass for corners.
- 4-Axis Rotary (see page 781) - used in turnmill to machine round surfaces with an X tool.
- Swarf (see page 794) - toolpaths are cut using the side of the tool. The tool is in constant contact with the surface.
- 5-Axis Trim (see page 800) - toolpaths that are along the edges of surfaces. There is the option to cut on the inside or outside edge of the surface.

For more details on these options, see operations overview (see page 742).

Move item up changes the order of operations in the milling feature by moving the selected operation up one place in the list.

Move item down changes the order of operations in the feature by moving the selected operation down one place in the list.

Delete operation removes an operation from the feature. You can disable an operation instead by deselecting the operation. The check box, when set, includes that operation in the feature.

**Machining Side tab (3D)**

You can use the **Machining Side** tab of the **Surface Milling Properties** dialog (see page 1045) to specify the machining side of Surface Milling features.

This tab shows a table of each **Surface** in the feature and its current **Machining Side**.

FeatureCAM tries to cut on the appropriate side of a surface based on the surface normals, but sometimes you need to explicitly orient a surface. This is mainly for the Z-level rough, Z-level finish, and Isoline strategies.
Vertical surfaces are usually the only surfaces that need to be manually oriented. FeatureCAM tries to automatically flip surface normals so that they are consistent. For this automatic flipping to work on vertical surfaces, there must be some non-vertical surfaces nearby. For parts that have only vertical surfaces, FeatureCAM does not automatically flip any normals. That means that you must ensure that all surface normals point either in or out by manually flipping the normals to ensure a consistent cutting side.

For open surfaces with a floor, the normals are flipped to create a pocket shape and the insides are milled.

For open surfaces with a top, they are treated as a boss shape and the outsides of the surfaces are milled.

Select a surface name in the table, and an arrow is shown on the model that indicates which side of the surface is cut.

**Reset Normals** — Click this button to return the machining side of all surfaces to the FeatureCAM defaults.
Switch Machining Side button — Select a surface in the table and click this button to reverse the machining side. The Machining Side in the table changes from Normal to Reverse. Click again to return to Normal.

Pick surface button — If you have more than one surface in your feature and do not know the name of the surface you want to reverse, click this button and select the surface in the graphics window. The name of the surface is highlighted in the table.

Misc. tab (3D LITE)
You can use the Misc tab of the Surface Milling Properties dialog (see page 1045) to edit the machining options of a Surface Milling feature.

Enable 3D cutter comp — Enable this option to use 3D cutter compensation. For a 3D surface milling feature, 3D cutter compensation compensates for the tool radius in the direction of the contact point. The compensation is not simply right or left. See the 2.5D Strategy (see page 936) tab for more information on cutter compensation.

To use 3D cutter compensation, the .cnc file must support 3D cutter compensation in the linear move format. For example:

```cnc
{N<SEQ> }{<MOTION> }{<COMP-STAT> }{X<X-COOORD> }
{Y<Y-COOORD> }{Z<Z-COOORD> }
<IF><COMP-3D-ON><THEN>
I<X-SRFNORM><32>J<Y-SRFNORM><32>K<Z-SRFNORM><32>
<ENDIF>
```
3D cutter comp applies only to finishing operations and linear moves. Any arc lead-ins are approximated by linear moves if 3D cutter comp is selected for the feature. The XBUILD compensation keywords (<COMP-STAT>, <COMP-START> and so on) work for both 2D and 3D cutter compensation (only one type of compensation can be active). Set the NC codes to turn 3D cutter compensation on and off in the NC Codes dialog in XBUILD:

![NC Codes dialog](image)

**Base priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Feed override %** — Enter a scaling factor for the feed rates generated by the system. A value of less than 100 reduces the calculated feed rates. A value of more than 100 increases the rates.

**Max. spindle RPM** — Enter the maximum spindle speed (in RPM) that you want to use.

**Spindle RPM override %** — Enter a scaling factor for the speed rates generated by the system. A value of less than 100 reduces the speed rate, and a value of greater than 100 increases it.

**Spline tolerance** approximates the profile with arcs and lines if a profile is defined as a spline. The smaller the value of the parameter, the smoother the profile.

**Tool % of arc radius** (see page 973)

**Z rapid plane** — Enter the minimum safe distance in Z above your part.
Before performing a rapid move away from a feature, the tool retracts to the Z rapid plane setting for that feature. The rapid move to the next feature changes in Z height, that is, changes Z coordinates, if the next feature has a different Z rapid plane setting. So that when it arrives at the next feature it is at the Z rapid plane for that next feature.

This value is relative to the top of your stock in the current user coordinate system. Compare with Plunge clearance.

**Strategy tab (3D LITE)**

The attributes available on the Strategy tab of the Surface Milling Properties (see page 1045) dialog for 3D surface milling depend on the strategy.

**3D LITE (see page 10)**
- Z-level rough (see page 1061)
- Parallel rough/finish (see page 1070)
- 2D spiral finish (see page 1073)
- Isoline finish (see page 1074)

**3D MX (see page 10)**
- Z-level finish (see page 1076)
- Flowline finish (see page 1087)
- Between two curves (see page 1089)
- Horizontal + vertical (see page 1090)
- Swarf (see page 1096)
- Four-axis rotary (see page 1097)

**3D HSM (see page 10)**
- Plunge rough (see page 1099)
- 3D spiral finish (see page 1101)
- Corner remachining (see page 1104)
- Pencil (see page 1107)
- 5-axis trim (see page 1108)
- Steep and Shallow (see page 1109)
Strategy tab (Z-level rough) (3D LITE)

Specify the style of toolpath. If you select Zig-zag, this roughs the part raster-style with an optional profile around each Z-slice (optionally select the Profile contour option).

The value can be anywhere from -360 to 360 degrees, the default is 0.0. A positive value rotates counter-clockwise from the principle axis, and a negative value rotates clockwise from the axis.

X parallel, Parallel angle 20

Y parallel, Parallel angle 20

- Setting the angle to 90 on an X-parallel operation causes it to effectively become a Y-parallel operation.
- Setting the angle to 180 causes the toolpaths to be cut from the opposite side of the part. For example, an X-parallel operation with the angle set to 0 starts at the minimum Y coordinate. With the angle set to 180, the toolpaths start at the maximum Y coordinate.

**Continuous spiral** — This option enables the tool to move in a continuous smooth spiral motion and reduces tool load.

This blow mold base example shows a single Z-level rough slice:

Using the **Offset** option: Using the **Continuous Spiral** option:

[Images of spiral toolpaths]

**Vortex** (3D HSM (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.

**Classify slices as**

You can tell FeatureCAM to rough your part as a **3D Pocket**, or as a **3D Boss**. If you select **3D Pocket**, the tool plunges or ramps onto the part and cuts from the inside of the part out toward the boundary of the part. A **3D Boss** typically plunges off the part and cuts from the outside toward the center.

Even if the surfaces of your part create a boss shape (meaning it protrudes instead of being a cavity), you can still select **3D Pocket**. The first image below shows the slices of a part being cut as a boss, and the second as a pocket. Notice that the slides of the boss go all the way around the part at each slice, but the pocket example has slices that just cut a region of the part.
Offset Direction:

- **Automatic** — The tool cuts from the outside to the inside of the stock in a continuous radial movement. This is the default option.

  During cutting:  
  Cutting complete:

- **In to out** — The tool plunges into the stock and cuts outwards.

  During cutting:  
  Cutting complete:
- **Out to in** — The tool cuts from the outside to the inside of the stock. The tool outlines the surfaces and cuts large sections last.

**During cutting:**

**Cutting complete:**

**Non-Cutting Moves** — Click this button to display the Vortex Non-Cutting Moves dialog (see page 1069) where you can specify whether to retract and increase the feed rate on non-cutting moves for vortex toolpaths.

**Remachining** — Click this button to open the Z-Level Rough Remachining Options (see page 1066) dialog.
Area Removal (3D HSM (see page 10))

Remove unsafe areas — This removes small toolpath segments to prevent tool damage when using non-center cutting tools. When machining into small pockets, removing small segments stops the central, non-cutting underside of the tool from hitting non-machinable material. Unsafe segment removal filters out the machining of confined areas with small movement of the cutting tool.

Remove area less than — This removes segments that are smaller than the entered percentage of the tool's diameter, unless they surround a Boss feature.

Closed areas only — Select this option to remove segments, in enclosed areas, that are smaller than the Threshold value.

Holder collision clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the Holder clearance and Shank clearance attributes are displayed on the Milling tab for the operation.

Z-level rough area removal example

This headlamp mold has a couple of cavities that work their way down into very small pockets:

This is a cutaway view of a 3D simulation with Remove unsafe areas deselected:

This is the previous and default behavior.
The bottoms of the pockets are barely bigger than the tool diameter, and the tool hardly moves in these areas. The non-center cutting region of the tool cannot cut the material at the bottom of the pockets.

This is the simulation with **Remove unsafe areas** selected and **Remove area less than** set to 80 % of the tool diameter:

![Simulation Image]

The two smaller pocket regions are removed from the toolpath. This protects the tool and prevents damage.

**Z-Level Rough Remachining Options dialog**

To open this dialog, click the **Remachining** button on the **Strategy** (see page 1061) tab.

![Dialog Image]

**None** — Select this option to have no remachining.

**Multiple tool diameters**

Enter a list of roughing tool diameters separated by commas, to enable multiple Rough passes.

*The last diameter is also used for the Finish pass. If you want the system to select the tool for the final roughing pass, enter the last diameter as 0.*
The system works down the list to the finish tool. One way is to let the system pick the tooling initially, then set up your diameter list to work gradually toward the last value. For example, if the system recommends a 0.125 inch endmill, enter 1.0, 0.5, 0.

By default, FeatureCAM creates one roughing and one finish pass for all of the milled features. If you use multiple roughing tools, FeatureCAM cuts all the parts of a feature that it is capable of cutting with the larger tool, and cuts only the remaining portions of the feature with the smaller tool. You do not have to manually create these separate regions. FeatureCAM automatically calculates them for you.

For cutting Pocket or Boss features, FeatureCAM automatically selects a single tool diameter for roughing and finishing. For a large feature with small corner diameters, this method results in a small tool cutting the middle of the pocket and wastes time. A better strategy uses a larger tool for the wide areas and a smaller tool for the tight corners.

**Step cutting** — This option machines the terraces that would otherwise remain during a Z-level rough toolpath with the same tool in the same toolpath. The terraces are machined from bottom to top. FeatureCAM increases the feed rate of the intermediate slices as the depth of cut gets progressively smaller, which enables a constant volume removal rate.

1. The first pass is a main slice.
2. The next pass is the lowest step-cutting slice.
3. The next pass is the next to lowest step cutting slice and so on up the part (shown by 4) until the previous main slice is reached.
4. The next main slice.

The main slices are cut from top to bottom as normal. The intermediate slices are cut from bottom to top. This is possible because the depth of cut is always less than the depth of cut (or **Stepdown**) for the main slice. This is the most efficient way of cutting the part as it reduces the number of passes and increases the depth of cut of each pass.
**Step up** — Enter the distance between intermediate cutting levels.

1. Stepdown of the main slice.
2. Stepup of the intermediate slice.

The main slice clears the majority of the material. The intermediate slices remove the terraces remaining after the main slice.

**Detect material thicker than** — Enter a threshold value. FeatureCAM ignores rest material that is thinner than the specified threshold.

**Expand area by** — Enter the distance by which to expand the rest areas, measured along the surface. Use with the **Detect material thicker than** value to reduce the areas to be machined to the details (for examples, corners), and then to offset these areas slightly to ensure that all the detail (for example, on the corners) is machined.

1. Model
2. Thickness
3. True rest material (outlined in pink)
4. Actual rest material detected (blue hatched area)
5. Amount you need to expand the area by to include all the rest material
Undetected material (black area)

Tool

Reference tool

Use the **Expand area by** option to increase the rest area (the blue hatched area) and eliminate the undetected area (the black area).

*Increase feed for intermediate steps* — Select to increase the **Feed rate** of the intermediate slices. Because the stepdown of the intermediate slices is less than that of the main slice, you can increase the feed rate of the intermediate slices while maintaining the tool load. Each intermediate slice can have an increasing feed rate as the depth of cut gets progressively smaller.

*Maximum feed increase %* — Enter the maximum allowable cutting feed rate for the intermediate slices as a percentage of the normal feed rate. This value must be larger than 100%. A value of **300** means the cutting feed rate of the intermediate slices can be up to three times faster than for the main slices.

**Vortex Non-Cutting Moves dialog**

Use the **Vortex Non-Cutting Moves** dialog to specify whether to retract and increase the feed rate on non-cutting moves.

To display the **Vortex Non-Cutting Moves** dialog:

- for 2D toolpaths, click **Non-Cutting Moves** in the **Stepovers** tab of the **Feature Properties** dialog.
- for 3D toolpaths, click **Non-Cutting Moves** in the **Strategy** tab of the **Feature Properties** dialog.
- to change the default options, click **Non-Cutting Moves** in the **Milling** tab of the **Machining Attributes** dialog.

Under **Retract on non-cutting moves**, select whether you want the tool to retract on non-cutting moves:

- **Never** — the tool does not retract on non-cutting moves.
- **Automatic** — FeatureCAM will decide when the tool should retract on non-cutting moves.
- **Longer than** — the tool retracts instead of making non-cutting moves larger than the value you enter. For example, the left image is a standard vortex toolpath and in the right image the non-cutting moves are replaced with retracts.

Select **Increase feed rate for non-cutting moves** to override the feed rate for non-cutting moves with the specified **Non-cutting feed rate**. If the **Non-cutting feed rate** is lower than the Feed rate specified on the F/S tab, the **Non-cutting feed rate** is ignored.

**Strategy tab (Parallel rough/finish) (3D LITE)**
**X parallel** — Select this option to cut parallel to the X axis.

![X parallel diagram](image)

**Y parallel** — Select this option to cut parallel to the Y axis.

![Y parallel diagram](image)

**Parallel angle** — Optionally enter an angle in degrees. You can have the toolpath at any angle. The angle is measured counter-clockwise from the X axis if X parallel is selected or counter-clockwise from the Y axis if Y parallel is selected.

The value can be anywhere from -360 to 360 degrees, the default is 0.0. A positive value rotates counter-clockwise from the principle axis, and a negative value rotates clockwise from the axis.

- **X parallel, Parallel angle 20**
- **Y parallel, Parallel angle 20**

- Setting the angle to 90 on an X-parallel operation causes it to effectively become a Y-parallel operation.
- Setting the angle to 180 causes the toolpaths to be cut from the opposite side of the part. For example, an X-parallel operation with the angle set to 0 starts at the minimum Y coordinate. With the angle set to 180, the toolpaths start at the maximum Y coordinate.

**Add perpendicular remachining pass** — Select this option if you want to add a perpendicular, remachining pass. For example, this setting adds a Y parallel pass to an X parallel operation. To use this option you also must specify the Steep slope angle.

**Optimize parallel pass** — If you create a parallel toolpath and select Add perpendicular remachining pass, with a Steep slope angle greater than 0°, the Optimize parallel pass option trims the parallel pass so it doesn't machine the areas that the perpendicular pass machines.

**Optimize parallel pass** — If a parallel toolpath is created with a perpendicular pass, with a shallow angle greater than 0°, this option trims the parallel pass so it doesn't machine the areas that the perpendicular pass machines.

**Steep slope angle** — This option is used with Add perpendicular remachining pass. The perpendicular pass is applied only to regions that exceed this slope limit.

You must select **Add perpendicular remachining pass** to access the **Optimize parallel pass** and **Steep slope angle** options.

**Remachining** — Click this button to open the Remachining (see page 1112) dialog.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.

**Machine maximum stock** — Use with **Holder collision clipping** to machine the stock as close to the part without causing a holder collision. This creates smoother toolpaths with fewer retracts, which can improve the surface finish and reduce the machining time, but may cause increased air cutting on some parts.
Strategy tab (2D spiral finish) (3D LITE)

Spiral in — Select this option to spiral from the edge in toward the center.

Spiral out — Select this option to spiral away from the center.

Holder collision clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the Holder clearance and Shank clearance attributes are displayed on the Milling tab for the operation.
Strategy tab (Isoline finish) (3D LITE)

Continuous spiral — Enable this option to stop the tool lifting from the surface when machining.

Enable **Continuous spiral** to have a toolpath that stays in constant contact with a surface, reducing the chance of leaving any dwell or witness marks on the surface caused by regular retract and approaches to the surface.
The standard Z level finishing toolpaths creates paths with a constant Z height as shown below. The tool either retracts or feeds along the surface between Z levels.

With **Continuous spiral** enabled, the toolpaths change into a continuous spiral. The toolpaths no longer have a constant Z height.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.
**Strategy tab (Z-level finish) (3D MX)**

**Undercuts** — Select this option to enable side mill tools to machine undercuts. When **Undercuts** is enabled, the **Machining Side** (see page 1056) tab is available.

The **Undercuts** option is unavailable when **Interleave spiral paths** is enabled.

**Interleave spiral paths** (see page 1081)

**Continuous spiral** — Enable this option to stop the tool lifting from the surface when machining.
Enable **Continuous spiral** to have a toolpath that stays in constant contact with a surface, reducing the chance of leaving any dwell or witness marks on the surface caused by regular retract and approaches to the surface.

The standard Z level finishing toolpaths creates paths with a constant Z height as shown below. The tool either retracts or feeds along the surface between Z levels.

With **Continuous spiral** enabled, the toolpaths change into a continuous spiral. The toolpaths no longer have a constant Z height.

**Bottom up** — Enable this option cut the Surface feature from the bottom upwards. Disable it to cut top downwards.
For example, you can use **Bottom up** to cut this glider mold part:

![Glider Mold](image1)

After a Z-level rough and a 2.5D finish, a Z-level finish strategy is used, with **Scallop height** to control the shape of the toolpath.

This is a 3D simulation with **Bottom up** deselected:

![3D Simulation](image2)

This is the previous and default behavior.

The Ball End Mill tool (shown in yellow) starts at the top in the middle cutting outwards and so is cutting with the center of the tool:

![Ball End Mill](image3)

This is the result with **Bottom up** selected:

![Result](image4)
The tool starts at the bottom outside of the slope and mills upwards and inwards towards the center so that the side of the tool is used, which has a better cutting surface.

**Remachining** — Click this button to open the Remachining (see page 1112) dialog.

**Area Removal (3D HSM)**

**Remove unsafe areas** — This removes small toolpath segments to prevent tool damage when using non-center cutting tools. When machining into small pockets, removing small segments stops the central, non-cutting underside of the tool from hitting non-machinable material. Unsafe segment removal filters out the machining of confined areas with small movement of the cutting tool.

**Remove area less than** — This removes segments that are smaller than the entered percentage of the tool’s diameter, unless they surround a Boss feature.

**Closed areas only** — Select this option to remove segments, in enclosed areas, that are smaller than the Threshold value.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the Holder clearance and Shank clearance attributes are displayed on the Milling tab for the operation.

**Machine maximum stock** — Use with Holder collision clipping to machine the stock as close to the part without causing a holder collision. This creates smoother toolpaths with fewer retracts, which can improve the surface finish and reduce the machining time, but may cause increased air cutting on some parts.

Z-level finish area removal example
This cavity part has a small pocket (shown in red):

![Cavity part with small pocket](image)

After using a Z-level rough on the part, this is a cutaway front view of a 3D simulation of a Z-level semi-finish with **Remove unsafe areas** deselected:

![3D simulation with Z-level semi-finish](image)

This is the previous and default behavior.
The bottom of the pocket is barely bigger than the tool diameter, and the tool hardly moves in this areas. The non-center cutting region of the tool cannot cut the material at the bottom of the pocket.

This is the simulation with **Remove unsafe areas** selected and **Remove area less than** set to 80 % of the tool diameter:

![Simulation with Remove unsafe areas selected](image)

The small pocket region is removed from the toolpath. This protects the tool and prevents damage.
**Interleave spiral paths**

One disadvantage of using Z-level finish is that flat surfaces may fall between the Z-level slices of your operation. The interleave option of Z-level finishing inserts toolpaths in the shallow regions between the slices. This option attempts to finish the entire part with a minimum number of retracts. This example shows coarse interleaved toolpaths.

Enable interleaved toolpaths by selecting the **Interleave spiral paths** option on the **Strategy** (see page 1076) tab.

Interleaved toolpaths are controlled by the **Spiral max slope** parameter. This parameter controls the slope below which the zigzag toolpaths are inserted. A higher setting of **Spiral max slope** increases the size of the zigzag or spiral region. In general, this parameter should be set to a value less than 40, because the zigzag toolpaths should be limited to surfaces with slight slopes.

When using the interleaved technique, Z level toolpaths are always calculated using the specified **Scallop height** (see page 1209), instead of an explicit Z increment. How accurately the toolpaths fit the surfaces is controlled by the **Tolerance** (see page 1209) parameter. To minimize retracts, you may also have to adjust the **Stepover rapid distance** (see page 1209).

**Arc/line approx.** (see page 1209) applies for the Z-level portion of interleaved toolpath.
There are four different styles of toolpaths that can be created for the shallow regions. If you select Closed spirals on the Strategy (see page 1076) tab, but deselect the Spiral attribute on the Milling tab, offset toolpaths are generated.
If you select **Closed spirals** on the **Strategy** (see page 1076) tab and select the **Spiral** attribute on the **Milling** tab, continuous spiral toolpaths are generated.
If you deselect **Closed spirals** on the **Strategy (see page 1076)** tab and select **bi-directional** in the **Cut Direction** dialog (accessed by clicking the **Direction** button) on the **Milling** tab, zigzag toolpaths are created.
If you deselect **Closed spirals** on the **Strategy** (see page 1076) tab and select **Uni-directional** in the **Cut Direction** dialog (accessed by clicking the **Direction** button) on the **Milling** tab, you can create toolpaths that cut in a single direction.

**Remove shallow slices** — In addition to the style of cut on the shallow regions, you can also change the toolpaths with the **Remove shallow slices** option. This example shows Z finish toolpaths with **Remove shallow slices** selected.
Without **Remove shallow slices** selected, toolpaths are inserted between each slice. This results in the shallow regions being relatively flat.

With **Remove shallow slices** selected, the slices in the flatter regions are removed. This results in the removal of some possibly unnecessary slices, but shallow regions tend to be larger and the shallow toolpaths tend to vary more in the Z direction.
Continuous spiral — Enable this option to stop the tool lifting from the surface when machining.

Enable **Continuous spiral** to have a toolpath that stays in constant contact with a surface, reducing the chance of leaving any dwell or witness marks on the surface caused by regular retract and approaches to the surface.
The standard Z level finishing toolpaths creates paths with a constant Z height as shown below. The tool either retracts or feeds along the surface between Z levels.

With **Continuous spiral** enabled, the toolpaths change into a continuous spiral. The toolpaths no longer have a constant Z height.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.

**Machine maximum stock** — Use with **Holder collision clipping** to machine the stock as close to the part without causing a holder collision. This creates smoother toolpaths with fewer retracts, which can improve the surface finish and reduce the machining time, but may cause increased air cutting on some parts.
**Strategy tab (Between two curves) (3D MX)**

Pick or select the **Start curve** and **End curve** to machine between.

- **Along curves** — Select this option to create toolpaths parallel to the curves radiating out from the start curve towards the end curve.
- **Across curves** — Select this option to create toolpaths that begin at the start curve and move across to the end curve.
- **Tool center** — Select this option to limit the toolpath based on the center of the tool.
- **Contact point** — Select this option to limit the toolpath based on last point of contact between the tool and the surface.

- **Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.
Strategy tab (Horizontal + Vertical) (3D MX)

Slope boundary — This is the angle that divides the horizontal and vertical regions. Portions of the surfaces with slopes less than this angle are machined with the parallel toolpaths, and the steeper slopes are machined by the Z level.

Slope overlap — This indicates how much the two regions overlap, in degrees. An overlap of 0 means that the two regions are distinct. A value of 10 means that the two passes overlap by 10 degrees.

Horizontal

Select a Spiral or Parallel toolpath for the shallow regions of the feature.

If you are using a Spiral toolpath for the shallow regions, the shape of those regions is automatically calculated based on the Slope boundary and Slope overlap attributes.

Continuous spiral — Enable this option to stop the tool lifting from the surface when machining.

Enable Continuous spiral to have a toolpath that stays in constant contact with a surface, reducing the chance of leaving any dwell or witness marks on the surface caused by regular retract and approaches to the surface.
The standard Z level finishing toolpaths creates paths with a constant Z height as shown below. The tool either retracts or feeds along the surface between Z levels.

With **Continuous spiral** enabled, the toolpaths change into a continuous spiral. The toolpaths no longer have a constant Z height.

**In to out** — The default spiral motion starts at the edge of the feature and moves inwards. Enable this option to start the spiral at the center of the feature and move outwards.

**Smoothing** — This removes all sharp changes in direction. It works in a similar way to the Toolpath corner % (see page 1163) raceline smoothing attribute, but smooths all toolpaths, not just corners.
This example shows a 3D spiral finish without smoothing:

And with smoothing:

If you select to use a **Parallel** toolpath, the pass is parallel to the X axis unless you enter a **Parallel angle**. Set the **Parallel angle** to $90^\circ$ to be parallel to the Y axis.

**Vertical**

These attributes control the steeper regions of the feature.

**Bottom up** — Enable this option cut the Surface feature from the bottom upwards. Disable it to cut top downwards.

For example, you can use **Bottom up** to cut this glider mold part:

After a Z-level rough and a 2.5D finish, a Z-level finish strategy is used, with **Scallop height** to control the shape of the toolpath.
This is a 3D simulation with **Bottom up** deselected:

This is the previous and default behavior. The Ball End Mill tool (shown in yellow) starts at the top in the middle cutting outwards and so is cutting with the center of the tool:

This is the result with **Bottom up** selected:

The tool starts at the bottom outside of the slope and mills upwards and inwards towards the center so that the side of the tool is used, which has a better cutting surface.
**Continuous spiral** — Enable this option to stop the tool lifting from the surface when machining.

Enable **Continuous spiral** to have a toolpath that stays in constant contact with a surface, reducing the chance of leaving any dwell or witness marks on the surface caused by regular retract and approaches to the surface.

The standard Z level finishing toolpaths creates paths with a constant Z height as shown below. The tool either retracts or feeds along the surface between Z levels.

With **Continuous spiral** enabled, the toolpaths change into a continuous spiral. The toolpaths no longer have a constant Z height.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.
Spiral example

Parallel example
Strategy tab (Swarf) (3D MX)

Reverse Tool Axis — If the tool axis is upside down, select this option to reverse it.

Follow surface laterals — When selected, the swarf toolpath follows the underlying surface rulings. When deselected, this is not necessarily the case.

Gouge check — Select this option to check the toolpath for gouges.

Holder collision clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the Holder clearance and Shank clearance attributes are displayed on the Milling tab for the operation.
Strategy tab (Four-axis rotary) (3D MX)

Select a cutting style from:

- **Linear**

Linear rotary milling causes the tool to traverse along the index axis in straight lines, with the rotary axis only used at the end of each pass to reposition the job.

- **Circular**
In circular milling the job rotates with the tool at a fixed position, effectively machining a circle. The tool then steps over the required amount and machines the next circle.

- **Spiral**

A continuous spiral is cut along the length of the job when spiral milling is used. To ensure a clean finish a full circle is cut at the two ends. Because rotation is continuous, only Climb and Conventional milling are available (so, you must have a rotary head that can make an unlimited number of rotations).

**Y offset** — Enter a distance to avoid cutting on the center of the tool.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.

**Machine maximum stock** — Use with **Holder collision clipping** to machine the stock as close to the part without causing a holder collision. This creates smoother toolpaths with fewer retracts, which can improve the surface finish and reduce the machining time, but may cause increased air cutting on some parts.
**Strategy tab (Plunge rough) (3D HSM)**

- **X parallel** — Select this option to arrange the drilling operations parallel to the X axis.

- **Y parallel** — Select this option to arrange the drilling operations parallel to the Y axis.

- **Parallel angle** — Optionally enter an angle in degrees. You can have the toolpath at any angle. The angle is measured counter-clockwise from the X axis if **X parallel** is selected or counter-clockwise from the Y axis if **Y parallel** is selected.

  The value can be anywhere from **-360** to **360** degrees, the default is **0.0**. A positive value rotates counter-clockwise from the principle axis, and a negative value rotates clockwise from the axis.

- **X parallel, Parallel angle 20**

- **Y parallel, Parallel angle 20**
- Setting the angle to 90 on an X-parallel operation causes it to effectively become a Y-parallel operation.
- Setting the angle to 180 causes the toolpaths to be cut from the opposite side of the part. For example, an X-parallel operation with the angle set to 0 starts at the minimum Y coordinate. With the angle set to 180, the toolpaths start at the maximum Y coordinate.

**Honeycomb pattern**

Plunge roughing is performed in either a straight rectangular pattern, as shown below:

or a honeycomb pattern in which each row is offset horizontally by half the rough pass stepover amount:

The honeycomb pattern is usually preferable. The **Honeycomb pattern** attribute controls the pattern type.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.
**Strategy tab (3D spiral finish) (3D HSM)**

Continuous spiral — Enable this option to stop the tool lifting from the surface when machining.

Enable **Continuous spiral** to have a toolpath that stays in constant contact with a surface, reducing the chance of leaving any dwell or witness marks on the surface caused by regular retract and approaches to the surface.
The standard Z level finishing toolpaths creates paths with a constant Z height as shown below. The tool either retracts or feeds along the surface between Z levels.

With **Continuous spiral** enabled, the toolpaths change into a continuous spiral. The toolpaths no longer have a constant Z height.

**In to out** — The default spiral motion starts at the edge of the feature and moves inwards. Enable this option to start the spiral at the center of the feature and move outwards.

**Smoothing** — This removes all sharp changes in direction. It works in a similar way to the **Toolpath corner %** (see page 1163) raceline smoothing attribute, but smooths all toolpaths, not just corners.
This example shows a 3D spiral finish without smoothing:

And with smoothing:

**Remachining** — Click this button to open the **Remachining** (see page 1112) dialog.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.

**Machine maximum stock** — Use with **Holder collision clipping** to machine the stock as close to the part without causing a holder collision. This creates smoother toolpaths with fewer retracts, which can improve the surface finish and reduce the machining time, but may cause increased air cutting on some parts.
**Strategy tab (Corner remachining) (3D HSM)**

Under **Options**, select:

- **Multi pencil** — Create toolpaths along the corner edges. This is similar to **Along**, but with fewer retracts where three or more rest areas meet. This is the same as creating a Pencil milling toolpath with remachining (see page 1112) enabled.

- **Along** — Create toolpaths parallel to the sharp corner edges.

- **Across** — Create toolpaths across the corner edges.

- **Combo Along and Across** — Create Across toolpaths in steep areas and Along toolpaths in shallow areas.

**Remove deep cuts**

**Remove deep cuts** removes segments of the toolpath where the depth of cut is large, to prevent tool damage.

A *deep cut* is defined internally as the sum of the current and previous tool radii plus any overlap.
Deep cuts example

The following example has 'ribs' that contain deep cuts:
With **Remove deep cuts** deselected, the remachining toolpaths cut the full length of the ribs including the deep cut areas, which could damage the tool:

![Diagram](image1)

With **Remove deep cuts** selected, the remachining toolpaths cut only the shallower parts of the ribs:

![Diagram](image2)

**Detection angle** — Only corners below the angle specified are found. **Detection angle** is the largest angle between adjacent, non-tangential surfaces that is detected as part of a pencil or remachining operation. It is used to set the sensitivity of the region detection. Generally, **Detection angle** should be set as big as possible to detect the unmachined regions.
Remachining — Click this button to open the Remachining (see page 1112) dialog.

Holder collision clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the Holder clearance and Shank clearance attributes are displayed on the Milling tab for the operation.

Strategy tab (Pencil) (3D HSM)

Detection angle — Only corners below the angle specified are found.

Detection angle is the largest angle between adjacent, non-tangential surfaces that is detected as part of a pencil or remachining operation. It is used to set the sensitivity of the region detection. Generally, Detection angle should be set as big as possible to detect the unmachined regions.

Remachining — Click this button to open the Remachining (see page 1112) dialog.

Holder collision clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the Holder clearance and Shank clearance attributes are displayed on the Milling tab for the operation.
**Strategy tab (5-axis trim) (3D HSM)**

**Inside edge** — Select this option to create toolpaths on the inside edge of the surface.

**Outside edge** — Select this option to create toolpaths on the outside edge of the surface.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.
**Strategy tab (Steep and shallow) (3D HSM)**

**Order** — This determines the order in which the steep and shallow portions are machined.

- **Top first** — Select this option to machine from the top regions downwards. If you have a boss, the shallow regions at the top of the boss are machined before the steep regions down the sides.

- **Steep first** — Select this option to machine the steep sections before the flat. If you have a boss, the steep regions are machined before the shallow regions.
Options

Threshold angle — Enter the angle of the surface slope, measured from the horizontal, that determines the split between constant Z (steep) and shallow machining.

Overlap distance — Enter the size of the overlap area between steep and shallow machining. This reduces marks on the model caused by a sudden switch between steep and shallow machining.

Steep

Spiral — Select this option to create a spiral path between two consecutive closed contours. This minimises the number of lifts of the tool and maximises cutting time while maintaining more constant load conditions and deflections on the tool.

Shallow

Select from:

Parallel

Optionally enter a Wall Clearance and Raster Angle.

3D Spiral
Smoothing — Select this option to smooth offsets of toolpath segments over the model.

Selecting the **Smoothing** option converts this:

As a general rule, use raster on open-edged parts and 3D offsets at the bottom of a pocket.

**Holder collision clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface, or unmachined stock. When selected, the **Holder clearance** and **Shank clearance** attributes are displayed on the **Milling** tab for the operation.

**Machine maximum stock** — Use with **Holder collision clipping** to machine the stock as close to the part without causing a holder collision. This creates smoother toolpaths with fewer retracts, which can improve the surface finish and reduce the machining time, but may cause increased air cutting on some parts.
Remachining dialog

You can use the Remachining dialog to create remachining (see page 788) toolpaths that automatically mill regions that were not cut by previous operations.

To display the Remachining dialog, click Remachining on the Strategy tab of the Feature Properties dialog.

![Remachining dialog](image)

**Remachining** — Select this option to enable planar remachining (see page 789).

**Previous tool diameter** — Enter the dimensions of the tool that was used to cut the part previously. This parameter applies to all remachining methods.

**Overcut percent** — Enter a percentage by which to increase the Previous tool diameter to expand the remachining region. This is useful to ensure complete coverage by the remachining toolpath.

**Minimum rest material** — Specify the minimum size of remaining material you want to remachine.

*This parameter does not apply to corner remachining. It applies only to parallel, Z-level and 3D spiral remachining.*
This setting can be used to filter out regions that have a minimal amount of rest material left by the previous tool. The default is 0 which means it tries to cut anywhere the previous tool had a double contact with the part surfaces, including a fillet of the same size as the previous tool (assuming Overcut percent is also set to 0). If Minimum rest material is set to a positive number, the remachining only includes tool paths that remove rest material that is greater than this depth. Its main use is to handle the case where you have some part fillets exactly the size of the previous tool and some that are smaller. If you do not want to remachine the part fillets that are exactly the size of the previous tool you can set Overcut percent to 0 and Minimum rest material to 1 or 2 times the machining tolerance to make sure the previous tool radius sized fillets are not remachined.

The following example part has some fillets that have a 10 mm radius and some smaller fillets. Remachining with a Previous tool diameter of 20 mm and the default Overcut percent of 5 remachines all the fillets:

If you set Overcut percent to 0 to avoid cutting the 10 mm fillets we may get some unwanted tool paths, depending on the machining tolerance and the accuracy of the part model. Here the machining tolerance is set to 0.01 mm and we have some unwanted tool paths:
Generally, setting the Minimum rest material to twice the tolerance (0.02 mm in this case) eliminates these extra tool paths.

Another use for Minimum rest material is to eliminate noise from the remachining tool paths due to inaccuracies in the part surfaces, non-solid models, poor tolerances, and so on.
**Edges tab (3D LITE)**

You can use the Edges tab of the Surface Milling Properties dialog (see page 1045) to specify how the tool behaves at the edges of the surface.

This tab gives you options to set how the toolpaths are generated near surface edges.

**Automatic** — A set of rules that chooses between Don't roll and Cut to bottom to get the best performance (see page 1121).

**Cut to bottom: Roll over top edge and cut to bottom of stock/part limits** — This does not set any boundary. In this case, FeatureCAM uses only the boundary specified by the curve options in the Stock tab.

**Cut top edge: Just roll over the top edge** — Sets a pocket-like curve boundary to the silhouette of the part offset by a tool radius. The tool rolls over the edges by a tool radius. In PowerMILL this is known as a silhouette boundary. Edge boundary uses a silhouette boundary of the part, but it uses the top (highest) Z values where the silhouettes are at a vertical surface.

**Cut top edge examples**
Cut top edge, z-level operation:

Don't roll over the edge at all
Sets a pocket-like curve boundary to the silhouette of the part. The tool contacts the surface boundary. In PowerMILL this is known as a contact point boundary. This prevents any cutting of sharp corners at the external edges of the part. If the part has a vertical surface at the outside of the part AND has a sharp corner at the top of the vertical surface, it prevents cutting of the vertical surface because it is coincident with the sharp corner at the top.

Don't roll over examples
Do not roll over the edge at all, z-level operation:

Do not roll over the edge at all, parallel operation:

You can set advanced options on the part boundary by clicking the **Advanced** (see page 1118) button.

If you have a vertical surface and you want to cut to the bottom, select **Cut to/from bottom of vertical walls**.

**Cut selected surfaces: Only cut selected part surfaces** — FeatureCAM only machines the selected surfaces and does not cut any of the neighboring or unselected surfaces. If there are no neighboring surfaces, the tool rolls over the edges by a tool radius.

If you have a vertical surface and you want to cut to the bottom, select **Cut to bottom of vertical walls**.

**Save Combined Boundary** (see page 1119) — This preview button shows both the part boundary (in blue) and the tool center (in red) curves on your model and enables you to save it for future use if you want to.

*The settings on the **Edges** tab may affect performance (see page 1121).*
Advanced part boundary options

This page gives you advanced settings for the Don’t roll over the edge at all option.

There are two types of curves used by the Don’t roll option. One type is a curve on the surfaces of the feature. This is called a part boundary and the points are the contact points where the tool stops at the edge of the feature. These curves do not depend on the tool. The second type of curve is a tool center (offset) curve. A tool center curve is a part boundary curve that has been offset by the tool edge radius. The Show combined boundary button on the Stock page gives a preview of all the part boundary and tool center curves.

Part boundary tolerance — This controls the accuracy of the part boundaries. The default value is automatically computed. Smaller values give better results but take longer to compute. To reset to the default value, enter 0 and click OK, then click Apply on the Edges tab.

Use separate wall tolerance — The part boundaries use a tolerance to check for vertical surfaces (walls). By default it uses the Part boundary tolerance. Selecting this option enables you to enter a separate tolerance value for vertical walls. You may need to use this setting if you use the Cut to/from bottom of vertical walls option on the Edges tab. If you preview the part boundaries and they are not consistent at the bottom of vertical walls, select Use separate wall tolerance and enter a larger tolerance than the boundary tolerance above.

Offset boundary tolerance — This controls the accuracy of the tool center (offset) curves. The default value is the same as the Tolerance value on the Milling tab, but if you override it here it becomes a separate tolerance for the tool center curves.

Small values produce smoother tool center curves, but take longer to compute.
**Edge tolerance** — This specifies the tolerance between the part boundaries and the surfaces. The default value of 0 means this tolerance is set automatically based on the boundary tolerance above. If the tool center curve is rolling over the edges of the feature you may need to set a larger edge tolerance (relative to the boundary tolerance).

**Advanced part boundary examples**

The **Save Combined Boundary** preview button on the **Edges** tab shows both the part boundary (blue) and the tool center (red) curves:

![Advanced part boundary examples](image)

In the following example, the part boundary (red) is smooth, but the tool offset (blue) is rough. Decrease the **Offset boundary tolerance** for a smoother tool offset:

![Advanced part boundary examples](image)

This shows a smoother tool offset (blue) with decreased **Offset boundary tolerance**:
In the following example, the part boundary (red) is not consistent along a vertical wall. First try reducing the **Boundary tolerance**. If that does not solve the problem, try using a separate (larger) **Wall tolerance**.

By using a reduced **Boundary tolerance**, a smoother part boundary is produced along the top of a vertical wall:

Using the **Rollover** option, the tool offset (red) (and toolpath) rolls over the part boundary (blue):
Using an **Edge tolerance** larger than the **Boundary tolerance** eliminates the rollover. Reducing the **Boundary tolerance** may also eliminate the rollover without setting the **Edge tolerance**:

![Diagram](image)

**Edges performance**

The options on the **Edges** tab can have a large impact on the performance of 3-axis toolpaths. The edge options cause various types of automatic boundary curves to be calculated which, depending on the size of the model and the tool, can take significant time to compute.

These are the edge options ordered from best to worst in order of performance:

- **Cut to bottom** — This option computes no automatic boundary and has no impact on performance.
- **Cut selected surfaces** — This option computes a boundary between the selected surfaces and unselected surfaces. This is intended for milling a small subset of the surfaces in a larger model (in other words, a feature). When used in this way it should not have a large impact on performance. If you do not have any unselected surfaces, this option behaves the same as **Cut top edge**.
- **Cut top edge** — This option computes an automatic silhouette boundary of the part surfaces. Performance is impacted on large models.
- **Don't roll** — This option computes two automatic boundaries and can have a large impact on performance. Large models and small tools both slow down these calculations. This option is best for simple surface models where the milling needs to be limited to not roll over the edges along the profile of a feature.

**Automatic**

The **Automatic** option follows a set of rules to choose between **Don't roll** and **Cut to bottom**. **Automatic** tries to avoid the computation of **Don't roll** when it thinks that it is unnecessary and chooses **Cut to bottom** (no boundary calculation) instead.
**Automatic** follows these rules:

- Use **Cut to bottom** for any of these cases:
  - 4- or 5-axis operation
  - Roughing operation
  - Flowline or Isoline operation
  - Corner remachining operation
  - **Select curves for boundaries** has been set on the **Stock** tab
  - A slope has been set up on the **Slopes** tab
  - **Remachining** option has been selected on the **Strategy** tab
  - **Overcut %** is not 100 on the **Stock** tab
- Otherwise use **Don't roll**.
Stock tab (3D LITE)

Use the Stock tab of the Surface Milling Properties dialog (see page 1045) to choose the clipping curves for the material to be removed.

Use part surface dimensions — This creates toolpaths on the surfaces regardless of the location of the stock. If you are using a spiral toolpath, this option automatically calculates the silhouette curve of the feature and uses this curve as the shape of the spiral. This generally has the best shape for spiral toolpaths.

Use stock dimensions — This restricts the toolpaths to the portions of the surface feature that are within the stock. If you are using a spiral toolpath, this option uses the outline of the stock as the shape of the spiral. You can set what percentage of the tool approaches or passes beyond the stock boundary in the Overcut % option.

Overcut % applies to three types of surface milling features:

- spiral toolpaths designated as a boss on the stock page
- features cut with projection milling technique that do not have an explicit boundary curve
- some Z level rough passes.

In the boss case this attribute applies only to how the toolpaths behave around the stock boundary.
For other 3D surface milling features, use the cut allowance feature described on the Stock tab. The Overcut % option applies only if Use stock dimensions is selected on the feature’s Stock tab.

Overcut % specifies what percentage of the tool approaches or passes beyond the stock boundary.

It can have a value between -100 and 100 with the following meanings:

0 puts the centerline of the tool on the stock curve.

100 overcuts the region by a tool radius.

-100 stops one tool radius short of the stock curve.

For Z level rough, this attribute applies to all features except Pocket features without stock curves. This attribute controls the outer extend of Boss features and the amount that Pocket feature cuts beyond its boundary. The default value is 100% which puts the edge of the tool on the boundary. A number greater than 100 extends the toolpaths beyond the boundary. A number less than 100 essentially offsets the outer boundary and clips the toolpaths against this closer boundary.

Use solid model — This restricts toolpaths to be within the solid model or STL model that you choose. Optionally enter an Allowance.

This applies to Z-level roughing only.

Select curves for boundaries — This uses curves to restrict the toolpath boundaries or to affect the shape of a spiral toolpath. Click the Curve Options button to open the Boundary Curve (see page 1129) dialog. Additional options are displayed for 2D spiral toolpaths (see page 750), 3D spiral toolpaths (see page 755), and all other techniques (see page 1129).
**Stock Model** — Select this check box to use a stock model (see page 266) in combination with the curve you selected. Select the Stock Model name and the Operations to use from the lists. Click the Stock Model Options button to open the Stock Model Settings (see page 1131) dialog.

*This option is available for Z-level rough, Parallel rough and all 3-axis finishing strategies*

**Save Combined Boundary** — Click this button to display and save the boundary for the operation. The boundary is a combination of the edge boundary, the stock curve boundary, and the slope limit. This may take some time to compute, but is computed and stored with the operation, that is, computed only once.

**Creating an STL file**

To create an STL file:

1. Play a 3D simulation up to the end of the operation that you want to save.
2. Select View > Simulation > Save Simulation Results from the menu.
3. The Save STL dialog (see page 104) is displayed:

   ![Save STL Dialog](image)

4. Select to save to either the current directory or a different directory.
5. Enter an STL File Name or accept the default.
6. Optionally select Save STL File Using Short File Name, Create Subfolder, and Overwrite Existing Files.
7. Click OK.

You can then import (see page 1125) the STL file to use as initial stock for Z-level roughing.

**Importing an STL file**

To import an STL file:
1. Select **File > Import** from the menu.
   The **Import** window opens.

2. At the bottom of the **Import** window, for **Files of type**, select **Supported types**, **STL**, or **All**.

3. Browse to the STL file you want to import and either double-click its name, or select it and click **Open**.
   Follow the steps in the wizard or click **Cancel** to return to the Graphics area.

   The STL displays in the **Part View** panel under **STL** with the default name **stl**.

   *Any additional STL files that you import are named **stl_1**, **stl_2**, and so on.*

   ![Part View](image)

   ![You can also import an STL file by dragging it into the Graphics area.](image)
**Multiple roughing tools STL example**

The following example part needs to be initially machined, and then sent off to be hardened:

The remaining material must be rest machined around the upstands of the model.

We do the initial Z-level roughing operation with a 20 mm tool and achieve the following result:

This is the stock state after hardening.
We save this 3D simulation as an STL file (see page 1125), and import (see page 1125) it back into the active file:

We then do a **Multiple rough** Z-level operation using a 10 mm tool and a 6 mm tool. On the **Stock** tab for this operation, we select the *.*.stl file that we had created and imported, to clip the toolpaths to. This is the result:
**Boundary Curve dialog**

To open the **Boundary Curve** dialog, click the **Curve Options** button on the **Stock** tab (see page 1123).

![Boundary Curve dialog](image)

**3D pocket** — The toolpaths are restricted to the regions inside of the curves specified as the boundaries.

![3D pocket](image)

You can also specify **Island curves** for 3D pockets. The toolpaths are generated outside of the island curves, but inside the boundary curves. The island curves must be inside of the boundaries and must not touch the boundaries.

![Island curves](image)
**3D boss** — The toolpaths are restricted to the regions outside of the curves specified as the boundaries.

Boundary curves may extend beyond the stock or beyond the surfaces of the feature. Regardless of the curves that are specified, toolpaths do not extend beyond the surfaces of a feature.

**Curve allowance** — The distance to stay away from the boundary or island curves. This must be a positive number and is an absolute distance.

Spiral Boss feature with **Boundary Curve Allowance**. Notice the gap between the Boss features and the toolpaths.

**Limiting method**

**Tool center** — Select this option to limit the toolpath based on the center of the tool.

**Contact point** — Select this option to limit the toolpath based on last point of contact between the tool and the surface.
Stock Model Settings dialog

![Stock Model Settings dialog](image)

**Stock model rest roughing**

These attributes apply to the rough operation.

**Expand area by** — Enter a value to expand rest areas by the specified distance (measured along the surface). A negative value reduces the size of rest areas.

**Detect material thicker than** — Enter a threshold value. FeatureCAM ignores rest material that is thinner than the specified threshold.

**Minimum gap length** — Enter the gap length, which controls fragmentation by replacing gaps shorter than this distance with a toolpath segment. A large value reduces fragmentation, but increases the length of the toolpath that is not cutting material. A small value produces shorter toolpaths, but increases the number of toolpath lifts.

A Minimum gap length of 0:

[Diagram of toolpath with different gap lengths]
A **Minimum gap length** of the default value:

**Stock model engagement for finishing**

These attributes apply to the finish operation. They reduce tool wear, improve surface finish, and stop the tool engaging with the material excessively.

**Machine stock only** — Select this option to limit the toolpaths to areas where a minimum amount of stock is being removed from the stock model.

**Detect material thicker than** — Enter a threshold value. FeatureCAM ignores rest material that is thinner than the specified threshold.

**Minimum length removed** — Enter a threshold value. FeatureCAM ignores toolpath portions that are shorter than this.

**Use depth of cut** — Select this option to limit the depth of cut to the value you enter.
Slopes tab (3D LITE)

You can use the Slopes tab of the Surface Milling Properties dialog (see page 1045) to specify the slope limitations of a 3D Surface Milling toolpath.

Many of the 3D toolpath techniques can be limited to regions of the part by angles. These controls are located on the Slopes tab. The options are:

None — All regions of the surfaces of the model are included regardless of slope.

Horizontal only — Limits cutting to regions with a slope less than the Maximum surface slope angle.

Maximum surface slope limits the toolpaths to portions of surfaces with a slope less than that angle. This is a good way to limit milling to the 'flatter' portions of your model. This attribute applies to most finishing types of toolpaths (for example Parallel, Radial and so on). The image below shows an example of limiting X parallel toolpaths to the bottom of the mold by setting Maximum surface slope angle to 45 degrees.
The toolpaths do not climb up steep walls.

Vertical only — Limits cutting to steep regions with slope greater than the Minimum surface slope angle.

This limits toolpaths to surface portions that have a slope greater than that angle. It works well to limit toolpaths to the steeper portions of the model. The image shows an example of using this to limit the finishing passes to the walls.

The bottom of the mold is not machined.
If you are using a spiral operation that is limited by slope, then selecting the **Horizontal only** option generates spiral operations based on the outlines of the slope-based regions.

**4-Axis/5-Axis tab (5AS)**

You can use the 5-Axis tab of the Surface Milling Properties dialog (see page 1045) to edit the Multi-Axis options of a Surface Milling feature.
For a turn/mill document with a B-axis enabled post (.cnc file) or a 5-axis positioned document, these surface milling operations have a 5-Axis tab:

- Parallel finish
- Z-level finish
- Isoline
- 2D spiral
- 3D spiral
- Flowline
- 5-axis trim
- Swarf
- Horizontal + Vertical
- Pencil
- Corner Remachining
- Between 2 curves

The strategy type determines the options that are available.

This tab enables you to set three different things: **Tool Axis, Tilt Axis for Gouge Avoidance, and Tool Axis Limits**. The first two sections of the dialog can be confusing because they both control the tilt of the tool axis. Think of the first section, **Tool Axis**, as a first level of tool tilting, controlled in a manual way. And then you can add extra tilting in order to avoid gouges with the tool holder by using **Tilt Axis for Gouge Avoidance**.

*You can use these two sections of the dialog independently, one without the other, meaning that you can use the second section without having specified any tilting in the first section.*

The **Tool Axis** enables you to define the tool orientation. The default value is **Vertical**, which is used for standard 3-axis machining. However, it can also be a continuously changing orientation for so-called 5-axis simultaneous machining.

**Vertical (Z)** — The tool remains aligned with the Z-axis of the active Setup and so is the same as for standard 3-axis milling.

**Fixed** — This option enables you to set the tool axis direction as a vector.

**Use Lead and Lean** — The tool tilts at a fixed angle relative to the direction of tool travel.

- **from** — Select where the lead and lean angle is measured from.
  - **Contact normal** — Select this option to lead and lean from the surface normal at the contact point.
  - **Vertical** — Select this option to lead and lean from the Setup's Z direction.
  - **Travel dir** — Select this option to lead and lean from the perpendicular to the direction of movement
  - **Legacy** — Select this option to use the traditional lead and lean style.
**Lead Angle** — This tilts the tool forwards or backwards along the travel direction.

**Lean Angle** — This tilts the tool to the left or right of the travel direction.

*For more information, see Lead/Lean (see page 1142).*

**Other** —

**From point** — This option aligns the tip of the tool away from a fixed point. The angle of the tool is constantly changing. The tip of the tool moves significantly while the head of the machine tool stays relatively still.

**To point** — This option aligns the tip of the tool towards a point. The angle of the tool is constantly changing. The head of the machine tool moves significantly while the tip of the tool stays relatively still.
**From line** — This option aligns the tip of the tool away from a fixed line. The angle of the tool is constantly changing. The tip of the tool moves significantly while the head of the machine tool remains relatively still.

![Diagram of From line alignment](image)

**To line** — The tool tip always tries to point towards the fixed line. The angle of the tool is constantly changing. The head of the machine tool moves significantly whilst the tip of the tool stays relatively still.

![Diagram of To line alignment](image)
From curve — This option aligns the tip of the tool away from a fixed curve. The angle of the tool is constantly changing. The tip of the tool moves significantly while the head of the machine tool stays relatively still.

To curve — This option aligns the tip of the tool towards a curve. The angle of the tool is constantly changing. The head of the machine tool moves significantly while the tip of the tool stays relatively still.

In FeatureCAM 2013, these options have been improved and are now more accurate. The old options are still available so that you can keep any tool axes that you are happy with, in existing files. The old options have been renamed From point (old-style), To point (old-style), From line (old-style), From curve (old-style), and To curve (old-style).
**Automatic** — The swarf operation has an automatic option (instead of the above **Other** option). The automatic option tilts the tool to keep the side of the tool in contact with the surface(s) being cut.

**Retract to** — Click the **Retract to** button to open the **Safe Area** (see page 1152) dialog.

**Tool axis smoothing** — This minimizes changes in velocity and position of the tool axis. This smooths the axis movements of the machine tool.

It works by smoothing the rotary axis motion on the A/B axis (Elevation) and the C axis (Azimuth) of a machine tool.

The benefits of using tool axis smoothing include:

- Improved surface finish due to a reduction in jerky motion and reduction of surface dwell marks.
- Reduced machining time due to a more constant rotary axis speed.
- Improved quality of all 5-axis machining strategies.

**Tilt Axis For Gouge Avoidance** (see page 1143) — This enables you to tilt the tool in order to avoid gouging the model with the holder, in a user-defined way.

**Smoothing distance** — When using **Tilt Axis for Gouge Avoidance**, set this attribute to avoid sudden tool axis changes.

This example part has a vertical surface, shown in red, with two tabs at the top:

![Example part with tabs](image1)

This is the surface in more detail:

![Surface detail](image2)
Using an Isoline strategy, with **Tool axis smoothing** enabled and a **Tilt axis of Lean then lead** with no **Smoothing distance** value, the tool has sudden changes in direction. For example, it machines the area below the first tab in a tilt position:

Then returns to a vertical position between the tabs:

Then returns to the tilt position to machine the area below the second tab:
With a **Smoothing distance** value entered that is long enough to cover the area between the two tabs, the tool stays tilted when machining between the tabs:

**Tool Axis Limits** (see page 1147) — This enables you to define limits on the direction of the tool axis whilst cutting a multi-axis toolpath.

**Lead and Lean**

The tool is at a fixed angle relative to the direction of the toolpath. You can specify two different angles, **Lead** and **Lean**. If you specify a **Lead angle** and a **Lean angle**, the **Lead Angle** is applied first in the direction of the move, and then the **Lean Angle** from this rotated position towards a vector perpendicular to the move.

**Lead Angle** — This defines a rotation of the tool axis in the direction of travel. It is measured from the perpendicular to the direction of travel; 0 is vertical. Typically this is used to avoid cutting at the center of a ball nosed tool on flattish areas. The diagram below has a lead of 30°.
**Lean Angle** — This defines a rotation of the tool axis at right angles to the direction of travel; 0 is vertical. The diagram below has a lean of 30 degrees. Typically this is used to avoid collisions (such as a step). Or this can be used when machining up to a step to allow you to use a smaller tool.

![Diagram of Lean Angle](image)

**Tilt Axis for Gouge Avoidance**

Use this section of the 4-Axis or 5-Axis tab to specify how FeatureCAM automatically tilts the tool axis to avoid collisions between the shank and holder of the tool assembly and the model.

- **No tilting** — This is the default setting and means that the holder and shank are not gouge-checked.

- **Lean** — If a collision is detected, the tool axis moves from the original axis in the **Lean direction** until the collision is avoided.

- **Lead** — If a collision is detected, the tool axis moves from the original axis in the **Lead direction** until the collision is avoided.

- **Lead then Lean** — If a collision is detected, the tool tilts from the original axis in the **Lead direction** until the collision is avoided. If the collision cannot be avoided by tilting the tool in the **Lead direction**, the tool tilts in the **Lean direction** until the collision is avoided.

- **Lean then Lead** — If a collision is detected, the tool tilts from the original axis in the **Lean direction** until the collision is avoided. If the collision cannot be avoided by tilting the tool in the **Lean direction**, the tool tilts in the **Lead direction** until the collision is avoided.
To Point — If a collision is detected, the tool is aligned with the tip pointing towards the specified point, to become a Toward Point Tool Axis, until the collision is avoided.

From Point — If a collision is detected, the tool is aligned with the tip pointing away from the specified point, to become a From Point Tool Axis until the collision is avoided.

Towards the surface normal — If a collision is detected, the tool axis moves from the original axis and move towards the Surface normal direction until the collision is avoided.

This simple example uses an X-parallel toolpath over a step to show the effect of Collision Avoidance. If you create a simple parallel toolpath over this, you get collisions of the shank as it climbs or descends the step:

One way around this is to increase the length of the tool. Another way is to change the toolpath strategy. The third way is to use Collision Avoidance. In this case, the initial Tool Axis is Vertical. Select a Tilt Axis for Gouge Avoidance of Lead.

Create a new parallel toolpath. You can see that the toolpath now tilts on the steep portions to avoid the tool holder colliding:
However, the toolpath is still 3-axis on the flat portions where the tool holder does not collide:

In summary, the tool tries to respect the original Tool Axis Definition for as much of the toolpath as possible. When this is not possible, the tool axis changes in the direction specified in the Tool Tilt Axis field until the tool assembly no longer collides.

**Lead then lean** example

The following example model can be machined using 5-axis simultaneous machining:

A Tilt Axis of Lean does not create a toolpath in the corners ①:

A Fixed direction and a Tilt Axis of From curve creates an incomplete toolpath.
The only way to resolve this would be to create a curve in each pocket and generate a separate toolpath for each pocket.

A **Tilt Axis** of **Lead then lean** achieves the required result with one toolpath, so there is no need to create any additional geometry.

**Linearization**

5-axis machine tools do not guarantee (and frequently don't use) a straight line move from one point to another in multi-axis. This means that you cannot necessarily guess where the tool might move to between two points. The machine tool moves all of its axes simultaneously — it doesn't just move in X and then rotate the head. It does both together so that both movements are carried out at the same time. This is not a big issue if the points are close together. However, if the points are far apart, the machine tool (which may be rotating the tool tip between two points) can cause gouges when the part is cut on the actual machine.

Consider moving between two points. Although the move looks like a straight line, it won't necessarily be a line on the machine tool.

Arc swept by machine tool.

FeatureCAM does attempt to linearize moves by dividing the curves into smaller straight line moves, based on the **Use linearization** and **Inch/Metric Tolerance** options on the **FIVE-AXIS** dialog in XBUILD.
A very small wrapping tolerance tends to make 3D and machine simulation rather slow. For this reason, the simulation has its own Linearization tolerance option, which you can set to a larger number than that of manufacturing. That is, the simulation uses the tolerance (which you set under Options > Simulation > 2D/3D Shaded tab) for linearization, and the posting process uses the wrapping tolerance found on the FIVE-AXIS dialog in XBUILD.

**Tool Axis Limits**

The Tool Axis Limits dialog controls angular limitations of the machine toolpath which therefore limits the angle at which a tool can be positioned while cutting a multi-axis toolpath.

When the angular limits are met or exceeded, there are two options:

- **Remove toolpaths** — This removes the toolpath outside the angular limit.
- **Leave tool at Limit** — This keeps the tool axis at the machine limit on reaching an angular limit.

**Elevation angle** — This defines the angular limits of the machine tool above the azimuth plane; 0 is in the azimuth plane, 90 is along the axis perpendicular to the azimuth plane.

**Azimuth Angle** — This defines the angular limits of the machine tool in the azimuth plane.

**Project to Plane** — This is the same as setting the elevation angle to zero. Because the elevation angle is fixed, this usually produces a 4-axis toolpath. If the stock Z axis is not aligned with a rotary axis of the machine tool, a 5-axis toolpath may be produced.
It is not always immediately obvious how to translate the machine tool angular limits with FeatureCAM’s Azimuth and Elevation angles. This looks at a couple of machine configurations with different angular limits.

The configuration of the rotary axes varies widely. However, the differences between many of these are relatively minor, and there are really only three fundamentally different machine configurations:

Table - Table
Both rotary axes move the table.

With table-table machine tools, typical angular limits are:

X ± 30
Y ± 360

The machine tool Y limits are equivalent to the Azimuth Angle or the angular limits in the XY plane. The Y limit of ± 360 translates to Azimuth Angle limits of 0 to 360.

The machine tool X limits are equivalent to the angle above the XY plane. However, they are not the same angle. This is best described using the diagram below. The machine tool measures the angular range relative to the Z axis and FeatureCAM measures it relative to the XY plane. So, the angle required for the limit is the complementary angle to the one given for the machine tool.
If you select a **Mode** of **Remove Toolpath** this will machine a sphere to the following extent:

![Diagram of sphere machine tool](image1)

**Head - Head**

Both rotary axes move the head.

![Diagram of head machine tool](image2)

With head–head machine tools, typical angular limits are:

- $X \pm 60^\circ$
- $Z \pm 360^\circ$

The machine tool $Z$ limits are equivalent to the **Azimuth angle** or the angular limits in the XY plane. The $Z$ limit of $\pm 360^\circ$ translates to **Azimuth angle** limits of $0^\circ$ to $360^\circ$. 
The machine tool X limits are equivalent to the angle above the XY plane. The machine tool measures the angular range relative to the Z axis and FeatureCAM measures it relative to the XY plane. So, the angle required for the limit is the complementary angle to the one given for the machine tool. This is described in more detail in Table – Table. The X limit of \( \pm 60^\circ \) translates to Elevation angle limits of \( 30^\circ \) to \( 90^\circ \).

---

1 — The machine tool's X angle range = \( \pm 60^\circ \), FeatureCAM's elevation angle range = \( 30^\circ \) to \( 90^\circ \).

If you select a Mode of **Remove toolpath** this machines:

Alternative typical Head - Head machine tool angular limits are:
X -50° to +60°
Z ± 360°

This translates to **Azimuth Angle** limits of 0° to 360° and to **Elevation Angle** limits of 30° to 90°. In this case, although the machine tool limits appear to be different to those in the first Head - Head example, the FeatureCAM angular limits are in fact the same. This happens because rotating the head 180 about Z then gives you the complete range.

**Head - Table**

One rotary axis moves the head; the other moves the table. This is the case for lathes with a B-axis head.

**Azimuth Angle** - defines the angular limits of the machine tool in the XY plane. 0 is along the X axis; 90 is along the Y axis. Can range from 0 to 360.

**Elevation Angle** - defines the angular limits of the machine tool above the XY plane. 0 is in the XY Plane; 90 is along the Z axis, -90 is along the -Z axis. Can range from -90 to 90.

That is, the elevation angle limits the angle in the XZ plane. Angle 0 is the X tool, 90 is the Z tool, so a minimum elevation 0 to max elevation 90 cuts the complete right half of a sphere (flowline) given no min_azimuth/max_azimuth. (Think of it as latitudes and longitudes that are reachable. The longitude (circles parallel to XZ plane for turnmill) is controlled by elevation angles).

The latitude (think of a tool axis in the XY plane for turnmill) is controlled by azimuth angles. That is, -90 to 90 would cut the entire top half of a sphere if given no elevation limits... (X axis is 0 azimuth angle). However, the allowable range is 0 to 360, so setting minimum to 270 and maximum to 90 is acceptable (the limit is set going clockwise around positive Z axis from minimum to maximum).
The example below shows you how to transpose the angular limits on the machine tool to the **Azimuth** and **Elevation** limits on the **Limits** tab on the **Tool Axis Direction** dialog. These examples all use a sphere with an Isoline or Flowline Projection toolpath. If no tool axis limits are imposed, you will see the following toolpath:

![Sphere Toolpath](image)

**Safe Area dialog**

![Safe Area Dialog](image)

The **Safe Area** dialog affects the approaches, plunges, and retracts of a 5-axis simultaneous operation.

- **Retract to** sets the shape of the safe area. Select from:
  - **Plane** — In this case, the safe area is defined as a plane, a distance of **Z rapid plane** (1.0 inches in this example) above the top of the stock. All plunges begin a distance of **Plunge clearance** away from the top of the stock (at Z = 0.1 inches in this example).
You set the Z rapid plane and Plunge clearance attributes in the Retract and Plunge (see page 1339) dialog.

Cylinder — If you select Cylinder, the safe area of the operation is set as an infinitely long cylinder. Enter the Radius of the cylinder, the Origin and the Axis Direction.

Sphere — If you select Sphere, the shape of the safe area is set as a sphere. Enter a Radius and Origin for the sphere.

Axis Smoothing tab (5AS)

You can use the Axis Smoothing tab of the Surface Milling Properties dialog (see page 1045) to specify axis smoothing on Surface Milling toolpaths.
You must select the **Tool axis smoothing** option on the 5-Axis (see page 1135) tab to display the **Axis Smoothing** tab.

**Elevation** — Select how to smooth the elevation angle of the tool axis. An elevation of ±90° aligns the tool with the Z axis, and an elevation of 0° means the tool is in the XY plane.

**None** — Select this option to have no smoothing. The tool axis orientation moves as and when it needs to move.

**Smoothed** — Select this option to enable the tool axis angle to change smoothly over the **Smoothing distance**. The change in angle will not be more than the **Maximum angular correction** unless the angle of the unsmoothed toolpath varies by more than the **Maximum angular correction** in less than **Smoothing distance**. In such regions, the angle may change by more than the **Maximum angular correction** to give a smooth result.

**Stepped on surface** — Select this option to enable the tool axis angle to change by up to the **Maximum angular correction** to form steps of constant value. To avoid sharp tool axis movements, a smooth transition between steps is made starting at the **Smoothing distance** away from the possible ends of adjacent steps. The tool always remains in contact with the surface.

**Stepped with links** — Similar to **Stepped on surface**, select this option to enable the tool axis angle to change by up to **Maximum angular correction** to form steps of constant value. In this case, the toolpath segments are subdivided at the end of each step, and link moves are inserted so the tool axis changes when the tool is not in contact with the model. This means that tool axis angle of each toolpath segment is constant.

---

1. Original toolpath, no smoothing
2. Smoothed toolpath
3. Maximum angular correction limits
Azimuth or elevation

Toolpath distance

**Maximum angular correction** — Enter the maximum angle the smoothed axis may deviate from the initial in the elevation direction. The maximum angular correction angle is only exceeded if the unsmoothed toolpath moves by more than this value in less than the **Smoothing distance**. In such regions, the angle may change by more than the **Maximum angular correction** to give a smooth result.

**Azimuth** — Select how to smooth the azimuth angle of the tool axis. Azimuth is the angle between the $+X$ axis and the projection of the tool in the XY plane.

- **None** — Select this option to have no smoothing. The tool axis orientation moves as and when it needs to move.
- **Smoothed** — Select this option to enable the tool axis angle to change smoothly over the **Smoothing distance**. The change in angle will not be more than the **Maximum angular correction** unless the angle of the unsmoothed toolpath varies by more than the **Maximum angular correction** in less than **Smoothing distance**. In such regions, the angle may change by more than the **Maximum angular correction** to give a smooth result.
- **Stepped on surface** — Select this option to enable the tool axis angle to change by up to the **Maximum angular correction** to form steps of constant value. To avoid sharp tool axis movements, a smooth transition between steps is made starting at the **Smoothing distance** away from the possible ends of adjacent steps. The tool always remains in contact with the surface.
Stepped with links — Similar to Stepped on surface, select this option to enable the tool axis angle to change by up to Maximum angular correction to form steps of constant value. In this case, the toolpath segments are subdivided at the end of each step, and link moves are inserted so the tool axis changes when the tool is not in contact with the model. This means that tool axis angle of each toolpath segment is constant.

1 Original toolpath, no smoothing
2 Smoothed toolpath
3 Maximum angular correction limits
4 Azimuth or elevation
5 Toolpath distance
**Maximum angular correction** — Enter the maximum angle the smoothed axis may deviate from the initial in the azimuth direction. The maximum angular correction angle is only exceeded if the unsmoothed toolpath moves by more than this value in less than the **Smoothing distance**. In such regions, the angle may change by more than the **Maximum angular correction** to give a smooth results.

**Smoothing distance** — Enter the distance over which to smooth the tool axis movement. When using **Stepped on Surface**, or with sudden changes in direction in the original toolpath (such as a right-angled corner), you get rapid changes of orientation of the tool axis which leaves dwell marks. To prevent this, the **Smoothing distance** blends the change in orientation and gives a much improved surface finish.

1. Original toolpath, no smoothing
2. Smoothed toolpath
3. Maximum angular correction limits
4. Azimuth or elevation
5. Toolpath distance

**Override smoothing UCS** — Select this option to use a different UCS to the UCS used to generate the toolpath to define elevation and azimuth for smoothing.

**UCS** — Select the UCS to use when smoothing.
**Stepped on surface example**

This car door part uses a trimming toolpath around the edge:

With no smoothing, the rotary table has a rocking motion and sudden direction changes can leave witness marks.

In some areas of the model, it is impossible to avoid the rotation, such as when the tool makes its way around the corners and the wheel arch. However, it is areas such as on this long edge of the door, where the machine table is rocking backwards and forwards, that you can avoid this using the **Stepped on surface** options:

With **Stepped on surface** enabled for both **Elevation** and **Azimuth**, with a **Max. angular correction** of **80**, the table does not rotate while cutting this area:
Stepped with links example
This example part uses the Pencil strategy to cut the bottom fillet:

Enabling Stepped with links for both Elevation and Azimuth reduces the tool movement.

A centerline simulation shows the links that FeatureCAM inserts links so that it can change direction while not in contact with the surface:

Surface control tab (3D LITE)
You can use the Surface control tab of the Surface Milling Properties dialog (see page 1045) to specify how the toolpaths are generated on surfaces.

The Surface list displays all surfaces in the feature. Deselect the check box next to a surface name to exclude it from the operation.
Select a surface in the list to highlight it in the graphics window, or use the Pick surface button and select a surface in the graphics window to highlight it in the list.

**Isoline milling**

Attributes for — displays the operation being edited.

- **Surface** — The surfaces are machined in the order listed. Use the ↑ and ↓ buttons to rearrange the surfaces in the list. Deselect the check box next to a surface name to exclude it from the operation.

- **Start Curve** — Isoline surfaces are made up of rows or columns of curves. The Start Curve determines the first isoline curve used for machining the surface. Click Set isoline row/col to change the starting isoline curve.

  - **First Row** — the tool cuts along the row isoline curves, starting with the first row.
  - **Last Row** — the tool cuts along the row isoline curves, starting with the last row.
  - **First Col** — the tool cuts along the column isoline curves, starting with the first column.
  - **Last Col** — the tool cuts along the column isoline curves, starting with the last column.
- **Cut direction** — Determines the direction that the tool cuts along the isoline curves. Click **Cut direction** to change the direction between **increasing** and **decreasing**.

- **Sequence** — Determines the sequence in which the tool cuts the isoline curves. Click **Sequence** to cycle through the toolpath sequence options.
  - **None** — the tool cuts the isoline curves in order.
  - **In to out** — The tool starts at the middle and cuts towards the outside in both directions.
  - **Out to in** — The tool starts at the outside and cuts towards the middle from both directions.

An axis is displayed in the graphics view which shows the location and direction of the start of the toolpath for the selected surface:

1. Machining side arrow
2. Isoline row column corner and direction

If the wrong side of the surface is selected, click **Switch Machining Side** to reverse the machining side.

**Flowline milling**

If you select a **Flowline guide surface** (see page 773), the isolines of another surface are projected onto all the surfaces of the feature.

**Milling tab (3D LITE)**

You can use the **Milling** tab of the **Surface Milling Properties** dialog (see page 1045) to edit the 3D Milling attributes of the operation selected in the Tree view to control how the part is manufactured.

The check boxes, menus, and numeric attributes on this tab vary according to the operation type:

**3D LITE**

Z-level rough (see page 1163)
Parallel rough (see page 1179)
Parallel finish (see page 1187)
2D spiral finish (see page 1194)
Isoline finish (see page 1202)

**3D MX**
Z-level finish (see page 1209)
Flowline finish (see page 1222)
Radial finish (see page 1229)
Between 2 curves (see page 1237)
Horizontal + vertical (see page 1246)
Swarf strategy (see page 1268)

**3D HSM**
Plunge rough (see page 1292)
3D spiral finish (see page 1300)
Corner remachining (see page 1309)
Pencil (see page 1314)
Steep and shallow (see page 1320)

**5-axis simultaneous**
5-axis trim (see page 1327)
Milling tab (Z-level rough) (3D LITE)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Corner radius %** — This setting avoids sharp changes in direction by inserting an arc. To enable it, enter a percentage of the tool diameter to use for the arc radius.
Slices in Z-level (both rough and finish) can be arc-fitted to avoid sharp changes in direction. For Z roughing, only the toolpath closest to the part is rounded. **Corner radius %** defines the radius that is inserted into the toolpaths.

The radius of internal corners is defined as a proportion of the tool diameter. The default value is 5% for a finish pass and 0% for a roughing pass. So if you have a tool of diameter 10 mm then the arc radius is 0.5 mm. The **Corner radius %** can have a value between 0 and 100.

Arc fitting is of particular importance when high speed machining as it eliminates sudden changes in tool direction.

[Diagram showing normal and arc fitted toolpaths]

1. Normal
2. Arc fitted

**Direction** — Click this button to open the **Cut Direction** (see page 1337) dialog.

**Finish allowance** — Enter the amount of material to leave on a feature after the Rough pass. You can enter a positive or negative value.

**Finish axial allowance** — Enter the amount of axial (XY) material to leave on a feature after the Rough pass. If you enter a value for **Finish axial allowance**, the value for **Finish allowance** is applied to radial (Z) material. If you leave **Finish axial allowance** blank, the value for **Finish allowance** is applied to axial and radial material. You can enter a positive or negative value.
**Flat surface support** — There are three options for **Flat surface support**:

**Off** — Select this option to ignore flat areas and calculate Z levels at a constant Z increment.

**Level** — Select this option to insert extra levels above each flat surface and machine whole flat Z levels. This ensures that the **Finish allowance** is applied accurately.

**Area** — Select this option to insert extra levels above each flat surface and machine flat areas only. This ensures that the **Finish allowance** is applied accurately.

**Level** — FeatureCAM machines whole flat Z levels.
Looking at a different angle you can see that three complete levels are machined.

**Area** — FeatureCAM machines flat areas only (instead of the whole level).

Looking at a different angle you can see that only the flat areas are machined in the first level.
Off — flat areas are ignored.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature’s **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:
With an orientation angle of 0, the groove is cut in the machine's Y direction.  

With an orientation angle of 90, the groove is cut in the machine's X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Max. ramp distance** — This applies to linear or helical ramping.

**Max ramp distance** applies to linear or helical ramping.

For linear ramping it is the distance for each linear move:

![Linear ramping](image)

For helical ramping it is the diameter of the helix:

![Helical ramping](image)
If this attribute is not set, then **Max ramp distance** is initialized to the tool diameter. If ramping at this distance would cause a gouge, then the distance is reduced by a percentage of the initial setting. Several different percentages are tried by FeatureCAM.

*You cannot control the percentages.*

If a gouge-free ramping location cannot be found, then FeatureCAM ramps to depth using helical moves that follow the shape of the toolpath. In order for this to work, your machine must be able to do helical interpolation.

If, after reducing the ramping distance, a ramping location still cannot be found, then a direct plunge may occur. If you observe direct plunges, then you can set **Max ramp distance** to be smaller than the default. So, for example, if your tool is 6 mm in diameter, then the default of **Max ramp distance** is initially 6 mm. If you observe direct plunges at 6 mm, then try setting **Max ramp distance** to something smaller, say 3 mm. If a gouge-free ramping location cannot be found at 3 mm, then the **Max ramp distance** is reduced using the same percentages as before, but using an initial value of 3 mm instead of 6 mm. In this way, you have a better chance at getting a successful ramp to depth. The unfortunate trade-off is that by setting **Max ramp distance** to 3 mm, then all of your ramps to depth use this smaller distance.

See also **Max. ramp angle**.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves.
Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

New Value — To change the value of an attribute in the list, first select it, then enter the new value. Click the Set button to save the new value.

Output Options — Click this button to open the Output Options (see page 1017) dialog.
**Plunge feed override %** — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Plunge point(s)** — Optionally pick plunge points to override the points that are automatically used by FeatureCAM for a Pre-drill operation with a Spiral type toolpath.

> The Plunge point(s) attribute is only available when Plunge to Pre-drill location is selected on the Leads tab.

**Post Vars.** — Click this button to open the Post Variables dialog.

The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

> If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

> Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

**Reorder** — Enable this option to create a depth-first strategy. With Reorder off, each Z level is roughed completely before moving to a lower depth.
With **Reorder** off, each Z level is roughed completely before moving to a lower depth.

![Diagram showing roughing with Reorder off.](image1)

With **Reorder** on, paths are created that machine vertical regions as shown below.

![Diagram showing paths with Reorder on.](image2)

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the **Retract and Plunge** (see page 1339) dialog.
**Rough pass stepover %** — Enter the distance between plunge holes in the same row, as a percentage of the tool diameter.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click **Set**.

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

**Stepover rapid distance** is similar to **Min rapid distance %**, but **Stepover rapid distance** is a 3D distance and **Min rapid distance %** is a 2D distance.

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.
This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:

Lower value tolerance:

*The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.*
Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Toolpath corner % — This enables raceline smoothing by replacing sharp corners with rounded corners. Smoothing the sharp corners of the toolpaths gives a more constant tool velocity and reduces the tool load. Enter a toolpath radius larger than the tool radius to minimize the percentage of the tool that contacts the part. This enables enough cooling to take place and avoiding sharp increases in tool load as the tool enters the corners.

Effective only during Z-level rough, a non-zero Toolpath corner % enables raceline smoothing by replacing sharp corners with rounded corners. Defines the maximum deviation from the sharp corner. The maximum this can be set to is 40% of stepover. This means that if you have a 10 mm stepover the maximum deviation from the sharp to the rounded corner is 4mm.

Using the Toolpath corner % produces a toolpath with fewer small arcs which makes the toolpath more suitable for high speed machining. The original profile has the same number of points, but the offset passes have a reduced number of points.

Total stock — This controls the extent of the toolpaths.

Total stock controls the extent of the toolpaths for a feature.

Enter an offset distance for each Z slice of a feature to use instead of the Stock boundary.
This example shows a **Total stock** value of a for one Z slice of a Surface Mill feature that is classified as a **3D boss**:

A — A Z slice of a **3D boss** feature

a — **Total stock** value

If the **Total stock** value is 0, the Stock boundary is used, for example:

You can also use **Boundary curves** (see page 1129) to control the extent of a Z-level rough operation.

**Trochoidal cut** check box

The **Trochoidal cut** attribute is available for Z-level roughing.

Turning **Trochoidal cut** on turns on the ability to detect and avoid tool overload. As the tool gets towards an overload situation then FeatureCAM automatically puts in a trochoidal path to take away the overload. This happens in corners, in narrow channels, slots and the first cut of an offset toolpath which is, in effect, a narrow channel.

Because some tool overload may be acceptable, you can control **Trochoidal cut** with the **Avoid overload (% stepover)** attribute. This is the allowable overload percentage of the existing stepover. So, if you use a stepover of 10 mm and an **Avoid overload (% stepover)** of 10%, trochoidal moves don't start appearing until an overload condition of 10% (or 1 mm) is exceeded.
Looking in detail at a typical toolpath:

1 - Channel
2 - First cut
3 - Sharp corner
4 - Smooth link

Looking at a corner in detail you can see the trochoidal paths more easily:

Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.
**Vortex min point spacing** (3D HSM (see page 10)) — Enter the minimum point spacing at which the machine tool can move at the specified feed rate. If the machine tool has too many points to process, it cannot sustain the specified feed rate. You must select the Vortex option on the **Strategy** tab (see page 1060) to access this attribute.

**Vortex min radius** (3D HSM (see page 10)) — Enter the minimum radius of the internal trochoids. Vortex toolpaths use trochoidal moves to maintain a constant feed rate. Higher feed rates require a larger minimum radius. If you do not override this value, a default value is used, which is suitable for a typical machine tool at the feed rate specified for the operation. You must select the Vortex option on the **Strategy** tab (see page 1060) to access this attribute.

**Vortex Z lift distance** (3D HSM (see page 10)) — Enter a Z distance to lift the tool during trochoidal moves to avoid contact between the tool and the surface. You must select the Vortex option on the **Strategy** tab (see page 1060) to access this attribute.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

> **Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.**

**Z increment** — Enter the distance the tool moves down in the Z axis with each pass. This is useful if the default step down is leaving excess material on the part. When **Scallop stepover** is enabled, this attribute is not available.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
Milling tab (Parallel rough) (3D LITE)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the **Preferred orientation of the primary rotary axis** option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the **Finish allowance** value is used. If left blank for a finishing pass, the **Leave allowance** value is used. You can enter a positive or negative value. Set **Check surfaces** on the **Dimensions** (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for **Check axial allowance**, the value for **Check allowance** is applied to radial (Z) check surfaces only. If you leave **Check axial allowance** blank, the value for **Check allowance** is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the **Cut Direction** (see page 1337) dialog.
**Finish allowance** — Enter the amount of material to leave on a feature after the Rough pass. You can enter a positive or negative value.

**Finish axial allowance** — Enter the amount of axial (XY) material to leave on a feature after the Rough pass. If you enter a value for **Finish axial allowance**, the value for **Finish allowance** is applied to radial (Z) material. If you leave **Finish axial allowance** blank, the value for **Finish allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance* (see page 1648) *value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine's Y direction.
- With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Max. ramp distance** — This applies to linear or helical ramping.

**Max ramp distance** applies to linear or helical ramping.

For linear ramping it is the distance for each linear move:

![Linear ramping diagram]

For helical ramping it is the diameter of the helix:

![Helical ramping diagram]
If this attribute is not set, then **Max ramp distance** is initialized to the tool diameter. If ramping at this distance would cause a gouge, then the distance is reduced by a percentage of the initial setting. Several different percentages are tried by FeatureCAM.

> You cannot control the percentages.

If a gouge-free ramping location cannot be found, then FeatureCAM ramps to depth using helical moves that follow the shape of the toolpath. In order for this to work, your machine must be able to do helical interpolation.

If, after reducing the ramping distance, a ramping location still cannot be found, then a direct plunge may occur. If you observe direct plunges, then you can set **Max ramp distance** to be smaller than the default. So, for example, if your tool is 6 mm in diameter, then the default of **Max ramp distance** is initially 6 mm. If you observe direct plunges at 6mm, then try setting **Max ramp distance** to something smaller, say 3 mm. If a gouge-free ramping location cannot be found at 3 mm, then the **Max ramp distance** is reduced using the same percentages as before, but using an initial value of 3 mm instead of 6 mm. In this way, you have a better chance at getting a successful ramp to depth. The unfortunate trade-off is that by setting **Max ramp distance** to 3 mm, then all of your ramps to depth use this smaller distance.

See also **Max. ramp angle**.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

New Value — To change the value of an attribute in the list, first select it, then enter the new value. Click the Set button to save the new value.

Output Options — Click this button to open the Output Options (see page 1017) dialog.
**Plunge feed override %** — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Post Vars.** — Click this button to open the Post Variables dialog.

The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the Retract and Plunge (see page 1339) dialog.

**Rough pass stepover %** — Enter the distance between plunge holes in the same row, as a percentage of the tool diameter.

**Set** — You must click the Set button to save a New Value for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.
Stepover rapid distance is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance* is similar to *Min rapid distance %*, but *Stepover rapid distance* is a 3D distance and *Min rapid distance %* is a 2D distance.

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing *Stepover rapid distance*.

This image shows how the tool stays on the metal with an increase in *Stepover rapid distance*.

*Target horsepower* (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

*Tolerance* — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.
Higher value tolerance:

![Higher value tolerance diagram]

Lower value tolerance:

![Lower value tolerance diagram]

- The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

- Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

**Unset** — Click this button to return the value of the selected attribute to its default value.

- If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

- Use **Z end** on an earlier operation then follow it with an operation using the **Z start** attribute so you control the toolpaths efficiently.

**Z increment** — Enter the distance the tool moves down in the Z axis with each pass. This is useful if the default step down is leaving excess material on the part. When **Scallop stepover** is enabled, this attribute is not available.
**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

**Milling tab (Parallel finish) (3D LITE)**

The image shows the 5-axis position menu with options for setting various machining parameters.

- **5-axis position** menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:
  - **Standard** — The default orientation.
  - **Alternate** — The alternative orientation to the default.
  - **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

- **Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

- **Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.
Direction — Click this button to open the Cut Direction (see page 1337) dialog.

Holder Collision Clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select Holder collision clipping on the feature's Strategy tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.

- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

Index X coordinate (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

Index Y coordinate (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

Index Z coordinate (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

Orientation angle — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine's Y direction.  
With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — This is the amount of material to leave after a 3D finish pass. If unset, **Leave allowance** defaults to 0. You can enter a negative number (up to - tool radius) to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified.

If unset leave allowance defaults to 0. You can enter a negative number (up to - tool radius) to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Max. angular deviation** — This attribute is available if you select **Tool axis smoothing** on the 5-Axis (see page 1135) tab. This value is the tolerance, in degrees, by which FeatureCAM can adjust the azimuth and elevation angles during tool axis smoothing.
Min. rapid distance % — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

Minimum rapid distance applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.
**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

**Output Options** — Click this button to open the **Output Options** (see page 1017) dialog.

**Plunge feed override %** — Enter the percentage of the **Feed** setting to use during a plunge into the material. For example, if the **Feed** attribute is 2000 MMPM and you set the **Plunge feed override %** to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Post Vars.** — Click this button to open the **Post Variables** dialog.

The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the **Op List** (see page 1553) to drag-and-drop operations to the order you want, the **Priority** is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the **Retract and Plunge** (see page 1339) dialog.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click **Set**.*

**Stepover** — Enter the planar stepover distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature.

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.
**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.*

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.

![Before increasing stepover rapid distance](image1.png)

This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

![After increasing stepover rapid distance](image2.png)

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.
Higher value tolerance:

Lower value tolerance:

*The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.*

*Lower value tolerances may take longer to calculate.*

The **Tolerance** value must be less than the Finish allowance value to avoid gouging.

**Toolpath end** — For X Parallel finishing, enter the Y value for the last toolpath. For Y Parallel finishing, enter the X value for the last toolpath.

**Toolpath start** — For X Parallel finishing, enter the Y value for the first toolpath. For Y Parallel finishing, enter the X value for the first toolpath.

**Unset** — Click this button to return the value of the selected attribute to its default value.

*If you have changed the value of a numeric attribute, its name is prefixed by * in the list.*

**Z end** — Enter the distance along the Z axis below which the operation does not mill.
Use **Z end** on an earlier operation then follow it with an operation using the **Z start** attribute so you control the toolpaths efficiently.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

**Milling tab (2D spiral finish) (3D LITE)**

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the **Five Axis** dialog for the **Preferred orientation of the primary rotary axis** option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the **Finish allowance** value is used. If left blank for a finishing pass, the **Leave allowance** value is used. You can enter a positive or negative value. Set **Check surfaces** on the **Dimensions** (see page 1048) tab.
Check axial allowance — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

Direction — Click this button to open the Cut Direction (see page 1337) dialog.

Holder Collision Clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select Holder collision clipping on the feature’s Strategy tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

Index X coordinate (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

Index Y coordinate (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

Index Z coordinate (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

Orientation angle — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine’s Y direction.
- With an orientation angle of 90, the groove is cut in the machine’s X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a Leave axial allowance, the Leave allowance is applied to radial (XY) material only. If you do not enter a Leave axial allowance, the value for Leave allowance is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with \textbf{Min rapid distance} set to 10\% and the tool retracts and rapids between passes.

\textbf{New Value} — To change the value of an attribute in the list, first select it, then enter the new value. Click the \textbf{Set} button to save the new value.

\textbf{Output Options} — Click this button to open the \textbf{Output Options} (see page 1017) dialog.
**Plunge feed override %** — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Post Vars.** — Click this button to open the Post Variables dialog.

The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the priority is updated automatically.

Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

**Reorder** — Enable this option to create a depth-first strategy. With Reorder off, each Z level is roughed completely before moving to a lower depth.

With Reorder off, each Z level is roughed completely before moving to a lower depth.
With **Reorder** on, paths are created that machine vertical regions as shown below.

![Diagram](image)

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the **Retract and Plunge** (see page 1339) dialog.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Stepover** — Enter the planar stepover distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature.

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.*
You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.

This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

**Toolpath corner %** — This enables raceline smoothing by replacing sharp corners with rounded corners. Smoothing the sharp corners of the toolpaths gives a more constant tool velocity and reduces the tool load. Enter a toolpath radius larger than the tool radius to minimize the percentage of the tool that contacts the part. This enables enough cooling to take place and avoiding sharp increases in tool load as the tool enters the corners.

Effective only during Z-level rough, a non-zero **Toolpath corner %** enables raceline smoothing by replacing sharp corners with rounded corners. Defines the maximum deviation from the sharp corner. The maximum this can be set to is 40% of stepover. This means that if you have a 10 mm stepover the maximum deviation from the sharp to the rounded corner is 4mm.

Using the **Toolpath corner %** produces a toolpath with fewer small arcs which makes the toolpath more suitable for high speed machining. The original profile has the same number of points, but the offset passes have a reduced number of points.
Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Z end — Enter the distance along the Z axis below which the operation does not mill.

Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.

Z start — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

Milling tab (Isoline finish) (3D LITE)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- Standard — The default orientation.
- Alternate — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select Holder collision clipping on the feature's Strategy tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.

- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, Leave allowance defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a Leave axial allowance, the Leave allowance is applied to radial (XY) material only. If you do not enter a Leave axial allowance, the value for Leave allowance is applied to axial and radial material. You can enter a positive or negative value.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.
Index Z coordinate (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

Orientation angle — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine's Y direction. With an orientation angle of 90, the groove is cut in the machine's X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

Max. angular deviation — This attribute is available if you select Tool axis smoothing on the 5-Axis (see page 1135) tab. This value is the tolerance, in degrees, by which FeatureCAM can adjust the azimuth and elevation angles during tool axis smoothing.
**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of **400%**:

![Feature cut with Min. rapid distance set to 400%](image)

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with **Min rapid distance** set to **10%** and the tool retracts and rapids between passes.

![Feature cut with Min rapid distance set to 10%](image)
New Value — To change the value of an attribute in the list, first select it, then enter the new value. Click the Set button to save the new value.

Output Options — Click this button to open the Output Options (see page 1017) dialog.

Plunge feed override % — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

Post Vars. — Click this button to open the Post Variables dialog.

The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

Priority

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

Reset All — Click this button to reset all of the attributes on the tab to their default values.

Retract/Plunge — Click this button to open the Retract and Plunge (see page 1339) dialog.

Set — You must click the Set button to save a New Value for the selected attribute.

If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.

Stepover — Enter the planar stepover distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature.

Stepover rapid distance — This is used to determine whether to feed or rapid between toolpaths.
**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.*

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.

![Toolpaths before increasing Stepover rapid distance](image1.png)

This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

![Tool stays on metal with increase in Stepover rapid distance](image2.png)

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.
Higher value tolerance:

Lower value tolerance:

- The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

- Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Use alternative 5-axis position (see page 261) (5AP) — Select this option to change the default orientation for a 5-axis machine.

Z end — Enter the distance along the Z axis below which the operation does not mill.

Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.

Z start — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
Milling tab (Z-level finish) (3D MX)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Corner correction menu**
Corner correction defines the type of corner correction that you want to apply to all internal corners of a Z-level finish toolpath. The types are available from a pull-down list and three options are available:

**None** - no sharpening or arc fitting is carried out.

**Arc Fitted** - arcs are created and rounded in all internal corners.

The yellow toolpath shows the **Arc Fitted** toolpath and the green toolpath shows the **Normal** toolpath.

Arc fitting is of particular importance when high speed machining, as it eliminates sudden changes in tool direction.

**Corner Radius %**

This defines the radius used if you select **Arc Fitted**. The radius is defined as a proportion of the tool diameter. For a Z finish pass the default value is 5%. So, if you have a tool of diameter 10 mm (radius 5 mm) then the arc radius is 0.5 mm. The **Corner Radius %** can have a value between 0 and 100.

**Corner radius %** — This setting avoids sharp changes in direction by inserting an arc. To enable it, enter a percentage of the tool diameter to use for the arc radius.

Slices in Z-level (both rough and finish) can be arc-fitted to avoid sharp changes in direction. For Z roughing, only the toolpath closest to the part is rounded. **Corner radius %** defines the radius that is inserted in to the toolpaths.
The radius of internal corners is defined as a proportion of the tool diameter. The default value is 5% for a finish pass and 0% for a roughing pass. So if you have a tool of diameter 10 mm then the arc radius is 0.5 mm. The Corner radius % can have a value between 0 and 100.

Arc fitting is of particular importance when high speed machining as it eliminates sudden changes in tool direction.

1 - Normal
2 - Arc fitted

Direction — Click this button to open the Cut Direction (see page 1337) dialog.

Flat srf support — This inserts a final profile pass exactly at the base of a flat pocket.

This example shows previous behavior, with Flat srf support disabled:
With **Flat Srf support** enabled, FeatureCAM adds a final profile pass, (1):

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the **Z index clearance** (see page 1648) value is used for the index retract move. **Z index clearance** is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — **Enter the initial C-axis position of the part in the machine at the start of the operation.**

For example:

- With an orientation angle of 0, the groove is cut in the machine’s Y direction.
- With an orientation angle of 90, the groove is cut in the machine’s X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with **Min rapid distance** set to 10% and the tool retracts and rapids between passes.

**Min Z increment** — Enable **Scallop stepover** to access this attribute. The **Scallop height** attribute specifies the maximum cusp height between neighboring passes. However, if the calculated value is smaller than the **Min. Z increment**, it is set to **Min. Z increment**.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.
Output Options — Click this button to open the Output Options (see page 1017) dialog.

Plunge feed override % — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

Post Vars. — Click this button to open the Post Variables dialog.
The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

Priority
Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

Reorder — Enable this option to create a depth-first strategy. With Reorder off, each Z level is roughed completely before moving to a lower depth.

With Reorder off, each Z level is roughed completely before moving to a lower depth.
With **Reorder** on, paths are created that machine vertical regions as shown below.

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the **Retract and Plunge** (see page 1339) dialog.

**Scallop stepover**

The **Scallop stepover** option is available for certain finish operations. For projection milling methods, it toggles the way that you specify how far the tool moves over between passes. With the **Scallop stepover** option disabled, you specify the **Stepover**. With it enabled, you specify the **Scallop height**.

For Z-level finish operations, it toggles options for you to specify tool movements down in Z. With **Scallop stepover** disabled, you specify the **Z-increment**. With it enabled, you specify the **Scallop height**.

With the **Scallop stepover** option enabled, spacing of the toolpaths is calculated along the surfaces to provide a uniform surface finish.

These images show surfaces cut without using scallop stepover:
These images show the same surfaces cut with scallop stepover:

**Scallop height**

Enter the absolute scallop height between passes. This distance is measured along the surface and represents the maximum cusp height between neighboring passes.

![Diagram showing scallop height](image)

You must select the **Scallop stepover** option, to access the **Scallop height** attribute.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click **Set**.*
Start point(s) — Override the default start point(s) of a toolpath by entering the name of a curve that, when projected, intersects the toolpath at the point you want. You can use a curve with multiple segments to set multiple start points for a toolpath, and alternating segments are used to set the start points.

This example aerospace part has several open and closed areas:

This centerline simulation of a Z-level finish toolpath shows the locations of the default start points:

To move the default start points, first create curves that intersect the toolpath where you want the new start points to be.

In the example, the curves are shown in red:

You must use a single curve per toolpath. You can use the Join constructor to create one curve from multiple curves. To open the Join Curve dialog, select Construct > Curve > From Curve > Join from the menu.
Select the curves and click the Add button to add the curves to the list in the Join Curves dialog, for example:

Select the Show Preview option to preview the joined curves, for example:

If the curves are not listed in the correct order, select the curve you want to move in the list and use the Move item up and Move item down buttons.

You can also reverse a curve’s direction using the Reverse selected curve button.

Enter a Curve name for the joined curve.

Copy the Curve name to the clipboard so that you can paste it into the Start point(s) option.

On the Milling tab for the finishing strategy, select the Start point(s) attribute, enter the name of the curve you created and click the Set button to save it.
Another centerline simulation shows that the start points have moved to the intersections of the joined curve with the toolpath, and the toolpath is more symmetrical:

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

> **Stepover rapid distance** is similar to **Min rapid distance %**, but **Stepover rapid distance** is a 3D distance and **Min rapid distance %** is a 2D distance.

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.
This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:

Lower value tolerance:

*The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.*
Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Z end — Enter the distance along the Z axis below which the operation does not mill.

Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.

Z increment — Enter the distance the tool moves down in the Z axis with each pass. This is useful if the default step down is leaving excess material on the part. When Scallop stepover is enabled, this attribute is not available.

Z start — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

Milling tab (Flowline finish) (3D MX)
5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

Check allowance — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

Check axial allowance — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

Direction — Click this button to open the Cut Direction (see page 1337) dialog.

Holder Collision Clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select Holder collision clipping on the feature's Strategy tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

Index X coordinate (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

Index Y coordinate (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

Index Z coordinate (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.
If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine’s Y direction. With an orientation angle of 90, the groove is cut in the machine’s X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool’s Z-axis is aligned with the setup’s Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, Leave allowance defaults to 0.
**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of **400%**: 

![Diagram](image)

*As the tool moves inward, there are few rapid moves.*

*Instead, the tool is fed between passes.*
This is the same example with **Min rapid distance** set to **10%** and the tool retracts and rapids between passes.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

**Output Options** — Click this button to open the **Output Options** (see page 1017) dialog.

**Plunge feed override %** — Enter the percentage of the **Feed** setting to use during a plunge into the material. For example, if the **Feed** attribute is **2000** MMPM and you set the **Plunge feed override %** to **50**, the resulting feed rate for the initial plunge is **1000** MMPM.

**Post Vars.** — Click this button to open the **Post Variables** dialog.

The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*
**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the Retract and Plunge (see page 1339) dialog.

**Set** — You must click the Set button to save a New Value for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Stepover** — Enter the planar stepover distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature.

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.*

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing Stepover rapid distance.
This image shows how the tool stays on the metal with an increase in Stepover rapid distance.

Target horsepower (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

Tolerance — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:

Lower value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.
Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

**Unset** — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

Use **Z end** on an earlier operation then follow it with an operation using the **Z start** attribute so you control the toolpaths efficiently.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

**Milling tab (Radial finish) (3D MX)**

![Surface Milling Properties - srf_mill](image)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the **Five Axis** dialog for the **Preferred orientation of the primary rotary axis** option.

**Angle end/start** is a numeric attribute for radial operations only.

If **Angle end** is greater than **Angle start**, the tool travels counter-clockwise.

![Diagram 1](image1)

1. **Angle start** = $0^\circ$
2. **Angle end** = $120^\circ$
3. Tool moves counter-clockwise

If **Angle end** is less than **Angle start**, the tool moves clockwise.

![Diagram 2](image2)

1. **Angle end** = $0^\circ$
2. **Angle start** = $120^\circ$
3. Tool travels clockwise

To machine an area counter-clockwise starting at $350^\circ$ and ending at $10^\circ$ you need to think about the values you enter. If you enter an **Angle start** of $350^\circ$ and an **Angle end** of $10^\circ$ then the tool travels clockwise and machines the opposite of what you want. So you must enter an **Angle start** of $350^\circ$ and an **Angle end** of $370^\circ$ to get the result you want.
**Center point** — The center of the radial pattern is calculated automatically unless you set a Center point. This point is projected down onto the surface to become the center of the radial pattern.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select Holder collision clipping on the feature’s Strategy tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.

- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

If you do not enter a coordinate, the **Z index clearance** (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.
For example:

With an orientation angle of 0, the groove is cut in the machine’s Y direction.

With an orientation angle of 90, the groove is cut in the machine’s X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool’s Z-axis is aligned with the setup’s Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.

- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.
**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with **Min rapid distance** set to 10% and the tool retracts and rapids between passes.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

**Output Options** — Click this button to open the **Output Options** (see page 1017) dialog.
**Plunge feed override %** — Enter the percentage of the *Feed* setting to use during a plunge into the material. For example, if the *Feed* attribute is **2000** MMPM and you set the **Plunge feed override %** to **50**, the resulting feed rate for the initial plunge is **1000** MMPM.

**Post Vars.** — Click this button to open the *Post Variables* dialog.

The *Post Variables* dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Radius end/start**

**Radius start** — Enter the radius where you want the toolpath to start and set **Radius end**.

**Radius end** — Enter the radius where you want the toolpath to end and set **Radius start**.

These radii control the dimensions of the pattern and whether the first pass travels inwards or outwards.

*If Radius start > Radius end, the first pass moves inwards*
If \textit{Radius end} > \textit{Radius start}, the first pass moves outwards.

1. \textit{Radius end}
2. \textit{Radius start}
3. First pass travels outwards

\textbf{Retract/Plunge} — Click this button to open the \textbf{Retract and Plunge} (see page 1339) dialog.

\textbf{Set} — You must click the \textbf{Set} button to save a \textbf{New Value} for the selected attribute.

\begin{itemize}
  \item \textit{Target horsepower} (see page 1574) — This is the ideal \textit{horse} power for the specified width/depth of cut and feed rate on the specified stock material type.
  \item \textit{Tolerance} — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.
\end{itemize}

Higher value tolerance:
Lower value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

**Unset** — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
Milling tab (Between 2 curves) finish (3D MX)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.
**Edge tolerance** — Enter the trimming tolerance used to reduce the noise of the toolpath near the start and end curves.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.

- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP [see page 10]) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP [see page 10]) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP [see page 10]) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z** index clearance (see page 1648) **value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine's Y direction.
- With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Max. stepover** — If the automatically generated stepover is too large, you can restrict it by specifying a **Max stepover**.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

Output Options — Click this button to open the Output Options (see page 1017) dialog.

Plunge feed override % — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

Post Vars. — Click this button to open the Post Variables dialog.
The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the **Retract and Plunge** (see page 1339) dialog.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Start point(s)** — Override the default start point(s) of a toolpath by entering the name of a curve that, when projected, intersects the toolpath at the point you want. You can use a curve with multiple segments to set multiple start points for a toolpath, and alternating segments are used to set the start points.

This example aerospace part has several open and closed areas:
This centerline simulation of a Z-level finish toolpath shows the locations of the default start points:

To move the default start points, first create curves that intersect the toolpath where you want the new start points to be. In the example, the curves are shown in red:

You must use a single curve per toolpath. You can use the **Join** constructor to create one curve from multiple curves. To open the **Join Curve** dialog, select **Construct > Curve > From Curve > Join** from the menu.
Select the curves and click the **Add** button to add the curves to the list in the **Join Curves** dialog, for example:

![Join Curves Dialog](image)

Select the **Show Preview** option to preview the joined curves, for example:

![Curves Preview](image)

If the curves are not listed in the correct order, select the curve you want to move in the list and use the **Move item up** and **Move item down** buttons.

You can also reverse a curve's direction using the **Reverse selected curve** button.

Enter a **Curve name** for the joined curve.

> Copy the **Curve name** to the clipboard so that you can paste it into the **Start point(s)** option.

On the **Milling** tab for the finishing strategy, select the **Start point(s)** attribute, enter the name of the curve you created and click the **Set** button to save it.
Another centerline simulation shows that the start points have moved to the intersections of the joined curve with the toolpath, and the toolpath is more symmetrical:

![Image of toolpath simulation](image_url)

**Stepover** — Enter the planar stepover distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature.

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance* is similar to *Min rapid distance %*, but *Stepover rapid distance* is a 3D distance and *Min rapid distance %* is a 2D distance.

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.
This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:

![Higher value tolerance image]

Lower value tolerance:

![Lower value tolerance image]

*The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.*
Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Z end — Enter the distance along the Z axis below which the operation does not mill.

Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.

Z start — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

Milling tab (Horizontal + vertical strategy) (3D MX)

This strategy combines two different toolpath operations, one for finishing shallow portions of the part and one for finishing the steep regions.

An X parallel or spiral toolpath is applied to the shallow regions, and a Z level finishing operation cuts the steep regions.

The attributes available on the Milling tab are different for each operation:
1st (shallow) operation

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.
**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.

- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

> If you do not enter a coordinate, the **Z index clearance** (see page 1648) value is used for the index retract move. **Z index clearance** is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine's Y direction.  
With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of 400%:
As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

Output Options — Click this button to open the Output Options (see page 1017) dialog.

Plunge feed override % — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

Post Vars. — Click this button to open the Post Variables dialog. The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

Priority

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.
Reset All — Click this button to reset all of the attributes on the tab to their default values.

Retract/Plunge — Click this button to open the Retract and Plunge (see page 1339) dialog.

Set — You must click the Set button to save a New Value for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

Stepover — Enter the planar stepover distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature.

Stepover rapid distance — This is used to determine whether to feed or rapid between toolpaths.

Stepover rapid distance is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.*

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing Stepover rapid distance.
This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:

Lower value tolerance:

*The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.*
Lower value tolerances may take longer to calculate.

The **Tolerance** value must be less than the Finish allowance value to avoid gouging.

**Unset** — Click this button to return the value of the selected attribute to its default value.

> If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

> Use **Z end** on an earlier operation then follow it with an operation using the **Z start** attribute so you control the toolpaths efficiently.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

### 2nd (steep) operation

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.

- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Corner correction**

Corner correction defines the type of corner correction that you want to apply to all internal corners of a Z-level finish toolpath. The types are available from a pull-down list and three options are available:

- **None** - no sharpening or arc fitting is carried out.
- **Arc Fitted** - arcs are created and rounded in all internal corners.

The yellow toolpath shows the Arc Fitted toolpath and the green toolpath shows the Normal toolpath.
Arc fitting is of particular importance when high speed machining, as it eliminates sudden changes in tool direction.

1 - Normal
2 - Arc fitted

Corner Radius %

This defines the radius used if you select Arc Fitted. The radius is defined as a proportion of the tool diameter. For a Z finish pass the default value is 5%. So, if you have a tool of diameter 10 mm (radius 5 mm) then the arc radius is 0.5 mm. The Corner Radius% can have a value between 0 and 100.

Corner radius % — This setting avoids sharp changes in direction by inserting an arc. To enable it, enter a percentage of the tool diameter to use for the arc radius.

Slices in Z-level (both rough and finish) can be arc-fitted to avoid sharp changes in direction. For Z roughing, only the toolpath closest to the part is rounded. Corner radius % defines the radius that is inserted in to the toolpaths.

The radius of internal corners is defined as a proportion of the tool diameter. The default value is 5% for a finish pass and 0% for a roughing pass. So if you have a tool of diameter 10 mm then the arc radius is 0.5 mm. The Corner radius % can have a value between 0 and 100.
Arc fitting is of particular importance when high speed machining as it eliminates sudden changes in tool direction.

1 - Normal
2 - Arc fitted

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.

**Flat srf support** — This inserts a final profile pass exactly at the base of a flat pocket.

This example shows previous behavior, with Flat srf support disabled:
With **Flat Srf support** enabled, FeatureCAM adds a final profile pass, ①:

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

<table>
<thead>
<tr>
<th>Orientation angle</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>With an orientation angle of 0, the groove is cut in the machine's Y direction.</td>
</tr>
<tr>
<td>90</td>
<td>With an orientation angle of 90, the groove is cut in the machine's X direction.</td>
</tr>
</tbody>
</table>
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

Min. Z increment

Min Z increment — Enable Scallop stepover to access this attribute. The Scallop height attribute specifies the maximum cusp height between neighboring passes. However, if the calculated value is smaller than the Min. Z increment, it is set to Min. Z increment.
**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the Set button to save the new value.

**Output Options** — Click this button to open the Output Options (see page 1017) dialog.

**Plunge feed override %** — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Post Vars.** — Click this button to open the Post Variables dialog.

The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Reorder** — Enable this option to create a depth-first strategy. With Reorder off, each Z level is roughed completely before moving to a lower depth.
With Reorder off, each Z level is roughed completely before moving to a lower depth.

With Reorder on, paths are created that machine vertical regions as shown below.

Reset All — Click this button to reset all of the attributes on the tab to their default values.

Retract/Plunge — Click this button to open the Retract and Plunge (see page 1339) dialog.

Scallop stepover

The Scallop stepover option is available for certain finish operations. For projection milling methods, it toggles the way that you specify how far the tool moves over between passes. With the Scallop stepover option disabled, you specify the Stepover. With it enabled, you specify the Scallop height.
For Z-level finish operations, it toggles options for you to specify tool movements down in Z. With **Scallop stepover** disabled, you specify the **Z-increment**. With it enabled, you specify the **Scallop height**.

With the **Scallop stepover** option enabled, spacing of the toolpaths is calculated along the surfaces to provide a uniform surface finish.

These images show surfaces cut without using scallop stepover:

These images show the same surfaces cut with scallop stepover:

**Scallop height**

Enter the absolute scallop height between passes. This distance is measured along the surface and represents the maximum cusp height between neighboring passes.
You must select the Scallop stepover option, to access the Scallop height attribute.

**Set** — You must click the Set button to save a New Value for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Start point(s)** — Override the default start point(s) of a toolpath by entering the name of a curve that, when projected, intersects the toolpath at the point you want. You can use a curve with multiple segments to set multiple start points for a toolpath, and alternating segments are used to set the start points.

This example aerospace part has several open and closed areas:

This centerline simulation of a Z-level finish toolpath shows the locations of the default start points:

To move the default start points, first create curves that intersect the toolpath where you want the new start points to be.
In the example, the curves are shown in red:

You must use a single curve per toolpath. You can use the Join constructor to create one curve from multiple curves. To open the Join Curve dialog, select Construct > Curve > From Curve > Join from the menu.

Select the curves and click the Add button to add the curves to the list in the Join Curves dialog, for example:

Select the Show Preview option to preview the joined curves, for example:
If the curves are not listed in the correct order, select the curve you want to move in the list and use the Move item up ↑ and Move item down ↓ buttons.

You can also reverse a curve's direction using the Reverse selected curve ➔ button.

Enter a Curve name for the joined curve.

Copy the Curve name to the clipboard so that you can paste it into the Start point(s) option.

On the Milling tab for the finishing strategy, select the Start point(s) attribute, enter the name of the curve you created and click the Set button to save it.

Another centerline simulation shows that the start points have moved to the intersections of the joined curve with the toolpath, and the toolpath is more symmetrical:

Stepover rapid distance — This is used to determine whether to feed or rapid between toolpaths.

Stepover rapid distance is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.
You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.

This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

- The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.
- Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

**Unset** — Click this button to return the value of the selected attribute to its default value.

- If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

- Use **Z end** on an earlier operation then follow it with an operation using the **Z start** attribute so you control the toolpaths efficiently.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
**Milling tab (Swarf strategy) (3D MX)**

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Axial offset** — This attribute offsets the lowest position of the toolpath along the tool axis. Positive numbers offset the toolpath towards the tool holder, negative numbers away.

This is an example of a swarf with a positive offset:
Axial tolerance — This helps to stabilize the tool axis and reduce tool load.

For a relatively rare number of geometries, the tool axis can waver slightly as it positions accurately on the surfaces to be machined. This can be due to small but significant changes in the geometry as the tool moves from one position to another. This tolerance can be larger than the machining tolerance to stabilize the tool axis as it moves across this geometrically varying region. As a consequence excess material may be left on the surface but the load on the tool may be reduced.

No Axial tolerance set:

Axial tolerance set to 0.5 (mm):

Check allowance — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

Check axial allowance — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

Corner radius % — This setting avoids sharp changes in direction by inserting an arc. To enable it, enter a percentage of the tool diameter to use for the arc radius.
Slices in Z-level (both rough and finish) can be arc-fitted to avoid sharp changes in direction. For Z roughing, only the toolpath closest to the part is rounded. **Corner radius %** defines the radius that is inserted into the toolpaths.

The radius of internal corners is defined as a proportion of the tool diameter. The default value is 5% for a finish pass and 0% for a roughing pass. So if you have a tool of diameter 10 mm then the arc radius is 0.5 mm. The **Corner radius %** can have a value between 0 and 100.

Arc fitting is of particular importance when high speed machining as it eliminates sudden changes in tool direction.

1 - Normal
2 - Arc fitted

**Degouge tolerance** — This is the maximum distance (in addition to **Radial offset**) that is used to push the tool away from the surfaces to avoid gouges.

It defines the upper acceptable bound for this intermediate form of gouge avoidance. If gouges greater than this value are detected then the tool is lifted axially to avoid the gouge.

This value can therefore be used to control the location and amount of material left on non-swarfable surfaces. For example, if material on a surface can mostly be machined by swarf machining, but there is a region where 3 mm of material could be left, then you can either:
- choose a **Radial offset** of 3 mm to leave 3 mm of material on the whole of the surface; or
- set a **Radial offset** of 0 mm and a **Degouge tolerance** of 3 mm. In this case, the surface is completely machined where possible, but some material of up to 3 mm is left on a part of the surface.

*Degouge tolerance remains in effect even if Gouge check is not selected.*

**Direction** — Click this button to open the **Cut Direction** (see page 1337) dialog.

**Fan at ends** — With Swarf milling, the tool aligns itself with the ruling direction of the surface. As the toolpath moves from one surface to another, there can be a change in the ruling direction and therefore the tool axis. This is called *fanning*. With **Fan at ends** enabled, fanning happens only in the end region of a plane. Disable **Fan at ends**, to allow fanning to happen anywhere across the plane.

![Diagram](image)

With **Fan at ends** on, the tool axis changes mainly in region 1 and 3. The tool axis is relatively constant in region 2.

With **Fan at ends** off, the tool axis may change in region 2.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.
Index Y coordinate (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

Index Z coordinate (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

Orientation angle — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine's Y direction. With an orientation angle of 90, the groove is cut in the machine's X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.
**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of 400%:

![Diagram of a feature cut with a value of 400%](image)

*As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.*
This is the same example with **Min rapid distance** set to 10% and the tool retracts and rapids between passes.

**Minimum fanning** — Enter the distance over which the tool can change from one ruling direction to the next.

With Swarf milling, the tool aligns itself with the ruling direction of the surface. As the toolpath moves from one surface to another, there can be a change in the ruling direction and therefore the tool axis. This is called *fanning*.

Enter the minimum distance over which fanning can occur. The fanning distance is measured as the smallest movement on either surface edge (or the distance the closest part of the tool is to the opposite part of the surface before fanning starts). The actual fanning distance may be larger than the **Minimum fanning** value specified, to prevent the toolpath from gouging.

**Multiple Cuts** — This enables multiple passes down the tool axis.
By default, **Multiple cuts** is off and a single toolpath is created:

Enable **Multiple cuts** to have multiple passes down the tool axis and select the **Multicut strategy**.

**Multicut strategy** — To use multiple cuts, first enable the **Multiple cuts** attribute, then select the type of strategy from the **Multicut strategy** list.

**Offset top down** — Select this option to offset the top cutting path, moving downwards.

**Offset bottom up** — Select this option to offset the bottom cutting path, moving upwards.
**Merge** — Select this option to offset the top and bottom cutting path, merging from one to the other.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

**Output Options** — Click this button to open the **Output Options** (see page 1017) dialog.

**Plunge feed override %** — Enter the percentage of the **Feed** setting to use during a plunge into the material. For example, if the **Feed** attribute is 2000 MMPM and you set the **Plunge feed override %** to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Priority**
Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Post Vars.** — Click this button to open the **Post Variables** dialog.
The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.
**Radial offset** — Enter the distance to offset the toolpath in the direction perpendicular to the tool axis. The default is zero.

1. Trim with no radial offset
2. Trim with 5 mm offset

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the *Retract and Plunge* (see page 1339) dialog.

**Set** — You must click the *Set* button to save a *New Value* for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click *Set*.*

**Start point(s)** — Override the default start point(s) of a toolpath by entering the name of a curve that, when projected, intersects the toolpath at the point you want. You can use a curve with multiple segments to set multiple start points for a toolpath, and alternating segments are used to set the start points.

This example aerospace part has several open and closed areas:
This centerline simulation of a Z-level finish toolpath shows the locations of the default start points:

To move the default start points, first create curves that intersect the toolpath where you want the new start points to be. In the example, the curves are shown in red:

You must use a single curve per toolpath. You can use the Join constructor to create one curve from multiple curves. To open the Join Curve dialog, select Construct > Curve > From Curve > Join from the menu.
Select the curves and click the Add button to add the curves to the list in the Join Curves dialog, for example:

![Join Curves dialog](image)

Select the Show Preview option to preview the joined curves, for example:

![Curves preview](image)

If the curves are not listed in the correct order, select the curve you want to move in the list and use the Move item up and Move item down buttons.

You can also reverse a curve's direction using the Reverse selected curve button.

Enter a Curve name for the joined curve.

![Tip: Copy Curve name](image)

*Copy the Curve name to the clipboard so that you can paste it into the Start point(s) option.*

On the Milling tab for the finishing strategy, select the Start point(s) attribute, enter the name of the curve you created and click the Set button to save it.
Another centerline simulation shows that the start points have moved to the intersections of the joined curve with the toolpath, and the toolpath is more symmetrical:

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance* is similar to *Min rapid distance %*, but *Stepover rapid distance* is a 3D distance and *Min rapid distance %* is a 2D distance.

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing *Stepover rapid distance*. 
This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Stock overcut %**

**Overcut %** applies to three types of surface milling features:
- spiral toolpaths designated as a boss on the stock page
- features cut with projection milling technique that do not have an explicit boundary curve
- some Z level rough passes.

In the boss case this attribute applies only to how the toolpaths behave around the stock boundary.

For other 3D surface milling features, use the cut allowance feature described on the **Stock** tab. The **Overcut %** option applies only if **Use stock dimensions** is selected on the feature's **Stock** tab.

**Overcut %** specifies what percentage of the tool approaches or passes beyond the stock boundary.

It can have a value between **-100** and **100** with the following meanings:

0 puts the centerline of the tool on the stock curve.
100 overcuts the region by a tool radius.

-100 stops one tool radius short of the stock curve.

For Z level rough, this attribute applies to all features except Pocket features without stock curves. This attribute controls the outer extend of Boss features and the amount that Pocket feature cuts beyond its boundary. The default value is 100% which puts the edge of the tool on the boundary. A number greater than 100 extends the toolpaths beyond the boundary. A number less than 100 essentially offsets the outer boundary and clips the toolpaths against this closer boundary.

**Surface join tolerance** — Use this setting to enter a separate tolerance to define what represents a gap between surfaces. Sometimes the default tolerance is smaller than the gap between surfaces, and two segments of toolpath are created. To ensure one continuous toolpath across a gap, use a larger **Surface join tolerance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Up/Down smoothing % — Occasionally, the swarf toolpath must move up and down in order to avoid gouging. The smoothing happens within the tolerance you enter here. Enter a percentage of the tool diameter.

The default tolerance is 15%:

A larger smoothing tolerance reduces this 'spike' in the toolpath, but affects more of the toolpath near the area:
**Z end** — Enter the distance along the Z axis below which the operation does not mill.

*Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.*

**Z increment** — Enter the distance the tool moves down in the Z axis with each pass. This is useful if the default step down is leaving excess material on the part. When *Scallop stepover* is enabled, this attribute is not available.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

**Milling tab (4-axis rotary) (3D MX)**

![Image of Surface Milling Properties window](image)

**Angle end/start**
If `Angle end` is greater than `Angle start`, the tool travels counter-clockwise.

1. **Angle start** = $0^\circ$
2. **Angle end** = $120^\circ$
3. Tool moves counter-clockwise

If `Angle end` is less than `Angle start`, the tool moves clockwise.

1. **Angle end** = $0^\circ$
2. **Angle start** = $120^\circ$
3. Tool travels clockwise

To machine an area counter-clockwise starting at $350^\circ$ and ending at $10^\circ$ you need to think about the values you enter. If you enter an **Angle start** of $350^\circ$ and an **Angle end** of $10^\circ$ then the tool travels clockwise and machines the opposite of what you want. So you must enter an **Angle start** of $350^\circ$ and an **Angle end** of $370^\circ$ to get the result you want.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the **Finish allowance** value is used. If left blank for a finishing pass, the **Leave allowance** value is used. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.
**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine's Y direction.
- With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.

- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — This is the amount of material to leave after a 3D finish pass. If unset, **Leave allowance** defaults to 0. You can enter a negative number (up to - tool radius) to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified.

If unset leave allowance defaults to 0. You can enter a negative number (up to - tool radius) to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of **400%**: 

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.
This is the same example with **Min rapid distance** set to 10% and the tool retracts and rapids between passes.

![Diagram](image)

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

**Output Options** — Click this button to open the **Output Options** (see page 1017) dialog.

**Plunge feed override %** — Enter the percentage of the **Feed** setting to use during a plunge into the material. For example, if the **Feed** attribute is 2000 MMPM and you set the **Plunge feed override %** to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Post Vars.** — Click this button to open the **Post Variables** dialog.

The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

- If you use the **Op List** (see page 1553) to drag-and-drop operations to the order you want, the **Priority** is updated automatically.

- Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.
Reset All — Click this button to reset all of the attributes on the tab to their default values.

Retract/Plunge — Click this button to open the Retract and Plunge (see page 1339) dialog.

Set — You must click the Set button to save a New Value for the selected attribute.

- If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.

Stepover rapid distance — This is used to determine whether to feed or rapid between toolpaths.

Stepover rapid distance is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

- Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing Stepover rapid distance.
This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Stock overcut %**

*Overcut %* applies to three types of surface milling features:

- spiral toolpaths designated as a boss on the stock page
- features cut with projection milling technique that do not have an explicit boundary curve
- some Z level rough passes.

In the boss case this attribute applies only to how the toolpaths behave around the stock boundary.

For other 3D surface milling features, use the cut allowance feature described on the **Stock** tab. The Overcut % option applies only if **Use stock dimensions** is selected on the feature's **Stock** tab.

*Overcut %* specifies what percentage of the tool approaches or passes beyond the stock boundary.

It can have a value between **-100** and **100** with the following meanings:

- **0** puts the centerline of the tool on the stock curve.
100 overcuts the region by a tool radius.

-100 stops one tool radius short of the stock curve.

For Z level rough, this attribute applies to all features except Pocket features without stock curves. This attribute controls the outer extend of Boss features and the amount that Pocket feature cuts beyond its boundary. The default value is 100% which puts the edge of the tool on the boundary. A number greater than 100 extends the toolpaths beyond the boundary. A number less than 100 essentially offsets the outer boundary and clips the toolpaths against this closer boundary.

Target horsepower (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

Tolerance — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Unmount — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Milling tab (Plunge rough) (3D HSM)
5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.

**Finish allowance** — Enter the amount of material to leave on a feature after the Rough pass. You can enter a positive or negative value.

**Finish axial allowance** — Enter the amount of axial (XY) material to leave on a feature after the Rough pass. If you enter a value for Finish axial allowance, the value for Finish allowance is applied to radial (Z) material. If you leave Finish axial allowance blank, the value for Finish allowance is applied to axial and radial material. You can enter a positive or negative value.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select Holder collision clipping on the feature’s Strategy tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.
**Improved** — Enable this option to calculate the true highest Z value where the tool touches the surface. If disabled, the surface is tessellated into a series of approximating triangles and the highest Z value where the tool touches the triangular plane is used. **Improved** is more accurate, but may be slower to calculate.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine's Y direction.
- With an orientation angle of 90, the groove is cut in the machine's X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:
- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the **5 Axis Fixture Location** dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of **400%**:

![Diagram](image)

*As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.*
This is the same example with **Min rapid distance** set to **10%** and the tool retracts and rapids between passes.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

**Next row stepover %** — Enter the distance between rows of a plunge roughing operation, as a percentage of the tool diameter.

**Plunge feed override %** — Enter the percentage of the **Feed** setting to use during a plunge into the material. For example, if the **Feed** attribute is **2000** MMPM and you set the **Plunge feed override %** to **50**, the resulting feed rate for the initial plunge is **1000** MMPM.

**Post Vars.** — Click this button to open the **Post Variables** dialog.

The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**
Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the Retract and Plunge (see page 1339) dialog.

**Rough pass stepover %** — Enter the distance between plunge holes in the same row, as a percentage of the tool diameter.

**Set** — You must click the Set button to save a New Value for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

**Stepover rapid distance** is similar to **Min rapid distance %**, but **Stepover rapid distance** is a 3D distance and **Min rapid distance %** is a 2D distance.
You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.

![Image showing toolpaths before increasing Stepover rapid distance](image1.png)

This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

![Image showing how the tool stays on the metal with an increase in Stepover rapid distance](image2.png)

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

**Toolpath end/start**

**Toolpath end** — For X Parallel finishing, enter the Y value for the last toolpath. For Y Parallel finishing, enter the X value for the last toolpath.

**Toolpath start** — For X Parallel finishing, enter the Y value for the first toolpath. For Y Parallel finishing, enter the X value for the first toolpath.

These attributes are available only for parallel finish operations.

**Unset** — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

Use **Z end** on an earlier operation then follow it with an operation using the **Z start** attribute so you control the toolpaths efficiently.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
Milling tab (3D spiral finish) (3D HSM)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

Check allowance — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

Check axial allowance — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

Direction — Click this button to open the Cut Direction (see page 1337) dialog.
**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

> *If you do not enter a coordinate, the Z index clearance* (see page 1648) *value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

> **Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine's Y direction.
- With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, Leave allowance defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a Leave axial allowance, the Leave allowance is applied to radial (XY) material only. If you do not enter a Leave axial allowance, the value for Leave allowance is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

Minimum rapid distance applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of 400%:
As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the Set button to save the new value.

**Output Options** — Click this button to open the Output Options (see page 1017) dialog.

**Plunge feed override %** — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Post Vars.** — Click this button to open the Post Variables dialog.

The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.
Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the Retract and Plunge (see page 1339) dialog.

**Set** — You must click the Set button to save a New Value for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Start point(s)** — Override the default start point(s) of a toolpath by entering the name of a curve that, when projected, intersects the toolpath at the point you want. You can use a curve with multiple segments to set multiple start points for a toolpath, and alternating segments are used to set the start points.

This example aerospace part has several open and closed areas:

This centerline simulation of a Z-level finish toolpath shows the locations of the default start points:

To move the default start points, first create curves that intersect the toolpath where you want the new start points to be.
In the example, the curves are shown in red:

You must use a single curve per toolpath. You can use the Join constructor to create one curve from multiple curves. To open the Join Curve dialog, select Construct > Curve > From Curve > Join from the menu.

Select the curves and click the Add button to add the curves to the list in the Join Curves dialog, for example:

Select the Show Preview option to preview the joined curves, for example:
If the curves are not listed in the correct order, select the curve you want to move in the list and use the Move item up and Move item down buttons.

You can also reverse a curve's direction using the Reverse selected curve button.

Enter a Curve name for the joined curve.

Copy the Curve name to the clipboard so that you can paste it into the Start point(s) option.

On the Milling tab for the finishing strategy, select the Start point(s) attribute, enter the name of the curve you created and click the Set button to save it.

Another centerline simulation shows that the start points have moved to the intersections of the joined curve with the toolpath, and the toolpath is more symmetrical:

![Diagram showing the result of adjusting curves]

**Stepover** — Enter the planar stepover distance between toolpath center lines. This distance is measured in the XY plane and then the toolpaths are projected onto the surfaces of your feature.

**Stepover rapid distance** — This is used to determine whether to feed or rapid between toolpaths.

**Stepover rapid distance** is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

*Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.*
You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing **Stepover rapid distance**.

This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Z end — Enter the distance along the Z axis below which the operation does not mill.

Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.

Z start — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
Milling tab (Corner remachine strategy) (3D HSM)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set **Check surfaces** on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.
**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature's **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

—if you do not enter a coordinate, the **Z index clearance** (see page 1648) value is used for the index retract move. **Z index clearance** is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine's Y direction. With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool’s Z-axis is aligned with the setup’s Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the **Alternative 5-axis position** (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the **Use Origin of this Setup as the Touch-off Point** option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of 400%:
As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with **Min rapid distance** set to 10% and the tool retracts and rapids between passes.

New Value — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

Output Options — Click this button to open the **Output Options** (see page 1017) dialog.

Plunge feed override % — Enter the percentage of the **Feed** setting to use during a plunge into the material. For example, if the **Feed** attribute is 2000 MMPM and you set the **Plunge feed override %** to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

Post Vars. — Click this button to open the **Post Variables** dialog. The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

Priority

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the **Op List** (see page 1553) to drag-and-drop operations to the order you want, the **Priority** is updated automatically.
Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the **Retract and Plunge** (see page 1339) dialog.

**Set** — You must click the **Set** button to save a **New Value** for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click **Set**.*

### Scallop height

Enter the absolute scallop height between passes. This distance is measured along the surface and represents the maximum cusp height between neighboring passes.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This sets how close milling is to the mathematically ideal surface.

This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

**Unset** — Click this button to return the value of the selected attribute to its default value.

*If you have changed the value of a numeric attribute, its name is prefixed by * in the list.*

**Use alternative 5-axis position** (see page 261) (5AP) — Select this option to change the default orientation for a 5-axis machine.

**Z end** — Enter the distance along the Z axis below which the operation does not mill.
Use **Z end** on an earlier operation then follow it with an operation using the **Z start** attribute so you control the toolpaths efficiently.

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.

**Milling tab (Pencil strategy) (3D HSM)**

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (**Positive** or **Negative**) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the **Finish allowance** value is used. If left blank for a finishing pass, the **Leave allowance** value is used. You can enter a positive or negative value. Set **Check surfaces** on the Dimensions (see page 1048) tab.
Check axial allowance — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

Direction — Click this button to open the Cut Direction (see page 1337) dialog.

Holder Collision Clipping — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select Holder collision clipping on the feature’s Strategy tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.

- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

Index X coordinate (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

Index Y coordinate (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

Index Z coordinate (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

Orientation angle — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

With an orientation angle of 0, the groove is cut in the machine’s Y direction. With an orientation angle of 90, the groove is cut in the machine’s X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with **Min rapid distance** set to 10% and the tool retracts and rapids between passes.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the Set button to save the new value.

**Output Options** — Click this button to open the **Output Options** (see page 1017) dialog.
**Plunge feed override %** — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

**Post Vars.** — Click this button to open the Post Variables dialog. The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Reset All** — Click this button to reset all of the attributes on the tab to their default values.

**Retract/Plunge** — Click this button to open the Retract and Plunge (see page 1339) dialog.

**Set** — You must click the Set button to save a New Value for the selected attribute.

*If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.*

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.
Higher value tolerance:

The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.

Lower value tolerances may take longer to calculate.

The Tolerance value must be less than the Finish allowance value to avoid gouging.

Unset — Click this button to return the value of the selected attribute to its default value.

If you have changed the value of a numeric attribute, its name is prefixed by * in the list.

Use alternative 5-axis position (see page 261) (5AP) — Select this option to change the default orientation for a 5-axis machine.

Z end — Enter the distance along the Z axis below which the operation does not mill.

Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.

Z start — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
Milling tab (Steep and shallow) (3D HSM)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set Check surfaces on the Dimensions (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for Check axial allowance, the value for Check allowance is applied to radial (Z) check surfaces only. If you leave Check axial allowance blank, the value for Check allowance is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the Cut Direction (see page 1337) dialog.
**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select [Holder collision clipping](#) on the feature's [Strategy](#) tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

*If you do not enter a coordinate, the [Z index clearance](#) (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — Enter the initial C-axis position of the part in the machine at the start of the operation.

For example:

- With an orientation angle of 0, the groove is cut in the machine's Y direction.
- With an orientation angle of 90, the groove is cut in the machine's X direction.
This option only applies if the machine tool starts at the singularity (where the machine tool’s Z-axis is aligned with the setup’s Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, **Leave allowance** defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a **Leave axial allowance**, the **Leave allowance** is applied to radial (XY) material only. If you do not enter a **Leave axial allowance**, the value for **Leave allowance** is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.

This example shows a feature cut with a value of 400%:
As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

Min Z increment — Enable Scallop stepover to access this attribute. The Scallop height attribute specifies the maximum cusp height between neighboring passes. However, if the calculated value is smaller than the Min. Z increment, it is set to Min. Z increment.

Output Options — Click this button to open the Output Options (see page 1017) dialog.

Plunge feed override % — Enter the percentage of the Feed setting to use during a plunge into the material. For example, if the Feed attribute is 2000 MMPM and you set the Plunge feed override % to 50, the resulting feed rate for the initial plunge is 1000 MMPM.

Post Vars. — Click this button to open the Post Variables dialog.

The Post Variables dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.

Priority

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.
Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

Retract/Plunge — Click this button to open the Retract and Plunge (see page 1339) dialog.

Scallop stepover

The Scallop stepover option is available for certain finish operations. For projection milling methods, it toggles the way that you specify how far the tool moves over between passes. With the Scallop stepover option disabled, you specify the Stepover. With it enabled, you specify the Scallop height.

For Z-level finish operations, it toggles options for you to specify tool movements down in Z. With Scallop stepover disabled, you specify the Z-increment. With it enabled, you specify the Scallop height.

With the Scallop stepover option enabled, spacing of the toolpaths is calculated along the surfaces to provide a uniform surface finish.

These images show surfaces cut without using scallop stepover:

These images show the same surfaces cut with scallop stepover:
Scallop height
Enter the absolute scallop height between passes. This distance is measured along the surface and represents the maximum cusp height between neighboring passes.

You must select the Scallop stepover option, to access the Scallop height attribute.

Set — You must click the Set button to save a New Value for the selected attribute.

If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.

Shallow stepover — Enter the distance between successive machining passes. This is for the shallow portions of the toolpath.

Steep stepover — Enter the distance between successive machining passes. This is for the steep portions of the toolpath.

If you have enabled Scallop stepover, this attribute is replaced by Scallop height.

Target horsepower (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

Tolerance — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

*The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.*

*Lower value tolerances may take longer to calculate.*

The **Tolerance** value must be less than the Finish allowance value to avoid gouging.

**Unset** — Click this button to return the value of the selected attribute to its default value.

*If you have changed the value of a numeric attribute, its name is prefixed by * in the list.*

**Z end** — Enter the distance along the Z axis below which the operation does not mill.

*Use Z end on an earlier operation then follow it with an operation using the Z start attribute so you control the toolpaths efficiently.*

**Z start** — Enter the distance along the Z axis where the milling operation starts. You can use this to save time if the stock material has already been machined away in an earlier operation.
Milling tab (5-axis trim) (5AS)

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

Axial offset — This attribute offsets the lowest position of the toolpath along the tool axis. Positive numbers offset the toolpath towards the tool holder, negative numbers away.

This is an example of a swarf with a positive offset:
**Check allowance** — Enter the minimum distance that you want to leave around check surface(s). If left blank for a roughing pass, the Finish allowance value is used. If left blank for a finishing pass, the Leave allowance value is used. You can enter a positive or negative value. Set **Check surfaces** on the **Dimensions** (see page 1048) tab.

**Check axial allowance** — Enter the amount of axial (XY) material to leave on a check surface. If you enter a value for **Check axial allowance**, the value for **Check allowance** is applied to radial (Z) check surfaces only. If you leave **Check axial allowance** blank, the value for **Check allowance** is applied to axial and radial check surfaces. You can enter a positive or negative value.

**Direction** — Click this button to open the **Cut Direction** (see page 1337) dialog.

**Holder Collision Clipping** — Clips the toolpath where the holder or shank collides with a part surface, check surface or unmachined stock. Select **Holder collision clipping** on the feature’s **Strategy** tab to enable it. When enabled, these options are displayed:

- **Holder clearance** — Enter the clearance distance for the tool holder. The toolpath is clipped where the tool holder moves within this distance of a part surface or check surface.
- **Shank clearance** — Enter the clearance distance for the tool shank. The toolpath is clipped where the shank moves within this distance of a part surface or check surface.

**Index X coordinate** (5AP (see page 10)) — Optionally enter the absolute X coordinate to use for the index retract move.

**Index Y coordinate** (5AP (see page 10)) — Optionally enter the absolute Y coordinate to use for the index retract move.

**Index Z coordinate** (5AP (see page 10)) — Optionally enter the absolute Z coordinate to use for the index retract move.

> *If you do not enter a coordinate, the Z index clearance (see page 1648) value is used for the index retract move. Z index clearance is a clearance distance above the stock bounding cylinder. This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape.*

**Orientation angle** — *Enter the initial C-axis position of the part in the machine at the start of the operation.*

For example:
With an orientation angle of 0, the groove is cut in the machine's Y direction. With an orientation angle of 90, the groove is cut in the machine's X direction.

This option only applies if the machine tool starts at the singularity (where the machine tool's Z-axis is aligned with the setup's Z-axis). If the machine tool is not at the singularity, you can specify the C-axis orientation using these methods:

- Use the Alternative 5-axis position (see page 261) option to specify a C-axis orientation of either 0 or 180 degrees.
- Use the Use Origin of this Setup as the Touch-off Point option in the 5 Axis Fixture Location dialog. This method applies the C-axis orientation to all setups in the part, instead of to individual operations.

**Leave allowance** — Enter the amount of material to leave after a finish pass. You can enter a positive or negative value. You can enter a negative number, up to minus the tool radius, to allow for shrinkage or spark gaps, and the part is machined into the part surfaces by the negative amount specified. If unset, Leave allowance defaults to 0.

**Leave axial allowance** — Enter the amount of axial (Z) material to leave on a feature after the Finish pass. If you enter a Leave axial allowance, the Leave allowance is applied to radial (XY) material only. If you do not enter a Leave axial allowance, the value for Leave allowance is applied to axial and radial material. You can enter a positive or negative value.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

Multiple Cuts — This enables multiple passes down the tool axis.
By default, **Multiple cuts** is off and a single toolpath is created:

Enable **Multiple cuts** to have multiple passes down the tool axis and select the **Multicut strategy**.

**New Value** — To change the value of an attribute in the list, first select it, then enter the new value. Click the **Set** button to save the new value.

**Output Options** — Click this button to open the **Output Options** (see page 1017) dialog.

**Priority**
Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the **Op List** (see page 1553) to drag-and-drop operations to the order you want, the **Priority** is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Post Vars.** — Click this button to open the **Post Variables** dialog.

The **Post Variables** dialog contains nine separate variables that are passed directly to the post processor. You can use these variables to pass strings directly to the post processor.
Radial offset — Enter the distance to offset the toolpath in the direction perpendicular to the tool axis. The default is zero.

1 Trim with no radial offset
2 Trim with 5 mm offset

Reset All — Click this button to reset all of the attributes on the tab to their default values.

Retract/Plunge — Click this button to open the Retract and Plunge (see page 1339) dialog.

Start point(s) — Override the default start point(s) of a toolpath by entering the name of a curve that, when projected, intersects the toolpath at the point you want. You can use a curve with multiple segments to set multiple start points for a toolpath, and alternating segments are used to set the start points.

This example uses a 5-axis swarf and two 5-axis trim strategies.
Viewing a centerline simulation from the top, you can see that the default start point for the 5-axis swarf operation is at the lower right of the part.

The default start point for the upper trim operation is at the lower left:

And the default start point for the lower trim operation is at the lower right:

To override the default start points, you must create a curve that intersects the toolpaths at the locations of the new start points. In this example, the curve is shown in blue:

On the **Milling** tab for each strategy, select the **Start point(s)** attribute, enter the name of the curve you created and click the **Set** button to save it.
A centerline simulation of all three operations shows that the start points are now aligned along the curve:

Set — You must click the Set button to save a New Value for the selected attribute.

If you change the value of a numeric attribute, the attribute name is prefixed with a * in the attribute list after you click Set.

Stepover rapid distance — This is used to determine whether to feed or rapid between toolpaths.

Stepover rapid distance is the maximum 3D length of a non-cutting move at which a feed move is used, above this length a rapid move is used. This applies to the different cuts within an operation, even across multiple surfaces, but does not affect the moves between operations. If you do not set this attribute, the default stepover threshold is set to the tool radius.

Stepover rapid distance is similar to Min rapid distance %, but Stepover rapid distance is a 3D distance and Min rapid distance % is a 2D distance.

You can use this attribute to prevent stepovers from climbing up or down a big wall. This image shows toolpaths before increasing Stepover rapid distance.
This image shows how the tool stays on the metal with an increase in **Stepover rapid distance**.

**Stock overcut %**

**Overcut %** applies to three types of surface milling features:
- spiral toolpaths designated as a boss on the stock page
- features cut with projection milling technique that do not have an explicit boundary curve
- some Z level rough passes.

In the boss case this attribute applies only to how the toolpaths behave around the stock boundary.

For other 3D surface milling features, use the cut allowance feature described on the **Stock** tab. The **Overcut %** option applies only if **Use stock dimensions** is selected on the feature's **Stock** tab.

**Overcut %** specifies what percentage of the tool approaches or passes beyond the stock boundary.

It can have a value between **-100** and **100** with the following meanings:
- **0** puts the centerline of the tool on the stock curve.
100 overcuts the region by a tool radius.

-100 stops one tool radius short of the stock curve.

For Z level rough, this attribute applies to all features except Pocket features without stock curves. This attribute controls the outer extend of Boss features and the amount that Pocket feature cuts beyond its boundary. The default value is 100% which puts the edge of the tool on the boundary. A number greater than 100 extends the toolpaths beyond the boundary. A number less than 100 essentially offsets the outer boundary and clips the toolpaths against this closer boundary.

**Surface join tolerance**

Use this setting to enter a separate tolerance to define what represents a gap between surfaces. Sometimes the default tolerance is smaller than the gap between surfaces, and two segments of toolpath are created. To ensure one continuous toolpath across a gap, use a larger **Surface join tolerance**.

**Target horsepower** (see page 1574) — This is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type.

**Tolerance** — This attribute controls how accurately the toolpath follows the surface. If your part appears faceted, set the tolerance to a lower value.

Higher value tolerance:
Lower value tolerance:

*The tool you select may be incapable of cutting to within the specified tolerance in constrained areas.*

*Lower value tolerances may take longer to calculate.*

The **Tolerance** value must be less than the Finish allowance value to avoid gouging.

**Unset** — Click this button to return the value of the selected attribute to its default value.

*If you have changed the value of a numeric attribute, its name is prefixed by * in the list.*

**Cut Direction dialog (3D LITE)**

Use the **Cut Direction** dialog to control the direction the tool cuts when machining surface milling features. Different options are available for different toolpath techniques.

To display the **Cut Direction** dialog, click the **Direction** button in the **Milling** tab of a surface milling feature.
Style Options

- **Unidirectional** — Toolpaths go in one direction. For Z-level toolpaths, the conventional/climb mill parameters control the direction. For other toolpaths, the decreasing/increasing controls the direction.

- **Bidirectional** — If active, the decreasing or increasing parameters control the initial cut’s direction.

- **Uphill only** — Breaks toolpaths up into segments that increase in Z. If this option is selected all direction parameters are dimmed because **Uphill only** fully determines the cut direction.

- **Downhill only** — Breaks toolpaths up into segments that decrease in Z. If this option is selected all direction parameters are dimmed because **Downhill only** fully determines the cut direction.

Direction

- **Conventional** — Applies only to Z level with **Unidirectional**. The tool rotates against the direction of the cut.

- **Climb mill** — Applies only to Z level with **Unidirectional**. If **Climb mill** is set the tool rotates in the direction of the cut.

- **Decreasing** — Forces the cut to decrease in its principal direction. For X-parallel operations, the tool starts at the maximum X value and cut in the negative direction.

- **Increasing** — Forces the cut to increase in its principal direction. For X-parallel operations, the tool starts at the minimum X value (or Y value for Y-parallel) and cut in the positive direction.

If **Unidirectional** is set, the **Increase** and **Decrease** options only affects the direction of the initial cut. For spiral milling use **Decrease/Increase** to toggle the clockwise/counter-clockwise nature of the paths. For pencil milling **Decreasing/Increasing** options toggle the direction of cut. For radial milling, use **Decrease/Increase** to toggle the clockwise and counter-clockwise ordering of each radial pass around the center. For parallel milling set **Parallel angle** to 180 to cut from the opposite end of the part.

Start corner

Choose the starting point for the parallel pass from among **lower left, lower right, upper left, lower right**. These terms are relative to a top view of the part.
Retract and Plunge dialog (3D LITE)

To display the Retract and Plunge dialog, click the Retract/Plunge button in the Milling tab of a surface milling feature.

Z rapid plane — Enter the minimum safe distance in Z above your part.

Before performing a rapid move away from a feature, the tool retracts to the Z rapid plane setting for that feature. The rapid move to the next feature changes in Z height, that is, changes Z coordinates, if the next feature has a different Z rapid plane setting. So that when it arrives at the next feature it is at the Z rapid plane for that next feature.

This value is relative to the top of your stock in the current user coordinate system. Compare with Plunge clearance.

Plunge clearance

Plunge clearance is the distance above a feature at which the tool starts to feed. In the case of deep hole drilling, the drill retracts to this distance between pecks. Compare with Z Rapid Plane.

Relative plunge

The Relative plunge attribute in 3D machining affects how the Plunge clearance attribute is used.
When **Relative plunge** is deselected, the tool plunges to the **Plunge clearance** as an absolute value. This can cause the tool to feed an unnecessary amount for parts that are not flat. For example, in this uphill only surface toolpath the tool rapid to a set Z value and then feeds to the part on each end:

![Diagram of toolpath with relative plunge deselected](image1)

When **Relative plunge** is selected, **Plunge clearance** is used as a relative distance from the surface. For example, here the tool plunges down closer to the part.

![Diagram of toolpath with relative plunge selected](image2)

**Retract options**

**Retract to Z rapid plane** is the default retract type. The tool retracts to the full Z height:

![Diagram of retract to Z rapid plane](image3)
**Relative retract** - When you retract and rapid to a new position, using the **Relative retract** option, the tool only retracts as high as it needs to go plus the **Clearance** amount that you enter, for example:

*Relative retract is known as Skim in PowerMILL.*

**Retract to plunge clearance** can save time on milling features by retracting a lower Z clearance after cutting:
Leads tab (3D Lite)

You can use the Leads tab of the Surface Milling Properties dialog (see page 1045) to control how the tool moves on and off the 3D surface milling feature (lead in/out) and how the tool moves between toolpaths (stepovers).

There are slightly different options on the Leads tab for Z-level rough operation (see page 1348).

Stepover type controls the moves between toolpaths.

The options available to you depend on the operation type. The Stepover type controls the type of transition move that is inserted between toolpaths. The options are:
- **Direct**: The tool moves straight over to the next position. The tool can move in all 3 axes. This figure shows a direct stepover move on a flat surface feature.

- **Arc**: For Z-roughing only, the tool attempts to connect to the next position with an arc. (If that is not possible, an arc and several tangential lines are used). For Z-roughing, only Direct and Arc apply.

- **Stair step**: The tool moves up in Z and then over in X and Y. This image shows a Stair step transition move on a spherical surface.

This image shows the same surface feature using a Direct stepover.
Loop: The tool makes an arc move out of one toolpath and an arc move into the next toolpath. These transitions are actually programmed from linear moves and may move all three axes. This image shows a loop move on a flat surface feature.

Ramping

If Ramp to Depth is deselected, the tool plunges to depth. If Ramp to Depth is selected and Helical is not selected, the tool zigzags into the material. The angle of the zigzag passes is controlled by Ramp angle. If Helical is selected, the tool spirals into the material.

Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.

Lead Moves

Use lead in/out controls when lead in/out moves are applied. The Use lead in/out menu controls when lead moves will be applied. The options are:

- Never: Do not use lead moves on this operation.
- On all plunges/retract: Apply the leads on all plunge and retract moves for this operation.
- **On first plunge/last retract**: Apply on the first plunge and last retract move only for this operation.
- **On all stepovers, plunges and retracts**: Apply the leads on all stepovers, plunge and retract moves for this operation.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Surface Leadin** (see page 1672) tab.

The **Lead in/out plane** controls how the arcs and ramps are measured.

The arcs and ramps are measured relative to one of the following options:

- **Normal to surface**: Lead in/out moves are relative to the surface normal.
- **Horizontal**: Moves are relative to a horizontal plane. Directions of the ramp could be right or left.
- **Horizontal left**: This setting is most useful for uni-directional paths. It ensures a consistent left ramping.
**Horizontal right:** This setting is most useful for uni-directional paths. It ensures a consistent right ramping.

**Vertical:** Moves are relative to a vertical plane.

**Default:** The default for z-level finish is **Horizontal**, and **Vertical** for all others.

Lead moves are performed either as arcs or linear moves by selecting one of the following categories:

**Use arc ramp-in/out**

If you select **Use arc ramp in/out**, the following parameters are used to control the ramping on and off the part feature:

1. **Ramp-in angle** - The angle of the ramp in move.
2. **Ramp diameter** - The diameter of the ramp move.
3. **Ramp-out angle** - The angle of the ramp out move.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Surface Leadin** (see page 1672) tab.
Use linear lead-in/out

If you select **Use linear lead-in/out**, the following parameters control the move off the feature:

- **Lead-in angle** - Angle measured away from the toolpath for the lead-in move. Note this angle can be negative.
- **Lead-out angle** - Angle measured away from the toolpath for the lead-out move. This angle can be negative.
- **Lead-in length** - Length of the linear lead-in length.
- **Lead-out length** - Length of the linear lead-out length.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Surface Leadin** (see page 1672) tab.
Leads tab (Z-level rough) (3D Lite)

The Leads tab controls how the tool moves on and off the surface milling feature (lead in/out) and how the tool moves between toolpaths (stepovers).

The moves between toolpaths are controlled by the Stepover type.

*The options available to you depend on the operation type.*

The Stepover type controls the type of transition move that is inserted between toolpaths. The options are:

- **Direct**: The tool moves straight over to the next position. The tool can move in all 3 axes. This figure shows a direct stepover move on a flat surface feature.
- **Arc**: For Z-roughing only, the tool attempts to connect to the next position with an arc. (If that is not possible, an arc and several tangential lines are used). For Z-roughing, only **Direct** and **Arc** apply.

- **Stair step**: The tool moves up in Z and then over in X and Y. This image shows a **Stair step** transition move on a spherical surface.

- **Loop**: The tool makes an arc move out of one toolpath and an arc move into the next toolpath. These transitions are actually programmed from linear moves and may move all three axes. This image shows a loop move on a flat surface feature.
Ramping

There are three choices for the Z-roughing ramp style: Plunge To Depth, Ramp To Depth, or Plunge To A Pre-drill Location.

If Ramp To Depth is deselected, the tool plunges to depth. If Ramp To Depth is selected and Helical is deselected, the tool zigzags into the material. The angle of the zigzag passes is controlled by Ramp angle. If Helical is selected, the tool spirals into the material. See Helical ramping for more information.

Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.

Selecting Plunge To Pre-drill Location(s) creates a pre-drill operation(s) in the feature if appropriate (there may only be one pre-drill operation per feature). You must set the Pre-drill Diameter which attempts to select a drill of that particular diameter. Be advised to select a drill smaller than (or equal to) the diameter of the tool used for the Z-roughing. (A bigger tool may gouge). FeatureCAM automatically calculates (perhaps multiple) pre-drill locations based upon the regions where it needs to plunge interior to the stock boundary.

If Approach Outside Where Possible is selected, the approach moves include a small horizontal move so the tool plunges off the stock.
Turning feature attributes (TURN)

The turning feature tab view lists the different operations for the feature:

1. Tree view
2. Tabs

The tabs displayed in the dialog change depending on the level in the tree view you have selected.

**Feature-level tabs**
Select the feature name at the top level of the tree view to access these tabs:
- Dimensions (see page 1352)
- Strategy (see page 1366)
- Misc (see page 1400)

**Operation-level tabs**
Select an operation in the tree view to access the following tabs:
- Tools (see page 1401)
- Tool Usage (see page 1404)
- Feed/Speed (see page 1404)
• **B-Axis** (see page 1412)
• Coolant (see page 985)
• **Turning** (see page 1420)/**Boring** (see page 1446)/**Threading** (see page 1459)/**Cutoff** (see page 1464) depending on the feature

**Dimensions tab (TURN)**

The **Dimensions** tab of the **Turning Feature Properties** (see page 1351) dialog is different for each turning feature type. Most of the attributes on the **Dimensions** tab are the same as on the **New Feature - Dimensions** page of the **New Feature** (see page 530) wizard, however there are some additional advanced attributes:

- **Groove** (see page 1352)
- **Thread** (see page 1355)
- **Face** (see page 1356)
- **Cutoff** (see page 1357)
- **Bar Feed/Bar Pull** (see page 1357)
- **Turn** (see page 1359)
- **Bore** (see page 1360)
- **Part Handling** (see page 1361)

**Stock Curve** button — You can limit the extent of the roughing by using a stock curve. Click the **Stock Curve** button and select or pick a curve in the **Select Stock Curve** dialog. This is useful if you are working from a casting, for example.

**Dimensions tab (Groove)**

Use the **Dimensions** tab to edit the dimensions of a Groove feature. Select a **Type**, the options in the dialog are different depending what you select:
- **From dimensions** — Enter the dimensions of the Groove.

Location — Select **ID** for an inside diameter Groove or **OD** for an outside diameter Groove.

Orientation — Select the orientation of the Groove feature from **X axis**, **Face**, or **Backface**.

Diameter — Enter the diameter of the Groove feature.

Depth — Enter the depth of the Groove feature.

Width — Enter the width of the Groove feature.

Chamfer/Radius — Optionally add a chamfer or a radius to the top of the Groove at each side. Select **Chamfer** or **Radius** from the menu and enter the value.

Angle — Optionally enter an angle for each side wall of the Groove.

Radius — Optionally set a bottom radius for the feature. The radius corresponds to the shape of the cutter. By default, the material is milled using a flat-bottomed mill, making stair-step passes when close to the radius. Then a rough and finishing pass is made with the radiused mill. The default value is 0, which cuts a square corner. You can have a different bottom radius for each side of the Groove.
- **From curve** — Select a curve from which to create the Groove.

Location — Select **ID** for an inside diameter Groove or **OD** for an outside diameter Groove.

Orientation — Select the orientation of the Groove feature from **X axis**, **Face**, or **Backface**.

- **Simple groove** — Create a Groove with simple geometry and only one operation.

This option simplifies the manufacturing strategy for the feature. Select this option to machine the feature by making a single pass down the center of it with a tool whose radius is equal to the width of the feature.

Location — Select **ID** for an inside diameter Groove or **OD** for an outside diameter Groove.

Orientation — Select the orientation of the Groove feature from **X axis**, **Face**, or **Backface**.

Enter the Diameter, Depth and Width of the Groove.
Dimensions tab (Thread)

Use the Dimensions tab to edit the dimensions of a Thread feature.

**Type** — Select **ID** for an inner diameter thread or **OD** for an outer diameter thread, or select **Curve** to create the Thread from a curve.

**Custom** — Enter the thread dimensions.

**Standard Thread** — Select a thread from the list to use its dimensions.

**Thread** — Select a **Left hand** or **Right hand** thread. When viewed from the end of the part toward the chuck, on a left hand thread the tool winds counter-clockwise as it moves towards the chuck, on a right hand thread the tool winds clockwise as it moves towards the chuck.

**Thread Length** — Enter the length of the thread.

**Pitch** — Enter the pitch of the thread.

**Thread Height** — Enter the height of the thread.

**Minor/Major Diameter** — Enter the **Minor Diameter** for an ID feature or the **Major Diameter** for an OD feature.

**Tapered** — If your thread is tapered, select this option and enter the taper **Angle**.
Tapered taps are driven to a different depth than straight taps. For straight taps, a tip allowance is added to the thread depth so that the tool cuts the complete thread, this is not added for tapered taps so that the OD is not affected.

There are two ways that FeatureCAM can calculate Standard Threads. Set the Thread depth calculations attribute on the Threading (see page 1699) tab of Machining Attributes.

**Dimensions tab (Face)**

Use the Dimensions tab to edit the dimensions of a Face feature.

![Face Properties window](image)

**Feed direction** — Select Positive if you want to cut in the +X direction or select Negative if you want to cut in the -X direction.

**Thickness** — Enter the amount of material to remove in Z.

**Outer Diameter** — Enter the top X value as the Outer Diameter.

**Inner Diameter** — Enter the inner diameter.
**Dimensions tab (Cutoff)**

Use the **Dimensions** tab to edit the dimensions of a Cutoff feature.

- **Chamfer/Radius** - Optionally add a chamfer or a radius to the Cutoff feature. Select **Chamfer** or **Radius** from the menu and enter the value.
- **Diameter** - Enter the (outer) diameter.
- **Inner Diameter** — Enter the inner diameter.
- **Width** - Enter the width of the Cutoff tool.
- **Transfer to sub spindle** — Select this option if you want to transfer the part to the sub spindle. The **Transfer Parameters** button is displayed.
- **Transfer Parameters** — Click this button to open the **Transfer Parameters** dialog, where you can enter the **Grab distance**, **Feed distance**, and **Pull distance** for the transfer.

**Dimensions tab (Bar Feed/Bar Pull)**

Use the **Dimensions** tab to edit the dimensions of a Bar Feed or Bar Pull feature.

- **Type** - Select **Bar Feeder** or **Bar Puller** from the menu.
**Bar Feeder**

**Diameter** - Enter the Y coordinate for the bar feed.

**Feed Amount** - Enter the amount of material you want to feed in the Z direction.

**Bar Puller**

**Overlap** - Enter the amount of material to hold in the puller (in the Z direction).

**Pull Amount** - Enter the amount of material you want to pull in the Z direction.
**Dimensions tab (Turn)**

Use the **Dimensions** tab to edit the dimensions of a Turn feature.

![Turn Properties dialog](image)

**Curve** button — Click this button to open the **Select Curve** (see page 1366) dialog.

**Stock Curve** button — You can limit the extent of the roughing by using a stock curve. Click the **Stock Curve** button and select or pick a curve in the **Select Stock Curve** dialog. This is useful if you are working from a casting, for example.

**Fillet Radius** — Enter a value to automatically deburr sharp corners. Select **Other Side** to change between external and internal corners.

For example, no **Fillet Radius**:
With a **Fillet Radius** value applied:

If you want to apply the fillet to internal instead of external corners, select the **Other Side** option:

**Dimensions tab (Bore)**

Use the **Dimensions** tab to edit the dimensions of a Bore feature.

**Curve** button — Click this button to open the **Select Curve** (see page 1366) dialog.
Stock Curve button — You can limit the extent of the roughing by using a stock curve. Click the Stock Curve button and select or pick a curve in the Select Stock Curve dialog. This is useful if you are working from a casting, for example.

Fillet Radius — Enter a value to automatically deburr sharp corners. Select Other Side to change between internal and external corners.

For example, no Fillet Radius:

With a Fillet Radius applied:

If you want to apply the fillet to external instead of internal corners, select the Other Side option:

Dimensions tab (Part Handling)

Use the Dimensions tab to edit the dimensions of a Part Handling feature.

Select what you want to do from:

- **Slug Transfer** — Select this option to transfer the part from the main spindle to the sub-spindle.
- **Reverse Slug Transfer** — Select this option to transfer the part from the sub-spindle to the main spindle.
- **Bar pull** — Select this option to use the subspindle to grab and pull the bar of material further out of the main spindle.

- **Part Support On** — Select this option to enable part support such as a steady rest or tailstock.

- **Part Support Off** — Select this option to remove the part support.

**Slug Transfer**

![Slug Transfer Diagram]

- **Grab distance** — Enter the grab distance.
- **Feed distance** — Enter the feed distance.
**Reverse Slug Transfer**

- **Grab distance** — Enter the grab distance.
- **Feed distance** — Enter the feed distance.
- **Sub position** — Enter the sub-spindle position.
Bar pull

Grab distance — Enter the grab distance.

Feed distance — Enter the feed distance.

Pull distance — Enter the pull distance.
**Part Support On**

**Grab distance** — Enter the grab distance in Z where you want the support to move to.

**Feed distance** — Enter the feed distance.
Part Support Off

Select Curve dialog

Use the **Select Curve** dialog to select the curve that defines the shape of the feature.

Select a curve in the graphics window and click **+** to add it to the list.

**Show all** — Select this option to show all available curves in the document.

**Strategy tab (TURN)**

The **Strategy** tab of the **Turning Feature Properties** (see page 1351) dialog has different options depending on the turn feature:

**Turn** (see page 1367)
**Bore** (see page 1376)

**Groove** (see page 1382)

**Thread** (see page 1384)

**Cutoff** (see page 1389)

*Strategy tab (Turn feature) (TURN)*

---

**Below centerline** — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Use canned cycle**

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

*For support of canned cycles in Fanuc controllers, use the fanucez.cnc post.*

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.
Hole features

If Enable drilled canned cycles is deselected in the Post options dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If Enable drilled canned cycles is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.

Turn/Bore features

Canned cycles for Turn and Bore features must be enabled by selecting Enable turn canned cycles in the Post options dialog. You must then go to the Properties dialog for each Turn/Bore feature, click the Strategy tab and select Use canned cycle. Also select Reuse path in canned cycle if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

Groove features

Enable grooving canned cycles in the Post options dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature's Property dialog, clicking the Strategy tab, and then clicking Use path canned cycle. You can also set this attribute on the Groove tab of the default attributes, but this will only apply to features you create after changing this setting.

Thread features

Thread features always use canned cycles.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/bore (see page 1689) tab.

Reuse path in canned cycle — Relates to Use canned cycle. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

Cycle — Select from:
• **Turn/Bore** — This cycle roughs within the defined material boundaries by feeding parallel to the part's center line along the Z axis while stepping down in the X axis. If you select **Negative**, the tool moves from right to left. If you select **Positive**, the tool moves from left to right. If the **Total stock** (see page 1445) attribute is set, then the part is roughed using curves that are offset from the feature's profile.

**Turn** cycle rough operation with **Positive** feed direction:

**Turn** cycle rough operation with **Negative** feed direction:
- **Face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the negative direction.

- **Back face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the positive direction.

**Toolpath** — Select from:

**Turning** — Normal roughing passes are enabled. Each roughing pass is cut in the same direction. For finishing, the tool traces the contour of the feature from right to left and is withdrawn from the part.

**Roughing**

If the **Toolpath** attribute is set to **Turning**, the normal roughing passes are enabled. Each roughing pass is cut in the same direction.
1. Feed straight down into the part. The distance is based on the depth of cut.
2. Cut down the right-hand wall.
3. Feed straight across.
4. Feed up the left-hand wall.
5. Withdraw from the wall, retract all the way across the feature.

**Finishing**

If the **Toolpath** attribute is set to **Turning**, the toolpath is generated as shown below.

1. The tool traces the contour of the feature from right-to left.
2. The tool is withdrawn from the part based on withdraw angle and withdraw length.

**Offset** — Roughing toolpaths are created using offsets of the Turn feature's curve. These offsets are clipped against the stock.

For the **offset** toolpath type, the roughing toolpaths are created using offsets of the Turn feature's curve. These offsets are clipped against the stock.
**Cut-Grip** — Roughing with Iscar cut grip tools is bi-directional. The cut grip finishing style is performed using a unique strategy that is enabled by having a grooving tool that cuts in both directions.

**Roughing**

Roughing with Iscar cut grip tools is bi-directional. The steps of the cuts are as follows.

1. Feed straight down into the part. The distance is based on the depth of cut.
2. Feed straight over in Z.
3. Withdraw away from the wall and rapid back slightly in Z.
4. Feed straight down again based on the depth of cut.
5. Feed straight in the -Z direction.

**Finishing**

The cut grip style of finishing is performed using a unique strategy that is enabled by having a grooving tool that cuts in both directions.

1. Cut down the left hand wall up to the bottom radius.
2. Rapid up and over and plunge a relief groove.
3. Cut down the right-hand wall, through the bottom radius into the relief groove.
4. Cut along the bottom of the groove. This move is offset by a deflection amount.
5. Cut up the left-hand bottom radius. This move is offset by a deflection amount.
If the Turn feature has multiple groove cavities, each cavity is cut in this way and the cavities are ordered from left to right:

**Round Insert** — Round tool roughing toolpaths are designed to ease the tool more gently into a groove shape. Round tool roughing toolpaths are designed to ease the tool more gently into a groove shape. Instead of plunging straight into the material, part entry is controlled by the Engage angle (see page 1416) turning attribute.

A round tool is required and you must manually select the tool for this toolpath type.

**Engage angle**

Round insert tool finish toolpaths are the same as Turning finish toolpaths.

**Turnmilling** — Uses a rotating endmill tool with rotating stock. Control the turning spindle speed on the Turn F/S tab. Control the milling spindle speed on the Mill Speed tab.

**Rough pass** — Enable this option to add a Rough operation to the feature.

**Semi-finish pass** — Enable this option to add a Semi-finish (see page 969) operation to the feature.
**Finish pass** — Enable this option to add a Finish operation to the feature.
When this option is deselected, the rough pass is still machined as if the finish pass were included. The **Finish allowance** is left on the roughing pass, and the **Bottom finish allowance** is left on the roughing pass when **Finish bottom** is selected, even though the check box is unavailable.

**Conventional** — The feed moves in the +X direction, followed by the -Z direction, and so on, until it reaches the end of the stair step.

**No drag** — Using the **Conventional** finish type can reduce the tool life and also result in chips being dragged along the face of the part. Select the **No drag** finish, to cut the vertical faces first, in the -X direction, then the horizontal -Z areas.

**Feed dir** — This is the direction that the tool feeds for the operation. Select **Negative** (-Z direction) or **Positive** (+Z direction). Set this separately for the Rough, Semi-finish, and Finish operations.

**Use finish tool**
If disabled, the same tool is used for both the Rough and Finish passes. Enable **Use finish tool** to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named **endmill1.0**, the finishing tool is called **endmill1.0-finish**. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.
If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable **Use finish tool** and explicitly change the tool to use for finishing.

**Cutting method**

Choose an entry in the drop-down list to specify a cutting method for the operation for each pass. Select:

- **Single turret** to cut the feature using one turret.
- **Pinch turning** to cut the feature using turrets positioned above and below the axis of rotation. The tools cut simultaneously: the first tool leaves a spiral of material and the second tool cuts the spiral of material left by the first tool.
- **Follow turning** to cut the feature using turrets positioned above and below the axis of rotation. Each turret uses a standard depth of cut: the top tool leads the bottom tool.

**TNR Comp**

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want **TNR comp** for Rough, Semi-Finish, and Finish operations. Enter the **Lead-in angle**, **Lead-out angle**, and **Lead distance** parameters for **TNR comp**.

**Turn feature example**

![Turn feature example diagram]

If you select **TNR comp** on the **Strategy** tab, the related attributes **Lead distance**, **Lead-in angle**, and **Lead-out angle** become available on the **Turning** (see page 1420) tab (for a rough pass) or the **Leads** (see page 1416) tab (for a finish pass).

**You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/Bore (see page 1689) tab.**
**Strategy tab (Bore feature) (TURN)**

**Below centerline** — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Use canned cycle**

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

*For support of canned cycles in Fanuc controllers, use the [fanucez.cnc](fanucez.cnc) post.*

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.
Hole features

If Enable drilled canned cycles is deselected in the Post options dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If Enable drilled canned cycles is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.

Turn/Bore features

Canned cycles for Turn and Bore features must be enabled by selecting Enable turn canned cycles in the Post options dialog. You must then go to the Properties dialog for each Turn/Bore feature, click the Strategy tab and select Use canned cycle. Also select Reuse path in canned cycle if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

Groove features

Enable grooving canned cycles in the Post options dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature’s Property dialog, clicking the Strategy tab, and then clicking Use path canned cycle. You can also set this attribute on the Groove tab of the default attributes, but this will only apply to features you create after changing this setting.

Thread features

Thread features always use canned cycles.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/bore (see page 1689) tab.

Reuse path in canned cycle — Relates to Use canned cycle. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

Cycle — Select from:
- **Turn/Bore** — This cycle roughs within the defined material boundaries by feeding parallel to the part's center line along the Z axis while stepping down in the X axis. If you select **Negative**, the tool moves from right to left. If you select **Positive**, the tool moves from left to right. If the **Total stock** (see page 1445) attribute is set, then the part is roughed using curves that are offset from the feature's profile.

**Turn cycle rough operation with Positive feed direction:**

![Diagram of Turn cycle rough operation with Positive feed direction]

**Turn cycle rough operation with Negative feed direction:**

![Diagram of Turn cycle rough operation with Negative feed direction]
- **Face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the negative direction.

- **Back face** — This cycle roughs within the defined material boundaries by feeding from the outside of the part to the center while stepping into the face of the part along the Z axis in the positive direction.

**Toolpath** — Select from:
- Turning
- Offset
- Turnmilling
- Cut-Grip
- Round Insert

**Pre-drill** — Select this option to have a pre-drill operation for a Bore feature. Enter the **Dia** (diameter), **Depth**, and Z position of your pre-drilled hole.

**Rough pass** — Enable this option to add a Rough operation to the feature.
Semi-finish pass — Enable this option to add a Semi-finish (see page 969) operation to the feature.

Finish pass — Enable this option to add a Finish operation to the feature.

When this option is deselected, the rough pass is still machined as if the finish pass were included. The Finish allowance is left on the roughing pass, and the Bottom finish allowance is left on the roughing pass when Finish bottom is selected, even though the check box is unavailable.

Conventional — The feed moves in the +X direction, followed by the -Z direction, and so on, until it reaches the end of the stair step.

No drag — Using the Conventional finish type can reduce the tool life and also result in chips being dragged along the face of the part. Select the No drag finish, to cut the vertical faces first, in the -X direction, then the horizontal -Z areas.

Feed dir — This is the direction that the tool feeds for the operation. Select Negative (-Z direction) or Positive (+Z direction). Set this separately for the Rough, Semi-finish, and Finish operations.

Use finish tool

If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.
If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable Use finish tool and explicitly change the tool to use for finishing.

**Tool nose radius compensation**

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want TNR comp for Rough, Semi-Finish, and Finish operations. Enter the Lead-in angle, Lead-out angle, and Lead distance parameters for TNR comp.

**Turn feature example**

If you select TNR comp on the Strategy tab, the related attributes Lead distance, Lead-in angle, and Lead-out angle become available on the Turning (see page 1420) tab (for a rough pass) or the Leads (see page 1416) tab (for a finish pass).

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/Bore (see page 1689) tab.
**Strategy tab (Groove feature) (TURN)**

- **Below centerline** — Enable this option to make the tool work on the negative X side of the spindle centerline.
- **Rough pass** — Enable this option to add a Rough operation to the feature.
- **Feed dir** — This is the direction that the tool feeds for the operation. Select **Negative** (-Z direction) or **Positive** (+Z direction). Set this separately for the Rough, Semi-finish, and Finish operations.
- **Plunge center first** — This attribute is available for Groove features.
  - **Plunge center first** — For groove features, if this option is selected, the straight portion of the groove is roughed first and then the angled portions are roughed separately. If **Plunge center first** is set, the red region of this image is roughed first and then the yellow regions are roughed.

  You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Grooving** (see page 1702) tab.

- **Output dwell on rough** — Select this option to have a **Dwell** amount on the rough operation of a Groove feature.
Finish pass — Enable this option to add a Finish operation to the feature.
When this option is deselected, the rough pass is still machined as if the finish pass were included. The Finish allowance is left on the roughing pass, and the Bottom finish allowance is left on the roughing pass when Finish bottom is selected, even though the check box is unavailable.

Use finish tool
If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.

Feed Dir — Select the feed direction. Positive cuts in the +X direction, Negative cuts in the -X direction.

Use 2nd offset register — Use a different offset register for each side of a grooving tool. The second offset register number is displayed in the Tool Mapping dialog.

If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable Use finish tool and explicitly change the tool to use for finishing.

This requires a change to your post to work properly. See the XBUILD help for the <OFFSET_CH> reserved word.
**Strategy tab (Thread feature) (TURN)**

**Below centerline** — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Turn to diameter**

Optionally create a rough and/or finish pass to turn the part down to the diameter of the thread. The creation of these operations is controlled by the **Turn to diameter: Rough** and **Finish** options on the Strategy page. See How a turn feature is manufactured (see page 833) for more details.

**Chamfer** — Enable the **Chamfer** option to add a chamfer to your Thread feature.

The chamfer slopes into the thread for OD threads (turn) and away from the thread for ID threads (bore).

*You must select either Rough or Finish to access the Chamfer option.*

*You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. Set it on the Threading (see page 1699) tab.*

**Relief Groove**
Optionally generate a roughing (see page 814) pass for the relief groove. The **Width** controls the Z-axis dimension, the **Depth** controls the X-axis dimension and the **Side Wall Angle** controls the angle of the wall closest to the thread.

**Thread** — Enable this option to have a thread operation on the feature.

**Feed** — This is the direction of the feed moves, select from:

- **Towards chuck** — the threading is performed in the direction toward the chuck.
- **Away from chuck** — the threading is performed in the direction away from the chuck.

**Passes** — This is the number of steps to the bottom of the thread. Select either **Fixed** or **Calculated**.

- **Fixed** — refers to a fixed rate of material removal. As the tool cuts further into the part, the area of contact of the tool increases. FeatureCAM reduces the infeed on each pass so that the tool loading remains constant. Enter the number of passes in **Count**.

- **Calculated** — the number of steps is calculated automatically by FeatureCAM.

  **Step1** is used to specify the incremental step for the first pass across the thread.

  **Step2** specifies the second pass and is used by the system to determine subsequent passes on the thread, reducing in depth until the **Min Infeed** value is reached.

**Spring passes** — A *spring pass* is a duplicate of the final threading pass. Enter the number of **Spring passes** that you want.
**Strategy tab (Face feature) (TURN)**

Below centerline — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Use canned cycle**

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

*For support of canned cycles in Fanuc controllers, use the *fanucez.cnc* post.*

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.
Hole features

If Enable drilled canned cycles is deselected in the Post options dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If Enable drilled canned cycles is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.

Turn/Bore features

Canned cycles for Turn and Bore features must be enabled by selecting Enable turn canned cycles in the Post options dialog. You must then go to the Properties dialog for each Turn/Bore feature, click the Strategy tab and select Use canned cycle. Also select Reuse path in canned cycle if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

Groove features

Enable grooving canned cycles in the Post options dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature’s Property dialog, clicking the Strategy tab, and then clicking Use path canned cycle. You can also set this attribute on the Groove tab of the default attributes, but this will only apply to features you create after changing this setting.

Thread features

Thread features always use canned cycles.

Reuse path in canned cycle — Relates to Use canned cycle. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

Rough pass — Enable this option to add a Rough operation to the feature.

Finish pass — Enable this option to add a Finish operation to the feature.

When this option is deselected, the rough pass is still machined as if the finish pass were included. The Finish allowance is left on the roughing pass, and the Bottom finish allowance is left on the roughing pass when Finish bottom is selected, even though the check box is unavailable.
Use finish tool

If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.

If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable Use finish tool and explicitly change the tool to use for finishing.

Tool nose radius compensation

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want TNR comp for Rough, Semi-Finish, and Finish operations. Enter the Lead-in angle, Lead-out angle, and Lead distance parameters for TNR comp.

Turn feature example

If you select TNR comp on the Strategy tab, the related attributes Lead distance, Lead-in angle, and Lead-out angle become available on the Turning (see page 1420) tab (for a rough pass) or the Leads (see page 1416) tab (for a finish pass).

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/Bore (see page 1689) tab.
**Strategy tab (Cutoff feature) (TURN)**

**Below centerline** — Enable this option to make the tool work on the negative X side of the spindle centerline.

**Part catcher** is available for Cutoff features.

If enabled, the part catcher code is output after the Cutoff operation. The code for activating the parts catcher must be listed in your `.cnc` file.

**Plunge rough edge break** — If there is a chamfer or radius on a Cutoff feature and **Plunge rough edge break** is enabled:

1. The Cutoff groove is plunged down to the depth of the chamfer/radius
2. The chamfer/radius is plunge-roughed.

**Transfer** — You must select **Transfer to sub spindle** on the **Dimensions** (see page 1357) tab to access the options in this section:

- **Already Supported** — Enable this option to indicate that the part is already supported.
- **Push/Press** — Select this option to use Push/Press for the spindle position.
Open dwell — Optionally enter the time, in seconds, to dwell after opening the spindle.

Close dwell — Optionally enter the time, in seconds, to dwell after closing the spindle.

Spindle Action — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

Main Angle — Enter the angle that you want the main spindle to rotate to before the part is collected.

Sub Angle — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

Spindle Speed — Enter the spindle speed.

Sub-spindle feed rate — Enter the subspindle feed rate.

Transfer turret — If your machine has multiple turrets, select the correct transfer turret.

Turret control — Click the button to open the Transfer Turret Control (see page 1397) dialog.
**Strategy tab (Part Handling feature) (TURN)**

**Slug transfer**

![Slug transfer interface](image)

**Part catcher** — Enable this option if you want to instigate the part catcher.

**Already Supported** — Enable this option to indicate that the part is already supported.

**Push/Press** — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the **Grab distance**.

**Open dwell** — Optionally enter the time, in seconds, to dwell after opening the spindle.

**Close dwell** — Optionally enter the time, in seconds, to dwell after closing the spindle.

**Spindle Action** — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

**Main Angle** — Enter the angle that you want the main spindle to rotate to before the part is collected.
Sub Angle — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

Spindle Speed — Enter the spindle speed.

Sub-spindle feed rate — Enter the subspindle feed rate.

Transfer turret — If your machine has multiple turrets, select the correct transfer turret.

Turret control — Click the button to open the Transfer Turret Control (see page 1397) dialog.

Reverse slug transfer

Part catcher — Enable this option if you want to instigate the part catcher.

Leave Supported — Enable this option if you want to keep the part supported.

Push/Press — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the Grab distance.

Open dwell — Optionally enter the time, in seconds, to dwell after opening the spindle.

Close dwell — Optionally enter the time, in seconds, to dwell after closing the spindle.
Spindle Action — Select what you want the main and sub-spindles to do during synchronization:
- Stop spindles
- Orient spindles
- Keep rotating

Main Angle — Enter the angle that you want the main spindle to rotate to before the part is collected.

Sub Angle — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

Spindle Speed — Enter the spindle speed.

Sub-spindle feed rate — Enter the subspindle feed rate.

Transfer turret — If your machine has multiple turrets, select the correct transfer turret.

Turret control — Click the button to open the Transfer Turret Control (see page 1397) dialog.

Bar pull

Already Supported — Enable this option to indicate that the part is already supported.

Leave Supported — Enable this option if you want to keep the part supported.
Part catcher — Enable this option if you want to instigate the part catcher.

Push/Press — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the Grab distance.

Open dwell — Optionally enter the time, in seconds, to dwell after opening the spindle.

Close dwell — Optionally enter the time, in seconds, to dwell after closing the spindle.

Spindle Action — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

Main Angle — Enter the angle that you want the main spindle to rotate to before the part is collected.

Sub Angle — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

Spindle Speed — Enter the spindle speed.

Sub-spindle feed rate — Enter the subspindle feed rate.

Transfer turret — If your machine has multiple turrets, select the correct transfer turret.

Turret control — Click the button to open the Transfer Turret Control (see page 1397) dialog.
Part support on

Support type — Select the type of support from:

- Subspindle
- Tailstock
- Steadyrest

Jaws Only — For steady rests, select this option to operate the jaws without moving the steady rest.

Push/Press — If you enable this option, the subspindle feeds slowly until it touches the part, then grabs it at the Grab distance.

Open dwell — Optionally enter the time, in seconds, to dwell after opening the spindle.

Close dwell — Optionally enter the time, in seconds, to dwell after closing the spindle.

Spindle Action — Select what you want the main and sub-spindles to do during synchronization:

- Stop spindles
- Orient spindles
- Keep rotating

Main Angle — Enter the angle that you want the main spindle to rotate to before the part is collected.
**Sub Angle** — Enter the angle that you want the sub-spindle to rotate to before it moves to collect the part.

**Spindle Speed** — Enter the spindle speed.

**Sub-spindle feed rate** — Enter the subspindle feed rate.

**Transfer turret** — If your machine has multiple turrets, select the correct transfer turret.

**Turret control** — Click the button to open the Transfer Turret Control (see page 1397) dialog.

**Part support off**

![Part support off dialog](image)

**Support type** — Select the type of support from:
- **Subspindle**
- **Tailstock**
- **Steadyrest**

**Jaws Only** — For steady rests, select this option to operate the jaws without moving the steady rest.

**Open dwell** — Optionally enter a dwell time after opening the spindle.

**Transfer turret** — If your machine has multiple turrets, select the correct transfer turret.
Transfer Turret Control dialog

Use this dialog to set the **Location** and **Index** that you want to use for each turret on your machine during part handling.

**Location** — Select where you want the turret to be during the part handling:

- **None** — Select this option to leave the turret at its current position before starting the part handling.
- **Home** — Select this option to move the turret to its home position before starting the part handling.
- **Escape** — Select this option to move the turret to a safe location away from the part before starting the part handling.

**Index** — If necessary, you can rotate the turret to ensure that tools are not in the way. Enter the **Index** number.
Strategy tab (Air Blast feature) (TURN)

Use the Strategy tab of the Feature Properties dialog to control air blast features.
**Right Angle Head tab (TURN)**

To display the **Right Angled Head** tab, you must allow right-angled tool holders (see page 220) on the **Right Angled Head** page of the **Setup** wizard.

**Use right angle head** — Select to use a right-angled head tool.

**Feature location is on ID** — Select if the feature is on the inside diameter of the part.

**Holder orientation in spindle** — Enter the holder orientation in the spindle in degrees.
**Misc. tab (TURN)**

You can use the **Misc** tab of the **Turning Feature Properties** (see page 1351) dialog to edit machining options of a Turning feature.

![Turning Feature Properties dialog](image)

**Feed override %** — Enter a scaling factor for the feed rates generated by the system. A value of less than 100 reduces the calculated feed rates. A value of more than 100 increases the rates.

**Spindle RPM override %** — Enter a scaling factor for the speed rates generated by the system. A value of less than 100 reduces the speed rate, and a value of greater than 100 increases it.

**Spline tolerance** — If a profile is defined as a spline, it is approximated with arcs and lines. Enter a tolerance value for the approximation. The smaller the tolerance, the smoother the profile.
Tools tab (TURN)

You can use the Tools tab of the Turning Feature Properties (see page 1351) dialog to select a tool to machine a feature or create a new tool.

The table lists the default recommended tool (marked with a D) and other tools in the current tool crib that fit the tool selection criteria. Other tools can be selected from the table by selecting the check-box next to the tool name. The tools that are listed in the table are controlled by the filter settings.

The tools displayed in the table are chosen from the database based on the criteria listed above the table. To choose from different tools, change the filter criteria. The criteria are:

- **Orientation** — Select an orientation from among the icons. Select Anything to see tools of all orientations.
- **Insert shape** — Select an insert shape from among the icons. Select Anything to see tools with all insert shapes.
- **Presentation angle** — Enter a number for the presentation. Select Anything to see tools with all presentation angles.

Regardless of the filtering criteria, the automatically selected tool stays in the list.
Select a tool in the table to see the preview image in the upper right-hand corner of the dialog. You can pan and zoom this display by left-clicking and dragging the mouse cursor in the tool graphic window. Right-click in the tool graphic window and select **Center all** to center the entire tool and holder.

You can sort the tools listed in the table by any column by clicking the title of the column.

*You can adjust the column widths by clicking and dragging the borders of the column titles. FeatureCAM remembers your width preferences.*

- **Undo tool override** — Click this button to revert the selected tool back to the default recommended tool (marked with a D).
- **New tool** — Click this button to create a brand new tool and add it to the current crib. The tool that is selected in the table is used to fill in the initial values for the tool.
- **Tool manager** — Click this button to open the **Tool Manager** (see page 1745) dialog.
- **Properties** — Click this button to open the **Tool Properties** (see page 1749, see page 1795) dialog for the selected tool.
- **Recent tools** — Select this option to filter the list and show only recently used tools.
- **Turnmilling tool orientation** button — available when you select **Turnmilling** as the turn **Toolpath** type on the **Strategy** (see page 1366) tab. Click this button to open the **B-Axis Tool Orientation** (see page 1403) dialog.

To override the automatically selected tool to one of your choice:

1. Select the **Orientation**.
2. Select or enter the tool **Insert Shape**.
3. Select or enter the tool's **Presentation Angle**.
4. Optionally select the **Recent tools** option to filter your tool search further.
5. Scroll through the table.
6. To preview a tool:
   - Select a tool in the table to view it in the small graphics window. You can pan and zoom this view.
   - Select a tool in the table and click the **Properties** button or double-click a tool in the table to open its **Tool Properties** dialog. You can edit the tool's properties if you want to.
To change the tool, select the check box next to the Name of the tool you want to use in the table.

If you cannot find the tool you want, click the New tool button and create a new tool (see page 1749).

To revert back to the automatically selected tool, click the Undo tool override button. The override tool is deselected in the table and FeatureCAM uses the default tool marked D.

**B-Axis Tool Orientation dialog**

Use the B-Axis Tool Orientation dialog to specify the tool orientation for turnmilling tools.

To display the B-Axis Tool Orientation dialog:

1. Ensure the Turnmilling option is selected under Toolpath on the Strategy (see page 1366) tab of the Feature Properties dialog.
2. On the Tools tab, click Turnmilling tool orientation.

**Select tool orientation** — Select whether to align the tool orientation with the X Axis, Y Axis, or B Axis.

- **X-axis toolpaths can be used only for OD features.**

**Tool Y offset** — Enter the Y offset for the tool. The default value is 25% of the tool diameter.
Tool Usage tab (TURN)

You can use the Tool Usage tab of the Turning Feature Properties (see page 1351) dialog to edit the tools usage settings for machining a Turning feature.

The Tool Usage tab for turning features contains the following attributes:

**Tool** — This displays the name of the tool for the operation selected in the tree view.

*This is just for information, to change the tool, use the Tools tab.*

**Turret** — If you are doing multi-turret turning, select which turret to use to cut the selected operation.

**Turret direction** — We recommend that you leave this as Auto so that FeatureCAM can calculate the direction for a particular operation. You can also set this option explicitly to CW (clockwise) or CCW (counter-clockwise).

*You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. Set it on the Misc (see page 1708, see page 1404) tab for Turn.*

Feed-Speed tab (TURN)

You can use the Feed/Speed tab of the Turning Feature Properties (see page 1351) dialog to change the feeds and speeds settings for a Turning feature.
When using Turnmilling toolpaths (machining using a rotating endmill), this tab is replaced by two tabs: Turn F/S (see page 1408) and Mill Speed (see page 1411).

Spindle Direction — The direction the spindle turns for the selected operation. Select from CW (clockwise) and CCW (counter-clockwise). If you select the option that is not the default, the Override option is selected automatically. Deselect the Override option to return to the default value. Set the default Spindle direction on the Misc. (see page 1708, see page 1404) tab of Machining Attributes.

Speed

Constant Surface Speed — Select this option to specify the speed as a constant surface speed.

RPM Range — If your machine has explicit spindle speed ranges, you can set this option.

Some turning centers have gear boxes that set the maximum spindle speed of the machine. The RPM Range list sets the gear box to a specific maximum range. If you set RPM Range to a value of 1-4, then the range is set explicitly. If RPM Range is set to Auto then FeatureCAM sets the range for you based on the following rules:
1 If the feature is a turned Hole or another turned feature without Constant Surface Speed set, then the range is determined based on the Spindle Speed.

2 If the feature is a turned feature with Constant Surface Speed set, then the range is determined based on the Max RPM.

Surface Speed — Enter the surface speed in SFM (surface feet per minute). FeatureCAM uses the displayed recommended value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.

Spindle speed — If you want to enter the speed as a single revolution per minute value, deselect Constant Surface Speed and enter the Spindle speed.

Maximum speed — Enter the maximum constant surface speed in RPM. This is the maximum revolutions per minute that the machine can generate. FeatureCAM uses the displayed recommended value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.

Approach speed — Enter the constant surface speed approach in RPM. This is the initial speed for the operation before it reaches the part. FeatureCAM uses the displayed recommended value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.

Feeds

The Feeds section is for setting how fast the tool moves through the stock. The default units are IPM (inches per minute) or MMPM (mm per minute). Optionally select Use IPR (inches per revolution) or Use MMPR (mm per revolution) to change the units.

FeatureCAM uses the displayed recommended feed value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.

Feed from start point or curve — Select this option to use a feed move from the Start point (see page 1420) or the end of the Start curve, to the beginning of the toolpath. If you are using a start curve, you have two further options:

- Rapid on curve — Select this option if you want to use a rapid move along the start curve.

Selecting Feed from start point or curve and Rapid on curve is the equivalent of selecting the Feed from start
Feed on curve — Select this option if you want to use a feed move along the start curve. Enter the feed rate value(s). You can set the feed move as a single value, or use a comma separator to enter multiple values, for example 200, 100, 50. If you enter multiple values, the feeds are applied to the curve segments in reverse order. So with these values, the last segment has a feed rate of 50, the second last has a feed rate of 100 and any remaining segments have a feed rate of 200. If you do not enter any feed rate values, FeatureCAM uses the default feed rate.

This example turned part has a Turn, Hole, and Groove feature:

A 3D simulation with 3/4 view shows that the tool has to pass through a narrow channel to access the Groove feature:

To control the movement of the tool through that narrow channel, you can create curves and set them as Start point and End point on the Turning tab.

A Centerline simulation of just the Groove feature, shows the approach move in green, which is a rapid move:
On the **Feed/Speed** tab, select **Feed from start point or curve** and **Feed on curve**. Enter the feed value(s) and click **Apply**.

The Centerline simulation now shows the approach move in purple, a feed move:

![Feed/Speed tab](image)

**Turn F/S tab (TURN)**

This tab is available when using **Turnmilling** toolpaths (machining rotating stock with a rotating endmill).

**Spindle Direction** — The direction the spindle turns for the selected operation. Select from **CW** (clockwise) and **CCW** (counter-clockwise). If you select the option that is not the default, the **Override** option is selected automatically. Deselect the **Override** option to return to the default value. Set the default **Spindle direction** on the **Misc.** (see page 1708, see page 1404) tab of **Machining Attributes**.
Speed

Constant Surface Speed — Select this option to specify the speed as a constant surface speed.

RPM Range — If your machine has explicit spindle speed ranges, you can set this option.

Some turning centers have gear boxes that set the maximum spindle speed of the machine. The RPM Range list sets the gear box to a specific maximum range. If you set RPM Range to a value of 1-4, then the range is set explicitly. If RPM Range is set to Auto then FeatureCAM sets the range for you based on the following rules:

1. If the feature is a turned Hole or another turned feature without Constant Surface Speed set, then the range is determined based on the Spindle Speed.

2. If the feature is a turned feature with Constant Surface Speed set, then the range is determined based on the Max RPM.

Surface Speed — Enter the surface speed in SFM (surface feet per minute). FeatureCAM uses the displayed recommended value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.

Maximum speed — Enter the maximum constant surface speed in RPM. This is the maximum revolutions per minute that the machine can generate. FeatureCAM uses the displayed recommended value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.

Approach speed — Enter the constant surface speed approach in RPM. This is the initial speed for the operation before it reaches the part. FeatureCAM uses the displayed recommended value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.

Feeds

The Feeds section is for setting how fast the tool moves through the stock. The default units are IPM (inches per minute) or MMPM (mm per minute). Optionally select Use IPR (inches per revolution) or Use MMPR (mm per revolution) to change the units.

FeatureCAM uses the displayed recommended feed value by default. You can optionally enter a different value and the Override option is automatically selected. If you want to revert back to the recommended value, deselect Override.
Feed from start point or curve — Select this option to use a feed move from the Start point (see page 1420) or the end of the Start curve, to the beginning of the toolpath. If you are using a start curve, you have two further options:

- **Rapid on curve** — Select this option if you want to use a rapid move along the start curve.

  Selecting *Feed from start point or curve* and *Rapid on curve* is the equivalent of selecting the *Feed from start option on the Turning tab in previous versions of FeatureCAM*.

- **Feed on curve** — Select this option if you want to use a feed move along the start curve. Enter the feed rate value(s). You can set the feed move as a single value, or use a comma separator to enter multiple values, for example 200, 100, 50. If you enter multiple values, the feeds are applied to the curve segments in reverse order. So with these values, the last segment has a feed rate of 50, the second last has a feed rate of 100 and any remaining segments have a feed rate of 200. If you do not enter any feed rate values, FeatureCAM uses the default feed rate.

This example turned part has a Turn, Hole, and Groove feature:

A 3D simulation with 3/4 view shows that the tool has to pass through a narrow channel to access the Groove feature:

To control the movement of the tool through that narrow channel, you can create curves and set them as **Start point** and **End point** on the **Turning** tab.
A Centerline simulation of just the Groove feature, shows the approach move in green, which is a rapid move:

On the Feed/Speed tab, select Feed from start point or curve and Feed on curve. Enter the feed value(s) and click Apply.

The Centerline simulation now shows the approach move in purple, a feed move:

**Mill Speed tab (TURN)**

This tab is available when using Turnmilling toolpaths (machining rotating stock with a rotating endmill).

Use the Mill Speed tab to control the speed of rotation of milling tools when used for turning operations. This tab is only available when a Toolpath type of Turnmilling is selected on the Strategy tab.

**Speed**
The **Speed** section is for setting how fast the tool spins. The default units are **RPM** (revolutions per minute). Optionally select **Use SFM** (surface feet per minute) to change the units. FeatureCAM uses the **Recommended** speed value by default. You can optionally enter a different value and the **override** option is automatically selected. If you want to revert back to the recommended value, deselect **override**.

**B-Axis tab (TURN)**

To use B-axis simultaneous turning, select the finish operation of a Turn or Bore feature in the Tree view in the **Turning Feature Properties** (see page 1351) dialog, then select **Use B-axis simultaneous** on the **B-Axis** tab.

![B-Axis tab](image.png)

**Lead angle** — Optionally enter a lead angle (the default is **0**).

**Limit B-angle** — You can optionally limit the B-angle. If you choose to limit the B-angle, enter values between a **Min B-angle** of **-90** and a **Max B-angle** of **270**.

When using B-axis simultaneous, please note these points:

- To use B-axis simultaneous, you must set the **Tool program point** to **Tool tip center** on the **Misc** (see page 1708, see page 1404) tab of turning **Machining Attributes**.
- You must also turn on tool nose radius compensation by selecting **TNR Comp** on the **Strategy** (see page 1366) tab of the **Feature Properties** dialog.
- It makes sense to turn undercuts off, by setting the **Undercuts** option to **No checking** on the **Turning** (see page 1420) tab of the **Feature Properties** dialog.

> There is no gouge checking if you turn off undercuts.
**B-axis simultaneous example**

The B-axis simultaneous option can be used to cut parts such as this one:

![Diagram of a part with a vertical tool colliding](image1.png)

**Vertical tool**

Using a vertical tool, the tool collides with the part as shown:

![Diagram of tool colliding with part](image2.png)

**Neutral tool, fixed B axis**

Using a neutral tool with a fixed B axis, the tool copes with the undercut part of this example:

![Diagram of tool coped with undercut part](image3.png)
However, it collides further along:
Simultaneous B-axis tool

Using the simultaneous B-axis option, the tool can cut the entire part without colliding, because it can move in the B-axis as it cuts:
Leads tab (TURN)

The Leads tab of the Turning Feature Properties (see page 1351) dialog applies to the finish pass of a Turn feature:

In
Select the type of lead-in from:

Arc in — Select this option to use an arc ramp-in move and enter the Arc-in angle and Arc in/out radius.

This example uses Arc in and Arc out:
When using **Arc in** and **Arc out** with **TNR Comp** (see page 1366) enabled, small linear moves are added to the toolpath before the arc in and after the arc out. Compensation is turned on during the linear segments:

**Linear in** — Select this option to use a linear lead-in move and enter the **Engage angle/Lead-in angle** and the **Lead distance**.

This example uses **Linear in** and **Linear out**:

**Engage angle** — This attribute is available for **Linear in** if **TNR comp** is off for the finish pass.

When TNR comp is off, the part entry angle is controlled by the **Engage angle** attribute.

1. **Engage angle**

Enter the approach angle for the tool, measured away from the part. An angle of 0 approaches along the path. An angle of 90 approaches perpendicular to the path. If the beginning of a scan line begins with a shoulder, a value of 90 is used automatically for that scan line. The only valid values are 0 or 90 degrees.
The Engage angle and Withdraw angle are specified from the path (or extension of the path), relative to the side of the path that the tool is on, and the direction in which the tool is traveling. In the graphic below, Point 1 is the calculated engage point and the Point 6 is the calculated withdraw point.

1. Clearance
2. Withdraw angle
3. Clearance zone
4. Engage angle

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. Set it on the Turn/Bore (see page 1689) tab.

Lead-in angle — Enter the angle at which the tool enters the stock for boundary moves. This attribute is available for the rough pass if TNR comp is on.

When TNR comp is on, the part entry angle is controlled by the Lead in angle attribute.

Enter the angle for the lead-in move, measured counter-clockwise away from the part. An angle of 0° approaches along the path. An angle of 90° approaches perpendicular to the path.

Out

Select the type of lead-out from:
**Arc out** — Select this option to use an arc ramp-out move and enter the **Arc-out angle** and **Arc in/out radius**.

**Linear out** — Select this option to use a linear lead-out move and enter the **Withdraw angle/Lead-out angle** and the **Lead distance**.

This example uses **Linear in** and **Linear out**:

![Diagram](image)

**Withdraw angle** — This attribute is available for **Linear out** if **TNR comp** is off for the finish pass.

**Use clearance as finish withdraw length** — When selected, the **Clearance** value is used as the approach and withdraw length for finishing moves. When deselected, you can enter a separate **Withdraw length**.

**Lead-out angle** — This attribute is available for **Linear out** if **TNR comp** is on. This is the angle for the lead-out move for semi-finishing and finishing of Turn and Bore features. It is measured clockwise. The **Lead-out angle** is measured away from the part. An angle of $0^\circ$ exits along the direction of path. An angle of $90^\circ$ exits perpendicular to the path.

**Arc in/out radius** — Enter the radius of the arc to use for arc-in and arc-out ramp moves.

**Lead distance** — Enter the distance for linear lead-in and lead-out moves.
**Turning tab (TURN)**

You can use the **Turning** tab of the **Turning Feature Properties** (see page 1351) dialog to edit the machining setting of a Turning feature.

![Turning Feature Properties dialog](image)

**Auto Round**

This turning attribute applies to both rough and finish passes. When **Auto round** is enabled, FeatureCAM automatically inserts arc moves to connect two non-tangent elements. The effects are:

- Minimum of wasted motion by the machine; however, the posted part program may be slightly longer in the number of blocks used.
- Burrs are removed, but otherwise the part has the same shape and dimensions given by the feature curve because the radius of the inserted arc is the same as the tool nose radius.
- Machine motion is smoother.
This is an example with **Auto round** turned off:

This is the same example with **Auto round** turned on:

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. Set it on the **Turn/Bore** (see page 1689) tab.

**Canned cycle X clearance** — Enter the tool clearance in X before the start of a turning canned cycle. The tool location is obtained by applying the **Canned cycle X clearance** and **Canned cycle Z clearance** to the start point of the canned cycle.

You must enable **Use canned cycle** (see page 1367) to access this attribute.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. Set it on the **Turn/Bore** (see page 1689) tab.
**Canned cycle Z clearance** — Enter the tool clearance in Z before the start of a turning canned cycle. The tool location is obtained by applying the Canned cycle X clearance and Canned cycle Z clearance to the start point of the canned cycle.

You must enable Use canned cycle (see page 1367) to access this attribute.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. Set it on the Turn/Bore (see page 1689) tab.

**Centerline overcut** — Used with Turnmilling (see page 1366) toolpaths. Enter the amount that the tool cuts past the centerline when cleaning up material against a shoulder at the end of a scan line. The default is 0.1 inches or 3 mm.

**Chamfer extend dist.** — applies to thread features and provides extra space for the tool so that it does not start on the metal for the groove finish pass.

**Clearance**

At the beginning of an operation, the tool rapids to a point that is a distance away from the beginning of the toolpath. This distance is the Clearance.

The clearance is also used to calculate the move at the end of the operation (except for an ID Groove feature), unless Use clearance as finish withdraw length is deselected on the Leads tab.

For an ID Groove feature, the Clearance attribute is not used for the exit point. For safety reasons, by default the center line of the tool (holder plus exposed insert) is withdrawn exactly along the center line of the Groove, for example:

1. ID Groove feature
2. Entry point, determined by the Clearance attribute
3. Exit point
4. Center line of tool (holder plus exposed insert)
You can override this and control the retract point precisely using the **Endpoint** attribute. This image shows the same example, but with an **Endpoint** set at 🔄:

The location of these points is also controlled by the **Engage Angle** and **Withdraw Angle**.

If you are using Tool Nose Radius Compensation, **Lead In Dist** is used instead of **Clearance**.

**Deflection** — This attribute applies to the finish pass of a Turn feature when using a Cut-Grip tool.

**Depth of cut**

Enter a step increment for each pass that the roughing routine performs on the part. The interpretation of **Depth of cut** depends on the **Constant DOC** setting in the **Turn/Bore** (see page 1689) document-level options.

If **Constant DOC** is deselected, the **Depth of cut** value you set is the maximum depth of cut for the feature. If the **Depth of cut** evenly divides the depth of your feature, your increment is used. If it results in a final pass that is quite shallow, the **Depth of cut** is adjusted to result in even roughing passes. For example if you have a feature that is 0.5 inches deep and specify a **Depth of cut** of 0.4, the feature is roughed in two even passes 0.25 inches deep instead of one pass of depth 0.4 inches and another pass with depth of 0.1 inches.

If **Constant DOC** is selected, the feature is cut using this depth for each pass. With **Constant DOC** selected, you can also list a series of depths, separated by commas, to control the depth of each cut. For example a **Depth of cut** specified as 0.25, 0.15, 0.1 results in the first pass being cut at 0.25 inches, the second at 0.15 inches and the remaining pass at 0.1 inches. If there are more cuts than depths specified, the last depth is repeated.

**Dwell** — Enter the number of seconds that you want the tool to dwell after plunging. This applies during the Rough pass of a Groove feature and also a Cutoff chamfer.
**End point** — Set the point that the tool-tip center rapids to at the end of the operation.

**Start point and End Point** attributes are available on all turn operations. If the **Start point** is set, the center of the tool tip rapids to this point at the start of the operation. If the **End point** is set, the center of the tool tip rapids to this point at the end of the operation.

To set the value for **Start point** and **End point**, you can click the **Pick XYZ Location** button next to the **New Value** field at the bottom of the dialog and click the location in the graphics window. You can also type in the name of a linear curve and the tool follows this curve on part entry or exit.

*You cannot pick the curve graphically.*

The image below shows an unusually shaped tool that requires a start curve to control precisely.

*You can set FeatureCAM to feed (see page 1708, see page 1404) from the **Start point** (or the end of a start curve) to the beginning of the toolpath.*
Engage angle — Enter the angle at which the tool enters the stock for boundary moves. This attribute is available for the rough pass if TNR comp is off. This attribute is available when TNR comp is on. For the Semi-finish and Finish pass, this attribute is available on the Leads (see page 1416) tab.

When TNR comp is off, the part entry angle is controlled by the Engage angle attribute.

Engage angle

Enter the approach angle for the tool, measured away from the part. An angle of 0 approaches along the path. An angle of 90 approaches perpendicular to the path. If the beginning of a scan line begins with a shoulder, a value of 90 is used automatically for that scan line. The only valid values are 0 or 90 degrees.

The Engage angle and Withdraw angle are specified from the path (or extension of the path), relative to the side of the path that the tool is on, and the direction in which the tool is traveling. In the graphic below, Point 1 is the calculated engage point and the Point 6 is the calculated withdraw point.
**Finish passes** — Normally this is set to 1 and a single pass is generated offset by the tool tip. If set to greater than 1, then the region to be finished is divided into equal parts and finished in sequential passes. The region to be finished is the X semi-finish allowance and the Z semi-finish allowance if the feature has a semi-finish pass, and it is the full X finish allowance and Z finish allowance if the feature has no semi-finish pass.

**Lead dist** — Enter the distance for the lead-in and lead-out moves. This attribute is available for the Rough pass if you have selected TNR comp. on the Strategy (see page 1366) tab. For the Semi-finish and Finish pass, see the Leads (see page 1416) tab.

**Lead-in angle** — Enter the angle at which the tool enters the stock for boundary moves. This attribute is available for the rough pass if TNR comp is on. For the Semi-finish and Finish pass, this attribute is available on the Leads (see page 1416) tab.

When TNR comp is on, the part entry angle is controlled by the Lead in angle attribute.

Enter the angle for the lead-in move, measured counter-clockwise away from the part. An angle of \(0^\circ\) approaches along the path. An angle of \(90^\circ\) approaches perpendicular to the path.

**Lead-out angle** — Enter the angle for the lead-out move, measured clockwise away from the part. An angle of \(0^\circ\) exits along the direction of path. An angle of \(90^\circ\) exits perpendicular to the path. This attribute is available when TNR comp is on. For the Semi-finish and Finish pass, this attribute is available on the Leads (see page 1416) tab.
**Left boundary**

A turning feature's boundary (shown in dark blue) encloses the whole feature by default.

The toolpath is enclosed within the boundary:
You can edit the default leftmost boundary that is machined up to by setting a **Left boundary**:

The toolpath is contained within the new boundary:

*You must specify the boundary so that it completely encloses the path (for example, the path cannot start or end in the boundary box; it must start on, or outside of the boundary).*

You can also set the **Right boundary** and **Max/Min radius boundary attributes**.

**Max. radius boundary**
A Turn feature's boundary (shown in dark blue) encloses the whole feature by default.

The toolpath is enclosed within the boundary:

You can edit the default outer radius boundary that is machined up to by setting a **Max radius boundary**:
The toolpath is contained within the new boundary:

You must specify the boundary so that it completely encloses the path (for example, the path cannot start or end in the boundary box; it must start on, or outside of the boundary).

You can also set the Left boundary and Right boundary attributes.

Min. radius boundary

A Bore feature's boundary (shown in dark blue) encloses the whole feature by default.

The toolpath is enclosed within the boundary:
You can edit the default inner radius boundary that is machined up to by setting a **Min radius boundary**: 

The toolpath is contained within the new boundary: 

You must specify the boundary so that it completely encloses the path (for example, the path cannot start or end in the boundary box; it must start on, or outside of the boundary).

You can also set the **Left boundary** and **Right boundary** attributes.

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.
If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

Post Vars. (see page 1656) button

Right boundary

A Turn feature's boundary (shown in dark blue) encloses the whole feature by default.

The toolpath is enclosed within the boundary:
You can edit the default rightmost boundary that is machined up to by setting a **Right boundary**:

The toolpath is contained within the new boundary:

> You must specify the boundary so that it completely encloses the path (for example, the path cannot start or end in the boundary box; it must start on, or outside of the boundary).

You can also set the **Left boundary** and **Max/Min radius boundary** attributes.

**Side liftoff angle** — Enter the angle to lift the tool off the part after each plunge cut. This increases the tool's life and leaves a better finish on the part. This attribute applies to a Groove feature.
This part has a Groove feature, shown in pink:

The default behavior is for the tool to lift off the part at 90°, shown in the following image by 1, after each plunge cut. This results in tool contact with the uncut material, at 2, when the tool is retracting at a rapid feed rate along the X axis:

You can avoid this by using the Side liftoff dist. attribute, to move the tool back along the Z axis 3, before lifting off.

Side liftoff dist and Side liftoff angle are ignored for the retract move at the end of the first plunge. The liftoff move is performed at the plunge feed rate. If the groove is a round-bottomed groove, then liftoff is not used, even when specified.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Grooving (see page 1702) tab.

Side liftoff dist — Enter the distance to move the tool after a plunge cut, in the direction opposite to the cutting direction. This increases the tool’s life and leaves a better finish on the part. This applies to a Groove feature. See also Side liftoff angle.
This part has a Groove feature, shown in pink:

![Diagram of a part with a groove feature](image)

The default behavior is for the tool to lift off the part at 90°, shown in the following image by 1, after each plunge cut. This results in tool contact with the uncut material, at 2, when the tool is retracting at a rapid feed rate along the X axis:

![Image showing tool lift-off](image)

You can avoid this by using the Side liftoff dist. attribute, to move the tool back along the Z axis 3, before lifting off.

![Image showing tool lift-off with side liftoff](image)

**Side liftoff dist** and **Side liftoff angle** are ignored for the retract move at the end of the first plunge. The liftoff move is performed at the plunge feed rate. If the groove is a round-bottomed groove, then liftoff is not used, even when specified.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Grooving** (see page 1702) tab.

**Skip wall pass**

This attribute applies to turning and boring roughing passes. On a typical roughing pass, the tool follows these moves:

1. Move straight across the part. This is the black move in the diagram.
2 Move up the wall to remove any scallops, shown as the blue move.

3 Withdraw from the part at an angle, shown as the small angled move at the top of the blue move.

If Skip wall pass is enabled the second move (the blue one) is no longer performed. If you are using a tool that does not cut well in the upward direction, you should consider using this option. With Skip wall pass enabled, the toolpaths appear as in the image below.

For boring features, you can select how many passes to apply the Skip wall pass option to from the menu. For example, if you select 1, that means that the wall move is skipped for the first roughing pass but not for the other passes.

Start point — Set the point that the tool-tip center rapids to at the start of the operation.
Start point and End Point attributes are available on all turn operations. If the Start point is set, the center of the tool tip rapidis to this point at the start of the operation. If the End point is set, the center of the tool tip rapidis to this point at the end of the operation.

To set the value for Start point and End point, you can click the Pick XYZ Location button next to the New Value field at the bottom of the dialog and click the location in the graphics window. You can also type in the name of a linear curve and the tool follows this curve on part entry or exit.

*You cannot pick the curve graphically.*

The image below shows an unusually shaped tool that requires a start curve to control precisely.

You can set FeatureCAM to feed (see page 1708, see page 1404) from the Start point (or the end of a start curve) to the beginning of the toolpath.

Stepover % — Enter the distance, as a percentage of the tool's diameter, that the tool shifts to position itself for the next plunge cut. This value specifies the maximum stepover distance. If this value evenly divides the width of the feature, it is used. If it results in a final pass that is quite shallow, the cut widths are adjusted to result in even roughing passes.
For example if you have a feature that is 0.5 inches wide and specify a width of cut of 0.4 (specified as a Stepover % of 80 for a tool with a diameter of 0.5 inches), the feature is roughed in two even passes 0.25 inches wide rather than one pass of 0.4 inches and another pass with a width of 0.1 inches.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Grooving (see page 1702) tab.

**Tool change location** — Set the point where the tip of the tool moves to before a tool change.

This location is relative to the end of the curve (see page 329).

You can set the default value of this attribute for the current part in the Post Options dialog.

**Total stock** (see page 1445) — Enter an offset distance from the feature boundary to machine to instead of machining to the stock boundary. This option is available only for roughing operations of Offset (see page 1367) type toolpaths.

**Undercuts** — Select from No checking, Adjust to tool geometry, and Remove all undercuts.

In the following example, the tool cutting the Turn feature has started to descend into the Groove feature. You can see this on the centerline simulation in the area marked:
You can also see that this is happening in the 3D simulation:

To avoid this situation, select **Remove all undercuts**.
With this option selected, the tool does not descend into the Groove feature, as you can see from these simulation views of the same example part.
Centerline simulation:
3D simulation:

Withdraw angle — Enter the angle that the tool withdraws along before returning for the next step. The angle is measured in degrees, counter-clockwise from the Z axis. See also Withdraw length.

Withdraw length — Enter the distance along the Withdraw angle line that the toolwithdraws before returning for the next step.
X finish allowance — Enter the amount of material to leave in the X direction after the Rough pass.

You can enter a positive or negative value, but X finish allowance and Z finish allowance must be both positive or both negative.

X leave allowance — Enter the amount of material to leave in the X direction after the Finish pass.
You can enter a positive or negative value, but **X leave allowance** and **Z leave allowance** must be both positive or both negative.

**X semi-finish allowance** — Enter the amount of material to leave in the X direction after the Semi-finish pass.

**Z semi-finish allowance**

**X semi-finish allowance**

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Turn/Bore** (see page 1689) tab.

You can enter a positive or negative value, but **X semi-finish allowance** and **Z semi-finish allowance** must be both positive or both negative.

**Z finish allowance** — Enter the amount of material to leave in the Z direction after the Rough pass.
This parameter enables you to specify a separate finish allowance in the Z-axis direction. This is the amount of material to leave in the Z direction after the roughing pass.

1. **Z finish allowance**
2. **X finish allowance**

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Turn/Bore** (see page 1689) tab.

You can enter a positive or negative value, but **X finish allowance** and **Z finish allowance** must be both positive or both negative.

**Z leave allowance** — Enter the amount of material to leave in the Z direction after the Finish pass.
1. Z leave allowance
2. X leave allowance

You can enter a positive or negative value, but **X leave allowance and Z leave allowance must be both positive or both negative.**

**Z semi-finish allowance** — Enter the amount of material to leave in the Z direction after the Semi-finish pass.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Turn/Bore** (see page 1689) tab.

You can enter a positive or negative value, but **X semi-finish allowance and Z semi-finish allowance** must be both positive or both negative.

**Number of passes**

This parameter specifies the number of steps to the bottom of the thread. You can specify either **Fixed** or **Calculate**. If you select Fixed, then you must enter the total steps required for the threading operation in the **Passes** field. If you select Calculate, then the number of steps for the threading operation is calculated by the system. Additionally, if you select Calculate, then you must supply data for the **Step 1**, **Step 2**, and **Minimum Infeed** fields.
Taper angle

**Taper Angle** refers to the angle, measured clockwise from horizontal, for the thread.

![Taper Angle Diagram]

Total stock (turning)

The **Total stock** attribute changes the way that the feature is roughed. Instead of roughing within the boundaries of the stock, the region that is roughed is determined by offsetting the feature's curve by the total stock amount. The toolpaths are then performed parallel to the feature's curve.

![Total stock Diagram]
**Boring tab (TURN)**

You can use the Boring tab of the Turning Feature Properties (see page 1351) dialog to edit the machining settings of a Boring feature.

![Boring tab](image)

**Auto Round**

This turning attribute applies to both rough and finish passes. When Auto round is enabled, FeatureCAM automatically inserts arc moves to connect two non-tangent elements. The effects are:

- Minimum of wasted motion by the machine; however, the posted part program may be slightly longer in the number of blocks used.
- Burrs are removed, but otherwise the part has the same shape and dimensions given by the feature curve because the radius of the inserted arc is the same as the tool nose radius.
- Machine motion is smoother.
This is an example with **Auto round** turned off:

This is the same example with **Auto round** turned on:

You can set the default value of this attribute for the current document in the *Machining Attributes* (see page 1591) dialog. Set it on the *Turn/Bore* (see page 1689) tab.

**Clearance**

At the beginning of an operation, the tool rapid to a point that is a distance away from the beginning of the toolpath. This distance is the **Clearance**.

The clearance is also used to calculate the move at the end of the operation (except for an ID Groove feature), unless **Use clearance as finish withdraw length** is deselected on the **Leads** tab.
For an ID Groove feature, the **Clearance** attribute is not used for the exit point. For safety reasons, by default the center line of the tool (holder plus exposed insert) is withdrawn exactly along the center line of the Groove, for example:

1. **ID Groove feature**
2. Entry point, determined by the **Clearance** attribute
3. Exit point
4. Center line of tool (holder plus exposed insert)

You can override this and control the retract point precisely using the **Endpoint** attribute. This image shows the same example, but with an **Endpoint** set at 1:

The location of these points is also controlled by the **Engage Angle** and **Withdraw Angle**.

If you are using Tool Nose Radius Compensation, **Lead In Dist** is used instead of **Clearance**.

**Constant DOC** — See **Depth of cut**

**Depth of cut**

Enter a step increment for each pass that the roughing routine performs on the part. The interpretation of **Depth of cut** depends on the **Constant DOC** setting in the **Turn/Bore** (see page 1689) document-level options.
If Constant DOC is deselected, the Depth of cut value you set is the maximum depth of cut for the feature. If the Depth of cut evenly divides the depth of your feature, your increment is used. If it results in a final pass that is quite shallow, the Depth of cut is adjusted to result in even roughing passes. For example if you have a feature that is 0.5 inches deep and specify a Depth of cut of 0.4, the feature is roughed in two even passes 0.25 inches deep instead of one pass of depth 0.4 inches and another pass with depth of 0.1 inches.

If Constant DOC is selected, the feature is cut using this depth for each pass. With Constant DOC selected, you can also list a series of depths, separated by commas, to control the depth of each cut. For example a Depth of cut specified as 0.25, 0.15, 0.1 results in the first pass being cut at 0.25 inches, the second at 0.15 inches and the remaining pass at 0.1 inches. If there are more cuts than depths specified, the last depth is repeated.

End point

Start point and End Point attributes are available on all turn operations. If the Start point is set, the center of the tool tip rapids to this point at the start of the operation. If the End point is set, the center of the tool tip rapids to this point at the end of the operation.

To set the value for Start point and End point, you can click the Pick XYZ Location button next to the New Value field at the bottom of the dialog and click the location in the graphics window. You can also type in the name of a linear curve and the tool follows this curve on part entry or exit.
You cannot pick the curve graphically.
The image below shows an unusually shaped tool that requires a start curve ① to control precisely.

You can set FeatureCAM to feed (see page 1708, see page 1404) from the Start point (or the end of a start curve) to the beginning of the toolpath.

Rough engage angle — Enter the angle at which the tool enters the stock for boundary moves. This attribute is available for the rough pass when TNR comp is off. For the Semi-finish and Finish pass, this attribute is available on the Leads (see page 1416) tab.

When TNR comp is off, the part entry angle is controlled by the Engage angle attribute.

Engage angle
Enter the approach angle for the tool, measured away from the part. An angle of 0 approaches along the path. An angle of 90 approaches perpendicular to the path. If the beginning of a scan line begins with a shoulder, a value of 90 is used automatically for that scan line. The only valid values are 0 or 90 degrees.
The **Engage angle** and **Withdraw angle** are specified from the path (or extension of the path), relative to the side of the path that the tool is on, and the direction in which the tool is traveling. In the graphic below, Point 1 is the calculated engage point and the Point 6 is the calculated withdraw point.

![Graphical representation of toolpath angles]

1. Clearance
2. **Withdraw angle**
3. Clearance zone
4. **Engage angle**

**Feed from start** — This attribute applies to rough and finish turn and bore operations. If you are using a **Start point**, then enabling the **Feed from start** option ensures that the move from the Start point to the beginning of the toolpath is a feed move.

**Lead-in angle** — Enter the angle at which the tool enters the stock for boundary moves. This attribute is available for the rough pass if **TNR comp** is on. For the Semi-finish and Finish pass, this attribute is available on the **Leads** (see page 1416) tab.

When TNR comp is on, the part entry angle is controlled by the **Lead in angle** attribute.

Enter the angle for the lead-in move, measured counter-clockwise away from the part. An angle of $0^\circ$ approaches along the path. An angle of $90^\circ$ approaches perpendicular to the path.
**Lead-out angle** — Enter the angle for the lead-out move, measured clockwise away from the part. An angle of $0^\circ$ exits along the direction of path. An angle of $90^\circ$ exits perpendicular to the path. This attribute is available when **TNR comp** is on. For the Semi-finish and Finish pass, this attribute is available on the **Leads** (see page 1416) tab.

![Lead-out angle diagram](image)

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the **Op List** (see page 1553) to drag-and-drop operations to the order you want, the **Priority** is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Skip wall pass**

This attribute applies to turning and boring roughing passes. On a typical roughing pass, the tool follows these moves:

1. Move straight across the part. This is the black move in the diagram.
2. Move up the wall to remove any scallops, shown as the blue move.
3. Withdraw from the part at an angle, shown as the small angled move at the top of the blue move.
If **Skip wall pass** is enabled the second move (the blue one) is no longer performed. If you are using a tool that does not cut well in the upward direction, you should consider using this option. With **Skip wall pass** enabled, the toolpaths appear as in the image below.

For boring features, you can select how many passes to apply the **Skip wall pass** option to from the menu. For example, if you select 1, that means that the wall move is skipped for the first roughing pass but not for the other passes.

**Start point**

**Start point and End Point** attributes are available on all turn operations. If the **Start point** is set, the center of the tool tip rapids to this point at the start of the operation. If the **End point** is set, the center of the tool tip rapids to this point at the end of the operation.

To set the value for **Start point** and **End point**, you can click the **Pick XYZ Location** button next to the **New Value** field at the bottom of the dialog and click the location in the graphics window. You can also type in the name of a linear curve and the tool follows this curve on part entry or exit.
You cannot pick the curve graphically.

The image below shows an unusually shaped tool that requires a start curve 1 to control precisely.

You can set FeatureCAM to feed (see page 1708, see page 1404) from the Start point (or the end of a start curve) to the beginning of the toolpath.

Tool change location is the point where the tip of the tool moves before a tool change.

You can set this at a global machine level in the Post Options dialog.

Undercuts — Select from No checking, Adjust to tool geometry, and Remove all undercuts.

In the following example, the tool cutting the Turn feature has started to descend into the Groove feature. You can see this on the centerline simulation in the area marked:
You can also see that this is happening in the 3D simulation:

To avoid this situation, select **Remove all undercuts**.
With this option selected, the tool does not descend into the Groove feature, as you can see from these simulation views of the same example part.

Centerline simulation:
Withdraw angle — Enter the angle for the lead-out move, measured clockwise away from the part. This attribute is available when TNR comp is off. For the Semi-finish and Finish pass, this attribute is available on the Leads (see page 1416) tab.

This parameter specifies the angle between cross feed movement and the withdraw move. For both roughing and finishing passes this angle is measured against the roughing scanlines.

Withdraw length
Boundary
Clearance
Depth
An angle of $90^\circ$ retracts perpendicular to the roughing pass. An angle of $45^\circ$ pulls back away from the part and the chuck. An angle of $135^\circ$ pulls toward the chuck. The withdraw angle for finishing is not dependent on the shape of the feature curve. Even if no roughing pass is created, the withdraw angle for finishing pass is measured against the roughing scanlines.

The **Engage angle** and **Withdraw angle** are specified from the path (or extension of the path), relative to the side of the path that the tool is on, and the direction in which the tool is traveling. In the graphic below, Point 1 is the calculated engage point and the Point 6 is the calculated withdraw point.

![Engage and Withdraw angles diagram](image)

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Threading** (see page 1699) tab.

**Withdraw length** — This is the distance along the withdraw angle line that the tool withdraws before returning for the next step.

![Withdraw length diagram](image)
X finish allowance

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/Bore (see page 1689) tab.

You can enter a positive or negative value, but X finish allowance and Z finish allowance must be both positive or both negative.

Z finish allowance

This parameter enables you to specify a separate finish allowance in the Z-axis direction. This is the amount of material to leave in the Z direction after the roughing pass.
1. **Z finish allowance**
2. **X finish allowance**

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Turn/Bore** (see page 1689) tab.

You can enter a positive or negative value, but **X finish allowance** and **Z finish allowance** must be both positive or both negative.

**Threading tab (TURN)**

You can use the **Threading** tab of the **Turning Feature Properties** (see page 1351) dialog to edit the machining settings for a Thread feature.

Some of the **Threading** attributes are shown on this diagram:
Clearance

At the beginning of an operation, the tool rapids to a point that is a distance away from the beginning of the toolpath. This distance is the Clearance.

The clearance is also used to calculate the move at the end of the operation (except for an ID Groove feature), unless Use clearance as finish withdraw length is deselected on the Leads tab.

For an ID Groove feature, the Clearance attribute is not used for the exit point. For safety reasons, by default the center line of the tool (holder plus exposed insert) is withdrawn exactly along the center line of the Groove, for example:

ID Groove feature
Entry point, determined by the Clearance attribute
Exit point
Center line of tool (holder plus exposed insert)
You can override this and control the retract point precisely using the **Endpoint** attribute. This image shows the same example, but with an **Endpoint** set at 1:

The location of these points is also controlled by the **Engage Angle** and **Withdraw Angle**.

If you are using Tool Nose Radius Compensation, **Lead In Dist** is used instead of **Clearance**.

**End clearance** — Enter the distance that the tool feeds past the end of the thread (into the relief groove) before retracting from the part's surface.

You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Threading** (see page 1699) tab.

**End point**

**Start point** and **End Point** attributes are available on all turn operations. If the **Start point** 1 is set, the center of the tool tip rapids to this point at the start of the operation. If the **End point** 2 is set, the center of the tool tip rapids to this point at the end of the operation.
To set the value for **Start point** and **End point**, you can click the **Pick XYZ Location** button next to the **New Value** field at the bottom of the dialog and click the location in the graphics window. You can also type in the name of a linear curve and the tool follows this curve on part entry or exit.

*You cannot pick the curve graphically.*

The image below shows an unusually shaped tool that requires a start curve 1 to control precisely.

You can set FeatureCAM to feed (see page 1708, see page 1404) from the **Start point** (or the end of a start curve) to the beginning of the toolpath.

**Infeed angle** — Enter an unsigned, incremental value from the positive Z axis.

*You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Threading** (see page 1699) tab.*

**Priority**

Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

*If you use the **Op List** (see page 1553) to drag-and-drop operations to the order you want, the **Priority** is updated automatically.*

*Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

**Start clearance** — This value is the position to which the tool traverses before engaging into the workpiece.

*You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Threading** (see page 1699) tab.*

**Start point**
**Start point and End Point** attributes are available on all turn operations. If the **Start point** is set, the center of the tool tip rapids to this point at the start of the operation. If the **End point** is set, the center of the tool tip rapids to this point at the end of the operation.

To set the value for **Start point** and **End point**, you can click the **Pick XYZ Location** button next to the **New Value** field at the bottom of the dialog and click the location in the graphics window. You can also type in the name of a linear curve and the tool follows this curve on part entry or exit.

*You cannot pick the curve graphically.*

The image below shows an unusually shaped tool that requires a start curve to control precisely.

*You can set FeatureCAM to feed (see page 1708, see page 1404) from the **Start point** (or the end of a start curve) to the beginning of the toolpath.*

**Start threads** — If set to 1, a single thread is created. If set to 2 or 3, multiple start threads are created. The number of threads per inch (or per mm) for each thread is divided by the number of threads. For example, if you create a thread with 10 threads per inch with 2 start threads, then each thread is 5 threads per inch 180° apart.
Tool change location is the point where the tip of the tool moves before a tool change.

You can set this at a global machine level in the Post Options dialog.

Cutoff tab (TURN)

You can use the Cutoff tab of the Turning Feature Properties (see page 1351) dialog to edit the machining settings for a Cutoff feature.

Chamfer extend dist. — Enter extra space for the tool so that the tool does not start on the metal for the groove finish pass.

Clearance

At the beginning of an operation, the tool rapid's to a point that is a distance away from the beginning of the toolpath. This distance is the Clearance.

The clearance is also used to calculate the move at the end of the operation (except for an ID Groove feature), unless Use clearance as finish withdraw length is deselected on the Leads tab.
For an ID Groove feature, the **Clearance** attribute is not used for the exit point. For safety reasons, by default the center line of the tool (holder plus exposed insert) is withdrawn exactly along the center line of the Groove, for example:

1. **ID Groove feature**
2. **Entry point**, determined by the **Clearance** attribute
3. **Exit point**
4. **Center line of tool** (holder plus exposed insert)

You can override this and control the retract point precisely using the **Endpoint** attribute. This image shows the same example, but with an **Endpoint** set at 1:

The location of these points is also controlled by the **Engage Angle** and **Withdraw Angle**.

If you are using Tool Nose Radius Compensation, **Lead In Dist** is used instead of **Clearance**.

**Depth of cut**

Enter a step increment for each pass that the roughing routine performs on the part. The interpretation of **Depth of cut** depends on the **Constant DOC** setting in the **Turn/Bore** (see page 1689) document-level options.
If Constant DOC is deselected, the Depth of cut value you set is the maximum depth of cut for the feature. If the Depth of cut evenly divides the depth of your feature, your increment is used. If it results in a final pass that is quite shallow, the Depth of cut is adjusted to result in even roughing passes. For example if you have a feature that is 0.5 inches deep and specify a Depth of cut of 0.4, the feature is roughed in two even passes 0.25 inches deep instead of one pass of depth 0.4 inches and another pass with depth of 0.1 inches.

If Constant DOC is selected, the feature is cut using this depth for each pass. With Constant DOC selected, you can also list a series of depths, separated by commas, to control the depth of each cut. For example a Depth of cut specified as 0.25, 0.15, 0.1 results in the first pass being cut at 0.25 inches, the second at 0.15 inches and the remaining pass at 0.1 inches. If there are more cuts than depths specified, the last depth is repeated.

Dwell — Enter the number of seconds that you want the tool to dwell after plunging.

End point — See Start point

Peck retract dist. — This is the distance the tool retracts between plunges.

Priority
Enter the priority that the operation takes in the document. The lower the number, the higher priority the operation takes.

If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

Although you can specify the exact order of every operation by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

Start point
Start point and End Point attributes are available on all turn operations. If the Start point is set, the center of the tool tip rapid to this point at the start of the operation. If the End point is set, the center of the tool tip rapid to this point at the end of the operation.

To set the value for Start point and End point, you can click the Pick XYZ Location button next to the New Value field at the bottom of the dialog and click the location in the graphics window. You can also type in the name of a linear curve and the tool follows this curve on part entry or exit.

You cannot pick the curve graphically.

You can set FeatureCAM to feed (see page 1708, see page 1404) from the Start point (or the end of a start curve) to the beginning of the toolpath.

Tool change location — Set the point where the tip of the tool moves to before a tool change.

You can set this at a global machine level in the Post Options dialog.
Wire feature attributes (WIRE)

These tabs are available in the Feature Properties dialog for wire features:

- **Strategy** (see page 1468)
- **Start** (see page 1481)
- **Misc** (see page 1483)
- **Cutting Data** (see page 1487)
- **Leads Style** (see page 1489)

Strategy tab (WIRE)

You can use the Strategy tab of the Wire Feature Properties dialog (see page 1468) to edit the strategy attributes of a Wire feature.

Operations — Choose which operation(s) (see page 620) you want for your wire feature.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Wire EDM (see page 1716) tab.

Primary Cut/Offset Dir

For closed curves, the Primary Cut Dir attribute controls the direction of a cut. The options are CW (clockwise) or CCW (counter-clockwise).
For open curves the **Primary Offset Dir** attribute controls the direction of a cut. The options are **Left** or **Right**. These settings are relative to the machining-side setting.

\[ 
\begin{align*}
1 & \quad - \text{Machining side} \\
2 & \quad - \text{Primary offset direction is Right} \\
\end{align*} 
\]

\[ 
\begin{align*}
1 & \quad - \text{Machining side} \\
2 & \quad - \text{Primary offset direction is Left} \\
\end{align*} 
\]

You can set the default value of this attribute for the current document in the *Machining Attributes* (see page 1591) dialog. See the *Settings* (see page 1717) tab.

**Retract Length** — Enter the distance that the wire retracts from the part at the end of an operation.

The **Retract Length** attribute is used for **Retract**, **Stop**, and **Cutoff** operations.

\[ 
\begin{align*}
1 & \quad - \text{Retract length} \\
2 & \quad - \text{Stop length} \\
3 & \quad - \text{Wire path} \\
4 & \quad - \text{Inserted end position} \\
5 & \quad - \text{Normal contour start/end position} \\
6 & \quad - \text{Contour} \\
\end{align*} 
\]

**Use on both ends of skim passes** — Enable this option to apply the **Retract length** to both ends of skim passes. (The wire does not return to the start point at one end.)

The following example shows a retract and cutoff operation using the default behavior (**Use on both ends of skim passes** disabled):

1. End of retract pass 1, wire retracts by the **Retract Length**:
2. End of retract pass 2, wire retracts back to the start point:
3. End of retract pass 3, wire retracts by the **Retract Length**:
4. End of cutoff pass 1, wire retracts back to the start point:

5. End of cutoff pass 2, wire retracts by the Retract Length:

This is the same example with **Use on both ends of skim passes** enabled:

1. End of retract pass 1, wire retracts by the **Retract Length**:

2. End of retract pass 2, wire retracts by the **Retract Length**:

3. End of retract pass 3, wire retracts by the **Retract Length**:

4. End of cutoff pass 1, wire retracts by the **Retract Length**:

5. End of cutoff pass 2, wire retracts by the **Retract Length**:
**Stepover** — Enter the stepover amount between passes for Pocketing and Zigzag operations.

**Finish allowance** — This is the amount of material left after a Pocketing or Zigzag pass. Even if a **Cleanup Pass** is used, the finish allowance still remains.

**Cut Angle** — This sets the cutting angle for a Zigzag operation.

The angle is defined from the X-positive axis of the current UCS. Enter the angle in degrees.

**Cleanup Pass** — Enable this option to create a finishing cut at the end of a Zigzag operation.

The contour is cut with a contour parallel finishing path to remove any rough edges left by the stepover between passes.

**Stop length** — Enter the distance from the normal contour end position to the inserted stop or end position.

This parameter is used for **Retract**, **Stop**, and **Cutoff** operations.
Retract operation:

1. Contour
2. Wire path
3. Stop length
4. Normal contour start/end position
5. Inserted end position
6. Run-out

Stop operation:

1. Contour
2. Wire path
3. Stop length
4. Contour start/end position
5. Inserted stop positions

Cutoff operation (CW):

1. Contour
2. Wire path
3. Stop length
4. Normal contour start/end position
5. Inserted end position
6. Run-out

Cutoff operation (CCW):

1. Contour
2. Wire path
3. Stop length
4. Normal contour start/end position
5. Inserted end position
6. Run-out

Stop code — For Stop operations you can choose from:

- **M00** is program stop. This stop is always performed.
- **M01** is optional program stop. There is a setting on the machine tool to observe or skip these stops.

Overlap — Enter the distance by which the normal contour end position is overcut for Stop and Cutoff operations.
Stop operation:

1 - Contour
2 - Wire path
3 - Contour start/end position
4 - Inserted stop positions
5 - Stop length
6 - Overlap

Cutoff operation (clockwise):

1 - Contour
2 - Normal contour start/end position
3 - Inserted end position
4 - Run-out
5 - Stop length
6 - Overlap

Cutoff operation (counter-clockwise):

1 - Contour
2 - Normal contour start/end position
3 - Inserted end position
4 - Run-out
5 - Stop length
6 - Overlap

The run-off back to the end position of the contour is at an angle. On some machines (for example, Agie), an angled run-off may not be allowable.

If the overlap is too large, a triangular piece of material is left, which may fall and halt the machine.

Contour overlap — This is used only by the Contour operation. It is the amount by which the Contour operation overlaps.
**Total Stock** — This applies to Pocketing and Zigzag operations. This parameter sets the amount of material removed from the contour when using the **Offset Method** of **Offset Toolpath**. When the value is 0, only one cutting pass is made.

*The calculated wire path represents the center of the wire; the amount remaining on the curve is dependent on the cutter compensation values.*

1. - Leave allowance
2. - Contour stock
3. - **Total stock**

**Linear Approx** is for 4-axis EDM. All arcs are converted into small line segments. This parameter controls how finely arcs are refined into lines. The smaller the number, the more points arcs will be broken down into.

*You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Settings** (see page 1717) tab (where it is called 4 axis/Rapid toolpath linear approx.).*

**Keep wire vertical at retract** — This keeps the wire vertical after Retract and Cutoff operations for 4-axis features.

The following example shows the end of a Retract operation with **Keep wire vertical at retract** selected:
This is the same example with **Keep wire vertical at retract** deselected:

---

**Skim Pass Options** (see page 1475) button

You can set many of these attributes as defaults for the current document in the **Machining Attributes** dialog on the **Settings** (see page 1717) tab.

---

**Skim Pass Options (WIRE)**

Click **Skim Pass Options** at the bottom of the **Strategy** tab (see page 1468) to display the **Skim Pass Options** dialog:

![Skim Pass Options dialog](image)

---

The **Skim Pass Options** dialog used to be called **Offset Options**.

**Offset method** (see page 1479) — This controls whether the offsetting of the wire path is performed on the machine using cutter compensation or by FeatureCAM. Select **Cutter comp** to perform the offsetting on the machine, or **Offset Toolpath** if you want FeatureCAM to perform the offsetting.

**Total passes** — Enter the total number of passes to take to cut the feature. If a feature has a Retract, Stop, or Cutoff operation these operations are each performed **Total Passes - Contour Passes**. If a feature has a Contour operation, **Total Passes** must be at least 2. **Total Passes** must be between 1 and 9.

**Contour passes** — This is the number of passes to take for the Contour operation for a Retract, Stop, or Contour operation.
**Cut all operations on each curve first** — For features with multiple curves, enable this option to do all operations on each curve before moving on to the next curve. If the option is disabled, the first operation is done on all curves, then the next operation, and so on.

**Cut the first pass on each curve first** — For features with multiple curves, using multiple-pass operations, select this option to cut the first pass on each curve first rather than cut all passes on one curve before moving on to the next.

For features with multiple curves, such as the die below, the default behavior is to cut all the passes for one curve before moving on to the next curve.

![Die with multiple curves](image)

1 - curve1  
2 - curve2  
3 - curve3

If you want to cut the first pass on each curve first, select the **Cut the first pass on each curve first** option:

This option is for 2-axis only and is available for the following operations:

- Cutoff
- Stop
- Contour only (not, for example, a Stop plus Contour combination)
For the example above with **Retract** and **Cutoff** operations, the default behavior is to cut the three **Retract** passes on **curve1**, then the three **Retract** passes on **curve2**, then the three **Retract** passes on **curve3**. It then cuts all three **Cutoff** passes on **curve1**, then all three **Cutoff** passes on **curve2**, then all three **Cutoff** passes on **curve3**.

With **Cut the first pass on each curve first** selected for the same example, FeatureCAM cuts the **Retract** operation as before. It then cuts the first **Cutoff** pass on **curve1**, then the first **Cutoff** pass on **curve2**, then the first **Cutoff** pass on **curve3**.
It then cuts the remaining two **Cutoff** passes on each curve.

Because the first **Cutoff** pass of each curve needs the attention of the machinist to remove the core, the advantage of using **Cut the first pass on each curve first** is that the machinist can remove the cores of all the curves together, and the machine can finish cutting the part without intervention.

**Single Cutoff Pass** — Select this option to use one pass for the Cutoff operation. If you are using a Cutoff operation with a Retract operation, deselect this option to use the same number of passes as for the Retract operation.

**Leave allowance** is the amount of material to leave after the Retract, Cutoff, Stop, and Contour operations.

** negative Leave allowance acts as an overcut.**

**Uni-Directional**
Applies to Contour, Stop, Retract, and Cutoff operations that use the **Offset Method** of **Cutter Comp**.

For multiple passes, the cutting direction for each following pass is *not* reversed and all passes take place in the defined direction. At the end of each pass the wire is cut and the machine re-positions to the start point for the next pass.

**Uses Macro if available**

Applies to Contour, Stop, Retract and Cutoff operations that use the **Offset Method** of **Cutter Comp**. Available for 2-axis features only.

This option activates the automatic creation of sub-programs for the machining of operations. You must define the format and output of sub-programs in the post processor. The use of sub-programs is particularly useful when producing chain programs. In this case each machining contour is written to a separate sub-program. The main calling program then contains only the movements required to move to the next start point.

For multiple pass, if the **Uni-Directional** option is enabled then only a single macro is output containing a single pass.

**Offset method (WIRE)**

The **Offset Method** attribute controls whether the offsetting of the wire path is performed on the machine using cutter compensation or by FeatureCAM. Select **Cutter comp** to perform the offsetting on the machine, or **Offset Toolpath** if you want FeatureCAM to perform the offsetting.

To cut a workpiece to the finished size the Wire radius compensation function on the NC-machine is normally used. Activating this function with a particular value causes the machine to calculate a new path for the center of the wire. The compensation value is normally composed of the wire radius plus the spark gap allowance plus any finishing allowance that may be required. The compensation value is normally entered in a **Compensation Register** on the machine.

1. Stock allowance
2. Wire
3. Spark gap
Compensation (Offset)

If the erosion of a workpiece needs to be made in several cuts (roughing and finishing), each cut normally uses a different compensation value or compensation register. The values for the compensation are often given in a table supplied by the machine builder or automatically entered in the compensation registers via the technology tables built into the controller.

In every case you should ensure that the appropriate linear lead-in and lead-out moves are contained within the program to enable the compensation to be switched on and off.

The output of the commands to activate and deactivate the compensation is automatically carried out by the software on the first and last moves.

On the machine

When using the Wire Compensation command, the center path of the wire is calculated and corrected directly by the nc-machine. The compensation amount is normally entered in a Compensation Register on the machine controller and activated by an appropriate command within the nc-program. The format of the command to activate the compensation and to control the compensation direction is dependent upon the nc-machine type. The FeatureWIRE software supports the output of these commands both for single and multiple cuts (backwards/forwards cutting or Main/Sub-Programs).

The following parameters, in the Skim Pass Options (see page 1475) dialog, control the use of wire compensation on the machine:

- **Total Passes**
- **Leave Allowance**
- **Contour Passes**
- **Uni-Directional**
- **Uses Macro if Available**

In FeatureCAM

If the wire radius compensation is carried out by FeatureCAM the appropriate compensation value and direction is automatically used to produce a wire path that is already corrected. The path cannot be altered by changing the offset register of the nc-machine. This may be necessary, for example, when cutting a contour which contains elements or arcs which are smaller than the required compensation amount and thus cannot be cut using the machine registers.

The following parameters control the use of wire compensation:

- **Total stock** (see page 1725)
Leave Allowance (see page 1475)
Stepover (see page 1725)
Contour stock (see page 1725)

**Start tab (WIRE)**

You can use the **Start** tab of the **Wire Feature Properties** dialog (see page 1468) to specify the start point of a Wire feature.

![Image of Wire Feature Properties dialog]

Leads are non-perpendicular by default. If you want the lead to be perpendicular, select the **Pick only perpendicular lead** box before you click the **Pick location** button. Click the start point and FeatureCAM highlights the corresponding perpendicular point when you mouse-over the curve segment. **Click to accept it.**

**Die and Punch Features**

For 2 and 4-axis Die or Punch features, a start point is automatically calculated. You can change the start point for a Die or Punch feature using the following procedure:

1. If the feature has multiple curves, select the appropriate curve from the **Curve** list.
2. Click the **Pick location** button.
3. Click the new **Start point**.
You must pick on the appropriate side for the feature type. For die features, pick on the inside. For punch features, pick on the outside. For side features pick on the machining side. If you pick a point in the incorrect side, the approach moves will gouge the part.

4 Select the segment of the curve to connect the start point to by moving the mouse over the feature until the segment of the curve you want is highlighted and then click the mouse.

5 The X and Y coordinates of the new start point are displayed in the dialog.

If you want to force the wire to start on the curve, you cannot simply double-click. You must move your second pick (the one that indicates the curve segment) slightly so that you are not picking the same point twice.

If you are creating a 4-axis feature, follow the above procedure for both the upper and lower curves.

Side Features

For 2 and 4-axis side features, the default is to start at the first point of the curve. To add new linear moves at the start or end of a curve:

1 If the feature has multiple curves, select the appropriate curve from the Curve drop down list.

2 Click the Pick point button for either the start or end point. A line will rubber-band from the current start of end point.

3 Click a point at the new location.

4 Alternatively, you can simple enter the new end point coordinates.
**Misc. tab (WIRE)**

You can use the Misc tab of the Wire Feature Properties dialog (see page 1468) to edit machining options of a Wire feature.

### Wire Cutting/Threading

This offers settings to control the output of wire threading or wire cutting commands.

- **Off** — No wire threading or wire cutting commands are output in the NC-program.
- **Both** — The commands to thread the wire and cut the wire are output automatically at the start and end of each operation within the feature.
- **Cut** — The wire cutting command is output at the end of each operation within the feature (but no wire thread command at the start). When viewing the toolpath in centerline simulation, the Cut location is denoted with a small circle.
- **Thread** — The wire threading command is output at the start of each operation within the feature (but no cut wire command at the end). When viewing the toolpath in centerline simulation, the Thread location is shown as a small plus sign.

### Modify outside corners

A radius is inserted into the wire path at each outside sharp corner. This can be useful for reducing unnecessary movements and for producing cleaner corners.
This example shows the original toolpath:

If Modify outside corners is enabled, the toolpath rounds sharp corners, for example:

The size of the outside corner depends on the Radius you set, for example:

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Misc. (see page 1735) tab

Modify inside corners

Circular

A circle is inserted in the corners. The center of the circle lies on the corner point.

This example shows the original toolpath of an inside corner:

If Modify inside corners is enabled, with an Inside corner style of Circular, FeatureCAM inserts a circle into sharp inside corners, for example:
The size of the circle depends on the **Radius** you set, for example:

Enter a **Center shift** to offset the center of the circle.

Positive **Center shift**: No **Center shift**: Negative **Center shift**:

Select **Auto adjust the radius** to enable FeatureCAM to automatically adjust the radius of the circle according to how sharp each corner is. A 45 degree corner uses a circle of the specified **Radius**. For sharper corners with angles less than 45 degrees, the radius of the circle is increased, for less sharp corners with angles greater than 45 degrees, the radius of the circle is reduced. Deselect **Auto adjust the radius** to always use the specified **Radius**.

**Triangular**

The path follows a triangular shape at an inside corner. Specify the length and width of the triangle.

**Rounded**

The path rounds inside corners. Specify the radius.

---

*You can set the default value of this attribute for the current document in the **Machining Attributes** (see page 1591) dialog. See the **Misc.** (see page 1735) tab.*
Modifying both inside and outside corners

Both inside and outside corners are modified as shown below.

Original path curve with inside corner (shown in blue):

Resulting NC output (shown in pink):

Resulting part shape:

Auto Round

If **Auto round** is enabled, arcs are inserted at all sharp corners. This applies only if **Cutter comp** is enabled and you have a leave allowance or if **Cutter comp** is not set. If you have enabled **Modify outside corners**, it does not perform any further rounding on these corners. It rounds inside corners (even if **Modify inside corners** is enabled) by inserting an arc before and after the circular corner as shown below: The radius of the inserted arcs is equal to the radius of the wire.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Misc. (see page 1735) tab.
**Cutting Data tab (WIRE)**

The Cutting Data tab of the Wire Feature Properties dialog (see page 1468) displays the feed, water, and cutter compensation registers for each pass of the operation selected in the Tree view.

The use of all these settings depends on the machine and controller type. You can set these values automatically from the current material database, or enter them manually.

Most modern NC machines have an integrated technology database which the machine uses to set up the optimum cutting conditions for the workpiece. In this way the cutting is accurate and uses the full power of the machine. These settings for the cutting conditions are usually stored in Registers in the controller and are activated by particular codes in the NC program. FeatureCAM enables you to define these codes for up to nine cuts (either backwards/forwards cutting or with sub-programs). You can also load pre-defined settings from a database you have prepared.

**Feed** — This is used to select the generator setting on the wire machine. The generator setting controls the cutting speed of the machine by setting parameters such as strength, pulse time, and pause time between pulses of the electrical current used to produce the spark. These parameters vary with the workpiece material, height, and so on.

**Water** — This is used to select the machine register that defines the water flow during cutting. The parameters that are controlled include the water pressure, flow rate, and so on.
**Comp. Reg.** — This sets the number of the Compensation Register of the NC machine, which is used for wire radius compensation. The value held within this register is the amount by which the wire is corrected to the left or right of the defined wire path when the function for wire correction on the machine is switched on (normally G41 or G42).

**Comp. Val.** — This sets the wire radius correction value for the given offset register on the machine. The value is normally the sum of the wire radius + spark gap + any finishing allowance required. For most machines, the compensation value is referenced through the compensation register, so there is no need to set this value.

You can change the labels of these columns in the **Cutting Conditions Names** dialog in XBUILD. Select **CNC-Info > Cutting Conditions Names** from the XBUILD menu.

**Post Vars.** button — displays the **Post Variables** dialog (see page 1656).

**Cutting Data example (WIRE)**

In the example above, **C1** is the first pass and **C2** is the second pass.

**Feed** is the feed rate.

**Water** is where you enter your EPAK values. For an EPAK value of E1251, enter **1251**.
You should have documentation with your machine that lists the EPAK values for various materials and thicknesses. So, for example, it should give you one EPAK value for 0.5 inch thick aluminum, another for 0.75 inch aluminum, another for 0.5 inch titanium, and so on. Each EPAK contains settings for 'On Time', 'Off Time', 'Dwell', 'Voltage', and so on.

Comp. Reg associates each Comp. Val with a particular pass and appears as H11, H12, and so on in the NC code.

Comp. Val is basically the wire radius plus the wire offset. Comp. Vals should also be in your machine's documentation.

Here is the NC code for the above example, with the values from the table marked in bold:

```
N10 G90
N15 M101
N20 M106 Q-2
N25 G53 G92 X-95.956 Y-61.722 Z0
N30 M20 (WIRE THREAD LN)
N35 M78 ( FILL TANK )
N40 M78
N45 M80 ( FLUSHING ON )
N50 M82 ( WIRE FEED ON )
N55 M84 ( MACHINING ON )
N60 M90 ( ADAPTIVE CONTROL ON )
N65 H11=0.006
N70 E1251 F0.090
N75 G01 G42 X-369.727 Y-348.437 H11
```

Leads Style tab (WIRE)

You can use the Leads Style tab of the Wire Feature Properties dialog (see page 1468) to edit the lead moves of a Wire feature.

![Leads Style tab](image)

This tab applies to 2-axis features with no taper.
**Style** — There are several choices for the type of moves for leading in and out of an operation.

**Direct** — This style moves straight from the start point to the contour.

There are four different ramp styles that arc onto the contour. The ramp styles available are:

- **Teardrop:**
- **Bullet:**
- **Arc:**
- **U-Shape:**

To set a ramp style, select the **Style** from the list and enter a **Diameter for lead moves**.
The same diameter arc is used to ramp off the contour and then the wire returns to the start point.

You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Start (see page 1730) tab.

Renaming features
When you create a feature, FeatureCAM automatically generates its name.
To change the name of a feature:
1 Select an item in the graphics window or the Part View panel.
2 To display the Rename Object dialog:
   ▪ Select Edit > Rename from the menu.
   ▪ Select Rename from the context menu.
   ▪ Press the F2 key.
3 Enter the New Name in the Rename Object dialog.
4 Click OK.

Deleting features
Use one of the following methods to delete a feature:
▪ Select a feature in the graphics window or the Part View, then press the Delete key.
▪ Select a feature in the graphics window or the Part View, then select Edit > Delete from the menu.
▪ Right-click a feature in the graphics window or the Part View and select Delete from the context menu.

Move features to a different Setup
To move a feature to a different Setup:
1 Select Manufacturing > Process Plan from the menu to display the Process Plan (see page 1492) dialog.
   Two Setups are displayed in the dialog, with the list of features on each Setup listed below its name. If there is only one setup it is displayed in both lists.
2 From the left Setup list, select the Setup which contains the feature you want to move.
The features on that setup are listed in the left field.

3 From the right Setup list, select the Setup you want to move the feature to.

The features on that setup are listed in the middle field.

4 In the left field, select the feature you want to move.

5 Click **Move item to another setup** to move the feature to the middle field.

6 Click **OK** to close the dialog.

**Process Plan dialog**

Use the **Process Plan** dialog to move features between Setups, remove features or Setups from the manufacturing plan, or add features to the plan. The order of operations in the **Process Plan** dialog is only the initial manufacturing order. Settings in the Default Operation attributes and the Ordering (see page 1495) dialogs can override this order.

To display the **Process Plan** dialog, select **Manufacturing > Process Plan** from the menu.

The left and middle boxes show the features contained in the Setups whose name is listed above the box. If you have only one Setup in your part, both of these boxes display the operations of your single stage. The **Process Plan** list contains the names of all Setups in your process plan.

**Process Plan** — This displays a list of Setups in the model.

**Setup** — This lists all the Setups in the part. Select a Setup from the list and the features contained in the Setup are displayed in the **Feature** list.

**Feature** — This lists the features for each Setup.

**Delete item** — Click this button to delete the selected Setup in the **Process Plan** list or Feature in the **Feature** list.

**Move item to another setup (right)** - moves the selected manufacturing operation(s) from the left Setup to the right Setup. For example, if your part has a **top** and **roughbot** Setup. With the **roughbot** Setup selected in the left Setup list (the first stage of the manufacturing process), the operations assigned to this Setup are displayed in the left field. If you select the **top** Setup in the right Setup list, the operations for this setup are displayed in the middle field. If you select an operation in the **roughbot** Setup and then click **Move item to another setup (right)**, the operation is assigned to the **top** Setup, and is displayed in the middle field.
Move item to another setup (left) - moves the selected manufacturing operation(s) from the right Setup to the left Setup.

Move item up - moves the selected feature or Setup up in the list by one place.

Move item down - moves the selected feature or Setup down in the list by one place.

Including and excluding features for a process plan

When you create a feature, it is automatically included for manufacturing in the current Setup of the process plan. Sometimes, it is convenient to exclude a feature from the manufacturing plan without deleting the feature.

The Include In Plan and Exclude from Plan options of the Edit menu toggle the inclusion of the selected feature in the manufacturing plan.

You can use the Process Plan dialog to select which features and Setups to include in the plan, and easily correct any oversights you might make with the include and exclude options.

- Including a feature in the process plan (see page 1493)
- Excluding a feature from the process plan (see page 1493)
- Checking if a feature is included in the process plan (see page 1493)

If a feature is not included in the process plan, the toolpaths, and the NC code generated by the post processor exclude that feature entirely.

Including a feature in the process plan

To include a feature in the manufacturing plan:

1. Select a feature in the graphics window or the Part View.
2. Select Manufacturing > Include in Plan from the menu.

Excluding a feature from the process plan

To exclude a feature from the manufacturing plan:

1. Select a feature in the graphics window or the Part View.
2. Select Manufacturing > Exclude from Plan from the menu.

Checking if a feature is included in the process plan

To check whether a feature is included in the manufacturing plan:

1. Select a feature in the graphics window or the Part View.
2 Select **Manufacturing** from the menu. There is a black dot next to either **Include in Plan** or **Exclude from Plan**, which shows the current setting for the selected feature.

**Ordering features for manufacturing**

You create features, and FeatureCAM splits them into operations for manufacturing. For example, from a Hole feature, FeatureCAM creates spotdrill, drill, and countersink operations. FeatureCAM uses logic to ensure that operations created from a feature are manufactured in the correct order. For example, a Hole is spot-drilled before it is drilled and a Pocket is roughed before it is finished.

Each Setup can contain multiple features, which are split into operations. By default, a part is manufactured in the order it is created. You can change the order of manufacture using the **Process Plan** (see page 1492) dialog, or you can set automatic Ordering optimizations.

You can use the following methods to order features for manufacturing:

Op list tab (see page 1494)

Ordering optimization (see page 1495)

Using groups to determine manufacturing order (see page 1496)

**Op List tab**

The **Op List** tab of the **Results** panel displays all the operations in the part and the machining order, and contains options for editing and reordering operations.

Each row displays the operation, the feature that the operation is created from and the tool used to cut the feature.

If there is an **Error** ! or a **Warning** ▲ icon in the left hand margin, you have an error or warning (see page 194) for this operation.

This tab has three main functions:

- Simulation control (see page 1550)
- Operation ordering (see page 1553)
- Operation editing (see page 1554)
**Ordering optimization**

You can use the **Ordering** dialog to automatically optimize the manufacturing process.

![Ordering dialog](image)

Clicking **Play** in the **Simulation** toolbar displays the **Ordering** dialog by default.

*To stop the **Ordering** dialog displaying, select **Don't show this dialog next time in the **Ordering** dialog.***

*If you want the **Ordering** dialog to display, select **Manufacturing > Machining Attributes** from the menu, then on the **Operations tab** of the **Machining Attributes** dialog, in the **Ordering section**, deselect **Don't ask at tool path simulation.***

The **Ordering** dialog displays the current Setup, CNC File, Tool Crib, and has an option for operation ordering. There are different kinds of automatic operation ordering that work together to speed up the manufacturing of your part.

Depending on the type of part, click one of the following buttons to display the dialog for changing the machining order:

- **Mill Ordering** — displays the **Automatic Ordering Options** (see page 1553) dialog, which contains options for setting the machining order for Milling parts.

- **Turn Ordering** — displays the **Automatic Ordering Options** (see page 1553) dialog, which contains options for setting the machining order for Turning parts.

If the model contains a Points list Pattern, click **Sorting** in the **Pattern - Dimensions** (see page 879) dialog to display the **Point List Sorting** dialog, where you can change the machining order of the Pattern.
You can also use the Op List tab (see page 1494) to change the order of operations.

**Using Groups to determine manufacturing order**

You can use Groups (see page 869) to collect features together, but they also provide a powerful level of control over the order of manufacturing operations.

When you create a Group, select **Ordered** on the **Dimensions** tab of the **Group Properties** (see page 871) dialog to specify the manufacturing order of the Objects in the Group. If you created an ordered Group with a Hole feature and a Pocket feature, then the operations are performed in the following order:

- spotdrill Hole
- drill Hole
- rough Pocket
- finish Pocket

You can mix ordered and unordered Groups in your setup for more flexibility in ordering operations. For example, perform all drilling operations first and all milling operations last:

1. Create a mixture of Hole and Milling features (see page 636).
2. Create an unordered Group of Hole features:
   a. Select the Hole features in the graphics window, then select **Construct > Pattern and Group > Group** from the menu to display the **Feature Group Properties** (see page 871) dialog.
   b. On the **Dimensions** tab of the **Group Properties** (see page 871) dialog, deselect **Ordered**, then click **OK** to close the dialog.
      This creates a Group of Holes with a default manufacturing order.
3. Rename the Group of Holes to **holegroup**:
   a. In the **Part View** panel, right-click the Group of Holes and select **Rename** from the context menu to display the **Rename Object** dialog.
   b. In the **Rename Object** dialog, enter **holegroup** in the **New Name** field.
   c. Click **OK**.
4. Create an unordered Group of Milling Features:
   a. Select the Milling features in the graphics window, then select **Construct > Pattern and Group > Group** from the menu to display the **Feature Group Properties** (see page 871) dialog.
b On the **Dimensions** tab of the **Group Properties** (see page 871) dialog, deselect **Ordered**, then click **OK** to close the dialog.

This creates a Group of Milling features with a default manufacturing order.

### 5 Rename the Group of Milling features to **millgroup**:

a In the **Part View** panel, right-click the Group of Milling features and select **Rename** from the context menu to display the **Rename Object** dialog.

b In the **Rename Object** dialog, enter **millgroup** in the **New Name** field.

c Click **OK**.

### 6 Create a Group which contains the two existing Groups:

a In the **Part View** panel, select **holegroup**.

b Hold the **Shift** key and select **millgroup**.

c Select **Construct > Pattern and Group > Group** from the menu to display the **Feature Group Properties** (see page 871) dialog.

d On the **Dimensions** tab of the **Group Properties** (see page 871) dialog, select **Ordered**, then click **OK** to close the dialog.

### 7 Rename the Group to **ordered**:

a In the **Part View** panel, right-click the Group and select **Rename** from the context menu to display the **Rename Object** dialog.

b In the **Rename Object** dialog, enter **allgroup** in the **New Name** field.

c Click **OK**.

When **allgroup** is manufactured, all the Holes are made first, then the Milling features are made. Within each group, FeatureMILL optimizes the order so that tool changes are minimized. For example, in **holegroup**, all spotdrilling operations are done first, followed by all drilling operations. Then all milling operations are completed. Using Groups, you control the order of manufacturing operations without sacrificing the help that FeatureMILL can provide.

**Paste Special dialog**

The **Paste special** dialog enables you to replicate or transfer objects or their settings between FeatureCAM part files.

You can display the **Paste Special** dialog in different ways depending what you want to do:
To duplicate features in the document:

a. Select a feature in the graphics window or Part Tree.

b. Select Edit > Copy from the menu to copy the selected objects to the clipboard.

c. Select Edit > Paste Special from the menu.

To insert features from the Part Library:

a. Select the Construct > Part Library menu option to display the Part Library dialog.

b. Select a feature in the Part Library dialog and click Paste.

To insert Part Library features using the New Feature wizard:

a. In the New Feature wizard, under From Feature, select User and click Next.

b. On the User defined feature page, select a feature and click Next.

These options are displayed in the Paste Special dialog:

- Paste the clipboard contents into the current setup — This inserts the objects in the clipboard into the current FeatureCAM part document. This is the same as selecting Edit > Paste from the menu.

  *If you paste into the same document that you copied from, the new copy is placed on top of the original.*

- Paste the clipboard... Select a new location — This inserts the objects in the clipboard into the current FeatureCAM part document, and the Paste Special - Reference (see page 1499) dialog is displayed which you can use to position the objects.

- Copy attributes from feature to another feature — The Paste Special - Attributes dialog is displayed, which you can use to apply the machining attributes of the copied feature to other features in the model. This option is only available if the clipboard contains a single feature.

  *The Undo button is unavailable after using Copy attributes from feature to another feature.*

- Paste the clipboard contents into the current setup — The Select New Profile Curve(s) dialog (see page 1501) is displayed, which you can use to replace the pasted feature’s boundary curve with a curve in the document.
**Paste Special - Reference**

Use the Paste Special - Reference page to specify a reference point for pasting features.

1. To specify the location of a reference point, enter the coordinates of a point in the X, Y and Z fields, or click Pick location and select a point in the graphics window.

2. Click Next to display the Paste Special - Location (see page 1499) page, which you can use to specify a new location point.

The copied objects will be translated between the point specified in this dialog and the point specified in the Paste Special - Location page.

   To locate the feature using polar coordinates, select Polar on the Location page. The Reference page has no effect when using polar coordinates.

**Paste Special - Location**

The Paste Special - Location page enables you to specify a new location point for pasting features.

1. Select whether you want to locate the new feature using XYZ or polar coordinates.

   You can only use polar coordinates to locate individual features, not groups or multiple features.

   - For XYZ coordinates, enter the coordinates of a point in the X, Y, and Z fields, or click Pick location and select a point in the graphics window.

   The copied objects are translated between the point specified in the Paste Special - Reference (see page 1499) page and this point.

   - For polar coordinates, enter the Radius and Angle to offset the new feature from the setup location, and enter the Z value to specify the Z height of the feature above the setup.

2. Click Preview to display a preview of the objects in the graphics window.

3. Click Finish to create the new objects and close the wizard.

**Paste Special - Attributes**

**Feed/speed overrides** — Applies the values for feed and speed that have been explicitly set on the copied feature to another feature. This option is available only if the copied feature has feed or speed values that have been changed from the defaults.
Tool overrides — Applies the tool information from the copied feature onto another feature. This option is only available if the tool options used to machine the feature have been changed from the default.

Machining attributes

- Copy only the attributes that were set on the feature — Applies non default attributes from the copied feature to another feature. This affects all tabs of the Feature Properties dialog except the Dimensions tab.

- Copy all machining attributes in effect for the feature — All attributes of the copied feature, including the default attributes, are applied to another feature.

And set them on the following feature(s) — Apply the selected attributes to these features.

To add a feature to this list:

- Select a feature in the graphics window, then click Add from selected items.

- Click Pick feature, then select a feature in the graphics window.

Attributes, feeds and speeds, and tooling can be transferred only to features of the same type.
Select New Profile Curve(s)

The Select New Profile Curve(s) dialog enables you to select curves to replace a feature's boundary curve when pasting it into the document:

Select curves from the list that you want to replace the feature's boundary curve with, or click Pick Curve and select curves or geometry in the graphics window.

Click Next to display the Paste Special - Reference dialog (see page 1499).

Part Library

The Part Library dialog enables you to create commonly used configurations of objects and save them for easy use in FeatureCAM parts. For example, the library could include a collection of lines and arcs, single features with customized attributes for specific applications, or a collection of features that you use regularly.
To display the **Part Library** dialog, select **Construct > Part Library** from the menu.

The Tree View displays the contents of a specific part library. These libraries contain objects, which you can paste into FeatureCAM parts, and folders which are used to organize the objects.

Above the Tree View, the dialog displays whether the current part library is 64-bit or 32-bit.

**Add Selected** — Click this button to add the selected objects to the library. If multiple objects are selected, they are added to the library as a *stream* and displayed in the tree view with the stream icon. A stream is a temporary group. When these objects are pasted into a document, the stream grouping is removed and just the objects are added directly to the document. If you want a permanent grouping, create a group of objects and then add the group to the part library.

**Add Folder** — Click this button to add a folder to the part library for storing objects.

**Delete** — Click this button to remove the selected object from the part library.

**Rename** — Click this button to rename the selected object.
Paste — Click this button to apply the Paste special (see page 1497) command to the selected objects from the part library. The name of the pasted object is based on the name of the object in the library. If you paste multiple copies of the same type of object, the subsequent objects are named with a _1, _2 suffix. The only exception is a stream object. For stream objects, the objects are pasted directly into the document using the names of the objects contained in the stream.

Import — Click this button to import objects from a part library into the current library.

Export — Click this button to export all objects in the current library to an external library file. These files have a .nam extension.

Open library — Click this option to open a part library.

New library — Click this button to create a new part library.

When you create or export a part library, you are asked to specify the format of the part library as 64-bit or 32-bit. A 32-bit version of FeatureCAM cannot read a 64-bit part library, but a 64-bit part library is faster and recommended.

Part Library example

FeatureCAM has a Counterdrill hole. These are the manufacturing steps:

1. Spot-drill the top.
2. Drill the smaller diameter hole.
3. Drill the top diameter hole.

The order of these is fixed, you cannot rearrange them in the Op List.

An alternative manufacturing strategy would be to:

1. Spot-drill the top.
2. Drill the larger hole on the top.
3. Drill the smaller diameter.

You can use the part library to create a feature that uses the alternative manufacturing strategy.

1. Create a plain hole:
   a. Set the Diameter to 0.375.
   b. Set the Depth to 0.25.
c  On the **Strategy** tab, select the **Spot drill** and **Drill** options.

d  On the **Location** tab, set the X, Y, and Z coordinates to 0.0.

2  Create a second plain hole:

   a  On the **Dimensions** tab, set the **Diameter** to 0.25 and the **Depth** to 0.75.

   b  On the **Location** tab, set the Z location to -0.25

   c  On the **Strategy** tab deselect the **Spotdrill** option and select the **Drill** option.

3  Create a group of the two holes:

   a  Arrange the holes so that the top hole is the first in the group.

   b  Select the **Ordered** option.

Select the group and create a library part

1  Create the objects in a FeatureCAM document. See Tips for library part objects (see page 1504).

2  Select all of the objects you want to include in the part library.

3  Select **Part library** from the **Construct** menu.

4  Click the **Add selected** button to create the library part.

**Tips for part library objects**

- If you plan on modifying the dimensions of a feature, do not override the default tools on the library object, use the automatically selected tools. This allows the automatic tool selection to modify the tooling when the dimensions are changed.

- If you want to create a single library part that contains more than one object, use a Group (see page 869). If you want to ensure that the operations of that group are not rearranged, select **Ordered** on the **Dimensions** tab of the **Feature Group Properties** dialog.

- Any object type can be added to the part library.

- If you want to use a unique name for your object, rename the object either before you put it in the library, or rename the object in the part library.

- Center the object around the origin. This makes it easier to place the feature when you paste it into a document.

**Adding objects from the part library to a FeatureCAM document**

To creating library part objects:
1 Create the objects in a FeatureCAM document. See Tips for library part objects (see page 1504).
2 Select all of the objects you want to include in the part library.
3 Select Construct > Part library from the menu to display the Part Library dialog.
4 Click the Add Selected button to create the library part.

To add existing library parts to a model:
1 Select Construct > Part library from the menu to display the Part Library dialog.
2 Select an object in the Part Library dialog.
3 Click Paste to display the Paste Special (see page 1497) dialog.

Alternatively, you can use the New Feature Wizard (see page 1505) to add an object from the Part Library to the model.

Creating a single part library object
You can insert a single object from a part library by either using the Paste Special (see page 1497) dialog, or using the New Feature Wizard:

1 Click the Features step in the Steps panel to display the New Feature Wizard.
2 In the From Feature section of the New Feature Wizard, select User and click Next.
3 Select an object in the Part Library dialog, then click Next.
4 Enter the coordinates of a point, or click Pick location and select a point in the graphics window.
5 Click Preview to display a preview of the object in the graphics window.
6 Click Finish to paste the object into the model.

Creating a pattern of part library objects
Creating a pattern of part library or UDF objects:
These instructions assume that you already have an object in a part library (see page 1501) or have defined a UDF (see page 857) that you want to add to a part.

1 Click the Features step in the Steps panel to display the New Feature Wizard.
2 In the From Feature section of the New Feature Wizard, select User.
3 Select Make a pattern from this feature.
4 Click Next.
5 Select an object in the Part Library dialog, then click Next.
6 Follow the instructions in the Wizard to create a pattern form the feature.

**Part Library Format**

The Part Library Format dialog is displayed when you create a part library (see page 1501). Use it to choose the format in which the library is saved.

To specify the format for a part library:
1 In the Part Library dialog, click New Library or Export. The Part Library Format dialog is displayed.
2 Choose a format option. Select:
   - **64-bit** to export the library in 64-bit format. Choose this option when the library is only used with 64-bit installations of FeatureCAM.
   - **32-bit** to export the library in 32-bit format. Choose this option when the library is used with 32-bit and 64-bit installations of FeatureCAM.

   **64-bit libraries are faster and can be larger than 32-bit libraries, but they cannot be read by 32-bit installations of FeatureCAM.**

3 Click OK to save your changes and close the dialog. The format you selected is displayed above the tree in the Part Library dialog.

   *To check whether you are using the 32-bit or 64-bit version of FeatureCAM, select the Help > About FeatureCAM menu option. The version is shown at the top of the About FeatureCAM dialog.*
**Feeds and speeds**

Feeds and speeds values are calculated automatically for each operation based on FeatureCAM’s built-in feed/speed database.

Each feature is automatically broken down into a collection of operations. Feeds and speed settings for each operation are automatically calculated. To view the recommended feed or speed value for an operation, click the operation in the tree view and then click the **Feed/speed** tab for turned features or the **Tools** tab for milling operations.

The recommended feed and speed values are extracted from a built-in database in FeatureCAM. The combination of the stock material, the tool material, and the manufacturing operation are used to find the suitable values in the FeatureCAM feed/speed tables.

You can customize this database by changing the values for an existing table or by creating a new table for an additional material. By customizing the database in this way, you are ensuring that FeatureCAM makes future decisions about feed and speed values just as you would.

You can also explicitly set the feed rate or spindle speed for an individual operation, but these changes only affect a single feature in a single part file.

**Feeds and Speeds database**

The **Feeds/Speeds And Cutting Data Tables** dialog displays the information stored in the Feeds and Speeds database.

Use one of the following methods to display the **Feeds/Speeds And Cutting Data Tables** dialog:

- Select **Manufacturing > Feeds/Speeds And Cutting Data Tables** from the menu.
- Click **F/S Tables** on the **Material** page of the **Stock** wizard (see page 205).

**See also:**

Wire EDM cut data (see page 1509)
Stock material (see page 209)
Initializing FeatureMILL databases (see page 1513)
Feed rates for turn/mill features

All feed rates are specified in inches per minute (or millimeters per minute). The post processor then translates these rates into degrees per minute or inverse time.

Wire EDM cut data

FeatureWIRE has material databases that describe the cutting conditions for various materials. Each database entry is uniquely identified by the material type, material thickness, wire type, wire diameter, and machine type. The values for each entry are the feed, water and cutter compensation registers (see page 1509) on the machine. The database is used to fill in the values in the Cutdata dialog, if the current cutting conditions match. The material thickness does not have to be an exact match. The values for the closest thickness are used.

Feed, water and cutter compensation registers

Most NC machines have an integrated technology database, which the machine uses to set up the optimum cutting conditions for the workpiece. This ensures cutting is accurate and uses the full power of the machine. These settings for the cutting conditions are usually stored in registers in the controller and are activated by particular codes in the NC program. The FeatureWIRE software enables you to define these codes for up to nine cuts (either backwards/forwards cutting or with sub-programs). You can also load pre-defined settings from a database.

Feed

This field is used to select the generator setting on the wire machine. The generator setting controls the cutting speed of the machine by setting parameters such as strength, pulse time and pause time between pulses of the electrical current used to produce the spark. These parameters vary with the workpiece material, height and so on.

Water

This field is used to select the machine register that defines the water flow during cutting. The parameters that are controlled include the water pressure, flow rate and so on.
Comp. Reg.
This field sets the number of the Compensation Register of the NC machine which is used for wire radius compensation. The value held within this register is the amount by which the wire is corrected to the left or right of the defined wire path when the function for wire correction on the machine is switched on (normally G41 or G42).

Comp. Val
This field sets the wire radius correction value for the given offset register on the machine. The value is normally the sum of the wire radius + spark gap + any finishing allowance required. For most machines, the compensation value is referenced through the compensation register, so there is no need to set this value.

Other fields
FeatureCAM also contains fields that can be customized to enter machine-specific data, such as spark on and spark off time. For more information customizing these fields, refer to the XBUILD help.

How feedrates are scaled
Feedrates are specified for a 1" (or 20mm) tool. For tools that are other diameters, the feedrates are scaled linearly.

For example, the feedrate for a 0.25" (or 5mm) tool is 1/4 of the table rate.

Changing a feed or speed value for a Milling operation
1 Double-click a Milling feature in the graphics window or the Part View panel to display the Feature Properties dialog.
2 In the Tree View on the left of the dialog, select an operation, for example finish.
3 On the F/S tab (see page 983), enter any values you want to change.
4 Click OK to close the dialog.

On the F/S tab, click Reset All to return all fields to their default values.

Changing a feed or speed value for a Turning operation
1 Double-click a Turning feature in the graphics window or Part View panel to display the Feature Properties dialog.
2 In the Tree View on the left of the dialog, select an operation, for example finish.
3 Select the **Feed/speed** (see page 1404) tab.

4 If you want to specify the speed as constant surface speed:
   a Click **Constant Surface Speed** option.
   b Enter the **Surface Speed**.
   c Optionally specify the **Approach RPM** (the initial speed for the operation while still off the part).
   d Optionally specify the **Maximum RPM** (the maximum revolutions per minute that the machine can generate).

5 If you want to enter the speed as a single revolution per minute value, deselect **Constant Surface Speed** and enter the **Spindle speed**.
   - If your machine has explicit spindle speed ranges, you may want to set the **RPM Range**.

Some turning centers have gear boxes that set the maximum spindle speed of the machine. The **RPM Range** list sets the gear box to a specific maximum range. If you set **RPM Range** to a value of 1-4, then the range is set explicitly. If **RPM Range** is set to **Auto** then FeatureCAM sets the range for you based on the following rules:

1 If the feature is a turned Hole or another turned feature without **Constant Surface Speed** set, then the range is determined based on the **Spindle Speed**.

2 If the feature is a turned feature with **Constant Surface Speed** set, then the range is determined based on the **Max RPM**.
   - If you want to specify the **Speed as feed per revolution**, select the **IPR** option and enter the feed rate.
   - If you want to specify the **Speed as feed per minute**, deselect the **IPR** option and enter the feed rate.

3 Click **OK** to close the dialog.

**Default feed/speed values for turning**

The default values for feeds and speeds are calculated from the feed/speed tables. If the feed is specified in Feed per minute (IPM for inch units), then the feed rate is dependent on the speed value.

When you change the **Speed** value, the recommended **Feed** value is changed.

To see the recommended **Feed** value when you have entered a **Speed** value:

1 Enter a **Speed** value on the **F/S** tab (see page 1510) (Milling features) or Feeds/speeds tab (see page 1510) (Turning features) of the **Feature Properties** dialog.
2 Click **Apply**.
   The Feed value is updated to display the new value.

**Show/Hide Material**

You can use the Show/Hide Material dialog to remove materials from the Material list in the Feeds/Speeds And Cutting Data Tables dialog (see page 1508).

To display the Show/Hide Material dialog, select Manufacturing > Materials > Show/Hide from the menu.

FeatureCAM comes with a long list of materials. Some of these materials might not be applicable for your shop. You can delete materials from the database, but when you upgrade to a new version, these deleted materials reappear. The solution is to hide unwanted material. When the materials database is updated, hidden materials do not reappear.

To hide or show a material:
1 In the list in the Show/Hide Material dialog, select any material you want to show.
2 Deselect any material you want to hide.
3 Click **OK**.

*Click Exclude all items* to deselect all of the materials in the list or *Include all items* to select all of the materials in the list.
Initializing FeatureCAM databases

The tooling and feed/speed databases are created using the INITDB Initialization program in FeatureCAM. This is the program that is run the first time you run FeatureCAM to create your initial database.

Select where your database is located:

**On my local computer** — Select this option to use the database on your PC.

**On another computer that I will access over a network** (see page 1838) (SND (see page 10)) — Select this option to use an MS Access shared network database. Click **Browse** and browse to the location of the shared network database.

**On a SQL Server** (see page 1839) (SND (see page 10)) — Select this option to use an SQL Server network database. Select the **Server Name** and the **Database Name**. To use SQL authentication, select **SQL Server** in the **Authentication Mode** list and enter your **SQL Username** and **SQL Password**. If you use SQL authentication, the **Database Name** list only displays databases to which you have access.

You may also want to use INITDB for the following reasons:

- Adding default tools and feed/speed tables to the database (see page 1853)
- Recreating tooling and feed/speed databases if they become corrupt (see page 1854)
## Macro programming options

The type of macro code that is created by a specific post processor depends on whether the post processor supports incremental programming, local coordinate systems or both.

<table>
<thead>
<tr>
<th>Incremental</th>
<th>Local coordinate</th>
<th>File type</th>
<th>Code created</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No</td>
<td>.fm</td>
<td>Pattern instances are cut with absolute coordinates relative to the current Setup.</td>
</tr>
<tr>
<td></td>
<td>.mf with multiple fixture</td>
<td></td>
<td>Each FM part is cut with absolute coordinates relative to the global fixture. Pattern instances in each FM part are cut with absolute coordinates relative to the global fixture.</td>
</tr>
<tr>
<td></td>
<td>.mf with global fixture</td>
<td></td>
<td>Each FM part is cut with absolute coordinates relative to its local fixture (G54). Pattern instances in each FM part are cut with absolute coordinates relative to the part's local fixture (G54).</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>.fm</td>
<td>Each pattern instance calls a macro with incremental coordinates relative to the pattern instance location.</td>
</tr>
<tr>
<td></td>
<td>.mf with multiple fixture</td>
<td></td>
<td>Each FM part is cut with absolute coordinates relative to the global fixture. Pattern instances in each FM part are cut with incremental coordinates relative to the pattern instance location based on the global fixture.</td>
</tr>
<tr>
<td>.mf with global fixture</td>
<td>.mf with multiple fixture</td>
<td>.mf with global fixture</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------</td>
<td>-------------------------</td>
<td></td>
</tr>
<tr>
<td>Each FM part is cut with absolute coordinates relative to its local fixture (G54). Pattern instances in each FM part are cut with incremental coordinates relative to the pattern instance location based on the part's local fixture (G54).</td>
<td>A local coordinate system is established for each FM part. A local coordinate system is established for each pattern instance. A macro is called with absolute coordinates relative to the pattern instance location which is based on the global fixture.</td>
<td>Each FM part is cut with absolute coordinates relative to its local fixture (G54). A local coordinate system is established for each pattern instance. A macro is called with absolute coordinates relative to the pattern instance location which is based on the local fixture (G54).</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>.fm</td>
<td></td>
</tr>
<tr>
<td>A local coordinate system is established for each pattern instance. A macro is called with absolute coordinates relative to the pattern instance location.</td>
<td></td>
<td>Local coordinates are not used.</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>.fm</td>
<td></td>
</tr>
</tbody>
</table>
A local coordinate system is established for each FM part. Pattern instances in each FM part are cut with incremental coordinates relative to the pattern instance location based on the part's local coordinate system.

Local coordinates are not used.

**Toolpaths**

You must simulate toolpaths in FeatureCAM in order to produce the NC code for your part.

*If you are using the Student version of FeatureCAM, you cannot post NC code.*

You can use toolpath simulations to check for gouges (see page 1540) and manage tool load (see page 1545).

Click **Toolpaths** in the **Steps** panel to display the **Simulation** toolbar:

**Simulating toolpaths**

In FeatureCAM, you can display the following types of simulation:
Centerline — Lines are drawn that represent the center of the tip of the tool. This simulation method is usually the fastest. The default colors are:

- Rapid moves (G0)

- Toolpath lines and arcs (G1, G2, G3)
- Index moves
- Part line program toolpaths
- Ramps and leads

You can change these colors in the Default Colors (see page 129) dialog.

For 3D and 2.5D NT toolpaths, stepovers are brown and leads are blue.

2D — For turning, this style shows a cross section of the part. For milling this style shows a flat (from the top) view of the part, with each tool being shown in a different color.
3D (sometimes called Visicut) — This style shows a three-dimensional shaded rendering of the initial stock and simulates material removal in 3D. You can optionally display the holder. Any gouge caused by holder interference or the tool hitting the part during a rapid move is displayed in pink. For turning simulation a 3/4 cut-away view is optionally available to view ID cuts.

3D RapidCut (see page 1524) — This shows a very fast simulation of a 3-axis milling job. You can also use it with 2.5-axis milling, but it works best for 3-axis milling.

Machine simulation — This displays the motion of the entire machine tool (see page 1895).

With all simulation methods, video-style controls (see page 1520) are used to pause, stop, and step through the toolpath, giving you fine control over the process.
Generating toolpaths

You can use the Simulation toolbar to simulate toolpaths.

To simulate toolpaths:

1. Click Toolpaths in the Steps panel to display the Simulation toolbar:
2. Select a simulation type (see page 1519).
3. Click Play.

The toolpaths are simulated in the graphics window.

Simulation types

You can select the following simulation types in the Simulation toolbar:

- **Show Centerline** — Simulates the centerline of the toolpath in the graphics window using the current view. If Keep toolpaths upon view change is selected on the Centerline tab (see page 1532) of the Simulation Options dialog, you can view the part and the toolpaths dynamically, otherwise the toolpaths are erased when you change the view.

- **2D Simulation** — The top view of the part is displayed, and the toolpaths are simulated in different colors. You cannot change the view during the simulation. When the simulation is complete, you can change the view, but the toolpaths are erased.

- **3D Simulation** — A 3D simulation of the part is displayed in the current view. You can dynamically change the view at any point during or after the simulation. The simulation does not have to be recalculated, so the view change is instant.

- **3D RapidCut** — You can view this simulation dynamically. For zooming, the image must be recalculated, but this calculation time is quick. For panning or rotating, the image does not have to be recalculated, but a lower resolution version is displayed while you are transforming the part. This lets you change the view more interactively.
Machine simulation — A 3D simulation of the part and the machine is displayed in the current view. You can dynamically change the view at any point during or after the simulation. The simulation does not have to be recalculated, so the view change is instant.

Video-style controls

When you generate toolpaths, they are displayed in the graphics window using the technique (centerline, 2D, and so on) that you selected. You can control the simulation using the video-style buttons in the Simulation toolbar.

- The Eject button removes the Simulation toolbar from the screen and erases the simulation from the graphics window.
- The Stop button cancels a simulation and clears it from the screen.
- The Play button restarts a paused simulation.
- The Pause button suspends the simulation. The button changes to the Play button after it is clicked.
- The Single step button moves the simulation by one tool move. The keyboard shortcut for this button is Alt+F3.

After stepping forward, you can also step backward by selecting View > Simulation > Step Backward from the menu.

- The Next operation button simulates until the end of this operation. Click the triangle to the right of the button to display the following options:
  - The Next rapid button simulates until the next rapid tool move.
  - The Next tool change button simulates until the next tool change.
  - The Next Z level button simulates the next Z of a Z level toolpath. For other toolpaths, it plays the entire next operation.
- The Clear toolpath button is for centerline simulation only. If you have paused your simulation, or if you are using one of the simulation tools above, this button clears all of the centerline toolpaths simulated up to that point.
- The Region of interest button limits the portion of part that is simulated (see page 1521).
The **Show tool load** button indicates whether or not to display a graph of the tool load (see page 1545) when the next 3D Simulation is performed.

To adjust the speed of a centerline, 2D, or 3D simulation, use the **Sim Speed** slider on the right-hand side of the controls. Slide to the right to speed up, and move to the left to slow the simulation down. The slider of the simulation toolbar also affects the display for rapidcut simulation. If the slider is all the way to the right, only the final simulation result is displayed. Position the slider bar further to the left to see intermediate results.

**Pausing a toolpath simulation**

You can use the following methods to pause a simulation:

- Click **Pause** in the **Simulation** toolbar.
- Set a break point (see page 1550).
- Use the **Single step**, **Next operation**, **Next rapid** or **Next tool change** buttons in the **Simulation** toolbar.

**Region of interest**

The **Region of Interest** button in the **Simulation** toolbar enables you to limit the portion of the part that is rendered during a 3D simulation or 3D Rapidcut simulation. There are two main reasons to do this:

- The rest of the part is not simulated, so simulation time is reduced.
- If you are using RapidCut (see page 1524), the region is simulated at a finer resolution.

There are three different types of region:

**Stock** — This is the default type of simulation where the entire stock is rendered during simulation:
**Feature** — Select the name of the feature from the list and a region around the feature is selected as the region.

![Feature Image](image)

**XYZ Location** — The region is defined by either a box you drag or by two points whose coordinates you can enter.

*The sides of the box are aligned with the X and Y axes.*

![XYZ Location Image](image)

**Preview simulation button**

Simulations are normally performed on all features in a Setup. To simulate a single feature or operation:

1. Double-click a feature.
2. The **Feature Properties** dialog is displayed.
3. Select the feature or an operation in the tree view.
4. Click the **Preview** button. The **Feature Properties** dialog is minimized. A special version of the **Simulation** toolbar is displayed.

![Simulation Toolbar](image)

5. Click the **Play Feature** button. See Using simulation video-style controls (see page 1520) for more information.
6. Click the **Eject** button. The **Properties** dialog is maximized.
**Part compare**

**Part compare** is a feature of RapidCut simulation that enables you to compare the results of a toolpath simulation with the actual solid part model.

Regions that are properly cut are displayed in green. Regions where extra material remains are shown in light blue (small amount of rest material) through to dark blue (larger amount of rest material). Gouged regions are shown in yellow (small gouge) through to red (large gouge), for example:

![Part compare example](image)

To use part compare:

1. Right-click the solid in the graphics window and select **Use Solid As Part Compare Target** from the context menu.
2. Specify the part compare settings and tolerances (see page 1533) on the **Part Compare** tab of the **Simulation Options** dialog.
3. Run a 3D RapidCut simulation (see page 1524).
4. Select **View > Simulation > Show Part Compare** from the menu.

To view the actual part model that the simulation is compared with, select **View > Simulation > Show target part** from the menu.

*If you adjust the view after a part compare has been performed, a new RapidCut simulation is performed automatically, but you must run another part comparison.*

Part compare also works with the region of interest (see page 1521).
### Part compare example

In the example you can see that the trough is undercut.

Examining the trough more closely, you can see that the bottom of the trough is greatly undercut. This is indicated by the dark blue color. The light blue regions indicate a slightly undercut region.

### 3D RapidCut simulation

This mode is available only in FeatureCAM 3D. RapidCut simulation does not apply to turned parts. In this mode the tool is not animated, but rather the results of the simulation are directly displayed. For most parts, the simulation takes only a few seconds to complete.

To start this simulation mode, click the **3D RapidCut** button.
If you have set a break point, the result of the simulation is performed up to the break point. If you have not set a break point, then the whole NC program is simulated. The slider of the simulation toolbar also affects the display. If the slider is all the way to the right, only the final simulation result is displayed. Position the slider bar further to the left to see intermediate results.

*RapidCut simulation does not detect insufficient cutter length or tool holder gouges.*

When you have run a RapidCut simulation you can then run a part compare (see page 1523) to see how the toolpaths you generated compare to the final shape.

*Undercuts are not supported when using RapidCut.*

*Indexed and 5-axis parts are not supported when using RapidCut.*

**Simulation Options dialog**

You can use the **Simulation Options** dialog to control how toolpath simulations behave.

To display the **Simulation Options** dialog, select **Options > Simulation** from the context menu.

![Simulation Options dialog](image)

You can use this dialog while a simulation is playing and edit some options without having to restart the simulation, such as number of colors and simulation speed. If you display the **Simulation Options** dialog during a simulation, the simulation pauses until you close the dialog. A message is displayed if you run the 3D simulation in a display showing fewer than 256 colors.

The **Simulation Options** dialog contains the following tabs:

**General** (see page 1526)
2D/3D Shaded (see page 1528)
Centerline (see page 1532)
Part Compare (see page 1533)
Wire (see page 1535)

**General tab**

You can use the General tab of the Simulation Options dialog (see page 1525) to edit the settings which affect all simulation types.

![Simulation Options dialog](image)

**Tool Colors** — Simulates the cuts of each tool with a different color.

This lets you graphically view which portions of the part are cut with which tool. After you run a 3D simulation, you can toggle this setting without re-running the simulation. This image shows an example of tool colors.

![Tool Colors example](image)

For centerline simulation this option displays each tool in a different color during the simulation.

💡 You can change the color at any time during a simulation by clicking **Change the Simulation Tool Color** in the Simulation toolbar.

**Show holder** — Select this option to display the tool holder during centerline and 3D simulation.
**Show spindle** — Select this option to display the spindle during centerline and 3D solid simulation.

You must also select **Show holder** in order to view the spindle.

**Simulation Speed** — This controls the speed of the simulation. Position the slider on the scale between the far left for the minimum (slowest) speed and the far right for the maximum (fastest) speed. This slider controls the speed of 2D and 3D solid simulation.

The **Status** section shows the information that is displayed in the status bar during simulation. Select the check boxes for the information you want to see in the status bar:

- **Feed** displays the feed rate for the operation being simulated.
- **Speed** displays the spindle speed rate for the operation being simulated.
- **Time** turns on the display of the machining time estimate.
- **Operation** displays the name of the operation currently being simulated.
- **Tool** displays the name of the tool performing the current operation.
- **Position** shows the X, Y and Z positions of the tool on the screen. If you are using indexing, the angle you are rotated around the axis is also shown.

This option can slow the simulation.
2D/3D Shaded tab

You can use the 2D/3D Shaded tab of the Simulation Options dialog (see page 1525) to edit the settings which affect 2D and 3D simulations.

Resolution — This controls the quality of the image and affects the speed of the simulation. The default value is 1. If you double the value (by setting it to 2.0), the tool is subtracted from the block half as often. If you decrease the value, the tool is subtracted from the block more often. If the simulation is too chunky, decrease Resolution by half. If the simulation quality is acceptable, but it is running too slowly, double the Resolution.

Power graph samples/min — The tool load graph is determined by measuring the Tool load (see page 1545) a certain number of times per minute. The Power graph samples/min is the number of samples to take per simulation minute.

Pause on limits — Select this option to pause the machine simulation if a solid exceeds the limits of movement specified in the Machine Design file.

Show pause on gouge dialog — Select this option to display the Possible Gouge dialog to warn you that a gouge has taken place. See Detecting gouges (see page 1540) for more information.
Only Play Sim Once (TURN (see page 10)) — For some machines with two spindles, the simulation plays through the simulation twice. If you want to see the part simulated only once, select this option.

Translucent tool — Select this option to change the tool of a 3D solid simulation to be slightly transparent.

Translucent part — Select this option to change the stock of a 3D solid simulation to be slightly transparent.

Metallic — If you are using graphics hardware for OpenGL shading, you have the option to have the 3D simulation look metallic.

Tool cutting tolerance — This tolerance affects the fineness of the 3D simulation. If this is set high, the simulation appears more faceted. The lower this tolerance is set, the smoother the simulation appears.

Tool visual tolerance — This tolerance affects the appearance of the tool. By increasing this tolerance, the tool appears chunkier. By decreasing the tolerance the tool looks rounder and smoother, but the simulation uses more memory and may be slower.

Turn/mill angular interpolation — If the part rotates during cutting, the movement of a point on the part's surface is approximated with small linear movements instead of a true circular movement. This setting determines how accurately the linear movements approximate the actual movement of the part. Increase this setting to reduce the simulation time for complex parts. This tolerance is also affected by the wrapping tolerance and linearization attributes.

Linearization tolerance (5-AXIS SIM) — This tolerance controls the linearization (see page 1146) of the 3D simulation. If this is set larger, the simulation of 5-axis simultaneous features is faster, but may not be entirely accurate as the tool tip of the machine tends to travel in arcs instead of straight lines. If this tolerance is set smaller, the simulation of 5-axis simultaneous features is more accurate, but the simulation is slower.
Rotate view when indexing — This setting applies to 4th or 5th axis indexed parts and turn/mill parts. With Rotate view when indexing selected, the simulation rotates the part for an A-axis or B-axis indexing move in milling or for a C-axis rotation in turn/mill. Although these rotations provide a more accurate simulation, they can slow down the simulation especially with simultaneous X- and C-axis moves in turn/mill. To speed up the simulation, deselect this setting and the part stays fixed and the tool moves around the part.

You must deselect 3/4 view with lathe ID work to use Rotate view when indexing with turn/mill parts.

Save result files during RapidCut — Select this option to view intermediate shaded simulations (see page 1552) in rapid cut mode (see page 1524). This option is useful if you want to have quick access to images of the part at the conclusion of each operation. This option requires a lot of memory and slows down the simulation process, so we recommend that you use it only when you want to study the results of each operation carefully.

Save result files during 3D sim — You must select this option to enable the Use results as starting point (see page 1540) feature.

View independent — Select this option to use our Visicut engine. When using this engine you can pause a 3D simulation and change the view at any time. This simulation method uses a solid model and can be used for any and all 3D simulations. Deselect View independent to use our Pixelcut engine. Pixelcut does not allow you to rotate the model, but the simulation runs considerably faster. Pixelcut is very fast, similar to RapidCut, but it has an advantage over RapidCut in that it can simulate tools with undercuts, and it can also simulate cutting from different directions (3+2). RapidCut is great if you are cutting a long-running toolpath in 3-axis, such as a mold. Pixelcut is great if you are cutting a long-running toolpath from multiple directions (3+2).

Show edges — Select this option to outline the edges of the machine during machine simulation.
This example shows the default behavior with **Show edges** deselected:

This is the same example with **Show edges** selected:

**Shadow quality** — If you are using graphics hardware for OpenGL shading you can display shadows in your simulation. The image shows an example of shadows displayed when using machine simulation.
If the slider is dragged all the way to the left to None, then shadows are turned off. As you drag the slider to the right the quality of the shadows improves. Be aware that this option can slow down the simulation.

**Centerline tab**

You can use the Centerline tab of the Simulation Options dialog (see page 1525) to edit the settings which affect centerline simulations.

![Simulation Options dialog](image)

**Keep toolpaths with view change** — Select this option to leave the toolpaths on the screen while you change the view of the part. Without this setting, the toolpaths are erased when the view changes.

*Saving the toolpaths for interactive viewing needs extra memory.*

**Show animation** — Displays the tool as a line drawing as the centerline toolpaths are displayed. This setting must be selected to see the toolpaths in an incremental manner. If this option is deselected, the toolpaths for the entire part are shown together at the end of the calculation.

**Show animation prior to 2D/3D simulation** — If the 2D or 3D simulation button is selected without performing a centerline simulation first, the toolpaths must be generated. If this option is selected, a centerline simulation is shown while the toolpaths are being generated and then the 2D or 3D simulation is then performed. If it is deselected, then the initial toolpaths are generated without display and then the 2D or 3D simulation is performed.
**Smooth animation** — This controls the display of the tool during Centerline simulation. With **Smooth animation** selected, the tool is displayed without flickering during the simulation. With this setting deselected, the simulation needs less memory, but may flicker during the simulation.

**Only update display every** — This controls the display of the centerline toolpath as it is calculated. This number controls how often the toolpaths are displayed. This number is specified in minutes of tool travel, that is, if the feed rate is 100 inches per minute and **Only update display every** is set to 0.5 minutes, then the screen is updated after the tool has moved 50 inches. A zero setting causes the screen to be updated for every block of NC code. If the speed control slider is not set to the maximum value the **Only update display every** setting is ignored.

*In older versions of FeatureCAM, this was called Toolpath update.*

**Part Compare tab**

You can use the **Part Compare** tab of the **Simulation Options** dialog (see page 1525) to edit the settings which affect part compare (see page 1523).

**RapidCut conversion tolerance** — When mixing 3D solid and RapidCut simulations (see page 1539), the images must be converted from one type to the other by FeatureCAM. If you want to improve the quality of the part when it switches representations, decrease this tolerance.
Show rest material — Regions that have extra material greater than or equal to this value are shown in blue. The more rest material there is, the darker the shade of blue.

Show gouge — Regions with gouges greater than or equal to this value are shown in yellow. Larger gouges are shown in red.

Regions with rest material less than the Show rest material parameter or gouges less than the Show gouge number are shown in green. These areas are considered correctly cut.

If either the Show rest material value or the Show gouge value is set too small, then the part comparison is very noisy and difficult to interpret.

Target part tessellation tolerance (see page 1534)

See also Rapidcut simulation (see page 1524) and Generating/simulating toolpaths.

Target part tessellation tolerance

Part compare works by comparing the part cut by the toolpaths with the actual surfaces of your part, known at the target part. The target part is approximated by triangles for the comparison. If this tolerance is too coarse, then the part compare reports gouges or rest material where there actually is none and the model has streaks, for example:

Decrease this tolerance to remove such streaks.
Wire tab

You can use the Wire tab of the Simulation Options dialog (see page 1525) to edit the settings which affect Wire EDM simulations.

Wire visual diameter — The wires used in wire EDM are often quite thin and difficult to see during a 3D toolpath simulation. Select the Wire visual diameter option and enter a larger diameter so that the wire is easier to see during the simulation.

*The width of the actual cut being simulated is not affected by changing this number. The cut is always simulated using the actual wire diameter that is specified in the condition dialog (see page 228).*

Tool cutting tolerance — This tolerance affects the fineness of the 3D simulation. If this is set high, the simulation appears more faceted. The lower this tolerance is set, the smoother the simulation appears.

Tool visual tolerance — This tolerance affects the appearance of the wire. By increasing this tolerance, the wire looks squarer. By decreasing the tolerance the tool looks rounder and smoother, but the simulation uses more memory and may be slower.

*Changing this tolerance does not affect the quality of the simulation, only how the wire is displayed.*
**Round Stock tab**

You can use the **Round Stock** tab of the **Simulation Options** dialog to edit the settings which affect Turning and Turn/Mill simulations.

![Simulation Options dialog]

**3/4 view with lathe ID work** — This option enables a 3/4 cut-away view for ID work for turned setups.

This image shows an example of the 3/4 view:

![3/4 view example]

**Roundness tolerance** — Reduce the tolerance to make round stock appear rounder and less faceted.
Higher Roundness tolerance:  

Lower Roundness tolerance:

**Turn/mill angular interpolation** — If the part rotates during cutting, the movement of a point on the part's surface is approximated with small linear movements instead of a true circular movement. This setting determines how accurately the linear movements approximate the actual movement of the part. Increase this setting to reduce the simulation time for complex parts. This tolerance is also affected by the **wrapping tolerance** and **linearization** attributes.

**Show Turn Chuck** — Select this option to display a solid representing the chuck during 3D simulation.

**Chip Recognition size** — During simulation, detached pieces of the part are removed if they are smaller than this value. For parts with large stock, you may want to reduce this value to ensure cutoffs are not hidden.

**Display Specific Stock Length** — Specify the length of bar stock in simulations.

### Simulating 3D toolpaths

Due to the large number of moves in the toolpaths for a typical 3D part, animating the entire toolpath using 3D solid simulation is often time-consuming. Instead, consider one of the following techniques:

- Mix 3D solid and RapidCut simulation (see page 1539).
- Use centerline simulation and pause the simulation periodically and erase the displayed toolpaths to clear the screen.
- Use RapidCut (see page 1524) and use the **Next operation** button to quickly see the results of each operation.
- Use RapidCut (see page 1524) and slow down the speed control so that you see some intermediate results.
- Use a region of interest (see page 1521) in combination with either 3D solid simulation or rapidcut.

*If you are doing a 3D simulation of a large part, you can simulate two different views at the same time (see page 1538).*

**Dual view for 3D simulation**

You can carry out 3D simulation with two different views at the same time, for example:

To use dual simulation for 3D simulation, follow these steps before you start the simulation:

1. If the current window is maximized, click **Restore Down** on the window's control bar (in the top-right).
2. Select **Window > New Window** from the menu.
   - A new window is displayed in front of the original window.
3. Arrange the windows, so that you can see them both.
   - *To move a window, click and drag its control bar. To resize a window, click and drag the blue borders.*
4. Use one window to display a zoomed in detail view of an area, and the other window to display the whole view of the part.
5 Play the simulation.
   The simulation plays in both windows at the same time.

**Simulated slug removal**

In FeatureCAM WIRE, you can graphically remove a slug after the 3D simulation is finished. The region to remove must be totally separated from the rest of the part.

To remove the slugs:

1. Perform a 3D solid toolpath simulation.
2. Click the **Select** button in the **Standard** toolbar.
3. Click the slug in the graphics window. The slug is removed.
4. Click any slugs you want to remove.
5. Click the **Stop** button in the simulation toolbar (see page 1520) to clear the screen.

Before slug is removed:  
![Before slug removed](image1)

After slug is removed:  
![After slug removed](image2)

**Mixing 3D simulation and RapidCut**

You can switch between 3D simulation and RapidCut any time the simulation is paused.

To switch between these two simulation modes:

1. In the Simulation toolbar, click **3D Simulation** ![3D Simulation](image3) or **RapidCut** ![RapidCut](image4) to select a simulation type.
2. Click **Play** ![Play](image5) to play the simulation.
3. Pause the simulation (see page 1521).
4. Click **3D Simulation** ![3D Simulation](image3) or **RapidCut** ![RapidCut](image4) to change the simulation type.
5. Click **Play** ![Play](image5) to continue the simulation.
Using this method, you can use RapidCut to fast forward to a point and then use 3D simulation to see a part of the simulation in more detail.

**Use results as starting point**

You can save the results of a 3D simulation to use as a starting point, to save calculation time during subsequent simulations.

To use the current simulation results as a starting point, select View > Simulation > Use Results as Starting Point from the menu.

To clear the simulation results, select View > Simulation > Clear Starting Point from the menu.

To use this feature, **Save result files during 3D sim** must be selected on the **2D/3D Shaded** (see page 1528) tab of the **Simulation Options** dialog. This option is selected by default.

You can add the **Set sim results as starting point** button and the **Clear starting point** button to the **Simulation** (or any) toolbar from the **Simulation** Category Buttons section on the **Commands tab** (see page 27) of the **Customize Toolbars** dialog.

**Detecting gouges**

Using 3D simulation, you can visually detect gouges with the tool (during rapid moves), the tool holder or the spindle. Any gouge is displayed in pink. If you want the simulation to pause when it detects a gouge, set the **Pause on gouge** simulation option. If this option is set, the simulation pauses if a gouge is detected. Click the **Play** button in the simulation toolbar to continue the simulation. See **Simulation options** (see page 1525) for additional options.
**Machine simulation gouges**

Whenever a named part of the machine collides with another solid, a flashing arrow is displayed and the display turns transparent, for example:

You must enable **Pause on gouge** on the **2D/3D Shaded** (see page 1528) tab of **Simulation Options** to see this feature.

The first collision point only is marked.

The display returns to normal when you continue the simulation.

The arrow is not shown for tools colliding with stock.

---

**Fixture and clamp collision detection**

Normally, only the part model is rendered during a 3D simulation. If Pause on gouge is set, the simulation pauses if the tool rapids into the part. In FeatureCAM 3D, 3D simulation can help you detect collisions with models of clamps or fixtures that you create as solid models. To detect these collisions:

1. Create a solid model of a fixture or clamps. It can be as elaborate as you need it to be. You can also use an STL file as a clamp.
2. Set the solid or solids as a clamp (see page 1542).
3. If you want the simulation to alert you to gouges, select **Simulation** from the **Options** menu. Click the **2D/3D** simulation tab and select Pause on gouge.
4 Run a 3D simulation. During the simulation both the part and the clamp model are rendered. It may take longer for the simulation to start up because the clamp model is being rendered.

The simulation has paused at the end of the move because it gouged the clamp.

*FeatureCAM does not come with a library of clamps, but the 3D solid modeling capabilities of FeatureCAM 3D enables you to create these models from scratch. You can also import clamp models for other solid modeling systems (see page 82).*

*If a clamp is defined in an .fm part file, this clamp is displayed during 3D simulation in a tombstone document (see page 1885).*

**Using solids or STL files as clamps**

When machining a part, it must be held tight with clamps. The position and shape of the clamps affect the way the part is machined. It is useful to see the clamps during simulation (see page 1541).

In FeatureCAM, you can set any solids or STL files to be clamps.

**To use solids as clamps:**

1. If surfaces are not displayed in the graphics window, click **Shade Surfaces** in the **Standard** toolbar.
2. Select any solids you want to use as a clamp:
   - Select a face of a solid in the graphics window.
   - Select the name of a solid in the **Part View** panel.
3. Right-click the selected solid and select **Use Solids as Clamp** from the context menu.

To see if a solid is used as a clamp, right-click the solid to display the context menu. If there is a check mark next to **Use Solids As Clamp** in the context menu, the selected solid is currently used as a clamp:

- **Use Solids As Clamp**

If there is no check mark next to **Use Solids As Clamp**, the selected solid is not currently used as a clamp.

To not use the solid as a clamp, right-click the solid and deselect **Use Solids As Clamp** from the context menu.

You can set multiple solids as clamps simultaneously. If you try to set or unset multiple solids as clamps and some of them are currently set as clamps, the **Use Objects As Clamp** dialog is displayed:

Click **Use All** to use all of the selected solids as clamps.
Click **Use None** to use none of the selected solids as clamps.
Click **Cancel** to close the dialog.
Click **Help** to open this help page.

**To use STL files as clamps:**

1. Select any STLs you want to use as a clamp:
   - Select an STL in the graphics window.
   - Select the name of an STL in the **Part View** panel.
2 Click Shade Selected in the Display Mode toolbar to shade the selected STLs in the graphics window.

3 Right-click a selected STL and select Use STLs As Clamp from the context menu.

To see if an STL is used as a clamp or not, right-click the STL to display the context menu. If there is a check mark next to Use STLs As Clamp in the context menu, the selected STL is currently used as a clamp:

To not use the STL as a clamp, right-click the STL and deselect Use STLs As Clamp from the context menu.

You can set multiple STLs as clamps simultaneously. If you try to set or unset multiple STLs as clamps and some of them are currently set as clamps, the Use Objects As Clamp dialog is displayed:

Click Use All to use all of the selected STLs as clamps.
Click Use None to use none of the selected STLs as clamps.
Click Cancel to close the dialog.
Click Help to open this help page.

Simulating multiple Setups

Many parts have more than one Setup.

To simulate toolpaths for multiple Setups:

1 Select a Setup in the Part View panel, or in the Setups list in the Status bar to make it the active Setup.

2 Play a simulation (see page 1516).
   Toolpaths on the selected Setup are simulated.

3 Select the next Setup in the Part View panel, or in the Setups list in the Status bar.
   The tool is displayed in its home position in graphics window.
4 Click **Play** on the **Simulation** toolbar to continue playing the simulation.

Toolpaths on the selected Setup are simulated alongside the previous simulation.

5 Repeat for any other Setups you want to simulate.

**Tool load**

You can use the Tool Load dialog to show a graph of the estimated horsepower load on the tool during 3d simulation. You can use these estimates to fine-tune the program to improve performance.

> The horsepower values are estimates. If you are approaching the power limits of your machine, you should lower your feed rates, or decrease the width or depth of your cuts.

To show the tool load:

1 In the **Simulation** toolbar, click **Show tool load**. The Tool Load dialog is displayed.

2 Run a 3D simulation. The Tool Load dialog displays a graph of the simulation time and the load on the tool. The current simulation time and tool load are displayed below the graph.

3 Click **Settings** to display the Power Settings dialog.

4 Specify the settings in the Power Settings dialog:
   - **Max. Power** — This displays the maximum horsepower used so far. Display this dialog at the end of a simulation to see the maximum horsepower used in the entire program.
- **Power Limit** — Enter a maximum horsepower displayed in the Tool Load dialog.
- **Pause simulation** — Select this option to pause the simulation when the Power Limit value is exceeded.
- **Show this dialog** — Select this option to display the Power Settings when the Power Limit is exceeded.
- **Clear** — This clears the Max. Power value and clears the graph when the simulation resumes.

5 Click OK to close the Power Settings dialog.

6 Repeat the 3D simulation to show the graph using the updated settings.

You can control the accuracy of the graph with the Power graph: samples/min setting on the 2D/3D Shaded tab of the Simulation Options (see page 1525) dialog.

If you have run a feed optimization (see page 1570), the Tool Load graph shows the optimized loads in black and the unoptimized loads in white:
Results window

You can access the Results window in one of these ways:

- Click the tab labeled Results to the top right of the Graphics (see page 1) window.
- Select View > Show Reports from the menu and select the tab you want to view.

The Results window is to the right of the Graphics window and contains the following tabs:

**Op List** (see page 1548) — This tab displays a list of all of the operations in the part, with information about each operation such as the tool used, and feed and speed values.

**Details** (see page 1555) — This tab contains two reports, select one of the options at the top of the tab:

- Operation List (see page 1556) details
- Tool List (see page 1556) details

**NC Code** (see page 1557) — This tab is displayed only after you have simulated your part.

**Turrets** (see page 1557) (MTT (see page 10)) — This tab lists the operations assigned to each turret of the machine. It is displayed only when using synchronized turning.

*To toggle the display of the Results window, click on the tab name to collapse or expand it.*

*To adjust the width of the Results window, move the cursor over the Results window border until the cursor changes to ‹|›, then click and drag the border.*
**Op List tab**

The **Op List** tab contains a table of operations. The table displays the following columns by default:

- Retract
- Operation
- Feature
- Tool
- Feed
- Speed
- Depth

Right-click on any of the column headers to open a context menu that lets you show or hide these columns:

- **Setup**
- **Tool Slot**
- **Turret** (for multi-turret turning)
- **Priority**

If there is a ! or a ⚠ icon in the left hand margin, you have an error or warning (see page 194) for this operation.

This tab has three main functions:

- Simulation control (see page 1550)
- Operation ordering (see page 1553)
- Operation editing (see page 1554)

During simulation, the yellow arrow ➤ icon moves down the operations list to indicate which operation is currently being simulated.
**Retract** — The name of this column is partly hidden by default, but you can make it wider by clicking and dragging the column divider. This column applies to the canned cycle (see page 891) setting and contains the following symbols:

| Retract to plunge clearance | This short green arrow indicates that the tool retracts to the lower plunge clearance plane (G99, "R point level return", on a Fanuc control) after performing the operation. You can toggle this arrow to a tall arrow ↑ by clicking the short arrow ↑ with the left mouse button and selecting Retract to Z rapid plane from the context menu. |
| Retract to Z rapid plane | This tall green up arrow means that the tool retracts to the higher Z Rapid Plane (G98, "Initial level return", on a Fanuc control) after the operation. You can toggle this arrow to a short arrow ↑ by clicking the tall arrow ↑ with the left mouse button and selecting Retract to Plunge clearance from the context menu. |
| Retract to Z rapid plane | This gray arrow means that the tool retracts to the higher Z Rapid Plane after the operation, and you can't change it because it is typically shown at the end of a canned cycle. |

**Operation** — This is the type of operation performed. If multiple roughing tools are used, then the roughing passes are labeled rough pass 1 and rough pass 2.

**Feature** — This is the name of the feature. FeatureCAM names features automatically, but you can rename them using the **Feature Properties** dialog.

**Setup Name** — This shows the name of the setup that the operation is on.

*Display of the Setup name column is optional. To add or remove it from the display, right-click anywhere in the existing column titles area and select or deselect Show Setup from the context menu.*

**Tool** — This is the type of tool used for the operation.

**Tool Slot** is where the tool should be loaded in the tool changer. The tool slot is displayed within the **Tool** column to the left of the tool type.
Display of Tool Slot is optional. To add or remove it from the display, right-click anywhere in the existing column titles area and select or deselect Tool Slot from the context menu.

Feed is the feed of the tool that performs the operation. The feed can be in IPR or IPM units depending on the unit set on the operation.

Speed is the speed in RPM of the current operation.

Depth is the cut depth for the operation.

Priority shows the priority of the operation.

Display of Priority is optional. To add or remove it from the display, right-click anywhere in the existing column titles area and select or deselect Priority from the context menu.

The Priority column appears as the last column on the right (you may need to scroll-right to see it).

Simulation control using the Op List tab

If you display the Op List tab while simulating a part, the operation that is currently being simulated is indicated with a yellow arrow in the left-hand margin. You can also set break points in the simulation. A break point pauses the simulation at a particular operation. You can then use the video-style controls (see page 1520) to control the simulation.

Breakpoints in op list tab (see page 1550)
Display a single Z level (see page 1551)
Viewing centerlines for an operation (see page 1552)
Viewing intermediate shaded simulations (see page 1552)

Breakpoints

To set a breakpoint:

1 Select the operation that you want to pause on.

2 Click the Breakpoint button. A maroon dot displays in the left-hand margin. The next time you run simulation it pauses when it reaches this operation.

To remove a breakpoint:

1 Select the operation that has a breakpoint set on it. (It has a maroon dot in the left-hand margin.)

2 Click the Breakpoint button.
The dot is removed from the margin to show that there is no longer a breakpoint on the operation.

To remove all breakpoints, click the **Clear all breakpoints** button.

To perform a centerline simulation of a single operation:

1. Click the operation that you would like to simulate.
2. Click the **Preview toolpaths** button. The Preview simulation buttons (see page 1522) are displayed on the **Simulation** toolbar.

**Single Z level**

To display a single Z level of a Z-level rough or Z-level finish operation:

1. Click the Show **Centerline** button and click the **Play** button to simulate all of the toolpaths for your part.
2. Click the **Clear toolpath** button.
3. Select a Z-level operation in the **Op List** tab. Click the arrow button to see all of the Z-level toolpaths for that operation.
4. Select a Z level from the menu to see the toolpaths for that Z-level.
Single operation

To view all the centerline toolpaths for an operation:

1. Click the Centerline simulation button, then click the Play button.
2. Click the Clear toolpath button.
3. Click any operation in the Op List tab.

Intermediate shaded simulations

To view intermediate shaded simulations:

1. Click the 3D shaded button or the 3D Rapid cut simulation button, then click the Play button.
2. Click an operation to display the machined model up to that point in the process.
3. At the end of the list of operations is the word, Result. Click this word to view the final simulation image for your part.
You must select the **Save result files during RapidCut** option in the **2D/3D Shaded** tab of the **Simulation Options** dialog to use this procedure for rapid cut simulations (see page 1524).

**Operation ordering using the Op List tab**

The **Op List** tab of the **Results** panel displays a list of operations in the order they are performed. By default, the operations are automatically ordered. You can change the order of the operations automatically, by specifying rules, or manually.

**For automatic ordering:**

1. Select **Automatic Ordering** at the top of the **Op List** tab.
2. Click **Ordering** ![Ordering Button] to display the **Automatic ordering options** dialog.
3. Select or deselect the following ordering options:
   - **Minimize tool changes** — Groups operations together that use the same tool. This saves time for you by eliminating or reducing needless tool changes. You must select this check box if you want to generate hole macros in the NC code.
   - **Do finish cuts last** — Moves the finish milling operations to the end of the Setup without altering the order of the finishing operations. If you want to perform all rough milling operations before finish milling operations, select the **Do finish cuts last** attribute.
   - **Cut higher operations first** — Affects only milling Setups. Select this option to mill the features from the top of the stock first and work toward the bottom. If you deselect this option, you should graphically verify the toolpath before cutting your part.
• **Minimize rapid distance** — Affects only milling Setups and is the only ordering option that changes the order of features specified in the part view. **Minimize rapid distance** moves to the next closest feature that uses the same tool as the last operation. You must deselected this option if you want to generate hole macros in the NC code.

As you select ordering options, the operations are re-sorted.

4 Click **OK**.

If you create a new operation with **Automatic Ordering** selected, the new operation is automatically sequenced using the selected ordering options.

**For manual ordering:**

1 Select **Manual Ordering** at the top of the **Op List** tab.

2 To change the position of an operation:

   ▪ Select an operation in the **Operation List**, then click **Move item up** or **Move item down**.

   ▪ Drag-and-drop an operation to move it to a new position in the list.

   *Right-click one of the column names and select **Show Priority** to display the Priority of each operation.*

If you create a new operation with **Manual Ordering** selected, the new operation is inserted at the end of the list.

**Feature and operation editing from the Op List tab**

You can edit features and operations directly from within the **Op List** tab. Double-click in the column for the operation you want to edit. The columns open the following tabs in the **Feature Properties** dialog:

<table>
<thead>
<tr>
<th>Column</th>
<th>Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td><strong>Milling</strong> or <strong>Drilling</strong> tab for the operation. Here you can modify manufacturing attributes.</td>
</tr>
<tr>
<td>Feature</td>
<td><strong>Dimensions</strong> tab for the feature. Change dimensions for the feature or click the <strong>Strategy</strong> tab to alter the types of operations that are used to manufacture the feature.</td>
</tr>
<tr>
<td>Tool</td>
<td><strong>Tools</strong> tab for the operation. Review tooling details or modify the tooling for the operation.</td>
</tr>
<tr>
<td>Feed</td>
<td><strong>F/S</strong> tab for the operation.</td>
</tr>
<tr>
<td>Speed</td>
<td><strong>F/S</strong> tab for the operation.</td>
</tr>
</tbody>
</table>
### Depth
- **Dimensions** tab for the feature.

### Priority
- **Milling** or **Drilling** tab for the operation. Here you can edit the **Priority** attribute.

### Retract
- Single-click this column to change the retract plane for drilling features. See Combine with similar holes into canned cycle (see page 1601) for more information.

If a manufacturing error is detected for an operation that would prohibit generating toolpaths, a stop sign 🚫 icon is displayed in the left-hand side of the row. Click this icon to try and fix the error.

> You can also right-click a row of the table and a menu of feature tabs is displayed. Select the tab name to go directly to that tab.

**See also:**
- Overriding the tool, feed or speed for multiple operations at once (see page 1555)

#### Overrides for multiple operations

To override the tool, feed, speed, or priority for multiple operations simultaneously:

1. Select the first operation in the **Op List** tab in the **Results** window.
2. Hold down the **Shift** key and select the last operation so that a block of operations are selected.
3. Right-click the selected group to open a context menu. It contains items that begin with the word **Override**. Select the menu item to override the tool, feed, speed, or priority of all selected operations so that they are identical to the first selected operation.

#### Details

At the top of the **Details** tab, there are two options:

- **Operation List** (see page 1556) — This displays a detailed report on each manufacturing operation.
- **Tool List** (see page 1556) — This displays a report on the automatically selected tools.
Operation List details

The operation details sheet lists information for each manufacturing step on cut type, cut depth and center point, tool details, speed/override, feed/override, and estimated manufacturing time.

Part — This shows the filename of the part. If you have not saved your part, the default part name is FM1.

Date — This shows the date and time that the NC code was generated.

Stock — This shows the dimensions of your initial stock.

Mat — This shows the material name and hardness of the stock material.

Setup — This shows the name of the coordinate system that defines this Setup.

Origin — This shows the origin using the world coordinate system.

Op — This shows the operation number. The operation numbers start at 1 and are incremented by one for each operation. The operation number is followed by the feature name, and the operation name in parentheses.

F/S — This shows the speed and feed of the operation.

Tool — This shows the tool number and type.

Est. HP and Power — When toolpaths are generated, the estimated horsepower needed for each operation is calculated by using the depth of cut, width of cut, feedrate, and stock material. The actual shape of the feature is not taken into account. Instead, just a simple straight cut is assumed when calculating the estimated horsepower. This number is reported as the Est. HP. The estimated horsepower is calculated only for operations that are cut with flat bottom tools with a fixed depth. This includes 2.5D milling features, and 3D Z-level roughing and other 3D features with Z increment set.

Tool List details

Whenever you simulate a part, the Manufacturing Tool Detail sheet is automatically generated. The Manufacturing Tool Detail sheet provides information on the following:

- Tool name — This shows name of the tool.
- Tool slot no. — This shows the tool slot (or tool pocket) that contains the tool.
- Tool offset no. — This shows the tool cutter comp. offset register. If the offset register has the same number as the Tool Slot No. it is not reported.
More information on changing the Tool Slot No. or the Tool Offset No (see page 1575).

**NC Code tab**

To view the NC code for your part click the **NC Code** tab. This posts the part program and shows the M and G-codes. It is not a report in the normal sense, but is often reviewed as a report by those who understand NC code. You can also display the NC code by clicking the **NC Code** icon in the **Steps** toolbox.

*If you hold the Shift key down and then click the NC Code tab, the underlying ACL code is displayed in the Manufacturing Feedback window.*

You cannot click the NC tab unless you have a dongle installed. Clicking one of the report buttons shows you the documentation, but it doesn't save it to disk. Use **Save NC** (see page 1567) from the **File** menu to save the documentation.

*If you are using the Student version of FeatureCAM, you cannot post NC code.*

**Tool Posts tab (MTT)**

The **Tool Posts** tab is displayed in the Results Window on the right of FeatureCAM for Multi-Turret Turning documents.

To display this tab:

1. Click the **Results** tab in the upper right corner of the FeatureCAM screen.
2. Click the **Tool Posts** tab at the bottom of the window.

There are two viewing options for the **Tool Posts** tab, which you select from the options at the top of the tab:

- Time view (see page 1557)
- Operation view (see page 1558)

**Time view**

Use the **Time view** to show a timeline of operations for each tool post in the document.

A list of spindles is displayed on the left of the window. A list of tool posts is displayed under each spindle, and the operations are shown by each tool post. The tool post names are taken from the solid names in the Machine Design file.
A Time Scale is displayed on the top of the window which shows the machining time in minutes. You can shorten or lengthen the time scale by clicking and dragging it, or by scrolling the mouse-wheel when the cursor is in the **Results** window.

In this example, the machine has two spindles and two turrets that can cut parts loaded into either spindle. The main spindle has a roughing operation that is performed simultaneously on both turrets. The identical length of the boxes surrounding the roughing operations shows that they will take the same time to cut.

**Synchronizing operations**

**Assign an operation to a turret**

Operations are assigned to turrets in the **Turret** tab.

To change the turret for an operation:

1. Select the operation in the **Turret** tab.
2. Right-click the mouse on the selected operation.
3. Click either **Set opers to turret 1** or **Set opers to turret 2**. (If you have more than two turrets, additional menu items will be displayed to allow you to move the operation to any turret.)

**Operation view**

Use the **Operation view** to show the operations in the order they are machined.

Operations are displayed beside the feature names in columns organized by tool post and spindle.

You can drag and drop operations within the grid to change their order or tool post.
Synchronizing operations

To control which operations are synchronized, that is run at the same time, you add sync points.

If you want two operations to happen at the same time:

1. Select one or more operations in a column.
   
   To select multiple operations, hold down the Ctrl key.

2. Press and hold the Ctrl key and select an operation from the other column.

3. Either:
   - Right-click on either of the selected operations and select Set sync point at oper start from the context menu; or
   - Click the Set sync at oper start button at the top right of the Tool Posts tab.

   A red line is displayed in the list to show the sync point. The two operations and all subsequent operations move below it.

You can also use synchronization to force one operation to run before another.

In the example above, we want the hole2 drill operation on the Lower turret to run before the main_off off Main spindle operation on the Upper turret. To do this:
1. Select the operation that you want to run first, in this case `hole2 drill`.

2. Press and hold the Ctrl key and, from the other column, select the operation that you want to run next, in this case `main_off off Main spindle`.

3. Either:
   - Right-click on either of the selected operations and select Set sync for 'radial_pattern1.hole2.drill' before 'main_off.off Main spindle'; or
   - Click the Set sync for 'radial_pattern1.hole2.drill' before 'main_off.off Main spindle' button at the top right of the Turrets tab.

A red line is displayed in the list to show the sync point. `hole2 drill` is above the sync point and `main_off off Main spindle` and all subsequent operations are displayed below it.
To remove a sync point, right-click on it and select **Remove selected sync point** from the context menu. To remove all sync points, click the **Remove all sync points** button at the top right of the **Tool Posts** tab.

Click the **button to access the options **Reset all opers to default tool post** and **Remove all oper sync points**.

You can also use the **Undo sync code changes** button, at the top right of the **Tool Posts** tab, to remove your most recently created sync point.

**Automatic synchronized turning**

Using the **Tool Posts** tab, you can manually synchronize operations. For cutting OD turning features, FeatureCAM can automatically synchronize operations and load the appropriate tools in each tool post. All of the automatic synchronized turning requires a lathe with two opposing tool posts.

**Pinch turning**

Pinch turning is also referred to as balanced turning. It can be used for either roughing or finishing. With pinch turning, both tools cut the same curve (although one is above the axis of rotation and the other is below). The feed rate that is calculated for each tool is doubled. The first tool actually leaves a spiral of material after its finish pass and the second tool is positioned at min Z so that it cuts the spiral of material left by the first tool. The tools cut at the same time so that the time needed for the finish pass is halved. The tool that is selected for the operation is automatically inserted into both tool posts.

The following image shows an example of pinch turning.

*The two tools are positioned identically in both the X and Z axes.*
To set this strategy on a turning operation:

1. Bring up the **Strategy** tab of the turn operation
2. Make sure that the roughing or finishing pass is enabled by selecting the **Rough** or **Finish** option.
3. Select **Pinch turning** from the menu after the option.

**Follow turning**

Follow turning is typically performed when roughing. Each tool post removes a standard depth of cut. The second tool post removes a depth of cut below the cut left by the first tool post. The tool posts wait or synchronize at the start of the cut. One tool post is a fixed distance in front of tool post 2. The image below illustrates follow turning. The top tool is in front of the bottom tool and the bottom tool is cutting deeper in X.
**Viewing a turret's NC code**

For synchronized turning, a separate NC program is created for each turret. The **Part View** has an entry called **Turrets**. Each turret is listed under this entry. To display a specific turret's NC code, click the name of the turret in the **Part View**. The NC code will then be displayed in the **Results** window.

![Turrets.png](image)

**Changing the fonts for the reports in the Manufacturing Feedback window**

You have a choice of three font sizes for the text in the **Results** window.

To change the font size:

1. Right-click in the window.
2. Select **Small Font**, **Medium Font**, or **Large Font**.

You can also select **Fixed Width Font**, which means that the characters line up vertically. This can be easier to read.

**Turn operation order**

The **Turn operation order** option of the **Manufacturing** menu displays the general outline that is used for ordering turning operations if the Use operation template default ordering attribute is set. The dialog that displays lists the types of operations that are created in a general turned part. The order of the list determines the order that the operations in your part are cut. If your part does not have a particular operation in it, that operation is skipped.

By selecting an operation type and using the arrow keys, you can change the order in which the features are manufactured. After rearranging the list, click **OK**. This order is remembered for all of your parts.

**Printing**

You can print the tooling lists, operations sheets, NC programs, and drawing for a part by selecting **File > Print** from the menu. You can also preview these documents with **Print Preview**. Some options are unavailable in the dialog if you have not generated toolpaths.

To print information from FeatureCAM:
1 Select the information you want to print in the **Print Range** area of the dialog. See FeatureCAM file types (see page 69) for more information.

2 If there is a toolpath displayed and you want to print it, click **Print tool path**.

3 If you want to print so that the units of your part are honored, click **Print to scale**. This means that a 1 inch line segment measures 1 inch on the paper. If your part is larger than your physical sheet of paper only a portion of your part is printed. If **Print to scale** is deselected, your drawing is scaled to fit the paper.

4 Set your **Print Quality**. The specific options depend on your printer.

5 Set the **Number of copies** to print.

6 Click **OK**. **Setup** opens the standard Windows printer configuration window.

**Print Preview**

Select **File > Print Preview** from the menu to display the active document as it would appear when printed. When you choose this command, the main window is replaced with a print preview window in which one or two pages are displayed in their printed format. The print preview toolbar gives you options to view either one or two pages at a time; move back and forth through the document; zoom in and out of pages; and start a print job.

**Print Setup**

Select **File > Print Setup** to open the **Print Setup** dialog, where you specify the printer and its connection.

- **Name** — Select the printer you want to use from the menu.
- **Properties** — Displays a dialog where you can make additional choices about printing, specific to the type of printer you have selected.
- **Size** — Select the paper size.
- **Source** — Some printers offer multiple trays for different paper sources. Select the tray here.
- **Orientation** — Select **Portrait** or **Landscape**.
- **Network** — Click this button to connect to a network location, assigning it a new drive letter.
You must generate toolpaths (see page 1516) before you can create NC code.

After you have generated toolpaths, the NC Code step is available to you. Click the NC Code icon in the Steps toolbox to open the NC Code dialog:

The options are:

- **Optimize feed rates** — Click the icon to open the Feed Optimization (see page 1570) dialog.

- **Display the NC code** — Click the icon to view the NC code on the NC code tab of the Results window.

- **Save the NC code** — Click the icon to open the Save NC (see page 1567) dialog.

- **Re-map the tools** — Click the icon to open the Tool Mapping (see page 1575) dialog.
Creating NC code

After you have run a simulation, the NC Code tab is active.

You can edit the NC Code directly in this tab.

Right-click in the code area to display the context menu.

Use Cut, Copy, Paste, Delete, Find, Replace, and Undo to edit the code.

Select the size of the text displayed from:

- Small Font
- Medium Font
- Large Font

Fixed Width Font — Select this option to display the NC code in a fixed-width font. This means that each individual character is the same width, which can be easier to read because the characters line up vertically. Deselect it to display the NC code in a variable-width font.

You cannot post without the dongle connected to the computer.
The post processors are configured using the XBUILD program. The documentation for XBUILD, FeatureCAM’s post processor, is available in a formatted electronic version by selecting Post Processing Guide from the Help menu in FeatureCAM. It is available directly from the XBUILD program in online form by selecting Using Xbuild from the Help menu in XBUILD. The formatted electronic version is available by selecting Post Processing Guide from the Help menu in XBUILD. XBUILD and all of its reserved words are documented in this separate documentation.

You can use the Post Options dialog (see page 1857) to change the post options and select the controller.

Saving an NC part program to disk

Open the Save NC dialog in one of these ways:

- Click the NC Code icon in the Steps toolbox and then click the Save the NC code icon.
- Select File > Save NC from the menu.

The Save NC dialog is displayed:

1. Specify the NC Output Directory.
2 If you want the NC code file to have a different name than the part name, enter a different name for the NC file name. If you omit the file extension, it defaults to *.txt.

3 If you want to save the NC code for only the current Setup, select **Current Setup**. Select **All Setups** if you want to save separate NC programs for each Setup.

4 Select what you would like to save to disk from: **Operations list**, **Tools List of All Setups**, **Tools List of Each Setup**, **NC Program**, **Tool data**, **F/S data**, **Machining Configuration**. See FeatureCAM file types for an explanation of the types of files that are saved (see page 69).

5 Click **Create subfolder** if you want to create an additional folder inside the **NC Output** folder. This folder has the same name as your part.

6 If you know you want to overwrite all existing folders with the same names, select **Overwrite Existing Files**. Otherwise you are asked to confirm before overwriting any file.

7 Click **OK**.

### Milling macros

Macros can be generated in the NC code for multiple Z levels of a milled feature. To generate these macros, your post processor must support them, and you must turn this function on for the post.

1 Select the **Manufacturing > Post Process** menu option to display the **Post Options** dialog.

2 Select your post processor.

3 Deselect **Disable Macros**.

4 Click **OK**.

5 Select **Manufacturing > Machining Attributes** from the menu.

6 Select **Minimize tool changes**.

   You could set Minimize tool changes in the Ordering (see page 1495) dialog instead. Using the Default Attributes setting includes macros for any parts you create. **Minimize tool changes** groups operations together that use the same tool. This saves time for you by eliminating or reducing needless tool changes. You must select this check box if you want to generate hole macros in the NC code.

1 Turn off **Minimize rapid distance**.
This attribute affects only milling setups and is the only ordering option that changes the order of features specified in the part view. **Minimize Rapid Distance** moves to the next closest feature that uses the same tool as the last operation. You must deselect this option if you want to generate hole macros in the NC code.

1. Click **OK**.

Now when you generate NC code, you get macros for the milled features that are milled at multiple Z depths.

**Incremental programming and local coordinate systems**

These topics apply to the use of milling macros (also called subprograms or subroutines) and are activated by selecting the **Use macro calls for each instance in the pattern** on the pattern **Strategy** (see page 873) tab.

Incremental programming means that the moves in the subroutine are relative instead of absolute. Instead of moving to a particular absolute location inside of the macro, the moves are relative to the current position, such as move two additional inches in X. An example G-code is Fanuc's **G91** for relative programming.

When using local coordinate systems, the coordinate systems are constantly being redefined outside of the macro and the moves within the macro are absolute. Examples of this concept are Fanuc's **G92**, Heidenhain's Datum Shift and Siemens's **G58**.

The actual G-code created for a particular pattern depends on the macro programming options (see page 1514) that are supported by the post processor.

**Turning canned cycles**

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles on the feature level.

**Hole features**

If **Enable drilled canned cycles** is deselected in the **Post options** dialog, then all hole drilling operations will be computed in the post. This includes spotdrilling, drilling, bore, ream and tapping operations. If **Enable drilled canned cycles** is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.
There is no way to control the output of canned cycles on an individual feature basis.

**Turn/Bore features**

Canned cycles for Turn and Bore features must be enabled by selecting **Enable turn canned cycles** in the **Post options** (see page 1857) dialog. You must then go to the **Properties** dialog for each Turn/Bore feature, click the **Strategy** tab and select **Use canned cycle**. Also select **Reuse path in canned cycle** if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but remember these values apply only to features you create after making this change.

**Groove features**

Enable grooving canned cycles in the **Post options** dialog by selecting **Enable groove path canned cycle**. Then turn on canned cycles for each groove by bringing up the feature's **Property** dialog, clicking the **Strategy** tab, and then clicking **Use path canned cycle**. You can also set this attribute on the **Groove** tab of the default attributes, but this will only apply to features you create after changing this setting.

**Thread features**

Thread features always use canned cycles.

**Feed Optimization**

You can use Feed Optimization to even out the tool load by adjusting the program's feed rates.

To optimize a program's feed rates:

1. Generate the toolpaths.
2. Set the **Target horsepower** (see page 1574) milling attribute for the operations you would like to optimize. For 2.5D finish milling operations, set the Peripheral Feed (see page 1655) options.
3. Select **Manufacturing > Feed Optimization** from the menu. The **Feed Optimization** dialog is displayed.
4. Specify the Feed Optimization parameters (see page 1571), and click **OK** to close the dialog.
5 In the Simulation toolbar, click Show tool load, and run the simulation again to show the tool load (see page 1545) before and after the optimization. The Tool Load graph shows the optimized loads in black and the unoptimized loads in white:

![Tool Load graph](image)

In the image above, the tool load spikes have been reduced in the black (optimized) curve.

6 To remove the optimized feed rates without regenerating the NC code, select the Manufacturing > Clear Optimized Feeds menu option.

**Feed optimization parameters**

These parameters are in the Feed Optimization dialog:

![Feed Optimization dialog](image)

*Increase feed when load is below \% of target horsepower* — The programmed power is the estimated horsepower displayed in the Operations List. This percentage is applied to the estimated horsepower and the feed rate is increased for any move that requires less power.
But do not increase feed beyond % of programmed feed — Enter the maximum percentage to increase the feed rate over the operation's initial feedrate.

Decrease feed when load is above % of target horsepower — The programmed power is the estimated horsepower displayed in the Operations List. This percentage is applied to the estimated horsepower and the feed rate is decreased for any move that requires more power.

But do not decrease feed below % of programmed feed — Enter the minimum percentage to decrease the feed rate.

Perform super sampling to calculate instantaneous tool load — Set this option to create a more accurate sampling of the tool loads by sampling the loads at a number of points along the toolpath and then averaging these loads for each NC block. If this option is turned off a single tool load is calculated for each block of NC code.

Number of times to measure tool load — If Perform super sampling is selected, then you can enter how many times per minute to calculate the tool load. To calculate the load for each NC block, the loads are averaged. The larger this number is, the longer the feed optimization takes.

This number is relative to the running time of your NC program. If your program runs more than an hour, we recommend that you set this number to 100 or less.

Use different feed rates on a single block — A long cut may have varying tool loads. If you want to break up NC blocks so that you can more finely control the feed rates, check this option.

This option increases the size of your NC program.

Distance to split toolpath — If you select Use different feed rates on a single block, then this parameter controls how often the toolpath is broken up. It is specified as a percentage of the tool diameter.

OK — Click the OK button to optimize feed rates for the part.

See also tool load (see page 1545).
Feedrate optimization example

The top boss of this brake caliper is used in this example.

When cutting this feature in aluminum with the default stepover and feed/speed table, the horsepower is estimated at 2.0 for the roughing pass and 0.3 for the finishing pass. A 0.5" tool is selected. Let’s assume that you would like to keep the horsepower requirements for this cut to less than 2.5. When a tool load is run on this example, the maximum horsepower required is shown to be 5.9. In order to stay under the stated horsepower requirement, the feedrate for the roughing pass must be reduced by 50%. Without feedrate optimization, your only choice for lower the horsepower requirements are to adjust the width or depth of cut for the entire operation or change the feedrate for the entire operation.

When you examine the toolpaths of this boss there are light cuts, as shown in the narrow cut in the first image, and heavy cuts, as shown in the wide cuts in the second image.

Feedrate optimization looks at the tool load for each move and adjusts the feedrate to even out the load. Instead of reducing the overall feedrate for the roughing pass, let's keep the feedrate for the roughing feature the same and use feedrate optimization to adjust the feedrates of the individual moves of the toolpath. The table below shows that feedrate optimization allowed us to reduce the machining time by 47% while maintaining a more constant cutter load.
Target horsepower

Target horsepower is the ideal [horse] power for the specified width/depth of cut and feed rate on the specified stock material type. By default, it is set on a 2.5D milling operation when a flat-end milling tool is used. The calculation is simple. The stock material has a property which specifies the [horse] power per unit material removal rate. All we need is to calculate the material removal rate from the width/height of cut and the feed rate. Then multiply this value and the stock’s [horse] power per unit material removal rate.

During feed optimization, FeatureCAM calculates the sampled material removal rate along the whole toolpath. If the rate is faster than the target feed rate, it is decreased. If the rate is slower than the target feed rate, it is increased.

Set this milling attribute to the required horsepower for the operation. This number is then used in feed optimization (see page 1570) to even out the tool loads. This attribute is automatically set to the estimated horsepower for 2D roughing passes performed with flat end tools. For 3D roughing passes performed with flat end tools, this attribute is also set to the estimated horsepower as long as the Z increment attribute is set. For all other operations, this attribute has no default value.
When toolpaths are generated, the estimated horsepower required for each operation is calculated by using the depth of cut, width of cut, feedrate and stock material. The actual shape of the feature is not taken into account. Instead just a simple straight cut is assumed when calculating the estimated horsepower. This number is reported in the **Operations list** of the **Details** tab as the Est HP. The estimated horsepower is only calculated for operations that are cut with flat bottom tools with a fixed depth. This includes 2.5D milling features, and 3D Z level roughing and other 3D features with Z increment set.

When toolpaths are generated, the estimated horsepower required for each operation is calculated by using the depth of cut, width of cut, feedrate and stock material. The actual shape of the feature is not taken into account. Instead just a simple straight cut is assumed when calculating the estimated horsepower. This number is reported in the **Operations list** of the **Details** tab as the Est HP. The estimated horsepower is only calculated for operations that are cut with flat bottom tools with a fixed depth. This includes 2.5D milling features, and 3D Z level roughing and other 3D features with Z increment set.

If the **Target horsepower** is not set for an operation, then its feedrates are not modified by feed optimization (see page 1570). This means that if you do not explicitly set the target horsepower for individual operations, feed optimization will only affect 2D roughing operations and 3D roughing operations with flat end mills and the Z increment parameter set.

*For 2.5D finish milling operations, we recommend that you use Peripheral feeds (see page 1655) instead.*

**Tool Mapping**

You can open the **Tool Mapping** dialog in one of these ways:

- Select **Manufacturing > Tool Mapping** from the menu.
- Click NC Code in the Steps panel, then click **Re-map the tools to new tool slots** in the NC Code dialog.

The **Tool Mapping** dialog is where you change the tool slot assigned to the selected tool. You can change the **Cutter comp. offset register** for any tool here too.

The dialog has a table at the top. Each row of the table represents a tool. Select a tool to edit its values in the fields below the table.

Double-click on a tool name, or click the + to the left of the tool name to see the list of operations that use that tool.

Click the **Add tool slots** button at the top left of the table to open the **Number of tool slots** dialog. It enables you to increase the number of tool slots listed; you cannot reduce this number.

**Tool number** — This corresponds to the first (gray) column in the table and is the current tool slot number for that tool. To move a tool to a different slot tool slot, enter a new **Tool number** and click the **Set** button, or drag-and-drop the name of the tool in the table onto the tool slot number in the left column. More than one turning tool can occupy the same tool slot (see page 1582).
Diameter offset register — Specifies the diameter cutter compensation offset register number for the tool. This value is passed to XBUILD as `<COMP-NUM>`. It corresponds to the Diameter column in the Tool Mapping table. Enter up to 8 digits.

Length offset register — Specifies the tool length offset register number. Most lathe controllers have a single register that contains the length and diameter offset values. In this case, the Length offset register is the important field to set in FeatureCAM. This value is passed to XBUILD as `<OFFSET#>`. It corresponds to the Length column in the Tool Mapping table. Enter up to 8 digits.

2nd Length (for grooves) — The second length offset register for groove tools. The default second offset register number is the Tool number plus the 2nd offset reg. increment in the Turn default attributes.

To set the offset registers by operation, select the operation in the table. You may need to expand the tool name to view the operation.

Most lathe controllers have a single register that contains the length and diameter offset values. In this case, the Length offset register number is the important field to set in FeatureCAM.

Tool ID — This corresponds to the ID column in the table and is the tool ID register for the tool. This is a seldom-used field that is used by Bridgeport lathes and occasionally for Cincinnati machines.

The Tool Mapping dialog has these buttons:

Same — This sets the cutter comp. offset registers for all tools to the value of their tool slot number.

Set — Select a tool in the table, enter a Tool number and click the Set button to assign this tool a number specific for this part.

This assignment is for the current part only. If you want to assign a tool to a default tool slot for all parts, use the Overrides (see page 1785) tab of the Tool Properties dialog.

Save in Crib — This permanently assigns the tool number with the tool in the database. The tool is then locked in this position for all parts that use the tool.

Clear in Crib — The tool number slot for the selected crib is erased. This means you want FeatureCAM to assign a tool number automatically.
 See Tool Manager (see page 1745) for more information on tooling databases.

Set All — All tools numbers are set to their current values and are not changed.

Reset All — This returns all tool slot numbers and cutter comp offset registers to their initial values.

Select Block — Click this button to display the Tool Block Selection dialog (see page 1579), which you can use to specify which tool block is used to hold the selected tool.

Tool Life — Tool life management enables you to limit the use of a tool and automatically switch to another tool when that limit is reached. It is useful when cutting hard material that may wear out a tool during a single program run. The table in the Tool Mapping dialog displays the number of Holes that are cut by each drilling tool and the Time (number of minutes) that each milling tool is used during a single run of the NC program. Select a tool in the table and click the Tool Life button to open the Tool Life (see page 1579) dialog.

  This button is not available until after you have run a simulation.

Tool numbering

FeatureCAM automatically selects tools from the active tool crib. These tools are assigned a tool number (also referred to as a tool slot or tool pocket) for an automatic tool changer. The numbering is assigned according to these rules:

1 Use the number assigned in the Tool Mapping (see page 1575) dialog.

  This numbering is in effect for the current part only.

2 If no number has been assigned via tool mapping, then the number assigned to the tool in the crib (the Tool number field for milling tools or the Tool slot for turning tools), is used as the tool number. If two tools have the same permanent number in the crib, the first tool used is assigned the preset number and the other tool is given a new number.

3 If no number has been assigned via tool mapping or in the crib, FeatureCAM assigns a tool number.
Tool Block Selection dialog

Use the Tool Block Selection dialog to specify which tool block holds a tool.

![Tool Block Selection dialog](image)

To specify which tool block holds a tool:

1. In the Tool Mapping dialog, select a tool and click Select Block to display the Tool Block Selection dialog.
2. In the Tool block list, select the tool block solid from the Machine Design file that you want to hold the selected tool.
3. Select the sub slot in the list that you want to hold the tool.
4. Click OK to close the Tool Block Selection dialog.

The tool block you selected is displayed in the tool mapping tree.

Tool Life

To open the Tool Life dialog, select the tool you want to manage in the table in the Tool Mapping (see page 1575) dialog and click the Tool Life button.

The Tool Life dialog has different options depending on if the tool is a drill or a milling tool.
Drills

The **Tool Life** dialog for drilling tools has these options:

- **Use a single tool. (Turn off tool life for this tool)** — Select this option to disable tool life management for this tool. A single tool performs all operations that are scheduled for this tool slot.

- **Divide the number of holes equally between a specified number of tools** — This option divides the work of the tool, in terms of number of holes, equally among the **Number of tools** you specify.

- **Limit each tool to a specified number of holes. Create as many tools as needed** — For this option you specify a limit in **Number of holes** and additional tools are assigned when the limit is reached. No tool cuts more than the **Number of holes** you specify. Additional tool slots are then assigned to the same tool and the work is divided among those slots. When the NC code is created, a tool change is inserted when the limit is reached.
Milling tools

The Tool Life dialog for milling tools has these options:

- **Use a single tool. (Turn off tool life for this tool)** — Select this option to disable tool life management for this tool. A single tool performs all operations that are scheduled for this tool slot.

- **Divide the cutting time equally between a specified number of tools** — This option divides the work of the tool, in terms of cutting time, equally among the Number of tools you specify.

- **Limit each tool to a specified number of minutes. Create as many tools as needed.** — For this option you specify a limit in Number of minutes and additional tools are assigned when the limit is reached. No tool cuts more than the Number of minutes you specify. Additional tool slots are then assigned to the same tool and the work is divided among those slots. When the NC code is created, a tool change is inserted when the limit is reached.

  *Time measurements only consider cutting times. Time spent in rapid moves is ignored.*

- **Divide the cut distance equally between a specified number of tools** — This option divides the work of the tool, in terms of cut distance, equally among the Number of tools you specify.

- **Limit each tool to a specified distance. Create as many tools as needed.** — For this option you specify a limit in Distance and additional tools are assigned when the limit is reached. No tool cuts more than the Distance you specify. Additional tool slots are then assigned to the same tool and the work is divided among those slots. When the NC code is created, a tool change is inserted when the limit is reached.
Restrictions for Tool Life management

- Tool life management is active for milled parts, multiple fixture parts, and tombstone parts.
- It is not active for turning, turn/mill, or wire EDM parts.
- You must generate toolpaths to activate tool life management.
- For milled parts, tool life management is only active for the creation of a single program. Therefore it is active for single-Setup parts, or 4-axis or 5-axis indexed parts. For 4-axis and 5-axis parts, if Setup dominant is selected, you must also select Generate single program to enable tool life management. See the Index tab of the Stock dialog for more information on indexing. If you have a multiple-Setup milling part without indexing, you must deselect all but one setup in the Part View to enable tool life management for this setup.
- Tool life applies only to the use of a tool during the running of a single program. Tool life information is not stored permanently in the tooling databases.

Putting two tools in the same tool slot

There are situations in turning when two different tools are loaded in the same tool slot. For example, two drills may be loaded with one facing the main spindle and the other facing the sub-spindle. Use the following steps to implement this tooling setup.

1. Program the part as if the tools are in separate tool slots.
2. Open the Tool Mapping (see page 1575) dialog.
3. Set the Tool number of the two tools to the same number.
4. Set the Length offset register to different values for the two tools in the same tool slot.

Using an insert drill to drill and bore in the same program

1. Create the Hole feature and override the tool for the drilling operation to be an insert drill.
2. Create the Bore feature and override the tool to be the same insert drill.

If you view the tools in the Tool mapping (see page 1575) dialog, you see that there are two drills listed in the same tool slot, but they each have a different Length offset register.
Getting the file to the machine

Configuring HyperTerminal (see page 1583)
EZ-UTILS (see page 1583)
Cables (see page 1589)
Serial port pinouts (see page 1590)

Configuring HyperTerminal

HyperTerminal is easy to use to send and receive NC code from the machine. The first time you use HyperTerminal, set up an icon for communication with the machine tool. All the parameters for machine communication are linked to the icon link you created. In later sessions, you only have to double-click the icon instead of re-entering the communications settings.

1  Launch Hyperterminal from the Start menu.

2  Double-click the Hypertrm.exe icon. You may or may not see the .exe extension depending on your computer's configuration.

3  You may be prompted to install a modem. If you do not have one, click No and set up a communications icon.

4  Enter a name for the icon and pick an icon from the group.

5  Click OK.

6  Set the list box at the bottom of the screen to Direct to COM1 (or whichever port you communicate through). Click OK and a communications properties box appears.

7  Your machine tool should have recommended communication settings. If so, use those settings here.

8  Click OK. HyperTerminal is configured to communicate with your machine.

You may also need to review how to send and receive files from the machine.

EZ-UTILS

To run the EZ-UTILS program, double-click the EZ-UTILS icon. When the EZ-UTILS main screen appears, there are three menus at the top of the screen: To CNC, From CNC, and Settings. These menus contain commands to communicate with various CNC controls.
EZ-UTILS is an unsupported module that is provided to FeatureCAM users free of charge. FeatureCAM regrets that it cannot provide customer support on this application.

To CNC menu

The **To CNC** menu shows five commands. These are all used to allow a file to be sent from the FeatureMILL system to the CNC control via a hard-wired cable which is attached to both the CNC control and the FeatureMILL computer.

From CNC menu

The **From CNC** menu shows three commands. These are all used to accept a file sent from a CNC control to the FeatureMILL system via a hard-wired cable which is attached to both the CNC control and the FeatureMILL computer.

Settings menu

The **Settings** menu in EZ-UTILS contains three menu choices. These are used only before sending a part program to the CNC machine.

**Resequence** lets you renumber the lines in a part program without re-posting the program. When the **Resequence** command is selected from the **Settings** menu, a dialog is shown asking for the **Start Number** and **Increment values**. When OK is selected, the screen displays a dialog that allows the operator to select a *.txt file from a disk volume.

After you have selected a file, enter a filename at the prompt so the resequenced file can be saved under a new name. The name can also be the same as the file selected. After a file name is selected, the file is renumbered. The first line in the program is numbered with the **Start Number** and the line number on every succeeding line in the part program file is incremented by the **Increment value**.

A message is shown on the screen indicating that the operation was completed successfully. Click OK to return to the **EZ-UTILS** menu level.

**Serial port** changes two basic communications settings. The **Baud Rate** is the speed at which the computer sends data to the CNC. This speed must be set the same at both the CNC and FeatureMILL computer.

The **Port** setting determines which serial port the computer uses to communicate to the CNC. The communications cable must be attached to the selected port.

**Set directory** changes the locations where incoming files from a CNC are stored. This command should be set before attempting to download any file, or before establishing communications using the EZ-Link utility.
Connecting to the SX15 or DX32

When linking EZ-UTLS to the Bridgeport SX15 and DX32 controls, connect the Bridgeport communications cable to the RS-232 serial port on the machine and the adapter cable connected to the RS-232 serial port (COM 1 or COM 2) on the computer.

Sending from EZ-UTLS to the CNC:

1. At the EZ-UTLS system:
   1. Start EZ-UTLS and select the EZ-Link utility from the To CNC menu.

2. At the CNC:
   1. Select the Load Remote command on the numeric keypad.
   2. Press the 4 RECV EZLINK key on the keyboard.
   3. Press the F3 LOAD key. A list of files is shown. Press the + key to enter a new file name for receiving. Be sure to type the .TXT file extension.

The file should be sent automatically to the control.

Sending from the CNC to EZ-UTLS:

1. At the EZ-UTLS system:
   1. Start the EZ-UTLS program and select EZ-Link from the To CNC menu.

2. At the CNC:
   1. Select the 4 Load Remote command on the numeric keypad.
   2. Press the 3 SEND EZLINK key on the keyboard.
   3. Press the F3 LOAD key. A list of files is shown. Use the cursor keys to select the file to be sent to EZ-UTLS. Press Enter when the file name is highlighted.

The file should be sent automatically to EZ-UTLS.

Connecting the EZ-UTLS system to BOSS 8, 9, or 10

When linking EZ-UTLS to BOSS 8, 9, or 10, connect the Bridgeport communications cable to the BOSS 8 adapter cable, then plug the round end of this cable into the port on the machine. Connect the adapter cable to the RS-232 serial port (COM 1 or COM 2) on the computer. The BOSS 8 adapter cable should be connected to port B on the CNC.
Use the REMOTE load utility to upload and download programs less than 12,000 characters long (V2E3, R2E3) and less than 200,000 characters long for the R2E4. Use DNCLINK (Direct Numerical Control) when the part programs are too long to reside in the CNC memory.

Sending from EZ-UTLS to the CNC

To transfer a program from disk into the memory of the BOSS 8/9/10:

1. At the EZ-UTLS system:
   1. Select Set Directory in the Settings menu.
   2. Choose the directory from the dialog.
   3. Click Open.
   4. Select EZ-Link from the To CNC menu.

2. At the CNC:
   1. Under OPTIONS, set the baud rate to 4800.
   2. Press the LOAD/CLEAR/EDIT button once.
   3. Press 0 (REMOTE), then EXECUTE.
   4. Press 0 (FROM REMOTE), then EXECUTE.
   5. Enter the file name and press EXECUTE (if the file name is numeric). If the file name is NOT numeric, just press EXECUTE, and the EZ-UTLS system prompts for the file name. Enter the file name, then press RETURN.

Sending from the CNC to EZ-UTLS

To transfer a program to disk from the memory of the BOSS 8/9/10:

1. At the EZ-UTLS system:
   1. Select Set Directory in the Settings menu.
   2. Choose the directory from the dialog.
   3. Click Open.
   4. Select EZ-Link in the To CNC menu.

2. At the CNC:
   1. Under OPTIONS, set the baud rate to 4800.
   2. Press the LOAD/CLEAR/EDIT button once.
   3. Press 0 (REMOTE), then EXECUTE. Then press 1 (TO REMOTE), then EXECUTE.
4 Enter the file name and press EXECUTE (if the file name is numeric). If the file name is NOT numeric, just press EXECUTE, and the EZ-UTLS system prompts for the file name. Enter the file name, then press RETURN.

Connecting to the EZ-Trak SX
When linking EZ-UTLS to an EZ-Trak SX, connect the Bridgeport communications cable to the RS-232 serial port on the machine and the EZ-UTLS adapter cable connected to the RS-232 serial port (COM 1 or COM 2) on the computer.

Sending from EZ-UTLS to the CNC
To transfer a program from EZ-UTLS into the memory of the EZ-Trak control:

1 At the EZ-UTLS system:
   1 Select Set Directory in the Settings menu.
   2 Choose the directory from the dialog.
   3 Click Open.
   4 Select EZ-Link in the To CNC menu.

2 At the CNC:
   1 Press UTILS.
   2 Press 7 Send or Receive Files.
   3 Select the EZ-Link communications protocol, by pressing 1.
   4 Select either 3 or 4, receive an EZ-TRAK (.PGM) file or other (.TXT).
   5 Enter the numeric name of the file to be sent from EZ-UTLS.

Sending from the CNC to EZ-UTLS
To transfer a program to EZ-UTLS from the memory of the EZ-Trak:

1 At the EZ-UTLS system:
   1 Select Set Directory in the Settings menu.
   2 Choose the directory from the dialog.
   3 Click Open.
   4 Select EZ-Link from the To CNC menu.

2 At the CNC:
   1 Press UTILS.
   2 Press 7 Send or Receive Files.
   3 Select the EZ-Link communications protocol, by pressing 1.
4 Select either 1 or 2, send an EZ-TRAK (.PGM) file or other (.TXT).

5 Enter the numeric name of the file to be sent to the EZ-UTLS system.

Connecting to Heidenhain Interact I and II

When linking EZ-UTLS to Interact I or II or to Bridgeport R2C3 Series I or II with the Heidenhain TNC 145 control, connect the Bridgeport communications cable to the RS-232 serial port on the machine and the adapter cable to the RS-232 serial port (COM 1 or 2) on the computer.

Sending from EZ-UTLS to the CNC:

If downloading from EZ-UTLS, make sure that the text file is in the proper Heidenhain format. See the Heidenhain TNC 145 Operation Manual for details.

1 At the EZ-UTLS system:
   1 Select Serial Port from the Settings menu.
   2 Set the Baud Rate to 2400 and click OK.
   3 Select Heidenhain from the To CNC menu.
   4 Select a directory and file name from the dialog.

2 At the TNC 145:
   1 Select the MANUAL mode.
   2 Click EXT.
   3 Enter 2400 for the baud rate and press ENT.
   4 Now choose the PROGRAMMING and EDITING mode.
   5 Press the EXT key. The CRT displays the message: EXTERNAL DATA INPUT.

3 At the EZ-UTLS system:
   1 On the screen, the message Data Transfer in Progress appears.

Sending from the CNC to EZ-UTLS:

1 At the EZ-UTLS system:
   1 Select Serial Port from the Settings menu.
   2 Set the Baud Rate to 2400 and click OK.
   3 Select Heidenhain from the From CNC menu.
   4 Select a directory and enter a new file name in the dialog.
   5 Click Open.

2 At the TNC 145:
1. Select the **MANUAL** mode.
2. Press the **EXTernal** key.
3. Enter **2400** for the baud rate and press **RETURN**.
4. Select either **PROGRAM RUN** modes (**SINGLE BLOCK** or **FULL SEQUENCE**).
5. Enter the starting block number of the program, then press the **GO TO** key.
6. Press **EXTERNAL** key. The CRT displays the message **EXTERNAL DATA OUTPUT**.

At the EZ-UTLS system:
1. The message **Data Transfer in Progress** appears on the screen.

**Cables**

You need an RS-232 adapter cable to connect the computer to the communications cable leading to the CNC machine. The adapter cable may also be used to connect the computer to a serial port expander (ABC switch box). The adapter cable can be plugged into the COM1 or COM2 port, at the back of the main unit.

*The cable can be a 9-pin or 25-pin connector at the computer end. The manual contains an illustration of the required wiring pattern for the cable.*
Serial port pinouts

The necessary communications cables for connecting the computer to any device or CNC control can be made with parts available from most electronics supply stores. The pin functions for a standard 25-pin RS-232 port and a standard 9-pin RS-232 port are shown below. Check your computer owner's manual for the correct information.

<table>
<thead>
<tr>
<th>9-pin</th>
<th>25-pin</th>
<th>25-pin</th>
<th>25-pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>7</td>
<td>4</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td>20</td>
</tr>
</tbody>
</table>

Computer 3-pin

<table>
<thead>
<tr>
<th>25-pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
</tbody>
</table>

Switchbox 25-pin

Computer 25-pin

<table>
<thead>
<tr>
<th>25-pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
</tbody>
</table>

Switchbox 25-pin

<table>
<thead>
<tr>
<th>25-pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>20</td>
</tr>
</tbody>
</table>
Customize Manufacturing

Click **Customize Mfg.** in the **Steps** panel to display the **Customize Manufacturing** dialog:

The options are:

**Establish my manufacturing preferences** — Click **Establish my manufacturing preferences such as setups, tool selection rules, etc.** to open the **Machining Attributes** (see page 1591) dialog. You can also open this dialog by selecting **Manufacturing > Machining Attributes** from the menu.

**Setup FeatureCAM's virtual tool cribs** — Click **Setup FeatureCAM's virtual tool cribs to match the tooling I have in my shop.** to open the **Tool Manager** (see page 1745) dialog. You can also open this dialog by selecting **Manufacturing > Tool Manager** from the menu.

**Refine FeatureCAM's feed & speed tables** — Click **Refine FeatureCAM's feed & speed tables to suit my particular requirements.** to open the **Feeds/Speeds and Cutting Data Tables** (see page 1508) dialog. You can also open this dialog by selecting **Manufacturing > Feeds/Speeds and Cutting Data Tables** from the menu.

**Configure post processor.** — Click **Configure post processor.** to open the **Post Options** (see page 1857) dialog. You can also open this dialog by selecting **Manufacturing > Post Process** from the menu.

**Machining attributes**

You control the default behavior for manufacturing with default machining attributes. You set these attributes so that the system's default behavior represents the practice of your shop.
To override these settings for a particular instance of a feature, you use **Feature attributes** (see page 884). These attributes are set directly on the feature.

You can save machining attribute settings as **Machining configurations** (see page 1741).

Select **Manufacturing > Machining Attributes** from the menu to display the **Machining Attributes** dialog:

![Machining Attributes dialog]

At the top of the dialog, select one of three categories of machining attributes from **Mill** (see page 1597), **Turn** (see page 1685), and **Wire** (see page 1716).
**Default values (inch and mm)**

The following tables show the default machining attribute values in inches and metric for milling (see page 1593), turning (see page 1595), and wire (see page 1596).

### Milling

<table>
<thead>
<tr>
<th>Type</th>
<th>Attribute</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Milling</td>
<td>Minimum tool diameter</td>
<td>0.125 / 5.000</td>
</tr>
<tr>
<td></td>
<td>Z rapid plane</td>
<td>1.000 / 25.000</td>
</tr>
<tr>
<td></td>
<td>Rough tool diameter</td>
<td>&quot;0.5, 0&quot; / &quot;15, 0&quot;</td>
</tr>
<tr>
<td></td>
<td>Spline tolerance</td>
<td>0.001 / 0.025</td>
</tr>
<tr>
<td></td>
<td>Wrap tolerance</td>
<td>0.0001 / 0.003</td>
</tr>
<tr>
<td></td>
<td>Chamfer depth</td>
<td>0.100 / 3.000</td>
</tr>
<tr>
<td></td>
<td>Z clearance plane</td>
<td>0.100 / 3.000</td>
</tr>
<tr>
<td></td>
<td>Tap Z clearance plane</td>
<td>0.100 / 3.000</td>
</tr>
<tr>
<td></td>
<td>Z ramp clearance</td>
<td>0.010 / 0.030</td>
</tr>
<tr>
<td></td>
<td>Z index clearance</td>
<td>1.000 / 25.000</td>
</tr>
<tr>
<td></td>
<td>Finish allowance</td>
<td>0.050 / 1.250</td>
</tr>
<tr>
<td></td>
<td>Finish bottom allowance</td>
<td>0.050 / 1.250</td>
</tr>
<tr>
<td></td>
<td>Semi-finish allowance</td>
<td>0.020 / 0.500</td>
</tr>
<tr>
<td></td>
<td>Semi-finish bottom allowance</td>
<td>0.020 / 0.500</td>
</tr>
<tr>
<td></td>
<td>Side finish overlap</td>
<td>0.100 / 3.000</td>
</tr>
<tr>
<td></td>
<td>Wind fan radius</td>
<td>0.100 / 3.000</td>
</tr>
<tr>
<td></td>
<td>Deburr radius</td>
<td>0.000 / 0.000</td>
</tr>
<tr>
<td></td>
<td>Min corner radius</td>
<td>0.000 / 0.000</td>
</tr>
<tr>
<td></td>
<td>Helix linear approx. tol.</td>
<td>0.001 / 0.025</td>
</tr>
<tr>
<td></td>
<td>Face depth of cut</td>
<td>0.250 / 5.000</td>
</tr>
<tr>
<td></td>
<td>Face finish allowance</td>
<td>0.020 / 0.500</td>
</tr>
<tr>
<td></td>
<td>Tool diameter selection tolerance</td>
<td>0.002 / 0.050</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Value 1</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Thread milling</td>
<td>Linear ramp dist.</td>
<td>0.100</td>
</tr>
<tr>
<td></td>
<td>Helix linear approx. tol.</td>
<td>0.001</td>
</tr>
<tr>
<td>Drilling</td>
<td>Bore X shift</td>
<td>0.000</td>
</tr>
<tr>
<td></td>
<td>Bore Y shift</td>
<td>-0.010</td>
</tr>
<tr>
<td></td>
<td>Spot drill edge break</td>
<td>0.005</td>
</tr>
<tr>
<td></td>
<td>Turn spot drill edge break</td>
<td>0.005</td>
</tr>
<tr>
<td></td>
<td>Spot drill default size</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Pilot drill diameters</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Turn pilot drill diameters</td>
<td>none</td>
</tr>
<tr>
<td>3D milling</td>
<td>Rough tolerance</td>
<td>0.005</td>
</tr>
<tr>
<td></td>
<td>Finish tolerance</td>
<td>0.001</td>
</tr>
<tr>
<td></td>
<td>Scallop height</td>
<td>0.001</td>
</tr>
<tr>
<td></td>
<td>Check allowance</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Stepover</td>
<td>0.050</td>
</tr>
<tr>
<td></td>
<td>Finish allowance</td>
<td>0.050</td>
</tr>
</tbody>
</table>
## Turning

<table>
<thead>
<tr>
<th>Type</th>
<th>Attribute</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>inch</td>
</tr>
<tr>
<td>Turn</td>
<td>X finish allowance</td>
<td>0.005</td>
</tr>
<tr>
<td></td>
<td>Z finish allowance</td>
<td>0.005</td>
</tr>
<tr>
<td></td>
<td>X semi finish allowance</td>
<td>0.002</td>
</tr>
<tr>
<td></td>
<td>Z semi finish allowance</td>
<td>0.002</td>
</tr>
<tr>
<td></td>
<td>Rough DOC</td>
<td>0.200</td>
</tr>
<tr>
<td></td>
<td>Rough constant DOC</td>
<td>0.200</td>
</tr>
<tr>
<td></td>
<td>Withdraw length</td>
<td>0.025</td>
</tr>
<tr>
<td></td>
<td>Clearance</td>
<td>0.100</td>
</tr>
<tr>
<td></td>
<td>Cutter comp lead distance</td>
<td>0.100</td>
</tr>
<tr>
<td></td>
<td>Cutter comp min. corner radius</td>
<td>0.000</td>
</tr>
<tr>
<td>Turn groove</td>
<td>Rough DOC</td>
<td>0.500</td>
</tr>
<tr>
<td></td>
<td>Chamfer extend distance</td>
<td>0.005</td>
</tr>
<tr>
<td></td>
<td>Rough liftoff distance</td>
<td>0.000</td>
</tr>
<tr>
<td></td>
<td>Finish liftoff distance</td>
<td>0.000</td>
</tr>
<tr>
<td></td>
<td>Peck retract distance</td>
<td>0.050</td>
</tr>
<tr>
<td>Turn cutoff</td>
<td>Peck retract distance</td>
<td>0.050</td>
</tr>
<tr>
<td>Turn thread</td>
<td>Start clearance</td>
<td>0.250</td>
</tr>
<tr>
<td></td>
<td>End clearance</td>
<td>0.100</td>
</tr>
<tr>
<td></td>
<td>Step1</td>
<td>0.000</td>
</tr>
<tr>
<td></td>
<td>Step2</td>
<td>0.000</td>
</tr>
<tr>
<td></td>
<td>Groove additional depth</td>
<td>0.005</td>
</tr>
<tr>
<td>Turn bar feed</td>
<td>Feed rate</td>
<td>50.000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Wire

<table>
<thead>
<tr>
<th>Type</th>
<th>Attribute</th>
<th>Default value</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Wire</td>
<td>Stop length</td>
<td>0.500</td>
<td>15.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Overlap</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contour overlap</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Retract length</td>
<td>0.020</td>
<td>5.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Finish allowance</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Offset total stock</td>
<td>0.150</td>
<td>4.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contour total stock</td>
<td>0.050</td>
<td>1.250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Leave allowance</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cutoff leave allowance</td>
<td>0.010</td>
<td>0.250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lead length</td>
<td>0.100</td>
<td>3.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Side lead length</td>
<td>0.250</td>
<td>5.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inside corner radius</td>
<td>0.050</td>
<td>1.250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Outside corner radius</td>
<td>0.050</td>
<td>1.250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Corner options length</td>
<td>0.250</td>
<td>5.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Corner options width</td>
<td>0.050</td>
<td>0.250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Upper guide</td>
<td>10.000</td>
<td>250.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lower guide</td>
<td>-2.000</td>
<td>-50.000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4th axis linear approx.</td>
<td>0.010</td>
<td>0.250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 axis pocket total stock</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
</tbody>
</table>
Milling default machining attributes

The **Machining Attributes** dialog for **Mill** parts has these tabs:

- **Drilling** (see page 1598, see page 889)
- **Pecking** (see page 1605)
- **Milling** (see page 1607)
- **Stepover** (see page 1618)
- **Lead/Ramp** (see page 1637)
- **Coolant** (see page 1647)
- **Misc.** (see page 1648)
- **Operations** (see page 1657)
- **Thread Mill** (see page 1660)
- **Surface Mill** (see page 1666)
- **Surface Leadin** (see page 1672)
- **Tool selection** (see page 1676)
- **Facing** (see page 1681)
**Drilling tab**

![Drilling tab screenshot](image)

**Spot drill** — Enable this option to add a spot drill operation to the Hole feature.

This operation has some wide-ranging effects, however, especially when used with the **Attempt chamfer w/ spot** and tool optimization. Of those three settings, tool optimization has the highest priority and its decisions override settings with a lower priority.

For example, a spot drill operation could be performed with either a spot drill or a center drill. Spot drills with a tip angle of 90° can also perform a chamfering operation. You specify a specific tool to cut the hole's chamfer and also turn on **Attempt Chamfer /w Spot** and tool optimization. If there is an appropriate spot drill in the tool crib, FeatureCAM optimizes things and use this tool in spite of your lower priority override. Even though you selected a specific tool, your other settings conflicted with and superseded your choice.

This is the advantage of the optimization and simulation functions in FeatureCAM. As you work through the optimization settings, and see where you can optimize automatically and where you cannot, you can find ways to group your parts for faster production, but still use specific tools for specific effects when needed.

*You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 889) tab.*
**Spot drill edge break** — To create an edge break or chamfer using the spot drill tool, enter the radial distance of the edge break/chamfer. The spot drill creates an edge break/chamfer by cutting deeper than it normally would to create the spot drill operation alone. The default value **0.0050"** or **0.1 mm** results in a chamfer **0.0100"** or **0.2 mm** greater than the hole size. The angle of the chamfer depends on the spot drill tool used.

**Attempt chamfer w/ spot** — Enable this option to try to cut the chamfer during spot drilling. If no available tool can spot and chamfer without gouging the hole, a separate chamfer operation is created.

**Spot drill diameter %** — This percentage is used to select a spot drilling tool. A value of **100** specifies that the spot drill should be the same diameter as the hole. A smaller value creates only a starter hole.

**Use L/D compensation** — This reduces speed and feed for holes that have a ratio of hole depth (L) to hole diameter (D) of greater than 2.5. The greater this ratio, the greater the speed/feed reduction.

**Combine similar holes into canned cycle** (see page 1601) — By default, a tool retracts to the **Z rapid plane** between operations. Enable this option and then select whether to **Retract to the Z rapid plane** or the lower **Plunge clearance** plane after drilling each hole. This option also creates more efficient NC code by entering the canned cycle mode only once.

Retract to

\[ \text{Z rapid plane:} \quad \text{Plunge clearance:} \]

**Drill large counterdrill first** — For Counter Drill holes, select this option to do the counterdrill operation before the drill operation.

**Ream before chamfer** — Enable this option to do the Ream operation before the Chamfer operation. This avoids pushing any kind of burr or edge back up onto the chamfer if the chamfer is a sealing surface.

**Machining Type** — Select from:
- **Drill only** — All Hole features are drilled in the traditional way using a drill that is the same size as the hole diameter.

- **Drill/Mill** — This option allows Hole features to be drilled or milled, to minimize the number of tools needed.

Click the **Drill/Mill Options** (see page 1604) button to set drill/mill parameters.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). Set it on the Strategy (see page 889) tab.

**Dwell** — Enter the amount of time, in seconds, for the spot drill to dwell for a feed-dwell-feed cycle.

**Max. tap spindle RPM** — This is the maximum speed (in RPM) for tapping.

**Drill cycle** — This affects how FeatureCAM performs a drill operation. Select one of the following from the menu:

- **Deep Hole** — The tool pecks and retracts to the Plunge clearance and returns to the previous depth. This cycle is posted using the Deep Hole format in XBUILD.

- **Chip Break** — The tool stops feeding only to break the chip. This cycle is posted using the Chip Break format in XBUILD.

**Tap cycle** affects how a tap operation is performed. Select from:

- **Floating** — Floating and tension-compression holders

- **Rigid** — This is most commonly available on current machines

- **Deep Hole** — The tool pecks and retracts to the Plunge clearance and returns to the previous depth.

- **Chip Break** — The tool stops feeding only to break the chip.

All cycles use the same Tap program format, but logical reserved words exist in XBUILD to distinguish the tap type.

**Ream cycle** — This affects how a ream is performed. The choices are FDF (feed-dwell-feed), FF (feed-feed), and FSR (feed-stop spindle-retract).

If you select FF, the cycle is posted using the Bore (F-F) format in XBUILD. FDF uses the Bore (F-D-F) format, and FSR uses the Bore (F-S-R) format.

**Bore cycle** — This affects how a bore is performed. Select one of the following from the menu:

- **FF** — The cycle is posted using the Bore (F-F) (feed-feed) format in XBUILD.
- **FDF** — The cycle is posted using the **Bore (F-D-F)** (feed-dwell-feed) format in XBUILD.
- **FSR** — The cycle is posted using the **Bore (F-S-R)** (feed-stop spindle-retract) format in XBUILD.
- **No Drag** — The cycle is posted using the **Bore (No Drag)** format in XBUILD.

**No drag X shift** and **No drag Y shift** — These attributes affect the amount that the boring tool shifts prior to retracting in No-drag boring.

**Pilot diameter(s)** — This enables and sets a list of drill sizes used to drill pilot holes. Enter a comma-separated list of drill diameters. For example, entering **0.5, 1, 1.5** in inches, causes holes to be pilot drilled with the half inch drill for final hole sizes up to an inch. A hole in excess of 1.5" is pilot-drilled with all three of the specified drills before being drilled to size. No list of drill sizes turns off pilot drilling for the feature, although this attribute can also be set up as a default for all parts.

**Combine similar holes into canned cycle**

The **Combine similar holes into canned cycle** attribute applies to drilling operations.

In previous versions of FeatureCAM this attribute was called **Retract to Plunge Clearance**. The **Retract to Plunge Clearance** attribute still applies to milling operations.

By default, FeatureCAM retracts the tool to the higher **Z rapid plane** between operations. Although this is a safe assumption, it can result in inefficient NC part programs because between each operation the program cancels (**G80**) and then re-establishes (**G81, G83**, and so on) the canned cycle mode. The figure below shows such an inefficient program.
The Combine with similar holes into canned cycle attribute serves two functions. First it creates more efficient NC code by entering canned cycle mode only once. It also causes the tool to retract to the lower Plunge Clearance plane after drilling each hole.

If the Disable Macros is deselected in the Post Options dialog, the hole locations are included in a macro as shown in the Fanuc NC code sample below.
If Disable Macros is selected, the NC code is still efficient, because canned cycle mode is entered only once. The code sample shown below is Fanuc NC code for a hole pattern with Combine with similar holes into canned cycle enabled, but without macros.

```
:10
(9-13-2001)
N25G00G17G40G49G80
N30G30G91Z0
N35T1M6
N40G00G54G90X0.Y0.S3819M03
N45G43H1Z1.0M08
N50Z0.1
N55G83R0.1Z-1.0Q0.25F14.3
N60P1001M98
N65G80
N70G00Z1.0
N75G0G91G28Z0M09
N80G49G90
N85M30
:1001
N90G91
N95X0.5
N100X1.0
N105G90
N110M99
```

1. Tool change location
2. Z rapid plane
3. Plunge clearance
**Drill/mill options (machine level)**

You control machine-level drill/mill in the machine-level **Drill/Mill Options** dialog:

![Drill/Mill Options dialog](image)

Select the strategies that you want to enable. The options are:

- **Drill full diameter**
- **Rough with Drill, Finish with Bore**
- **Rough with Drill, Finish with Ream**
- **Rough with Endmill, Finish with Bore**
- **Rough with Endmill, Finish with Ream**
- **Rough with Endmill, Finish with Endmill**
- **Finish Bottom**
- **Rough with Endmill to full diameter** — this option lets FeatureCAM rough to the final hole diameter without having a finish pass.

- **Use hole milling canned cycle if available ( )** — For machines that support hole/bore milling, such as Heidenhain Cycle 208, Siemens POCKET4, Fagor G88, and Haas G12/13. The hole milling canned cycle is posted using the hole milling format in XBUILD. If you enter a G code, for example **G208**, for the **Hole Milling** cycle in the **NC Codes** dialog in XBUILD, that code displays in the brackets after this attribute name, for example **Use hole milling canned cycle if available (G208)**.

If you select more than one strategy, FeatureCAM works down the strategy list in the dialog until it finds a strategy that can complete the hole.
Use continuous spiral — Select this option to use an NT Continuous Spiral toolpath, which eliminates nearly all stepovers.

Use continuous spiral deselected

Use continuous spiral selected

You can use Helical ramping with Use continuous spiral, for example:

Traditional spiral toolpaths can produce spikes in tool load. Another advantage of NT continuous spiral is that the tool load increases gradually.

Pecking tab

![Pecking tab screenshot]
Pecking applies to Deep Hole, Chip Break, and Tap operations. FeatureCAM supports four styles of pecking. These styles are listed in the post processor. Three different attributes control the pecking and they are used differently depending on the style of pecking. FeatureCAM checks the pecking type in the currently loaded post processor to duplicate canned cycles when simulating toolpaths. Set these attributes separately for **Drilling** and **Tapping** operations:

- **First peck** — This is the depth of the first peck of a drilling/tapping operation specified as a percentage of tool diameter. If the depth of the hole is less than First peck, the hole is drilled in a single peck.

- **Second peck** — This is the depth of the second peck of a drilling/tapping operation specified as a percentage of tool diameter. The post handles the conversion.

**Minimum peck** — This is the minimum step size for a peck used for value reduction pecking methods or factor reduction pecking methods.

The peck style is specified in the CNC file, and determines which of the tool’s pecking depth values are used to calculate the pecking depth values for the operation:

**Fixed Steps**

The NC code specifies one depth (First peck) and all the steps peck at that depth. **Second peck** and **Minimum peck** have no effect in this case.

**Two Steps**

The NC code specifies two depths. The first step pecks at the first depth (First peck) and all the subsequent steps peck at the second depth (Second peck). **Minimum peck** has no effect in this case.

**Value Reduction**

The NC code specifies the first depth (First peck), a reducing value (First peck - Second peck), and a minimum depth (Minimum peck). The first step pecks at the first depth. Each subsequent step is reduced by the reducing value until the minimum depth is reached.

**Factor Reduction**

The NC code specifies the first depth (First peck), a reducing factor (Second peck/First peck), and a minimum depth (Minimum peck). The first step pecks at the first depth. Each subsequent step is reduced by the reducing factor until the minimum depth is reached.
Milling tab

Climb mill — Enable this option to have the tool on the left side of the machined edge (in the direction of tool travel). Disable it for conventional milling, with the tool on the right side of the machined edge.

Bi-directional rough — Enable this option to mill in both directions. If disabled, conventional roughing happens and the cutting path moves in one direction with rapid, above-stock return movements to set up for the next pass. Climb mill controls the cutting direction.

Use finish tool — If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.
If disabled, the same tool is used for both the Rough and Finish passes. Enable Use finish tool to create a new tool for finishing. This finishing tool is identical to the tool that was selected for roughing. The name of the new tool is appended with -finish. For example if the roughing tool is named endmill1.0, the finishing tool is called endmill1.0-finish. This finishing tool is not permanently assigned to a tool crib, it is a temporary tool for use in the current document only.

If you want to use different types of tools for roughing and finishing, like different length tools or tools with a different number of flutes, disable Use finish tool and explicitly change the tool to use for finishing.

Finish cutter comp (see page 1614) — Enable this option to use cutter compensation for the Finish and Semi-finish passes of a milled feature.

Rough cutter comp — Select this option to enable cutter compensation for the rough pass of all milled features in the current document by default. See Finish cutter comp for more information.

Chamfer cutter comp — Select this option to enable cutter compensation for chamfer operations of all milled features in the current document by default.

Partline program — This is a particular kind of cutter compensation for milled features.

Part line program is a particular kind of cutter compensation for milled features. If enabled, the actual drawing dimensions of the feature are output as the toolpath instead of the center line of the tool. The tool selected to cut the feature is still important even when using part line programming. If the same tool is used for roughing, be sure that the actual tool diameter does not deviate too far from the diameter of the tool used by FeatureCAM to ensure proper area coverage for the roughing passes. Also ensure that the diameter of the selected finishing tool is small enough to cut your entire feature. If you have selected a tool too large to fit into a tight corner, you cannot correct the toolpath with just cutter compensation. FeatureCAM automatically calculates the entrance point of your finish pass and adds a linear move and a ramping move (based on the Ramp diameter attribute) to your finish pass to accommodate cutter compensation. If you receive a warning in the operations list such as "Can't find ramp in/out arc" or "Can't extend end of open profile" then correct the problem by decreasing the Ramp diameter attribute or changing the Pre-drill point.

Minimize tool retract — Enable this option (see page 966) to reduce the amount of retracting that the tool does while milling a feature. Instead of retracting, the tool continues feeding to its next location.
This example shows normal retracting.

This is the same example with **Minimize tool retract** enabled.

Setting this attribute can result in more slot cutting. Study the toolpaths carefully before cutting.

This feature is helpful for 2-axis mills.

If **Minimize tool retract** is selected, the setting for the default attribute, **Min. rapid distance**, is ignored. The tool does not retract unless to prevent gouging.

This attribute only affects how the tool retracts within a single operation. It does not control how operations are ordered. For this functionality, see **Min. rapid distance**.

**NT toolpaths**

Using the **Minimize tool retract** options with the NT toolpaths gives better results than with the traditional toolpaths.

**Pocket feature**

For a Pocket feature, the toolpath slot cuts following the offsets instead of just a straight line. There are fewer plunges than with traditional toolpaths.
Traditional toolpath example:

NT toolpath example:

**Boss feature**

For a Boss feature, the toolpath has a lot fewer retracts and plunges at the edge of the Stock.
Traditional toolpath example:

![Traditional toolpath example image]

NT toolpath example:

![NT toolpath example image]

**Individual rough levels** (see page 963) — The rough pass is often performed at multiple Z levels (see page 963) due to the depth of the feature. Enable this option to list them all so that you can edit the attributes of each level separately.
**Depth first** — Enable this option to cut each region of a feature completely before moving on to another region. The toolpaths descend in Z.

If this option is deselected then all regions of a feature are cut at one Z level before descending to a deeper Z-level.

> *This attribute has no effect if the toolpaths for your feature do not rapid between regions of the feature.*

The images below show how regions of a feature are completely cut before moving on to another region.

![Toolpaths](image)

If you are using **Multiple roughing tools** (see page 1676) or **Multiple finishing tools** (see page 994), to efficiently rough out tight corners, **Depth first** is also useful. The images below show a tool finishing tight corners in a depth first manner.

![Toolpaths](image)

> You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 936) tab.

**Reorder**

The **Reorder** attribute tells FeatureCAM to re-sequence the toolpaths to minimize retractions while trying to avoid full width cuts. Use **Reorder** when you have a part where several separate regions are cut. If you want the toolpaths to move directly across a surface without worrying about retractions, deselect **Reorder**.
For Z-level operations (rough or finish), the Reorder attribute enables zone machining, where the toolpaths descend in the Z (or -Z) direction if that is more efficient than cutting the entire part in complete Z levels. The phone handset example below shows that the toolpaths cut the top of the part in complete Z levels and then cut one side and the other.

5-axis position menu (5AP (see page 10)) — There is often an alternate orientation (see page 261) option for accessing a face. Select from:

- **Standard** — The default orientation.
- **Alternate** — The alternative orientation to the default.
- **Use Post preference** — Uses the position (Positive or Negative) set in XBUILD in the Five Axis dialog for the Preferred orientation of the primary rotary axis option.

Clamp avoidance — Click this button to display the Clamp Avoidance dialog (see page 1615) where you can specify the options for avoiding clamp solids in 3 axis and NT toolpaths.

Non-Cutting Moves — Click this button to display the Vortex Non-Cutting Moves dialog (see page 1069) where you can specify whether to retract and increase the feed rate on non-cutting moves for vortex toolpaths.

Use new ID/OD groove toolpath — Select this option to use the new Side Groove toolpath style (see page 69), or deselect it to enable backwards compatibility.

When this option is selected, these changes are made to side groove toolpaths:

- The plunge and retract moves are checked for gouges.
  
  You can disable the gouge checking on plunge and retract moves by deselecting the **Plunge gouge check** option on the Strategy tab of the Feature Properties dialog.

- You can use wind fan finishing for the finish operation.
To specify the wind fan settings, click **Wind Fan** on the **Strategy** tab of the **Feature Properties** dialog, and use the **Wind Fan Finish Options** dialog (see page 1643).

- You can use arc lead-in moves for the finish operations. Otherwise you can only use a linear lead-in move.
  
  To use an arc lead-in move, select **Arc Lead** on the **Stepovers** tab of the **Feature Properties** dialog.

- You can set a start point for the finish pass.
  
  To set a start point, use the **Start point** attribute on the **Plunge** tab of the **Feature Properties** dialog.

**Trochoidal slotting**

**Trochoidal cut** — Enable this option to use a trochoidal cut on a Simple Groove. Select the direction of the trochoids for a trochoidal cut, from **CW** (clockwise) or **CCW** (counter-clockwise).

Instead of a simple slotting cut, the tool uses a series of circles, for example:

![Trochoidal cut diagram](image)

A trochoidal toolpath reduces the load on the tool.

**Max tool diameter** % — This is the percentage of the groove width that is used to determine the diameter of the tool that will be selected.

**Max step distance** % — This is specified as a percentage of the tool diameter and represents the maximum distance between neighboring circles of the toolpath.

**Cutter comp**

Cutter compensation offsets the lines and arcs of a toolpath to account for the difference between a tool's actual diameter and the diameter specified. For example, if the specified diameter is **0.500**, the actual tool diameter, due to wear, could be 0.496. Cutter compensation allows this difference to be accounted for at the control so that a single NC program can be used as long as the tool is close enough in diameter to the ideal size entered into FeatureCAM.
The direction of the compensation depends on the value of **Climb mill**. If **Climb mill** is on, the cutter compensation direction is left, and if it is off, the cutter compensation is right.

If you use cutter compensation you must select **Enable Cut Comp** in **Post Options** (see page 1857). Turning it on does not turn on cutter compensation for every feature, however, as cutter compensation NC code is output only for those features with the **Cutter Comp** attribute selected. If the **Cutter Comp** option is deselected in the **Post Options** dialog, then cutter compensation is disabled for the entire part regardless of the value of the **Cutter Comp** attributes on each feature.

If you select **Part line program**, you get a special kind of cutter compensation known as part line programming.

If you have specified both **Multiple roughing tools** and **Part line prog** for the roughing pass, then in most cases bad NC code is generated because the first roughing tool is likely to be bigger than the arcs in the part. We would consider this to be a fact of life and you need to turn off one or the other in order to get workable NC code.

If cutter comp is not chosen for the roughing, then no cutter comp is output at all.

Cutter compensation for the roughing pass results in only the passes closest to the wall being compensated. The interior passes are not compensated because there is no need.

**Clamp Avoidance dialog**

To open the **Clamp Avoidance** dialog, click the **Clamp avoidance** button on the **Milling** (see page 1607) tab of the **Machining Attributes** dialog.

**Automatic clamp avoidance** — Select this option to automatically avoid solids that are marked as a clamp. To mark a solid as a clamp, right-click its name in the **Part View** and select **Use Solids as Clamp** in the context menu.
This option applies to 2.5D NT-style toolpaths and 3D toolpaths. You must use NT-style toolpaths for both the Rough and Finish operations to use this option for a 2.5D part.

Allowance — Enter the minimum distance that you want to leave around clamps.

Axial allowance — To set separate axial and radial allowances, select this option and enter the minimum axial (XY) distance that you want to leave around clamps. If you enable Axial allowance, the Allowance value is applied to the radial (Z) distance only.

For 2D features, the Axial allowance is ignored, and the Allowance is used as the radial and axial allowance.

Example:

This example bracket part is held in place by four clamps:

With Automatic clamp avoidance disabled, there is a collision with the clamps in the bright pink areas:
Here is the back clamp in more detail, the front of the clamp has been machined away:

With **Automatic clamp avoidance** enabled, the clamps are avoided:

You can see the upstands of material, which have been left around the clamps:
**Stepover tab**

![Stepover tab screenshot](image-url)

**Rough pass** — Select this option to have a rough pass by default for all milling features.

**Depth %** — Enter the percentage of the tool Diameter to use for the Rough depth of cut. You can override the depth of cut (see page 1023) value in several places.

**Equal depth of cut** — Enable this option to make each Z step equal depth.

If **Equal depth of cut** is selected, FeatureCAM calculates the depth of cut like this:

1. Divides the feature depth, for example 10 mm, by the depth of cut (see page 1023) you set to get the number of steps.

2. Divides the depth by the number of steps to get the actual depth of cut (the depth of cut for each step is equal).

For example:

If the feature depth is 10 mm and you set a depth of cut of 3 mm, the number of steps is calculated as \((10/3) + 1 = 4\) steps. The actual depth of cut is \(10 / 4 = 2.5\) mm. The steps are cut at 2.5 mm, 5 mm, 7.5 mm, and 10 mm.

*If the second to last pass is within 10% of the depth of cut, it is ignored.*

For a feature depth of 10 mm with a depth of cut of 3.3 mm, the steps are cut at 3.3 mm, 6.6 mm, and 10.0 mm.
For a feature depth of 10 mm with a depth of cut of 3.2 mm, the steps are cut at 3.2 mm, 6.4 mm, 9.6 mm, and 10 mm.

To set an exact depth of cut, deselect Equal depth of cut.

Using the same example, with Equal depth of cut deselected:

If the feature depth is 10mm and you set a depth of cut (see page 1023) of 3mm, the number of steps is calculated as \((10/3) + 1 = 4\) steps. FeatureCAM uses the actual depth of cut you set (3 mm) for each pass, then cuts any remainder depth. The steps are cut at 3 mm, 6 mm, 9 mm, and 10 mm.

These features support exact depth of cut:

- Profile boss
- Profile pocket
- Profile side
- Profile groove (Face groove only)
- Slot
- Rectangular pocket
- Step bore
- Counter bore hole
- Plain hole with drill/mill roughing
- Tapped hole with drill/mill roughing

Stepover Options button — Click this button to open the Rough Stepover Options (see page 1620) dialog.

Semi-finish pass — Select this option to have a semi-finish pass by default.

Allowance — This is a facing parameter for the amount of material to leave after the roughing pass.

Bottom allowance — Enter the amount of material to leave on the floor of a milled feature. It applies only if Finish bottom is selected. The attribute, Finish allowance, controls the allowance on the walls of a feature.

Zig-zag angle — this controls the angle (measured from the X axis) of the direction of the facing passes. A setting of 0 cuts parallel to the X axis and a value of 90 cuts parallel to the Y axis.

Finish pass — Select this option to have a finish pass by default.

Allowance — Facing parameter for the amount of material to leave after the roughing pass.

No. of Passes — The number of duplicate finish passes to take. If you want to compensate for tool deflection, set No of Passes to more than 1.

Overlap — This applies to features defined by closed profiles and is the distance that the tool overlaps its starting point on the finish pass. The toolpath runs counter-clockwise.
Bottom Finishing — Click this button to open the Bottom Finish Options (see page 1628) dialog.

Rough Stepover Options dialog

Click the Stepover Options button on the Stepover tab to open the Rough Stepover Options dialog:

For Pocket, Rectangular Pocket, and Boss and features, FeatureCAM provides several different milling methods for roughing:

Stepover — Select the Stepover type in the list.

Traditional toolpaths

- Spiral — This toolpath type is based on a series of offset curves.

For a Boss feature, the curves of the Boss are offset and then clipped against the shape of the stock. When using a square piece of stock the toolpaths tend to cut the four corners first, and then work their way inward. You can alter the extent of the toolpaths by using a stock curve of total stock.
For a Pocket feature, the boundary of the Pocket is offset and the toolpaths are cut starting from the center of the pocket. The shape of the stock does not affect the toolpaths.

- **Zigzag** — This toolpath type uses straight toolpaths that are parallel to each other.

For a Boss feature, the toolpaths are laid in parallel lines across the stock and clipped against the boundaries of the Boss.

The starting point is one of the four corners of the stock. You can change the angle of the toolpaths, but the neighboring toolpaths are always parallel.
For a Pocket feature, the parallel toolpaths are laid inside the Pocket boundary.

After the parallel paths, a clean-up pass is then performed around the boundaries of Bosses, Pockets, and Pocket islands.

The Zigzag roughing pass has two phases, the parallel roughing phase and the boundary clean-up phase. The clean-up phase, marked ①, cleans up the boundaries of the feature to ensure a uniform finish allowance:

The tree view for the feature only shows a single feature, so the clean-up phase uses the same feed and speed values as the roughing pass. The number of clean-up passes is determined by the Cleanup passes (see page 1161) attribute. If Cleanup passes is set to 0, the clean-up pass is not performed. If set to 1, a single pass is performed along the boundaries of the roughing region:
The roughing region is determined by offsetting the boundaries of the feature by the Finish allowance.

If set to a number larger than 1, multiple clean-up passes are performed. The default spacing of these passes is controlled by the Cleanup stepover (see page 1161) attribute. To more finely control the spacing of multiple clean-up passes, set the Cleanup stepover attribute.

The ramping onto the clean-up pass is controlled by the Ramp diameter (see page 985) attribute.

The direction of the Zigzag path is controlled by the relationship between the Zigzag angle (see page 994) and the Climb mill (see page 936) attributes.

The table shows the relationship between the zigzag angle and the Climb mill setting. The image in the Path column indicates the direction, the start point, and the sequencing of the toolpaths.

For example, indicates toolpaths that are parallel to the X axis. The start point is the lower left and the paths are sequenced from the bottom to the top. In the images, the X axis of the Setup is the horizontal axis, and the Y-axis is the vertical axis.

<table>
<thead>
<tr>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No</td>
<td>↑</td>
<td>180</td>
<td>Yes</td>
<td>↓</td>
</tr>
<tr>
<td>0</td>
<td>Yes</td>
<td>↑</td>
<td>180</td>
<td>No</td>
<td>↓</td>
</tr>
<tr>
<td>90</td>
<td>Yes</td>
<td>←</td>
<td>-90</td>
<td>No</td>
<td>→</td>
</tr>
</tbody>
</table>
If the **Bi-directional cut** (see page 936) or the **Reorder** (see page 1607, see page 1660) attribute is selected, the toolpath is reordered so that it completes one region before moving on to the next.

For example, with this Boss feature the toolpaths finish the region on the right of the Boss before moving on to the region on the left side.

If **Bi-directional cut** and **Reorder** are deselected, the toolpaths move across the part without any reordering.

When roughing a Boss with the Zigzag method, the amount that the tool overlaps the stock boundary is controlled by the **Finish allowance** (see page 994).

The Zigzag technique applies to a finishing pass only if the bottom of the feature is being finished. In this case, it behaves just like a single roughing pass.

**NT (New Technology) toolpaths**

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional **Spiral** toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional **Zigzag** toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional **Spiral** toolpath, but eliminates nearly all stepovers.
- **Vortex** (see page 725) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.

Set the default type in **Machining Attributes** on the **Stepover** tab using the **Stepover Options** button.

Click the **Stepover Options** button to open the **Rough Stepover Options** dialog:

The **NT** toolpaths are available in the **Stepover** menu along with the traditional **Spiral** and **Zigzag** toolpaths.
At feature level, you can override the default **Stepover type** in the menu on the **Strategy** tab of the feature's **Properties** dialog.
You can override this at operation level on the Stepovers tab. If you are using Individual rough levels, you can set the Cut type for each individual rough pass.

Regardless of the roughing method selected, the feature is roughed to within the Finish allowance (see page 1161) of the boundary.

There are some key differences between Traditional and NT toolpaths (see page 727).

**Spiral %** — Enter the percentage of the tool diameter to use for the radial depth of cut for machining the bottom of a milled feature when using the spiral method.

**Zigzag %** — This is the percentage of tool diameter to use for radial depth of cut for roughing the bottom of a milled feature when using the zigzag method.
**Bottom Finish Options dialog**

Open this dialog by clicking the **Bottom Finishing** button on the **Stepover** (see page 1618) tab of Milling **Machining Attributes** (see page 1597).

**Finish bottom** —

**Wall pass** — Enable this option to finish the bottom of the feature up to the **Finish allowance** on the wall, then finish the walls in a separate pass.

*Wall pass applies only to the finishing passes of milling features where the bottom is finished.*

1. **Finish allowance**
2. **Wall pass**
3. **Floor pass**

If **Wall pass** is disabled, then the floor is finished all the way out to the wall in a single pass. The wall is not finished separately.
For OD/ID grooves if this attribute is selected, then the bottom is finished separately from the walls of the groove.

1. **Finish allowance**
2. **Bottom**
3. **Wall**
4. **Wall finish allowance**

**Stepover** — Select the stepover type for finishing the bottom of a milled feature.

**Traditional toolpaths**

- **Spiral** — This toolpath type is based on a series of offset curves. For a Boss feature, the curves of the Boss are offset and then clipped against the shape of the stock. When using a square piece of stock the toolpaths tend to cut the four corners first, and then work their way inward. You can alter the extent of the toolpaths by using a stock curve of total stock.
For a Pocket feature, the boundary of the Pocket is offset and the toolpaths are cut starting from the center of the pocket. The shape of the stock does not affect the toolpaths.

- **Zigzag** — This toolpath type uses straight toolpaths that are parallel to each other.

For a Boss feature, the toolpaths are laid in parallel lines across the stock and clipped against the boundaries of the Boss.

The starting point is one of the four corners of the stock. You can change the angle of the toolpaths, but the neighboring toolpaths are always parallel.
For a Pocket feature, the parallel toolpaths are laid inside the Pocket boundary.

![Diagram of Pocket feature with parallel toolpaths and clean-up pass](image)

After the parallel paths, a clean-up pass is then performed around the boundaries of Bosses, Pockets, and Pocket islands.

The Zigzag roughing pass has two phases, the parallel roughing phase and the boundary clean-up phase. The clean-up phase, marked ①, cleans up the boundaries of the feature to ensure a uniform finish allowance:

![Diagram showing clean-up pass around Pocket feature](image)

The tree view for the feature only shows a single feature, so the clean-up phase uses the same feed and speed values as the roughing pass. The number of clean-up passes is determined by the **Cleanup passes** (see page 1161) attribute. If **Cleanup passes** is set to 0, the clean-up pass is not performed. If set to 1, a single pass is performed along the boundaries of the roughing region:
The roughing region is determined by offsetting the boundaries of the feature by the Finish allowance.

If set to a number larger than 1, multiple clean-up passes are performed. The default spacing of these passes is controlled by the Cleanup stepover (see page 1161) attribute. To more finely control the spacing of multiple clean-up passes, set the Cleanup stepover attribute.

The ramping onto the clean-up pass is controlled by the Ramp diameter (see page 985) attribute.

The direction of the Zigzag path is controlled by the relationship between the Zigzag angle (see page 994) and the Climb mill (see page 936) attributes.

The table shows the relationship between the zigzag angle and the Climb mill setting. The image in the Path column indicates the direction, the start point, and the sequencing of the toolpaths.

For example, indicates toolpaths that are parallel to the X axis. The start point is the lower left and the paths are sequenced from the bottom to the top. In the images, the X axis of the Setup is the horizontal axis, and the Y-axis is the vertical axis.

<table>
<thead>
<tr>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
<th>Zigzag Angle</th>
<th>Climb Mill</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No</td>
<td>↑</td>
<td>180</td>
<td>Yes</td>
<td>↓</td>
</tr>
<tr>
<td>0</td>
<td>Yes</td>
<td>←</td>
<td>180</td>
<td>No</td>
<td>→</td>
</tr>
<tr>
<td>90</td>
<td>Yes</td>
<td>←</td>
<td>-90</td>
<td>No</td>
<td>→</td>
</tr>
</tbody>
</table>
If the **Bi-directional cut** (see page 936) or the **Reorder** (see page 1607, see page 1660) attribute is selected, the toolpath is reordered so that it completes one region before moving on to the next.

For example, with this Boss feature the toolpaths finish the region on the right of the Boss before moving on to the region on the left side.

If **Bi-directional cut** and **Reorder** are deselected, the toolpaths move across the part without any reordering.

When roughing a Boss with the Zigzag method, the amount that the tool overlaps the stock boundary is controlled by the **Finish allowance** (see page 994).

The Zigzag technique applies to a finishing pass only if the bottom of the feature is being finished. In this case, it behaves just like a single roughing pass.

**NT (New Technology) toolpaths**

- **NT Spiral** (see page 723) — This toolpath is similar to the traditional **Spiral** toolpath, but can use stepovers larger than 50%.

- **NT Zigzag** — This toolpath is similar to the traditional **Zigzag** toolpath, but uses an angle that is calculated automatically, to cut the longest toolpaths.

- **NT Continuous Spiral** — This toolpath is similar to the traditional **Spiral** toolpath, but eliminates nearly all stepovers.
- **Vortex** (see page 725) (REC/3D MX (see page 10)) — An offset toolpath, which is machined at the specified cutting feed rate almost all of the time. The optimum tool engagement angle is never exceeded, by replacing difficult toolpath segments with trochoids. This works well for solid carbide tools.

Set the default type in Machining Attributes on the Stepover tab using the Stepover Options button.

Click the Stepover Options button to open the Rough Stepover Options dialog:

The NT toolpaths are available in the Stepover menu along with the traditional Spiral and Zigzag toolpaths.
At feature level, you can override the default *Stepover type* in the menu on the *Strategy* tab of the feature's *Properties* dialog.
You can override this at operation level on the **Stepovers** tab. If you are using **Individual rough levels**, you can set the **Cut type** for each individual rough pass.

Regardless of the roughing method selected, the feature is roughed to within the **Finish allowance** (see page 1161) of the boundary.

There are some key differences between **Traditional** and **NT toolpaths** (see page 727).

**Spiral %** — This is the percentage of tool diameter to use for radial depth of cut for finishing the bottom of a milled feature when using the spiral method.

**Zigzag %** — This is the percentage of tool diameter to use for radial depth of cut for finishing the bottom of a milled feature when using the zigzag method.
**Lead/Ramp tab**

**Horizontal lead/ramp**

**Extension distance**

Enter a distance if you want to move the tool off the part by that distance at the end of each pass.

In this Side feature example, we used an extension distance of 1 inch:
Compare it to the same example with no extension distance added:

**Lead distance**

**Lead distance in/out** is the linear distance that a tool path extends beyond the ends of an open toolpath or toolpaths that are clipped against the stock profile. This parameter is specified as a percentage of the tool's diameter. If **Lead Distance** is set to 0.0, the toolpath starts or stops exactly at the ends of the profile.

The **Lead-in angle** applies only over the **Lead-in distance**, so if the **Lead-in distance** is 0, the **Lead-in angle** has no effect.

The **Lead-out angle** applies only over the **Lead-out distance**, so if the **Lead-out distance** is 0, the **Lead-out angle** has no effect. The **Lead-out angle** is applied to the end of the finish pass for an open toolpath. It also applies to the last toolpath of a roughing pass if the **Finish allowance** is set to 0.

**All stepover**

The **All Stepover** attribute adds a lead-in and lead-out to each stepover move for an open feature.
This example shows the behavior with All Stepover deselected.

And with All Stepover selected:

**Ramp type** — Select the stepover style from the list.

**Direct**

The Direct stepover connection type creates a straight linear transition that is perpendicular to the toolpath.
**Arc**

The Arc stepover connection type creates an arc transition. Set the **Diameter** parameter to specify the radius of the arc as a percentage of the tool diameter. This example has the **Ramp diameter** set to 55%:

![Arc example](image)

This example has the **Ramp diameter** set to 600%:

![Arc example](image)

**Line**

The Line stepover connection type creates a linear stepover at an angle. The length of the line is determined by multiplying the diameter of the tool by the **Ramp diameter** parameter.

![Line example](image)
**S-shape**

The **S-shape** stepover connection type creates a stepover move that consists of two arcs. As a result this transition makes a smooth exit from the existing contour to the new contour. The diameter of the arcs is determined by the **Ramp diameter** parameter.

![Diagram of S-shape stepover]

**Ramp diameter** — See **Ramp type**.

**Minimum ramp distance** — This attribute applies to the Finish operation. Enter the minimum horizontal distance for ramping. If the computed horizontal ramp distance is less than this, the tool plunges instead of ramping. Enter the value as a percentage of the tool’s diameter.

**Wind Fan** — Click this button to open the **Wind Fan Finish Options** (see page 1643) dialog.

**Vertical ramp**

**Minimum Z ramp distance** — This is the minimum vertical ramp distance allowed. If **Minimum Z ramp distance** is greater than the calculated ramp distance or **Max ramp distance**, the tool plunges. Enter the value as a percentage of the tool's diameter.

**Max. ramp angle** — This controls the angle of the ramp.

**Max. finish ramp angle** — This is the same as **Max. ramp angle**, but for the finish pass.

**Ramp from top**

Disable this option to avoid ramping to depth on the Finish and Semi-finish pass of a 2.5D feature. This saves machining time.

This example shows the Finish operation for a Side feature.
You must deselect the **NT toolpaths** option to access this option.

**Helical ramping** — Enable this option to use helical ramping. Disable it to use zigzag ramping.

**Helical ramping is not available for zigzag (see page 716) milling.**

**Helical Options** — Click this button to open the **Helical Ramp Options** (see page 1646) dialog.

**Arc lead**

**Arc Lead**

**Arc Lead** changes the lead-in or lead-out move to be an arc. The endpoint of the arc is determined by the **Lead distance** and either the **Lead-in angle** or **Lead-out angle**.
Open the **Wind Fan Finish Options** dialog by clicking the **Wind Fan** button on the **Lead/Ramp** (see page 1637) tab of the Milling **Machining Attributes** (see page 1597) dialog, or on the **Strategy** (see page 936) tab in the Feature Properties dialog.

**Wind fan finish** — Select this option to have a single point that is used as both the start and end point of the Finish path. This is useful for machines which require large lead moves to enable cutter compensation.

**Wind fan radius** — Enter the radius to use for the wind fan shape. Increasing the **Wind fan radius** moves the toolpath's start point further from the feature boundary.
Wind fan angle — Enter the angle to use for the wind fan shape. The wind fan angle is a combination of the lead-in and lead-out arc angles.

By changing the Start point (see page 1028), you can move the starting and ending points of the toolpath. FeatureCAM uses the nearest point to your Start point that is consistent with the angle and radius you specify for the wind fan.

Wind fan example

This example shows you how to create a wind fan finish toolpath, and change the start and end points.

To use wind fan finishing to cut the Boss feature:

1. Create the Boss feature.
2. Enable wind fan finishing:
   a. In the Boss Properties dialog, on the Strategy tab, click Wind Fan.
      The Wind Fan Finish Options dialog is displayed.
   b. Select Wind fan finish to make the finish path start and end at the same point.
   c. Specify the Wind fan radius and Wind fan angle, then click OK to close the dialog.
   d. Click OK to close the Boss Properties dialog.
3. Run a 2D simulation.

To machine the Boss finish pass, the tool:
a starts in the top-right corner of the part and cuts the feature.

b returns to the start point.

The part is complete, but you can edit the toolpath. For example, you may want the tool to start cutting on a straight edge, rather than on the corner.

To change the starting and finishing point of the toolpath:

1. In the Geometry toolbar, click Point, and create a point near one of the edges of the feature.

2. In the Boss Properties dialog, on the Plunge tab, specify the Start point as the position of the point you created.
Run a 2D simulation:

The point's location along the curve is used to place the start point, but the point's distance from the feature boundary is ignored.

**Helical Ramp Options dialog**

Select the direction for helical ramping from **CW** (clockwise) or **CCW** (counter-clockwise).

**Linear approximation** — Select this option to approximate arc moves with linear moves.

**Linear approximation tolerance** — Enter a tolerance to control the accuracy of **Linear approximation** relative to the theoretical helix. The lower the value, the more accurate the approximation.

**Ramp diameter** — Enter the diameter of the helix to use for helical ramping.
**Coolant tab**

Use the **Coolant** tab of the **Machining Attributes** dialog to specify the default coolants to use for an operation.

![Coolant tab dialog](image)

Select the coolant types you want to use. The available coolant types are specified in the CNC file using the **Coolant** dialog in XBUILD.

You can override this option for a tool using the **Coolant tab** of the **Tool Properties** dialog, or for an operation using the **Coolant** tab of the **Feature Properties** dialog.
**Misc. tab**

**Z rapid plane** — Enter the minimum safe distance in Z above your part.

Before performing a rapid move away from a feature, the tool retracts to the **Z rapid plane** setting for that feature. The rapid move to the next feature changes in Z height, that is, changes Z coordinates, if the next feature has a different **Z rapid plane** setting. So that when it arrives at the next feature it is at the **Z rapid plane** for that next feature.

This value is relative to the top of your stock in the current user coordinate system. Compare with **Plunge clearance**.

**Plunge clearance** — Enter the distance above the operation at which the tool feeds.

This is marked as *L1* in the diagram.
For deep hole drilling, the drill retracts to this distance between pecks. For milling features, the default is to use the same value for roughing and finishing. As a result, the tool feeds from the top of a feature to the floor before cutting. To make the tool feed down into the feature, set the Plunge clearance for an operation to a negative value, but ensure the value is above the floor of the feature.

To rapid to depth, you can use a negative Plunge clearance, or select Relative plunge.

Z ramp clearance — Enter the distance above the operation at which ramping starts. Z ramp clearance is bound by Plunge clearance.

This is marked as L2 in the diagram.

Spline tolerance — This approximates the profile with arcs and lines if a profile is defined as a spline. The smaller the value of the parameter, the smoother the profile. This machining attribute is used in Feature Recognition to determine whether a surface is a Hole.

Posting tolerance — Enter the tolerance with which the toolpaths are created. Reduce the Posting tolerance value for small parts to create more precise toolpaths.

You must also adjust your post processor to output more digits. For example, if you adjust the posting tolerance from 0.001 to 0.0001, then you must adjust the digit format in the post processor so that the extra decimal place is used in the NC code. Reducing the posting tolerance creates additional lines of NC code, so you should only do this for high-precision NC machines that can use the high-precision coordinates, when required for an application.

Z index clearance — This is the clearance distance above the stock bounding cylinder.

This can result in a Z value for indexing that is outside the valid range for the machine. It can also result in less-efficient retract moves if the part is an irregular shape. You can set absolute X, Y, and Z coordinates to use for the index retract move at feature-level (see page 900) or Setup-level.

Wrap tolerance
Arcs that are wrapped must be converted to small 3D line segments. The **Wrap tolerance** is used to determine the acceptable distance between the line segments and the initial arc. The figure on the left shows a lower tolerance for a wrapped circular groove. The right-hand figure shows a large tolerance. In this case the circle is approximated by a square.

The **Wrap tolerance** is also used to calculate toolpaths which are on a cylinder, given a linear toolpath in unwrapped space. That is, if the toolpath without wrapping is a straight line, then the wrapped toolpath is an arc around the index axis. The **Wrap tolerance** controls the accuracy of this arc.

This attribute is also used to control the polar interpolation on face cuts for turn/milling. If FeatureCAM is performing the polar interpolation, any linear move or off center arc move on the face of the part must be interpolated by linear moves and rotations about the C axis. **Wrap tolerance** is used to control the fineness of this linear interpolation. The figure on the left shows a straight face cut with loose wrap tolerance. The right-hand figure shows the same cut with a tighter tolerance.
When circular interpolation is turned off in post, then **Wrap tolerance** is used to control fineness of toolpath.

**Chamfer depth**

For milled chamfers, **Chamfer depth** controls the depth of the tool and therefore the contact point. The default **Chamfer depth** for a chamfer is 0.1 inches or 3 mm. This means that the tool extends 0.1 inches or 3 mm below the bottom of the chamfer. A setting of 0.0 places the bottom of the tool at the bottom of the chamfer. A larger value moves the contact point down the tool.

![Chamfer depth diagram]

1. **Through depth**

   You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Milling** (see page 994) tab.

**Deburr radius** — Enter a radius to automatically round sharp outside corners of the feature by the specified radius. The feature shape does not change, but the toolpaths are modified to reflect the rounding.

   To automatically round inside corners, use **Min. corner radius**.

   Be wary of setting a default **Deburr radius** value, because small part details (less than 2* **Deburr radius**) can be mistakenly eliminated. You can set a **Deburr radius** at feature-level in the **Feature Properties** dialog on the **Misc.** (see page 973) tab.

**Min. corner radius** — Enter a radius to automatically round the inside corners of a feature by the specified radius. The feature shape does not change, but the toolpaths are modified to reflect the rounding.

   To automatically round outside corners, use **Deburr radius**.

**Min. rapid distance %** — Enter the minimum distance, as a percentage of the tool diameter, that the tool can use a rapid move for. Moves smaller than this distance use a feed move.

**Minimum rapid distance** applies to 2.5D milling. Specify the value as a percentage of tool diameter.
This example shows a feature cut with a value of 400%:

As the tool moves inward, there are few rapid moves. Instead, the tool is fed between passes.

This is the same example with Min rapid distance set to 10% and the tool retracts and rapids between passes.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). Set it on the Milling (see page 994) tab.

Back clearance — Used when machining a backbore Hole, Back clearance is the distance the backbore tool is from the bottom of the Hole when cutting the bore section.
**Use edge-based stock curve finder** — In certain cases, the Parasolid kernel does not compute a Stock curve correctly. If you have problems trying to compute a Stock curve from a Parasolid file, try selecting this option. This option is deselected by default because it is slower.

**Speed %** — This is a scaling factor for the spindle speeds generated by the system. A value of less than 100 reduces the calculated speed rates. A value of more than 100 increases the rates.

**Feed %** — This is a scaling factor for the feeds generated by the system. A value of less than 100 reduces the calculated feed rates. A value of more than 100 increases the rates.

**Plunge feed %** — The percentage of the Feed % attribute to use during the initial plunge into the material. For example, if the Feed % attribute is 2000 MMPM and you set the Plunge feed % to 50, the resulting feed rate for the initial plunge is 1000 MMPM. See also First plunge feed %.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). Set it on the Milling (see page 994) tab.

**First plunge feed %** — You can specify a slower feed rate for the first plunge move (the initial approach to the Stock) than for subsequent Z plunge moves to depth. This is a percentage of the Plunge feed %.

For example, if the Feed % attribute is 2000 MMPM and you set the Plunge feed % to 50, and the First plunge feed % to 20, the resulting feed rate for the first plunge move is 200 MMPM. Setting the First plunge feed % at a slower feed rate can protect your tool from a hardened crust on the surface of the material.
You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). Set it on the **Milling** (see page 994) tab.

**Feed unit** — This changes the default feed rate units.

Select the units that you want to be FeatureCAM's global feed rate units in the **Feed unit** menu:

- **Use IPM** (inches per minute)
- **Use IPR** (inches per revolution)
- **Use IPT** (inches per tooth)
- **Use MMPM** (mm per minute)
- **Use MMPR** (mm per revolution)
- **Use MMPT** (mm per tooth)

This global setting is reflected locally on the **Feed/Speed** page of the **New Feature** wizard and the **F/S** (see page 983) tab of the feature **Properties** dialog.

**Proportional plunge feed**

If **Proportional plunge feed** is selected, the feed rate of the ramping move is scaled based on the **Max ramp angle**. A **Ramp angle** of 1° sets the feed rate of the plunging moves to approximately the milling feedrate. An angle of 90° sets the feed rate of the plunging moves to the value determined by **Plunge feed override %**. If **Proportional plunge feed** is not selected, then the feed rate of plunging moves is determined by **Plunge feed override %** regardless of the ramp angle.

Enter the maximum angle, in degrees, for ramping down to depth. It applies to helical or zigzag ramping. Set this value to 0 to cause a plunge cut.

**Peripheral Feed** (see page 1655) dialog.

**Post Vars** — Click the **Post Vars** button and the **Post Variables** dialog is displayed. This contains a list of variables that are passed straight to the post processor. You can use these variables to pass strings directly to the post processor.
Peripheral Feed dialog

These parameters let you adjust the feedrates of arc moves for 2.5D milling features. The concept is that by slowing the feedrate on internal arcs and increasing the feedrate on external arcs, you get a more consistent finish.

Select **Decrease feed on internal arcs** to slow down on concave moves. Set the lower limit by entering a percentage of the linear feed.

Select **Increase feed on external arcs** to speed up on convex moves. Set the upper limit by entering a percentage of the linear feed.

There is a section for roughing and finishing and the options are identical. The finishing section applies to semi-finishing and finishing 2.5D milling operations. The roughing section applies to 2.5D roughing operations.

We recommend that you use these adjustments for finishing and leave the settings for roughing deselected. Use feed optimization (see page 1570) for roughing instead.

*In earlier versions of FeatureCAM, this functionality was called Corner feedrate reduction and only allowed you to slow down concave corners.*
Post Variables dialog

You can use the Post Variables dialog to pass strings of text to the post processor.

To display the Post Variables dialog:

- In the Feature Properties dialog, on the Milling (see page 994), Drilling (see page 900), Turning (see page 1420), or Cutting Data (see page 1487) tab, click Post Vars.
- In the Machining Attributes dialog, on the Misc tab, click Post Vars.

Variables

The dialog contains a list of variables. You can enter a value for each variable so that when the variable name is used in the post, the assigned Value is output to the NC code.

To assign a value to a variable, select the variable's name in the list, and enter the value. Ensure that when you enter the value it is displayed in the Value list.

You can assign a different value to a variable for each operation, and you can set the default values for the document in the Machining Attributes dialog. The value output to the NC code is taken from the active operation.

You can change the names of post variables to make them easier to use. In the XBUILD dialog, select CNC-Info > Post Variable Names from the menu to display the Post Variable Names dialog.
Comments

Open the Post Variables dialog for each operation to set the comment for the operation. The operation comment is included in the operation sheet after the operation's details.

Open the Post Variables dialog from the Machining Attributes dialog and enter a comment to set the default comment for the document.

The default comment is not included in the operation sheet. If an operation has the default comment, the comment is not included in the operation sheet.

Operations tab

![Machining Attributes dialog](https://via.placeholder.com/150)

Automatic Options (see page 1658)

Base priority

Features are sorted by their Base priority to determine the order in which they are manufactured. For features that have the same Base priority value, the system uses the Automatic Ordering settings.

To ensure that an individual feature is cut before anything else, you can set its Base priority attribute. All features have a default Base priority of 10. To ensure that a feature is manufactured first, set its priority to a lower value. To make a feature last, set its priority to a higher value. For example, if you set the Base priority of a pocket to 8, its roughing pass is the first operation performed, its finish pass is second, and the rest of the operations are ordered according to the Automatic Ordering or Manual Ordering settings.
Although you can specify the order of every feature by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.

The order of operations in the document is controlled by the operation-level Priority attribute. If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

Don't ask at tool path generation — This is a toggle for whether you are prompted with the dialog when you run a simulation. The Ordering dialog settings override the operation defaults set on this tab.

Time estimation attributes — Set these attributes to fit the behavior of your particular machine. These attributes affect the machining time estimates printed in the operation sheets.

Rapid traverse — This is the feed per minute of rapid moves.

Tool change — This is the time in seconds it takes to change a tool (not including the rapid to get to tool change location).

Go to start — This is the time it takes for the tool head to move to the start location and the spindle or tool head to come to a stop.

X-Y acceleration — This is used in the formula (see page 1659) to calculate the time for a particular tool move.

Z acceleration — This is used in the formula (see page 1659) to calculate the time for a particular tool move.

Rotary rapid — This is the rotation per minute of the indexing axis.

Automatic Options

The following settings control the ordering of milling operations.

Minimize tool changes — This option groups operations together that use the same tool. This saves time for you by eliminating or reducing needless tool changes. You must select this option if you want to generate hole macros in the NC code.
**Do finish cuts last** — This option moves the finish milling operations to the end of the Setup without altering the order of the finishing operations. If you want to perform all rough milling operations before finish milling operations, select this option.

**Cut higher operations first** — This option affects only milling Setups. Select this option to mill the features from the top of the stock first and work toward the bottom. If you deselect this attribute, you should carefully graphically verify the toolpath before cutting your part.

*Sorting by Z coordinate is controlled by the Cut higher operations first attribute. If you deselect this attribute, graphically verify the toolpath before cutting your part.*

**Minimize rapid distance** — This affects only milling Setups and is the only ordering option that changes the order of features specified in the part view. **Minimize Rapid Distance** moves to the next closest feature that uses the same tool as the last operation. You must deselect this option if you want to generate hole macros in the NC code.

If you have selected all of the optimization options, the manufacturing order for operations that were derived from different features is determined like this:

1. The operations are sorted by their top Z coordinate.
2. Among operations with the same top Z coordinate, operations are grouped by the tool with which they are cut.
3. After an operation is cut, FeatureCAM moves to the next operation performed with the same tool that is the closest to the current operation.

**Formula for particular tool move**

The formula for the time estimate for a particular tool move is:

\[
\text{time} = \frac{\text{dist} / \text{fpm} + \text{fpm} \times (1 + \text{zdist} / \text{dist} \times (1 / z\text{-accln} - 1))}{xy\text{-accln}}
\]

where:

- **fpm** is feed per minute (Rapid Travers for rapids, feed rate for cutting moves)
- **xy-accln** is X-Y Acceleration
- **z-accln** is Z Acceleration
- **dist** is the total distance of tool move
- **zdist** is the total distance that the tool moves in the Z-direction
Acceleration conversions

If the acceleration rates for your machine are reported in different units, use the following conversions:

<table>
<thead>
<tr>
<th>Current Units</th>
<th>Desired Units</th>
<th>Multiply by</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meter per second squared</td>
<td>Millimeters per minute squared</td>
<td>3,600,000</td>
</tr>
<tr>
<td>Feet per second squared</td>
<td>Inches per minute squared</td>
<td>43,200</td>
</tr>
<tr>
<td>Inches per second squared</td>
<td>Inches per minute squared</td>
<td>3,600</td>
</tr>
</tbody>
</table>

Assumptions used

Most often, because of change of direction (and/or several other factors), the tool must effectively accelerate to final fpm from a stop. So the acceleration is calculated as if the tool head must always accelerate to final fpm from 0.

Also, most mills take longer to accelerate in the Z-direction than in either X or Y (and that X and Y acceleration are equal).

Thread Mill tab

![Thread Mill tab screenshot]( Attached image)
**Wind fan** — Select this option to have a single point that is used as both the start and end point of the Finish path. This is useful for machines which require large lead moves to enable cutter compensation.

![Wind fan diagram]

**Wind fan radius** — Enter the radius to use for the wind fan shape as a percentage of the thread-milling tool radius. Increasing the **Wind fan radius** moves the start point of the toolpath further from the feature boundary.

![Wind fan radius diagram]

**Wind fan angle** — Enter the angle to use for the wind fan shape. The wind fan angle is a combination of the lead-in and lead-out arc angles.

![Wind fan angle diagram]

**Linear ramp distance** — Enter the length of the linear approach move to a Thread feature.

*To activate this attribute, you must set **Ramp diameter %** to 0.*

*You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Milling** tab.*

**Ramp diameter %** — This attribute controls the diameter of the arc along which the tool ramps on and off the Thread Milling feature. Enter a percentage of the tool diameter.

Negative angles create a ramp on a clockwise arc. If set to a value greater than 1000, the tool moves in on a straight line tangent to the initial cutting move. If set to 0, the tool approaches perpendicular to the initial cutting move.
Ramp angle offset

This angle controls the starting and ending points of the ramp moves of a Thread Milling feature. The tool starts ramping along the arc of radius Ramp diameter % using the Ramp angle offset to determine the start point of the ramping move. If positive, the arc is counter-clockwise.

Spring passes — A spring pass is a duplicate of the final threading pass. Spring passes indicates the number of spring passes that are to occur at the completion of the thread.

Starts — Enter a value greater than 1 for multiple start threads.
Start angle — Measured counter-clockwise, the Start angle determines the starting point of the thread.

Tooth overlap — Enter the number of threads that one revolution of a multi-thread tool overlaps the previous revolution. An overlap of at least one thread is recommended.

Tooth outside — Enter the number of teeth that are above (if feeding in negative Z) or below (if feeding in positive Z) the thread mill feature for the first pass.

Taper approx. angle — For tapered threads the toolpath is increasing in diameter as well as moving in Z. These moves are approximated with 3D arcs. The Taper approx. angle is the angle around the thread that will be approximated by a single arc. A 360 must be evenly divisible by the Taper approx. angle. For example, if set to 90, a single revolution of the tool is broken into 4 arcs.
**OD Depth %** — The default ratio of **Pitch** to **Thread Height** for OD Thread Milling features.

**ID Depth %** — The default ratio of **Pitch** to **Thread Height** for ID Thread Milling features.

**Helical Ramping**

---

**Cutter comp** (see page 936)

**Partline program** — This is a particular kind of cutter compensation for milled features.

**Part line program** is a particular kind of cutter compensation for milled features. If enabled, the actual drawing dimensions of the feature are output as the toolpath instead of the center line of the tool. The tool selected to cut the feature is still important even when using part line programming. If the same tool is used for roughing, be sure that the actual tool diameter does not deviate too far from the diameter of the tool used by FeatureCAM to ensure proper area coverage for the roughing passes. Also ensure that the diameter of the selected finishing tool is small enough to cut your entire feature. If you have selected a tool too large to fit into a tight corner, you cannot correct the toolpath with just cutter compensation.

FeatureCAM automatically calculates the entrance point of your finish pass and adds a linear move and a ramping move (based on the **Ramp diameter** attribute) to your finish pass to accommodate cutter compensation. If you receive a warning in the operations list such as "**Can't find ramp in/out arc**" or "**Can't extend end of open profile**" then correct the problem by decreasing the **Ramp diameter** attribute or changing the **Pre-drill point**.

**Through** — Select **Through** to increase the hole length by 10% of the hole diameter to account for the drill tip and prevent burring. If **Through** is deselected, the toolpaths are generated to ensure that the tool does not cut past the end of the thread.
Use Finish tool (see page 936)

Rough

Select the Rough attribute to include a roughing operation when you create a thread milling feature.

Enter a Stepover in % for the roughing operations.

You can edit the attributes of the roughing operations using the Milling tab of the Thread Milling Properties dialog when the roughing operation is selected in the Tree View.

Finish

Select the Finish attribute to include a finishing operation when you create a thread milling feature.

Enter an Allowance and number of Spring passes for the finishing operations.

A 'spring pass' is a duplicate of the final threading pass. Spring passes indicates the number of spring passes that are to occur at the completion of the thread.

You can edit the attributes of the finishing operations using the Milling tab of the Thread Milling Properties dialog when the finishing operation is selected in the Tree View.
**Surface Mill tab**

### Tolerance (Finish) and Tolerance (Rough)
Set how close the milling is to the mathematically ideal surface. This does not guarantee that your feature is machined to this tolerance in all locations if the tool you select is incapable of cutting within that tolerance in constrained areas. If your part shows a faceted appearance, set the tolerance to a lower value. This also affects the default tolerance for stock models.

#### Scallop stepover
Select this attribute to set the default stepover type for projection milling finishing and Z-level finishing to be specified by scallop height instead of a linear stepover distance.

#### Scallop height
This sets the default scallop height allowed for surface milling features. You can override it on individual features.

#### Stepover
Enter the default Stepover value for surface milling features. This also affects the default Step Size value for stock models.

#### Parallel angle
is a numeric attribute for X and Y parallel roughing only.

The value can be anywhere from -360 to 360 degrees, the default is 0.0. A positive value rotates counter-clockwise from the principle axis, and a negative value rotates clockwise from the axis.
• Setting the angle to **90** on an X-parallel operation causes it to effectively become a Y-parallel operation.

Setting the angle to **180** causes the toolpaths to be cut from the opposite side of the part. For example, an X-parallel operation with the angle set to **0** starts at the minimum Y coordinate. With the angle set to **180**, the toolpaths start at the maximum Y coordinate.

**Tool diameter** — This sets the default tool diameter for 3D surface milling features.

**Tool end radius**

Select the type of **Tool end radius** from:

- **Ball end** sets the default tool to a ball-end tool to be chosen automatically from the tool database. If there are no ball-end tools in the database, a flat-end tool is chosen as a template and a new ball-end tool is automatically created from it. The new tool is given a name with a suffix of **-ground**, implying that you must grind the tool as needed. If there are no flat-end mill tools in the database, a tool-selection error is displayed.

- **Flat** sets the default tool to a flat-end mill to be chosen automatically from the tool database. If there are no flat-end mill tools in the database, a tool-selection error is displayed.

- **Bull nose** sets the default tool to a bull-nose tool to be chosen automatically from the tool database. If there are no bull-nose tools in the database, a flat-end mill tool is chosen at a template and a new bull-nose tool is automatically created from it. The new tool is given a name with a suffix of **-ground**, implying that you must grind the tool as needed.

*You can override the tool on individual features as needed.*

**Steep and Shallow Options** — Click this button to open the **Steep and Shallow Options** dialog.

**Finish allowance** — This is the amount of material left after a 3D roughing pass.
**Check allowance** — This is the minimum distance that you want to leave around check surface(s). Select from:

- **Finish/leave allowance** — FeatureCAM uses the *Finish allowance* value for rough operations and the *Leave allowance* value for finish operations, by default. You can override this by entering a *Check allowance* value at operation level.

- **Fixed allowance** — Enter a specific *Check allowance* value to use by default for both rough and finish operations. You can override this by entering a *Check allowance* value at operation level.

**Slope limitation angles**

- **Horizontal only** — The default *Maximum surface slope* (see page 1133) angle for the current part document.

- **Vertical only** — The default *Minimum surface slope* (see page 1133) angle for the current part document.

- **Steep slope** — The default *Steep slope angle* (see page 1060) for parallel operations in the current part document.

**Swarf axial tol.** — This helps to stabilize the tool axis and reduce tool load.

For a relatively rare number of geometries, the tool axis can waver slightly as it positions accurately on the surfaces to be machined. This can be due to small but significant changes in the geometry as the tool moves from one position to another. This tolerance can be larger than the machining tolerance to stabilize the tool axis as it moves across this geometrically varying region. As a consequence excess material may be left on the surface but the load on the tool may be reduced.

No *Axial tolerance* set:

![Image of tool without axial tolerance]

*Axial tolerance* set to 0.5 (mm):

![Image of tool with axial tolerance]
**Edges** — The default **Edges** (see page 1115) setting for the current part document.

### Steep and Shallow Options dialog

![Steep and Shallow Options dialog](https://via.placeholder.com/150)

**Order** — This determines the order in which the steep and shallow portions are machined.

- **Top first** — Select this option to machine from the top regions downwards. If you have a boss, the shallow regions at the top of the boss are machined before the steep regions down the sides.

- **Steep first** — Select this option to machine the steep sections before the flat. If you have a boss, the steep regions are machined before the shallow regions.
Options

**Threshold angle** — Enter the angle of the surface slope, measured from the horizontal, that determines the split between constant Z (steep) and shallow machining.

**Overlap distance** — Enter the size of the overlap area between steep and shallow machining. This reduces marks on the model caused by a sudden switch between steep and shallow machining.

**Steep**

**Spiral** — Select this option to create a spiral path between two consecutive closed contours. This minimises the number of lifts of the tool and maximises cutting time while maintaining more constant load conditions and deflections on the tool.

**Shallow**

Select from:

**Parallel**

Optionally enter a **Wall Clearance** and **Raster Angle**.

**3D Spiral**
**Smoothing** — Select this option to smooth offsets of toolpath segments over the model.

Selecting the **Smoothing** option converts this:

![Before Smoothing](image1.png)

...to this:

![After Smoothing](image2.png)

*As a general rule, use raster on open-edged parts and 3D offsets at the bottom of a pocket.*
**Surface Leadin tab**

**Stepover type** — This controls the moves between toolpaths.

*Stepover type* controls the type of transition move that is inserted between toolpaths. The options are:

- **Direct** - The tool moves straight over to the next position. The tool can move in all 3 axes. This figure shows a direct stepover move on a flat surface feature.
- **Stair step**: The tool moves up in Z and then over in X and Y. This figure shows a stair step transition move on a spherical surface.

This figure shows the same surface feature using a direct stepover.

- **Loop**: The tool makes an arc move out of one toolpath and an arc move into the next toolpath. These transitions are actually programmed from linear moves and may move all three axes. This figure shows a loop move on a flat surface feature.

**Use lead-in/out** — This controls when lead-in/out moves are applied. The **Use lead in/out** menu controls when lead moves will be applied. The options are:

- **Never**: Do not use lead moves on this operation.
- **On all plunges/retract**: Apply the leads on all plunge and retract moves for this operation.
- **On first plunge/last retract**: Apply on the first plunge and last retract move only for this operation.
- **On all stepovers, plunges and retracts**: Apply the leads on all stepovers, plunge and retract moves for this operation.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Leads** (see page 1342) tab.

**Normal to surface** — If you select Normal to surface, the lead in/out moves are performed with respect to the surface normal. If you deselect it, the moves are performed in the plane of the toolpath.

Lead moves are either performed as arcs or linear moves by selecting one of the following:

**Use arc ramp-in/out**

If you select **Use arc ramp in/out**, the following parameters are used to control the ramping on and off the part feature:

1. **Ramp-in angle** - The angle of the ramp in move.
2. **Ramp diameter** - The diameter of the ramp move.
3. **Ramp-out angle** - The angle of the ramp out move.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Leads** (see page 1342) tab.

**Use linear lead-in/out**

If you select **Use linear lead-in/out**, the following parameters control the move off the feature:

- **Lead-in angle** - Angle measured away from the toolpath for the lead-in move. Note this angle can be negative.
- **Lead-out angle** - Angle measured away from the toolpath for the lead-out move. This angle can be negative.
- **Lead-in length** - Length of the linear lead-in length.
- **Lead-out length** - Length of the linear lead-out length.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Leads (see page 1342) tab.
**Tool Selection tab**

The **Counter bore** options control the default behavior for tool selection for counter bore operations. Select **Use counter bore** to default to a counter bore tool or select **Use endmill** to make circular interpolation with an endmill the default. Select **Automatic** to have FeatureCAM first attempt to select a counter bore and to use an endmill as a secondary choice.

**Spot drill** — Select from:
- **Prefer spot drill** — Use a spot drill tool for spot drill operations if possible.
- **Prefer center drill** — Use a center drill tool for spot drill operations if possible.

**Tool diameter tolerance** — This is the tolerance used when selecting a tool for an operation. If the tool diameter is within the tolerance of the tool, the tool is selected.

**Drill % of ream/bore** — This is the percentage of the Hole diameter to use for selecting tooling for undersize drilling operation. For example, if set to 95, a drilling operation is created with a diameter that is 95% of the nominal Hole diameter.

**Thread % for tap drill**
Thread % for tap drill (cutting, helicoil, user-defined) and Thread % for tap drill (rolled) represent the percentage of the thread form that is cut with the tap. By default the cutting percentage is greater than the rolled percentage indicating that a greater percentage of the thread is manufactured by the cutting tap. This parameter is used in determining the size of the drill to use for cutting and rolled tapping operations. The larger the percentage, the smaller the size of the drilled hole.

Tap type — Select the type of tap from:

- **Cutting** — The tool cuts the threads into the material.
- **Rolled** — The tool presses or forms the threads into the material.
- **Helicoil** — The size of the Drill and Tap operations are larger to fit the helicoil insert.

Default auto-chamfer tool — Select the default tool for chamfer operations. The selected tool is used for any new chamfer operations you create, and any existing chamfer operations which use the default tool are updated.

Tool % of arc radius controls the size of the tool that FeatureCAM automatically selects.

If Tool % of arc radius is set to 100 then a tool equal to the smallest corner radius is selected for a feature such as a pocket, and the finish tool path for the pocket looks like the toolpath shown below. With Tool % of arc radius set to 100 the tool dwells in the corners as it changes direction. This can sometimes nick the part. To avoid this problem, set Tool % of arc radius to a slightly smaller number, such as 98.
In earlier versions of FeatureCAM Tool % of arc radius was called Default tool %.

Preferred spot drill diameter — This is the diameter of the spot drill (or center drill) that is preferred for all holes.

Optimize spot drill tool selection — Select this option to automatically spot drill all Holes with the largest spot drill that would be used for a collection of Holes.

For example if you have 0.25, 0.375 and 0.5 inch holes, a 0.5 inch spotdrill is used for all holes. It is possible that you could get a gouge with this setting turned on, if a large spotdrill might gouge neighboring features. The following image shows a situation that would gouge:

This image shows the proper result with Optimize spot drill tool selection deselected:

Optimize chamfer tool selection — Select this option to automatically chamfer all Holes with the largest chamfer that would be used for a collection of Holes.

Tool diameter tolerance — This is the tolerance used by tool selection.

Multiple Roughing Tools — Displays the Multiple Roughing Tools for Milling (see page 1679) dialog.

Tool Holder Clearance — Displays the Tool Holder Clearance dialog (see page 1680).


**Multiple Roughing Tools for Milling dialog**

FeatureCAM has the option of roughing a 2.5D milling feature with a single tool or using a sequence of tools.

If you use multiple roughing tools, FeatureCAM cuts all the parts of a feature that it is capable of cutting with the larger tool, and cuts only the remaining portions of the feature with the smaller tool. You do not have to manually create these separate regions. FeatureCAM automatically calculates them for you.

The default behaviors available are:

- **Use a single tool that is automatically selected** — FeatureCAM selects a tool based on the smallest radius of the feature and use that tool to cut the entire feature. If your part has broad corners or you need to minimize the number of tools you are using, this is a good option to pick. If you have features with tight corners, you should not choose this option. If you are using automatic feature recognition, this option can result in a number of tool selection errors for parts with sharp corners.

- **Use Multiple roughing tools** — This option cuts the part with a list of tools you supply. Each tool cuts only in the regions that have not been cut previously. As soon as the part has been cut completely, no more operations are created with the smaller tools. This is a good option to select if your part has sharp corners, but be aware that your part needs more tools and tool changes. You should enter the tool diameters you want to use. Separate each diameter with a comma. As part of this option, you can select **Automatically select an additional tool that fits the smallest radius of the contour**. If you select this option, you should list some larger diameters for multiple roughing and then let FeatureCAM select the tool for the final roughing pass.

As a separate option, you can limit the smallest tool FeatureCAM chooses by selecting **The minimum tool diameter of an automatically chosen roughing tool** and entering a diameter. Because many CAD models have sharp corners, we recommend that you use this option when working with imported models with Feature Recognition.
Tool Holder Clearance dialog

Use the Tool Holder Clearance dialog to specify an additional clearance for FeatureCAM's automatic tool selection to prevent tool holder gouges.

To display the Tool Holder Clearance dialog, click Tool Holder Clearance on the Tool Selection tab of the Machining Attributes dialog.

To specify a tool selection clearance:

1. In the Clearance Requirement list, select the clearance you want between the tool holder and the part. Select from:
   - None — Select this option to leave no additional clearance. Old part files select the same tools as before.
   - Feature — Select this option to ensure the tool is long enough for the tool holder to clear the feature.
   - Setup — Select this option to ensure the tool is long enough for the tool holder to clear the total depth below the setup.
   - Stock — Select this option to ensure the tool is long enough for the tool holder to clear the total depth into the stock.

2. Enter an Extra allowance as a % of feature or setup depth to leave extra clearance of the tool holder above the feature, setup, or stock.

3. Select how tool selection is affected if no matching tool is found:
   - Give an error if no tool meets requirements — FeatureCAM does not select a tool for the operation, so an error is shown during NC code generation. In the Operation List, a red exclamation point ! is displayed beside operations with no tool selected.
   - Select tool closest to requirements if none match — this enables you to generate NC code, but it may result in tool holder gouges because a smaller tool may be used.
4 Click **OK** to close the dialog.

**Facing tab**

![Facing tab image]

**Rough pass** — Select this option if you want to have a rough operation on face features by default. You can override this selection at an individual feature level.

**Finish pass** — Select this option if you want to have a finish operation on Face features by default. You can override this selection at an individual feature level.

**Finish allowance** — This is a facing parameter for the amount of material to leave after the rough pass. You can enter a positive or negative value.

**Facing stepover %** — This is the width of cut for a facing operation specified as a percentage of the tool diameter.

**Lateral overcut %** — Enter the distance, as a percentage of the tool radius, that the tool cuts past the stock boundary in the direction of the cut, on the X axis (unless you have changed the **Zigzag angle**). The default value is 100% of the tool radius.
This example shows a Face feature top view centerline simulation using the default **Lateral overcut %** value of **100%** of the tool radius (the distance marked with the arrows):

This is the same example with the **Lateral overcut %** value set to **150%** of the tool radius:

**Last pass overcut %** — This attribute applies to a Face feature. Enter the distance, as a percentage of the tool radius, that the tool moves past the stock boundary perpendicular to the cut, in the Y direction (unless you have changed the **Zigzag angle**). The default value is 20% of the tool radius.
This example shows a Face feature top view centerline simulation using the default **Last pass overcut** % value of 20% of the tool radius (the distance marked with the arrows):

This is the same example with the **Last pass overcut** % value set to 50% of the tool radius:

**Max depth of cut** — This is the maximum depth of cut for facing tools.

**Connect stepovers with arc**

When cutting Face features, you can optionally select **Connect stepovers with arc**.
This example shows a Face feature with Connect stepovers with arc selected:

Compare this to the example with Connect stepovers with arc deselected (the default setting):

Zigzag angle — Enter the angle in degrees (counter-clockwise from X) that you want to use to cut the Face feature.

An example of a Face feature with Zigzag angle set to the default 0 deg:

The same example with Zigzag angle set to 30 deg:
You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). Set it on the Milling (see page 1161) tab.

Turning default machining attributes [TURN]

The Machining Attributes dialog for Turn parts has these tabs:
- Drilling (see page 1686)
- Pecking (see page 1688)
- Turn/Bore (see page 1689)
- Threading (see page 1699)
- Grooving (see page 1702)
- Cutoff (see page 1706)
- Bar Feed (see page 1707)
- Coolant (see page 1647)
- Misc. (see page 1708, see page 1404)
- Operations (see page 1713)
Drilling tab [TURN]

Spot drill

This operation has some wide-ranging effects, however, especially when used with the Attempt chamfer w/ spot and tool optimization. Of those three settings, tool optimization has the highest priority and its decisions override settings with a lower priority.

For example, a spot drill operation could be performed with either a spot drill or a center drill. Spot drills with a tip angle of 90° can also perform a chamfering operation. You specify a specific tool to cut the hole's chamfer and also turn on Attempt Chamfer /w Spot and tool optimization. If there is an appropriate spot drill in the tool crib, FeatureCAM optimizes things and use this tool in spite of your lower priority override. Even though you selected a specific tool, your other settings conflicted with and superseded your choice.

This is the advantage of the optimization and simulation functions in FeatureCAM. As you work through the optimization settings, and see where you can optimize automatically and where you cannot, you can find ways to group your parts for faster production, but still use specific tools for specific effects when needed.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 889) tab.
**Spot drill edge break** — To create an edge break or chamfer using the spot drill tool, enter the radial distance of the edge break/chamfer. The spot drill creates an edge break/chamfer by cutting deeper than it normally would to create the spot drill operation alone. The default value **0.0050" or 0.1 mm results in a chamfer 0.0100" or 0.2 mm greater than the hole size. The angle of the chamfer depends on the spot drill tool used.

Enable this option to try to cut the chamfer during spot drilling. If no available tool can spot and chamfer without gouging the hole, a separate chamfer operation is created.

**Spot drill diameter %** — This percentage is used to select a spot drilling tool. A value of **100** specifies that the spotdrill should be the same diameter as the hole. A smaller value creates only a starter hole.

**Use L/D compensation** — This reduces speed and feed for holes that have a ratio of hole depth (L) to hole diameter (D) of greater than 2.5. The greater this ratio, the greater the speed/feed reduction.

**Max. tap spindle RPM** — This is the maximum speed (in RPM) for tapping.

**Tap cycle** affects how a tap operation is performed. Select from:

- **Floating** — Floating and tension-compression holders
- **Rigid** — This is most commonly available on current machines
- **Deep Hole** — The tool pecks and retracts to the Plunge clearance and returns to the previous depth.
- **Chip Break** — The tool stops feeding only to break the chip.

All cycles use the same Tap program format, but logical reserved words exist in XBUILD to distinguish the tap type.

**Pilot diameter(s)** — This enables and sets a list of drill sizes used to drill pilot holes. Enter a comma-separated list of drill diameters. For example, entering **0.5, 1, 1.5** in inches, causes holes to be pilot drilled with the half inch drill for final hole sizes up to an inch. A hole in excess of 1.5" is pilot-drilled with all three of the specified drills before being drilled to size. No list of drill sizes turns off pilot drilling for the feature, although this attribute can also be set up as a default for all parts.
Pecking applies to Deep Hole, Chip Break, and Tap operations. FeatureCAM supports four styles of pecking. These styles are listed in the post processor. Three different attributes control the pecking and they are used differently depending on the style of pecking. FeatureCAM checks the pecking type in the currently loaded post processor to duplicate canned cycles when simulating toolpaths. Set these attributes separately for Drilling and Tapping operations:

- **First peck** — This is the depth of the first peck of a drilling/tapping operation specified as a percentage of tool diameter. If the depth of the hole is less than First peck, the hole is drilled in a single peck.

- **Second peck** — This is the depth of the second peck of a drilling/tapping operation specified as a percentage of tool diameter. The post handles the conversion.

**Minimum peck** — This is the minimum step size for a peck used for value reduction pecking methods or factor reduction pecking methods.
**Turn/Bore tab [TURN]**

Rough depth of cut

Enter a step increment for each pass that the roughing routine performs on the part. The interpretation of **Depth of cut** depends on the **Constant DOC** setting in the **Turn/Bore** (see page 1689) document-level options.

If **Constant DOC** is deselected, the **Depth of cut** value you set is the maximum depth of cut for the feature. If the **Depth of cut** evenly divides the depth of your feature, your increment is used. If it results in a final pass that is quite shallow, the **Depth of cut** is adjusted to result in even roughing passes. For example if you have a feature that is 0.5 inches deep and specify a **Depth of cut** of 0.4, the feature is roughed in two even passes 0.25 inches deep instead of one pass of depth 0.4 inches and another pass with depth of 0.1 inches.

If **Constant DOC** is selected, the feature is cut using this depth for each pass. With **Constant DOC** selected, you can also list a series of depths, separated by commas, to control the depth of each cut. For example a **Depth of cut** specified as 0.25, 0.15, 0.1 results in the first pass being cut at 0.25 inches, the second at 0.15 inches and the remaining pass at 0.1 inches. If there are more cuts than depths specified, the last depth is repeated.
Constant DOC (see page 1697) — See Rough depth of cut.

**X finish allowance**

![Diagram of X finish allowance](image)

1. Z finish allowance
2. X finish allowance

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Turning (see page 1420) tab.

Z finish allowance — See X finish allowance.

**Rough Engage angle** — Enter the angle at which the tool enters the stock in roughing operations when TNR comp is off.

When TNR comp is off, the part entry angle is controlled by the Engage angle attribute.

![Diagram of Engage angle](image)

1. Engage angle
Enter the approach angle for the tool, measured away from the part. An angle of 0 approaches along the path. An angle of 90 approaches perpendicular to the path. If the beginning of a scan line begins with a shoulder, a value of 90 is used automatically for that scan line. The only valid values are 0 or 90 degrees.

The Engage angle and Withdraw angle are specified from the path (or extension of the path), relative to the side of the path that the tool is on, and the direction in which the tool is traveling. In the graphic below, Point 1 is the calculated engage point and the Point 6 is the calculated withdraw point.

1. Clearance
2. Withdraw angle
3. Clearance zone
4. Engage angle

Finish Engage angle — Enter the angle at which the tool enters the stock in finish operations when TNR comp is off.

When TNR comp is off, the part entry angle is controlled by the Engage angle attribute.
Enter the approach angle for the tool, measured away from the part. An angle of 0 approaches along the path. An angle of 90 approaches perpendicular to the path. If the beginning of a scan line begins with a shoulder, a value of 90 is used automatically for that scan line. The only valid values are 0 or 90 degrees.

The Engage angle and Withdraw angle are specified from the path (or extension of the path), relative to the side of the path that the tool is on, and the direction in which the tool is traveling. In the graphic below, Point 1 is the calculated engage point and the Point 6 is the calculated withdraw point.

1 Clearance
2 Withdraw angle
3 Clearance zone
4 Engage angle

Rough withdraw angle — Enter the angle at which the tool withdraws from the stock after cutting during roughing operations when TNR comp is off.

Finish withdraw angle — Enter the angle at which the tool withdraws from the stock after cutting during finish operations when TNR comp is off.

Withdraw length — This is the distance along the withdraw angle line in which the tool withdraws before returning for the next step.
Withdraw length
Boundary
Clearance
Depth

Use Clearance as finish withdraw length — When selected, the Clearance value is used as the approach and withdraw length for finishing moves. When deselected, the Withdraw length value is used.

Auto round

This turning attribute applies to both rough and finish passes. When Auto round is enabled, FeatureCAM automatically inserts arc moves to connect two non-tangent elements. The effects are:

- Minimum of wasted motion by the machine; however, the posted part program may be slightly longer in the number of blocks used.
- Burrs are removed, but otherwise the part has the same shape and dimensions given by the feature curve because the radius of the inserted arc is the same as the tool nose radius.
- Machine motion is smoother.

This is an example with Auto round turned off:
This is the same example with **Auto round** turned on:

![Diagram showing Auto round turned on](image)

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). Set it on the **Turning** (see page 1420) tab.

**Tool nose radius compensation**

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want **TNR comp** for **Rough**, **Semi-Finish**, and **Finish** operations. Enter the **Lead-in angle**, **Lead-out angle**, and **Lead distance** parameters for **TNR comp**.

**Turn feature example**

![Diagram showing tool nose radius compensation](image)

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Strategy** (see page 1366) tab.

**Rough lead in angle** — Enter the angle at which the tool enters the stock in roughing operations when **TNR comp** is on.
When TNR comp is on, the part entry angle is controlled by the **Lead in angle** attribute.

Enter the angle for the lead-in move, measured counter-clockwise away from the part. An angle of $0^\circ$ approaches along the path. An angle of $90^\circ$ approaches perpendicular to the path.

---

**Finish lead in angle** — Enter the angle at which the tool enters the stock in finish operations when **TNR comp** is on.

When TNR comp is on, the part entry angle is controlled by the **Lead in angle** attribute.

Enter the angle for the lead-in move, measured counter-clockwise away from the part. An angle of $0^\circ$ approaches along the path. An angle of $90^\circ$ approaches perpendicular to the path.

---

**Rough lead out angle** — Enter the angle at which the tool withdraws from the stock after cutting during roughing operations when **TNR comp** is on.

---

**Finish lead out angle** — Enter the angle at which the tool withdraws from the stock after cutting during finish operations when **TNR comp** is on.
Use canned cycle

Enable this option to perform the feature's operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

For support of canned cycles in Fanuc controllers, use the fanucez.cnc post.

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.

Hole features

If Enable drilled canned cycles is deselected in the Post options dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If Enable drilled canned cycles is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.

There is no way to control the output of canned cycles on an individual feature basis.

Turn/Bore features

Canned cycles for Turn and Bore features must be enabled by selecting Enable turn canned cycles in the Post options dialog. You must then go to the Properties dialog for each Turn/Bore feature, click the Strategy tab and select Use canned cycle. Also select Reuse path in canned cycle if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.
**Groove features**

Enable grooving canned cycles in the **Post options** dialog by selecting Enable groove path canned cycle. Then turn on canned cycles for each groove by bringing up the feature's **Property** dialog, clicking the **Strategy** tab, and then clicking **Use path canned cycle**. You can also set this attribute on the **Groove** tab of the default attributes, but this will only apply to features you create after changing this setting.

**Thread features**

Thread features always use canned cycles.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Strategy** (see page 1366) tab.

**Reuse path in canned cycle** — Relates to **Use canned cycle**. Enable this option to output the curve to the NC file once and then reference it in both the Rough and Finish canned cycles. This option is enabled by default.

**Canned cycle clearance X** and **Z** — These attributes control the tool location before the start of a turning canned cycle. The tool location is obtained by applying the X and Z clearances to the start point of the curve.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). Set it on the **Turning** (see page 1420) tab.

**Constant DOC**

The **Constant DOC** option controls how the **Depth of cut** attribute is used to calculate the X depth of roughing passes.

If **Constant DOC** is deselected, cuts are guaranteed not to exceed the **Depth of cut**, but some cuts may be less than that amount. A pass is performed at each step. The area above each step is divided into equal regions with a depth of less than the **Depth of Cut**.

In the example below, the bottom three cutter paths are aligned with the steps. The top region is divided into two equal regions with shallow depths of cut.
If **Constant DOC** is selected, each pass is performed at a consistent depth of cut. If required, the pass also climbs and cleans up previous steps. In the figure below, the first cut is performed straight across at the specified **Depth of cut**.

In the next pass, the tool cuts across at the specified depth of cut and then the tool climbs up the wall and the previous step is cut to with the finish allowance.
**Threading tab [TURN]**

Some of the **Threading** attributes are shown on this diagram:

1. **End clearance**
2. **Withdraw angle**
3. **Depth**
4. **Start clearance**
5. **Clearance**
6. **Infeed angle**
7. **Height**

**Rough turn** and **Finish turn** — Select these options to automatically turn the piece down to the thread diameter. See How a thread feature is manufactured (see page 817) for more details.

**Chamfer**

**OD Thread feature:**
ID Thread feature:

(Chamfer) Angle — Enter the angle of the chamfer in degrees (between 0 and 85) measured from vertical. The default angle is 30.

(Chamfer addl.) depth — Optionally enter additional depth for the chamfer. The default depth is the same as the Thread Height. The minimum value is 0.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 1366) tab.

Relief groove — A Thread feature has an option of cutting a relief groove at the end of the thread. Enter the groove parameters in the Feature Properties dialog on the Strategy (see page 1366) tab.

Side wall angle — This is the default angle of the relief groove of the thread.

Groove addl. depth — The depth of the relief groove is the depth of the thread plus the Groove addl. depth. This prevents the threading tool from dragging on the bottom of the groove.

Start clearance — This value is the position to which the tool traverses before engaging into the workpiece.
You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Threading** (see page 1459) tab.

**End clearance** — Enter the distance that the tool feeds past the end of the thread (into the relief groove) before retracting from the part's surface.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Threading** (see page 1459) tab.

**Infeed angle** — Enter an unsigned, incremental value from the positive Z axis.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Threading** (see page 1459) tab.

**OD/ID Depth %** — The depth of a thread is based on the thread pitch. The thread depth is calculated as **Depth% * pitch**.

**Passes** — This is the number of steps to the bottom of the thread. Select either **Fixed** or **Calculated**.

- **Fixed** — refers to a fixed rate of material removal. As the tool cuts further into the part, the area of contact of the tool increases. FeatureCAM reduces the infeed on each pass so that the tool loading remains constant. Enter the number of passes in **Count**.

- **Calculated** — the number of steps is calculated automatically by FeatureCAM.

  - **Step1** is used to specify the incremental step for the first pass across the thread.

  - **Step2** specifies the second pass and is used by the system to determine subsequent passes on the thread, reducing in depth until the **Min Infeed** value is reached.

**Spring passes** — A **spring pass** is a duplicate of the final threading pass. Enter the number of **Spring passes** that you want.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Strategy** (see page 1366) tab.
Thread depth calculations - Select how you want FeatureCAM to calculate the **Standard Threads** for pre-populating the dimensions of a Thread (see page 1352) feature. Select from:

- **Use tool tip radius** — This option takes into account the tool tip radius. For example the standard thread designation **M20 x 2.5** outputs:
  - OD thread: **Thread Height 1.894, Major Diameter 19.791**
  - ID thread: **Thread Height 1.625, Major Diameter 17.519**

- **Use tool tip zero radius** — This option outputs the nominal diameter and actual thread depth. This method is more commonly used in Europe. With this option selected, the standard thread designation **M20 x 2.5** outputs:
  - OD thread: **Thread Height 1.534, Major Diameter 20.000**
  - ID thread: **Thread Height 1.534, Major Diameter 16.933**

**Grooving tab [TURN]**

![Grooving tab screenshot]

**Plunge center first** — For groove features, if this option is selected, the straight portion of the groove is roughed first and then the angled portions are roughed separately. If **Plunge center first** is set, the red region of this image is roughed first and then the yellow regions are roughed.
You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 1366) tab.

Cut type

A turned groove can be cut in two different styles. The regions in the following figure are used to show the differences.

- **Width first** - regions are cut in the order: 1, 3, 5, 2, 4, 6.
- **Depth first** - regions are cut in the order: 1, 2, 3, 4, 5, 6.

If Depth First and Plunge Center First are both enabled, then the groove is cut in the order: 3, 4, 1, 2, 5, 6. If the groove were wider, the subsequent cuts would alternate from one side of the groove until the other until the entire groove was cut.

**Feed dir** — This is the direction the tool feeds. The choices are either **Neg** (negative, -Z direction) or **Pos** (positive, +Z direction). For finish, you can also set this to **Opposite from rough dir**.

**Side liftoff dist** — Enter the distance to move the tool after a plunge cut, in the direction opposite to the cutting direction. This increases the tool's life and leaves a better finish on the part. This applies to a Groove feature. See also **Side liftoff angle**.

This part has a Groove feature, shown in pink:
The default behavior is for the tool to lift off the part at 90°, shown in the following image by 1, after each plunge cut. This results in tool contact with the uncut material, at 2, when the tool is retracting at a rapid feed rate along the X axis:

You can avoid this by using the **Side liftoff dist.** attribute, to move the tool back along the Z axis 3, before lifting off.

**Side liftoff dist** and **Side liftoff angle** are ignored for the retract move at the end of the first plunge. The liftoff move is performed at the plunge feed rate. If the groove is a round-bottomed groove, then liftoff is not used, even when specified.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Turning** (see page 1420) tab.

**Side liftoff angle** — Enter the angle to lift the tool off the part after each plunge cut. This increases the tool's life and leaves a better finish on the part. This attribute applies to a Groove feature.

This part has a Groove feature, shown in pink:
The default behavior is for the tool to lift off the part at 90°, shown in the following image by 1, after each plunge cut. This results in tool contact with the uncut material, at 2, when the tool is retracting at a rapid feed rate along the X axis:

You can avoid this by using the **Side liftoff dist.** attribute, to move the tool back along the Z axis 3, before lifting off.

Side liftoff dist and Side liftoff angle are ignored for the retract move at the end of the first plunge. The liftoff move is performed at the plunge feed rate. If the groove is a round-bottomed groove, then liftoff is not used, even when specified.

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Turning** (see page 1420) tab.

**Dwell** — The number of seconds the tool dwells after plunging during a groove roughing pass. It also applies to the roughing of the Cutoff chamfer.

**Use 2nd offset register** — Use a different offset register for each side of a grooving tool. The second offset register number is displayed in the **Tool Mapping** dialog.

This requires a change to your post to work properly. See the **XBUILD help for the <OFFSET_CH> reserved word.**
**Stepover %** — Enter the distance, as a percentage of the tool’s diameter, that the tool shifts to position itself for the next plunge cut. This value specifies the maximum stepover distance. If this value evenly divides the width of the feature, it is used. If it results in a final pass that is quite shallow, the cut widths are adjusted to result in even roughing passes.

For example if you have a feature that is 0.5 inches wide and specify a width of cut of 0.4 (specified as a Stepover % of 80 for a tool with a diameter of 0.5 inches), the feature is roughed in two even passes 0.25 inches wide rather than one pass of 0.4 inches and another pass with a width of 0.1 inches.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Turning (see page 1420) tab.

**Chamfer extend dist.** — This provides extra space for the tool so that the tool does not start on the material for the Groove finish pass.

**Peck retract dist.** — For Cutoff and Groove features, Peck retract dist is the distance the tool retracts between plunges.

**Cutoff tab [TURN]**

![Cutoff tab](image)

**Peck retract dist.** — For Cutoff and Groove features, Peck retract dist is the distance the tool retracts between plunges.

**Dwell** — The number of seconds the tool dwells after plunging during a groove roughing pass. It also applies to the roughing of the Cutoff chamfer.

You can set these attributes for an individual Cutoff feature in the Feature Properties dialog on the Cutoff (see page 1464) tab.
Bar Feed tab [TURN]

Dwell — The number of seconds you want the tool to dwell after plunging during a groove roughing pass. It also applies to the roughing of the cutoff chamfer.

Coolant tab

Use the Coolant tab of the Machining Attributes dialog to specify the default coolants to use for an operation.
Select the coolant types you want to use. The available coolant types are specified in the CNC file using the Coolant dialog in XBUILD.

You can override this option for a tool using the Coolant tab of the Tool Properties dialog, or for an operation using the Coolant tab of the Feature Properties dialog.

**Misc. tab**

**Plunge clearance** — This is the distance above an operation at which the tool starts to feed. In the case of deep hole drilling, the drill retracts to this distance between pecks. For milling features, the default is to use the same value for roughing and finishing. As a result, the tool feeds from the top of a pocket to the floor before cutting. To make the tool feed down into the feature, set the Plunge clearance for an operation to a negative value, but make sure the value is above the floor of the feature.

**2nd offset reg. increment** — When using a 2nd offset register for grooving tools, the 2nd Length offset register in the Tool Mapping dialog is calculated as the Length offset register plus the 2nd offset reg. increment.
The **Starting offset number for shared tool slots** is the first length offset register to use for tools that share the same tool slot.

**Tool program point** — Specify the program point for turning tools, select from:

- **Tool tip edge** — Select this option to adjust the tool program point by the insert radius in the NC code. In this case, adjust the tool's program point by the radius compensation on the **Prog. Pt** (see page 1815) tab of the **Tool Properties** dialog.

- **Tool tip center** — Select this option to adjust the tool program point by the insert radius at the machine. In this case, set the tool's program point **X Coordinate** and **Z Coordinate** to **0, 0** on the **Prog. Pt** (see page 1815) tab of the **Tool Properties** dialog.

**Turnmilling program point** — Specify the program point for turnmilling tools, select from:

- **Tool edge** — Select this option to adjust the tool program point by the tool radius in the NC code.

- **Tool center** — Select this option to adjust the tool program point by the tool radius at the machine.

**Post vars.** dialog (see page 1656)

**Feed from start point or curve** — Select this option to use a feed move from the **Start point** (see page 1420) or the end of the **Start curve**, to the beginning of the toolpath. If you are using a start curve, you have two further options:

- **Rapid on curve** — Select this option if you want to use a rapid move along the start curve.

  *Selecting **Feed from start point or curve** and **Rapid on curve** is the equivalent of selecting the **Feed from start option** on the **Turning tab** in previous versions of FeatureCAM.*

- **Feed on curve** — Select this option if you want to use a feed move along the start curve. Enter the feed rate value(s). You can set the feed move as a single value, or use a comma separator to enter multiple values, for example *200, 100, 50*. If you enter multiple values, the feeds are applied to the curve segments in reverse order. So with these values, the last segment has a feed rate of **50**, the second last has a feed rate of **100** and any remaining segments have a feed rate of **200**. If you do not enter any feed rate values, FeatureCAM uses the default feed rate.
This example turned part has a Turn, Hole, and Groove feature:

A 3D simulation with 3/4 view shows that the tool has to pass through a narrow channel to access the Groove feature:

To control the movement of the tool through that narrow channel, you can create curves and set them as **Start point** and **End point** on the **Turning** tab.

A Centerline simulation of just the Groove feature, shows the approach move in green, which is a rapid move:

On the **Feed/Speed** tab, select **Feed from start point or curve** and **Feed on curve**. Enter the feed value(s) and click **Apply**.

The Centerline simulation now shows the approach move in purple, a feed move:
**Turret direction** — We recommend that you leave this as **Auto** so that FeatureCAM can calculate the best direction for a particular operation. You can also explicitly set this option to **CW** (clockwise) or **CCW** (counter-clockwise).

**RPM Range** — If your machine has explicit spindle speed ranges, you can set this option.

Some turning centers have gear boxes that set the maximum spindle speed of the machine. The **RPM Range** list sets the gear box to a specific maximum range. If you set **RPM Range** to a value of 1-4, then the range is set explicitly. If **RPM Range** is set to **Auto** then FeatureCAM sets the range for you based on the following rules:

1. If the feature is a turned Hole or another turned feature without **Constant Surface Speed** set, then the range is determined based on the **Spindle Speed**.
2. If the feature is a turned feature with **Constant Surface Speed** set, then the range is determined based on the **Max RPM**.

**Remachining** — This automatically sets the boundaries for subsequent operations that use the same curve. This minimizes air cutting and works between Turn features, Bore features and between Holes and Bore features. The same curve must be used in both features. ID features use the results of a previous turn drill operation if such a feature exists. The stock curve that results from the first operation is the result of undercut clipping with the tool geometry and nothing more than that.

**Constant Surface Speed** — Select this option to specify the speed as a constant surface speed.

**Use IPR/MMPR** — The default feed units are **IPM** (inches per minute) or **MMMP** (mm per minute). Select this option to use **IPR** (inches per revolution) or **MMPR** (mm per revolution).

**Do feed reduction for small moves** — This attribute helps FeatureCAM cut small features properly. It is typically applied to small chamfers or small radii but affects any small move. If **Do feed reduction for small moves** is selected, then any move with fewer revolutions than the **Threshold**, is reduced by the **Feed rate %**.

**Calculate index radius from solid stock outline** — Select this option to determine the index height directly from the stock solid, instead of calculating it above a square bounding box.

---

**Calculate index radius from solid stock outline off:**

**Calculate index radius from solid stock outline on:**
Automatic tool orientation — Select this option to use a turning tool in any orientation without needing to create duplicates. When this option is selected, only tools in the default orientation are displayed in the tool crib and available for selection. When this option is deselected, all tools are available, but each tool can only be used in the orientation selected on the Orientation tab of the Tool Properties dialog.

Turret location

The Turret location is kept in the *.cnc file, because there may be multiple turret locations.

To change the locations:
1 Select Manufacturing > Post Process from the menu.
2 In the Post Options dialog, click the Turn/Mill tab.
3 Click the Edit button and XBUILD opens. Select CNC-Info > Turrets from the menu.
Operations tab [TURN]

Automatic Options (see page 1714)

Base priority

Features are sorted by their Base priority to determine the order in which they are manufactured. For features that have the same Base priority value, the system uses the Automatic Ordering settings.

To ensure that an individual feature is cut before anything else, you can set its Base priority attribute. All features have a default Base priority of 10. To ensure that a feature is manufactured first, set its priority to a lower value. To make a feature last, set its priority to a higher value. For example, if you set the Base priority of a pocket to 8, its roughing pass is the first operation performed, its finish pass is second, and the rest of the operations are ordered according to the Automatic Ordering or Manual Ordering settings.

*Although you can specify the order of every feature by priority, you should not do so casually because you lose the automatic optimization sequences built into the system and it is harder to maintain or change the part.*

The order of operations in the document is controlled by the operation-level Priority attribute. If you use the Op List (see page 1553) to drag-and-drop operations to the order you want, the Priority is updated automatically.

Don't ask at tool path generation — This is a toggle for whether you are prompted with the dialog when you run a simulation. The Ordering dialog settings override the operation defaults set on this tab.
Time estimation attributes — Set these attributes to fit the behavior of your particular machine. These attributes affect the machining time estimates printed in the operation sheets.

Rapid traverse — This is the feed per minute of rapid moves.

Tool change — This is the time in seconds it takes to change a tool (not including the rapid to get to tool change location).

Go to start — This is the time it takes for the tool head to move to the start location and the spindle or tool head to come to a stop.

X-Y acceleration — This is used in the formula (see page 1659) to calculate the time for a particular tool move.

Z acceleration — This is used in the formula (see page 1659) to calculate the time for a particular tool move.

These attributes are the same as on the Operations tab for Mill (see page 1657), with an additional option in the Automatic Ordering Options dialog, Use template:

This attribute is applicable only to turning setups. If Use template is selected then the order of operations is determined by the outline of operations listed in the Feature Order dialog. Click Edit template to open the Feature Order dialog. See turn operation order (see page 1563) for more information.

Automatic Options [TURN]

These attributes are the same as on the Operations tab for Mill, with one additional option in the Automatic Ordering Options dialog, Use template:
Use rules:

Minimize tool changes — This option groups operations together that use the same tool. This saves time for you by eliminating or reducing needless tool changes. You must select this option if you want to generate hole macros in the NC code.

Do finish cuts last — This option moves the finish milling operations to the end of the Setup without altering the order of the finishing operations. If you want to perform all rough milling operations before finish milling operations, select this option.

Cut higher operations first — This option affects only milling Setups. Select this option to mill the features from the top of the stock first and work toward the bottom. If you deselect this attribute, you should carefully graphically verify the toolpath before cutting your part.

Sorting by Z coordinate is controlled by the Cut higher operations first attribute. If you deselect this attribute, graphically verify the toolpath before cutting your part.

Minimize rapid distance — This affects only milling Setups and is the only ordering option that changes the order of features specified in the part view. Minimize Rapid Distance moves to the next closest feature that uses the same tool as the last operation. You must deselect this option if you want to generate hole macros in the NC code.

If you have selected all of the optimization options, the manufacturing order for operations that were derived from different features is determined like this:

1. The operations are sorted by their top Z coordinate.
2. Among operations with the same top Z coordinate, operations are grouped by the tool with which they are cut.
3. After an operation is cut, FeatureCAM moves to the next operation performed with the same tool that is the closest to the current operation.

Use template — This attribute is applicable only to turning Setups. If you select Use template then the order of operations is determined by the outline of operations listed in the Feature Order dialog. Click Edit template to open the Feature Order dialog. See turn operation order (see page 1563) for more information.
Wire default machining attributes [WIRE]

The Machining Attributes dialog for Wire parts has these tabs:
- Wire EDM (see page 1716)
- Settings (see page 1717)
- Offset (see page 1725)
- Start (see page 1730)
- Misc. (see page 1735)
- Operations (see page 1739)
- Posting (see page 1740)

Wire EDM tab [WIRE]

2 axis Die operations — This sets the default operations for a 2-axis Die feature. Select the main operation from the menu. For some operations you can optionally select to add an additional Cutoff and Contour operation.
2 axis Punch/Side operations — This sets the default operations for a 2-axis Punch or Side feature. For some operations you can optionally select to add an additional Cutoff and Contour operation.

4 axis Die operations — This sets the default operations for a 4-axis Die feature. For some operations you can optionally select to add an additional Cutoff and Contour operation.

4 axis Punch/Side operations — This sets the default operations for a 4-axis Punch or Side feature. For some operations you can optionally select to add an additional Cutoff and Contour operation.

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 1468) tab.

Settings tab [WIRE]

Die/Punch primary cut dir

For closed curves, the Primary Cut Dir attribute controls the direction of a cut. The options are CW (clockwise) or CCW (counter-clockwise).

For open curves the Primary Offset Dir attribute controls the direction of a cut. The options are Left or Right. These settings are relative to the machining-side setting.
You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 1468) tab.

Side primary offset dir

For closed curves, the Primary Cut Dir attribute controls the direction of a cut. The options are CW (clockwise) or CCW (counter-clockwise).

For open curves the Primary Offset Dir attribute controls the direction of a cut. The options are Left or Right. These settings are relative to the machining-side setting.

Retract/Cutoff/Stop stop length — This is the distance from the normal contour end position to the inserted stop or end position.

This parameter is used for Retract, Stop, and Cutoff operations.
Retract operation:

- Contour
- Wire path
- Stop length
- Normal contour start/end position
- Inserted end position
- Run-out

Stop operation:

- Contour
- Wire path
- Stop length
- Contour start/end position
- Inserted stop positions

Cutoff operation (CW):

- Contour
- Wire path
- Stop length
- Normal contour start/end position
- Inserted end position
- Run-out

Cutoff operation (CCW):

- Contour
- Wire path
- Stop length
- Normal contour start/end position
- Inserted end position
- Run-out

You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 1468) tab.

Stop Code — For stop operations you can choose from:
- M00 is program stop. This stop is always performed.
- **M01** is optional program stop. There is a setting on the machine tool to observe or skip these stops.

**Retract/Cutoff retract length** — This is the distance that the wire retracts from the part at the end of an operation.

The **Retract Length** attribute is used for **Retract**, **Stop**, and **Cutoff** operations.

![Diagram](image)

**Use on both ends of skim passes** — Enable this option to apply the **Retract length** to both ends of skim passes. (The wire does not return to the start point at one end.)

The following example shows a retract and cutoff operation using the default behavior (**Use on both ends of skim passes** disabled):

1. End of retract pass 1, wire retracts by the **Retract Length**:

![Diagram](image)

2. End of retract pass 2, wire retracts back to the start point:

![Diagram](image)

3. End of retract pass 3, wire retracts by the **Retract Length**:

![Diagram](image)

4. End of cutoff pass 1, wire retracts back to the start point:

![Diagram](image)

5. End of cutoff pass 2, wire retracts by the **Retract Length**:
This is the same example with **Use on both ends of skim passes** enabled:

1. End of retract pass 1, wire retracts by the **Retract Length**:

2. End of retract pass 2, wire retracts by the **Retract Length**:

3. End of retract pass 3, wire retracts by the **Retract Length**:

4. End of cutoff pass 1, wire retracts by the **Retract Length**:

5. End of cutoff pass 2, wire retracts by the **Retract Length**:

**Retract/Cutoff overlap** — This is the distance by which the normal contour end position is overcut.

Stop operation:
The run-off back to the end position of the contour is at an angle. On some machines (for example, Agie), an angled run-off may not be allowable.

If the overlap is too large, a triangular piece of material is left, which may fall and halt the machine.

Contour overlap — This is used only by the Contour operation. It is the amount by which the Contour operation overlaps.

2 axis Pocket/Zigzag total stock
This parameter sets the amount of material removed from the contour when using the **Offset Method** of **Offset Toolpath**. When the value is **0**, only one cutting pass is made.

*The calculated wire path represents the center of the wire; the amount remaining on the curve is dependent on the cutter compensation values.*

1 - Leave allowance
2 - Contour stock
3 - Total stock

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Strategy** (see page 1468) tab.

**Stepover** — This is the default stepover for Pocketing or Zigzag operations. Specify this default attribute as a percentage of the wire diameter.

2 axis Pocket/Zigzag finish allowance — This is the amount of material left after a Zigzag pass. Even if a **Cleanup Pass** is used, the finish allowance still remains.

2 axis Zigzag cut angle — This sets the cutting angle for a Zigzag operation.

The angle is defined from the X-positive axis of the current UCS. Enter the angle in degrees.
You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Strategy (see page 1468) tab.

Cleanup Pass — Enable this option to create a finishing cut at the end of a Zigzag operation.

The contour is cut with a contour parallel finishing path to remove any rough edges left by the stepover between passes.

1 - Cleanup Pass

4 axis/Rapid toolpath linear approx — In 4-axis wire EDM, all arcs are converted into small line segments. This attribute controls how finely arcs are refined into lines. The smaller the number, the more points arcs are broken down into.

This attribute is called Total Stock at feature-level on the Strategy (see page 1468) tab

Keep wire vertical at retract — This keeps the wire vertical after Retract and Cutoff operations for 4-axis features.

The following example shows the end of a Retract operation with Keep wire vertical at retract selected:
This is the same example with Keep wire vertical at retract deselected:

You can override many of these default attributes at feature level on the Strategy (see page 1468) tab.

**Offset tab [WIRE]**

**Offset method** (see page 1479) — This controls whether the offsetting of the wire path is performed on the machine using cutter compensation or by FeatureCAM. Select Cutter comp to perform the offsetting on the machine, or Offset Toolpath if you want FeatureCAM to perform the offsetting.

**Total passes** — Enter the total number of passes to take to cut the feature. If a feature has a Retract, Stop, or Cutoff operation these operations are each performed Total Passes - Contour Passes. If a feature has a Contour operation, Total Passes must be at least 2.

**Contour passes** — This is the number of passes to take for the Contour operation for a Retract, Stop, or Contour operation.
Uni-directional

Applies to Contour, Stop, Retract, and Cutoff operations that use the Offset Method of Cutter Comp.

For multiple passes, the cutting direction for each following pass is not reversed and all passes take place in the defined direction. At the end of each pass the wire is cut and the machine re-positions to the start point for the next pass.

Uses Macro if available

Applies to Contour, Stop, Retract and Cutoff operations that use the Offset Method of Cutter Comp. Available for 2-axis features only.

This option activates the automatic creation of sub-programs for the machining of operations. You must define the format and output of sub-programs in the post processor. The use of sub-programs is particularly useful when producing chain programs. In this case each machining contour is written to a separate sub-program. The main calling program then contains only the movements required to move to the next start point.

For multiple pass, if the Uni-Directional option is enabled then only a single macro is output containing a single pass.

Total stock — This is the default for the total stock feature attribute.

This parameter sets the amount of material removed from the contour when using the Offset Method of Offset Toolpath. When the value is 0, only one cutting pass is made.

The calculated wire path represents the center of the wire; the amount remaining on the curve is dependent on the cutter compensation values.

- Leave allowance
- Contour stock
- Total stock

Contour stock — This the default for the contour stock attribute.
Contour Stock is the amount of material to leave for the contour operation.

1 - Leave allowance
2 - Contour stock
3 - Total stock

Stepover — This is the default attribute for the stepover feature attribute. This default attribute is specified as a percentage of the wire diameter.

This parameter defines the stepover between passes for Cutoff, Stop, Retract, and Contour operations.

Cut all operations on each curve first — For features with multiple curves, enable this option to do all operations on each curve before moving on to the next curve. If the option is disabled, the first operation is done on all curves, then the next operation, and so on.

Cut the first pass on each curve first — For features with multiple curves, select this option to cut all the passes for one curve before moving on to the next curve.

For features with multiple curves, such as the die below, the default behavior is to cut all the passes for one curve before moving on to the next curve.
1 - curve1  
2 - curve2  
3 - curve3  

If you want to cut the first pass on each curve first, select the **Cut the first pass on each curve first** option: 

This option is for 2-axis only and is available for the following operations: 

- Cutoff  
- Stop  
- Contour only (not, for example, a Stop plus Contour combination) 

For the example above with Retract and Cutoff operations, the default behavior is to cut the three Retract passes on curve1, then the three Retract passes on curve2, then the three Retract passes on curve3. It then cuts all three Cutoff passes on curve1, then all three Cutoff passes on curve2, then all three Cutoff passes on curve3.
With **Cut the first pass on each curve first** selected for the same example, FeatureCAM cuts the **Retract** operation as before. It then cuts the first **Cutoff** pass on **curve1**, then the first **Cutoff** pass on **curve2**, then the first **Cutoff** pass on **curve3**.

It then cuts the remaining two **Cutoff** passes on each curve.

Because the first **Cutoff** pass of each curve needs the attention of the machinist to remove the core, the advantage of using **Cut the first pass on each curve first** is that the machinist can remove the cores of all the curves together, and the machine can finish cutting the part without intervention.
**Leave allowance** — This is the amount of material to leave after the Retract, Cutoff, Stop, and Contour operations.

1. Leave allowance
2. Contour stock
3. Total stock

A negative *Leave Allowance* acts as an overcut.

**Start tab [WIRE]**
For Die/Punch

Lead length — This is the default distance for the automatically calculated lead move of die or punch features. The initial point of the toolpath by this lead length perpendicular from the start point of the curve. You can change the start point of the toolpath on the Start (see page 1481) tab of the wire feature.

Connect lead to first curve piece’s — This is the position of the default lead on the first curve piece, select either Beginning (default option) or Middle.

This example shows the default Beginning option:

This is the same example with Middle selected:

For circular Die

Use the center as the start/end point — Select this option to use the center of the circle as the start/end point. Deselect this option to use a different location for the start/end point.

Use lead angle (see page 1733) — Select the option and enter the lead angle in degrees. Deselect the option if you do not want to use a lead angle.

2 axis lead style (for non-taper only)

Style — There are several choices for the type of moves for leading in and out of an operation. The default Diameter for lead/retract moves is a percentage of the tool diameter.

Direct — This style moves straight from the start point to the contour.
There are four different ramp styles that arc onto the contour. The ramp styles available are:

- **Teardrop:**
- **Bullet:**
- **Arc:**
- **U-Shape:**

To set a ramp style, select the **Style** from the list and enter a **Diameter for lead moves**.

The same diameter arc is used to ramp off the contour and then the wire returns to the start point.
**Use lead angle example**

This example model has been pre-machined and only the circular areas are left to finish:

Create a Die feature from the four circles, using a Contour strategy with a Direct lead style.

After doing a 3D simulation, you can see that there is unnecessary cutting into the model on circles 1, 2, and 4:

Because the Die feature is made up of four circles, if you change the default **Lead angle** on the **Start** tab of the **Machining Attributes** dialog, from 0 to 90 deg., this changes the lead angle for all four circles:

So now, circle 4 is fine, but there is unnecessary cutting for circles 1, 2, and 3, so changing the lead angle does not help in this situation.
To change the lead angle for each circle individually, deselect the **Use lead angle** option on the **Start** tab of the **Machining Attributes** dialog, and FeatureCAM uses the start points of the curves as they were defined:

You can change the start points of new or existing curves using the **Set start point** option in the **Curve Start/Reverse** (see page 329) dialog:
**Misc. tab [WIRE]**

**Wire Cutting/Threading** — This offers settings to control the output of wire threading or wire cutting commands.

- **Off** — No wire threading or wire cutting commands are output in the NC-program.
- **Both** — The commands to thread the wire and cut the wire are output automatically at the start and end of each operation within the feature.
- **Cut** — The wire cutting command is output at the end of each operation within the feature (but no wire thread command at the start). When viewing the toolpath in centerline simulation, the Cut location is denoted with a small circle.
- **Thread** — The wire threading command is output at the start of each operation within the feature (but no cut wire command at the end). When viewing the toolpath in centerline simulation, the Thread location is shown as a small plus sign.

**Modify outside corners**

A radius is inserted into the wire path at each outside sharp corner. This can be useful for reducing unnecessary movements and for producing cleaner corners.
This example shows the original toolpath:

If **Modify outside corners** is enabled, the toolpath rounds sharp corners, for example:

The size of the outside corner depends on the **Radius** you set, for example:

You can set this attribute for an individual feature in the **Feature Properties** dialog. Feature-level attributes override **Machining Attributes** (see page 1591). See the **Misc.** (see page 1483) tab.

**Modify inside corners**

**Circular**

A circle is inserted in the corners. The center of the circle lies on the corner point.

This example shows the original toolpath of an inside corner:

If **Modify inside corners** is enabled, with an **Inside corner style** of **Circular**, FeatureCAM inserts a circle into sharp inside corners, for example:
The size of the circle depends on the **Radius** you set, for example:

Enter a **Center shift** to offset the center of the circle.
- **Positive Center shift:**
- **No Center shift:**
- **Negative Center shift:**

Select **Auto adjust the radius** to enable FeatureCAM to automatically adjust the radius of the circle according to how sharp each corner is. A 45 degree corner uses a circle of the specified **Radius**. For sharper corners with angles less than 45 degrees, the radius of the circle is increased, for less sharp corners with angles greater than 45 degrees, the radius of the circle is reduced. Deselect **Auto adjust the radius** to always use the specified **Radius**.

**Triangular**

The path follows a triangular shape at an inside corner. Specify the length and width of the triangle.

**Rounded**

The path rounds inside corners. Specify the radius.
You can set this attribute for an individual feature in the Feature Properties dialog. Feature-level attributes override Machining Attributes (see page 1591). See the Misc. (see page 1483) tab.

Modifying both inside and outside corners

Both inside and outside corners are modified as shown below.

Original path curve with inside corner (shown in blue):

Resulting NC output (shown in pink):

Resulting part shape:

Auto round

If Auto round is enabled, arcs are inserted at all sharp corners. This applies only if Cutter comp is enabled and you have a leave allowance or if Cutter comp is not set. If you have enabled Modify outside corners, it does not perform any further rounding on these corners. It rounds inside corners (even if Modify inside corners is enabled) by inserting an arc before and after the circular corner as shown below: The radius of the inserted arcs is equal to the radius of the wire.

Post Vars (see page 1656) dialog
Operations tab [WIRE]

Click the Automatic Options button to open the Automatic Ordering Options dialog:

This dialog contains options suitable for Wire EDM:

- **Do Cutoffs last** — All retracts are done together, then cutoffs, then contours

- **Minimize rapid distance** — This minimizes movement of the wire by moving to the next closest feature after the one it is currently cutting

If the Don't ask at tool path simulation option is deselected, the Ordering dialog is displayed when you start simulation, as a reminder about ordering.
Posting tab [WIRE]

The Posting tab is for 4-axis features only.

By default, FeatureCAM outputs the upper and lower toolpaths at the same planes as the feature is programmed. For example, if the feature is at Z0 and has a depth of 1, then the upper toolpath is at Z0 and the lower toolpath is at Z-1.

Some machines need the output to be at the Z planes of the upper and lower wire guides, so FeatureCAM must project the toolpaths outwards to the location of the guides. For example, if the wire guides are at Z-2 and Z10, we need to project the upper toolpath to Z10 and the lower toolpath to Z-2.

For these machines, select Generate 4 axis toolpath at the wire guide planes and enter the Z planes of the Upper guide and Lower guide.
In the image below, ① is the original lower toolpath, ② is the toolpath at the wire guide plane.

**Machining configurations**

A configuration is a collection of machining attributes. The defaults for values such as for stepovers, ramping, canned cycle use, or operation ordering are all stored as default machining attributes. Default attributes are stored in collections called configurations.
Select **Manufacturing > Machining Configurations** to open the **Machining Configuration** dialog.

This dialog lists all of the available configurations. Configurations are listed with the following icons:

- **File (f)** — Configurations for files that are currently open.
- **Personal (p)** — Configurations that are independent of a particular file and are stored only on your PC.
- **Workgroup (w)** — Configurations that are independent of a particular file and are stored on a network for sharing with colleagues.

Selecting a configuration from the **Available configurations list does not have any affect unless you then select one of the actions below.**

**New** — Click this button to open the **New Configuration** dialog:

Use this dialog to create a new configuration that is independent of any part file.

Enter the name of the new configuration.

Select an existing file to copy and base the new configuration on.

Select the **Configuration type.**
To create a Workgroup configuration, you must first enter a valid network path on the Database (see page 140) tab of the File Options dialog.

Configurations are saved in a file called EZFM_mfg.ini.

If you have several Personal configuration files that you want to share as Workgroup files, you can copy your local EZFM_mfg.ini file to the network location specified on the Database (see page 140) tab in the File Options dialog.

Rename — Click this button to rename a configuration that is independent of a part file.
Copy — Click this button to copy attributes from one configuration to another. Select the configuration you want to copy to in the Available configurations list before clicking the Copy button. You are then prompted for the configuration to copy from.
Delete — Click this button to delete the selected machining configuration. You can remove only configurations that are not associated with an open file. You are not allowed to delete the last configuration that is independent of opened files.
Import — Click this button to import a .cdb configuration file into FeatureCAM.

These attributes are not applied to a file unless they are copied or unless these attributes are used as an initial configuration for a document.

Export — Click this button to export configurations to a .cdb file. A dialog is displayed in which you can select the configurations to export and to specify the name of the file to be exported.
Edit — Select a configuration from the list of Available configurations and then click the Edit button to modify the attributes of the configuration.

To modify the attributes of the current document, it is easier to select Machining attributes from the Manufacturing menu.

Use the Initial configuration list at the bottom of the dialog to specify the configuration to use as the initial configuration for new documents. New documents copy the attributes from this configuration when the document is created.
Tooling

FeatureCAM has extensive tooling databases and automatically selects tools for each manufacturing operation.

Overview of tooling (see page 1744)
Tooling database (see page 1745)
How to import tooling (see page 1830)
How to export tooling (see page 1833)
Assigning tool numbers (see page 1575)
Spindles and tool holders (see page 1841)
Tool life management (see page 1579)

Overview of tooling

For each manufacturing operation created for the features of a part, a tool must be selected from the internal tooling database. This database is broken into separate tool cribs to represent individual collections of tools that your organization might have. The image below shows the structure of the tooling database.

1. Tooling database
2. Tool cribs
3. Tool groups for example drills, taps, or mills
4. Tools

FeatureCAM comes with two different built-in tool cribs. The **Basic** crib is the default crib that contains standardly available tools that most shops own. The **Tools** crib is a large crib containing thousands of tools. This crib is most often used as a source to copy from into custom tool cribs or into the basic tool crib. Only one tool crib is available at a time and all tools are selected for a part from only the current tool crib. Tool cribs contain individual tools and they are classified into tool groups such as drills, end mills, and boring bars. You cannot create new tool groups, but you can create new tools to reflect the specific tools that your shop owns.

Each feature type has rules for tool selection.
Double-click a feature in the graphics window or the Part View panel to display the Feature Properties dialog, then select an operation from the Tree View on the left of the dialog.

On the Tools tab of the Feature Properties dialog, you can:
- see which tool is currently selected to perform the operation; or
- change the tool used to perform the operation.

Tooling database

The tooling database defines the set of tools from which FeatureCAM selects tools to perform manufacturing operations. These tool sets are called cribs. FeatureCAM comes with two standard tool cribs, the Tools tool crib and the Basic tool crib. The Tools tool crib is a comprehensive tool crib that contains more tools than your shop probably owns. The Basic tool crib contains a smaller set of tools such as HSS endmills and standardly available drills. By default FeatureCAM is set to use the Basic tool crib. You should modify the cribs to reflect the tools your shop has. You can create a crib containing tools you commonly use, which can simplify setting up a part for machining.

The name of the active tool crib is displayed on the status bar. To change the current tool crib you are currently using, click the crib name on the status bar. A list of tool cribs is displayed that you can select from.

To create or modify a tool crib, you must have a part file open, then select Manufacturing > Tool Manager from the menu to display the Tool Manager (see page 1745) dialog.

Tool Manager

To display the Tool Manager dialog, select Manufacturing > Tool Manager from the menu.

Use the Tool Manager to view, edit, or add tools to a tool crib. Tools are separated into groups. Tool Group (see page 1751) contains a list of the groups supported by FeatureCAM.
The **Tool Manager** shows only one type of tool at a time. The dialog is arranged so it's convenient to move tools from one crib to another. In general you want to have the **Tools** tool crib selected in **From Crib** and the **basic** or **basicmetric** tool crib selected in **Current Crib**.

**From Crib** — Select the tool crib from which you want to take tool definitions to copy to the tool crib selected in the **Current Crib**.

**Tool Group** — This menu lists tools in related groups, according to the type of manufacturing operation that class of tools typically performs.

**Current Crib** — Select the tool crib into which you copy tools from the crib selected in **From Crib**.

**Sort by** — You can sort the tools by selecting one of the following:

- **Name** — The tool name.
- **Unit** — The tooling unit. All inch tools are grouped together and all mm tools are grouped together.
- **Material** — Sort by the tool material.
- **Diameter** — The diameter of the tool. The units of the tool are ignored.

**Show only** — You can filter which tools are displayed by selecting **Name**, **Unit**, **Material**, or **Diameter** and entering a value.
To limit the tools by name, type in the initial characters of the name.

You cannot use other string wildcards like the "*".

Available Tools — This shows the tools that are in the tool crib selected under From Crib for the selected Tool Group.

Select All — Click the left arrow button to copy all the tools listed under Current Tools to Available Tools. Click the right arrow button to copy all the tools listed under Available Tools to Current Tools.

Add — Copies the selected tool(s) in the Available Tools list to the Current Tools list, thus building a set of tool definitions for the tool crib selected under Current Crib.

Remove — Removes the selected tool(s) from the Current Tools list.

Use the **Shift** and **Ctrl** keys to select more than one tool.

Current Tools — This shows the tools that are already in the Current Crib for the selected Tool Group.

Double-click a tool name under Current Tools to open the Tool Properties (see page 1749, see page 1795) dialog for that tool.

OK — Click the OK button to save your settings and close the dialog.

Cancel — Click the Cancel button to close the dialog without saving any changes.

New Tool — Click this button to create a new tool for the selected Tool Group. Click the New Tool button and the Tool Properties (see page 1749, see page 1795) dialog is displayed for the selected Tool Group.

The Tool Properties dialog is displayed with a copy of the tool selected in the Tool Manager, or if no tool is selected, it uses a copy of the first tool in the Current Tools list.

If the new tool that you want to create is similar to an existing tool, select that tool in the Tool Manager before clicking New Tool and you have fewer attributes to edit.

New Crib — Click this button to create a new tool crib. Click New Crib and the New Tool Crib dialog is displayed. Enter a unique name for your new tool crib. Click OK to create the new, empty, crib. The new crib is selected under Current Crib ready for you to add tools to it.
Delete Crib — Click this button to delete the tool crib selected under Current Crib. FeatureCAM asks you to confirm before deleting the tool crib.

Copy Crib — Click this button to bulk-copy tools by whole Tool Group from one crib to another. Select the destination crib you want to copy into under Current Crib and click the Copy Crib button. The Copy Tool Crib dialog is displayed. Select the Tool crib to be copied, select the Tool Groups that you want to copy and click Copy, then Close.

Tool Grades button - opens the Turning Tools Grades dialog. See Adding a new tool grade for turning operations (see page 1849) for more information.

Import — Click this button to import tools from other FeatureCAM users. Click the Import button to open the Tool Import dialog. Browse to where the import file is saved, select the tool crib you want to import into and select what to do if the tool name already exists.

Export — Click this button to export tools so that you can share them with other FeatureCAM users. Click the Export button to open the Tool Export dialog. Two file types are supported,.xml and .tdb. We recommend that you use the .xml format as it supports exporting custom-drawn holders. Click the browse button and specify the location and File Name for your file, and click OK. Select the Tool crib to be exported and the Tool Groups that you want to export. Click Export and wait for FeatureCAM to confirm how many tools were exported. Click OK to confirm and click Close in the Tool Export dialog to return to the Tool Manager.

Properties — Select a tool in the Current Tools list and click Properties to see more details of the tool. You can also double-click a tool in the Current Tools list to open its Properties dialog.

Tool Parameters — Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to access a context menu.

Center Tool — Select this menu option to center the tool in the preview image.

Center All — Select this menu option to center the tool and tool holder in the preview image.

Redraw Tool — Select this menu option to recreate the preview image after making changes to its attributes.

Show Tool Holder — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

Show Flutes on End Mills — Select this menu option to display a representation of an end mill tool's flutes in the preview image.
2 flutes, right-handed

4 flutes, right-handed

4 flutes, left-handed

Automatic Center Tool — Select this menu option to center the tool automatically when you move the mouse pointer over the image.

Milling Tool Properties dialog

Use the Tool Properties dialog to:

- View a tool’s details.
- Edit a tool’s details.
- Create a new tool.

To display the Tool Properties dialog:

- Double-click the name of a tool on the Tools tab of the Feature Properties dialog (see page 884).
- Select a tool on the Tools tab of the Feature Properties dialog and click Properties.
- Double-click the name of a tool on the Op List tab (see page 1548) of the Results window.
- Select a tool on the Op List tab of the Results window and click Properties.
- Double-click the name of a tool in the Current Tools list in the Tool Manager dialog (see page 1745).
Select a tool from the **Current Tools** list in the **Tool Manager** dialog and click **Properties**.

The **Tool Properties** dialog has four tabs for milling tools.

- **Tool Group** (see page 1751)
- **Overrides** (see page 1785) — Use this tab to set the tool number, cutter comp register and offset register for the tool. These settings are used for this tool whenever it is used to cut a part.
- **Coolant** (see page 1788)
- **Holder** (see page 1789)
- **Feed/Speed** (see page 1791) — Use this tab to set speed and feed overrides for a particular tool. Whenever this tool is used, the feed and speed values are scaled by this percentage value.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog.
**Tool Group tab**

The first tab of the Milling **Tool Properties** dialog (see page 1749) has the name of the tool group that the tool belongs to.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to display the context menu.

- **Center Tool** — Select this menu option to center the tool in the preview image.
- **Center All** — Select this menu option to center the tool and tool holder in the preview image.
- **Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
- **Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.
- **Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.
These tool groups are available for milling:

- **Backbore** (see page 1753)
- **Boring Bar** (see page 1754)
- **Chamfer Mill** (see page 1755)
- **Counterbore** (see page 1757)
- **Countersink** (see page 1758)
- **End Mill** (see page 1760)
- **Face Mill** (see page 1762)
- **Plunge Mill** (see page 1766)
- **Probe** (see page 1767)
- **Ream** (see page 1769)
- **Rounding Mill** (see page 1770)
- **Side Mill** (see page 1773)
- **Spot and Center Drill** (see page 1774)
- **Tap** (see page 1776)
- **Thread Mill** (see page 1779)
- **Twist Drill** (see page 1780)
**Backbore** tools are used for drilling Backbore Hole features.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram.

**Cutter Length** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Shank Diameter** — See diagram.

**Tip Radius** — See diagram.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

**Hand** — Set whether the tool is **Right**-handed or **Left**-handed.
Boring Bar tools are used in milling for the boring operation of a Hole feature or for a step of a Step Bore feature.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.
Tip Radius — See diagram.

Material — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

Hand — Set whether the tool is Right-handed or Left-handed.

The Tip Radius is taken into account only for step bores. FeatureCAM assumes that you have an adjustable boring bar. For boring operations, if there is not an appropriate tool in the tool crib FeatureCAM creates a tool with the name user_adjust....

Chamfer Mill

Chamfer Mill tools are used for chamfer features or for chamfering large diameter holes.

Name — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.
**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Inner Diameter** — See diagram.

**Outer Diameter** — See diagram.

**Shank Diameter** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

**Hand** — Set whether the tool is **Right**-handed or **Left**-handed.
Counterbore tools are used for the counterbore operations of counter bored holes.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Shank Diameter** — See diagram.

**Pilot Diameter** — See diagram.

**Pilot Length** — See diagram.

**Flutes** — Enter the number of grooves on the tool.

**Touch off at the shoulder** — Select this check box to position the tool z-zero at the end of the flutes (the tool shoulder). Deselect the check box to position the tool z-zero at the end of the pilot (the tool tip).

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).
**Tool Finish** — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a **Bright** finish, but not for **TI_N** or **Black Oxide** tool finishes, then the speed values are derived from the **Bright** table. The speed for **TI_N** is 1.5 times the **BRIGHT** speed. The speed for **BLACK_OXIDE** is 1.05 times the **BRIGHT** speed. The feed rates are the same as the **BRIGHT** feed rates.

**Hand** — Set whether the tool is **Right**-handed or **Left**-handed.

**Countersink**

**Countersink** tools are used for counter sink operations on holes.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.
**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Body Diameter** — See diagram.

**Flat Diameter** — Countersink tools can optionally have a flat end. See diagram.

**Shank Diameter** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Angle** — See diagram.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

**Tool Finish** — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a **Bright** finish, but not for **TI_N** or **Black Oxide** tool finishes, then the speed values are derived from the **Bright table**. The speed for TI_N is 1.5 times the BRIGHT speed. The speed for BLACK_OXIDE is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

**Hand** — Set whether the tool is **Right**-handed or **Left**-handed.

See also Hole: Tool Selection (see page 649).
End Mill tools are used to represent flat end mills, ball end mills, bull-nose mills, and tapered end mills.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Cutter Length** — See diagram.

**Shank Diameter** — See diagram.

**End Radius** — See diagram.

**Use curve to describe tool shape** — Select this option to create a form tool. Select a curve in the **Curve** list to define the profile of the tool.

**Taper** — See diagram.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

**Hand** — Set whether the tool is **Right**-handed or **Left**-handed.
For ball end tools, enter the diameter, select **Ball-end** and the radius is calculated.

For flat end tapered tools there are three different ways to specify the taper angle, cutter length and diameters:

- Enter the **Taper angle**, **Diameter** (which is the diameter of the tool at the top of the taper) and the **Cutter length**.

- Enter the **Taper angle**, select **Diameter at Bottom**, enter the **Bottom diameter** and enter the **Cutter length**.

- Enter the **Taper angle**, select **Diameter at Bottom**, enter the **Diameter** (which is the diameter at the bottom of the taper) and click the **Compute from shank** button to have the **Cutter Length** computed for you.
Face Mill tools are used for facing features.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram. If you selected Chamfer as the corner type, ensure that the **Height** is >= \((\text{Diameter} - \text{Effective diameter})/2\).

**Corner** — Select either **Round** or **Chamfer** \((45°)\) as the corner type.

💡 You can use a Face Mill with a Chamfer to cut a Chamfer feature to reduce the number of tools used to cut a part.

This example part has a Face and Chamfer features on the top and on the side:
By default, this part uses three tools:

- a Face Mill to cut the top Face, then indexed around to cut the side Face.
- a Chamfer tool to cut the Chamfer around the top Face
- a Chamfer tool to cut the Chamfer around the side Face

Instead of the default Face Mill, you can create a new Face Mill with a Chamfer, for example:

Set this new tool as the override for the Face feature, and then use it to cut the Chamfer features, by overriding the default tools in the Op List.
After simulating the part again, you can see that the new Face Mill tool cuts both the Face features and the Chamfers:

In this example, the chamfered Face Mill tool is too large to cut the Chamfer on the side of the part:

FeatureCAM give a warning and you can change the tool for this Chamfer back to the default tool.

Using a chamfered Face Mill tool, you can cut this particular part with two tools instead of three:
• a chamfered Face Mill to cut the top Face, the top Chamfer, then indexed around to cut the side Face

• a Chamfer tool to cut the Chamfer around the side Face

Effective diameter — See diagram. If you selected Chamfer as the corner type, enter an Effective diameter greater than 0. The Effective diameter must not be less than Diameter - 2*Height and must not be greater than Diameter.

Corner Radius — See diagram.

Exposed length — This is the amount of the tool that sticks out of the holder if the holder is simulated.

Material — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

Hand — Set whether the tool is Right-handed or Left-handed.

Round

Chamfer

1. Height
2. Diameter
3. Corner Radius
4. Effective Diameter
**Plunge Mill** tools are used in plunge roughing operations.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram.

**Cutter Length** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Shank Diameter** — See diagram.

**Insert Tip Radius** — See diagram.

**Insert Length** — This parameter is for tooling documentation only. It is not used for toolpath generation.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).
**Tool Finish** — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a Bright finish, but not for Ti_N or Black Oxide tool finishes, then the speed values are derived from the Bright table. The speed for Ti_N is 1.5 times the BRIGHT speed. The speed for BLACK_OXIDE is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

**Hand** — Set whether the tool is Right-handed or Left-handed.

**Probe**

**Diagram of Tool Finish:***

- Tool Finish
- Bright finish
- Ti_N finish
- Black Oxide finish

**Diagram of Probe:***

- Ball Diameter
- Stem Diameter
- Overall Length
- Shank Length
- Lower Shank Diameter
- Upper Shank Diameter
- Taper Length
**Taper Shank** — Deselect this option to have a shank with a constant diameter and enter the **Shank Diameter** instead of **Lower Shank Diameter** and **Upper Shank Diameter**.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.
Ream tools are used for reaming operations on holes.

Name — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

Measure — This indicates the units that are used for reporting the tool’s dimensions. Select Inches for inch units or deselect it for millimeters.

Diameter — See diagram.

Cutter Length — See diagram.

Overall Length — See diagram.

Exposed length — This is the amount of the tool that sticks out of the holder if the holder is simulated.

Shank diameter — See diagram.

Drill diameter — Enter the default diameter of all drill and bore tools used in the feature. This value should not be larger than the Diameter value of the tool, as this causes the drill tool to be larger than the ream tool, which may compromise the accuracy of the feature.

If Calculated is selected, the Drill diameter is calculated from the Drill % of ream/bore attribute on the Tool Selection tab (see page 1676) of the Machining Attributes dialog.

Material — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).
**Tool Finish** — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a **Bright** finish, but not for **TI_N** or **Black Oxide** tool finishes, then the speed values are derived from the **Bright table**. The speed for **TI_N** is 1.5 times the BRIGHT speed. The speed for **BLACK_OXIDE** is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

**Hand** — Set whether the tool is **Right**-handed or **Left**-handed.

**Rounding Mill** tools are used for Round features.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.
**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Inner diameter** — See diagram.

**Outer diameter** — See diagram.

**Shank diameter** — See diagram.

**Radius** — See diagram.

**Overall length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

*When Touch off at the shoulder is selected, the Exposed length value does not include the tip. When it is deselected, the Exposed length value includes the tip length.*

**Tip-To-Shoulder Length** — Enter the length between the shoulder and the tip of the tool. This length is the same as the arc **Radius** by default, but you can increase it.

**Touch off at the shoulder** — Rounding Mill tools touch off at the shoulder by default. Deselect this option to move the touch-off point to the tip of the tool.

1. This example shows the default behavior with **Touch off at the shoulder** selected. The toolpath is at the top of the Round feature.

2. This example shows **Touch off at the shoulder** deselected. The tool touches off at the tip. The toolpath is at the bottom of the Round feature.

3. This example shows **Touch off at the shoulder** deselected and a **Tip-To-Shoulder Length** that is double the **Radius** value. The tool touches off at the tip. The toolpath is below the bottom of the Round feature.

*When Touch off at the shoulder is selected, the Exposed length value does not include the tip. When it is deselected, the Exposed length value includes the tip length.*
Material — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

Hand — Set whether the tool is Right-handed or Left-handed.

- Inner Diameter
- Outer Diameter
- Shank Diameter
- Radius
- Exposed length when Touch off at the shoulder is selected.
- Exposed length when Touch off at the shoulder is deselected.
- Tip-To-Shoulder Length
Side Mill tools are used for OD and ID grooves.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Slitting Saw** — This parameter is used only as documentation on the tool.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram.

**Cutter Width** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Shank Diameter** — See diagram.

**Neck Diameter** — See diagram.

**Arbor Tip Length** — See diagram.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).
**Tool Finish** — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a **Bright** finish, but not for **Ti_N** or **Black Oxide** tool finishes, then the speed values are derived from the **Bright table**. The speed for **Ti_N** is 1.5 times the **BRIGHT** speed. The speed for **BLACK_OXIDE** is 1.05 times the **BRIGHT** speed. The feed rates are the same as the **BRIGHT** feed rates.

**Hand** — Set whether the tool is **Right-handed** or **Left-handed**.

![Diagram of tool dimensions](image)

**Spot & Center Drills**
Spot Drills are used for spot drilling starter holes.

*Center Drills are preferred for spot drill operations.*

Center Drills are used to drill starter holes. They are preferred over spot drills for spot drilling operations. Spot Drills can also be used for spot drill operations.

Name — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

Type — Select Center or Spot.

Measure — This indicates the units that are used for reporting the tool’s dimensions. Select Inches for inch units or deselect it for millimeters.

Diameter — See diagrams.

Body Diameter — See diagrams.

Overall Length — See diagrams.

Exposed length — This is the amount of the tool that sticks out of the holder if the holder is simulated.

Tip Angle — See diagrams.

Material — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

Tool Finish — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a Bright finish, but not for Ti_N or Black Oxide tool finishes, then the speed values are derived from the Bright table. The speed for Ti_N is 1.5 times the BRIGHT speed. The speed for BLACK_OXIDE is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

Hand — Set whether the tool is Right-handed or Left-handed.

Spot drill diagram:

1. Diameter
2. Overall Length
3. Tip Angle
4. Cutter Length

Center drill diagram:
**Tap** tools are used to tap holes.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Diameter** — See diagram.

**Length** — See diagram.

**Overall Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**TPI/Pitch** — For inch tools, you specify the threads per inch (TPI), and for metric tools, you specify the **Pitch** of the threads.
**Drill Diameter** — If this is set, that tap always uses a twist drill of that diameter. If you select **Calculate**, the drill is calculated using the product's formulas. FeatureCAM uses one of two formulas for calculating Drill Diameter. One formula is used for Cutting, Helicoil, and user-defined tap types. The other formula is used for Rolled types. You can control these two formulas by using the **Thread % for tap drill (cut)** and **Thread % for tap drill (rolled)** attributes on the **Tool Selection** (see page 1676) tab of Machining Attributes.

If no **Drill Diameter** is set for helicoil or user-defined tap types, then the cutting tap formula is used to calculate the drill diameter.

**Taper** — If you want a tapered tap, enter the angle in degrees. Holes with tapered threads automatically select tapping tools with the same taper angle.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

**Tool Finish** — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a **Bright** finish, but not for **Ti_N** or **Black Oxide** tool finishes, then the speed values are derived from the **Bright table**. The speed for Ti_N is 1.5 times the BRIGHT speed. The speed for BLACK_OXIDE is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

**Point** — **Bottom** taps have a flat bottom, and **Plug** taps come to a point. If a bottom tap is required for a blind hole, a warning is issued in the operations sheet. Regardless of the type of tool used for tapping, the hole must allow enough clearance for the tap. If the hole breaks this rule, an error message is generated when you enter the hole dimensions.

**Style** — **Spiral**-style taps have twisted flutes while **Gun**-style taps have straight flutes.

**Limit** — This attribute is ignored for tool selection. It is used only to document the tool.

**Type** — A tapped hole is classified by its **Type**. When selecting taps, FeatureCAM searches for a tapping tool that matches the **Type** of the threaded hole.
**Cutting** — These tools cut the threads into the material. The diameter of the drilling operation is typically calculated.

**Rolled** — These tools press or form the threads into the material. The diameter of the drill operation for rolled (or formed) taps is typically larger than for cutting taps and is typically calculated using a formula.

**Helicoil** — These operations are performed within a cutting-style taps, but the size of the drill and tap operations are larger to fit the helicoil insert. For these holes, specify the TPI and Diameter of the helicoil that you want to insert and FeatureCAM selects the appropriate drill size and helicoil tap.

**Add New** — New types can be created when a tapping tool is defined. Any new tapping tool type is displayed as a potential hole tap type. Automatic tool selection is limited to looking for tools of this new type.

**Hand** — Set whether the tool is **Right**-handed or **Left**-handed.

![Diagram of a tool with labels for Diameter, Length, and Overall Length.](image)
Thread Mill tools are used for OD and ID thread milling operations.

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Pitch** — See diagram.

**Shank Diameter** — See diagram.

**Cutter Length** — See diagram.

**Body Length** — See diagram.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Material** — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

**Tool Finish** — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a **Bright** finish, but not for **TI_N** or **Black Oxide** tool finishes, then the speed values are derived from the **Bright table**. The speed for **TI_N** is 1.5 times the BRIGHT speed. The speed for **BLACK_OXIDE** is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.
Hand — Set whether the tool is Right-handed or Left-handed.

Pitch
Shank Diameter
Cutter Length
Body Length

For single point tools, set Max Pitch equal to Cutter Length.

Hand — Select whether the tool is a Right Hand or Left Hand tool

Twist Drill

Twist Drill tools are used for drilling operations.

When drilling with a standard twist-drill, extra depth is added to the operation to account for the drill tip geometry. When a form tool (see page 1782) or insert drill is used for drilling, no extra depth is added automatically. You can use the Drill depth (see page 900) attribute to manually add extra depth if required.

Name — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.
Measure — This indicates the units that are used for reporting the tool’s dimensions. Select Inches for inch units or deselect it for millimeters.

Diameter — See diagram.

Overall Length — See diagram.

Exposed length — This is the amount of the tool that sticks out of the holder if the holder is simulated.

Shank Diameter — See diagram.

Angle — See diagram.

Class — For insert drills, select Insert and enter the Insert Depth instead of the Angle. Insert drills do not usually require a spot drill operation, so to remove the spot drill operation by default when using this tool, deselect Spot drill on the Overrides tab. Selecting this option does not affect the drill depth (see page 648) or automatic tool selection (see page 649).

Use curve to describe tool shape — Select this option to create a form tool. Select a curve in the Curve list to define the profile of the tool.

Material — This indicates what the tool is made of. This information is important when calculating the feeds and speeds (see page 1508).

Tool Finish — This is the coating, or finish, on the tool. This information is also used in feed/speed calculations. If a feed/speed table exists for a material cut with a tool with a Bright finish, but not for Ti_N or Black Oxide tool finishes, then the speed values are derived from the Bright table. The speed for Ti_N is 1.5 times the BRIGHT speed. The speed for BLACK_OXIDE is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

Hand — Set whether the tool is Right-handed or Left-handed.
Form tools

The FeatureCAM tool cribs contain thousands of industry-standard tools in a wide variety of types. Custom-shaped form tools are not included in the default tool cribs, but you can create these tools and use them to cut features.

Examples of form tools:

Concave cutter  Tripan cutter  Port-entrance tool

Using these tools does not change the toolpaths generated for features, but the 3D simulation does simulate the proper shape of form tools. Form tools are never automatically selected, but you can select them manually.

Form tools have unique shapes, but their type must be endmill, twistdrill, or sidemill. If you want to use the form tool to perform a milling operation it must be an endmill form tool. Drilling operations can be performed with endmill form tools or twistdrill form tools. OD/ID grooves can be performed only with sidemill form tools.

Creating a form tool

To create a form tool:

1. Create a curve in the graphics window that you want to be used as the 2D turned profile of the tool. There are some requirements which the curve must meet.

2. The curve must lie in the XZ plane of the Stock axis.

3. One endpoint of the curve must be on the origin (0,0,0) of the stock axis and the other must lie on the Z-axis.
You can display the profile of an existing tool (see page 1783) in the graphics window to help you create this curve.

1. In the **Tool Manager** (see page 1745) dialog or on the **Tools** tab of the **Feature Properties** dialog, select either an endmill, sidemill, or twistdrill tool.

2. To create a new tool:
   - click **New tool** in the **Tool Manager** (see page 1745) dialog; or
   - click **New tool** on the **Tools** tab of the **Feature Properties** dialog.

3. Select **Use curve to describe tool shape** in the **Tool Properties** dialog.

4. Select the curve you created from the **Select curve** list.

5. Click **OK** to close the **Tool Properties** dialog.

*When you use a curve to define the shape of a tool, many of the dimensions in the **Tool Properties** dialog are not used, but the **Diameter** is still used for calculating stepovers and generating the paths.*

**Displaying a profile of an existing tool**

You can display the profile of an existing tool in the graphics window to use as a reference when creating a curve for a form tool.

To display the profile of a tool in the graphics window:

1. Double-click a tool on the **Tools** tab of the **Feature Properties** dialog (see page 903) to display the **Tool Properties** dialog.

2. Click **Paste copy of curve** in the **Tool Properties** dialog.
Click **Cancel** to close the **Tool Properties** dialog without making any changes to the tool.

**Using a form tool or insert drill for drilling operations**

When drilling with a standard twist-drill, extra depth is added to the operation to account for the drill tip geometry. When a form tool or insert drill is used for drilling, no extra depth is added automatically. You can use the **Drill depth** (see page 900) attribute to manually add extra depth if required.

**Using an insert drill for drilling and boring**

To use an insert drill for drilling and boring:

1. Create the drilling and boring operations.
2. Override the tool for the drilling operation to use an insert drill.
3. Override the tooling for the boring operations to use the same insert drill.

In the **Tool Mapping** dialog, the insert drill is listed twice. Each listing has the same tool slot, but the **Length offset** registers are different.

See also:

- How to put two tools in the same tool slot (see page 1582)

**Changing the Tool number and Cutter comp**

On the **Overrides** tab of the **Tool Properties** (see page 1749) dialog, the tool slot number and cutter comp offset register are displayed in the **Tool number** and **Diameter offset register** fields.

1. If the **Diameter offset register** field is unavailable, deselect **Same**.
2. Enter the new values in the **Tool number** and **Diameter offset register** fields.
3. Click **OK** to close the **Tool Properties** dialog.
Overrides tab

Use the **Overrides** tab of the Milling **Tool Properties** dialog (see page 1749) to set the tool number, cutter comp register, and offset register for the selected tool.

![End Mill Tool Properties dialog](image)

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to display the context menu.

- **Center Tool** — Select this menu option to center the tool in the preview image.
- **Center All** — Select this menu option to center the tool and tool holder in the preview image.
- **Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
- **Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.
- **Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.
Automatic Center Tool — Select this menu option to center the tool automatically when you move the mouse pointer over the image.

Name — Specifies the name of the current tool. You can edit the Name of the tool on the Tool Group (see page 1751) tab.

Only set turret 1 — Select this option to set the tool registers for only one turret.

Set all turrets — Select this option to set the tool registers for each turret of a multi-turret machine. Select an entry in the Turret and spindle list to choose the turret you want to work with.

The turret options are only displayed when the Turning component (see page 10) of FeatureCAM is activated. The turrets you can select are determined by the current post file.

Default tool registers — Specify the register settings for the tool:

- **Tool number** — Specifies the slot number for the tool. Enter 0 to allow FeatureCAM to assign a value when the tool is used.

Tools can occupy the same tool slot (see page 1582).
• **Same** — Select this check box to use the Tool number value for all the registers. Deselect the check box to set the registers individually.

• **Diameter offset register** — Specifies the diameter cutter compensation offset register number for the tool. This value is passed to XBUILD as `<COMP-NUM>`.

• **Length offset register** — Specifies the tool length offset register number. Most lathe controllers have a single register that contains the length and diameter offset values. In this case, the Length offset register is the important field to set in FeatureCAM. This value is passed to XBUILD as `<OFFSET#>`.

• **Tool ID** — Specifies the identification number of the tool. This is used by Bridgeport lathes and some Cincinnati machines.

  To override the register values for individual parts, use the Tool Mapping (see page 1575) dialog.

**Operations** — Select an entry in the list to specify the type of operation for which FeatureCAM can select this tool. You can override this setting by selecting the tool manually (see page 981).

**Cycle** — Select the type of drilling cycle to be used with the tool.

**Spotdrill** — This enables the spotdrill operation for insert drill tools. This is useful for high-speed drilling.

**Depth of cut** (see page 1023) — Select the check box and enter a value to specify a depth of cut (Z-step increment) override for the tool.

**Stepover** — Select the check box and enter a value to specify the stepover distance override for the tool.

**RampAngle** — Select the check box and enter an angle to specify a ramp angle override for the tool.

**Comments** — Enter any comments for the tool. The post can be configured to output these comments.
Coolant tab

Use the **Coolant** tab of the **Tool Properties** dialog to specify the default coolants to use for an operation when this tool is used.

Select the coolant types you want to use. The available coolant types are specified in the CNC file.

Deselect **Override** to use the default coolant types set in the **Coolant** tab of the **Machining Attributes** dialog.

You can override the coolant types for each operation using the **Coolant** tab of the **Feature Properties** dialog.
**Holder tab**

Use the **Holder** tab of the Milling **Tool Properties** dialog (see page 1749) to change or edit the Tool Holder for the selected tool.

![End Mill Tool Properties dialog](image)

The **Holder** tab enables you to see the tool holder that has been automatically selected for the tool and to permanently assign a holder to the tool.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to display the context menu.

- **Center Tool** — Select this menu option to center the tool in the preview image.
- **Center All** — Select this menu option to center the tool and tool holder in the preview image.
- **Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
- **Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.
- **Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.
**Automatic Center Tool** — Select this menu option to center the tool automatically when you move the mouse pointer over the image.

**Tool name** — This displays the name of the tool.

**Current spindle** — This displays the spindle type that matches the current holder.

Tool holders are shown in the table at the bottom of the dialog.

Select **Only show holders that match the current spindle** to hide holders that do not fit in the current spindle. Select **Show all holders** to show them all.

The holder that was selected automatically for the tool is shown with a D in the check box. To explicitly select a holder to use with this tool any time the tool is used, select the check-box next to the tool name. To remove an association of the tool with a holder, click the **Undo holder override** button.

**Create new toolholder** — Click this button to open the **Tool Holder Properties** (see page 1843) dialog, where you can create a new tool holder for the current spindle. The dimensions of the current tool holder are used as initial dimensions.
**Edit toolholder definition** — Click this button to open the Tool Holder Properties (see page 1843) dialog, where you can edit the properties of the selected toolholder.

**Feed/Speed tab**

Use the Feed/Speed tab of the Milling Tool Properties dialog (see page 1749) to specify Feed and Speed overrides for the selected tool.

This tab is where you override the feed and speed values if you want to always use specific speed and feed values for this tool, or this tool with a specific material.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to display the context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.

**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.
**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool’s flutes in the preview image.

- 2 flutes, right-handed
- 4 flutes, right-handed
- 4 flutes, left-handed

**Automatic Center Tool** — Select this menu option to center the tool automatically when you move the mouse pointer over the image.

**Name** — Specifies the name of the current tool.

*You can edit the Name of the tool on the Tool Group (see page 1751) tab.*

The table displays any overrides that have been set for this tool with specific materials.

**Material** is the list of materials that you choose to override the feed and speed values for.

**% Speed override** is the percentage to adjust the speed value whenever this tool is used; 100% means that the values chosen by FeatureCAM or overridden by the user are not scaled.

**% Feed override** is the percentage to adjust the feed rate whenever this tool is used; 100% means that the values chosen by FeatureCAM or overridden by the user are not scaled.
Create new item — Click this button to open the Tool Specific Feeds and Speeds (see page 1793) dialog, where you can add a new Material and its corresponding feed and speed values to use with this specific tool.

Properties — Click this button to open the Tool Specific Feeds and Speeds (see page 1793) dialog for the selected material, where you can edit the material’s feed and speed values to use with this specific tool.

Delete item — Click this button to remove the selected material.

You can override the depth of cut (see page 1023) value in several places.

Tool Specific Feeds and Speeds dialog

Name — Specifies the name of the current tool.

You can edit the Name of the tool on the Tool Group (see page 1751) tab.

To add a material:

1. Select the Material from the list.
2. Change any Feed, Speed, Depth (of cut), and Stepover values and click OK.
The material is added to the table on the **Feed/Speed** (see page 1791) tab.

**To edit values for a material:**

1. Ensure that the **Material** is the one that you want to edit the values of.
2. Change any **Feed**, **Speed**, **Depth**, and **Stepover** values and click **OK**.

The material is updated with the new values in the table on the **Feed/Speed** (see page 1791) tab.

**Pecking tab**

You can use the **Pecking** tab to override the Pecking depths for individual tools. The global pecking depth values are specified on the **Pecking** tab of the **Machining Attributes** dialog.

![Pecking tab](image)

Pecking applies to Deep Hole, Chip Break, and Tap operations. FeatureCAM supports four styles of pecking. These styles are listed in the post processor. Three different attributes control the pecking and they are used differently depending on the style of pecking. FeatureCAM checks the pecking type in the currently loaded post processor to duplicate canned cycles when simulating toolpaths. Set these attributes separately for **Drilling** and **Tapping** operations:
- **First peck** — This is the depth of the first peck of a drilling/tapping operation specified as a percentage of tool diameter. If the depth of the hole is less than First peck, the hole is drilled in a single peck.

- **Second peck** — This is the depth of the second peck of a drilling/tapping operation specified as a percentage of tool diameter. The post handles the conversion.

- **Minimum peck** — This is the minimum step size for a peck used for value reduction pecking methods or factor reduction pecking methods.

For each attribute, leave the value as 0% to use the global setting, or enter a new value to override the global setting.

For example, if the tool diameter is 1", and the tool's **First peck** depth is 80% of the tool diameter, the operation's **First peck** depth is 0.8", regardless of the global **First peck** depth specified in the Machining Attributes dialog.

**Turning Tool Properties dialog**

Use the **Tool Properties** dialog to:

- View a tool's details.
- Edit a tool's details.
- Create a new tool.

To display the **Tool Properties** dialog:

- Double-click the name of a tool on the **Tools** tab of the **Feature Properties** dialog (see page 884).
- Select a tool on the **Tools** tab of the **Feature Properties** dialog and click **Properties**.
- Double-click the name of a tool on the **Op List** tab (see page 1548) of the **Results** window.
- Select a tool on the **Op List** tab of the **Results** window and click **Properties**.
- Double-click the name of a tool in the **Current Tools** list in the **Tool Manager** dialog (see page 1745).
- Select a tool from the **Current Tools** list in the **Tool Manager** dialog and click **Properties**.

The **Tool Properties** dialog has these tabs for turning tools:

**Insert/Type** (see page 1796)  
**Holder Drawing** (see page 1817)  
**Holder** (see page 1803)  
**Overrides** (see page 1826)  
**Orientation** (see page 1813)  
**Coolant** (see page 1788)  
**Prog. Pt.** (see page 1815)  
**Feed/Speed** (see page 1828)

**Insert/Type tab**

For most turning tools, the first tab in the **Tool Properties** dialog (see page 1749, see page 1795) is the **Insert** tab.
The parameters on the **Insert** tab are different depending on the turning tool type:

- **Lathe - Turning** (see page 1797)
- **Lathe - Boring** (see page 1797)
- **Lathe - Groove/Cutoff** (see page 1799)
- **Lathe - Thread** (see page 1801)
- **Lathe - Bar Feed** (see page 1802)

For **Bar Feed** tools, the first tab in the **Tool Properties** dialog is the **Type** tab.

**Turn, Bore**

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

- **Center Tool** — Select this menu option to center the tool in the preview image.
- **Center All** — Select this menu option to center the tool and tool holder in the preview image.
- **Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

- 2 flutes, right-handed
- 4 flutes, right-handed
- 4 flutes, left-handed

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Insert Shape** — Select the insert shape. For the Cust. diamond shape, you must enter the **Tip Angle**.

- 80 Diamond:
- Square:
- Triangle:
- 35 Diamond:
- 55 Diamond:
- Round:
- 80 Trigon:
- Cust. Diamond:

**Tip Radius** is the radius of the cutting tip of the insert.

*For threading tools, 3D simulation simulates the tool with a tip radius of 0.0. This is just for visualization purposes only. The NC code or tool selection is not affected in any way.*

**Tip Angle** is the included angle of the insert.
**Inscribe Circle Diam** is the diameter of a circle that fits inside the insert shape.

1. Tip radius
2. Tip angle
3. Inscribe circle diam.

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Groove/Cutoff**

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

- 2 flutes, right-handed
- 4 flutes, right-handed
- 4 flutes, left-handed

**Name** — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

**Tip Radius** is the radius of the cutting tip of the insert.

*For threading tools, 3D simulation simulates the tool with a tip radius of 0.0. This is just for visualization purposes only. The NC code or tool selection is not affected in any way.*

**Tip Angle** is the included angle of the insert.

**Width** is the width along the Z axis of a grooving/cutoff tool.

**Cutgrip grooving tool**

**Measure** — This indicates the units that are used for reporting the tool’s dimensions. Select **Inches** for inch units or deselect it for millimeters.
Thread

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to access a context menu.

Center Tool — Select this menu option to center the tool in the preview image.

Center All — Select this menu option to center the tool and tool holder in the preview image.

Redraw Tool — Select this menu option to recreate the preview image after making changes to its attributes.

Show Tool Holder — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

Show Flutes on End Mills — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

2 flutes, right-handed

4 flutes, right-handed

4 flutes, left-handed

Name — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.
**Tip Radius** is the radius of the cutting tip of the insert.

For threading tools, 3D simulation simulates the tool with a tip radius of 0.0. This is just for visualization purposes only. The NC code or tool selection is not affected in any way.

**Tip Angle** is the included angle of the insert.

**Measure** — This indicates the units that are used for reporting the tool's dimensions. Select **Inches** for inch units or deselect it for millimeters.

**Bar Feed**

The **Bar Feed** tool group represents both bar feeders and bar pullers. This tool group has a **Type** tab instead of an **Insert** tab.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.

**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.
Name — Enter a name that identifies the tool. The name must be unique among all the tools in the crib.

Type — Select Bar Feed or Bar Pull.

Measure — This indicates the units that are used for reporting the tool’s dimensions. Select Inches for inch units or deselect it for millimeters.

Bar Pull tools have additional options:

1. Depth is the depth of the puller
2. Max. Diameter is the maximum diameter of the puller

Holder tab

The Holder tab describes the characteristics of the tools holder and how the insert is oriented relative to the holder. The parameters on this tab depend on the type of tool:

- Turn (see page 1804)
- Bore (see page 1806)
- Groove/Cutoff (see page 1808)
- Bar Feed (see page 1810)
- Thread (see page 1812)
Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.

**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

- 2 flutes, right-handed
- 4 flutes, right-handed
- 4 flutes, left-handed

**Name** — Specifies the name of the current tool.
To edit the **Name of the tool**, use the **Insert/Type** (see page 1796) tab.

**End Cut** — The tool cuts in a direction parallel with the length of the holder.

**Side Cut** — The tool cuts in a direction perpendicular with the length of the holder.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.
Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to access a context menu.

Center Tool — Select this menu option to center the tool in the preview image.

Center All — Select this menu option to center the tool and tool holder in the preview image.

Redraw Tool — Select this menu option to recreate the preview image after making changes to its attributes.

Show Tool Holder — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

Show Flutes on End Mills — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

Name — Specifies the name of the current tool.
To edit the Name of the tool, use the Insert/Type (see page 1796) tab.

End Cut — The tool cuts in a direction parallel with the length of the holder.

Side Cut — The tool cuts in a direction perpendicular with the length of the holder.

Exposed length — This is the amount of the tool that sticks out of the holder if the holder is simulated.
Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.

**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

![Tool Preview Images](image)

The **Holder** tab for Groove/Cutoff tools, contains these attributes:

**Name** — Specifies the name of the current tool.
To edit the **Name of the tool**, use the **Insert/Type** (see page 1796) tab.

**Holder Type** — For grooves possible holder types are:

- **OD Groove** — Select this option for outer diameter grooving tools.
- **ID Groove** — Select this option for inner diameter grooving tools.
- **Face Groove** — Select this option for face grooving tools.
- **Cutting** — Select this option for cutoff tools.

**End Cut** — The tool cuts in a direction parallel with the length of the holder.

**Side Cut** — The tool cuts in a direction perpendicular with the length of the holder.
Many Face Groove tools have curved holders. Due to the curvature of the holders the tools have a limited set of diameters at which they can plunge. The image below shows the curved shape of the supporting holder.

These two diameters are the minimum and maximum diameters between which the tool can plunge.

The tool inside edge of the groove must be between the **Min plunge diameter** and **Max plunge diameter** if the Groove is being cut in the positive direction. The outside edge must be between these two diameters if the Groove is being cut in the negative direction.

**Cut Depth** — This is the maximum depth of cut.

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Bar Feed**
Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.

**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool’s flutes in the preview image.

2 flutes, right-handed

4 flutes, right-handed

4 flutes, left-handed

The **Holder** tab for **Bar Feed** and **Bar Pull** tools contains these attributes:

**Name** — Specifies the name of the current tool.

*To edit the Name of the tool, use the Insert/Type (see page 1796) tab.*

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.
Thread

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to access a context menu.

Center Tool — Select this menu option to center the tool in the preview image.

Center All — Select this menu option to center the tool and tool holder in the preview image.

Redraw Tool — Select this menu option to recreate the preview image after making changes to its attributes.

Show Tool Holder — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

Show Flutes on End Mills — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

<table>
<thead>
<tr>
<th>Flutes Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 flutes, right-handed</td>
<td>An image of an end mill with 2 flutes, right-handed.</td>
</tr>
<tr>
<td>4 flutes, right-handed</td>
<td>An image of an end mill with 4 flutes, right-handed.</td>
</tr>
<tr>
<td>4 flutes, left-handed</td>
<td>An image of an end mill with 4 flutes, left-handed.</td>
</tr>
</tbody>
</table>

Name — Specifies the name of the current tool.
To edit the **Name of the tool**, use the **Insert/Type** (see page 1796) tab.

**Holder Type** — For threads possible holder types are:
- **OD Threads** — Select this option for outer diameter threading tools
- **ID Threads** — Select this option for inner diameter threading tools

**End Cut** — The tool cuts in a direction parallel with the length of the holder.

**Side Cut** — The tool cuts in a direction perpendicular with the length of the holder.

![Diagram showing shaft diameter (D) and length (C)](image)

**Exposed length** — This is the amount of the tool that sticks out of the holder if the holder is simulated.

**Orientation tab**

![Orientation tab interface](image)

On the **Orientation** tab, you can set the orientation of the holder in the machine and the handedness of the tool.
Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.

**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool’s flutes in the preview image.

![Tool Preview](image)

**Name** — Specifies the name of the current tool.

To edit the **Name** of the tool, use the **Insert/Type** (see page 1796) tab.

**Insert** — Select the handedness of the tool from **Right Hand** and **Left Hand**.

**Select holder orientation:**

- Select whether the holder is for an **OD Turning tool** or **ID Boring Bar**.
- Set the orientation of the holder by clicking one of the buttons: **SE**, **SW**, **NE**, or **NW**.

The images on the buttons do not necessarily show the shape of the actual insert. The insert of the tool can be any shape.

When **Automatic tool orientation** is selected on the **Misc** tab of the **Machining Attributes** dialog, the tool holder orientation is ignored, and a tool can be used in any orientation.
On the **Prog. Pt.** (program point) tab you set the point of the insert that is programmed. You can set both the **X Coordinate** and the **Z Coordinate**.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

- **Center Tool** — Select this menu option to center the tool in the preview image.
- **Center All** — Select this menu option to center the tool and tool holder in the preview image.
- **Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
- **Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.
- **Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

2 flutes, right-handed

4 flutes, right-handed

4 flutes, left-handed
**Name** — Specifies the name of the current tool.

To edit the **Name** of the tool, use the **Insert/Type** (see page 1796) tab.

**Tool tip centre** — If both **X Coordinate** and the **Z Coordinate** are set to 0.0 then the center point of the tip arc is programmed. In this case it is expected that you perform insert radius compensation at the machine tool.

**Tool tip edge** — To perform insert radius compensation in FeatureCAM, set the **X Coordinate** and **Z Coordinate** to the radius compensation values provided with your tool.

**X/Z Gauge length** — This is the distance between the tool program point and the origin/part program zero in the X and Z directions, when the tool is at the tool home/tool change location position:

![Diagram](attachment:image.png)

**X Gauge length** corresponds to the `<X-PRESET>` reserved word in XBUILD.

**Z Gauge length** corresponds to the `<Z-PRESET>` reserved word in XBUILD.

You should also set the default **Tool program point** (see page 1708, see page 1404) attribute to **Tool tip center** or **Tool tip edge**.
**Holder Drawing tab**

You can use the **Holder Drawing** tab to create a custom Tool Holder from a curve or solid.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.

**Show Tool Holder** — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

**Show Flutes on End Mills** — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

- 2 flutes, right-handed
- 4 flutes, right-handed
- 4 flutes, left-handed
Name — Specifies the name of the current tool.

To edit the Name of the tool, use the Insert/Type (see page 1796) tab.

No Custom Holder — A default rectangular holder is used based on the Holder dimensions.

Curve — You can select a curve to define the shape of the Holder. This enables you to specify the exact shape of your Tool Holder, so you can check for Holder collisions during simulations.

Paste example — Creates a curve in the shape of the current Holder in the graphics window, which you can use as a guide to create a new curve.

Regardless of the eventual orientation of the holder in the machine, draw the holder curve in the XZ plane with the length of the tool holder in the +Z direction and the leading edge of the insert at the origin. The curve you draw must be a closed curve.

Select a curve from the Select custom drawn list, then click Set selected to save it. The curve is saved in the tooling database independently from the part file. Any subsequent use of this tool in any part file uses the custom holder.

Solid — You can select a solid to define the shape of the Tool Holder. This is the most accurate way to represent the tool holder.

After you have imported and positioned the solid (see page 1819) so that the point zero is in the correct place, select Solid, then select it from the Select custom drawn list, then click Set selected to save it. The solid is saved in the tooling database independently from the part file. Any subsequent use of this tool in any part file uses the custom holder. the solid name in the Set menu. Click Set selected to save the solid.
Solid tool holder example

Here is an example of a FeatureCAM turning tool holder:

To use a solid model to accurately define the shape of the tool holder:

1 Import the solid model file of the tool holder:
   a Select File > Import from the menu to display the Import dialog.
   b Select the solid model in the Import dialog, then click Open.
   c Click Cancel to close the Import Results dialog.

In this example, a *.x_t solid model of the tool holder is used:

2 Optionally rename the solid in the Part View panel:
   a Right-click the solid in the Part View panel and select Rename to display the Rename Object dialog.
   b Enter a New Name, then click OK.

3 Find the zero point (mounting point) of the solid model holder:
a. Select the two faces that point towards the zero point, for example:

b. Click **Hide Unselected** in the **Hide Menu** on the **Advanced** Toolbar. Only the selected surfaces are displayed in the graphics window:

c. On the **Geometry** toolbar, click **Line from 2 Pts**, and create a line along the mounting edge of each face, for example:

d. Select the two faces in the graphics window, then right-click on the selection and select **Hide Selected** from the context menu.

e. Click **Trim/Extend** in the **Geometry** toolbar and use the **Trim/Extend** tool (see page 315) to extend the lines until they intersect:
Click **Clip** in the **Geometry** toolbar and use the **Clip** tool (see page 315) to clip the ends of the lines beyond the intersection:

![Clip tool example](image)

The intersection is the zero point which you can use to position the holder:

![Intersection example](image)

4 Create a reference point to move the holder to:

a On the **Holder Drawing** tab of the **Tool Properties** dialog (see page 1749, see page 1795), select **Curve**, then click **Paste example**:

![Tool Properties dialog](image)

A curve is created in the graphics window.

b Click **Show All Solids** in the **Show Menu** in the **Advanced** toolbar.

c Click **Unshade All** in the **Display Mode** toolbar.
An outline of the solid is displayed in the graphics window:

5 Use the Transform tool to move the zero point of the solid holder to the zero point of the pasted holder curve:
   a Select the solid holder in the Part View panel.
   b Select Edit > Transform from the menu to display the Transform dialog.
   c Select Translate and Move and under Distance from 2 points, click From Pick Location and select the zero point you sketched earlier in the graphics window:
   d Click To Pick Location and select the zero point of the pasted holder curve in the graphics window:
   e Click Preview to display a preview of the solid holder’s new location of the in the graphics window. The preview is shown in blue:
f Click OK to accept the new location and close the Transform dialog.

6 Click Shade Surfaces in the Standard toolbar:

7 Select the holder curve you pasted earlier and press the Delete key to delete it.

8 If you look at the solid holder from the front, there is a recess where the insert sits:

9 You must take this recess into account to achieve accurate simulation. To do this:
   a Using the Linear Distance tool (see page 290), create a measurement of the depth of the recess:
      
      In this example, it is approximately 2mm.
   b Select the solid holder in the Part View panel.
c. Select **Edit > Transform** from the menu to display the **Transform** dialog.

d. In the **XYZ Distance** section, enter **0** for \( X \), **-2** for \( Y \), and **0** for \( Z \) to move the holder down by 2mm in the \( Y \) direction.

e. Click **OK**.

The solid holder is now in the correct position.

10. Set the solid as the holder for the tool:

a. On the **Holder Drawing** tab of the **Tool Properties** dialog (see page 1749, see page 1795), select **Solid**, then select the solid from the **Select custom drawn** list.

b. Click **Set Selected**.
c The solid holder is displayed in the preview window on the tab and you can see the insert position relative to the holder:

d Click OK to accept the solid holder.

The preview on the **Tools** tab is updated:

e Click **OK** to continue.

11 Hide the imported solid and show the part solid.
12 Run a 3D simulation. The solid model that you imported is now used as the tool holder and the simulation is more accurate:

![3D simulation preview](image)

**Overrides tab**

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the Machine tab settings of the Viewing Options dialog. Right-click the image to access a context menu.

- **Center Tool** — Select this menu option to center the tool in the preview image.
- **Center All** — Select this menu option to center the tool and tool holder in the preview image.
- **Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
Show Tool Holder — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

Show Flutes on End Mills — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

<table>
<thead>
<tr>
<th>Flutes</th>
<th>Right-handed</th>
<th>Left-handed</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Name — Specifies the name of the current tool.

To edit the Name of the tool, use the Insert/Type (see page 1796) tab.

Only set turret 1 — Select this option to set the tool registers for only one turret.

Set all turrets — Select this option to set the tool registers for each turret of a multi-turret machine. Select an entry in the Turret and spindle list to choose the turret you want to work with.

The turret options are only displayed when the Turning component (see page 10) of FeatureCAM is activated. The turrets you can select are determined by the current post file.

Default tool registers — Specify the register settings for the tool:

- Tool number — Specifies the slot number for the tool. Enter 0 to allow FeatureCAM to assign a value when the tool is used.

Tools can occupy the same tool slot (see page 1582).

- Same — Select this check box to use the Tool number value as the Default offset register, Length offset register, and Tool ID number. Deselect the check box to set the register values individually.

- Diameter offset register — Specifies the diameter cutter compensation offset register number for the tool. This value is passed to XBUILD as <COMP-NUM>.

- Length offset register — Specifies the tool length offset register number. Most lathe controllers have a single register that contains the length and diameter offset values. In this case, the Length offset register is the important field to set in FeatureCAM. This value is passed to XBUILD as <OFFSET#>. 
- **Tool ID** — Specifies the identification number of the tool. This is used by Bridgeport lathes and some Cincinnati machines.

  To override the register values for individual parts, use the **Tool Mapping** (see page 1575) dialog.

**Operations** — Select an entry in the list to specify the type of operation for which FeatureCAM can select this tool. You can override this setting by selecting the tool manually (see page 981).

**Max. depth of cut** — This is the maximum cut depth that is allowed for this tool.

**Comments** — Optionally enter comments associated with the tool. A post processor can be configured to output these comments.

### Feed/Speed tab

This tab is where you override the feed and speed values if you want to always use specific speed and feed values for this tool, or this tool with a specific material.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog. Right-click the image to access a context menu.

**Center Tool** — Select this menu option to center the tool in the preview image.

**Center All** — Select this menu option to center the tool and tool holder in the preview image.

**Redraw Tool** — Select this menu option to recreate the preview image after making changes to its attributes.
Show Tool Holder — Select this menu option to display the tool holder with the tool. The tool holder is displayed by default.

Show Flutes on End Mills — Select this menu option to display a representation of an end mill tool's flutes in the preview image.

<table>
<thead>
<tr>
<th>Flutes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 flutes, right-handed</td>
<td></td>
</tr>
<tr>
<td>4 flutes, right-handed</td>
<td></td>
</tr>
<tr>
<td>4 flutes, left-handed</td>
<td></td>
</tr>
</tbody>
</table>

Name — Specifies the name of the current tool.

To edit the Name of the tool, use the Insert/Type (see page 1796) tab.

The table displays any overrides that have been set for this tool with specific materials.

Material is the list of materials that you choose to override the feed and speed values for.

% Speed override is the percentage to adjust the speed value whenever this tool is used; 100% means that the values chosen by FeatureCAM or overridden by the user are not scaled.

% Feed override is the percentage to adjust the feed rate whenever this tool is used; 100% means that the values chosen by FeatureCAM or overridden by the user are not scaled.

Create new item — Displays the Tool Specific Feeds and Speeds dialog, where you can add a new Material and its corresponding feed and speed values to use with this specific tool.

Properties — Displays the Tool Specific Feeds and Speeds dialog for the selected material, where you can edit the material's feed and speed values to use with this specific tool.

Delete item — Removes the selected material.

**Tool selection for turn/mill features**

Turn/mill features use the same tools as the normal milling features, but they are renamed with -rotaryX appended to the name to indicate that it is a powered rotary tool. For example, if a tool called center_4 is selected for a turn/mill center drill operation, the tool is copied and the copy is called center4-rotaryX.
Rotary tools cannot be explicitly created, but if you manually select a tool for a turn/mill operation, it is copied and the copy is designated as a rotary tool.

Rotary tools cannot be used for turning operations.

**Turret location**

The *Turret location* is kept in the *.cnc* file, because there may be multiple turret locations.

To change the locations:

1. Select **Manufacturing > Post Process** from the menu.
2. In the **Post Options** dialog, click the **Turn/Mill** tab.
3. Click the **Edit** button and XBUILD opens. Select **CNC-Info > Turrets** from the menu.

**Adding tools to an existing tool crib**

You can copy a tool definition directly from an already defined tool crib (such as **Tools**) to a new tool crib, or create a new tool.

See Adding tools or New tools.

To add a tool from a tool crib to another tool crib:

1. Select the tool crib that contains the tool definition in the **From Crib** list.
2. Select the name of the destination crib in the **Current Crib** list.
3. Select a tool from the **Available Tools** list.

   ![Tip] You can select multiple tools by pressing the CTRL key, or you can select a tool group's entire tool list using the left **Select All** arrow.

4. Click **Add**.

**Importing tools into a tool crib**

To import a tool into the tool crib:

Select **Manufacturing > Tool Manager** from the menu to display the **Tool Manager** dialog.
1 Click **Import** to display the **Tool Import** dialog:

2 Under **Tool import file name**, enter the name and path of the file you want to import, or click **Browse** and select it in the **Import** dialog.

   You can import TDB or XML files, and you can import tools saved in Excel documents (see page 1831).

3 In the **Import into tool crib** list, select the tool crib you want to import the tools into.

4 Under **If tool name already in crib**, select an option to determine what happens to tools with the same name as existing tools:
   - Select **Overwrite with new tool** to replace the old tool with the new tool.
   - Select **Add 2nd copy of tool** to add the new tool under a different name.
   - Select **Skip tool** to ignore any new tools with the same name as old tooling.

5 Click **Import** to import the tools.

   A message dialog is displayed that tells you how many tools have been imported.

6 Click **Close** to close the dialog.

---

**Importing tools from Excel**

You can import Excel documents that contain tool information by converting them to TDB files.

* TDB files do not support form curves.

To import tools saved in an Excel document:

1 Create a backup of your Excel document before starting.

2 Export tools (see page 1833) from FeatureCAM into a TDB file.

3 Open the TDB file in Excel to see how it is formatted.
4 Edit the Excel document that contains your tools so it is formatted the same as the exported TDB file.

5 Save your Excel document as a TDB file.

   A TDB file is similar to a CSV (Comma Separated Value) file. You can create a TDB file from Excel by saving as a CSV file and changing the file extension.

6 Import (see page 1830) your TDB file into FeatureCAM using the Tool Import dialog.

**Changing the active tool crib**

FeatureCAM selects tools from only the active tool crib to create toolpaths.

You can use these methods to change the active tool crib:

- Select the **Manufacturing > Set Tool Crib** menu option. In the **Select Active Tool Crib** dialog, select the tool crib you want to use and click OK.

- In the Status bar (see page 32), click the name of the active tool crib, and select the tool crib you want to use in the menu.

- In the **Tool Manager** dialog, select the tool crib you want to use in the **Current Crib** list, and click OK to close the dialog.

   A message is displayed asking if you want to change the current tool crib.

   To create or edit a tool crib, use the **Tool Manager** dialog (see page 1745).
Exporting tools

To export tools from a tool crib:

1. Select Manufacturing > Tool Manager from the menu to display the Tool Manager dialog.

2. Click Export to display the Tool Export dialog:

3. Enter the file name and location under Export file name, or click Browse, browse to the location and enter the File name in the Export dialog.

Two file types are supported: .xml and .tdb. We recommend that you use the .xml format as it supports exporting form tools and custom drawn holders. To change the type, click the Browse button and select the file type in the Save as type menu.

4. Select a tool crib from the Tool crib to be exported list.

5. In the Tool Groups list select the groups you want to export, and deselect the groups you do not want to export.

   Use the Include all items button to select all groups. Use the Exclude all items button to deselect all groups.

6. Click Export.

7. Click Close.

The file created is tab delimited text. You can edit the file in a spreadsheet. This file can now be imported into FeatureCAM.

Editing multiple tools at the same time (bulk editing)

If you want to edit many tools, editing them individually in the Tool Properties dialog may be time-consuming.

There are several ways to bulk-edit tools:
• Export the tools (see page 1833) to a .tdb file, edit them in Excel, then reimport (see page 1830) them.

You must select **Overwrite with new tool** in the **Tool Import** dialog when reimporting, otherwise you lose form curve information. By selecting Overwrite with new tool, the numeric information is overwritten, but the form curve is not lost.

• Export the tools (see page 1833) to an .xml file, edit them in Notepad, then reimport (see page 1830) them. This method keeps the curve/holder information regardless of your overwrite choice upon import. The disadvantage with this method is that it is not so easy to edit an .xml file.

• Use a BASIC macro to do your edits. This is useful if you have many edits to do of a similar type and you are adept at writing BASIC.

• Using MSACCESS is possible, to directly edit a network database, but the database structure is convoluted and confusing and easy to break. We do not recommend this method.

**Moving a tool database without exporting and importing**

*FeatureCAM can use either a local or a network database. This topic applies only to local databases.*

You cannot move a local database between computers simply by transferring the database files. To move a local database between computers, export (see page 1833) tools and materials from the source computer and import (see page 1830) them on to the target computer.

Sometimes this is not possible due to hardware problems, or if you cannot export information from FeatureCAM, for example:

• the source computer is damaged but you can access the hard-drive where the database is stored.

• there is a fault and you cannot open FeatureCAM.

In this situation you can move the database manually.

To manually move a database between computers:

1 Identify the location of the source database:

   The following points describe the database:

   • It is a folder with a lot of files in it.

   • If you have the 32-bit version of FeatureCAM, the folder is called DATABASE.
If you have the 64-bit version of FeatureCAM, the folder is called DATABASEX64.

- A FeatureCAM databases folder contain the following files:
  - object.idx
  - domain.num
  - several .a1 files

Problems which make it difficult to find the database:

- If you have installed multiple copies of FeatureCAM, there are multiple databases.
- The database is stored in different places on different versions of Windows.
- The database is stored in different places on different versions of FeatureCAM.
- The database may be stored in a different place or with a different name depending on the language of Windows or FeatureCAM.

Use the following tips to distinguish between different databases:

- You can compare time stamps to distinguish between an older database and a newer one.
- You can compare file sizes to distinguish between a database that you have not used (such as from a trial download), and one you have used a lot.

2 Identify the location of the target database:

You need to identify the target database that you want to replace with your source database. You must have already installed FeatureCAM on the source computer with a local database.

a Use the information in step 1 to find the database on the target computer, and note the full pathname to the database folder, for example: 

C:\programdata\featurecam\featurecam188\database.

b From the target database folder, open object.idx in a text editor. It contains the folder name repeated many times.

c From the target database folder, open domain.num in a text editor. It contains the folder name repeated many times.

3 Create a copy of the source database in a neutral location:

Copy the source database folder and all its contents (the domain.num, object.idx, and .a1 files) to a neutral location.
You will edit this copy of the database instead of the original. If you make a mistake you can start again by recopying the original folder.

4 Edit the neutral copy of the database:
   a In the neutral database folder, open \texttt{object.idx} in a text editor.
   b Replace all instances of the source database pathname with the target folder pathname.
      For example, if the source database pathname is:
      \texttt{c:\foo\bar\featurecam\featurecam184\database}
      and the target pathname is:
      \texttt{c:\programdata\featurecam\featurecam188\database}
      Replace all instances of
      \texttt{c:\foo\bar\featurecam\featurecam184\database} with
      \texttt{c:\programdata\featurecam\featurecam188\database}.
   c Repeat steps a and b for \texttt{domain.num}.
   d Optionally repeat steps a and b for \texttt{object.bak} (this is a backup file).

\begin{itemize}
\item \textbf{Be careful not to make any other accidental changes when editing the files.}
\item \textbf{Do not edit .a1 files, they are binary and cannot be edited with a text editor.}
\end{itemize}

5 Delete all files in the target database folder.

\begin{itemize}
\item Any tools or materials in the target database are deleted. If you want to keep them, export them before you delete the target database and import them later.
\end{itemize}

6 Copy all files from the neutral database folder into the target database folder.

The next time you use FeatureCAM on the target computer, you can access the tools and materials you copied from the source database.

\textbf{Displaying a profile of an existing tool}

You can display the profile of an existing tool in the graphics window to use as a reference when creating a curve for a form tool.

To display the profile of a tool in the graphics window:

1 Select a tool in the \textbf{Tool Manager} (see page 1745) dialog and click \textbf{Properties} to display the \textbf{Tool Properties} dialog.
2 Click \textbf{Paste copy of curve} in the \textbf{Tool Properties} dialog.
3 Click **Cancel** to close the Tool Properties dialog without making any changes to the tool.

**Deleting a tool crib**

To delete a tool crib:

1. Select **Manufacturing > Tool Manager** from the menu to display the Tool Manager dialog.
2. Select the crib you want to delete in the Current Crib list.
3. Click **Delete Crib**.
4. Click **Yes** in the message dialog to delete the tool crib.
5. Click **OK** to close the Tool Manager dialog.

**Tool and Material Setup**

The tooling and feed/speed databases are created using the INITDB Initialization program in FeatureCAM. This is the program that is run the first time you run FeatureCAM to create your initial database.

Select where your database is located:

**On my local computer** — Select this option to use the database on your PC.

**On another computer that I will access over a network** (see page 1838) (SND (see page 10)) — Select this option to use an MS Access shared network database. Click **Browse** and browse to the location of the shared network database.
On a SQL Server (see page 1839) (SND (see page 10)) — Select this option to use an SQL Server network database. Select the Server Name and the Database Name. To use SQL authentication, select SQL Server in the Authentication Mode list and enter your SQL Username and SQL Password. If you use SQL authentication, the Database Name list only displays databases to which you have access.

You may also want to use INITDB for the following reasons:

- Adding default tools and feed/speed tables to the database (see page 1853)
- Recreating tooling and feed/speed databases if they become corrupt (see page 1854)

**MS Access shared network database (SND)**

The shared network database is provided as an empty MDB format database, created by Microsoft Access and accessed using the Microsoft Jet database driver.

The database must be set up properly before it can be used:

1. Establish a location on your network for the database and copy a blank database from the FeatureCAM DVD to that location.
2. Fill the database with default tooling and feed/speed information. Do this by running INITDB on any computer that has access to the database and point INITDB to the database.
3. Set the location of the database for each user using the Browse button during installation (see page 1837), or after installation on the Database tab (see page 140) of the File Options dialog.

To set up a network database on a 64-bit machine:

1. Download the 32-bit Microsoft Access Database driver from internet. The 32-bit driver needs to be used on both 32 and 64-bit machines.
2. If a 64-bit driver is already installed on the machine (for example, if you have 64-bit MS Office installed), you must uninstall it.

   *Uninstalling the 64-bit driver and installing the 32-bit driver, could break 64-bit MS Access.*

3. Install the 32-bit driver you downloaded in step 1.
4. Open the folder `C:\Windows\SysWOW64`.
5. Find and run the file `odbcad32.exe`. The ODBC Data Source Administrator dialog is displayed.
6 Click Add on the User DSN tab. The Create New Data Source dialog is displayed.

7 Scroll down, select Microsoft Access Driver (*.mdb, *.accdb) and click Finish. The ODBC Text Setup dialog is displayed.

8 For the Data Source Name option, enter MS Access Database and click OK. The database is displayed in the list of User Data Sources on the User DSN tab.

9 Restart FeatureCAM.

Network database configuration is user-based. If there are multiple users on the machine, each user must go through the process above and configure it.

**SQL Server shared network database (SND)**

You can use SQL Server for your network database. This gives better performance and reliability for your network database.

Microsoft SQL Server 2014 Express is a free edition of SQL Server that you may use to host your Delcam tools and materials database used by FeatureCAM. It is available in 32-bit and 64-bit editions and in these languages:

- Chinese (simplified)
- Chinese (traditional)
- English
- French
- German
- Italian
- Japanese
- Korean
- Portuguese (Brazil)
- Russian
- Spanish

When using Microsoft SQL Express to host your FeatureCAM tools and materials you need a server computer to host the SQL Server software and the tools/materials database. This server computer should be a different computer from the client workstations where users are running FeatureCAM.

*The database server can host tools and materials databases from different versions of FeatureCAM, or different parts of your organization.*

**Installation**

1 Pick a computer at your facility that you want to host the FeatureCAM tools and materials database. We’ll call this the database server. The database server must meet these criteria:

- It must be running Microsoft Windows.
- It must be connected to your network.
- It must be able to run Microsoft SQL Server Express 2014.

2 Find out the hostname of the database server.

3 Download either the **Express (Database Only)** or **Express with Tools** from http://www.microsoft.com/en-gb/download/details.aspx?id=42299 (http://www.microsoft.com/en-gb/download/details.aspx?id=42299). If your **database server** is a 32-bit Windows, then you'll need to download the 32-bit version of SQL Server Express. If 64-bit, then download the 64-bit version instead.

   The bitness of your download must match the bitness of the database server computer, and has nothing to do with the bitness of your client workstations. You may download the language of your choice.

4 Install Microsoft SQL Server Express on your database server.

5 From any client workstation using FeatureCAM 2016 R2, find **INITDB** in the **Start** menu and run it.

6 In the **Tool and Material Setup** dialog, select **On a SQL Server** and enter the hostname of the database server computer as the **Server Name**.

7 After entering the **Server Name**, you can select an existing database on the database server in the **Database Name** menu, or create a new one.

8 The first time you run **INITDB** you can do one of the following:
   - Initialize a new database with all the default tools.
   - Import tools from another database elsewhere on your network
   - Upgrade an existing database to the latest version of FeatureCAM and load it with all of the default tooling.

   Subsequent client installations default to this choice.
Spindles and tool holders

You can display spindles and tool holders in toolpath simulations to see how they interact with the part and check for collisions and gouges (see page 1540).

Use the Simulation Options dialog to display spindles and tool holders in simulations.

To display spindles or tool holders during simulation:

1. Select Options > Simulation from the menu to display the Simulation Options dialog.
2. On the General tab, select Show Holder to display the tool holder during simulation.
3. Select Show Spindle to display the spindle during simulation.
   
   You cannot select Show Spindle without unless Show Holder is selected.
4. Click OK to close the Simulation Options dialog.

   You can change these settings while a simulation is playing, but you must restart the simulation for the changes to take effect.

Use the Spindles and Tool Holders dialog (see page 1841) to manage spindles and tool holders. You can open these dialogs:

- Use the Tool Holder Properties dialog to view, edit, and create tool holders.
- Use the Spindle Properties dialog (see page 1845) to view, edit, and create spindles.

The length of tool extending past the tool holder is determined by the Exposed length attribute in the Tool Properties dialog.

Spindles and Tool Holders dialog

Use the Spindles and Tool Holders dialog to view, edit, and create new spindles and tool holders.
To display the **Spindles and Tool Holders** dialog, select **Manufacturing > Spindles and Tool Holders** from the menu.

![Spindles and Tool Holders dialog](image)

*These options are the same as on the **Holder** tab (see page 1789) for a specific tool.*

The **Spindles and Tool Holders** dialog displays the current spindle and the holders that are defined for it. To change the current spindle, select the spindle from the **Current Spindle** list. Select a tool holder to display the spindle and tool holder combination in the preview area.

Click the tool preview image to pan and zoom it. The orientation of the preview is determined by the **Machine** tab settings of the **Viewing Options** dialog.

The spindle buttons are:

- **Create new spindle** — Displays the **Spindle Properties** (see page 1845) dialog. The dimensions of the current spindle are used as initial dimensions.

- **Edit spindle definition** — Displays the **Spindle Properties** (see page 1845) dialog where you can view and edit the dimensions of the current spindle.

- **Delete spindle definition** — Deletes the current spindle and its tool holders.

The tool holder buttons are:

- **Create new tool holder** — Displays the **Tool Holder Properties** (see page 1843) dialog. Creates a new tool holder for the current spindle. The dimensions of the current tool holder are used as initial dimensions.

- **Edit tool holder definition** — Displays the **Tool Holder Properties** (see page 1843) dialog where you can view and edit the properties of the current tool holder.
Delete tool holder definition — Deletes the current tool holder.

**Tool Holder Properties dialog**

The Tool Holder Properties dialog enables you to view, edit, and create tool holders.

To display the Tool Holder Properties dialog, click Create new tool holder or Edit tool holder definition on the Holder tab (see page 1789) of the Milling Tool Properties dialog or the Spindles and Tool Holders dialog (see page 1841).

**Holder Name** — Each tool holder must have a unique name.

**Measure** — Select the Inches check box if the tool holder dimensions are in inches. For millimeter dimensions deselect this box.
**Holder type** — Holders are either **Endmill** or **Collet**. The major difference between these two types of holders is that collets are adjustable to fit a range of tool diameters.

**Tool Groups** — This button displays a list of tooling types that use this holder.

**Use curve as revolved holder shape** — If you want to make a custom holder shape, select this option and select a curve in the menu that describes the shape. This curve must be in the XZ plane with one endpoint at the origin.

**Use solid to describe holder shape** — If you want to use a solid for the custom holder shape, select this option and select a solid in the menu.

**Paste example into graphics window** — Click the **Paste** button to copy into the graphics window a set of lines and arcs for the current holder shape. This can be useful as a reference if you are going to draw a custom holder shape.

**Tip Dia** — This is the outer diameter of the holder at the tip for collets. For convenience, you can set the **Tip diameter** for endmill holders to **Based on tool dia** so that the holder is scaled to fit a tool.

**Tool Dia** — The diameter of the tool. For collets this can be specified as a minimum and maximum value, to accurately reflect actual collets, or it can be set to **Fit any tool** so that the diameter is adjusted to fit any tool with a diameter less than the **Tip Dia**.

**Dimensions** — The other dimensions of the holders are shown below.

**Endmill tool holder dimensions:**

1. Flange length
2. Step diameter
3. Tip diameter
4. Tool diameter
5. Tip length
6. Length
7. Diameter

**Collet tool holder dimensions:**
Angled Head — Select this option if you want to create a right-angled tool holder. This option is only available when you are using a solid to describe the holder shape.

Azimuth angle — Select whether the tool has a Variable or Fixed azimuth angle. If Fixed is selected, enter the angle in degrees.

Spindle Properties dialog

The Spindle Properties dialog lets you view, edit, and create spindles.

To display the Spindle Properties dialog, click Create new spindle or Edit spindle definition in the Spindles and Tool Holders dialog (see page 1841).

Spindle Name — Each spindle must have a unique name.

Measure — This indicates the units that are used for the spindle's dimensions. Select Inches to use inch units or deselect the box for millimeters.

Diameter — This is the diameter of the spindle (see diagram)

Height — This is the height of the spindle (see diagram)

Gage Diameter — This is the diameter of the gage (see diagram)
OK — Click OK to save any changes to new or existing spindles.

Cancel — Click Cancel to discard any changes (if you have made any) and return to the Spindles and Tool Holders dialog.

**Tool holder selection**

When you select a tool for an operation, FeatureCAM automatically selects a tool holder.

If there is no tool holder that matches the tool, FeatureCAM creates a new tool holder by scaling up the dimensions of an existing holder.

Tool holders have a **Holder Type** of either Endmill or Collet.

When you select a **Holder Type** on the **Holder Properties** dialog, FeatureCAM selects a holder to match the diameter of the tool. For Endmill holders, the smallest tool holder with a **Tool Diameter** value greater than or equal to the tool’s diameter is selected. For Collet holders, the tool’s diameter must be within the **Min** and **Max** values.

You can specify which tool holder is used for a tool on the **Holder** tab (see page 1789) of the **Tool Properties** dialog.

**Creating/editing a spindle**

To create or edit a spindle:

1. Select **Manufacturing > Spindles and Tool Holders** from the menu to display the **Spindles and Tool Holders** dialog.

2. To modify a spindle, select it from the **Current Spindle** list and click **Edit spindle definition**. The Spindle Properties dialog (see page 1845) is displayed.

3. To create a new spindle, select an existing spindle from the **Current Spindle** list and click **Create new spindle**. The spindle properties dialog (see page 1845) is displayed. The dimensions of the selected spindle are used as the initial dimensions for the new spindle.

**Creating/editing a tool holder**

To create or edit a tool holder:

1. Select **Manufacturing > Spindles and Tool Holders** from the menu to display the **Spindles and Tool Holders** dialog.
2 Select a spindle from the **Current Spindle** list. The tool holders for the selected spindle are displayed.

3 To modify a tool holder, double-click the tool holder name in the **Tool Holders** list, or select the tool holder name and click **Edit tool holder definition** to display the **Tool Holder Properties** (see page 1843) dialog.

4 To create a new tool holder, select an existing tool holder name from the **Tool Holders** list and click **Create new tool holder** to display the **Tool Holder Properties** (see page 1843) dialog. The dimensions of the selected tool holder are used as the initial dimensions for the new holder.

### Feeds/Speeds and Cutting Data Tables

Use one of the following methods to display the **Feeds/Speeds and Cutting Data Tables** dialog:

- Select **Manufacturing > Feeds/Speeds and Cutting Data Tables** from the menu.

- Click **Customize Mfg.** in the Steps panel, then click **Refine FeatureCAM’s feed & speed tables to suit my particular requirements** in the Customize Manufacturing dialog.

- Click **F/S Tables** on the Material page of the Stock wizard.
Material — Select the material you want to edit. The selected material's table of speed and feed values is displayed.

Tool Grade and Tool Finish — Select a tool grade and tool finish. A material can have multiple data tables, to account for the different combinations of tool grade and finish.

If a feed/speed table exists for a material cut with a tool with a BRIGHT finish, but not for TL_N or BLACK_OXIDE tool finishes, then the speed values are derived from the BRIGHT table. The speed for TL_N is 1.5 times the BRIGHT speed. The speed for BLACK_OXIDE is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

Use Range — Some materials have two tables, each associated with a hardness value. For these, you must select either Hardness 1 or Hardness 2 to see the table.

Feedrates are specified for a 1" (or 20mm) tool. For tools that are other diameters, the feedrates are scaled linearly. For example, the feedrate for a 0.25 tool is 1/4 of the table rate.

Dialog buttons

New Stock Material — Add a new stock material (see page 1848).
Delete — Delete the table for the selected material.
Copy Values — Copy the speed and feed values from one material to another. This saves time if two materials have similar values.
Import — Import a feed and speed data file.
Export — Export the feed and speed data.

Adding a new stock material

To add a new stock material:

1. Click New Stock Material in the Feeds/Speeds And Cutting Data Tables dialog to display the New Stock Material dialog.
2. Enter the name of the new material in the New Stock Material dialog and click OK.

The name can contain characters in the ranges A-Z and 0-9, plus underscores (_) and dashes (-).

3. Click New to create a Feed/Speed table for the new material.
4. Select the Tool Grade and Tool Finish from the lists.
5. Enter speeds and feed values for each operation type.
To copy the values from an existing material, click Copy Values; select a material in the Copy Feed/Speed Values dialog; and click OK.

6 If the feed or speed are dependent on the hardness:
   a Select Use Range and enter the lower hardness value in the Hardness 1 field.
   b Enter the upper hardness value in the Hardness 2 field.

7 Click OK to close the Feeds/Speeds And Cutting Data Tables dialog.

If a feed/speed table exists for a material cut with a tool with a BRIGHT finish, but not for TI_N or BLACK_OXIDE tool finishes, then the speed values are derived from the BRIGHT table. The speed for TI_N is 1.5 times the BRIGHT speed. The speed for BLACK_OXIDE is 1.05 times the BRIGHT speed. The feed rates are the same as the BRIGHT feed rates.

Adding a new tool grade for turning operations

To add a new tool grade for turning operations:

1 Click Tool Grades on the Turning tab of the Feeds/Speeds And Cutting Data Tables dialog.

   The Turning Tool Grades dialog is displayed.

2 Click New, then enter the new Tool Grade Name and click OK.

3 Under When F/S table is undefined select either:
   ▪ Generate toolpath error if you want to define all table entries.
   ▪ Scale existing material to get values from another material.
      Select the existing material from the list and enter the scaling values for Speed and Feed.

4 Click OK to close the Turning Tool Grades dialog.

5 If you selected Generate toolpath error, enter values in the fields in the Feeds/Speeds And Cutting Data Tables dialog.

6 Click OK.

Feeds and Speeds database

The Feeds/Speeds And Cutting Data Tables dialog displays the information stored in the Feeds and Speeds database.

Use one of the following methods to display the Feeds/Speeds And Cutting Data Tables dialog:
- Select **Manufacturing > Feeds/Speeds And Cutting Data Tables** from the menu.
- Click **F/S Tables** on the **Material** page of the **Stock** wizard (see page 205).

**See also:**
- Wire EDM cut data (see page 1509)
- Stock material (see page 209)
- Initializing FeatureMILL databases (see page 1513)

### Use Range

For a rangeless table, deselect **Use Range**. The stock hardness value is ignored and a single feed/speed table is used.

For a ranged table, select **Use Range**. You must enter two values of hardness and two separate feed/speed tables are created. You must enter the values for both tables.

> For a stock hardness below the first value in the range, the table for the first hardness is used. For a hardness between the two range values, a table of interpolated values is used. Hardnesses above the last hardness value are invalid.

### Importing feeds/speeds or cutting data tables

1. Click **Import** in the **Feed/Speed And Cutting Data Tables** dialog to display the **Feed/Speed And Cutting Data Import** dialog.

2. Enter the path to the file or click **Browse for file location** and select it in the **Import** dialog and click **OK**.

   - **.fdb** files have been previously exported from FeatureCAM.
   - **.dxx** files are text files containing Wire EDM cut data.

3. Click **Import**.

4. If you are importing a **.dxx** file, you are prompted to enter the wire type, machine name and unit before the file is imported.

5. Select an option for handling new materials with the same name as existing materials:
   - Select **Overwrite material** if you want the new material to be copied over the old one.
   - Select **Skip material** to ignore any new materials with the same name as an existing material.

6. Click **Import**.
7 Click Close.

See also How to export feed/speed tables (see page 1851).

**Exporting feeds/speeds or cutting data tables**

1 Click Export in the Feed/Speed And Cutting Data Tables dialog to display the Feed/Speed And Cutting Data Export dialog.

2 Enter a pathname in the Export file name field, or click Browse and select a file location in the Export dialog.

3 In the Materials to be exported list, select any materials you want to export and deselect any materials you do not want to export.

   ![Click Include all items to select all materials, or click Exclude all items to deselect all materials.](image)

4 Select Milling to export milling tables.

   Select Turning to export turning tables.

   Select Wire EDM to export the cutting data for FeatureCAM.

5 Under Export F/S values in, select the units to export the tables in, from either Inch units or Metric units.

6 Click Export.

7 Click Close.

The file created is tab delimited text. You can edit the file in a spreadsheet if you want to. This file can now be imported (see page 1850) into FeatureCAM.

**Creating a text file for wire material databases**

A material database can be imported as an ASCII (readable text) file that can be created using a text editor (Notepad, Wordpad and so on). When you have written the file you should save it as plain ASCII text (if your editor offers more than one option) with a name that has the extension *.dxx such as Copper.dxx. You can import the file into the Feed/Speed and Cutting Data Tables dialog.

Format of the file:

<table>
<thead>
<tr>
<th>2.0</th>
<th>This value is a version number. It has no special function but should always be entered to maintain the file format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Thickness</td>
</tr>
<tr>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>COPPER 10.0</td>
<td>10.0</td>
</tr>
</tbody>
</table>
| COPPER 0.25 3 | **This line is the first line of a new material definition. The fields have the following functions:**
| COPPER - the name of the material |
| 10.0 - The material thickness |
| 0.25 - The wire diameter |
| 3 - the number of cuts |
| 1 1 1 0.1 | **This line specifies the generator and water settings, and so on, for the first cut. The fields are as follows:**
| 1 - the generator setting register number |
| 1 - the water setting register number |
| 1 - the compensation register number |
| 0.1 - The value of the compensation |
| 2 2 2 0.2 | The parameters as above but for the second cut |
| 3 3 3 0.3 | The parameters as above but for the third cut |
| COPPER 20.0 | 20.0 | 0.25 | 3 |
| COPPER 0.25 3 | **New Material** |
| 11 11 11 0.11 |
| 12 12 12 0.12 |
| 13 13 13 0.13 |
| COPPER 30.0 | 30.0 | 0.25 | 3 |
| COPPER 0.25 3 |
| 21 21 21 0.183 |
| 22 22 22 0.173 |
| 23 23 23 0.163 |
| COPPER 40.0 | 40.0 | 0.25 | 3 |
| COPPER 0.25 3 |
| 31 31 31 0.184 |
| 32 32 32 0.174 |
| 33 33 33 0.164 |
Adding default tools and feed/speed tables to the database

Each tool is identified by a tool name and each feed/speed table is defined by a combination of the stock material name, tool material, and tool grade.

Any tool or feed/speed table that you add to the database remains even if you re-run the INITDB program. INITDB does not overwrite any existing tools or feed/speed table in the database. The only way to remove them is to explicitly delete them in the Feed/speed table dialog or the Tool Manager dialog. See Deleting a tool from a tool crib for more information.

The two most common reasons for re-running INITDB are:

- Restoring default tools or default feed/speed tables that you have deleted.
- Adding tools specified in other units. You may have chosen to load only the inch tools the first time and you may now want to add the metric tooling.

To perform these tasks:

1. Exit FeatureCAM if it is open.
2. Run INITDB from the FeatureCAM group in the Start menu.
3. Select the units of tools you want to add. FeatureCAM does not alter any items that you changed or delete any items that you added.
4. Click OK.
5. If you added tooling of both units, you prompted to select which unit you use most often to model parts.
Recreating tooling and feed/speed databases if they become corrupt

If your tooling or feed/speed database becomes corrupt, you can recreate the databases using the INITDB program.

This procedure erases any changes you have made to existing tools or feed/speed tables and deletes any custom tooling or new feed/speed tables that you have created. Contact your FeatureCAM support person before performing this task.

To remove your database and recreate it:
1. Exit FeatureCAM if you are running it.
2. Run Windows Explorer.
3. Open the directory in which you installed FeatureCAM.
4. Open the database directory.
5. Click in the right-hand contents window.
6. Click Select All from the Edit menu.
7. Press the Delete key on the keyboard.
8. In Windows, select Start > All Programs > FeatureCAM > INITDB.
9. Select the units of tools you want to add. FeatureCAM does not alter any items that you changed or delete any items that you added.
10. Click OK.
11. If you added tooling of both units, you are asked which unit you use most often to model parts.

Cutting data by tool

You can associate cutting data with individual tools in the tool database at two levels:

- On the Overrides tab of the Tool Properties dialog. You can set cutting data for the tool for all materials and operations.
- On the Feed/Speeds tab of the Tool Properties dialog. You can set cutting conditions by material, operation, and cut type. These override any settings on the Overrides tab.

You can override these settings at feature operation level.
Tool overrides for all materials and operations

The new parameters on the Overrides tab of the Tool Properties dialog are Depth of cut (Z-step increment), Stepover distance, and Ramp angle.

Enter values to use with the current tool for all materials, except those overridden on the Feed/Speed tab, for example:

![Image of Tool Properties dialog showing overrides](image)

Tool overrides by material, operation, and cut type

As well as the previously available Speed and Feed settings, you can set Depth (of cut) and Stepover by Material, operation (Rough and Finish) and type of cut (Profile, Slot, Face, and Plunge Mill).

To do this, select the Feed/Speed tab of the Tool Properties dialog and click the Create new item button:

![Image of Tool Properties dialog showing overrides by material, operation, and cut type](image)
The **Tool Specific Feeds and Speeds** dialog is displayed. Select the **Material** name from the list and enter any **Depth** and **Stepover** overrides by operation and type of cut, for example:

![Tool Specific Feeds and Speeds dialog](image)

Click **OK**. The material is listed on the **Feed/Speed** tab:

![End Mill Tool Properties](image)

These material-based settings take priority over any on the global **Overrides** tab.
Post Options

The Post Options dialog controls the type of CNC machine that FeatureCAM targets for NC output. The dialog contains some auxiliary parameters used in post processing.

You can open the Post Options dialog in one of these ways:

- Select the Customize Mfg. step from the steps panel and select Configure post processor by clicking the Post Process Options icon.
- Select Manufacturing > Post Process from the menu.
- Click the name of the current CNC in the Status (see page 32) bar.

In the Post Options dialog, select the tab you want from:

- Milling (see page 1858)
- Turning or Turn/Mill (see page 1864)
- Wire EDM (see page 1870)
Milling tab

**CNC File** — This is the file name and location for the type of machine. The file is either one that comes as standard with FeatureCAM or one that you created with the XBUILD program. Click **Browse** to select your CNC file from the list of available files. Browse presents a list of files on disk. You may put your files anywhere on disk, but look in the **Posts** subdirectory of the **FeatureCAM** directory to find the CNC files that come as standard with FeatureCAM.

For example, if you installed FeatureCAM in C:\FeatureCAM, the pre-defined CNC files are in the following directory:

C:\FeatureCAM\Posts\Mill

See a description of some of the most-used CNC files for milling (see page 1860).

You can also use the Delcam post processor files *.pmopt and *.pmoptz with XBUILD.

Some XBUILD reserved words have no equivalent in PMOPT. However these are available as PMOPT user-defined parameters:

<table>
<thead>
<tr>
<th>XBUILD reserved word</th>
<th>PMOPT user-defined parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;P1&gt;</td>
<td>udp_P1</td>
</tr>
<tr>
<td>&lt;P2&gt;</td>
<td>udp_P2</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>
Some PMOPT capabilities are not supported by XBUILD. For example, XBUILD supports much wider variety of NC output for 2-axis milling than is currently unavailable in PMOPT. So if you choose PMOPT you lose such control of your NC code. PMOPT files do not support Turning and Wire EDM.

Select the file name and click **Open** to use a file.

**Edit** — This opens the post processor, XBUILD, for the current CNC file.

**Defaults** — Click this button to return all the **Post Options** attributes to their default values.

**Min Arc** — This defines the limit for any arc whose radius is transferred to the CNC machine as a line. Arcs greater than this limit are sent as arcs.

**Max Arc** — This defines the maximum arc radius. Arcs greater than this limit are translated into lines.

**Block Start** — This sets the starting line number for your CNC programs.

**Block Increment** — This sets the increment between line numbers in your CNC programs.

**Disable Macros** — This turns off macro generation for the NC code. This option is not available for all posts. Refer to Hole macros (see page 645) for more information about setting up macros.

**Enable Cut Comp** — This enables output of cutter compensation NC code.
Force segment start for each operation — Enable this option to force a Segment Start format for each operation. You can also set this option to ON or OFF in XBUILD in the General Information dialog.

If you have set this option in XBUILD, the Post Options dialog in FeatureCAM displays a message, either Force segment start for each operation is set to on in the current post or Force segment start is set to off in the current post.

You must close and reopen the Post Options dialog to see any changes.

Non-Modal Decel. override — This is an optional setting for the G-code for overriding the automatic deceleration of a control.

Tool Change Location — This is the point where the tip of the tool moves to prior to a tool change.

OK — Click the OK button to save your settings and close the dialog.

Cancel — Click the Cancel button to close the dialog without saving any changes.

### Milling Post Processors

<table>
<thead>
<tr>
<th>Post</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INMTCI/ M</td>
<td>Interact Manual Tool Change (Inch/Metric). Bridgeport Machines with Heidenhain 150,151,155 controls.</td>
</tr>
<tr>
<td>INATCI/ M</td>
<td>Interact Automatic Tool Change (Inch/Metric). Bridgeport Machines with Heidenhain 150,151,155 controls.</td>
</tr>
<tr>
<td>TN145I/ M</td>
<td>Heidenhain TNC 145 (Inch/Metric). Bridgeport machines using the TNC 131,135,145 controls.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BP320I/M</td>
<td>Bridgeport 320 Machining Center (Inch/Metric). Bridgeport 320 series horizontal machining centers with Fanuc 6M/11M controls.</td>
</tr>
<tr>
<td>BP380I/M</td>
<td>Bridgeport 380 Machining Center (Inch/Metric). Bridgeport 380 series horizontal machining centers with Fanuc 6M/11M controls.</td>
</tr>
<tr>
<td>BP520I/M</td>
<td>Bridgeport 520 Machining Center (Inch/Metric). Bridgeport 520 series vertical machining centers with Fanuc 11M controls.</td>
</tr>
<tr>
<td>BOSS3I/M</td>
<td>Bridgeport Operating Software Systems 3 (Inch/Metric). Bridgeport machines with BOSS3 control software.</td>
</tr>
<tr>
<td>BOSS6I/M</td>
<td>Bridgeport Operating Software Systems 6 (Inch/Metric). Bridgeport machines with BOSS6 control software.</td>
</tr>
<tr>
<td>BOSS7I/M</td>
<td>Bridgeport Operating Software Systems 7 (Inch/Metric). Bridgeport machines with BOSS7 control software.</td>
</tr>
<tr>
<td>BOSS8I/M</td>
<td>Bridgeport Operating Software Systems 8 (Inch/Metric). Bridgeport machines with BOSS8 control software.</td>
</tr>
<tr>
<td>BOSS9I/M</td>
<td>Bridgeport Operating Software Systems 9 (Inch/Metric). Bridgeport machines with BOSS9 control software.</td>
</tr>
<tr>
<td>BPSER2</td>
<td>Bridgeport Series II NC (Inch). Series II incremental controls.</td>
</tr>
<tr>
<td>BTC2I/M</td>
<td>Bridgeport BTC II (Inch/Metric). BTC II controls.</td>
</tr>
<tr>
<td>ABS7DI/M</td>
<td>Allen Bradley S7D3 (Inch/Metric). Bridgeport Series II CNC S7D3 (Manual tool change) with an Allen Bradley 8200 control.</td>
</tr>
<tr>
<td>Model</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AB845I/M</td>
<td>Allen Bradley 7-845 (Inch/Metric). Bridgeport Series II BMC 7-845 (Automatic tool change) with an Allen Bradley 8200 control.</td>
</tr>
<tr>
<td>OKUMA5</td>
<td>Okuma OSP5000 (Inch). General post for Okuma vertical mills using the OSP5000 control.</td>
</tr>
<tr>
<td>OK5MGI</td>
<td>Okuma OSP5000 (Inch). General post for Okuma vertical mills using the OSP5000 control.</td>
</tr>
<tr>
<td>FANU6M</td>
<td>Fanuc 6M (Inch). General post for mills using the Fanuc 6M control.</td>
</tr>
<tr>
<td>CINACR</td>
<td>Cincinnati Acramatic CNC-MC 2200B (Inch). General post for Cincinnati Milacron mills using the Acramatic CNC-MC 2200B control. This post is setup for vector type cutter compensation.</td>
</tr>
<tr>
<td>ACLOC</td>
<td>Acraloc CNC (Inch). General post for Acraloc mills.</td>
</tr>
<tr>
<td>MAZAK</td>
<td>Mazak CNC (Inch). General post for Mazak mills.</td>
</tr>
<tr>
<td>BANDIT</td>
<td>Bandit CNC (Inch). General post for mills using the Bandit control.</td>
</tr>
<tr>
<td>SYS10</td>
<td>Bendix system 10 (Inch). General post for mills using the Bendix system 10 or 20 controls.</td>
</tr>
<tr>
<td>MAHO60</td>
<td>Maho Model 600 (Inch). This post is specifically designed for the Maho Model 600 horizontal machine center with the Phillips CNC 432 Control. It will support the model 500 with a minimal amount of changes to the output.</td>
</tr>
<tr>
<td>ANILAM</td>
<td>Anilam (Inch). General post designed for mills using the Anilam control.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EZTRAK</td>
<td>Bridgeport EZ-Trak (Inch)</td>
</tr>
<tr>
<td>FADALI</td>
<td>Fadal Controls (Inch) Compatible with all Fadal Machines.</td>
</tr>
<tr>
<td>BOSS15 I V2XT KNEE MILL (INCH)</td>
<td>Bridgeport BOSS 15 (SX) based control. This post generates M26 for tool changes &amp; M22 for program rewind.</td>
</tr>
<tr>
<td>DSC300 I</td>
<td>Discovery 300 (Inch) Bridgeport BOSS 15(SX) based control. This post generates M6 for tool changes &amp; M22 for program rewind.</td>
</tr>
<tr>
<td>DSC308 I</td>
<td>Discovery 308 (Inch) Bridgeport BOSS 15(SX) based control. This post generates M6 for tool changes &amp; M22 for program rewind.</td>
</tr>
<tr>
<td>HD2500 MI</td>
<td>Heidenhain 2500 Manual Tool Change (Inch) Interact I Mark II knee mills with Heidenhain 2500 control. This post uses tool change positions and M25 code to change tools.</td>
</tr>
<tr>
<td>HD2500 AI</td>
<td>Heidenhain 2500 Automatic Tool Change (Inch) General post for machining centers with Heidenhain 2500 control. This post does not use tool change positions and uses M6 to change tools.</td>
</tr>
<tr>
<td>INT300I</td>
<td>Heidenhain 2500 (Inch) Interact 300 Machining Center with Heidenhain 2500 control.</td>
</tr>
<tr>
<td>INT308I</td>
<td>Heidenhain 2500 (Inch) Interact 308 Machining Center with Heidenhain 2500 control.</td>
</tr>
<tr>
<td>INTGI</td>
<td>Heidenhain G-Code (Inch)</td>
</tr>
<tr>
<td>OM550I</td>
<td>Bridgeport 550 Machining Center (Inch). Bridgeport 550 series horizontal machining centers with Fanuc -0-M controls.</td>
</tr>
<tr>
<td>FAN0M</td>
<td>Fanuc -0- M General post designed for mills using the Fanuc 0 M control.</td>
</tr>
<tr>
<td>PTRAKM X3</td>
<td>Proto Trak MX3 This post will generate 3 axis G-Code format programs.</td>
</tr>
<tr>
<td>850SXM</td>
<td>Cincinnati Avenger 850 Machining Center</td>
</tr>
<tr>
<td>DI308I4X</td>
<td>Discovery 308 with DX-32 Control &amp; Rotary Axis This post will support G97 origin translation without turning on indexing or wrapping. It also supports indexing and wrapping in both milling and drilling cycles.</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BOSSSX</td>
<td>This post for the BOSS SX15 controls supports a pneumatic indexer using an M51 code. Wrapping is not supported.</td>
</tr>
<tr>
<td>INMTCI4X</td>
<td>This post supports the rotary axis on Heidenhain 150, 151, and 155 controls. Indexing and wrapping are supported.</td>
</tr>
<tr>
<td>EZTRAKSX</td>
<td>Bridgeport EZ-Trak 2 or 3 AXIS conversational post; no cut comp.</td>
</tr>
<tr>
<td>TORQCUTTI</td>
<td>Bridgeport TORQ CUT 22 CNC uses 4th axis and MCSID</td>
</tr>
</tbody>
</table>

**Turning or Turn/Mill tab**

![Post Options](image)

**Post Options** in the **Manufacturing** menu controls the type of CNC machine that FeatureCAM targets for NC output.

The dialog contains some auxiliary parameters used in post processing.
**CNC file** is the file name for the type of machine. The file is either one that comes standard with FeatureCAM or one that you created with the XBUILD program. Click **Browse** to select your CNC file from the list of available files. Browse presents a list of files on disk. You may put your files anywhere on disk, but look in the **Posts\Turn** folder to find the CNC files that come standard with FeatureCAM. For example, if you installed FeatureCAM in "C:\FeatureCAM", the pre-defined CNC files are in the following directory:

*C:\FeatureCAM\Posts\Turn*

Select the file name and click **OK** to select a CNC file.

See a description of some of the most-used CNC files for turn (see page 1867).

**Defaults** returns all the Post Options to their default values.

**Max. speed** is the maximum spindle speed of your machine.

**Min. Arc** defines the limit for any arc whose radius is transferred to the CNC machine as a line. Arcs greater than this limit are sent as arcs.

**Block Start** sets the starting line number for your CNC programs.

**Block Increment** sets the increment between line numbers in your CNC programs.

A number of system features are enabled at the bottom of the dialogs. These settings allow these options to be individually set on features. Note that these settings must be set on the feature to be activated. By turning off these settings, the options is turned off system-wide. These options include:

**Enable Tool Nose Radius Comp**

Enable this option to ignore the tool radius when generating passes for Turn, Bore, and Face features. The actual part geometry is output as the toolpath. It is assumed that the tool radius compensation will be performed by the operator at the machine tool when this option is enabled.

Select whether you want **TNR comp** for **Rough**, **Semi-Finish**, and **Finish** operations. Enter the **Lead-in angle**, **Lead-out angle**, and **Lead distance** parameters for **TNR comp**.

**Turn feature example**

1. Lead-in angle
2. Lead-out angle
3. Lead distance
If you select **TNR comp** on the **Strategy** tab, the related attributes **Lead distance**, **Lead-in angle**, and **Lead-out angle** become available on the **Turning** (see page 1420) tab (for a rough pass) or the **Leads** (see page 1416) tab (for a finish pass).

*You can set the default value of this attribute for the current document in the Machining Attributes (see page 1591) dialog. See the Turn/Bore (see page 1689) tab.*

**Disable Macros** — This turns off macro generation for the NC code. This option is not available for all posts. Refer to **Hole macros** (see page 645) for more information about setting up macros.

**Enable Hole Canned Cycle** activates canned cycles for drilling. This is a global setting and cannot be set on individual hole features. Note the post processor must support canned cycles.

**Enable Groove canned cycle** activates canned cycles for grooving. This is a global setting and cannot be set on individual groove features. Note the post processor must support canned cycles.

**Enable Part catcher**

If enabled, the part catcher code is output after the Cutoff operation. The code for activating the parts catcher must be listed in your `cnc` file.

**Enable Turn Canned Cycle** activates canned cycles for turning and boring. It must also be turned on for individual features. See Use canned cycle for more information.

Enable this option to perform the feature’s operations using canned cycles. You must use a post that has support for roughing and finishing canned cycles.

*For support of canned cycles in Fanuc controllers, use the fanucez.cnc post.*

Canned cycles can be generated in the NC code for nearly every turned feature. To generate these macros, your post processor must support them, and you must turn this function on for the post and for some features you must also activate the canned cycles at feature level.

**Hole features**

If **Enable drilled canned cycles** is deselected in the **Post options** dialog, then all hole drilling operations are computed in the post. This includes spotdrilling, drilling, bore, ream, and tapping operations. If **Enable drilled canned cycles** is selected, then canned cycles will be output if the post you are using has g-codes defined for the hole canned cycles. If the post does not have these G-codes defined, the hole operations will still be computed.
There is no way to control the output of canned cycles on an individual feature basis.

**Turn/Bore features**

Canned cycles for Turn and Bore features must be enabled by selecting **Enable turn canned cycles** in the **Post options** dialog. You must then go to the **Properties** dialog for each Turn/Bore feature, click the **Strategy** tab and select **Use canned cycle**. Also select **Reuse path in canned cycle** if you want to output the path geometry only once for both roughing and finishing. You can also set these values in the default attributes, but these values will only apply to features you create after making this change.

**Groove features**

Enable grooving canned cycles in the **Post options** dialog by selecting **Enable groove path canned cycle**. Then turn on canned cycles for each groove by bringing up the feature's **Property** dialog, clicking the **Strategy** tab, and then clicking **Use path canned cycle**. You can also set this attribute on the **Groove** tab of the default attributes, but this will only apply to features you create after changing this setting.

**Thread features**

Thread features always use canned cycles.

**Tool Change Location** — Enter the point where the tip of the tool moves to before a tool change. This location is absolute.

### Turning Post Processors

<table>
<thead>
<tr>
<th>Post</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>850SXT</td>
<td>Cincinnati 850 Talon Lathe</td>
</tr>
<tr>
<td>850TC</td>
<td>Acramatic 850TC control. Inch format, OP STOP after tool changes, BLOCK DELETE (SKIP) at sync blocks. Turn off BLOCK DELETE to access sync block when restarting at other than start of program. Uses TOOL CHANGE location as positioning move in sync blocks.</td>
</tr>
<tr>
<td>ANILAM T</td>
<td>Anilam Lathe</td>
</tr>
<tr>
<td>FAN0TC</td>
<td>Fanuc 0TC controller. Inch format. Supports multiple repetitive cycles (G70/G71) and threading canned cycles (G76).</td>
</tr>
<tr>
<td>Model</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FAN6TI/M</td>
<td>Fanuc6T Control (Inch/Metric). General post for Lathes using the Fanuc6T control. The post is designed for computed threading and drilling cycle output.</td>
</tr>
<tr>
<td>FANUC11T</td>
<td>Fanuc 11T Lathe</td>
</tr>
<tr>
<td>FANUC3T</td>
<td>Fanuc 3T Lathe. This post is for a Fanuc 3TD control on a Mori Seiki SL - 1. G50's are used on every tool and after completion of the segment it is returned to the Home position by a G28 on the X axis first followed by the Z axis. X axis output is negative for all values since all cutting is done on backside of part.</td>
</tr>
<tr>
<td>G10_CYC</td>
<td>G10 Romi lathe with Fanuc 21i control. Supports Fanuc Canned Cycles: G83 Drilling, G84 Taping G70 Finishing Cycle, G71/72 Roughing Cycles, G76 Threading Cycle.</td>
</tr>
<tr>
<td>G30_CYC</td>
<td>G20 &amp; G30 Romi lathes with Fanuc 21i control. Supports Fanuc Canned Cycles: G83 Drilling, G84 Taping G70 Finishing Cycle, G71/72 Roughing Cycles, G76 Threading Cycle.</td>
</tr>
<tr>
<td>GE1050</td>
<td>General Electric 1050T Control. This is a general post designed for lathes using the General Electric 1050T control.</td>
</tr>
<tr>
<td>HARD6T</td>
<td>Hardinge Fanuc6T Control (Inch). General post for Hardinge Lathes using the Fanuc6T control. Instead of using G0 for rapid movements it uses feed rates of 200 inches per minute. The post is designed for computed threading, with canned drilling and grooving cycle output.</td>
</tr>
<tr>
<td>MAZAK TI</td>
<td>Mazak lathe with diameter output. Computed drilling and canned thread and groove. G42 left compensation. G41 right compensation.</td>
</tr>
<tr>
<td>MORSE K</td>
<td>Moriseki (Inch). General post for Moriseki lathes. The post is designed for computed drilling, threading and grooving output.</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MSL200</td>
<td>Moriseki SL200 Lathe. Inch format</td>
</tr>
<tr>
<td>NC-RUN</td>
<td>This is a special post created just for NC-RUN verification, it is based on the okuma OSP5000 control.</td>
</tr>
<tr>
<td>NEW6T</td>
<td>New Hardinge Fanuc6T Control (Inch). This is a modified version of the HARD6T post for Hardinge, It uses G0 for all rapid movements. The post is designed for computed threading, drilling and grooving cycle output.</td>
</tr>
<tr>
<td>OK500I /M</td>
<td>Okuma OSP5000 Control (Inch/Metric). General post for Okuma lathes using the OSP5000 control. The post is designed for canned cycle drilling, threading and grooving output.</td>
</tr>
<tr>
<td>OKLC3I /M</td>
<td>Okuma LC30 Lathe OSP3000 Control (Inch/Metric). General post for Okuma lathes using the OSP3000 control. The post is designed for canned cycle drilling, threading and grooving output.</td>
</tr>
<tr>
<td>PATH</td>
<td>*Bridgeport EZ-Path Lathe (without CSS). This post generates native conversational format programs.</td>
</tr>
<tr>
<td>PATH_CYC</td>
<td>Bridgeport EZ-Path Lathe (without CSS) with canned cycles. Conversational format programs. Supported Canned Cycles: ROUGH, PROFIL, GROOVE, THREAD, and DRILL.</td>
</tr>
<tr>
<td>PATHG</td>
<td>Bridgeport EZ-Path Lathe (without CSS). This post generates G-Code format programs.</td>
</tr>
<tr>
<td>PATHS</td>
<td>*Bridgeport EZ-Path S Lathe (with CSS). This post generates native conversational format programs.</td>
</tr>
<tr>
<td>PATHSG</td>
<td>Bridgeport EZ-Path S Lathe (with CSS). This post generates G-Code format programs. (with CSS)</td>
</tr>
<tr>
<td>PP15_CYC</td>
<td>Bridgeport PowerPath 15 Lathe with canned cycles. Supported Canned Cycles: ROUGH, PROFIL, GROOVE, THREAD, and DRILL.</td>
</tr>
<tr>
<td>PPATH</td>
<td>*Bridgeport Power-Path-15 Lathe. This post generates native conversational format programs.</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PPATHG</td>
<td>Bridgeport Power-Path-15 Lathe. This post generates G-Code format programs.</td>
</tr>
<tr>
<td>PTHS_CYC</td>
<td>Bridgeport EZPath S Lathe (with CSS) with canned cycles. Supported Canned Cycles: ROUGH, PROFIL, GROOVE, THREAD, and DRILL. (with CSS)</td>
</tr>
<tr>
<td>ROMI35I</td>
<td>Romi Lathe. This post is designed for the Romi</td>
</tr>
<tr>
<td>SBLI</td>
<td>South Bend Lathe (Inch) This post is designed for the Magna Turn Slant Bed CNC2000 lathe.</td>
</tr>
</tbody>
</table>

For Plain Language Dialog Post \((P1 = \text{Tool I.D.})\)

Wire EDM tab

![Wire EDM tab](image)

**Block Start** — This sets the starting line number for your CNC programs.

**Block Increment** — This sets the increment between line numbers in your CNC programs.

**Block Maximum** — This is the maximum block number for the CNC program.
Reorder cut comp moves for old Agie controls — Select this option if you are posting to a machine with a control from Agie. If selected, the lines of NC code that correspond to cutter compensation are output in a different order.

Skip moves that travel less than n % of wire diameter — This prevents moves that are too small from being sent to the EDM control. If a move is too small, it is not output. As soon as the program advances the wire to a point that is more than this threshold, then a move is output directly to that position.

In this example, if move 2 is too short, it is not output. If the distance from the end of move 1 to the end of move 3 is long enough, move 5 is inserted between moves 1 and 4.
Multiple fixture documents (2.5D & 3D)

If you want to cut different parts on your machine at the same time, use the Multiple Fixture document type. With multiple fixture parts, you can mix different setups from FeatureCAM parts. FeatureCAM can then create a single program for cutting all the parts and it can minimize tool changes across all parts.

Example of a multiple fixture part:

Creating a multiple fixture part

In FeatureCAM, a multiple fixture part can include Setups, UCSs, and part files.

To create a multiple fixture part:

1. Open any .fm files which contain Setups you want to add to the multiple fixture document.
2. Select File > New from the menu to display the New Part Document dialog.
3. Select Multiple Fixture from the Type list.
4. Select the Unit of Measure from either Inch or Millimeter.
5. Click OK to create a document.

The Multiple Fixtures dialog (see page 1873) is displayed.
You can use the **Multiple Fixtures** dialog to add and orientate parts and Setups.

**Multiple Fixtures dialog**

You can use the **Multiple Fixtures** dialog to add and orientate parts and Setups in the multiple-fixture document.

To display the **Multiple Fixtures** dialog:

- The **Multiple Fixtures** dialog is displayed when you create a multiple fixture document.
- Click **Parts** in the **Steps** panel, or double-click a space in the graphics window.

The **Multiple Fixtures** dialog contains the following options:

**Setups** — A list of all Setups in the multiple-fixture document.

  - Click **Up** and **Down** to move the selected Setup up or down in the **Setups** list.
  - Click **Include** or **Exclude** to include or exclude the selected Setup from the Process Plan. Excluded Setups have a * in the Excl. column of the **Setups** list.

**Tool Dominant** — When creating the toolpaths, FeatureCAM uses a tool everywhere possible before moving on to the next tool.

**Part Dominant** — When creating the toolpaths, FeatureCAM machines every part completely (within the limits of the setup) before moving on to the next part.

**OK** — Closes the dialog and accepts the changes.
**Cancel** — Closes the dialog and cancels any changes, including changes made in linked dialogs.

**Parts List** — Displays the **Part Files** dialog (see page 1875), which you can use to open part files so you can add Setups from them to the multiple fixture document.

**Fixtures** — Displays the **Fixture Offset Locations** dialog (see page 1876).

**Add** — Displays the **Setup** dialog (see page 1874), which you can use to add Setups to the multiple fixture part file.

> *The Add button is unavailable unless you have other part files open, or you have opened part files in the Parts List dialog.*

**Delete** — Deletes the selected Setup from the multiple fixture document.

**Edit** — Displays the **Setup Properties** dialog for the selected Setup.

**Machine Sim** — Displays the dialog where you can specify the machine design file and clamp locations.

### Add

You can use the **Add** function to add Setups from open .fm files to the multiple fixture part. To open part files, use the Part files dialog. (see page 1875)

To add Setups to a multiple fixture document:

1. Click **Add** in the **Multiple Fixtures** dialog (see page 1873) to display the **Setup** dialog.

> *The Add button is unavailable unless you have other part files open, or you have opened part files in the Parts List dialog.*
A list of setups in open .fm files is displayed.

2 Select a setup in the **Part/Setup** list.

3 Optionally enter a **Part Name**.

4 Click **Next** to display the **Fixtures** dialog:

![Fixtures dialog]

5 Select how you want to locate the new setups, select from:

- **Add the new setups to a predefined fixture**.
  
  Select a fixture from the list.

  *This option is unavailable unless you have already created a fixture using the **Fixture Offset Locations** dialog.*

- **Create a new fixture for each setup**.
  
  The default value for **Start fixture IDs at** is the number above the previously used fixture ID. You can enter a new value or use the default.

6 Click **Next** to display the **Configuration** dialog (see page 1878).

**Parts List**

Click **Parts List** in the **Multiple Fixtures** dialog (see page 1873) to display the **Part Files** dialog.
You can use the **Part Files** dialog to open part files, so that you can add setups from them to the multiple fixture document:

![Part Files dialog](image)

**FM Part Files** — A list of part files from which you can add (see page 1874) Setups. Open part files are displayed automatically.

**OK** — Closes the dialog and accepts the changes.

**Cancel** — Closes the dialog and cancels any changes.

**Browse** — Displays the **FM Part File** dialog. Select an `.fm` file and click **Open** to open the part file. You can add (see page 1874) Setups from any open part files to the multiple fixture document.

**Reload** — Updates the selected part file in the multiple fixture document if the source file has changed.

**Delete** — Removes the selected part file from the **FM Part Files** list. This option is unavailable for part files currently being used by the multiple-fixture document.

**Fixture Offset Locations dialog**

You can use the **Fixture Offset Locations** dialog to create, edit, and delete fixtures in a multiple fixture document.

To display the **Fixture Offset Locations** dialog:

- Click **Fixtures** in the **Multiple Fixtures** dialog (see page 1873).
Click **Fixture ID** in the **Steps** panel.

**Fixture ID** — A list of fixtures in the multiple fixture document.

**Add** — Displays the **Fixture** wizard for creating a new fixture.

**Delete** — Deletes the selected fixture.

**Edit** — Displays the **Fixture** wizard for editing the selected fixture.

**OK** — Closes the **Fixture** wizard and accepts the changes.

**Cancel** — Closes the dialog and cancels any changes.

**Fixture wizard**

You can use the **Fixture** wizard to create a new fixture, or edit an existing fixture.

To use the **Fixture** wizard:

- to create a new fixture, click **Add** in the **Fixture Offset Locations** dialog (see page 1876).
- to edit an existing fixture, select a fixture in the **Fixture Offset Locations** dialog (see page 1876) and click **Edit**.

The first page of the **Fixture** wizard is the **Fixture ID** page:
Optionally enter a **Fixture ID** to overwrite the default. The default value is numbered sequentially from the previously used value.

Click **Next** to display the **Fixture Zero Location** page:

![Fixture Zero Location](image)

Enter the X, Y and Z coordinates of the fixture zero location in the X, Y and Z fields.

Click **Preview** to display a preview of the fixture in the graphics window. A 🕳️ symbol **Fixture ID** next to it shows the location of the fixture in the graphics window.

Click **Finish** to accept the changes and close the wizard.

The **Fixture Offset Locations** dialog (see page 1876) is displayed.

**Configuration**

You can use the **Configuration** dialog to specify the number of copies and locations of Setups.

![Configuration](image)

To complete the **Configuration** dialog:

1. Enter the coordinates of the origin of the first Setup in the X, Y, and Z fields.
2 If you want to repeat the Setup in the multiple fixture document, enter the number of repeats and the spacing between Setups. Repeated Setups are organized in a rectangular array.

**X spacing** and **Y spacing** are the spacings between part origins. Depending on your post, these spacing numbers might not have any effect on the part as produced at the machine. That is controlled by the **Fixture ID** and how the Fixture ID is used to locate other parts relative to each other.

*You can enter negative values.*

Repeated Setups' **Fixture IDs** are numbered sequentially from the previously used number.

3 Click **Next**.

If you entered values in the **X repeats** or **Y repeats** fields, the **Layout** (see page 1879) tab is displayed, where you can specify the layout of the repeated Setups.

If there is only one Setup, the **Preview** (see page 1883) dialog is displayed.

### Layout

You can use the **Layout** dialog to specify the layout of repeated Setups:

- **Individual Blocks** (see page 1880) — Simpler to design, but less efficient.
- **Single Block** (see page 1880) — Minimizes waste, but more difficult to layout and fixture.
Individual blocks

1. Select **Individual Blocks** in the **Layout** (see page 1879) dialog:

   ![Layout dialog]

2. Click **Next** to display the **Preview** dialog. (see page 1883) A preview of the Setups is displayed in green in the graphics window.

Single block

To create a single block layout:

1. Select **Single Block** in the **Layout** (see page 1879) dialog to display the Single block options:

   ![Layout dialog]

2. Select **Retract** if you want the tool to retract to the home position after each operation.

3. Optionally select **Nested** to display the nesting options. (see page 1881)

4. Click **Next** to display the **Stock** (see page 1882) dialog.
Nested

You can set the following nesting options in the Layout dialog (see page 1879):

![Layout dialog](image)

**Nested** — FeatureCAM rotates and flips the part geometry to find the most efficient layout, to reduce the waste material when cutting some parts.

**X shift** and **Y shift** — The distances between the origins of nested objects in the X and Y axes.

*These options only applies to the inverted row or column; the spacing between objects on the same row or column is dependent on the X spacing and Y spacing values in the Configuration dialog (see page 1878).*

*These options are only available if Nested is selected.*

*You can enter negative values.*

Click **Next** to display the Preview dialog (see page 1883).
Stock

You can use the Stock dialog to specify the size and location of the stock:

1. Enter the coordinates of the stock origin in the X, Y and Z fields. The default block size is calculated as the minimum block size that will contain all the parts in the document with the spacings specified in the Configuration dialog.

2. If you want to use a stock with a specific size, enter the dimensions in the Length, Width, and Height fields.

3. Click Auto to calculate the minimum block size that will contain all the parts.

4. Click Next to display the Preview dialog (see page 1883). A preview of the layout is displayed in green in the graphics window.
Completing the multiple fixture part

The Preview page is displayed, and a preview of the Setup(s) is displayed in green in the graphics window.

![Preview dialog](image)

If you want to change any settings, click Back until you reach the page you want to change.

Click Cancel to close the wizard and cancel any changes.

Click Finish to accept the changes and close the Preview dialog.

The Multiple Fixtures dialog is displayed.

You can repeat the Add (see page 1874) process to place more Setups or parts in the whole layout as needed to complete the task. You can add a mixture of single and individual block layouts.

To save the changes, click OK in the Multiple Fixtures dialog.

![Warning icon](image)

*If you click Cancel, or you close the dialog without clicking OK, any changes you made in previous dialogs are lost.*

You can edit (see page 1883) a Setup or part after you have added it to the multiple fixture document.

Editing a multiple fixture document

You can use the Setup Properties dialog to edit a multiple fixture document after you have created it.

To display the Setup Properties dialog:

- Right-click a Setup or part in the graphics window and select Properties from the context menu.
- Select a Setup in the Multiple Fixtures dialog (see page 1873) and click Edit.

![Multiple Fixtures dialog](image)

The tabs contain the options from the Setup, Fixtures (see page 1874), Configuration (see page 1878), Layout (see page 1879), and Stock (see page 1882) dialogs.

The Layout and Stock tabs are not available for non-repeated parts, and you cannot create repeats of a part after it has been added to the multiple fixture document.

You can modify the spacing, shift spacing, nesting, and so on in the Properties dialog. You can also change the Setup name and fixture ID directly in the Name tab.

### Saving and opening multiple fixture parts

Multiple fixture documents are saved as MF Documents with the file extension .mf.

To open a multiple fixture document:

1. Select File > Open from the menu to display the Open dialog.
2. Select FM Documents (*.fm) from the Files of type list.
4. Click Open.
Tombstone machining (TOMB)

If your milling machine is equipped with a tombstone, FeatureCAM makes it easy to take advantage of this high production feature.

Tombstone parts are saved in files with the .tsf extension. When opening tombstone documents change the Files of type to be TSF Documents (*.tsf) to view the tombstone documents saved on your disk.

You must license the Tombstone machining option to use tombstone machining.

Overview of tombstone machining

The tombstone fixture document enables you to arrange FeatureCAM milling parts on a tombstone for production manufacturing.

Your first step is to describe your tombstone (see page 1887). Tombstones for vertical and horizontal milling machines are supported. Specify the number of faces and the dimensions of a face. These dimensions are remembered for future parts.

Next use the tombstone wizard to open FeatureCAM parts and position them on the tombstone (see page 1893). You can cut multiple copies of a single part or mix different parts on the tombstone. You can order the operations automatically to minimize tool changes across all setups or to cut each setup completely before rotating.

Example of four parts on a two face horizontal tombstone
Example of twelve parts on a six face horizontal tombstone

Example of four parts on a four face vertical tombstone.

Creating a tombstone machined part

To create a tombstone machined part:

1. Select File > New from the menu or click the New button from the Standard toolbar.
   The New Part Document dialog opens.
2. Select Tombstone Fixture as the type.
3. Select the system units you will use for the multiple part document. This is the unit you will use to specify the size of the tombstone and to position the parts on the faces of the tombstone. It specifies the system of units for all parts that you will place on the tombstone.
4. Click OK.
5. If it is the first time you have created a part for tombstone machining, specify the dimensions of the tombstone (see page 1887).
6. Add parts to the tombstone (see page 1893).
**Specifying tombstone dimensions**

It is important to accurately reflect the dimensions of the tombstone because these dimensions are used to simulate toolpaths and to calculate the required retract distances.

To specify the dimensions of the tombstone:

1. If the **Tombstone Dimensions** dialog is not already open, click the **Tombstone** step in the **Steps** Toolbox to open it.

2. Select the **Axis of rotation** for the tombstone. For horizontal machining centers, this is normally the Y axis. For vertical machining centers, this is normally the X axis.

3. Enter the **Number of faces** of the tombstone.

4. Enter the dimensions as indicated on the diagram on the dialog:
   
   a. Enter the axis **Length**. This is the dimension of the tombstone parallel with the tombstone axis.
   
   b. Enter the **Width of Face**. This is the dimension that is perpendicular to the **Axis Length**.

   For a tombstone with four faces, enter **Width of Face1** and **Width of Face2**.

   c. Enter the **Tombstone Thickness**. For a tombstone with an even number of faces, this is the distance between parallel faces. For a tombstone with an odd number of faces it is the perpendicular distance from a face to the joint of faces on the opposite side of the tombstone.

5. Click **OK** to close the dialog.
Handling multiple tombstones

If you have more than one tombstone in your shop, you can simply enter the dimensions of the tombstone with each part, but there is an easier way. The dimensions of the tombstone are stored in the tombstone part file (.tsf file extension). If you create a blank tombstone file for each tombstone in your shop, you can use these files as a starting point for each tombstone part. Make sure to save your part under a different name so that you do not overwrite your initial blank tombstone file.
Tombstone global fixtures

You can create global fixture coordinate systems relative to the existing part setups (see page 1889) or relative to tombstone faces (see page 1890).

Creating global fixture coordinate systems from Setups on placed parts

If you want to use a Setup of a part that you have placed on the tombstone to locate other part Setups, use the following procedure:

1. Open the Fixture Offset Locations dialog in one of these ways:
   - Click the Fixture ID step in the Steps Toolbox.
   - Click the Fixtures button in the Tombstone Process Plan dialog.

2. Click the Add button. The Fixture Location wizard is displayed.

   - Click the Fixture ID step in the Steps Toolbox.
   - Click the Fixtures button in the Tombstone Process Plan dialog.

3. Select Create the fixture zero at the origin of a setup and click Next. The Select Fixture Setup page is displayed.

4. Select the Setup whose origin you want to use and click Next. The Fixture ID page opens.

5. Enter the Fixture ID to use for the first face. You probably don't need to change the default value because it was set when you placed the first part.
6 If you want to set the origin of each face at the same point, select **Use the same fixture ID on each orientation**.

7 If you want to use a different origin for each face, select **Increment the fixture ID for each orientation**.

8 Click the **Finish** button.

   The fixture offsets you create are displayed, in the Graphics window, on each face of the tombstone with the ⚘ symbol. The **Fixture Offset Locations** dialog lists the fixture IDs you created.

9 Click **OK** to accept them.

   The faces that they apply to are shown underneath the fixture IDs.

10 Click **OK** to accept the settings and close the **Tombstone Process Plan** dialog.

---

**Creating global fixture coordinate systems on the tombstone**

The first step to placing parts on the tombstone is to locate a point on the tombstone to position the primary setups of the parts. These coordinate systems are created relative to the tombstone and are called global fixture coordinate systems.

1 Open the **Fixture Offset Locations** dialog in one of these ways:

   - Click the **Fixture ID** step in the **Steps** Toolbox.
   - Click the **Fixtures...** button in the **Tombstone Process Plan** dialog.
2 Click the **Add** button. The **Fixture Location** wizard opens.

![Fixture Location wizard](image)

3 Select **Create the fixture zero relative to one of the faces of the tombstone** and click **Next**.

The **Fixture ID** page opens.

4 Enter the **Fixture ID** to use for the first face.

5 If you want to set the origin of each face at the same point, select **Use the same fixture ID on each orientation**.

6 If you want to use a different origin for each face, select **Increment the fixture ID for each orientation**.

7 Click the **Next** button.

8 The **Fixture Zero Location** page opens. Enter the offsets from the left/right edge, top edge and tombstone face.

   *These values are for simulation purposes only. When you set up the machine you can locate the origin anywhere on the face that you want.*

9 Click the **Finish** button.

The fixture offsets you create are displayed on each face of the tombstone with the symbol.

The **Fixture Offset Locations** dialog lists the fixture IDs you created.

10 Click **OK** to accept them.

The faces that they apply to are shown underneath the fixture IDs.

11 Click **OK** to accept the settings and close the **Tombstone Process Plan** dialog.

**Tombstone Process Plan dialog**

Open the **Tombstone Process Plan** dialog in one of these ways:

- Click the **Parts** step in the **Steps** toolbox.
- Click the **Properties** button at the bottom of the Graphics window.
- Select **Manufacturing > Process Plan** from the menu.

![Tombstone Process Plan dialog](image)

**Fixtures** — Click this button to open the **Fixture Offset Locations** dialog.

**Add Part** — Places a part (see page 1893) on one face of the tombstone.

**Add To All** — Places a part (see page 1893) on all faces of the tombstone.

**Delete** — Removes a face from the tombstone, or a part from a face of the tombstone. Select the entity name in the list and click **Delete**.

**Edit** — Lets you modify the location of a part on a face, or a setup name or fixture ID. Select the entity in the list and click **Edit**. If you selected a part, the **Edit Part Location** dialog is displayed. If you selected a setup, the **Edit Setup Information** dialog is displayed.

**Reload** — Reloads the selected part file into the tombstone document. If the part file has changed since you created the tombstone part, you must reload the part.

**Machine Sim** — Opens a dialog where you enter the location of the bottom of the bottom-most clamp, and the location of the machine design file, for simulation purposes.

**Tool Dominant** — If you want the ordering of operations to minimize tool changes across all setups, select **Tool Dominant**.

> You must also select **Minimize tool changes** in the **Automatic Ordering Options** (see page 1553) dialog for **Tool Dominant** to work correctly.
Setup Dominant — If you want the ordering of operations to complete each setup before moving on to another setup, select Setup Dominant. The milling ordering attributes determine the order in which operations are performed within a setup.

OK — Accept changes and close the dialog

Apply — Accept changes and keep the dialog open.

Help — Opens this Help topic.

Adding a part to the tombstone

To add a part to the tombstone:

1. Open the Tombstone Process Plan (see page 1891) dialog.
2. Click the Add Part button to place a part on one face of the tombstone, or Add To All to place a part on all faces of the tombstone.
   The Select Part page is displayed and all open part files are listed.
3. Do one of the following:
   - Select a part file from the list.
   - Click Browse, browse to the location of the file, click Open and select the part file in the list.
4. Click Next.
   The Primary Setup page is displayed.
5. Select the name of the setup to orient the part on the tombstone. The Z-axis of the primary setup is oriented perpendicular to the face of the tombstone.
6. Click Next.
   The Active Setups page is displayed.
7. Select each setup that will be active on the tombstone and click Next.
   The Select Fixtures page is displayed.
8. To assign the part to an existing fixture ID, select Use a predefined fixture ID and select a fixture in the list.
   To assign the part to a new fixture ID:
   a. Select Create a new fixture zero at the setup origin.
   b. Enter the Fixture number.
   c. Click Next.
d When locating a part on a single face, select whether to locate the primary setup relative to the tombstone face or to an existing fixture.

9 Click Next.

The **Part Location** page is displayed.

10 Specify the offset of the part’s setup from the location selected in the **Select Fixture** page.

![These values are for simulation purposes only.]

11 Click Next.

The **Preview** page is displayed, and a wireframe preview of the part is displayed in the graphics window.

12 Click **Finish** to add the part and close the dialog.
Machine Simulation

FeatureCAM's Machine Simulation enables you to see the whole machine in a view that is similar to FeatureCAM's 3D simulation. Machine Simulation is intended to complement the standard simulation types of Centerline, 2D, 3D, and 3D RapidCut. With these other types of simulation you can see only the stock and the current cutting tool. This is enough for simple machines, but more complex machines such as multi-axis turning and 5-axis milling need simulation of the entire machine in order to help you understand how the machine cuts your part. You can detect odd motions and collisions so that you can adjust the program before code is sent to the CNC machine. You can expect to save a lot of time by proofing your NC code on the PC before sending it to the machine.

A few simple example machines are provided with FeatureCAM. But the ability to design a machine from scratch is also included in FeatureCAM as a document type called a Machine Design (MD) document. The file extension is .md. The process of designing a machine consists of creating solids and establishing movement relationships between them. Because machine design relies on solids, you must either create them in FeatureCAM or import them from another CAD system. You must license the Solid Modeling or a solid import component. After the solids are present in an MD file, you establish relationships between them. This capability is part of the MD document type and is independent of solid modeling or solid import.

Machine Simulation applies to every machine type except wire. The full range of milling machines is supported, such as 2.5-axis, 3-axis, 4-axis indexers and rotary tables, and 5-axis machines of all types. Turning is also fully supported: simple 2-axis turning, Y-axis, C-axis, turn/mill with rotary (live) tooling, sub-spindle, and multi-axis multi-turret turning. You can also create auxiliary machine functions like parts catchers, tool changers, bar feeders, and so on, possibly using some coding in BASIC using FeatureCAM's API.

Using Machine Simulation

To use Machine Simulation you must:

1. Choose a machine.
2. Choose a corresponding post processor.
3. Open a part file that uses the kind of machining done on the chosen machine.
Choosing a machine

In order to use Machine Simulation you first need to specify a machine for each Setup. Every Setup can have its own machine (.md file), or you can specify a machine in the first Setup to apply to all Setups. You can change which machine is used by the Setup by editing the Setup properties (see page 1896).

Choosing a post processor

It is important to have an appropriate post processor (.cnc file) loaded. So make sure that you've got an .md file that has the same configuration as the post processor that you have selected.

Using Machine Simulation

After you've established a machine for the Setup, you can select View > Simulation > Machine Solid from the menu. Or click the Machine simulation button in the Simulation toolbar. Then click the Play button to start the simulation.

Examples

You should try running the examples that are provided with FeatureCAM. In the Examples\Machine Design folder there are several folders each containing three files:

- a machine design file (.md)
- a post processor file (.cnc)
- a sample part file (.fm)

To see full machine simulation:

1. Load the .fm file.
2. Load the post processor.
3. Select Machine simulation button in the Simulation toolbar. Then click the Play button.

In these examples you do not need to set the machine design file for each Setup because the part file specifies using one in the post processor file, which in turn references the machine design file in the same folder.

Specifying the machine simulation file

The Machine Simulation file is associated with the Setup. For files where you simulate multiple setups such as indexed or turn/mill parts, you should associate the machine file with the first setup of a part.
To specify a machine simulation file:

1. Open the **Setups** dialog in one of these ways:
   - Select **Manufacturing > Setups** from the menu.
   - Double-click the Setup name in the **Part View**.
   - Select **Properties** from the Setup's context menu in the **Part View**.
   - Double-click the Setup in the graphics window.

2. Click the **Edit** button.

3. Click the **Next** button until the **Setups > Simulation Information** dialog is displayed.

4. Enter the **X Offset**, **Y Offset**, and **Z Offset** parameters. These represent offsets for loading the part onto the machine. For simulating single milling or turning setups these offsets are applied to the setup after the part is aligned with the top-most location (see page 1912). For indexed parts or turn/mill parts, the offset is relative to the stock axis.

5. The **Simulation machine design file** section has these options:
   - **Always use this one** — Select this option if you want to identify a specific file. Browse to the location of the Machine Design file.

   > The number of turrets and locations of the turrets must match the selected post processor.
Use the one specified in the .cnc file — Select this option to use the machine specified in the post processor .cnc file.

Removing objects from the simulation

During a machine simulation you can remove an object (such as machine doors) from the scene. To do this:

1. Click the Select button.
2. Click on an object.

This removes the object from the simulation temporarily; it does not delete it. To show all solids, select View > Show All when the simulation is still shown.

Shadows

If you are using graphics hardware for OpenGL shading you can display shadows in your simulation. The image shows an example of shadows displayed when using machine simulation.

The quality of the shadows is controlled by the Shadow quality slider on the 2D/3D shaded tab of the Simulation Options (see page 1525) dialog. If the slider is dragged all the way to the left to None, then shadows are turned off. As you drag the slider to the right the quality of the shadows improves. Be aware that this option can slow down the simulation.
Creating a Machine Design document

In the New Part Document (see page 63) dialog there is an option for file type Simulation Machine Design. Files of this type have a .md extension (MD for machine design). In these types of files you design solids that collectively represent a CNC machine and specify how these solids interact or move according to how your machine operates. (You must have the ability to at least import solids, that is, you must have the solid import plugin installed which comes with the FeatureRecognition product, the 3D milling product, and the advanced solid modeling product).

Each solid represents a particular part of your machine, and it is important that you model each movable part of your machine as an independent solid. That is, do not make use of the solid wizard's Combine Solids command to union two tables into one solid, because you need to rotate one table independently of the other. If you have imported a file and it contains only one solid, use the Explode Solid (see page 491) method and then reconstruct multiple solids from the exploded surfaces (probably constructing additional surfaces as well).

In an MD document, there are no manufacturing-like commands. That is, there is no stock, no Setups, no simulation, and no manufacturing attributes, manufacturing menu, and so on. The purpose of the document type is to design solids, and to assign attributes to the solids that match your particular machine movement and machine hierarchy. An example of a machine hierarchy is that tableA is on top of tableB and so, whenever you rotate tableB, tableA is also rotated. This is called a parent/child relationship (see page 1910).

General guidelines

Some general guidelines for machine design:

- You should design the machine in its home state. Design the machine in the file as it is when you first power-on the real machine.

- All FeatureCAM movements are programmed relative to the tool direction. For example, if FeatureCAM wants to move the tool in a positive X direction, and your machine tool is stationary, but the tables move, the +X tool direction is equivalent to moving your table in a negative X direction.
• If you are designing a 4-axis or 5-axis machine, a single solid can rotate only about one axis. Unlike the human wrist, for example, machine joints are modeled as single revolute joints (only allow rotation about one mechanical axis).

• Your .md file should match your .fm and .cnc files. If, for example, your part file (.fm) is defined as **Indexing around the X axis**, you should design your machine so that the degree of rotation is about the world X also. (Although we have plans to remove this restriction in the future, it simplifies the design process if your wrapping axis matches your .md file rotation axis). Also consider your post (.cnc file); if your .md file specifies two turrets, you must use a .cnc file that enables twin turrets or the simulation is unpredictably wrong, and so on.

• Using our approach, you should be able to model most lathes as well as most of the traditional 4-axis and 5-axis machines. (Traditional meaning table-on-table, rotating head(s), and so on). Non-traditional 4-axis or 5-axis machines such as a machine which 3 linear motors push and pull 3 different points of the table (or tool) to effectively rotate the table through A and B, are not supported by the framework. (It may be possible to program these in our BASIC API).

• Mixing units is supported, that is, you may model your machine in millimeters, and use it when simulating an inch .fm document and vice-versa.

• Keep the model simple. Only the necessary details of a machine should be modeled. Modeling every chamfer, fillet and tiny detail is only going to slow the simulation down.

• There are several attributes which are based on the name of the solid. This means if you want to rename some or all of the solids, you should use the rename commands before you begin using the machine design commands.

• FeatureCAM cannot distinguish a crash (sometimes called a clash or gouge) and the case where a table slides along another table such that the two tables share a common plane. We advise that you avoid modeling such solids. Use **solid offset** or **transform** by small amounts (for example, 0.005 inches) to eliminate false gouges in the simulation.

• Although you can use STL data for machine simulation, surface-based data is better.

• Solids must be closed. No open faces are allowed.
Machine Design concepts

Parent/child relationships

Think of a machine as a hierarchy. For example, when the slide on a lathe moves back and forth, the turret moves with it in lock-step. The turret is considered to be a child and the slide is considered to be a parent. In this manner, if the G-code specifies a certain movement, you can assign that movement to the parent and all of the children move with it. That way you don’t need to specify how every piece of the machine moves independently.

Movement

You assign a piece of the machine to a particular movement. For example, you could assign a slide on a lathe to Z movement. So whenever the G-code has a Z move, the slide moves accordingly. If the slide is a parent of a turret, the turret moves too.

Top-most table

A milling machine has a top-most table that the fixture, vise, or stock from the FM file must mate to. A turning machine has a similar concept with the main-spindle chuck.

UCS/LCS

FeatureCAM users are familiar with the term UCS (User Coordinate System). UCSs are critically important in machine design. The term LCS (Local Coordinate System) is sometimes used and is equivalent to UCS.

Mate

A mate is a term from assembly modeling (or constraint-based positioning). Suppose there are 2 similarly sized cubes in space, randomly oriented and you want cube1 to be totally coincident with cube2 so that a specific corner of each cube occupies the same point as a specific corner of the other cube, and the edges are parallel and, in fact, coincident. Suppose further that there is a UCS that describes the position of the interesting corner of each cube and the orientation of the edges of that cube. We want to mate the UCS of cube2 to that of cube1, that is, we find a transformation (translation and rotation) such that the origins of the UCSs are made to be concentric, and the X, Y, and Z directions are the same. That is, there is one transformation (and only one) which takes cube1 (or cube2) and moves it to where you want it.
**Lathe design overview**

Lathe tool inserts cut the stock when they are parallel to the Setup's XZ plane. You must design your lathe machine so that a lathe tool in slot 1 can be moved into the XZ plane. FeatureCAM does not initially rotate the turret.

The following image shows a turret that is modeled incorrectly. The turret solid can't be moved such that the tool in slot #1 can cut in the XZ plane of the chuck without rotating the turret. In this situation, you should rotate the turret solid so that the tool is in the XZ plane of the chuck.

FeatureCAM assumes that the tools point toward the center of the chuck. If that is not the case with the machine you are modeling, FeatureCAM needs the flexibility to move the turret so that the tool points toward the center of the chuck. In the example shown below, the tools are parallel to the XZ plane, but they do not line up with the chuck's center. In this case you should tell FeatureCAM that part of your machine moves in Y, when in reality, your machine cannot move in the Y axis. FeatureCAM needs to move the turrets in Y so that the tools can be translated into the chuck's XZ plane.

*The machine simulation does not affect the NC code. No actual Y moves are included in the NC code.*
It is not necessary or desirable to include the tool holders in the .md file. However, the tool blocks are part of the lathe machine.

**About UCSs for machine design**

The key to a Machine Design file that properly simulates the target machine lies in the correct placement of the various UCSs. These UCSs are used to control both mating and movement. Mating controls how various components are positioned and oriented with respect to each other.

Some of the important mate interactions are:

- Stock and machine table/chuck (see page 1912)
- Tool and milling spindle (see page 1915)
- Tool holders and turning turret (see page 1923)
- Tool and tool holder on turning turret (see page 1923)

Some UCSs affect the direction of linear or rotational movement of machine components. Linear movements in the machine simulation take place in the coordinate system for the top-most table. That is, if you’ve used **Specify Movement** (see page 1904) to indicate that a turret slide can move in X, it is the X direction of the top-most table UCS that indicates the direction of translational freedom.

Rotational motion, however, is determined by a UCS specifically associated with the particular solid that is rotating. This is done in the **Local Coordinate System** (see page 1923) dialog.
Configuring the machine

Think of Machine Design files as consisting of two parts:

- A model of the physical machine to be simulated, which is a set of geometric solids.
- The definition of the kinematics that describe how the components move with respect to each other in the machine.

You can find basic information about preparing your solid model in the General guidelines (see page 1899) topic, and additional suggestions in the Preparing the solid model (see page 1946) topic of the Machine Design handbook (see page 1945).

You define the kinematics within the FeatureCAM Machine Simulation component. The following topics give information about the concepts you need to understand, as well as how to use the dialogs and menus provided for machine design.

You can delete a machine design (movement, parent/child relationships, tool location, and so on) by selecting Machine Design > Start over from the menu. This does not delete solid names, solid colors, and UCSs.

Specify Movement dialog

If a part on a machine moves independently, you must specify the way it moves in the Specify Movement dialog.

To open the Specify Movement dialog, select Machine Design > Specify Movement from the menu.
If the solid moves only through the association with its parent solid, you do not need to specify any additional movements for that solid.

There are two major categories of movement: **Tool quill** and **Table**. There are translational and rotational options for each category. The movements specified under **Tool quill** move in the same direction as the tool. If the tool moves in the +X direction, the solid also moves in the +X direction. Solids in the **Table** category move in the opposite direction. To affect a +X tool movement, a table solid must move in the -X direction.

After you determine whether the solid is a **Tool quill** or a **Table** solid, indicate how the solid moves by selecting the appropriate options. For **Tool quill** solids, select **Moves +delta X**, **Moves +delta Y**, or **Moves +delta Z** for translational movements. Select **rotates +A**, **rotates +B**, or **rotates +C** for rotational movements. For **Table** solids the translational options are **Moves -delta X**, **Moves -delta Y**, or **Moves -delta Z** and the rotational movements are **rotates -A**, **rotates -B**, or **rotates -C**.

One special case of movement that must be specified for lathes which support a sub-spindle is the **Moves as Turn spindle** option. Select this option for the solid that supports the sub-spindle and performs the independent Z movement.

To use this dialog:

1. Select or pick the **solid**.
2. Select the appropriate type of movements.
3. Click the **Apply** button.
4. Use the **Specify Limits** tab (see page 1906) to set the limits of movement.
Specify Limits tab

You can use the Specify Limits tab of the Specify Movement dialog to set the limits of movement for solids in a Machine Design document.

To specify the limits of movement for a solid in the Machine Design document:

1. Select the Machine Design > Specify Movement menu option. The Specify Movement dialog is displayed.
2. Use the Specify Movement tab to select the solid and specify how it can move.
3. Use the Specify Limits tab to specify the linear and rotational limits of movement.

There are several example MD files that have limits of movement set. These are located in \FeatureCAM\Examples\Machine Design\Axis Limits.

To display a warning if the machine exceeds its limits of movement during a machine simulation, select Pause on limits on the 2D/3D Shaded of the Simulation Options dialog.

A message dialog is displayed when the machine moves outside the specified limits if Pause on Limits is selected.
The **Outside of Limits** message dialog displays this information:
- The name of the solid that has exceeded its limits.
- The axis in which the solid has exceeded its limits.
- The specified limit.
- The solid’s current position.

You can select these options in the **Outside of Limits** message dialog:
- **Don’t pause for this solid again** — Select this option to run machine simulations without pausing when this solid exceeds its limits.
- **Don’t pause on limits again** — Select this option to run machine simulations without pausing when any solids exceed their limits.

**Part Handling Movement dialog**

Use the **Part Handling Movement** dialog to program steady rests and tailstocks.

To display the **Part Handling Movement** dialog, ensure the **Machine Design > Enable Turn/Mill UI** menu option is selected, and select **Machine Design > Specify Part Handling Movement**.

solid — Select the solid for which you want to specify movement.
Jaw

Use this section to mark a solid as a jaw.

A jaw can be a jaw of a chuck (on a lathe spindle) or a jaw of a steady rest. The jaw on a chuck translates to open and close, the outer jaws of a steady rest rotate.

For a translating jaw, select **Moves in LCS X** or **Moves in LCS Y** to specify in which axis of the jaw's Local Coordinate System the jaws translate.

A translating jaw with **Moves in LCS X** selected opens in a positive X and closes in a negative X of its Local Coordinate System. Marking a solid as a translating jaw of the chuck in the .md file means that you do not have to write BASIC code in the .md file to close it. If you mark it as a translating jaw, you should not move it around with the BASIC callback hooks. If you want to move it around in a custom method, leave it unmarked.

A rotating jaw with **Rotates +C** selected closes by rotating in a positive direction around the Z-axis of its LCS, and opens by rotating in the opposite direction. A rotating jaw with **Rotates -C** selected closes by rotating in a negative direction around the Z of its LCS.

Steady Rest

Use this section to mark a solid as a steady rest.

Select **Moves in LCS Z** for the parent steady rest solid (the solid that connects the steady rest to the machine) to make it slide along a track in Z in response to a Part Support On or Off feature. The jaws of a steady rest should be children of the steady rest solid.

Select **Moves in LCS X** or **Moves in LCS Y** if you have an off-center steady rest that needs to move in X or Y to be in line with the part.

Steady rests are simulated with pressure sensitive jaws that close in small increments until they touch another solid or themselves. Ensure you design your steady rest jaws and housing so they do not touch when the jaws are moving.

Model the steady rest in the open position. A Part Support On feature causes the jaws to open (the first open move does nothing), positions the LCS of the steady rest to the appropriate grab distance, and then closes the steady rest until the jaws touch the stock. The next Part Support On feature is used to reposition the steady rest, which opens the jaws to the position they were modeled in, positions the steady rest, and closes the jaws. For example, if the first Part Support On feature causes the jaws to close by 37 degrees, the next Part Support On feature causes them to open by 37 degrees.
Subspindle
Select **Moves as Turn Subspindle** to specify this solid as the subspindle.

Tailstock
Select **Moves as Turn Tailstock** for the parent solid to specify it as a tailstock. A tailstock solid and its children move in Z in response to a Part Support On or Off feature, from its LCS origin to the grab distance in the Setup coordinate system.

There are two types of tailstock, dead-center and live-center. In a live-center tailstock the tailstock piece rotates as it supports the stock. In a dead-center tailstock the tailstock piece does not rotate. A live-center tailstock piece is made from softer material so it can be remachined, a dead-center tailstock piece is made from harder material. A tailstock piece typically has a 60 degree nose. Live-center tools are not necessarily held by a turret, some tailstocks have a spindle that can rotate the tool (the tailstock piece).

Some tailstocks have a hydraulic pressure-sensing cylinder that also moves in Z. The tailstock in process is then a two-step process, you position the large tailstock housing to some position out in front of the stock, and then the hydraulic cylinder/cone comes out (in Z) until it hits the stock.

For a dead-center tailstock, you can have the LCS of the tailstock be at the tip of the cone, and move the tip of the tailstock to Z=0 by using a Part Support On feature with a grab distance of 0.

Alternatively, you can move the large tailstock housing out in front of the stock by using a Part Support On feature with a negative grab distance. Then, you can implement a BASIC callback hook to *move in the hydraulic pressure sensing cylinder* in the callback hook: `MachineSim_PartHandle`. The `MachineSim_PartHandle` callback hook is called whenever a steady rest or a tailstock is opened or closed, and is called twice for positioning moves: once before the move, and once after the move. To implement the *move in the hydraulic pressure sensing cylinder*, you would implement `MachineSim_PartHandle` and test if Action is eSimAction_TS_PostPosition (that stands for tailstock, post (after) positioning). You can move the *hydraulic pressure sensing cylinder* in small Z increments until it collides with the stock if the tailstock is moving in, or move the cylinder back if the tailstock is moving out.
**Parent/Child Relationships dialog**

The first step in creating a simulation machine is to specify the relationships between the different solids. In the image below, **Table C** is located on top of **Table A**. If **Table A** moves, then **Table C** should move with it. This is specified by indicating that **Table A** is the parent of **Table C**.

![Diagram showing Table A and Table C with arrows indicating parent-child relationship]

You specify this type of relationship in the **Parent/Child Relationships** dialog.

![Image of Parent/Child Relationships dialog]

To open the **Parent/Child Relationships** dialog, select **Machine Design > Parent/Child Relationships** from the menu.

To use this dialog:

1. Select the **parent** solid.
2. Select the **child** solid.
3. Click the **Apply** button.

As you work up or down through the machine hierarchy, you can save time by moving the previously selected solid from the **parent** to the **child** selection or the **child** to the **parent** selection using the arrow buttons.
All solids must be associated with the machine. The **machine** solid in the **Part View** is not an actual solid, but it represents the top level of the machine. All solids must be connected to **machine** to be included in the simulation. The parent/child relationships are displayed in the **Part View** under the **machine** object. Here is an example of the hierarchy for a simple table-on-table machine.

```
- Machno
  - machine
    - table_a
      - table_b
```

- Machno
  - machine
    - table_a
      - table_b
**Top-most Table dialog**

The top-most table solid is the solid that the stock and clamps are attached to. That is, the stock and clamps in the machine simulation move around with the solid that is specified in this dialog as if they were children of the solid.

For a lathe, this is the main spindle or chuck. For mills, it is the top table solid. Use the Top-most Table dialog to set this up.

To open the Top-most Table dialog, select Machine Design > Top-most Table from the menu.

To use this dialog:

1. Select or pick the solid.
2. Select either:
   - **Existing UCS** — Select or pick the UCS on the top of the solid where you want the part mounted.
     
     Note that if your part has its coordinate system located on its top, you can offset the solid in the Simulation Information page of the Setup wizard.
   - **Create UCS and go to alignment wizard**
3. Click the **Apply** button.

**UCS for top-most table**

The Top-most Table UCS is the most crucial UCS to get right, particularly for a turning machine. Both the position and the orientation of the top-most table UCS are important because they establish a correspondence to the Setup position and orientation used in the FeatureCAM part. You can think about this in any of several equivalent ways:
- The top-most table UCS is mated to the Setup's origin (minus the offsets in the Setup - Simulation Information (see page 1896) dialog).

- The origins of the Setup UCS (minus the offsets in the Setup - Simulation Information (see page 1896) dialog) are made to be coincident with the top-table UCS; and the X, Y, and Z directions are aligned.

- FeatureCAM's simulation aligns (transforms) the whole machine so that the top table UCS is aligned with the setup (minus the offsets in the Setup - Simulation Information (see page 1896) dialog). That is, the machine is transformed such that the +X of the top table UCS is aligned to the Setup's +X, +Z to +Z, and the machine is translated such that the Setup's origin (minus the offsets in the Setup - Simulation Information dialog) is the same point as the top-table UCS origin.

Below is a sample of the UCS and solid used for a milling machine:

![UCS and solid for milling machine](image)

The UCS for milling should have:
- the XY positioned in the center of the table
- the Z positioned on the top of the table
- X pointing to the right
- Z pointing up

For 4-axis indexed parts, the combination of the .fm's Setup's clamp location and the top-most table location should translate the stock such that the index axis of the part is aligned with the table's rotation axis. If this is not true, the simulation cannot rotate the machine about the index axis.
Below is a sample of the UCS and solid used for a turning or turn/mill machine:

The UCS for turning should have:
- the XY positioned in the center of the chuck
- the Z positioned on the face of the jaws
- X pointing up (or towards the tool on a slant-bed lathe)
- Z pointing to the right (from the main to the sub-spindle or tailstock)

**Sub-spindle dialog**

*Ensure that the Machine Design > Enable Millturn UI menu option is selected to access the lathe design options.*

If you are modeling a lathe with a sub-spindle, you must identify the solid representing the sub-spindle. Specify the solid in the **Sub-spindle** dialog:

To open the **Sub-spindle** dialog, select Machine Design > Sub-spindle from the menu.

To use this dialog:
1. Select or pick the sub-spindle solid.
2 Click the **Apply** button.

This dialog lets you designate which solid represents the sub-spindle. In a sense, this is akin to the **Top-most Table** dialog, that is, FeatureCAM has to know which solid holds the part when cutting on the sub-spindle.

*If the stock is parted with a cutoff operation, the right-most stock becomes a child of the sub-spindle solid.*

The Local Coordinate System (see page 1923) of the sub-spindle is important in terms of simulating sub-spindle positioning features. Typically the sub-spindle is positioned with respect to a machine coordinate system and not the part program (or Setup) zero. Set the Local Coordinate System’s Z direction to match the machining sub-spindle commands. That is, if the machine's sub-spindle moves to the left in response to a negative W (or sometimes B), set the Z direction of the LCS pointing to the right (like the main spindle or turning main setup). Sometimes the positive W axis points to the left, that is, the machine moves to the left in response to a positive W (assuming W=0 is the home position). You can set the home W and max W in the `.cnc` file (**Edit the `.cnc` file, and go to CNC-Info > Spindles**).

Here, the sub-spindle's LCSs (UCS shown) Z direction points to the right; this would be correct for a machine where a **move the sub-spindle in to grab the part** is a negative W and the move the sub-spindle home is a W of zero.

**Add Tool Location dialog (Milling)**

You can use the **Add Tool Location** dialog to specify where the tool is held in a milling machine.
To display the **Add Tool Location** dialog, select the **Machine Design > Add Tool Location** menu option.

![Add Tool Location dialog]

For most milling machines, the tool location is a single point at the center of the base of the spindle as shown below. The +Z axis points away from the part. The choice of the X and Y directions of the UCS are relatively arbitrary.

![Milling spindle diagram]

To use the **Add Tool Location** dialog to add a milling machine tool location:

1. Specify the solid that represents the milling spindle that holds the tool.
   - Select a solid from the list, or click **Pick Solid** and select it in the graphics window.

2. Select the UCS that represents the location where the milling spindle is attached to the machine.
   - Select **Existing UCS** and then pick the UCS from the graphics window, or select **Create UCS/use alignment wizard** and then use the wizard to create the UCS.
3 Enter a Simulation C angle offset value. This is the angle between the turret and the X axis. In some milling machines, you can perform turning with a C table, where you can turn in the YZ plane using a X angle offset of -90.

4 Click Apply.
A wireframe preview of the tool is displayed in the graphics window.

5 Click OK to close the dialog.

**Add tool locations dialog (Turning)**

You can use the Add tool locations dialog to specify where the tool block mounting locations are in turning and turn/mill machines.

To display the Add tool locations dialog, ensure Machine Design > Enable Turn/Mill UI is selected, and select the Machine Design > Add Tool Location menu option.

**Add tool locations tab**

Use the Add tool locations tab to specify the details of the solid that holds the tools.
This solid holds tools as a turret or gang — Specify the solid that represents the turret or gang that holds the tools. Select a solid from the list, or click Pick Solid and select it in the graphics window.

Which turret — Specify whether to use a main turret or sub turret, and whether the turret is above or below the stock. Ensure this setting matches the information in the .cnc file.

Consider this solid a — Select whether the solid is a Programmable channel or Part of turret. For most turn/mill machines, a turret is a programmable channel. For non-standard machines, such as where part of the gang can rotate, you can create turrets and gangs made of multiple solids, and select Part of turret to set up hierarchical movements.

Solid rotates when changing tool — Select this option for rotating solids such as turrets, deselect it for gang tools. For non-symmetrical turrets, you must add tool locations individually.

Tool Locations tab
Use the Tool locations tab to add and edit tool locations, which determines where the tool blocks are held on the solid.

Add — Displays the Add Tool Location wizard (see page 1919).
Remove — Select a tool location and click Remove to delete it.
**Edit** — Select a tool location and click **Edit** to display the **Each new location** page. This enables you to edit the tool type, spindle, and tool slot, but not the UCS.

---

**Add Tool Location wizard**

**Add Tool Location wizard**

Use the **Add Tool Location** wizard to create tool locations.

![Add Tool Location wizard](image)

**Select Existing UCS** — Select the UCS that represents the location where the top of the spindle is held in the turret or gang.

**Type** — Select the type of tool that is held at this tool location.

To create a turret, the solid must have a Local Coordinate System (see page 1923), and you can create multiple tool locations rotated around the LCS origin and the Z axis.

**Mounting type** — Specify the **mounting type**.

Specify whether the tool is mounted on the face of the turret for cutting on the main spindle, the face for cutting on the sub-spindle, or on the OD which can cut in either direction. The image shows the tool mounting directions:
These options are unavailable if **Head** is selected in the **Type** list.

**Repeats** — Specify how many tool locations to create.

Click **Next** to display the **Each new location** page.

**Each new location page**

Use the **Each new location** page of the **Add Tool Location** wizard to specify the details of the tool locations.

**Tool location(s) can hold** — Select the tool types that can be held by the tool location.

**Can address** — Select which spindles the tool can machine.

**Simulation C angle offset** — This is the angle between the turret and the X axis. This is usually 0 for an upper turret and 180 for a lower turret.
**Begin tool slot** — Specify the tool slot number. When creating multiple tool locations, they are numbered sequentially starting on this number.

**Delta tool slot** — Specify the numerical increment between tool slots. For example, a **Delta tool slot** of 2 results in T1, T3, T5, etc.

**Show tool block** — Select this option to simulate the tool block in this tool location.

**Show milling holder** — Select this option to simulate milling tool holders in this tool location. You can deselect this to hide the tool holder when the insert is held directly without a tool holder.

**Show turning holder** — Select this option to simulate turning tool holders in this tool location. You can deselect this to hide the tool holder when the insert is held directly without a tool holder.

**Reverse rotary tool spindle direction of the first tool location added** — Specify whether the spindle direction of the first tool location is reversed. When adding multiple tool locations, selecting this option reverses all tool locations, unless **Toggle the reverse sense** is selected.

**Toggle the reverse sense (spindle direction) of every other tool location** — When creating multiple tool locations, select this option to alternate between reverse and normal spindle direction.

**Has ATC** — Select this option if the machine has an automatic tool changer. This enables you to use a single tool location and tool slot with multiple tools.
**Tool direction**

The tool location orientation is the same for milling and turning, where +Z points into the quill or turret. The following image shows both a machine tool spindle and lathe turret for illustration purposes only:
Local Coordinate System dialog

For any machine part that rotates during the simulation, a center of rotation, its local coordinate system must be specified using the Local Coordinate System dialog:

To open this dialog, select Machine Design > Local Coordinate System from the menu.

Rotating parts include turrets and rotating tables. Parts that rotate about the A axis rotate about its local X axis. B-axis rotations are performed about the local Y axis and C-axis rotations rotate around the local Z axis.

Turrets rotate about their local Z axis.

If a solid rotates only if the parent rotates, you do not have to define a local coordinate system.

To use this dialog:
1. Select or pick the Solid.
2. Select Existing UCS and pick/select the UCS or select Create UCS and go to alignment wizard to create a new UCS.
3. Click the Apply button.

Tool Block dialog

Ensure that the Machine Design > Enable Millturn UI menu option is selected to access the lathe design options.

Use the Tool Block dialog to specify solids as tool blocks, specify their positions relative to the turret, and specify the locations of the tools in the tool blocks.

There are different types of tool blocks (see page 1926).
To display the **Tool Block** dialog, select the **Machine Design > Tool Block for Turret** menu option.

![Tool Block Dialog](image)

To create a tool block:

1. Select a solid to use as the tool block. You can use a block solid positioned out in space, or in place such that it plugs into tool slot #1.

2. Under **This UCS will match up with the tool location on the turret**, select a UCS to mate with the tool mounting location on the turret (shown in the image below).

   If the tool block solid is already in place, you can use the same UCS as the tool location slot #1 on the turret.

   ![UCS Selection](image)

3. Select which turrets the tool block can address.

4. Select which tool locations on the turret the tool block can attach to.
5 Select the **Tool Locations** tab.

![Tool Block](Image)

6 Click **Add** to add a new tool location.

The new **Tool Information** dialog is displayed.

![Tool Information](Image)

7 Select a UCS to define the tool location (see page 1930) on the tool block, or click **New UCS Wizard** and create one.

8 Under **Modeled to cut which spindle**, select which of the spindles the tool addresses.

9 Under **Holds which tool type**, select the tool types that can be used at this tool location.

   For OD Lathe tools, select the **Handedness** of the tool.

10 Select or deselect **Show milling holder** and **Show turning holder** to specify whether to simulate the tool holders in the tool block. You can use this to hide the tool holder when a tool block holds the insert directly.
Specify where to locate the tool in relation to the tool location. Select **Locates back of tool** to specify that the tool location is the location of the back of the tool, or select **Locates front of tool** to specify that the tool location is the location of the tool tip.

**Tool location at back of tool holder:**

**Tool location at tool tip:**

1. Click **OK** to add the tool location and close the **Tool Information** dialog.
2. To remove a tool location, select it and click **Remove**.
3. To edit a tool location, select it and click **Edit**, or double-click it.
4. Use the **Move Up** and **Move Down** buttons to change the order of the tool locations in the dialog.
5. Click **OK** to close the dialog.

**Types of tool blocks for turrets**

For a turn/mill machine, the holder is held by tool blocks. The tool blocks are most likely supplied by your machine tool vendor. As such, they are stored in the machine design file.

- Each tool block must be represented by a separate solid model.
- Tool blocks should not be associated with the machine through a parent/child relationship.
- The solids must be identified only as a tool block and the appropriate block is displayed along with the selected tools during machine simulation.
- You can model the tool blocks in any location.

There are three basic types of tool block:
• those that hold OD turning tools
  • **OD turning (RH)**
    This tool block holds right-handed turning tools and is mounted on the face of the turret.

• **OD turning (LH)**
  This tool block holds left-handed turning tools and is mounted on the face of the turret.

• those that hold X-rotary tools
  • **X tool, OD mount**
    This tool block holds milling tools parallel to the X axis and is mounted on OD of the turret.

• **X tool, face mount**
This tool block holds milling tools parallel to the X axis and is mounted on the face of the turret.

- **Turret**
- X tool not mounted on OD block
- X tool

- **Z tool**

This tool block holds boring bars and drills parallel to the Z axis and can be mounted on the OD or the face of the turret.

- **Turret**
- ID or Z tool block
- Z tool and holder

You may want to differentiate between an OD turning tool block for left-handed tool versus a right-handed tool. If you use any left-handed turning tools, add a left-handed tool block.

There is another option for X-rotary and Z-axis tools: you can mount them on the OD of the turret or on the face of the turret. If, when adding a tool location on the turret, you specified the tool position was on the face of the turret, you should use the face-mounted option here in this dialog as well. (The converse is also true, if the OD mounted tool was used as a tool location, specify that the tool block is also OD mounted).
If you cannot mount a tool to the OD of your turret, you do not need to define an OD-mounted tool block. You must, however, have at least one solid tool block defined for every tool type that you intend to simulate. Currently, you cannot use the same solid for different types of tool blocks.

If you do not define an OD-turning tool block, FeatureCAM attempts to use an OD mounted X-tool block for any OD turning tools. In this manner, you can generally define a machine with only two tool blocks, one for OD turning and X-tools, and another for ID boring bars and other Z-tools.

You need only define tool blocks for the main turret. Tool blocks with appropriate transformations are used for the sub-turret automatically.
**Positioning turning tool holders in a tool block**

The tool location UCS for a turning tool block should be located at the back of the holder at the bottom of the tool block as shown:

The tool holder is positioned with the back of the tool along the Z axis of the tool location UCS and extends below the tool block by the distance specified as **Exposed length** on the **Holder** tab (see page 1803) of the **Turning tool properties** dialog. Additionally, the tool tip is located the distance specified as **Tip to back (F)** on the **Holder** tab in the local X direction of the tool location UCS (the turning stock Z direction).

**Machine jogging**

You can use machine jogging to simulate the movement of solids in a Machine Design document without having to use an FM file. This enables you to test the movement and ensure the limits (see page 1906) are set correctly.

To use machine jogging to test machine movements:

1. Save any changes to your MD document.
Any unsaved changes to the document are not displayed in the jogging simulation.

2 Select the **Machine Design > Jog Machine** menu option. The **Jog Machine** dialog is displayed.

![Jog Machine dialog](image)

Each row displays an axis in which solids in the document can move.

3 Select a solid in the list next to an axis name. The list is unavailable if there is only one solid that can move in that axis.

4 For the selected solid, move the slider between the minimum limit and the maximum limit.

   The solid's current position is shown in the middle field, and the solid's movement is simulated in the graphics window.

   *You can set the limits (see page 129) and home positions of the solids using the **Specify Movement** dialog.*

5 To hide solids in the jogging simulation, click **Select** in the **Standard** toolbar, then click solids in the graphics window.

6 To return all solids to their default positions, click **Reset All**.

7 When finished, close the dialog. The jogging simulation is cleared, and all solids are returned to their default positions.
**G53 Z0 Before Indexing**

The **Machine Design** menu has a **G53 Z0 Before Indexing** option, mainly for 5-axis machines. Select this option to enable it (a check mark displays to the left of the menu item when it is enabled). This option simulates the movement of the tool to Z=0 in the machine's coordinate system before performing the indexing rotations. The effect of putting such a line in the segment start is that the tool retracts to a safe position before the tables and/or head index to a new set of angles.

This command does not affect the G code. It performs only the simulation of this move.

**G28 (move turret home) Before Tool Change**

Ensure that the **Machine Design > Enable Millturn UI** menu option is selected to access the lathe design options.

The **Machine Design** menu has a **G28 (move turret home) Before Tool Change** option. Select this option to enable it (a check mark displays to the left of the menu item when it is enabled). This option outputs a **G28** to move the tool to turret home before changing the tool.

This command does not affect the G code. It performs only the simulation of this move.

**Delete Tool Locations/Blocks dialog**

Select **Machine Design > Delete Tool Location/Block** from the menu to open the **Delete Tool Locations/Blocks** dialog.

This dialog removes any tool locations and tool block attributes associated with a solid.
To complete this dialog:

1. Select or pick the solid whose tool locations you want to delete.
2. Click the **Apply** button.

You can use this dialog to remove tool locations that are specified with either the **Add Tool Location** dialog or the **Tool Block for Turret** dialog.

### Display Properties

Use the **Display Properties** dialog to control the display of the solid components of the machine during full machine simulation:

To open this dialog, select **Machine Design > Display Properties** from the menu.

To use this dialog:

1. Select or pick the solid.
2. Enter the **Fineness** value. (Low numbers look better, but may slow down the simulation. High numbers run faster, but the solid may appear faceted.)
3. Optionally select the **Transparent** option.
4. Click the **Apply** button.
Replace Solid dialog

Use the Replace Solid dialog to replace solid1 with solid2, and keep the machine design attributes from solid1, such as parent/child relationships, movement, and so on.

Lock or Unlock File

You can protect your Machine Design files from the extraction of solids, so that you can share them for simulation without anyone being able to extract the solids.

FeatureCAM comes with some locked Machine Design files. You can use these for simulation, but you cannot extract solids from them. When you open a locked file, a dialog is displayed explaining the restriction.

You can lock your files, but you cannot unlock them. You should not lock an original file, instead create a copy of it and lock the copy.

To lock a file:

1. Use the File > Save As menu option to save a copy of your file.
2. Select the File > Lock/Unlock menu option.
The **Lock or Unlock File** dialog is displayed.

3 Select **Lock**.

⚠️ *If you lock a file, you cannot unlock it.*

4 Click **OK** to close the dialog and save your changes.

---

**Mini-turrets**

You can simulate mini-turrets, which are tools with multiple inserts where the tool rotates around the b-axis to access each insert. The tools are simulated simultaneously, which enables you to check for gouges with the tools that are not currently in use.

To simulate a mini-turret:

1 In the Machine Design file, create a solid and UCS to represent the mini-turret, with the X axis of the UCS pointing towards the main spindle.

2 Create a UCS for each tool location. The difference between the X axis of the tool location UCS and the turret UCS determines the angle that the mini-turret is rotated to use the tool.

3 In the **Tool Block** dialog:
   a Select the turret solid under **This solid is a tool block for solids**.
b Select the turret UCS under **This UCS will match up with the tool location on the turret.**

c Use the **Tool Locations** tab to add each tool location UCS as a separate sub slot in the tool block.

d Click **OK** to close the dialog.

4 Save the Machine Design file.

5 In the FM document, use the **Tool Mapping** dialog to specify which tool block and sub slot to use for each feature.

---

**Turning head tool holders Machine Design**

You can simulate turning head tool holders (see page 186), which enable you to perform turning and boring operations on a milling machine.

For example, in the image below the piece is machined by the tool rotating around the stock.

To modify a Machine Design file to support turning head tool holders:

1 In the Machine Design document, ensure the **Machine Design > Enable Turn/Mill UI** is selected.

2 Select the **Machine Design > Supports Specialized Turning Heads** menu option.
3 Create or import solids to represent the turning head tool holder and the plate that moves in the U axis that holds the turning tool.

4 Use the **Parent/Child Relationships** dialog (see page 1910) to make the U plate solid a child of the turning head tool holder solid.

5 Use the **Specify Movement** dialog (see page 1904) to enable the U plate solid to move in +delta X.

6 Create a UCS on the U plate solid to locate the tool.

7 Using the **Tool Block** dialog (see page 1923), make the turning head tool holder solid a tool block, and create a tool location on the tool block using the UCS you created on the U plate solid.

8 To use two tools that cut from opposite sides of the part, create a second UCS for the tool location, which is facing the opposite direction to the other tool location UCS, and add the tool location in the **Tool Block** dialog.
Machine Design tutorial: Simple 3-axis mill

This tutorial guides you through the design of a simple 3-axis milling machine. We start the tutorial by opening an .md file that already contains all of the solids that represent the machine. This tutorial gives you instructions that help you establish the relationships between the different solids. You are guided in establishing movement, parent/child, and top-most table relationships.

Specifying movements

First, open 3axFerrriMachine Notcomplete.md from Examples\Machine Design\Mill\3-Axis.

Let's specify how the machine moves. The first piece is the quill. The quill is represented as a single solid in the part file. You can see the quill displayed in the Part View and in the graphics window (shown in red here):

1. Select Machine Design > Specify Movement from the menu.
The **Specify Movement** dialog is displayed:

![Specify Movement dialog](image)

2 For the **solid**, select **quill** and in the **Tool quill** section, select **Moves +delta Y**.

3 Click the **Apply** button to save the setting for this solid.

4 For the next **solid**, select **z_slide** and in the **Tool quill** section, select **Moves +delta Z**.

5 Click the **Apply** button to save the setting for this solid.

6 For the next **solid**, select **x_slide** and in the **Table** section, select **Moves -delta X**.

7 Click the **Apply** button to save the setting for this solid.

8 Click the **OK** button to close the dialog.

**Defining parent/child relationships**

Next, we must define some parent-child relationships between various solids. The image below shows the first set of parent-child relationships that we must establish. The machine is the parent of **column_base**, which in turn is the parent of **z_slide**, which in turn is the parent of **quill**. If **column_base** moves, then **z_slide** needs to move with it, and if **z_slide** moves, then **quill** needs to go along as well.

2. For parent/solid1, select **machine** and for child/solid2, select **column_base**. This sets **machine** as the parent of **column_base**.

3. Click the **Apply** button to save the relationship.

4. Repeat steps 2 and 3 to set the following:
   - **column_base** as the parent of **z_slide**
   - **z_slide** as the parent of **quill**
   - **machine** as the parent of **base**
   - **base** as the parent of **x_slide**
   - **x_slide** as the parent of **top_table**
   - **x_slide** as the parent of **tool_storage**

*Use the left arrow button to quickly move the previous child solid to the parent column as you work down the list.*
Your machine hierarchy should look like this:

```
Machine
  machine
    base
      x_side
        tool_storage
      top_table
    column_base
      z_slide
    quill
```

5 Click the OK button to close the dialog.

**Defining the stock attachment point**

Next, we must define the top-most table so that FeatureCAM knows where to put the stock whenever this machine is used in simulation.

1 Select **Construct > UCS** from the menu.

   The **UCS** dialog is displayed.

2 Click the **New** button.

   The **New UCS** dialog is displayed.

3 In the **New UCS** dialog:

   a For the **Name**, enter **UCS2**.

   b Select the **Create from UCS** option.

   c Select the **STOCK** UCS.

   d Click the **OK** button to close the **New UCS** dialog.

4 In the **UCS** dialog, ensure **UCS2** is selected as the **Current UCS** and click the **Translate** button.

   The **Translate** dialog is displayed.

5 In the **Translate along axis** section, enter **100** for the **Z** axis. This places it on the top of the top table as shown below.
6 Click the OK button to save the settings and close the dialog.
7 Click the Close button to close the UCS dialog.
8 Select Machine Design > Top-most Table from the menu.
   The Top-most Table dialog is displayed.
9 In the Top-most Table dialog:
   a Select top_table as the solid.
   b Select the Existing UCS option.
   c Select UCS2 from the Existing UCS menu.
   d Click the OK button to save the settings and close the dialog.

Defining the spindle attachment point
Next, we must define a place where the spindle mates to the quill.
1 Select Construct > UCS from the menu.
   The UCS dialog is displayed.
2 Click the New button.
   The New UCS dialog is displayed.
3 In the New UCS dialog:
   a For the Name, enter UCS3.
   b Select the Create and go to alignment wizard option.
   c Click the OK button.
      The Align UCS wizard opens.
4 Select Revolved Surface and click the Next button.
5 For the surface, select or pick `face_31` of the quill solid (shown below).

6 Click the **Finish** button to save and close the wizard.

7 Click the **Close** button to close the **UCS** dialog.
   This new UCS is a mating point for the spindle.

8 Select **Machine Design > Add Tool Location** from the menu.
   The **Add Tool Location** dialog is displayed.

9 In the **Add Tool Location** dialog:
   a Select the **Add Tool Location** tab.
   b For the solid, select **quill**.
   c Select the **Existing UCS** option.
   d Select **UCS3** from the **Existing UCS** menu.
   e Click the **OK** button to save the settings and close the dialog.

**Saving your new machine**
Save your machine in a new file.
1 Select **File > Save As** from the menu.
2 Save the file with a new name so that you don't overwrite the example file and can run the tutorial again in future.

**Using your new machine**
To use your new machine:
1 **Open** an `.fm` file.
2 Select **Manufacturing > Setups** from the menu.
   The **Setups** dialog is displayed.
3 Select the Setup that you want to simulate and click the **Edit** button.
For files where you simulate multiple Setups such as indexed or turn/mill parts, you should associate the machine file with the first Setup of a part.

4 Click the Next button until you reach the Setup - Simulation Information page.

5 Change the offset as needed. Usually, if the part-program zero is on the top of the part, then the offset is a negative Z.

6 Select Always use this one and browse to the location of your new Machine Design file.

Click the Finish button to save the settings and close the wizard.

7 Select Machine Simulation mode in the Simulation toolbar and press Play.
Machine Design handbook

This handbook is a practical guide for creating a Machine Design document (for use with Machine Simulation) from a solid model of a machine tool. The handbook does not try to duplicate the information elsewhere in FeatureCAM Reference Help, but rather gives you a framework for using that information more effectively, along with various practical suggestions to make the task more manageable.

We have assumed that you already know how to use FeatureCAM's machine simulation (see page 1895).

Before using this handbook, it is important that you are familiar with at least the introductory topics of FeatureCAM Reference Help:

- Creating a Machine Design document (see page 1899)
- General guidelines (see page 1899)
- Machine Design concepts (see page 1901)
- Lathe design overview (see page 1902) (if you are creating a turning machine)

Getting started with Machine Design

To start creating a new MD file, select File > New to open the New Part Document dialog.

1. Select Simulation Machine Design in the Type list.
2. Select Millimeter as the Unit of Measure.
3. Select None for Initial stock dialog.
4. Click the OK button.

*You can develop the MD in inches, but most are done in metric, as that is the bulk of the dimensions that would be read from a print for any machine.*

When your document is open, select File > Import from the menu to import the CAD model of the machine you want to make into an MD file.
Preparing the solid model

The solid model that you use to create your machine design file may be well-suited to the simulation task, or it may have characteristics that make it difficult to work with in simulation. Many solid models are provided by machine tool builders, and probably were not specifically created for simulation purposes. Before trying to set up the relationships needed for simulation, it is a good idea to spend the time to prepare your solid model for the task. The next few topics provide some guidelines.

It may be tempting to skip these steps because some of them do not seem relevant to the simulation of the machine. However, we strongly recommend you carry out as many of these tasks as early as possible. The reason is that the rest of the machine design definition can be easily lost or destroyed when renaming or replacing solids in the machine design file. So you could end up having to re-do all the work anyway.

Machine Design file size

Large files can slow down simulation, so it is useful to ensure machine design files are less than around 2 MB.

The machine design files provided for simulation are often more complex than is necessary for correct and informative simulation.

You can use the following methods to reduce the size of machine design files:

- Remove solids that are not needed, such as small details like bolts, or hidden components that do not affect simulation.
- Remodel components with less detail. Keep enough of the supporting structure to ensure that the components are connected and do not float in space.
- You do not usually want to simulate the outer housing and doors when simulating, but you may not want to delete them. Exclude these components from the machine hierarchy, and they will not be included in the simulation.

Selecting solids

When creating an MD file, you regularly need to select solid components to modify them, set relationships and attributes. Select solids in these ways:

- Select solids by name (see page 1947) in the Part View, in the Solids or Machine areas.
- Select solids from the graphics window:
Hold the **spacebar** key and select a face to select the whole solid.

Right-click a face and select **Select Solid** from the context menu.

*Select solids in the graphics window before opening the Machine Design dialog, and they will be automatically selected in the dialog when you open it.*

### Naming solids

When you open a Machine Design file in FeatureCAM, the solids may not have descriptive names. You do not need to rename all solids, but it is useful to rename the moving machine components to their standard descriptive names (for example `main_spindle`) or by their intended motion (for example `x_slide`). This makes the rest of the creation process simpler, and makes it easier for others to modify the document later.

To rename a solid:

1. Right-click its name in the **Part View**.
2. Select **Rename** from the context menu.
   
   The **Rename Object** dialog is displayed.

   ![Rename Object dialog](image)

   3. Enter the **New Name** for the solid.
   4. Click **OK** to save your changes.

### Changing solid colours

You can change the colors of solids to match your machine tool.

To change the color of a solid:

1. Select the solid you want to change.
2. Select **Options > Coloring > Change Selected** from the menu.
   
   The **Selected Object Color Overrides** dialog is displayed.
3 In the **Selected Object Color Overrides** dialog, click the **More Colors** button, and choose a new color from the palette.

![Selected Object Color Overrides dialog](image)

4 Click **Apply**.

5 Click **Done** to close the dialog.

**Creating clearances**

During machine simulation, FeatureCAM checks for collisions between solids. This is one of the main purposes of the simulation, but there are sometimes *false* errors that are not due to any error in the toolpaths or machine setup. These false errors often occur during development of the MD file when appropriate clearances have not been created between the moving parts of the machine.

There must be a small clearance between some of the moving parts so they do not collide in typical intended motion. If the mating faces are flat, there is little likelihood of a collision being signaled. However, when the faces are not flat, a collision is more likely because curved solids are approximated by (smaller) flat polygons during the simulation. The fineness of this approximation plays a role, and in some cases collisions can be erroneously signaled when the simulation is run at low resolution, where a higher resolution would not raise any error. It may be safer to provide relatively larger clearances for curved mating faces.
The image shows some examples of clearances. They are not much larger than 2mm each.

You cannot check for moving collisions until you have completed enough of the machine design to run tests with full machine simulation. However, when the solids for your machine are detailed, it may save some effort to perform an initial check of the solids that have close interactions. In some cases, the solids may intersect each other in the home position of the machine; these always produce false collision reports.

As well as checking them visually, you can check whether two solids intersect in the home position like this:

1. Open the **Combine Solids** dialog in one of these ways:
In the **Solid Wizard** (see page 452), select **Shape Modifiers**, then **Combine Solids**, and click **Next**.

On the **Solid** toolbar (see page 453), click the **Combine Solids** button in the **Modify solid** menu.

From the menu, select **Construct > Solid > Modifiers > Combine solids**.

2. In the **Operation** menu, select **Intersection**.

3. Select the two solids you want to check as **solid1** and **solid2**.

4. Click the **Preview** button.
   - If you see the error **Unable to construct object with these inputs**, the solids do not have any overlapping volume.
   - If not, the overlapping area is displayed in a dark blue preview in the graphics window, and you can adjust the view to determine what the problem is.

5. Click the **Cancel** button to close the dialog without saving any changes.

If you find that there is an overlapping volume, you can correct it in several ways (depending on the amount of the overlap and the function of the components in conflict):

- Scale one component down by a small amount. For example, if you have a cylindrical piece with a Z axis that is just slightly too big, you could scale it non-uniformly in XY without changing any critical motion of the machine.

- Translate one component away from the collision area by a small amount, in a way that does not affect the simulation.

- Shrink or expand one of the solids to avoid the collision using **Construct > Solid > Modifiers > Offset**.

- Cut off the conflicting portion of the solid if it is not critical to the simulation. **Cut with Parting Surface** can be useful for this if you carefully construct a temporary surface to 'slice off' a small portion of the solid.

- Remodel the solid in a simpler way (possibly in a separate CAD system) to avoid the collision without compromising the fidelity of the simulation.
Defining the Machine Kinematics

When you have prepared the model, you are ready to establish the relationships and properties that define how your machine moves. The following topics provide a general framework and suggestions for working through this process.

Setting up the machine hierarchy

The first step in creating the MD file is to set up the machine hierarchy, which is done using the Parent/Child Relationships (see page 1910) dialog. You must add all components that you want to show during machine simulation as children of machine in the Part View. The main purpose of this is to create a hierarchy of movement, but static components (such as body, base, or even logos) are also included. There may be solids that you choose to leave in the document even though they are not displayed during simulation (for example the doors, which should always be hidden during simulation, or a parts-catcher mechanism for which you plan to add the simulation at a later time).

Here are examples of two different machines with their parent/child relationships structures set up.

Turn/mill example: 5-axis milling example:

In the turn/mill example, the jaws are children of the chucks, which are children of the heads. In the mill example, head sits on the z_slide, which sits on the x_slide.

Additional notes

- It is not possible to have a child solid linked to several parent solids. Therefore, if you require this, you must make a copy of the child solid.
If you ever need to remove these relationships to be rebuilt or replaced, it is best practice to remove the lowest objects in the hierarchy first. In the 5-axis milling example above, if you wanted to remove the objects x\_slide, z\_slide, and head, you would remove head first, then z\_slide, then x\_slide.

The machine tree is easier to navigate if you make non-moving solids children of the main (non-moving) body. Because they do not move, this has no functional effect, but makes it easier to navigate and adjust the solids that move.

**Managing UCSs for machine design**

The UCSs (User Coordinate Systems) that you create and associate with the components of your solid model are crucial to correct simulation. Be sure to pay close attention to the information about position and orientation of the UCSs. If you are having trouble, review the introduction and overview (see page 1903) topic. The UCS checklist provides a summary of all the UCSs and their positions, and also contains links to full documentation on each type of UCS.

Here are a few general tips for creating UCSs:

- Although you can create a UCS from within almost all of the machine design dialogs (via the Create UCS and go to alignment wizard option). It is usually better to do this as a separate step before opening the dialog.

- Be sure to give each UCS that you create with a name that describes what it is used for. As you work with the machine design, it's much easier to remember that, for example, Tool\_UCS defines the tool location, rather than UCS3.

- Usually only one UCS is visible while you work on the MD file. One way to see them all and to work out which is which is to open the Local Coordinate System (see page 1923) dialog. When open, this dialog displays all the UCSs currently defined for the machine. The UCS selected in the Existing UCS menu is highlighted in red in the graphics window, so you can select them one at a time to highlight a specific UCS and compare it to others.

  *Ensure you click Cancel to close this dialog if you didn’t really want to assign a UCS to a particular solid.*
**Defining component motion**

The second stage of building your MD file is to set which solids work in which axes, using the **Specify Movement** (see page 1904) dialog. You can define both rotary and linear axis movements for all types of machines, from simple 3-axis milling machines to full turn/mill machines.

In the following example, the **z_slide** solid is selected.

Given that this solid moves in the Z axis, the option **Moves +delta Z** is selected in the **Tool quill** section.
If this were a Z motion on the table instead, we would select the **Moves -delta Z** option in the **Table** section.

Although this component also moves in the X axis, that is not selected because the solid behind it controls that movement that relates to this solid when we set our parent/child relationships.

*If a particular machine component has compound motion (meaning it moves around a non-orthogonal axis), you cannot set this in the machine simulation module, but you can use a BASIC script (see page 1961) associated with the MD file.*

**Movement for slant-bed turning machines**

Many lathes and turn/mill machines have a slant-bed design that requires compound linear motion for the turret. When you first create the machine design, it may be easiest to ignore the slant-bed to start with and just specify the X and Y motion in the machine coordinate system. You can disable collision warnings when testing the simulation to check more basic functions, such as whether the stock and tool interact properly. Then, go back and set up the correct motion for the slant-bed.

**Setting the top-most table**

The top-most table is a UCS and solid combination that tells FeatureCAM where to place the stock on the machine when trying to simulate the program. This equates to the Setup position on the machine when running the program. Both the position and the orientation of the UCS for the top-most table are very important.

Full information is available in the Top-most table (see page 1912) topic, and it is worth your while to read this section carefully. If you are having trouble with this step, it might also be helpful to read About UCSs for machine design (see page 1903).

The following clarifications for machines with turning may be helpful:

- The solid to be used for the top-most table should be the chuck rather than the jaws on a turn/mill style machine, even though the UCS is located on the jaws.
- On a machine with two spindles, this location should be on the main spindle. (The sub-spindle specification is described elsewhere.)

**Setting up the sub-spindle**

See the **Sub-spindle** (see page 1914) topic for full information about setting up the sub-spindle and also the quick reference table (see page 1952).
If you are having trouble, check the following:

- **Sub-spindle** (see page 1914) dialog:
  - Is the correct solid selected? (It should be the sub-spindle chuck)
- **Specify Movement** (see page 1904) dialog:
  - Have you selected **Moves as Turn spindle** for the main sub-spindle solid? Do not select any other movement options for this solid.
  - Have you set the chuck to rotate (as table) about C?
- **Parent/Child Relationships** (see page 1910) dialog:
  - Is the chuck a child of the main sub-spindle solid?
  - Are the jaws children of the chuck?
- **Local Coordinate System** (see page 1923) dialog:
  - Is the UCS specified for the sub-spindle chuck correct for the rotational motion of the chuck?
  - Is the UCS specified for the main sub-spindle correct for the sub-spindle to move in Z?

> The distance between the two spindles is specified within the CNC file.

**Tailstock or steady-rest**

You can control tailstocks and steady rests using the **Part Handling Movement** dialog (see page 1907).

Alternatively, you can use UDF macros to simulate them as a sub-spindle. If you are using these, you must specify that the tailstock or steady-rest is the sub-spindle in the MD file. You may need to provide a BASIC script to control the movement.

**Adding tool locations**

Milling machines generally have a single tool location, which is quite easy to set up. Lathes and turn/mill machines may have multiple tool posts and need several tool blocks for mounting tools of different types. Setting up the tool locations properly may be the most difficult part of creating a working machine design file for a lathe or turn/mill machine.

Before you define the tool locations for a lathe or turn/mill machine, make sure you read these topics:

- Add Tool Location dialog (see page 1915)
- Overview of tool blocks for tool posts (see page 1926)
- Tool Block dialog (see page 1923)

Here is a summary of the various tool block types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Required?</th>
<th>If unspecified, uses</th>
</tr>
</thead>
<tbody>
<tr>
<td>X tool</td>
<td>Yes</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Generic Z tool</td>
<td>Yes</td>
<td>Not applicable</td>
</tr>
<tr>
<td>OD turning (RH)</td>
<td>No</td>
<td>X tool</td>
</tr>
<tr>
<td>Z drilling/milling (only)</td>
<td>No</td>
<td>Generic Z tool</td>
</tr>
<tr>
<td>Z boring (only)</td>
<td>No</td>
<td>Generic Z tool</td>
</tr>
<tr>
<td>OD turning (LH)</td>
<td>No</td>
<td>X tool</td>
</tr>
</tbody>
</table>

Here are some tips for working with tool locations and tool blocks:

- To create a tool post tool location, the tool post solid must have a LCS. Go to the Local Coordinate System dialog and set the UCS before setting the tool location. See the lathe overview section of Add tool location (see page 1917) for details about the location and orientation of this UCS.

- Make sure that the CNC file you are using specifies a tool post for each of the locations you specify in the Tool Locations tab (for example, Main Lower and Sub Lower are not interchangeable).

When first defining tool locations and tool posts, it can be difficult to work out why things do not work, and to determine what you have (or have not) defined. Here are some tips that may help you:

- For Milling machines, you can only associate one tool location with a solid. You can select your solids one-by-one and examine the dialog settings (in either the Add Tool Location or Tool Block dialog). However, the dialogs do not clearly indicate if no tool location is defined for a particular solid. If the Existing UCS option in the Local Coordinate System dialog shows STOCK, it is probably not defined.

- If you are unsure about the state of a location, delete it and define it again. You can use Delete Tool Location (see page 1932) to remove tool locations created with either the Add Tool Location or Tool Block dialogs.
## UCS checklist

This table summarizes the UCSs that you need to create an MD file:

<table>
<thead>
<tr>
<th>UCS</th>
<th>Machine type</th>
<th>Dialog</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock</td>
<td>Any</td>
<td>Not applicable</td>
<td>Cannot be changed</td>
</tr>
<tr>
<td>Top-most table</td>
<td>Mill</td>
<td>Top-Most Table (see page 1912)</td>
<td>The XY location is at the center of the table, Z is on the top of the table. Orientation should be so that X points to the right and Z points up.</td>
</tr>
<tr>
<td>Top-most table</td>
<td>Turn, turn/mill</td>
<td>Top-Most Table (see page 1912)</td>
<td>The XY location is at the center of the chuck, Z is on the face of the jaws. Orientation should be so that X is up, Z points to the right.</td>
</tr>
<tr>
<td>Sub-spindle</td>
<td>Turn, turn/mill</td>
<td>Sub-spindle (see page 1914)</td>
<td>Z points in the direction of the machine sub-spindle motion, its location is at the center of the jaws of the sub-spindle</td>
</tr>
<tr>
<td>Tool</td>
<td>Mill</td>
<td>Add Tool Location (see page 1915)</td>
<td>Z points away from the part, X and Y do not matter.</td>
</tr>
<tr>
<td>Tool</td>
<td>Turn, turn/mill</td>
<td>Add Tool Location (see page 1915)</td>
<td>Multiple locations possible, around turret and with various mounting directions, Z points into the turret.</td>
</tr>
<tr>
<td>Rotational Axes</td>
<td>Any</td>
<td>Local Coordinate System (see page 1923)</td>
<td>For any solid that rotates, make sure that it is assigned a UCS that points the rotational axis in the proper direction, and at the right location.</td>
</tr>
<tr>
<td>Toolblock-to-turret</td>
<td>Turn, turn/mill</td>
<td>Tool Block for Turret (see page 1923)</td>
<td>Mates to the Tool UCS (see previous row). Z points away from the part. X aligns with X on the Tool UCS.</td>
</tr>
<tr>
<td>Tool-to-tool block</td>
<td>Turn, turn/mill</td>
<td>Tool Block for Turret (see page 1923)</td>
<td>Tool mates to this location. Z points away from the part. For turning tools, see the Positioning turning tool holders in a tool block (see page 1930) topic for details about where to locate this UCS.</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Jaws</td>
<td>Turn, turn/mill</td>
<td>BASIC script (see page 1961)</td>
<td>You can simulate the main or sub-spindle jaws using a BASIC script. A UCS must define the direction of movement for each jaw that is moved by the script.</td>
</tr>
<tr>
<td>Viewing</td>
<td>Any</td>
<td>Not applicable</td>
<td>The view of the machine that you want when it first loads (looks along Z).</td>
</tr>
</tbody>
</table>

**Strategy for a milling machine**

Machine design files for milling (even 5-axis) are relatively simple to set up. The following is a suggested order for the required steps.

1. Prepare solid model (see page 1946).
2. Define parent/child relationships (see page 1951).
3. Specify movement for linear axes only (see page 1953).
4. Set top-most table (see page 1954).
5. Set tool location (see page 1955).
6. Specify movement for rotational axes (see page 1953).

Unfortunately you must complete steps 1 to 5 before you can try to simulate even the most basic toolpath motion. If you have rotational axes, omit them at the beginning and use only 3-axis linear motion until you have confirmed that the tool, stock, and table are interacting the way you intend.
Strategy for a turn/mill machine

Ensure that the Machine Design > Enable Millturn UI menu option is selected to access the lathe design options.

Unlike milling machines, setting up a machine design file for even a simple lathe without live tooling can be quite difficult. Some of the complicating factors are:

- Many lathes have slant-beds, which makes even linear motion complicated (BASIC script).
- Tool blocks must be defined to work with turrets, which requires several UCS mates per type of tool block.
- Many machines have sub-spindles that require additional specification and clearances.

The following is a suggested order for the required steps.

1. Prepare solid model (see page 1946).
2. Define parent/child relationships (see page 1951).
3. Specify movement (see page 1953).
   - Ignore slant-bed, pretend it is straight XYZ and ignore collisions.
   - Ignore sub-spindle, and do not try any transfers or cutting on the sub-spindle initially.
   - Fake a Y motion if necessary. If the machine does not have a Y motion, the components (chuck/turret/sub-spindle) must align exactly. Sometimes this is hard to achieve so it may be simpler to add a Y motion to the turret assembly to correct for this. This does not affect the simulation in any significant way.
4. Set top-most table (see page 1954).
   - Ignore sub-spindle (the top-most table applies only to the main spindle).
5. Set tool location (see page 1955).
   - Tool blocks - do not define any, just put one temporary tool location on the bottom of the turret like a milling machine, and ignore how the tools look with respect to the turret.
   - Ignore the lower turret if there is one.
6. Add slant bed (see page 1961).
7 Add toolblocks (see page 1923). This is easier if you have a working example of a machine with similar toolblock types. Study the locations and orientations in the working model carefully. Add one toolblock at a time.

8 Add sub-spindle (see page 1914).

9 Add lower turret (Tool location (see page 1915) and Tool block (see page 1923))

You may find it useful to save key versions of a turn/mill machine design file as you progress. If you change something that breaks a motion that was working in a prior version, you can revert back to that version.

MD and post interactions

In general, a Machine Design file is not necessarily tied to a particular post. For example, if you have a lathe without an optional sub-spindle, the main spindle simulation of the machine works fine with a post that doesn't support a sub-spindle. There are a few interactions that you need to be aware of. Only the first two apply to milling machines; all apply to lathes and turn/mill machines.

- **Matching .md file** (found under Sim-Info > Set .md in the XBUILD menu) — We recommend that you set this to machine.md (without a full path), so that the simulation looks for the MD file in the same directory as the CNC file. This means that you can move the post/MD file combination anywhere and it still works without changes.

- **Dogleg rapid moves** (found under CNC Info > General in the XBUILD menu) — This option affects only simulation, not the NC code produced by XBUILD.

- **B-axis support** (found under CNC Info > General in the XBUILD menu) — You must select this option for a B-axis lathe, or for a hybrid milling machine that has a table that spins rapidly for turning (for example, SuperMILLER or Variaxis).

- Turret configuration (found under CNC-Info > Turrets in the XBUILD menu) — The number and placements must match the machine design file. For example, a main-spindle-side lower turret is much different to a sub-spindle-side lower turret.
• Spindle distances (found under **CNC-Info > Spindles** in the XBUILD menu) — The distance between spindles is vital for sub-spindle transfers. These are the options **Machine Z coordinate at sub-spindle home** and **Machine Z coordinate at sub-spindle max** (left). In particular, the sign of the movement should match the local coordinate system of the sub-spindle solid in the machine design file. For instance, if the Z coordinate at sub-spindle left is -63 inches, the sub-spindle solid should have a local coordinate system where the Z point 'to the right' so that it interprets 'move minus Z' as 'move left'.

### BASIC scripts for MD files

As in other areas of FeatureCAM, you can extend the functionality that is provided for machine design files by accessing the FeatureCAM Application Programming Interface (API). This programming environment enables you to customize and enhance the machine design capabilities using the BASIC programming language.

Some functionality that has been added using the API in various situations includes:

- Linear motion for slant-bed lathes
- Opening and closing jaws on main and sub-spindle chucks of a lathe
- Moving a lower turret out of the way for a sub-spindle transfer
- Part-catcher simulation
- Pallet-changer simulation

Typically, it is fairly simple to program one of these scripts. Often you can copy a similar block of code from another machine and edit it slightly to get it to work on a new machine. In fact, we recommend that you use copy-and-edit for any standard functions.

The BASIC script that is associated with a machine design file is completely managed by FeatureCAM. That is, you do not have a separate file that you can see in the file browser. You can access it only from within FeatureCAM in the following way:

1. Load your machine design file into FeatureCAM.
2. Press the **Alt+F11** keys on your keyboard.

   A new window is displayed, containing the BASIC script associated with the current MD file.
Important notes

- Although there is a Save button in the window displaying your BASIC script, the only way to save the script is to save the MD file from the FeatureCAM window. The script is saved automatically each time you save the MD file.

- FeatureCAM does not handle two MD scripts loaded at the same time very well. If you are working with an MD file that has a script, it is best to not open any other MD files in the same session. If you do, you are very likely to lose your script completely or to save the wrong script with the MD file.

As a small example of a BASIC script for an MD file, code for opening the main spindle jaws is shown below. Annotations following the code describe some key aspects that you must consider.

```
Public Sub MachineSim_spindle( Doc As FeatureCAM.MFGDocument,  _  
   ByVal data As Double,  _  
   ByVal Action As  _  
   FeatureCAM.tagFMMachineSimSpindleActionType,  _  
   ByVal spindle As Long) 1
Dim Vw As MFGWindow
Dim Err As Long
Dim i As Integer
Dim dOpen As Double
Dim dCls As Double

Set Vw = Doc.ActiveWindow
Err = 0
i = 0
If( Doc.Metric ) Then 2
   dOpen = 4
   dCls = -1
Else
   dOpen = .25
   dCls = -.125
End If
Vw.SimIgnoreClashes(0)

If( Action = eSimAction_Open And spindle = 0 ) Then 3
   Vw.SimIgnoreClashes(1) 4
   While Err = 0 And i<3 5
      Vw.SimCutMove( "main_jaw_1", dOpen, 0, 0 ) 6
      Vw.SimCutMove( "main_jaw_2", dOpen, 0, 0 ) 7
      Vw.SimCutMove( "main_jaw_3", dOpen, 0, 0 )
```

1. Variables and function calls
2. Decision based on metric units
3. Script action selection
4. Setting ignore clashes
5. Loop condition
6. Calling simulation move functions
7. Calling simulation move functions
Vw.SimPerformCut Err
If( Err = 0 ) Then
    Vw.SimUpdateGraphics
End If
i = i + 1
Wend
End If

End Sub

1. The MachineSim_spindle routine shown is the hook provided for getting control over spindle actions.

2. Although you define your machine in metric or imperial units, those who use your file may run FeatureCAM documents in either type of units. So the MD file must calculate or convert all units for either system.

3. The eSimAction_Open enum indicates that the action generated is 'Open'. Other types include eSimAction_Close and eSimAction_Position. See the API guide for a full list.

4. The main sub-spindle is identified as 0, the sub-spindle as 1. So this block catches events that signal the opening of the main spindle only.

5. Turns off gouge-checking, which you must handle manually in the script.

6. Movement is usually done in a loop to break the motion into small increments. In this case the jaws are opened in three steps. Typically, we can use much larger increments for things that are unlikely to collide. When closing jaws, however, you might use 50 steps in order to be able to stop exactly when the jaws touch the stock.

7. This is the basic command to move a solid with linear motion. (A similar command, SimCutRotate, is used for rotational motion). All child solids declared in the MD file follow appropriately. The name of the solid is the first argument and must match the name of a solid in the MD file. The motion is with respect to the LCS defined for the solid, or the table coordinate system if no LCS is specified.

8. Perform all the movements that have been specified, and perform gouge-checking at the same time. Note that the movements are performed simultaneously, not sequentially.
Check whether there was an error. Sometimes it can be useful to disable the error checking for debugging, but you should put the condition back when the model is working.

Update the graphics display only if there was no error.
# Index

## 1

- FeatureCAM 2016 R2 Reference Help

## 2

- # of tools • 1916, 1956
- .
  - .cnx • 162
  - .html • 162
  - .md file protection • 175, 1935
  - .prn files • 105
  - .sldasm • 10
  - .sldprt • 10
  - .xml • 162

<

- <SUBFIXTURE> • 974

## 2.5D

- 2.5D • 10
  - Milling features • 637
  - Multiple region support for stock solid • 223
  - Roughing toolpaths overview • 717
- 2.5D milling • 9

## 3D

- 3D • 10
  - 3D Attributes • 1046
  - 3D boss • 1062
  - 3D cutter comp • 1059
  - 3D leads/step tab • 1343
  - 3D Lite • 10, 1046, 1049, 1055, 1057, 1059, 1061, 1116, 1124, 1160, 1162, 1164, 1180, 1188, 1195, 1203
  - 3D milling attributes • 1667
  - 3D milling feature attributes • 1046
  - 3D Milling tab • 1162
  - 3D operations • 1046
  - 3D pocket • 1062
  - 3D product differences • 11
  - 3D RapidCut simulation • 1517, 1525, 1540
  - 3D simulation • 1517, 1538, 1540
  - 3D spiral finish • 1018, 1110
  - 3D Strategy tab • 1055
- 3D milling • 55
- 3D toolpath simulation • 14, 37, 54, 66, 71
- 3Dconnexion • 53

## 4

- 408MT • 234
- 4-axis
  - 4-axis Die feature (Wire) • 865
  - 4-axis match curve • 617
  - 4-axis Punch feature (Wire) • 866
  - 4-axis Side feature (Wire) • 867
- 4th axis indexing

---

FeatureCAM 2016 R2 Reference Help

Index • 1965
4th axis indexing - How the clearance plane is calculated • 243
4th axis indexing - Specifying the tool change position • 242
4th axis indexing with a single setup - Positioning features • 240
4th axis indexing with multiple setups • 238

5
5 axis engraving • 754
5 axis Z-indexing • 13
5AP • 10
5-axis • 68
5-axis engraving • 126
5-axis patterns • 207
5-axis positioning • 256
  Using a single coordinate system • 263
  Using fixture offsets • 265
5-Axis tab • 1136
5-axis untransformed coordinates • 91

6
64-bit files • 67

A
A and 45 degree angled B tilting head figure • 256
A difference B (SOLID) • 476
A intersection B (SOLID) • 476
A table B tilting head figure • 256
A union B • 476
Accelerated feature creation • 532
Accelerators • 34
ACIS files • 82, 94
ACIS solids • 61
ACL code • 1558
Acrobat files • 224
Across curves • 1061, 1090
Across option • 1105
Active setups (TOMB) • 1894
Add • 455, 1875
  Add a new material • 1849
  Add a new tool grade for turning operations • 1850
Add button to toolbar • 27
Add default tools and feed/speed tables to the database • 1854
Add new operation • 1055
Add objects from the part library to a document • 1505
Add part (TOMB) • 1892
Add perpendicular remachining pass • 1061, 1071
Add stock model • 266
Add surface curve • 439
Add to all (TOMB) • 1892
Add tool location • 1916, 1939, 1956
Add tools to a tool crib • 1831
Add Operation to Toolpath dialog • 17
Addendum • 192
Adding Tombstone parts • 26
Adding tool locations to tool blocks • 48
Add-ins • 194, 226, 228, 230, 233, 234, 145, 146, 147, 173
Additional trimming restrictions • 422
Adjust to tool geometry (undercuts) • 1421, 1447
Advanced part boundary options • 1119
Advanced toolbar • 12
AFR • 496
Air blast • 855
Align (UCS) wizard • 112
Align to revolved surface • 113
Alignments for interrogation • 294
All Stepover • 986, 1638
Allowance • 1124
Along curves • 1061, 1090
Along option • 1105
Always
  Always save (toolpath) • 67
  Always save as 32-bit • 67
  Always show • 298
  Always unshow • 298
  Always update • 133
  Always use this one • 1897, 1939
Ambient • 49
Analysis tab • 192
Analysis tab (Gears dialog) • 140
Angle • 290
  Angle end • 1230
  Angle line • 279
  Angle start • 1230
API • 80
Apply button • 188
Approach outside • 1349
Approach RPM • 1511
Approach speed (TURN) • 1409
Approximate linear moves • 1018
Arbor tip length (tooling) • 1774
Arc • 56, 986, 1490
  Arc fitting • 1018
  Arc from center, radius, begin, and end points • 290
  Arc from three points • 288
  Arc from two points and center • 289
  Arc from two points and radius • 288
  Arc Lead • 986, 1638
  Arc/line approx. • 1018
Arcline fitting tolerance • 1018
Arcs • 287, 288, 986, 1018, 1490, 1517
  From 2 points and radius • 288
  From 3 points • 288
  From center radius
    begin and end points • 290
    From center begin and end points • 289
Area clearance
  Roughing • 63
Area removal (3D HSM) • 1062, 1077
Array operators • 40
As add (SOLID) • 455
As cut (SOLID) • 455
As new base solid (SOLID) • 455
As on setup • 41
As on UCS • 41
As on world • 41
Ask before update (op list) • 133
Ask me (saving toolpath) • 67
asm files • 82, 97
Assign keyboard shortcut • 30
Assign shortcut • 30
Assigning a macro to a custom toolbar button • 29
Assistance bar • 5, 1, 29
Attempt chamfer w/ spot • 890, 1599
Attributes • 885, 1592
Authentication mode • 181
Auto Path
  Auto Path Cut Off Option
  Contouring Cycle • 631
  Auto Path Retract Option
  Contouring Cycle • 626
  Auto Path Stop Option • 626
Auto round • 1421, 1447, 1484, 1690
AutoCAD • 61, 89, 93
  Export settings • 93
  Importing AutoCAD files • 89
  Mechanical Desktop Import • 94
  Simplifying 3D AutoCAD data for 2D import • 90
  Solid Import • 94
Auto-chamfer • 204
Autodesk Inventor • 222
Autohide solids • 36
Automatic
  Automatic boss recognition on solid models • 522
  Automatic Feature Recognition • 496
  Automatic feature recognition error • 511
  Automatic flipping • 1059
  Automatic grid • 298
  Automatic options • 1659
  Automatic ordering • 1554
  Automatic pocket recognition on solid models • 522
  Automatic side recognition on solid models • 525
  Automatic synchronized turning • 1562
Automatic Feature Recognition • 185
Automatic ordering • 16, 38
Automatic tool orientation • 74
Automatic tool selection • 16, 110, 146, 1681
Auto-round with TNR • 19
Avoid sharp corners • 324
Away from chuck • 1367
Axial offset • 1269, 1328
Axial tolerance • 1269
Axis (stock) • 208
Axis Length (TOMB) • 1888
Axis of rotation (TOMB) • 1888
Axis smoothing • 68
Axis smoothing • 68
Azimuth angle • 1148

B

B and 45 Degree angled A tilting head figure • 256
B table and A tilting head figure • 256
Back clearance • 1649
Back to top • 8
Back view • 41
Backface lighting • 49
Backfaces removed • 49
Backups • 67
Bad solid (SOLID) • 450
Bad surfaces (SOLID) • 451
Balanced turning • 1562
Ball end (tooling) • 1761
Bar Feed tab • 1708
Bar stock • 160
Bar-fed mill • 85
Bar-fed mills • 234
Barrel Cams • 249
How to create a cylindrical cam • 250
Base (SOLID) • 448
Base priority • 1059, 1658
BASIC IDE • 147
BASIC script • 1955, 1956, 1962
B-axis
 B-axis fixture location • 974
 B-axis simultaneous example (TURN) • 1414
 B-axis support • 1961
 B-axis tab • 1413
Bi-directional cut • 937
Bi-directional rough • 937, 1608
Blend surface • 441
Block Stock • 207
Body diameter (tooling) • 1759, 1775, 1780
Body length (tooling) • 1780
Boolean (SOLID) • 476, 1949
Boolean dialog • 141
Bore • 890, 899
 Bore cycle • 1599
 Bore FDF • 899
 Bore feature • 841, 843
 Bore FF • 899
 Bore FSR • 899
 Bore NoDrag • 899
Bore depth • 202
Bore feature • 30
Boring bars for milling • 1755
Boring tab (TURN) • 1447
Boss recognition • 520
Bottom radius • 979
Bottom semi-finish allowance • 995
Bottom up • 979, 1077
Bottom view • 41
Boundaries • 205
Boundaries for spiral toolpaths • 751
Boundaries for techniques other than spiral • 1130
Boundaries tab • 1124
Boundary Curve allowance • 753
Box zoom • 40
Breakpoints in op list tab • 1551
Bridgeport • 82
Browser • 1, 8, 143
Bullet • 1490
Button size • 24, 29
C
C rotary A tilting figure • 256
C rotary B tilting figure • 256
Cables • 1590
Calculate index radius from solid stock outline • 116
Cam Performance at high speeds • 366
CAMplete • 80, 166
Cams • 249, 364
 Barrel • 249
 Edit Cam Segment • 367
 General tab • 364
 Roller tab • 365
 Segment tab • 366
Canned cycle • 890, 892, 1599
Canned cycle X clearance • 1421
Canned cycle Z clearance • 1421
Cap surface • 448
Catia files • 82, 96, 97
C-axis indexing • 124
Center all • 40
Center point • 1230
Center selected • 40
Centerline options • 1533
Centerline overcut • 1421
Centerline simulation • 142, 1517
Centre all • 26, 44
Chain curves • 27, 44, 56
Chain only on-screen geometries • 324
Chaining • 319
Chamfer • 27, 204, 483, 1050
 Chamfer depth • 995, 1649, 1658
 Chamfer extend dist • 1421, 1703
 Chamfer extent distance (TURN) • 1421, 1465
 Chamfer mills • 1756
 Chamfer, 2D • 287
Chamfer limit • 230
Change Layer dialog • 303
Change link to arc • 439
Change link to line • 438
Change point • 437
Change selected menu option • 128
Changing the active tool crib • 1833
Changing the simulation tool color • 57
Check include or exclude • 1494
Check surfaces • 1049
Checklist • 19
Child solids • 1952
Chip Break • 899, 1599
Chip recognition size • 143
Circle • 281
   From center and edge • 282
   From diameter • 283
   From radius and center • 281
   From two points and radius • 284
   Snapping to centers • 295
   Tangent to two entities • 283
   Through three points • 284
Circular inside corner (WIRE) • 1484
Circular text • 371
Clamps • 80, 83, 185, 1542, 1543
Classic style • 24
Classify slices • 1061, 1062
Cleanup Pass (WIRE) • 1469
Clear Starting Point • 1541
Clear toolpath button (simulation) • 1521
Clearances • 1421, 1447, 1460, 1465, 1949
Climb Mill • 937, 1608
Clip geometry • 315
Clipping curves • 205
Closed areas only (3D HSM) • 1062, 1077
Closed curve • 320
Closed toolpaths • 994
CNC documentation • 93
  cnc file • 1896, 1900
CNC files • 240
CNC-Info menu • 242
CNX • 162
Collate copies • 105
Collision avoidance • 65, 197
Collisions • 1542, 1949
Colors • 128, 129, 132, 1948
Combine similar holes into canned cycle • 1599
Combine solids • 476, 1900, 1949
Combine with similar holes into canned cycle • 890, 892
Combining solids • 141
Combo along and across • 1105
Command line options • 194
Command prompt install language • 37
Comparison of surface and solid modeling • 448
Comparison of surface surface intersection and trim a surface with a curve • 436
Compensation
   Compensation register • 1488
   Compensation value • 1488
Completing the multiple fixture part • 1884
Compress file • 67
Condition dialog • 219
Condition dialog box • 228
Configuration • 1879
Connect attribute • 986
Connect stepovers with arc • 937
Connected lines • 278
Connection moves for cuts with closed ends • 986
Construct solid (SOLID) • 452
Contact Delcam • 8
Contact point • 1061, 1090
Context menus • 1
Context-sensitive help • 6
Continuous spiral (3D LITE) • 1062, 1077, 1102
Contour operation (WIRE) • 1469
Contour Overlap • 1469, 1718
Contouring - wire radius compensation • 1480
Contouring Cycle • 632
   Contouring Cycle Cut Off Option - Auto Path • 631
   Contouring Cycle Retract Option - Auto Path • 626
   Contouring Cycle Stop Option - Auto Path • 626
Controlling operations • 20
Controlling strategies • 20
Convert arcs to linear • 1018
Coolant • 71, 89, 984, 986, 1405, 1649, 1658
Coons • 395, 396, 397
Coordinate system • 26, 44
Coordinate systems • 109
Copies • 105
Copy solid (SOLID) • 452
Core usage • 33
Core/Cavity (SOLID) • 486
Corner blend surface • 441
Corner correction • 1210
corner feedrate reduction • 1656
Corner fillet • 285
Counter bores • 1758
Counterbore hole • 638
Counterbore operation • 202
Counterdrill first • 890, 1599
Counter-drill hole • 638
Counter-drilled Tapped hole • 638
Counter-sink hole • 638
Countersink tab • 1759
Creating a bore feature • 842
Creating a chamfer feature • 688
Creating a cutoff feature • 827
Creating a face feature • 678
Creating a form tool • 1783
Creating a groove feature • 699
Creating a new part • 61
Creating a new part while in FeatureMILL • 61
Creating a new setup • 114
Creating a pattern of part library objects • 1506
Creating a pocket feature • 703
Creating a rectangular pocket • 657
Creating a round feature • 708
Creating a side feature • 714
Creating a single part library object • 1506
Creating a solid (SOLID) • 452
Creating a step bore feature • 669
Creating a thread feature • 819
Creating a tombstone machined part • 1887
Creating a turn feature • 840
Creating a turned face feature • 825
Creating a User Coordinate System • 110
Creating a user defined feature (UDF) • 858
Creating an STL file • 1126
Creating multiple features • 532
Creating shortcuts • 30
Creating the fixture zero relative to one of the faces of the tombstone (TOMB) • 1891
Creating toolbar buttons for macros • 28
Creo files • 82
Cross section for Boss, Side, or Pocket • 716
Cube (SOLID) • 466
Curly Corner dialog • 995
Current UCS • 1939
Cursor color • 138
Curvature • 290
Curve • 27, 44, 50, 68, 4, 318
Adjusting • 179
Approximating with lines and arcs • 337
Arc • 56
Fineness • 44
From curve • 327
From function • 356
From surfaces • 343, 351
Join • 327
Offset • 332
Profile • 68
Project to UCS • 333
Splines • 367
Start/End Point (WIRE) • 1482
Start/reverse • 329
Text • 372
To geometry • 380
Unwrap • 339, 340
Wizard • 325
Curve length • 139
Curve Sorting Options dialog • 6
Curves • 59, 190, 192
Custom Format Name dialog • 236
Custom parallels for vises • 35
Custom setup sheets add-in • 177
Custom toolbar • 24
Customize colors • 128
Customize manufacturing • 1592
Customizing the snapping cursor • 138
Customizing toolbars • 23, 31
Cut
Cut all operations on each curve first (WIRE) • 1476
Cut angle (WIRE) • 1469
Cut data dialog box • 1488
Cut direction • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1269, 1293, 1301, 1310, 1315, 1338
Cut from curves • 455
Cut higher operations first • 1554
Cut Off Option Auto Path - Contouring Cycle • 631
Cut selected surfaces • 1116
Cut sides perpendicular to index axis • 251
Cut the first pass on each curve first (only for Cutoff) (WIRE) • 1476
Cut to bottom • 1116
Cut top edge • 1116
Cut type • 717, 986
Cut type overview • 717
Cut using Y-axis coordinates • 857
Cut with parting surface • 1949
Cut with surface (SOLID) • 474
Cut feature using Y Axis coordinates • 13
Cutoff
Cutoff feature feeds and speeds • 826
Cutoff feature finishing operation • 829
Cutoff feature tool selection • 828
Cutoff Leave Allowance (WIRE) • 1476
Cutoff operation (WIRE) • 1469
Cutoff tab • 1465, 1707
Cutter compensation • 937, 1059, 1476, 1480, 1608, 1661
Cutoff feature • 30
Cutoff Properties dialog • 216
Cutoffs • 143
Cutter length • 16, 1024, 1754, 1755, 1758, 1761, 1767, 1770, 1775, 1780, 1781
Cutting Condition Names dialog • 237
Cutting data • 219
Cutting Data tab (Wire) • 1488, 1489
Cycle contouring • 632
Cycle overview pocketing cycle • 627
Cycle overview zig-zag cycle • 629
Cycle tab • 899
Cylinder example • 410
Cylinder snapping • 187
Cylindrical Cams • 249

D
Database • 2
  Material database • 2
  Tool database • 2
Database • 181
Database tab • 140
Date • 1557
ddx files • 82, 88
Deassign keyboard shortcut • 30
Debug options • 194
Deburr (TURN) • 1360, 1361
Deburr radius • 974, 1649
Decimal places dialog • 317
Decimal points • 92
Defedentum • 192
Deep Hole • 899, 1599
Deep Holes • 153
Default
  Default attributes • 1592
  Default browser content • 8
  Default color list [FC] • 131
  Default colors • 129
  Default conical corner • 615
  Default feed/speed values for turning • 1512
  Default keyboard shortcuts • 30
  Default ramping for milled finish passes • 995
  Default tool • 565, 974
  Default toolbars • 24
  Default values for inches and metric • 1594
Define Custom Colors • 128, 129, 132
Degouge tolerance • 1269
Delcam Exchange • 87
Delcam PowerSHAPE files • 82, 88
Deleting
  Deleting faces • 490
  Deleting features • 1492
  Deleting keyboard shortcuts • 30
  Deleting solids (SOLID) • 450
  Deleting surface curves • 440
  Deleting tool locations • 1933
  Deleting toolpaths • 1521
Deleting unused curves • 103
Depth • 1024, 1619, 1700
Depth column • 1549
Depth cue • 49
Depth first • 937
Depth of cut • 210, 974, 1024, 1447, 1619
Depth-first machining • 1608
Derive surface from feature • 411
Details tab • 1548, 1556
Detect material thicker than (3D LITE) • 1067
Detecting gouges • 1541
Detection angle • 1105, 1108
Diameter • 290, 1024, 1754, 1755, 1758, 1761, 1763, 1767, 1770, 1774, 1775, 1777, 1781
Diametric pitch • 192
Die feature • 218
Die feature (Wire) • 860
Difference (SOLID) • 476
Diffuse lighting • 49
Dimension dialog bar • 292
Dimension text size • 44
Dimensions • 290, 1049
Angle dimension • 290
Annotation • 290
Dialog bar • 292
Diameter dimension • 290
Dimensions tab (feature properties) • 222, 906, 1049, 1353
Horizontal • 290
Label • 290
Linear • 290
Radius dimension • 290
Stock • 207
Vertical • 290
Dips • 210
Direct • 986, 1490
Direction button (3D Lite) • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1269, 1293, 1301, 1310, 1315
Disable Macros option • 163
Disconnected design feature (SOLID) • 449
Display
  Display a single Z level • 1552
  Display Assistance Bar • 29
  Display grid • 298
  Display properties • 1934
  Display settings • 44
  Curve Fineness • 44
Depth Cueing • 44
Surface Fineness • 44
Toolpath Update • 44
Display shortcuts list • 30
Display snap mode dialog • 297
Display Status Bar • 29
Display the profile of a tool • 1837
Display toolbars • 24
Display toolbox • 29
Display mode toolbar • 30
  2D turned profile • 30, 47, 48
Distance between cuts • 986
Dither • 49
Do feed reduction • 1709
Do finish cuts last • 1554
Documentation for CNC files • 93
Dogleg rapid moves • 1961
Don't ask at tool path simulation • 1658
Don't roll over edge • 1116
Double-click depth • 324
Draft angle • 74, 733, 979
Draft face • 494
Draft flat scallop height • 995
Draft radius scallop height • 995
Drill • 890, 899
  Drill cycle • 899, 1599
  Drill depth • 901
  Drill diameter • 1349, 1777
  Drill large counterdrill first • 890, 1599
  Drill only • 887, 1599
  Drill selection for tapped holes • 648
Drill/Mill • 890, 1599
Drilling • 153
Drilling feature attributes • 887
Drilling tab • 1599, 1687
Dual view • 1538, 1539
Dwell • 1421, 1465, 1599, 1703, 1707
dwf files • 89
dwg files • 82, 89
DWG files • 61
DX DY • 292
dxf files • 103
Dynamic tab • 46
Dynamic viewing choice upon
  FeatureCAM start-up • 44
E

Edge • 446, 1667
  Edge chamfer (solid) • 483
  Edge performance • 1122
  Edge tolerance • 1119, 1238
Edges tab • 1116
Edit
  Clip • 314
  Edit cam segment • 367
  Edit colors • 128
  Edit tools • 314
  Infinite • 314
  Trim/extend • 314
Editing a multiple fixture design • 1884
Editing drawings • 309
Editing solids (SOLID) • 452
Effective diameter (tooling) • 1763
Eject button (simulation) • 1521
Elevation angle • 1148
Ellipse curve • 374
Email Delcam • 8
Enable 3D cutter comp • 1059
End
  End Clearance • 1460, 1700
  End curve • 1061
  End points • 295, 1421, 1447, 1460, 1465
Endmill tools • 1761
Endpoint tolerance • 324
Engage angle • 76
Engage Angle • 1421, 1447, 1690
Engraving • 50, 126, 754
Entities dialog • 43
Equal depth of cut • 974, 1024, 1619
Equations • 304, 309
Erase toolpath • 1521
Error (SOLID) • 449
Estimated horsepower • 1557
Evaluating other FeatureCAM components • 11
Even sections • 295
Exact depth of cut • 974, 1619
Examples • 8
Excel document • 1832
Exchange • 223, 87
Exclude features • 4
Exclude steps • 1494
Existing UCS • 1913, 1916, 1924, 1939, 1956
Exit geometry • 276
Exiting a geometry mode • 276
Expand area by (3D LITE) • 1067
Explode solid • 492, 1900
Export • 84
Exporting program files • 233
Exposed length • 16
Exposed length (tooling) • 1754, 1755, 1756, 1758, 1759, 1761, 1763, 1767, 1768, 1770, 1771, 1774, 1775, 1777, 1780, 1781
Extcut (SOLID) • 448
Extend example • 417
Extend geometry • 315
Extend surface • 417
Extension dist • 986, 1638
Extract font curve • 334
Extract with FeatureRECOGNITION • 532
Extracting geometry from solid models of turned parts • 354
Extrude • 385, 468
ezfm.exe • 194
ezfm.ini • 71
ezfm_mfg.ini • 54, 71
ezfm_ui.ini • 54, 71
EZ-UTILS • 1584

F

F/S tab • 984, 986
Face dimensions • 533
Face feature • 30
Face features • 186
Face mills • 1763
Face recognition • 526
Facing attributes • 995
Facing tab • 1682
Fan at ends • 1269
Fanuc-style programming • 240
FDF • 899
Feature • 4
  Bore feature • 30
  Cutoff feature • 30
  Duplicate holes • 49
  Engraving • 50
  Face feature • 30
  Feature and operation editing • 1555
  Feature attributes (WIRE) • 1469
  Feature column • 1549
Fixed-width font • 1564
Fixing solids (SOLID) • 451
Fixture and clamp collision detection • 1542
Fixture collision detection • 1542
Fixture ID (TOMB) • 1890, 1891
Fixture Location wizard (TOMB) • 1890, 1891
Fixture Offset Locations dialog (TOMB) • 1890, 1891
Fixture Zero Location (TOMB) • 1891
Fixtures • 1542
Flat • 410
  Flat diameter (tooling) • 1759
  Flat example • 411
  Flat surface • 410
  Flat surface support • 1164
  Flat-end mill • 979
Flats • 148
Flowline • 200, 774
Fluid • 219
Flutes (tooling) • 1758, 1759, 1761, 1770, 1777, 1780
fm file • 1896, 1900
FMA • 80
Follow distance • 1562
Follow surface laterals (3D MX) • 1097
Follow turning • 213, 1562
Font • 1564
Font curve • 334
For OD mounted tools • 1916
For turning turrets • 1916, 1956
Form Tools • 1783
Formatting reserved words • 92
Formats • 236
Formats editor • 243
Formula for tool move • 1660
Forum • 8
Fourth axis rotation • 237
From feature (SOLID) • 467
From line • 1136
Front view • 13, 41
FSR • 899
Full machine architecture • 80
Full machine simulation • 1896
Function curve • 356
Functions • 307, 356

G
G0 • 1517
G1 • 1517
G2 • 1517
G28 • 1933
G3 • 1517
G53 Z0 before indexing • 1933
G74 • 899
G76 • 899
G81 • 899
G82 • 899
G83 • 899
G84 • 899
G85 • 899
G86 • 899
G87 • 899
G88 • 899
G89 • 899
G98 • 1549, 1602
G99 • 1549
Gear curve • 378
Gears • 140, 192, 378
General simulation options • 1527
General viewing options • 44
Generate Single Program with program stop between each setup • 229, 230
Generating toolpaths • 1520
Generic Z tool • 1956
geo files • 82
Geometry • 274
  Hide all geometry • 61
  Show all surfaces • 61
Geometry Constructors dialog • 275
Geometry creation • 27, 56
  Arc • 56
  Chain curves • 27, 44, 56
  Chamfer • 27
  Curve • 27, 44, 50, 68
  Draft angle • 74
  Engraving • 50
  Fillet • 44
  Line • 27, 44, 56
  Profile • 68
  Taper • 74
  Text • 50
Geometry edit bar • 5, 1
Geometry from curve • 380
Gimbal head figure • 256
Glass style • 24
Go to start • 1658
Gouge • 1900
Gouge avoidance • 197
Gouge check (3D MX) • 1097
Gouge detection • 1541
Gouge-checking • 65
Graphics window • 5, 1
   Results window • 5, 15, 16, 18, 19, 38, 40
   Toolbox window • 5
Grid • 296
Grid display • 298
Grid points • 295
Grid resizes to match • 298
Groove feature • 30
Grooves • 69, 77
Grooving tab • 1703
Groups • 4, 532, 874
Groups of features • 872
GUI • 1

H
Hardness (stock) • 209
Hardness units • 209
Head • 1952
Helical (3D) • 1343, 1349
Helical ramping • 995, 1343, 1349, 1649, 1661
Helical side finish • 155, 995
Helix linear approx tol • 995
Help • 6, 54
   Context-sensistive help • 6
   Help links • 6
   Online help • 6
   Technical support • 6
Help links • 6
Help PDF • 3
Hide all geometry • 61
Hide flyout • 39
Hide grid • 298
Hide menu • 39
Hide rapid moves in centerline simulations • 142
Hide solids • 36
Hide Status Bar • 29
Hide toolbar • 24
Hide toolbox • 29
Hierarchy • 1952
Highlighting objects from the Part View • 55
Holder collision checking • 197, 199
Holder tab • 1804
Hole attribute table • 652
Hole dimensions • 533
Hole feature • 10, 30, 49
Hole Feature Properties dialog • 202
Hole features • 638
Hole figures • 638
Hole macros • 646
Hole patterns • 207
Hole recognition • 512
Hole recognition on imported parts • 99
Holes • 153
Honeycomb pattern • 1061, 1100
Horizontal + vertical strategy • 779
Horizontal distance • 290
Horizontal line • 279
Horizontal milling machine • 49
Horizontal only • 1134, 1667
Horizontal Tombstone Machining • 1886
Horsepower • 995, 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1269, 1293, 1301, 1315, 1546
Hot keys • 30
How
   How a barfeed/barpull is performed • 829
   How a bore feature is manufactured • 833
   How a cutoff feature is manufactured • 826
   How a thread feature is manufactured • 818
   How a turn feature is manufactured • 834
   How a turned face feature is manufactured • 823
   How a turned groove feature is manufactured • 808
   How chamfers are machined? • 685
   How do setups relate to UCSs? • 127
   How feedrates are scaled • 1511
   How holes are manufactured • 647
   How is a face groove machined? • 692
   How is a round machined? • 706
   How is a simple face groove machined? • 694
How rectangular pockets are manufactured • 660
How sides are manufactured • 710
How slots are manufactured • 664
How step bores are manufactured • 667
How to chain lines and arcs into curves • 319
How to change the start point of a curve • 330
How to change User Coordinate systems • 111
How to create a 3D boss from font curves • 754
How to create a barfeed feature • 830
How to create a barpull feature • 831
How to create a fillet surface • 429
How to create a NC program using 4th axis wrapping • 245
How to create a pencil mill operation • 778
How to create a remachining operation • 792
How to create a sub-spindle feature • 847
How to create a surface from a curve mesh • 399
How to create a User Coordinate System • 110
How to create a Z level roughing operation • 760
How to create an indexed program • 236
How to create an intersection curve • 345
How to create blend surfaces • 443
How to create linear text • 369
How to create text along a circle • 371
How to create text along a curve • 372
How to delete a tool crib • 1838
How to export feed/speed tables • 1852
How to export tooling • 1834
How to extract curves from 3D data • 350
How to import feed/speed tables • 1851
How to import tooling • 1831
How to modify a User Coordinate System • 111
How to put two tools in the same tool slot • 1583
How to recognize all holes in a setup • 513
How to recognize drafted features • 508
How to recognize features from surfaces • 501
How to recognize features from surfaces using curve chaining • 503
How to recognize pockets and bosses from top or bottom surfaces • 504
How to recognize pockets automatically from solids • 524
How to reverse a curve • 329
How to trim surfaces against other surfaces • 434
How to untrim a surface • 423
How to use an insert drill to drill and bore in the same program • 1583
HTML • 162
HTML documentation • 42
HTML documentation for CNC • 93
html files • 8
HyperTerminal • 1584

iam files • 82, 97
ID grooves • 69
IDE • 147
IDE Editor • 226
IFR • 56, 186
iges files • 82, 91, 93, 103
Imperial tools • 2
Imperial units • 4
Import • 82
Import formats • 84
Import Results dialog • 85
Import Using Exchange • 87
Import wizard • 85
Import/Export • 75
Import/Export Options • 75
Imported solid models (SOLID) • 448
Imported solid names • 61
Importing • 82
ACIS • 94
AutoCAD • 89
Autodesk Inventor files • 82, 97
Catia • 96, 97
Delcam PowerSHAPE files • 88
Dimensions from DXF and DWG files • 89
DMT files • 98
dwg and dxf files • 89
iges files • 91
Mechanical Desktop • 89
NX (Unigraphics) files • 98
Parasolid • 94
Pro/E files • 97
SolidEdge • 94, 98
SolidWorks • 94, 95
Solidworks assemblies • 96
STEP files • 98
STL files • 98
Tools • 1831
Unigraphics • 94
Importing files • 222, 223, 224
Importing SolidEdge files • 106
Importing SolidWorks 2016 files • 10
Importing SolidWorks files • 105
Importing toolpath points • 17
In to out • 1102
Inch tools • 2
Inch units • 4
Inches per minute • 984, 1649
Inches per revolution • 984, 1649
Inches per tooth (feed) • 984, 1649
Include features • 4, 1494
Include steps • 1494
Increase feed for intermediate steps (3D LITE) • 1067
Increment the fixture ID for each orientation (TOMB) • 1890, 1891
Increment tool color • 57
Index axis • 207
Index axis UCS • 229
Index radius • 116
Index X coordinate (5AP) • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1247, 1269, 1293, 1301, 1310, 1315, 1321, 1328
Index Y coordinate (5AP) • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1247, 1269, 1293, 1301, 1310, 1315, 1321, 1328
Index Z coordinate (5AP) • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1247, 1269, 1293, 1301, 1310, 1315, 1321, 1328
Indexing • 234
Indexing using a stock solid • 116
Individual blocks • 1881
Individual levels • 937, 964
Individual rough levels • 1608
Infeed angle • 1460, 1700
Infeed angle (TURN) • 1460
Infinite and finite lines • 316
Infinite geometry • 316
Infinite lines • 279, 316
ini files • 194, 54, 71
Initial orientation • 231
Initial viewing mode • 44
Initializing FeatureCAM databases • 1514
Inner diameter (tooling) • 1756, 1771
Input modes • 26, 44
Insert length (tooling) • 1767
Insert shape (TURN) • 1402
Insert tip radius (tooling) • 1767
Inside corners (WIRE) • 1484
Inside edge • 1109
Installation message • 180
Installing FeatureCAM • 9
Instructions • 1
Integrated Development Environment • 147
Interactive Feature Recognition • 56, 186
Interface • 1
Interleave spiral paths • 1061, 1077, 1082
Intermediate CNC files • 87
Internal gears • 140
Interrogation • 292
Interrogation dialog • 293
Intersection (SOLID) • 476
Intersections • 295, 1949
Inventor files • 222, 82, 97
Inventor hole recognition • 99
Invoking the automatic feature recognition wizard • 509
Invoking the automatic option of new feature wizard • 500
IPM • 984, 1649
IPR • 984, 1649
IPT • 984, 1649
ipt files • 82, 97
Isccar CUT-GRIP tooling • 1800
Islands • 218
ISO 282-2 standard • 230
ISO cylindrical corner • 615
Isoline • 200
Isoline curve • 347
Isoline milling • 773
 Isoline • 200
Isometric • 41
Isometric 2 • 41
Isometric 3 • 41
Isometric view • 13, 35, 48, 61

J
Jogging • 130
Join curves • 327
JT files • 223

K
Keep toolpaths upon view change • 1533
Keep wire vertical at retract (WIRE) • 1469
Keyboard shortcuts • 34
Keyboard Shortcuts tab • 30
ksi • 209

L
L/D compensation • 1599
Large buttons • 24
Large font • 1564
Last pass overcut % • 995
Lateral Overcut % • 995
Lathe - barfeed tool group • 1803
Lathe design • 1903
Layers • 299, 303
 Changing layers • 303
Layout • 4, 1879, 1880
LCS • 1902, 1924, 1953, 1955
Lead and lean • 1136
Lead angle • 1136, 1143, 1413
Lead distance • 986, 1638
Lead in angle • 1343, 1421, 1638, 1673, 1690
Lead moves for cuts with open ends • 986
Lead out angle • 1343, 1421, 1638, 1673, 1690
Lead/Ramp tab • 1638
Lead-in • 76, 986
Lead-in distance • 1421, 1690
Lead-in length • 1343, 1673
Lead-in/out plane (3D) • 1343
Lead-out • 986
Lead-out angle • 76
Lead-out length • 1343, 1673
Leads • 1517
Leads style tab • 1490
Leads tab (3D) • 1343
Lean angle • 1136, 1143
Leave allowance • 77, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1269, 1301, 1310, 1315, 1421, 1476
Left boundary • 1421
Left view • 41
Left-arrow button • 1493
Length of curves • 139
Lengthen Sim Speed slider • 20
Library part objects • 1505
License checks • 194
Light vector 1 • 49
Light vector 2 • 49
Limit B-angle (TURN) • 1413
Limit linear moves • 1018
Limitations of planar remachining • 794
Limits of movement • 1907
Line • 27, 44, 56
Line at angle through point • 279
Linear approximation • 1343, 1638
Linear distance • 290
Linear moves • 1018
Linear pattern • 875
Linear ramp distance • 995, 1661
Linear text • 369
Linearization tolerance • 1529
Lines • 277, 986, 1517
 Angle • 279, 290
Connected • 278
From 2 points • 277
Horizontal line • 277
Offset • 280
Vertical • 279
Local Coordinate System • 1904, 1924, 1955, 1956
Locating back of tool • 48
Lock Machine Design documents • 175, 1935
Loft (SOLID) • 462
Lofted example • 402
Lofted solid design feature • 462
Lofting • 400
Lower Curve Start/End Point (WIRE) • 1482

M
M00 • 1469
M01 • 1469
Machine can do helix • 995
Machine design • 1896, 1946
Machine Design document protection • 175, 1935
Machine design file • 22
Machine design handbook • 1946
Machine design tutorial • 1939
Machine doors • 1947
Machine hierarchy • 1900, 1952
Machine jogging • 130
Machine maximum stock • 199
Machine movement limits
  Specifying limits • 129
  Testing limits • 130
  Using limits • 113
Machine simulation • 142, 143, 160, 166, 1517, 1896, 1897, 1946
Machine solid • 1896, 1952
Machine tab • 49
Machine tool simulation • 1517
Machine Z coordinate at sub-spindle home • 1961
Machine Z coordinate at sub-spindle max (left) • 1961
Machining
  Machining attributes • 1592
    Mill machining attributes • 1598
    Turn machining attributes • 1686
    Wire machining attributes • 1717
  Machining Contouring Cycle • 632
  Machining - Overview of Strategies • 621
  Machining Overview Pocketing Cycle • 627
  Machining Overview Zig-Zag Cycle • 629
  Machining - Start point for Zig-Zag Cycle • 630
  Machining - Wire radius compensation • 1480
  Machining - Wire radius compensation via Software • 1480
  Machining configurations • 1742
  Machining side • 535
  Machining Side tab • 1057
  Machining type • 890, 1599
  Machining attributes • 182, 204
  Machining Attributes • 154
  Machining operations • 15, 38
    Automatic ordering • 16, 38
    Controlling operations • 20
    Controlling strategies • 20
    Finishing • 63
    Manual ordering • 18
    Operation template • 38
    Ordering options • 16, 38
    Results window • 5, 15, 16, 18, 19, 38, 40
    Roughing • 63
    Semi-finishing • 63
  Macro Add-ins dialog • 226
  Macro buttons • 28
  Macros • 163, 145, 147, 1955
  Main lower (turret) • 1916
  Main spindle (face mounted) • 1916
  Main upper (turret) • 1916
  Make a pattern from this feature • 532
  Managing your settings • 54
  Manual ordering • 18, 1554
  Manually ordering Pocket curves • 8
  Manufacturing • 483
    Manufacturing Attributes
      Climb Mill • 937, 1608
      Feed Override % • 1059
      Finish Passes • 995, 1421
      Plunge Clearance • 1059
      Plunge Feed Override % • 974, 1059
      Pre-drill Diameter • 995
      Priority • 995, 1059
      Retract to Plunge Clearance • 890, 974, 1059, 1340, 1549, 1599
      Spindle RPM Override % • 1059
      Spline Tolerance • 1059
Milling Post Processors • 1861
Milling setup • 4
Milling tab • 995, 1024, 1162, 1608
Min radius boundary • 1421
Minimize rapid distance • 1554
Minimize tool changes • 1554
Minimize tool retract • 1608
Minimize width check box • 242
Minimum B-angle (TURN) • 1413
Minimum corner radius • 974, 1649
Minimum fanning • 1269
Minimum rapid distance • 1649
Minimum rapid distance % (3D Lite) • 1164, 1180, 1195, 1203, 1210, 1223, 1230, 1238, 1247, 1269, 1293, 1301, 1310, 1315, 1321, 1328
Minimum rest material • 1061
Minimum retract • 937
Minimum surface slope • 1134
Minimum Z increment • 1210, 1321
Minimum Z ramp dist % • 1638
Mini-turrets • 132
Misc attributes • 1059
Misc tab • 29, 974, 1024, 1059, 1484, 1649, 1709
Mixing 3D simulation and rapid cut • 1540
Modal delimiters • 243
MODEL files • 82, 96
Modify example • 441
Modify inside corners • 1484
Modify surface • 437, 448
Modifying geometry • 309
Modifying patterns • 874
Modifying solids • 141
Module • 192
Modules • 10
More colors • 128, 129, 132, 1948
More Simulation toolbar • 22
Motion controller support • 53
Mouse options • 44
Move features to a different setup • 1492
Move solid (SOLID) • 452
Movement • 1902
Moves as Turn spindle • 1905
MSIM • 10
MTT • 10
Multi Turret Turning • 161
Multi-code coolant • 89
Multi-finish diameters • 995
Multi-pencil • 1105
Multiple coolant types • 71
Multiple cuts • 1269, 1328
Multiple features • 532
Multiple fixture part • 1873
Multiple operation overrides • 1556
Multiple regions • 314
Multiple rough • 1061
Multiple roughing tools for milling • 1680
Multiple select • 4
Multiple Setups • 56
Multiple Setups simulation • 1545
Multiple tool diameters (3D LITE) • 1067
Multi-rough diameters • 995, 1017
Multi-tool blocks • 170
Multi-turret machining • 211, 213, 215

N

Name (tooling) • 1754, 1755, 1756, 1758, 1759, 1761, 1763, 1767, 1768, 1770, 1771, 1774, 1775, 1777, 1780, 1781
Name Layer dialog • 302
Naming solids • 1948
NC code • 21, 41, 73, 58, 87, 1517, 1548, 1558, 1564
Saving NC code • 23
Tool mapping • 22
NC file extension • 240
NC part program • 1557
NC program names • 125
NCSIMUL • 233
NCSIMUL add-in • 173
Neck diameter (tooling) • 1774
Negative leave allowance for grooves • 77
Nested • 1882, 1883
Nesting • 81, 189
Net • 10
Network printer • 107
Never save (toolpath) • 67
New Crib • 1746
New feature strategy • 1061
New Feature wizard • 531, 574
New Feature - Curves page • 534
New Feature - Default Tool page • 565, 604
New Feature - Dimensions page • 533, 574
<table>
<thead>
<tr>
<th>New Feature</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed/Speed page</td>
<td>568, 607</td>
</tr>
<tr>
<td>Location page</td>
<td>535, 575</td>
</tr>
<tr>
<td>Machining Side page</td>
<td>535</td>
</tr>
<tr>
<td>Operations page</td>
<td>565</td>
</tr>
<tr>
<td>Strategies page</td>
<td>538, 576</td>
</tr>
<tr>
<td>Summary</td>
<td>568</td>
</tr>
<tr>
<td>Tool Usage (TURN)</td>
<td>608</td>
</tr>
<tr>
<td>Type (TURN/MILL)</td>
<td>608</td>
</tr>
<tr>
<td>Feature Wizard</td>
<td>207</td>
</tr>
<tr>
<td>New Files tab</td>
<td>137</td>
</tr>
<tr>
<td>New FM document</td>
<td>63</td>
</tr>
<tr>
<td>New keyboard shortcut</td>
<td>30</td>
</tr>
<tr>
<td>New Object Color Override dialog</td>
<td>132</td>
</tr>
<tr>
<td>New part</td>
<td>61</td>
</tr>
<tr>
<td>New part document</td>
<td>1946</td>
</tr>
<tr>
<td>New Part Document dialog</td>
<td>63</td>
</tr>
<tr>
<td>New Part Document wizard</td>
<td>222</td>
</tr>
<tr>
<td>New Part Document Wizard</td>
<td>61</td>
</tr>
<tr>
<td>New shortcut</td>
<td>30</td>
</tr>
<tr>
<td>New solid (SOLID)</td>
<td>452</td>
</tr>
<tr>
<td>New Stock Material dialog</td>
<td>184</td>
</tr>
<tr>
<td>New strategy — Finish</td>
<td>742</td>
</tr>
<tr>
<td>New strategy — Rough</td>
<td>740</td>
</tr>
<tr>
<td>New strategy — Semi-finish</td>
<td>741</td>
</tr>
<tr>
<td>New Technology (NT) toolpaths (25D)</td>
<td>717</td>
</tr>
</tbody>
</table>

| Number of copies | 1564 |
| Number of copies to keep | 67 |
| Number of faces (TOMB) | 1888 |
| Number of passes | 1445 |
| Number of steps | 974, 1619 |
| Numeric attributes | 995 |
| NX files | 82, 98 |

| Object color | 128 |
| Objects | 295 |
| OD grooves | 69 |
| OD turning (LH) | 1956 |
| OD turning (RH) | 1956 |
| Offset (solid) | 1949 |
| Offset (SOLID) | 480 |
| Offset boundary tolerance | 1119 |
| Offset curve | 332 |
| Offset line | 280 |
| Offset Method (WIRE) | 1476, 1480 |
| Offset Options dialog (WIRE) | 1476 |
| Offset tab | 1726 |
| Offset Toolpath (WIRE) | 1476, 1480 |
| Offset/spiral | 1061, 1062 |
| Offsetting Tab (Machining Attributes) | 1726 |
| Okuma-style programming | 240 |
| Online help | 6 |
| Only update display every | 1533 |
| Op | 1557 |
| Op List | 133, 1549 |
| Opacity | 49 |
| Open and closed portions of toolpaths | 994 |
| Open toolpaths | 994 |
| Opening a part | 4 |
| Operating systems | 180 |
| Operation | 1527 |
| Operation column | 1549 |
| Operation details | 1557 |
Operation list • 133, 1548, 1556
Operation order • 1554
Operation ordering • 1554
Operation simulation • 1523
Operation template • 38
Operation view • 1559
Operation-level tabs • 887, 904, 1046
Operations • 15, 38, 211, 213
  Automatic ordering • 16, 38
  Controlling operations • 20
  Controlling strategies • 20
  Manual ordering • 18
  Operation template • 38
  Ordering options • 16, 38
Operations (WIRE) • 1469
Operations list • 19
Operations tab (25D) • 1658
Operators • 305
Operator's checklist • 19
Operators table • 305
Optimize parallel pass • 1071
Options • 71, 128
Options (printing) • 105
Order of operations • 1554
Ordering • 1658
Ordering feature curves • 6, 8
Ordering of operations • 15, 38
  Automatic ordering • 16, 38
  Controlling operations • 20
  Controlling strategies • 20
  Manual ordering • 18
  Operation template • 38
  Ordering options • 16, 38
Ordering optimization • 1496
Ordering options • 16, 38
Orientation (printing) • 107
Orientation (TURN) • 1402
Orientation angle • 124
Orientation of turning tools • 74
Orientation tab • 1814
Origin • 1557
Other side • 1360, 1361
Outer diameter (tooling) • 1756, 1771
Output filter tolerance • 1018
Output filtering • 152
Output options • 150, 152, 1018, 1164,
  1180, 1188, 1195, 1203, 1210, 1223,
  1230, 1238, 1269, 1301, 1310, 1321,
  1328
Output streams • 87

Outside corners (WIRE) • 1484
Outside edge • 1109
Outside of Limits dialog • 113, 1907
Overall length (tooling) • 1754, 1756, 1758, 1759, 1761, 1767, 1770, 1771, 1774, 1775, 1777, 1780, 1781
Overcut percent • 1061, 1113, 1124
Overlap (WIRE) • 1469
Overlap angle • 1110
override • 984, 986
Override multiple operations • 1556
Overrides • 215
Overrides tab (tooling) • 1024
Overriding the tool feed or speed for multiple operations at once • 1556
Overview - Machining strategies • 621
Overview Pocketing Cycle • 627
Overview Zig-Zag Cycle • 629
Overview of blend surfaces • 442
Overview of chaining • 319
Overview of combine solids • 476
Overview of cut solid with parting surface • 474
Overview of feeds and speeds • 1509
Overview of fillets • 427
Overview of isoline milling • 773
Overview of shell solid design feature • 478
Overview of solid fillets • 471
Overview of solid from 2.5D feature • 467
Overview of stepover types • 717
Overview of stitching • 464
Overview of surface from curve mesh • 398
Overview of surface surface trimming • 433
Overview of the feature rerecognition wizard • 528
Overview of tooling • 1745
Overview of trimmed surface • 419
Overview of untrimming surfaces • 422

P

P numbers • 240
Pan and zoom • 40
Panels • 182
Paper size (printing) • 107
Paper source (printing) • 107
Parallel • 1091, 1110
Parallel angle • 1018, 1061, 1062, 1071, 1100, 1667
Parallel toolpaths • 746
Parallels for vises • 35
Parameters • 194, 1592
Parameters (feature level) • 885
Parametric modeling • 309, 310
Parasolid • 62
Parasolid files • 82, 94
Parasolid v28.0 • 11
Parent/child relationships • 1900, 1902, 1911, 1939, 1955
Part • 1557
Part
  Opening a part • 4
Part boundary options • 1119
Part boundary tolerance • 1119
Part catcher • 1367
Part catchers • 216
Part compare • 1524
  Part compare example • 1525
  Part compare options • 1534
  Part compare rest material > • 1534
Part documentation • 19, 40
Part Documentation • 70
Part handling • 158
Part handling simulation • 23
Part library • 99
  Adding objects • 1505
  Importing objects • 1505
  Part library example • 1504
Part line program • 937, 1608, 1661
Part Location dialog • 26
Part Location page (TOMB) • 1894
Part Name • 125
Part surfaces • 1049
Part Tree • 4
Part view • 182
Part View • 1, 4, 448
Part-catcher • 1962
Partial select • 98
Parting surface • 492
Parts List • 1876, 1882
Pass-level tabs • 904
Past special - reference • 1500
Paste special — attributes • 1500
Paste special — location • 1500
Pasting features • 101
Pattern • 4
Pattern dialog • 874
Pattern Properties • 876
  Linear • 290, 876, 1018
  Point List • 879
  Rectangular • 875
Patterns • 207, 875
Pause button (simulation) • 1521, 1522
Pause on limits • 1907
Pause simulation • 1522, 1546
Pausing a toolpath simulation • 1522
PDF • 54
PDF files • 224
PDF of reference help • 3
Peck retract distance • 1465, 1703, 1707
Pecking • 153
Pecking tab • 1606
Pencil milling • 777
Per minute (feed) • 984, 1649
Per revolution (feed) • 984, 1649
Per tooth (feed) • 984, 1649
Performance • 1122
Perpendicular remachining pass • 1061
Pick curve pieces • 321
Pick Dimension dialog • 139
Pick point • 275
Pick types and pick filters for interrogation • 294
Picking profiles • 319
Pilot diameter (tooling) • 1758
Pilot drill • 890
Pilot drill diameter • 1599
Pilot length • 202
Pin gauge • 192
Pinch turning • 213, 1562
Pitch diameter • 192
Planar remachining operation • 790
Plunge • 1340, 1349
  Plunge (relative) • 974
  Plunge center first • 1367
  Plunge clearance • 974, 995, 1340, 1599, 1649, 1709
  Plunge feed % • 1649
  Plunge Feed Override % • 974, 1059
  Plunge feed override % (3D Lite) • 974, 995, 1164, 1180, 1188, 1195, 1203, 1210, 1230, 1238, 1269, 1293, 1301, 1310, 1315, 1321, 1328
  Plunge feed override (1st step) % • 995
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program point tab</td>
<td>1816</td>
</tr>
<tr>
<td>Project curve to UCS</td>
<td>333</td>
</tr>
<tr>
<td>Project to UCS</td>
<td>333</td>
</tr>
<tr>
<td>Project to XY plane</td>
<td>1148</td>
</tr>
<tr>
<td>Projected onto surface curve</td>
<td>349</td>
</tr>
<tr>
<td>Proportional plunge feed</td>
<td>1649</td>
</tr>
<tr>
<td>Protecting Machine Design files</td>
<td>175, 1935</td>
</tr>
<tr>
<td>prt files</td>
<td>82, 97, 98</td>
</tr>
<tr>
<td>Punch feature (Wire)</td>
<td>861</td>
</tr>
</tbody>
</table>

**Q**

Quadrant • 295

**R**

\[ r = F(a) \] • 358  
\[ r = F(a), z = G(a) \] • 361  
\[ r = F(a) \] • 358  
\[ r = F(z), Z = G(a) \] • 361  
Radial  
- Radial about X • 535  
- Radial about X axis • 935  
- Radial about Y • 535  
- Radial about Y axis • 935  
- Radial offset • 1269, 1328  
- Radial pattern • 876  
- Radial toolpaths • 760  
Radius • 290  
Radius end • 1230  
Radius mill • 979  
Radius start • 1230  
Radius tool scallop height • 995  
Ramp angle (3D) • 1343, 1349  
Ramp angle offset • 995, 1661  
Ramp diameter • 995, 1343  
Ramp diameter % • 995, 1638, 1661, 1673  
Ramp styles • 1490  
Ramp to depth (3D) • 1343, 1349  
Ramp type • 1638  
Ramp-in angle • 1343, 1673  
Ramping (3D) • 1343, 1349  
Ramping attributes • 995  
Ramping for milled finish passes • 995  
Ramp-out angle (3D) • 1343  
Rapid moves • 142, 1517  
Rapid traverse • 1658  
RapidCut conversion tolerance • 1534  
RapidCut simulation • 1517, 1525, 1540  
Raster angle (3D HSM) • 1110  
Ream • 890, 899  
- Ream before chamfer • 890, 1599  
- Ream cycle • 1599  
- Ream FDF • 899  
- Ream FF • 899  
- Ream FSR • 899  
- Reams • 1770  
RECOG • 10  
Recreating tooling and feed/speed databases if they become corrupt • 1855  
Rectangle curve • 375  
Rectangular pocket • 533  
Redistribute points • 1018  
Redo • 309  
Reduce curve • 335  
Reducing curve data • 338  
Reference help PDF • 3, 54  
Reflect geometry • 313  
Reflect solid (SOLID) • 452  
Refreshing the view • 54  
Region example • 414  
Region of interest • 1521, 1522  
Registers • 1488  
Relative plunge • 15, 974, 1340  
Relative retract • 1340  
Release center • 8  
Relief groove • 1367, 1700  
Reload settings • 54, 71  
Remachining • 1061, 1067, 1709  
Remove  
- Remove all sync points • 1559  
- Remove all undercuts • 1421, 1447  
- Remove area less than (3D HSM) • 1062, 1077  
- Remove button from toolbar • 27  
- Remove deep cuts • 1105  
- Remove object from simulation • 1899  
- Remove selected sync point • 1559  
- Remove shortcut • 30  
- Remove slugs (simulation) • 1540  
- Remove unsafe areas (3D HSM) • 1062, 1077  
Rename object • 1948  
Renaming features • 1492  
Reorder • 1164, 1195, 1608  
Reports • 1556
Reserved words • 92, 242, 243
Reset all opers to default turret • 1559
Reset normals • 1057
Reset selected opers to default turret • 1559
Reset settings • 44
Reset viewing options • 44
Resize grid • 298
Resolution • 1529
Restrictions
- Restrictions of 4th axis wrapping • 252
- Restrictions of indexing • 243
- Restrictions of plunge roughing • 781
- Restrictions of projection milling techniques • 748
- Restrictions of surface from curve mesh • 399
- Restrictions of using pick pieces (chaining) for creating curves • 322
- Restrictions on blend surfaces • 444
Rests • 234
Results window • 5, 15, 16, 18, 19, 38, 40, 1, 1548
Retract • 1340
  Retract • 937
  Retract and Plunge dialog • 1340
  Retract column • 1549
  Retract Length (WIRE) • 1469
  Retract operation (WIRE) • 1469
  Retract options • 626, 1340
  Retract point • 995
  Retract to • 1136, 1599
  Retract to Plunge Clearance • 890, 974, 1059, 1340, 1549, 1599
  Retract to Z rapid plane • 890, 1340, 1549, 1599
  Retract/plunge • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1247, 1269, 1293, 1301, 1315, 1321, 1328
  Retract on non-cutting moves • 64
Reuse path in canned cycle (TURN) • 1367, 1690
Reverse Cutoff (WIRE) • 1469
Reverse scroll wheel zoom • 46
Reverse surface • 414
Reverse tap cycle • 899
Reverse tool axis (3D MX) • 1097
Revolve (SOLID) • 457
Revolve a surface (SOLID) • 470
Revolved boundary curve • 353
Revolved example • 388
Revolved solid design feature • 457
Revolved solid from surface design feature • 470
Revolved surface • 1939
RH Command line options • 73
Right boundary • 1421
Right view • 41
Rockwell • 209
Roller tab (cams) • 365
Rotary rapid • 1658
Rotate • 40
  Rotate geometry • 312
  Rotate solid (SOLID) • 452
  Rotate view when indexing • 1529
  Rotate X • 40
  Rotate Y • 40
  Rotate Z • 40
Rotating construction grid • 296
Rotation axis (TOMB) • 1888
Rotation of primary axis • 266
Rough • 937, 1666
  Rough cutter comp • 1608
  Rough depth of cut • 1024
  Rough pass • 1619, 1682
  Rough pass stepover % • 1180
  Rough pass Z increment • 995, 1024
  Rough turn • 1700
Roughing • 63
Roughing methods • 717
Roughing toolpaths (25D) • 717
Round corners (TURN) • 1360, 1361
Round stock • 143, 207
Rounded inside corner • 1484
Rounding mills • 1771
RPM • 984, 986
Ruled example • 394
Ruled surface • 392, 448
S
sab files • 82, 94
Safe Area dialog • 1136
sat files • 82, 94
save • 66
  Save .stl dialog • 104
  Save as 32-bit • 67
Save combined boundary • 1116, 1124
Save computed toolpath • 67
Save Holes • 1124
Save NC • 1529
Save on Exit • 71
Save options • 67
Save preview picture in file • 67
Save result files during 3D Sim • 1529
Save result files during rapid cut • 1529
Save settings now • 54, 71
Save simulation results • 1126
Save STL dialog • 104, 1126
Save toolpath • 67
Save view • 42
Saving a part file • 66
Saving an NC part program to disk • 1568
Saving and opening multiple fixture parts • 1885
Saving NC code • 23
Saving your settings • 71
Scale geometry • 312
Scale solid (SOLID) • 452
Scallop height • 1210, 1247, 1310, 1321, 1667
Scallop stepover (3D MX) • 1210, 1247, 1321
Screen layout • 5
Scripts, running • 194
Section • 298
Segment adjustment • 179, 182
Segment End Format • 39
Segment tab (cams) • 366
Segments • 230
Select Active Tool Crib dialog • 1833
Select button • 1899
Select circles • 885
Select Core/Cavity (SOLID) • 486
Select Fixture dialog • 26
Select Fixture Setup (TOMB) • 1890
Select Fixtures (TOMB) • 1894
Select Part dialog (TOMB) • 1894
Select tool block • 1580
Selected object color overrides • 128, 1948
Selecting a Machine Design file • 22
Selecting objects • 98
Selection radius • 44
Semi-finish • 937
Semi-finishing • 63
Sequence • 200
Serial port pinouts • 1591
Server authentication • 181
Set sync at oper start • 1559
Settings • 71, 1718
Setup • 4, 105, 1557, 1896, 1897
  Imperial units • 4
  Inch units • 4
  Metric units • 4
  Milling setup • 4
  Setup - Simulation Information • 1897
Setup - Simulation information dialog • 22
Setup Activate add-in • 36
Setup column • 1549
Setup layer • 299
Setup Name column • 1549
Setup Sheet • 165
Setup Sheet add-in improvements • 34
Setups • 56
Setup-sheet • 79
Shade stock by default • 49
Shaded gray style • 24
Shading • 35, 48, 61
Shading options • 49
Shading Options dialog • 49
Shadow quality • 1529, 1899
Shadows (simulation) • 1899
Shank diameter (tooling) • 1754, 1756, 1758, 1759, 1761, 1767, 1770, 1771, 1774, 1780, 1781
Shape modifiers (SOLID) • 471
Sheet (SOLID) • 446
Shell (SOLID) • 478
Shininess • 49
Shortcut keys • 30
Show
  Show • 1524
  Show animation • 1533
  Show flyout • 37
  Show gouge • 1534
  Show grid • 298
  Show holder • 1527
  Show menu • 37
  Show pause on gouge dialog • 1529
  Show rest material • 1534
  Show spindle • 1527
    Turret column • 1549
Show surface boundaries only • 44
Show this dialog • 1546
Show tool load • 1521, 1546
Show toolbar • 24
Show Toolbox • 29
Show Turn chuck • 1529
Show/Hide Material • 1513
Status Bar • 29
Show all surfaces • 61
Show Centerline Rapids • 142
Side feature (Wire) • 862
Side finish bottom up • 1608
Side finishing • 979
Side grooves • 69
Side leave allowance • 995
Side liftoff distance • 1421
Side mills • 1774
Side recognition • 525
Side roughing • 979
Side roughing bottom up • 1608
Significant digits • 292
Silent install • 9
Silent install language • 37
Silhouette (SOLID) • 484
Silhouette Curves • 484
Simulate feature • 1523
Simulation • 142, 143, 160, 166
Simulation (machine) • 1896, 1897
Simulation C angle offset • 1916
Simulation control • 1551
Simulation controls • 1521
Simulation machine design file • 1897, 1900
Simulation Options dialog • 1526
Simulation speed • 1521, 1527
Simulation toolbar • 1521
Simulation types • 1520
Simulation Options dialog • 143
Simulation tool color • 57
Single block • 1881
Single Cutoff Pass (WIRE) • 1476
Single step button (simulation) • 1521, 1522
Single-click depth • 324
Size of buttons • 24
Skim Pass Options dialog (WIRE) • 1476
Skin (user interface) • 24
Skip wall pass • 1421
Slant bed lathe • 49
Slant-bed turning machines • 1954, 1962
sldasm files • 82, 96
sidprt files • 82, 95
Slices • 1061
Slop limits tab • 1134
Slope boundary • 1061, 1091
Slope limitation angles • 1667
Slope overlap • 1091
Slot • 519, 533, 662
Slot feature • 53
Slug removal simulation • 1540
Small buttons • 24
Small font • 1564
Small parts • 154
Smart dialogs • 54
Smart MD choice • 22
Smooth animation • 1533
Smooth line • 49
Smooth shading • 49
Smooth/reduce curve • 335
Smoothing • 1102, 1110, 1269
Smoothing distance (5-axis Sim) • 1136
Snap Discrimination dialog • 297
Snap modes • 15, 295
Snapping • 138, 187, 295
Snapping grids • 134, 296, 298
SOLID • 10
Solid (SOLID) • 446, 448
Solid colors • 1948
Solid design features (SOLID) • 448, 449
Solid error (SOLID) • 449
Solid from curves (SOLID) • 455
Solid Import tab • 77
Solid model • 1124
Solid offset • 1900
Solid simulation • 1517
Solid source file • 95
Solid Source File dialog • 95
Solid toolbar • 22
Solid wizard • 453
Solid modelling • 141
SolidEdge • 106
SolidEdge files • 82, 98
SolidEdge hole recognition • 101
SolidEdge Import • 94
Solids • 61, 188, 223, 4
SolidWorks • 105, 94, 95
SolidWorks and Autodesk Inventor automatic hole recognition example • 102
SolidWorks Export settings • 93
SolidWorks files • 82, 93, 95, 96
SolidWorks hole recognition • 100
SolidWorks IGES Export settings • 93
SolidWorks Import • 94, 95
SolidWorks 2016 files • 10
Sorting feature curves • 6
Source file • 95
SpaceBall • 53
SpaceMouse • 53
SpaceTraveler • 53
Spacing • 298
Spatial R25 SP2 • 62
Specific stock length • 160
Specify limits • 1907
Specify movement • 1904, 1905, 1939, 1954, 1955
Specular • 49
Speed • 984, 1527, 1649
Speed column • 1549
Sphere • 406, 408
Spindle direction • 608
Spindle list • 1558
Spindle properties dialog • 1846
Spindle RPM override • 974, 1059
Spiral • 717, 986, 1074, 1110, 1203, 1210, 1223, 1301, 1619
Spiral in • 1061, 1074, 1091
Spiral out • 1061, 1074, 1091
Spiral stepover (25D) • 717
Spiral toolpath (25D) • 717
Spiral toolpaths • 750
Spiral Z-roughing (3D) • 1061
Spiral finishing • 155
Spline curve • 367
Spline Tol • 974, 1059, 1649
Splines • 367
Split face • 489
Split surface • 424
Spot Drill • 890, 1349, 1599
Spot drill depth • 901
Spot drill diameter % • 1599
Spot drill edge break • 1599
Spot face • 899
Spotdrills • 1775
Spring Passes • 971, 1367, 1661, 1700
SQL server • 181
SQL Server • 168, 1840
S-shape • 986
Standard toolbar • 11
Start
Start angle • 995, 1661
Start Clearance • 1460, 1700
Start curve • 1061
Start point (TURN) • 1421, 1447, 1460, 1465
Start points • 995, 1210, 1238, 1269, 1301
Start tab • 1731
Start threads • 995, 1460
Starting FeatureCAM • 2
Starting Point (simulation) • 1541
Starts • 1661
Status bar • 5, 32
Steady rest • 158
Steady-rest • 1955, 1962
Steep and shallow strategy (3D HSM) • 1321
Steep first • 1110
Steep slope • 1667
Steep slope angle • 1061, 1071
Step 1 • 1367, 1700
Step 2 • 1367, 1700
Step backward (simulation) • 1521
Step Bore dimensions • 533
Step cutting (3D LITE) • 1067
step files • 82, 98
Step size • 266
Step up (3D LITE) • 1067
Stepover • 1188, 1195, 1203, 1223, 1238, 1301, 1517, 1667
Stepover % • 995, 1421, 1703
Stepover (WIRE) • 1469
Stepover rapid distance (3D Lite) • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1238, 1269, 1293, 1301, 1328
Stepover tab • 1619
Stepover type • 1673
Stepover type (3D) • 1343, 1349
Stepovers tab • 986, 1024
Steps • 974, 979, 1619
Steps buttons • 29
Steps panel • 1
Steps toolbar • 22
Steps Toolbox buttons • 29
Stepover type overview • 717
Stepovers tab • 986, 1024
Steps • 974, 979, 1619
Steps buttons • 29
Steps panel • 1
Steps toolbar • 22
Steps Toolbox buttons • 29
Stitch (SOLID) • 464
Stk (SOLID) • 448
STL • 4, 1900
stl files • 4, 1124
Stock • 9, 24, 44, 56, 67, 4, 223, 1557, 1883, 1956
Stock axis • 208, 235
Stock curve • 224
Stock indexing tab • 229
Stock layer • 299
Stock material • 209
Stock models • 266, 1124
Stock opacity • 49
Stock overcut % • 1269, 1328
Stock tab • 1124
Stock wizard • 205
Stock wizard - Align Part Program Zero with UCS • 216
Stock wizard - Align with Index Axis • 216
Stock wizard - Definition • 212
Stock wizard - Dimensions • 207
Stock wizard - Material • 209
Stock wizard - Multi-axis options • 211
Stock wizard - Multi-axis positioning • 211
Stock wizard - Part Program Offset • 218
Stock wizard - Part Program Zero • 214, 215
Stock length • 160
Stock materials • 184, 199
Stock models • 205
Stock solid • 72
Stock solid indexing • 116
Stop button (simulation) • 1521
Stop Code • 1469
Stop Length (WIRE) • 1469
Stop operation (WIRE) • 1469
Stop option • 626
stp files • 82, 98
Strategy
  Automatic ordering • 16, 38
  Controlling strategies • 20
  Manual ordering • 18
  Ordering of operations • 15, 38
  Ordering options • 16, 38
Strategy tab • 213
Strategy tab (feature properties) • 890, 937, 1061, 1367, 1469
Strategy-level tabs • 1046
Student version • 10
Style • 24, 1490
Styles of automatic feature recognition • 497
Sub slot • 1580
Subfixture ID • 974
Sub-spindle (face-mounted) • 1916
Sub-spindle location tab • 848
Sub-spindle transfer • 1962
Sub-spindles • 845, 1558, 1915, 1955, 1956
Sub-upper turret • 1916
Suffix • 292
Summary of ways you can make holes in FeatureCAM • 650
Support for Microsoft SQL server 2014 • 168
Support forum • 8
Surface • 446, 448
  Surface boundary • 343
  Surface control tab • 1160
  Surface design tips • 382
  Surface edges curve • 350
  Surface editing • 383
  Surface editing tips • 383
  Surface fineness • 44
  Surface from feature • 411
  Surface from multiple surfaces • 426
  Surface from one surface • 412
  Surface intersection curve • 345
  Surface join tolerance • 1269, 1328
  Surface Lead-in tab • 1673
  Surface Mill tab • 1667
  Surface milling feature dimensions tab • 1049
  Surface Milling Properties dialog • 1046
  Surface Normal offset • 416
  Surface of revolution • 386
  Surface offset • 416
  Surface projection curve • 351
  Surface region • 413
Surface Region • 413
Surface Reverse • 414
Surface speed (TURN) • 1409
Surface surface trimming restrictions • 435
Surface triangle tolerance • 1018
Surface wizard • 381
Surface/surface trimming • 432
Surface-surface trimming • 432
Surface creation • 60
Surface of revolution • 60
Surface milling feature • 63
Surface Milling Properties dialog • 199, 200, 205
Surface of revolution • 60
Surface selection • 195
Surfaces • 28, 381, 441
   Blending • 441
   Cap • 405
   Coons • 396
   Cylinders • 409
   Editing • 383
   Extending • 417
   Extruded • 385
   Fillet • 427, 448, 471
   Flat • 410
   From 2.5D feature • 411
   From surface region • 413
   Lofted • 400
   Merging • 431
   Modifying • 437
   Offset • 416
   Reversing • 414
   Revolved • 386
   Spheres • 406
   Splitting • 424
   Surfaces from curves • 384
   Sweep • 389
   Trimming • 418
   Trimming with another surface • 432
   Untrimming • 422
Swarf axis tol • 1667
Swarf machining • 66
Swarf milling • 795
Sweep • 391, 460
Swept surface • 389
Switch machining side • 535, 1057
Synchronizing operations • 211
Synchronizing operations (multi-turret) • 1559

System units • 64

T

Table • 1905, 1939
Tabs • 904
   Threshold angle • 1110
   Through • 995
Tailstock • 1955, 1962
Tangent • 295
Tap • 899
Tap cycle • 1599
Tap depth • 901
Tap plunge clearance • 1649
Taper • 74
Taper (tooling) • 1761, 1770, 1777, 1780
Taper angle • 1446
Taper approx angle • 995, 1661
Tapered mill • 979
Taps • 1777
Target horsepower • 995, 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1269, 1293, 1301, 1310, 1315, 1321, 1328, 1575
Target part tessellation tolerance • 1534, 1535
Teardrop • 1490
Technical support • 6
Teeth (tooling) • 6
Thread • 533
Thread feature • 30
Thread mill attributes • 995
Thread Mill tab • 1661
Thread mills • 1780
Thread tool selection • 822
Threading (WIRE) • 1484
Threading operation • 823
Threading tab • 1700
Three point fillet • 286
Through depth • 995
Through option • 995, 1661
Thumbnail pictures • 65
Tilt axis for gouge avoidance • 1136, 1144
Time • 1527
  Time estimation • 1658
  Time view • 1558
Tip angle (tooling) • 1775
Tip offset • 1050
Title bar • 5, 1
TNR undercut checking • 19
Tolerance • 179, 266, 292, 1018, 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1269, 1293, 1301, 1310, 1315, 1321, 1328, 1667
Tolerance of Line Segments dialog • 182
Tolerance of Turned Segments dialog • 179
Tolerancing • 31
TOMB • 10
Tombstone • 1894
  Adding a part to the tombstone • 1894
  Coordinate systems from already placed parts • 1890
  Creating global fixture coordinate systems on the tombstone • 1891
  Creating tombstone document • 1887
Delete button • 1892
Edit button • 1892
Fixture • 1887
Overview • 1886
Reload button • 1892
Specifying tombstone physical dimensions • 1888
  Thickness • 1888
  Tombstone Process Plan dialog • 1890, 1891
Tombstone adding parts • 26
Tool • 565, 1527, 1557
  Tool % of arc radius • 974, 1059
  Tool (TURN) • 1405
  Tool axis limits • 1136, 1148
  Tool blocks for turrets • 1924, 1927, 1956
  Tool center • 1061, 1090
  Tool change • 1658
  Tool colors • 1527
  Tool column • 1549
  Tool cutting tolerance • 1529, 1536
  Tool details • 1557
  Tool diameter • 1024, 1667
  Tool end radius • 1667
  Tool groups • 982, 1746
  Tool holder selection • 1847
Tool life management overview • 1580
  Tool List • 1548, 1556, 1557
  Tool load • 1521, 1546
  Tool location • 1916, 1956
  Tool Manager dialog • 1746
  Tool Mapping • 1576
  Tool nose radius compensation • 1367, 1690
  Tool programming point • 1709
  Tool quill • 1905, 1939, 1954
  Tool selection for 3D milling features • 742
  Tool selection for MillTurn features • 1830
  Tool Selection tab • 1677
  Tool Slot • 1549
  Tool Usage tab (TURN) • 1405
  Tool visual tolerance • 1529, 1536
Tool block • 170, 173
  Tool Block Selection dialog • 173, 1580
  Tool block tool location • 48
  Tool color • 57
  Tool crib • 1833
  Tool database • 2
    Imperial tools • 2
    Inch tools • 2
    Metric tools • 2
  Tool holder • 112
  Tool holder clearance • 146, 1681
  Tool Holder Clearance dialog • 110
  Tool Information dialog • 48
  Tool location at back of tool holder • 48
  Tool Locations • 170
  Tool mapping • 22
  Tool Mapping dialog • 173
  Tool Nose Radius compensation • 19
  Tool orientation • 74
  Tool pecking depths • 153
  Tool post movement simulation • 23
  Tool Properties dialog • 215
  Tool selection • 16, 110, 146, 1681
  Tool selection tab • 204
  Tool slot numbers • 1916
Toolbars • 5, 1, 10, 32
  Assistance bar • 5
  Display mode toolbar • 30
  Feature/geometry edit bar • 5
  Geometry edit bar • 5
  Menu bar • 5
Status bar • 5
Title bar • 5
Toolbar display • 24
Toolbar name • 24
Toolbar view • 24
Toolbox • 182, 1, 29
Toolbox window • 5
Toolholder properties dialog • 1844
Tooling database • 1746
Toolpath • 295, 1517, 1533
  Simulating toolpaths • 14, 37, 54, 66, 71
  Toolpath colors • 1517
  Toolpath corner % • 995, 1164, 1195, 1608
  Toolpath end/start • 1188
  Toolpath feature • 532
  Toolpath type • 717
Toolpath boundaries • 205
Toolpath features • 17
Toolpath points preview • 152
Toolpaths • 199, 200
Tools
  Imperial tools • 2
  Inch tools • 2
  Metric tools • 2
  Tool database • 2
  Tool mapping • 22
Tools list • 19
Tools tab • 982, 984, 1402
Tools with multiple inserts • 132
Tooth outside • 995, 1661
Tooth overlap • 995, 1661
Top • 10
  Top first • 1110
  Top view • 41
  Top-most table • 1902, 1913, 1939, 1955, 1956
Total Passes (WIRE) • 1476
Total stock • 995, 1164, 1446
Touch off at the shoulder (tooling) • 1781
Touch off at the shoulder check box • 202
Towards chuck • 1367
TPI (tooling) • 1777
Trackball • 40
Traditional toolpaths • 717
Transfer tool post control • 23
Transfer Turret Control • 23
Transform solid (SOLID) • 452
Transforming a solid • 452
Transforms • 310, 1900
  Reflect • 310
  Rotate • 310
  Scale • 310
  Translate • 310
Transitions for 2.5D milling toolpaths • 993
Translate • 311, 1939
Translucent part • 1529
Translucent tool • 1529
Transparent • 49, 1934
Traveling steady rest • 234
Tree view • 4, 904
Triangular inside corner (WIRE) • 1484
Trim • 418
Trim geometry • 315
Trim surface • 418
Trimmed surface edge • 344
Trimming a surface with a curve • 420
Trimming restrictions • 421
Trochoical cut • 995, 1164, 1608
Trochoidal stepover • 995
Troubleshooting isoline milling • 773
Troubleshooting pencil milling • 778
Troubleshooting pick pieces (chaining) • 322
Troubleshooting planar remachining • 794
Troubleshooting projection milling methods • 748
Troubleshooting Z level finishing • 772
Troubleshooting Z level roughing • 761
tsf files (TOMB) • 1886
Turn • 11
  Turn F/S tab • 1409
  Turn feature feeds and speeds • 834
  Turn feature finishing • 840
  Turn feature roughing • 835
  Turn feature semi-finishing • 839
  Turn feature tool selection • 834
  Turn features (TURN) • 574
  Turn groove finishing • 816
  Turn groove roughing • 815
  Turn machining attributes • 1686
    Bar Feed tab • 1708
    Cutoff tab • 1465, 1707
Grooving tab • 1703
Pecking tab • 1606
Threading tab • 1700
Turn/Bore tab • 1690
Turn operation order • 1564
Turn to diameter • 1367
Turn feature • 30, 47
Turn format feature • 855
Turn Properties dialog • 213
Turn/Bore tab • 1690
Turn/mill • 43
TURN/MILL • 10
Turn/mill angular interpolation • 1529, 1537
Turn-curve tolerance add-in • 230
TurnCurveTolerance.bas • 179
Turned groove feature • 808
Turned groove tool selection • 809
Turning • 24
Turning canned cycles • 1570
Turning chuck • 83
Turning Features • 805
Turning head tool holders • 186
Turning head tool holders Machine Design • 1937
Turning heads with multiple tools • 29
Turning Input Modes • 304
Turning Post Processors • 1868
Turning tool orientation • 74
Turning tool overrides tab • 1786
TurnMill location dialog • 535
Turnmill Overview • 857
Turnmilling • 1367
Turnmilling program point • 118
Turret (TURN) • 608, 1405
Turret control • 855
Turret direction • 608, 1405, 1709
Turret Information dialog • 240
Turret location • 1713
Turret names • 161, 1558
Turret NC code • 1564
Turret rotates when changing tools • 1916
Turret selection • 215
Turrets • 4
Turrets tab • 211, 1548, 1558
Tutorial - machine design • 1939
Twist drills • 1781
Twists in surfaces or solids with closed cross sections • 395
Two lights • 49
Two point fillet • 286
Two points line • 277
Types of features that can be recognized • 512
Types of wire EDM tapers • 614

U
U axis • 29
UCS • 110, 229, 1902, 1904, 1939, 1953, 1955
UDF • 1955
Unable to construct object with these inputs • 1949
Unattached design features • 449
Unconnected design feature (SOLID) • 449
Undercut checking with TNR • 19
Undercuts • 157, 1077, 1421, 1447
Undo • 309
Undo sync code changes • 1559
Ungrouping objects • 873
Uni-directional (WIRE) • 1476
Unigraphics files • 82, 94, 98
Union (SOLID) • 476
Unit horsepower • 209
Units • 1900, 1946
  Imperial tools • 2
  Imperial units • 4
  Inch tools • 2
  Inch units • 4
  Metric tools • 2
  Metric units • 4
Unpick curve pieces • 324
Untransformed coordinates • 91
Untrim surface • 422
Unused curves • 103
Unwrap curve • 339
Up/down smoothing % • 1269
Update operation list • 133
Update options (probing) • 168
Upper Curve Start/End Point (WIRE) • 1482
Use
  Use 90 deg comp • 1638
  Use alternative 5-axis position (5AP) • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1247, 1269, 1293, 1301, 1310, 1315, 1321, 1328
Use arc ramp in/out • 1673
Use arc ramp-in/out (3D) • 1343
Use B-axis simultaneous • 1413
Use Blank • 8
Use canned cycle (TURN) • 1367, 1690
Use curve to describe tool shape • 1761, 1774, 1781
Use finish tool • 937, 1367, 1608, 1661
Use graphics hardware • 49
Use IPT • 984, 1649
Use L/D compensation • 1599
Use lead and lean • 1136
Use lead in/out • 1343, 1673
Use linear approximation (3D) • 1343
Use linear lead in/out • 1343, 1673
Use MMPR • 984, 1649
Use MMPT • 984, 1649
Use on both ends of skim passes (WIRE) • 1469
Use operation template • 1564
Use part surface dimensions • 1124
Use Results as Starting Point • 1541
Use separate wall tolerance • 1119
Use SFM • 568, 984, 986
Use solid model • 1124
Use Solids As Clamp (SOLID) • 1543
Use stock dimensions • 1124
Use the same fixture ID on each orientation (TOMB) • 1890, 1891
Use white background (printing) • 106
Use solids as clamp option • 185
User Coordinate System • 109, 1953, 1955
User interface • 4
User interface style • 24
User views • 42
User-defined features (UDFs) • 532, 858
User-defined stock • 72, 223
Uses Macro if Available (WIRE) • 1476
U-Shape • 1490
Using
   Using a form tool or insert drill for drilling operations • 1785
   Using an insert drill for both drilling and boring • 1785

Using groups to determine manufacturing order • 1497
   Using multiple UCS and setups • 113
Using simulation video-style controls • 1521
Using the Integrated Development Environment (IDE) • 147
Using zig-zag ramping to mill a helical path for a simple groove • 695

V
Valid solids (SOLID) • 450
Variable taper table • 615
Variable width text • 58
Variables • 995, 1164, 1180, 1188, 1195, 1203, 1223, 1230, 1238, 1269, 1293, 1301, 1310, 1315
Vericut files • 163
Verify solid (SOLID) • 450
Verifying that a solid is valid • 450
Vertical • 279
   Vertical (Z) • 1136
   Vertical Distance • 290
   Vertical line • 279
   Vertical milling machine • 49
   Vertical only • 1134, 1667
   Vertical turret lathe • 49
Videos • 8
View
   View animation • 44
   View Entities • 43
   View independent • 1529
   View menu • 40
   View on start-up • 44
   View shortcuts list • 30
   View toolbars • 24
   &frac34; • 1529
Viewing • 4, 37, 44
   Viewing centerlines for an operation • 1553
   Viewing intermediate shaded simulations • 1553
   Viewing mode on startup • 46
   Viewing Options dialog • 44
Viewing Options dialog • 137
Viewing the part • 13, 35, 48, 61
   Hide all geometry • 61
   Shading • 35, 48, 61
   Show all surfaces • 61
Views
2D turned profile • 30, 47, 48
Centre all • 26, 44
Front view • 13
Isometric view • 13, 35, 48, 61
Viewing the part • 13, 35, 48, 61
Vise • 83
Vises • 35
Visicut simulation • 1517
Vortex • 148, 150
Vortex non-cutting moves • 64

W
Wall clearance (3D HSM) • 1110
Wall finish allowance • 971
Wall pass • 937
Wall tab • 979
Wall tolerance • 1119
Warnings • 194, 195
Warp dialogs • 54
Water • 1488
Web content • 8
Web pages • 8
Website • 10
White background (printing) • 106
Wide face grooves • 814
Width of face (TOMB) • 1888
Willemin-Macodel 480MT • 85
Wind fan • 1661
Wind fan angle • 1638
Wind fan finish • 937, 1638
Wind fan radius • 1638
Window
Graphics window • 5
Results window • 5, 15, 16, 18, 19, 38, 40
Toolbox window • 5
Windows 7 • 180
WIRE • 10
Wire Compensation (WIRE) • 1480
Wire cutting/threading • 1736
Wire EDM • 67, 218, 219, 237
Wire EDM cut data • 1510
Wire EDM feature • 69
Wire EDM tab • 1717
Wire EDM Taper • 614
Wire feature attributes (WIRE) • 1469
Wire machining attributes • 1717
Misc. tab (WIRE) • 1736
Offset tab • 1726
Posting tab (WIRE) • 1741
Start tab • 1731
Wire EDM tab • 1717
Wire radius compensation • 1480
Wire radius compensation - on the machine • 1480
Wire radius compensation via the software • 1480
Wire simulation options • 1536
Wire visual diameter • 1536
Withdraw angle • 1421, 1447
Withdraw length • 1421, 1447, 1690
Words Info dialog • 242
Working with imported geometry • 84
World layer • 299
Wrap feature around Z-axis • 857
Wrap tolerance • 1658

X
x = F(t) • 360
x = F(t), y = G(t) • 360
x = F(t), y = G(t), z = H(t) • 362
x = F(y) • 357
X finish allowance • 1421, 1447, 1690
X Length • 298
X offset • 1897
X Origin • 298
X parallel • 1061, 1071, 1100
X semi-finish allowance • 1421, 1690
X Spacing • 298
X tool • 1956
x=F(t) • 360
y=G(t) • 360
x=F(t) y=G(t) z=H(t) • 362
XBUILD • 236, 237, 240, 242
xmb files • 82, 94
XML • 162
xmt files • 82, 94
X-Y acceleration • 1658
XYZ location • 535

Y
y = F(x) • 357
y = G(t) • 360
Y Length • 298
Y offset • 1897
Y Origin • 298
Y parallel • 1061, 1071, 1100
Y Spacing • 298
y=F(x) and x=F(y) • 357

Z

z = G(a) • 361
Z boring (only) • 1956
Z depth • 974
Z drilling/milling (only) • 1956
Z end • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1293, 1301, 1310, 1315, 1321
Z finish allowance • 1421, 1447, 1690
Z increment • 995, 1164, 1210
Z index clearance • 243, 1658
Z leave allowance • 1421
Z offset • 1897
Z ramp clearance • 995, 1649
Z rapid plane • 974, 1059, 1340, 1599, 1649
Z semi-finish allowance • 1421, 1690
Z start (3D Lite) • 1164, 1180, 1188, 1195, 1203, 1210, 1223, 1230, 1238, 1293, 1301, 1310, 1315, 1321
Z steps • 974, 1619
Z-acceleration • 1658
Z-buffer • 49
Zigzag • 986, 1061, 1062, 1469, 1619
  Zigzag Cycle - Define Start point • 630
  Zigzag Cycle Overview • 629
  Zigzag operation (WIRE) • 1469
  Zigzag ramping • 995
  Zigzag stepover (25D) • 717
  Zigzag toolpath (25D) • 717
Zigzag (Wire) • 218
Z-indexing • 13
Z-level
  Z-level finish • 772
  Z-level rough — How to create • 760
  Z-level Rough Remachining Options dialog (3D LITE) • 1067
  Z-level rough spiral (3D) • 1061
  Z-level roughing • 760, 762, 763, 1164
  Z-level simulation • 1552
  Z-level slice classification • 1061
Zoom • 40